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Material Editor,
Materials, and Maps

Materials describe how an object reflects or transmits light. Within a material, maps can
simulate textures, applied designs, reflections, refractions, and other effects. (Maps can also
serve as environments and projections from lights.) The Material Editor is the dialog you use
to create, alter, and apply the materials in your scene.
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See also:

■ Designing Materials on page 5260

■ Types of Materials on page 5379

■ Material Editor  on page 5284

■ Types of Maps on page 5767

Designing Materials

Materials make objects look more convincing.

These topics give you an overview of using the Material Editor to design
materials on page 8041. The Material Editor  on page 5284 gives you a wide variety
of options for designing material, as well as myriad controls. If you’re new to
the Material Editor, read this topic for a general idea about working with
materials, and what the most important options are.
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For more details, follow the links in the workflow outline.

Workflow Outline

In general, when you create a new material and apply it to an object, you
follow these steps:

1 Make a sample slot on page 5262 active, and enter a name for the material
you are about to design.

2 Choose the material type on page 5264.

TIP 3ds Max provides two renderers: the default scanline renderer on page
6141 and the mental ray renderer on page 6230, each with distinctive capabilities.
You choose a renderer for each scene based on its features. It is a good idea
to design materials with a particular renderer in mind. The mental ray
Connection rollout on page 5385 lets you add features unique to the mental
ray renderer to basic 3ds Max materials.

When rendering with mental ray, it’s highly recommended that you use
the Arch & Design material on page 5544 whenever possible. This material
is optimized for use with mental ray and offers a number of distinct
advantages over other materials available with 3ds Max.

3 For a Standard or Raytrace material, choose the shading type on page 5265.

4 Enter settings for the various material components on page 5267: diffuse
color, glossiness, opacity, and so on.

NOTE Lights and Shading on page 5268 describes how lights affect the
appearance of a material. Choosing Colors for Realism on page 5270 gives
guidelines on getting good results from unmapped materials.

5 Assign maps on page 5274 to the components you want to map, and adjust
their parameters.

6 Apply on page 5278 the material to the object.

7 If necessary, adjust the UV mapping coordinates on page 5279 in order to
orient maps with objects correctly.

8 Save on page 5280 the material.
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Sample Slots and Material Name

The sample slots on page 5304 display previews of materials. They are the most
prominent feature of the Material Editor interface. Below and to the right of
the sample slots are various tool buttons on page 5317 for the Material Editor.
Below the tool buttons is a name field that shows the name of the material.

TIP Always give a material a unique, intelligible name as soon as you begin to
work on it.

By default, six sample slots are visible at once. The Material Editor actually
holds 24 materials at one time. You can use the scroll bars to move among
the sample slots, or you can change the number of sample slots visible at once
to 15 or 24 slots. Seeing more slots at once can be helpful if you are working
with a complex scene.
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IMPORTANT While the Material Editor can edit no more than 24 materials at a
time, a scene can contain an unlimited number of materials. When you are through
editing one material, and have applied it to objects in the scene, you can use that
sample slot to get on page 5341 a different material from the scene (or create a new
one) and then edit it.

To increase the number of sample slots visible at once, right-click a slot and
then choose 5 X 3 Sample Windows or 6 X 4 Sample Windows from the pop-up
menu.

NOTE The right-click menu also has an Options choice on page 5335. This displays
a dialog with various options for sample display. Exploring these options can help
you learn to preview materials effectively. However, keep in mind that these settings
affect the sample display only. They change nothing in the 3ds Max scene.

When more sample slots are visible, the images are smaller, but you can display
a larger, floating, and resizable material sample by double-clicking the slot
you want to see better.

Click a sample slot to make it active. Now you can design a new material from
scratch, or you can load a previously stored material by clicking Get Material
on page 5341, which displays the Material/Map Browser. The Browser is a dialog
that lets you choose materials and maps from a material library, from the
scene, and so on.

You can also copy a material from one sample slot to another. Drag the slot
with the material to another slot. To avoid confusion, rename the copy in the
new sample slot before you begin to make changes to it.
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Material Type

Every material has a type. The default is Standard on page 5395, which is the
material type you will probably use most often. In general, other material
types are for special purposes. The other material types are:

■ Advanced Lighting Override on page 5734
Used to fine-tune the effects of a material on Advanced Lighting on page
6153, including light tracing on page 6154 and radiosity solutions on page 6168.
Radiosity Override is not required for calculating advanced lighting, but
it can enhance the result.

■ Blend on page 5708
Mixes two other materials together. Can use a mask or a simple amount
control.

■ Composite on page 5711
Mixes up to 10 materials.

■ Double-Sided on page 5713
Contains two materials, one for the front and one for the back faces of an
object.

■ Ink 'n Paint on page 5742
Creates cartoon effects with flat shading and “inked” borders.

■ Lightscape on page 5741
Supports import on page 7253 and export on page 7251 of data from the
Lightscape product.

■ Matte/Shadow on page 5699
Displays the environment but receives shadows. This is a special-purpose
material. The effect is similar to using a matte in filmmaking.

■ Morpher on page 5716
Lets you morph between materials using the Morpher modifier on page
1545.

■ Multi/Sub-Object on page 5720
Lets you apply multiple sub-materials to a single object's sub-objects.

■ Raytrace on page 5490
Supports the same kind of diffuse mapping as Standard material, but also
provides fully raytraced reflections and refractions, along with other effects
such as fluorescence.
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■ Shell on page 5732
Contains a material that has been rendered to a texture on page 6371, as well
as the original material upon which the texture is based.

■ Shellac on page 5727
Mixes two materials by applying a "shellac" material to another.

■ Standard on page 5395
Uses surface shaders to simulate materials. In general, the standard material
is probably the best choice for a simple material if you choose to use
standard light objects. If you use photometric lights, use the default
Architectural material.

■ Top/Bottom on page 5729
Contains two materials, one for faces that point upward, the other for faces
that point downward.

Standard materials let you set values for components such as color,
glossiness, and opacity. They also let you apply maps to the components,
which can produce an enormous variety of effects. Some other material
types have these features as well. Some materials, such as Multi/Sub-Object
or Double Sided, have controls only for combining other materials.

mental ray Materials

A group of materials is provided for use with the mental ray renderer on page
6230. See mental ray Materials on page 5543.

Shading Type

The Standard and Raytrace materials let you specify a shading type. Shading
types are handled by a "shader," which describes how the surface responds to
light.

WARNING When you change the shading type of a material, you lose the settings
(including map assignments) for any parameters that the new shader does not
support. If you want to experiment with different shaders for a material with the
same general parameters, copy the material to a different sample slot on page 5304
before you change its shading type. That way, you can still use the original material
if the new shader doesn't give you the effect you want.
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Samples of different shading for a standard material

1. Anisotropic

2. Blinn

3. Metal

4. Multi-layer

5. Oren-Nayar-Blinn

6. Phong

7. Strauss

8. Translucent

Several different shaders are available. Some of these are not available for the
Raytrace material, as indicated below. Blinn is the most general-purpose of
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these shaders. The others have special purposes, especially regarding how the
material creates highlights.

■ Anisotropic on page 5424
Creates surfaces with noncircular, "anisotropic" highlights; good for
modeling hair, glass, or metal.

■ Blinn on page 5426
Creates smooth surfaces with some shininess; a general-purpose shader.

■ Metal on page 5427
Creates a lustrous metallic effect.

■ Multi-Layer on page 5428
Creates more complex highlights than Anisotropic by layering two
anisotropic highlights.

Not available for Raytrace material.

■ Oren-Nayar-Blinn on page 5429
Creates good matte surfaces such as fabric or terra-cotta; similar to Blinn.

■ Phong on page 5426
Creates smooth surfaces with some shininess; similar to Blinn, but doesn't
handle highlights (especially glancing highlights) as well.

■ Strauss on page 5431
Creates both nonmetallic and metallic surfaces; has a simple set of controls.

Not available for Raytrace material.

■ Translucent on page 5434
Translucent shading is similar to Blinn shading, but it also lets you specify
translucency, where light is scattered as it passes through the material.
You can use translucency to simulate frosted and etched glass.

Not available for the Raytrace material.

Material Components

A material's components describe its visual and optical properties. The
components in the Architectural material on page 5526 are based on physical
qualities; for example, diffuse color, shininess, transparency, and so on. The
components in a Standard material on page 5395 include color components,
highlight controls, self-illumination, and opacity. Like the Standard material,
the Raytrace material on page 5490 uses a nonphysical model to describe surfaces.
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Standard and Raytrace material components vary depending on which shader
on page 5265 you use.

You can assign maps to most components, including color components such
as Diffuse, and value components such as Transparency or Opacity. Maps can
increase the complexity and realism of the material's appearance.

Lights and Shading

Materials work in combination with lights on page 4970. The intensity of light
that falls on a surface determines the intensity of color to display. Three factors
contribute to the intensity of light where it falls on an object:

■ Light intensity: A light's original intensity at its point of origin.

■ Angle of incidence: The more a surface inclines away from the light source,
the less light it receives and the darker it appears. The angle between a ray
of light and the face normal on page 8059 of a surface is the angle of incidence
for that face.
When the angle of incidence is 0 degrees (that is, the light strikes the face
perpendicularly), the face is illuminated at full intensity unless the light
is attenuated. Full intensity is the light's Multiplier value times the value
of the face's surface color. The Multiplier value is 1.0 by default; the surface
value is the Value component of the surface color's HSV description on
page 8105. As the angle of incidence increases, the intensity of the face
illumination decreases.
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Angle of incidence affects intensity.

■ Distance: Light diminishes over distance. This effect is known as
attenuation on page 7915. By default, attenuation is turned off, but you can
turn it on and specify the distance over which it operates.

Lights and the Component Colors of a Standard Material

As the names of a standard material's color components on page 5267 imply,
the kind of light that strikes a surface with a material determines how the
surface appears when it is shaded.

■ Ambient color appears where the surface is lit by ambient light alone
(where the surface is in shadow).

■ Diffuse color appears where light falls directly on the surface. It is called
"diffuse" because light striking it is reflected in various directions.
Highlights, on the other hand, are reflections of light sources.

■ Specular highlights appear where the viewing angle is equal to the angle
of incidence. Glancing highlights appear where the angle of incidence is
high, relative to the observer or camera (that is, the light ray is nearly
parallel to the surface). Shiny surfaces usually have specular highlights.
Glancing highlights are characteristic of metallic surfaces.
Some surfaces are completely reflective, or nearly so. These reflect their
environment as well as the light sources that illuminate them. To model
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such surfaces, you need to use reflection mapping on page 5964 or ray tracing
(see Raytrace Material on page 5490).

The three color components blend at the edges of their regions. Between
ambient and diffuse, the blending is calculated by the shader. Between diffuse
and specular, you set the amount of blending by using the standard material's
highlight controls.

Choosing Colors for Realism

Materials add greater realism to a scene only if you choose their colors and
other properties to appear like real-world objects. This topic presents some
general guidelines for choosing standard material colors. When possible, you
should also observe colors in the objects you are modeling, especially under
different lighting conditions.

For objects on which you want the viewer to focus attention, an unmapped
standard material doesn't often provide the level of realistic detail you probably
want. However, for distant and peripherally visible objects, as well as some
kinds of real-world materials, such as molded plastic, an unmapped standard
material can work well. Keeping the number of maps to a minimum can help
keep down the file size.

Indoor and Outdoor Lighting

Whether a scene is indoors or outdoors affects your choice of material colors,
just as it affects the way you set up lights on page 4970. Full sunlight is bright
and unidirectional. Most indoor lighting is less intense and more even (that
is, multidirectional) than daylight. However, some special indoor lighting
(and nighttime outdoor lighting), as for the stage, also features intense,
directional light.

Direct sunlight has a yellow tint. Materials for objects to appear in daylight
should have a specular color of a pale, unsaturated yellow (for example, RGB
values of 240, 240, 188). The ambient color should be the complement of the
specular: a deep, dark purple with a hint of the diffuse color.

Materials for objects to appear under normal interior lighting should have a
specular color that is close to white. (Our perception compensates for the
yellow or green tint that is often present in artificial light.) The ambient color
can often have the same hue as the diffuse color, but with a darker value.
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Materials for objects to appear under spotlights should follow the general
guidelines for daylight materials. The specular color should match the
spotlight's color, and the ambient color should be a very dark value of the
spotlight color's complementary hue, mixed with a bit of the material's diffuse
color.

If you want to render an object under changing lighting conditions, you can
choose colors that are a compromise between the optimal colors for each kind
of lighting, or you can animate on page 5361 the material so that its colors
change to suit the changing light.

Representing Natural Materials

Outdoor scene with natural materials

Most natural materials have a matte surface with little or no specular color.
For natural materials such as these, use the following guidelines:

■ Ambient color: The ambient color depends on whether the scene is indoors
or outdoors, as previously described.

■ Diffuse color: Choose a color found in nature. It is best to use the observed
color of the object itself, or a similar object.
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■ Specular color: Make the specular color the same hue as the diffuse, but
with a higher value and a lower saturation.

■ Glossiness: Set the Glossiness to a low value.
Some foliage, bird feathers, fish scales, and so on, are shiny. For materials
such as these, set the Glossiness to higher values. You might also want to
change the specular color so it's closer to the lighting color than the
surface's diffuse color.

Water is reflective, and is best modeled by a color component in combination
with a reflection map on page 5964 or a water map on page 5907.

While metal is a natural material, its special visual characteristics are most
apparent when it has been polished. Standard material represents this by using
a special shading type, described later in this topic.

Representing Manufactured Materials

Indoor scene with manufactured materials
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Manufactured materials often have a synthetic color rather than an "earth
tone." Also, many manufactured materials, such as plastics and porcelain
glazes, are very shiny. For manufactured materials, use the following guidelines:

■ Ambient color: The ambient color depends on whether the scene is indoors
or outdoors, as previously described.

■ Diffuse color: Although the diffuse color doesn't have to be an "earth tone,"
as with natural materials you should used the observed color of the object
or a similar object.

■ Specular color: Make the specular color close to white, or to the color of
the light source. White is especially characteristic of plastic materials.

■ Glossiness: Set the glossiness to a high value.

Representing Metallic Objects

Metallic cup and ice cream scoop

Polished metal has a characteristic "glancing" highlight that appears where
the light is at a high angle of incidence. To generate this effect, Metal shading
uses the Cook/Torrance illumination model.
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For metallic materials, you can use the Metal shading type. This disables the
specular color and highlight controls. The Metal shader calculates its own
specular color, which can vary between the diffuse color and the color of the
light.

In the diffuse region of a metal material, the ambient component is greater
than it is for other kinds of materials.

The Anisotropic, Multi-Layer, and Strauss shaders give you further options for
modeling polished metal.

If the metallic object is the focus of the scene, you can improve realism by
using a Blend material on page 5708 to combine metallic shading with a
reflection map on page 5964.

TIP  When you preview metallic surfaces, it is useful to turn on a backlight.
This displays the metal's glancing highlight. The Backlight button is to the right
of the sample slots.

Using Maps to Enhance a Material

Maps provide images, patterns, color adjustments, and other effects you can
apply to the visual/optical components of a material. Without maps, material
design in 3ds Max is limited. Maps give the Material Editor its full flexibility,
and can give you dramatic results.

Spheres with various maps applied to them (as well as a reflection map applied to the
surface beneath them)

The simplest use of a map is to assign a pattern to a material's Diffuse color.
Diffuse mapping on page 5460 is also known as "texture mapping." It applies an
image or pattern to geometry the material is applied to.
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Example of designing a mapped material:

1. Choose a sample slot.

2. Increase the highlight.

3. Apply a checker map to the material's diffuse component.

4. Apply a bump map to give the material ridges.
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5. The checker map displays in viewports, but the bump map does not, by default.

6. Rendering the material shows the full effect of mapping.

WARNING When you change the shading type on page 5265 of a standard material,
you lose the settings (including map assignments) for any parameters that the
new shader does not support. If you want to experiment with different shaders
for a material with the same general parameters, copy the material to a different
sample slot on page 5304 before you change its shading type. That way, you can
still use the original material if the new shader doesn't give you the effect you
want.

Map Terminology

The term "material map" is sometimes used to describe a map assigned in the
material editor. A material map applies a color or pattern to a surface. This is
different from maps used for displacement mapping with the Displace modifier
on page 1344, environment mapping for backgrounds, or projection mapping
from lights.

The term "texture map" is sometimes used as well. It is interchangeable with
"diffuse map"; that is, with a map that applies colors to geometry, as opposed
to a map that create reflections, bumps, and so on.

In the Material/Map Browser on page 5290, maps are categorized according to
how the map software functions. The categories are:

■ 2D maps
A bitmap on page 5795 is the prototypical 2D map. 2D maps apply pictures
and patterns to the surface of objects.

■ 3D maps
3D maps are generated procedurally. 3D maps apply patterns throughout
an object's geometry.

■ Compositors
Compositors combine other maps.

■ Color Modifiers
Color modifiers are usually composited with another map to adjust its
color. The Vertex Color map is a special case that displays the colors you
assign to vertices in a mesh.

■ Other
"Other" maps include maps that simulate reflection or refraction.
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The names of individual map types describe the pattern or effect they create,
such as Checker map, Bitmap, Gradient, Flat Reflection, and so on.

NOTE In some cases the user interface also uses "map" to describe not the map
type, but the visual component being mapped. For example, a "diffuse map"
means a map of any type applied to a material's diffuse component. This is an
ambiguity in the use of "map" that can be a bit confusing when you first encounter
it.

Assigning Maps

For a standard material on page 5395, you assign maps using the Maps rollout.
Click the Map button in line with the name of the visual component you
want to map. The Material/Map Browser on page 5290 is displayed. Select the
map type (for example, Bitmap) from the list of maps, and then click OK.
Double-clicking the map's name in the Browser also assigns the map type.

The Browse From group box in the Browser creates new maps by default. You
can also use it to obtain maps from a library (see Saving A Material), from the
current scene, from objects selected in the scene, or from elsewhere in the
material editor.

In the Browser, you can turn on icons of differing sizes to preview maps before
you assign them.

A Standard material's Basic Parameters rollout has shortcut buttons for
assigning a map to some of the material's visual components. These small
buttons are equivalent to the buttons in the Maps rollout. Assigning a map
to a button in one rollout changes the corresponding button in the other.

Each type of map has its own set of parameters and controls. If the map is a
Checker map, for example, you can choose the colors of the checkers, and
whether a checker color has a map of its own. You can change tiling values
to affect the scale of the checkers, adjust noise parameters to make the checkers
irregular, and so on.

NOTE To save loading time, if a map with the same name is in two different
locations (in two different paths), it is loaded only once. This poses a problem only
if your scene includes two maps that have different content but the same name.
In this case, only the first map encountered will appear in the scene.

Navigating the Material/Map Tree

When you build a material of any complexity, you are building a material/map
tree. The root of the tree is the material itself. The branches are the maps you
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have assigned to the material's components. Some maps can themselves
contain maps, as in a map applied to one color of a Checker material on page
5808, so the tree can be more than two levels deep, and can actually be as deep
as you need it to be.

 The Material/Map Navigator on page 5357 is a dialog that displays the tree
for the current material. It is useful for finding a map and displaying its
parameters. Click the map to display its rollouts in the Material Editor. To
copy a map to a different component of the same material, you can also drag
the map's name from the Navigator to a map button in the Material Editor.

 The Go Forward To Sibling and Go To Parent buttons also navigate
the map tree. Go Forward To Sibling moves laterally in the map tree, while
Go To Parent moves up the tree. (To move down the tree, click a map button
that has a map assigned to it.) Another way to move between parents and
children in the tree is to drop down the material name field on page 5360 and
click the name of a map or material.

Applying a Material to an Object

There are two ways to apply a material to an object:

■ If the sample slot is active and the object is already selected, click Assign
Material To Selection on page 5344.

■ Drag from the sample slot to the object.
As you drag, a tooltip appears over each object beneath the mouse, showing
the object's name. You can apply the material whether the object is selected
or not. Release the mouse to apply the material.

Applying a material overrides any previous material assignment the object
might have had. Once the material is applied, while the sample slot is active,
the material is "hot" and changes you make to it affect the object automatically.
See Sample Slots on page 5304 for more about hot and cold materials.

The Undo command on page 262 works for material assignment.

You can apply only one material to an object. To overcome this restriction,
use a Multi/Sub-Object material on page 5720. This is a container for various
sub-materials that correspond to specified sub-objects such as different faces
in a mesh, NURBS surfaces in a NURBS model, and so on.
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You can apply the same material to multiple objects in the scene.

See also:

■ Dragging and Dropping Maps and Materials on page 5310

■ Drag and Drop Sub-Object Material Assignment on page 5312

Mapping Coordinates

An object assigned a 2D mapped material (or a material that contains 2D
maps) must have mapping coordinates. These coordinates specify how the
map is projected onto the material, and whether it is projected as a "decal,"
or is tiled or mirrored. Mapping coordinates are also known as UV or UVW
coordinates on page 8161. These letters refer to coordinates in the object's own
space, as opposed to the XYZ coordinates that describe the scene as a whole.

Most renderable objects have a Generate Mapping Coordinates parameter.
This is on by default, but if it’s off and the object contains a mapped material,
when you try to render, you get a warning.

Some objects, such as editable meshes, don't have automatic mapping
coordinates. For these types of objects, you can assign coordinates by applying
a UVW Map Modifier on page 1931.

If the material appears the way you want it with the default mapping, you
don't need to adjust the mapping. If you need to adjust it, use the map's
Coordinates rollout. There are two typical sets of coordinates parameters: one
for 2D maps such as Bitmaps on page 5795, and another for 3D maps such as
Noise on page 5886. See Coordinates Rollout (2D) on page 5782 and Coordinates
Rollout (3D) on page 5861.

NOTE The UVW Remove utility on page 5284 provides a way to remove mapping
coordinates or an entire material from selected objects.
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Mapping coordinates shown as U and V axes local to a surface.

Saving a Material

While a material is in the Material Editor or applied to an object, it is part of
the scene, and is saved with the scene. However, for complicated scenes it is
inconvenient to have all materials active in the Material Editor. You can also
save a material by putting it into a material library. Some libraries are provided
in the \materiallibraries subdirectory. The file 3dsmax.mat is the default library.
You can add your material to this library, or create your own libraries.

Procedures

To save a material in a library:

This stores a material in the current material library. To use a different library,
first open it using the Material/Map Browser on page 5290.

1 In the Material Editor, click the sample sphere for the material to save.
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2  On the Material Editor toolbar, click Put to Library on page 5348.

This opens the Put to Library dialog on page 5372. Change the material
name or leave it as is, and then click OK.

3  Choose Rendering > Material/Map Browser, or, on the Material
Editor toolbar, click Get Material on page 5341.

The Material/Map Browser on page 5290 opens.

4 In the Browser > Browse From group, choose Mtl Library, if necessary.

The stored material appears in the list.

5 In the Browser > File group, click Save to save the library with the current
name (if any) or Save As to save it as a different file.

TIP You can use the Merge function in the File group to add materials from
the current library to another library.

Material XML Exporter Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Material
XML Export

You can export materials you create in 3ds Max to XML files, which can then
be shared with other 3ds Max users or used in AutoCAD Architecture (formerly
Autodesk Architectural Desktop) to modify material definitions.

NOTE You can add an exported XML material to your 3ds Max scene by dragging
and dropping from a Web site or Windows Explorer onto an object in your scene,
or by importing it directly onto objects.
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Interface

Selection Method group

The Selection Method group lets you set the method for selecting the materials
you wish to export.

Material/Map Browser Lets you select a material to export from the
Material/Map browser on page 5290.

Object List Lets you specify objects using the Select Object For Material
Modifier Export dialog, which works like the Select From Scene dialog on page
228. All materials assigned to the selected objects are exported.

Pick Object in Scene Lets you select an object from your scene. Any materials
assigned to the selected object are exported.

All Objects in Scene Exports all of the assigned materials in your scene.
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Output Format group

The Output Format group defines the format of the XML Material output.

Native XML (vizML) Materials are exported as raw XML.

TIP Use this format for sharing XML material files within 3ds Max.

Tool Catalog Materials are exported to the ATC (Autodesk Tool Catalog)
format.

This file type is suitable for display in the AutoCAD Content Browser and the
Autodesk VIZ Content Browser.

NOTE This file type cannot be imported to 3ds Max unless you also have Autodesk
VIZ Render installed on the same system.

Specify XSLT This option lets you apply your own XSL transform to the XML
output.

Export group

The Export group lets you define the parts of the material assignments to
export.

Material Exports the material definitions.

Create Thumbnails Exports thumbnails for each material.

NOTE Thumbnail images are referenced by the ATC and displayed in the AutoCAD
Content Browser and Autodesk VIZ Content Browser.

Mapping Modifiers Exports the mapping modifiers applied to specific objects.

Export This button begins the XML export process, using the defined selection
method, output format, and export parameters.

Upon clicking Export, you are prompted to set the path or URL to store in the
XML file as the path to any referenced bitmap files. The default is an empty
string, which means no path will be prepended to the bitmap filenames when
written to XML. When the material is later imported, it will be assumed that
the referenced bitmap file can be found in the bitmap search path.

If you have elected to export thumbnails or to apply your own XSL transform,
you are then prompted to set a path to store the thumbnail files and to locate
your XSLT file, respectively.
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UVW Remove Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > UVW
Remove

The UVW Remove utility removes mapping coordinates or materials from the
currently selected objects.

Interface

UVW Click to remove UVW mapping from this object.

NOTE The utility can remove UVW mapping only from collapsed editable mesh
objects; that is, editable meshes with no modifiers.

Materials Click to remove material assignment from the selected objects.

Set Gray If this is on when you click the Materials button, the object color is
set to a neutral gray. Default=off.

Material Editor 
Main toolbar > Material Editor

Rendering menu > Material Editor

Keyboard > M

The Material Editor provides functions to create and edit materials on page
8041 and maps on page 8036.
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Materials create greater realism in a scene. A material describes how an object
reflects or transmits light. Material properties work hand-in-hand with light
properties; shading or rendering combine the two, simulating how the object
would look in a real-world setting.

You apply materials to individual objects or selection sets; a single scene can
contain many different materials.

NOTE Creating a new material clears the Undo/Redo lists.

Procedures

To view the Material Editor:

■  Click the Material Editor button on the main toolbar, or press M.
The Material Editor dialog has sample slots on page 5304 for viewing previews
of materials. When you first view the Material Editor, the material previews
have a uniform default color.

To give a material a different name:

■ Edit the name field that appears below the Material Editor toolbar.
The name of the active material appears in the title bar of the Material
Editor dialog. The name of the material is not a file name: it can contain
spaces, numbers, and special characters.

The name field displays only 16 characters, but a material name can be
longer than that.

To make a copy of a preview material:

■  On the Material Editor toolbar, click Make Material Copy on page
5346.

To get a material from a scene:

If a material that you want to change has been saved in the scene, but not in
the Material Editor, you can load the material by getting it from the scene.

1 Click a sample slot to make it active.

Be careful not to click the sample slot of a material you want to use later.
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2  On the Material Editor toolbar, click Get Material on page 5341.

A modeless Material/Map Browser on page 5290 is displayed.

3 In the Browse From group box at the upper left, make sure that either
Selected or Scene is chosen.

The Selected option lists only materials in the current selection. If no
objects are selected, the list of materials is blank.

The Scene option lists all the materials currently in the scene.

4 In the list of materials, double-click the name of the material you want.

You can also drag the material name to the sample slot.

The material you chose replaces the previous material in the active sample
slot.

WARNING When you get a material from a scene, it is initially a hot material on
page 8006.

To apply a material to objects in a scene:

■ Drag the sample slot that contains the material you want to apply to an
object in the scene.
If the object isn't selected, or if it's the only object selected in the scene,
the material is applied immediately. If the object is one of several selected
objects in the scene, the software prompts you to choose whether to apply
the material to the single object only or to the whole selection (the latter
is the default choice).

 You can also apply materials to a selection by clicking Assign Material
To Selection on page 5344 on the Material Editor toolbar.

NOTE When you apply a material to an object or selection, that material becomes
a hot material on page 8006 (its sample slot is displayed with white corner brackets).
When you change the properties of a hot material, the scene immediately updates
to reflect those changes. Every object with that material changes its appearance,
not just the objects in the current selection.

To remove a material from an object:

1  On the Material Editor toolbar, click Get Material.
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The Material/Map Browser appears.

2 Drag the entry NONE from the top of the list in the Browser to the object.

The object now has no material applied to it.

 To make a material no longer hot so it doesn't change the current scene,
click Make Material Copy on page 5346.

To put a material back into a scene:

■  On the Material Editor toolbar, click Put Material To Scene on page
5343.
The material in the active sample slot is now a hot material on page 8006.

The Put Material button is available only when (1) the material in the
active sample slot has the same name as a material in a scene, and (2) the
material in the active sample slot is not hot. In other words, this command
is meant to fit into the following overall sequence of handling materials:

■ You create a hot material either by applying it to objects in the scene
or by getting it from the scene.

■ You make a copy of the material.

■ You make changes to the copy of the material.

■ You update the scene by putting the changed material back into the
scene.
These steps are not as immediate as changing a material while it is hot,
but they help you avoid changing the scene's materials unintentionally
or in unexpected ways.

When a material in the Material Editor is applied to objects in the scene,
you can select the objects from the Material Editor.

To select objects that have the same material applied:

When a material in the Material Editor is applied to objects in the scene, you
can select the objects from the Material Editor.

1 Click a sample slot that contains a material in the scene.
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White corner brackets indicate materials that are in the scene.

2  Click Select By Material on page 5340.

This button is unavailable unless the active sample slot contains a material
in the scene.

The Select Objects dialog on page 228 opens. The names of objects with
the active material applied are highlighted when the dialog appears.

3 Click Select to select objects that have the active material applied to them.

You can also change the selection by choosing other objects. If you change
the selection, you can then apply the active material to newly selected
objects by clicking Assign Material To Selection on page 5344.

To get a material from a library:

1  On the Material Editor toolbar, click Get Material on page 5341.

A modeless Material/Map Browser on page 5290 is displayed.

2 In the Browse From group box at the upper left, choose Material Library
if necessary.

If you have opened a library, the list of materials shows the contents of
the library.

If you haven't opened a library, click Open in the File group on the
Browser. This opens the Open Material Library file dialog; use it to open
a material library. After you open the library, its contents appear in the
list of materials.

3 In the list of materials, double-click the name of the material you want.

You can also drag the name of the material to the sample slot.

The material you chose replaces the previous material in the active sample
slot.

To save a material in a library:

1 Click the sample slot that has the material you want to save.

2  On the Material Editor toolbar, click Put To Library on page 5348.

3 A Put To Library dialog on page 5372 appears.
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4 Change the material name or leave it as is, and then click OK.

The material is saved in the currently open library. If no library is open,
a new library is created. You can save the new library as a file using the
Material/Map Browser on page 5290 file controls.

Interface

The Material Library interface consists of a menu bar at the top, sample slots
(the spheres) below the menu bar, and toolbars along the bottom and side of
the sample slots. For links to topics describing these interface elements as well
as overviews of materials and maps, see the end of this section.

The Material Library interface also includes a number of rollouts whose
contents depend on the active material (click a material's sample slot to make
it active). Each rollout contains standard controls such as drop-down lists,
check boxes, numeric fields with spinners, and color swatches.

In many cases, associated with a control (typically to its right) is a map shortcut
button: a small, square, blank button, which you can click to apply a map to
the control. If you have assigned a map to a control, the button displays the
letter M. An uppercase M means that the corresponding map is assigned and
active. A lowercase m means that the map is assigned but inactive (turned
off). You turn maps on and off with the check boxes on the Maps rollout on
page 5414 (see this procedure on page ? and the one following it). You can
also right-click the map shortcut button to access functions such as copy and
paste (see Copying and Pasting: Right-Click Menu for Materials, Maps, Bitmaps,
and Colors on page 5301).
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For choosing materials, see Material/Map Browser on page 5290. For applying
materials using drag and drop techniques, see Dragging and Dropping Maps
and Materials on page 5310.

For an overview of how to use the Material Editor, see Designing Materials on
page 5260.

For the user interface elements in Material Editor and the different materials
and map types, see the following topics:

Material Editor Menu Bar on page 5321

Sample Slots on page 5304

Material Editor Tools on page 5317

Types of Materials on page 5379

Types of Maps on page 5767

For information about how to animate materials, see Animating Materials on
page 5361.

Material/Map Browser

Main toolbar > Material Editor > Get Material > Material/Map Browser

Rendering menu > Material/Map Browser

Material Editor > Click Material Type button or Map Type button. >
Material/Map Browser

Procedures on page 5293 Interface on page 5295

The Material/Map Browser lets you choose a material on page 8041, map on
page 8036, or mental ray shader on page 5974.

When you click Get Material on page 5341, the Browser that is displayed is
modeless (you can leave it displayed while you do other work). However,
when you display the Browser by clicking the Type on page 5361 button, a map
assignment button in the Environment dialog on page 6689, or from a projector
light (see Advanced Effects Rollout on page 5108), it appears as a modal dialog
with OK and Cancel buttons.

You can leave the modeless Browser displayed, and drag materials from its
listings to material or map sample slots and buttons in the user interface.
When the Browser displays a Material Library, you can also add materials to
the library by dragging them from the Material Editor sample slots on page
5304.
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When you double-click a material, map, or shader in the Browser, it places
that material, map, or shader in the Material Editor's active sample slot. It
automatically chooses between an instance or a copy, as follows:

■ Browsing New Materials: Creates a new material.

■ Browsing a Library: Makes a copy.

■ Browsing the Material Editor, Scene, or Selected: Depends on the status of
the map or material.

When you browse the Material Editor, the Scene, or Selected objects, the choice
between making a copy or an instance depends on the status of the material,
as follows:

■ If the material or map is already in the active slot, the Browser does
nothing.

■ If the material or map is in some other sample slot, the Browser puts a
copy in the active slot.

■ In all other cases, the Browser makes an instance of the material or map.

Browsing mental ray Materials and Maps

When you use the mental ray renderer on page 6230, you might want to use
the materials and shaders that provide effects for this renderer only. (The
default scanline renderer renders these materials and shaders only as black or
white, or it simply ignores their effects.) The Material/Map Browser lists mental
ray maps and materials only if you assign the mental ray renderer as the
currently active renderer.

Once you have enabled the renderer, when you use the Browser, it shows
mental ray materials and shaders. Materials are displayed with a yellow sphere,
rather than blue for standard materials, and shaders are displayed with a yellow
parallelogram, rather than green as for standard maps.
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mental ray maps in the browser's list are shown with yellow icons.

When you use the mental ray Connection rollout on page 5385, or other shader
buttons specific to mental ray materials and shaders, the shaders that appear
in the Browser's list are restricted to those that the mental ray renderer allows
for that particular shader component. By default, only shaders that ship with
3ds Max are listed. If you have acquired other shader libraries, you might see
the names of shaders that are not mentioned in this reference.

NOTE You can see the listing of materials, maps, or shaders that are incompatible
with the current renderer, if you turn on the Incompatible toggle in the Show
group, as described under “Interface,” below.

See also:

■ Material/Map Navigator  on page 5357
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Procedures

To navigate materials with the Browser:

TIP Use the Browser primarily in Root Only mode, to see only the top levels of
the materials. This provides a simpler view of your materials, and speeds redraws
when you're using any of the icon display modes. (You can also create thumbnails
to speed up redraws, as described below.)

1 In the Material Editor, choose any sample slot you want that contains a
complex, multilevel material.

2 In the Browser > Browse From group, choose Active Slot mode to display
all levels of the active sample slot.

3 Click any of the items in the Browser's material/map list to move to that
level of the current material.

4 When you want to switch to a different material, select its sample slot in
the Material Editor, and its hierarchy will appear in the Browser.

5 Again, click the items in the Browser to change levels.

To delete an assigned map:

1 While viewing the map parameters, click the Map Type button.

2 In the Material/Map Browser, choose NONE as the new map type.

TIP You can also remove a material or map by dragging the NONE item
from the Browser over to the object or map button.

To merge material libraries:

1 In the Browse From group, choose Mtl Library, and then click the Merge
button.

2 In the Merge Material Library dialog on page 5371, select a material library
other than the current library, or select a 3ds Max or VIZ Render (DRF
on page 7167) scene.

A Merge dialog on page 5370 is displayed, listing all materials in the specified
library, or all materials assigned to the 3ds Max or VIZ Render file. Below
the list are All and None buttons to help in the selection.
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3 Select the materials in the list that you want to merge, and then click
OK.

The selected materials are merged into the current material library.

4 Save the library to save your changes.

To save the sample spheres as thumbnail images:

1 Open the Browser. In the Browse From group, choose Mtl Library.

2  Choose View Small Icons.

3 Display all of the icons in the library by either scrolling through all of
them, or by enlarging the Browser so that all of the icons have been
displayed at least once.

The action of displaying the icons automatically creates thumbnails in
memory.

IMPORTANT If you want to include thumbnails of the sub-materials and
maps, be sure to turn off Root Only.

4 Save the library.

When you save the library, you save the thumbnail images of the samples
as they appeared in the Browser at that time. If you change any of the
materials or maps later, you must re-save the library in order to update
the thumbnails. If you do not re-save the library after altering or adding
a materials, the icon of the material will still appear correctly, but it will
be rerendered when it first appears in the Browser, while all the other
icons will appear immediately.
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Interface
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The Material/Map Browser contains the following controls:

Material/Map list The main part of the Material/Map Browser dialog is a
scrollable list of materials and maps. The list indicates a material with a blue
sphere, and indicates a map with a green parallelogram. When you list both
materials and maps, the materials are listed first.

NOTE Icons of materials and maps for which Show Standard/Hardware Map in
Viewport  on page 5350 is on are red.

Also, the names of instanced on page 8014 materials and maps appear in boldface.

Both of these effects are shown in the following illustration:

Text entry As you enter a material name in this field, the first matching text
item is selected in the list. Press Enter to select the next matching name, and
so on.

For example, if you enter ch when the list includes the material names Cherry
Red, Chrome Blue, and Chrome Zinc, Cherry Red is selected first. Press Enter,
and the Chrome Blue is selected. Press Enter again, and Chrome Zinc is selected.

The search is not case-sensitive.

Sample slot Below the text-entry field is a single sample slot. This displays a
sample of the current selection. You can drag the sample to any other sample
slot or material button. The sample slot display is interruptible, so you can
quickly click from one list item to the next without waiting. In addition, if
you complete the display of one sample, then move on to another sample,
when you return to the first sample, it displays instantly.

Tool buttons

The first part of this row of buttons controls how you view the list. The second
part is for managing material libraries.
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To speed up the display of the sample spheres in the Browser, the smaller of
the sample spheres (those displayed when you choose View Small Icons or
View List + Icons) can be saved as thumbnail images in the material library
file. (See the Procedures for this topic, above.)

Keep in mind that the saved thumbnails increase the size of the material
library file.

 View List Displays the materials and maps in list format. Blue spheres
are materials. Green parallelograms are maps. The green parallelograms turn
red if Show Map in Viewport is on for a material.

 View List + Icons Displays the materials and maps in a list with small
icons.

 View Small Icons Displays the materials and maps as small icons. As
you move the mouse over the icons, tooltip labels pop up, showing you the
name of the material or map.

 View Large Icons Displays the materials and maps as large icons.

The large icons are labeled with the name of the material or map and are
displayed using progressive refinement—samples are rendered quickly, with
large pixels, then rendered a second time in greater detail.

 Update Scene Materials from Library Updates materials in the scene
with the materials of the same name stored in the library.

When you click Update Scene Materials from Library, the Update Scene
Materials dialog on page 5377 is displayed. This dialog lists materials in the
library that have the same name as materials in the scene. In the list, select
the materials you want to update in the scene, and then click OK.

If no materials exist in the scene that match the names in the library, an alert
informs you of this.

This button is available only when the Browser is viewing a library.

 Delete from Library Removes the selected material or map from the
library display. The library on disk is not affected until you save it. Use Open
to reload the original library from disk. This button is only active when you
select a named material that exists in the current library.
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This button is available only when the Browser is viewing a library.

 Clear Material Library Removes all materials from the library display.
The library on disk is not affected until you save it. Use Open to reload the
original library from disk.

This button is available only when the Browser is viewing a library.

Browse From group

The controls in this group choose the source of the materials displayed in the
material/map list.

Material Library Displays the contents of a material library file from disk.
When you set this option, the buttons under File become active (see below).

You can also load a library from a MAX file. When browsing from the Material
Library in the Material/Map Browser, choose Open, and then choose 3ds Max
(*.max) from Files of type. Select and load a .max file. All materials assigned in
that scene are listed in the Browser. To convert the collection of materials to
a library file, click Save, and save it as a MAT (.mat) file.

Material Editor Displays the contents of the sample slots.

Active Slot Displays the contents of the currently active sample slot.

This option is unavailable in the modal version of the Browser.

When you choose this mode, all check boxes in the Show group box are made
available. The entire material and map tree of the active material is displayed,
regardless of the state of these check boxes in other Browse From modes.

You can also use Active Slot mode to navigate the hierarchy of the active
material. When Active Slot is chosen, clicking an item in the material/map
list moves Material Editor controls to that level of the material.

Selected Displays the material applied to the selected objects.

Scene Displays all materials applied to objects in the scene.

All maps assigned to the scene, including Environment Background or spotlight
projector maps, are displayed in the Browser list.

New Displays the set of material/map types for you to create a new material.
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Show group

These options filter what is displayed in the list. Either Materials or Maps is
always on, and both can be on at the same time. The first two options can be
unavailable, depending on the active Browse From and View settings.

Materials Turns display of materials and sub-materials on or off.

This is always unavailable in the modal version of the Browser.

Maps Turns display of maps on or off.

This is always unavailable in the modal version of the Browser.

Incompatible When on, displays materials or maps and shaders that are
incompatible with the currently active renderer. The incompatible materials
are displayed in gray. You can still assign incompatible materials, maps, or
shaders to buttons where they would be legal, but if you use the current
renderer, the results might not be correct. Default=off.

Root/Object group

Root Only When on, the material/map list displays only the root of the
material hierarchy. When off, the list displays the full hierarchy.

The default state of Root Only depends on how you display the Browser.
Generally, when you display the modeless Browser, you're selecting materials
rather than maps (to begin with), so Root Only is on. However, when you
display the modal Browser (by clicking a map button anywhere in the user
interface), Root Only is off so you can see all the maps.

By Object This is available only when you're browsing from either Scene or
Selected. When on, the list displays materials by their object assignment in
the scene. At the left are the names of the objects arranged alphabetically,
with a yellow cube icons as in Track View on page 3503. Applied materials are
shown as children of the objects. When off, the list displays only material
names.
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File group

This button group is displayed when you've chosen Material Library, Material
Editor, Selected, or Scene in the Browse From group. All four buttons are
displayed only when browsing from the Material Library; otherwise, only the
Save As button appears.

Open Opens a material library.

Merge Merges materials from another material library or scene. When you
click Merge, the Merge Material Library dialog on page 5371 is displayed. This
file dialog lets you choose a material library or a scene. When you choose a
library or scene to merge, the Merge dialog on page 5370 is displayed. This lets
you select which materials to merge. If there are duplicate names among the
materials you're merging, the Duplicate Name dialog on page 5368 is displayed
so you can resolve the name conflicts.

Save Saves the open material library.

Save As Saves the open material library under another name.

Display group

This group of radio buttons is displayed only when you've chosen New under
Browse From. It controls what types of maps the Browser displays in the
material/map list. (The Browser displays materials regardless of this setting.)

2D Maps Lists only 2D map types.

3D Maps Lists only 3D (procedural) on page 8097 map types.

Compositors Lists only compositor map types.

Color Mods Lists only color modifier map types.

Other Lists reflection and refraction map types.
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All (The default.) Lists all map types.

Copying and Pasting: Right-Click Menu for Materials,
Maps, Bitmaps, and Colors

Material Editor > Right-click a Type button, sub-materials button, map button,
bitmap button, or color swatch.

Elsewhere in the user interface > Right-click a map button or color swatch.

A set of right-click pop-up menus in the Material Editor (and elsewhere in the
program's user interface) lets you copy and paste, and otherwise manage
materials, maps, bitmaps, and colors.

You see these menus only if copy and paste actions are appropriate. For
example, if you copy a material and then right-click a map button, nothing
happens.

Material Right-Click Menu

When you right-click a button that represents a material, this menu appears.
This includes the Type button on page 5361 for a material, and sub-material
buttons such as you find in the Multi/Sub-Object material on page 5720, the
Blend material on page 5708, and others.

Cut Makes a copy of the material. If you right-click a sub-material button,
this also removes the material from that sub-material component. If you
right-click the Type button, Cut is equivalent to Copy.

Copy Makes a copy of the material.

Paste (Copy) Pastes a copy from the copy buffer.

This item doesn't appear if you haven't yet copied a material.

Paste (Instance) Pastes an instance from the copy buffer.
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This item doesn't appear if you haven't yet copied a material.

Clear If you right-click a sub-material button, Clear removes the material from
that sub-material component without making a copy of it. If you right-click
the Type button, Clear has no effect.

Map Right-Click Menu

When you right-click the button for a map component (a “map slot”), the
menu you see depends on whether a map has been assigned yet.

When a Map Has Been Assigned

The following menu appears if a map has been assigned:

Cut Removes the assigned map, and puts a copy of it in the copy buffer.

Copy Copies the map without removing it.

Paste (Copy) Pastes a copy from the copy buffer.

This item doesn't appear if you haven't yet copied a map.

Clear Removes the assigned map without copying it.

Open For bitmaps on page 5795, launches whichever application is associated
with the currently assigned 2D map.

This item does not appear for other map types such as procedural maps.

Reveal Location in Explorer Launches a copy of Windows Explorer to display
the folder where the map is saved.

When No Map Has Been Assigned

If no map has been assigned, all you can do is paste another:
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Paste (Copy) Pastes a copy from the copy buffer.

Paste (Instance) Pastes an instance from the copy buffer.

When No Map Has Been Either Assigned or Copied

If no map has been assigned and you haven't copied a map yet, then no
right-click menu appears at all.

Bitmap Right-Click Menu

This menu appears when you click a button that specifies an external bitmap
on page 7926. See Bitmap 2D Map on page 5795.

Copy Copies the bitmap.

Paste Pastes the bitmap from the copy buffer.

Open Launches whichever application is associated with the bitmap.

Reveal Location in Explorer Launches a copy of Windows Explorer to display
the folder where the bitmap is saved.

Color Swatch Right-Click Menu

This menu appears when you right-click a color swatch.

NOTE This menu does not apply to the VertexPaint modifier's Color Palette on
page 1984, which has its own right-click menu.
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Copy Copies the color.

Pastes Pastes a color from the copy buffer.

Sample Slots

Material Editor > Sample slots display

The sample slots let you maintain and preview materials on page 8041 and maps.
on page 8036 Each slot previews a single material or map. You can change the
material by using the Material Editor controls, and you can apply the material
to objects in the scene. The easiest way to do this is to drag the material from
the sample slot to objects in viewports. See Dragging and Dropping Maps and
Materials on page 5310.

IMPORTANT While the Material Editor can edit no more than 24 materials at a
time, a scene can contain an unlimited number of materials. When you are through
editing one material, and have applied it to objects in the scene, you can use that
sample slot to get on page 5341 a different material from the scene (or create a new
one) and then edit it.

You can display a sample slot in a window of its own. This magnifies the
sample slot, which can make it easier to preview the material. You can resize
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the magnified window to make it even larger. To magnify a sample slot,
double-click it, or right-click and choose Magnify from the pop-up menu. See
Sample Slot Right-Click Menu on page 5308.

The Material Editor has 24 sample slots. You can view them all at once, six at
a time (the default), or 15 at a time. When you view fewer than 24 slots at
once, scroll bars let you move among them. See Material Editor Options on
page 5335 and Sample Slot Right-Click Menu on page 5308.

A material in a slot is shown on a sample object. By default, the object is a
sphere. Use the Sample Type flyout on page 5328 to change the sample object.

Sample slot showing a material

By default, a standalone map in a slot fills the whole slot. This is when the
slot shows only a standalone map at the top of a tree; when the map is assigned
to a material, the slot shows it as part of the material, mapped to the sample
object. See Get Material  on page 5341 and Material Editor Options  on page 5335.

Sample slot showing a map

The Material Editor renders only the active sample sphere for the current
frame.
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Hot and Cool Materials

A sample slot is "hot" on page 8006 when the material in the slot is assigned to
one or more surfaces in the scene. When you use the Material Editor to adjust
a hot sample slot, the material in the scene changes at the same time.

The corners of a sample slot indicate whether the material is a hot material:

■ No triangle: The material is not used in the scene.

■ Outlined white triangle: The material is hot. In other words, it's instanced
in the scene. Changes you make to the material in the sample slot will
change the material displayed in the scene.

■ Solid white triangle: The material is not only hot, but is applied to the
currently selected object.

Left: "Hot" material applied to currently selected object.

Middle: "Hot" material assigned to scene but not to currently selected object.

Right: "Cool" material: active but not assigned to scene.

A material is "cool" on page 7943 if it is not applied to any object in the scene.

To make a hot sample slot cool, click Make Material Copy on page 5346. This
copies the material in the sample slot on top of itself so that it's no longer
used in the scene.

You can have the same material (with the same name) in more than one
sample slot, but only one slot containing that material can be hot. You can
have more than one hot sample slot, as long as each has a different material.

If you drag to copy a material from a hot slot to another slot, the destination
slot is cool, and the original slot remains hot.
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See also:

■ Sample Slot Right-Click Menu on page 5308

■ Dragging and Dropping Maps and Materials on page 5310

■ Creating a Custom Sample Object on page 5314

Procedures

To use a sample slot:

■ Click the sample slot to make it active.
The active sample slot is displayed with a white border around it.

The sample slot shows a sample object shaded with a material. (By default,
the sample object is a sphere.) The sample object is lit by a light source
above it and slightly toward the viewer. For the sphere, the highlight is in
the upper-left quadrant. The diffuse color shows most clearly above and
to the left of the highlight, shading toward the ambient color at the sphere's
lower right.

To change the preview shape:

1 Make sure the sample slot of the material you want to view is active.

2 Use the Sample Type flyout on page 5328 to choose the shape you want to
view. The flyout gives you three options: sphere (the default), cylinder,
or box.

The new shape is displayed in the sample slot, with the material mapped
to it.

To render the current mapping level:

1 Move to the level of the map hierarchy that you want to render.

2 Right-click in the sample slot, and choose Render Map from the pop-up
menu.

The Render Map dialog on page 5373 is displayed.

3 Choose Single or the range of frames you want to render.

4 In the Dimensions group box, specify the pixel resolution of the map.
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5 Click the Files button, and specify a path and file name for the file. Make
sure Save To File is on unless you want to see the image only in a Rendered
Frame Window  on page 6073.

6 Click Render.

A Rendered Frame Window appears displaying the map. If Save To File
is on, the image is also saved to disk.

Sample Slot Right-Click Menu

Material Editor > Right-click active sample slot.

When you right-click the active sample slot, a pop-up menu is displayed. For
other sample slots, click or right-click once to select them, then right-click to
use the pop-up menu.

The pop-up menu is available in magnified sample slot windows. See the
"Magnify" option, below.

Interface

The pop-up menu has these options:

Drag/Copy Sets dragging a sample slot to copy mode. When on, dragging a
sample slot copies the material from one sample slot to another, or from the
sample slot to an object in the scene or a material button.
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Drag/Rotate Sets dragging a sample slot to rotate mode. When on, dragging
in the sample slot rotates the sample object. This helps you preview the
material. Drag over the object to rotate it about its X or Y axis; drag in the
corners of the sample slot to rotate the object about its Z axis. In addition, if
you press Shift before dragging in the center, the rotation is constrained to
the vertical or horizontal axis, depending on your initial drag direction.

If you have a three-button mouse and are using Windows NT, the middle
mouse button rotates the sample object while Drag/Copy mode is active.

Reset Rotation Resets the sample object to its default orientation.

Render Map Renders the current map, creating a bitmap or an AVI file (if the
map is animated). Only the current map level renders. That is, the rendering
shows the image displayed when Show End Result is turned off.

If you're at a material level instead of a map level, this menu item is disabled.

Options Displays the Material Editor Options dialog on page 5335. This is an
alternative to clicking the Options button.

Magnify Generates a magnified view of the current sample slot. The magnified
sample is displayed in its own, floating (modeless) window. You can display
up to 24 magnified windows, but you can't display the same sample slot in
more than one magnified window at a time. You can resize magnify windows.
Clicking a magnify window activates the sample slot, and vice versa.

Shortcut Double-click a sample slot to display the magnified window.

The magnify window's title bar displays the contents of the editable material
name field on page 5360. It varies depending on which level of the material is
active.
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Auto Turn off to prevent the magnified window from updating automatically.
This can save rendering time, especially when you have resized the magnified
window to make it larger. Default=on.

Update Click to update the magnified window. This button is unavailable
unless Auto is turned off.

Dragging a different sample slot to the magnify window changes the contents
of the magnify window.

Sample Windows options

The Material Editor always has 24 sample slots available. You can choose to
display fewer sample slots at a larger size. When you do, scroll bars let you
move around among the sample slots.

3 X 2 Sample Windows Displays a 3 x 2 array of sample slots. (The default:
6 windows.)

5 X 3 Sample Windows Displays a 5 X 3 array of sample slots. (15 windows.)

6 X 4 Sample Windows Displays a 6 X 4 array of sample slots. (24 windows.)

Dragging and Dropping Maps and Materials

You can move materials from sample slots to objects using a drag-and-drop
operation. You can also drag to and from map and material buttons. See the
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following lists to determine where in the interface you can drag from and drag
to.

When dragging materials, use the Undo command on page 262 to cancel
material assignments.

Where You Can Drag From

■ Sample Slots on page 5304
The content you drag from a sample slot is always at the top level of the
sample slot, regardless of which level is currently displayed. If the sample
slot contains a material, you can't drag from the sample slot to a map
button, even if you're at the map level of the material.

■ Material preview and map preview

■ The Material Editor Type button on page 5361

■ Material/Map Browser on page 5290 lists (text or icon lists)
You can't drag from the modal version of the Browser (when OK and Cancel
buttons are present).

■ The sample slot in the Browser

■ Material map buttons (see below)

■ A projector light map button (see Advanced Effects Rollout on page 5108)

■ The Environment Background on page 6689 map button

■ Fog on page 6707 Color and Opacity map buttons

■ Displace modifier on page 1344 map buttons

Material Map Buttons

The material map buttons you can drag from include:

■ The buttons in the Maps rollout on page 5414

■ The small shortcut map buttons on the Basic Parameters rollouts on page
5406.

■ Any map buttons at any level.

■ Sub-material buttons, such as those found in the Multi/Sub-Object material
on page 5720.
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Where You Can Drag To

■ All of the items in the previous list.

■ Objects in viewports.
Drag from a material button, sample slot, or Browser listing into the
viewport and over an object. When you release the mouse, the material is
applied.

If you drag a material over two or more selected objects, an alert message
asks if you want to apply the material to the object or to the selection.
Choose the option you want, and click OK.

■ The Material Editor Type button on page 5361.
You can drag to the Type button only from the Browser. If the Type button
shows a standalone map, you can drag only a map to it. If it shows a
material type, you can drag only a material to it.

■ All of the items in the previous list, except that you can drag to the Browser
only when it displays a material library.
When the Browser is set to browse from a Material Library, dragging
materials and maps into the Browser adds them to the library.

■ Any palette in the Content Browser. You can drag individual materials,
selections of materials, or entire panels or palettes into the Content Browser.

■ A Face, Polygon, Patch, or Element sub-object selection of an editable
surfacemesh object (mesh, patch, or poly).

■ A Face, Polygon, Patch, or Element sub-object selection created by the Edit
Mesh modifier on page 1353 or Edit Patch on page 1360; or by one of these
selection modifiers: Mesh Select on page 1527, Patch Select on page 1592, or
Poly Select on page 1613.

See also:

■ Applying a Material to an Object on page 5278

■ Drag and Drop Sub-Object Material Assignment on page 5312

Drag and Drop Sub-Object Material Assignment

You can apply a material to a selection of renderable sub-objects, such as faces
in a mesh. In the Material Editor, you can use Assign Material to Selection on
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page 5344. You can also drag the material from the Material Editor or the
Material/Map Browser on page 5290 to the selected faces. This can create a new
Multi/Sub-Object material on page 5720 on the fly.

You can disable drag-and-drop of materials to sub-objects. To do so, go to the
General tab on page 7744 of the Preferences dialog on page 7743, and in the
Sub-Materials group, turn off Assign Automatically. This check box is on by
default.

How the Multi/Sub-Object Material Is Created

The Multi/Sub-Object material is created in one of three ways, depending on
what material is already applied to the selected sub-objects:

■ No material applied
If the selected faces have no material applied, a new Multi/Sub-Object
material is created. The dragged material becomes a sub-material in the
new material. If material IDs already exist, they are preserved.

■ Existing material applied (other than Multi/Sub-Object material)
A new Multi/Sub-Object material is created and applied to the selected
faces. The existing material is moved into the Multi/Sub-Object material
and becomes the first sub-material. Unselected faces get material ID #1,
the selected faces get material ID #2, and the dragged material becomes
part of the Multi/Sub-Object material. Existing material IDs are not
preserved.

■ Multi/sub-object material applied
If the existing Multi/Sub-Object material is already applied more than once
in the scene, the material is copied and the new copy is applied to the
selected faces.

If the Multi/Sub-Object material is only applied once in the scene, then
the existing material is used. The dragged material is added to the existing
Multi/Sub-Object material.

If the dragged material already is a part of the Multi/Sub-Object material,
then the selected faces receive the corresponding material ID number. If
the selected faces all have the same material ID number, and no unselected
faces are already using this number, then this number is used and the new
material replaces the old sub-material at this ID. Otherwise, a new material
ID number is assigned to the faces, and used for the dragged material. In
this case, any existing material IDs are preserved.
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Procedures

To drag materials onto sub-object selections:

1 In the Modify panel > Modifier Stack rollout, choose Face as the sub-object
level.

2 Select faces of an editable mesh object.

3 Drag a material from a Material Editor sample slot to the selected faces.

4 In the Modifier Stack rollout, click to turn off Sub-Object and return to
the object level.

5  On the Material Editor, click Pick Material From Object, then use
the eyedropper to get the material from the sphere.

The new Multi/Sub-Object material appears in the active sample slot.

Creating a Custom Sample Object

Material Editor > Right-click the active sample slot. > Right-click menu >
Options > Material Editor Options dialog

Material Editor > Material Editor Options > Material Editor Options dialog
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Custom sample object fits within a 100-unit cube

By default, the sample object in a sample slot is a sphere. You can use the
Sample Type flyout on page 5328 to change this to a cube or a cylinder. You can
also create a custom sample object by creating a 3ds Max scene that shows
the object.

Overview of Using a Custom Sample Object

See Procedures for more details.

The scene you create should contain a single object that fits into an imaginary
cube that is 100 units on each side. The object must be at the root level of the
scene: it can't be linked to other objects. If more than one object is in the
scene, only the first object listed in the Track View hierarchy is used as the
sample object.

If the object is of a type that doesn't have a Generate Mapping Coords check
box, apply a UVW Map modifier on page 1931 to it.

After you have saved the single-object scene as a MAX file, use the Custom
Sample Object group in the Material Editor Options dialog on page 5335 to
specify the file. When you specify the file, a new button is displayed at the
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right of the Sample Type flyout. This button, which shows an object with a
question mark, displays the sample object file you chose.

If the sample object scene contains only the object, sample slots display it
with default lighting. If the scene also contains a camera and lights, you can
use the camera to specify the view, and the lights to light the object as you
choose. Turn on Load Camera and/or Lights in the Custom Sample Object
group.

Procedures

To set up a custom sample object:

1 Create a scene with a single object, such as a pyramid.

The object should fit into an imaginary cube that is 100 units on each
side. Also, the object must be at the root level of the scene: it can't be
linked to other objects.

If more than one object is in the scene, the Material Editor uses the first
object listed in the Track View hierarchy.

2 If the object does not have built-in mapping coordinates (via a Generate
Mapping Coords check box), then assign a UVW Map modifier on page
1931 to it to provide mapping coordinates.

If the object has a Generate Mapping Coords check box, it's on by default,
and the Material Editor uses those coordinates. If you want to use
coordinates other than those built into the object, assign a UVW Map
modifier and set up your own coordinates.

3 Save the scene as a MAX file.

4 In the Material Editor Options dialog, click the File Name button in the
Custom Sample Object group box, and choose the file that contains your
object.

5 Activate the sample slot in which you want to see the custom object,
then choose the button at the far right of the Sample Type flyout.

Your custom object is displayed in the sample slot.

If the size of your object is not quite right for the sample slot, adjust its
size and save the scene again. To update the sample slot so it uses the
newly saved MAX file, open the Material Editor Options dialog, and then
click OK.
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To use a camera and lights with the custom sample object:

1 Create a camera in the scene that contains your sample object, and then
adjust the camera to show the object as you want it seen in sample slots.

TIP Viewports have a different aspect ratio than sample slots, so using Zoom
Extents on page 7594 on the sample object usually results in the object
appearing smaller in a sample slot. Perform Zoom Extents on the object, and
then before you save the file, zoom in a little farther so the object more than
fills the viewport. The sample slot projection is based on the width of the
sample object's geometry, not on the image in the viewport.

If more than one camera is in the scene, the Material Editor uses the first
camera listed in the Track View hierarchy.

2 If you want to use your own lighting rather than the default sample-slot
lighting, set up as many lights as you need. If you want to use the
sample-slot lighting, do not add any lights to the scene.

3 Save the MAX file.

4 In the Material Editor Options dialog, specify the file as the Custom
Sample Object file.

5 Turn on Load Camera and/or Lights.

Sample Slots set to use the custom object now display the object as seen
through the camera. If lights are in the scene, those lights are used in the
sample slot instead of the default lights.

Material Editor Tools

Main toolbar > Material Editor
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Material Editor tools below and to the right of the sample slots

Above the Material Editor sample slots on page 5304 is the menu bar. Below and
to the right of the sample slots are buttons and other controls that you use to
manage and change maps and materials.

Material Editor Menu Bar on page 5321

Reflectance and Transmittance Display on page 5324

NOTE These fields are not displayed unless you change a toggle in Preferences >
Advanced Lighting.

Buttons below the sample slots (the "toolbar")

Get Material on page 5341

Put Material to Scene on page 5343
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Assign Material to Selection on page 5344

Reset Map/Mtl to Default Settings on page 5345

Make Material Copy on page 5346

Make Unique on page 5346

Put to Library on page 5348

Material ID Channel on page 5348

Show Map in Viewport on page 5350

Show End Result on page 5356

Go to Parent on page 5356

Go Forward to Sibling on page 5357

Buttons to the right of the sample slots

Sample Type on page 5328

Backlight on page 5329

Background on page 5329

Sample UV Tiling on page 5330

Video Color Check on page 5332
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Make Preview, Play Preview, Save Preview on page 5333

Material Editor Options on page 5335

Select By Material on page 5340

Material/Map Navigator on page 5357

Controls below the toolbar

Pick Material from Object on page 5360

Material name field on page 5360

Material Type button on page 5361

Procedures

To use the Material Editor Options dialog:

1  Click Options on page 5335 to the right of the sample slots.

2 Set the options as you want, and then click OK.

To change the preview shape:

1 Activate the sample slot of the material you want to view.

2 Use the Sample Type flyout on page 5328 to choose the shape you want to
view.

The new shape is displayed in the sample slot, with the material mapped
to it.

The flyout gives you three options: sphere (the default), cylinder, or box.
An additional custom object option is available if you define a custom
object as described in Creating a Custom Sample Object on page 5314.
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Material Editor Menu Bar

Material Editor > Menu bar

The Material Editor menu bar appears at the top of the Material Editor window.
It provides another way to invoke the various Material Editor tools.

Material Menu

The Material menu provides the most commonly used Material Editor tools.

■ Get Material on page 5341

■ Pick from Object on page 5360

■ Select By Material  on page 5340

■ Highlight Assets in ATS Dialog If the active material uses maps that are
tracked assets on page 7099 (typically bitmap textures), opens the Asset
Tracking dialog with the assets highlighted.

■ Assign to Selection on page 5344

■ Put to Scene on page 5343

■ Put to Library on page 5348

■ Change Material/Map Type Equivalent to clicking the Material Type
Button on page 5361.

■ Make Material Copy on page 5346

■ Launch Magnify Window Equivalent to double-clicking the active sample
slot on page 5304, or choosing Magnify on its right-click menu on page 5308.

■ Save as .FX File See DirectX Manager Rollout on page 5393.

■ Make Preview on page 5333

■ View Preview on page 5333

■ Save Preview on page 5333

■ Show End Result on page 5356

■ Show Materials in Viewport As on page 173
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■ Reset Sample Slot Rotation Returns the active sample slot's object to its
default orientation; equivalent to choosing Reset Rotation on the sample
slot right-click menu on page 5308.

■ Update Active Material If Material Editor Options dialog on page 5335 >
Update Active Only is on, choosing this updates the active material in its
sample slot.

Navigation Menu

The Navigation menu provides tools that navigate a material's hierarchy.

■ Go to Parent on page 5356

■ Go Forward to Sibling on page 5357

■ Go Backward to Sibling Like Go Forward To Sibling, but navigates to the
preceding sibling map in the tree instead of the succeeding one.

Options Menu

The Options menu provides some additional tools and display choices.

■ Propagate Materials to Instances on page 5328

■ Manual Update Toggle Equivalent to the Manual Update toggle in the
Material Editor Options dialog on page 5335.

■ Copy/Rotate Drag Mode Toggle Equivalent to choosing either Drag/Copy
or Drag/Rotate on the sample slot right-click menu on page 5308.

■ Background on page 5329

■ Custom Background Toggle If you have used the Material Editor Options
dialog on page 5335 to assign a custom background, this toggles its display.

■ Backlight on page 5329

■ Cycle 3X2, 5X3, 6X4 Sample Slots Cycles through the equivalent choices
on the sample slot right-click menu on page 5308.

■ Options Opens the Material Editor Options dialog on page 5335.
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Utilities Menu

The Utilities menu provides map rendering and selecting objects by material.

■ Render Map Equivalent to choosing Render Map on the sample slot
right-click menu on page 5308.

■ Select Objects by Material on page 5340

■ Clean MultiMaterial on page 6052

■ Instance Duplicate Map on page 6058

■ Reset Material Editor Slots Replaces all materials in the Material Editor
with the default material type. This action is not undoable, but you can
restore the previous state of the Material Editor with the Restore Material
Editor Slots command (see below).

■ Condense Material Editor Slots Sets all unused materials in the Material
Editor to the default type, retaining only materials in the scene and moving
those materials to the first slots in the editor. This action is not undoable,
but you can restore the previous state of the Material Editor with the Restore
Material Editor Slots command (see below).

■ Restore Material Editor Slots When you use either of the two previous
commands, 3ds Max saves the current state of the Material Editor in a
buffer; using this command restores the state of the editor using the buffer
contents.

TIP The buffer that holds the material definitions survives the File menu > Reset
command. Thus, if you use either the Reset Material Editor Slots or the
Condense Material Editor Slots function, and then reset 3ds Max, you can then
use Restore Material Editor Slots to bring all materials back into the Material
Editor. This makes it easy to use the same materials in different projects.

For best results, follow this procedure:

1 Save your scene.

2 Use the Reset Material Editor Slots or Condense Material Editor Slots
function.

3 Reset 3ds Max. When prompted to save the scene, click No. Otherwise,
you might lose material definitions in the Material Editor that were
saved with the scene.

4 Open the Material Editor and choose Utilities menu > Restore Material
Editor Slots.
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The Material Editor status before step 2 is restored.

Reflectance and Transmittance Display

Material Editor > Reflectance and Transmittance fields (below the sample slots)

These fields show the reflectance and transmittance of the active material.
Both the average value and the maximum value are shown.

NOTE These fields appear only when you turn on Material Editor > Display
Reflectance & Transmittance Information on the Radiosity panel on page 7786 of
the Preferences dialog.

These fields can change according to the current Show End Result setting on
page 5356. When Show End Result is off, the reflectance and transmittance show
the properties of the current element in the material hierarchy, not the
properties of the material overall.

The reflectance and transmittance values of a material are particularly
important when you are preparing a radiosity solution on page 6168 to obtain
a physically accurate lighting simulation. If a material’s reflectance or
transmittance values are not what your scene needs, you need to adjust these
values.
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Materials and Radiosity

Upper left: Washed-out walls due to high reflectance.

Right: Better radiosity achieved by reducing the HSV Value (V) of materials in the scene.

To get good radiosity results, keep these points in mind as you design materials:

■ Before you generate a radiosity solution, check the reflectance value of all
materials in the scene, to make sure it is not too high. The reflectance of
a material determines how much of the light energy it receives is
subsequently used in the radiosity calculation. Keep this value within the
range of the physical materials you are simulating. (See the table in the
description of “Reflectance,” below.)

■ Don’t be concerned if a material preview seems too dark. For example, a
white wall with the maximum recommended reflectance of 80% appears
gray. The color balance will be adjusted correctly by the exposure control
on page 6732 in the final rendering.

■ Bitmaps used as diffuse textures have already been illuminated by the
scanner, digital camera, or paint program in which you created them. To
bring them into the proper reflectance range, you might have to dim them
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by reducing the RGB Level value in the bitmap’s Output rollout on page
5774.

Left: Wood grain bitmap as originally photographed has too high a reflectance.

Right: Reducing the RGB Level value reduces the map’s reflectance.

Interface

Reflectance Reflectance is the percentage of diffuse light energy that is
reflected from a material. When you increase a material’s HSV value (V), the
material reflects more diffuse light. Decreasing a material’s Opacity also
decreases its reflectance.

Typically, the reflectance of a material should never be greater than 85%. this
is an unusually high value that will lead to poor-quality renderings. In the
real world, even the whitest wall reflects no more than 80% of the light it
receives.

One source of high reflectance can be a map assigned to the material’s diffuse
component. For example, a white tile bitmap might create high reflectance.
In this case, you can reduce reflectance by reducing the RGB Level in the
bitmap’s Output rollout.

An alternate way to reduce a bitmapped material’s reflectance is to set the
diffuse color of the material to black, and then reduce the diffuse map’s
Amount (in the parent material’s Maps rollout on page 5414). You can use this
method to reduce the reflectance of 3D procedural maps on page 5860 as well.
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Here are some typical reflectance ranges for common materials:

MaximumMinimumMaterial

70%20%Ceramic

70%20%Fabric

50%20%Masonry

90%30%Metal

80%30%Paint

70%30%Paper

80%20%Plastic

70%20%Stone

50%20%Wood

Transmittance Transmittance is the amount of light energy transmitted
through a material. A completely opaque material has 0% transmittance.

When the material is transparent (like clear glass), the energy transmitted is
specular, and light passes directly through the material (subject to refraction).
The value of specular transmittance is an interaction between the material’s
Opacity value on page 5442 and its filter color on page 7976. When the filter color
is pure white, specular transmittance is the inverse of Opacity.

When the material is translucent (like frosted glass), the energy transmitted
is diffuse, and scattered in all directions. The value of diffuse transmittance is
based on the HSV value (V) of the translucent color on page 5447. Diffuse
transmittance happens only for materials that use the Translucent shader on
page 5434, or Raytrace materials on page 5490, that specify translucency.

Usually, when a material has high transmittance, it has low reflectance, and
the other way around.
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Sample Type 

Material Editor > Sample Type

The Sample Type flyout lets you choose which geometry to display in the
active sample slot on page 5304. This flyout has three buttons:

■  Sphere (the default) Displays the material on a sphere.

■  Cylinder Displays the material on a cylinder.

■  Cube Displays the material on a cube.

■  Custom Displays the material on a custom object. This button
appears only if you have used the Material Editor Options dialog on page
5335 to specify a custom object for sample slots.

See also:

■ Creating a Custom Sample Object on page 5314

Propagate Materials to Instances

Material Editor > Options menu > Propagate Materials to Instances

When Propagate Materials To Instances is on, any material assignment you
make will be propagated to all instances on page 8014 of the object in your
scene, including imported AutoCAD blocks and ADT style-based objects; these
object types are common in DRF files on page 7167. Assignments are also
propagated to instances of Revit objects and of other instances that you've
made in the current scene.

When Propagate Materials To Instances is off, materials are assigned in
traditional 3ds Max fashion; each object has a unique material assignment.

5328 | Chapter 19   Material Editor, Materials, and Maps



Backlight 

Material Editor > Backlight

Material Editor menu > Options menu > Backlight

Left: Backlight on

Right: Backlight off

Turning on Backlight adds a backlight to the active sample slot. This button
is on by default.

The effect is most easily seen with the sample spheres, where the backlight
highlights the lower-right edge of the sphere.

Backlight is especially useful whenever you're creating metal on page 5427 and
Strauss on page 5431 materials. Backlight lets you see and adjust the specular
highlight created by glancing light, which is much brighter on metals.

Sample Slot Background 

Material Editor > Background
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Material Editor menu > Options menu > Background

Left: Background on

Right: Background off

Turning on Background adds a multicolored checkered background to the
active sample slot. The pattern background is helpful when you want to see
effects of opacity and transparency.

The Material Editor Options dialog on page 5335 also lets you assign a bitmap
to use as a custom background.

Sample UV Tiling 

Material Editor > Sample UV Tiling
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1x1, 2x2, and 3x3 sample tiling

The buttons on the Sample UV Tiling flyout adjust the repetition of the map
on page 8036 pattern on the sample object in the active sample slot.

The tiling pattern you set with this option affects only the sample slot. It has
no effect on the tiling on the geometry in the scene, which you control with
parameters in the map's own coordinates rollout.

■  1 x 1 (the default) Tile once in the U dimension and once in V.
This is equivalent to no tiling at all.

■  2 x 2 Tile twice in U and twice in V.

■  3 x 3 Tile three times in U and three times in V.

■  4 x 4 Tile four times in U and four times in V.

The buttons specify the number of times the pattern repeats over the surface
of the sample object. Because maps are mapped spherically around the sample
sphere, the tiling on page 8148 repetition covers the entire surface of the sphere.
The sample cylinder maps cylindrically. The sample cube uses box mapping:
the tiling appears on each side of the cube. Custom sample objects use the
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default mapping coordinates for that kind of object, unless the object has a
UVW Map modifier on page 1931 applied to it, in which case the modifier
controls the mapping.

This flyout is unavailable when the sample slot displays a standalone (top-level)
map.

See also:

■ Creating a Custom Sample Object on page 5314

Video Color Check 

Material Editor > Video Color Check

Left: Material with oversaturated colors

Right: Video color check shows black areas that are beyond the video threshold

Video Color Check checks the material on the sample object for colors that
are beyond the safe NTSC on page 8059 or PAL on page 8078 threshold.

Such colors tend to blur or fuzz when transferred from computer to video.
Pixels containing these "illegal" or "hot" colors are flagged on the sample object.
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You can have 3ds Max correct illegal colors automatically when you render,
depending on the settings in the Rendering tab on page 7768 of the
Customize/Preferences dialog on page 7743.

Use this option as a guide only. The colors in a rendered scene depend not
only on the material color but also on the intensity and color of the lighting.
A material that shows as safe in the sample slot might become illegal if
rendered under several bright lights. A safe practice for video is to use colors
whose saturation is less than 80 to 85 percent.

Procedures

To check for illegal video colors:

1  On the Material Editor, turn on Video Color Check on page 5332.

The active sample slot now renders "illegal" pixels as black. Illegal pixels
have a color that is beyond the safe video threshold.

If Video Color Check detects illegal colors, try reducing the saturation of
the material colors in question.

2 You can also check for legal video colors when you render a scene.

To change the video system:

NTSC on page 8059 is the default video system to check. You can change the
video checking to PAL on page 8078.

■ In the Tools menu > Options > Options dialog > Rendering panel on page
7768 > Video Color Check group, change the setting to PAL.
The sample slot does not automatically update when you change the video
system preference. Turn video checking off and back on to see the change.

NOTE The Rendering panel also shows options for choosing alternate ways
to display illegal pixels. These apply to renderings only, not to the sample slots
in the Material Editor.

Make Preview, Play Preview, Save Preview 

Material Editor > Make/Play/Save Preview flyout
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Material Editor menu > Material menu > Make Preview, View Preview, or Save
Preview

You can use animated maps to add movement to a scene. For example, to
simulate a sky view, you could map an animation of moving clouds to a
clerestory window. The Make Preview options let you experiment with the
effect in the Material Editor before you apply it to your scene.

The buttons on the Make Preview, Play Preview, Save Preview flyout let you
preview the effect of an animated map on the object in a sample slot (see
Sample Type on page 5328 for alternatives to the default sphere.) You can use
an AVI file on page 7326, or IFL file on page 7339 as a source for the animation.
The finished preview is saved as a new AVI file and automatically played back.
You can also view the preview in a sample slot by dragging the time slider.

This flyout has three options:

■  Make Preview Displays a Create Material Preview dialog on page
5366 to create an AVI file of the animated material.
When the preview is complete, it is saved as _medit.avi in the \previews
subdirectory. The file is then opened in the Windows Media Player and
played back.

Without this option, the only other way to preview a complex animated
material in real time is to use the renderer on page 6121 to render an animated
sequence and save it to an AVI file, a digital disk recorder, or a video tape
recorder.

■  Play Preview Uses the Windows Media Player to play the current
_medit.avi preview file in the \previews subdirectory.

■  Save Preview Saves the _medit.avi preview to an AVI file of a
different name in the \previews subdirectory.

Procedures

To create a preview of an animated material:

1 Choose Make Preview from the flyout.

2 In the Create Material Preview dialog, set the preview conditions you
want, and then click OK.
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The preview is created, and then plays.

To play back a preview of an animated material:

■ Choose Play Preview from the flyout.
The Material Editor starts the Windows Media Player. The Player then loads
the current _medit.avi preview file in the \previews subdirectory and plays
it in a separate window.

To view an animated material in a sample slot:

■ Drag the time slider through the range of frames.
By default, all sample slots with animated maps update at the same time.
To change this, see Material Editor Options Dialog on page 5335.

To save a preview under a different name:

1 Choose Save Preview from the flyout.

The Material Editor displays a File Save dialog.

2 Enter a new name for the preview, and then click OK to save the file in
the \previews subdirectory.

To play a renamed preview:

1 Choose Tools menu > Display Image.

2 In the View File dialog, change to the \previews subdirectory.

3 Select the renamed preview file and click Open.

The preview is played in a separate window.

Material Editor Options 

Material Editor > Material Editor Options

Material Editor menu > Options menu > Options

This button displays the Material Editor Options dialog to let help you control
how materials and maps are displayed in the sample slots on page 5304.
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These settings are “sticky”; they survive a reset, and even quitting and restarting
3ds Max.

NOTE  The controls to assign a renderer for the sample slots are on the Assign
Renderer rollout on page 6135.

Interface
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Manual Update When on, the sample slots don't update their contents until
you click them. This option affects only the updating of the sample slots; it
doesn't affect the icon displays in the Browser. Default=off.

Don't Animate When on, animated maps are not updated in the sample slots
while you play an animation or drag the time slider. However, the animation
is updated to the current frame when you stop the animation or release the
time slider. An animated map can use an AVI file on page 7326 or IFL file on
page 7339as a source. Default=off.

Animate Active Only When on, only the active sample slot is animated when
you play an animation or drag the time slider. This option is good for situations
where you have multiple animated materials in the Material Editor, but you
only need to see one at a time. This check box is unavailable when Don’t
Animate is on. Default=off.

Update Active Only When on, sample slots do not load or generate maps
until you make one sample slot active. This can save time while you use the
Material Editor, especially when your scene uses a lot of materials with maps.
Default=off.

Antialias Turns on antialiasing on page 7904in the sample slots. Default=off.

If the mental ray renderer is used to render sample slots, this setting is
disregarded. The mental ray renderer's sampling values control antialiasing.

Progressive Refinement Turns on progressive refinement in the sample slots.
When on, samples are rendered quickly, with large pixels, then rendered a
second time in greater detail. Default=off.

Simple Multi Display Below Top Level When on, the sample sphere for a
Multi/Sub-Object material displays the multiple patches only at the top level
of the material. The sub-materials are displayed over the entire sphere. When
you use nested Multi/Sub-Object materials, the multiple patches again appear
at the top level of the nested material, but the sample sphere is again whole
when displaying any of the sub-materials. Default=on.

Display Maps as 2D When on, sample slots display maps, including standalone
maps, in 2D. The map fills the entire slot. When off, maps are displayed on
the sample object, as materials are. Default=on.

Custom Background Lets you specify a custom background for the sample
slots, instead of the default checkers background. Click the file-assignment
button to display a file dialog from which you can select the custom
background. This can be any bitmap format supported by 3ds Max. Turn on
Custom Background to use the new background instead of the checkered

Material Editor Tools | 5337



background. The custom background is stored in the 3dsmax.ini on page 83
file, so it is available from session to session. Default=off.

Display Multi/Sub-Object Material Propagation Warning Toggles display
of warning dialog when you apply a Multi/Sub-Object material on page 5720 to
an instanced ADT style-based object.

Auto-Select Texture Map Size When on, and you have a material that uses
a texture map set to Use Real-World Scale, ensures that the map will be
displayed correctly on the sample sphere. Turn off to be able to enable Use
Real-World Map Size For Geometry Samples (see following).

NOTE If a material uses several texture maps at different levels, and only one is
set to Use Real-World Scale, the sample sphere will render with real-world size
coordinates.

Use Real-World Map Size For Geometry Samples This is a global setting that
allows you to manually choose which style of texture coordinates are used.
When on, real-world coordinates are used for the sample slot display.
Otherwise, the old style of 3ds Max mapping coordinates is active. When off,
you must turn on Use Real-World Scale on the map's Coordinates rollout to
see the sample sphere as you'd expect. Available only when Auto-Select Texture
Map Size (above) is off. Default=off.

Top Light color/Back Light color Specify the two lights used in the sample
slots. Click the color swatch to alter the color of either light. Adjust the
Multiplier spinners to multiply the values (intensity) of the lights.

Use the Default buttons to return to the initial settings.

Ambient Light Shows the color of ambient light on page 7906 used in the
sample slots. Click the color swatch to change the color. When the lock button
is on, changing the Ambient Light color here or on the Environment panel
on page 6689 changes both; when off, changing one setting does not affect the
other.

Use the Default button to return to the initial setting.

Background Intensity Sets the background intensity in the sample slots. The
range is from 0 (black) to 1 (white). Default=0.2.

Use the Default button to return to the initial setting.

Render Sample Size Sets the scale of the sample sphere to any size, making
it consistent with the object or objects in the scene that have the texture on
them. This setting affects how 2D and 3D maps are displayed providing that
the sample spheres are set to display real-world scale.
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NOTE The size is scaled to use the current units.

This is a global option that affects all the sample slots. Default=100.0 (Imperial
units) and 2.54m (Metric units).

Use the Default button to return to the initial setting.

Default Texture Size Controls the initial size (both height and width) of a
newly created real-world texture. You see the result of changing this option
only when you create a new texture in a material; the change appears in the
Coordinates rollout on page 5782. Default=48.0 (Imperial units) and 1.219m
(Metric units).

NOTE This setting applies to real-world textures only. For the default size to be
applied to newly created textures, the Preferences dialog > General panel > Use
Real-World Texture Coordinates check box must be on.

Use the Default button to return to the initial setting.

DirectX Shader group

These options affect the viewport behavior of the DirectX 9 Shader material
on page 5758.

Force Software Rendering When on, forces DirectX 9 Shader materials to
use the selected software render style for viewports. When off, the FX file
specified in the DirectX 9 Shader is used unless the material's local Force
Software Rendering toggle is on. Default=off.

Shade Selected When Force Software Rendering is on, selected objects, and
only selected objects, are shaded by the DirectX 9 Shader material. This toggle
is unavailable unless Force Software Rendering is on. Default=off.

Custom Sample Object group

Controls in this group let you specify a custom sample object on page 5314 to
use in the sample slots on page 5304.

File Name Selects the MAX scene file.

The scene should contain a single unlinked object that fits in an imaginary
cube 100 units on a side. The object must be either a primitive with a Generate
Mapping Coords. check box, or have a UVW Map modifier on page 1931 applied
to it. The scene can contain a camera and lights.

Load Camera and/or Lights Turn on to have sample slots use the camera
and lights in the scene, instead of the default sample slot lighting.
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Slots group

These options let you choose how many sample slots to display at a time.

The Material Editor always has 24 sample slots available. You can choose to
display fewer sample slots at a larger size. When you do, scroll bars let you
move around among the sample slots.

3 X 2 Specifies a 3 x 2 array of sample slots. (The default: 6 windows.)

5 X 3 Specifies a 5 X 3 array of sample slots. (15 windows.)

6 X 4 Specifies a 6 X 4 array of sample slots. (24 windows.)

Apply Applies the current settings, except for changes to the Slots group,
without leaving the Material Editor Options dialog. This is useful when you
adjust lighting values for the sample slots.

OK Closes the dialog and applies any changes you made.

Cancel Closes the dialog and cancels any changes you made, including changes
you applied with the Apply button.

Select By Material 

Material Editor vertical toolbar > Select By Material button

Material Editor > Material menu > Select by Material

Material Editor > Utilities menu > Select Objects by Material

Select By Material allows you to select objects based on the active material in
the Material Editor. This command is unavailable unless the active sample
slot contains a material used in the scene.

Choosing this command opens the Select Objects dialog, which works like
Select From Scene  on page 228. All objects that have the selected material
applied to them are highlighted in the list.

NOTE Hidden objects don't appear in this list, even if the material is applied to
them. However, in the Material/Map Browser on page 5290, you can choose Browse
From: Scene, turn on By Object, and then browse from the scene. This lists all
objects in the scene, hidden and unhidden, along with their assigned materials.
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Procedures

To select objects that have the same material applied:

1 Click a sample slot that contains a material in the scene.

White corner brackets indicate materials that are in the scene.

2  Click Select By Material on page 5340 in the Material Editor.

This button is unavailable unless the active sample slot contains a material
in the scene.

The Select Objects dialog on page 228 opens. The names of objects with
the active material applied are highlighted.

3 Click Select to select objects with the active material applied.

You can also change the selection by choosing other objects. If you change
the selection, you must then click Assign Material To Selection on page
5344 to apply the active material to newly selected objects.

Get Material 

Material Editor > Get Material

Material Editor menu > Material menu > Get Material

Get Material displays the Material/Map Browser on page 5290 to allow you to
choose a material on page 8041 or map on page 8036.

Procedures

To get a material from a scene:

1 Click a sample slot to make it active.

Be careful not to click the sample slot of a material you want to use later.

2  On the Material Editor toolbar, click Get Material on page 5341.

A modeless Material/Map Browser on page 5290 is displayed.

3 In the Browse From group box at the upper left, make sure that either
Selected or Scene is chosen.
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The Selected option lists only materials in the current selection. If no
objects are selected, the list of materials is blank.

The Scene option lists all the materials currently in the scene.

4 In the list of materials, double-click the name of the material you want
to get.

You can also drag the material name to the sample slot.

The material you chose replaces the previous material in the active sample
slot.

WARNING When you get a material from a scene, initially it is a hot on page 8006
material.

To get a material from a library:

1  On the Material Editor toolbar, click Get Material on page 5341.

A modeless Material/Map Browser on page 5290 is displayed.

2 In the Browse From group box at the upper left, make sure that Material
Library is chosen.

If you have opened a library, the list of materials shows the contents of
the library.

If you haven't opened a library, click Open in the file area of the Browser.
A file dialog is displayed. Choose a library. After you open the library,
the list of materials updates to show the library contents.

NOTE Open also lets you get materials from a 3ds Max scene (a .max file).

3 In the list of materials, double-click the name of the material you want
to get.

You can also drag the name of the material to the sample slot.

The material you chose replaces the previous material in the active sample
slot.

To create a standalone map tree:

1 Activate a sample slot.

2  On the Material Editor toolbar, click Get Material.
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3 In the Material/Map Browser on page 5290, make sure Browse From is set
to New.

4 In the Show group box, turn off Materials so only maps are displayed in
the list.

5 Double-click the name of the map type (not a material type) you want
to use, or drag the map to a sample slot.

The sample slot now contains a standalone map not associated with
material parameters.

6 Use the Material Editor to modify the map as you would any other map.

By default, the sample slots distinguish maps from materials by displaying
maps as 2D surfaces without lighting or shading.

To remove a material from an object:

1  On the Material Editor toolbar, click Get Material.

The Material/Map Browser appears.

2 Drag the entry NONE from the top of the list in the Browser to the object.

The object now has no material applied to it.

Put Material to Scene 

Material Editor > Put Material to Scene

Material Editor menu > Material menu > Put to Scene

Put Material To Scene updates a material in the scene after you edit the
material. Put Material To Scene is available only when:

■ The material in the active sample slot has the same name as a material in
a scene.

■ The material in the active sample slot is not hot.
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In other words, this command is intended to fit into the overall sequence of
handling materials:

■ You create a hot material either by applying it to objects in the scene or
by getting it from the scene.

■ You make a copy of the material.

■ You make changes to the copy of the material.

■ You update the scene by putting the changed material back into the scene.

Notes

■ If you apply a mapped material to a parametric object whose Generate
Mapping Coords option is off, the software automatically turns on mapping
coordinates at render time. In addition, if you apply a mapped material
with Show Map in Viewport active to an object, that object's Generate
Mapping Coords option is turned on if necessary.

■ The Show Map In Viewport flag is now saved with individual materials,
so you can drag mapped materials from the modeless Browser onto objects
in your scene, and the mapping appears in the viewports.

Procedures

To put a material back into a scene:

■  On the Material Editor toolbar, click Put Material To Scene.
The material in the active sample slot is now a hot material on page 8006.

Assign Material to Selection 

Material Editor > Assign Material to Selection

Material Editor menu > Material menu > Assign to Selection

Assign Material to Selection applies the material in the active sample slot to
the currently selected object or objects in the scene. At the same time, the
sample slot becomes hot on page 8006.
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If you apply a mapped material to a parametric object whose Generate Mapping
Coords option is off, the software automatically turns on mapping coordinates
at render time. In addition, if you apply a mapped material with Show Map
In Viewport on page 5350 active to a parametric object, that object's Generate
Mapping Coords option is turned on if necessary.

The Show Map In Viewport flag is saved with individual materials, so when
you drag mapped materials from the modeless Browser on page 5290 onto objects
in your scene, the mapping appears in the viewports.

The Undo command works for material assignment.

Procedures

To apply a material to objects in a scene:

1 Select the sample slot that contains the material you want to apply.

2 Select the objects you want to apply the material to.

3 Do either of the following:

■ Drag from the sample slot to the objects. If more than one object is
selected, you are asked whether you want to apply to the single object
or to the whole selection.

■  Click Assign Material To Selection on page 5344 on the Material
Editor toolbar.

WARNING When you apply a material to an object or selection, that material
becomes a hot material on page 8006. When you change the material's properties,
the scene immediately updates to reflect those changes. Any object with that
material will change its appearance, not just the objects in the current selection.
When a material is hot, its sample slot is displayed with white corner brackets.

 To make a material no longer hot so it doesn't change the current scene,
click Make Material Copy on page 5346.

Reset Map/Mtl to Default Settings 

Material Editor > Reset Map/Mtl to Default Settings
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Reset Map/Mtl to Default Settings resets the values for the map or material in
the active sample slot.

The material colors are removed and set to shades of gray. Glossiness, opacity,
and so on are reset to their default values. Maps assigned to the material are
removed.

If you are at a map level, this button resets the map to default values.

Reset changes the name on page 5360 only when this field names a material used
in the scene.

Make Material Copy 

Material Editor > Make Material Copy

Material Editor menu > Material menu > Make Material Copy

Make Material Copy "cools" on page 7943 the current hot on page 8006 sample
slot by copying the material to itself.

The sample slot is no longer hot, but the material retains its properties and
name. You can adjust the material without affecting it in the scene. Once
you've got what you want, you can click Put Material to Scene on page 5343 to
update the material in the scene and change the sample slot to hot again.

Make Unique (Material Editor) 

Material Editor > Make Unique

Make Unique makes a map instance on page 8014 into a unique copy. It also
makes an instanced sub-material into a unique, standalone sub-material. It
gives the sub-material a new material name. A sub-material is a material within
a Multi/Sub-Object material on page 5720.

Using Make Unique prevents changes to the top-level material instance from
affecting the sub-material instance within the Multi/Sub-Object material.

You can also use Make Unique at the map level, when a map is instanced to
different components of the same material.
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NOTE If you drag an instanced map to a Material Editor sample slot, the Make
Unique button will not be available, because it is not clear from the context what
it would be unique relative to. Instead, you need to bring one of the parent maps
or materials into the Material Editor, browse down into the map, and then make
the map unique relative to that parent.

Procedures

Example: Create an instanced sub-material:

1  Create a box and a sphere.

2  Open the Material Editor.

3 Choose a sample slot, click the Material Type button, choose
Multi/Sub-Object in the Material/Map Browser, and then click OK.

4  Select the box, and then apply the new Multi/Sub-Object
material to it.

5 Drag one of the Sub-Material buttons from the Material Editor to the
sphere.

6  Choose a different sample slot, and use the Pick Material From Object
button to get the sub-material applied to the sphere.

At this point, the material applied to the sphere and the sub-material are
instances of each other.

7 Go to the parameters for the instanced sub-material by clicking its
Sub-Material button.

8  The Make Unique button is now available. Click it to make the
sub-material unique again, and assign it a new material name.

Make Unique is not available for the top-level instance of the sub-material.
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Put to Library 

Material Editor > Put to Library

Material Editor menu > Material menu > Put to Library

Put to Library adds the selected material to the current library.

A Put to Library dialog on page 5372 is displayed, which lets you enter a name
for the material that’s different from the one you used in the Material Editor.

The material becomes visible in the material library display in the Material/Map
Browser on page 5290. The material is saved to the library file on disk. (You can
also save a library by using the Save button in the Material/Map Browser.)

Procedures

To save a material in a library:

1 Click to select the sample slot that has the material you want to save.

2  On the Material Editor toolbar, click Put To Library on page 5348.

3 A Put To Library dialog on page 5372 is displayed.

4 Either change the material name or leave it as is, and then click OK.

The material is saved in the currently open library. If no library is open,
a new library is created. You can save the new library as a file using the
Material/Map Browser on page 5290 file controls.

Material ID Channel 

Material Editor > Material ID Channel

The buttons on the Material ID Channel flyout tag a material as a target for
a Video Post on page 6773 effect or a rendering effect on page 6583, or for storing
with a rendered image saved in RLA on page 7364 or RPF on page 7366 file format
(so that the channel value can be used in a post-processing application). The
material ID value is the counterpart of a G-buffer value on page 7991 for objects.
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Zero (0), the default, indicates that no material ID channel is assigned.

A value from 1 to 15 means to apply a Video Post or rendering effect that uses
this channel ID to this material.

For example, you might want a material to glow wherever it appears in the
scene. The material is in the Material Editor and the glow comes from a
rendering effect. First, you add a Glow rendering effect on page 6599 and set it
up so that it operates on ID 1. Use Material ID Channel to give the material
an ID number of 1, then apply the material to objects in the scene in the usual
way.

To save the channel data with the rendering, use the RLA or RPF format.

WARNING The mental ray renderer on page 6230 does not recognize Z-depth with
G-buffers. G-buffer data is saved on a single layer. Also, the mental ray renderer
does not support the following effects:

■ Glow lens effect on page 6599 (rendering effect)

■ Ring lens effect on page 6606 (rendering effect)

■ Lens effects Focus filter on page 6871 (Video Post)

Procedures

To assign a material ID channel to a material:

■  Choose a channel number from the Material ID Channel flyout on
page 5350.

NOTE Giving a material a nonzero ID channel number tells the renderer to
generate a material ID channel containing that value. This information is stored
in images only if you save the rendered scene in RLA or RPF format. However,
the ID channel data is available to rendering effects at render time.
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Material ID Channel Flyout

Material Editor > Tool buttons > Material ID Channel flyout

The Material ID Channel on page 5348 flyout in the Material Editor on page 5284
lets you assign a material ID to the material. The ID value can associate a Video
Post effect on page 6773 or rendering effect on page 6583 to objects assigned this
material. The channel ID can also be saved if you render to a file in the RLA
on page 7364 or RPF on page 7366 format. Saving the material ID in an image file
lets you use the channel in post-processing applications, such as Autodesk
Combustion.

Zero (0), the default, indicates that no material ID channel is assigned.

A value from 1 to 15 says that an effect that uses this material ID will be applied
to this material.

Show Standard/Hardware Map in Viewport 

Material Editor > Show Standard/Hardware Map in Viewport

Material Editor menu > Material menu > Show Materials in Viewport As on
page 173
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Left: Map shown on sample cube

Right: Map shown in a viewport

This control lets you switch between using software and hardware (DirectX
9.0c and above) for the viewport display, and also toggles the display of
mapped materials on the surfaces of objects in shaded viewports with the
interactive renderer on page 8164. The control is actually a flyout on page 7985
with four possible states:

■ Show Standard Map in Viewport [off]: Uses the legacy software
display and disables viewport display of all maps for the active material.

■ Show Standard Map in Viewport [on]: Uses the legacy software
display and enables viewport display of all maps for the active material.

■ Show Hardware Map in Viewport [off]: Uses the hardware display
and disables viewport display of all maps for the active material.

■ Show Hardware Map in Viewport [on]: Uses the hardware display
and enables viewport display of all maps for the active material.
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Comparison of Standard and Hardware Displays

The ability to render materials in the viewports using a hardware-based display
mode lets you view and adjust certain parameters interactively without having
to generate a final render, saving time when editing materials. The hardware
display does not fully support all material parameters, however. When
considering which display mode to use for a material, take these points into
consideration:

Hardware DisplaySoftware Display

Supports only Standard and Arch & Design
materials

Supports all materials

Supports Diffuse, Specular, and Bump
maps, as well as Anisotropy and BRDF set-
tings

Supports Diffuse maps only

Reflects the sky shader on page 5181No reflection

Calculates specularity on per-pixel basisCalculates specularity on per-face basis

Slower but more accurate, requires a Dir-
ectX9.0c-compliant video card

Faster, no special hardware requirements

Renders faceted display modes as
smoothed

Renders faceted display modes correctly

The following image, taken from the 3ds Max viewport, shows two spheres
to which are applied two copies of an Arch & Design material with identical
settings, including texture-mapped diffuse color and bump mapping, a high
reflectivity level, and a Checker map applied to the Anisotropy channel. The
scene also includes a Daylight system with mr Sun and Sky, with the
Environment Map set to mr Physical Sky. The only difference is that the
material on the left-hand sphere is set to Show Standard Map in Viewport,
while the material on the right-hand sphere is set to Show Hardware Map in
Viewport. The latter shows the bump mapping, reflection of the sky, and the
checkered anisotropy in the specular highlight. The spheres render identically,
and look similar to the right-hand sphere.
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Usage Notes

Please observe the following important aspects of using these controls:

■ The hardware display applies only to the Standard on page 5395 and Arch
& Design on page 5544 materials; when it’s active, 3ds Max still uses the
software display to render all other materials.

■ Choosing the alternate flyout button does not toggle its state. For example,
if Show Standard Map in Viewport is off for the active material, choosing
Show Hardware Map in Viewport simply switches the material to hardware
display mode; it does not turn on the maps. You must toggle the control
explicitly.

■ This control is also available at the map level, where it functions only as
a toggle for the option set at the material level, and applies only to the
active map. So, for example, with the hardware display you could enable
viewport display of the bump map while disabling display the diffuse map,
although both would appear in the final rendered image. Changing the
setting at the material level overrides any map-level settings.

NOTE If the toggle is unavailable at a map level, it means viewport display of
the map is unsupported. One possible reason is that the map is nested too
deep in the material tree.
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■ Hardware viewport rendering requires a DirectX9.0c-compliant video card.
Also, hardware viewport rendering is supported only by the Direct3D
display driver on page 7802.

■ These options do not apply to XRef materials on page 5765, including
materials from XRef objects on page 6936 and XRef scenes on page 6959

■ Displaying mapped materials in a viewport can slow performance. If you
don't need to view the map, turn off its viewport display.

■ You can toggle Show Standard/Hardware Map In Viewport for all materials
by choosing Views menu > Show Materials in Viewport As on page 173.

■ The state of this button is saved with the material in the library. When
you apply a mapped material while Show Map In Viewport is active, the
object's Generate Mapping Coords. check box is turned on. This means
that you can drag mapped materials from the Material Library in the
Browser over objects in your scene, and have the mapped material appear
in the viewports.

■ In the Material/Map Browser on page 5290 and Material/Map Navigator  on
page 5357, icons of materials and maps for which Show Map in Viewport is
on are red, as shown in the following example:

Requirements

For mapped materials to display in the viewport, the following conditions
must be met:

■ Mapping coordinates on page 8034 must be applied to the object. This is
already the case with most primitive objects, which by default have
Generate Mapping Coords on at creation. If an object doesn't have mapping
coordinates, you can turn this on, or apply a mapped material to the object
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(if it has a Generate Mapping Coords check box), or apply a UVW Map
modifier on page 1931 or an Unwrap UVW modifier on page 1841.

■ A mapped material must be applied to the object.

■ Show Map In Viewport must be on, either at the level of the material that
contains the map on page 8036, or at the top level of the material.

NOTE With the software display driver on page 7794, viewports don't accurately
display a map with transparency that has UV tiling or mirroring. Also, this driver
cannot display a map on a faceted material.

3D Maps in Viewports

Show Map In Viewport works for 3D procedural maps as well as 2D maps.

3D map display in viewports is not necessarily accurate. To improve the 3D
preview, you can use the Material Editor Options dialog on page 5335 to set the
3D Map Sample Scale to equal a main dimension of the object you are applying
the map to. For example, if you want to use the planet map on a sphere with
a radius of 20, change the map scale from 100 (the default) to 20.

Particle Age and Particle MBlur maps do not preview in viewports.

Multiple Maps in Viewports

Viewports can display multiple maps. For multiple map display, the display
driver must be OpenGL on page 7796 or Direct3D on page 7802. The software
display driver on page 7794 does not support multiple map display.

The composite map on page 5918 and mix map on page 5926 support multiple
map display.

In addition, turning on Show Map In Viewport at the top level of a standard
material on page 5395 lets you view maps on both the diffuse and opacity
components (though not on other mapped components).

Procedures

To view maps interactively:

1 Select an object.

2 In the object's creation parameters, make sure that Generate Mapping
Coords. is on. (If this option isn't enabled, the object can't be mapped.)
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If the object type does not have a mapping coordinates check box, apply
a UVW Map on page 1931 modifier.

3 In the Material Editor, apply the mapped material to the object.

4  Turn on Show Standard Map In Viewport, or with the
Standard or Arch & Design material, alternatively turn on Show Hardware
Map in Viewport.

The map appears on objects assigned the material in all shaded viewports.
Now when you adjust a map, the viewports update to display the
adjustments.

To turn off interactive texture display:

■  Turn off Show Map In Viewport.
The object is shaded but the map no longer appears.

Show End Result 

Material Editor > Show End Result

Material Editor menu > Material menu > Show End Result

Show End Result lets you look at the material at the level you're on instead
of looking at the end result of all the other maps on page 8036 and settings.

When this button is off, the sample slot shows only the current level of the
material. This tool is useful when you are working with compound materials
on page 7938. It would be difficult to see exactly what effect you're creating on
a particular level if you didn't have the ability to turn off the display of the
other levels.

Go to Parent 

Material Editor > Go to Parent
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Material Editor menu > Navigation menu > Go to Parent

Go To Parent moves up one level in the current material.

This button is available only when you are not at the top level of a compound
material on page 7938. You can tell you're at the top level when this button is
unavailable and the name in the edit field matches the name in the Material
Editor title bar.

A typical situation is one in which you have a material with a Diffuse map.
The Material level is the parent and the Diffuse map is the child. The Go To
Parent button becomes available at the level of the Diffuse map.

TIP You can also navigate through the levels of a material with the Material/Map
Navigator on page 5357.

Go Forward to Sibling 

Material Editor > Go Forward to Sibling

Material Editor menu > Navigation menu > Go Forward to Sibling

Go Forward To Sibling moves to the next map or material at the same level
in the current material.

This button is available only when you are not at the top level of a compound
material on page 7938, and there is more than one map or material at the current
level.

A typical situation is one in which you have a material with a Diffuse map, a
Bump map, and a Glossiness map. The Material level is the parent and the
Diffuse map, Bump map, and Glossiness map are its children. Go Forward To
Sibling becomes available at the level of the children and allows you to go
from one to another.

You can also navigate through the levels of a material with the Material/Map
Navigator on page 5357.

Material/Map Navigator 

Material Editor > Material/Map Navigator
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The Material/Map Navigator is a modeless dialog that provides quick navigation
through the hierarchy of maps on page 8036 in a material on page 8041, or of
sub-materials in a compound material on page 7938.

The Navigator displays the material and maps in the currently active sample
slot. You can navigate the hierarchy of the current material by clicking the
material or map listed in the Navigator. Conversely, as you navigate the
material in the Material Editor, the current level is highlighted in the Navigator.
The selected material or map becomes active in the sample slot, while the
rollouts for the selected material or map are displayed below.

You can also drag from the Navigator to any valid sample slot or button in
the user interface.

Use the view buttons at the top to change the display. The list displayed in
the Navigator is similar to the one displayed in the Track View hierarchy.

See also:

■ Material/Map Browser on page 5290

Interface
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NOTE Icons of materials and maps for which Show Standard/Hardware Map in
Viewport  on page 5350 is on are red.

Also, the names of instanced on page 8014 materials and maps appear in boldface.

Both of these effects are shown in the following illustration:

The view buttons are as follows:

 View List Displays the materials and maps in list format. Blue spheres
are materials. Green parallelograms are maps. The green parallelograms turn
red if Show Map in Viewport is on for a material.

 View List + Icons Displays the materials and maps as small icons in a
list.

 View Small Icons Displays the materials and maps as small icons. As
you move the mouse over the icons, tooltip labels show you the name of the
material or map.

 View Large Icons Displays the materials and maps as large icons. As
you move the mouse over the icons, tooltip labels show you the name of the
material or map.

The large icons are labeled with the name of the material or map and are
displayed using progressive refinement. That is, samples are rendered quickly,
with large pixels, then rendered a second time in greater detail.
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Pick Material From Object (Eyedropper) 

Material Editor > Pick Material From Object

Material Editor menu > Material menu > Pick from Object

Pick Material From Object lets you select a material from an object in the
scene. Click the eyedropper button, and then move the eyedropper cursor
over the objects in the scene. When the eyedropper cursor is over an object
containing a material, it fills with "ink" and a tooltip with the name of the
object pops up. Click the object. The material is placed in the active sample
slot.

If the material is already in the active sample slot, the eyedropper has no effect.

If the eyedropper cursor is over an editable mesh on page 2075 with faces selected
at the sub-object level, and the mesh has a Multi/Sub-Object material on page
5720 applied to it, then the eyedropper picks up the sub-material. However, if
the selected faces have more than one sub-material assigned to them, then
the eyedropper picks up the entire Multi/Sub-Object material.

Name Field (Materials and Maps)

Material Editor > Material Name field

The Name field displays the name of the material or map. Default material
names are "01 − Default," and so on, the number changing to reflect the
material's sample slot. Maps are named "Map #1," and so on.

You can edit this field to change the name of the material in the active sample
slot. You can also edit the names of maps and sub-materials assigned at lower
levels of the map or material hierarchy.

The name of the material is not a file name: it can contain spaces, numbers,
and special characters. It can be of any length.

This field also functions as a drop-down list. At the top level, it shows only
the material or map name. At lower levels of the hierarchy, drop the list down
to see the names of ancestors to the map or material. The top level is at the
top of the list, the current level is at the bottom, and intermediate levels appear
between them.
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Procedures

To give a material a different name:

■ Edit the name field that appears below the Material Editor toolbar.
The name of the active material appears in the title bar of the Material
Editor dialog.

Type Button (Materials and Maps)

Material Editor > Type button

Material Editor menu > Material menu > Change Material/Map Type

Click the Type button to display the Material/Map Browser on page 5290 and
choose which material type or map type to use.

When changing a material's type, the original material type is replaced unless
you choose a compound material on page 7938, in which case a Replace Material
dialog on page 5376 is displayed. The Replace Material dialog lets you choose
between discarding the original material or using it as a sub-material within
the new material.

For a standalone map (a map at the top level), clicking the Type button lets
you change the map type instead of the material type. However, you can't use
this button to make a map standalone. To make a standalone map, you have
to click Get Material on page 5341 and choose a map from the Browser it displays.

When you change the type of a standalone map, a Replace Map dialog on
page 5376 is displayed. The Replace Map dialog lets you choose between
discarding the original map or using it as a sub-map within the new map.

Animating Materials

This topic provides some suggestions about how to animate materials.

Animating Basic Materials

In general, you animate a basic material by changing its parameters in different
keyframes while Auto Key is active. 3ds Max interpolates values between
keyframes, as it does when you animate transforms and modifiers.
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Be aware that the tracks for a material assigned to an object are distinct from
the material tracks that belong to the Material Editor: animating a material
in the Material Editor affects the scene only if the material is hot on page 8006.

Animating Mapped Materials

As with basic materials, you can create animation keys for map parameters.

The noise parameters and the Noise map on page 5886 itself provide the Phase
parameter specifically for animating the noise function.

You can also produce an animated material by applying an animated bitmap
as a map. This automated bitmap can be an AVI on page 7326 or MOV on page
7348 file, or an image sequence in the form of an IFL on page 7339 file.

Changing One Material into Another

Probably the easiest way to animate the change of one material into another
is to create a Blend material on page 5708, make the two other materials its
sub-materials, and then animate its Mix Amount parameter.

Preview and Playback

When you animate a material, or use an animated bitmap in a material, you
can create and view a preview of this material before you decide to use it in
a fully rendered animation.

See also:

■ Creating and Playing Animated Material Previews on page 5362

■ Synchronizing an Animated Bitmap with the Scene on page 5363

Creating and Playing Animated Material Previews

You can create a preview movie of an animated material. Use Make Preview
on page 5333 in the Material Editor. Clicking this button displays the Create
Material Preview dialog on page 5366, which like the Renderer has controls for
which frames to render, playback speed, and output size.

The preview movie is saved in the \previews subdirectory in a file called
_medit.avi. Each time you create a new preview, the Material Editor overwrites
this file. To keep a preview movie on hand, save it under a different name by
using the Save Preview button on the same flyout as Make Preview.
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Procedures

To create a preview of an animated material:

1 Choose Make Preview from the flyout.

2 In the Create Material Preview dialog, set the preview conditions you
want, and then click OK.

The Material Editor creates the preview.

To play back a preview of an animated material:

1 Choose Play Preview from the flyout.

The Material Editor starts the Windows Media Player with the active
preview movie loaded.

2 Click Play to view the preview movie.

To save a preview movie under a different name:

1 Choose Save Preview from the flyout.

The Material Editor displays a file save dialog.

2 Enter a new name for the preview, and then click OK.

Synchronizing an Animated Bitmap with the Scene

Material editor > Bitmap map > Time rollout

Bitmaps on page 5795 have a Time rollout with controls that let you synchronize
an animated bitmap with scene animation.
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Interface

Start Frame The frame number of the 3ds Max scene at which the bitmap
animation begins to play.

Playback Rate Sets the bitmap's playback rate. This value is a multiplier: 1.0
is one bitmap frame per scene frame, 2.0 is twice as fast, 3.33 is 1/3 as fast,
and so on. Default=1.0.

Sync Frames to Particle Age When on, the software synchronizes the frames
of a bitmap sequence to the age of particles to which the map is applied. With
this effect, each particle displays the sequence from the start when it is born,
rather than being assigned whichever frame is current. Default=off.

When using Particle Flow, assign the material containing the Bitmap map to
a Material Dynamic operator. For more details and a procedure, see Material
Dynamic Operator on page 2925.

NOTE This functionality is not supported by the mental ray renderer.

End Condition group

Determines what happens after the last frame of the bitmap animation if the
animation is shorter than the scene.

Loop Causes the animation to repeat over and over again from the beginning.

Ping-Pong Causes the animation to be played forward and then backward
repeatedly, making every animated sequence "loop smoothly."

Hold Freezes on the last frame of the bitmap animation.
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Material Editor Subdialogs

Copy (Instance) Map Dialog

Material Editor > Drag one map button to another.

The Copy (Instance) Map dialog is displayed when you copy a map by dragging
and dropping a map button. It gives you the choice of copying the map,
making the newly assigned map an instance of the one you dragged, or
swapping maps.

You can drag map buttons in the Maps rollout, in the Basic Parameters rollout,
or from one rollout to the other.

TIP When you use the same map for multiple parameters, such as both
self-illumination and opacity, it is usually easier to work with an instance rather
than a copy.

Interface

Instance Makes an instance of the map you dragged. The newly assigned map
is not independent. Adjusting the parameters of one map or the other changes
both of them.

Copy Copies the map you dragged. The newly assigned map is a copy whose
parameters you can adjust independently.
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Swap Swaps the maps. This option isn't displayed when you drag from one
rollout to another.

Copy or Swap Colors Dialog

Material Editor > Basic Parameters rollout or Extended Parameters rollout or
both > Drag one color swatch to another.

The Copy or Swap Colors dialog is displayed when you copy a color by dragging
and dropping a color swatch. It gives you the choice of copying the color or
swapping the colors, trading one for the other.

Interface

Swap Swaps the colors.

Copy Copies the color you dragged.

Create Material Preview Dialog 

Material Editor > Make/Play/Save Preview flyout > Make Preview

The Create Material Preview dialog is displayed when you click Make Preview
on page 5333 to preview an animated material. By default, the preview is saved
in the \previews subdirectory with the name _medit.avi. You can use Save
Preview to give the preview a different name so it won't be overwritten the
next time you use Make Preview.
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Interface

Preview Range group

Active Time Segment Renders the active time segment on page 7898.

Custom Range Renders a custom range from the start to the end frame you
specify in the spinners below.

Frame Rate group

These controls specify the playback rate.
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Every Nth Frame Renders a regular sampling of the animation. For example,
a value of 8 includes only every eighth frame in the preview. Default=1 (every
frame).

Playback FPS Specifies the playback rate in frames per second. Default=30
(full speed).

Image Size group

Percent of Output Specifies the resolution of the preview. This value is a
percentage; 100 percent has a resolution of 101 x 99 pixels (the size of a sample
slot in the 3 x 2 array). Default=100.

Duplicate Name Dialog (Material Library)

Material Editor > Get Material or Type button > Browse From group > Select
Mtl Library. > File group > Open material library. > File group > Merge > Merge
Material Library dialog > Open another material library or a 3ds Max scene.
> Merge dialog > Select materials to merge > OK

File > XRef Objects > XRef Objects dialog > Create XRef Record from File >
Choose a file. > Select objects to XRef. > Duplicate Name dialog

The Duplicate Name dialog is displayed if, after you click OK in the Merge
dialog on page 5370, one or more materials to merge have the same name as
materials in the open library.

If this dialog appears while you are using XRef Objects on page 6936, in the XRef
Objects dialog you can see the updated material name in the “Scene Name”
column, while the original name in the source scene appears in the “Source
Name” column.
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Interface

Material name At the right, the dialog displays a duplicate material name.
You can edit the name to make it unique before you merge it with the open
(current) library by clicking the Merge button.

Apply to All Duplicates If you turn this on before you use the buttons, all
subsequent incoming materials with duplicate names are treated the same
way as the current one, and no further alert messages are displayed.

Use this option when you know that you've got several duplicate materials,
and don't need constant reminders.

This check box is unavailable if you edit the material name.

Merge Merges the material with the open, current library. This button is
unavailable unless you edit the duplicate name to be a different, unique name.

Skip Skips this material and doesn't merge it with the open, current library.

Delete Old Deletes the "old" material in the open, current library and replaces
it with the material to merge.

Auto-Rename Click to have 3ds Max automatically rename the material by
appending a sequence number to the duplicate material name.

Cancel Cancels further merging of materials with duplicate names. If you
have already merged some materials, they appear in the open, current library.
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Merge Dialog (Material Library)

Material Editor > Get Material or Type button > Browse From group > Select
Mtl Library. > File group > Open material library. > File group > Merge > Merge
Material Library dialog > Open another material library or a 3ds Max scene.

The Merge dialog displays a list of materials to merge with the open library.
The materials are from a different material library or from a 3ds Max or VIZ
Render (DRF on page 7167) scene.

Procedures

To merge all materials:

■ Click All.

To select a single material to merge:

■ Click the material's name.

To select materials to merge one by one:

1 Click a material's name.

2 Hold down Ctrl, and click other material names.

To select a group of contiguous materials to merge:

1 Click a material's name.

2 Hold down Shift, and click another material's name.

The dialog selects the two materials you clicked, and all materials whose
names lie between the two.
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Interface

Material list Shows the names of all materials in the library or scene.

All Selects all materials in the list.

None Deselects all materials in the list.

Merge Material Library Dialog

Material Editor > Get Material or Type button > Material/Map Browser > Browse
From group > Select Mtl Library. > File group > Open material library. > File
group > Merge

Material Editor Subdialogs | 5371



The Merge Material Library dialog lets you merge materials in the open material
library with materials in another material library or another 3ds Max or VIZ
Render (DRF on page 7167) scene.

Interface

This is a standard Windows file dialog. It lets you select either material library
(MAT) files, 3ds Max (MAX), or VIZ Render (DRF on page 7167) scene files.

When you click OK, a further Merge dialog on page 5370 is displayed. This lets
you select by name the materials you want to merge with the open library.

Put to Library Dialog 

Material Editor > Put To Library

The Put To Library dialog is displayed when you want to save the material in
an active sample slot on page 5304 into a material library file. It lets you change
the material's name before you save it.
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Interface

Name Shows the name of the material to save. You can edit this name to save
it under a different name.

Render Map Dialog

Material Editor > Right-click a sample slot. > Render Map > Render Map dialog

The Render Map dialog is displayed when you use Render Map on the Sample
Slots Right-Click Menu on page 5308 to render the map displayed in a sample
slot
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Interface

Time Output group

These controls specify how many frames to render.

Single Renders a single frame.

Every Nth Frame Renders a regular sampling of the animation. For example,
a value of 8 includes only every eighth frame in the preview. Default=1 (every
frame).

Active Time Segment Renders the active time segment on page 7898.

Range Renders a custom range from the start to the end frame you specify in
the spinners below.
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Dimensions group

These controls specify the size of the rendered frames, in pixels.

Width Specifies the frame width, in pixels.

Height Specifies the frame height, in pixels.

Output group

These controls let you save the rendered map to a file.

Files Click to display a file dialog that lets you specify where to save the
rendered map.

When you click Save in the file dialog, you might see an additional dialog
that gives you options specific to the file type you chose. These are the file
formats available for a rendered map:

AVI on page 7326

BMP on page 7328

Kodak Cineon on page 7328

Encapsulated Postscript on page 7332

JPEG on page 7347

PNG on page 7360

MOV (QuickTime) on page 7348

SGI on page 7369

RLA on page 7364

RPF on page 7366

Targa on page 7370

TIFF on page 7372

Save to File When on, the rendered map is saved to a file. When off, the map
is rendered only to a Rendered Frame Window  on page 6073. This check box
is unavailable unless you use Files to specify a file name, when it defaults to
on.

File name field Displays the name of the file you chose.

Render Renders the map to a feature-reduced version of the Rendered Frame
Window  on page 6073, and to a file if you chose one.
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Replace Map Dialog

Material Editor > Go to a map level or a standalone map. > Type button >
Material/Map Browser > Choose a compound map.

The Replace Map dialog is displayed when you change a map type to any type
of map that can have sub-maps. It gives you the choice of replacing the original
("old") map completely, or using the original map as a sub-map of the new
map.

Interface

Discard old map Discards the old map.

Keep old map as sub-map Retains the old map as a sub-map.

Replace Material Dialog

Material Editor > Type button > Material/Map Browser > Choose a compound
material.

The Replace Material dialog is displayed when you change a material type to
one of the compound material types on page 5706. It gives you the choice of
replacing the original ("old") material completely, or using the original material
as a sub-material of the new material.
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Interface

Discard old material Discards the old material.

Keep old material as sub-material Retains the old material as a sub-material.

Update Scene Materials Dialog 

Material Editor > Get Material > Material/Map Browser > Update Scene Materials
from Library > Update Scene Materials dialog

The Update Scene Materials dialog lets you use a library to update materials
in the scene. It appears only when you click Update Scene Materials From
Library in the Material/Map Browser on page 5290, and the scene contains
materials that have the same name as materials in the library.

Procedures

To update a material in the scene and replace it with a material from the
library:

■ In the Update Scene Materials dialog, select the name of the material, and
then click OK.

To leave a material in the scene unchanged, do one of the following:

1 In the Update Scene Materials dialog, make sure the name of the material
is not selected, and then click OK.
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2 Click Cancel.

Interface

Material name list Shows the materials that have the same name in the library
and in the scene.

All Selects all material names in the list.

None Deselects all material names in the list.
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Types of Materials
Rendering menu > Material Editor > Type button > Material/Map Browser >
In Show group, turn off Maps. > Material types are listed.

Materials create greater realism in a scene. A material describes how an object
reflects or transmits light. You assign materials to individual objects or selection
sets; a single scene can contain many different materials.

Different materials have different uses.

■ Standard material on page 5395 is the default material. This is a versatile
surface model with a large number of options.

■ Raytrace material on page 5490 can create fully raytraced reflections and
refractions. It also supports fog, color density, translucency, fluorescence,
and other special effects.

■ mental ray materials on page 5543 are provided for use with the mental ray
renderer on page 6230. Of particular importance in this category is the Arch
& Design material on page 5544.

■ Architectural material on page 5526 provides a physically accurate material.
It is especially intended for use with the default scanline renderer and
radiosity on page 6168.

■ Matte/Shadow material on page 5699 is specifically for making an object into
a matte object on page 8042 that reveals the current environment map on
page 7964. A matte object is effectively invisible in the scene, but it can
receive shadows cast onto it from other objects.

■ Shell material on page 5732 is for storing and viewing rendered textures on
page 6371.

■ Advanced Lighting Override material on page 5734 is used to fine-tune the
effects of a material on radiosity solutions on page 6168 or the Light Tracer
on page 6154. This material is not required for calculating advanced lighting,
but it can help improve the result.

NOTE The Architectural material has its own controls for adjusting advanced
lighting.

■ Lightscape material on page 5741 helps support import and export of data
from the Lightscape product.

■ Ink 'n Paint material on page 5742 gives a cartoon appearance to objects.
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■ The DirectX 9 Shader material on page 5758 enables you to shade objects in
viewports using DirectX 9 (DX9) shaders. To use this material, you must
have a display driver that supports DirectX 9, and you must be using the
Direct3D display driver.

■ The XRef material on page 5765 lets you externally reference a material in a
different scene file.

Other material types fall into the category of Compound materials on page
5706.

Compound Materials

Compound materials combine other materials in some way.

■ Blend on page 5708 material mixes two materials on a single side of a surface.

■ Composite on page 5711 material mixes up to 10 materials, using additive
colors, subtractive colors, or opacity mixing.

■ Double-Sided on page 5713 material lets you assign different materials to the
front and back faces of an object.

■ Morpher on page 5716 material uses the Morpher modifier on page 1545 to
manage multiple materials over time.

■ Multi/Sub-Object on page 5720 material uses the sub-object level to assign
multiple materials to a single object, based on material ID values.

■ Shellac on page 5727 material superimposes one material on another using
additive composition.

■ Top/Bottom on page 5729 material lets you assign different materials to the
top and bottom of faces of an object.

Procedures

To get a material:

1  Click Get Material on the Material Editor toolbar.

The Material/Map Browser on page 5290 is displayed.

2 Double-click a material type (not a map type) in the list, or drag the
material to a sample slot.
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The Material Editor replaces the original material.

To change a material type:

1 At the level of a material, click the Type button below the Material Editor
toolbar.

A modal Material/Map Browser on page 5290 is displayed. If you were at a
material when you clicked Type, the Browser lists only materials (if you
were at a map, it lists only maps).

2 Choose a material from the list, and then click OK.

If you choose a compound material, a Replace Material on page 5376 dialog
is displayed. This dialog lets you choose whether to keep or discard the
original material.

The Material Editor now displays controls for the new material.

SuperSampling Rollout

Material Editor > Architectural material > SuperSampling rollout

Material Editor > Raytrace material > SuperSampling rollout

Material Editor > Standard material > SuperSampling rollout

The SuperSampling rollout is used by Architectural, Raytrace, and Standard.
It lets you choose a supersampling method on page 8141. Supersampling performs
an additional antialiasing on page 7904 pass on the material. This requires more
time but can improve image quality. Supersampling is especially helpful when
you need to render very smooth specular highlights, subtle bump mapping,
or high resolutions.

In 3ds Max the default is to apply a single supersampling method to all
materials in the scene. This feature gives you more control over your scenes,
especially larger models that make use of many materials, by letting you
control the supersampling at a global level from the Rendering dialog. You
can override this locally by turning off Use Global Settings. It also gives you
file compatibility and workflow replication with DRF files imported from VIZ
Render.

NOTE SuperSampling settings are ignored by the mental ray Renderer on page
6230, which has its own sampling method.
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Use supersampling when you notice artifacts in your final renderings. For
example, a thin bump map might produce scintillating, jagged bumps that
supersampling can correct. Supersampling requires considerably more time
to render, although it does not necessarily require any additional RAM.

NOTE Supersampling is not processed when you turn off Antialiasing in the
production renderer on page 6121. You can also globally disable supersampling for
all materials using the parameters for the default scanline renderer on page 6141.
Globally disabling supersampling can speed up test renderings.

Supersampling uses smaller sampling points, and returns averaged values to increase
the antialiasing effect.

Supersampling and Antialiasing

Supersampling is one of several antialiasing techniques. Textures, shadows,
highlights, and raytraced reflections and refractions all have their own
preliminary antialiasing strategies. Supersampling is an additional step that
provides a "best guess" color for each rendered pixel. The supersampler's output
is then passed on to the renderer, which performs a final antialiasing pass.
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A single rendered pixel represents an area of the scene's geometry. The pixel
can stand in for multiple colors, especially when it appears at the edge of an
object or a region of color. This is where aliasing effects occur.

When supersampling is turned off, 3ds Max simply looks at the center of the
geometry covered by the pixel, and uses that for the pixel color.

When you turn on supersampling, a supersampler performs an additional
antialiasing pass on the material. You can choose one of four supersamplers.
As the name implies, a supersampler takes additional samples of geometry
color in or near each pixel, in order to obtain a more accurate pixel color that
is less prone to aliasing error.

These are the supersampling methods:

DescriptionName

Spaces samples along both X and Y
axes according to a scattered, "quasi

Adaptive
Halton

random" pattern. Depending on
Quality, the number of samples can
range from 4 to 40. This method is
adaptive, as described below.

Spaces samples regularly, from a
minimum quality of 4 samples to a

Adaptive Uni-
form

maximum of 36. The pattern is not
square, but skewed slightly to im-
prove accuracy in the vertical and
horizontal axes. This method is adapt-
ive, as described below.

Spaces samples regularly along the
X axis, but along the Y axis it spaces

Hammersley

them according to a scattered, "quasi
random" pattern. Depending on
Quality, the number of samples can
range from 4 to 40. This method is
not adaptive.

The sample at the center of the pixel
is averaged with four samples sur-

MAX 2.5 Star

rounding it. The pattern is like the
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DescriptionName

fives on dice. This is the super-
sampling method that was available
in 3ds Max 2.5.

Regular sampling, as performed by the Adaptive Uniform and MAX 2.5 Star
methods, is more prone to aliasing than the irregular patterns performed by
the Adaptive Halton and Hammersley methods.

You can set a variable Quality value for the Adaptive Halton, Adaptive Uniform,
and Hammersley methods. Quality can range from 0.0 to 1.0. A quality of 0.0
is minimal, with about four samples per pixel. A quality of 1.0 is the highest
possible, with between 36 and 40 samples per pixel. High-quality
supersampling is very time consuming.

Another setting for the Adaptive Halton and Adaptive Uniform supersamplers
is the Adaptive toggle, which works in conjunction with the Threshold spinner.
When Adaptive is on, these methods take fewer samples unless a change in
color is greater than the Threshold value. In that case, they take the full number
of samples specified by the Quality. To reduce the amount of time the
supersampler spends, leave the Adaptive check box on.

Interface

Use Global Settings When on, the material uses the supersampling options
set in the Default Scanline Renderer rollout on page 6141. Default=on.

Enable Local Supersampling When on, applies supersampling to the material.
Default=off
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Sampler drop-down list Lets you choose which supersampling method to
apply. The list is not active unless Use Global Settings is turned off.
Default=Max 2.5 Star.

Supersample Maps When on, the maps applied to the material are
supersampled as well. When off, the supersampler uses pixel averages for maps.
This switch is active only when Use Global Settings is turned off. Default=on.

Quality Adjusts the quality of supersampling by controlling the number of
samples used for each pixel. At the minimum value, 0.0, four samples are
taken per pixel. At the maximum value, 1.0, about 40 samples are taken per
pixel (the value varies depending on which shader is active). Range=0.0 to
1.0. Default=0.5.

This spinner is unavailable for the Max 2.5 Star method.

Adaptive Visible only for the Adaptive Halton and Adaptive Uniform methods.
When on, these methods take fewer samples than the Quality specifies unless
samples show a change in color greater than the Threshold value. In that case,
they take all the samples specified by the Quality. Turning on Adaptive On
can reduce the amount of time required to supersample. Default=on.

Threshold Controls the Adaptive methods. Visible only for the Adaptive
Halton and Adaptive Uniform methods. A change in color greater than the
Threshold value causes the adaptive methods to take the full number of
samples specified by the Quality. If the color does not change as much, the
adaptive method takes fewer samples and does not require as much processing
time. Can range from 0.0 to 1.0. Setting Threshold to 0.0 has the same effect
as turning off Adaptive On. Default=0.1.

mental ray Connection Rollout

Material Editor > Click a sample slot that contains a material other than a
Multi/Sub-Object or a mental ray material. > mental ray Connection rollout

The mental ray Connection rollout is available for all types of materials except
the Multi/Sub-Object material and the mental ray materials themselves (for
which it would be redundant). With this rollout you can add mental ray
shading to conventional 3ds Max materials. These effects are visible only when
you use the mental ray renderer on page 6230.
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IMPORTANT The mental ray Connection rollout does not appear unless you have
enabled the mental ray extensions by using the mental ray Preferences panel on
page 7787. In addition, you can't assign shaders to the options in this rollout unless
the mental ray renderer is the currently active renderer.

Interface

For each kind of shader on this rollout, there is a toggle and a button.

■ The toggle controls whether the assigned shader is active or not.
If no shader is assigned, the toggle has no effect.
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■ The button lets you assign a shader to the component type. Clicking it
displays the Material/Map Browser on page 5290: assigning a shader is just
like assigning a map to a component of a standard material.
While a shader is assigned, its name appears on the button.

■  In addition to the toggle and button, some of the shader types have
a lock button to the right. When button is on, the component is inherited
from the base material, and you can't assign a shader. For example, by
default the Surface component is locked, and the surface is shaded using
the settings of the 3ds Max material (basic parameters, maps, and so on).
Turn off this button to replace the base material's settings with a mental
ray shader.

NOTE Using a shader for the Surface component can result in a material whose
appearance in mental ray renderings is completely different from the
appearance it has in the sample slot, viewports, and scanline renderings.

Basic Shaders group

Surface Shades the surface of objects that have this material. Default=locked
to parent material.

In addition to any of the usual 3ds Max materials, the surface component can
be assigned the following mental ray materials or shaders:

LibraryShader

3ds MaxBump on page 5986

3ds MaxDGS Material on page 5615

baseDielectric

3ds MaxDielectric Material on

page 5992

lumeEdge

lumeFacade
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LibraryShader

lumeGlass

lumeGlow

lumeLandscape

3ds MaxMaterial to Shader on

page 6001

lumeMetal

lumeOcean

baseOpacity

baseReflect

baseRefract

3ds MaxShader List on page 6003

lumeStain

lumeTranslucency

physicsTransmat

baseTransparency

baseTwo Sided

3ds MaxUV Generator on page 6005
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LibraryShader

lumeWater Surface

lumeWet-Dry Mixer

3ds MaxXYZ Generator on page

6013

NOTE Unlike a standard 3ds Max material, if you assign the Surface component
a bitmap with tiling turned off, the original surface color does not “show through.”
In renderings, you see only the untiled map, and none of the rest of the object.

Shadow Assigns a shadow shader. Default=locked to parent material.

The shadow component can be assigned the following shaders:

LibraryShader

lumeEdge Shadow

lumeFacade

lumeGlass

lumeGlow

3ds MaxMaterial to Shader on page 6001

lumeMetal

3ds MaxShader List on page 6003

baseShadow Transparency

lumeTranslucency

physicsTransmat
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LibraryShader

lumeWater Surface Shadow

Caustics and GI group

Photon Assigns a photon shader. Photon shaders affect how object surfaces
respond to photons; that is, they control how the surfaces behave when
generating caustics and global illumination. Default=locked to parent material.

The photon component can be assigned the following shaders:

LibraryShader

3ds MaxDGS Material on page 5615

3ds MaxDielectric Material Photon on page 5992

lumeEdge

lumeGlow

3ds MaxMaterial to Shader on page 6001

lumeMetal

basePhoton Basic

lumeTranslucency

physicsTransmat

Photon Volume Assigns a photon volume shader. Photon volume shaders
affect how an object's volume responds to photons; that is, they control how
the volume behaves when generating caustics and global illumination.
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The photon volume component can be assigned the following shaders:

LibraryShader

3ds MaxMaterial to Shader on page 6001

physicsParti Volume Photon

3ds MaxShader List on page 6003

Extended Shaders group

Displacement Assigns a displacement shader on page 6268. Default=locked to
parent material.

The displacement component can be assigned the following shaders:

LibraryShader

3ds Max3D Displacement on page 5983

3ds MaxMaterial to Shader on page 6001

lumeOcean

Volume Assigns a volume shader on page 6265.

The volume component can be assigned the following shaders:

LibraryShader

lumeBeam

3ds MaxMaterial to Shader on page 6001

lumeMist

physicsParti Volume Photon

3ds MaxShader List on page 6003
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LibraryShader

lumeSubmerge

Environment Assigns an environment shader. The environment shader
provides an environment local to the material. It is visible if the material is
reflective or transparent.

The environment component can be assigned the following shaders:

LibraryShader

3ds MaxEnvironment on page 5995

3ds MaxMaterial to Shader on page 6001

3ds MaxShader List on page 6003

Advanced Shaders group

Contour Assigns a contour shader on page 6269.

The contour component can be assigned the following shaders:

LibraryShader

contourCombi

contourCurvature

contourDepth Fade

contourFactor Color

contourLayer Thinner

contourSimple

contourWidth From Color
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LibraryShader

contourWidth From Light

contourWidth From Light Dir

Light Map Assigns a light map shader.

WARNING No light map shaders are provided with 3ds Max. This option is for
users who have access to light map shaders via other shader libraries or custom
shader code.

Optimization group

Flag Material as Opaque When on, indicates that the material is fully opaque.
This tells the mental ray renderer that it doesn't need to process transparency
for this material, or to use the shadow shader. This can improve rendering
time. Default=off.

DirectX Manager Rollout

Material Editor > DirectX Manager rollout

Lets you select a DirectX viewport shader for viewing Direct3D hardware
shaders. DirectX shaders require the Direct3D graphics driver on page 7802,
which uses DirectX. With DirectX shading, materials in a viewport more
accurately represent how the material will appear in another application, or
on other hardware such as a game engine.

DirectX viewport shaders are especially useful for previewing texture-baked
materials on page 6371.

3ds Max provides two DirectX shaders:

■ LightMap shader on page 5760

■ Metal Bump shader on page 5761

NOTE This rollout does not appear for Multi/Sub-Object and Shell materials, which
are simply containers of other materials.
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See also:

■ DirectX 9 Shader Material on page 5758

Interface

DX Display of Standard Material When on, displays the active material as
a DX shader. You can save the material as an FX file by clicking Save As .FX
File.

For full support of this feature, DX9 must be active.

WARNING Not all standard 3ds Max features can be represented by DX shaders,
and you it is possible to create a standard material that is more complex than a
DX video card can display. DX shaders do support the most commonly used
material components: diffuse color (or texture), specular highlights, opacity, bump
mapping, and reflections.

Save as .FX File Click to display a Save Effect File dialog that lets you save the
active material as an FX file on page 7990.

Enable Plugin Material Turn on to use the chosen DirectX shader in shaded
viewports. Default=off.

When not enabled, viewports continue to use the default viewport (interactive)
renderer on page 8164 (or the ActiveShade renderer on page 6102, if that has been
chosen).

This toggle is unavailable if no shader plug-in has been chosen from the
drop-down list, and when DX Display Of Standard Material is on.

Plug-in drop-down list Use the drop-down list to choose a DirectX viewport
shader.

The list is unavailable when DX Display Of Standard Material is on.
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Standard Material

Material Editor > Type button > Material/Map Browser > Standard

Scooter rendered with the default standard material

The Standard material type provides a fairly straightforward way to model
surfaces. In the real world, the appearance of a surface depends on how it
reflects light. In 3ds Max, a standard material simulates a surface's reflective
properties. If you don't use maps on page 8036, a standard material gives an
object a single, uniform color.

Standard material is the default material in the Material Editor sample slots.

This topic introduces the controls for Standard material, exclusive of mapping.

TIP The Standard material supports hardware-based viewport display for improved
feedback while editing its parameters. For more infomation, see Show
Standard/Hardware Map in Viewport  on page 5350.
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Standard Color Components

A surface of a "single" color usually reflects many colors. Standard materials
typically use a four-color model to simulate this. (This can vary, depending
on which shader on page 5397 you use.)

■ Ambient color on page 7906 is the color of the object in shadow.

■ Diffuse on page 7955 is the color of the object in direct, "good" lighting.

■ Specular on page 8133 is the color of shiny highlights.

NOTE Some shaders generate the specular color procedurally, rather than
letting you choose it.

■ Filter on page 7976 is the color transmitted by light shining through the
object.
The Filter color component isn't visible unless the material's Opacity is
less than 100 percent.

NOTE The Raytrace material on page 5490 uses a different, six-color model to
simulate surfaces. Several components are similar to those in the Standard
Material, but they behave differently in Raytrace.

When we describe an object's color in conversation, usually we mean its diffuse
color. The choice of an ambient color depends on the kind of lighting. For
moderate indoor lighting, it can be a darker shade of the diffuse color, but for
bright indoor lighting and for daylight, it should be the complement of the
primary (key) light source. The specular color should be either the same color
as the key light source, or a high-value, low-saturation version of the diffuse
color.

For more tips on choosing color components, see Choosing Colors for Realism
on page 5270.

WARNING When you change the shading type of a material, you lose the settings
(including map assignments) for any parameters that the new shader does not
support. If you want to experiment with different shaders for a material with the
same general parameters, copy the material to a different sample slot on page 5304
before you change its shading type. That way, you can still use the original material
if the new shader doesn't give you the effect you want.
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Other Standard Material Components

A standard material's specular color appears in highlights. You can control
the size and shape of the highlight. A polished surface has a small and strong
highlight. A matte surface has a large, weak highlight, or no highlight at all.

Standard materials also have controls for making the object appear transparent,
and for making it self-illuminating so that it appears to glow.

Along with the material's color components, components also refers to the
parameters that control highlights, transparency, self-illumination, and so
on.

See also:

■ Material Components on page 5267

■ Choosing Colors for Realism on page 5270

Interface

The interface for a standard material is organized into several rollouts:

Shader Basic Parameters Rollout on page 5397

Basic Parameters Rollout (Standard Material) on page 5406

Extended Parameters Rollout (Standard Material) on page 5408

SuperSampling Rollout on page 5381

Maps Rollout (Standard Material) on page 5414

Dynamics Properties Rollout on page 5423

DirectX Manager Rollout on page 5393

Shader Basic Parameters Rollout

Material Editor > Standard material > Shader Basic Parameters rollout > Choose
shader from drop-down list.

The Shader Basic Parameters rollout lets you choose the type of shader to use
with a Standard on page 5395 material. Some additional controls affect how the
material appears.
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Procedures

To set a material's shading type:

1 On the Shader Basic Parameters rollout, open the shader drop-down list.

2 Click the name of the shader type to use for the active material.

To use Wire mode:

■ On the Shader Basic Parameters rollout, turn on Wire.
The material is now shaded as a wireframe mesh. The wire portions of the
geometry do not change; color components, shininess, and so on, remain
the same.

For a wireframe material, turn on the 2-Sided option as well.
You have two choices for how wireframe materials are rendered. The
controls for tuning wireframe shading are on the Extended Parameters on
page 5408 rollout.

If you choose Pixels, the thickness of the wires maintains the same apparent
thickness regardless of the scale of the geometry or how near or far the
object is positioned. In other words, pixel wires have a constant display
size as if the wires were traced over an image.If you choose Units, the wires
behave as if they were modeled in the geometry. They appear thinner at
a distance and thicker at close range. Scaling a wireframe object does scale
wire width.

Interface

[shader drop-down list] Chooses a shader. The material's Basic Parameters
rollout can change to show the controls for the shader you choose. Default
shader=Blinn

There are seven different shaders. Some are named for what they do; others
are named for their creators. These are the basic material shaders:

■ Anisotropic on page 5424: For surfaces with elliptical, "anisotropic" highlights.
These highlights are good for modeling hair, glass, or brushed metal.
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■ Blinn on page 5426: For rounder, softer highlights than Phong shading

■ Metal on page 5427: For metallic surfaces

■ Multi-Layer on page 5428: For surfaces with more complex highlights than
Anisotropic

■ Oren-Nayar-Blinn on page 5429: For matte surfaces such as fabric or terra-cotta

■ Phong on page 5430: For surfaces with strong, circular highlights

■ Strauss on page 5431: For metallic and nonmetallic surfaces. The Strauss
shader has a simpler interface than other shaders.

■ Translucent on page 5434: Similar to Blinn shading, the Translucent shader
also lets you specify translucency, where light is scattered as it passes
through the material.

For more information about the shaders, including illustrations, see
Understanding Shaders on page 5399.

Wire Renders the material in wireframe mode on page 8172. You can set the
size of the wire in Extended Parameters on page 5408.

2-Sided Makes the material 2-sided on page 7893. Applies the material to both
sides of selected faces.

Face Map Applies the material to the faces of the geometry. If the material is
a mapped material, it requires no mapping coordinates on page 8034. The map
is automatically applied to each facet of the object.

Faceted Renders each face of a surface as if it were flat.

Understanding Shaders

For standard materials, a shader is an algorithm that tells 3ds Max how to
calculate surface rendering. Each shader has a unique set of characteristics in
order to serve a particular purpose. Some are named for what they do well,
such as the Metal shader. Others are named for the person who developed
them, such as the Blinn and Strauss shaders. The default shader in 3ds Max
is the Blinn shader.

NOTE In addition to the shaders listed below, 3ds Max supports plug-in shader
types.
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The following list describes the shaders supplied with the software:

■ Anisotropic: Used for brushed metal or hair. Creates a highlight that is
stretched and angled, rather than the standard circular highlight.

■ Blinn: Has the same features as the Phong shader, but its mathematics are
more accurate. This is the default shader for Standard materials.

■ Metal: Used for making metals.

5400 | Chapter 19   Material Editor, Materials, and Maps



■ MultiLayer: Two anisotropic shaders in one. Used to make two different
highlights with independent controls. Simulates materials such as a metal
that is covered with a shiny coat of wax.

■ Oren-Nayar-Blinn: An adaptation of the Blinn shader. It gives objects a
porous, non-plastic appearance, and is suitable for surfaces like skin.
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■ Phong: A classic shading method that was the first to enable specular
highlights. Suitable for plastic surfaces.

■ Strauss: Suitable for metals. Allows you to control the degree of metallic
characteristics of the material.
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■ Translucent Shader: Translucent shading is similar to Blinn shading, but
it also lets you specify translucency. A translucent object allows light to
pass through, and also scatters light within the object. You can use
translucency to simulate frosted and etched glass.

Comparing Shader Parameters

A shader is an algorithm that tells the program how to calculate surface
rendering. Each shader has a unique set of characteristics in order to serve a
particular purpose.

Compare the parameters of different shader types:

1 Open the Material Editor and click an available sample slot.

2 In the list on the Shader Basic Parameters rollout, change Blinn to
Anisotropic.
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The Blinn Basic Parameters rollout changes to the Anisotropic Basic
Parameters rollout. Observe the differences in the available basic
parameters.
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3 Select each shader type from the list and compare its parameters with
the others. Some parameters are shared in common, but each shader has
its own unique combination of settings.

For more information on shader types, see Shader Basic Parameters Rollout
on page 5397.
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Basic Parameters Rollout (Standard Material)

Material Editor > Standard material > Basic Parameters rollout for the shader
you've chosen

The Basic Parameters rollouts for Standard materials contain controls that let
you set the color of your material, the shininess, the transparency, and so on,
and specify maps on page 8036 to use for the various components of the material.

Example: The Basic Parameters rollout for the Anisotropic shader.

Basic Parameters rollouts vary depending on which shader is chosen.

The Basic Parameters rollout changes depending on which kind of shader you
choose in the Shader Basic Parameters on page 5397.

NOTE The Strauss shader’s Basic Parameters rollout is simpler than those for other
shaders. See Strauss Shader on page 5431 for a description.
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Component Controls

The first part of the Basic Parameters rollout contains controls for overall
material components. They are described in the following topics:

■ Color Controls on page 5436 let you choose the material’s color components,
or replace them with maps.

■ Self-Illumination on page 5440 makes a material appear lit from within.
Self-illumination is not available for the Strauss shader on page 5431.

■ Opacity on page 5442 controls how opaque or transparent a material is.

■ Diffuse Level on page 5444 controls the brightness of the diffuse color
component.
Diffuse Level is available only for the Anisotropic on page 5424, Multi-Layer
on page 5428, and Oren-Nayar-Blinn on page 5429 shaders.

■ Roughness on page 5446 controls how quickly the diffuse component blends
into the ambient component.
Roughness is available only for the Multi-Layer on page 5428 and
Oren-Nayar-Blinn on page 5429 shaders.

Highlight Controls

The second part of the Basic Parameters rollout contains controls for specular
highlights, which in some ways are the greatest difference between the various
shaders. See these topics for a description:

■ Anisotropic Highlights on page 5424

■ Blinn, Oren-Nayar-Blinn, and Phong Highlights on page 5451

■ Metal Highlights on page 5452

■ Multi-Layer Highlights on page 5454

For information on highlights with the Strauss shader, see Strauss Shader on
page 5431.

Translucency Controls

For the Translucent shader on page 5434, an additional group on the Basic
Parameters rollout contains controls for translucency on page 5447.
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Extended Parameters Rollout (Standard Material)

Material Editor > Standard material > Extended Parameters rollout

The Extended Parameters rollout is the same for all shading types of Standard
material. It has controls related to transparency and reflection, as well as
options for Wire mode.

This topic contains tables of the Index of Refraction for some common physical
materials. These can be used to create Standard materials with realistic
transparency.

Additive Opacity and the Alpha Channel

By default, additive opacity does not generate an alpha value. In other words,
the alpha value is zero, indicating no transparency. This gives correct results
with backgrounds in renderings, but if you want to composite objects with
additive opacity using video post on page 6773 or a different compositing
program, you might want to have additive opacity render with transparency.
To do so, add the following line to the [Renderer] section of the 3dsmax.ini
file, and then restart 3ds Max:

AlphaOutOnAdditive=1

To revert to the default method of rendering additive opacity, in the 3dsmax.ini
file, change the value of AlphaOutOnAdditive back to 0 (zero), and then restart
3ds Max.

Interface

Advanced Transparency group

These controls affect the opacity falloff on page 8068 of a transparent material.

NOTE For the Translucent shader on page 5434, these controls do not appear. They
are replaced by the Translucency controls on page 5447 on the Basic Parameters
rollout.

Falloff Chooses whether falloff is in or out, and how great it is.

■ In Increases transparency toward the inside of the object, as in a glass
bottle.

■ Out Increases transparency toward the outside of the object, as in a cloud
of smoke.
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Amt (Amount) Specifies the amount of transparency at the outside or inside
extreme.

Type These controls choose how transparency is applied.

■ Filter on page 7976 computes a filter color that it multiplies by the color
behind the transparent surface. Click the color swatch to change the filter
color. Click the button to assign a map to the filter color component.
The filter, or transmissive color, is the color transmitted through transparent
or semi-transparent materials such as glass. You can use the filter color
with volumetric lighting to create effects such as colored light through a
stained-glass window. Ray-traced shadows on page 8103 cast by transparent
objects are tinted with the filter color.

A shadow's color is changed with a red filter color.

■ Subtractive on page 8140 subtracts from the color behind the transparent
surface.

■ Additive on page 7901 adds to the color behind the transparent surface.

Index of Refraction Sets the index of refraction (IOR) used by refraction maps
and raytracing. The IOR controls how severely the material refracts transmitted
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light. Left at 1.0, the IOR of air, the object behind the transparent object does
not distort. At 1.5 the object behind distorts greatly, like a glass marble. At an
IOR slightly less than 1.0, the object reflects along its edges, like a bubble seen
from under water. Default=1.0.

Common IORs (assuming the camera is in air or a vacuum) are:

IOR ValueMaterial

1.0 (exactly)Vacuum

1.0003Air

1.333Water

1.5 (clear glass) to 1.7Glass

2.417Diamond

In the physical world, the IOR results from the relative speeds of light through
the transparent material and the medium the eye or the camera is in. Typically
this is related to the object's density; the higher the IOR, the denser the object.

You can also use a map to control the index of refraction. IOR maps always
interpolate between 1.0 (the IOR of air) and the setting in the IOR parameter.
For example, if the IOR is set to 3.55 and you use a black-and-white Noise
map to control IOR, the IORs rendered on the object will be set to values
between 1.0 and 3.55; the object will appear denser than air. If, on the other
hand, your IOR is set to 0.5, then the same map values will render between
0.5 and 1.0, as if the camera were under water and the object was less dense
than the water.

Here are some more IOR values for various materials:

IOR ValueMaterial

1.200Carbon Dioxide, Liquid

1.309Ice

1.360Acetone
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IOR ValueMaterial

1.360Ethyl Alcohol

1.380Sugar Solution 30%

1.329Alcohol

1.434Flourite

1.460Quartz, Fused

1.486Calspar2

1.490Sugar Solution 80%

1.517Glass, Zinc Crown

1.520Glass, Crown

1.530Sodium Chloride

1.544Sodium Chloride (Salt) 1

1.550Polystyrene

1.553Quartz 2

1.570Emerald

1.575Glass, Light Flint

1.610Lapis Lazuli

1.610Topaz
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IOR ValueMaterial

1.630Carbon Bisulfide

1.644Quartz 1

1.644Sodium Chloride (Salt) 2

1.650Glass, Heavy Flint

1.740Methylene Iodide

1.770Ruby

1.770Sapphire

1.890Glass, Heaviest Flint

2.000Crystal

2.705Chromium Oxide

2.705Copper Oxide

2.920Amorphous Selenium

3.340Iodine Crystal

Wire group

Size Sets the size of the wire in wireframe mode on page 8172. You can set either
pixels or current units.

In Chooses how to measure wire.

■ Pixels (The default.) Measures wire in pixels. With pixels, wires maintain
the same apparent thickness regardless of the scale of the geometry or how
near or far the object is positioned.
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■ Units Measures wire in 3ds Max units. With units, the wires appear
thinner at a distance and thicker at close range, as if they were modeled
in the geometry.

Reflection Dimming group

These controls dim reflection maps that are in shadow.

Reflection dimming

Above: None

Below: 0.0 (100% dimming)

Apply Turn on to use reflection dimming. When off, the reflection-mapped
material is not affected by the presence or absence of direct light. Default=off.
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Dim Level The amount of dimming that takes place in shadow. At 0.0, the
reflection map is completely dark in shadow. At 0.5, the reflection map is half
dimmed. At 1.0, the reflection map is not dimmed and the material appears
as if Apply were turned off. Default=0.0.

Refl. Level Affects the intensity of the reflection that is not in shadow. The
Reflection Level value multiplies the illumination level of the lit area of the
reflection, to compensate for dimming. In most cases, the default value of 3.0
keeps the reflection in the lit area at about the same level it would appear if
reflection dimming were not on.

Maps Rollout (Standard Material)

Material Editor > Standard material > Maps rollout

A material's Maps rollout lets you access and assign maps on page 8036 to various
components of the material.

You can choose from a large variety of map types. To find descriptions of these
types, and how to set their parameters, see Map Types on page 5767.

Assigning the Same Map to Different Parameters

Applying the same map to different parameters is useful in some cases. For
example, using a pattern to map both self-illumination and opacity can make
the pattern appear to glow and hover in space.

Blending Map Amounts for Opacity and Other Material Components

When you map a scalar component (such as Specular Level, Glossiness,
Self-Illumination, and Opacity), the component's value in the Basic Parameters
on page 5406 rollout is blended with its associated map Amount in the Maps
rollout.

For example, when the Opacity spinner is set to 0, the map Amount spinner
completely controls Opacity. That is, reducing the Amount value increases
the transparency of the entire surface. On the other hand, when Opacity is
100, reducing the map's Amount value increases the opacity of the entire
surface. You can adjust a Checker Opacity map so that the opaque areas remain
opaque, while the transparent areas become semi-transparent.

Other scalar components behave in the same way. Setting the map's Amount
to 100 applies all of the map. Setting the Amount to 0 is the equivalent of
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turning the map off. Intermediate Amount values are blended with the value
of the scalar component.

When you load old 3ds Max files or bring earlier materials from the Browser
into the Materials Editor, the spinner values for Opacity, Specular Level,
Glossiness, and Self-Illumination are altered, where necessary, to maintain
the equivalent material effect.

Ambient and Diffuse Map Lock 

In the Maps rollout, the lock button to the right of the Diffuse Color map
button locks ambient mapping to diffuse mapping. It is on by default. Usually
it makes sense to use the same map for the ambient and diffuse components.
To use different maps for ambient and diffuse, turn off the lock button. The
map button for Ambient Color becomes available.

Procedures

To assign a map:

1 In the Maps rollout, click a map button.

A modal Material/Map Browser on page 5290 is displayed.

2 Use the Browse From buttons to choose where you want to look.

If you choose Material Library and the dialog's display area is blank, you
need to open a library file. Click the Open button and then choose the
library to browse.

3 Use the display buttons to choose how you view maps.

■  View List shows each map by name.

■  View List + Icons shows a small preview and each map's name.

■  View Small Icons shows a small preview for each map.

■  View Large Icons shows a large preview for each map, along
with the map's name.
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TIP You can resize the Browser dialog to increase the size of the display
area. This is especially useful when you view large icons.

4 Double-click the map you want.

To use the same map for different parameters:

1 In the Maps rollout, use a map button to assign a map.

The Material Editor is now at the map level, and displays controls for the
map parameters.

2  Click Go To Parent to return to the material level, and then open
the Maps rollout.

3 Drag the assigned map button to another map button.

The Copy (Instance) Map dialog on page 5365 is displayed.

4 Choose Copy or Instance, and then click OK.

If you choose Swap, the Material Editor swaps the two button assignments.

To view the parent material's parameters:

■  If you are currently at the map level in the Material Editor, click Go
To Parent.
The parameters for the map's parent material are displayed. Also, the Show
End Result and Go To Parent buttons become unavailable.

To view a map's parameters:

■ If you are currently at the material level in the Material Editor, click the
button that corresponds to the map.
The parameters for the map are displayed. Also, the Show End Result on
page 5356 and Go To Parent on page 5356 buttons become available.

In the Basic Parameters rollout, if a map has been assigned to a color
component or parameter, the corresponding button displays a letter M.
In the Maps rollout, if a map has been assigned, the corresponding button
displays the map name.
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To view a map's location:

■  Click Material/Map Navigator to view the Navigator.
The Material/Map Navigator on page 5357 displays the hierarchy of the
current material, which contains the map.

To go to a map using the Navigator:

■ In the Material/Map Navigator on page 5357, click the name of the map, or
the green or red parallelogram to the left of the map's name.
The Navigator goes to the level of the map, and the Material Editor displays
the controls for the map you clicked.

As the Navigator's map tree shows, maps for basic material components
and parameters are one level below the material itself.

To preview a map in a sample slot:

1 Go to the level of the map, as described in previous procedures.

The Material Editor displays the map's parameters.

2  Turn off Show End Result on page 5356.

The sample slot shows the map instead of the material. If the map
contains sub-maps, these are also visible.

By default, the sample slot displays a map with no three-dimensional
shading. You can change this in the Material Editor Options dialog on
page 5335.

To view the map interactively:

1 Select an object.

2 In the object's creation parameters, make sure that Generate Mapping
Coords is on.

If the object type does not have a Generate Mapping Coordinates toggle,
you need to assign mapping coordinates by applying a UVW Map modifier
on page 1931.

3 In the Material Editor, assign the mapped material to the object.

4 If you are at the material level (the top level), click the appropriate map
button to go to the map level.

Standard Material | 5417



5  Turn on Show Map In Viewport on page 5350.

The map appears on objects assigned the material in all shaded viewports.
Now when you adjust the map, the viewports update to display the
adjustments.

Turning on Show Map In Viewport for one map automatically turns this
button off for all other maps the material has.

Viewports can display 2D maps such as Checker and Bitmap.

Viewports can also display most kinds of 3D maps. The exceptions are
Particle Age and Particle MBlur. Also, the appearance of the Falloff map
in viewports give only a vague indication of how it will appear when
rendered.

Show Map In Viewport is unavailable if the active map type cannot display
in viewports.

Displaying mapped materials in a viewport can slow performance. If you
don't need to view the texture, turn off its viewport display.

To turn off interactive texture display:

1 Go to the map level.

If you are at the material level, click the appropriate map button to go
to the map level.

2  Turn off Show Map in Viewport on page 5350.

The object is shaded but the map no longer appears.

To turn a map off:

■ On the Maps rollout, turn off the map's check box.
The check box is to the left of the map's name.

When a map is off, a lowercase m appears on the corresponding map
button.
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To turn a map on:

■ In the Maps rollout, turn on the map's check box.
The check box is to the left of the map's name.

When a map is on, an uppercase M appears on the corresponding map
button.

To change a map's strength:

■ In the Maps rollout, adjust the map's Amount spinner.
The material's sample slot reflects the change.

NOTE Adjusting a map's output (in the map's Output rollout) can also change
the map's strength.

To move directly to an ancestor:

1 Below the Material Editor toolbar, click the arrow to the right of the map's
name field on page 5360.

A drop-down list of ancestors is displayed.

2 Click a name in the Ancestor list.

With this list, you can skip intermediate levels in the tree.

 The Ancestor drop-down list shows only part of the tree. It
does not show side branches and siblings. To view these, use the
Material/Map Navigator on page 5357 or the Go Forward To Sibling on page
5357 and Go To Parent on page 5356 buttons on the Material Editor toolbar.

To change a map type:

1 At the level of a map, click the button labeled Type below the Material
Editor toolbar.
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A modal Material/Map Browser on page 5290 is displayed. If you were at a
map, it lists only maps (if you were at a material when you clicked Type,
the Browser lists only materials).

2 Choose a map type from the list, and then click OK.

If you change a map type and the new map type can have component
maps, a Replace Map dialog is displayed. This dialog gives you a choice
between discarding the original map or using it as a component map.

If the new map type does not have components, it simply replaces the
original map type.

To create a standalone map tree:

1 Activate a sample slot.

2  Click Get Material on page 5341.

3 In the Material/Map Browser on page 5290, make sure Browse From is set
to New.

4 Double-click the name of the map type (not a material type) you want
to use, or drag the map to a sample slot.

The sample slot now contains a standalone map not associated with
material parameters.

5 Use the Material Editor to modify the map as you would any other map.

By default, the sample slot displays a map with no three-dimensional
shading. You can change this in the Material Editor Options dialog on
page 5335.
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Interface

The Maps rollout contains a wide button for each map type. Click this button
to select a bitmap file stored on disk or to select a procedural map type on
page 8097. After you select a map, its name and type appears on the button. Use
the check box to the left of the button to turn the effect of the map off and
on. When the check box is off, the map is not computed and has no effect in
the renderer.

Standard Material | 5421



The Amount spinner determines the amount that the map affects the material
expressed as a percentage of full intensity. For example, a diffuse map at 100%
is completely opaque and covers the base material. At 50%, it is
semi-transparent and the base material (the diffuse, ambient, and other colors
of the material without mapping) shows through.

Ambient Color Mapping on page 5458

Diffuse Color Mapping on page 5460

Diffuse Level Mapping on page 5462

Diffuse Roughness Mapping on page 5464

Specular Color Mapping on page 5465

Glossiness Mapping on page 5467

Glossiness and Specular Level Settings on page 7999

Self-Illumination Mapping on page 5469

Opacity Mapping on page 5470

Filter Color Mapping on page 5471

Anisotropy Mapping on page 5473

Orientation Mapping on page 5474

Metalness Mapping on page 5476

Bump Mapping on page 5478

Reflection Mapping on page 5480

Refraction Mapping on page 5483

Displacement Mapping on page 5487

The Maps rollout can have unused, disabled control rows at the bottom. This
is because the number of components that can be mapped varies depending
on the current shader on page 5397. The last four rows are always Bump,
Reflection, Refraction, and Displacement, in that order.

NOTE The sub-material and sub-map buttons for most materials and maps have
check boxes beside each button. These turn that branch of the material or map
off or on. For example, in the Top/Bottom material, the Top Material and Bottom
Material buttons each have check boxes. Similarly, the Checker map has two map
buttons, one for each color. Each button has check box beside it that lets you turn
off that color's map.
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Dynamics Properties Rollout

Material Editor > Standard material > Dynamics Properties rollout

The Dynamics Properties rollout lets you specify surface properties that affect
the animation of an object upon collision with another object. If there are no
collisions in your simulation, these settings have no effect. The dynamics
properties are used by the Dynamics utility on page 3852.

Since the Dynamics Properties rollout is available at the top level of any
material (including submaterials), you can specify different surface dynamic
properties for each face in an object. There are also controls in the Dynamics
utility that let you adjust the surface properties at the object level, but only
the Materials Editor lets you alter the surface properties at the sub-object level,
through use of a Multi/Sub-Object material on page 5720.

As a default, the values in the Dynamics Properties rollout provide a surface
that's similar to Teflon-coated hardened steel.

Interface

Bounce Coefficient Sets how far an object bounces after hitting a surface.
The higher the value, the greater the bounce. A value of 1 represents a "perfectly
elastic collision," or a bounce in which no kinetic energy is lost. Default=1.0.

If you've seen the desktop toy with four ball bearings swinging back and forth
on strings and hitting one another, you've seen an example that comes very
close to a bounce coefficient of 1. Generally, hardened steel or a super ball
have a bounce near 1, while lead has a bounce near 0.

Static Friction Sets how difficult it is for the object to start moving along a
surface. The higher this value, the more difficult. Default=0.0.

If something weighs ten pounds and sits on Teflon (a static friction of near
0), it takes almost no force to make it move sideways. On the other hand, if
it sits on sandpaper, then the static friction might be very high, on the order
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of 0.5 to 0.8. A static friction near 1 is very difficult to create in the real world
without adhesives or friction material.

Sliding Friction Sets how difficult it is for the object to keep moving over a
surface. The higher this value, the more difficult for the object to keep moving.
Default=0.0.

Once two objects begin to slide over one another, static friction disappears
and sliding friction takes over. Generally, sliding friction is lower than static
friction due to surface tension effects. For example, once steel starts sliding
over brass (a value of static friction that might run from 0.05 to 0.2), the
sliding friction drops to a significantly lower value, on the order of .01 to 0.1.
For some materials, such as specific friction materials like brake linings, sliding
friction is just as high as static friction because it is used in conjunction with
a nearly frictionless material such as hardened polished steel.

Basic Material Shaders

Anisotropic Shader

Material Editor > Standard material > Shader Basic Parameters rollout >
Anisotropic shader > Anisotropic Basic Parameters rollout

The Anisotropic shader creates surfaces with elliptical, "anisotropic" highlights.
These highlights are good for modeling hair, glass, or brushed metal. The basic
parameters are similar to those for Blinn or Phong shading on page 5426, except
for the Specular Highlight parameters, and Diffuse Level controls such as those
for Oren-Nayar-Blinn shading on page 5429.
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Anisotropic highlights are elliptical, with differing U and V dimensions.

Anisotropy measures the difference between sizes of the highlight as seen
from two perpendicular directions. When anisotropy is 0, there is no difference
at all. The highlight is circular, as in Blinn or Phong shading. When anisotropy
is 100, the difference is at its maximum. In one direction the highlight is very
sharp; in the other direction it is controlled solely by Glossiness.

For more complex highlights, see the Multi-Layer shader on page 5428.

See also:

■ Shader Basic Parameters Rollout on page 5397

■ Basic Parameters Rollout (Standard Material) on page 5406

■ Anisotropic Highlights on page 5449
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Blinn Shader

Material Editor > Standard material > Shader Basic Parameters rollout > Blinn
shader > Blinn Basic Parameters rollout

Blinn shading is a subtle variation on Phong shading. The most noticeable
difference is that highlights appear rounder. In general, you don't need to use
the Soften parameter (described in Blinn, Oren-Nayar-Blinn, and Phong
Highlights on page 5451) as often as you do with Phong shading.

Blinn shading tends to have soft, round highlights.

With Blinn shading, you can obtain highlights produced by light glancing
off the surface at low angles. These highlights are lost when you increase the
value of Soften using Phong shading.

The Blinn and Phong shaders have the same basic parameters on page 5406.

See also:

■ Shader Basic Parameters Rollout on page 5397

■ Basic Parameters Rollout (Standard Material) on page 5406
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■ Blinn, Oren-Nayar-Blinn, and Phong Highlights on page 5451

Metal Shader

Material Editor > Standard material > Shader Basic Parameters rollout > Metal
shader > Metal Basic Parameters rollout

Metal shading provides realistic-looking metallic surfaces and a variety of
organic-looking materials.

Metal shading has a distinct curve for specular highlights. Metal surfaces also
have glancing highlights. Metal materials calculate their own specular color,
which can vary between the material's diffuse color and the color of the light.
You can't set a metal material's specular color.

Metal shading has distinctive highlights.

Because there's no separate specular highlight, the two specular highlight
spinners behave differently than the spinners for Blinn and Phong shading
on page 5426. The Specular Level spinner still controls intensity, but the
Glossiness spinner affects both the intensity and size of the specular areas.
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TIP When you create a metal material, make sure the backlight on page 5329 is on
in the sample slot.

See also:

■ Shader Basic Parameters Rollout on page 5397

■ Basic Parameters Rollout (Standard Material) on page 5406

■ Metal Highlights on page 5452

Multi-Layer Shader

Material Editor > Standard material > Shader Basic Parameters rollout >
Multi-Layer shader > Multi-Layer Basic Parameters rollout

Upper left: No highlights

Upper right: Single highlight

Lower middle: Multiple highlights from the multi-layer shader

The Multi-Layer shader is similar to the Anisotropic shader on page 5424, but it
has a set of two specular highlight controls. The highlights are layered, letting
you create complex highlights that are good for highly polished surfaces,
special effects, and so on.
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Highlights in the Multi-Layer shader can be anisotropic. Anisotropy measures
the difference between sizes of the highlight as seen from two perpendicular
directions. When anisotropy is 0, there is no difference at all. The highlight
is circular, as in Blinn or Phong shading. When anisotropy is 100, the difference
is at its maximum. In one direction the highlight is very sharp; in the other
direction it is controlled solely by Glossiness.

See also:

■ Shader Basic Parameters Rollout on page 5397

■ Basic Parameters Rollout (Standard Material) on page 5406

■ Multi-Layer Highlights on page 5454

Oren-Nayar-Blinn Shader

Material Editor > Standard material > Shader Basic Parameters rollout > Blinn
shader > Oren-Nayar-Blinn shader > Oren-Nayar-Blinn Basic Parameters rollout

The Oren-Nayar-Blinn shader is a variant of the Blinn shader on page 5426. It
contains additional "advanced diffuse" controls, Diffuse Level and Roughness,
that you can use to give the material a matte effect. This shader is good for
matte surfaces such as fabric, terra-cotta, and so on.
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Oren-Nayar-Blinn shading typically has a matte appearance.

See also:

■ Shader Basic Parameters Rollout on page 5397

■ Basic Parameters Rollout (Standard Material) on page 5406

■ Blinn, Oren-Nayar-Blinn, and Phong Highlights on page 5451

Phong Shader

Material Editor > Standard material > Shader Basic Parameters rollout > Phong
shader > Phong Basic Parameters rollout

Phong shading smoothes the edges between faces and renders highlights
realistically for shiny, regular surfaces. This shader interpolates intensities
across a face based on the averaged face normals of adjacent faces. It calculates
the normal for every pixel of the face.
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Phong-shaded highlights are typically less regular than Blinn highlights.

Phong shading can accurately render bump, opacity, shininess, specular, and
reflection maps.

The Blinn and Phong shaders have the same basic parameters on page 5406.

See also:

■ Shader Basic Parameters Rollout on page 5397

■ Basic Parameters Rollout (Standard Material) on page 5406

■ Blinn, Oren-Nayar-Blinn, and Phong Highlights on page 5451

Strauss Shader

Material Editor > Standard material > Shader Basic Parameters rollout > Strauss
shader > Strauss Basic Parameters rollout

The Strauss shader is for modeling metallic surfaces. It uses a simpler model
and has a simpler interface than the Metal shader on page 5427.
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Sample of Strauss shading

NOTE The Strauss shader’s Basic Parameters rollout differs a great deal from the
Basic Parameters rollouts for other shaders, and is described in this topic.

See also:

■ Shader Basic Parameters Rollout on page 5397

Procedures

To change the color of a Strauss material:

1 Click the Color swatch.

The Color Selector on page 391 is displayed.

Right-clicking the color swatch also displays the Color Selector.

2 In the Color Selector, change the values of the color.

As you change color values, the color also changes in the sample in the
sample slot.
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To reduce a material's opacity:

■ Change Opacity to a value less than 100%.
The material becomes more transparent. A fully transparent object (0%
Opacity) is nearly invisible except for the light it reflects: the specular
highlights.

To preview transparency in the sample slots, view the sample object against
a background. Click the checkered Background on page 5329 button to the
right of the sample slots.

Transparent materials render more realistically when you turn on 2-Sided
in the material's Shader Basic Parameters on page 5397.

To increase or decrease the size and intensity of highlights:

■ Change the Glossiness value.
The width of the Highlight curve and the highlights in the preview change.
At 0% glossiness, the curve is at its maximum width. At 100% glossiness,
the curve is extremely narrow.

Increasing Glossiness also dims the diffuse color.

To make the material appear more metallic:

1 Increase the Glossiness value.

The metallic effect requires visible highlights.

2 Increase the value of Metalness.

Highlights become more focused, and the (diffuse) color component is
dimmed.

Interface
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Color Controls the color of the material. This corresponds to the diffuse color
on page 7955 you specify for other kinds of shaders. With the Strauss shader,
you control only this color. The shader calculates the ambient and specular
color components.

Click the map button to assign a map to the color component. See Diffuse
Mapping on page 5460. This button is a shortcut: you can also assign color
mapping in the Maps on page 5414 rollout.

Glossiness Affects the size and intensity of the specular highlight. As you
increase the value, the highlight gets smaller and the material appears shinier.
Default=25.

Glossiness also controls the strength of reflection maps assigned to a Strauss
material.

Click the map button to assign a map to the glossiness component. See
Glossiness Mapping on page 5467. This button is a shortcut: you can also assign
glossiness mapping in the Maps on page 5414 rollout.

Metalness Changes the metallic appearance of a material. Increasing the
Metalness value increases the metallic appearance, with glancing as well as
primary highlights. Because a metallic appearance principally depends on
highlights, the Metalness value has little effect unless you also increase the
Glossiness value. Default=0.

TIP When you create a metal material, make sure the backlight on page 5329 is on
in the sample slot.

Opacity Sets the opacity/transparency of the material as a percentage. The
effect is best previewed against a pattern background on page 5329 in the sample
slot. You can control opacity falloff on page 8068 in the Extended Parameters.
Default=100.

Click the map button to assign a map to the opacity component. See Opacity
Mapping on page 5470. This button is a shortcut: you can also assign opacity
mapping in the Maps rollout on page 5414.

Highlight graph This curve shows the effect of adjusting the value of
Glossiness. As you decrease Glossiness, the curve grows shorter; as you increase
it, the curve grows taller.

Translucent Shader

Material Editor > Standard material > Shader Basic Parameters rollout >
Translucent shader > Translucent Basic Parameters rollout
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The bust on the right has been made translucent.

Translucent shading is similar to Blinn shading, but it also lets you specify
translucency. A translucent object allows light to pass through, and also scatters
light within the object. You can use translucency to simulate frosted and
etched glass.

Translucency is inherently a two-sided effect: with the translucent shader,
backface illumination appears on front faces. To generate translucency, both
sides of the material receive diffuse light, though only one side is visible in
renderings and shaded viewports unless you turn on 2-Sided (in the Shader
Basic Parameters rollout).

If you use radiosity on page 6168, it will process light transmitted by translucency.
The accuracy of this depends on the mesh: the more subdivided the faces are,
the more accurate the solution will be (at a cost of processing time).

For specular highlights, you have a choice: to model materials like translucent
plastic, you can choose to have highlights on both sides; to model materials
like frosted glass, which is reflective on one side only, you can choose to have
highlights on only one side. This is controlled by the Backside Specular toggle
in the translucent highlight controls.
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TIP To simulate frosted glass, a fine-grained bump map can also help.

The translucent effect appears only in renderings. It does not appear in shaded
viewports.

NOTE The translucent shader does not simulate the scattering of light within the
object. Because of this, it is better at simulating thin objects such as glass or paper,
than at thick objects. For thicker objects, the light passing through might saturate
excessively. To avoid this, try reducing the HSV Value of the material's Translucent
Color.

Translucent materials also capture shadows cast on the backfaces of the
material. However, because the translucent shader doesn't scatter light, for
thicker objects the effect is not an accurate simulation of real-world
translucency.

WARNING Do not use shadow maps with the translucent shader. Shadow maps
result in artifacts at the edge of translucent objects.

See also:

■ Shader Basic Parameters Rollout on page 5397

■ Basic Parameters Rollout (Standard Material) on page 5406

■ Translucency Setting on page 5447

■ Translucent Highlights on page 5457

Basic Parameters for Standard Materials

Color Controls

Material Editor > Standard material > Anisotropic, Blinn, Metal, Multi-Layer,
Oren-Nayar-Blinn, or Phong Basic Parameters rollout > First group in the
rollout (unlabeled)

Color controls set the colors for different color components. You can set the
color by clicking the color swatch to display the Color Selector on page 391.
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NOTE The Metal shader does not have a Specular component, because it generates
the specular color automatically. The Multi-Layer shader can have two different
Specular color components, so for this material the Specular color swatches are
found in the Specular Highlights group. The Strauss shader has only a single color
component, which corresponds to Diffuse.

1. Specular color

2. Diffuse color

3. Ambient color

Copying and Locking Color Components

For convenience in changing color components, the Material Editor lets you
copy one color component to another by dragging, and to lock two color
components together with the lock buttons to the left of the Ambient and
Diffuse, and Diffuse and Specular color swatches.

When you drag and drop a color swatch, the Copy or Swap Colors dialog on
page 5366 asks if you want to copy the color or swap the two colors.

In general, materials with two identical color components do not look realistic,
and except for materials that are close to solid black, you should avoid using
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copied or locked color components in materials you use in a scene. Color
copying and locking are best used as conveniences when you design a new
basic material.

Shortcut Map Buttons

The small buttons to the right of the color swatches access the Material/Map
Browser on page 5357, where you select a map for that component. These buttons
are shortcuts: you can also use the corresponding buttons in the Maps rollout
on page 5414 If you have assigned a map to one of these color components, the
button displays the letter M. An uppercase M means that the corresponding
map is assigned and active. A lowercase m means that the map is assigned
and inactive (turned off).

 The lock button to the right of the Diffuse map button locks Ambient
mapping to Diffuse mapping. It is on by default. Usually it makes sense to use
the same map for the ambient and diffuse components. To use different maps
for ambient and diffuse, turn off the lock button. A map shortcut button for
Ambient appears.

Procedures

To change a color component:

1 Click the color swatch next to the color component you want to change.

The Material Editor displays a Color Selector on page 391.

Right-clicking the color swatch also displays the Color Selector.

2 Use the Color Selector to change the values of the color component.

As you change color values, the color component also changes in the
sample slot.

To copy one color component to another:

1 Drag the color swatch of the color you want to copy to the color swatch
of the other color component.

A Copy or Swap Colors dialog on page 5366 is displayed.

2 Click Copy to replace the second color swatch with the color you dragged.
Click Swap to swap the two color components.
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To lock two color components:

1  Click the lock button between Ambient and Diffuse or between
Diffuse and Specular.

The Material Editor displays an alert that asks whether you want to lock
the two color components.

2 Click Yes.

The color above replaces the color below. In other words, Ambient replaces
Diffuse and Diffuse replaces Specular.

If two colors are locked, and you lock the other two, all three component
colors are replaced by the active color.

While two colors are locked, adjustments to one color component affect
the other as well.

To unlock two color components:

■  Click the lock button to turn it off.
The two colors remain the same until you change one of them, or both.

Interface

Ambient Controls the ambient color on page 7906. The ambient color is the
color in shadow (indirect light).

Diffuse Controls the diffuse color on page 7955. The diffuse color is the color
in direct light.

Specular Controls the specular color on page 8133. The specular color is the
color of the highlight on a shiny object. You can control the size and shape
of highlights in the Specular Highlights group, described below.
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Self-Illumination Setting

Material Editor > Standard material > Anisotropic, Blinn, Metal, Multi-Layer,
Oren-Nayar-Blinn, or Phong Basic Parameters rollout > Self-Illumination group

These controls make the material self illuminated on page 8122. Self-illumination
creates the illusion of incandescence by replacing shadows on the surface with
the diffuse color. As you increase self-illumination, the self-illumination color
takes over from the ambient color. At a setting of 100, the material shows no
shaded areas, although it can show specular highlights.

The self-illumination color appears in viewports. (In releases prior to 3ds Max
5,, viewports showed the self-illumination value but not the color.)

NOTE The Strauss shader on page 5431 does not have self-illumination.

There are two ways to specify self-illumination. You can turn on the check
box and use a self-illumination color, or turn off the check box and use a
monochrome spinner, which is comparable to using a gray scale
self-illumination color.

Self-illuminated materials do not show shadows cast onto them, and they are
unaffected by the lights in the scene. The brightness (Value in the HSV color
description on page 8105) remains the same regardless of the scene's lighting.

To make a visible light source in a scene, you can combine a geometric object
with a light object, and give the geometric object a self-illuminating surface.
For example, you could create a lofted light bulb shape, assign it a
self-illuminating white or yellowish material, and place an omni light in the
same location.

To make a material both self-illuminating and transparent, use the Additive
transparency type in combination with self-illumination. See Extended
Parameters on page 5408.
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A self-illuminated object using a percentage value and a color

Procedures

To make a material self-illuminating:

1 Click the color swatch in the Self-Illumination group.

2 In the Color Selector on page 391, choose a color for self-illumination.

3 Use the color's Value parameter (in the HSV model) to increase or decrease
the amount of self-illumination on page 8122.

You can also set self-illumination with a monochrome spinner. To do
so, turn off the self-illumination check box and adjust the spinner.

The self-illumination color is mixed with the material's diffuse color. The
closer to black the self-illumination color, the more diffuse color is used.

As self-illumination increases, the sample object appears flatter and more
luminous.
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Interface

Color check box When on, the material uses a special self-illumination color.
When off, the material uses the diffuse color for self-illumination, and displays
a spinner to control the self-illumination amount. Default=off.

Color swatch When Color is on, the color swatch shows the self-illumination
color. To change the color, click the swatch and then use the Color Selector
on page 391. Adjusting the Value (in the color's HSV description on page 8105)
adjusts the amount of self-illumination. The greater the Value, the more the
self-illumination color dominates both the ambient and diffuse color
components.

Mono spinner When Color is off, the diffuse component is used as the
self-illumination color, and this spinner lets you adjust the amount of
self-illumination. At 0, there is no self-illumination. At 100, the diffuse color
takes over from the ambient color.

Click the map button to assign a map to the self-illumination component.
See Self-Illumination Mapping on page 5469. This button is a shortcut: you can
also assign self-illumination mapping in the Maps rollout on page 5414.

Opacity

Material Editor > Standard material > Anisotropic, Blinn, Metal, Multi-Layer,
Oren-Nayar-Blinn, or Phong Basic Parameters rollout > Opacity group
(unlabeled)

Opacity controls whether a material is opaque, transparent, or translucent.
(A more physically accurate way to generate translucency is to use the
Translucent shader on page 5434.)
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Controlling opacity using the Opacity setting (left) or an opacity map (right).

Procedures

To reduce a material's opacity:

■ Change Opacity to a value less than 100%.
The material becomes more transparent. A fully transparent object (0%
Opacity) is nearly invisible except for the light it reflects (the specular
highlights).

To preview transparency in the sample slots, view the sample object against
a background. Click the checkered Background button on page 5329 to the
right of the sample slots.

Transparent materials render more realistically when you turn on 2-Sided
in the material's Shader Basic Parameters on page 5397.
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Interface

Opacity Sets the opacity/transparency of the material as a percentage. The
effect is best previewed against a pattern background on page 5329 in the sample
slot. You can control opacity falloff on page 8068 in the Extended Parameters.

Click the map button to assign a map to the opacity component. See Opacity
Mapping on page 5470. This button is a shortcut: you can also assign opacity
mapping in the Maps rollout on page 5414.

Diffuse Level

Material Editor > Standard material > Anisotropic, Multi-Layer, or
Oren-Nayar-Blinn Basic Parameters rollout > Diffuse Level group (unlabeled)
or Advanced Diffuse group

Diffuse Level controls the brightness of the material's diffuse component.
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NOTE The Blinn, Metal, Phong, and Strauss shaders do not have Diffuse Level
control.

Adjusting diffuse level

Procedures

To adjust the diffuse level:

■ Change the value of Diffuse Level.
The material grows lighter or darker. Lowering the Diffuse Level dims the
material's diffuse color without affecting the specular highlight. Diffuse
Level is intended primarily so you can create a map on page 5462 that makes
portions of the material very dark.

Interface
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Diffuse Level Increasing this value increases diffuse brightness, and decreasing
it reduces diffuse brightness without affecting the specular highlight. You can
increase the diffuse level over and above the diffuse color's Value (in its HSV
description on page 8105). This parameter can range from 0 to 400. Default=100.

Click the map button to assign a map to the diffuse level parameter. See Diffuse
Level Mapping on page 5462. This button is a shortcut: you can also assign
diffuse level mapping in the Maps rollout on page 5414.

Roughness

Material Editor > Standard material > Multi-Layer or Oren-Nayar-Blinn Basic
Parameters rollout > Advanced Diffuse group (unlabeled for Multi-Layer)

Roughness controls the rate at which the diffuse component blends into the
ambient component.

NOTE The Roughness parameter is available only with the Oren-Nayar-Blinn on
page 5429 and Multi-Level on page 5428 shaders, and with the Arch & Design material
(mental ray) on page 5544.

Increasing the blending area between ambient and diffuse with Roughness
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Procedures

To adjust the roughness:

■ Change the value of Roughness.
Increasing roughness makes the material have a flatter, more matte
appearance.

Interface

Roughness As you increase this value, the matte appearance of the material
increases. It also grows darker and appears more flat. At 0, the roughness is
the same as it is with Blinn shading on page 5426. Range (Oren-Nayar-Blinn and
Multi-Layer)=0 to 100. Range (Arch & Design material)=0.0 to 1.0. Default=0.

Click the map button to assign a map to Roughness. This button is a shortcut:
you can also assign Diffuse Roughness mapping on the Maps rollout on page
5414 (Oren-Nayar-Blinn and Multi-Layer) or General Maps rollout on page 5579
(Arch & Design material). See Diffuse Roughness Mapping on page 5464.

Translucency Setting

Material Editor > Standard material > Shader Basic Parameters rollout >
Translucent shader > Translucent Basic Parameters rollout > Translucency
group

The translucency controls are available for the Translucent shader on page
5434.

WARNING Do not use shadow maps with the translucent shader. Shadow maps
result in artifacts at the edge of translucent objects.

Procedures

To make a material translucent:

■ Increase the HSV Value (V) on page 8105 of the Translucent Color.
As the Value increases, the material becomes more translucent. The Hue
of the Translucent Color tints the light that is scattered within the material.
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Translucent materials render more realistically when you turn on 2-Sided
in the material's Shader Basic Parameters on page 5397. The translucent effect
does not appear in shaded viewports.

Example of translucency

Interface

Translucent Clr (Color) Specifies a translucency color. This is the color of
light that is scattered within the material. It does not need to be the same as
the filter color, which is light transmitted by the material. The two color values
are multiplied. Click the color swatch to change the translucent color. Click
the button to assign a map to the translucent color component.

Filter Color Specifies a filter color on page 7976 that is multiplied by the
translucent color. Click the color swatch to change the filter color. Click the
button to assign a map to the filter color component.

The filter, or transmissive color, is the color transmitted through transparent
or semi-transparent materials such as glass. You can use the filter color with
volumetric lighting to create effects such as colored light through a
stained-glass window. Ray-traced shadows on page 8103 cast by transparent
objects are tinted with the filter color.

Opacity Sets the opacity/transparency on page 5442 of the material as a
percentage. The effect is best previewed against a pattern background on page
5329 in the sample slot.

Click the map button to assign a map to the opacity component. See Opacity
Mapping on page 5470. This button is a shortcut: you can also assign opacity
mapping in the Maps rollout on page 5414.
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Specular Highlight Controls

Anisotropic Highlights

Material Editor > Standard material > Anisotropic Basic Parameters rollout >
Specular Highlight group

Material Editor > Raytrace material > Raytrace Basic Parameters rollout >
Shading: Anisotropic > Specular Highlight group

Anisotropic highlights are good for modeling hair, glass, or brushed metal.

NOTE For the Raytrace material on page 5490, the Specular Color component
appears in the Specular Highlight group. Also, highlight controls that don’t pertain
to the current shader are labeled “N / A.”

Procedures

To increase or decrease the size of a highlight:

■ Change the Glossiness value.
The width of the Highlight curves and the highlights in the preview change.
At 0% glossiness, the curves are at their maximum width. At 100%
glossiness, both curves are extremely narrow.

To increase or decrease the strength of a highlight:

■ Change the value of Specular Level.
The intensity of the Highlight curves and the highlights in the preview
change. At 0% specular level, there is no highlight. At 100% specular level,
the curves are at their maximum height with no overloading. At values
greater than 100%, the curves are overloaded: they grow wider, and a wider
area is at the maximum highlight intensity.

The shape of the Highlight curves affects the blending between the specular
and diffuse color regions of the material. The steeper the curve, the less
blending there is and the sharper the edge of the specular highlight.

To adjust the shape (anisotropy) of the highlight:

■ Change the value of Anisotropy.
The width of the white highlight curve and the highlights in the preview
change. At 0% anisotropy, both highlight curves are the same and the
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highlight is circular, as in Blinn and Phong shading. At 100% anisotropy,
the white highlight curve and the highlights are extremely narrow.

To adjust the orientation of the highlight:

■ Change the value of Orientation.
Highlights in the preview show the change in orientation. The display of
the highlight curve does not change.

Interface

Specular Level Affects the intensity of the specular highlight. As you increase
the value, the highlight grows brighter. Default=5.

Click the map button to assign a map to the specular level component. See
Specular Level Mapping on page 5466. This button is a shortcut: you can also
assign specular level mapping in the Maps rollout on page 5414.

Glossiness Affects the size of the specular highlight. As you increase the value,
the highlight gets smaller and the material appears shinier. Default=25.

Click the map button to assign a map to the glossiness component. See
Glossiness Mapping on page 5467. This button is a shortcut: you can also assign
specular level mapping in the Maps rollout on page 5414.

Anisotropy Controls the anisotropy, or shape, of the highlight. At 0, the
highlight is round. At 100, the highlight is extremely narrow. One axis of the
Highlight graph changes to show changes in this parameter. Default=50.

Orientation Changes the orientation of the highlight. The sample slot shows
changes in orientation. This is a value in degrees that can range from 0 to
9,999. Default=0.

Highlight graph These two intersecting curves show the effect of adjusting
the values of Specular Level, Glossiness, and Anisotropy. As you decrease
Glossiness, the curves grow wider; as you increase Specular Level, the curves

5450 | Chapter 19   Material Editor, Materials, and Maps



grow taller. As you adjust Anisotropy, the white curve changes to show how
wide or narrow the highlight is.

Blinn, Oren-Nayar-Blinn, and Phong Highlights

Material Editor > Standard material > Blinn, Oren-Nayar-Blinn, or Phong Basic
Parameters rollout > Specular Highlight group

Material Editor > Raytrace material > Raytrace Basic Parameters rollout >
Shading: Blinn, Oren-Nayar-Blinn, or Phong > Specular Highlight group

The Blinn on page 5426, Oren-Nayar-Blinn on page 5429, and Phong on page 5430
shaders all have circular highlights and share the same highlight controls.
Blinn and Oren-Nayar-Blinn highlights are somewhat softer and rounder than
Phong highlights.

NOTE For the Raytrace material on page 5490, the Specular Color component
appears in the Specular Highlight group. Also, highlight controls that don’t pertain
to the current shader are labeled “N/A.”

Procedures

To increase or decrease the strength of a highlight:

■ Change the value of Specular Level.
The intensity of the Highlight curve and the highlight in the preview
change. At 0% specular level, there is no highlight. At 100% specular level,
the curve is at its maximum height with no overloading. At values greater
than 100%, the curve is overloaded: it grows wider, and a wider area is at
the maximum highlight intensity.

The shape of the Highlight curve affects the blending between the specular
and diffuse color regions of the material. The steeper the curve, the less
blending there is and the sharper the edge of the specular highlight.

To increase or decrease the size of a highlight:

■ Change the Glossiness value.
The width of the Highlight curve and the highlight in the preview change.
At 0% glossiness, the curve is at its maximum width. At 100% glossiness,
the curve is extremely narrow.
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Interface

Specular Level Affects the intensity of the specular highlight. As you increase
the value, the highlight grows brighter. Default=5.

Click the map button to assign a map to the specular level component. See
Specular Level Mapping on page 5467. This button is a shortcut: you can also
assign specular level mapping in the Maps rollout on page 5414.

Glossiness Affects the size of the specular highlight. As you increase the value,
the highlight gets smaller and the material appears shinier. Default=25.

Click the map button to assign a map to the glossiness component. See
Glossiness Mapping on page 5467. This button is a shortcut: you can also assign
specular level mapping in the Maps rollout on page 5414.

Soften Softens the effect of specular highlights, especially those formed by
glancing light. When Specular Level is high and Glossiness is low, you can
get harsh backlights on surfaces. Increase the value of Soften to mitigate this
effect. At 0, there is no softening. At 1.0, the maximum amount of softening
is applied. Default=0.1.

NOTE The Soften control was a check box in releases prior to 3ds Max 2. When
you load a material created in an earlier version of 3ds Max, if Soften was originally
off, the new Soften value is 0.0. If Soften was originally on, the new Soften value
is 0.6.

Highlight graph This curve shows the effect of adjusting the values of Specular
Level and Glossiness. As you decrease Glossiness, the curve grows wider; as
you increase Specular Level, the curve grows taller.

Metal Highlights

Material Editor > Standard material > Metal Basic Parameters rollout > Specular
Highlight group
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Material Editor > Raytrace material > Raytrace Basic Parameters rollout >
Shading: Metal > Specular Highlight group

Metal-shaded materials generate their own specular color. Also, the highlight
curve for the Metal shader differs in shape from the curve for Blinn
Oren-Nayar-Blinn, and Phong highlights on page 5451.

NOTE For the Raytrace material on page 5490, the Specular Color component
appears in the Specular Highlight group. Also, highlight controls that don’t pertain
to the current shader are labeled “N/A.”

Procedures

To increase or decrease the size and intensity of a highlight:

■ Change the Glossiness value.
The width of the Highlight curve and the highlights in the preview change.
At 0% glossiness, the curve is at its maximum width. At 100% glossiness,
the curve is extremely narrow.

To increase or decrease the strength of a highlight:

■ Change the value of Specular Level.
The intensity of the Highlight curve and the highlight in the preview
change. At 0% specular level, there is no highlight. At 100% specular level,
the curve is at its maximum height with no overloading. At values greater
than 100%, the curve is overloaded: it grows wider, and a wider area is at
the maximum highlight intensity.

Increasing the Specular Level also dims the diffuse color.

The shape of the Highlight curve affects the blending between the specular
and diffuse color regions of the material. The steeper the curve, the less
blending there is and the sharper the edge of specular and glancing
highlights.
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Interface

Specular Level Affects the intensity of the specular highlight. As you increase
the value, the highlight grows brighter and the diffuse color grows dimmer.
Default=5.

Click the map button to assign a map to the specular level component. See
Specular Level Mapping on page 5466. This button is a shortcut: you can also
assign specular level mapping in the Maps on page 5414 rollout.

Glossiness Affects the size of the specular highlight. As you increase the value,
the highlight curve grows narrower and the highlight gets smaller. Default=25.

Click the map button to assign a map to the glossiness component. See
Glossiness Mapping on page 5467. This button is a shortcut: you can also assign
specular level mapping in the Maps on page 5414 rollout.

Highlight graph This curve shows the effect of adjusting the values of Specular
Level and Glossiness. As you decrease Glossiness, the curve grows wider; as
you increase Specular Level, the curve grows taller.

Multi-Layer Highlights

Material Editor > Standard material > Multi-Layer Basic Parameters rollout >
First Specular Layer/Second Specular Layer groups

Multi-layer highlights consist of two layers, each of them anisotropic. The
highlights are transparent to each other. Where they overlap, the Multi-Layer
shader blends their colors.

Procedures

To increase or decrease the size of a highlight (specular) layer:

■ Change the Glossiness value.
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The width of the Highlight curves and the highlights in the preview change.
At 0% glossiness, the curves are at their maximum width. At 100%
glossiness, both curves are extremely narrow.

To increase or decrease the strength of a highlight (specular) layer:

■ Change the value of Specular Level.
The intensity of the Highlight curves and the highlights in the preview
change. At 0% specular level, there is no highlight. At 100% specular level,
the curves are at their maximum height with no overloading. At values
greater than 100%, the curves are overloaded: they grow wider, and a wider
area is at the maximum highlight intensity.

The shape of the Highlight curves affects the blending between the specular
and diffuse color regions of the material. The steeper the curve, the less
blending there is and the sharper the edge of the specular highlight.

To adjust the shape (anisotropy) of a highlight (specular) layer:

■ Change the value of Anisotropy.
The width of the white highlight curve and the highlights in the preview
change. At 0% anisotropy, both highlight curves are the same and the
highlight is circular, as in Blinn and Phong shading. At 100% anisotropy,
the white highlight curve and the highlights are extremely narrow.

To adjust the orientation of a highlight (specular) layer:

■ Change the value of Orientation.
Highlights in the preview show the change in orientation. The display of
the highlight curve does not change.

Standard Material | 5455



Interface

The First Specular Layer and Second Specular Layer groups have identical
controls, which can have different settings.

Color Controls the specular color on page 8133 of this highlight. The specular
color is the color of the highlight on a shiny surface.

Level Affects the intensity of this specular highlight. As you increase the value,
the highlight grows brighter. Default: First layer=5, Second layer=0.

Click the map button to assign a map to the specular level component. See
Specular Level Mapping on page 5466. This button is a shortcut: you can also
assign specular level mapping in the Maps rollout on page 5414.

Glossiness Affects the size of this specular highlight. As you increase the value,
the highlight gets smaller and the material appears shinier. Default=25.

Click the map button to assign a map to the glossiness component. See
Glossiness Mapping on page 5467. This button is a shortcut: you can also assign
specular level mapping in the Maps rollout on page 5414.
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Anisotropy Controls the anisotropy, or shape, of this highlight. At 0, the
highlight is round. At 100, the highlight is extremely narrow. One axis of the
Highlight graph changes to show changes in this parameter. Default=0.

Orientation Changes the orientation of this highlight. The sample slot shows
changes in orientation. This is a value in degrees that can range from 0 to
9,999. Default=0.

Highlight graph These two intersecting curves show the effect of adjusting
the values of Level, Glossiness, and Anisotropy. As you decrease Glossiness,
the curves grow wider; as you increase Specular Level, the curves grow taller.
As you adjust Anisotropy, the white curve changes to show how wide or narrow
the highlight is.

Translucent Highlights

Material Editor > Standard material > Translucent Basic Parameters rollout >
Specular Highlight group

Like the Blinn shader, the Translucent shader has circular highlights.

Procedures

To increase or decrease the strength of a highlight:

■ Change the value of Specular Level.
The intensity of the Highlight curve and the highlight in the preview
change. At 0% specular level, there is no highlight. At values greater than
100%, the curve is overloaded: it grows wider, and a wider area is at the
maximum highlight intensity. At 100% specular level, the curve is at its
maximum height with no overloading.

The shape of the Highlight curve affects the blending between the specular
and diffuse color regions of the material. The steeper the curve, the less
blending there is and the sharper the edge of the specular highlight.

To increase or decrease the size of a highlight:

■ Change the Glossiness value.
The width of the Highlight curve and the highlight in the preview change.
At 0% glossiness, the curve is at its maximum width. At 100% glossiness,
the curve is extremely narrow.
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Interface

Specular Level Affects the intensity of the specular highlight. As you increase
the value, the highlight grows brighter. Default=0.

Click the map button next to the spinner to assign a map to the specular level
component. See Specular Level Mapping on page 5466. This button is a shortcut:
you can also assign specular level mapping in the Maps rollout on page 5414.

Glossiness Affects the size of the specular highlight. As you increase the value,
the highlight gets smaller and the material appears shinier. Default=10.

Click the map button next to the spinner to assign a map to the glossiness
component. See Glossiness Mapping on page 5467. This button is a shortcut:
you can also assign specular level mapping in the Maps rollout on page 5414.

Backside specular When on, both sides of the material receive a specular
highlight. When off, only the front side of the material receives a highlight.
Default=on.

Leave Backside Specular on to model materials like translucent plastic. Turn
it off to model materials like frosted glass.

TIP When Backside Specular is turned off, the front side is always the one that
receives a specular highlight. You can change this by reversing the normals of
surfaces that have the translucent-shaded material.

Mapping Standard Material Components

Ambient Color Mapping

Material Editor > Standard material > Maps rollout > Ambient button
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Mapping the ambient color

You can select a bitmap file or procedural map on page 8097 to map an image
to the material's ambient color on page 7906. The image is painted on the shaded
parts of the object.

By default, diffuse mapping maps the ambient component as well, so you
seldom need to use a different map for diffuse and ambient components. If
you do want to apply a separate ambient map, first click to turn off the lock
button to the right of the long Map buttons in the Maps rollout on page 5414.
This unlocks ambient and diffuse mapping. The Map button for ambient color
becomes available. You can then click the ambient button to select a map.

NOTE Ambient color mapping is not visible in viewports or renderings unless the
level of ambient light is greater than default value of black. Choose Rendering >
Environment, then adjust the level of ambient light using the Environment dialog
on page 6689.
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Procedures

To map the ambient color:

1  Make sure the ambient and diffuse components have their maps
unlocked. Click to turn off the lock button. The Map button for ambient
color becomes available.

2 Click the Map button for Ambient color.

The Material/Map Browser on page 5357 is displayed.

3 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

4 Use the map controls to set up the map.

Diffuse Color Mapping

Material Editor > Standard material > Maps rollout > Diffuse button (or Color
button for the Strauss shader)
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Applying a texture by mapping the diffuse color

You can select a bitmap file or procedural map on page 8097 to assign a pattern
or texture to a material's diffuse color on page 7955. The colors of the map replace
the material's diffuse color component. This is the most common kind of
mapping.

Mapping the diffuse color is like painting an image on the surface of the object.
For example, if you want a wall to be made out of brick, you can choose a
map with an image of bricks, such as Bricks on page 5851.

By default, diffuse mapping applies the same map to the ambient color on
page 7906 as well. You seldom need to use a different map for diffuse and ambient
components.

It isn't strictly necessary to lock the ambient and diffuse maps. By turning the
lock off and using a different map for each component, you can obtain
interesting blend effects. But in general, the purpose of diffuse mapping is to
simulate a single surface that is more complex than a basic material, and for
this purpose the lock should be on.
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Procedures

To map the diffuse color:

1 Make sure the ambient and diffuse components have their maps locked.
This button is to the right of the map shortcut buttons for Ambient and
Diffuse on the Basic Parameters rollout, and on the Maps rollout in a
similar position. It is on by default. When it is on, the map button for
the ambient color component is unavailable.

2 Click the Map button for Diffuse color.

The Material/Map Browser on page 5357 is displayed.

3 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

4 Use the map controls to set up the map.

Diffuse Level Mapping

Material Editor > Standard material > Shader Basic Parameters rollout >
Anisotropic, Oren-Nayar-Blinn, or Multi-Level shader > Maps rollout > Diffuse
Level button

5462 | Chapter 19   Material Editor, Materials, and Maps



Mapping diffuse level

Top: No mapping

Bottom: Mapping diffuse level with a bitmap

You can select a bitmap file or procedural map on page 8097 to control the
Diffuse Level parameter. White pixels in the map leave the diffuse level
unchanged. Black pixels reduce the diffuse level to 0. Intermediate values
adjust the diffuse level accordingly.

The diffuse level parameter is available with the Anisotropic on page 5424,
Oren-Nayar-Blinn on page 5429, and Multi-Level on page 5428 shaders.
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Reducing the Amount of the diffuse level map reduces the map's effect, and
increases the effect of the Diffuse Level value on the Basic Parameters rollout.
When the Amount is 0 percent, the map isn't used at all.

Procedures

To map the diffuse level value:

1 Click the Map button for Diffuse Level.

The Material/Map Browser on page 5357 is displayed.

2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Diffuse Roughness Mapping

Material Editor > Standard material > Shader Basic Parameters rollout >
Oren-Nayar-Blinn or Multi-Level shader > Maps rollout > Diff. Roughness
button

You can select a bitmap file or procedural map on page 8097 to control the
Roughness parameter on the Basic Parameters rollout. White pixels in the
map increase roughness. Black pixels reduce roughness to 0. Intermediate
values adjust roughness accordingly.

NOTE The Roughness parameter is available only with the Oren-Nayar-Blinn on
page 5429 and Multi-Level on page 5428 shaders, and with the Arch & Design material
(mental ray) on page 5544.

Reducing the Amount of the Diffuse Roughness map reduces the map's effect,
and increases the effect of the Roughness value on the Basic Parameters rollout.
When the Amount is 0 percent, the map isn't used at all.

Procedures

To map the roughness value:

1 Click the Map button for Diffuse Roughness (Diff. Roughness).

The Material/Map Browser on page 5357 is displayed.
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2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Specular Color Mapping

Material Editor > Standard material > Maps rollout > Specular button

Mapping the specular highlight

You can select a bitmap file or procedural map on page 8097 to apply an image
to the material's specular color component on page 8133. The map's image
appears only in the specular highlight areas.

When the amount spinner is at 100, all specular color is provided by the map.

Specular mapping is used primarily for special effects such as placing an image
in a reflection. The important thing to remember is that, unlike Specular Level
or Glossiness mapping, which alter the intensity and location of specular
highlights, specular mapping alters the color of specular highlights.
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Procedures

To map the specular color:

1 Click the Map button for Specular color.

The Material/Map Browser on page 5357 is displayed.

2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Specular Level Mapping

Material Editor > Standard material > Maps rollout > Specular Level button

Mapping the specular level: the sea reflects more than the land.

You can select a bitmap file or procedural map on page 8097 to alter the intensity
of specular highlights, based on the intensity of the bitmap. White pixels in

5466 | Chapter 19   Material Editor, Materials, and Maps



the map produce full specular highlights. Black pixels remove the specular
highlights completely, and intermediate values reduce the specular highlights
accordingly.

Mapping the specular level component is different from mapping specular
color. Mapping the specular level alters the intensity of highlights, while
specular mapping alters the color of highlights.

Specular level mapping usually works best when you assign the same map to
both Specular Level and Glossiness. (In the Maps on page 5414 rollout, you can
do this by dragging from one map button to another.)

Procedures

To map the specular level value:

1 Click the Map button for the Specular Level value.

The Material/Map Browser on page 5357 is displayed.

2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Glossiness Mapping

Material Editor > Standard material > Maps rollout > Glossiness button
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An object with glossiness mapping. The sea appears more reflective than the land.

You can select a bitmap file or procedural map on page 8097 that affects where
specular highlights appear. A map assigned to glossiness determines which
areas of the whole surface are more glossy and which areas are less glossy,
depending on the intensity of colors in the map. Black pixels in the map
produce full glossiness. White pixels remove glossiness completely, and
intermediate values reduce the size of the highlight.

Mapping the glossiness component is different from mapping specular color.
Mapping glossiness alters the location of highlights, while specular mapping
alters the color of highlights.

Glossiness mapping usually works best when you assign the same map to both
Glossiness and Specular Level. (In the Maps rollout, you can do this by dragging
from one map button to the other.)

Procedures

To map the glossiness value:

1 Click the Map button for the Glossiness value.

The Material/Map Browser on page 5357 is displayed.

5468 | Chapter 19   Material Editor, Materials, and Maps



2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Self-Illumination Mapping

Material Editor > Standard material > Maps rollout > Self-Illumination button

Mapping self-illumination

You can select a bitmap file or procedural map on page 8097 to map the
self-illumination on page 8122 value. This makes portions of an object appear
to glow. White areas of the map render as fully self illuminating. Black areas
render with no self-illumination. Gray areas render as partially self
illuminating, depending on the grayscale value.

Self-illumination means that the glowing area is not affected by lights in the
scene (its ambient color component goes away), and does not receive shadows.
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Procedures

To map the self-illumination value:

1 Click the Map button for Self-Illumination.

The Material/Map Browser on page 5357 is displayed.

2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Opacity Mapping

Material Editor > Standard material > Maps rollout > Opacity button

The gray levels of an opacity map determine the amount of opacity.
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You can select a bitmap file or procedural map on page 8097 to make an object
partially transparent. Lighter (higher-value) areas of the map render as opaque;
darker areas render as transparent; and values in between are semi-transparent.

Setting the opacity map's Amount to 100 applies all of the map. Transparent
areas are fully transparent. Setting the Amount to 0 is the equivalent of turning
the map off. Intermediate Amount values are blended with the Opacity value
on the Basic Parameters rollout. Transparent areas of the map become more
opaque.

Specular highlights are applied to transparent areas of the opacity map, as
well as to opaque areas, creating the effect of glass. If you want the transparent
areas to look like holes, map the specular level on page 5467 as well.

Procedures

To map the opacity value:

1 Click the Map button for Opacity.

The Material/Map Browser on page 5357 is displayed.

2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Filter Color Mapping

Material Editor > Standard material > Maps rollout > Filter Color button
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Mapping filter color

The filter, or transmissive color, is the color transmitted through transparent
or semi-transparent materials such as glass.

You can select a bitmap file or procedural map on page 8097 to map the filter
color component. This map applies a transparent-color effect based on the
intensity of the map's pixels.

You can combine a mapped filter color with volumetric lighting on page 6721
to create effects such as colored light through a stained-glass window.
Ray-traced shadows on page 8103 cast by transparent objects are tinted by the
filter color.

Procedures

To map the filter color:

1 Click the Map button for Filter color.

The Material/Map Browser on page 5357 is displayed.

2 Choose from the list of map types, and then click OK.
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The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Anisotropy Mapping

Material Editor > Standard material > Shader Basic Parameters rollout >
Anisotropic or Multi-Level shader > Maps rollout > Anisotropy button

Mapping anisotropy. The stretch of the highlight depends on the level of gray in the
map.

You can select a bitmap file or procedural map on page 8097 to control the
Anisotropy parameter. The map controls the shape of the anisotropic highlight,
roughly (but not necessarily) within the area specified by the glossiness
parameter. Black and white values have little effect. Maps with a good deal of
grayscale values, such as Noise on page 5886 or Falloff on page 5877, can be very
effective.

The anisotropy parameter is available with the Anisotropic on page 5424 and
Multi-Level on page 5428 shaders.
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The effect of mapping anisotropy is not very apparent unless the specular
level is fairly high and glossiness is fairly low.

Reducing the Amount of the anisotropy map reduces the map's effect, and
increases the effect of the Anisotropy value on the Basic Parameters rollout.
When the Amount is 0 percent, the map isn't used at all.

Procedures

To map the anisotropy value:

1 Click the Map button for Anisotropy.

The Material/Map Browser on page 5357 is displayed.

2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Orientation Mapping

Material Editor > Standard material > Shader Basic Parameters rollout >
Anisotropic or Multi-Level shader > Maps rollout > Orientation button
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Mapping anisotropy orientation

You can select a bitmap file or procedural map on page 8097 to control the
Orientation parameter. Orientation controls the position of the anisotropic
highlight. Mapping orientation changes the highlight's position. Black and
white values have little effect. Maps with a good deal of grayscale values, such
as Noise on page 5886 or Falloff on page 5877, can be very effective. You can also
get a good effect using the same map for orientation mapping and bump
mapping on page 5478.

The orientation parameter is available with the Anisotropic on page 5424 and
Multi-Level on page 5428 shaders.

Reducing the Amount of the orientation map reduces the map's effect, and
increases the effect of the Orientation value on the Basic Parameters rollout.
When the Amount is 0 percent, the map isn't used at all.

The effect of mapping orientation, like anisotropy, is not very apparent unless
the specular level is fairly high and glossiness is fairly low.

TIP Using an instance of the same map to control both anisotropy and orientation
can give you good control over anisotropic highlights.
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Procedures

To map the orientation value:

1 Click the Map button for Orientation.

The Material/Map Browser on page 5357 is displayed.

2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Metalness Mapping

Material Editor > Standard material > Shader Basic Parameters rollout > Strauss
shader > Maps rollout > Metalness button
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Mapping metalness

Top: No mapping

Bottom: Mapping metalness with noise map

You can select a bitmap file or procedural map on page 8097 to control the
Metalness parameter. White pixels in the map increase metalness. Black pixels
reduce metalness to 0. Intermediate values adjust metalness accordingly.

The metalness parameter is available with the Strauss shader on page 5431.

Reducing the Amount of the metalness map reduces the map's effect, and
increases the effect of the Metalness value on the Basic Parameters rollout.
When the Amount is 0 percent, the map isn't used at all.
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Procedures

To map the metalness value:

1 Click the Map button for Metalness.

The Material/Map Browser on page 5357 is displayed.

2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

Bump Mapping

Material Editor > Standard material > Maps rollout > Bump button

An object with two different bump maps.

You can select a bitmap file or procedural map on page 8097 to use for bump
mapping. Bump mapping makes an object appear to have a bumpy or irregular
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surface. When you render an object with a bump-mapped material, lighter
(whiter) areas of the map appear to be raised, and darker (blacker) areas appear
to be low.

NOTE The effect of a bump map is not previewed in viewports. You must render
the scene to see the bump effect.

Bump mapping uses the intensity of the map to affect the surface of the
material. In this case, the intensity affects the apparent bumpiness of the
surface: white areas protrude, and black areas recede.

Use bump maps when you want to take the smoothness off a surface, or to
create an embossed look. Keep in mind, however, that the depth effect of a
bump map is limited. If you want extreme depth in a surface, you should use
modeling techniques instead. For example, the Displace modifier on page 1344
pushes surfaces or faces in and out based on the intensity of a bitmap image.
(Displacement mapping on page 5487 is another way to do emboss a surface.)

Grayscale images can make effective bump maps. Maps that shade between
white and black generally work better than maps with hard edges between
the white and black areas.

The bump map Amount adjusts the degree of bumpiness. Higher values render
as higher relief; low values render as low relief.

The bumps are a simulation created by perturbing face normals before the
object is rendered. Because of this, bumps don't appear on the silhouette of
bump-mapped objects.

TIP If you render a bump-mapped material and notice aliasing in the highlights,
try turning on supersampling on page 5381 and rendering again.

NOTE Most controls on the Output rollout on page 5774 don't affect bump mapping.
Only the Invert toggle is considered; it reverses the direction of the bumps.

Procedures

To assign a bump map:

1 Click the Map button labeled Bump.

The Material/Map Browser on page 5290 is displayed.

2 Choose from the list of map types on page 5767, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.
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(If you choose Bitmap as the map type, you first see a file dialog that lets
you choose the image file.)

3 Use the map controls to set up the map.

TIP To avoid aliasing caused by a 2D bump map, go to the bump map's
Coordinates rollout. Set Blur to be in the range 0.3 to 0.6, and increase Blur
Offset to be greater than 0.0. The default Blur and Blur Offset values work
well for mapping other material components, but for bump mapping, lower
Blur and higher Blur Offset values give better results.

To remove a bump map from a material:

TIP You can disable the map without removing it. Simply turn off the toggle
immediately to the left of the map button on the Special Effects rollout.

1 If the Material Editor is displaying the map controls, click the Type button
on page 5361 to display the Material/Map Browser. If the map controls
aren't visible, click the Bump map button to display them, and then click
the Type button.

2 In the Browser, choose NONE as the map type, and then click OK.

The map is removed.

Reflection Mapping

Material Editor > Standard material > Maps rollout > Reflection button
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Reflection created by mapping

You can select a bitmap file or procedural map on page 8097 to use as a reflection
map.

You can create three kinds of reflection: basic reflection maps, automatic
reflection maps, and flat-mirror on page 7982 reflection maps.

■ A basic reflection map creates the illusion of chrome, glass, or metal by
applying a map to the geometry so that the image looks like a reflection
on the surface.

■ An automatic reflection map uses no mapping at all, but looks outward
from the center of the object, and maps what it sees onto the surface.
Another way to generate reflections automatically is to assign a Raytrace
map on page 5952 to be the reflection map.

■ A flat-mirror reflection map is applied to a series of coplanar faces and
reflects objects facing it, exactly like a real mirror.
Reflection maps don't need mapping coordinates on page 8034 because
they're locked to the world, not to the geometry. The illusion of a reflection
is created because the map doesn't move with the object, but with changes
in the view, as do real reflections.
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The most common use of reflection maps in a realistic scene is to add just a
touch of reflection to an otherwise non-reflective surface. By default, reflection
map strength is 100 percent, as it is for other maps. For many kinds of surfaces,
however, reducing the strength gives the most realistic result. A polished table
top, for example, primarily shows a wood grain; the reflections are secondary.

Reflection maps look more realistic if you increase the Glossiness and Specular
Level values in the Basic Parameters rollout on page 5406. They are also affected
by the diffuse on page 7955 and ambient on page 7906 color values. The darker
the color, the stronger the mirror effect.

Even when the Amount spinner is at 100, the reflection map is tinted by the
ambient, diffuse, and specular on page 8133 colors.

In metal materials, the Diffuse color tints the reflection map. Specifically, the
color from the reflection map is multiplied by the diffuse color (including a
diffuse map, if one exists). The value (in the HSV on page 8105 description) of
the diffuse color controls the reflection map intensity. If the diffuse color
value is 255, the reflection is at full intensity; if the value is 0, the map is not
visible.

In non-metal materials, the Specular color multiplies only reflection maps.
The value (in the HSV on page 8105 description) of the specular color affects
the reflection intensity. If the specular color value is 255, the reflection is at
full intensity; if the value is 0, the map is not visible.

Procedures

To create an automatic reflection:

1 In the Maps rollout, click the Map button labeled Reflection.

2 In the Material/Map Browser on page 5357, choose the Reflect/Refract map
type, and then click OK.

Adjusting the map's Strength slider in the parent material's Maps rollout
controls how reflective the material is. At 100 percent, the material is
fully reflective.

To assign a bitmap as a reflection map:

1 In the Maps rollout, click the Map button labeled Reflection. In the
Material/Map Browser on page 5357, double-click Bitmap.

2 In the Bitmap Parameters rollout, click the Bitmap button.

3 Use the file dialog to choose the bitmap file.
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4 Reduce the Reflection map's Amount to get the effect you want.

Refractions are similar to reflections. Bitmaps simulate reflections, while
Reflect/Refract maps generate them based on the scene's background and
geometry.

Refraction Mapping

Material Editor > Standard material > Maps rollout > Refraction button

Refractions show the scene or background through a refractive object.

You can select a bitmap file or a procedural map on page 8097 such as
Reflect/Refract on page 5964 to use for refraction mapping.

Refraction mapping is similar to reflection mapping. It maps the view onto
the surface in such a way that the image looks like you're seeing it through
the surface, rather than being reflected off it.

Like a reflection map, a refraction map's orientation is locked to the view
rather than to the object. That is, as you move or rotate the object, the position
of the refracted image remains fixed.
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Setting the Index of Refraction

The physical properties of refractive objects often distort the image. A special
parameter adjusts this distortion. It is in the parent material's Extended
Parameters rollout on page 5408.

Index of Refraction The index of refraction (IOR) controls how severely the
material refracts transmitted light. Left at 1.0, the IOR of air, the object behind
the transparent object does not distort. At 1.5 the object behind distorts greatly
(like a glass marble). At an IOR slightly less than 1.0, the object reflects along
its edges (like a bubble seen from under water). Default=1.5 (the IOR of typical
glass).

Common IORs (assuming the camera is in air or a vacuum) are:

IOR ValueMaterial

1.0 (exactly)Vacuum

1.0003Air

1.333Water

1.5 to 1.7Glass

2.419Diamond

In the physical world, the IOR results from the relative speeds of light through
the transparent material and the medium the eye or the camera is in. Typically
this is related to the object's density. The higher the IOR, the denser the object.

You can also use a map to control the index of refraction. IOR maps always
interpolate between 1.0 (the IOR of air) and the setting in the IOR parameter.
For example, if you set the IOR to 3.55 and use a black-and-white Noise map
to control IOR, the IORs rendered on the object will be set to values between
1.0 and 3.55; the object will appear denser than air. If, on the other hand, you
set the IOR to 0.5, then the same map values will render between 0.5 and 1.0:
as if the camera is under water and the object is less dense than the water.

Here are some more IOR values for various materials:

IOR ValueMaterial

1.200Carbon Dioxide, Liquid
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IOR ValueMaterial

1.309Ice

1.360Acetone

1.360Ethyl Alcohol

1.380Sugar Solution 30%

1.329Alcohol

1.434Flourite

1.460Quartz, Fused

1.486Calspar2

1.490Sugar Solution 80%

1.500Glass

1.517Glass, Zinc Crown

1.520Glass, Crown

1.530Sodium Chloride

1.544Sodium Chloride (Salt) 1

1.550Polystyrene

1.553Quartz 2

1.570Emerald
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IOR ValueMaterial

1.575Glass, Light Flint

1.610Lapis Lazuli

1.610Topaz

1.630Carbon Bisulfide

1.644Quartz 1

1.644Sodium Chloride (Salt) 2

1.650Glass, Heavy Flint

1.740Methylene Iodide

1.770Ruby

1.770Sapphire

1.890Glass, Heaviest Flint

2.000Crystal

2.417Diamond

2.705Chromium Oxide

2.705Copper Oxide

2.920Amorphous Selenium

3.340Iodine Crystal
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Tip: The Reflect/Refract on page 5964 map type used as a Refraction map doesn't
effectively model a material surrounding an object, such as a pencil in a glass
of water. For this effect, use either the Thin Wall Refraction on page 5971 or the
Raytrace map type on page 5952.

Procedures

To create an automatic refraction:

1 In the Maps rollout, click the Map button labeled Refraction.

2 In the Material/Map Browser on page 5357, choose the Reflect/Refract on
page 5964 map type, and then click OK.

At a Refraction Amount of 100 percent, the material is extremely
refractive, regardless of the material's Opacity setting. At a Refraction
Amount of 0 percent, the map is turned off. When the Amount is less
than 100 percent, both the Reflect/Refract map and the Opacity setting
control transparency.

To assign a bitmap as a refraction map:

1 In the Maps rollout, click the Refraction map button.

2 Use the Material/Map Browser on page 5357 to choose the Bitmap type.

3 Use the file dialog to choose the bitmap file.

For bitmapped refractions, you don't necessarily want to reduce the map
strength.

Displacement Mapping

Material Editor > Standard material > Maps rollout > Displacement button
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Using displacement mapping to alter a surface

A displacement map displaces the geometry of surfaces. The effect is similar
to using the Displace on page 1344 modifier. Unlike bump mapping on page
5478, displacement mapping actually changes the geometry of the surface or
patch tessellation. Displacement maps apply the gray scale of the map to
generate the displacement. Lighter colors in the 2D image push outward more
strongly than darker colors, resulting in a 3D displacement of the geometry.

WARNING A displacement map generates many triangular faces per surface,
sometimes over 1M faces per surface. While displacement mapping can create
good effects, there is a large cost in terms of time and memory.

The displacement Amount is measured as a percentage of the diagonal of the
bounding box for the object that contains the patch or surface. This makes
the displacement effect consistent for all surfaces in an object, and it also
means that when you scale the object, the displacement is scaled with it.

You can apply a displacement map directly to the following kinds of objects:

■ Bezier patches on page 2067

■ Editable meshes on page 2075

■ Editable polymeshes on page 2123
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■ NURBS surfaces on page 2237

For other kinds of geometry such as primitives, extended primitives, compound
objects, and so on, you can't apply displacement mapping directly. To use
displacement mapping with these kinds of objects, apply a Disp Approx on
page 1340 (Displacement Approximation) modifier. This makes the object's
surface displaceable. Disp Approx works with any kind of object that you can
convert to an editable mesh.

Displacement mapping isn't visible in viewports unless you apply a modifier
to make it so.

■ For NURBS surfaces, you can make displacement mapping visible in
viewports and editable as a mesh object by using the Displace NURBS on
page 1117 world space modifier.

■ For editable meshes and objects with Disp Approx applied to them, use
the Displace Mesh on page 1115 modifier to obtain the same effect.

NOTE If you apply a UVW Map on page 1931 modifier to the surface, all maps
obtain their coordinates from the modifier except for the displacement map,
which always obtains its coordinates from the original surface or the Disp
Approx modifier.

Under certain circumstances, such as when the underlying mesh is fairly
simple, displacement mapping of an editable mesh can cause problems because
of the way the underlying mesh is tessellated. (These problems don't occur
when you apply displacement mapping to a NURBS surface.) When this
happens, smoothing does not work properly and you can see the underlying
wireframe mesh in the surface itself. To correct this problem, use these
techniques:

■ Avoid applying displacement mapping to large areas of a single color. Map
the diffuse color and use a small amount of variation, such as slight amount
of noise, in the map you use for the diffuse color.

■ Add a small amount of noise to the map you use for displacement. This
can complicate the tessellation enough to ease the problem.

■ Add detail to the mesh. The more initial faces, and the smoother the mesh
curvature, the more even the displacement mapping will be.
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Procedures

To apply a displacement map to a NURBS surface, editable mesh, or patch:

1 In a material's Maps rollout, click the map button for Displacement.

The Material/Map Browser on page 5357 is displayed.

2 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

3 Use the map controls to set up the map.

To apply a displacement map to other kinds of objects:

1  Select the object. Go to the Modify panel and choose Disp Approx
from the Modifiers drop-down list.

You can adjust the Disp Approx modifiers parameters, or you can leave
them at their default settings.

2  Go to the Material Editor.

3 In a material's Maps rollout, click the map button for Displacement.

The Material/Map Browser on page 5357 is displayed.

4 Choose from the list of map types, and then click OK.

The Material Editor is now at the map level, and displays controls for the
map parameters.

5 Use the map controls to set up the map.

For example, if you chose Bitmap as the map type, you now need to select
the bitmap file to use.

Raytrace Material

Material Editor > Type button > Material/Map Browser > Raytrace
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Balls using raytrace material to reflect each other

Raytrace material is an advanced surface shading material. It supports the
same kinds of diffuse surface shading that a standard material does. It can also
create fully raytraced reflections and refractions. It also supports fog, color
density, translucency on page 8158, fluorescence on page 7984, and other special
effects.

The reflections and refractions Raytrace material generates are more accurate
than those produced by the Reflect/Refract on page 5964 map. Rendering
raytraced objects can be slower than using Reflect/Refract. On the other hand,
Raytrace is optimized for rendering 3ds Max scenes. You can further optimize
it for your scene by excluding specific objects from raytracing.

NOTE If you want accurate, raytraced reflections or refractions in a standard
material you can use the Raytrace map on page 5952, which uses the same raytracer.
The Raytrace map and material share global parameter settings.

IMPORTANT Raytrace map and Raytrace material use a surface's normal to decide
whether a ray is entering or exiting a surface. If you flip the normals of an object,
you can get unexpected results. Making the material 2-Sided doesn't correct the
problem as it often does with reflections and refractions in Standard materials.

In some cases, the colors in the Basic Parameters rollout of Raytrace material
behave differently from colors in standard materials. Standard material has a
diffuse shading model that does an excellent job of rendering solid,
nonreflective objects such as plastic, ceramic, and so on. In effect, this model
applies color to the object. The color components in Raytrace material, on
the other hand, attempt to model their physical counterparts in nature.
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In Raytrace material, the surface reflects its Diffuse color component without
specular reflection, while the Reflect color component controls the amount
of specular reflection. These two material components are layered together.
The results you see depend on the layering effect. For example, if the material
is not transparent and completely reflective, no diffuse color is visible. If the
material is not transparent and completely nonreflective, only the diffuse
color is visible.

The Dynamics Properties rollout for the Raytrace material contains the same
controls as the dynamics properties for a standard material on page 5395.

Raytrace material has a large user interface with a lot of controls. In general,
if you are using Raytrace to create reflections and refractions, the controls in
the Basic Parameters rollout are the only ones you need to adjust. The Extended
Parameters rollout for Raytrace has controls for special effects. The Raytracer
Controls rollout affects the raytracer itself. Use the Raytracer Controls to turn
the raytracer on or off, and to toggle other options. Use the Raytracer Global
Parameters rollout on page 6221 (Rendering > Raytrace Globals) to set options
globally (for all Raytrace materials and maps in the scene), including recursion
depth.

Interface

Raytrace material has the following rollouts, which are described in these
topics:

Raytrace Basic Parameters Rollout on page 5493

Raytrace Extended Parameters Rollout on page 5502

Raytracer Controls Rollout on page 5506

SuperSampling Rollout on page 5381

Raytrace Maps Rollout on page 5509

Raytrace Dynamics Properties Rollout on page 5516

The following are also part of the Raytrace material’s interface:

Raytracer Global Parameters rollout on page 6221

Raytracing Acceleration Parameters Dialog on page 5518

Raytrace Exclude/Include Dialog on page 5519

Raytrace Antialiaser Dialog: Fast Adaptive Antialiaser on page 5522

Raytrace Antialiaser Dialog: Multiresolution Adaptive Antialiaser on page 5524
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Raytrace Basic Parameters Rollout

Main toolbar > Material Editor > Type button > Material/Map Browser > Choose
Raytrace. > Raytrace Basic Parameters rollout

The Raytrace Basic Parameters rollout for a Raytrace material on page 5490
controls the material's shading, color components, reflectivity or refractivity,
and bumps.

Interface

The basic parameters in this rollout are similar to the basic parameters for
standard materials, but the color components of a Raytrace material behave
differently.

As with standard materials, you can use a map for Raytrace color components
and various other parameters. The small buttons to the right of the color
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swatches and parameters take you to the Material/Map Browser on page 5290,
where you select a map of corresponding type. These are shortcuts that also
have corresponding buttons in the Maps rollout. If you have assigned a map
to one of these colors, the button displays the letter M. An uppercase M means
that the corresponding map is assigned and active. A lowercase m means that
the map is assigned and inactive (turned off).

Shading drop-down list Chooses a shader. Depending on the shader you
choose, the Specular Highlight can change to show the controls for that shader.
The alternatives are:

■ Anisotropic: on page 5449 For surfaces with elliptical, "anisotropic" highlights.

■ Blinn: on page 5451 For rounder, softer highlights than Phong shading.

■ Metal: on page 5452 For metallic highlights.

■ Oren-Nayar-Blinn: on page 5451 For matte surfaces such as fabric or
terra-cotta.

■ Phong: on page 5451 For surfaces with strong, circular highlights. Phong is
the default shading type.

2-Sided Same as for standard materials. When on, shades and raytraces both
sides of faces. By default, objects are one-sided in order to speed up rendering.

If you have a 2-sided, reflective and refractive object, and you use the raytrace
map on page 5952 rather than the material, the raytracer runs until it hits the
maximum recursion level. This can be time-consuming.

Wire Same as for standard materials. When on, renders the material in
wireframe mode on page 8172. You can specify the wire size in the Extended
Parameters rollout.

With pixels, wires maintains the same apparent thickness regardless of the
scale of the geometry or how near or far the object is positioned. With units,
the wires appear thinner at a distance and thicker at close range, as if they
were modeled in the geometry.

Face Map Applies the material to the faces of the geometry. If the material is
a mapped material, it requires no mapping coordinates on page 8034. The map
is automatically applied to each facet of the object.

Faceted Renders each face of a surface as if it were flat.

NOTE Raytrace material has the same SuperSampling on page 5381 options as a
Standard material.
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Ambient This is not the same as the standard ambient color. For Raytrace
material, this controls an ambient absorption factor: that is, how much the
material absorbs ambient light. Setting Ambient to white is the same as locking
the ambient and diffuse colors in a standard material. Default=black.

■ Ambient Color check box When on, the material uses an ambient color.
When off, the material uses a spinner to set a grayscale value only.
Default=on.

■ Color swatch When on, the color swatch shows the ambient color. To
change the color, click the swatch and then use the Color Selector on page
391.

■ Mono spinner When the check box is off, the ambient component is
gray, and this spinner lets you adjust the gray value.
Click the map button to assign a map to the ambient component. See
Ambient Mapping on page 5458. This button is a shortcut: you can also
assign ambient mapping on the Raytrace Maps rollout on page 5509.

Diffuse Sets the diffuse color. This is the same as the standard diffuse color.
It is the color that the object reflects, without specular reflection. Reflection
and transparency effects are layered on top of the diffuse result. When Reflect
is 100% (pure white), the diffuse color isn't visible. (This differs from the
standard material.) Default=50% gray.

Reflect Sets the specular reflection color. This is the color that the reflected
environment (that is, the rest of the scene) is filtered through. The color's
Value controls the amount of reflection. If your reflect color is saturated and
the diffuse color is black, the effect is like colored chrome (for example, colored
Christmas tree balls). Default=black (no reflection).

If raytracing is off (on the Raytracer Controls rollout), the object still reflects
the environment, but ignores other objects in the scene. The environment
can be the background color, the environment map, or the map in the Raytrace
material's Environment component.

TIP If you turn off raytraced reflections, set the Reflect color to a color other than
black, and use a Reflect/Refract map for the local environment (see the Environment
parameter, below), you get the same effect as a reflection map in a standard
material. This can improve rendering time.
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NOTE Raytrace reflects and transmits the IDs in material effects channel on page
5348 (G-buffer on page 7991), so it can create glowing reflections, and so on.

■ Reflect Color check box When on, the material uses a reflection color.
When off, the material uses a spinner to set a grayscale value only.
Default=on.

■ Color swatch When the check box is on, the color swatch shows the
reflection color. To change the color, click the swatch and then use the
Color Selector on page 391.

■ Mono spinner When the check box is off, the reflection color component
is gray, and this spinner lets you adjust the gray value.

■ Fresnel Clicking the check box a second time displays this option. When
active, applies a Fresnel effect to the reflection. This can add a bit of
refraction to the reflecting object, depending on the viewing angle of the
object.

Click the map button to assign a map to the reflect component. This button
is a shortcut: you can also assign reflect mapping in the Raytrace Maps rollout
on page 5509.

Luminosity Similar to the Standard material's self-illumination component,
except that it does not depend on the diffuse color. You can have a blue diffuse
object with red luminosity. Default=black.

NOTE When Luminosity is off, the name of this control changes to Self-Illum
(Self-Illumination).

■ Luminosity check box When on, the material uses a luminosity color.
When off, the material uses a spinner to set a grayscale value only for
self-illumination. Default=on.

■ Color swatch When the check box is on, the color swatch shows the
luminosity color. To change the color, click the swatch and then use the
Color Selector on page 391.

■ Mono spinner When the check box is off, the luminosity color
component is gray, and this spinner lets you adjust the gray value.

Click the map button to assign a map to the luminosity component. This
button is a shortcut: you can also assign reflect mapping in the Raytrace Maps
rollout on page 5509.
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Transparency Similar to the standard material's filter color for transmitted
light, combined with the standard material's opacity controls. This color filters
scene elements that are behind the object with Raytrace material. Black is
opaque, white is fully transparent, and any value in between filters objects
behind the raytraced object. A fully saturated color in both the diffuse and
transparency components gives the effect of tinted glass. If you want more of
an opaque look, pick the color you want as a transparent color, copy it to the
diffuse color, make the diffuse color fully saturated, and then adjust the
transparency to get the effect you want. Default=black (no transparency).

If raytracing is turned off (in the Raytracer Controls rollout), the object still
refracts the environment mapping, but ignores other objects in the scene.

NOTE By separating the diffuse, reflect, and transparency components, Raytrace
material gives you a great deal of control over how the object reacts to its
environment. For example, an object might diffusely reflect red, specularly reflect
green, and transmit blue. This is not a real-world effect, but it can be useful.

■ Transparency Color check box When on, the material uses a transparency
color. When off, the material uses a spinner to set a grayscale value only.
Default=on.

■ Color swatch When the check box is on, the color swatch shows the
transparency color. To change the color, click the swatch and then use the
Color Selector on page 391.

■ Mono spinner When the check box is off, the transparency color
component is gray, and this spinner lets you adjust the gray value.

Click the map button to assign a map to the transparency component. See
Filter Color Mapping on page 5471. This button is a shortcut: you can also assign
reflect mapping in the Raytrace Maps rollout on page 5509.

Index of Refr. (Refraction) The index of refraction (IOR) controls how severely
the material refracts transmitted light. At 1.0, the IOR of air, the object behind
the transparent object does not distort. At 1.5, the object behind distorts
greatly, like a glass marble. At an IOR slightly less than 1.0, the object reflects
along its edges, like a bubble seen from under water. Default=1.0.

Common IORs (assuming the camera is in air or a vacuum) are:

IOR ValueMaterial

1.0 (exactly)Vacuum
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IOR ValueMaterial

1.0003Air

1.333Water

1.5 to 1.7Glass

2.419Diamond

In the physical world, the IOR results from the relative speeds of light through
the transparent material and the medium the eye or the camera is in. Typically
this is related to the object's density, and the higher the IOR, the denser the
object.

You can also use a map to control the IOR. IOR maps always interpolate
between 1.0 (the IOR of air) and the setting in the IOR parameter. For example,
if the IOR is set to 3.55 and you use a black-and-white Noise map to control
IOR, the IORs rendered on the object will be set to values between 1.0 and
3.55. The object will appear denser than air. If, on the other hand, your IOR
is set to 0.5, then the same map values will render between 0.5 and 1.0, as if
the camera were under water and the object was less dense than the water.

Here are some more IOR values for various materials:

IOR ValueMaterial

1.200Carbon Dioxide, Liquid

1.309Ice

1.360Acetone

1.360Ethyl Alcohol

1.380Sugar Solution 30%

1.329Alcohol

1.434Flourite
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IOR ValueMaterial

1.460Quartz, Fused

1.486Calspar2

1.490Sugar Solution 80%

1.500Glass

1.517Glass, Zinc Crown

1.520Glass, Crown

1.530Sodium Chloride

1.544Sodium Chloride (Salt) 1

1.550Polystyrene

1.553Quartz 2

1.570Emerald

1.575Glass, Light Flint

1.610Lapis Lazuli

1.610Topaz

1.630Carbon Bisulfide

1.644Quartz 1

1.644Sodium Chloride (Salt) 2
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IOR ValueMaterial

1.650Glass, Heavy Flint

1.740Methylene Iodide

1.770Ruby

1.770Sapphire

1.890Glass, Heaviest Flint

2.000Crystal

2.417Diamond

2.705Chromium Oxide

2.705Copper Oxide

2.920Amorphous Selenium

3.340Iodine Crystal

Specular Highlight group

The controls in this group affect the appearance of specular highlights. Specular
highlights simulate the surface of the raytraced object reflecting the lights in
the scene. Changing the color or intensity of lights in the scene can change
the appearance of specular highlights.

As in standard materials, as you adjust the values in this group the highlight
curve at the right changes to give you an idea of the effect. The material
preview in the sample slot also updates.

Specular Color Sets the specular color on page 8133, assuming there are white
lights in the scene.

Click the color swatch to display the Color Selector on page 391 and change
the highlight color.
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Click the map button to assign a map to the specular color. See Specular
Mapping on page 5465. This button is a shortcut: you can also assign specular
level mapping in the Raytrace Maps rollout on page 5509.

The remaining controls in the Specular Highlight group depend on the active
shader, as shown next to “Shading:” at the top of this rollout. These highlight
controls are the same as for the Standard material shaders.

These are the highlight controls available to Raytrace materials:

■ Anisotropic highlights on page 5449

■ Blinn, Oren-Nayar-Blinn, and Phong highlights on page 5451

■ Metal highlights on page 5452

NOTE Highlight controls that don’t pertain to the current shader are labeled
“N/A.”

Environment Specifies an environment map that overrides the global
environment map. Both Reflect and Transparency use the scene-wide
environment map unless you use this button to specify another map. With
this control, you can use different environment maps on a per-object basis,
or provide an environment to specified objects when the scene as a whole has
none.

This map overrides the scene-wide environment for both reflection and
refraction. To override for refraction alone, see the Transparency Environment
control in the Extended Parameters rollout.

Use the check box to turn this map on or off.

TIP You can use any map as the Raytrace environment, including the Reflect/Refract
on page 5964 map. Reflect/Refract map is often adequate for getting the required
look, and it usually renders more quickly than raytracing the entire scene, especially
if the Raytrace material is transparent. If you are using Raytrace material just to
get the glass to look right on a car's headlight or on a light bulb hanging in the
middle of a room, turn off the raytracer and use an environment map instead.

Lock button Locks the Environment map to the Transparency Environment
map (found on the Extended Parameters rollout on page 5502). When on, the
Transparency Environment map controls are disabled, and a map applied to
the Raytrace Environment applies to the Transparency Environment as well.
When off, the Transparency Environment map controls are enabled, and the
Transparency Environment can have a different map assigned to it. Default=on.

Changing this button’s setting here also changes it on the Extended Parameters
rollout on page 5502 and the Maps rollout on page 5509.
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Bump This is the same as bump mapping on page 5478 for Standard materials.
Click the button to assign the map. Use the spinner to change the bump
Amount. Use the check box to turn the map on or off.

Raytrace Extended Parameters Rollout

Material Editor > Type button > Material/Map Browser > Raytrace > Extended
Parameters rollout

The Extended Parameters rollout for a Raytrace material on page 5490 controls
the material's special effects, transparency properties, and advanced reflectivity.

Interface
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Except for the wireframe controls, the controls in the Extended Parameters
rollout for Raytrace material are specific to the Raytrace material.

Special Effects group

The controls in this group are special effects. They are powerful, but you might
need to experiment to use them effectively.

Object with raytrace material using translucency and fluorescence

Extra Lighting Adds light to the surface of objects with the Raytrace material.
You can view this as an ambient lighting color that you can control on a
per-material basis, but don't confuse it with the ambient absorption from the
Basic Parameters rollout.

By mapping this parameter, you can simulate radiosity: the ambient light that
results from reflected light in a scene. One effect of radiosity is color bleeding.
For example, in strong light a white shirt next to an orange wall will show a
reflected orange color.
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Translucency Creates a translucent effect on page 8158. The Translucency color
is a non-directional diffuse reflection. The diffuse color on an object depends
upon the angle between the surface normal and the position of the light
source. By ignoring the surface normal alignment, this color component
simulates translucent materials.

For thin objects, the appearance can be like shining a light on the back of a
piece of rice paper. You can cast shadows onto the back of the paper and see
them projected through the paper; this works well with a projector light. On
thicker objects, you can get some good wax-like effects.

Fluorescence and Fluor. Bias Creates an effect similar to black light on a
black light poster. The light from a black light is largely ultraviolet, outside
the visible spectrum. Under black light, fluorescent on page 7984 paints flare or
glow. The fluorescence in Raytrace material takes whatever light it sees in the
scene, applies the Bias to it, and then, regardless of the color of the lights in
the scene, illuminates the fluorescent material as if it were lit by white light.

At 0.5, The Bias makes Fluorescence behave just like diffuse coloring. Bias
values higher than 0.5 increase the fluorescent effect, making the object
brighter than other objects in the scene. Bias values lower than 0.5 make the
object dimmer than other objects in the scene. You can get some chromatic
shifting effects with this.

TIP Full saturation and value for the Fluorescence color help give the effect of
commercial fluorescent paints.

TIP A slight amount of Fluorescence can add to the realism of skin and eyes.

Wire group

Size Sets the size of the wire in wireframe mode on page 8172. You can set either
pixels (the default) or current units.

In Chooses how to measure wire. With pixels, wires maintain the same
apparent thickness regardless of the scale of the geometry or how near or far
the object is positioned. With units, the wires appear thinner at a distance
and thicker at close range, as if they were modeled in the geometry.

Pixels (The default.) Measures wire in pixels.

Units Measures wire in 3ds Max units.

Advanced Transparency group

The controls in this group let you further tune transparency effects.
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Transp. (Transparency Environment) Similar to the environment map in
Basic Parameters, but overrides the scene's environment map for transparency
(refraction) only. Transparent objects refract this map, while reflections still
reflect the scene (or the Basic Parameters Environment map, if one is chosen).

Click the button to choose the Transparency Environment map. Use the check
box to toggle the effect of the map.

Lock button Locks the Transparency Environment map to the Environment
map (found on the Basic Parameters rollout on page 5493). When on, the
Transparency Environment map controls are disabled, and a map applied to
the Raytrace Environment applies to the Transparency Environment as well.
When off, the Transparency Environment map controls are enabled, and the
Transparency Environment can have a different map assigned to it. Default=on.

Changing this button’s setting here also changes it on the Basic Parameters
rollout on page 5493 and the Maps rollout on page 5509.

Density The density controls are for transparent materials. If the material is
opaque (the default), they have no effect.

Color Sets a transmission color based on thickness. While filter (Transparency)
color tints objects behind the transparent object, the density color gives the
appearance of color within the object itself, like tinted glass.

To use, first make sure the object is transparent. Click the color swatch to
display the Color Selector. Choose a color, and then turn on the check box.

The Amount controls the amount of density color. Reducing this value reduces
the density color effect. Range=0 to 1.0. Default=1.0.

A thin piece of tinted glass is mainly clear, while a thick piece of the same
glass has more color. The Start and End controls help you simulate this effect.
They are expressed in world units. Start is the position in the object where
the density color begins to appear. (Default=0.0.) End is the position in the
object where the density color reaches its full Amount value. (Default=25.0)
To have a lighter effect, increase the End value. To have a heavier effect, reduce
the End value.

The object must be at least as thick as the Start value before the density color
is visible.

You can map this color component.

Fog Density fog is also a thickness-based effect. It fills the object with a fog
that is both opaque and self illuminated. The effect is like smoke trapped in
a glass, or wax at the tip of a candle. Colored fog in tubular objects can
resemble neon tubes.

To use, first make sure the object is transparent. Click the color swatch to
display the Color Selector. Choose a color, and then turn on the check box.
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The Amount controls the amount of density fog. Reducing this value reduces
the density fog effect and makes the fog translucent. Range=0 to 1.0.
Default=1.0.

The Start and End controls let you adjust the fog effect based on the object's
dimensions. They are expressed in world units. Start is the position in the
object where the density fog begins to appear. (Default=0.0.) End is the position
in the object where the density fog reaches its full Amount value.
(Default=25.0) To have a lighter effect, increase the End value. To have a
heavier effect, reduce the End value.

You can map this color component.

Render objects inside raytraced objects Turns the rendering of objects inside
raytraced objects on or off. Default=on.

Render atmospherics inside raytraced objects Turns the rendering of
atmospheric effects inside raytraced objects on or off. Atmospheric effects
include fire, fog, volume light, and so on. Default=on.

Reflections group

Controls in this group give you finer control over reflections.

Type When set to Default, reflections are layered with the Diffuse color. For
example, if the material is not transparent and completely reflective, no diffuse
color is visible. When set to Additive, reflections are added to the Diffuse color,
as in Standard materials on page 5395. The diffuse component is always visible.

Gain Controls reflection brightness. The lower the gain value, the brighter
the reflection. At a gain of 1.0, no reflection is visible. Default=0.5.

Raytracer Controls Rollout

Material Editor > Type button > Material/Map Browser > Raytrace material >
Raytracer Controls rollout

The Raytracer Controls rollout for a Raytrace material on page 5490 controls
affect the operation of the raytracer itself. It can help you improve rendering
performance.

5506 | Chapter 19   Material Editor, Materials, and Maps



Interface

Local Options group

Enable Raytracing Turns the raytracer on or off. Default=on.

Even with raytracing off, Raytrace material and Raytrace map still reflect and
refract the environment, including both the environment map for the scene,
and the environment map assigned to the Raytrace material.

Raytrace Atmospherics Turns the raytracing of atmospheric effects on or off.
Atmospheric effects include fire, fog, volume light, and so on. Default=on.

Enable Self Reflect/Refract Turns self reflection/refraction on or off.
Default=on.

Can an object reflect itself? For example, a teapot's body reflects the teapot's
handle, but a sphere will never reflect itself. If you don't need this effect, you
can improve render time by turning off this toggle.
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TIP If you have a transparent object such as glass, and Enable Self Reflect/Refract
is on, you don't have to make the object 2-sided on page 7893. The raytracer sees
back faces when exiting refractive objects.

Reflect/Refract Material IDs When on, the material reflects effects assigned
to material IDs in the renderer's G-buffer on page 7991 on or off. Default=on.

By default, Raytrace material and Raytrace map reflect effects assigned to a
material's ID, so that G-buffer effects are not lost. For example, if a raytraced
object reflects a lamp made to glow with the Video Post Glow filter (Lens
Effects Glow), the reflection glows as well.

Raytracer Enable group

These two check boxes turn raytracing of reflections or refractions on or off
for this material. If you are using the Raytrace material to create only reflections
or refractions, turn off the one you aren't using to improve rendering time.

Raytrace Reflections Turns raytracing of reflective objects on or off.
Default=on.

Raytrace Refractions Turns raytracing of transparent objects on or off.
Default=on.

Local Exclude Displays the local Exclude/Include dialog on page 5519.

An object that is excluded locally is excluded from this material only.

TIP Using exclusion lists is one of the best and simplest ways to speed up the
raytracer.

Bump Map Effect Adjusts the effect of bump maps on raytraced reflections
and refractions. Default=1.0.

Falloff End Distance group

Reflect Dims reflections to black at this distance. Default=100.0.

Refract Dims refractions to black at this distance. Default=100.0.

NOTE The toggles for Reflect Falloff and Refract Falloff aren't animatable.

Raytraced Reflection and Refraction Antialiaser group

Controls in this group let you override the global antialiasing settings for
raytraced maps and materials. They are unavailable if antialiasing is turned
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off globally. To turn on antialiasing globally, choose Rendering > Raytrace
Globals to display the  Raytracer Global Parameters rollout on page 6221.

On When on, uses antialiasing. Default=unavailable unless global antialiasing
is on; on if global antialiasing is turned on.

Drop-down list Chooses which antialiasing settings to use. There are three
options:

■ Use Global Antialiasing Settings (The default.) Uses the global antialiasing
settings.
Click ... to open the  Raytracer Global Parameters rollout on page 6221.

■ Fast Adaptive Antialiaser Uses the Fast Adaptive antialiaser, regardless of
the global setting.
Click ... to open the Fast Adaptive Antialiaser dialog on page 5522.

■ Multiresolution Adaptive Antialiaser Uses the Multiresolution Adaptive
antialiaser, regardless of the global setting.
Click ... to open the Multiresolution Adaptive Antialiaser dialog on page
5524.

When you change settings for an antialiaser locally, you don't affect the global
settings for that antialiaser.

Raytrace Maps Rollout

Material Editor > Type button > Material/Map Browser > Raytrace material >
Maps rollout

As with a standard material, the Maps rollout for a Raytrace material on page
5490 contains map buttons for the components of the Raytrace material that
can be mapped.

You can choose from a large variety of map types. See Map Types on page 5767
to find descriptions of these types, and how to set their parameters.

Assigning the Same Map to Different Parameters

Applying the same map to different parameters is useful in some cases. For
example, using a pattern as both a self-illumination map and an opacity map
can make the pattern appear to glow and hover in space.

Raytrace Material | 5509



Blending Map Amounts for Opacity and Other Material Components

The Specular Level, Glossiness, Self-Illumination, and Opacity values in the
four spinners in the Basic Parameters rollout are blended with their associated
map Amount values in the Maps rollout.

When the Opacity spinner is set to 0, the map Amount spinner completely
controls Opacity. That is, reducing the Amount value increases the
transparency of the entire surface. On the other hand, when Opacity is 100,
reducing the map Amount value increases the opacity of the areas where the
Opacity map is less than 1. For example, you can now adjust a Checker Opacity
map so that the solid areas remain solid, while the clear areas are
semi-transparent.

The Specular Level, Glossiness, and Self-Illumination channels all behave in
the same way. A setting of 100 applies all of the map; a setting of 0 is the
equivalent of turning the map off.

When you load old 3ds Max files or bring earlier materials from the Browser
into the Materials Editor, the spinner values for Opacity, Specular Level,
Glossiness, and Self-illumination are altered, where necessary, to maintain
the equivalent material effect.

Procedures

To assign a map:

1 Click a map button.

A modal Material/Map Browser on page 5290 is displayed.

2 Use the Browse From buttons to choose where you want to look.

If you choose Material Library and the dialog's display area is blank, you
need to open a library file. Click the Open button and then choose the
library to browse.

3 Use the display buttons to choose how you view maps.

■ View List shows each map by name.

■ View List + Icons shows a small preview and each map's name.

■ View Small Icons shows a small preview for each map.

■ View Large Icons shows a large preview for each map, along with the
map's name.
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TIP You can resize the Browser dialog to increase the size of the display
area. This is especially useful when you view large icons.

4 Double-click the map you want.

To use the same map for different parameters:

1 In the Maps rollout, use a map button to assign a map.

The Material Editor is now at the map level, and displays controls for the
map parameters.

2  Click Go To Parent to return to the material level, and then open
the Maps rollout.

3 Drag the assigned map button to another map button.

The Copy (Instance) Map dialog on page 5365 is displayed.

4 Choose Copy or Instance, and then click OK.

If you choose Swap, the Material Editor swaps the two button assignments.

To view the parent material's parameters:

■  If you are currently at the map level in the Material Editor, click Go
To Parent.
The parameters for the map's parent material are displayed. Also, the Show
End Result and Go to Parent buttons become unavailable.

To view a map's parameters:

■ If you are currently at the material level in the Material Editor, click the
button that corresponds to the map.
The parameters for the map are displayed. Also, the Show End Result on
page 5356 and Go to Parent on page 5356 buttons become available.

In the Basic Parameters rollout, if a map has been assigned to a color
component or parameter, the corresponding button displays a letter M.
In the Maps rollout, if a map has been assigned, the corresponding button
displays the map name.
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To view a map's location:

■  Click Material/Map Navigator to view the Navigator.
The Material/Map Navigator on page 5357 displays the hierarchy of the
current material, which contains the map.

To go to a map using the Navigator:

■ In the Material/Map Navigator on page 5357, click the name of the map, or
the green or red parallelogram to the left of the map's name.
The Navigator goes to the level of the map, and the Material Editor displays
the controls for the map you clicked.

As the Navigator's map tree shows, maps for basic material components
and parameters are one level below the material itself.

To preview a map in a sample slot:

1 Go to the level of the map, as described in previous procedures.

The Material Editor displays the map's parameters.

2  Turn off Show End Result on page 5356.

The sample slot shows the map instead of the material. If the map
contains sub-maps, these are also visible.

By default, the sample slot displays a map with no three-dimensional
shading. You can change this in the Material Editor Options dialog on
page 5335.

To view the map interactively:

1 Select an object.

2 In the object's creation parameters, make sure that Generate Mapping
Coords is on.

If the object type does not have a Generate Mapping Coordinates toggle,
you need to assign mapping coordinates by applying a UVW Map modifier
on page 1931.

3 In the Material Editor, assign the mapped material to the object.

4 If you are at the material level (the top level), click the appropriate map
button to go to the map level.
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5  Turn on Show Map in Viewport on page 5350.

The map appears on objects assigned the material in all shaded viewports.
Now when you adjust the map, the viewports update to display the
adjustments.

Turning on Show Map In Viewport for one map automatically turns this
button off for all other maps the material has.

Viewports can display 2D maps such as Checker and Bitmap. They cannot
display other kinds of maps such as 3D maps. Show Map in Viewport is
unavailable if the active map type cannot display in viewports.

TIP Displaying mapped materials in a viewport can slow performance. If you
don't need to view the texture, turn off its viewport display.

To turn off interactive texture display:

1 Go to the map level.

If you are at the material level, click the appropriate map button to go
to the map level.

2  Turn off Show Map in Viewport on page 5350.

The object is shaded but the map no longer appears.

To turn a map off:

■ Turn off the map's check box.
The check box is to the left of the map's name on the Maps rollout.

To turn a map on:

■ Turn on the map's check box.
The check box is to the left of the map's name on the Maps rollout.

To change a map's strength:

■ Adjust the map's Amount spinner in the Maps rollout.
The material's sample slot reflects the change.

NOTE Adjusting a map's output (in the map's Output rollout) can also change
the map's strength.

Raytrace Material | 5513



To move directly to an ancestor:

1 Click the arrow to the right of the map's name on page 5360 field.

A drop-down list of ancestors is displayed.

2 Click a name in the Ancestor list.

With this list, you can skip intermediate levels in the tree.

The Ancestor drop-down list shows only part of the tree. It does not show
side branches and siblings. To view these, use the Material/Map Navigator
on page 5357.

 You can also use the Go Forward to Sibling on page 5357 and
Go to Parent on page 5356 buttons.

To change a map type:

1 At the level of a map, click the button labeled Type below the Material
Editor toolbar.

A modal Material/Map Browser on page 5290 is displayed. If you were at a
map, it lists only maps (if you were at a material when you clicked Type,
the Browser lists only materials).

2 Choose a map type from the list, and then click OK.

If you change a map type and the new map type can have component
maps, a Replace Map dialog is displayed. This dialog gives you a choice
between discarding the original map or using it as a component map.

If the new map type does not have components, it simply replaces the
original map type.
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Interface

The Maps rollout for Raytrace contains a wide button for each map type. Click
this button to select a bitmap file stored on disk or to select a procedural-map
type on page 8097. After you select a map, its name and type appears on the
button. Use the check box to the left of the button to turn the effect of the
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map off and on. When the check box is off, the map is not computed and has
no effect in the renderer.

The Amount spinner determines the amount that the map affects the material,
expressed as a percentage of full intensity. For example, a diffuse map at 100%
is completely opaque and covers the base material. At 50%, it is
semi-transparent and the base material (the diffuse, ambient, and other colors
of the material without mapping) shows through.

Lock button Locks the Environment map to the Transparency Environment
map. When on, the Transparency Environment map controls are disabled,
and a map applied to the Raytrace Environment applies to the Transparency
Environment as well. When off, the Transparency Environment map controls
are enabled, and the Transparency Environment can have a different map
assigned to it. Default=on.

Changing this button’s setting here also changes it on the Basic Parameters
rollout on page 5493, and the Extended Parameters rollout on page 5502.

Diffusion Mapping

The Diffusion map component lets you apply an additional, second texture
to modify the Diffuse component. Typically, you will want to reduce the
Amount of this map to allow the main Diffuse map to show through.

For example, you might have a clean, bright image for a billboard. You use
this image as the Diffuse map, and then use a second map as a Diffusion map
to apply soot and city grime.

TIP Animating the Amount can change the appearance of the material over time,
letting the Diffusion map either conceal or reveal the underlying Diffuse map.

NOTE Show Map In Viewport does not display the Diffusion map.

Raytrace Dynamics Properties Rollout

Material Editor > Type button > Material/Map Browser > Raytrace material >
Dynamics Properties rollout

As with a standard material, the Dynamics Properties rollout for a Raytrace
material on page 5490 lets you specify surface properties that affect the animation
of an object upon collision with another object. If there are no collisions in
your simulation, these settings have no effect.
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Since the Dynamics Properties rollout is available at the top level of any
material (including sub-materials), you can specify different surface dynamic
properties for each face in an object. There are also controls in the Dynamics
utility that let you adjust the surface properties at the object level, but only
the Materials Editor lets you alter the surface properties at the sub-object level,
through use of a Multi/Sub-Object material on page 5720.

As a default, the values in the Dynamics Properties rollout provide a surface
that's similar to Teflon-coated hardened steel.

Interface

Bounce Coefficient Sets how far an object bounces after hitting a surface.
The higher the value, the greater the bounce. A value of 1 represents a "perfectly
elastic collision," or a bounce in which no kinetic energy is lost. Default=1.0.

If you've seen the desktop toy with four ball bearings swinging back and forth
on strings and hitting one another, you've seen an example that comes very
close to a bounce coefficient of 1. Generally, hardened steel or a super ball
have a bounce near 1, while lead has a bounce near 0.

Static Friction Sets how difficult it is for the object to start moving along a
surface. The higher this value, the more difficult. Default=0.0.

If something weighs ten pounds and sits on Teflon (a static friction of near
0), it takes almost no force to make it move sideways. On the other hand, if
it sits on sandpaper, then the static friction might be very high, on the order
of 0.5 to 0.8. A static friction near 1 is very difficult to create in the real world
without adhesives or friction material.

Sliding Friction Sets how difficult it is for the object to keep moving over a
surface. The higher this value, the more difficult for the object to keep moving.
Default=0.0.

Once two objects begin to slide over one another, static friction disappears
and sliding friction takes over. Generally, sliding friction is lower than static
friction due to surface tension effects. For example, once steel starts sliding
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over brass (a value of static friction that might run from 0.05 to 0.2), the
sliding friction drops to a significantly lower value, on the order of .01 to 0.1.
For some materials, such as specific friction materials like brake linings, sliding
friction is just as high as static friction because it is used in conjunction with
a nearly frictionless material such as hardened polished steel.

Raytracing Acceleration Parameters Dialog

Rendering menu > Raytracer Settings > Render Setup dialog > Raytracer panel
> Raytracer Global Parameters rollout > Global Raytrace Engine Options group
> Acceleration Controls button

The controls in this dialog let you override the default acceleration values and
specify your own requirements. Typically you don't need to use them, but if
you are familiar with the requirements of your scene, they can help you
optimize raytrace rendering for your specific needs and time constraints.

Raytracing subdivides the scene, organizing it into a tree for raytrace purposes.
A node in this tree is known as a "voxel." Voxel trees are dynamic, and you
can't explicitly specify the structure of the tree. (If you set Max. Divisions to
2, the tree is an octree, which is possibly a more familiar data structure.)

TIP If your scene is particularly unbalanced (for example, it has a giant planet
object and a cluster of small spacecraft objects) keep the Balance setting low.

Interface

Face Limit Sets the maximum number of faces allowed in a lattice voxel before
it is subdivided. Default=10.

Balance Determines the sensitivity of the subdivision algorithm. Increasing
this value uses more memory but can increase performance. Default=4.0.
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Max. Divisions Sets the initial lattice dimension. For example, 4 is a 4 x 4 x
4 lattice. Default=30.

Max. Depth Sets the maximum number of lattice subdivisions. Default=8.

Raytrace Exclude/Include Dialog

Rendering menu > Raytrace Global Include/Exclude

Material Editor > Raytrace material > Raytracer Controls rollout > Local Exclude
button

Material Editor > Raytrace map > Raytracer Parameters rollout > Local Exclude
button

Rendering menu/main toolbar > Raytracer Settings > Render Setup dialog >
Raytracer panel > Raytracer Global Parameters rollout > Global Raytrace Engine
Options group > Exclude button

Upper left: Bottle excluded from both mirrors

Upper right: Bottle reflected by both mirrors

Lower middle: Bottle excluded from one mirror
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These dialogs let you specify which objects the raytracer will and won't see.
This is a good optimization when you are working with complex scenes and
all you really need is for an object to reflect itself or some other, simpler
elements in the scene.

The global dialog affects all Raytrace materials and Raytrace maps in your
scene. The local dialog affects only the current material or map.

TIP Another good use for exclusion can be when you are working on a scene
where the world-space scale of objects is not realistic. For example, consider an
animation of a space dog-fight, with a planet and its moon in the background.
You would use a planet that was actually much smaller, relative to the fighters,
than an actual planet. (For example, the planet might be only five times bigger
than the fighters, and the moon only half as big as the fighters.) If the fighters are
reflective, the reflections of the planet and moon will be incorrect and will give
away the fact that you are using miniatures. In this case, raytrace the reflective
fighters, and laser blasts, and so on, but exclude the planet and moon props from
the raytracer. Create an environment map that represents the planet and moon
at their correct scale, and make that the Raytrace material's local environment.
When you render, the scale of the planet and moon geometry appears to be
correct, and the reflections on the fighters will behave as your eye expects.
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Interface

Both the Global and the Local Exclude/Include dialogs contain the following
controls:

Exclude/Include Choose whether raytracing will exclude or include the
objects named in the list on the right.

Illumination / Shadow Casting / Both For the raytracer, this is turned off
(always set to Illumination).

Scene Objects Select objects from the Scene Objects list on the left, then use
the arrow buttons to add them to the exclusion list on the right.

The Exclude/Include dialog treats a group as an object: you can exclude or
include all objects in a group by selecting the group's name in the Scene
Objects list. If a group is nested within another group, it isn't visible in the
Scene Objects list.
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Search Field The edit box above the Scene Objects list lets you search for
object names by entering names that use wildcards.

Display Subtree When on, indents the list according to the object hierarchy.

Case Sensitive When on, uses case sensitivity when searching object names.

Selection Sets Displays a list of named selection sets. Choosing a selection
set from this list selects those objects in the Scene Objects list.

Clear Clears all entries from the Exclude/Include list on the right.

OK Closes the dialog and retains the exclude or include operations you
performed.

Cancel Closes the dialog and cancels the exclude or include operations you
performed.

Raytrace Antialiaser Dialog: Fast Adaptive
Antialiaser

Rendering menu > Raytracer Settings > RaytracerGlobal Parameters dialog >
Global Ray Antialiaser group > Turn on global ray antialiasing. > Choose Fast
Adaptive Antialiaser from the drop-down list. > ... button

Material Editor > Type button > Material/Map Browser > Raytrace material >
Raytracer Controls rollout > Raytraced Reflection and Refraction Antialiaser
group (enabled only if antialiasing is globally enabled) > Choose Fast Adaptive
Antialiaser from the drop-down list. > ... button

Material Editor > Type button > Material/Map Browser > Raytrace map >
Raytracer Parameters rollout > Raytraced Reflection and Refraction Antialiaser
group (enabled only if antialiasing is globally enabled) > Choose Fast Adaptive
Antialiaser from the drop-down list. > ... button

The Fast Adaptive Antialiaser dialog changes settings for the Raytrace material
and maps Fast Adaptive antialiaser. You can use this dialog either globally,
from the Raytracer Global Parameters rollout on page 6221, or locally, from the
Raytracer Controls rollout on page 5506. When you locally change settings for
an antialiaser, you don't affect the global settings for that antialiaser.
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Interface

Blur / Defocus (Distance Blur) group

Blur Offset is similar to blur offset for Bitmaps, while defocus is based on
distance.

Blur Offset Affects the sharpness or blurriness of the reflections or refractions
without regard to distance. You can use Blur Offset to soften or defocus the
details of a reflection or refraction. The value is specified in pixels. Default=0.0.

TIP The default Blur Offset setting usually produces good results. If you see aliasing
in reflections or refractions, increase its value in increments of 0.5 until the aliasing
goes away.

See Blur/Blur Offset on page 7928.

Blur Aspect This is an aspect ratio that changes the shape of the blur. Usually
you will not need to change it. Default=1.0.
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TIP If you see aliasing that occurs mostly along horizontal lines, try increasing Blur
Aspect to 1.5. This changes the shape of the blurred effect. The reverse is also
true. If aliasing occurs mostly along vertical lines, try decreasing Blur Aspect to
0.5.

Defocusing Defocusing is a blur based on distance. With Defocus, objects
near the surface are not blurred, but objects farther away are blurred. The rays
cast are spread as they leave the Raytrace material object's surface. Default=0.0.

TIP Increasing the value of Defocusing can give a good distance blurring effect.
Small adjustments are usually adequate. Try starting with a value less than 0.1,
and increase or decrease it as necessary. Also try adjusting Reflect Falloff in Raytrace
material or Attenuation in Raytrace map to get the best distance blurring effect.

Defocus Aspect This is an aspect ratio that changes the shape of the
defocusing. Usually you will not need to change it. Default=1.0.

Raytrace Antialiaser Dialog: Multiresolution
Adaptive Antialiaser

Rendering menu > Raytracer Settings > Render Setup dialog > Raytracer panel
> Raytracer Global Parameters rollout > Raytracer Global Parameters > Global
Ray Antialiaser group > Turn on global antialiasing. > Choose Multiresolution
Adaptive Antialiaser from the drop-down list. > ... button

Material Editor > Type button > Material/Map Browser > Raytrace material >
Raytracer Controls rollout > Raytraced Reflection and Refraction Antialiaser
group (enabled only if antialiasing is globally enabled) > Choose
Multiresolution Adaptive Antialiaser from the drop-down list. > ... button

The Multiresolution Adaptive Antialiaser dialog changes settings for the
Raytrace material and maps Multiresolution Adaptive antialiaser. You can use
this dialog either globally, from the Raytracer Global Parameters rollout on
page 6221, or locally, from the Raytracer Controls rollout on page 5506. When
you locally change settings for an antialiaser, you don't affect the global
settings for that antialiaser.
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Interface

Adaptive Control group

Initial Rays Sets the initial number of rays cast per pixel. Default=4.

Threshold Determines the sensitivity of the adaptation algorithm. It can range
from 0 to 1, where 0 always casts the maximum number of rays and 1 always
casts only the minimum number of rays. Default=0.1.

Max. Rays (Maximum Rays) Sets the maximum number of rays the algorithm
will cast. Default=32.
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Blur / Defocus (Distance Blur) group

Blur Offset is similar to blur offset on page 7928 for bitmaps, while Defocusing
is based on distance.

Blur Offset Affects the sharpness or blurriness of the reflections or refractions
without regard to distance. You can use Blur Offset to soften or defocus the
details of a reflection or refraction. The value is specified in pixels. Default=0.0.

TIP The default Blur Offset setting usually produces good results. If you see aliasing
in reflections or refractions, increase its value in increments of 0.5 until the aliasing
goes away.

Blur Aspect This is an aspect ratio that changes the shape of the blur. Usually
you will not need to change it. Default=1.0.

TIP If you see aliasing that occurs mostly along horizontal lines, try increasing Blur
Aspect to 1.5. This changes the shape of the blurred effect. The reverse is also
true. If aliasing occurs mostly along vertical lines, try decreasing Blur Aspect to
0.5.

Defocusing Defocusing is a blur based on distance. With Defocus, objects
near the surface are not blurred, but objects farther away are blurred. The rays
cast are spread as they leave the Raytrace material object's surface. Default=0.0.

TIP Increasing the value of Defocusing can give a good distance blurring effect.
Small adjustments are usually adequate. Try starting with a value less than 0.1,
and increase or decrease it as necessary. Also try adjusting Reflect Falloff in Raytrace
material or Attenuation in Raytrace map to get the best distance blurring effect.

Defocus Aspect This is an aspect ratio that changes the shape of the
defocusing. Usually you will not need to change it. Default=1.0.

Architectural Material

The settings for an Architectural material are physical properties, so it provides
the greatest possible realism when used with photometric lights on page 5005
and radiosity on page 6168. With this combination of features, you can create
lighting studies with a high degree of accuracy.

It is not recommended that you use the Architectural material with standard
3ds Max lights in the scene, or with the Light Tracer. The point of this material
is to provide accurate modeling. Use it with photometric lights and radiosity.
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The mental ray renderer, on the other hand, can render the Architectural
material, with some limitations described below.

TIP If you don't need the degree of realism that the Architectural material provides,
you can use a standard material on page 5395 or other material type.

Material Templates

When you create a new material, you can choose from a variety of templates.
A template is simply a set of preset material parameters, which approximates
the kind of material you want to create, and gives you a starting point. See
Templates Rollout on page 5528.

Rendering Architectural Materials with the mental ray Renderer

The mental ray Renderer on page 6230 can render Architectural materials. There
are some limitations, as follows:

■ Emit Energy (Based on Luminance): This setting is ignored. The
Architectural material does not contribute to the scene's lighting.

■ Sampling Parameters: These settings are ignored, as the mental ray renderer
uses its own sampling.

TIP When rendering with mental ray, instead of the Architectural material, we
highly recommend that you use the Arch & Design material on page 5544. This
material was designed especially for mental ray and provides superior flexibility,
rendering characteristics, and speed.

Interface

Templates Rollout on page 5528

Physical Qualities Rollout on page 5530

Special Effects Rollout on page 5534

Advanced Lighting Override Rollout on page 5536

SuperSampling Rollout on page 5381

mental ray Connection Rollout on page 5385
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Templates Rollout

Material Editor > Architectural material > Templates rollout

The Templates rollout gives you a list of material types to choose from. A
template is simply a set of preset parameters for the Physical Qualities rollout,
which approximates the kind of material you want to create, and gives you a
starting point. Once you choose a template, you can adjust its settings and
add maps on page 5767 to enhance realism and improve the material's
appearance.

The templates do not affect the Diffuse Color on the Physical Qualities rollout,
only the numeric settings.

Interface

Template drop-down list Chooses the kind of material you are designing.
Each template provides preset values for the various material parameters.

These are the material templates provided with 3ds Max. The purpose of most
templates is clear, so the table doesn't comment on all of them.

CommentsTemplate

Ceramic Tile - Glazed

Fabric

Glass - Clear

Glass - Translucent

A neutral white materialIdeal Diffuse

A good base for a diffuse mapMasonry

Shiny and reflectiveMetal
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CommentsTemplate

Less shinyMetal - Brushed

Even less shinyMetal - Flat

Highly shinyMetal - Polished

Completely shinyMirror

Another neutral white materialPaint Flat

Also white, but shinyPaint Gloss

Also white, only slightly shinyPaint Semi-Gloss

Paper

Paper - Translucent

Plastic

A good base for a diffuse mapStone

Has a bit of shininess; also a good base for

a diffuse map

Stone Polished

Neutral; a good base for a diffuse mapUser Defined

Somewhat shiny; also a good base for a

diffuse map

User-Defined Metal

Completely clear and shinyWater

Neutral; a good base for a mapWood Unfinished
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CommentsTemplate

Wood Varnished

Physical Qualities Rollout

Material Editor > Architectural material > Physical Qualities rollout

When you create a new Architectural material on page 5526 or edit an existing
one, the settings on the Physical Qualities rollout are the ones you are most
likely to need to adjust.

Procedures

To match a material's luminance to a light:

WARNING Only photometric lights give correct luminance. Also, the mental ray
renderer disregards the Emit Energy setting.

■  Click to turn on Set Luminance From Light (below the
Luminance setting), then in a viewport, click the light.
After you choose the light, the button turns off once more.

TIP If you are using a radiosity solution on page 6168, make sure to turn on Emit
Energy (Based On Luminance) for any material whose luminance is greater
than zero. This control is on the Advanced Lighting Override rollout on page
5536.
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Interface

Diffuse Color Controls the diffuse color on page 7955. The diffuse color is the
color this material has in direct light. Click the color swatch to display the
Color Selector on page 391 and change the diffuse color.

 Set color to texture average Click to change
the diffuse color to an average of the colors in the current diffuse map. (If no
map is assigned, this button has no effect.)

This button is useful when you are going to reduce the diffuse map’s Amount.
When the diffuse map pattern appears over an average of itself, for most kinds
of materials the effect is more realistic than when the pattern appears over an
unrelated color.

WARNING This button will change the diffuse color even if the diffuse map is
turned off.

Diffuse Map These controls assign a map to the material’s diffuse component.
To assign a map, click the oblong button (labeled “None” by default). This
displays the Material/Map Browser. In the Browser, choose the map type, and
then click OK. If you choose Bitmap as the map type, an additional dialog
prompts you to choose the particular bitmap file to use.
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While a map is assigned to the material, its name appears as the map button’s
label.

■ Amount spinner The spinner at the left sets the amount of diffuse map
to use. This value is a percentage: at 100.0, only the map is visible; at lower
amounts, the diffuse color shows through; at 0.0, the map is not visible at
all.

■ On/off The check box between the spinner and the map button is an
on/off switch. When on, the map appears in the material. When off, the
map does not appear.

Shininess Sets the shininess of the material. This value is a percentage: at
100.0, the material is as shiny as possible; at lower values, it is less shiny; at
0.0, it is not shiny at all.

In general, the shinier a material is, the smaller its specular highlights appear.
Specular highlights are reflections of the lights that illuminate the material.
(The index of refraction can also affect the size of highlights.) Shininess also
controls how much the material reflects other objects in the scene.

NOTE Shininess alone is not sufficient to produce specular reflections and highlights
on a surface. You must also consider the Index Of Refraction (IOR), described
below.

The amount spinner for a shininess map scales the map. If no map is assigned,
the spinner value is used by itself.

Transparency Controls how transparent the material is. This value is a
percentage: at 100.0, the material is completely transparent; at lower values,
the material is partly opaque; and at 0.0, the material is completely opaque.

TIP The effect of transparency is best previewed against a pattern background. If
the material preview doesn’t show a pattern of colored checks, right-click the
material preview or the map preview, and choose Background from the pop-up
menu.

The amount spinner for a transparency map scales the map. If no map is
assigned, the spinner value is used by itself.

Translucency Controls how translucent the material is. A translucent object
transmits light, but also scatters it within the object. This value is a percentage:
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at 0.0, the material is completely opaque; at 100.0, the material is as translucent
as possible.

The amount spinner for a translucency map scales the map. If no map is
assigned, the spinner value is used by itself.

Index of Refraction The index of refraction (IOR) controls how severely the
material refracts transmitted light, and how reflective the material appears.
At 1.0, the IOR of air, the object behind the transparent object does not distort.
At 1.5, the object behind distorts greatly, like a glass marble. Range=1.0 to
2.5.

Common IORs (assuming the camera is in air or a vacuum) are:

IOR ValueMaterial

1.0 (exactly)Vacuum

1.0003Air

1.333Water

1.5 to 1.7Glass

2.419Diamond

In the physical world, the IOR results from the relative speeds of light through
the transparent material and the medium the eye or the camera is in. Typically
this is related to the object's density: the higher the IOR, the denser the object.

The IOR affects how shiny a material appears; or, in the case of transparent
materials such as water or glass, the amount of distortion. For nontransparent
materials, the higher the IOR, the more light is reflected from the material,
and the shinier the material appears.

A refractive index of 1.0 means that all light is transmitted into the material.
In this case, even if the material has a high Shininess value, the surface appears
perfectly diffuse, and shows no specular highlights.

Luminance cd/m2 When its luminance is greater than 0.0, the material
appears to glow, and if you turn on Emit Energy (see below), it contributes
energy to the radiosity solution on page 6168. Luminance is measured in candelas
per meter squared.

The amount spinner for a luminance map scales the map. If no map is assigned,
the spinner value is used by itself.
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 Set luminance from light Obtains the material’s luminance
from a light in the scene. Click to turn on this button, then click a light in a
viewport. The material’s luminance is set to match the luminance of the light,
and the button is turned off once more.

2-Sided When on, makes the material 2-sided on page 7893. Applies the material
to both sides of selected faces.

Raw Diffuse Texture When on, excludes the material from lighting and
exposure control. This makes the material render with a completely flat look,
using the pure RGB values of the diffuse color or map. Default=off.

Special Effects Rollout

Material Editor > Architectural material > Special Effects rollout

When you create a new Architectural material on page 5526 or edit an existing
one, the settings on the Special Effects rollout let you assign maps that create
bumps or displacement, adjust light intensity, or control transparency.

Interface

Bump controls These controls assign a bump map on page 5478 to the material.
To assign a map, click the oblong button (labeled “None” by default). This
displays the Material/Map Browser. In the Browser, choose the map type, and
then click OK. If you choose Bitmap as the map type, an additional dialog
prompts you to choose the particular bitmap file to use.

While a map is assigned to the material, its name appears as the map button’s
label.
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■ Amount spinner The spinner at the left sets the amount of bump mapping
to use. At 1000.0, bump mapping has its greatest effect; at lower amounts,
the bumps are less pronounced; at 0.0, the bumps are not visible at all.
Negative values reverse the direction of the bump effect. Range: –1000.0
to 1000.0.

■ On/off The check box between the spinner and the map button is an
on/off switch. When on, the map is used in the material. When off, the
map is not used.

Displacement controls These controls assign a displacement map on page
5487 to the material. To assign a map, click the oblong button (labeled “None”
by default). This displays the Material/Map Browser. In the Browser, choose
the map type, and then click OK. If you choose Bitmap as the map type, an
additional dialog prompts you to choose the particular bitmap file to use.

While a map is assigned to the material, its name appears as the map button’s
label.

■ Amount spinner The spinner at the left sets the amount of displacement
mapping to use. At 1000.0, displacement mapping has its greatest effect;
at lower amounts, the displacement is less pronounced; at 0.0, the
displacement are not visible at all. Negative values reverse the direction of
the displacement. Range: –1000.0 to 1000.0.

■ On/off The check box between the spinner and the map button is an
on/off switch. When on, the map is used in the material. When off, the
map is not used.

Intensity controls These controls assign an intensity map to the material,
modulating the material's brightness. The map is treated as a black-and-white
scale of intensity values.

TIP Applying a low-frequency Noise map on page 5886 to the intensity can help
reduce the “computer-generated” look of a texture, and add a natural feel to
surfaces such as bricks and carpets lit by daylight.

To assign a map, click the oblong button (labeled “None” by default). This
displays the Material/Map Browser. In the Browser, choose the map type, and
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then click OK. If you choose Bitmap as the map type, an additional dialog
prompts you to choose the particular bitmap file to use.

While a map is assigned to the material, its name appears as the map button’s
label.

■ Amount spinner The spinner at the left sets the amount of intensity
mapping to use. At 100.0, intensity mapping has its greatest effect; at lower
amounts, the effect is less pronounced; at 0.0, the map has no effect; and
at values less than 0.0, the material is dimmed. Range: –100.0 to 100.0.

■ On/off The check box between the spinner and the map button is an
on/off switch. When on, the map is used in the material. When off, the
map is not used.

Cutout controls These controls assign a cutout map on page 5541 to the material.
To assign a map, click the oblong button (labeled “None” by default). This
displays the Material/Map Browser. In the Browser, choose the map type, and
then click OK. If you choose Bitmap as the map type, an additional dialog
prompts you to choose the particular bitmap file to use.

While a map is assigned to the material, its name appears as the map button’s
label.

■ Amount spinner The spinner at the left sets the amount of cutout
mapping to use. This value is a percentage: at 100.0, the map has its full
effect; lower amounts have the effect of darkening the map, reducing its
effect and increasing transparency. At 0.0, the map is completely black,
making objects with this material completely transparent.

■ On/off The check box between the spinner and the map button is an
on/off switch. When on, the map is used in the material. When off, the
map is not used.

Advanced Lighting Override Rollout

Material Editor > Architectural material > Advanced Lighting Override rollout
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When you create a new Architectural material on page 5526 or edit an existing
one, the settings on the Adjust Radiosity rollout let you adjust how the material
behaves in a radiosity solution on page 6168.

Obtaining a Better Image

Materials with a bright diffuse color or high shininess can be highly reflective.
This can lead to overexposed or washed-out radiosity solutions. In general,
the best way to adjust this is to reduce the HSV Value (V) of a material's diffuse
color; or, for a material with a diffuse map, reduce the map's RGB level. In
some situations, the controls on this rollout can improve the appearance of
the radiosity solution. Examples of situations where the material's radiosity
settings can help include color bleeding and large dark areas:

■ You might want to reduce Reflectance Scale or Color Bleed Scale when a
large area of color (for example, a red carpet in a room with white walls)
creates excessive color bleeding. This might be physically accurate, but the
eye adjusts for such effects, and the radiosity result might look better with
less reflectance or less color bleeding.

Left: Excessive bleeding of the floor color onto the walls and ceiling.

Right: Reducing the floor's Reflectance Scale causes less bleeding.

■ You might want to increase Reflectance Scale when the scene includes a
large dark area (for example, a black floor). This can lead to a very dark
radiosity result. You can maintain the floor’s color but increase reflectance,
giving the solution the colors you want while increasing its brightness.
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The room is lit only by spotlights pointed at the floor. Increasing reflectance of the
floor brightens the entire room.

TIP Check the reflectance and transmittance display on page 5324 to get an
idea of how the current material will affect the radiosity solution.

Interface

WARNING There is no problem with reducing the default scale, but increasing it
for any of these parameters might cause colors to “burn out”: if the scale is too
great, they render as pure white, appearing overexposed.

Emit Energy (Based on Luminance) When on, the material contributes
energy to the radiosity solution, based on the material’s luminance value (see
above).
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NOTE The mental ray renderer on page 6230 does not use this setting. The
Architectural material does not contribute to the scene's lighting.

Increasing the Luminance (above 0.0) makes an object appear to glow in
ordinary renderings, but does not contribute energy to the radiosity solution.
To have radiosity processing take a self-illuminating material into account,
turn on Emit Energy (Based On Luminance).

Upper left: By default, luminous neon lights do not influence the scene light.

Right: With Emit Energy on, the radiosity solution takes luminance into account.

TIP When you increase luminance to achieve a special effect in the rendering (for
example, to make the globe surrounding a lamp appear to be glowing), probably
you shouldn't turn on Emit Energy (in the example, both the globe and lamp
would then add light to the scene). When you increase luminance because the
object really glows (for example a neon light tube), then you should turn on Emit
Energy, so that the object contributes light to the scene.

Color Bleed Scale Increases or decreases the saturation of reflected color.
Range=0.0 to 100.0. Default=100.0.
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Color Bleed increases or decreases the saturation of reflected color.

Indirect Bump Scale Scales the effect of the base material’s bump mapping
on page 5478 in areas lit by indirect light. When this value is zero, no bump
mapping is done for indirect light. Increasing Indirect Light Bump Scale
increases the bump effect under indirect lighting. This value does not affect
the Bump amount in areas where the base material is lit directly. Range=–999.0
to 999.0. Default=100.0.

TIP This parameter is useful because indirect bump mapping is simulated and not
always accurate. Indirect Light Bump Scale lets you adjust the effect by hand.

Reflectance Scale Increases or decreases the amount of energy the material
reflects. Range=0.0 to 100.0. Default=100.0.

Reflectance Scale increases or decreases the energy of reflected rays.

TIP Don’t use this control to increase self-illumination. Use the material's Luminance
instead. The Luminance control is on the Physical Qualities rollout on page 5530.

5540 | Chapter 19   Material Editor, Materials, and Maps



Transmittance Scale Increases or decreases the amount of energy the material
transmits. Range=0.1 to 5.0. Default=1.0.

Transmittance Scale increases or decreases the energy of transmitted rays.

Cutout Mapping

Material Editor > Architectural material > Special Effects rollout > Cutout map
button

Assigning a bitmap on page 5795 or procedural map on page 8097 to the Cutout
component of an Architectural material on page 5526 makes the material partially
transparent. Lighter (higher-value) areas of the map render as opaque; darker
areas render as transparent; and values in between are semi-transparent.

Setting the cutout map's Amount to 100 applies all of the map. Transparent
areas are fully transparent. Setting the Amount to 0 is the equivalent of turning
the map off. Intermediate Amount values are blended with the Transparency
value on the Physical Qualities rollout. Transparent areas of the map become
more opaque.
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The gray levels of a cutout map determine the amount of transparency.

Procedures

To use a cutout map:

1 Click the Cutout map button.

The Material/Map Browser on page 5290 is displayed.

2 Choose from the list of map types on page 5767, and then click OK.

The Material is now at the map level, and displays map controls.

(If you choose Bitmap as the map type, you first see a file dialog that lets
you choose the image file.)

3 Use the map controls to set up the map.
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To remove a cutout map from a material:

TIP You can disable the map without removing it. Simply turn off the toggle
immediately to the left of the map button on the Special Effects rollout.

1 If the Material Editor is displaying the map controls, click the Type button
on page 5361 to display the Material/Map Browser. If the map controls
aren't visible, click the Cutout map button to display them, and then
click the Type button.

2 In the Browser, choose NONE as the map type, and then click OK.

The map is removed.

mental ray Materials

3ds Max comes with several materials created specifically for use with the
mental ray renderer on page 6230. These materials are visible in the Material/Map
Browser on page 5290 when mental ray is the active renderer.

■ Arch & Design on page 5579
The Arch & Design material is a monolithic material shader designed to
support most materials used in architectural and product-design renderings.
For most applications this is the recommended material.

■ Car Paint on page 5607
Car Paint, available as both a material and a shader, has components for
a paint layer with embedded metal flakes, a clear-coat layer, and a
Lambertian dirt layer.

■ DGS on page 5615
DGS stands for Diffuse, Glossy, and Specular. This material behaves in a
physically realistic way.

■ Glass on page 5619
The Glass material simulates both the surface properties and the
light-transmitting (photon) properties of glass.

■ Matte/Shadow/Reflection on page 5622
The Matte/Shadow/Reflection (mi) material is used to create “matte
objects”; that is, objects that represent real-world objects in a photograph
used as the scene background. The material provides a wealth of options
for marrying a photographic background with the 3D scene, including
support for bump mapping, ambient occlusion, and indirect illumination.
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■ mental ray on page 5638
The mental ray material has components for the surface shader, and for
the other nine optional shaders that make up a material in mental ray.

■ Subsurface Scattering Materials on page 5693
The subsurface scattering materials, supported by a shader library from
mental images, can model skin and similar organic materials.

■  ProMaterials on page 5647 model materials commonly used in
construction, design, and the environment.

■ Utility mental ray Materials on page 5695
The utility mental ray materials allow you to combine a material with
multiple maps.

NOTE When you wire the parameters of an object with a mental ray material
assigned, the names of material parameters might differ from those in the Material
Editor interface. Also, parameters not supported by 3ds Max might appear as
blanks in the wiring menu.

Arch & Design Material (mental ray)

Material Editor > Type button > Material/Map Browser > Arch & Design Material

Material Editor > any material > Click a Map button. > Material/Map Browser
> Car Paint Shader

Note: The Arch & Design material appears in the Browser only if the mental
ray renderer is the currently active renderer.

The mental ray Arch (architectural) & Design material improves the image
quality of architectural renderings and improves workflow and performance
in general and for glossy surfaces such as floors in particular. Special features
include self-illumination, advanced options for reflectivity and transparency,
ambient occlusion settings, and the ability to round off sharp corners and
edges as a rendering effect.

TIP The Arch & Design material supports hardware-based viewport display for
improved feedback while editing its parameters. For more infomation, see Show
Standard/Hardware Map in Viewport  on page 5350.
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TIP The Arch & Design material interface has built-in descriptions of all of its
important parameters. To view a tooltip describing a parameter of interest, position
the mouse cursor over the control's spinner, color swatch, check box, etc.

See also:

■ Arch & Design Material (mental ray): Overview on page 5579

■ Arch & Design Material (mental ray): Tips and Tricks on page 5593

Procedures

To create a physically correct, self-illuminated surface:

An example of this application is a realistic halogen pendant luminaire with
a translucent shade, such as frosted glass.

1 Create your geometry and obtain or create a photometric file of the
luminaire. Determine the lamp color and intensity, as measured or
provided by the manufacturer; for example: 1,500 cd/m2 and 3,700
degrees Kelvin. Enable tone mapping on page 6732 and global illumination
on page 6261.

2 Create a photometric light (the halogen lamp) and set its color and
intensity.

3 Turn off the light source's Affect Specular property.

4 Create and place the light-shade geometry and apply an Arch & Design
material to it.

5 On the Self Illumination (Glow) rollout, set the same color and intensity
you applied to the light source. Also turn off the Illuminates The Scene
(When Using FG) check box in the Glow Options group.

mental ray Materials | 5545



6 Render the scene.

Interface

Main material parameters rollout on page 5547

BRDF rollout on page 5557

Self Illumination (Glow) rollout on page 5559

Special Effects rollout on page 5563

Advanced Rendering Options rollout on page 5568

Fast Glossy Interpolation rollout on page 5574

Special Purpose Maps rollout on page 5577

General Maps rollout on page 5579

Templates rollout

Provides access to Arch & Design material presets for quickly creating different
types of materials such as wood, glass, and metal. You can also use these as
starting points for generating customized materials. Choose a template from
the drop-down list; a description of the material then appears in the left-hand
pane.

NOTE The Arch & Design material works only with the mental ray renderer, so
in order to see it represented accurately in the sample slots, you must first set
mental ray to render in the Material Editor. For details, see Assign Renderer Rollout
on page 6135.
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Main material parameters rollout

Diffuse group

Diffuse Level Diffuse Level on page 5444 controls the brightness of the diffuse
color component. Range=0.0 to 1.0. Default=1.0.

NOTE Because the material is energy conserving, the actual diffuse level used
depends on the reflectivity and transparency, as discussed in the introductory
section, above.

Color Controls the diffuse color on page 7955. The diffuse color is the color in
direct light. Default=50% gray.

Roughness Roughness on page 5446 controls how quickly the diffuse component
blends into the ambient component. Range=0.0 to 1.0. Default=0.0.

The diffuse component uses the Oren-Nayar shading model. When the
Roughness value is 0.0 this is identical to classical Lambertian shading, but
with higher values the surface gets a more “powdery” look, as shown in the
following illustration.

mental ray Materials | 5547



Left: Roughness=0.0; Center: 0.5; Right: 1.0

Reflection group

Reflectivity The overall level of reflectivity. Range=0.0 to 1.0. Default=0.6.

The Reflectivity and Color values combine to define the level of reflections
as well as the intensity of the traditional highlight, also known as the specular
highlight.

This value is the maximum value; the actual value also depends on the angle
of the surface and comes from the BRDF curve. This curve (see BRDF rollout
on page 5557) lets you define 0–degree reflectivity for surfaces facing the view
and 90–degree reflectivity for surfaces perpendicular to the view.

Left: No reflectivity, with a purely diffuse material
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Center: Angle-dependent reflectivity, with 0–degree reflectivity of 0.1 and a 90–degree
reflectivity of 1.0

Right: Constant reflectivity, with both 0–degree reflectivity and 90–degree reflectivity
of 0.9

NOTE In the preceding illustration, the high reflectivity automatically “subtracts”
from the white diffuse color. If this didn’t happen, the material would become
unrealistically overbright, and would break the laws of physics.

Color The overall color of reflected light. Default=white.

Glossiness Defines the surface “glossiness,” ranging from 1.0 (a perfect mirror)
to 0.0 (a diffusely reflective surface). Default=1.0.

Left: Glossiness=1.0; Center, 0.5; Right, 0.25

Glossy Samples Defines the maximum number of samples (rays) that mental
ray shoots to create glossy reflections. Higher values cause slow rendering but
create a smoother result. Lower values render faster but create a grainier result.
Generally 32 is enough for most cases.

Available only when Glossiness does not equal 1.0. Because a Glossiness value
of 1.0 creates a “perfect mirror,” it is meaningless to shoot multiple rays for
this case, hence only one reflection ray is shot.

NOTE If you set Glossy Samples to 0, the reflections take the form of a “perfect
mirror” and only one ray is shot, regardless of the actual value of Glossiness . You
can use this to boost performance for surfaces with very weak reflections. The
highlight still respects the Glossiness value.
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Glossy reflections need to trace multiple rays to yield a smooth result, which
can affect performance. For this reason, the material includes the following
two special features designed to enhance performance:

Fast (interpolate) When on, a smoothing algorithm allows rays to be reused
and smoothed. The result is faster and smoother glossy reflections at the
expense of accuracy. Interpolation is explained in greater detail in the section
on the Fast Glossy Interpolation rollout on page 5574.

NOTE This method works best on flat surfaces.

Highlights+FG only When on, mental ray traces no actual reflection rays.
Instead, only the highlights are shown, as well as soft reflections emulated
with the help of using Final Gathering.

The Highlights+FG Only mode takes no additional rendering time compared
to a non-glossy (diffuse) surface, yet can yield surprisingly convincing results.
While it might not be completely convincing for “hero” objects in a scene, it
can work very well for less-essential scene elements. It tends to work best on
materials with weak reflections or extremely glossy (blurred) reflections, as
shown in the following illustration:

The two cups on the left use real reflections, while those on the right use Highlights+FG
Only.

Metal material Metallic objects actually influence the color of their reflection,
whereas other materials do not. For example, a gold bar will have gold colored
reflections, but a red glass orb does not have red reflections. This is supported
through the Metal Material option:

■ When off, the Reflection Color parameter defines the color, and the
Reflectivity parameter together with the BRDF settings defines the intensity
and colors of reflections.
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■ When on, the Diffuse Color parameter defines the color of reflections, and
Reflectivity parameter sets the “weight” between diffuse reflections and
glossy (metallic) reflections.

Left: Non-metallic reflections (Metal Material is off). Reflections clearly contain the
color of the objects they reflect and are not influenced by the color of the materials.

Center: Metallic reflections (Metal Material is on). Now the color of reflections are
influenced by the color of the object.

Right: A variant of this with Reflectivity=0.5, creating a 50:50 mix between colored
reflections and diffuse reflections

Refraction group

Transparency Defines the level of refraction. Range=0.0 to 1.0. Default=0.0.

Due to the material's energy-conserving nature, the value set in the
Transparency parameter is the maximum value; the actual value depends on
the reflectivity as well as the BRDF curve.

Color Defines the color of refraction. While this color can be used to create
“colored glass,” a slightly more accurate method to do this is described in the
Colored Glass section on page 5595 of the Tips & Tricks topic.

Glossiness Defines the sharpness of the refraction/transparency, ranging from
1.0 (completely clear transparency) to 0.0 (extremely diffuse or blurry
transparency). Default=1.0.
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Left: Refraction Glossiness=1.0; Center: 0.5; Right: 0.25

Glossy refraction needs to trace multiple rays to yield a smooth result, which
can affect performance. For this reason, the material includes the following
special feature designed to enhance performance:

Fast (interpolate) When on, a smoothing algorithm allows rays to be reused
and smoothed. The result is faster and smoother glossy refraction at the
expense of accuracy. Interpolation is explained in greater detail in the section
on the Fast Glossy Interpolation rollout on page 5574.

NOTE This method works best on flat surfaces.

Glossy Samples Defines the maximum number of samples (rays) that mental
ray shoots to create glossy refraction. Higher values cause slow rendering but
create a smoother result. Lower values render faster but create a grainier result,
like frosted glass. Generally 32 is enough for most cases.

Available only when Glossiness does not equal 1.0. Because a Glossiness value
of 1.0 creates a perfectly clear (non-blurry) transparency, it is meaningless to
shoot multiple rays for this case, hence only one refraction ray is shot.

NOTE If you set Glossy Samples to 0, the refraction takes the form of a “perfect
lens” and only one ray is shot, regardless of the actual value of Glossiness. You
can use this to boost performance for draft renderings.

IOR The Index of Refraction, which is a measurement of how much a ray of
light bends when entering a material.

The direction in which light bends depends on whether it is entering or exiting
the object. The Arch & Design material use the direction of the surface normal
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as the primary cue for figuring out whether it is entering or exiting. It is
therefore important to model transparent, refractive objects with the surface
normals pointing in the proper direction.

The IOR can also be used to define the BRDF curve, which is what happens
in the class of transparent materials known as “dielectric” materials, and is
illustrated here:

Left: IOR=1.0; Center: 1.2; Right: 1.5

The leftmost cup looks completely unrealistic and is almost invisible. Because
an IOR of 1.0, which equals that of air, is impossible in solid matter, we get
no change in reflectivity across the material and hence perceive no edges or
changes of any kind. On the other hand, the center and rightmost cups have
realistic changes in reflectivity guided by the IOR.

Instead of basing the reflectivity on the IOR, you can instead use the BRDF
mode to set it manually:
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Different types of transparency

As in the previous illustration, the leftmost cup acquires its curve from the
index of refraction. The center cup has a manually defined curve, which has
been set to a 90 degree reflectivity of 1.0 and a 0 degree reflectivity of 0.2; this
looks a bit more like metallized glass. The rightmost cup uses the same BRDF
curve, but instead is set to thin-walled transparency on page 5571. Clearly, this
method is better for making non-refractive objects than simply setting IOR
to 1.0, as we tried above.

Translucency group

Translucency is handled as a special case of transparency; in order to use
translucency there must first exist some level of transparency. The
implementation of translucency in the Arch & Design material is a
simplification concerned solely with the transport of light from the back of
an object to its front faces and is not true SSS (subsurface scattering) effect.
You can create an SSS-like effect by using glossy transparency coupled with
translucency, but this is neither as fast nor as powerful as the dedicated SSS
shaders on page 5693.

Translucency When on, the remaining Translucency become available and
take effect when rendering.

Weight Determines how much of the existing transparency is used as
translucency. For example, if Weight=0.0, all of the transparency is used as
transparency. If Weight=0.3, 30 percent of the transparency is used as
translucency.
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All: Transparency=0.75. Left: Weight=0.0; Center: Weight=0.5; Right: Weight=1.0

Translucency is intended for use primarily in thin-walled mode on page 5571,
as in the example above) to model things like curtains, rice paper, and similar
effects. In thin-walled mode it simply allows the shading of the reverse side
of the object to bleed through. The shader also operates in solid mode on page
5571, but, as explained above, the SSS shaders are better suited for such purposes.

Solid translucency with: Left: Weight=0.0; Center: Weight=0.5; Right: Weight=1.0

Color The translucency color.
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Anisotropy group

Anisotropy Controls the anisotropy, or shape, of the highlight. At 1.0, the
highlight is round; that is, no anisotropy. At 0.01, the highlight is elongated.
One axis of the highlight graph changes to show changes in this parameter.
Default=1.0.

Left: Anisotropy=1.0; Center: Anisotropy=4.0; Right: Anisotropy=8.0

Rotation Changes the orientation of the highlight. The sample slot shows
changes in orientation. This value can range from 0.0 to 1.0, with 1.0=360
degrees. So, for example, 0.25=90 degrees and 0.5=180 degrees. Default=0.0.

Left: Anisotropy Rotation=0.0; Center: Anisotropy Rotation=0.25; Right: Anisotropy
Rotation=[texture map]
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TIP When using texture-mapped Anisotropy Rotation, make sure the texture is
not antialiased (filtered). You can achieve this by setting the map's Blur parameter
to 0.0. Otherwise the antialiased pixels cause local vortices in the anisotropy that
appear as seam artifacts.

Automatic/Map Channel Lets you optionally apply anisotropy to a specific
map channel.

If the Map Channel setting is Automatic, the base rotation follows the object's
local coordinate system. If it is any other value (in other words, a specific map
channel), the space that defines the stretch directions of the highlights is
derived from that channel's texture space.

WARNING Deriving the anisotropy from the texture space creates only one space
per triangle and can cause visible seams between triangles.

Also see Brushed Metal on page 5605.

BRDF rollout

BRDF stands for bidirectional reflectance distribution function. As explained in the
introduction on page 5586, this property lets the material's reflectivity be
ultimately guided by the angle from which the object surface is viewed.
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0 degree (green) and 90 degree (red) view angles

[BRDF method] Lets you choose how the BRDF curve is defined:

■ By IOR (fresnel reflections) How the reflectivity depends on the angle is
guided solely by the material's index of refraction. This is known as Fresnel
reflections and follows the behavior of most dielectric materials such as
water and glass.

■ Custom Reflectivity Function When chosen, the following settings
determine reflectivity based on angle of view.

■ 0 deg. refl. Defines the reflectivity for surfaces directly facing the
viewer (or incident ray).

■ 90 deg. refl. Defines the reflectivity of surfaces perpendicular to the
viewer.

■ Curve shape Defines the falloff of the BRDF curve.

This mode is used for most hybrid materials or for metals. Most materials
exhibit strong reflections at grazing angles; hence the 90 degree reflectivity
parameter can generally be kept at 1.0, using the Reflectivity parameter to
guide the overall reflectivity instead. Metals tend to be fairly uniformly
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reflective and the 0 degree reflectivity value is high (0.8–1.0), but many other
layered materials, such as linoleum and lacquered wood have lower 0 degree
reflectivity values, in the range 0.1–0.3). For further information, see Quick
Guide to Some Common Materials on page 5593.

Reflectivity vs. Angle graph Depicts the combined Custom Reflectivity
Function settings.

Self Illumination (Glow) rollout

These parameters let you specify luminous surfaces within the Arch & Design
material, such as a translucent lamp shade. Such a surface does not actually
cast light, but it can optionally act as a source of indirect light when Final
Gather on page 6295 is in effect, and thus can have an impact on scene lighting
in the rendered image.

The optimal settings for self-illuminated surfaces depend on the lighting
conditions and desired effects. This table provides recommended initial settings
for lights and the glow options under different circumstances:

Self-Illuminated Sur-
face

Light Object

Illumin-
ates with
FG

Visible in
Reflec-
tions

Affect
Diffuse

Affect
Specu-
lar

OffOnOnOffArea
Lights

OffOffOnOnPoint
Lights

OnOnnot
applic-
able

not
applic-
able

Glow-
ing Ob-
ject

TIP The easiest way to toggle the Affect Specular and Affect Diffuse switches for
a light source is to select it in the viewport, right-click it, and then use the Tools
1 quadrant settings. This applies to only one light source at a time.
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Self Illumination (Glow) When on, the material is set to be self-illuminating,
and the remaining rollout settings become available. Default=off.

Color group

To set the illumination color, choose either option and adjust its parameter:

■ Light Pick a common lamp specification to approximate the spectral
character of the desired illumination.

■ Kelvin Set the color of the self-illuminated surface by adjusting the color
temperature spinner. The color temperature is displayed in degrees Kelvin.

Filter Use a color filter to simulate the effect of a color filter placed over the
self-illuminated surface. For example, a red filter over a white luminance source
casts red light. Set the filter color by clicking the color swatch to display the
Color Selector on page 391. Default=white (RGB=255,255,255; HSV=0,0,255).

Luminance

To set the brightness of the illuminated surface, choose either option and
then adjust the numeric setting.

■ Physical Units Sets the brightness in candelas per square meter. This is a
physical value that takes the physical scale into account.

■ Unitless Uses an arbitrary numeric value to represent the brightness.
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[numeric value spinner] When Physical Units is chosen, sets the brightness
in cd/m2. When Unitless is chosen, sets the brightness as an arbitrary value.

The following table shows some representative real-world luminance values.

Brightness in cd/m2Object

250Cathode-ray tube (CRT) television screen

140Liquid-crystal diode (LCD) television screen

100Bright light-emitting diode (LED) panel on

an electronic device such as a DVD player

10,000 (average)Frosted lens in front of a desk lamp

10,000 (average)Frosted lens in front of a residential re-

cessed halogen lamp

1300Exterior of a ceramic lamp shade on a

decorative fixture

2500Interior of a ceramic lamp shade on a dec-

orative fixture

210,000Frosted incandescent bulb inside a decor-

ative fixture

8,000Cloudy sky in the afternoon

140White ceiling in a brightly daylit room on

a cloudy day, oriented north

875Reflection from a cloudy sky on a varnished

wooden floor

115Dark asphalt on a cloudy afternoon, out-

doors
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Glow Options

Visible in Reflections When on, the illumination produced by the settings
on this rollout appears in reflections on other surfaces. When off, the object
is still reflected, but the illumination is not.

Illuminates the Scene (when using FG) When on, and Final Gather on page
6295 is in effect, the self-illuminated surface acts as an indirect light source and
contributes to the final gather lighting in the scene. When off, has no effect
on final gather.

Self-illuminated spheres not illuminating the scene
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Self-illuminated spheres illuminating the scene

Special Effects rollout
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Provides settings for ambient occlusion on page 5589 (AO) and round
corners/edges.

Ambient Occlusion group

Ambient occlusion helps emulate the look of global illumination by creating
darker areas where light doesn’t reach without actually generating shadows.
With the Arch & Design material, you can specify ambient occlusion on a
per-material basis.

The following illustration depicts a model helicopter that is lit almost
exclusively by indirect light. Note how the helicopter does not feel “grounded”
in the left-hand image and the shadows under the landing skids are too vague.
The right-hand image uses AO to “punch out” the details and the contact
shadows.

Left: Without AO; Right: With AO

Ambient Occlusion When on, enables ambient occlusion (AO) and makes
the remaining group controls available.

Samples The number of samples (rays) shot for creating AO. Higher values
yield smoother results but render more slowly, while lower values render faster
but look grainier. Values in the range 16–64 cover most situations.

Max Distance Defines the radius within which mental ray looks for occluding
objects. Smaller values restrict the AO effect to small crevices only but are
much faster to render. Larger values cover larger areas but render more slowly.

The following illustrations show the raw AO contribution with two different
distances:
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Left: Higher Max Distance value; Left: Lower Max Distance value

TIP To specify an infinite radius, set Distance to 0.0.

Use Color From Other Materials (Exact AO) When on, derives the AO
coloring from surrounding materials, for more accurate overall results (also
known as color bleeding). For example, a glowing material would return a
brighter color than a dark material.

NOTE When this parameter is on, the function of the Shadow Color setting (see
following) changes to let you specify the extent of color bleeding from nearby
materials.

In the following pair of illustrations, the first image shows the problem with
the traditional AO: It applies to all indirect illumination and always makes it
darker. It is most noticable on the glowing sphere, which has a dark spot under
it, but can also be perceived on the floor in front of the cube which is
suspiciously dark, even though the cube is strongly lit on the front, as well as
between the legs of the horse and the underside of the red sphere.

In contrast, the second image has Use Color From Other Materials on for all
materials, so the floor is lit correctly by the glowing ball, there is a hint of
white bounce light on the floor from the cube, and light appears between the
legs of the horse and on the underside of the red ball.
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Use Color From Other Materials is off

Use Color From Other Materials is on

If you find that using AO creates a “dirty” look with excessive darkening in
corners, or dark rims around self-illuminated objects, turn on Use Color From
Other Materials for a more accurate result.

Shadow Color When Use Color From Other Materials (see preceding) is off,
sets the darkness of the AO shadows. It is used as the multiplier value for
completely occluded surfaces. In practice, a black color makes the AO effect
very dark; a middle-gray color makes the effect less noticeable (brighter), and
so on.
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When Use Color From Other Materials is on, this setting determines the ratio
between the standard AO functionality with Shadow Color set to black and
the color bleeding from other materials. For example, at the default setting,
RGB=0.2, 20 percent of the AO shadow color is derived from black and 80
percent is derived from the color of the nearby material. If you set Shadow
Color to RGB=0.0 (black), then 100 percent of the shadow color comes from
nearby materials. If you set Shadow Color to RGB=1.0 (white), then 100 percent
of the shadow color comes from black; this is the same as turning off Use
Color From Other Materials and setting Shadow Color to black.

Custom/Global Ambient Light Color You can specify a color for the ambient
light used in AO, or use the global color specified on the Environment panel
on page 6689 > Common Parameters rollout.

This parameter is used for doing more traditional AO; that is, supplying an
imagined “ever-present ambient light” that is then attenuated by the AO effect
to create shadows.

While traditional AO is generally used when rendering without other indirect
light, you can also combine it with existing indirect light. Bear in mind that
this “ever-present ambient light” is inherently non-physical, but can possibly
help lighten some troublesome dark corners.

Round Corners group

This effect rounds off corners and straight edges as a rendering effect only; it
has no effect on geometry.

The rounding effect happens to convex corners and surfaces that actually
intersect. Concave corners that merely touch will not display the effect. To
get the effect to work in concave corners the objects must be pushed into each
other a little. The effect is intended for straight edges and is not guaranteed
to work properly for highly curved, complex intersections.

Round Corners When on, rounds off corners and straight edges at render
time.

Fillet Radius Specifies the radius of the filleted corners and/or edges.

Blend With Other Materials By default, the rounding effect happens only
between surfaces of the same material, but if you turn this on the filleting is
performed against any material.

In the following image, the molten chocolate is rounded off against the
submerged objects even though they use different materials. In actuality, the
molten chocolate is a completely flat plane.
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Objects in molten chocolate

Advanced Rendering Options rollout

These parameters define performance-boosting options.
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Reflections group

Max Distance Allows limiting reflections to a certain distance, which both
speeds up rendering and avoids pulling distant objects into extremely glossy
reflections.

Fade to end color When on, reflections fade to this color. When off, reflections
fade to the environment color. The former tends to be more useful for indoor
scenes; the latter, for outdoor scenes.

Available only when Max Distance is on.

Left: Full reflections (Max Distance=off); Center: 100mm; Right: 25mm

Max Trace Depth When this trace depth is reached, the material behaves as
if the Highlights+FG Only switch is on; that is, it shows only highlights and
“emulated” reflections created with the help of Final Gathering.

Cutoff Threshold The level at which reflections are rejected; that is, not
traced. It’s a relative value: For example, the default setting of 0.01 means that
rays that contribute less than 1 percent to the final pixel are ignored. A setting
of 0.25 means that mental ray discards rays that contribute less than a quarter
of the value of the final pixel.

Refraction group

The optimization settings for refraction (transparency) are nearly identical to
those for reflections. The exception is that of Color At Max Distance, which
behaves differently.

Max Distance Allows limiting refraction to a certain distance.
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Color at Max Distance When on, the material simulates physically correct
absorption. At the distance specified by Max Distance, the refracted image
has the color given by Color At Max Distance, but the rays are not limited in
reach. At twice the distance, the influence of Color At Max Distance is double,
at half the distance half, etc.

When off, transparency rays simply fade to black. This is like smoked glass
and other highly absorbent materials. Transparency just stops at the specified
distance. This has the same performance advantage as using the Max Distance
for reflections: Tracing shorter rays is much faster.

Available only when Max Distance is on.

Left: No limit (Max Distance=off); Center: Fade to black; Right: Fade to blue

Max Trace Depth When this trace depth is reached, the material refracts
black.

Cutoff Threshold The level at which refraction is rejected; that is, not traced.
It’s a relative value: For example, the default setting of 0.01 means that rays
that contribute less than 1 percent to the final pixel are ignored. A setting of
0.25 means that mental ray discards rays that contribute less than a quarter
of the value of the final pixel.

Advanced Reflectivity Options group

Visible area lights cause no Highlights When on, mental ray area lights
(Omni on page 5070 and Spotlight on page 5073) with the Show Icon In Renderer
property on create no specular highlights. Default=on.

The Show Icon In Renderer check box is found on the light's Area Light
Parameters rollout. When on, the light is visible and reflects in any glossy,
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reflective objects. If both the reflection of the visible area light and the
highlight is rendered, the light is added twice, causing an unrealistic
brightening effect. When on, this switch causes visible area lights to lose their
highlights and instead only appear as reflections. Note that this does not apply
to the Highlights+FG Only on page 5550 mode, which doesn’t actually reflect
anything.

Skip reflections on inside (except total internal reflection) Most reflections
inside transparent objects are very faint, except in the special case that occurs
at certain angles known as total internal reflection (TIR). When on, this option
saves rendering time by ignoring the weak reflections completely but retaining
the TIRs. Default=on.

Relative Intensity of Highlights Defines the intensity of specular highlights
vs. the intensity of true reflections. When the value is 1.0, the two intensities
are equal. A lower value subdues the intensity of highlights compared to
reflections, while a higher value intensifies the highlights.

Advanced Transparency Options group

The options give you control over some of the deepest details of the Arch &
Design material.

Glass/Translucency treat objects as...

■ Solid The object behaves as if it is made of a solid, transparent substance.

■ Thin-walled The object behaves as if made of wafer-thin sheets of a
transparent material.

For more information, see Solid versus Thin-Walled on page 5588.
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Left: Solid; Right: Thin-walled

When Caustics are enabled, transparent objects: When not rendering
caustics, the Arch & Design material uses a shadow shader to create transparent
shadows. For objects such as window panes this is perfectly adequate, and
actually creates a better result than using caustics, because the direct light is
allowed to pass more or less undisturbed through the glass into a space such
as a room.

Traditionally, enabling caustics in mental ray causes all materials to stop
casting transparent shadows and instead start to generate refractive caustics.
In most architectural scenes this is undesirable; you might want a glass
decoration on a table to generate caustic effect, but still want the windows to
the room to let in normal direct light. This switch makes this possible at the
material level.

■ Refract light and generate Caustic effects The material refracts light and
generates caustics.

■ Use Transparent Shadows No caustics are produced; the material and
object simply transmit the light, with greater shadowing in thicker areas.

In the following illustration, the left side shows the result with Use Transparent
Shadows chosen, and the right side shows the result with Refract Light And
Generate Caustic Effects chosen. You can freely mix the two modes in the
same rendering. Photons are automatically treated accordingly by the built-in
photon shader, shooting straight through as direct light in the former case,
and being refracted as caustics in the latter.
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Left: Using transparent shadows; Right: Using refractive caustics.

Back Face Culling When on, enables a special mode that makes surfaces
invisible to the camera when seen from the reverse side. You can use this to
create “magic walls” in a room. If all walls are planes with the normals facing
inwards, the Back Face Culling switch allows the room to be rendered from
“outside.” The camera can see into the room, but the walls will still exist and
cast shadows, bounce photons, etc. while being invisible when the camera
goes outside.

Left: Back Face Culling=off; Right: Back Face Culling=on

Transparency propagates Alpha channel Defines how transparent objects
treats any alpha channel information in the background. When on, refraction
and other transparency effects propagate the alpha of the background
“through” the transparent object. When off, transparent objects have an
opaque alpha.
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Indirect Illumination Options

FG/GI multiplier Allows tweaking of how strongly the material responds to
indirect light.

FG Quality A local multiplier for the number of final gather rays shot by the
material.

Fast Glossy Interpolation rollout

Glossy reflections and refraction can be interpolated, which causes them to
render faster and look smoother. Interpolation works by precalculating glossy
reflection in a grid across the image. The number of samples (rays) taken at
each point is govern by the Reflection > Glossy Samples on page 5549 or
Refraction > Glossy Samples on page 5552 parameters, as in the non-interpolated
case.

Note that interpolation can cause artifacts. Because it is done on a
low-resolution grid, it can lose details. And because it blends neighbors of this
low-resolution grid, it can cause oversmoothing. For this reason it is useful
primarily with flat surfaces. Interpolation does not work well with wavy, highly
detailed surfaces or surfaces that use bump maps.

Interpolation grid density The resolution of the grid used for interpolating
glossy reflections and refraction. Choose a setting from the drop-down list.

Within the grid, data is stored and shared across the points. Using a lower
grid resolution is faster, but causes greater loss of detail information.
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Reflective interpolation group

Neighboring points to look up Defines how many stored grid points (in an
N by N group around the currently rendered point) is looked up to smooth
out reflective glossiness. The default is 2, and higher values will “smear” the
glossiness more, but are hence prone to more oversmoothing artifacts.

In the following illustration, the reflection of the left cup in the floor does
not use interpolation, and some grain is evident (here intentionally
exaggerated). The floor tiles under the other two cups use a half-resolution
interpolation with point lookup set to 2 (center) and 4 (right), respectively.

Left: No interpolation; Center: Looking up two points; Right: Looking up four points.

The preceding image also illustrates one of the consequences of using
interpolation: The foot of the left cup, which is near the floor, is reflected
quite sharply, and only the parts of the cup far from the floor are blurry.
However, the interpolated reflections of the right cups have a base level of
blurriness, due to the smoothing of interpolation, which makes even the
closest parts somewhat blurry. In most scenes with weak glossy reflections
this discrepancy will never be noticed, but in other cases this can make things
like legs of tables and chairs feel “unconnected” with a glossy floor, if the
reflectivity is high. To resolve this, you can use the High Detail Distance setting
(see following).

High detail distance Allows tracing of a second set of detail rays to create a
“clearer” version of objects within the specified radius.

In the following illustration, all three floor tiles use interpolation but the two
on the right use different distances for the detail distance.
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Left: No detail distance; Center: 25mm detail distance; Right: 150mm detail distance

This also allows an interesting trick: Set Reflection > Glossy Samples to 0,
which renders reflections as if they were mirror-perfect, but also use
interpolation to introduce blur into this reflection, and perhaps use High
Detail Distance to make nearby parts less blurry. This is a fast way to obtain
a glossy reflection.

The floor tiles in the following illustration are rendered with mirror reflections,
and the blurriness comes solely from the interpolation. This renders as fast as
or faster than pure mirror reflections, yet gives a satisfying illusion of true
glossy reflections, especially when utilizing the High Detail Distance option,
as on the right.

Left: No detail distance; Right: With detail distance
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Single Sample from Environment Creating realistically blurry glossy
reflections normally requires taking multiple samples from the environment,
which can result in grainy, slow-rendering environment reflections. With this
check box on, mental ray instead takes only one sample, thus preventing the
grain. This also prevents blurring the environment, so it is best used together
with a local, “pre-blurred" environment map. You can do the pre-blurring in
an image-processing program or with the Material Editor > Coordinates rollout
on page 5782 > Blur and Blur Offset settings.

Refractive interpolation group

Neighboring points to look up Defines how many stored grid points (in an
N by N group around the currently rendered point) are looked up to smooth
out refractive glossiness. The default is 2; higher values tend to “smear” the
glossiness more, but are hence prone to more oversmoothing artifacts.

Special Purpose Maps rollout

Lets you apply bump, displacement, and other maps. Each left-justified setting
has a check box for enabling and disabling the map, and a button for defining
the map.

Bump Lets you apply a bump map and multiplier.

Do not apply bumps to the diffuse shading When off, the bumps apply to
all shading components: diffuse, highlights, reflections, refractions, etc. When
on, bumps are applied to all components except the diffuse. This means bumps
are seen in reflections, highlights, etc. but the diffuse shading shows no bumps.
It is as if the material's diffuse surface is smooth, but is covered by a bumpy
lacquer coating.
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Left: Do Not Apply Bumps ...=off; Right: Do Not Apply Bumps ...=on

Displacement Lets you apply a displacement map and multiplier.

Cutout Lets you apply an opacity map to completely remove parts of objects.
A classic example is to map an image of a tree to a flat plane and use opacity
to cut away the parts of the tree that are not there.

Left: Mapped transparency; Right: Using Cutout

Environment Lets you apply an environment map and shader.

Additional Color/Self illum. Lets you apply any shader. The output of this
shader is added on top of the shading done by the Arch & Design material
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and can be used for self-illumination-type effects, as well as adding any
additional shading you want.

General Maps rollout

This rollout enables application of maps or shaders to any of the Arch & Design
material parameters. Of course, you can apply a shader to a parameter at its
standard location in the user interface by clicking its Map button, so the
principal value of this rollout is that it also lets you toggle a parameter's shader,
using the check box, without removing the map.

Arch & Design Material (mental ray): Overview

This topic serves as an introduction to the Arch & Design material for mental
ray. For a detailed reference to the material interface, see Arch & Design
Material (mental ray) on page 5544. For a variety of suggestions for using the
material to create specific effects, see Arch & Design Material (mental ray):
Tips and Tricks on page 5593.
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A range of material effects available with the Arch & Design material

What Is the Arch & Design Material?

The mental ray Arch & Design material is a monolithic material shader
designed to support most materials used in architectural and product-design
renderings. It supports most hard-surface materials such as metal, wood and
glass. It is especially tuned for fast glossy reflections and refractions (replacing
the DGS material on page 5615) and high-quality glass (replacing the dielectric
material on page 5992).

The major features are:

■ Easy to use, yet flexible - controls are arranged logically in a most-used-first
fashion.
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■ Templates - allow fast access to settings combinations for common
materials.

■ Physically accurate - the material is energy conserving, making it impossible
to create shaders that break the laws of physics.

■ Glossy performance - advanced performance boosts including interpolation,
emulated glossiness, and importance sampling.

■ Tweakable BRDF (bidirectional reflectance distribution function) - the user
can define how reflectivity depends on angle.

■ Transparency - “Solid” or “thin” materials: transparent objects such as
glass can be treated as either solid (refracting, built out of multiple faces)
or thin (nonrefracting, can use single faces).

■ Round corners - simulate fillets to allow sharp edges to still catch the light
in a realistic fashion.

■ Indirect Illumination control - set the final gather accuracy or indirect
illumination level on a per-material basis.

■ Oren-Nayar diffuse - allows “powdery” surfaces such as clay.

■ Built-in Ambient Occlusion - for contact shadows and enhancing small
details.

■ All-in-one shader - photon and shadow shader built in.

■ Waxed floors, frosted glass and brushed metals - all fast and easy to set
up.

Physics and the Display

The Arch & Design material attempts to be physically accurate, hence its
output has a high dynamic range. How visually pleasing the material looks
depends on how colors inside the renderer are mapped to colors displayed on
the screen.

When rendering with the Arch & Design material it is highly recommended
that you operate through a tone mapper/exposure control such as the mr
Photographic Exposure Control on page 6744 in conjunction with gamma
correction on page 7758, or at the very least use gamma correction.
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A Note on Gamma

Describing all the details of gamma correction is beyond the scope of this
topic; this is just a brief overview.

The color space of a normal, off-the-shelf computer screen is not linear. The
color with RGB value 200 200 200 is not twice as bright as a color with RGB
value 100 100 100, as one might expect.

This is not a bug because, due to the fact that our eyes see light in a nonlinear
way, the former color is actually perceived to be about twice as bright as the
latter. This makes the color space of a normal computer screen roughly
perceptually uniform. This is a good thing, and is actually the main reason
24-bit color (with only 8 bits or 256 discrete levels for each of the red, green
and blue components) looks as good as it does to our eyes.

The problem is that physically correct computer graphics operates in a true
linear color space where a value represents actual light energy. If one simply
maps the range of colors output to the renderer naively to the 0–255 range of
each RGB color component it is incorrect.

The solution is to introduce a mapping of some sort. One of these methods
is called gamma correction.

Most computer screens have a gamma of about 2.2 (known as the sRGB color
space), but 3ds Max defaults to a gamma of 1.8, which makes everything look
too dark (especially midtones), and light does not “add up” correctly.

Using a gamma of 2.2 is the theoretically correct value, making the physically
linear light inside the renderer appear in a correct linear manner on screen.

However, because the response of photographic film isn’t linear either, users
find that this theoretically correct value looks too bright and washed out. A
common compromise is to render to the default gamma of 1.8, making things
look more photographic; that is, as if the image had been shot on photographic
film and then developed. However, when exporting and importing images
(for example, as texture maps) with external image-editing programs, for best
results set all gamma values on Preferences > Gamma and LUT Preferences on
page 7758 to 2.2.

Tone Mapping

Another method for mapping the physical energies inside the renderer to
visually pleasing pixel values is known as tone mapping. You can accomplish
this either by rendering to a floating-point file format and using external
software, or with a plug-in that allows the renderer to do it on the fly. In 3ds
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Max such plug-ins are known as exposure controls and are accessed from the
Environment dialog.

Use Final Gathering and Global Illumination

The Arch & Design material is designed to be used in a realistic lighting
environment; one that incorporates full direct and indirect illumination.

mental ray provides two basic methods for generating indirect light: Final
Gathering and Global Illumination. For best results, be sure to use at least one
of these methods.

At the very least, enable Final Gathering, or use Final Gathering combined
with Global Illumination (photons) for quality results. Performance tips for
using Final Gather and Global Illumination can be found here on page 5593.

If you use an environment for your reflections, make sure the same
environment (or a blurred copy of it) is used to light the scene through Final
Gathering. In 3ds Max this means you should include a Skylight on page 5065
in your scene set to Use Scene Environment, or use Daylight system on page
5139 with Skylight set to mr Sky.

Use Physically Correct Lights

Traditional computer-graphics light sources live in a cartoon universe where
the intensity of the light doesn’t change with the distance. The real world
doesn’t agree with that simplification. Light decays when leaving a light source
due to the fact that light rays diverge from their source and the intensity of
the light changes over distance. This decay of a point light source is 1/d2; in
other words, light intensity is proportional to the inverse of the square of the
distance to the source.

One of the reasons for this traditional oversimplification is the fact that in
the early days of computer graphics, tone mapping was not used and problems
of colors blowing out to white in the most undesirable ways was rampant.
(Raw clipping in sRGB color space is displeasing to the eye, especially if one
color channel clips earlier than the others. Tone mapping generally solves
this by “soft clipping” in a more suitable color space than sRGB.)

However, as long as only Final Gathering (FG) is used as indirect illumination
method, such traditional simplifications still work. Even light sources with
no decay still create reasonable renderings. This is because FG is concerned
only with the transport of light from one surface to the next, not with the
transport of light from the light source to the surface.
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It’s when working with Global Illumination (GI) (that is, with photons) the
troubles arise.

When GI is enabled, light sources shoot photons. For the Arch & Design
material (or any other mental ray material) to be able to work properly, it is
imperative that the energy of these photons to match the direct light cast by
that same light. And since photons model light in a physical manner, decay
is built in.

Hence, when using GI:

■ Light sources must emit photons at the correct energy.

■ The direct light must decay in a physically correct way to match the decay
of the photons.

Therefore it is important to make sure the light shader and the photon emission
shader of the lights work well together.

In 3ds Max this is most easily solved by using the photometric lights on page
5005. All of these lights are guaranteed to have their photon energy in sync with
their direct light. It is built in and automatic and one does not need to worry
about it.

Features

The Shading Model

From a usage perspective, the shading model consists of three components:

■ Diffuse - diffuse channel /including Oren Nayar “roughness”).

■ Reflections - glossy anisotropic reflections (and highlights).

■ Refraction - glossy anisotropic transparency (and translucency).
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The Arch & Design material shading model

Direct and indirect light from the scene cause diffuse reflections as well as
translucency effects. Direct light sources also create specular highlights.

Ray tracing is used to create reflective and refractive effects, and advanced
importance-driven multi-sampling is used to create glossy reflections and
refraction.

The rendering speed of the glossy reflections/refraction can further be enhanced
by interpolation as well as “emulated” reflections with the help of Final
Gathering.

Conservation of Energy

One of the most important features of the material is that it is automatically
energy conserving. This means that it makes sure that diffuse + reflection +
refraction <= 1. In other words, no energy is magically created and the
incoming light energy is properly distributed to the diffuse, reflection and
refraction components in a way that maintains the first law of
thermodynamics.

In practice, this means, for example, that when adding reflectivity, the energy
must be taken from somewhere, and hence the diffuse level and the
transparency will be automatically reduced accordingly. Similarly, adding
transparency happens at the cost of the diffuse level.
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The rules are as follows:

■ Transparency takes energy from diffuse; that is, at 100% transparency,
there is no diffuse at all.

■ Reflectivity takes energy from both diffuse and transparency; that is, at
100% reflectivity there is neither diffuse nor transparency.

■ Translucency is a type of transparency, and the Translucency Weight
parameter defines the percentage of transparency vs. translucency.

From left to right: Reflectivity=0.0, 0.4, 0.8, and 1.0

From left to right: Transparency=0.0, 0.4, 0.8, and 1.0

Conservation of energy also means that the level of highlights is linked to the
glossiness of a surface. A high Reflection Glossiness value causes a narrow,
intense highlight, while a lower value causes a wider, less intense highlight.
This is because the energy is now spread out and dissipated over a larger area.

BRDF: How Reflectivity Depends on Angle

In the real world, the reflectivity of a surface is often view-angle dependent.
A fancy term for this is bidirectional reflectance distribution function (BRDF); that
is, a way to define how much a material reflects when seen from various angles.
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The reflectivity of the wood floor depends on the view angle.

Many materials exhibit this behavior. The most obvious examples are glass,
water, and other dielectric materials with Fresnel effects (where the angular
dependency is guided strictly by the index of refraction), but other layered
materials such as lacquered wood and plastic display similar characteristics.

The Arch & Design material allows this effect to be defined by the index of
refraction, and also allows an explicit setting for the two reflectivity values
for:

■ 0 degree faces (surfaces directly facing the camera)

■ 90 degree faces (surfaces 90 degrees to the camera)

For more information, see BRDF rollout on page 5557.

Reflectivity Features

The final surface reflectivity is in reality caused by the sum of three
components:

■ The diffuse effect

■ The actual reflections

■ Specular highlights that simulate the reflection of light sources

Diffuse, reflections, and highlights
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In the real world, highlights are just glossy reflections of the light sources. In
computer graphics it’s more efficient to treat these separately. However, to
maintain physical accuracy the material automatically keeps highlight
intensity, glossiness, anisotropy, etc. in sync with the intensity, glossiness and
anisotropy of reflections. Thus, there are no separate controls for these as both
are driven by the reflectivity settings.

Transparency Features

The material supports full glossy anisotropic transparency and includes a
translucent component, described in detail here on page 5554.

Translucency

Solid versus Thin-Walled

The transparency/translucency property can treat objects as either solid or
thin-walled.

If all objects were treated as solids at all times, every window pane in an
architectural model would have to be modeled as two faces: an entry surface
that refracts the light slightly in one direction, and immediately following it
an exit surface, where light is refracted back into the original direction.

Not only does this entail additional modeling work, it is a waste of rendering
power to simulate refraction that has very little net effect on the image. Hence
the material allows modeling the entire window pane as a single flat plane,
foregoing any actual refraction of light.

5588 | Chapter 19   Material Editor, Materials, and Maps



Solid vs. thin-walled transparency and translucency

In the preceding illustration the helicopter canopy, the window pane, the
translucent curtain, and the right-hand sphere all use thin-walled transparency
or translucency, whereas the glass goblet, the plastic horse, and the left-hand
sphere all use solid transparency or translucency.

Cutout Opacity

Beyond the “physical” transparency, which models an actual property of the
material, the material provides a completely separate, non-physical “cutout
opacity” channel to allow “billboard” objects such as trees, or to cut out objects
such as a chainlink fence with an opacity mask.

Special Effects

Built-in Ambient Occlusion

Ambient Occlusion (AO) is a method spearheaded by the film industry for
emulating the look of true global illumination by using shaders that calculate
the extent to which an area is occluded, or prevented from receiving incoming
light.
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Used alone, an AO shader, such as the separate mental ray Ambient/Reflective
Occlusion shader, creates a grayscale output that is dark in areas light cannot
reach and bright in areas where it can:

The following image illustrates the main results of AO: dark crevices and areas
where light is blocked by other surfaces, and bright areas that are exposed to
the environment.

An example of AO applied to a scene

One important aspect of AO is that the user can how far it looks for occluding
geometry.
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AO looked up within a shorter radius

Using a radius creates a localized AO effect: Only surfaces within the given
radius are considered as occluders. This also speeds up rendering. The practical
result is that the AO provides nice “contact shadow” effects and makes small
crevices visible.

The Arch & Design material gives you two ways to utilize its built-in AO:

■ Traditional AO for adding an omnipresent ambient light that is then
attenuated by the AO to create details.

■ Use AO for detail enhancement together with existing indirect lighting
methods such as Final Gathering or photons.

The latter method is especially interesting when using a highly smoothed
indirect illumination solution, such as a high photon radius or an extremely
low final gather density, which could otherwise lose small details. By applying
the AO with short rays these details can be brought back.
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Round Corners

Computer-generated imagery tends to look unrealistic, partly because edges
of objects are geometrically sharp, whereas most edges in the real world are
slightly rounded, chamfered, worn, or filleted in some manner. This rounded
edge tends to “catch the light” and create highlights that make edges more
visually appealing.

The Arch & Design material can create the illusion of rounded edges at render
time. This feature is intended primarily to speed up modeling, so that you
need not explicitly fillet or chamfer edges of objects such as a tabletop.

Left: No round corners; Right: Round corners

The function is not a displacement; it is merely a shading effect, like bump
mapping, and is best suited for straight edges and simple geometry, not
advanced, highly curved geometry.

Performance Features

Finally, the Arch & Design material contains a large set of built-in functions
for optimal performance, including but not limited to:

■ Advanced importance sampling with ray rejection thresholds

■ Adaptive glossy sample count

■ Interpolated glossy reflection/refraction with detail enhancements

■ Ultra-fast emulated glossy reflections (Highlights+FG Only mode)

■ The option to ignore internal reflections for glass objects

■ The choice between traditional transparent shadows, suitable for objects
such as a window pane, and refractive caustics, suitable for solid glass
objects, on a per-material basis.
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Arch & Design Material (mental ray):Tips and
Tricks

This topic contains information to help you more effectively use the Arch &
Design material on page 5544 for mental ray.

See also:

■ Arch & Design Material (mental ray): Overview on page 5579

■ Arch & Design Material (mental ray) on page 5544

Final Gather Performance

The final gather algorithm in mental ray 3.5 is vastly improved from earlier
versions, especially in its adaptiveness. This means you can often use much
lower ray counts and much lower densities than in previous versions of mental
ray.

In many cases, you can render still images with such extreme settings as 50
rays and a density of 0.1. If this causes “oversmoothing” artifacts, you can use
the built-in ambient occlusion on page 5564 to solve those problems.

When using final gather together with GI (photons), make sure the photon
solution is fairly smooth by first rendering with Final Gather disabled first. If
the photon solution is noisy, increase the photon search radius until it “calms
down,” and then enable Final Gather.

Quick Guide to Some Common Materials

Following are some quick rules of thumb for creating various materials. Each
assumes the basic default settings as a starting point.

General Rules of Thumb for Glossy Wood, Flooring, and So On

These are the kind of “hybrid” materials you might require for architectural
renderings; lacquered wood, linoleum, etc.

For these materials, set BRDF to Custom Reflectivity Function; that is, you'll
define a custom BRDF curve. Start out with 0 degree reflectivity of 0.2, 90
degree reflectivity of 1.0, and apply a suitable texture map to the Diffuse Color.
Set Reflectivity between 0.6 and 1.0.
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How glossy is the material? Are reflections clear or blurry? Are they strong or
weak?

■ For clear, fairly strong reflections, keep Reflection Glossiness at 1.0.

■ For slightly blurry but strong reflections, set a lower Reflection Glossiness
value. If performance becomes an issue try turning on Fast (interpolate).

■ For slightly blurry but also very weak reflections, you can “cheat” by
applying a lower Reflection Glossiness value for broader highlights while
setting Reflection Glossy Samples to 0. This shoots only one mirror ray for
reflections, but if they are very weak, the viewer can often not really tell.

■ For moderately blurry surfaces, set an even lower Reflection Glossiness
value and maybe increase the Reflection Glossy Samples value. Again, for
improved performance turn on Fast (interpolate).

■ For extremely blurry surfaces or surfaces with very weak reflections, try
turning on Highlights+FG Only.

A typical wooden floor could use Reflection Glossiness of 0.5, Reflection Glossy
Samples of 16, Reflectivity of 0.75, a nice wood texture for Diffuse Color,
perhaps a slight bump map. If bumpiness should appear only in the lacquer
layer, turn on Special Purpose Maps rollout > Do Not Apply Bumps To The
Diffuse Shading.

Linoleum flooring could use the same settings but with a different texture
and bump map, and probably with slightly lower Reflectivity and Reflection
Glossiness values.

Ceramics

Ceramic materials are glazed; that is, they're covered by a thin layer of
transparent material. They follow rules similar to the general materials
mentioned above, but set the BRDF method on page 5557 to By IOR (fresnel
reflections) and set IOR to about 1.4 and Reflectivity to 1.0.

Set the Diffuse Color to a suitable texture or color, such as white for white
bathroom tiles.

Stone Materials

A stone object usually has a fairly matte finish, or has reflections that are so
blurry they are nearly diffuse. You can simulate the “powdery” character of
stone with the Diffuse Roughness parameter; try 0.5 as a starting point. Porous
stone such as brick would have a higher value.
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Stone would have a very low Reflection Glossiness (lower than 0.25) and one
can most likely use Highlights+FG Only to good effect for very good
performance. Use a nice stone texture for Diffuse Color, some kind of bump
map, and perhaps a map that varies the Reflection Glossiness value.

The Reflectivity would be around 0.5-0.6 with By IOR (fresnel reflections) off
and 0 degree reflectivity at 0.2 and 90 degree reflectivity at 1.0

Glass

Glass is a dielectric, so By IOR (fresnel reflections) should definitely be on.
The IOR of standard glass is 1.5. Set Diffuse Level to 0.0, Reflectivity to 1.0
and Transparency to 1.0. This is enough to create basic, completely clear
refractive glass.

If this glass is for a window pane, turn Thin-walled on. If this is a solid glass
block, turn Thin-walled off and consider if caustics are necessary or not, and
set Refractive Caustics accordingly.

If the glass is frosted, set Refraction Glossiness to a suitable value. Tune the
Refraction Samples for good quality or turn on Fast (interpolate) for
performance.

Colored Glass

For clear glass, use the tips in the preceding section. Colored glass, however,
is a different story.

Many shaders set the transparency at the surface of the glass. And indeed this
is what happens if one simply sets a Refractive Color to some value, such as
blue. For glass with Thin-walled turned on this works perfectly. But for solid
glass objects this is not an accurate representation of reality.

The scene in following illustration contains two glass blocks of different sizes,
a sphere with a spherical hole inside it, and a glass horse.

NOTE The spherical hole was created by inserting a second sphere with its normals
flipped inside the outer sphere. Don’t forget to flip the normals of such surfaces
or they will not render correctly.
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With a blue refraction color: Glass with color changes at the surface

The problems are evident:

■ The two glass blocks are of different thicknesses, yet they are exactly the
same level of blue.

■ The inner sphere is darker than the outer one.

Why does this happen?

Consider a light ray that enters a glass object. If the color is located at the
surface, the ray is colored somewhat as it enters the object, retains this color
through the object, and receives a second coloration (attenuation) when it
exits the object:
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Diagram for glass with color changes at the surface

In the above illustration the ray enters from the left, and at the entry surface
it drops in level and gets slightly darker (the graph illustrates the level
schematically). It retains this color throughout its travel through the medium
and then drops in level again at the exit surface.

For simple glass objects this is quite sufficient. For any glass using Thin-walled
on page 5571it is by definition the correct thing to do, but for any complex solid
it is not. It is especially wrong for negative spaces inside the glass (like the
sphere in our example) because the light rays have to travel through four
surfaces instead of two, getting two extra steps of attenuation at the surface.

In real colored glass, light travels through the medium and is attenuated as it
goes. In the Arch & Design material this is accomplished by turning on
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Advanced Rendering Options > Refraction > Max Distance, setting the Color
At Max Distance, and setting the Refraction Color to white. This is the result:

Glass with color changes within the medium

The result is clearly much more satisfactory: The thick glass block is a deeper
blue than the thin one, and the hollow sphere now looks correct. In diagram
form it looks as follows:
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d=Max Distance where attenuation is Color at Max Distance

The ray enters the medium and is attenuated throughout its travel. The
strength of the attenuation is such that precisely the Max Distance (d in the
figure) the attenuation matches that of Color At Max Distance. In other words,
at this depth the attenuation is the same as was received immediately at the
surface with the previous scene. The falloff is exponential, so at double the
Max Distance value the effect is that of Color At Max Distance squared, and
so on.

There is one minor tradeoff:

To render the shadows of a material correctly using this method, you must
either use caustics or make sure mental ray is rendering shadows in Segments
mode (see Shadows & Displacement Rollout (mental ray Renderer) on page
6292).
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Using caustics naturally gives the most correct-looking shadows (the above
image was rendered without caustics), but requires that the scene has caustic
photons enabled and contains a physical light source that shoots caustic
photons.

On the other hand, the mental ray Segments shadows have a slightly lower
performance than the more widely used Simple shadow mode. But if it is not
used, the shadow intensity will not take the attenuation through the media
into account properly. However, the image might still look pleasing.

Water and Liquids

Water, like glass, is a dielectric with an IOR of 1.33. Hence, the same principles
as for glass (above) apply to bodies of water, which truly need to refract their
environment. An example is water running from a tap. Colored liquids use
the same principles as colored glass.

Water into wine

To create a liquid in a container, as in the preceding image, it is important to
understand how the Arch & Design material handles refraction through
multiple surfaces vs. the real-world behavior of light in such circumstances.

What is important for refraction is the transition from one medium to another
with a different IOR. Such a transition is known as an interface.

For lemonade in a glass, imagine a ray of light travelling through the air
(IOR=1.0). When it enters the glass, it is refracted by the IOR of the glass (1.5).
The ray then leaves the glass and enters the liquid; that is, it passes through
an interface from a medium of IOR 1.5 to another medium of IOR 1.33.
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One way to model this in computer graphics is to make the glass one separate
closed surface, with the normals pointing outward from the surface of the
glass and an IOR of 1.5, and a second, closed surface for the liquid, with the
normals pointing outward and an IOR of 1.33, leaving a small air gap between
the container and the liquid.

This approach works, but can cause a problem: When light goes from a higher
IOR to a lower there is a chance of an effect known as total internal reflection
(TIR). This is the effect you see when diving into a swimming pool and then
looking up: You can see the objects above the surface only in a small circle
straight above. Anything below a certain angle shows only a reflection of the
pool and things below the surface. The larger the difference in the IOR of the
two media, the greater the chance of TIR.

So in our example, as the ray goes from glass (IOR=1.5) to air, there is a large
chance of TIR. But in reality the ray would move from a medium of IOR=1.5
to one of IOR=1.33, which is a much smaller step with a much smaller chance
of TIR. This looks different:

Left: Correct refraction; Right: the “air gap” method

The result on the left is the correct one, but how it is obtained?

The solution is to rethink the modeling, and not to think in terms of media,
but in terms of interfaces. In our example, we have three different interfaces,
where we can consider the IOR as the ratio between the IORs of the outside
and inside media:

■ air-glass interface (IOR=1.5/1.0=1.5)

■ air-liquid interface (IOR=1.33/1.0=1.33)

mental ray Materials | 5601



■ glass-liquid interface (IOR=1.33/1.5=0.8)

In the most common case of an interface with air, the IOR to use is the IOR
of the media (because the IOR of air is 1.0), whereas in an interface between
two different media, the situation is different.

To correctly model this scenario, then, we need three surfaces, each with a
different Arch & Design material applied:

■ the air-glass surface (blue), with normals pointing out of the glass, covering
the area where air directly touches the glass, having an IOR of 1.5

■ the air-liquid surface (green), with normals pointing out of the liquid,
covering the area where air directly touches the liquid, having an IOR of
1.33

■ the glass-liquid surface (red), with normals pointing out of the liquid,
covering the area where the glass touches the liquid, having an IOR of 0.8

The three interfaces for a liquid in a glass

By setting suitable Max Distance and Color At Max Distance values for the
two liquid materials (to get a colored liquid), we obtain the glass on the left
in the preceding rendered image.

Ocean and Water Surfaces

A water surface is a slightly different matter than a visibly transparent liquid.

The ocean isn’t blue; it is reflective. Not much of the light that penetrates the
surface of the ocean gets anywhere of interest. A small amount of light is
scattered back up again, doing a bit of literal subsurface scattering.
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To make an ocean surface with the Arch & Design material, follow these steps:

1 Set Diffuse Level to 0.0, Reflectivity to 1.0, and Transparency to 0.0. That's
right: No refraction is necessary.

2 Set IOR to 1.33 and turn on By IOR (fresnel reflections). Apply an
interesting wobbly shader to Bump (Ocean (lume) works well here) and
your ocean is basically done.

This ocean has reflections guided only by the IOR. But this might work fine;
try it. Just make sure there is something there for it to reflect. Add a sky map,
objects, or a just a blue gradient background. There must be something or it
will be completely black.

The ocean isn’t blue; the sky is.

For a more tropical look, try setting Diffuse Color to a slightly blue-green color,
set the Diffuse Level to a fairly low number such as 0.1, and turn on Do Not
Apply Bumps To The Diffuse Shading.

Now you have a base color in the water that emulates the small amount of
scattering that occurs in the top level of the ocean.
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Enjoy the tropics.

Metal

Metals are reflective, which means they need something to reflect. The best
looking metals come from having a true HDRI environment, either from a
spherically mapped HDRI photo, or something like the mental ray physical
sky.

To create classic chrome, turn off By IOR (fresnel reflections), set Reflectivity
to 1.0, 0 degree reflectivity to 0.9 and 90 degree reflectivity to 1.0. Set Diffuse
Color to white, and turn on Metal Reflections.

This creates an almost completely reflective material. Tweak the Reflection
Glossiness parameter for various levels of blurry reflections. Also consider
using the Round Corners effect on page 5567, which tends to work very well
with metallic objects.

Metals also influence the color of their reflections. Because you turned on
Metal Reflections, this is already happening; try setting the Diffuse Color to
a golden color to create gold.

Try various levels of Reflection Glossiness (with the help of Fast (interpolate)
for performance, when necessary).

You can also change the Reflectivity value. This has a slightly different meaning
when Metal Material is on; it blends between the reflections (colored by the
Diffuse Color) and normal diffuse shading. This allows a blend between the
glossy reflections and the diffuse shading, both driven by the same color. For
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example, an aluminum material would need a bit of diffuse blended in, whereas
chrome would not.

Gold, silver, and copper

Brushed Metal

Brushed metal is an interesting special case. In some cases, creating a brushed
metal requires only turning down the Reflection Glossiness to a level where
you obtain a very blurred reflection. This is sufficient when the brushing
direction is random or the brushes are too small to be visible even as an
aggregate effect.

For materials that have a clear brushing direction and/or where the actual
brush strokes are visible, creating a convincing look is slightly more involved.

The tiny grooves in a brushed metal surface all work together to cause
anisotropic reflections. This can be illustrated by the following schematic,
which simulates the brush grooves by modeling many tiny adjacent cylinders,
shaded with a simple Phong shader:
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Many small adjacent cylinders

As you can see, the specular highlights in the cylinders work together to create
an aggregate effect which is the anisotropic highlight.

Also note that the highlight isn’t continuous; it is actually broken up into
small, adjacent segments. So the primary visual cues that a material is brushed
metal are:

■ Anisotropic highlights that stretch out in a direction perpendicular to the
brushing direction

■ A discontinuous highlight with breaks in the brushing direction

Many attempts to simulate brushed metals have looked only at the first effect:
the anisotropy. Another common mistake is to think that the highlight
stretches in the brushing direction. Neither is true.

Hence, to portray brushed metals, it is necessary to simulate these two visual
cues. The first is simple: Use Anisotropy and Anisotropy Rotation to make
anisotropic highlights. The second can be done in several ways:

■ with a bump map

■ with a map that varies the Anisotropy or Reflection Glossiness values

■ with a map that varies the Reflection Color
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Each has advantages and disadvantages, but the one we suggest here is the
last one. The reason for choosing this method is that it works well with
interpolation.

1 Create a map for the brush streaks. The possible ways to do this include
painting a map in a paint program, or using a Noise map that has been
stretched heavily in one direction. The map should vary between
middle-gray and white.

2 Apply this map to the Reflection Color in a scale suitable for the brushing.

3 Set Diffuse Color to white (or the color of the metal) but set Diffuse Level
to 0.0 (or a small value).

4 Make sure Metal Material is on.

5 Set Reflection Glossiness to 0.75.

6 Set Anisotropy to 0.1 or a similar value. Use Anisotropy Rotation to align
the highlight properly with the map. If necessary use Anisotropy Channel
to base it on the same texture space as the map.

Brushed metal

Car Paint Material/Shader (mental ray)

Material Editor > Type button > Material/Map Browser > Car Paint Material

Material Editor > any material > Click a Map button. > Material/Map Browser
> Car Paint Shader
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Note: The Car Paint material and shader appear in the Browser only if the
mental ray renderer is the currently active renderer.

Car Paint is available as both a mental ray material and shader; both have
identical parameters, and support the following unique characteristics of
real-world car paint:

■ The lowest surface, applied directly to the car body, is a thin layer of
pigment. The properties of this layer are such that the perceived color
changes depending on the viewing angle as well as the incident angle of
the incoming light.

■ Tiny metal flakes are suspended within this layer. The flakes reflect light
and can be seen glittering on a sunny day, due to individual flakes reflecting
sunlight directly at the observer.

■ On top of this is a clear-coat layer, which can be more or less reflective
and more or less glossy, depending on the quality of the layer and any
added wax coating. Most notably, this layer tends to exhibit a pronounced
Fresnel effect, reflecting more light at glancing angles.

■ An optional, topmost Lambertian dirt layer can help give an "unwashed"
look.
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Interface

Diffuse coloring rollout

Ambient/Extra light The ambient light component.

NOTE This parameter is treated differently from the ambient/ambience parameter
pair of many other base shaders in that it is influenced by the additional Diffuse
Coloring parameters, and hence represents incoming light, rather than the object's
"ambient color."

Base color The base diffuse color of the material.

Edge color The color seen at glancing angles (that is, edges), which tends to
appear much darker. For deep metallic paints seen on sports cars it tends to
be almost black.

Edge bias The falloff rate of the color towards the edge. Higher values make
the edge region narrower; lower values make it wider. The useful range is 0.0
to approximately 10.0, where the value 0.0 turns the effect off.

Color shift due to view angle, shifting between a red base color and a blue edge color
(atypical colors chosen for demonstration purposes) with varying Edge Bias values

Light facing color The color of the area facing the light source.

Light facing color bias The falloff rate of the color towards the light. Higher
values make the colored region facing the light smaller/narrower; lower values
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make it larger/wider. The useful range is 0.0 to approximately 10.0, where the
value 0.0 turns the effect off.

Color shift due to view angle, shifting between a red base color and a green light facing
color (atypical colors chosen for demonstration purposes) with varying Light Facing
Color Bias values

Diffuse weight Controls the overall level of the Diffuse Coloring parameters.

Diffuse bias Modifies the falloff of the diffuse shading. Higher values push
the diffuse peak towards the light source, and lower values flatten the diffuse
peak. The useful range is approximately 0.5 to 2.0, where 1.0 represents
standard Lambertian shading.

Flakes rollout

Flake color The color (reflectivity) of the flakes, which is generally white.

Flake weight A scalar multiplier for the flake color.

Flake reflections (ray traced) The amount of ray-traced reflection in the
flakes, which allows glittery reflections of, for example, an HDRI environment.
The value 0.0 turns the effect off.

This effect should generally be very subtle; a value of 0.1 is often enough. The
final intensity of reflections also depends on the Flake Color and Flake Weight
values.

Flake specular exponent The Phong specular exponent for the flakes.
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Flake density The density of the flakes. The useful range is from 0.1 to
approximately 10.0, where lower values indicate sparser flakes and higher
values indicates denser flakes.

Flake decay distance The distance at which the influence of the flakes fades
out. A value of 0.0 disables fading. Any positive value causes the Flake Weight
value to be modulated so that it reaches zero at this distance.

Because flakes are relatively small, using can introduce rendering artifacts if
their visual density becomes significantly smaller than a pixel. If the
oversampling of the rendering is set high, small flakes can also potentially
trigger massive oversampling and hence overlong rendering times needlessly,
because the averaging caused by the oversampling will essentially cancel out
the flake effect. If you experience these issues, use Flake Decay Distance to
counteract them.

Flakes at different distances with no flake decay. The farthest flakes might cause flicker
in animations, or trigger unnecessary oversampling and long render times (rendered
here with low oversampling for illustrative purposes).

Using flake decay. The flake strength diminishes with distance. The same intentionally
low oversampling as in the previous image has been used.
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Flake strength The difference between the orientation of the flakes. The useful
range is 0.0 to 1.0 where 0.0 means that all flakes are parallel to the surface,
while higher values vary the orientation of flakes increasingly.

Flake scale The size of the flakes. The procedural texture is calculated in object
space, and will hence follow the object. Thus, the scale is influenced by any
scale transformation on the object.

Specular reflections rollout

Specular Color #1 The color of the primary specular highlight.

Specular Weight #1 A scalar multiplier applied to Specular Color #1.

Specular exponent #1 The Phong exponent of Specular Color #1.

Specular Color #2 The color of the secondary specular highlight.

Specular Weight #2 A scalar multiplier applied to Specular Color #2.

Specular exponent #2 The Phong exponent of Specular Color #2.

Glazed specularity #1 Enables a special mode on the primary specular
highlight called glazing. By applying a threshold to the specular highlight, it
makes the surface appear more polished and shiny. For a new sports car with
a lot of wax, turn this on. For a beat-up car in the junkyard, turn it off.

Left to right: Flake specularity only; standard specularity; "glazed" mode enabled;
"glazed" mode specularity with flakes

5612 | Chapter 19   Material Editor, Materials, and Maps



Reflectivity rollout

Reflection color The color of the reflections in the clear-coat layer. This is
generally white.

Edge factor Clear coat tends to reflect more at glancing angles (edges). This
parameter defines the "narrowness" of this edge.

Edge reflections weight The reflective strength at the edge (generally 1.0).

Facing reflections weight The reflective strength at facing angles (generally
low: 0.1 - 0.3).

Glossy reflection samples Enables a glossy clear coat. This parameter sets the
number of glossy reflection rays traced. A value of 0 disables glossiness.

Glossy reflections spread Sets the amount of glossiness. Cars are generally
near-mirrors so this value should be kept small.

Max distance Limits the reach of reflective rays.

Single environment sampling Optimizes lookup of environment maps.
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Dirty layer (lambertian) rollout

Real cars are rarely clean. This shows the dirt layer (hand-painted dirt-placement map),
including a bump map applied in the dirty regions.

A simple Lambertian dirt layer covers the underlaying paint and clear-coat
layers.

Dirt color The color of the dirt.

Dirt weight The amount of dirt in the layer. This is typically connected to a
texture shader to obtain variations in the dirt across the surface. If the value
is 0.0, no dirt is added.

Advanced options rollout
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Irradiance weight (indirect illumination) The influence of indirect light
(photons and final gathering) on the surface. It is internally divided by pi
(3.14159); for example, a value of 1.0 means the standard 1.0/pi weight.

Global weight A global tuning parameter that affects the entire diffuse, flake,
and specular subsystems. It does not affect reflections or dirt.

Shaders rollout

This rollout enables application of maps or shaders to any of the Car Paint
parameters. Of course, you can apply a shader to a parameter by clicking its
Map button, so the principal value of this rollout is that it also lets you toggle
a parameter's shader, using the check box, without removing the map.

DGS Material (mental ray)

Material Editor > Type button > Material/Map Browser > DGS Material
(physics_phen)

Note: The DGS material appears in the Browser only if the mental ray renderer
is the currently active renderer.

DGS stands for Diffuse, Glossy, Specular. This material is a mental ray
phenomenon (a scripted shader tree) that provides a physically accurate
simulation of a surface. Using DGS materials with the mental ray renderer is
comparable to using the Architectural material on page 5526 with the default
scanline renderer.

The DGS material's basic components appear on the Parameters rollout. You
can assign shaders to these components, creating a material of greater
complexity. Buttons for assigning shaders are on both the Parameters rollout
and the Shaders rollout.
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Interface

Parameters rollout

NOTE The button to the right of each control is a shortcut shader button. Clicking
one of these buttons displays the Material/Map Browser on page 5290 so you can
assign a shader to this component. When a map or a shader has been assigned
to a component, this button displays the letter “M,” and the comparable button
on the Shaders rollout displays the map or shader name.

Diffuse Click the color swatch to display a Color Selector on page 391 and
change the material's diffuse color.

Glossy Highlights Click the color swatch to display a Color Selector and
change the color of glossy highlights.

Specular Click the color swatch to display a Color Selector and change the
color of mirror reflections. When the specular color is white, the material is
100 percent reflective, like a mirror. When the specular color is black, the
material does not reflect any of its surroundings.

Shiny Sets the width of glossy highlights. The larger this value, the smaller
the highlights. Default=30.0.

Transparency Specifies the transparency. The effective range of Transparency
is from 0.0 to 1.0. At 0.0 the material is fully opaque. At 1.0 it is fully
transparent. Default=0.0.
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WARNING You can set the value of Transparency to be greater than 1.0, but this
has no effect. An anomaly of the user interface for shaders in the mental ray and
lume libraries is that spinner values are not “clamped” to lie within their effective
ranges, as they are for controls in 3ds Max.

The value of Transparency also indirectly specifies the reflectivity of the
material, which is calculated as 1.0 minus the Transparency value.

Index Of Refraction Specifies the IOR. In the physical world, the IOR results
from the relative speeds of light through the transparent material and the
medium the eye or the camera is in. Typically this is related to the object's
density. The higher the IOR, the denser the object. Default=1.5.

See Extended Parameters Rollout (Standard Material) on page 5408 for a list of
IOR values for commonly encountered materials.

NOTE When the IOR equals 1.0, there is no refraction, and calculating the
transparency can take less time than when the material is refractive.

Shaders rollout

The controls on this rollout let you assign a map or shader to one of the basic
parameters of the DGS material. This is comparable to mapping a component
of a standard material; by adding shaders, you can create a shader tree that
generates complex effects.

Click the button for a component to display the Material/Map Browser on
page 5290 and assign the map or shader. Use the toggle at the left to turn the
effect of the map off or on.
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 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

For all the DGS material components, the available mental ray shaders are the
same:

LibraryShader

3ds MaxBump on page 5986

3ds MaxDGS Material on page 5987

baseDielectric

3ds MaxDielectric Material on page 5992

lumeEdge

lumeFacade

lumeGlass

lumeGlow

lumeLandscape

3ds MaxMaterial to Shader on page 6001

lumeMetal
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LibraryShader

lumeOcean

baseOpacity

baseReflect

baseRefract

3ds MaxShader List on page 6003

lumeStain

lumeTranslucency

physicsTransmat

baseTransparency

baseTwo Sided

3ds MaxUV Generator on page 6005

lumeWater Surface

lumeWet-Dry Mixer

3ds MaxXYZ Generator on page 6013

Glass Material (mental ray)

Material Editor > Type button > Material/Map Browser > Glass (physics_phen)

Note: The Glass material appears in the Browser only if the mental ray renderer
is the currently active renderer.
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The Glass material simulates both the surface properties and the
light-transmitting (photon) properties of glass. It is a mental ray phenomenon
(a scripted shader tree) that is equivalent to a mental ray material on page 5638
with a Dielectric Material shader on page 5992 assigned to both its Surface and
Photon components, with the parameter settings identical for both. A dielectric
material, such as glass, is a material whose surface transmits most light that
strikes it at angles close to perpendicular (90 degrees), but reflects most light
that strikes at glancing angles (close to zero degrees).

NOTE This material does not use a shadow shader, so shadows will always be
opaque unless you generate caustics.

Adjacent Refractive Materials

Two controls, Outside Light Persistence and Index Of Refraction (Out), are
for situations where you are modeling two adjacent refractive materials.
Consider a drink in a martini glass. The glass has an index of refraction (IOR)
of 1.5, while the alcohol in the glass has an IOR of about 1.3. To create a
physically accurate model of this situation, use three glass materials: one for
the glass itself, one for the alcohol, and a third material for the surfaces where
they touch each other. For this third material, set the “inside” IOR to 1.3, and
the outside IOR to 1.5.
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Interface

Light Persistence In conjunction with the Persistence Distance, controls the
percentage of light that the volume transmits. For example, if the color is set
to R=G=B=0.5 and the Persistence Distance is set to 2.0, then objects with a
thickness of 2.0 units will appear 50 per cent transparent. Default=white
(R=G=B=1.0).

Because transparency depends on the thickness of the object, objects with
varying thickness show different transparency depending on the angle from
which they are viewed.

Index Of Refraction Specifies the Index Of Refraction (IOR). In the physical
world, the IOR results from the relative speeds of light through the transparent
material and the medium the eye or the camera is in. Typically this is related
to the object's density. The higher the IOR, the denser the object. Default=1.5.

See Extended Parameters Rollout (Standard Material) on page 5408 for a list of
IOR values for commonly encountered materials.

Outside Light Persistence In conjunction with the Persistence Distance,
controls the percentage of light transmitted on the other side of a surface.
When set to the default of black, this control has no effect. See the section
“Adjacent Refractive Materials,” above. Default=black (R=G=B=0.0).
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Index Of Refraction (out) Sets the IOR on the other side of a surface. When
set to the default of zero, this control has no effect. See the section “Adjacent
Refractive Materials,” above. Default=0.0.

Persistence Distance In conjunction with the Light Persistence color, controls
the percentage of light that the volume transmits. It is the distance at which
light transmission is reduced to the percentage specified by the Light
Persistence RGB values. Default=1.0.

If you specify an Outside Light Persistence color, that setting also uses the
Persistence Distance.

Ignore Normals When on, the renderer does not use normals to decide
whether a light ray is entering or leaving the object. Normally, the material
uses normals to decide whether a ray is entering or leaving an object. (It is
entering if the normal points toward the ray, leaving if the normal points
away from the ray.) This can present a problem for rendering objects whose
normals are not unified. When Ignore Normals is on, the material determines
whether a ray is entering or leaving the object by counting the number of
times the ray has intersected the object. Default=off.

Opaque Alpha When on, refracted rays that touch the environment don't
generate a transparent alpha value. (This is how 3ds Max usually treats the
environment.) When off, refracted rays that touch the environment render a
transparent alpha value, which can help if you plan to use the rendering as
part of a composite. Default=off.

Phong Coefficient When greater than zero, generates Phong highlights on
the material. The highlights appear in the sample slot. In general this value
must be greater than 10 for highlights to be apparent. Default=0.0.

 Matte/Shadow/Reflection (mi) Material

Material Editor > Type button > Material/Map Browser >
Matte/Shadow/Reflection (mi)

Note: The Matte/Shadow/Reflection (mi) material appears in the Browser only
if the mental ray renderer is the currently active renderer.

The Matte/Shadow/Reflection (mi) material, part of the  Production Shaders
on page 6017 library, is used to create “matte objects”; that is, objects that
represent real-world objects in a photograph used as the scene background
(also known as the plate). The material provides a wealth of options for
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marrying a photographic background with the 3D scene, including support
for bump mapping, ambient occlusion, and indirect illumination.

Applications include:

■ Blocking another 3D object from the camera view, thus allowing the 3D
object to appear to be behind the object in the photo.

■ Allowing 3D objects to cast shadows and occlusion on and receive shadows
from objects in the photo.

■ Adding reflections of 3D objects to objects in the photo.

■ Allowing the interplay of indirect light between 3D objects and objects in
the photo.

In all these cases the material is applied to a matte object that represents an
object in the background plate, and the 3D object uses a traditional material.

For additional information, see Help menu > Additional Help > mr Production
Shader Library > Matte/Shadow Objects and CameraMaps, as well as the Tech
Note (following).

Tech Note

The Matte/Shadow/Reflection shader works by doing a form of differential
shading. In other words, it determines the amount of light a point would
receive if it were not in shadow, compares it to the amount of light the point
actually receives, and shades it by the relative difference.

This means that any point that is fully lit, unshadowed by any object, returns
the same color it already had, completely disregarding the actual intensity of
that light. If half of the incoming light is blocked, the point will be shaded at
50 percent intensity, regardless of the full-intensity amount in an absolute
sense.

An important feature of the Matte/Shadow/Reflection material is that it is
non-self-shadowing, non-self-occluding, non-self- reflecting, and does not
cast indirect light onto itself. Because it is designed to act as a stand-in for
objects present in a photographic plate, which already contains self-shadowing,
self-reflection, and so on, the material automatically excludes these effects.
However, it is still able to cast shadows on other objects, receive shadows from
other objects, reflect other objects, and so on, withouth creating unwanted
double shadows or double reflections for such effects already present in the
plate.
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Procedure

This multi-part procedure provides step-by-step instructions for a simple case
of combining a 3D object with a photograph using the
Matte/Shadow/Reflection material, the Environment/Background Camera
Map shader, and the Environment Probe/Chrome Ball shader.

Prerequisites:

■ A photo of a background

■ A photo of a chrome ball, also known as a light probe, shot from the same
camera angle and cropped so the edges touch the image.
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Ideally, these should be HDR photos, but non-HDR images can also work well.

To use the production shaders to marry a 3D scene with a photographic
background:

1 First set up the viewport:

1 Make sure mental ray is the active renderer.

2 Activate a Perspective viewport.

3 Use Viewport Background on page 148 to set the background image
(see the procedure introduction, above) .

4 On the Viewport Background dialog, make sure both Display
Background and Match Rendering Output are on.
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5 Click OK to continue.

2 Open the Environment And Effects dialog to the Environment panel
(press 8).

3 On the Common Parameters rollout, click the Environment Map button
(reads “None”).

4 From the list that opens, choose Environment/Background Switcher (mi)

5 Open the Material Editor.

6 Drag the Environment Map button from the Environment And Effects
dialog to a sample slot in the Material Editor. Use the Instance option.

7 On the Material Editor > Environment/Background Switcher (mi)
Parameters rollout, click the Background map button (all the way to the
right of the parameter).

8 From the list that opens, choose Environment/Background Camera Map
(mi).

9 On the Environment/Background Camera Map (mi) Parameters rollout,
click the Browse button and again open the background image.

10  In the Material Editor, click the Go To Parent button to return
to the Switcher map.

11 Click the map button to the right of Environment/Reflections.

12 From the list that appears, choose Environment Probe/Chrome Ball (mi).

13 On the Environment Probe/Chrome Ball (mi) Parameters rollout, click
the Browse button and open the image containing the cropped photo of
the chrome ball.

If the two photos have different exposures, use the Multiplier setting for
either or both maps to match them.

Next you’ll make a rudimentary model that represents objects already
present in the background. At the very least you need a simple plane for
the "ground" to place things on.

NOTE It is easier to see if you maximize the viewport and use wireframe
display mode.
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14 Align the viewport so it matches the angle of the photograph as closely
as possible.

15 From the Create menu, choose Lights > Standard Lights > Skylight and
then click in the Perspective viewport to add a Skylight to the scene.

16 On the Skylight Parameters rollout for the light, set Sky Color to Use
Scene Environment.

This retrieves the appropriate ambient color from the chrome ball photo.

17 Create some geometry. For this example, add a plane to represent the
ground.

18 Add a teapot on top of the plane. You’ll use this temporarily to tune the
shadows.

19 In the Material Editor, create an Arch & Design material, change the color
to white, and apply it to the teapot.

20 Select the ground plane.

Next you’ll set up the Matte/Shadow/Reflection material.

21 In the Material Editor, activate the existing Environment/Background
Switcher map.

22 Right-click the Background map button and choose Copy.

23 Activate an unused sample sphere and create a new
Matte/Shadow/Reflection material.

24 On the Matte/Shadow/Reflection Parameters rollout, right-click the
Camera Mapped Background map button and choose Paste (Instance).

This places the same background map that is used in the environment
switcher into the background map in the material as an instance.

This completes the basic setup. If you render now, you should see the
teapot superimposed over the background image. The teapot should have
a soft shadow underneath, which comes from the ambient occlusion.
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Part 2: Marrying 3D with a photo:

Now you’ll tune the lighting in the scene. Generally you need at least one key
light to cast a directional shadow.

1 Add a light source such as mr Area Omni and place it in a location similar
to where the main light seems to be coming from in the photo.

2 Tune the light so that the lighting direction and intensity on the teapot
seems reasonable compared to the objects in the photo, and so the shadow
directions seem to match. For now, ignore the shadow intensity; just
consider the lighting on the teapot itself.
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3 Now tune the overall intensity of the shadow with the Ambient/Shadow
Intensity parameter to match existing shadows in the photo. If the shadow
needs tinting, use the Ambient/Shadow Color setting. You might also
need to modify the AO Max Distance value to make contact shadows
more or less pronounced.

4 You can adjust the shadow softness with the mr Area Omni light’s Radius
setting, on the Area Light Parameters rollout.
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The scene is now set up, although further tuning might be necessary.

5 Delete the teapot.

6 Add any objects you want to use to the scene.

7 Add any additional stand-in matte objects that you can use to occlude
objects, receive and cast shadows, etc., to the scene, and apply the same
Matte/Shadow/Reflection material to them.
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Part 3: Prepare for compositing:

So far the rendered 3D content has been added on top of the background
directly in the renderer. Generally, you want to do this in an external
compositing program, as follows:

1 Open the Material Editor.

2 Activate the Environment/Background Switcher shader (the one you
instanced from the Environment panel).

3 Right-click the Background map button and choose Cut.

4 Click the color swatch next to Background and make sure the color is
transparent black; in other words, Red, Green, Blue, and Alpha all equal
0.0. These are the default values, so no changes should be necessary. Close
the Color Selector dialog.

5 Activate the Matte/Shadow/Reflection material and cut the Camera
Mapped Background map.

6 To the Matte/Shadow/Reflection material > Camera Mapped Background
map, apply a new Environment/Background Switcher shader.
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7 Right click the Environment/Reflection map button (not the Background
map button) and choose Paste (Instance) to apply the previously used
map.

8 Click the Background color swatch and make sure the color is transparent
black as well.

The scene now contains two Switcher nodes: one used in the environment
(switching between transparent black and the chrome ball) and one in
the material (switching between transparent black and the camera map).

If you render now, the resulting image still properly contains all the
reflections, light, etc., from the background, but not the background
itself. Shadows exist in the alpha channel, so the image is suitable for
compositing directly on top of the background image.

A Note on Gamma

The preceding procedure did not mention gamma.

If you use a gamma-correct workflow, which yields a superior result, with
literal mental ray textures (that is, you use the big Browse button to reffer
directly to a bitmap file, rather than inseriting a Bitmap map), you must set
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the gamma of this bitmap explicitly in the appropriate Reverse Gamma
Correction parameters.

NOTE Intentionally exaggerating the Reverse Gamma Correction setting on the
chrome ball photo can turn a low-dynamic-range photo into a “faux” HDR image
by artificially exaggerating its contrast.

Interface

Matte/Shadow/Reflection Parameters rollout

Camera Mapped Background Sets the color or map for the matte material.
To use the scene background, click the map button, browse from the scene,
and choose the background map.

NOTE Unlike the standard Matte/Shadow material on page 5699, this material does
not automatically pick the background (that is, the scene environment) as its color;
rather, it’s necessary to provide the background explicitly. There are several ways
to do this:

■ The most common method is to use a screen-projected map. However,
using a Bitmap map with Screen environment mapping will not work
correctly, because it does not handle reflections correctly. Instead, for this
purpose, we recommed using the Environment/Background Camera Map
shader on page 6020. This shader projects the texture back from the current
rendering camera.

■ Alternatively, you can apply the color in any applicable UV texture space,
perhaps if you previously projected the texture into that texture space.

■ A third option is to project the background at render time with the Camera
Map Per Pixel map on page 6035.

Mask/Opacity The opacity of the material.
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TIP One use case for the Mask/Opacity setting on page 5633 is to refine a rough
stand-in object. For example, the plate might contain a person’s arm, and you
want to put in a CG object that goes behind the person’s arm and/or has shadows
thrown onto it by the person’s arm. You could create simple stand-in geometry
(maybe even a cylinder) and then use a screen-projected opacity map that defines
the exact edges of the arm. Also, if the arm in the plate is motion-blurred or out
of focus, you can feather the opacity mask accordingly.

Bump Specifies a bump map for the material.

Bump Amount The multiplier for the bump map.

Shadows rollout

Receive Shadows When on, the surface can receive shadows. If Shadow
Casting Lights List is off, all lights cast shadows on the surface.

Ambient/Shadow Intensity The amount of environmental light in the scene,
which in a practical sense is how dark the shadows are. The
Matte/Shadow/Reflection material does not use Skylights to generate shadows;
any such shadows must come from the ambient occlusion feature. So when
the shader is used together with a Skylight, this value should be similar to the
level of light the Skylight provides.

The units value for this setting depends on the lighting unit. If you use the
mr Photographic Exposure Control on page 6744, and set Physical Scale to
Physical Units (cd/m2), this value will be in physical values, and might need
to be in the hundreds (or thousands for an outdoor shot lit by mental ray Sun
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and Sky on page 5161). However, if you don’t use the exposure control, or set
it Physical Scale to Unitless, this parameter is in a "traditional" unit space
where 0 is black and 1 is white.

NOTE This "ambient" light is affected by ambient occlusion, so it is darkened by
the occlusion at contact points and in areas hidden under objects.

Ambient/Shadow Color Setting a color or map here tints the shadows. For
accurate shadow tint, use a neutral color.

Shadow Casting Lights List When on, you can use the Add/Replace/Delete
buttons to edit the list, specifying lights that are to cast shadows on the surface.
For the lights list to be in effect, Receive Shadows must also be on.

When off, and Receive Shadows is on, all lights in the scene cast shadows on
the surface.

NOTE Shadow-casting lights act as representations of any real-world lights in the
background plate, such as the sun or any artificial light sources. For further
information, see Direct Illumination rollout on page 5637, following.

Ambient Occlusion rollout

Use Ambient Occlusion (AO) When on, ambient occlusion affects the surface.

AO Samples The number of ambient-occlusion rays that are shot.

AO Max Distance The reach of ambient-occlusion rays. At 0, the ray distance
is not limited. Using short rays increases performance but localizes the
ambient-occlusion effect.

AO Shadow Strength The darkness of shadows the ambient occlusion causes.
The default value is black, but you can cause a less-pronounced shading effect
by using a lighter color.
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Reflections rollout

Receive Reflections When on, the surface reflects its surroundings.

Reflection Color Reflections are tinted this color. For accurate reflections, use
a neutral color.

Reflections (Subtractive Color) The subtractive color for reflections. This
amount is removed from the plate before reflections are added. If black,
nothing is removed, and reflections are added purely additively on top of the
plate. If 50% gray, the plate pixels are attenuated to 50% of their intensity,
and the reflections are added on top of that, and so on.

Use this setting is used if the plate contains an area with many reflections that
need to be removed before the new, synthetic reflection is added.

Glossiness The glossiness of reflections.

Glossy Samples The number of glossy-reflection samples.

Max Distance At values other than 0, limits the distance from which
reflections are cast.

Max Distance Falloff The falloff curve for reflections at Max Distance. Lower
values cause more rapid falloff.
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Indirect Illumination rollout

Receive Indirect Illumination When on, indirect light (final gather and
global illumination) is gathered and scaled by the Indirect Illumination
Multiplier value (see following).

Indirect Ilumination Multiplier The multiplier for gathered indirect light.

Direct Illumination rollout

NOTE The lights specified on this rollout actually illuminate the background, unlike
shadow-casting lights on page 5635. Thus, for the effect to be correct, make sure
no light source exists in both lists.

Receive Direct Illumination When on, the surface renders where struck by
direct illumination. If Illuminating Lights List is off, all lights in the scene
illuminate the surface.

Illuminating Lights List When on, you can use the Add/Replace/Delete
buttons to edit the list, specifying lights that are to illuminate the surface. For
the lights list to be in effect, Receive Direct Illumination must also be on.
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Maps Rollout

This rollout enables application of maps or shaders to the applicable material
parameters. Of course, you can apply a shader to a parameter at its standard
location in the user interface by clicking its map button (square button at the
right side of the parameter), so the principal value of this rollout is that it also
lets you toggle a parameter's shader, using the check box, without removing
the map.

mental ray Material

Material Editor > Type button > Material/Map Browser > mental ray

Note: The mental ray material appears in the Browser only if the mental ray
renderer is the currently active renderer.

The mental ray material lets you create a material exclusively for use by the
mental ray renderer on page 6230. A mental ray material consists, at the top
level, of from one to 10 kinds of shaders, or shading components.

IMPORTANT You must assign a shader to the material's Surface component.
Otherwise, the mental ray material will not be visible when you render.

Interface

The interface to the mental ray material consists of two rollouts:

■ Material Shaders Rollout (mental ray Material) on page 5638

■ Advanced Shaders Rollout (mental ray Material) on page 5646

Material Shaders Rollout (mental ray Material)

Material Editor > Type button > Material/Map Browser > mental ray > Material
Shaders rollout

Note: The mental ray material appears in the Browser only if mental ray is the
active renderer.

The mental ray material lets you create a material exclusively for use by the
mental ray renderer on page 6230. The Material Shaders rollout provides controls
for the main kinds of component shaders you are likely to assign.
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IMPORTANT You must assign a shader to the material's Surface component.
Otherwise, the mental ray material will not be visible when you render.

See also:

■ Advanced Shaders Rollout (mental ray Material) on page 5646

Interface

Each shader component has a toggle at the left of its name. When the toggle
is on, the shader is used in rendering. When the toggle is off, the shader is
not used, even if it has been assigned. Clicking the button to the right of the
component name displays the Material/Map Browser on page 5290 so you can
assign a particular shader to the component.
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Basic Shaders group

Surface Shades the surface of objects that have this material.

In addition to any of the usual 3ds Max materials, the surface component can
be assigned the following mental ray materials or shaders:

LibraryShader

base1 (see note, below)Ambient/Reflective Occlu-

sion

3ds MaxBump on page 5986

3ds MaxCar Paint Shader (mi) on

page 5607

3ds MaxDGS Material on page 5615

baseDielectric

3ds MaxDielectric Material on

page 5992

lumeEdge

lumeFacade

lumeGlass

lumeGlow

lumeLandscape

3ds MaxMaterial to Shader on

page 6001

lumeMetal

5640 | Chapter 19   Material Editor, Materials, and Maps



LibraryShader

3ds Maxmr Physical Sky on page

5181

lumeOcean

baseOpacity

baseReflect

baseRefract

3ds MaxShader List on page 6003

subsurface scatteringSSS Physical Material

lumeStain

baseTexture Wave

lumeTranslucency

physicsTransmat

baseTransparency

baseTwo Sided

3ds MaxUV Generator on page

6005

lumeWater Surface

lumeWet-Dry Mixer
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LibraryShader

3ds MaxXYZ Generator on page

6013

NOTE As of the current version of 3ds Max, the Ambient/Reflective Occlusion
shader has been updated to support certain capabilities for texture baking (see
this note on page 6381). If you load a file containing a material that uses the older
version of the shader, that same version is still used in the scene, and the shader
is renamed "Ambient/Reflective Occlusion (base) (old)". The old version of the
shader continues to be used in the scene until you reapply it in the Material Editor.

NOTE Unlike a standard 3ds Max material, if you assign the Surface component
a bitmap with tiling turned off, the original surface color does not “show through.”
In renderings, you see only the untiled map, and none of the rest of the object.

Shadow Assigns a shadow shader.

The shadow component can be assigned the following shaders:

LibraryShader

lumeEdge Shadow

lumeFacade

lumeGlass

lumeGlow

3ds MaxMaterial to Shader on page 6001

lumeMetal

3ds MaxShader List on page 6003

baseShadow Transparency

lumeTranslucency

5642 | Chapter 19   Material Editor, Materials, and Maps



LibraryShader

physicsTransmat

lumeWater Surface Shadow

Caustics and GI group

Photon Assigns a photon shader. Photon shaders modify the appearance of
caustics and global illumination. They modify light energy (luminous flux)
rather than color (radiance).

The photon component can be assigned the following shaders:

LibraryShader

3ds MaxDGS Material on page 5615

3ds MaxDielectric Material Photon on page 5992

lumeEdge

lumeGlow

3ds MaxMaterial to Shader on page 6001

lumeMetal

basePhoton Basic

subsurface scatteringSSS Physical Material

lumeTranslucency

physicsTransmat

Photon Volume Assigns a photon volume shader. Like a photon shader, a
photon volume shader modifies caustics and global illumination, but it affects
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photons that pass through the inside of the object, rather than photons that
collide with its surface.

The photon volume component can be assigned the following shaders:

LibraryShader

3ds MaxMaterial to Shader on page 6001

physicsParti Volume Photon

3ds MaxShader List on page 6003

Extended Shaders group

Bump Assigns a bump shader. Bump shading for mental ray materials is similar
to bump mapping on page 5478 for standard materials.

The bump component can be assigned the following shaders:

LibraryShader

3ds MaxBump on page 5986

lumeOcean

3ds MaxShader List on page 6003

Displacement Assigns a displacement shader on page 6268.

The displacement component can be assigned the following shaders:

LibraryShader

3ds Max3D Displacement on page 5983

3ds MaxMaterial to Shader on page 6001

lumeOcean

Volume Assigns a volume shader on page 6265.
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The volume component can be assigned the following shaders:

LibraryShader

lumeBeam

3ds MaxMaterial to Shader on page 6001

lumeMist

physicsParti Volume Photon

3ds MaxShader List on page 6003

lumeSubmerge

Environment Assigns an environment shader. Like an environment you
assign using the Render Setup dialog, the environment shader changes the
scene background.

The environment component can be assigned the following shaders:

LibraryShader

3ds MaxEnvironment on page 5995

3ds MaxMaterial to Shader on page 6001

3ds MaxShader List on page 6003

Optimization group

Flag Material as Opaque When on, indicates that the material is fully opaque.
This tells the mental ray renderer that it doesn't need to process transparency
for this material, or to use the shadow shader (if one has been assigned). This
can improve rendering time. Default=off.
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Advanced Shaders Rollout (mental ray Material)

Material Editor > Type button > Material/Map Browser > mental ray > Advanced
Shaders rollout

Note: The mental ray material appears in the Browser only if the mental ray
renderer is the currently active renderer.

The mental ray material lets you create a material exclusively for use by the
mental ray renderer on page 6230. The Advanced Shaders rollout provides
controls for two component shaders that aren't always used.

Interface

Each shader component has a toggle at the left of its name. When the toggle
is on, the shader is used in rendering. When the toggle is off, the shader is
not used, even if it has been assigned. Clicking the button to the right of the
component name displays the Material/Map Browser on page 5290 so you can
assign a particular shader to the component.

Contour Assigns a contour shader on page 6269 to the material.

The contour component can be assigned the following shaders:

LibraryShader

contourCombi

contourCurvature

contourDepth Fade

contourFactor Color

contourLayer Thinner
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LibraryShader

contourSimple

contourWidth From Color

contourWidth From Light

contourWidth From Light Dir

NOTE Contours don't render unless you have also enabled them on the Render
Setup dialog > Renderer panel > Camera Effects rollout on page 6283.

Light Map Assigns a light map shader to the material.

WARNING No light map shaders are provided with 3ds Max. This option is for
users who have access to light map shaders via other shader libraries or custom
shader code.

 ProMaterials

ProMaterials™ are mental ray materials that model materials commonly used
in construction, design, and the environment. They correspond to Autodesk
Revit materials, so they provide a way to share surface and material information
if you also use that application.

ProMaterials are based on the Arch & Design material on page 5544. Like that
material, they work best when used with physically accurate (photometric)
lights, and geometry that is modeled in real-world units. On the other hand,
the interface of each ProMaterial is much simpler than the Arch & Design
material interface, and lets you achieve realistic, physically correct results with
comparitively little effort.
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NOTE The ProMaterials library is a set of mental ray material libraries based on
manufacturing-supplied data and professional images. This includes building and
design materials such as professional wall paint with glossy or matte finishes, solid
glass, and concrete. These materials provide a convenient way of creating realistic
textures. There is actually one library (MAT) file that corresponds to each
ProMaterial: when you use the Material/Map Browser to browse library files, you
see library names such as autodesk.max.promaterials.ceramic.mat,
autodesk.max.profmaterials.concrete.mat, and so on.

 Ceramic ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Ceramic, and then click OK.

Note: The Ceramic material appears in the Browser only if mental ray is the
active renderer.

This material has the appearance of glazed ceramic, including porcelain.

Interface

Parameters rollout

Type The type of ceramic material (Ceramic or Porcelain). Default=Ceramic.
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Color (Reflectance) The color of the rendered appearance of the material.

■ Map button Click to assign a map to this component.

TIP To specify a grout color, use an image file that shows both the tile color and
the grout color.

Surface Finish The texture of the finished surface (High Gloss, Satin, or Matte).
Default=High Gloss.

Surface Bumps Bump pattern to use on the finished surface (for example, to
represent the surface roughness). Can be None, Wavy, or Custom.
Default=None.

To define bumps using an image, select Custom and then assigna map.

■ Custom Map Click to assign a bump map.

■ Amount Adjusts the amount of mapping. Default=0.05.

Tiling Pattern An additional bump pattern, superimposed on the Finish
Bumps pattern (for example, to define grout lines). To define bumps using an
image, select Surface Bumps > Custom.

■ Custom Map Click to assign a tiling pattern map.

■ Height Adjusts the height of the tiling. Default=0.25.

Special Effects rollout

See  Ambient Occlusion Controls on page 5685 and  Round Corners on page 5690.
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Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.

Maps rollout

Ceramic Material Parameters > Color (Reflectance) Lets you assign a map
to the Color component. The toggle at the left controls whether the map is
active; when you assign a map, it turns on by default.

Special Effects > Fillet Radius See  Round Corners on page 5690.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.
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 Concrete ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Concrete, and then click OK.

Note: The Concrete material appears in the Browser only if mental ray is the
active renderer.

This material has the appearance of concrete.

Interface

Parameters rollout

Color (Reflectance) The color of the rendered appearance of the material.

■ Map button Click to assign a map to this component.

Surface Finish Texture of the finished surface: Straight Broom, Curved Broom,
Smooth, Polished, or Custom. Default = Straight Broom.

To define the finish using an image, select Surface Finish > Custom, and then
assign a texture map.

■ Custom Map Click to assign a bump map.

■ Amount Adjusts the amount of bump mapping. Default=0.3.

Sealant The substance used to seal the surface: None, Epoxy, or Acrylic.
Default=None.
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Brightness Variations Simulates discoloration due to weather: None,
Automatic, or Custom. Default=None.

To define a weathering pattern using an image, select Brightness Variations
> Custom, and then assign a map.

■ Custom Map Click to assign a brightness map.

Special Effects rollout

See  Ambient Occlusion Controls on page 5685 and  Round Corners on page 5690.

(Texture) Coordinates for Built-In Textures rollout

Specifies how to map the Surface Finish texture.

UV Channel Specifies the map channel ID to use. Default=1.

Tiling Scales the built-in texture to the geometry. The default value of 1.0 is
a one-to-one mapping. Larger values tile the texture. Default=1.0.
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Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.

Maps rollout

Concrete Material Parameters > Color (Reflectance) Lets you assign a map
to the Color component. The toggle at the left controls whether the map is
active; when you assign a map, it turns on by default.

Special Effects > Fillet Radius See  Round Corners on page 5690.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.
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 Generic ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Generic, and then click OK.

Note: The Generic material appears in the Browser only if mental ray is the
active renderer.

This material is a generic interface for creating a custom appearance.

Interface

Parameters rollout

Diffuse Color (Reflectance) The color of the rendered appearance of the
material.

■ Map button Click to assign a map to this component.

Reflectivity Perpendicular to Surface Measurement of how much the material
reflects when the surface is directly facing the camera. Enter a value between
0 (no reflections) and 1 (maximum reflections). Default=0.2.

■ Map button Click to assign a map to this component.

Reflectivity Parallel to Surface Measurement of how much the material
reflects when the surface is at an angle to the camera. Enter a value between
0 (no reflections) and 1 (maximum reflections). Default=1.0.

■ Map button Click to assign a map to this component.
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Surface Glossiness Measurement of the glossy quality of the surface, which
affects the size and intensityof highlights. Enter a value between 0 (dull) and
1.0 (a perfect mirror). Default=1.0.

■ Map button Click to assign a map to this component.

Surface Imperfections Click to assign a bump map to the surface.

Surface Imperfections (Bump) Amount Adjusts the amount of bump
mapping. Default=0.3.

Transparency rollout

Transparency Measurement of how much light passes through the material.
Enter a value between 0 (completely opaque) and 1 (completely transparent).
When Transparency is 0, Translucency and Index Of Refraction are ignored.
Default=0.0.

■ Map button Click to assign a map to this component.

Translucency Measurement of how much light is scattered by the material,
so that objects behindthe material cannot be seen clearly. Enter a value
between 0 (not translucent) and 1 (completely translucent). Default=0.0.

■ Map button Click to assign a map to this component.

Index of Refraction Measurement of how much a ray of light bends when
entering the material. Enter a value between 0 (no refraction) and 5 (the most
refraction). Default=1.52 (a typical value for transparent glass).

Cutout Opacity Specifies shapes cut into the surface of the material. Click
the map button to specify cut-outs using an image. The value is the amount
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of transparency of the cutouts. Range: 0.0 to 1.0. Default=1.0 (completely
transparent).

■ Map button Click to assign a map to this component.

Backface Cull When on, faces whose normal points away from the camera
are ignored when creating cutouts. Default=off.

■ Map button Click to assign a map to this component.

Self Illumination rollout

Luminance (cd/m^2) Light emitted by the surface, measured in candelas per
square meter. Default=0.0.

Color Temperature (Kelvin) The color of the self-illumination, described in
terms of degrees Kelvin (K). This is useful for describing color values that are
close to white. Default=6500.0 (close to overcast daylight).

Filter Color The color transmitted through the material if it is transparent or
translucent.

■ Map button Click to assign a map to this component.

Ambient Occlusion rollout

See  Ambient Occlusion Controls on page 5685.
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Round Corners rollout

See  Round Corners on page 5690.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.
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Maps rollout

Simple Generic Material Parameters group

Diffuse Color (Reflectance) Lets you assign a map to the Color component.
The toggle at the left controls whether the map is active; when you assign a
map, it turns on by default.

Reflectivity Perpendicular Lets you assign a map to the Reflectivity
Perpendicular To Surface component.

Reflectivity Parallel Lets you assign a map to the Reflectivity Parallel To
Surface component.

Surface Glossiness Lets you assign a map to the Surface Glossiness component.

Transparency group

Transparency Lets you assign a map to the Transparency component.

Translucency Lets you assign a map to the Translucency component.
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Cutout Opacity Lets you assign a map to the Cutout Opacity component

Backface Cull Lets you assign a map to the Backface Cull component.

Self Illumination group

Filter Color Lets you assign a map to the Filter Color component.

Round Corners group

Fillet Radius See  Round Corners on page 5690.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

 Glazing ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Glazing, and then click OK.

Note: The Glazing material appears in the Browser only if mental ray is the
active renderer.

This material has a glazed appearance. It is more general purpose than the
Ceramic material.
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Interface

Parameters rollout

Color (Transmittance) The color of the glass. Can be Clear, Green, Gray,
Blue, Blue-Green, or Custom Color. Default=Clear.

Custom Color When you set Color (Transmittance) to Custom Color, you
can use this color swatch to assign a color other than one of the predefined
choices.

■ Map button Click to assign a map to this component.

Refraction Levels (N. Poly to Traverse) The number of layers in the glazing.
Range: 1 to 6. Default=2.

Reflectance The normalized percentage of light striking the glass that bounces
off again (like a reflection) rather than being absorbed or passing through
(transmittance). Enter a value between 0.001 and 1.0 (100 per cent).
Default=0.1.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.
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Maps rollout

Glazing Material Parameters > Custom Color When you set Color
(Transmittance) to Custom Color, you can assign a map to the color
component. The toggle at the left controls whether the map is active; when
you assign a map, it turns on by default.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

 Hardwood ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Hardwood, and then click OK.

Note: The Hardwood material appears in the Browser only if mental ray is the
active renderer.

The Hardwood material has the appearance of wood.

NOTE In Revit, this material is simply called “Wood.”
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Interface

Parameters rollout

Base Hardwood Click to select an image used to represent the surface of the
wood.

Stain Application Specifies whether the wood is stained: can be either None
or Enabled. Default=None.

■ Color Shows the color of the stain used when Stain Application = Enabled.
Click the color swatch to change the stain color.

Surface Finish Texture of the finished surface. Can be Glossy, Semi-Glossy,
Satin, or Unfinished. Default=Glossy.

Application Type The purpose of the wood (what it is used for): either Flooring
or Furniture. Default=Flooring.

Surface Imperfections Bump pattern to use on the finished surface. Can be
None, Automatic, or Custom. Default=None.

■ Custom Map When Surface Imperfections = Custom, click to choose the
bump map.

■ Amount The amount of bump mapping. Default=0.2.
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Special Effects rollout

See  Ambient Occlusion Controls on page 5685 and  Round Corners on page 5690.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.

Maps rollout

Special Effects > Fillet Radius See  Round Corners on page 5690.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
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Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

 Masonry/CMU ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Masonry/CMU, and then click OK.

Note: The Masonry/CMU material appears in the Browser only if mental ray
is the active renderer.

This material has the appearance of concrete masonry units (CMUs) or
masonry.

Interface

Parameters rollout

Type The type of masonry material: CMU or Masonry. Default=CMU.

Color (Reflectance) The color of the rendered appearance of the material.

■ Map button Click to assign a map to this component.
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Surface Finish Texture of the finished surface. Can be Glossy, Matte, or
Unfinished. Default=Glossy.

Pattern Bump pattern to use on the finished surface. Can be None or Custom.
Default=None.

■ Custom Map When Pattern = Custom, click to choose the bump map.

■ Height The amount of bump mapping. Default=0.25.

Special Effects rollout

See  Ambient Occlusion Controls on page 5685 and  Round Corners on page 5690.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.
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Maps rollout

Masonry/CMU Material Parameters > Color (Reflectance) Lets you assign
a map to the Color component. The toggle at the left controls whether the
map is active; when you assign a map, it turns on by default.

Special Effects > Fillet Radius See  Round Corners on page 5690.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

 Metal ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Metal, and then click OK.

Note: The Metal material appears in the Browser only if mental ray is the
active renderer.

This material has the appearance of metal.
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Interface

Parameters rollout

Type The type of metal: Aluminum, Anodized Aluminum, Chrome, Copper,
Brass, Bronze, Stainless Steel, or Zinc. Default=Aluminum.

Color (Reflectance) The color of the metal when Type equals Anodized
Aluminum.

Patina For Copper or Bronze, the degree of discoloration due to oxidation or
the application of a chemical compound. Enter a value between 0.0 (none)
and 1.0 (full). Default=0.0.

NOTE The Patina renders correctly only on curved surfaces.

Surface Finish Texture of the finished surface. Can be Polished, Semi-Polished,
Satin, or Brushed. Default=Polished.

Relief Pattern Decorative design pressed onto the surface of the metal (in
effect, a bump map). Select a pattern, or select Custom to define the relief
pattern using an image. Can be None, Knurl, Diamond Plate, Checker Plate,
or Custom. Default=None.

■ Pattern Height Height of the relief pattern. Enter 0.0 to make the surface
flat. Enter a value up to 2.0 to increase the depth of the relief pattern.
Default=0.3.
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■ Custom Map When Relief Pattern = Custom, click to choose the bump
map.

Cutouts/Perforations Shapes cut into the surface of the metal. Can be None,
Round Holes, Square Holes, or Custom. Select a shape, or select Custom to
define cut-outs using an image. Default=None.

■ Custom Map When Cutouts/Perforations = Custom, click to choose the
map that specifies holes in the metal.

Special Effects rollout

See  Ambient Occlusion Controls on page 5685 and  Round Corners on page 5690.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.
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(Texture) Coordinates for Built-In Textures rollout

Specifies how to map the Surface Finish, Relief Pattern, and Cutout textures.

UV Channel Specifies the map channel ID to use. Default=1.

Tiling Scales the built-in textures to the geometry. The default value of 1.0 is
a one-to-one mapping. Larger values tile the textures. Default=1.0.

Maps rollout

Round Corners > Fillet Radius See  Round Corners on page 5690.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

 Metallic Paint ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Metallic Paint, and then click OK.
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Note: The Metallic Paint material appears in the Browser only if mental ray is
the active renderer.

This material has the appearance of metallic paint, as on an automobile.

Interface

Parameters rollout

Color (Reflectance) Color of the metallic paint.

■ Map button Click to assign a map to this component.

Surface Finish Texture of the finished surface. Can be Glazed, Glossy, or Satin.
Default=Glazed.

Flakes When set to Enable, adds flakes or flecks to the paint. Default=None.

Flakes Color Color of the flakes, when Flakes equals Enabled.

Special Effects rollout
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See  Ambient Occlusion Controls on page 5685 and  Round Corners on page 5690.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.

Maps rollout

Metallic Paint Material Parameters > Color (Reflectance) Lets you assign a
map to the Color component. The toggle at the left controls whether the map
is active; when you assign a map, it turns on by default.

Round Corners > Fillet Radius See  Round Corners on page 5690.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.
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 Mirror ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Mirror, and then click OK.

Note: The Mirror material appears in the Browser only if mental ray is the
active renderer.

This material acts as a mirror.

Interface

Parameters rollout

Tint Color (Reflectance) Color of the mirror surface.

Special Effects rollout

See  Round Corners on page 5690.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.
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Maps rollout

Special Effects > Fillet Radius See  Round Corners on page 5690.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

 Plastic/Vinyl ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Plastic/Vinyl, and then click OK.

Note: The Plastic/Vinyl material appears in the Browser only if mental ray is
the active renderer.

This material has a synthetic appearance, as of plastic or vinyl.
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Interface

Parameters rollout

Color (Reflectance) The color of the rendered appearance of the material.

■ Map button Click to assign a map to this component.

Type The type of material. Can be Plastic (Solid), Plastic (Transparent), or
Vinyl. Default=Plastic (Solid).

Surface Finish Texture of the finished surface. Can be Polished, Glossy, or
Matte. Default=Polished.

Surface Bumps Bump pattern to use on the finished surface. Can be None or
Custom. Default=None.

■ Custom Map When Surface Bumps = Custom, click to choose the bump
map.

■ Amount The amount of bump mapping. Default=0.05.

Pattern An additional bump pattern, superimposed on the Finish Bumps
pattern. Can be None or Custom. Default=None.

■ Custom Map When Pattern = Custom, click to choose the bump map.

■ Height The amount of bump mapping. Default=0.05.
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Special Effects rollout

See  Ambient Occlusion Controls on page 5685 and  Round Corners on page 5690.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.

Maps rollout
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Plastic/Vinyl Material Parameters > Color (Reflectance) Lets you assign a
map to the Color component. The toggle at the left controls whether the map
is active; when you assign a map, it turns on by default.

Special Effects > Fillet Radius See  Round Corners on page 5690.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

 Solid Glass ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Solid Glass, and then click OK.

Note: The Solid Glass material appears in the Browser only if mental ray is the
active renderer.

This material has the appearance of glass.
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Interface

Parameters rollout

CColor (Transmittance) The color of the glass. Can be Clear, Green, Gray,
Blue, Blue-Green, Bronze, or Custom Color. Default=Clear.

■ Custom Map When Color (Transmittance) equals Custom Color, you can
either click the color swatch to assign the glass material a custom color,
or click the map button to assign a map to this component.

Reflectance Sets the reflectivity of the glass. Default=0.05.

Index of Refraction Sets the Index Of Refraction (IOR). Default=1.52 (a typical
value for glass).

Reference Thickness Sets the apparent thickness of the glass: this value is
independent of the geometry to which the material is applied. Default=6.0.

Surface Roughness Sets the roughness of the glass surface. Default=0.0.

Surface Imperfections Sets a surface pattern for the glass. Can be None,
Rippled, Wavy, or Custom. Default=None.

■ Custom Map When Surface Imperfections = Custom, click to choose the
bump map.

■ Amount The amount of bump mapping. Default=0.3.
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Special Effects rollout

See  Round Corners on page 5690.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.

Maps rollout

Solid Glass Material Parameters > Custom Map Lets you assign a map to
the Color (Transmittance) component. The toggle at the left controls whether
the map is active; when you assign a map, it turns on by default.

Special Effects > Fillet Radius See  Round Corners on page 5690.
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 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

 Stone ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Stone, and then click OK.

Note: The Stone material appears in the Browser only if mental ray is the active
renderer.

This material has the appearance of stone.

Interface

Parameters rollout
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Color (Reflectance) The color of the material.

■ Map button Click to assign a map to this component.

Surface Finish Texture of the finished surface. Can be Polished, Glossy, Matte,
or Unfinished. Default=Polished.

Surface Bumps Bump pattern to use on the finished surface. Can be None ,
Polished Granite, Stone Wall, Glossy Marble, or Custom. Default=None.

■ Custom Map When Surface Bumps = Custom, click to choose the bump
map.

■ Amount The amount of bump mapping. Default=0.5.

Pattern An additional bump pattern, superimposed on the Surface Bumps
pattern. Can be None or Custom. Default=None.

■ Custom Map When Pattern = Custom, click to choose the bump map.

■ Height The amount of bump mapping. Default=0.25.

Special Effects rollout

See  Ambient Occlusion Controls on page 5685 and  Round Corners on page 5690.
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Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.

(Texture) Coordinates for Built-In Textures rollout

Specifies how to map the Surface Finish, Surface Bumps, and Pattern textures.

UV Channel Specifies the map channel ID to use. Default=1.

Tiling Scales the built-in textures to the geometry. The default value of 1.0 is
a one-to-one mapping. Larger values tile the textures. Default=1.0.

Maps rollout

Stone Material Parameters > Color (Reflectance) Lets you assign a map to
the Color component. The toggle at the left controls whether the map is active;
when you assign a map, it turns on by default.

Special Effects > Fillet Radius See  Round Corners on page 5690.
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 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

Wall Paint ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Wall Paint, and then click OK.

Note: The Wall Paint material appears in the Browser only if mental ray is the
active renderer.

This material has the appearance of a painted surface.

NOTE In Revit, this material is simply called “Paint.”

Interface

Parameters rollout

Color (Reflectance) Color of the paint.

Surface Finish Texture of the paint. Can be Gloss, Semi-Gloss, Pearl, Platinum,
Eggshell, or Flat. Default=Flat.

Application Method The method used to apply the paint to the surface. Can
be Roller, Brush, or Spray. Default=Roller.

5682 | Chapter 19   Material Editor, Materials, and Maps



Special Effects rollout

See  Ambient Occlusion Controls on page 5685 and  Round Corners on page 5690.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.

Maps rollout

Special Effects > Fillet Radius See  Round Corners on page 5690.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
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Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

Water ProMaterial (mental ray)

Material Editor > Type button > Material/Map Browser > Choose ProMaterials:
Water, and then click OK.

Note: The Water material appears in the Browser only if mental ray is the
active renderer.

This material has the appearance of water.

Interface

Parameters rollout

Type Type of water source. Can be Swimming Pool, Reflecting Pool,
Stream/River, Pond/Lake, or Sea/Ocean. Default = Swimming Pool.

Color Color of the water (ignored when the Type equals Swimming Pool).
Select a predefined water color, or select Custom to specify a color. Can be
Tropical, Algae/Green, Murky/Brown, Reflecting Pool, Stream/River, Pond/Lake,
Sea/Ocean, or Custom Color. Default=Tropical.

■ Custom Color When Color equals Custom_Color, click to change the water
color.
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Wave Height Relative height of waves in the water. Enter a value between 0
(no waves) and 5 (big waves). Default=0.5.

Performance Tuning Parameters rollout

See  Performance Tuning Controls on page 5692.

 Common ProMaterials Controls

These topics describe controls that are common to all or most of the materials
in the ProMaterials library.

Ambient Occlusion Controls

Material Editor > Type button > Material/Map Browser > Choose a ProMaterials
material, and then click OK. > Special Effects rollout or Ambient Occlusion
rollout > Ambient Occlusion controls

Note: ProMaterials (marked “adsk”) appear in the Browser only if mental ray
is the active renderer. Not all ProMaterials support ambient occlusion.

Ambient Occlusion (AO) is a method spearheaded by the film industry for
emulating the look of true global illumination by using shaders that calculate
the extent to which an area is occluded, or prevented from receiving incoming
light.

Used alone, an AO shader, such as the separate mental ray Ambient/Reflective
Occlusion shader, creates a grayscale output that is dark in areas light cannot
reach and bright in areas where it can.
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The following image illustrates the main results of AO: dark crevices and areas
where light is blocked by other surfaces, and bright areas that are exposed to
the environment.

An example of AO applied to a scene

One important aspect of AO is that the user can see how far it looks for
occluding geometry.
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AO looked up within a shorter radius

Using a radius creates a localized AO effect: only surfaces within the given
radius are considered as occluders. This also speeds up rendering. The practical
result is that the AO provides nice “contact shadow” effects and makes small
crevices visible.

Interface

Depending on the material, the ambient occlusion controls appear either on
the Special Effects rollout or the Ambient Occlusion rollout. Not all
ProMaterials support ambient occlusion.

The following illustration depicts a model helicopter that is lit almost
exclusively by indirect light. Note how the helicopter does not feel “grounded”
in the left-hand image and the shadows under the landing skids are too vague.
The right-hand image uses AO to “punch out” the details and the contact
shadows.
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Left: Without AO

Right: With AO

There are four controls for ambient occlusion:

Ambient Occlusion When on, enables ambient occlusion (AO) and makes
the remaining group controls available. Default=off.

Samples The number of samples (rays) shot for creating AO. Higher values
yield smoother results but render more slowly, while lower values render faster
but look grainier. Values in the range 16–64 cover most situations. Default=16.

Max Distance Defines the radius within which mental ray looks for occluding
objects. Smaller values restrict the AO effect to small crevices only but are
much faster to render. Larger values cover larger areas but render more slowly.
Default=4.0.

The following illustrations show the raw AO contribution with two different
distances:

Left: Higher Max Distance value

Right: Lower Max Distance value
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TIP To specify an infinite radius, set Distance to 0.0.

Use Color from Other Mats (Exact AO) When on, derives the AO coloring
from surrounding materials, for more accurate overall results (also known as
color bleeding). For example, a glowing material would return a brighter color
than a dark material.

In the following pair of illustrations, the first image shows the problem with
the traditional AO: it applies to all indirect illumination and always makes it
darker. It is most noticable on the glowing sphere, which has a dark spot under
it, but can also be perceived on the floor in front of the cube which is
suspiciously dark, even though the cube is strongly lit on the front, as well as
between the legs of the horse and the underside of the red sphere.

In contrast, the second image has Use Color From Other Mats on for all
materials, so the floor is lit correctly by the glowing ball, there is a hint of
white bounce light on the floor from the cube, and light appears between the
legs of the horse and on the underside of the red ball.

Use Color From Other Mats is off
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Use Color From Other Mats is on

If you find that using AO creates a “dirty” look with excessive darkening in
corners, or dark rims around self-illuminated objects, turn on Use Color From
Other Mats for a more accurate result.

 Round Corners

Material Editor > Type button > Material/Map Browser > Choose a ProMaterials
material, and then click OK. > Special Effects rollout or Round Corners rollout
> Round Corners controls

Note: ProMaterials (marked “adsk”) appear in the Browser only if mental ray
is the active renderer. Not all ProMaterials support round corners.

Computer-generated imagery tends to look unrealistic, partly because edges
of objects are geometrically sharp, whereas most edges in the real world are
slightly rounded, chamfered, worn, or filleted in some manner. This rounded
edge tends to “catch the light” and create highlights that make edges more
visually appealing.

Many ProMaterials can create the illusion of rounded edges at render time.
This feature is intended primarily to speed up modeling, so that you need not
explicitly fillet or chamfer edges of an object such as a tabletop.
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Left: No round corners

Right: Round corners

The function is not a displacement; it is merely a shading effect, such as bump
mapping, and it is best suited for straight edges and simple geometry, not for
advanced, highly curved geometry.

Interface

Depending on the material, the round corner controls appear either on the
Special Effects rollout or the Round Corners rollout. Not all ProMaterials
support round corners.

This effect rounds off corners and straight edges as a rendering effect only; it
has no effect on geometry.

The rounding effect happens to convex corners and surfaces that actually
intersect. Concave corners that merely touch will not display the effect. To
get the effect to work in concave corners the objects must be pushed into each
other a little. The effect is intended for straight edges and is not guaranteed
to work properly for highly curved, complex intersections.

There are three controls for round corners:

Round Corners When on, rounds off corners and straight edges at render
time. Default=off.

NOTE For some ProMaterials, there is no Round Corners toggle. In this case, the
Fillet Radius defaults to 0.0. To enable rendering with round corners, increase the
Fillet Radius value.

Fillet Radius Specifies the radius of the filleted corners and/or edges.
Default=0.25.
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You can apply a map to this parameter, to create variations in the amount of
corner rounding.

Blend With Other Materials By default, the rounding effect happens only
between surfaces of the same material, but if you turn this on the filleting is
performed against any material. Default=off.

In the following image, the melted chocolate is rounded off against the
submerged objects even though they use different materials. In actuality, the
melted chocolate is a completely flat plane.

Objects in melted chocolate

 Performance Tuning Controls

Material Editor > Type button > Material/Map Browser > Choose a ProMaterials
material, and then click OK. > Performance Tuning Parameters rollout

Note: ProMaterials (marked “adsk”) appear in the Browser only if mental ray
is the active renderer.

The performance tuning parameters let you tune performance by limiting the
amount of calculation a ProMaterial has to perform. There are four parameters,
but for each material, only the relevant settings appear in the interface.

Reflection Glossy Samples Defines the maximum number of samples (rays)
that mental ray shoots to create glossy reflections. Higher values cause slow
rendering but create a smoother result. Lower values render faster but create
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a grainier result. Generally 32 is enough for most cases. Default=8 for most
ProMaterials, 0 for Mirror.

NOTE When Reflection Glossy Samples equals 0, the reflections take the form of
a “perfect mirror” and only one ray is shot, regardless of the actual value of
Glossiness . You can use this to boost performance for surfaces with very weak
reflections.

Refraction Glossy Samples Defines the maximum number of samples (rays)
that mental ray shoots to create glossy refraction. Higher values cause slow
rendering but create a smoother result. Lower values render faster but create
a grainier result, like frosted glass. Generally 32 is enough for most cases.
Default=8.

NOTE When Refraction Glossy Samples equals 0, the refraction takes the form of
a “perfect lens” and only one ray is shot. You can use this to boost performance
for draft renderings.

Reflection Max Trace Depth When this trace depth is reached, mental ray
stops calculating reflections. Default=0.

Refraction Max Trace Depth When this trace depth is reached, mental ray
stops calculating refractions. Default=0.

Subsurface Scattering (SSS) Materials

Material Editor > Type button > Material/Map Browser > Choose SSS Fast
Material (mi), SSS Fast Skin Material (mi), SSS Fast Skin Material+Displace (mi),
or SSS Physical Material (mi), and then click OK.

Note: The SSS materials appear in the Browser only if mental ray is the active
renderer.

The subsurface scattering (SSS) materials are provided especially to model skin
and other organic materials whose appearance depends on more than one
layer of light scattering. 3ds Max provides four of these materials. Each material
is a top-level wrapper (a “phenomenon”) for shaders whose controls are
documented in the Standard mental ray Shader Libraries document. Click a link
to see the mental images documentation for the shader.
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TIP When you follow a link to the documentation for mental images library shaders,
scroll up a bit in your browser. The links tend to go past the title of the section,
and there might be introductory content above the link location. If the link goes
to the beginning of a section, scroll down instead.

mi Library Shader NameMaterial Name

misss_fast_simple_phenSSS Fast Material (mi)

misss_fast_skin_phenSSS Fast Skin Material (mi)

misss_fast_skin_phen_dSSS Fast Skin Material+Displace (mi)

misss_physicalSSS Physical Material (mi)

Also see Subsurface Scattering Shaders and the topics that follow it for more
general information. See Physically Correct Subsurface Scattering for background
information and tips about the Physical material.

NOTE The SSS Physical Material can also be used as a shader for the Surface and
Photon components of a mental ray material on page 5638.

For a downloadable tutorial offering a practical demonstration of using the
SSS Fast Skin material, see
http://www.autodesk.com/3dsmax-mentalray-sssskin-tutorialthis Web page.

Light Controls for the SSS Physical Material

The SSS Physical material includes light controls that correspond to the lights
array in the parameters for the misss_physical shader.

Lights When on, the material is illuminated only by those lights specified in
the list. When Lights is turned off, all lights in the scene affect the material.
Default=off.

The remaining light controls are available only when Lights is on.

■ List of lights Displays the lights you have chosen to illuminate this
material.

■ Add Adds a light to the list. Click Add to turn it on, then click the light
object in a viewport.
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■ Replace Replaces a light in the list. Highlight a light's name in the list,
click Replace to turn it on, then click the replacement light object in a
viewport.

■ Delete Deletes a light from the list. Highlight a light's name in the list,
then click Delete.

 Utility mental ray Materials

The utility mental ray materials allow you to combine a material with multiple
maps.

 Utility Bump Combiner Material (mental ray)

Material Editor > Type button > Material/Map Browser > Utility Bump
Combiner (adsk)

Note: The Bump Combiner material appears in the Browser only if the mental
ray renderer is the currently active renderer.

The Bump Combiner lets you combine a material with up to three separate
bump maps.
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Interface

Parameters rollout

Shading Click the button to specify a base material. This can be any material
that mental ray supports.

Global Multiplier Adjusts the strength of bump mapping for the material as
a whole. This value overrides the individual bump map multiplier values. Can
range from 0.0 to 20.0. Default=1.0.

Map button Click to apply a map to the Global Multiplier value.

Bump 1, Bump 2, and Bump 3 Click to add a bump map to the material.

Multiplier Adjusts the strength of the bump map. Can range from 0.0 to 20.0.
Default=1.0.

Map button Click to apply a map to the Multiplier value.

Maps rollout
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Global Multiplier Lets you assign a map to the Global Multiplier. The toggle
at the left controls whether the map is active; when you assign a map, it turns
on by default.

Multiplier 1, Multiplier 2, and Multiplier 3 Let you assign maps to the three
bump map Multiplier values.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

 Utility Displace Combiner Material (mental
ray)

Material Editor > Type button > Material/Map Browser > Utility Displace
Combiner (adsk)

Note: The Displace Combiner material appears in the Browser only if the
mental ray renderer is the currently active renderer.

The Displace Combiner lets you combine a material with up to three separate
displacement maps.
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Interface

Parameters rollout

Shading Click the button to specify a base material. This can be any material
that mental ray supports.

Global Multiplier Adjusts the strength of displacement mapping for the material
as a whole. This value overrides the individual displacement shader multiplier
values. Can range from 0.0 to 20.0. Default=1.0.

Map button Click to apply a map to the Global Multiplier value.

Displace Shader 1, Displace Shader 2, and Displace Shader 3 Click to add
a displacement map to the material.

Multiplier Adjusts the strength of the displacement map. Can range from 0.0
to 20.0. Default=1.0.

Map button Click to apply a map to the Multiplier value.

Maps rollout
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Global Multiplier Lets you assign a map to the Global Multiplier. The toggle
at the left controls whether the map is active; when you assign a map, it turns
on by default.

Multiplier 1, Multiplier 2, and Multiplier 3 Let you assign maps to the three
displacement shader Multiplier values.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

Matte/Shadow Material

Material Editor > Type button > Material/Map Browser > Matte/Shadow

The Matte/Shadow material allows you to make whole objects (or any subsets
of faces) into matte objects on page 8042 that reveal the current background
color or environment map on page 7964.
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Simply rendering the framed photo against a background shows the photo in front of
the background.
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A matte object hides parts of the photo, revealing the background to make it appear
the photo is behind the goblets.

It can also receive shadows cast on it from non-matte objects in the scene.
Using this technique, you can cast shadows on backgrounds by building matte
proxy objects and placing them in front of similarly shaped objects in the
background.
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Creating a matte object for casting shadows against a background image

Matte/Shadow materials can also have reflections.

NOTE The Matte/Shadow effect is visible only when you render the scene. It isn't
visible in viewports.

TIP When rendering with mental ray, for best results and greater flexibility use
the Matte/Shadow/Reflection (mi) material on page 5622 instead of this one. Because
of the availability of the mental ray-specific material, the Matte/Shadow material
is designated Incompatible on page 5299 when mental ray is active.
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Procedures

To render objects seamlessly against a background environment:

There are three ways you can render objects to blend seamlessly into a
background environment:

■ Assign a Matte/Shadow Material.

■ Assign a 100% self-illuminated diffuse texture to an object using Camera
Mapping.

■ Assign a 100% self-illuminated diffuse texture using Environment/Screen
projection.

Use the Plate Match/MAX R2.5 antialiasing whenever you are trying to match
foreground objects with an unfiltered background, or trying to match the
antialiasing qualities of the 3ds Max 2.5 renderer. See the description of
Antialiasing Filter in the description of the Default Scanline Renderer on page
6141.

Example: To see the effect of Affect Alpha and Matte Reflection:

1 Create a scene with one or more objects on a box platform, and one or
more shadow-casting spotlights.

TIP If you use only one spotlight, increase its Multiplier value.

2 Assign a Matte/Shadow material to the box, and render the scene with
default Matte/Shadow parameters (Opaque Alpha is on, and Affect Alpha
is off).

3  On the Rendered Frame Window  on page 6073 that opens, turn on
Display Alpha Channel.

The objects all appear as white silhouettes, including the platform.

4 On the Matte/Shadow Basic Parameters rollout, turn off Opaque Alpha,
and turn on Receive Shadows and Affect Alpha.

5 Press F9 (Render Last on page 6117).

The silhouette of the box no longer appears, but the other objects and
their shadows appear.
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6 On the Matte/Shadow Basic Parameters rollout, click the Map button in
the Reflection group, and use the Material/Map Browser on page 5290 to
assign a Flat Mirror on page 5946 map to the box's material. On the Flat
Mirror Parameters rollout, turn on Render group > Assign To Faces With
ID and leave the value set to 1.

7 Press F9 (Render Last on page 6117).

8 On the Rendered Frame Window, turn off Display Alpha Channel.

The reflections of the objects appear on the box, even though the box
itself is invisible.

Interface
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Matte group

Opaque Alpha Determines whether or not the matte material appears in the
alpha channel. If you turn off Opaque Alpha, the matte object will not make
an alpha channel, and the image can be used for compositing, just as if there
are no matte objects in the scene. Default=off.

Atmosphere group

These options determine whether fog effects are applied to the matte surfaces,
and how they are applied.

Apply Atmosphere Turns the fogging of matte objects on and off.

When applying fog, you can choose between two different methods. You can
either apply fog as if the matte surface is at an infinite distance from the
camera or you can apply it as if the matte surface is actually at that point on
the object being shaded. In other words, you can apply the fog to the matte
surface in either 2D or 3D. The following controls determine how this is
applied:

At Background Depth This is the 2D method. The scanline renderer on page
8116 fogs the scene, and then renders its shadows. In this case, the shadows
won't be lightened by the fog. If you want to lighten the shadows, you need
to turn up the shadow brightness.

At Object Depth This is the 3D method. The renderer first renders the shadows,
and then fogs the scene. Since this varies the amount of fog over the 3D matte
surface, the generated matte/alpha channels don't blend perfectly into the
background. Use At Object Depth when the matte object is meant to be a 3D
object in the scene that the 2D background represents.

Shadow group

This group determines whether the matte surfaces receive shadows that are
cast upon them, and how they receive them.

Receive Shadows Renders shadows on the matte surfaces. Default=on.

Affect Alpha When on, shadows cast on a matte material are applied to the
alpha channel. This lets you render bitmaps with alpha channels that you can
composite later. Default=on.

Affect Alpha is available only when Opaque Alpha (in the Matte group box)
is turned off.
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When Affect Alpha is on, the higher the Shadow Brightness value, the more
transparent the shadow, allowing the background to show through more, and
making the shadow appear brighter.

Shadow Brightness Sets shadow brightness. At 0.5, the shadows will not be
attenuated on the matte surface; at 1.0, the shadows are brightened to the
color of the matte surface; and at 0.0 they are darkened to completely obliterate
the matte surface.

Color Displays a Color Selector on page 391 to let you choose the color of the
shadow. Default=black.

Setting shadow color is especially useful when you're using a Matte/Shadow
material to composite your shadows against a background image, such as
video. It lets you tint your shadows to match pre-existing shadows in the
image.

Reflection group

Controls in this group determine whether the matte surfaces can have
reflections. You create matte reflections using a shadow map.

TIP Matte reflections don't successfully create an alpha channel unless you render
them against a black background.

Amount Controls the amount of reflection to use. This is a percentage that
can range from 0 to 100. This control is unavailable unless you have assigned
a map. Default=50.

You can animate this parameter.

Map Displays the Material/Map Browser on page 5290 so you can assign a map
to use for reflections. The reflection is independent of the environment unless
you choose a Reflect/Refract on page 5946 or Flat Mirror map on page 5946.

Compound Materials

Compound materials combine two or more sub-materials. Compound materials
are similar to compositor maps on page 5918, but they exist at the material level.
Applying a compound material to an object creates a compound effect that
often uses mapping. You load or create compound materials using the
Material/Map Browser.

Using a filter control, you can choose whether the Browser lists maps or
materials or both.
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Different types of materials create different effects, behave in particular ways,
or are provided as ways to combine multiple materials.

NOTE The sub-material buttons and sub-map buttons for most materials and
maps have check boxes beside each button. These let you turn that branch of the
material or map on or off. For example, in the Top/Bottom material, the Top
Material and Bottom Material buttons each have check boxes. Similarly, the Checker
map has two map buttons, one for each color. Each button has a check box beside
it that lets you disable that color's map.

These are the different types of compound materials:

Blend on page 5708: Combines two materials by mixing their pixel colors, as
Mix maps do.

Composite on page 5711: Mixes up to 10 materials, using additive colors,
subtractive colors, or opacity mixing.

Double-Sided on page 5713: Stores two materials. One material is rendered on
the object's outer faces (the usual side for one-sided materials, as determined
by face normals), and the other is rendered on the object's inner faces.

Morpher Material on page 5716: Morpher materials use the Morpher modifier
on page 1545 to manage multiple materials over time.

Multi/Sub-Object on page 5720: Lets you assign more than one material to the
same object. Stores two or more sub-materials, which you assign at the
sub-object level by using the Mesh Select on page 1527 modifier. You can also
assign the sub-materials to whole objects by using the Material modifier on
page 1517.

Shellac on page 5727: Superimposes one material on another.

Top/Bottom on page 5729: Stores two materials. One material is rendered on an
object's top faces and the other is rendered on the object's bottom faces,
depending on whether a face normal points up or down.

Procedures

To have the Browser list only materials:

■ At the top of the Show group, leave Materials on and turn off Maps.

NOTE This option is available only at the material level in the Material Editor.
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Blend Material

Material Editor > Type button > Material/Map Browser > Blend

Blend material combines bricks and stucco.

The Blend material lets you mix two materials on a single side of the surface.
Blend has an animatable Mix Amount parameter that lets you draw material
morphing on page 8049 function curves to control the way that the two materials
are blended over time.

NOTE If even one sub-material has its shading set to Wire (see Shader Basic
Parameters Rollout on page 5397), the entire material displays and renders as a wire
material.

Procedures

To create a Blend material:

1 Activate a sample slot in the Material Editor.

2 Click the Type button.

3 In the Material/Map Browser on page 5290, choose Blend and then click
OK.
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A Replace Map on page 5376 dialog is displayed. This dialog asks whether
you want to discard the original material in the slot, or retain it as a
sub-material.

Blend materials have similar controls to Mix maps.

To specify a component material:

■ In the Blend Basic Parameters rollout, click one of the two material buttons.
The parameters for the sub-material are displayed. By default, a sub-material
is a Standard material with Blinn shading.

To control the mix amount:

■ In the Basic Parameters rollout, adjust the Mix Amount value.
You can also control the mix amount by using a map.

Map used to reveal brick beneath stucco

To control the mix amount using a map:

■ In the Basic Parameters rollout, click the map button next to Mask.
The Browser is displayed so you can select a map type.

The intensity of pixels in this mixing map controls the mix. When the
intensity is close to zero, one of the component colors or maps is visible;
when it is close to full intensity, the other component is visible.
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TIP Using a Noise map for the mixing map can give good effects that have a
natural appearance.
Mix Amount is unavailable while a map is assigned to this parameter. If
Use Curve is turned off, the mixing map is used as is. If Use Curve is on,
you can shift the effect of the mixing map's gradient ramp to reveal more
of one material and less of the other.

Interface

Material 1/Material 2 Set the two materials to be blended. Use the check
boxes to turn the materials on and off.

Interactive Chooses which of the two materials is displayed on object surfaces
in viewports by the interactive renderer.

If one material has Show Map in Viewport on page 5350 on, this takes precedence
over the Interactive setting. Only one map at a time can be displayed in
viewports.
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Mask Sets a map to use as a mask. The degree of blending between the two
materials depends on the intensity of the mask map. Lighter (whiter) areas of
the mask show more of Material 1, while darker (blacker) areas of the mask
show more of Material 2. Use the check box to turn the mask map on or off.

Mix Amount Determines the proportion of the blend (percentage). 0 means
only Material 1 is visible on the surface; 100 means only Material 2 is visible.
Unavailable if you have assigned a mask map and the mask's check box is on.

You can animate this parameter. Create Material Preview on page 5333 is useful
for testing the effect.

Mixing Curve group

The mixing curve affects how gradual or how sharp the transition between
the two colors being blended will be. It affects the blend only when a mask
map is assigned.

TIP For mottled effects, blend two standard materials using a noise map as a mask.

Use Curve Determines whether the Mixing Curve affects the mix. This control
is available only when a mask is assigned and active.

Transition Zone These values adjust the level of the Upper and Lower limits.
If the two values are the same, the two materials meet at a definite edge. Wider
ranges give more gradual blending from one sub-material to the other. The
mixing curve displays the effect of changing these values.

Composite Material

Material Editor > Type button > Material/Map Browser > Composite

Composite material composites on page 7937 up to 10 materials. The materials
are superimposed from top to bottom, as listed in the rollout. Materials are
combined using additive opacity on page 7901, subtractive opacity on page 8140,
or mixed using an Amount value.

NOTE If even one sub-material has its shading set to Wire (see Shader Basic
Parameters Rollout on page 5397), the entire material displays and renders as a wire
material.

See also:

■ Composite Map on page 5918

Compound Materials | 5711



Interface

Base Material Displays the Material/Map Browser on page 5290, where you
assign the base material. By default, the base material is a Standard material.
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The other materials are composited by superimposing them on top of this
material, in order from top to bottom.

Mat 1 through Mat 9 Each of these nine groups contains controls for a
material to composite. By default, no materials are assigned.

Check box When on, uses the material in the composite. When off, doesn't
use it. Default=on.

Button Displays the Material/Map Browser on page 5290, where you assign a
material to composite.

ASM buttons These buttons control how the material is composited.
Default=A.

■ A This material uses additive opacity on page 7901. Colors in the material
are summed based on their opacity.

■ S This material uses subtractive opacity on page 8140. Colors in the material
are subtracted based on their opacity.

■ M This material mixes materials based on the Amount value (see
following). Both color and opacity are blended as they are when you use
a Blend material on page 5708 with no mask.

Amount Controls the amount of mixing. Default=100.0.

For additive (A) and subtractive (S) compositing, the Amount value can range
from 0 to 200. When the Amount is 0.0, no compositing happens, and the
material below is not visible. When the Amount is 100.0, the composite is
complete. When the amount is greater than 100.0, compositing is "overloaded":
transparent portions of the material become more opaque, until the material
below is no longer visible.

For mix (M) compositing, the Amount can range from 0.0 to 100.0. When
the Amount is 0.0, no compositing happens, and the material below is not
visible. When the amount is 100.0, compositing is complete, and only the
material below is visible.

Double-Sided Material

Material Editor > Type button > Material/Map Browser > Double-Sided
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On the right, a double-sided material creates a pattern for the inside of the trash can.

The Double-Sided material lets you assign two different materials to the front
and back faces of an object.

NOTE If even one sub-material has its shading set to Wire (see Shader Basic
Parameters Rollout on page 5397), the entire material displays and renders as a wire
material.

Procedures

To create a double-sided material:

1 Activate a sample slot in the Material Editor.

2 Click the Type button.

3 In the Material/Map Browser, choose Double-Sided and then click OK.

A Replace Map dialog on page 5376 is displayed. This dialog asks whether
you want to discard the original material in the slot, or retain it as a
sub-material.
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The Double-Sided material controls let you choose the two materials, and
the translucency of the material overall.

To choose the outer material:

■ Click the button labeled Facing Material.
The parameters for the sub-material are displayed. By default, a sub-material
is a Standard material with Blinn shading.

To choose the inner material:

1 Go back to the parent material (parameters for the Double-Sided material).

2 On the Double-Sided Basic Parameters rollout, click the button labeled
Back Material.

The parameters for the sub-material are displayed. By default, a
sub-material is a Standard material with Blinn shading.

To make the material translucent:

■ Set Translucency to a value greater than 0.
The Translucency control affects the blending of the two materials. When
Translucency is 0, there is no blend. When Translucency is 100.0 percent,
the outer material is visible on inner faces and the inner material is visible
on outer faces. At intermediate values, the specified percentage of the inner
material "bleeds through" and is visible on outer faces.

Interface

Translucency Sets the amount that one material shows through the other.
This is a percentage that can range from 0.0 to 100.0. At 100 percent, the outer
material is visible on inner faces and the inner material is visible on outer
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faces. At intermediate values, the specified percentage of the inner material
"bleeds through" and is visible on outer faces. Default=0.0.

You can animate this parameter.

Facing Material and Back Material Click to display the Material/Map Browser
on page 5290 and choose a material for one side or the other.

Use the check boxes to turn the materials on or off.

Morpher Material

Material Editor > Type button (labeled Standard by default) > Material/Map
Browser > Morpher material

Procedures on page 5717 Interface on page 5718

The Morpher material works hand-in-hand with the Morpher modifier. You
can use it to make the cheeks of a character blush, or to wrinkle a character's
forehead when the eyebrows are raised. With the Morpher modifier's channel
spinners, you can blend materials the same way you morph the geometry.

The Morpher material has 100 material channels that map directly to the 100
channels in the Morpher modifier. After you apply the Morpher material to
an object and bind it to the Morpher modifier, you use the channel spinners
in the Morpher modifier to morph materials and geometry. Empty channels
in the Morpher modifier, with no geometry morph data, can be used to morph
materials only.

NOTE The mental ray renderer on page 6230 does not support the Morpher material.

NOTE If even one sub-material has its shading set to Wire (see Shader Basic
Parameters Rollout on page 5397), the entire material displays and renders as a wire
material.

See also:

■ Morpher Modifier on page 1545
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Applying the Morpher Material

An object must have at least one Morpher modifier in its modifier stack. You
can assign the material to an object and bind it to the object's Morpher
modifier in either of two ways.

■ After the Morpher modifier is applied to an object, use the Assign New
Material command in the Global Parameter rollout of the Morpher modifier.
This is the simplest way, and applies the Morpher Material to the object
and binds the material to the Morpher modifier at the same time.

■ Open the Material Editor, select the Morpher material, and click Choose
Morph Object in the Parameters rollout, then click the object in the
viewports. After clicking the object, a dialog displays in the viewports,
select the Morpher modifier from the dialog (an object may have multiple
Morpher modifiers). This binds the Morpher material to the Morpher
modifier.

NOTE You can bind a Morpher material to only one Morpher modifier.

Procedures

Example: To apply and use the Morpher material:

1 Create a sphere in the Perspective viewport.

2  On the Modify panel, right-click the sphere's entry in the modifier
stack display, and choose Convert To: Editable Mesh.

3 From the Modifier List, choose Morpher.

This applies the Morpher modifier to the sphere.

4 On the Morpher modifier's Global Parameters rollout, click Assign New
Material.

The Morpher material is now applied to the object and bound to the
Morpher modifier.

5  Open the Material Editor, and click Pick Material from Object
(the eyedropper), then click the sphere in the viewports.

The Material Editor displays the Morpher material parameters.

6 On the Morpher Material Parameters rollout, click the Mat 1 slot.
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7 On the Material/Map Browser choose Standard.

8 On the Basic Parameters rollout, click the Diffuse color swatch.

9 On the Color Selector, choose a bright yellow, and close the color selector.
Leave the Material Editor open.

10  Turn on the Auto Key button, then move the time slider to
frame 50.

11  Select the sphere, and then open the Modify panel.

12 On the Morpher modifier's Channel List rollout, set the channel 1 spinner
to 100.

In the Material Editor, the color of the sample sphere changes to yellow.

13 On the main toolbar, click Render.

The sphere is yellow. If you render an animation the sphere changes from
a grey color to yellow.

Interface

The Morpher material interface is on a Parameters rollout in the Material
Editor.
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Modifier Connection group

Choose Morph Object Click this option, then select an object in the viewports
that has a Morpher modifier applied to it. Clicking an object in the viewports
displays the Choose Morpher modifier dialog. Choose a Morpher modifier,
and click Bind.

Name Field Displays the name of object to which the Morpher material is
applied. If no object has been specified, the field displays "No Target".

Refresh Updates the channel data.

Marker List This list is identical to the marker list in the Morpher modifier.
Markers you save in the Morpher modifier appear here.

Base Material group

Base material button Click to apply a base material to the object. The base
material represents what the model looks like before any channel blending
takes place.

Channel Material Setup group

Map # 100 material channels are available. The scroll bar allows you to scroll
through all the channels. Double-click a channel to jump to the material
parameters for that channel.
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There is a one-to-one correspondence between the channels in the Morpher
material and the Morpher modifier. A material in channel 1 of the Morpher
material is controlled by the channel 1 spinner in the Morpher modifier.

Material on/off toggle Turns a channel on and off. Channels that are off do
not affect the morph result.

Mixing Calculation Options group

The system can slow down if there are many active materials being blended.
Options in this group allow you to control when the morph result will be
computed.

Constantly Choose to compute the material morph result all the time.

When Rendering Choose to compute the material morph result at render
time.

Never Calculate Choose to bypass material blending.

Multi/Sub-Object Material

Material Editor > Type button > Material/Map Browser > Multi/Sub-Object
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Figure mapped using a Multi/Sub-Object material

The Multi/Sub-Object material lets you assign different materials at the
sub-object level of your geometry. You create a multi-material, assign it to an
object, and then use the Mesh Select modifier on page 1527 to select faces and
choose which of the sub-materials in the multi-material are assigned to the
selected faces.

If the object is an editable mesh on page 2075, you can drag and drop materials
to different selections of faces, building a Multi/Sub-Object material on the
fly. See Drag and Drop Sub-Object Material Assignment on page 5312.

You can also create a new Multi/Sub-Object material by dragging to faces
selected with the Edit Mesh modifier on page 1353.

Sub-material IDs do not depend on the order of the list, and you can enter
new ID values.

The Make Unique button on page 5346 in the Material Editor lets you make an
instanced sub-material into a unique copy.

At the Multi/Sub-Object material level, the sample slot's sample object shows
a patchwork of the sub-materials. When you edit a sub-material, the sample
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slot display depends on the setting of the Simple Multi Display Below Top
Level toggle in the Material Editor Options dialog on page 5335.

Using Multi/Sub-Object Materials

Here are some usage tips with regards to mesh editing and managing
sub-materials.

■ When working at sub-object levels of Editable Meshes, Polys, Patches and
Splines, or with objects that have Edit Mesh, Spline or Patch modifiers
applied to them, you can browse by sub-material names if the object has
a multi-sub-object material applied to it.

■ Sub-materials that are not assigned to an object, or surface of an object,
can be 'cleaned' from the Multi-Sub-Object material by using the Clean
MultiMaterial utility on page 6052.

■ Duplicate maps, assigned to materials, can be changed to instances by
using the Instance Duplicate Maps utility on page 6058.

Procedures

To create a Multi/Sub-Object material:

1 Activate a sample slot in the Material Editor.

2 Click the Type button.

3 In the Material/Map Browser on page 5290, choose Multi/Sub-Object and
then click OK.

A Replace Map dialog on page 5376 is displayed. This dialog asks whether
you want to discard the original material in the slot, or retain it as a
sub-material.

The controls for a Multi/Sub-Object material are essentially a list of the
sub-materials it contains.

To assign a sub-material:

■ On the Multi/Sub-Object Basic Parameters rollout, click a sub-material
button.
The parameters for the sub-material appear. By default, a sub-material is a
Standard material with Blinn shading.
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To make one of the sub-materials a solid color:

■ On the Multi/Sub-Object Basic Parameters rollout, click the color swatch
next to the sub-material button.
In the Color Selector on page 391, choose a color.

The color swatches for sub-materials are shortcuts. They assign the color
you choose to the sub-material's Diffuse component.

To assign one of the sub-materials to a sub-object selection:

1 Select the object, and assign a Multi/Sub-Object material to it.

2  On the Modify panel on page 7633, apply Mesh Select on page 1527
to the object.

3 Click Sub-Object and choose Face as the sub-object category.

4 Select the faces to which you will assign a sub-material.

5 Apply a Material modifier on page 1517, and set the material ID value to
the number of the sub-material you want to assign.

The viewport updates to show the sub-material assigned to the selected
faces.

The material ID values in the Multi/Sub-Object material and the material
ID numbers in the Select Face rollout correspond. If you set the ID to a
number that doesn't correspond to a material contained in the
Multi/Sub-Object material, the faces render as black.

WARNING Some geometric primitives do not use 1 as the default material ID,
and some, such as hedra or box, have multiple material IDs by default.

TIP You can also use the Edit Mesh modifier on page 1353 to assign a contained
material to selected faces. Apply Edit Mesh to the object, go to the Face sub-object
level, and select the faces to assign. Then on the Edit Surface rollout, set the material
ID value to the ID of the sub-material. (You can drag and drop on page 5312 a
Multi/Sub-Object material to an Edit Mesh modifier as you can to an editable mesh
object.)

To add a new sub-material:

■ Click Add.
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A new sub-material is added to the end of the list. By default, the new
sub-material's ID number is one greater than the highest material ID already
in use.

To remove a sub-material:

1 Select the sub-material by clicking its small sample sphere in the
Multi/Sub-Object Basic Parameters rollout.

The small sample sphere is surrounded by a black and white border to
show the sub-material is selected.

If the list of sub-materials is longer than the rollout will hold, you can
use the scroll bar at the right to display other parts of the list.

2 Click Delete.

The sub-material is removed.

Deleting a sub-material is an undoable operation.
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Interface

Number This field displays the number of sub-materials contained in the
Multi/Sub-Object material.

Set Number Sets the number of sub-materials make up the material. At the
Multi/Sub-Object material level, the sample slot's sample object shows a
patchwork of the sub-materials. (When you edit a sub-material, the sample
slot display depends on the setting of the Simple Multi Display Below Top
Level toggle on the Material Editor Options dialog on page 5335.)

Compound Materials | 5725



Reducing the number of sub-materials removes sub-materials from the end of
the list. You can undo Set Number when you have used it to delete materials.

Add Click to add a new sub-material to the list. By default, the new
sub-material's ID number is one greater than the highest material ID already
in use.

Delete Click to delete the currently chosen sub-material from the list. You
can undo deleting a sub-material.

Sort list controls

These buttons appear above three of the columns in the sub-materials list.

ID Click to sort the list so it begins with the sub-material that has the lowest
material ID, and ends with the sub-material that has the highest material ID.

Name Click to sort the list by the names you have entered in the Name
column.

Sub-Material Click to sort the list by the sub-material names that appear on
the Sub-Material buttons.

List of sub-materials

Each sub-material has a single entry in this list. The rollout displays up to 10
sub-materials at a time. If the Multi/Sub-Object material contains more than
10 sub-materials, you can scroll the list using the scrollbar at the right.

Each sub-material in the list has the following controls:

Small sample sphere The small sample sphere is a "mini-preview" of the
sub-material. Click it to select this sub-material. You must select a sub-material
before you delete it.

ID Shows the ID number assigned to this sub-material. You can edit this field
to change the ID number. If you assign two sub-materials the same ID, a
warning message appears at the top of the rollout.

When the Multi/Sub-Object material is applied to an object, faces in the object
assigned the same material ID number render with this sub-material.

You can click Sort by ID to sort the sub-material list by this value, from lowest
to highest.

NOTE Sometimes the Sub-Material button shows a material number. This is not
the sub-material ID.
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Name Lets you enter a custom name for the material. A sub-material name
appears in the Name on page 5360 field when you're at the level of the
sub-material. It also appears in the Browser and the Navigator.

Sub-Material button Click the sub-material button to create or edit one of
the sub-materials. Each of the sub-materials is a complete material in its own
right, with as many maps on page 8036 and levels as you want.

By default, each sub-material is a Standard material on page 5395 with Blinn
shading on page 5426.

Color swatch Click the color swatch to the right of the Sub-Material button
to display the Color Selector on page 391 and choose a diffuse color for the
sub-material.

On/Off toggle Turns the sub-material on or off. When a sub-material is off,
it appears black in the sample slot and on objects in the scene. Default=on.

Shellac Material

Material Editor > Type button > Material/Map Browser > Shellac

Shellac material mixes two materials by superimposing one over the other.
Colors in the superimposed material, called the "shellac" material, are added
to colors in the base material. A Shellac Color Blend parameter controls the
amount of color mixing.
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Top: Base material

Middle: Shellac material

Bottom: Materials combined with a shellac color blend value of 50%
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NOTE If even one sub-material has its shading set to Wire (see Shader Basic
Parameters Rollout on page 5397), the entire material displays and renders as a wire
material.

Interface

Base Material Goes to the level of the base sub-material. By default, the base
material is a Standard material with Blinn shading.

Shellac Material Goes to the level of the shellac material. By default, the
shellac material is a Standard material with Blinn shading.

Shellac Color Blend Controls the amount of color mixing. At 0.0, the shellac
material has no effect. Increasing the Shellac Color Blend value increases the
amount of shellac material color blended into the base material color. There
is no upper limit on this parameter. Large values "overload" the shellac material
colors. Default=0.0.

You can animate this parameter.

Top/Bottom Material

Material Editor > Type button > Material/Map Browser > Top/Bottom
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Top/bottom material gives the pot a charred bottom.

The Top/Bottom material lets you assign two different materials to the top
and bottom portions of an object. You can blend the materials into one
another.

The object's top faces are those whose normals point up. The bottom faces
have normals that point down. You can choose whether "up" and "down"
refer to the scene's world coordinates or to the object's local coordinates.

NOTE If even one sub-material has its shading set to Wire (see Shader Basic
Parameters Rollout on page 5397), the entire material displays and renders as a wire
material.

Procedures

To create a top/bottom material:

1 Activate a sample slot in the Material Editor.

2 Click the Type button.
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3 In the Material/Map Browser on page 5290, choose Top/Bottom and then
click OK.

A Replace Map on page 5376 dialog is displayed. This dialog asks whether
you want to discard the original material in the slot, or retain it as a
sub-material.

The Top/Bottom material controls let you choose the two materials, and
also the transition between them.

To choose the top or bottom material:

■ On the Top/Bottom Basic Parameters rollout, click the Top Material button
or the Bottom Material button.
The parameters for the sub-material appear. By default, a sub-material is a
Standard material with Blinn shading.

To swap the two component materials:

■ In the Basic Parameters rollout, click Swap.
The remaining controls, described in the "Interface" section, affect the
transition between top and bottom.

Interface
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Top Material and Bottom Material Click to display the parameters for the
top or bottom sub-material. By default, a sub-material is a Standard material
with Blinn shading.

The check box to the right of each button lets you turn off that material,
making it invisible in the scene and in the sample slot.

Swap Swaps the position of the top and bottom materials

Coordinates group

Controls in this group let you choose how the software determines the
boundary between top and bottom.

World Faces point up or down according to the scene's world coordinates.
When you rotate the object, the boundary between top and bottom faces
remains in place.

Local Faces point up or down according to the object's local coordinates.
When you rotate the object, the material rotates with it.

Blend Blends the edge between the top and bottom sub-materials. This is a
percentage that can range from 0 to 100. At 0, there is a sharp line between
the top and bottom sub-materials. At 100, the top and bottom sub-materials
tint each other. Default=0.

You can animate this parameter.

Position Determines where the division between the two materials lies on an
object. This is a percentage that can range from 0 to 100. 0 is at the bottom
of the object, and displays only the top material. 100 is at the top of the object,
and displays only the bottom material. Default=50.

You can animate this parameter.

Shell Material

Render to a texture. > Material Editor > Pick Material from Object > Click
object with “baked” material.

The Shell material is for use with texture baking on page 6371. When you use
Render To Texture to bake a texture, it creates a Shell material that contains
two materials: the original material used in the rendering, and the baked
material. The baked material is a bitmap that is saved to disk by Render To
Texture. It is “baked,” or attached to an object in the scene.
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The Shell material is a container for other materials, like Multi/Sub-Object. It
also lets you control which material is used in which renderings.

NOTE The Material/Map Browser lists the Shell material when you assign a new
material. You can apply two materials to a single object this way, but changing a
material's type to Shell does not generate a baked texture that is saved to disk.

Procedures

To load a shell material into a sample slot:

1 Click an unused sample slot.

2  Click Pick Material From Object.

3 In a viewport, click an object that has a baked material.

The sample slot now contains the baked material, and the Shell Material
Parameters rollout is displayed.

Interface

Original Material Displays the name of the original material. Click the button
to view that material and adjust its settings.

Baked Material Displays the name of the baked material. Click the button to
view that material and adjust its settings.

In addition to the color and mapping of the original material, the baked
material can include shadows from lighting, and other information. Also, a
baked material has a fixed resolution.
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Viewport Use these buttons to choose which material appears in shaded
viewports: the original material (upper button) or the baked material (lower
button).

Render Use these buttons to choose which material appears in renderings:
the original material (upper button) or the baked material (lower button).

Advanced Lighting Override Material

Material Editor > Type button > Material/Map Browser > Advanced Lighting
Override

This material lets you directly control the radiosity properties of a material.
Advanced Lighting Override is always a supplement to a base material, which
can be any renderable material. The Advanced Lighting Override material has
no effect on ordinary renderings. It affects the radiosity solution on page 6168
or light tracing on page 6154. Advanced Lighting Override has two main uses:

■ Adjusting the material properties used in a radiosity solution or light tracing

■ Creating special effects such as having self-illuminating objects contribute
energy to the radiosity solution

As the rollout for the Advanced Lighting Override material states, you don’t
have to apply this material to obtain a radiosity solution, and most models
will never require it.

IMPORTANT The mental ray renderer on page 6230 does not support the Advanced
Lighting Override material.

Obtaining a Better Image

Materials that use default settings can be highly reflective. This can lead to
overexposed or washed-out radiosity solutions. In general, the best way to
adjust this is to reduce the HSV Value (V) of a material color; or, for a
bitmapped material, reduce the RGB Level. In some situations, Radiosity
Override can improve the appearance of the radiosity solution. Examples of
situations where Radiosity Override can help include color bleeding and large
dark areas:

■ You might want to reduce Reflectance Scale or Color Bleed when a large
area of color (for example, a red carpet in a room with white walls) creates
excessive color bleeding. This might be physically accurate, but the eye
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adjusts for such effects, and the radiosity result might look better with less
reflectance or less color bleeding.

Left: Excessive bleeding of the floor color onto the walls and ceiling.

Right: Radiosity Override material reduces the floor’s reflectance, causing less
bleeding.

■ You might want to increase Reflectance Scale when the scene includes a
large dark area (for example, a black floor). This can lead to a very dark
radiosity result. You can maintain the floor’s color but increase reflectance,
giving the solution the colors you want while increasing its brightness.

The room is lit only by spotlights pointed at the floor. Increasing reflectance of the
floor brightens the entire room.
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TIP Check the reflectance and transmittance display on page 5324 to get an
idea of how the current material will affect the radiosity solution or light-traced
rendering.

Creating Special Effects

Self-illumination on page 5440 makes an object appear to glow in ordinary
renderings, but does not contribute energy to the radiosity solution. To have
radiosity processing take a self-illuminating material into account, make this
material the base material of Advanced Lighting Override, then increase the
value of Luminance Scale.

Upper left: By default, self-illuminated neon lights do not influence the scene light.

Right: Advanced Lighting Override material scales the neon lights’ Luminance so the
radiosity solution can take it into account.

Luminance scale takes self-illumination mapping on page 5469 into account.
You can use this to model effects such as a computer monitor in a darkened
room.
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The Special Effects group of the Advanced Lighting Override material also has
a control for adjusting the quality of bump mapping on page 5478 in areas of
indirect lighting.

Procedures

To adjust a material’s reflectance and transmittance:

1 Create a material for your scene.

2 Click the Type button and choose Advanced Lighting Override.

3 In the Replace Material dialog on page 5376, choose Keep Old Material As
Sub-Material, and click OK.

4 Adjust the Reflectance Scale and Transmittance Scale parameters. As you
do, watch the Reflectance and Transmittance display, and make sure the
values are good for a radiosity solution. For example, 85 percent
reflectance is about the highest that will work with radiosity. Most
real-world materials have much lower reflectance.

See Reflectance and Transmittance Display on page 5324 for some reflectance
properties of real-world materials.

To make a self-illuminating material emit radiosity energy:

1 Create a material that is self-illuminating.

2 Click the Type button and choose Advanced Lighting Override.

3 In the Replace Material dialog on page 5376, choose Keep Old Material As
Sub-Material, and click OK.

4 Increase the value of Luminance Scale to have the material emit energy
for radiosity processing.
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Interface

Override Material Physical Properties group

These parameters directly control the base material’s advanced lighting
properties.

WARNING There is no problem with reducing the default scale, but increasing it
for any of these parameters might cause colors to “burn out”: if the scale is too
great, they render as pure white, appearing overexposed.

Reflectance Scale Increases or decreases the amount of energy the material
reflects. Range=0.1 to 5.0. Default=1.0.
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Reflectance Scale increases or decreases the energy of reflected rays.

TIP Don’t use this control to increase self-illumination. Use the Luminance Scale
instead. Luminance Scale is in the Special Effects group (below).

Color Bleed Increases or decreases the saturation of reflected color. Range=0.0
to 1.0. Default=1.0.

Color Bleed increases or decreases the saturation of reflected color.

Transmittance Scale Increases or decreases the amount of energy the material
transmits. Range=0.1 to 5.0. Default=1.0.
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Transmittance Scale increases or decreases the energy of transmitted rays.

NOTE This parameter affects only radiosity. It has no effect on light tracing.

Special Effects group

These parameters relate to specific components in the base material.

Luminance Scale (cd/m^2) When greater than zero, scales the
self-illumination component on page 5440 of the base material. Use this
parameter to have self-illuminating objects contribute energy to the radiosity
or light-traced solution. Cannot be less than zero. Default=0.0.

Typically, a value of 500 or more will give good results.

Indirect Light Bump Scale Scales the effect of the base material’s bump
mapping on page 5478 in areas lit by indirect light. When this value is zero, no
bump mapping is done for indirect light. Increasing Indirect Light Bump Scale
increases the bump effect under indirect lighting. This value does not affect
the Bump amount in areas where the base material is lit directly. Cannot be
less than zero. Default=1.0.

TIP This parameter is useful because indirect bump mapping is simulated and not
always accurate. Indirect Light Bump Scale lets you adjust the effect by hand.

Base Material Click to go to the base material and adjust its components. You
can also replace the base material with a different material type.

 To return from the base material to the Advanced Lighting Override
level, click Go To Parent.
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Lightscape Material

Material Editor > Type button > Material/Map Browser > Lightscape Mtl

The Lightscape material lets you set radiosity behavior for 3ds Max materials
you want to use in existing Lightscape radiosity meshes.

NOTE This material is for use with Lightscape. It is not meant for use with the
advanced lighting solution in 3ds Max. For adjusting a material's radiosity properties
in 3ds Max, use the Advanced Lighting Override material on page 5734.

IMPORTANT The mental ray renderer on page 6230 does not support the Lightscape
material.

Interface

Radiosity Mapping group

Brightness Controls the brightness of the displayed image on your monitor.
The setting of this control does not affect the actual lighting levels in the
model. Note: The default value is exactly the same as the values set in the
Import Lightscape Solution dialog.
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Contrast Controls the contrast between light and dark regions in the model.
Note: The default value is exactly the same as the values set in the Import
Lightscape Solution dialog.

Ambient Light Controls the amount of 3ds Max ambient light that will be
mixed in with the radiosity calculations. If the value is 0, none of the 3ds Max
ambient light is used. If the value is 1, the 3ds Max ambient light value is
added into the radiosity calculations. Default=0.0.

Bump Amount This value controls the strength of the bump map that is
applied to the lighting from Lightscape, as opposed to lighting done by 3ds
Max. It can be separately controlled from the bump amount in the 3ds Max
material, so you can adjust the bumps in Lightscape lighting to match the
bumps in 3ds Max lighting. Default=5.0.

Daylight Determines whether you want natural daylight to be used in the
calculation. Note: The default value is exactly the same as the values set in
the Import Lightscape Solution dialog.

Exterior Scene Used for exterior daylight simulations. Note: The default value
is exactly the same as the values set in the Import Lightscape Solution dialog.

Apply Changes to All Lightscape Materials Determines whether or not the
changes you make in this dialog are applied to every Lightscape Radiosity
material. Default=off.

Disable Radiosity Determines whether or not the radiosity is calculated. This
option provides a quick way to see the effect of the Lightscape-specific
illumination. Default-off.

Base Material Displays the base 3ds Max material to which the radiosity
illumination is applied. (The base material displays on the object while the
Lightscape Radiosity material adds radiosity effects.) Use this button to change
the base material on the object.

Ink 'n Paint Material

Material Editor > Type button > Material/Map Browser > Ink 'n Paint

The Ink 'n Paint material creates cartoon effects. Rather than the
three-dimensional, realistic effect most other materials provide, Ink 'n Paint
provides flat shading with “inked” borders.
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Snake rendered with ink 'n paint

Because Ink 'n Paint is a material, you can create a scene that combines
3D-shaded objects with flat-shaded cartoon objects.
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Rendering that combines realistic shading with cartoon shading

In the Ink 'n Paint material, ink and paint are two separate components, with
customizable settings.
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Left: The paint component only

Right: The ink component only

TIP Ink 'n Paint uses the raytracer settings on page 6221, so adjusting raytrace
acceleration can have an effect on the speed of Ink 'n Paint. Also, while you work
with Ink 'n Paint, disabling antialiasing can speed up the material, until you're
ready to create final renderings. (Turning off Ink really speeds it up.)

NOTE Motion blur does not work with Ink 'n Paint. (Typically, hand-drawn cartoons
are not motion blurred.)

NOTE Shadows don't appear on objects shaded with Ink 'n Paint unless the value
of Paint Levels is 4 or greater.

WARNING Ink 'n paint will only give correct results when rendered from a camera
or perspective view. It does not work in orthographic views.
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Using Ink 'n Paint

You can use Ink 'n Paint on multiple objects, but in general, it tends to work
best if you do the following:

1 Collect the objects for cartoon rendering into a single surface model such
as an Editable Mesh.

2 Assign different material ID values on page 8038 to portions of the model
you want to color differently.

Typically, you would do this at the Element sub-object level, although
you can certainly apply different material IDs to faces and polygons as
well.

3 Create a Multi/Sub-Object material on page 5720. In it, create a sub-material
for each of the colors in the model. Make each sub-material an Ink 'n
Paint material, then assign colors and maps using each sub-material's
Paint controls.

If necessary, adjust the Ink controls as well.

TIP ActiveShade on page 6102 works with the Ink 'n Paint material, and can be a
good way to preview the material's effect.

Troubleshooting

Here are some commonly encountered problems, and potential solutions:

■ Internal ink lines are missing.
The Overlap bias is probably too high. Decrease it. If Underlap is turned
on, this might also have too high a bias.

Another possible reason is that you have a self-intersecting object, or an
object built by attaching smaller objects, thus creating intersecting faces.
In this case, set up the objects to use the Mat ID or SmGroup ink
components. If elements already have differing material IDs, try turning
off Only Adjacent Faces.

■ Ink looks sloppy on sloping parts of the object.
The Overlap or Underlap bias might be too low. Try increasing it.

■ Ink looks sloppy between interpenetrating objects.
Find out which ink component is the sloppy one. Then adjust its bias
control.

■ Ink lines disappear or are too narrow when Variable Width is on.
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Turn on Clamp. You can also try to see if reducing the lighting level helps.
Or, you can try turning off Variable Width, then assigning a Falloff map
on page 5877 to the Ink Width component.

TIP To isolate which ink component is causing a problem, you can try assigning
each component a different, distinctive (and easy to read) color, then rendering
the image.

WARNING Ink 'n paint will only give correct results when rendered from a camera
or perspective view. It does not work in orthographic views.

Interface

Basic Material Extensions rollout

2-Sided Makes the material 2-sided on page 7893. Applies the material to both
sides of selected faces.

Face Map Applies the material to the faces of the geometry. If the material is
a mapped material, it requires no mapping coordinates on page 8034. The map
is automatically applied to each facet of the object.

Faceted Renders each face of a surface as if it were flat.

Fog BG when not painting When paint is turned off, the painted areas of
the material color are the same as the background. This toggle, when on, lets
the background in paint areas be affected by fog between the camera and the
object. Default=off.

Opaque alpha When on, the alpha channel is opaque even if ink or paint is
turned off. Default=off.
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Bump Adds bump mapping to the material.

■ Toggle When on, enables the bump map.

■ Spinner Controls the bump map amount.

■ Map button Click to assign a map to use for bump mapping.

Displacement Adds displacement mapping to the material.

■ Toggle When on, enables the displacement map.

■ Spinner Controls the displacement map amount.

■ Map button Click to assign a map to use for displacement mapping.

Paint Controls rollout

Paint is the main color of the material.

There are three main components of the “paint” of Ink 'n Paint. Each has
several associated controls, most of which are documented toward the end of
this section.

Lighted The fill color for the lighted side of objects. Default=light blue.

Turning off this component makes the object invisible, except for the ink.
Default=on.
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Left: A lighted character

Right: Lighted and Highlight both turned off to render only the ink

■ Paint Levels The number of shades of color that are rendered, from light
to dark. Lower values make objects look flatter. Range=1 to 255. Default=2.

Increasing the value of Levels increases the number of shades of the basic color
seen in the lighted area.

Shaded The value in the spinner at the left is the percent of the Lighted color
that appears on the unlighted side of objects. Default=70.0.

Turning off this component displays a color swatch, which you can use to
assign a distinct color to shaded areas. Default=on.
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Increasing the value of Shaded increases the saturation of the shaded area. You can
also use Shaded to assign a distinct color for shading.

Highlight The color of the specular highlight. Default=white.

When this component is off, there is no specular highlight. Default=off.

TIP A specular highlight can destroy the illusion of 2D. Use this component
sparingly.

Left: No highlights
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Right: Highlight on

■ Glossiness The size of the specular highlight. The greater the Glossiness,
the smaller the highlight. Default=50.0.

Increasing glossiness decreases the size of the highlight.

Color component controls:

These are the controls that are duplicated for each of the paint components.
Each has an on/off toggle, a main control, and then on the right, a set of map
controls.

■ Check box The check box at the left of the rollout enables or disables
that particular component. In the case of Shaded, it toggles between a
percentage value (of the Lighted color) or a distinct Shaded color.

■ Color swatch or spinner The main control for each component. Click a
color swatch to display a Color Selector on page 391 and set the color of
the component. In the case of Shaded, this control can also be a percentage
spinner.

■ Map spinner The spinner to the right of the main control is the
percentage of the map to use. Default=100.0.
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Mapping the Lighted component

Right rear: The original, unmapped material

Left: Lighted component with a falloff map applied

Right front: Lighted component with a bitmap applied

■ Map check box The check box between the spinner and the button
enables or disables the map. Default=off until a map is assigned, then on.

■ Map button Click the button to assign a map to this component.
While a map is assigned and enabled, at 100 percent it completely overrides
the main color component. At lower percentages, the map is blended with
the color.

Ink Controls rollout

Ink is the linework, the outlines, in the material.
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Except for Ink Width, each of the ink components has an on/off toggle and
a color swatch. Click the color swatch to display a Color Selector on page 391
and change the ink component's color. Each ink component, Ink Width
included, also has a set of map controls.

Ink When on, the rendering is “inked.” When off, no ink lines appear.
Default=on.
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Left: Rendering with ink

Right: Ink turned off

Ink Quality Affects the shape of the brush and the number of samples it uses.
When Quality equals 1, the brush is a “+” shape, and samples are taken over
an area of 5 pixels. When Quality equals 2, the brush is octagonal and the
samples are taken over an area of 9 to 15 pixels. When Quality equals 3, the
brush is nearly circular, and samples are taken over an area of 30 pixels.
Range=1 to 3. Default=1.

TIP For most models, increasing the Quality value introduces only a very subtle
change, and can take considerably longer to render. Do so only when a sub-object's
ink shows too many artifacts in the finished rendering, using the default Ink Quality.
(Don't rely on the ActiveShade preview, which will tend to be aliased.)

Ink Width The width of the ink, in pixels. This is specified by the spinner
labeled Min (minimum) unless Variable Width is on. When Variable Width
is on, the Max (maximum) spinner is also enabled, and the ink width can vary
between the minimum and maximum values. Default: Min=2.0, Max=4.0.
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Left: One-pixel ink width

Middle: Five-pixel ink width

Right: Ink width varies from one to five pixels.

Variable Width When on, the ink's width can vary between the minimum
and maximum Ink Width values. Ink with Variable Width looks a bit more
streamlined than ink with a constant width. Default=off.

The thickness of ink can be mapped.

Left: Thickness mapped with a gradient map

Right: Thickness mapped with a noise map

Clamp When Variable Width is on, sometimes the scene lighting causes some
ink lines to become so thin they nearly disappear. If this happens, turn on
Clamp, which forces the ink width to always remain between the Min and
Max values, regardless of the lighting. Default=off.

Outline The ink where the outer edges of the object appear against the
background or in front of a different object. Default=on.
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Left: Rendering the outline only

Right: Rendering only the overlap and underlap

■ Intersection Bias Use this to adjust artifacts that might appear when two
objects intersect each other. In effect, this moves the inked object closer
to the rendering point of view, or farther away, so Ink 'n Paint can decide
which object is in front. Positive values push the object away from the
point of view, negative values pull it closer. Default=0.0.

Overlap The ink used when a portion of an object overlaps itself. Default=on.

■ Overlap Bias Use this to adjust artifacts that might appear in ink that
traces the overlap. It says how far the overlap has to be in front of the rear
surface for Overlap ink to turn on. Positive values push the object away
from the point of view, negative values pull it closer. Default=10.0.

Underlap Similar to Overlap, but applies ink to the farther surface rather than
the nearer one. Default=off.

■ Underlap Bias Use this to adjust artifacts that might appear in ink that
traces the underlap. It says how far the underlap has to be behind the front
surface for Underlap ink to turn on. Positive values push the object away
from the point of view, negative values pull it closer. Default=0.0.

SmGroup The ink drawn between the boundaries of smoothing groups on
page 8130. In other words, it inks the edges of the object that have not been
smoothed. Default=on.
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Mat ID The ink drawn between different material ID values on page 8038.
Default=on.

TIP If two Ink 'n Paint materials overlap in the viewport, and both have Mat ID
on, you will often get a doubly thick ink line where they overlap. To correct this,
turn off the Mat ID component for one of these materials.

Inking the edges between sub-materials

■ Only Adjacent Faces When on, inks the material ID edge between adjacent
faces, but not between one object and another. When off, inks the material
ID edge between two objects or other non-adjacent faces. Default=on.

■ Intersection Bias When Only Adjacent Faces is turned off, use this to
adjust any artifacts that appear at the boundary between two objects with
different material IDs. Default=0.0.

Map controls There are map controls for each of the ink components: Width,
Outline, Overlap, Underlap, SmGroup, and Mat ID. These work the same as
they do for the material's paint components, as described above.
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Mapping the outline and overlap components to simulate the look of drawing on paper

DirectX 9 Shader Material

Material Editor > Type button > Material/Map Browser > DirectX 9 Shader

Note: Typically, this material is visible in the Browser only if DirectX 9 is
available on your system, and you are using the Direct3D display driver with
DirectX 9.0 chosen as the Direct3D version. If this material is not visible, you
can see it (in gray) by turning on Incompatible in the Show group.

The DirectX 9 Shader material enables you to shade objects in viewports using
DirectX 9 (DX9) shaders. With DirectX shading, materials in a viewport more
accurately represent how the material will appear in another application, or
on other hardware such as a game engine. You can use this material only
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when you are using the Direct3D Display driver on page 7802 and DirectX 9.0
is chosen as the Direct3D version.

DX9 shaders are FX files. Several sample FX files are provided in the \fx folder
in the 3ds Max program directory.

See also:

■ DirectX Shader group on page 5339

■ FX File on page 7990

Interface

DirectX 9 Shader rollout

Shader button Click to display a file dialog that lets you select a DX9 FX effect
(FX) file. By default, the default.fx file is chosen.

Reload Click to reload the active FX file. To update an FX file, you can edit
it and then click Reload. You don't have to restart 3ds Max to see the effect
of the changes to the shader.

Shader-specific rollouts

The rollouts that appear below the DirectX 9 Shader rollout and above the
Software Rendering rollout are the interface to the shader you chose. These
rollouts are specific to each shader.

Software Rendering rollout

Specifies a material that controls software shading and rendering of objects
to which the DirectX 9 Shader material is applied. Viewports use DX9 shading
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unless the Software or OpenGL driver is active. Renderings always use software
shading.

Usually you will want to choose a material that clearly identifies which objects
in your scene have the DirectX 9 Shader material applied.

NOTE The DirectX 9 Shader material has no specific settings for software shading.
Any type of 3ds Max material will do. Scenes from previous versions that used
DX9-specific settings are assigned a Standard material with equivalent rendering
properties.

NOTE If DirectX 9 is not available on your system, but you assign the DirectX 9
Shader material anyway (by using the Material/Map Browser's Incompatible option),
this is the only rollout that appears in the Material Editor.

DirectX Viewport Shaders

LightMap Shader Rollout

Material Editor > Viewport Manager rollout > Choose LightMap from the
drop-down list. > LightMap Shader rollout appears.

When you have chosen LightMap as the DirectX viewport shader on page 5393,
this rollout appears. The LightMap shader can display both a base texture and
a lighting map. Typically both these maps come from rendering to textures
(texture baking) on page 6371 The base texture typically would be a completed
map, a blend map, or a diffuse map. You can choose these map types, as well
as lighting map, to render as elements of a baked texture on page 6376.

NOTE In order to use the LightMap shader, you must have 3ds Max configured
to use the Direct3D graphics driver. To change the graphics driver configuration,
refer to the Viewport Preferences on page 7753 topic.
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Interface

Base Texture group

Button Shows the name of the base texture. Click the button to display that
material's parameters, and adjust them if necessary.

Toggle When on, shaded viewports display the base texture. When off, it is
not displayed.

If both the Base Texture and Light Map toggles are off, the material appears
black in viewports.

Mapping Channel Shows the map channel on page 8032 this texture uses.

Light Map group

Button Shows the name of the lighting map.

Toggle When on, shaded viewports display the lighting map. When off, it is
not displayed.

If both the Base Texture and Light Map toggles are off, the material appears
black in viewports.

Mapping Channel Shows the map channel this texture uses.

Metal Bump Shader Rollout

Material Editor > Viewport Manager rollout > Choose LightMap from the
drop-down list. > Metal Bump Shader rollout appears.
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When you have chosen Metal Bump as the DirectX viewport shader on page
5393, this rollout appears. The Metal Bump shader can display a variety of
texture-baked maps on page 6371, including normal maps for an embossed
effect. It is good for displaying shiny surfaces.

NOTE In order to use the Metal Bump shader, you must have 3ds Max configured
to use the Direct3D graphics driver. To change the graphics driver configuration,
refer to the Viewport Preferences on page 7753 topic.

The Metal Bump shader's results are alway visible in viewports, regardless of
the object type.

WARNING The Metal Bump shader lets you adjust settings to get various effects
in shaded viewports. These settings will not necessarily apply when you display
the texture-baked object on other Direct3D devices.

See also:

■ Baked Texture Elements on page 6376
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Interface
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Ambient & Diffuse group

Ambient Color When not black, tints the object's ambient color. Click the
color swatch to display a Color Selector on page 391 and choose the ambient
color. Default=black.

Diffuse Color When not white, tints the diffuse color. Click the color swatch
to display a Color Selector and choose the diffuse color. Default=white.

Texture 1 Displays a texture map for the diffuse color. Typically this would
be a texture-baked diffuse map, completed map, or blend map.

See the section “Map Controls,” below, for a description of the individual
controls.

Texture 2 Displays a second texture map for the diffuse color. Typically this
would be a texture-baked lighting map or shadows map.

See the section “Map Controls,” below, for a description of the individual
controls.

Use Alpha When on, displays the alpha channel. When off, does not.
Default=off.

Mix Amount Adjusts the mixing of the two texture maps in shaded viewports.

Specular group

Enable When on, enables specular highlights for the object. Default=off.

Specular Color Specifies a specular color for the object. Click the color swatch
to display a Color Selector and choose a color. Default=white.

Texture Displays a specular map for the object. Typically this would be a
texture-baked specular map.

See the section “Map Controls,” below, for a description of the individual
controls.

Bump group

Normal Displays a normal map for the object. Typically this would be a
texture-baked normals map.

See the section “Map Controls,” below, for a description of the individual
controls.

Bump Displays a bump map for the object. Typically this would be a bump
map used for the original material.
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See the section “Map Controls,” below, for a description of the individual
controls.

Bump Intensity Adjusts the intensity of the bumps in shaded viewports.

Reflection group

Cubemap Displays a reflection map projected cubically (around the scene).
Typically this would be an environment map.

Reflection Intensity Adjusts the intensity of reflections in shaded viewports.

Pick object and create Click to choose an object and have the program
generate the reflections used in the viewport.

Sync Standard Material

When on, adjustments you make to the Metal Bump shader update settings
in the active standard material, letting you save the changes you made. When
off, the standard material is unchanged. Default=off.

Map Controls

In this rollout, all texture maps have the same general controls. The rollout
appears only when you are using the DirectX viewport shader.

Toggle When on, the map is used in viewports. When off, it is not used.
Default=on if a map is assigned, off otherwise.

Map button Click to choose the texture map to use for this component of
the object.

Map Channel Specifies the map channel on page 8032 used by this map.

This control is not present for the cubic reflection map.

XRef Material

Material Editor > Type button > Material/Map Browser > XRef Material

The XRef material lets you externally reference a material applied to an object
in another scene file. As with XRef objects on page 6936, the material resides in
a separate source file. You can set the material properties only in the source
file. When you change them in the source file and then save it, the material's
appearance can change in the master file that contains the XRef.
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NOTE If an XRef object has a material applied to it in the original source file (and
Merge Materials is turned off when you reference the source file), then that material
is automatically externally referenced in the scene, and can be loaded in the
Material Editor if you browse from the scene. When you explicitly use the Material
Editor to create an XRef material, you don't have to have any XRef objects from
that particular source file. However, the record's source file and material do appear
in the XRef Objects dialog on page 6941.

The Show Map In Viewport button works for an XRef material only if the
same button is turned on in the source file. Otherwise, it is disabled.

Interface

 Highlight Corresponding XRef Record in the XRef Objects
Dialog Click to open the XRef Objects dialog on page 6941 that highlights the
source file's current record with its object displayed in the XRef Entities list.
If no file and object have yet been selected for the material, the XRef Objects
dialog is displayed, and lets you browse for the file and material to use.

File name field Displays the path and file name of the scene file containing
the source of the XRef material. You can edit this to point to a different path
and file.
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File name display Displays the file name only, without the path.

 Path button Click to display the Open File dialog from which you can
specify a different path and file name for the source file. After you choose the
file, 3ds Max displays the XRef Merge dialog on page 6956 that lets you choose
the object whose material you want to reference.

Object name field Displays the name of the source object pointed to in the
source file.

Object name and material Displays the name of the source object followed
by the material name in parentheses. For example, “Shaker ( Chrome ).”

 Path button Click to display the XRef Merge dialog on page 6956 pointing
to the scene in the XRef File Name field. Here, you can specifiy a different
object whose material you want to reference.

Status line Displays the status of the material. For example, if the file and
object are both found, this field says “Status: XRef Resolved.”

Types of Maps
The most common use for maps on page 8036 is to improve the appearance and
realism of Materials on page 8041. You can also use maps to create environments
on page 6689 or projections from lights (see Advanced Effects Rollout on page
5108 ).

Maps can simulate textures, applied designs, reflections, refractions, and other
effects. Used with materials, maps add details without adding complexity to
the geometry of an object. (Displacement mapping on page 5487 can add
complexity.)

Accessing Map Types

You use the Material/Map Browser on page 5290 to load a map or create a map
of a particular type. The Browser groups maps into categories according to
their type. You can choose whether the Browser lists maps, materials, or both;
you can choose which map types.
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To list map types by category:

1  Open the Material Editor.

2  Click Get Material to display the Material/Map Browser.

3 On the left side of the Material/Map Browser, in the Show group, turn
off Materials. Leave Maps turned on.

4 In the lower set of buttons, choose the category you want listed, or choose
All to show all map types.

The list is displayed in the right panel of the Browser.

To open the Browser from the Material Editor:

As you work with materials, you can open the Material/Map Browser from the
Material Editor.

1  Open the Material Editor.

2  On the Material Editor toolbar, click Get Material to display the
Material/Map Browser.

Understanding Map Types

Different types of maps create different effects and behave in particular ways.

■ 2D maps on page 5782 are two-dimensional images that are typically mapped
onto the surface of geometric objects, or used as environment maps to
create a background for the scene. The simplest 2D maps are bitmaps; other
kinds of 2D maps are generated procedurally.

■ 3D maps on page 5860 are patterns generated procedurally in three
dimensions. For example, Marble has a grain that goes through the assigned
geometry. If you cut away part of an object with Marble assigned as its
texture, the interior matches the exterior.

■ Compositors on page 5918 are for compositing other colors or maps.

■ Color Modifiers on page 5933 alter the colors of pixels in a material.
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■ The "Other" category includes maps that create reflections and refractions
on page 5946. It also includes mental ray shaders on page 5974, Normal Bump
maps on page 6033, and Camera Per-Pixel Projection maps on page 6035.

Maps and mental ray Shaders

When the mental ray renderer on page 6230 is active, the Material/Map Browser
also lists mental ray shaders. Shaders are similar to maps, but use yellow icons.
You assign them the way you do maps. The mental ray shaders don't fit into
the map categories described in the previous section, and aren't described in
this topic. See mental ray Shaders on page 5974 for links to shader descriptions.

mental ray maps in the browser's list are shown with yellow icons.

TIP When the default scanline renderer is active, you can view mental ray shaders
in the Browser list, and assign them, by turning on Incompatible in the Show
group. Incompatible shaders in the list are displayed in gray.

Maps and Mapping Coordinates

Maps have a spatial orientation. When you apply a material with maps in it
to an object, the object must have mapping coordinates. These are specified
in terms of UVW axes local to the object.

Most objects have a Generate Mapping Coordinates toggle. You can turn this
on to provide default mapping coordinates. If the object has this toggle, it is
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also turned on automatically when you render the scene, or use Show Map
In Viewport on page 5350.

Some objects, such as editable meshes, don't have automatic mapping
coordinates. For these types of objects, you can assign coordinates by applying
a UVW Map modifier on page 1931. If you assign a map that uses a mapping
channel, but don't apply a UVW Map modifier to the object, the renderer
displays a warning that lists objects that require mapping coordinates. You
can also use UVW Map to change an object's default mapping.

See Mapping Coordinates on page 5279.

UVW Mapping Coordinate Channels

Each object can have from 1 to 99 UVWmapping coordinate channels. The
default mapping (from the Generate Mapping Coordinates toggle) is always
UVW 1. The UVW Map modifier can send coordinates to any of these channels.

Each map in a material can use any UVW channel (if present), or other type
of mapping that depends on whether the map is 2D or 3D.

You can set the mapping channel used by NURBS surface on page 2275
sub-objects in their creation or modification parameters.

Mapping for 2D Maps

You can position a 2D map on the surface of an object by using a map channel,
any assigned vertex color, or the local or world coordinate systems. You can
also choose different environment mappings. See Coordinates Rollout (2D)
on page 5782.

Mapping for 3D Maps

You can position a 3D map within the volume of an object by using a map
channel, any assigned vertex color, or the local or world coordinate systems.
See Coordinates Rollout (3D) on page 5861.

Noise for Maps

Random noise values increase the complexity of maps and can give them a
more natural look. For 2D maps, see Noise Rollout (2D) on page 5793. For 3D
maps, you can assign a separate Noise map. See Noise Map on page 5886.
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Real-World Mapping

Real-world mapping is an alternative mapping paradigm in 3ds Max that is
off by default. The idea behind real-world mapping is to simplify the correct
scaling of texture-mapped materials applied to geometry in the scene. This
feature lets you create a material and specify the actual width and height of
a 2D texture map in the Material Editor. When you assign that material to an
object in the scene, the texture map appears in the scene with correct scaling.

For real-world mapping to work, two requirements must be met. First, the
correct style of UV texture coordinates must be assigned to the geometry.
Essentially, the size of the UV space needs to correspond to the size of the
geometry. To this end, a new option called Real-World Map Size has been
added to many of the dialogs and rollouts that let you generate texture
coordinates (see list at the end of this topic). Any dialog or rollout that lets
you turn on Generate Mapping Coords also lets you enable Real-World Map
Size. Also, you can toggle this option globally on the Preferences dialog >
General panel on page 7744.

Most object parameters settings now include a Real-World Map Size toggle.

The second requirement is available in the Material Editor. All 2D texture
maps, such as Bitmap, provide a Use Real-World Scale check box on the
Coordinates rollout on page 5782. Like Real-World Map Size, this check box is
off by default, but when on, the U/V parameter names change to Width/Height
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and the Tiling label changes to Size. You can then specify the
horizontal/vertical offsets and size of the texture map in current system units
on page 7812.

2D map coordinates settings now include a Use Real-World Scale toggle.

Following is a list of affected features (note links to topics with more extensive
information):

■ Bevel Modifier

■ Bevel Profile Modifier

■ Box Primitive

■ Capsule Extended Primitive

■ C-Ext Extended Primitive

■ ChamferBox Extended Primitive Create panel > Geometry button

■ ChamferCyl Extended Primitive

■ Cone Primitive

■ CV Curve

■ Cylinder Primitive Create panel

■ Doors
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■ Editable Spline

■ Extrude Modifier

■ Gengon Extended Primitive

■ GeoSphere Primitive

■ Importing AutoCAD Drawing

■ Importing DXF Files

■ Lathe Modifier

■ L-Ext Extended Primitive

■ L-Type Stair

■ Loft > Surface Parameters Rollout

■ Material Editor Coordinates Rollout

■ Material Editor Options  on page 5335

■ OilTank Extended Primitive

■ Plane Primitive

■ Point Curve

■ Pyramid Primitive

■ Railing

■ Renderable Spline Modifier

■ Sphere Primitive

■ Spindle Extended Primitive

■ Spline Rendering File Link Settings

■ Splines and Extended Splines

■ Stairs

■ Sweep Modifier

■ Teapot Primitive

■ Torus Primitive

■ Tube Primitive
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■ UVW Map Modifier on page 1931

■ Wall

■ Windows

Output Rollout

Material Editor > Select sample slot. > Get Material > Material/Map Browser >
Turn on 2D Maps and 3D Maps. > Choose a map type (Bitmap, Cellular, Falloff,
Gradient, Gradient Ramp, Mix, Noise, or Output). > Double-click a map type
to apply it to sample slot. > Output rollout (displayed near the bottom of the
Material Editor)

After applying a map and setting its internal parameters, you can adjust its
output parameters to determine the final appearance of the map.

NOTE Most controls on the Output rollout are for color output, and don't affect
bump mapping on page 5478. Only the Invert toggle is considered; it reverses the
direction of the bumps.
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Interface

These controls appear on the Output rollout for a number of 2D and 3D maps:

Invert Reverses the hues of the map, like a negative color photo. Default=off.
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Clamp When on, this parameter limits the values of the colors to no greater
than 1.0. Turn this on when you're increasing the RGB Level, but don't want
the map to appear self-illuminated. Default=off.

NOTE If you set the RGB Offset to a value greater than 1.0 while Clamp is on, all
colors become white.

Alpha from RGB Intensity When on, an alpha channel is generated based
on the intensity of the RGB channels in the map. Black becomes transparent
and white becomes opaque. Intermediate values are translucent according to
their intensity. Default=off.

Enable Color Map Turn on to use the Color Map. See “Color Map group.”
Default=off.

Output Amount Controls the amount of the map being mixed into a
composite material. Affects the saturation and alpha value of the map.
Default=1.0.

RGB Offset Adds to the RGB values of the map colors by the amount set by
the spinner, which affects the tonal value of the colors. Eventually the map
becomes white and self-illuminated. Lowering the value decreases the tonal
value toward black. Default=0.0.

RGB Level Multiplies the RGB values of the map colors by the amount set by
the spinner, which affects the saturation of the color. Eventually the map
becomes fully saturated and self-illuminated on page 8122. Lowering the value
decreases the saturation and makes the map colors grayer. Default=1.0.

Bump Amount Adjusts the amount of bumpiness. This value has an effect
only when the map is used as a bump map. Default=1.0.

For example, suppose you have a map instanced for both the Diffuse and the
Bump components. If you want to adjust the amount of bumpiness without
affecting the Diffuse colors, adjust this value, which changes the amount of
bumpiness without affecting the map's use in other material components.

Color Map group

At the bottom of the Output rollout, the Color Map group is inactive until
you turn on Enable Color Map.
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The Color Map graph lets you adjust the tonal range of an image. The point
at 1,1 controls highlights, the point at 0.5,0.5 controls midtones, and the
point at 0,0 controls shadows.

You adjust the shape of the graph by adding points to the line and moving
or scaling them. You can add Corner, Bezier-Smooth, or Bezier-Corner points.
When a move or scale option is active, points can be selected much like objects
in a viewport, by clicking a point, dragging a region around one or more
points, and holding down Ctrl to add or subtract from the selection.

When you select an individual point, its exact coordinates are displayed in
the two fields below the graph at the lower left. You can enter values directly
in these fields, but the values are automatically constrained as they are when
you manually move or scale a point.

You can zoom into the graph to make detailed adjustments. As you zoom in,
the graph updates to show decimal measurements along the left vertical axis.
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You can pan anywhere on the graph with the horizontal and vertical scroll
bars, use a button option, or the middle mouse button. Points can be deleted,
and you can reset the graph to its default at any time.

RGB/Mono Specifies a map curve to either filter the RGB channels separately
(RGB) or in combination (Mono).

Copy CurvePoints When turned on, points added to a Mono graph are copied
when you switch to an RGB graph. If you start with an RGB graph, the points
are copied to a Mono graph. You can animate the control points but not the
Bezier handles.

IMPORTANT When Copy CurvePoints is on, animation created in Mono mode
is carried over to RGB mode and you can switch channels. The reverse doesn’t
work.

The following controls affect the points on the graph:

Move flyout

 Moves a selected point in any direction, limited by the unselected points
on either side.

 Constrains movement to the horizontal.

 Constrains movement to the vertical.

On a Bezier smooth point, you can move the point or either handle.

 Scale Point Changes the output amount of control points while
maintaining their relative position. On a Bezier corner point, this control is
effectively the same as a vertical move. On a Bezier smooth point, you can
scale the point itself or either handle. As with the move controls, scale is
limited by the unselected points on either side.

Add Point flyout

 Adds a Bezier corner point anywhere on the graph line. The point makes
a sharp angle when moved.
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 Adds a Bezier smooth point anywhere on the graph line. Handles attached
to the point create smooth curves when moved.

When either Add Point button is active, you can use Ctrl+click to create the
other type of point. This eliminates the need to switch between buttons.

 Delete Point Removes selected points.

 Reset Curves Returns graph to its default, a straight line between 0,0
and 1,1.

The following controls affect the view of the graph. The change in view does
not affect the graph’s results.

 Pan Drags the graph in any direction within the viewing window.

Zoom Extents Shows the entire graph.

Zoom Horizontal Extents Shows the entire horizontal range of the
graph. The scale of the curve will be distorted.

 Zoom Vertical Extents Shows the entire vertical range of the graph.
The scale of the curve will be distorted.

Zoom Horizontally Compresses or expands the graph in a horizontal
direction.

Zoom Vertically Compresses or expands the view of the graph in a
vertical direction.

Zoom Zooms in or out around the cursor.

Zoom Region Draws a rectangular region around any area of the graph,
then zooms to that view.
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Missing Map Coordinates Dialog

Material Editor > Assign a mapped material to an object that has no UVW
Map modifier. > Map level > Coordinates rollout > Change Map Channel to
a value other than 1. > Render

Menu bar > File menu > Open > One or more maps in MAX file can’t be found.

The Missing Map Coordinates dialog is displayed when you attempt to render
one or more objects with materials whose maps use a map channel on page
8032 other than channel 1. (Channel 1 is an exception because channel 1
mapping coordinates are automatically turned on when you assign a mapped
material to an object.) Only maps with Show Map In Viewport toggled on are
listed as missing.

To use other map channels, you must assign a UVW Map modifier on page
1931 to the object. In UVW Map, set Map Channel to match the value used in
the material.

If the material has multiple maps that use multiple channels, you must assign
a separate UVW Map modifier for each channel besides channel 1.

If the object is a NURBS surface sub-object on page 2423, you don't need to use
UVW Map. Instead, set the map channel on the surface sub-object's Material
Properties rollout on page 2364.

The Missing Map Coordinates dialog is also displayed when you open a MAX
file that references bitmaps that can’t be found in their original location, or
are at a location not specified via the Configure User Paths dialog on page 7729.
To open the MAX file, click the Browse button on the Missing Map Coordinates
dialog. This opens the Configure User Paths dialog so you can assign one or
more paths for the MAX file to access. These settings are then stored with the
MAX file.

NOTE When you open a MAX file that references bitmaps that can’t be found,
you might also see a Missing Map/Photometric Files dialog on page 7130, which
lets you browse for the missing files.
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Interface

The list shows the map channel followed by the name of the object.

Continue Proceeds with the rendering. The objects listed will not show maps
in the material assigned to them, and might not be visible at all.

Cancel Cancels rendering.
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2D Maps

2D Maps are two-dimensional images that are typically mapped onto the
surface of geometric objects, or used as environment maps to create a
background for the scene. The simplest 2D maps are bitmaps; other kinds of
2D maps are generated procedurally.

Bitmap on page 5795: An image saved as an array of pixels in one of a number
of still-image file formats, such as .tga, .bmp, and so on, or an animation file
such as .avi, .mov, or .ifl. (An animation is essentially a sequence of still images.)
You can use any bitmap (or animation) file type that 3ds Max supports as a
bitmap in a material.

Checker on page 5808: Combines two colors in a checker pattern. You can replace
either color with a map.

Combustion on page 5811: Works in conjunction with the Autodesk Combustion
product. You can paint directly on a bitmap or object and have the result
update in the Material Editor and viewports. The map can include other
Combustion effects. Painting and other effects can be animated.

Gradient on page 5835: Creates a linear or radial ramp of three colors.

Gradient Ramp on page 5840: Creates a great variety of ramps, using as many
colors, maps, and blends as you choose.

Swirl on page 5848: Creates swirled (spiraling) patterns of two colors or maps.

Tiles on page 5851: Creates bricks or other tiled materials with colors or material
mappings. Includes commonly defined architectural brick patterns, but you
can also customize patterns.

Coordinates Rollout (2D)

Material Editor > Select sample slot. > Get Material > Material/Map Browser >
Turn on 2D Maps. > Double-click a map type to apply it to sample slot. >
Coordinates rollout is displayed on the Material Editor.

In the Coordinates rollout, by adjusting coordinate parameters, you can move
a map relative to the surface of the object to which it is applied and achieve
other effects.
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Tiling

Often when you apply a bitmap, especially as a texture pattern, you want the
pattern to repeat. This effect is known as tiling, as in a tiled floor or fountain.
You control tiling directly from the Coordinates rollout for any 2D map.

Tiling a map

In default mapping, tiling is active, but because the map is scaled to fit the
object, you don't see the effect of tiling unless you offset the UV coordinates
or rotate the map. In this case, the portions of the surface from which the
bitmap has moved away are filled by other portions of the map. Tiling wraps
the object with the map image.

Mirroring

Mirroring a map is an effect related to tiling. It repeats the map and flips the
repeated copy.

As with tiling, you can mirror in the U dimension, the V dimension, or both.
The Tiling parameter for each dimension specifies how many copies of the
map are shown. Each copy is flipped relative to its neighbors.
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Mirroring a map

Tiling and Mirroring Combined

Because mirroring defaults to two reflected images of the map, the meaning
of the Tiling value differs when Mirror is set.

In a single mapping dimension (U or V), a value of 1.0, the default, shows
two copies of the bitmap; a value of 2.0 shows four copies; a value of 1.5 shows
three copies; and so on. Mirroring in both dimensions multiplies the effect.
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Mirroring and tiling a map

Decals

Decals are useful for mapping single designs, small elements such as stickers,
or light switches.

A 2D map used as a decal appears only once and is not repeated as with tiling.
Wherever the decal doesn't appear on the surface, the surface is rendered as
a basic material, with the component colors specified at the material level.
With map trees, a decal might appear on top of a different bitmap or other
map type.
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Decal mapping

Procedures

To set tiling:

1 In the Coordinates rollout, make sure Use Real-World Scale is turned off
and Tile is turned on for the U or V coordinate, or for both.

2 In the Coordinates rollout, make sure Tile is turned on for the U or V
coordinate, or for both.

3 Set the Tiling value for the corresponding coordinates.

In the Material Editor, the sample slot changes to show the tiling value
you chose.

■ The Tiling value is the number of times the bitmap repeats along the
specified dimension. A value of 1.0, the default, maps the bitmap
exactly once; a value of 2.0 maps the bitmap twice, and so on.
Fractional values map a fractional portion of the bitmap in addition
to copies of the whole map. For example, a value of 2.5 maps the
bitmap two and a half times.

■ Tiling values less than one increase the size of the map relative to the
object. For example, a value of 0.5 maps half of the bitmap.

■ Tiling is uniform if both the U and V dimensions are tiled by the same
amount.
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To preview the effect of tiling:

■  In the Material Editor, use the Tiling flyout to choose a 1x, 2x, 3x,
or 4x tiling preview.
The button you choose changes tiling in the active sample slot to 1.0, 2.0,
3.0, or 4.0 in both U and V.

The flyout setting has no effect on the material or its mapping. It does not
change the Tiling value or the check box setting. It only helps you preview
the effect of changing these settings.

To set mirroring:

1 On the Coordinates rollout, make sure Mirror is turned on for the U or
V coordinate, or both.

Mirror and Tile are exclusive settings: if one is set when you choose the
other, the original setting turns off.

2 Set the Mirror value for the corresponding coordinate or coordinates.

The material preview changes to show the Mirror value you chose.

To create a decal:

1 In the Material Editor, choose a bitmap as a diffuse map.

2 On the map's Coordinates rollout, turn off both Mirror and Tile for both
the U and V coordinates. Change the mapping to Planar from Object
XYZ.

3 Adjust the U and V Tiling parameters to scale the decal.

Changing the Tiling value changes the size of the mapped bitmap as it
does when you tile the map, but with Mirror and Tile turned off, the
bitmap appears only once.

4 Adjust the U and V Offset parameters to position the decal.

NOTE You can also use the Parameters rollout's Cropping and Placement
controls to achieve a decal effect.

To offset the position of a map:

1 In the Coordinates rollout, make sure Use Real-World Scale is turned on.
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2 On the Coordinates rollout, set the U and V values to be between 0.0 and
100, or between -100 and 0.0.

3 Set the Offset Width and Height values to be between 0.0 and 100, or
between -100 and 0.0.

On the surface of the object, the map shifts in the directions you chose.

UV offsets are especially useful when you have turned tiling off and want the
bitmap to appear in a single location.

To rotate the map:

■ On the Coordinates rollout, set the Angle U, V, and W spinners.
Positive angles rotate the map in the clockwise direction; negative angles
rotate it counterclockwise.

The angle can be up to 360 degrees, which rotates the map completely and
has no visible effect unless you are animating the map's rotation.

You can also click Rotate to use the Rotate Mapping Coordinates dialog,
which lets you change the rotation by dragging the mouse.

To increase or decrease antialiasing:

■ On the map's Coordinates rollout, increase or decrease the Blur value.
For diffuse maps and other maps besides bump maps, the Blur value is
most effective in the 0.5-20 range. Lower values decrease antialiasing;
higher values increase it.

The Blur Offset parameter adjusts the image before antialiasing Blur is
applied. If all you need is antialiasing, leave Blur Offset at its default of
0.0.

To make a map image fuzzier:

■ On the map's Coordinate's rollout, increase the Blur Offset value.
Blur Offset is a very strong parameter. The Blur Offset spinner has
increments of 0.001 Values greater than 0.1 are likely to be too high.

To make a map image sharper:

■ On the map's Coordinates rollout, decrease the Blur Offset value to a value
below 0.0.
The negative Blur Offset value sharpens the image.
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Interface

These controls appear on the Coordinates rollout for many 2D maps:

Texture Applies the map as a texture map to a surface. Select the type of
coordinates from the Mapping list:

Environ Uses the map as an environment map on page 7964. Select the type of
coordinates from the Mapping list:

Mapping list Options vary depending on choice of Texture or Environ
mapping:

■ Explicit Map Channel Uses any map channel. When selected, the Map
Channel field becomes active, and you can choose any channel from 1 to
99.

■ Vertex Color Channel Uses assigned vertex colors as a channel. See
Editable Mesh on page 2075 for details on assigning vertex color.
See also Vertex Color Map on page 5943 and Assign Vertex Colors Utility on
page 6038.

■ Planar from Object XYZ Uses planar mapping based on the object's local
coordinates (disregarding the pivot point location). For rendering purposes,
planar mapping doesn't project through to the back of the object unless
you turn on Show Map On Back.

■ Planar from World XYZ Uses planar mapping based on the scene’s world
coordinates (disregarding the object’s bounding box). For rendering
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purposes, planar mapping doesn't project through to the back of the object
unless you turn on Show Map On Back.

■ Spherical Environment, Cylindrical Environment, Shrink-wrap
Environment Project the map into the scene as though it were mapped
to an invisible object in the background. See Environment Map on page
7964.

■ Screen Projects as a flat backdrop in the scene.

Show Map on Back When on, planar mapping (Planar from Object XYZ, or
with the UVW Map modifier) projects through to render on the back of the
object. When off, planar mapping doesn't render on the object's back.
Default=on.

This toggle is available only when Tiling is off in both dimensions. Its effect
is visible only when you render the scene.

NOTE In viewports, planar mapping always projects to the back of the object,
whether Show Map On Back is turned on or not. To override this, turn off Tiling.

Use Real-World Scale When turned on, applies the map to objects using the
real-world Width and Height values instead of UV values. Default=on.

When Real-World Scale is on, the texture placement is relative to the corner
of the texture map so alignment with architectural objects likes walls is more
efficient. When off, the texture placement is relative to the center of the
texture map.

Offset Changes the position of the map in UV coordinates on page 8161. The
map moves in relation to its size. For example, if you want to shift the map
its full width to the left, and half its width downward from its original position,
you enter -1 in the U Offset field and 0.5 in the V offset field.

UV/VW/WU Changes the mapping coordinate on page 8034 system used for
the map. The default UV coordinates project the map onto the surface like a
slide projector. The VW and WU coordinates rotate the map so that it is
perpendicular to the surface.

Tiling Determines the number of times the map is tiled on page 8148 (repeated)
along each axis.

Mirror Mirrors on page 8148 the map left-to-right (U axis) and/or top-to-bottom
(V axis).

Tile Turns tiling on or off in the U or V axis.
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When Use Real-World Scale is off

Offset (UV) Changes the position of the map in UV coordinates on page 8161.
The map moves in relation to its size. For example, if you want to shift the
map its full width to the left, and half its width downward from its original
position, you enter -1 in the U Offset field and 0.5 in the V offset field.

UV/VW/WU Changes the mapping coordinate on page 8034 system used for
the map. The default UV coordinates project the map onto the surface like a
slide projector. The VW and WU coordinates rotate the map so that it is
perpendicular to the surface.

Tiling Determines the number of times the map is tiled on page 8148 (repeated)
along each axis.

Mirror Mirrors on page 8148 the map left-to-right (U axis) and/or top-to-bottom
(V axis).

Tile Turns tiling on or off in the U or V axis.
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When Use Real-World Scale is on

Offset (Width/Height) Move the map horizontally or vertically along the
width or height of the object to which the material is applied. The offset
distance is relative to the lower-left corner of the map.

UV/VW/WU Changes the mapping coordinate on page 8034 system used for
the map. The default UV coordinates project the map onto the surface like a
slide projector. The VW and WU coordinates rotate the map so that it is
perpendicular to the surface.

Size Determines the real world width and height of the map.

For example, if you scan a piece of marble that is 12” x 8” and then assign
this image as the Diffuse Map, you can type 12” (or 1') and 8” as the Width
and Height. This ensures that the scale of the marble is correct in the rendered
scene.

NOTE The default setting for the texture size can be set using the Default Texture
Size option in the Material Editor Options Dialog on page 5335.

Mirror Mirrors on page 8148 the map horizontally and/or vertically.

Tile Turns horizontal and/or vertical tiling on or off.
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NOTE If the Use Real-World Size switch is turned off in the Material Editor, the
Real-World Map Size settings in modifiers like UVW Map or for primitives like Box
will not work. Likewise, moving vertices at a sub-object level or scaling an object,
in general, will not honor the Use Real-World Scale settings.

Angle U/V/W Rotates the map about the U, V, or W axis (in degrees).

Rotate Displays a schematic Rotate Mapping Coordinates dialog that lets you
rotate the map by dragging on an arcball diagram (similar to the arcball used
to rotate viewports, although dragging inside the circle rotates along all three
axes, and dragging outside it rotates about the W axis only). The Angle UVW
values change as you drag in the dialog.

Blur Affects the sharpness or blurriness of the map based on its distance from
the view. The farther away the map is, the greater the blurring. The Blur value
blurs maps in world space. Blur is primarily used to avoid aliasing on page 7904.

Blur Offset Affects the sharpness or blurriness of the map without regard to
its distance from the view. Blur Offset blurs the image itself in object space.
Use this option when you want to soften or defocus the details in a map to
achieve the effect of a blurred image.

See Blur/Blur Offset on page 7928.

Noise Rollout (2D)

Material Editor > Select sample slot. > Get Material > Material/Map Browser >
Turn on 2D Maps. > Select a map type. > Drag map from Browser thumbnail
to sample slot. > Noise rollout is displayed in the Material Editor.

You can add a random noise to the appearance of your material. Noise perturbs
the UV mapping of pixels by applying a fractal noise function.

Noise patterns can be very complex and are a versatile way to create apparently
random patterns. They are also good for simulating surfaces found in nature,
as is characteristic of fractal images.

Noise parameters interact closely with each other. Slight variations in each
can create noticeably different effects.

NOTE Noise settings aren't displayed in viewports.
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Above: A checker map and a bitmap

Below: The same maps with noise applied

Procedures

To add noise to a material:

1 In the Noise rollout, select On.

2 Adjust the three noise parameters to get an effect you like.

To remove noise from a material:

■ In the Noise rollout, turn off On.
Noise is no longer applied to the map.

To animate the noise effect:

1 Turn on the Auto Key button.

2 Move to a non-zero frame.

3 In the Noise rollout, turn on Animate.
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By default, animation keys are set at either end of the active frame range.

4 Change the Phase value at different keyframes.

Interface

These controls appear on the Noise rollout for many 2D maps:

On Determines whether the Noise parameters affect the map.

Amount Sets the strength of the fractal function, expressed as a percentage.
If the amount is 0 there is no noise. If the amount is 100 the map becomes
pure noise. Default=1.0.

Levels Or iterations: the number of times the function is applied. The effect
of the level is dependent on the Amount value. The stronger the amount, the
greater the effect of increasing the Levels value. Range=1 to 10; Default=1.

Size Sets the scale of the noise function relative to geometry. At very small
values, the noise effect becomes white noise. At large values, the scale can
exceed the scale of the geometry, in which case it has little or no effect.
Range=0.001 to 100; Default=1.0.

Animate Determines whether animation is on the noise effect. This parameter
must be turned on if you intend to animate the noise.

Phase Controls the speed of the animation of the noise function.

Bitmap 2D Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Bitmap
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Bitmaps shown in Material Editor sample slots

A bitmap is an image produced by a fixed matrix of colored pixels, like a mosaic.
Bitmaps are useful for creating many kinds of materials, from wood grains
and wall surfaces to skin and feathers. You can also use an animation or video
file instead of a bitmap to create an animated material.

When you assign the Bitmap map, the Select Bitmap Image File dialog on
page 5804 opens automatically. Use this dialog to specify a file or sequence as
the bitmap image.

The Bitmap map can synchronize the frames of a bitmap sequence to the age
of particles to which the map is applied. With this effect, each particle displays
the sequence from the start when it is born, rather than being assigned
whichever frame is current. This is achieved by turning on the Sync Frames
To Particle Age check box on page 5364. Also, when using Particle Flow, assign
the material containing the Bitmap map to a Material Dynamic operator. For
more details and a procedure, see Material Dynamic Operator on page 2925.

NOTE To save loading time, if a map with the same name is in two different
locations (in two different paths), it is loaded only once. This poses a problem only
if your scene includes two maps that have different content but the same name.
In this case, only the first map encountered will appear in the scene.
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Supported File Types

The Material Editor supports the following file formats:

AVI files on page 7326

BMP files on page 7328

CIN files (Kodak Cineon) on page 7328

DDS files on page 7330

GIF files on page 7334

IFL files on page 7339

JPEG files on page 7347

MOV files (QuickTime Movies) on page 7348

MPEG files on page 7348

PNG files on page 7360

PSD files on page 7361

RGB files (SGI format) on page 7369

RLA files on page 7364

RPF files on page 7366

TGA files (Targa) on page 7370

TIFF files on page 7372

YUV files on page 7374

NOTE If your scene includes animated bitmaps with materials, projector lights,
or environments, the animation file is reloaded once per frame. If your scene uses
multiple animations, or if the animations are large files, rendering will be slower.

See also:

■ Coordinates Rollout (2D) on page 5782

■ Noise Rollout (2D) on page 5793

■ Output Rollout on page 5774
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Procedures

To crop an image:

1 On the Bitmap Parameters rollout, click the Bitmap button and assign a
bitmap.

2 In the Cropping/Placement group, turn on Apply to see the results of
cropping in the sample slot (and in shaded viewports, if Show Map In
Viewport is active).

3 Turn on Crop.

4 Click View Image to display the bitmap.

A frame window appears, displaying the image surrounded by a region
outline (a dashed line at the outer edges of the image, with handles on
the sides and corners).

5 Specify a cropping region by adjusting the spinners at the top of the
window, or by dragging the region outline.

To place an image:

1 On the Bitmap Parameters rollout, click the Bitmap button and assign a
bitmap.

2 In the Cropping/Placement group, turn on Apply to see the results of
cropping in the sample slot (and in shaded viewports if Show Map In
Viewport is active).

3 Turn on Place.

4 Click View Image.

A frame window appears, displaying the image surrounded by a region
outline (a dashed line at the outer edges of the image, with handles on
the sides and corners).

5 Move the image by adjusting the spinners at the top of the window, or
by dragging the region outline.

The reduced image "decals" on the sample sphere. The diffuse color is
visible around the image.

To use the alpha channel that is part of the bitmap:

1 On the Maps rollout, assign the map to the Opacity component.
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(You can assign a copy or instance of this map to other components,
such as Diffuse, as well.)

2 Click the map button for the Opacity component.

This lets you adjust the settings for the Opacity map.

3 In the Bitmap Parameters rollout > Alpha Source group, choose Image
Alpha.

This option is not available if the bitmap does not have an alpha channel.

4 In the Bitmap Parameters rollout > Mono Channel Output group, choose
Alpha.

This option is not available if the bitmap does not have an alpha channel.

The bitmapped material will now have the transparency specified by the
alpha channel. This will appear in renderings. Transparency does not
appear in viewports or ActiveShade renderings.

To create an alpha channel based on intensity:

■ In Bitmap Parameters rollout > Alpha Source group, turn on RGB Intensity.
The software creates an alpha channel. Full-intensity areas of the image
are opaque, zero-intensity areas are transparent, and intermediate colors
become partially transparent.

To use a completely opaque bitmap:

■ In Bitmap Parameters rollout > Alpha Source group, turn on None (opaque).
The software ignores the bitmap's alpha channel, if present, and does not
create a new one.
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Interface

Bitmap Parameters rollout

Bitmap Selects the bitmap using the standard file browser. After selection,
the full path name appears on this button.

Reload Reloads the bitmap file using the same name and path. You don’t
need to use the file browser to reload the bitmap after you've updated it in
your paint program.

Clicking reload for any instance of the map updates the map in all sample
slots and in the scene.

Filtering group

Filtering on page 7977 options let you select the method of pixel averaging used
in antialiasing on page 7904 the bitmap.

5800 | Chapter 19   Material Editor, Materials, and Maps



Pyramidal Requires less memory and is adequate for most purposes.

Summed Area Requires much more memory, but yields generally superior
results.

None Turns off filtering.

Mono Channel Output group

Some parameters, such as opacity or specular level are a single value as opposed
to a material's three-value color components. Controls in this group determine
the source of the Output mono channel in terms of the input bitmap.

RGB Intensity Uses the intensity of the red, green, and blue channels for
mapping. The color of the pixels is ignored and only the value or luminance
of the pixels is used. The colors are computed as gray values in the range
between 0 (black) and 255 (white).

Alpha Uses the intensity of the alpha channel on page 7905 for mapping.

RGB Channel Output group

The RGB Channel Output determines where the output RGB part comes from.
The controls in this group affect only maps for material components that
display color: Ambient, Diffuse, Specular, Filter Color, Reflection, and
Refraction.

RGB Displays the full color values of the pixels. (Default)

Alpha as Gray Displays tones of gray based on the levels of the alpha channel.

Cropping/Placement group

The controls in this group let you crop the bitmap or reduce its size for custom
placement. Cropping a bitmap means to reduce it to a smaller rectangular
area than it originally had. Cropping doesn't change the scale of the bitmap.

Placing a bitmap lets you scale the map and place it anywhere within its tile.
Placing can change the bitmap's scale, but shows the entire bitmap. The four
values that specify the placement and size of the cropping or placement region
are all animatable.

Cropping and placement settings affect the bitmap only as it's used for this
map and any instances of the map. They have no effect on the bitmap file
itself.

Apply Turn on to use the cropping or placements settings.
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View Image Opens a window that shows the bitmap surrounded by a region
outline with handles at its sides and corners. To change the size of the crop
area, drag the handles. To move the region, position the mouse cursor inside
it and drag.

To see the results of editing the region, turn on Apply (see preceding). This
shows changes in the region as you make them.

The bitmap window has U/V and W/H (width/height) controls on its toolbar.
Use these to adjust the location and size the image or crop area.

When Place is chosen, dragging the region area handles changes the scale of
the bitmap (hold down Ctrl to preserve the bitmap's aspect ratio), and dragging
the image changes its location within the tile area.

The UV/XY button at the right of the window toolbar lets you switch between
using UV or XY coordinates in the toolbar spinners (Default=UV). .

Crop Makes cropping active.

Place Makes placement active.

U/V Adjusts the bitmap location.

W/H Adjusts the width and height of the bitmap or crop area.

Jitter Placement Specifies the amount of random offset. At 0, there is no
random offset. Range = 0.0 to 1.0

When Place is turned on, the size and position specified by the spinners or
editing window are ignored. The software then chooses a random size and
tile position for the image.

Alpha Source group

Controls in this group determine the source of the Output alpha channel in
terms of the input bitmap.

Image Alpha Uses the image's alpha channel (disabled if the image has no
alpha channel).

RGB Intensity Converts the colors in the bitmap to grayscale tonal values
and uses them for transparency. Black is transparent and white is opaque.

None (Opaque) Does not use transparency.

Premultiplied Alpha Determines how alpha is treated in the bitmap. When
turned on, the default, premultiplied alpha on page 8096 is expected in the file.
When turned off, the alpha is treated as non-premultiplied, and any RGB
values are ignored.
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TIP If you apply an alpha image as a Diffuse map, for example, and it doesn't
decal correctly, the bitmap file probably contains non-premultiplied alpha; the
RGB values are maintained separately from the alpha values. To correct this, turn
off Premultiplied Alpha.

Time rollout

These controls let you change the start time and speed of animation (AVI on
page 7326 or MOV on page 7348) files used as animated texture maps. They make
it easier to use sequences of images as maps in scenes, because you can control
the timing very precisely

Start Frame Specifies the frame where the playback of the animated map will
begin.

Playback Rate Lets you speed up and slow down the rate that the animation
is applied to the map (for example, 1.0 is normal speed, 2.0 is twice as fast,
.333 is 1/3 as fast).

Sync Frames to Particle Age When on, the software synchronizes the frames
of a bitmap sequence to the age of particles to which the map is applied. With
this effect, each particle displays the sequence from the start when it is born,
rather than being assigned whichever frame is current. Default=off.

When using Particle Flow, assign the material containing the Bitmap map to
a Material Dynamic operator. For more details and a procedure, see Material
Dynamic Operator on page 2925.

NOTE This functionality is not supported by the mental ray renderer.
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End Condition group

Determines what happens after the last frame of the bitmap animation if the
animation is shorter than the scene.

Loop Causes the animation to repeat over and over again from the beginning.

Ping-Pong Causes the animation to be played forward and then backward
repeatedly, making every animated sequence "loop smoothly."

Hold Freezes on the last frame of the bitmap animation.

Select Bitmap Image File Dialog

Material Editor > Maps Rollout > Click any map selector button. > Material/Map
Browser > Double-click Bitmap. > Select Bitmap Image.

Material Editor > Bitmap map > Bitmap Parameters rollout > Bitmap button

The Select Bitmap Image dialog allows you to choose a file or sequence of files
for a map. If a sequence of files is selected by turning on Sequence, the Image
File List Control dialog on page 7342 is opened when you click Setup or Open.

Procedures

To select a bitmap image for a map:

1 In the Material Editor, open the Maps rollout.

2 Click any button in the Map column.

This adds a map into the channel you've selected. For example, clicking
in the Map column of the Diffuse channel creates a diffuse or texture
map.

The Material Map Browser is displayed.

3 In the Material/Map Browser, double-click Bitmap.

The Select Bitmap Image dialog is displayed.

4 In the Select Bitmap Image dialog, navigate the Look In field to select
the appropriate directory.

NOTE The Select Bitmap Image File dialog uses the last location where a
bitmap was chosen, rather than the default bitmap path defined in Customize
> Configure User Paths.
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5 Highlight the file name in the file list window.

6 Click Open to close the dialog.

To select a set of still images as a bitmap sequence:

1 In the Material Editor, open the Maps rollout.

2 Click any button in the Map column.

This adds a map into the channel you've selected. For example, clicking
in the Map column of the Diffuse channel creates a diffuse or texture
map.

The Material Map Browser is displayed.

3 In the Material/Map Browser, double-click Bitmap.

The Select Bitmap Image dialog is displayed.

4 In the Select Bitmap Image dialog, navigate the Look in field to select the
directory containing the sequence of files.

5 If necessary, change file type to match the file extension of the sequence,
or choose All Formats.

6 Turn on Sequence, and choose the name of the first sequential file.

7 Click the Setup button.

The Image File List Control Dialog opens.

8 Click the Browse button and set the Target path to a writable directory
on your hard disk. Do not set the path to a CD-ROM drive.

9 Choose the options you want and click OK.

The IFL file is written to the target directory.

Interface

TIP You can resize the dialog by dragging an edge or a corner.
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History Displays a list of the most recent directories searched. Whenever an
image is selected, the path used is added to the top of the history list as the
most recently used path. The history information is saved in the 3dsmax.ini
on page 83 file.

Look In Opens a navigation window to browse other directories or drives.

 Up One Level Moves you up a level in the directory structure.

 Create New Folder Lets you create a new folder while in this dialog.
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 List Displays the contents of a directory without the details.

 Details Displays the contents of a directory with all the details.

List Window When details are turned on, the contents of the directory are
displayed with Name, Size, Type, Date Modified, and Attributes. You can sort
based on each of these columns by clicking the column label.

File Name Displays the file name of the file selected in the list.

Files of Type Displays all the file types that can be displayed. This serves as
a filter for the list.

Open Selects the highlighted file and closes the dialog.

Cancel Cancels the selection and closes the dialog.

Devices Lets you choose the hardware output device, for example, a digital
video recorder. The device, its driver, and its 3ds Max plug-in must all be
installed on your system to use the device.

Setup When Sequence is turned on, and there are sequential files in the
directory displayed, this Setup displays an Image File List Control dialog on
page 7342 to create an IFL file.

Info Displays expanded information about the file, such as frame rate,
compression quality, file size, and resolution. The information here depends
on the type of information that is saved with the file type.

View Displays the file at its actual resolution. If the file is a movie, the Media
Player is opened so the file can be played.

Gamma Group

These controls are unavailable unless Enable Gamma Correction is turned on
in the Gamma panel on page 7758 of the Preferences dialog.

Gamma Selects the type of gamma to be used for the selected file.

Use Image’s Own Gamma Uses the gamma of the incoming bitmap.

Use System Default Gamma Ignores the image’s own gamma and uses the
system default gamma instead, as set in the Gamma panel of the Preferences
dialog.
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Override Defines a new gamma for the bitmap that is neither the image’s
own, nor the system default.

NOTE In general, it is less confusing to use the System Default Gamma for
incoming bitmaps. But if you are using bitmaps created (or edited) by a variety
of other programs, and need to adjust gamma differently for each program, then
use Override.

Sequence Creates an "Image File List " using the given information. Note that
each time an image is selected, an evaluation is done to see if an IFL sequence
can be created. If the selected image does not yield a list, this option box is
unavailable. In the past, it was necessary to enter a wild card in order to create
a list. Now it is possible to use wild card to filter files in the file selector.

Preview Displays the image as a thumbnail in the image window.

Image Window Displays a thumbnail of the selected file.

Statistics Displays the resolution, color depth, file type, and number of frames
of the selected file.

Location Displays the full path for the file. With this information at the
bottom of the dialog, you always know exactly where you are.

Checker Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Checker
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Checker map used for the tablecloth and (in a composite) for the floor of the ice-cream
shop

The Checker map applies a two-color checkerboard pattern to the material.
The default checker map is a pattern of black and white squares. Checker maps
are 2D procedural maps. The component checkers can be either colors or
maps.

TIP Turning on Noise for a Checker map can be an effective way to create irregular
patterns with a natural appearance.

See also:

■ Coordinates Rollout (2D) on page 5782

■ Noise Rollout (2D) on page 5793

Procedures

To create a Checker map:

1 Click a map button to assign a map.
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2 Choose Checker in the Material/Map browser, and then click OK.

To change the color of one set of squares:

1 In the Checker Parameters rollout, click a color swatch to display the
Color Selector on page 391.

2 Adjust the color.

3 Click Close.

To use a map for one set of squares:

■ In the Checker Parameters rollout, click a map button to assign a map to
a color.

To soften the edge between the two checker colors:

■ In the Checker Parameters rollout, increase the value of Soften.
When Soften equals 0.0, there is a hard edge between the checker colors.
Low positive values soften or blur the checker boundary. Larger Soften
values can blur the entire material.

To swap the two checker components:

■ In the Checker Parameters rollout, click Swap.

Interface

Soften Blurs the edges between the checkers. A little blurs a lot.

Swap Switches the position of the two checkers.
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Color #1 Sets the color of one of the checkers. Click to display the Color
Selector on page 391.

Color #2 Sets the color of one of the checkers. Click to display the Color
Selector on page 391.

Maps Selects a map to use within the area of the checker color. For example,
you could put an additional checkerboard within one of the checker colors.

The check boxes enable or disable their associated map.

Combustion Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Combustion

With the Combustion map, you can create maps interactively using the
Autodesk Combustion software and 3ds Max at the same time. You use
Combustion to paint on a bitmap, and the material updates automatically in
the Material Editor and in shaded viewports.

IMPORTANT The Combustion map works only if Autodesk Combustion is installed
on your system.

Only Combustion 2.1 and later formats are supported. Maps in the Combustion
1 format are not supported in 3ds Max.

IMPORTANT The mental ray renderer on page 6230 does not support the
Combustion map.

See also:

■ CWS (Combustion Workspace) Files on page 7329

■ Noise Rollout (2D) on page 5793

About the 3ds Max and Combustion Integration

You can use Combustion as a material map in 3ds Max. With a Combustion
map, you can create a material from a Paint or composite operator, and in
turn apply that material to objects in a 3ds Max scene. The Combustion map
can include Combustion effects, and it can be animated.
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In addition, with Combustion you can import 3ds Max scenes that have been
rendered to a rich pixel file on page 7366 (RPF on page 7366 or RLA on page 7364
file). The imported rich pixel rendering becomes an element of your composite.
You can adjust its 3D position relative to video elements of the composite,
and you can apply Combustion 3D Post effects to objects within it. See the
Combustion User’s Guide for more information.

NOTE Because 3ds Max runs only on Windows, you cannot use Combustion to
create material maps on a Macintosh.

3ds Max Materials and the Combustion Map

In 3ds Max, a material on page 8041 is data that you assign to the surface or
faces of an object so that it appears a certain way when rendered. Materials
affect the color of objects, their shininess, their opacity, and so on.

The Material Editor on page 5284 is the portion of 3ds Max that creates and
manages materials. In the Material Editor, you can assign maps to a material's
color components and to its numeric components such as opacity. Maps add
images, patterns, color adjustments, and other effects to the visual properties
of the material.

In the 3ds Max Material Editor, you assign a map by clicking the map button
for a component color or other component. This displays the Material/Map
Browser, which lets you choose the map type.

3ds Max provides several types of maps on page 8036. The most basic is a 2D
map, a two-dimensional image that is typically mapped onto the surface of
geometric objects.

Other uses of 2D maps are as environments to create a background for the
scene, as projections from lights, and as displacements to "emboss" geometry.

A Combustion map is a 2D map on page 5782. It is a Combustion project used
by the 3ds Max Material Editor, so like any Combustion project, it is
vector-based, animatable, and fully editable. From within the Material Editor,
you can have Combustion create a new project from scratch, or use an existing
composite or Paint branch. You can synchronize the Combustion Timeline
with the 3ds Max time slider so animated materials synchronize with your
3D scene.

With a Combustion map, you can paint in either program: that is, you can
paint either in the Combustion viewport or on 3ds Max objects. Both programs
update the paint display. You also have the option of using Combustion to
paint on an "unwrapped" projection of 3ds Max object geometry.
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In addition, with Combustion effects that require you to pick a point, such
as Lens Flare or Ripple, you can use either program, Combustion or 3ds Max,
to pick the point.

Tips for Working with a Combustion Map in 3ds Max

■ If you have a dual-screen configuration, you can set it up so you can see
both the 3ds Max and the Combustion windows at the same time.
Otherwise, you need to use Alt+Tab to switch between the two windows.

■ To work with Combustion, the 3ds Max object must have mapping
coordinates on page 8034. Primitive objects have a Generate Mapping
Coordinates toggle, which is automatically enabled when you assign a
mapped material to the object. Some objects, such as editable meshes, do
not have a Generate Mapping Coordinates toggle. For these kinds of objects,
go to the Modify panel and apply a UVW Map modifier on page 1931.

■ Sometimes it can be hard to see how the Combustion operator is oriented
to the 3ds Max object's mapping coordinates. It can help to paint some
temporary strokes in Combustionto see how they are aligned in 3ds Max
viewports. Displaying the mapping coordinates in Combustion can help.
See the procedure, "To display an unwrapped mesh." It can also help to
paint directly on the object in a 3ds Max viewport. See the procedure, "To
paint directly on the 3D object."

Procedures

To create a new Combustion map:

1 Open the Material Editor.

2 Drag an unused sample slot from the Material Editor to the object you
want to paint.

3 In the Material Editor, click the map button for the Diffuse Color
component. This button is on the material’s Basic Parameters rollout.
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All standard materials have a Basic Parameters rollout, whose controls
vary depending on the chosen shader. The Strauss shader has only one
color component, labeled Color.

The Material/Map Browser appears.

4 In the Material/Map Browser, choose Combustion, and click OK.

A Combustion map is assigned to the Diffuse Color, and a black material
map appears in the active sample slot.

5  Click to turn on Show Map In Viewport.

In the scene, the object turns black in shaded viewports.

6 In the Parameters rollout, click Edit.

This launches Combustion, which displays the New Workspace dialog.

7 Set up the new project.
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The composite or Paint branch that you create in Combustion appears
on the object in 3ds Max viewports, as well as in the sample slot for the
material with the Combustion map. The workspace name and path are
assigned to the material, and appear on the Project button in the material’s
Combustion Parameters rollout.

For example, you can use the Paint operator in Combustion. When you release
the mouse, the stroke appears on the 3ds Max object.

Paint operator in Combustion
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Painted object in 3ds Max

To display an unwrapped mesh:

In the 3ds Max Material Editor, you can use the Unwrap Mesh feature to
display your 3D object as a 2D mesh in Combustion. You can adjust the color
and size of the mesh.

The mesh display is only an overlay to help you orient paint strokes and other
Combustion effects. It is displayed in Combustion but is not a part of the
composite or the map.

1 Create a Combustion map.

2 In the 3ds Max Material Editor, enable Unwrap Selected in the Live Edit
group.
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In Combustion, a mesh appears. This is an "unwrapped" projection of
the 3D object.

3D object in 3ds Max

Corresponding mesh in Combustion
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To set the mesh parameters:

■ In Combustion, choose File > Preferences > Mesh.

ToUse

Remove jaggies from the mesh.Anti-Alias Mesh

Display the mesh when you play back the
animation.

Display During Playback

Click the color box to set the color of the
mesh using a color picker.

Color

To paint directly on the 3D object:

1 Create a Combustion map.

2 In Combustion, select one of the following drawing tools:

■  Freehand

■  Straight Line

■  Rectangle

■  Ellipse

3 In the 3ds Max Material Editor, enable Paint in the Live Edit group of the
Combustion Parameters rollout.
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In the 3ds Max viewport, a pen cursor appears. Drag the cursor over the
object to paint on it.

When you release the cursor, the Paint object also appears in Combustion.

To animate Combustion Paint strokes:

1 Create a Combustion map.

2 In Combustion, set the time scale to start at frame number 0. Choose File
> Preferences. In the Preferences dialog select General, set Display Time
As to Frames (From 0), and then click OK.

3 In the 3ds Max Material Editor, enable Track Time in the Live Edit group
of the Combustion Parameters rollout.

Now the time slider in 3ds Max controls the Timeline indicator in
Combustion.

4 In 3ds Max, move the time slider to a frame and create a Paint object.

The Paint object appears on that frame in both Combustion and 3ds Max.

5 Move to another frame and use Combustion to modify the Paint object.
Combustion uses interpolation to determine the appearance of the Paint
object between keyframes. If you add a new Paint object, that object
simply appears, starting on the frame where you created it.
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6 Continue advancing in the clip, adding and modifying Paint strokes and
effects to create your animated material. For more information on
animating objects in Combustion, refer to the Combustion User’s Guide.

You can add Paint strokes in either program, but to modify them you
must use Combustion.

NOTE Remember, Combustion tracks the time slider in 3ds Max, but 3ds
Max does not track the Timeline indicator in Combustion. If the 3ds Max
viewport does not appear to be updating as you paint in Combustion, you
might be painting on a different frame than the one displayed in 3ds Max.
To find your Paint objects, move to the correct frame in 3ds Max.

To use an existing Combustion workspace as a material map in 3ds Max:

1 Open the Material Editor and select an unused sample slot.

2 In the Material Editor, expand the Maps rollout, and click the Map button
next to the Diffuse Color component.
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The Material/Map Browser appears.

3 In the Material/Map Browser, choose Combustion, and click OK.

A Combustion map is assigned to the Diffuse Color, and a black material
map appears in the active sample slot.

4 In the Combustion Parameters rollout, click the Project bar.
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The Open Project dialog appears.

5 Browse for the workspace file (.cws) that you want to use as a map, and
click the Open button.

The Combustion workspace name and path appear in the Project button.

To apply the map to an object, drag the sample slot from the Material
Editor to the object in a 3ds Max viewport.

To edit the map, click the Edit button in the Parameters rollout. In
Combustion, the workspace corresponding to the selected map opens,
and you can edit the image.

To paint geometry with a bitmapped material already assigned to it:

1 In 3ds Max, select the object that you want to paint.

2 In the Material Editor, select an unused sample slot.

3 Click the Pick Material From Object button, then click the object in the
viewport to put the object's material in the selected sample slot.

4 Open the Maps rollout and note the name of the bitmap file. Click Map
to go to the bitmap level of the material.

5 Click the map's Type button.

The Material/Map Browser appears.

6 In the Material/Map Browser, choose Combustion to change the type
from Bitmap to a Combustion map.

7 On the Paint Parameters rollout, click the blank Project button, and then
choose the same bitmap.

8 Click Edit.
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Combustion is launched and the Import Footage dialog appears. Import
the same bitmap.

To paint on the bitmap, select Paint. You can also key or color correct
the bitmap, or use it to build a composite. For more information, see the
Combustion User's Guide.

9  In the 3ds Max Material Editor, click Show Map In Viewport.

In the scene, the object is mapped in shaded viewports.

Object with original bitmap

Object with painted bitmap

2D Maps | 5823



To paint selected faces:

Use a Multi/Sub-Object material to control the location of your painting. Any
sub-material can have a Combustion map, so you can use Combustion to
affect only the selected faces.

1 In 3ds Max, select the object you want to paint.

2 In the Modify panel, apply an Edit Mesh modifier to the object. (Choose
Edit Mesh from the Modifier drop-down list.)

If you are working with an editable mesh object, or a patch or NURBS
surface, skip step 2. For geometry primitives, an option is to convert the
object to a mesh, patch, or NURBS surface before step 3. However, you
then lose the ability to adjust object parameters (for example, the radius
of a sphere, the height of a box).

3 Choose Face as the sub-object selection level. Select the faces on which
you want to paint.

4 Drag a material from a sample slot in the Material Editor onto the selected
faces.
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5 In the modifier stack display, choose the object again, to disable sub-object
selection.

6 In the Material Editor, use Pick Material From Object to grab the material
from the geometry.

You now have a new Multi/Sub-Object material. The original material
appears as a sub-material applied to the selected faces.

7 In the Multi/Sub-Object material, go to the material assigned to the faces
you want to paint.

A Multi/Sub-Object material is simply a container for multiple
sub-materials assigned to different faces of the same object. Click a
Sub-Material button to go to a sub-material.
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8 Assign a Combustion map to the Diffuse component of the sub-material
applied to the selected faces.

9 Click Edit to launch Combustion.

10 Use the tools in Combustion to modify the material.

To modify a Combustion map:

1 In the Material Editor, select the material you want to modify.

5826 | Chapter 19   Material Editor, Materials, and Maps



Material maps created in Combustion are vector-based and fully
modifiable.

2 In the Combustion Parameters rollout, click the Edit button.

The workspace corresponding to the Combustion map opens in
Combustion. As you modify the workspace in Combustion the map is
updated in 3ds Max.

3 In Combustion, save the workspace before you disable the Edit button
in 3ds Max.

To create a displacement map:

In 3ds Max, the Displace modifier on page 1344 acts as a force field to push and
reshape an object's geometry. You can apply its variable force directly from
the modifier gizmo, from a bitmap image, or from a Combustion workspace.

The grayscale component of the image is used to generate the displacement.
Lighter colors in the image push outward more strongly than darker colors,
resulting in a 3D displacement of the geometry.

1 In 3ds Max, select the object to which you want to apply the displacement
map.

In this example, the displacement is applied to a box primitive.

In the object's Parameters rollout, increase the number of Length and
Width Segments. The closer the number of segments approaches the
resolution of the displacement map, the more accurate is the result.

In the example, 150 by 150 gives good results.

2 Apply a Displace modifier: in the Modify panel, choose Displace from
the Modifier drop-down list.
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3 In the Parameters rollout, Image group, click the Map button.

4 The Material/Map Browser appears. Select Combustion and click OK.

The Map button now reads Map #1 (Combustion).

5 Open the Material Editor, and then click and drag the Map #1
(Combustion) button to an unused sample slot in the Material Editor.

An Instance (Copy) Map dialog is displayed.
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6 Select Instance and click OK.

7 In the Material Editor, Combustion Parameters rollout, click Edit.

This launches Combustion. In the New dialog, set the Type To Paint, and
create a grayscale image to use as a displacement map. For more
information, see the Combustion User's Guide.

8 In 3ds Max, increase the Displacement strength in the modifier Parameters
rollout.

As you increase the strength, you can see the result of the displacement
map on the selected object.
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9 In Combustion, save your project, then in 3ds Max, disable Edit in the
Combustion Parameters rollout to exit Edit mode.

Interface

2D Mapping Coordinates

Like any 2D map in 3ds Max, mapping coordinates control how a Combustion
map is positioned on objects.

For geometric primitives, mapping coordinates are usually provided
automatically. For some kinds of geometry, such as meshes on page 2075, patches
on page 2067, and NURBS surfaces on page 2237, you must apply a UVW Map
modifier on page 1931 to provide mapping coordinates.

Controls in a 2D map's Coordinates rollout on page 5782 affect how the map is
positioned.
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When you work with a Combustion map, these are the important points to
remember:

■ When you apply a Combustion map to an object, leave mapping set to
the default values of Texture and Explicit Map Channel.

■ When you use a Combustion map as an environment map, set mapping
to Environ and then choose the mapping shape from the Mapping
drop-down list.

■ The offset, tiling, mirror, and angle controls are useful especially when the
size of the projected Combustion map is smaller than the geometry.

■ You can choose between UV, VW, and WU projections. (You can also do
this from the Combustion Parameters rollout, as described below.) UV
projects onto the surface of geometry like a slide projector. VW and WU
project the map at right angles to the geometry. With a Combustion map,
UV is almost always the most useful choice.

Combustion Parameters rollout

The Combustion Parameters rollout appears when you assign a Combustion
map to a material.
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Project Loads the file to use in Combustion. You can load only file types
supported by Autodesk Combustion, such as Combustion workspace files
(cws), or footage and image file formats supported by Combustion (see the
Combustion User's Guide for information on supported footage formats).

Edit Launches Combustion from the 3ds Max Material Editor. If a project is
loaded, it is opened in Combustion. If no project is loaded, Combustion
displays the New dialog. This dialog lets you specify a project type, name,
video format, duration, and background color.

Live Edit group

These controls affect how you use Combustion with 3ds Max.

Operator Switches control to Combustion, where you can select an operator.
The results of the operator appear as the image in the Combustion map. The
operator does not have to be the last operator in the pipe.

While Combustion is active, you can also adjust the operator. The Combustion
map updates to show the results.
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Unwrap Selected Takes the current UVW mapping coordinates of the currently
selected 3D object (or the current Face sub-object selection), and displays them
in Combustion. This can help you coordinate the map and the mesh as you
paint. The Unwrap display is only an overlay. It is displayed in Combustion
but is not a part of the composite or the map.

UV List Changes the mapping coordinate system (the direction in which the
map is projected) from UV to VW or UW. UV projects onto the surface of
geometry like a slide projector. VW and WU project the map at right angles
to the geometry. With a Combustion map, UV is almost always the most
useful choice.

UV Specifies which mapping channel to unwrap and paint. Range=1 to 99.

Track Time Links the Timeline in Combustion to the time slider in 3ds Max.
When Track Time is enabled, you can use the time slider in 3ds Max to navigate
between frames in Combustion.

NOTE This control is not bidirectional; changing the frame in Combustion does
not change the frame in 3ds Max.

Paint When enabled, displays a paint cursor in 3ds Max viewports. You can
then paint directly on the 3D geometry. Dragging the cursor in the viewport
over the geometry in 3ds Max creates paint strokes inside Combustion.

Constrain To UV When enabled, constrains paint strokes to remain within
the edges of the UV mapping coordinates. When paint strokes are
unconstrained on an object such as a box, they can jump to the other side of
the map when you cross a map’s edge. This can give erratic results. To prevent
this, enable Constrain To UV.

In general, use the Constrain To UV option when you paint on boxes and
other objects with planar maps. Disable this option when you want to paint
on spherical maps or anywhere else the mapping has a singularity (where the
edges of the map converge to a single point).

Selected Faces Constrains the Combustion image to only the faces selected.
This gives additional control or masking based on faces rather than UV
mapping.

Project Info group

These readouts display the format of the Combustion Paint or composite
operator. They are active when a Combustion workspace is loaded or Edit
mode is active.

Width Sets horizontal resolution of the frame in pixels.
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Height Sets vertical resolution of the frame in pixels.

Frames Sets number of frames in the Combustion workspace.

Rate Sets playback speed in frames per second.

Custom Resolution group

With these controls, you can customize the resolution of the Combustion
map.

Enable Enables the Width and Height controls.

Width and Height Width changes the horizontal resolution of the map.
Height changes the vertical resolution of the map.

Time group

These controls relate frames in the Combustion workspace to frames in the
Combustion map. See the controls under "End Condition Group" for how to
handle the map when it contains fewer frames than the 3ds Max scene.

Start Frame Determines which frame of the Combustion sequence is used as
the first frame of the Combustion map in 3ds Max.

Duration Sets how many frames of the Combustion file sequence are used
by the Combustion map in 3ds Max.

Filtering group

These controls determine the method for calculating antialiasing on page 7904:

Pyramidal Sets the default antialiasing method. This method is faster than
Summed Area filtering.

Summed Area Implements a better method of antialiasing. Summed Area
filtering uses more memory than Pyramidal. If it has to use virtual memory,
it can dramatically increase rendering time.

None Performs no antialiasing. This option takes the least time to render, but
yields the lowest quality results.

End Condition group

These controls define what the 3ds Max renderer should do when the duration
of the Combustion project (or the range of frames used in the Combustion
map) is shorter than the rendering sequence in 3ds Max.
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Loop Plays the Combustion project animation repeatedly until the rendering
sequence ends.

Ping Pong Plays the animation forward, then backward, and repeatedly plays
forward and backward until the rendering sequence is completed.

Hold Plays the animation once, then repeatedly displays the last frame of the
project until the rendering sequence is completed.

Gradient Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Gradient

Gradient maps used for the stoplight lamps, and for the background of the scene

Gradients shade from one color to another. You specify two or three colors
for the gradient; the software interpolates intermediate values. Gradient maps
are 2D maps.
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TIP You can swap colors by dragging one color swatch over another, then clicking
Swap in the Copy or Swap Colors dialog. To reverse the overall direction of the
gradient, swap the first and third colors.

Gradient-mapped material tiled (left) and with noise (right)

See also:

■ Coordinates Rollout (2D) on page 5782

■ Noise Rollout (2D) on page 5793

■ Output Rollout on page 5774

Procedures

To create a Gradient map:

1 Click a map button to assign a map.

2 Choose Gradient in the Material/Map Browser, and then click OK.

To change a gradient color:

1 In the Gradient Parameters rollout, click a color swatch to display the
Color Selector on page 391.

2 Adjust the color.

3 Click one of the other color swatches.

4 Adjust the color.

5836 | Chapter 19   Material Editor, Materials, and Maps



To choose the kind of gradient:

■ Choose either Linear or Radial.
A linear gradient shades from one color to another along a line. A radial
gradient has one color on the inside and another on the outside, shading
in a circular pattern.

To use a map for a color in the gradient:

■ In the Gradient Parameters rollout, click a map button to assign a map to
a color.

To adjust the position of the second color:

■ Change the Color 2 Position value.
At the default value of 0.5, the second color is between the first and third
colors. For a linear gradient, the second color's position ranges from the
bottom at 0.0 to the top at 1.0. For a radial gradient, the second color's
position ranges from the inside at 0.0 to the outside at 1.0.
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Interface

Color #1-3 Sets the three colors that the gradient interpolates between.
Displays the Color Selector on page 391. You can drag and drop the colors from
one swatch to another.

Maps Displays a map on page 8036 instead of the color. Maps are blended into
the gradient in the same way that the gradient colors are blended. You can
add nested procedural gradients in each window to make 5-, 7-, 9-color
gradients, or more.

The check boxes enable or disable their associated maps.

Color 2 Position Controls the center point of the middle color. The position
ranges from 0 to 1. When it is 0, color 2 replaces color 3. When it is 1, color
2 replaces color 1.

Gradient Type Linear interpolates the color based on the vertical position (V
coordinate) while radial interpolates based on the distance from the center of
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the map (center is: U=0.5,V=0.5). With both of these, you can rotate the
gradient using the angle parameter under Coordinates, which is animatable.

Noise group

Amount When nonzero (ranges from 0 to 1), applies a noise effect. This
perturbs the color interpolation parameter using a 3D noise function based
on U, V, and Phase. For example, a given pixel is halfway between the first
and second color (the interpolation parameter is 0.5). If noise is added, the
interpolation parameter would be perturbed by some amount so that it may
become less or more than 0.5.

Regular Generates plain noise. This is the same as Fractal noise with the Levels
setting at 1. When the noise type is set to Regular, the Levels spinner becomes
disabled (because Regular is not a fractal function).

Fractal Generates noise using a fractal algorithm. The Levels option sets the
number of iterations for the fractal noise.

Turbulence Generates fractal noise with an absolute value function applied
to it to make fault lines. The noise amount must be greater than 0 to see any
effects of turbulence.

Size Scales the noise function. Smaller values give smaller chunks of noise.

Phase Controls the speed of the animation of the noise function. A 3D noise
function is used for the noise. The first two parameters are U and V and the
third is phase.

Levels Sets the number of fractal iterations or turbulence (as a continuous
function).

Noise Threshold group

When the noise value is above the Low threshold and below the High
threshold, the dynamic range is stretched to fill 0–1. This produces a smaller
discontinuity at the threshold transition and thus causes less potential aliasing.

Low Sets the low threshold.

High Sets the high threshold.

Smooth Helps make a smoother transition from the threshold value to the
noise value. When smooth is 0, no smoothing is applied. When it is 1, the
maximum amount of smoothing is applied.
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Gradient Ramp Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Gradient Ramp

Gradient ramp used for the layers of the cake

Gradient Ramp is a 2D map similar to the Gradient map. It shades from one
color to another. In this map, however, you can specify any number of colors
or maps for the gradient. There are a variety of controls, making highly
customized gradients possible. Almost any parameter of Gradient Ramp can
be animated.

See also:

■ Coordinates Rollout (2D) on page 5782

■ Noise Rollout (2D) on page 5793

■ Output Rollout on page 5774
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Procedures

To create a material with a Gradient Ramp map:

1 Open the Material Editor, and choose an unused sample slot.

2 Close the Basic Parameters rollout, and open the Maps rollout.

3 Click the Map button for Diffuse to display the Material/Map Browser.

4 In the Browser list, click Gradient Ramp. The map appears in the upper-left
of the Browser window. Click OK.

Gradient Ramp map is applied to the sample slot as the Browser closes.

5 In the Material Editor, under its toolbar, give the material a name to
identify its use in your scene.

When you replace an existing map with a gradient ramp map, choosing
to Keep Old Map as Submap in the Replace Map dialog, the old map
becomes assigned to the first flag as a texture.
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Gradient Ramp-mapped material with a colored gradient
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Interface

Gradient bar shows default gradient and interpolation types

Gradient bar Presents an editable representation of the gradient being created.
The effect of the gradient moves from left (start point) to right (end point).

By default, three flags appear along the bottom edge of a red/green/blue
gradient. Each flag controls a color (or map). The currently selected flag is
green, and its RGB value and its position in the gradient (in the range 0 to
100) appear above the gradient bar. Each gradient can have any number of
flags.

The gradient bar has the following features:

■ Click anywhere along the bottom edge to create additional flags.

■ Drag any flag to adjust the position of its color (or map) within the
gradient. The start and end flags (Flag #1 at 0 and Flag #2 at 100) cannot
be moved. However, other flags can occupy these positions and still be
moved.
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■ More than one flag can occupy a given position. If two flags are at the
same position, a slight edge appears between the colors. With three or
more flags at the same position, the edge is a hard line.

Right-click options for gradient bar Right-click in the gradient bar to display
a menu with these options:

Reset Returns gradient bar to defaults.

Load Gradient Loads an existing gradient (DGR) file into the gradient bar.

Save Gradient Loads your current gradient bar as a DGR file.

Copy, Paste Copies a gradient and pastes it into another Gradient Ramp map.

Load UV Map Selects a UV map.

Load Bitmap Selects a bitmap.

Flag Mode Toggles flag display.

Right-click options for flags Right-click any flag to display a menu with the
following options:

Copy and Paste Lets you copy the current key and paste it to replace another
key. The other key could be in another Gradient Ramp as well as the current
one.

Edit Properties Choose this option to display the Flag Properties dialog on
page 5846.

Delete Deletes the flag.

Gradient Type Chooses the type of gradient. The following Gradient types
are available. These affect the entire gradient.

■ 4 Corner An asymmetrical linear transition of colors.

■ Box A box.

■ Diagonal A linear diagonal transition of colors.

■ Lighting Based on the light intensity value. No light=far left; brightest
light=far right.

■ Linear A smooth, linear transition of colors.

■ Mapped Lets you assign a map to use as the gradient. Enables the Source
Map controls for specifying the map and turning it on and off.
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■ Normal Based on the angle between the vector from the camera to the
object and the surface normal vector at the sample point. The leftmost
flag of the gradient is 0 degrees; the rightmost flag is 90 degrees.

■ Pong A diagonal sweep that repeats in the middle.

■ Radial A radial transition of colors.

■ Spiral A smooth, circular transition of colors.

■ Sweep A linear sweep transition of colors.

■ Tartan A plaid.

Interpolation Chooses the type of interpolation. The following Interpolation
types are available. These affect the entire gradient.

NOTE Gradients are ordered from left to right. The “next” flag is to the right of
the current flag; the “previous” flag is to the left.

Custom Sets an individual interpolation type for each flag. Right-click the
flag to display the Flag Properties dialog on page 5846 and set the interpolation.

Ease In Weighted more toward the next flag than the current flag.

Ease In Out Weighted more toward the current flag than the next flag.

Ease Out Weighted more toward the previous flag than the next flag.

Linear Constant from one flag to the next. (Default.)

Solid No interpolation. Transitions are a sharp line.

Source Map Click to assign a map to a mapped gradient. The check box turns
the map on or off.

The Source Map controls are available only when Mapped is the chosen
gradient type.

Noise group

Amount When nonzero, a random noise effect is applied to the gradient,
based on the interaction of the gradient ramp colors (and maps, if present).
The higher this value, the greater the effect. Range=0 to 1.

Regular Generates plain noise. Basically the same as fractal noise with levels
disabled (because Regular is not a fractal function).
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Fractal Generates noise using a fractal algorithm. The Levels option sets the
number of iterations for the fractal noise.

Turbulence Generates fractal noise with an absolute value function applied
to it to make fault lines. Note that the noise amount must be greater than 0
to see any effects of turbulence.

Size Sets the scale of the noise function. Smaller values give smaller chunks
of noise.

Phase Controls the speed of the animation of the noise function. A 3D noise
function is used for the noise; the first two parameters are U and V and the
third is phase.

Levels Sets the number of fractal iterations or turbulence (as a continuous
function).

Noise Threshold group

When the noise value is above the Low threshold and below the High
threshold, the dynamic range is stretched to fill 0 to 1. This causes a smaller
discontinuity at the threshold transition and produces less potential aliasing.

High Sets the high threshold.

Low Sets the low threshold.

Smooth Helps make a smoother transition from the threshold value to the
noise value. When Smooth is 0, no smoothing is applied. When Smooth is 1,
the maximum amount of smoothing is applied.

Flag Properties Dialog

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Gradient Ramp > Gradient Ramp Parameters rollout > Right-click a flag at
the bottom of the gradient bar. > Edit Properties > Flag Properties dialog

By setting parameters on the Flag Properties dialog, you can customize the
effect of each flag on the Gradient Ramp map. You have access to all flags
from this dialog.

See also:

■ Gradient Ramp Map on page 5840
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Interface

Name field Select any flag with the spinners. The selected flag turns green on
the gradient bar. Use this field to rename a flag to represent its use in the
gradient.

Interpolation Disabled unless the Interpolation type for the Gradient Ramp
map is set to Custom. The available interpolation types for flags are similar
to the corresponding ones in the Gradient Ramp map:

NOTE Gradients are ordered from left to right. The “next” flag is to the right of
the current flag; the “previous” flag is to the left.

Ease In Weighted more toward the next flag than the current flag.

Ease In Out Weighted more toward the current flag than the next flag.

Ease Out Weighted more toward the previous flag than the next flag.

Linear Constant from one flag to the next. (Default.)

Solid No interpolation. Transitions are a sharp line.

Texture Assigns a map in place of a color. When unselected, the flag turns
blue to indicate a map assignment.
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Color Click the color swatch to change the color controlled by the selected
flag.

Position Shows the current position of the selected flag. Use the spinners to
reposition the flag, or enter a value directly. Position is not available for the
start and end flags, because these flags can’t be moved.

 Animation keys Animation keys are created by default for Color and
Position, and the keys are active, indicated by the green triangles next to the
Color and Position labels. You can turn these keys off if you don’t intend to
animate the gradient.

Swirl Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Swirl

Swirl used to create the whirlpool
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Swirl is a 2D procedural map that generates patterns similar to the swirls in
two-flavor ice creams. Like other two-color maps, either color can be replaced
with other maps, so it’s possible to swirl marble with wood, for example.

See also:

■ Coordinates Rollout (2D) on page 5782

■ Noise Rollout (2D) on page 5793

Procedures

To create a Swirl-mapped material:

1 Open the Material Editor, and choose an unused sample slot.

2 Close the Basic Parameters rollout, and open the Maps rollout.

3 Turn on Diffuse Color. Click its Map button to display the Material/Map
Browser.

4 In the Browser list, click Swirl. The map appears in the upper-left of the
Browser window. Click OK.

Swirl map is applied to the sample slot as the Material/Map broswer closes.

5 In the Material Editor, under its toolbar, give the material a name to
identify its use in your scene.
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Interface

Swirl Color Setup group

Base The underlying layer for the swirl effect. Click the color swatch to change.
Click None to assign a map in place of a color. The check box enables or
disables the map.

Swirl Mixed with the Base color or map, produces the swirl effect. Click the
color swatch to change this color. Click None to assign a map in place of a
color.

Swap Reverses the color or map assignments for Base and Swirl.

Color Contrast Controls the contrast between Base and Swirl. At 0, the swirl
is blurred. Higher values increase the contrast until all colors become black
and white, even if Swirl Intensity and Swirl Amount are very high. Range=0
to 4.0; Default=0.4.
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Swirl Intensity Controls the intensity of the swirl color. Higher values create
a more vibrant mix of colors. At 0, the swirl effect disappears. Range=-10 to
10.0; Default=2.0.

Swirl Amount Controls the quantity of the Swirl color that gets mixed into
the Base color. If set to 0, only the base color is used. Range=0 to 3.0;
Default=1.0.

Swirl Appearance group

Twist Changes the number of spirals in the swirl effect. Higher values increase
the number of spirals. Negative values change the direction of the twist. At
0, the colors are randomly distributed, not swirled. Range=-20.0 to 20.0;
Default=1.0.

Constant Detail Changes the level of detail within a swirl. Lower values
minimize the level of detail within the swirl. At 0, all detail is lost. Higher
values increase detail until the swirl effect disappears. Values are in whole
numbers. Range=0 to 10; Default=4.

Swirl Location group

Center Position X and Y Adjusts the location of the swirl’s center on the
object.

Lock X and Y values remain identical as you adjust them. By turning off Lock
and adjusting either the X or Y position, you can “slide” the swirl effect across
the object. Default=on.

Configuration group

Random Seed Sets a new starting point for the swirl effect. Changes the swirl
pattern while maintaining other parameters. Range=0 to 65,535; No default.

Tiles Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Tiles
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Tiles used for the walls of a house

Using the Tiles procedural map, you can create brick or stacked tiling of colors
or material mappings. There are commonly defined architectural brick patterns
available, or you can design custom patterns. With the Tiles map, you can:

■ Assign many of the maps available through the Material Editor.

■ Load textures and use colors in the pattern.

■ Control the number of tiles in columns and rows.

■ Control the size of the grout gap and its roughness.

■ Apply random variance in the pattern.

■ Control the stacking layout by shifting how the tiles line up.

See also:

■ Coordinates Rollout (2D) on page 5782

■ Noise Rollout (2D) on page 5793
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Procedures

Example: To create a brick wall:

1 Create a wall using a Box primitive, or use an existing surface in one of
your scenes.

2  Open the Material Editor on page 5284. Select an unused sample slot.

3 Click the Maps rollout to open it. Click the Map button for Diffuse to
display the Material/Map Browser.

4 In the map list, select Tiles, then click OK.

The Tiles map is now assigned to the sample slot. On the Material Editor,
you see new rollouts appear for this map.

5 On the Standard Controls rollout, use Preset Type to select the type of
tiles for the wall. Stack Bond is the default.

6  On the Material Editor toolbar, click Assign Material To
Selection to apply the tile map to the wall. Then click Show Map In
Viewport to see the applied map.

7 Open the Advanced Controls rollout. Under Tiles Setup, adjust Horizontal
and Vertical Count. The default is eight rows high, with three repeats of
the pattern in each row. Visually scale the size of the tiles to your scene.
Also adjust Texture as well as Color and Fade Variance to fine-tune the
appearance of the tiles.

8 Under Grout Setup, adjust parameters for the texture of the grout, gap
spacing between tiles, and roughness of the grout. You can also create
missing bricks in the map by setting % Holes to a value above 0.

9 Under Miscellaneous, you can vary the color of the tiles by using the
Random Seed option.

Example: To match the tiles on the top and side of a wall:

1 Select a wall mapped with tile.

2 On the Modify panel, choose Editable Mesh.

3 Turn on Sub-Object > Face.

4 Select the top face of the wall.
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5 Open the Material Editor. Drag the wall’s tile material to an unused sample
slot to duplicate the material.

6 Under Tiles Setup, adjust the horizontal and vertical count of the new
material to match the side of the wall.

7 Apply the new tile material to the selected faces on the top of the wall.

8 Under Stacking Layout, align the tiles by using the Line Shift option.

Interface

Standard Controls rollout

Preset Type Lists the commonly defined architectural tile bonds, or patterns,
plus a custom pattern, which you design by selecting options under the
Advanced Controls and Stacking Layout rollouts. The following illustrations
show some of the different bonds:

Common Flemish
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Fine Running

Fine Stack

1/2 Running
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Running

Stack
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Advanced Controls rollout

Show Texture Swatches Updates to show the texture assigned by a map for
Tiles or Grout.
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Tiles Setup group

Texture Controls the display of the current texture map for the tiles. When
on, the texture is used as the tile pattern instead of the color swatch. When
turned off, the color of the tiles is displayed; clicking the color swatch displays
the Color Selector on page 391.

None Acts as a target where you drag and drop maps for the tiles. When you
click this button with a map assigned, the software displays the rollout for
the map. You return this button to None (removing the assigned map) by
dragging and dropping a None map from the Map/Material Browser.

Horiz. Count Controls the number of tiles in a row.

Vert. Count Controls the number of tiles in a column.

Color Variance Controls the color variation among the tiles.

Fade Variance Controls the fading variation among the tiles.

Grout Setup group

Texture Controls the display of the current texture map for the grout. When
on, the texture is used as the grout pattern instead of the color swatch. When
off, the color of the grout is displayed, and clicking the color swatch displays
the Color Selector on page 391.

None Acts as a target where you drag and drop maps for the grout. When you
click this button with a map assigned, the software displays the rollout for
the map. You return this button to None (removing the assigned map) by
dragging and dropping a None map from the Map/Material Browser.

Horizontal Gap Controls the horizontal size of the grout between the tiles.
This value is locked by default to the vertical gap, so that both values change
as you edit one or the other. To unlock them, click the lock icon.

Vertical Gap Controls the vertical size of the grout between the tiles. This
value is locked by default to the horizontal gap, so that both values change
as you edit one or the other. To unlock them, click the lock icon.

% Holes Sets the percentage of holes in the tiled surface caused by missing
tiles. The grout shows through the holes.

Rough Controls the roughness of the edges of the grout.
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Miscellaneous group

Random Seed Randomly applies patterns of color variation to the tiles. Does
not require any other setting to generate completely different patterns.

Swap Texture Entries Swaps the texture maps or colors between the tiles and
the grout.

Stacking Layout group

NOTE This group of controls is active only when Custom Tiles is selected in
Standard Controls rollout > Pattern Setup > Preset Type.

Line Shift Shifts every second row of tiles a distance of one unit.

Random Shift Randomly shifts all rows of tiles a distance of one unit.

Row and Column Editing group

NOTE This group of controls is enabled only when Custom Tiles is selected in
Standard Controls rollout > Pattern Setup > Preset Type.

Row Modify When on, creates a custom pattern for rows, based on the values
of Per Row and Change. Default=off.

■ Per Row Specifies which rows to change. When Per Row equals 0, no
rows change. When Per Row equals 1, every row changes. When Per Row
is a value greater than 1, the change appears every N rows: a value of 2
changes every second row, a value of three changes every third row, and
so on. Default=2.

■ Change Changes the width of tiles in the affected rows. A value of 1.0
is the default tile width. Values greater than 1.0 increase the width of tiles,
and values less than 1.0 decrease it. Range=0.0 to 5.0. Default=1.0.
A value of 0.0 is a special case: When the Change value is 0.0, no tiles
appears in that row, and the underlying material shows through.

Column Modify When on, creates a custom pattern for columns, based on
the values of Per Column and Change. Default=off.

■ Per Column Specifies which columns to change. When Per Column
equals 0, no columns change. When Per Column equals 1, every column
changes. When Per Column is a value greater than 1, the change appears
every N columns: a value of 2 changes every second column, a value of
three changes every third column and so on. Default=2.
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■ Change Changes the height of tiles in the affected columns. A value of
1.0 is the default tile height. Values greater than 1.0 increase the height
of tiles, and values less than 1.0 decrease it. Range=0.0 to 5.0. Default=1.0.
A value of 0.0 is a special case: When the Change value is 0.0, no tile
appears in that column, and the underlying material shows through.

3D Maps

3D maps are patterns generated procedurally in three dimensions. For example,
Marble has a grain that goes through the assigned geometry. If you cut away
part of an object with marble assigned as its texture, the grain in the cutaway
portion matches the grain on the object's exterior. The following 3D maps
are available in 3ds Max:

Cellular on page 5862: Generates a cellular pattern that's useful for a variety of
visual effects, including mosaic tiling, pebbled surfaces, and ocean surfaces.

Dent on page 5869: Generates three-dimensional bumps over a surface.

Falloff on page 5877: Generates a value from white to black based on the angular
falloff of the face normals on the surface of the geometry. The Falloff map
provides greater flexibility when creating opacity falloff effects. Other effects
include Shadow/Light, Distance Blend, and Fresnel.

Marble on page 5883: Simulates the grain of marble with two explicit colors and
a third intermediate color.

Noise on page 5886: Noise is a turbulence pattern in three dimensions. Like
Checker in 2D, it is based on two colors, either of which can be mapped.

Particle Age on page 5889: Alters the color (or map) of a particle based on the
particle's life.

Particle MBlur on page 5891: (MBlur is short for Motion Blur.) Alters the opacity
of the leading and trailing ends of particles based on their rate of movement.

Perlin Marble on page 5893: An alternative, procedural marble map with a
turbulence pattern.

Planet on page 5896: Simulates the contours of a planet as seen from space.

Smoke on page 5898: Generates fractal-based turbulence patterns to simulate
the effects of smoke in a beam of light, or other cloudy, flowing mapping
effects.

Speckle on page 5901: Generates a speckled surface for creating patterned surfaces
that can simulate granite and similar materials.
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Splat on page 5902: Generates a fractal pattern similar to splattered paint.

Stucco on page 5904: Generates a fractal pattern similar to stucco.

Waves on page 5907: Creates watery or wavy effects by generating a number of
spherical wave centers and randomly distributing them.

Wood on page 5909: Creates a 3D wood grain pattern.

Coordinates Rollout (3D)

Material Editor > Select sample slot. > Get Material > Material/Map Browser >
Turn on 3D Maps. > Double-click a map type to apply it to sample slot. >
Coordinates rollout is displayed in Material Editor.

By adjusting coordinate parameters, you can move a map relative to the volume
of the object to which it is applied.

Interface

Source Chooses the coordinate system to use. There are four options:

■ Object XYZ Uses the object’s local coordinate system.

■ World XYZ Uses the scene’s world coordinate system.

■ Explicit Map Channel Activates the Map Channel field. You can choose
any channel from 1 to 99.
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■ Vertex Color Channel Assigns vertex colors as a channel. See Editable
Mesh on page 2075 for details on assigning vertex color.
See also Vertex Color Map on page 5943.

When one of the map channels is set, it locks the map into position on the
vertices of the object so that the map "sticks" to the object as it deforms during
animation.

When an object is deforming through its own local space (for example, when
it is bending or twisting), the object appears to move through the map, because
it passes through the XYZ coordinates of the 3D texture.

Map Channel Unavailable unless the source is Explicit Map Channel. When
available, you can choose any channel from 1 to 99.

Offset Moves the map pattern along the specified axis.

Tiling Tiles on page 8148 the map pattern along the specified axis and makes
the pattern narrower.

Angle Rotates the map pattern along the specified axis.

Blur Affects the sharpness or blurriness of the map based on its distance from
the view. The farther away the map is, the greater the blurring. The Blur value
blurs maps in world space. Blur is primarily used to avoid aliasing on page 7904.

Blur Offset Affects the sharpness or blurriness of the map without regard to
its distance from the view. Blur Offset blurs the image itself in object space.
Use when you want to soften or defocus the details in a map to achieve the
effect of a blurred image.

Cellular Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Cellular
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Cellular maps create the goblet textures.

The Cellular procedural map generates a pattern that's useful for a variety of
visual effects, including mosaic tiling, pebbled surfaces, and even ocean
surfaces.

TIP The Material Editor sample slot doesn't show the cellular effect very clearly.
For a better visual aid to getting the effect you want, assign the map to geometry
and render the scene.

See also:

■ Coordinates Rollout (3D) on page 5861

■ Output Rollout on page 5774

Procedures

Example: To create confetti:

1 Assign the Cellular map as a Diffuse map.

2 Set the parameters as follows:
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Cell Color (use RGB values after clicking color swatch): 202, 75, 171

Variation: 55

Division Colors (use RGB values after clicking the color swatch):

■ First: 127, 150, 197

■ Second: 0, 119, 163

Cell Characteristics:

■ Circular

■ Size: 2.4

■ Spread: 0.43

■ Fractal: off

Thresholds:

■ Low: 0.19

■ Mid: 0.65

■ High: 0.86

Example: To create alien skin:

1 Assign the Cellular map as a Diffuse map.

2 Set the parameters as follows:

Cell Color (use RGB values after clicking the color swatch): 52, 107, 58

Variation: 0.0

Division Colors (use RGB values after clicking the color swatch):

■ First: 112, 119, 64

■ Second: 143, 137, 112

Cell Characteristics:

■ Circular

■ Size: 7.9

■ Spread: 0.61

■ Fractal: on
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■ Iterations: 2.0

Thresholds:

■ Low: 0.17

■ Mid: 0.64

■ High: 1.0

3 Copy the Diffuse map to the Bump map.

If you increase the Bump amount, increase the Cellular bump map's
Bump Smoothing value as well.

Example: To create a tile mosaic:

1 Assign the Cellular map as a Diffuse map.

2 Set the parameters as follows:

Cell Color (use RGB values after clicking the color swatch): 141, 120, 87

Variation: 54

Division Colors (use RGB values after clicking the color swatch):

■ First: 128, 128, 128

■ Second: 221, 221, 221

Cell Characteristics:

■ Chips

■ Size: 7.0

■ Spread: 0.35

■ Fractal: off

Thresholds:

■ Low: 0.42

■ Mid: 0.76

■ High: 1.0

3 Assign a Mix map as the Bump map.
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4 Click Material/Map Navigator to display the Navigator. Copy the Cellular
Diffuse map by dragging it from the Navigator to the Color #2 map
window of the Mix map.

5 A dialog is displayed. You are asked if this should be an instance or a
copy. Select Copy and click OK.

6 Assign a Noise map to the Color #1 map window of the Mix map.

7 Set the Noise parameters as follows:

Noise Type: Fractal

Levels: 6.0

Size: 9.3

8 In the Mix Parameters rollout of the Mix map, set the Mix Amount to
0.5.

9 Go to top level of the material. In the Maps rollout, set Bump Amount
to 82.

5866 | Chapter 19   Material Editor, Materials, and Maps



Interface

Cell Color group

These controls specify the color of the cells.

Color swatch Displays the Color Selector on page 391. Choose a color for the
cells.

Map button Assigns a map to the cells, rather than a solid color.
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Check box When on, enables the map. When off, disables the map (cell color
reverts to the color swatch).

Variation Varies the color of the cells by randomly altering RGB values. The
higher the variation, the greater the random effect. This percentage value can
range from 0 to 100. At 0, the color swatch or the map completely determines
the cell color. Default=0.

Division Colors group

These controls specify the color of the divisions between cells. Cell divisions
are a ramp between two colors or two maps.

Color swatches Display the Color Selector for choosing a cell division color.

Map buttons Assigns a map to one of the cell division colors.

Check boxes When on, enables the associated map. When off, disables the
associated map (the division color reverts to the color swatch).

Cell Characteristics group

These controls change the shape and size of the cells.

Circular/Chips Lets you choose how cell edges look. With Circular, the cells
are circular. This gives a more organic, or bubbly look. With Chips, the cells
have linear edges. This gives a more chipped or mosaic appearance.
Default=Circular.

Size Alters the overall scale of the map. Adjust this value to fit the map to
your geometry. Default=5.0.

Spread Alters the size of individual cells. Default=0.5.

Bump Smoothing When you use a cellular map as a bump map on page 5478,
you might encounter aliasing or jagginess at the boundaries of the cells. If
this occurs, increase this value. Default=0.1.

Fractal Defines the cellular pattern as a fractal, thus enabling the three
following additional parameters. Default=off.

Iterations Sets the number of times the fractal function is applied. Caution:
Increasing this value increases rendering time. Default=3.0.

Adaptive When on, the number of fractal iterations is set adaptively. That is,
the number of iterations increases the closer the geometry is to the scene's
point of view, and decreases in the distance. This reduces aliasing and also
saves time while rendering. Default=on.
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Roughness When you use the Cellular map as a bump map on page 5478, this
parameter controls how rough the bumps are. When Roughness is zero, each
iteration is half the strength of the previous iteration, and half the size. As
Roughness increases, each iteration is closer in strength and size to the previous
iteration. When Roughness is at its maximum value of 1.0, each iteration is
the same size and strength as the previous. In effect, this turns off the
fractalization. Roughness has no effect unless Iterations is greater than 1.0.
Default=0.0.

Thresholds group

These controls affect the relative size of cells and divisions. They are expressed
as normalized percentages (0 to 1) of the sizes specified by the default
algorithm.

Low Adjusts the size of the cells. Default=0.0.

Mid Adjusts the size of the first division color, relative to the second.
Default=0.5.

High Adjusts the overall size of divisions. Default=1.0.

Dent Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Dent
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Dent map gives texture to the cup on the left; cup on the right has same pattern, but
without dents.

Dent is a 3D procedural map. During scanline rendering, Dent creates a random
pattern based on fractal noise. The effect of the pattern depends on the map
type.

Effect of default parameters

Defaults: Iterations=2, Size=200, Strength=20

Dent was designed to be used primarily as a bump map, and its default
parameters are optimized for this usage. As a bump map, Dent renders
three-dimensional dents over the surface of an object. Editable parameters
control the size, depth, and complexity of the denting effect.

5870 | Chapter 19   Material Editor, Materials, and Maps



Dent can also be used with other maps. With a diffuse color map, for example,
the two colors assigned to Dent mix in random swirls over the surface of the
object. Either of the colors can be replaced by other maps.

Dent bump maps

At left, default parameters produce fairly uniform dents over surface.

At right, increased Strength parameter creates a deeper and more irregular pitting
effect.

Dent diffuse maps

At left, Dent as a two-color diffuse map.

At right, colors replaced with Dent and Marble maps.

See also:

■ Coordinates Rollout (3D) on page 5861

Procedures

To make a Dent map:

1 In the Material Editor, click a sample slot to make it active.

2 Open the Maps rollout.

3 Click Bump or other map button to display the Material/Map Browser.

4 Double-click Dent in the list of map types.

The Material Editor displays the Coordinates and Dent Parameters rollouts.

5 Set parameters on the Dent Parameters rollout.
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The active sample slot updates to show the Dent effect.

To replace a color:

1 Click a color swatch labeled Color #1 or Color #2.

2 In the standard Color Selector on page 391, choose a replacement color.

The color updates in the color box and sample slot.

To swap a color:

■ Click Swap.
The position of the two colors is reversed in the color boxes and sample
slot.

To replace a color with a map:

1 Click a Map bar marked None next to one of the color swatches.

The Material/Map Browser is displayed.

2 Select a map from the list.

The sample slot updates to show the map in place of the color.

Interface

Size Sets the relative size of dents. As the size increases, the number of dents
decreases when other settings are the same. Default=200.

Decreasing Size creates the appearance of tiny dents spaced fairly evenly. The
effect can resemble a "sand-covered" surface.
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Increasing Size creates the appearance of distinct grooves and gouges on a
surface. The effect sometimes has a "hardened lava" look.

Size=10, 500, and 1000

Iterations=1, Strength=20 (default)

Size=10, 500, and 1000

Iterations=3, Strength=20 (default)

Each set of three spheres uses the same size range, but varies the number of
iterations. Strength is held constant in both sets.

Strength Determines the relative coverage of the two colors. Higher values
increase the coverage of Color #2, while lower values increase the coverage of
Color #1. Default=20.

When using Dent as a bump map, increasing the Strength value typically
makes the dents look deeper.

In the following illustrations, each set of three spheres uses the same Strength
range, but varies the Size value between the two sets. The Iterations value is
the same in both sets.
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Size=10, Iterations=3

Strength=5, 20 (default), and 100

Size=1000, Iterations=3

Strength=5, 20 (default), and 100

Iterations Sets the number of calculations used to create the dents. Default=2.

Dent is based on a fractal-noise equation. During rendering, a dented surface
is calculated one or more times to produce the finished effect. Each calculation
pass is an iteration.

As a surface is calculated, each iteration adds to the number of dents and the
complexity and randomness of the final surface (dents become dented).

The Dent texture requires heavy calculation, especially at higher iterations.
This can slow down rendering time considerably.

Iterations=1, 3, and 6

Size=500, Strength=20
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The three spheres have uniform settings for size and strength. Only the number
of iterations varies.

Swap Reverses the position of colors or maps.

Colors Allows choice of two colors where appropriate for a color component
(such as Diffuse). Defaults=black for Color #1 and white for Color #2.

Dent can create patterns in an object's color as well as its surface. By using
Dent as a diffuse color map, the entire surface is affected.

Size=500, Strength=60

Iterations=2

Two colors are mixed to produce a random pattern, governed by size, strength,
and iteration settings. The default colors are black and white, but either can
be replaced or swapped.

Left sphere: Sets the color to black and white.

Middle sphere: Replaces white with red.

Right sphere: Swap black and red.

By adjusting Strength, Size, and Iterations parameters, you vary the Dent
patterns on a diffuse color map.

■ Size sets the density of the dent pattern. At low settings, the pattern is
dense. As Size increases with other settings held constant, the pattern
becomes increasingly sparse.

■ Strength sets the color strength in the dent pattern. At low settings, Color
#1 (black) dominates the pattern. As Strength increases, Color #2 (white)
replaces Color #1.

■ Iterations sets the color iterations in the dent pattern. At low settings,
Color #1 is dominant. As iterations increase, Color #2 gradually increases
in the pattern.

Dent is applied as a diffuse map in the following examples. Colors are default
black and white.
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Size=100, 500, and 1000

Strength=20, Iterations=2

Color #1, #2=black, white (defaults)

Strength=20, 50, and 100

Size=500, Iterations=2

Iterations=2, 4, and 8

Size=500, Strength=20

Maps Replaces colors with maps in the dent pattern. The check boxes enable
or disable their associated map.

You can assign maps to one or both of the Dent color slots. Any kind of map
can be used, including Dent. The map overrides the assigned color, which has
no effect.

In the three spheres below, the assigned colors are progressively replaced with
maps. Parameters of the original Dent map are the same for all spheres.
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Size=500, Strength=60, Iterations=2

Left sphere: Applies Dent as a diffuse map. Color #1 is black; Color #2 is red.

Middle sphere: Replaces black with Dent map (all defaults).

Right sphere: Replaces red with Marble map (all defaults).

Falloff Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Falloff

Falloff map creates the appearance of translucency.
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The Falloff map generates a value from white to black, based on the angular
falloff of the face normals on the surface of the geometry. The direction used
to specify the angular falloff varies, depending on the methods you choose.
However, with the default settings, the map generates white on faces whose
normals point outward from the current view, and black on faces whose
normals are parallel to the current view.

Falloff map provides a greater variety of opacity falloff effects than those in
the Falloff settings in a standard material's Extended Parameters rollout on
page 5408. You assign the Falloff map as an opacity map on page 5470. However,
you can also use Falloff for special effects, such as an iridescent look.

NOTE When old files that use Falloff maps are brought into 3ds Max, the old
Falloff interface is displayed, replacing the new Falloff interface.

See also:

■ For functionality shared with other 3D maps, see Output Rollout on page
5774

Procedure

To control opacity using a Falloff map:

1 Assign the Falloff map as an opacity map.

2 Render to see the effect.

3 Adjust the falloff parameters to vary the effect.
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Interface

Falloff Parameters rollout

Front : Side By default, "Front : Side" is the name of the group at the top of
this rollout. Front : Side indicates Perpendicular/Parallel falloff. This name
changes depending on the falloff type selected. In all cases, the name on the
left refers to the top set of controls, and the name on the right to the bottom
set.

The controls are as follows:

■ Click the color swatches to assign colors.

■ Use the numeric fields and spinners to adjust the relative strength of the
colors.
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■ Click the buttons marked None to assign maps.

■ Turn on the check boxes to activate the maps; otherwise the colors are
used. These are on by default.

■  Click Swap Colors/Maps (the curved arrow) to exchange the
assignments.

Falloff Type Chooses the kind of falloff. Five options are available:

■ Perpendicular/Parallel Sets the angular falloff ranges between face normals
that are perpendicular to the falloff direction and normals that are parallel
to the falloff direction. The falloff range is based on a 90-degree change in
face normal direction. (Default.)

■ Towards/Away Sets the angular falloff ranges between face normals that
face toward (parallel to) the falloff direction and normals that face away
from the falloff direction. The falloff range is based on a 180-degree change
in face normal direction.

■ Fresnel Based on adjustments to the Index of Refraction (IOR). Results
in dim reflections on surfaces facing the view, with much brighter
reflections on angled faces, creating highlights like those on the sides of
a glass.

■ Shadow/Light Adjusts between two subtextures based on how much
light is falling on the object.

■ Distance Blend Adjusts between two subtextures based on Near Distance
and Far Distance values. Uses include reducing aliasing on large terrain
objects and controlling the shading in non-photorealistic environments.

Falloff Direction Chooses the direction of falloff. Five options are available:

■ Viewing Direction (Camera Z-Axis) Sets the falloff direction relative to
the camera (or screen). Changing object orientation doesn't affect the
falloff map. (Default.)

■ Camera X/Y Axis Similar to Camera Z-Axis. For example, using Camera
X-Axis with the Toward/Away falloff type runs the gradient from left
(Toward) to right (Away).

■ Object Uses an object whose position determines the falloff direction.
Click the wide button next to Object in the Mode Specific Parameters
group, and then pick an object in the scene. The falloff direction is the
direction from the point being shaded toward the object's center. Points
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on the side toward the object center get the Towards value, and those away
from the object get the Away value.

■ Local X/Y/Z Axis Sets the falloff direction to one of the object's local axes.
Changing the orientation of the object changes the falloff direction.

■ World X/Y/Z Axis Sets the falloff direction to one of the world coordinate
system axes. Changing object orientation doesn't affect the falloff map.

When no object is chosen, the falloff direction uses the local X, Y, or Z axis
of the object being shaded.

Mode Specific Parameters group

The first parameter applies and is available only when you set Falloff Direction
on page 5880 to Object:

Object Picks object from scene and puts its name on the button.

The following are parameters for the Fresnel falloff type:

Override Material IOR Allows change to the Index of Refraction set by the
material.

Index of Refraction Sets a new Index of Refraction. This option is unavailable
unless Override Material IOR is turned on.

The following are parameters for the Distance Blend falloff type:

Near Distance Sets the distance at which the blend effect begins.

Far Distance Sets the distance at which the blend effect ends.

Extrapolate When on, the effect continues beyond the Near and Far distances.
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Mix Curve rollout

Using the graph on the Mix Curve rollout, you can precisely control the
gradient produced by any falloff type. You see the resulting gradient in the
bar below the graph.

Move flyout

 Moves a selected point in any direction, limited by the unselected points
on either side.

 Constrains movement to the horizontal.

 Constrains movement to the vertical.

 Scale Point Scales the selected point within the range of its gradient.
On a Bezier corner point, this control is effectively the same as a vertical move.
On a Bezier smooth point, you can scale the point itself or either handle. As
with the move controls, scale is limited by the unselected points on either
side.
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Add Point flyout

 Adds a Bezier corner point anywhere on the graph line. The point makes
a sharp angle when moved.

 Adds a Bezier smooth point anywhere on the graph line. Handles attached
to the point create smooth curves when moved. On a Bezier smooth point,
you can move the point or either handle.

 Delete Point Removes selected points.

 Reset Curves Returns graph to its default, a straight line between 0 and
1.

Marble Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Marble
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Marble map used for the balusters

The Marble map produces a marbled surface with colored veins against a
colored background. A third color is automatically generated.

NOTE Another way to create marble is to use the Perlin Marble Map on page 5893.

See also:

■ For functionality shared with other 3D maps, see Coordinates Rollout (3D)
on page 5861.

Procedures

To create a Marble map:

1 Click a map button to assign a map.

2 Choose Marble in the Material/Map Browser, and then click OK.
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To adjust the size of Marble veins:

■ In the Marble Parameters rollout, change the Size value to change the
overall scale of the vein pattern, and change Vein Width to change the
width of veins relative to the overall scale.
The larger the Size value, the wider the veins. The larger the Vein Width
value, the more veins appear relative to the overall pattern.

To change vein color:

1 In the Marble Parameters rollout, click a color swatch to display the Color
Selector on page 391.

2 Adjust the color.

3 Click Close to dismiss the dialog.

To use a map for a vein:

■ In the Marble Parameters rollout, click a map button to assign a map to a
color.

To swap the two vein colors:

■ In the Marble Parameters rollout, click Swap.

To adjust mapping coordinates:

■ In the Coordinates rollout, adjust Offset, Tiling, or Angle.

Interface

Size Sets the spacing between the veins.
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Vein Width Sets the width of the veins.

Swap Switches the position of the two colors or maps.

Color # 1 and Color # 2 Displays the Color Selector on page 391. Select one
color for the veins (color 1) and another for the background (color 2). A third
color is generated from the two colors you select.

Maps Selects the bitmaps or procedural maps on page 8097 to appear in the
veins or in the background color.

Turn on the check boxes to make the maps active.

Noise Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Noise

Noise map used for the edges of the street

The Noise map creates random perturbation of a surface based on the
interaction of two colors or materials.
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See also:

■ Coordinates Rollout (3D) on page 5861

■ Output Rollout on page 5774

Procedures

To change a component color:

1 In the Noise Parameters rollout, click a color swatch to display the Color
Selector on page 391.

2 Adjust the color.

3 Click OK to dismiss the dialog.

To use a map for a component:

■ In the Noise Parameters rollout, click a map button to assign a map to a
color.

To swap the two component colors:

■ In the Noise Parameters rollout, click Swap.

To adjust mapping coordinates:

■ In the Coordinates rollout, adjust Offset, Tiling, or Angle.

Interface

NOTE For the Noise map, the tiling and mirroring controls are disabled in the
Texture Tiling And Output rollout.
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Noise Type

■ Regular (The default.) Generates plain noise. Basically the same as fractal
noise with the Levels setting at 1. When the noise type is set to Regular,
the Levels spinner is inactive (because Regular is not a fractal function).

■ Fractal Generates noise using a fractal algorithm. The Levels option sets
the number of iterations for the fractal noise.

■ Turbulence Generates fractal noise with an absolute value function
applied to it to make fault lines.

Regular, Fractal, Turbulence

Size Sets the scale of the noise function, in 3ds Max units. Default=25.0.

Noise Threshold When the noise value is above the Low threshold and below
the High threshold, the dynamic range is stretched to fill 0 to 1. This creates
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a smaller discontinuity (technically, 1st order instead of 0 order) at the
threshold transition and produces less potential aliasing on page 7904.

■ High Sets the high threshold. Default=1.0.

■ Low Sets the low threshold. Default=0.0.

Levels Determines how much fractal energy is used for the Fractal and
Turbulence noise functions. You can set the exact amount of turbulence you
want, and also animate the number of fractal levels. Default=3.0.

Phase Controls the speed of the animation of the noise function. Use this
option to animate the noise function. Default=0.0.

Swap Switches the position of the two colors or maps.

Color # 1 and Color # 2 Display the Color Selector on page 391 so you can
choose one or the other of the two principal noise colors. Intermediate color
values are generated from the two colors you select.

Maps Select the bitmaps or procedural maps to appear in one or the other
noise color.

Turn on the check boxes to make the maps active.

Particle Age Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Particle Age
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Particle age changes the appearance of particles over time.

The Particle Age map is for use with particle systems on page 8083. Typically
you assign the Particle Age map as a Diffuse map on page 5460, or in Particle
Flow with the Material Dynamic operator on page 2925. It alters the color (or
map) of a particle based on the particle's life. The particles in a system begin
as one color. At a specified age, they begin changing (by interpolation) to a
second color, and then they change again to a third color before they die out.

TIP This map works well with the Particle MBlur map on page 5891. For example,
you could assign Particle Age as a diffuse map on page 5460 and Particle MBlur as
an Opacity map on page 5470. Another way to use Particle Age is in the mask channel
of a Blend on page 5708 material. In this case, you could set up two of the colors to
white, and one to black, which would make the particles change materials over
their age. In addition, you could set up one of the two materials with an effects
channel on page 7991 and use a Glow on page 6857 filter on it through Video Post.

See also:

■ For functionality shared with other 3D maps, see Output Rollout on page
5774.
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Interface

Color #1 Sets the color of a particle at its birth.

Click the button to the right of the color swatch to assign a map instead of a
solid color. The check box turns the map on or off.

Age #1 Sets the age where a particle starts changing from Color #1 to Color
#2, expressed as a percentage of the particle's entire life.

Color #2 Sets the color of a particle in mid-life. You can also assign a map to
this color.

Age #2 Sets the age where a particle's color equals Color #2, expressed as a
percentage of the particle's entire life.

Color #3 Sets the color of a particle at its death. You can also assign a map to
this color.

Age #3 Sets the age where a particle changes to Color #3, expressed as a
percentage of the particle's entire life.

Particle MBlur Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Particle MBlur
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Particle MBlur makes particles blur as they move.

The Particle MBlur (Motion Blur) map is for use with particle systems on page
8083. The map alters the opacity of the leading and trailing ends of particles
based on their rate of motion. The map is usually applied as an opacity map,
but you can use it as a diffuse map for special effects.

The following conditions must be in effect to achieve particle motion blur:

■ The Particle MBlur map must be in the same material that is assigned to
the particles. For best results, it should be assigned as an opacity map

■ The particle system must support the Particle MBlur map. Particle systems
that support Particle MBlur include PArray, PCloud, Super Spray, and Spray.

■ In the particle system's Particle Rotation rollout, in the Spin Axis Controls
group, the Direction of Travel/MBlur option must be on.

■ In this same group, the Stretch spinner must be greater than 0 to stretch
the particles as a percent of their length based on the particle Speed setting.

■ The correct type of particle must be used. MBlur works on all particle types
except Constant, Facing, Metaparticles, and PArray Object Fragments. Also,
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in the Standard Particles category, MBlur does not support the Triangle
and SixPoint particle types.

■ The material assigned to the particle system must not be a Multi/Sub-Object
material.

Interface

Color #1 A particle approaches this color as it reaches its slowest speed. By
default, this color is white to provide the opaque end of the range for an
opacity map.

Color #2 A particle approaches this color as it speeds up. As a default, this
color is black to provide transparency in an opacity map.

Typically, you don't need to change either of these two colors.

Sharpness Controls the transparency, relative to the speed. If Sharpness is set
to 0, the entire particle is blurry and transparent, no matter how slow it is
traveling. The default works well in many cases. Default=2.0.

Perlin Marble Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Perlin Marble
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Perlin marble used for the texture of the goblet

The Perlin Marble map generates a marble pattern using the Perline Turbulence
algorithm. This map is an alternative to Marble on page 5883, which is also a
3D material.

See also:

■ Coordinates Rollout (3D) on page 5861
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Interface

Size Sets the size of the marble pattern. Change this to change the scale of
marble, relative to the object's geometry. Default=50.

Levels Sets the number of times the turbulence algorithm is applied. Can
range from 1.0 to 10.0. The higher the value, the more complicated the marble
pattern. Default=8.0.

Color 1 and Color 2 groups

The controls in these groups are identical. They determine the two main colors
of the marble.

Color swatch Click to display the Color Selector on page 391. and change the
color.

Map Click to assign a map instead of a solid color. The check box turns the
map on or off.

Saturation Controls the saturation of the color in the map, without altering
the color displayed in the color swatch. Lower values darken the color, and
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higher values lighten it. Range=1 to 100; Default=85 for Color 1, 70 for Color
2.

Swap Click to swap Color 1 and Color 2.

Planet Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Planet

Planet map used to create another world

Planet is a 3D map that uses fractal math to simulate the colors on the surfaces
of a planet. You can control the size of continents, percent of ocean coverage,
and so on. This map is meant to be used as a diffuse map. It does not work
well as a bump map.
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TIP The Material Editor's sample slot doesn't show the planet effect very clearly.
To help get the effect you want, double-click the sample slot to get a larger sample
slot, or assign the map to geometry and render the scene. Another way to preview
the planet map is to use the Material Editor Options dialog on page 5335 to set the
3D Map Sample Scale to equal a main dimension of the object you are applying
the map to. For example, if you want to use the planet map on a sphere with a
radius of 20, change the map scale from 100 (the default) to 20.

See also:

■ Coordinates Rollout (3D) on page 5861

Interface

Continent Size Sets the size of the fractal noise pattern used to generate the
continents. The higher the value, the larger the continents. Default=40.

Island Factor Sets the size of the fractal noise pattern used to generate islands
and mountains. Can range from 0 to 100. At 0, the geography is very low.
Higher settings create a more rugged landscape. Default=0.5.
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Ocean % Sets the percentage of the planet's surface that is covered by water.
Default=60.0.

Random Seed Sets the seed for pseudo-random generation of the pattern.
Changing this number can change the pattern completely, even if other
settings remain the same. On the other hand, a different Planet map with the
same settings including the same Random Seed will appear the same.

Water Colors group

The colors in these three swatches are applied to the water areas of the planet
surface.

Water colors Click a swatch to display the Color Selector on page 391 and
change the color. Color #1 is the "center" area of the water mass, Color #2
surrounds Color #1, and Color #3 surrounds Color #2, meeting the land.

Land Colors group

The colors in these five swatches are applied to the land areas of the planet
surface. Their arrangement continues that of the water colors.

Land colors Click a swatch to display the Color Selector on page 391 and
change the color. Color #4 is the shoreline of the land, meeting the water;
Color #5 comes next, working toward the center of the land mass. Color # 8
is at the center of the land mass.

Blend Water/Land When on, the boundary between water and land is
blended, giving a hazy appearance. When off, the boundary between water
and land is sharp.

Smoke Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Smoke
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Smoke map used to create clouds in the sky

Smoke is a 3D map that generates amorphous, fractal-based turbulent patterns.
It's primarily designed for animated opacity mapping on page 5470 to simulate
the effects of smoke in a beam of light, or other cloudy, flowing mapping
effects.

See also:

■ Coordinates Rollout (3D) on page 5861
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Interface

Size Changes the scale of the smoke "clumps." Default=40.

# Iterations Sets the number of times the fractal function is applied. The
higher the value, the more detail within the smoke, but the longer the
calculation time. Default=5.

Phase Shifts the turbulence within the smoke pattern. Animate this parameter
to animate the movement of the smoke. Default=0.0.

Exponent Makes color #2, representing the smoke, sharper and more wispy.
As this value increases, the smoke "tendrils" become smaller within the pattern.
Default=1.5.

Swap Exchanges the colors.

Color #1 Represents the smokeless portion of the effect.

Color #2 Represents the smoke.

Because this map is usually used as an opacity map, you can adjust the
luminance of the color values to alter the contrast of the smoke effect.

■ Click a color swatch to change the color. Usually you only need to do this
to adjust luminance.

■ Click a map button to assign a map instead of a solid color. Turn on the
check box to activate the map.
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Speckle Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Speckle

Speckle map used for rocks

Speckle is a 3D map that generates a speckled surface pattern that's useful for
diffuse mapping on page 5460 and bump mapping on page 5478 to create
granite-like and other patterned surfaces.

See also:

■ Coordinates Rollout (3D) on page 5861
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Interface

Size Adjusts the size of the speckles. Use this to make the speckles match your
geometry. Default=60.

Swap Exchanges the two color components.

Color #1 Represents the color of the speckles.

Color #2 Represents the color of the background.

Click one of the swatches to display the Color Selector on page 391 and change
one of these component colors.

Maps Click a button to assign a map that replaces one of the color
components. Turning off the check box turns off the associated map (the
Speckle map reverts to the associated color component).

Splat Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Splat
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Splat map used for the patterns in ice cream

Splat is a 3D map that generates a fractal surface pattern that is useful as a
Diffuse map on page 5460 for creating a pattern similar to splattered paint.

See also:

■ Coordinates Rollout (3D) on page 5861
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Interface

Size Adjusts the size of the splats. Use this to make the splats match your
geometry. Default=40.

# Iterations Sets the number of times the fractal function is evaluated. The
higher the number, the more detailed the splats, but the longer the calculation
time. Default=4.

Threshold Determines how much of Color #1 is mixed with Color #2. At 0,
only Color #1 is displayed; at 1, only Color #2 is displayed. Default=0.2.

Swap Exchanges the two color components.

Color #1 Represents the color of the background.

Color #2 Represents the color of the splats.

Click one of the swatches to display the Color Selector on page 391 and change
one of these colors.

Maps Assigns a map to replace one of the color components. Turning off the
check box turns off the associated map (the Splat map reverts to the associated
color component).

Stucco Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Stucco
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Stucco map used for a plaster wall

Stucco is a 3D map that generates a surface pattern that is useful for bump
mapping on page 5478 for creating the effect of a stuccoed surface.

See also:

■ Coordinates Rollout (3D) on page 5861

3D Maps | 5905



Interface

Size Adjusts the size of the indentations. Use this to make the scale of the
stucco match your geometry. Default=20.

Thickness Blurs the border between the two colors. At 0, the borders are sharp.
The higher the Thickness, the more the borders are blurred and the less distinct
the indentations are. When you use Stucco as a bump map, the indentations
are very faint at 0.5 and disappear at values not much greater. Default=0.15.

Threshold Determines how much of Color #1 is mixed with Color #2. At 0,
only Color #2 is displayed; at 1, only Color #1 is displayed. Default=0.57.

Swap Exchanges the two color components.

Color #1 Represents the color of the indentations.

Color #2 Represents the background stucco color.

Click one of the swatches to display the Color Selector on page 391 and change
one of these component colors.

TIP Because the Stucco map is meant to be used as a bump map, usually you
don't need to adjust the default colors.

Maps Assigns a map to replace one of the color components. Turning off the
check box turns off the associated map (the Stucco map reverts to the
associated color component).
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Waves Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Waves

Waves map used for the pool in the fountain

Waves is a 3D map that creates watery or wavy effects. It generates a number
of spherical wave centers and randomly distributes them over a sphere. You
can control the number of wave sets, the amplitude, and the speed of the
waves. This map works effectively as both a diffuse and bump map at the same
time. It can also be useful in combination with an opacity map.
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Interface

Num Wave Sets Specifies how many wave sets are used in the pattern. Wave
sets are groups of radially symmetrical waves that originate from randomly
computed points along the surface of an imaginary sphere inside the object
(a circle, in the case of 2D wave distribution). For calm water, set this to a low
number. Use a high number for choppy water. Range= 1 to 50; Default=10.

Wave Radius Specifies the radius, in 3ds Max units, of the imaginary sphere
(3D distribution) or circle (2D distribution) whose surface is the origin of each
wave set. A large radius produces large circular wave patterns, while a small
radius produces dense, smaller waves. Default=800.

Wave Len Max and Wave Len Min Define the interval used to randomly
chose each wave center. If these two values are close together, the water appears
more regular. If they're farther apart, the water is less regular. Default Max=50.0;
Default Min=5.0.

Amplitude Adjusts the strength and the depth of the waves by increasing the
contrast between the two colors. Default=1.0.

Phase Shifts the wave pattern. Animate this parameter to animate the motion
of the pattern.

Distribution 3D/2D 3D distributes the wave centers on the surface of an
imaginary sphere, affecting all sides of a 3D object. 2D distributes the wave
in circles centered on the XY plane, which is more appropriate for flat water
surfaces such as oceans and lakes.
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Random Number Seed Provides a seed number to generate the water pattern.
The pattern changes with each seed, but all other settings are maintained.

Swap Exchanges the colors.

Color #1 and #2 Click the color swatches to change the colors used in the
pattern. Use one color for the wave troughs and the other for the wave peaks.

You can also click the map buttons to replace one or both colors with a mapped
pattern. The check box enables or disables the map.

Wood Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Wood

Wood map used for the seat of the bench

Wood is a 3D procedural map that renders a wavy grain-like pattern throughout
the volume of an object. You can control the direction, thickness, and
complexity of the grain.
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Wood is primarily intended as a diffuse color map. Two colors assigned to
Wood mix to form the grain pattern. Either of the colors can be replaced by
other maps.

Wood can also be applied to other map types. When used as a bump map,
Wood renders the grain pattern as a three-dimensional engraving of the surface.

Wood mapped to a box and cylinder

Wood used as a bump map

Procedures

To replace a color:

1 Click a color swatch labeled Color #1 or Color #2.

2 In the standard Color Selector on page 391, choose a replacement color.

The color updates in the color box and sample slot.

To exchange colors:

■ Click Swap.
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The position of the two colors is reversed in the color boxes and sample
slot.

To replace a color with a map:

1 Click a Map bar marked None next to one of the color swatches. This
displays the Material/Map Browser.

2 Select a map from the list.

The sample slot updates to show the map in place of the color.

Interface

Coordinates rollout

Tiling Controls grain complexity or "distortion." By increasing this parameter
along a given axis, the grain becomes increasingly compressed and wavy along
that axis. Default=1.0 (X, Y, and Z axes).

Box A shows the default on all three axes. Boxes B and C show progressively
higher Tile settings for the X axis. Increasing Tile on other axes produces
similar effects.
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A: Tile, X axis=1.0 (default)

B: Tile, X axis=4.0

C: Tile, X axis=8.0

Grain Thickness=3

Tile, X axis=4.0 for both

Axial Noise=1 (left), 4 (right)

Grain Thickness=3

By combining Tile with Axial Noise, even greater distortion is possible. The
bottom left box is the same as B, with Tile at 4.0 on the X axis. The bottom
right box adds Axial Noise at 4.0.

Angle Controls grain direction.

Default Grain: Wood is rendered with the grain running along the X axis of
the object. This is illustrated by the left cube below. The default angle is 0 for
X, Y, and Z axes.

Rotated Grain: By rotating the direction of the grain around an axis, you
change the rendered effect. In the right cube, the Y axis is set to 90. This rotates
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the grain direction 90 degrees around the Y axis so that the grain is now
running along the Z axis.

Other Angle Effects: Varying a single angle can create distorted grain effects
(cylinder at left). Varying the three angles by a uniform amount keeps the
grain running parallel through an object (cylinder at right).

Angle=0,0,0 (defaults) and 0,90,0

Radial, Axial Noise=1 (defaults)

Grain Thickness=3

Angle=0,30,0 and 30,30,30

Radial, Axial Noise=1 (defaults)

Grain Thickness=3

(See Coordinates Rollout (3D) on page 5861 for a description of the other
parameters in this rollout.)
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Wood Parameters rollout

Defaults: Grain Thickness=7, Radial Noise=1.0, Axial Noise=1.0

Grain Thickness Sets the relative thickness of the color bands that make up
the grain. Default=7.

The effect of thickness is relative to the context of the object. A grain that
appears unrealistically wide on a small table might be acceptable on a large
overhead beam.

Decreasing Grain Thickness creates grain lines that are closer together. The
effect can resemble the fine grain of slow-growth hardwoods. At 0, grain
disappears, resulting in what can look like composition board made from
sawdust.

Increasing Grain Thickness creates grain lines that are farther apart. The effect
can resemble tropical woods that grow continuously.

Grain thickness is shown increasing with identical noise settings.
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Grain Thickness=1, 3

Radial, Axial Noise=1 (defaults)

Grain Thickness=7 (default), 14

Radial, Axial Noise=1 (defaults)

Radial Noise Sets the relative randomness of the pattern on a plane
perpendicular to the grain, the circular ring structure (cylinder B). Default=1.0.

Axial Noise Sets the relative randomness of the pattern on a plane parallel
with the grain, along the length of the grain (cylinder A). Default=1.0.

Noise settings let you set the randomness or "irregularity" of the grain pattern
in two directions. Without any noise, rings and grain are uniform and look
inorganic (upper-left cylinder). The defaults for both parameters produce
moderate irregularities (upper-right cylinder).

Radial, Axial Noise=0,0 and 1,1

Angle Y=90, Grain Thickness=3
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A: Radial, Axial Noise=0,2

B: Radial, Axial Noise=2,0

C: Radial, Axial Noise=2,2

Angle Y=90, Grain Thickness=3

Cylinders A and B show each parameter acting alone. Cylinder C shows the
combination of the same settings.

Swap Exchanges the position of the colors.

Colors Selects any two colors for the grain pattern. Defaults=brownish yellow
for Color #1 and dark brown for Color #2. Either color can be replaced or
swapped.

The choice of colors, along with grain pattern, is the primary way to represent
different types of wood. In fairly uniform woods like yellow pine or redwood,
the two colors are often near the same settings (examples B and C). Lighting
also makes a difference in the apparent colors.
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A: Default colors

B: Color #1=RGB 160,125,50

Color #2=RGB 170,135,25

C: Color #1=RGB 140,90,0

Color #2=RGB 130,80,50

Grain Thickness=3

Other settings at defaults

Maps Replace colors with maps. The check boxes enable or disable their
associated maps.

You can assign maps to one or both of the Wood color slots. Any kind of map
can be used, including Wood. The map overrides the assigned color, which
has no effect.

The left box uses defaults. The right box is the same, except that Color #1 has
been replaced with a Checker map, whose colors have been changed to wood
tones.

Left: Default

Right: Color #1 replaced with Checker map
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Grain Thickness=3

Other settings at defaults

Compositor Maps

Compositors are meant specifically for compositing other colors or maps. In
image processing, compositing images refers to superimposing two or more
images to combine them.

The following compositor maps are supplied with the software:

Composite on page 5918: Composites multiple maps. Unlike Mix, Composite
doesn't have explicit controls for the amount of mixing. Instead, it bases the
mix amount on the maps' alpha channel.

Mask on page 5925: A mask is a map itself, used in this case to control where a
second map is applied to the surface.

Mix on page 5926: Mix mixes two colors or two maps. You can adjust the amount
of mixing using a blend level you specify. The blend level can be mapped.

RGB Multiply on page 5930: Combines two maps by multiplying their RGB and
alpha values.

Composite Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Composite
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Composite map combines stars, moon, and a glow into the sky.

The Composite map type is made up of other maps on page 8036, which you
layer atop each other using the alpha channel on page 7905 and other methods.
For this type of map, you can use overlay images that already contain an alpha
channel, or employ built-in masking tools for overlaying only certain parts
of a map.

The controls for a Composite map include the list of the maps it combines
along with a blend mode, opacity setting, and mask for each.

Viewports can display the multiple maps in a composite map. For multiple
map display, the display driver must be OpenGL on page 7796 or Direct3D on
page 7802. The software display driver on page 7794 does not support multiple
map display.
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NOTE  The Composite map in Autodesk 3ds Max 2009 is a completely
revamped version of the previous Composite map, and contains additional
functionality including the ability to apply masks and use color correction on both
maps and masks, and to use blend modes for different methods of combining the
layers.

Procedures

To assign a map or mask:

1 On a Layer rollout, click an empty map or mask button. These are the
large, square buttons labeled “None.” The map button is on the left side;
the mask button is on the right.

The Material/Map Browser opens.

2 Choose a map type either by double-clicking its name in the list, or by
highlighting its name and then clicking OK. Make any further changes
as necessary for the map type, such as assigning an image file for a Bitmap
map.

To change the number of map layers:

■ To increase the number of layers, on the Composite Layers rollout, click

the  button.
The read-only Total Layers numeric field displays the current number of
layers.

■ To decrease the number of layers, find the layer to delete and click its 
(Delete this layer) button.

To change the order of layers:

■ Drag a layer by its title bar to a new location. As you drag the layer, a blue
line appears where it will be repositioned. This works the same way as
reordering any rollouts.
After you move a layer, the layers are renumbered to remain in order. For
example, if there are four layers, and you move Layer 4 above Layer 1,
Layer 4 becomes Layer 2, Layer 2 becomes Layer 3, and Layer 3 becomes
Layer 4.

5920 | Chapter 19   Material Editor, Materials, and Maps



Interface

Composite Layers rollout

Total Layers The numeric field shows the number of map layers. To add a

layer at the top of the stack of layers, click the  button.

Layer rollout

The Composite map uses a separate rollout for each layer’s controls, with as
many rollouts as there are layers. Each layer rollout is titled with the optional
name first, followed by “Layer” and then the layer number.

The layers are applied in order of increasing number; the layering in the
material reflects the order of layers in the interface. Layer 1 is lowest; layer 2
is immediately above layer 1, and so on.

The map composites layers in the same order. Layer 2 modifies the output of
Layer 1; Layer 3 modifies the output of Layer 2, and so on.
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 Hide this layer When on, the layer is hidden and has no effect on the

output. When a layer is hidden, the button looks like this: 

 Color Correct This Texture Applies a Color Correction map on page
5933 to the map and opens the Color Correction map interface. You can use its
controls to modify the map colors.

To return to the Composite map interface, click  (Go To Parent) on
the Material Editor toolbar.

After the Color Correction map is assigned, you can return to it from the
Composite map interface by clicking this button again.

[map] To assign a map to the layer, click this button and then use the
Material/Map Browser.

Before assigning a map, the button reads “None.” When a map is assigned,
the button image is a thumbnail of the map, and clicking it takes you to the
parameters for the map.

 Delete this layer Deletes the layer. This function is undoable.

Available only when the map contains more than one layer.

 Rename this layer Opens a small dialog for naming or renaming the
layer.

By default, each layer is named “Layer #” where # is the layer number. If you
name a layer, the text you enter precedes this default name; for example,
“Decal Layer 3.” The space between the custom name and the default name
is inserted automatically. If you’ve already named a layer, that name appears
in the renaming dialog when you open it.

 Duplicate this layer Creates an exact copy of the layer and inserts it
immediately adjacent to the layer.

Opacity The relative transparency of the unmasked portions of the layer. At
100, the layer is completely opaque. As you lower the Opacity value, more of
the underlying layers show through.
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[mask map] To assign a mask map to the layer, click this button and then
use the Material/Map Browser. The mask works the same as the Mask map on
page 5925: Black areas are transparent; white areas are opaque; and gray areas
allow degrees of transparency. So, for example, if the layer is to be a decal, the
decal image area would be white and the rest of the image map would be
black, so underlying layers can show through.

After a mask map is assigned, the button image is a thumbnail of the map,
and clicking it takes you to the parameters for the map.

 Hide the mask of this layer To turn off the mask temporarily, click

this button. When a mask is hidden, the button looks like this: 

 Color Correct This Mask Applies a Color Correction map on page 5933
to the mask map and opens the Color Correction map interface. You can use
its controls to modify the map colors.

To return to the Composite map interface, click  (Go To Parent) on
the Material Editor toolbar.

After the Color Correction map is assigned, you can return to it from the
Composite map interface by clicking this button again.

[blend mode] Use the drop-down list to choose how the layer pixels interact
with those in underlying layers. In the following descriptions, A refers to the
current (front) layer and B refers to the result or output of underlying layers.

NOTE Because Layer 1 has no underlying layers, its blend mode setting has no
effect.

■ Normal Displays A without any blending. This is the default setting.

■ Average Adds A and B and then divides by 2.

■ Addition Adds each A and B pixel.

■ Subtract Subtracts A from B.

■ Darken Compares the values of A and B, and, for each pixel, uses the
darker of the two.
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■ Multiply Multiplies the color values of each A and B pixel. Because
non-white color channels have values of less than 1.0 (using a range of
0.0 to 1.0), multiplying them tends to darken colors.

■ Color Burn Colorizes darker pixels from B with the color from A.

■ Linear Burn Same as Color Burn but with less contrast.

■ Lighten Compares the A and B pixels at each location and uses the lighter
of the two.

■ Screen Makes the light areas much lighter, and the darker areas somewhat
lighter.

■ Color Dodge Colorizes lighter pixels from B with the A color.

■ Linear Dodge Same as Color Dodge but with lower contrast.

■ Spotlight Like Multiply but with twice the brightness.

■ Spotlight Blend Same as Spotlight but also adds ambient illumination
to B.

■ Overlay Darkens or lightens the pixels depending on the B color.

■ Soft Light If the A color is lighter than mid-gray, the image is lightened.
If the A color is darker than mid-gray, the image is darkened.

■ Hard Light If a pixel color is lighter than mid-gray, screen mode is applied.
If a pixel color is darker than mid-gray, multiply mode is applied.

■ Pinlight Replaces the B colors depending on the brightness of the A color.
If the A color is lighter than mid-gray, B colors darker than the A color are
replaced. And vice-versa: If the A color is darker than mid-gray, B colors
lighter than the A color are replaced.

■ Hard Mix Produces either white or black, depending on similarities
between A and B.

■ Difference For each pixel pair, subtracts the darker one from the brighter
one.

■ Exclusion Similar to Difference but with lower contrast.

■ Hue Uses the color from A; the value (brightness) and saturation from
B.

■ Saturation Uses the saturation from A; the value and hue from B.
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■ Color Uses the hue and saturation from A; the value from B.

■ Value Uses the value from A; the hue and saturation from B.

Mask Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Mask

Mask map applies labels to the fire extinguisher.

With the Mask map, you can view one material through another on the surface.
The mask controls where a second map is applied to the surface.

By default, lighter (whiter) areas of the mask are opaque, showing the map.
Darker (blacker) areas of the mask are transparent, showing the underlying
material. You can use Invert Mask to reverse the mask's effect.
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Interface

These are the controls for the Mask map:

Map Selects or creates the map to be viewed through the mask.

Mask Selects or creates the map to use as a mask.

Invert Mask Inverts the effect of the mask.

Mix Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Mix
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Mix map blends skull and crossbones with the reflected scene.

With the Mix map, you can combine two colors or materials on a single side
of the surface. You can also animate the Mix Amount parameter, and draw
map morphing on page 8049 function curves to control how the two maps are
blended over time.

Viewports can display both maps in a mix map. For multiple map display, the
display driver must be OpenGL on page 7796 or Direct3D on page 7802. The
software display driver on page 7794 does not support multiple map display.

See also:

■ Output Rollout on page 5774

Procedures

To change a component color:

1 In the Mix Parameters rollout, click one of the two color swatches to
display the Color Selector on page 391.

2 Adjust the color.
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To use a map as a component:

1 In the Mix Parameters rollout, click a map button next to one of the two
color swatches.

The Material/Map Browser is displayed.

2 Select a map type.

To exchange the two component colors:

■ In the Mix Parameters rollout, click Swap.

To control the mix amount:

■ In the Mix Parameters rollout, adjust the Mix Amount value.
Mix Amount is the percentage of Color #2 used in the mix.

You can also control the mix amount by using a map.

To control the mix amount using a map:

1 In the Mix Parameters rollout, click the map button next to Mix Amount.

The Browser appears so you can

2 Select a map type.

The intensity of pixels in this mixing map controls the mix. When the
intensity is close to 0, one of the component colors or maps is visible;
when it is close to full intensity, the other component is visible.

TIP Using a Noise map for the mixing map can give good effects that have
a natural appearance.

In the Mix Parameters rollout, Mix Amount is inactive while a map is
assigned to this parameter. If Use Curve is off, the mixing map is used as
is. If Use Curve is on, you can shift the effect of the mixing map's gradient
ramp, offsetting it one way or the other and revealing more or less of the
mix components.

To control the mix amount using the mix curve:

1 In the Mixing Curve group, turn on Use Curve.

2 Change the shape of the curve by adjusting the Transition Zone values.
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Interface

Swap Exchanges the two colors or maps.

Color # 1, Color # 2 Displays the Color Selector on page 391 to select the two
colors to be mixed.

Maps Select or create the bitmaps or procedural maps to be mixed instead of
each color.

The check boxes enable or disable their associated maps.

Black areas of the map reveal color #1, and white areas of the map reveal color
#2. Gray values reveal intermediate mixes.

Mix Amount Determines the proportion of the mix. 0 means only Color 1 is
visible on the surface, 1 means only Color 2 is visible. You can also use a map
instead of the mix amount. The two colors will mix in greater or lesser degree
according to the intensity of the map.
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Mixing Curve group

These parameters control how gradual or how sharp the transition between
the two colors being mixed will be. (This really only has meaning when you
have a map applied to Mix Amount.)

TIP Try mixing two standard materials using a noise map as a mask for some
interesting mottled effects.

Use Curve Determines whether the Mixing Curve effects the mix.

Transition Zone Adjusts the level of the upper and lower limits. If the two
values are the same, the two materials will meet at a definite edge. Wider
ranges give more gradual mixing.

RGB Multiply Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> RGB Multiply
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RGB Multiply enhances the texture of the ashtray.

The RGB Multiply map is typically used for bump maps on page 5478, where
you might want to combine two maps to achieve the correct result.

This map combines two maps by multiplying their RGB values. For each pixel,
the red of one map is multiplied times the red of the second map, the blue
times the blue, and the green times the green.

If the maps have alpha channels, RGB Multiply can output either map's alpha
channel, or a new alpha channel created by multiplying the alpha channel
values of the two maps.

You can also make one of the maps a solid color. This tints the other map.
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Interface

Color #1, Color #2 Click a map button to assign one of the maps. The check
box disables or enables the map. To tint one of the maps, turn off the other
map and click its color swatch to choose the tint color, using the Color Selector
on page 391.

Alpha From group

The buttons in this group let you determine how to generate alpha for the
map. If neither map has an alpha channel, these options have no effect.

Map #1 Uses the first map's alpha channel.

Map #2 Uses the second map's alpha channel.

Multiply Alphas Generates a new alpha channel by multiplying the alpha
channels of the two maps.
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Color Modifier Maps

Color Modifier maps alter the colors of pixels in a material. Each of the
following maps uses a specific method to modify the color:

Color Correction on page 5933: Adjusts colors with a variety of manipulation
methods, using a stack-based approach.

Output on page 5939: Applies bitmap output functions to parametric maps, such
as Checker, that don't have these settings. These functions adjust the colors
of the map.

RGB Tint on page 5942: Tints the color of a map based on red, green, and blue
values.

Vertex Color on page 5943: Displays the effects of assigned vertex colors in the
rendered scene. You assign vertex colors from the editable mesh.

 Color Correction Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Color Correction

The Color Correction map provides an assortment of tools for modifying the
colors of an incorporated, underlying map, using a stack-based method. Tools
for correcting color include monochrome, inversion, custom rewiring of color
channels, hue shift, and adjustment of saturation and lightness.
Color-adjustment controls in many cases mirror those found in Autodesk
Toxik and Autodesk Combustion.
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Interface

IMPORTANT The Color Correction map uses a stack-based approach, with
modifications applied per rollout, starting at the top of the interface and ending
at the bottom. Settings from the Texture rollout are applied first, then the Channels
rollout settings are applied to the output of the Texture rollout, and so on. The
order is:

1 Texture rollout

2 Channels rollout

3 Color rollout

4 Lightness rollout

Because of this enforced order, it is not possible to reorder the rollouts for this
map.
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Texture rollout

[color swatch] The software uses this color if no map is specified. To change
the color, click the swatch and use the Color Selector on page 391 controls.

[map button] To specify a map, click this button, initially labeled “None.”
After you specify a map using the Material/Map Browser on page 5290, the button
label shows the name and type of the map.
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TIP If you replace an existing map with the Color Correction map, the software
prompts you to choose whether to keep the old map as a sub-map. If you do so,
the old map is placed in this slot.

Channels rollout

[channel operation] Choose the initial operation to be performed on the
map color channels:

■ Normal Passes the color channels unaltered to the Color rollout controls.

■ Monochrome Converts all color channels to shades of gray.

■ Invert Replaces the red, green, and blue color channels with their inverses.
The inverse for each channel is calculated by subtracting the value from
the maximum value: 1.0 in the case of floating-point colors, or 255 for
eight-bit channels. So, for example, red changes to cyan (green + blue);
green changes to magenta (red +blue); and blue changes to yellow (red +
green).

■ Custom Lets you apply different settings to each channel using the
remaining controls on the rollout.

TIP You can use one of the preset channel operations
(Normal/Monochrome/Invert) as a starting point for customization. Choose the
preset, and then choose Custom. The previous settings remain active and available
for changing.

Red/Green/Blue/Alpha Lets you specify channel operations on a per-channel
basis. Available only when Custom is the active choice. Otherwise these fields
show the current setting, such as Monochrome for the RGB channels.

Use the drop-down list to choose an replacement value or channel for each
channel:

■ Red/Green/Blue/Alpha Replaces the channel with the channel you
choose. For example, if you set Blue=Red, the blue component of each
pixel takes on the current value of the red component of that pixel.

■ Red (Inverse)/Green (Inverse)/Blue (Inverse)/Alpha (Inverse) Replaces
the channel with the inverse of the channel you choose. For example, if
you set Blue=Red (Inverse), the blue component of each pixel takes on the
inverse of the current value of the red component of that pixel.
The inverse for each channel is calculated by subtracting the value from
the maximum value: 1.0 in the case of floating-point colors, or 255 for
eight-bit channels. So, for example, red changes to cyan (green + blue);
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green changes to magenta (red + blue); and blue changes to yellow (red +
green).

■ Monochrome Converts the color channel to grayscale. To determine the
grayscale value for a channel, the software adds the values of of the red,
green, and blue channels for each pixel and then divides by three. For
example, if the RGB values are 0.5, 0.4, and 0.0, then the monochrome
value for any channel of that pixel would be 0.3.

■ One Sets the channel to the highest possible value; in effect, turns it all
the way on. For example, if the original color of a pixel in a 24-bit or 32-bit
map is R=50; G=75; and B=100, then the result of setting Green=One would
be R=50; G=255; and B=100.

■ Zero Sets the channel to the lowest possible value; in effect, turns it off.
For example, if the original color of a pixel is R=50; G=75; and B=100, then
the result of setting Green=Zero would be R=50; G=0; and B=100.

Color rollout

This rollout gives you three controls for overall color conversion. These controls
work on the output of the Channels rollout. To use the original map, make
sure the Channels rollout is set to Normal.

Hue Shift Lets you change colors using a standard Hue spectrum. Use the
slider or the numeric control to determine how to remap colors in the map.
To reset to 0, right-click the slider. Range=-180 to 180.

This control works the same as the Hue Shift control in Autodesk Combustion
and Autodesk Toxik.

Saturation The intensity or purity of the map colors. Lowering the Saturation
value removes color, causing the image to tend toward grayscale, while raising
it intensifies the color. To modify the value, use the slider or the numeric
control. To reset to 0, right-click the slider. Range=-100 to 100.

This control works the same as the Saturation control in Autodesk Combustion
and Autodesk Toxik.

Hue Tint Colorizes all non-white map pixels according to the color swatch
value. Grayscale values, including black and white, have no effect.

Strength The degree to which the Hue Tint setting affects the map pixels.
Range=0 to 100.
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Lightness rollout: Standard

The Standard option on the Lightness rollout gives you two easy-to-use
controls:

Brightness The overall luminance of the map image. To modify the value,
use the slider or the numeric control. To reset to 0, right-click the slider.
Range=-100 to 100.

Contrast The difference between brighter and darker portions of the map
image. To modify the value, use the slider or the numeric control. To reset to
0, right-click the slider. Range=-100 to 100.

Lightness rollout:Advanced

The Advanced controls are similar to those available in the Photo Lab feature
of Autodesk Toxik. This tool lets you simulate camera exposure and
photo-development changes in maps. You can change the exposure to brighten
or darken a map in incremental steps,providing perceptually relative uniform
changes in luminance. Photo-development adjustments can produce images
with different color distribution.

[exposure method] Choose from the drop-down list the method by which
to express exposure:

■ Gain The pixel color values are multiplied by this value.

■ F-Stop As in photography, increasing by 1 doubles the luminance, and
increases gain by a factor of 2.
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■ Printer Lights A definable setting (see Printer Lights per Stop) where
increasing this value by the value of the Printer Lights per Stop setting (N)
doubles the luminance (N printer lights=1 f-stop)

RGB/R/G/B You can change the settings for all three color channels
simultaneously (RGB) and for each channel individually. In addition, you can
toggle the settings for the individual channels with the check boxes.

Gamma/Contrast The amount of gamma correction can be expressed in terms
of contrast or in terms of the usual gamma exponent. Increasing the gamma
exponent decreases contrast.

Pivot Gamma correction is applied about a pivot value. That is, pixel values
equal to the pivot value are left unchanged. This is useful when you want to
use gamma correction to change the contrast of an map but do not want to
affect a particular luminance level.

Lift/Offset The lift is simply a uniform offset added to all the pixel values
(different offsets for different color components). Lift is usually applied as the
last step of the process and can be used to control the overall brightness of
the map.

Printer Lights per Stop When using the Printer Lights exposure method, this
setting determines the number of printer lights equivalent to one f-stop; that
is, the number required to double or halve the exposure.

Output Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Output

With Output map, you can apply output settings to procedural maps, such
as Checker or Marble, that don't have these settings.
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Interface

Output Parameters rollout

In this rollout, you choose the map to apply the output controls to.

Map Displays a modal version of the Material/Map Browser so you can choose
the map type.

The check box turns the map on or off.

Output rollout

The controls in this rollout are the same as for maps with a built-in output
option. See Output Rollout on page 5774.
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RGB Tint Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> RGB Tint

RGB Tint map

RGB Tint adjusts the value of the three color channels in an image. Three
color swatches represent these channels. Changing a color swatch adjusts the
value of its associated color channel.

The channels are named Red, Green, and Blue for their default colors, but you
can assign them any color. You are not limited to variations of red, green, and
blue.

Procedures

To tint a map:

1 In the RGB Tint Parameters rollout, click the Map button marked None.

The Material/Map Browser is displayed.

2 Select the map you want to tint

3 Click the R, G, or B color swatch.

The Color Selector on page 391 is displayed.

4 Choose a new color.

The red, green, or blue value of each pixel in the underlying map changes
accordingly.
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To change the saturation of one color in an image:

1 Click the R, G, or B color swatch.

2 On the Color Selector, increase or decrease Value to vary the color from
light to dark.

To replace one color with another:

1 Click the R, G, or B color swatch.

2 On the Color Selector, increase or decrease Hue to change the color.

Interface

R/G/B The red, green, and blue on page 8105 color swatches display the Color
Selector on page 391 to adjust the value of the specific channel.

Map Displays the Material/Map Browser to select the map to be tinted.

The check box turns the effect of the map on or off.

Vertex Color Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Vertex Color
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Mapping vertex colors

Vertex Color map makes any vertex coloring applied to an object available
for rendering. You can assign vertex colors using the VertexPaint Modifier on
page 1959, the Assign Vertex Colors utility on page 6038, or the vertex controls
for an editable mesh on page 2086, editable patch on page 2032, or editable poly
on page 2140.

While vertex color assignment is primarily used for special applications, such
as game engines or radiosity renderers, you can also use it to create colorful,
gradient surface effects. You can also use it in design visualization: Use the
VertexPaint Modifier on page 1959 to paint your landscape different colors to
represent grass, shrubbery, parking areas, etc., and then use Vertex Color map
to use the vertex coloring in your rendered images. Incidentally, when you
use the Terrain object's on page 774 Color By Elevation function, the software
assigns a material that uses a Vertex Color map as the diffuse component.

TIP To view vertex colors in a viewport, right-click the object, choose Properties
from the quad menu, and then turn on Vertex Channel Display in the Display
Properties group.

Procedures

To use the vertex color map:

1 Assign vertex colors to an object.

2 Assign a material to the object, then assign a Vertex Color map to the
material's diffuse component.

3 Optionally, if manipulating the map channels with the Channel Info
utility on page 6047, choose a map channel or sub-channel to render.

4 Render the scene.
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Interface

These parameters let you define which map channel or sub-channel is to be
rendered. One application is to support usage of the Vertex Color map in
conjunction with the Channel Info utility on page 6047.

The settings are interlinked; changing one parameter will change the other
two, as appropriate.

Map Channel Lets you specify which map channel to use. Range=0 to 99.
Default=0.

Notes regarding this setting:

■ If you set Map Channel to a channel that doesn't contain any vertex
coloring data, attempting to render will generate a Missing Map Coordinates
error message. To resolve this, apply vertex coloring to that channel.

■ By default, the vertex coloring in map channel 1 is a color gradient derived
from the UVW texture coordinates by converting UVW values to RGB
values. Thus, at UV=0,0 (the lower-left corner of the map), the coloring is
black; at UV=1,0, the coloring is red, and at UV=1,1 (the upper-right corner),
the coloring is yellow (red + green=yellow). You can change these colors
with a tool such as VertexPaint modifier on page 1959.

■ Map Channel cannot be set to a negative value, thus the map doesn't
support rendering of the vertex illumination (-1) or vertex alpha (-2)
channel.

Sub Channel Lets you can specify that the map will use either the Red, Green,
or Blue sub-channel of the specified map channel, or all sub-channels.

Channel Name After assigning the material with the Vertex Color map to an
object with named map or vertex-color channels (see Channel Info Utility on
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page 6047), you can click Update, and then, from this drop-down list, choose a
named map channel from the object.

Update Refreshes the contents of the Channel Name drop-down list. Use
Update after applying the material to an object, or after adding channels to
the object.

NOTE There could be conflicts if one material with a Vertex Color map is assigned
to objects with different named Map Channels, where one channel's name may
be displayed in preference to another's.

Reflection and Refraction Maps

These maps, grouped as "Other" in the Material/Map Browser on page 5290, are
maps that create reflections and refractions. Each of the following maps has
specific uses:

Flat Mirror on page 5946: Generates reflections for flat surfaces. You assign it to
faces rather than to the object as a whole.

Raytrace on page 5952: Creates accurate, fully raytraced reflections and
refractions.

Reflect/Refract on page 5964: Generates reflections or refractions automatically,
based on surrounding objects and the environment.

Thin Wall Refraction on page 5971: Generates refractions automatically,
simulating objects and the environment seen through a refractive material
such as glass or water.

Flat Mirror Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Flat Mirror
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Flat mirror map reflects the ice-cream shop's interior.

The Flat Mirror on page 7982 map produces a material that reflects surrounding
objects when it is applied to a collection of coplanar faces. You assign it as a
material's reflection map on page 5480.

Reflect/Refract maps don't work well for flat surfaces because each face reflects
part of the environment based on where its surface normal points. Using this
technique, a large flat face can reflect only a small part of the environment.
Flat Mirror automatically generates a reflection that encompasses a larger part
of the environment, to better simulate a mirror-like surface.

Rules for Using Flat Mirror

Flat Mirror cannot generate reflections correctly unless you observe these rules:

■ Assign Flat Mirror to selected faces only.
There are two ways to do this. You can make the Flat Mirror material a
sub-material of a Multi/Sub-Object on page 5720 material, or you can use
the Apply To Faces With ID control.

■ If you assign Flat Mirror to multiple faces, the faces must lie in a plane.
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■ Non-coplanar faces in the same object cannot have the same Flat Mirror
material.
In other words, if you want two different planes of an object to have flat
reflections, you must use a Multi/Sub-Object material. Assign Flat Mirror
to two different sub-materials, and assign different material IDs to the to
different planar faces.

■ The material ID used by the Flat Mirror sub-material must be unique to
the coplanar faces in the object.
If you assign Flat Mirror using Apply to Faces with ID, faces without that
ID display the nonreflective components (diffuse color, and so on) of the
material with the Flat Mirror reflection map.

Procedures

To assign a flat mirror to one face of an object:

1 In the Material Editor, create a standard material.

2 Assign a Flat Mirror map as the material's reflection map.

3 In the Flat Mirror Parameters rollout > Render group, turn on Apply To
Faces With ID, and choose the material ID number the mirrored face will
have.

4 Follow the next set of steps for assigning the material to the object.

To assign the mirror to a flat surface:

1 Select an object.

2 In the Modify command panel, apply Edit Mesh to the object.

3 Make sure Sub-Object is selected, and choose Face as the sub-object level.

4 Select a single face or multiple faces that lie in a single plane.

5 Assign the faces the material ID you chose for the Flat Mirror map.

6 Assign the material to the object.

To assign a flat mirror using a Multi/Sub-Object material:

1 In the Material Editor, create a Multi/Sub-Object material.

2 Click one of the unused material buttons in the Multi/Sub-Object
material's parameters.
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3 In the new Standard sub-material, open the Maps rollout and click the
map button for Reflection.

4 In the Material/Map Browser, choose Flat Mirror, and then click OK.

Flat Mirror controls are similar to those for automatic reflection and
refraction.

5 Apply Edit Mesh to the object, and then in the stack view area of the
modifier stack display on page 7635, choose Face as the sub-object level.

6 Select a single face or multiple faces that lie in a single plane.

7 Assign the faces the material ID corresponding to the Flat Mirror
sub-material slot.

Using a Multi/Sub-Object material, you can apply Flat Mirror to different
faces of the object that are not coplanar. However, faces that are not
coplanar must use different sub-material slots, otherwise the software
doesn't correctly generate the flat mirror reflections.
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Interface

Blur group

Apply Blur Turns on filtering to blur the maps.

Antialiasing is also applied to the Distortion effect, if any, when Apply Blur
is turned on.
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Blur Affects the sharpness or blurriness of the generated map based on its
distance from the object. The farther away the map is, the greater the blurring.
Blur is primarily used to avoid aliasing on page 7904. It's a good idea to use a
small amount of blurring for all maps in order to avoid the scintillation or
aliasing that can occur when pixel details are reduced off in the distance.
Default=1.0.

Render group

First Frame Only The renderer creates the automatic flat mirror only on the
first frame.

Every Nth Frame The renderer creates the automatic flat mirror based on the
frame rate on page 7987 set by the spinner.

Use Environment Map When off, environment maps are ignored by the
mirror during rendering. It's useful to turn this off when you have mirrors in
the scene and you're rotoscoping against a flat screen environment map. A
screen environment map does not exist in 3D space the way the other
environment-map types do, and will not render properly. Default=on.

Apply to Faces with ID Specifies the material ID number where you want
the mirror assigned.

You can assign a flat-mirror material to an object without having to make it
a component of a Multi/Sub-Object on page 5720 material. The restriction is
that the other faces on the object must be able to use the nonmirrored
properties of the same material (its diffuse color, and so on). If the other faces
need completely different material characteristics, you need to use a
Multi/Sub-Object material.

For example, if you have an object, such as a box, with unique material IDs
for each side, you can use Apply To Faces With ID to specify the side of the
box that will show the mirror reflection. The remaining sides of the box will
have the same material characteristics, but without the reflection.

Distortion group

To simulate irregular surfaces, you can distort the flat-mirror reflections.
Distortion can be based on a bump map or on noise controls built into Flat
Mirror material.

None No distortion.

Use Bump Map Distorts the reflection using the material's bump map.

A flat mirror surface that has a Bump map will appear bumpy, but its reflection
won't be distorted by the bumps unless you use this option.
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Use Built-In Noise Distorts the reflection using the settings in the Noise group.

Distortion Amount Adjusts the amount of distortion to the reflected image.
This is the only value that affects the amount of distortion. No matter how
high the Bump map's Amount spinner is set, or how extreme the Noise settings,
if this Distortion Amount is set to 0, no distortion appears in the reflection
itself. This control is inactive when None is chosen.

Noise group

The controls in this group are inactive unless you choose Use Built-In Noise
as the active distortion type.

Regular Generates plain noise. Basically the same as Fractal noise with the
Levels setting at 1. When the noise type is set to Regular, the Levels spinner
is inactive (because Regular is not a fractal function).

Fractal Generates noise using a fractal algorithm. The Levels setting determines
the number of iterations for the fractal noise.

Turbulence Generates fractal noise with an absolute value function applied
to it to make fault lines.

Phase Controls the speed of the animation of the noise function. A 3D noise
function is used for the noise, so that the first two parameters are U and V
and the third is phase.

You can animate this parameter to animate the noise effect.

Size Sets the scale of the noise function. Smaller values give smaller chunks
of noise.

Levels Sets the number of fractal iterations or turbulence (as a continuous
function).

Raytrace Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Raytrace
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Raytrace map creates highly reflective and refractive surfaces.

Raytrace map provides fully raytraced reflections and refractions. The
reflections and refractions it generates are more accurate than those produced
by the reflect/refract map on page 5964. Rendering raytraced objects is slower
than using Reflect/Refract. On the other hand, Raytrace is optimized for
rendering 3ds Max scenes, and you can further optimize it for your scene by
excluding specific objects or effects from raytracing.

You can also use the Raytrace material on page 5490, which uses the same
raytracer to generate accurate, raytraced reflections and refractions. The
differences between Raytrace map and Raytrace material are:

■ You use Raytrace map as you do other maps. This means you can add
raytraced reflections or refractions to any kind of material.

■ You can assign Raytrace map to material components other than reflect
or refract, although these are the main ways to use this map.

■ Raytrace map has more extensive attenuation controls than Raytrace
material.

■ Raytrace map often renders more quickly than Raytrace material.
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Raytrace Map and Raytrace material have the same name because they use
the same raytracer and share global parameters.

NOTE Raytracing does not always work correctly in orthogonal viewports (left,
front, and so on). It works correctly in perspective viewports and camera
viewports.

Interface

The interface for the Raytrace map is contained in four rollouts:

Raytracer Parameters Rollout on page 5954

Raytrace: Attenuation Rollout on page 5957

Raytrace: Basic Material Extensions Rollout on page 5960

Raytrace: Refractive Material Extensions Rollout on page 5962

Raytracer Parameters Rollout

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Raytrace > Raytracer Parameters rollout

This rollout contains the main controls for the Raytrace map on page 5952.
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Interface

Local Options group

Enable Raytracing Turns the raytracer on or off. Default=on.

Even with raytracing off, Raytrace material and Raytrace map still reflect and
refract the environment, including both the environment map for the scene,
and the environment map assigned to the Raytrace material.

Raytrace Atmospherics Turns the raytracing of atmospheric effects on or off.
Atmospheric effects include fire, fog, volume light, and so on. Default=on.

Enable Self Reflect/Refract Turns self reflection/refraction on or off.
Default=on.

Can an object reflect itself? For example, a teapot's body reflects the teapot's
handle, but a sphere will never reflect itself. If you don't need this effect, you
can improve render time by turning off this toggle.
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TIP If you have a transparent object such as glass, and have self reflect/refract
turned on, you don't have to make the object 2-sided on page 7893. The raytracer
sees back faces when exiting refractive objects.

Reflect/Refract Material IDs When on, the material reflects effects assigned
to material IDs in the renderer's G-buffer on page 7991 on or off. Default=on.

By default, Raytrace material and Raytrace map reflect effects assigned to a
material's ID, so that G-buffer effects are not lost. For example, if a raytraced
object reflects a lamp made to glow with the Video Post Glow filter (Lens
Effects Glow), the reflection glows as well.

Trace Mode group

With options in this group, you select whether to cast reflected or refracted
rays.

Auto Detect If assigned to the material's Reflection component, the raytracer
will reflect. If assigned to Refraction, it will refract. If you assign Raytrace to
any other component, you have to manually specify whether you want
reflected rays or refracted rays. (Default.)

NOTE Auto Detect might fail when you use Raytrace map in a material with a
strong bump map. When you use a strong bump map, choose one of the explicit
options.

Reflection Casts reflected rays off the object's surface.

Refraction Casts refracted rays into or through the object's surface.

NOTE Raytrace reflects and transmits the IDs in material effects channel on page
5348 (G-buffer on page 7991), so it can create glowing reflections, and so on.

Local Exclude Click to display the local Include/Exclude dialog on page 5519.

An object that is excluded locally is excluded from this map only.

TIP Using exclusion lists is one of the best and simplest ways to speed up the
raytracer.

Background group

Use Environment Settings Respects the environment settings of the current
scene.

Color Swatch Overrides the environment settings with the specified color.
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Map Button Overrides the environment settings with the specified map.

By specifying an environment map, you override the environment map for
the scene as a whole. Both reflection and refraction use the scene-wide
environment map unless you use this option to specify another map. With
this control, you can use different environment maps on a per-object basis,
or provide an environment to specified objects when the scene as a whole has
none.

Raytraced Reflection and Refraction Antialiaser group

Controls in this group let you override the global antialiasing settings for
raytraced maps and materials. They are unavailable if antialiasing is turned
off globally. To turn on antialiasing globally, choose Rendering > Raytracer
Settings to open the Raytracer Global Parameters rollout on page 6221.

On When on, uses antialiasing. Default=unavailable unless global antialiasing
is turned on; on if global antialiasing is turned on.

Drop-down list Chooses which antialiasing settings to use. There are three
options:

■ Use Global Antialiasing Settings (The default.) Uses the global antialiasing
settings.
Click ... to open the Raytracer Global Parameters rollout on page 6221.

■ Fast Adaptive Antialiaser Uses the Fast Adaptive antialiaser, regardless of
the global setting.
Click ... to open the Fast Adaptive Antialiaser dialog on page 5522.

■ Multiresolution Adaptive Antialiaser Uses the Multiresolution Adaptive
antialiaser, regardless of the global setting.
Click ... to open the Multiresolution Adaptive Antialiaser dialog on page
5524.

When you change settings for an antialiaser locally, you don't affect the global
settings for that antialiaser.

Raytrace:Attenuation Rollout

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Raytrace > Attenuation Rollout

When a ray is reflected off an object or refracted through it, by default the ray
travels through space forever, with no attenuation on page 7915. The controls
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in this rollout allow you to attenuate rays, so their strength diminishes over
distance.

In the Raytrace map on page 5952, attenuation is implemented by a clipping
algorithm. Objects beyond the maximum attenuation range aren't even
considered by the raytracer. Because of this, assigning attenuation can speed
up rendering time.

Interface

Falloff Type Choose the falloff to use.

■ Off Turns off attenuation. (Default.)

■ Linear Sets linear attenuation. Linear attenuation is calculated between
the start and end range values.

■ Inverse Square Sets inverse square attenuation. Inverse square attenuation
is calculated beginning at the start range, and doesn't use the end range.
Inverse square is the actual attenuation rate for light in the real world.
However, it doesn't always give the effect you want in a rendered scene.
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■ Exponential Sets exponential attenuation. Exponential attenuation is
calculated between the start and end range values. You also specify the
exponent to use.

■ Custom Falloff Specifies a custom curve to use for attenuation (falloff).

Start Range The distance in world units where attenuation begins. Default=0.0.

End Range Sets the distance in world units where the ray is fully attenuated.
Default=100.0.

This is not used by inverse square attenuation.

Exponent Sets the exponent used in exponential falloff. Default=2.0.

This is used only by exponential attenuation.

Color

These controls affect the behavior of light rays as they attenuate out. By default,
as a ray fades out, it is rendered as the background color.

You can set a custom color instead.

Background As the ray attenuates out, returns the background (either the
scene's background or the background specified locally in the Raytracer
Parameters rollout) rather than the actual color of what the reflected/refracted
ray sees. (Default.)

Specify Sets the color that is returned by the ray as it attenuates out.

If you choose not to use the background color, black or gray usually work best
as the attenuation color,

Custom Falloff group

These controls are inactive unless the Falloff Type is set to Custom Falloff.

Custom Falloff Uses the falloff curve to determine the falloff between the
start and the end ranges.

These are the controls for custom attenuation. The custom attenuation curve
is at the left. The gray scale bar below the curve shows how the curve will
affect the falloff as light rays diminish in strength.

Near Sets the strength of the reflected/refracted ray at the start range distance.
This is a normalized percentage that can range from 0.0 to 1.0. Default=1.0.

Control 1 Controls the shape of the curve near the curve start. Default=0.667.
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Control 2 Controls the shape of the curve near the curve end. Default=0.333.

Far Sets the strength of the reflected/refracted ray at the end range distance.
This is a normalized percentage that can range from 0.0 to 1.0. Default=0.0.

Raytrace: Basic Material Extensions Rollout

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Raytrace > Basic Material Extensions Rollout

This rollout contains controls for fine-tuning the effect of the Raytrace map
on page 5952.

Interface

Reflectivity/Opacity These controls affect the intensity of the raytracer's
results.

■ Spinner Controls the amount of raytracing used by the material it is
assigned to. Analogous to the Output Amount parameter in the Output
rollout of the Bitmap map type on page 5795.

■ Map button Assigns a map that controls the amount of raytracing. You
can vary the amount of raytracing used over the surface of the object.

■ Check box Enables or disables the map.

Tint With these controls, you can tint the colors returned by the raytracer.
Tinting applies only to reflected colors; it doesn't affect the material's diffuse
component.

■ Check box Turns basic tinting on or off. Default=off.

■ Color swatch Assigns a tint color for reflections. Default=white.
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■ Amount spinner Sets the amount of tinting used. Default=1.0.

■ Map button Assigns a map to use for tinting. You can vary the tint colors
over the surface of the object.

■ Check box Enables or disables the map.

Bump Map Effect Controls the effect of a bump map on rays that the surface
reflects and refracts. For example, you might want to make a glass object highly
bumpy, but reduce the bump effect on refracted parts of the scene.

Bump Map Effect equals 1.0.

The refraction of tiles behind the glass is distorted by the bump map.
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Bump Map Effect equals 0.0.

The refraction of tiles behind the glass is not distorted.

Bump Map Effect is active only when raytracing is enabled.

Raytrace: Refractive Material Extensions Rollout

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Raytrace > Refractive Material Extensions Rollout

With the controls in this rollout, you can fine-tune the effect of the Raytrace
map on page 5952 on a material's refraction component.
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Interface

Internal Density Effects

Color With these controls, you can specify a transmission color based on
thickness. The density color gives the appearance of color within the object
itself, like tinted glass.

■ Enable Turns color density on or off.

■ Color swatch Displays a Color Selector on page 391. Choose the
transmission color.

■ Amount Controls the amount of density color. Reducing this value
reduces the density color effect. Range=0 to 1.0. Default=1.0.

■ Color Map Assigns a map to the density color component. Use the check
box to enable or disable the map.

■ Start and End A thin piece of tinted glass is mainly clear, while a thick
piece of the same glass has more color. Start and End Distance, expressed
in world units, controls help you simulate this effect. Start is the position
in the object where the density color begins to appear (Default=0.0). End
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is the position in the object where the density color reaches its full Amount
value. To have a lighter effect, increase the End value. To have a heavier
effect, reduce the End value.

Fog Density fog is also a thickness-based effect. It fills the object with a fog
that is both opaque and self illuminated. The effect is like smoke trapped in
a glass, or wax at the tip of a candle. Colored fog in tubular objects can
resemble neon tubes.

■ Enable Turns fog on or off.

■ Color swatch Displays a Color Selector on page 391 for choosing the fog
color.

■ Amount Controls the amount of density fog. Reducing this value reduces
the density fog effect and makes the fog translucent. Range=0 to 1.0.
Default=1.0.

■ Color Map Assigns a map to the fog component. Use the check box to
enable or disable the map.

■ Start and End Start and End Distance controls, expressed in world units,
adjust the fog effect based on the object's dimensions. Start is the position
in the object where the density fog begins to appear (default=0.0). End is
the position in the object where the density fog reaches its full Amount
value. To have a lighter effect, increase the End value. To have a heavier
effect, reduce the End value.

Render objects inside raytraced objects Turns the rendering of objects inside
raytraced objects on or off. Default=on.

Render atmospherics inside raytraced objects Turns the rendering of
atmospheric effects inside raytraced objects on or off. Atmospheric effects
include fire, fog, volume light, and so on. Default=on.

Treat Refractions as Glass (Fresnel effect)  When on, applies a Fresnel effect
to the refraction. This can add a bit of reflection to the refracting object,
depending on the viewing angle of the object. When off, the object is refractive
only. Default=on.

Reflect/Refract Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Reflect/Refract
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Reflect/Refract map used for the balloons

The Reflect/Refract map produces a reflective or refractive surface. To create
reflection, assign this map type as the material's reflection map on page 5480.
To create refraction, assign it as the refraction map on page 5483.

NOTE A reflective object can reflect another reflective object. In the real world,
this creates a virtually infinite number of interreflections. In 3ds Max, you can set
the number of interreflections within a range from 1 to 10. You set this Rendering
Iterations parameter on the Render Setup dialog on page 6092.

This map works by using six renderings in the form of a cube that surrounds
the objects. Reflect/Refract views the cubic maps from the perspective of the
pivot point on page 8091 of the object, mapping them onto the object's surface
as a spherical reflection map.

You can choose to generate the cubic maps automatically, or to load previously
created maps.

A reflective surface reflects the surrounding maps like a mirror. A refractive
surface creates the illusion that the surrounding maps are seen through the
surface.

Reflection and Refraction Maps | 5965



NOTE Reflect/Refract is meant to be used with curved or irregularly shaped objects.
For mirror-like flat surfaces that you want to reflect the environment accurately,
use Flat Mirror on page 5946 material. For more accurate refractions, especially for
an object in a refractive medium (such as a pencil in a glass of water), use Thin
Wall Refraction material on page 5971.

Automatic Cubic Maps

When you choose automatic cubic maps, 3ds Max generates the maps based
on the perspective of the mapped object's pivot point. Automatic maps are
based on the geometry of the scene.

The advantage to using automatic maps is that the six views are automatically
generated at rendering time and can be easily updated for each frame of an
animation. The disadvantage is that regenerating the maps increases rendering
time. In addition, the maps exist only for the rendering and can't be edited
or otherwise manipulated.

In the Material Editor, automatic reflections or refractions reflect or refract
the background of the sample slot.

Assigning Cubic Maps

When you choose to load cubic maps from files, you use the controls in the
From File group. The advantage to using From File is that the bitmap files
already exist and take less rendering time. In addition, you can edit the bitmap
images. The disadvantage is that it's more difficult to use bitmaps to render
an animation because first you need to create the animated bitmaps.

IMPORTANT Assigned cubic maps must be square, and each of the six maps
must be the same size.

You can automatically load six bitmaps at once if the six bitmaps have valid
cubic-map file names. The first part of all six file names must be the same,
and the last part is an underscore followed by a two-letter abbreviation of the
map position, as shown in the following table:

MeaningLast Part of Cubic Map File Name

Up_UP

Down_DN
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MeaningLast Part of Cubic Map File Name

Left_LF

Right_RT

Front_FR

Back_BK

For example, if you have six bitmaps on disk, labeled view_up.bmp, view_fr.bmp,
view_lf.bmp, and so on, when you click one of the file buttons and choose the
bitmap for that position, all six views are loaded.

If you select a bitmap whose name doesn't follow the convention, or you
select one with a valid cubic-map name but assign it to the wrong button,
only that bitmap will be loaded.

Since all assigned bitmaps must be the same size, when you assign a new
bitmap to one of the windows, the sample slot doesn't update automatically.
This avoids generating an error message each time you assign a bitmap. Once
you've assigned all six maps and are sure they are square and the same size,
click the Reload button to update all of the maps and redisplay the sample
slot.

You can also use the Reload button to see your changes after you've edited
one of the cubic maps by using a paint program.

Rendering Cubic Maps

The controls in the Render Cubic Map Files group let you generate the maps
automatically and save them to disk. Use the To File button to specify the
folder and file name of the Up (_UP) bitmaps. Click Pick Object and Render
Maps, and then click the object to map. The software creates the files and also
assigns them to the six From File map buttons.

Rendering cubic maps has the same effect as automatic with the advantage
that map rendering doesn't have to take place at scene rendering time. The
disadvantage is that you can't create an automatically animated reflections or
refractions this way.
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Using Animated Cubic Maps

The cubic maps can be animations instead of bitmaps. Be sure that each is
square and all have the same resolution. If you want the animated reflections
to match animated changes in the scene, use automatic maps and set them
to render every Nth frame.

Procedures

To generate and save cubic maps:

1 In the Source group, choose From File.

2 In the Render Cubic Map Files group, click the button next to To File.

A file dialog is displayed. Type a name for one of the six cubic bitmap
files. You're specifying the name of the Up bitmap. There are two ways
to do this:

■ Specify the entire file name; for example, myview_up.bmp.

■ Specify the file prefix and extension only; for example, myview.bmp.

IMPORTANT You must specify at least a prefix and extension. The "_UP"
is added automatically.

3 Click Pick Object and Render Maps.

4 Click an object in your scene where you want the six views rendered.
This is usually the same object where you will apply the material, but it
doesn't have to be.

After selecting the object, a window opens temporarily that shows the
six views as they render and are saved to disk. Their file names then
appear on the six buttons in the From File group. Each of the six file
names is identical, except for a two-letter suffix indicating the direction
of the rendered view.
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Interface

Source Chooses the source of the six cubic maps.

Automatic Automatically generates by looking out in six directions from the
pivot of the object with the material, then mapped onto the surface during
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rendering. When on, the options in the Automatic group are active, letting
you choose whether the maps will be generated only once, or regenerated at
specified frames in the animation.

From File When on, you can specify the bitmaps to use.

When From File is active, the controls in the Render Cubic Map Files group
are also available. You can generate the six cubic reflection maps automatically
and save them to files, where you can load them with the From Files controls.

Size Sets the size of the Reflect/Refract maps. The default value of 100 produces
distinct images. Lower values lose progressively more detail.

Use Environment Map When off, environment maps are ignored by
Reflect/Refract map during rendering. It's useful to turn this off when you
have mirrors in the scene and you're rotoscoping against a flat screen
environment map. A screen environment map does not exist in 3D space the
way the other environment-map types do, and will not render properly.

Blur group

Apply Turns on filtering to blur the maps.

Blur Offset Affects the sharpness or blurriness of the map without regard to
its distance from the object. Use Blur Offset when you want to soften or defocus
the details in a map to achieve the effect of a blurred image.

Blur Affects the sharpness or blurriness of the generated map based on its
distance from the object. The farther away the map is, the greater the blurring.
Blur is primarily used to avoid aliasing on page 7904. It's a good idea to use a
small amount of blurring for all maps in order to avoid the scintillation or
aliasing that can occur when pixel details are reduced off in the distance.
Default=1.

Atmosphere Ranges group

If your scene contains environmental Fog on page 6707, the cubic maps must
have near and far range settings to properly render the fog from the point of
view of the object assigned the material. The Near and Far spinners in this
group let you specify a fog range relative to the object.

Near Sets the near range for fog.

Far Sets the far range for fog.

Get From Camera Uses the Near and Far atmosphere range settings of a camera
in the scene. Click this option, and then select the camera.
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These values aren't dynamically linked to the camera object. They are simply
copied from the camera's range values at the time you click the camera. If the
camera's range values later change, the map's Near and Far values remain the
same.

Automatic group

This controls are active only when Automatic is the active source for the
Reflect/Refract maps.

First Frame Only Tells the renderer to create automatic maps only on the
first frame.

Every Nth Frame Tells the renderer to create animated auto maps based on
the frame rate on page 7987 set by the spinner.

From File group

These controls are active when From File is active as the Reflect/Refract source.
Here you assign the six bitmaps to be used as the cubic maps.

Up / Down / Left / Right / Front / Back Assigns one of the six cubic maps.
If the map is one of a set of six with the correct file name, all six are loaded.

If the map doesn't follow file naming conventions, or you assign it to a button
of a different position (_UP to Front, for example), only that map is assigned.
You must assign the others manually.

Reload Reloads the assigned maps and updates the sample slot.

You can edit one or more of the cubic maps using a paint program, then click
Reload to update the material and the scene.

Render Cubic Map Files group

To File Choose a file name for the Up map (_UP).

Pick Object and Render Maps Active when you choose a file. Click to turn
on, then select the mapped object to render the six cubic maps. Assign the
cubic maps to the six From File buttons.

Thin Wall Refraction Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Thin Wall Refraction
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Thin wall refraction

Thin Wall Refraction simulates the "jog," or offset effect, you find when you
view part of an image through a plate of glass. For objects that model glass,
such as a Box in the shape of a window pane, this map is faster, uses less
memory, and provides a much better visual effect than the Reflect/Refract
map.

TIP At 100% refraction and opacity, you can see no diffuse color or mapping,
and there is not much illusion of a refractive material. The effect is invisible. In the
Maps rollout of the parent material, set Refraction Amount to 50%, and in the
Basic Parameters rollout, set Opacity to a value greater than 0.

Procedures

To assign the Thin Wall Refraction map to a material:

1 Click the Map button for Refraction in the material's Maps rollout.

2 In the Material/Map Browser, choose Thin Wall Refraction.

3 Adjust the map's parameters.
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4 In the parent material, set the Refraction Map Amount to 50%.

5 Assign the material to an object.

Interface

Blur group

These controls are for antialiasing.

Apply Blur Turns on filtering to blur the maps.

Blur Affects the sharpness or blurriness of the generated map based on its
distance from the object. The farther away the map is, the greater the blurring.
Blur is primarily used to avoid aliasing on page 7904. It's a good idea to use a
small amount of blurring for all maps in order to avoid the scintillation or
aliasing that can occur when pixel details are reduced off in the distance.
Default=1.0.

Render group

These controls affect how the refraction should behave in animations.

First Frame Only Tells the renderer to create the refracted image only on the
first frame.
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This is the fastest option. You can use it if the camera and refractive object
don't move.

Every Nth Frame Tells the renderer to regenerate the refracted image based
on the frame rate on page 7987 set by the spinner.

Every single frame provides the most accurate result, but takes longest to
render.

Use Environment Map When off, environment maps are ignored by the
refraction during rendering. It's useful to turn it this off when you have
refractions in the scene and you're rotoscoping against a flat screen
environment map. A screen environment map does not exist in 3D space the
way the other environment map types do, and will not render properly.
Default=on.

Refraction group

These controls are specific to the Thin Wall Refraction effect:

Thickness Offset Affects the size of the refractive offset, or jog effect. At 0,
there's no offset, and the object can appear invisible in the rendered scene.
At 10.0, the offset is at its greatest. Range from 0.0 to 10.0; Default=0.5.

NOTE The IOR (index of refraction) spinner in the parent material's Extended
Parameters rollout also affects the offset effect.

Bump Map Effect Affects the magnitude of refraction due to the presence of
a bump map. This parameter multiplies the current bump map Amount in
the parent material. Reduce this value to reduce the effect of the secondary
refraction; increase this value to increase the effect. If there is no bump map
assigned, this value has no effect. Default=1.0.

If there is unevenness in the surface of the glass, there is a secondary refraction.
Thin Wall Refraction generates this secondary refraction if the material also
has a bump map present. The algorithm guesses at the scaling of the secondary
refraction, and can create too large an effect. If this happens, scale the effect
down by reducing this value to less than one.

mental ray Shaders

In mental ray, a shader is a function that calculates light effects. There can be
shaders for lights, cameras (lens shaders), materials, shadows, and so on.
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NOTE In 3D modeling, the term “shader” typically refers to an algorithm that
specifies how a surface responds to light. (The shaders for standard 3ds Max fall
into this category.) With the mental ray renderer, “shader” has a more general
sense of any algorithm used in rendering.

The mental ray renderer on page 6230 can render most types of 3ds Max materials
and maps. See 3ds Max Materials in mental ray Renderings on page 6239. In
addition, if you have enabled mental ray extensions (see mental ray Preferences
on page 7787), you can apply a variety of shaders to materials. Materials designed
for use with the mental ray renderer have specific components to which you
can assign a shader. And for standard 3ds Max material types, the mental ray
Connection rollout on page 5385 lets you add mental ray shading.

WARNING When you use the scanline renderer, mental ray shaders typically
appear as black or white surfaces, or they are ignored entirely.

You assign a mental ray shader the same way you do a map. In the
Material/Map Browser on page 5290, mental ray shaders appear with a yellow
icon, instead of the green icon used for maps.

mental ray maps in the browser's list are shown with yellow icons.

The shaders listed in the Browser depend on which type of shader component
you have chosen in the Material Editor. For example, when you assign a Surface
shader, the Browser lists a variety of shaders and standard 3ds Max maps. But
when you assign a more special-purpose Contour shader, the Browser lists
only those shaders that generate contour lines.
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NOTE Other kinds of special-purpose shaders include shaders for cameras and
lights. Buttons to assign camera shaders are found on the Render Setup dialog >
Camera Effects rollout on page 6283, and the controls to assign light shaders are on
a light object's mental ray Light Shader rollout on page 5115. This rollout appears
only on the Modify panel, not the Create panel.

The shaders listed in the Browser come from several libraries that are provided
with 3ds Max. Shaders created specifically for 3ds Max are described in this
document. Shaders provided with the mental images or lume shader libraries
have their own online documentation. The following topics link to the
descriptions of specific shaders:

■ 3ds Max Custom Shaders on page 5982 links to descriptions of the shaders
provided in the product-specific library, 3dsmax.mi.

■ mental images Shader Libraries on page 5977 links to descriptions of the
shaders provided in the three standard mental ray libraries from mental
images: base.mi, contour.mi, and physics.mi.

■ Shaders in the LumeTools Collection on page 5980 includes links to
descriptions of shaders in the lume library, lume.mi.

■ The  Production Shaders on page 6017 library includes several special-purpose
texture shaders, a lens shader, and two output shaders.

■ The Car Paint on page 5607 material is also available as a shader, with the
same set of parameters.

■ The mr Sun on page 5173, mr Sky on page 5176, and mr Physical Sky on page
5181 shaders are components of the mental ray Sun and Sky on page 5161
solution.

NOTE When you wire the parameters of an object whose material has mental ray
shaders assigned, names of shader parameters might differ from those in the
Material Editor interface. Also, parameters not supported by 3ds Max might appear
as blanks in the wiring menu.

mental ray Shaders not Provided with 3ds Max

If your installation includes shader libraries other than those listed in this
reference (whether obtained from a third-party source, or custom written),
then the Browser might list those shaders as well. Documentation for
third-party or custom shaders should come from the shader's provider.
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Where Shaders Are Installed

Shaders provided with 3ds Max are installed in the subdirectory
\mentalray\shaders_standard\, below the 3ds Max root directory. The \include
folder is for the MI include files, and the \shaders folder is for the DLLs.

Third-party shaders should not be installed in \shaders_standard. They should
be installed either in \shaders_3rdparty or \shaders_autoload. If a third-party
shader is present in \shaders_autoload, it is loaded automatically when you
start 3ds Max. If a third-party shader is present in \shaders_3rdparty, you must
update the file 3rdparty.mi so it explicitly loads the shader. The MI file
\shaders_3rdparty\3rdparty.mi contains comments that explain how to add load
statements.

NOTE Shaders listed in the MI file are loaded in reverse order: that is, from the
bottom of the list to the top.

mental images Shader Libraries

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Pick a mental ray shader other than a custom 3ds Max shader or a lume
shader.

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The shaders provided with standard libraries from mental images are meant
for use with the mental ray renderer on page 6230. There are three standard
libraries: Base Shaders (base.mi), Physics Shaders (physics.mi), and Contour
Shaders (contour.mi).

NOTE In the mental image libraries, the names of base shaders have the prefix
“mib_” and the names of contour shaders have the prefix “contour_”. These
prefixes don't appear in the 3ds Max user interface or in the table that follows.
(Names of physics shaders have no conventional prefix.)

The following table lists the mental images library shaders provided with 3ds
Max.
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TIP When you follow a link to the documentation for mental images library shaders,
scroll up a bit in your browser. The links tend to go directly to the shader's
declaration code, and often there are some introductory paragraphs directly above
the code. If the link goes to the beginning of a section, scroll down instead.

LibraryShader

baseAmbient/Reflective Occlu-
sion

contourCombi

contourContour Composite

contourContour Contrast Function
Levels

contourContour Only

contourContour PS (PostScript)

contourContour Store Function

contourCurvature

contourDepth Fade

physicsDGS Material Photon

baseDielectric

contourFactor Color

contourLayer Thinner

baseLight Infinite

baseLight Point
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LibraryShader

baseLight Spot

baseOpacity

physicsParti Volume

basePhoton Basic

baseReflect

baseRefract

baseShadow Transparency

contourSimple

baseTexture Remap

baseTexture Rotate

baseTexture Wave

physicsTransmat

physicsTransmat Photon

baseTransparency

baseTwo Sided

contourWidth From Color

contourWidth From Light

contourWidth From Light Dir
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NOTE You can also access the mental images shader help by choosing Help >
Additional Help, opening the mental ray 3.6 Reference, and then highlighting
mental ray Shader Reference on the Contents panel.

Shaders in the LumeTools Collection

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Pick a shader with “(lume)” in its name.

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The LumeTools Collection of shaders provide a variety of naturalistic effects
when used with the mental ray renderer on page 6230. In the Material/Map
Browser, the name of these shaders is followed by “(lume).” These are the
lume shaders provided with 3ds Max:

■ Beam

■ Distortion

■ Edge and Edge Shadow

■ Facade

■ Glass

■ Glow

■ Landscape

■ Metal

■ Mist

■ Night

■ Ocean

■ Stain

■ Submerge

■ Translucency

■ Water Surface

■ Wrap Around
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■ Wet-Dry Mixer

NOTE You can also access the lume shader help by choosing Help > Additional
Help, opening the mental ray Reference, and then highlighting LumeTools
Collection on the Contents panel.

Connect Parameter to Shader Dialog (mental ray)

Material Editor > mental ray Connection rollout > Click a shader button. >
Material/Map Browser > Pick a mental ray shader that returns multiple values.

Material Editor > Shader controls > Click a shader button. > Material/Map
Browser > Pick a mental ray shader that returns multiple values.

Material Editor > DGS material > Click a shader button. > Material/Map Browser
> Pick a mental ray shader that returns multiple values.

Material Editor > Shader controls > Click a shader return parameter button
(to the right of the main shader button).

Note: The mental ray Connection rollout is available in the Material Editor
only if you have enabled the mental ray extensions by using the mental ray
Preferences panel. In addition, shaders don't appear unless the mental ray
renderer is the currently active renderer.

Some mental ray shaders return multiple values. If you choose one of these,
a Connect Parameter To Shader dialog appears. Choose one of the return
values in the list, and then click OK.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

 The components for some mental ray materials and shaders can be
assigned other shaders. For these components, the main shader button is
accompanied on the right by a small button. If no shader is assigned, or the
shader assigned has only a single return value, the button is disabled and
shows a dot in the middle. If the shader assigned can return multiple values,
text appears in this button, and a tooltip shows the parameter name. Clicking
the button displays the Connect Parameter To Shader dialog, allowing you to
change the parameter being used.
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Interface

List of return values Lists the parameters that the shader returns. The type
of each parameter is indicated in parentheses, following the parameter's name.

Show Compatible Only When on the list shows only the return values whose
type is compatible with the component the shader is assigned to. When off,
shows all return values from the shader, whether they are compatible or not.
Default=on.

3ds Max Custom Shaders

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Pick a mental ray shader other than a mental images library shader or a lume
shader.

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

For use with the mental ray renderer on page 6230, 3ds Max provides the
following custom shaders:
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3D Displacement Shader (mental ray)

Material Editor > mental ray Connection rollout > For the Displacement
component, turn off the lock button. > Click the button for the Displacement
component. > Material/Map Browser > 3D Displacement (3dsmax)

Material Editor > mental ray material > Click the button for the Displacement
component. > Material/Map Browser > 3D Displacement (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

A 3D Displacement shader displaces the geometry of surfaces. The effect is
similar to displacement mapping of a standard material. You can apply mental
ray displacement to any kind of object, unlike standard displacement mapping,
which is restricted to surface models (meshes, patches, polys, and NURBS
surfaces).

Displaced surfaces are smooth if the displaced polygons share normals;
otherwise, the displaced surfaces are faceted. Also, unless normals are shared,
faces can become separated in the displaced mesh. To prevent this, make sure
adjacent surfaces belong to the same shading group.

When the mental ray renderer is the active renderer, mental ray displacement
is the only displacement method used, unless your scene includes a Displace
modifier on page 1344, which always uses standard 3ds Max displacement.

TIP Before you render, you can disable or enable displacement by using the
Displacement toggle in the Options group on the Common Parameters rollout
on page 6121.

Global settings for the mental ray displacement method are in the
Displacement group on the Render Setup dialog > Renderer panel > Shadows
And Displacement rollout on page 6292.

See also:

■ mental ray Displacement on page 6268

■ mental ray Connection Rollout on page 5385

■ mental ray Material on page 5638
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Interface

3D Displacement (3dsmax) Parameters rollout

NOTE The button to the right of the Factor and Direction Strength controls is a
shortcut shader button. Clicking one of these buttons displays the Material/Map
Browser on page 5290 so you can assign a shader to this component. When a map
or a shader has been assigned to a component, this button displays the letter “M,”
and the comparable button on the Shaders rollout displays the map or shader
name.

Object Independent When on, the displacement effect is independent of the
size of the object's bounding box. When off, the displacement effect is scaled
according to the size of the object. Default=on.

Scaling the displacement based on object size is the standard behavior for
regular 3ds Max displacement mapping.

Displacement Length This is the length of displacement when Object
Independent is on, the extrusion map is at 100 per cent (white) and the
Extrusion Strength equals 1.0. Lower gray levels in the extrusion map, or other
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values of Extrusion Strength, scale the amount of displacement. When Object
Independent is off, this value is disregarded. Default=1.0.

Extrusion Strength Controls the height of the displacement. This value is a
multiplier: at the default value of 1.0, the map's effect is unchanged. Greater
values increase the effect of the map, and lower values decrease it. Default=1.0.

Extrusion Map Click to display the Material/Map Browser on page 5290 and
choose a map to use for the displacement. Displacement maps apply the gray
scale of the map to generate the displacement. Lighter colors in the 2D image
push outward more strongly than darker colors, resulting in a 3D displacement
of the geometry.

Direction Strength Controls the strength of the direction shader. Default=0.0.

IMPORTANT Adding a direction shader has no visible effect unless you set
Direction Strength to be greater than its default value of zero. (Direction Strength
values less than zero have no effect.)

Direction Map Click to display the Material/Map Browser on page 5290 and
choose a shader to use for the map direction. The direction of the displacement
is perturbed according to the RGB values of the shader output or map pixels.
Red values offset in the U axis, Green values offset in V, and Blue values offset
in W (using the object-local UVW coordinates).

Shaders rollout

The controls on this rollout let you assign a map or shader to the Factor or
Direction Strength parameters. Click the button for a component to display
the Material/Map Browser on page 5290 and assign the map or shader. Use the
toggle at the left to turn the effect of the map off or on.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinate on page 6013 and XYZ Coordinate on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.
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Bump Shader (mental ray)

Material Editor > mental ray material > Click the button for the Surface or
Bump component. > Material/Map Browser > Bump (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The Bump shader provides bump mapping for the mental ray renderer. Bumps
are created by perturbing face normals before the object is rendered, using the
same method as bump mapping on page 5478 for the scanline renderer.

WARNING Although you can assign a Bump shader to the Surface component,
if you assign only a Bump shader, the surface will render as black. For the Surface
component, use the Bump shader in a Shader List on page 6003, or for the mental
ray material on page 5638, use the Bump component itself.

Interface

Bump (3dsmax) Parameters rollout

Multiplier Adjust the bump effect by multiplying the map values. Negative
Multiplier values reverse the bump effect: hollow areas now protrude, and
raised areas become hollow. Default=1.0.

Map Click to display the Material/Map Browser on page 5290 and choose a map
to use for generating bumps. Bump mapping uses the intensity of the map to
affect the surface of the material. The intensity affects the apparent bumpiness
of the surface: white areas protrude, and black areas recede.
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Shaders rollout

The controls on this rollout let you assign a map or shader to the Multiplier
parameter. Click the button for a component to display the Material/Map
Browser on page 5290 and assign the map or shader. Use the toggle at the left
to turn the effect of the map off or on.

 The button to the right of the main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinate on page 6013 and XYZ Coordinate on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

DGS Material Shader (mental ray)

Material Editor > mental ray Connection rollout > Unlock the Surface or
Photon component. > Click the shader button for the Surface or Photon
component. > Material/Map Browser > DGS Material (3dsmax)

Material Editor > mental ray material > Click the button for the Surface or
Photon component. > Material/Map Browser > DGS Material (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

DGS stands for Diffuse, Glossy, Specular. This shader is a mental ray
phenomenon (a scripted shader tree) that provides a physically accurate
simulation of a surface. With the mental ray Connection rollout of a basic
3ds Max material, or a mental ray material, you can assign the DGS Material
shader to either the Surface or Photon component.

Despite the similarity in name, this shader is distinct from the DGS material
on page 5615. Both, in turn, provide a custom 3ds Max interface to the “DGS
Material Photon” shader that is part of the mental images physics library.
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Interface

Parameters rollout

NOTE The button to the right of the first six controls is a shortcut shader button.
Clicking one of these buttons displays the Material/Map Browser on page 5290 so
you can assign a shader to this component. When a map or a shader has been
assigned to a component, this button displays the letter “M,” and the comparable
button on the Shaders rollout displays the map or shader name.

Diffuse Click the color swatch to display a Color Selector on page 391 and
change the material's diffuse color.

Glossy Highlights Click the color swatch to display a Color Selector and
change the color of glossy highlights.
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Specular Click the color swatch to display a Color Selector and change the
color of mirror reflections. When the specular color is white, the material is
100 percent reflective, like a mirror. When the specular color is black, the
material does not reflect any of its surroundings.

Shiny Sets the width of glossy highlights. The larger this value, the smaller
the highlights. Default=30.0.

Transparency Specifies the transparency. The effective range of Transparency
is from 0.0 to 1.0. At 0.0 the material is fully opaque. At 1.0 it is fully
transparent. Default=0.0.

WARNING You can set the value of Transparency to be greater than 1.0, but this
has no effect. An anomaly of the user interface for shaders in the mental ray and
lume libraries, is that spinner values are not “clamped” to lie within their effective
ranges, as they are for controls in 3ds Max.

The value of Transparency also indirectly specifies the reflectivity of the
material, which is calculated as 1.0 minus the Transparency value.

Index Of Refraction Specifies the IOR. In the physical world, the IOR results
from the relative speeds of light through the transparent material and the
medium the eye or the camera is in. Typically this is related to the object's
density. The higher the IOR, the denser the object. Default=1.5.

See Extended Parameters Rollout (Standard Material) on page 5408 for a list of
IOR values for commonly encountered materials.

NOTE When the IOR equals 1.0, there is no refraction, and calculating the
transparency can take less time than when the material is refractive.

Lights When on, the material is illuminated only by those lights specified in
the list. When Lights is turned off, all lights in the scene affect the material.
Default=off.

The remaining light controls are unavailable unless Lights is turned on.

■ List of lights Displays the lights you have chosen to illuminate this
material.

■ Add Adds a light to the list. Click Add to turn it on, then click the light
object in a viewport.

■ Replace Replaces a light in the list. Highlight a light's name in the list,
click Replace to turn it on, then click the replacement light object in a
viewport.
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■ Delete Deletes a light from the list. Highlight a light's name in the list,
then click Delete.

Shaders rollout

The controls on this rollout let you assign a map or shader to one of the basic
parameters of the DGS Material shader. This is comparable to mapping a
component of a standard material; by adding shaders, you can create a shader
tree that generates complex effects.

Click the button for a component to display the Material/Map Browser on
page 5290 and assign the map or shader. Use the toggle at the left to turn the
effect of the map off or on.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.
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For all the DGS Material shader components, the available mental ray shaders
are the same:

LibraryShader

3ds MaxBump on page 5986

3ds MaxDGS Material (this shader)

baseDielectric

3ds MaxDielectric Material on page 5992

lumeEdge

lumeFacade

lumeGlass

lumeGlow

lumeLandscape

3ds MaxMaterial to Shader on page 6001

lumeMetal

lumeOcean

baseOpacity

baseReflect

baseRefract

3ds MaxShader List on page 6003
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LibraryShader

lumeStain

lumeTranslucency

physicsTransmat

baseTransparency

baseTwo Sided

3ds MaxUV Generator on page 6005

lumeWater Surface

lumeWet-Dry Mixer

3ds MaxXYZ Generator on page 6013

Dielectric Material Shader (mental ray)

Material Editor > mental ray Connection rollout > Unlock the Surface or
Photon component. > Click the shader button for the Surface or Photon
component. > Material/Map Browser > Dielectric Material (3dsmax) or
Dielectric Material Photon (3dsmax)

Material Editor > mental ray material > Click the button for the Surface or
Photon component. > Material/Map Browser > Dielectric Material (3dsmax)
or Dielectric Material Photon (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The Dielectric Material shader creates transparent, refractive materials that
are physically accurate. A dielectric material, such as glass, is a material whose
surface transmits most light that strikes it at angles close to perpendicular (90
degrees), but reflects most light that strikes at glancing angles (close to zero
degrees).
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When applied to the Surface component, this shader affects the surface's
appearance. When applied to the Photon component, it affects its photon
behavior for caustics and global illumination. (The Glass material is a mental
ray phenomenon (a scripted shader tree) that is equivalent to a mental ray
material on page 5638 with a Dielectric Material shader assigned to both its
Surface and Photon components, with the parameter settings identical for
both.)

NOTE This material does not use a shadow shader, so shadows will always be
opaque unless you use a Dielectric Material shader for the Photon component,
and generate caustics when you render.

Adjacent Refractive Materials

Two controls, Outside Light Persistence and Index Of Refraction (Out), are
for situations where you are modeling two adjacent refractive materials.
Consider a drink in a martini glass. The glass has an index of refraction (IOR)
of 1.5, while the alcohol in the glass has an IOR of about 1.3. To create a
physically accurate model of this situation, use three glass materials: one for
the glass itself, one for the alcohol, and a third material for the surfaces where
they touch each other. For this third material, set the “inside” IOR to 1.3, and
the outside IOR to 1.5.

mental ray Shaders | 5993



Interface

Light Persistence In conjunction with the Persistence Distance, controls the
percentage of light that the volume transmits. For example, if the color is set
to R=G=B=0.5 and the Persistence Distance is set to 2.0, then objects with a
thickness of 2.0 units will appear 50 per cent transparent. Default=white
(R=G=B=1.0).

Because transparency depends on the thickness of the object, objects with
varying thickness show different transparency depending on the angle from
which they are viewed.

Index Of Refraction Specifies the Index Of Refraction (IOR). In the physical
world, the IOR results from the relative speeds of light through the transparent
material and the medium the eye or the camera is in. Typically this is related
to the object's density. The higher the IOR, the denser the object. Default=1.5.

See Extended Parameters Rollout (Standard Material) on page 5408 for a list of
IOR values for commonly encountered materials.

Outside Light Persistence In conjunction with the Persistence Distance,
controls the percentage of light transmitted on the other side of a surface.
When set to the default of black, this control has no effect. See the section
“Adjacent Refractive Materials,” above. Default=black (R=G=B=0.0).
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Index Of Refraction (out) Sets the IOR on the other side of a surface. When
set to the default of zero, this control has no effect. See the section “Adjacent
Refractive Materials,” above. Default=0.0.

Persistence Distance In conjunction with the Light Persistence color, controls
the percentage of light that the volume transmits. It is the distance at which
light transmission is reduced to the percentage specified by the Light
Persistence RGB values. Default=1.0.

If you specify an Outside Light Persistence color, that setting also uses the
Persistence Distance.

Ignore Normals When on, the renderer does not use normals to decide
whether a light ray is entering or leaving the object. Normally, the shader uses
normals to decide whether a ray is entering or leaving an object. (It is entering
if the normal points toward the ray, leaving if the normal points away from
the ray.) This can present a problem for rendering objects whose normals are
not unified. When Ignore Normals is on, the shader decides whether a ray is
entering or leaving the object by counting the number of times the ray has
intersected the object. Default=off.

Opaque Alpha When on, refracted rays that touch the environment don't
generate a transparent alpha value. (This is how 3ds Max usually treats the
environment.) When off, refracted rays that touch the environment render a
transparent alpha value, which can help if you plan to use the rendering as
part of a composite. Default=off.

Phong Coefficient When greater than zero, generates Phong highlights on
the surface. The highlights appear in the sample slot. In general this value
must be greater than 10 for highlights to be apparent. Default=0.0.

Environment Shader (mental ray)

Material Editor > mental ray Connection rollout > Assign a shader to the
Environment component. > Material/Map Browser > Environment (3dsmax)

Material Editor > mental ray material > Assign a shader to the Environment
component. > Material/Map Browser > Environment (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The Environment shader lets you specify an environment that is local to the
material. Controls for the Environment shader are similar to those for a scene's
environment on the Render Setup dialog > Environment panel. However, the
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local Environment shader doesn't affect the scene background. Instead, it
provides an environment that the material can reflect or refract.

If an environment map is present, it generates the reflections or refractions,
and they are not ray traced.

Interface

Parameters rollout

NOTE The buttons to the right of the UseAlpha and Color controls are shortcut
shader buttons. Clicking one of these buttons displays the Material/Map Browser
on page 5290 so you can assign a shader to this component. When a map or a
shader is assigned to a component, this button displays the letter “M,” and the
comparable button on the Shaders rollout displays the map or shader name.

UseAlpha When on, uses the map's alpha channel, if it has one. The alpha
channel specifies those portions of the map that are transparent or translucent.
Default=off.

Color Click the color swatch to display a Color Selector on page 391 and choose
a color to use as the environment.

Map Click the button to display a Material/Map Browser on page 5290 and
choose a map to use as the environment.
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Shaders rollout

The controls on this rollout let you assign a map or shader to the UseAlpha
and Color parameters. Click the button for a component to display the
Material/Map Browser on page 5290 and assign the map or shader. Use the toggle
at the left to turn the effect of the map off or on.

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

Glare Shader (mental ray)

Render Setup dialog > Renderer panel > Camera Effects rollout > Camera
Shaders group > Click the Output button. > Material/Map Browser > Glare

The Glare shader, when used as a camera output shader on page 6289, creates
a halo around very bright areas in the rendered image. It’s applied in two
dimensions after rendering, so it can partially obscure darker objects between
the bright area and the camera for greater realism.

Interior with Glare shader for output;
default Glare settings

Interior lit by mr Sky Portal; no glare
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NOTE The glare effect from this shader is intended purely for illustrative purposes.
It is not designed to be physically accurate and is not suited for precise simulation
purposes.

Procedure

To use the Glare shader:

Using and adjusting the Glare output shader requires first assigning it on the
Render Setup dialog, and then instancing it in the Material Editor. This
procedure delineates the steps for doing so.

1 Make sure mental ray is the assigned renderer.

2 Open the Render Setup dialog (press F10), and on the Renderer panel, go
to the Camera Effects rollout.

3 On the Camera Effects rollout, click the Output button (labeled “None”
by default).

This opens the Material/Map Browser dialog.

4 In the shader list, double-click the Glare entry.

This assigns the shader and closes the browser.

5 Render the scene.

If the results are satisfactory, you can stop here. The remaining steps
concern adjusting the shader settings.

6 Open the Material Editor (press M), and, if necessary, the Render Setup
dialog.

7 Drag the Output button from the Camera Shaders group on the Render
Setup dialog to a sample slot on the Material Editor. When the Instance
(Copy) Map dialog prompts you, choose Instance, if necessary, and click
OK.

This places an instance of the Glare shader in the sample slot. Editing
this instance also modifies the output shader you originally assigned.

8 Adjust the Glare Parameters as necessary, rendering as you go to view the
results.
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Interface

Quality Lets you set the tradeoff between detail and speed. Lower Quality
settings cause Glare to run more quickly, but can result in a boxy-looking
glare halo, while a higher Quality value gives a better overall effect at the cost
of rendering time. A mid-level setting is appropriate for most scenes.

Spread Controls how sensitive Glare is to bright objects. Lower values for
Spread produce smaller glare halos while higher values cause larger glare halos.
Very high values can cause dark objects to have halos.

TIP The best way to enlarge an object's halo is to increase its brightness, not to
increase the Spread value.

Streaks When on, uses an image file you specify to create a streaking effect,
such as is visible when looking at bright images through glass or, in
photographs, through a camera lens.

Streak Image Click to choose an image file to be used to create the streak
effect. This file takes effect only when Streaks is on.

Streaks Weight Controls the blending between the "normal" glare and the
streaks image. A value of 0.0 disables streaks, while a value of 1.0 makes the
streaks fully visible.

Resolution for Glare Processing An absolute value specifying the image size,
in pixels, on which the Glare computation occurs. If you image is rendered
at 5000 x 5000 and Resolution for Glare Processing is set to 350, Glare will
effectively compute on a 350 x 350 image internally and reapplied on the
final image, possibly resulting in an inadeqate glare effect.
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Replace Rendered Image with Glare Only Generates an overlay image of
the glare effect only; the original underlying image is removed. This mode is
useful when render speed is critical, so that Glare can be run on a
lower-resolution image to produce an overlay, which you can then composite
with a higher-resolution underlying image.

Height Map Displacement Shader (mental ray)

Material Editor > mental ray Connection rollout > For the Displacement
component, turn off the lock button. > Click the button for the Displacement
component. > Material/Map Browser > Height Map Displacement (3dsmax)

Material Editor > mental ray material > Click the button for the Displacement
component. > Material/Map Browser > Height Map Displacement (3dsmax)

Note: Shaders don't appear unless the mental ray renderer is the currently
active renderer.

The Height Map Displacement shader displaces the geometry of surfaces, and
is specifically intended for use with height maps generated by normal mapping;
see Creating and Using Normal Bump Maps on page 6384.

IMPORTANT When applying a material containing this map to an object, the
mental ray Displacement > Smoothing option must be off. If such materials are
applied to all objects in the scene, you can turn off Smoothing globally on page
6294. Otherwise, turn off smoothing for each object whose material uses a height
map via the Object Properties > mental ray panel on page 322 (turn off Use Global
Settings and then turn off Smoothing).

TIP Avoid the temptation to apply MeshSmooth to a model when creating a
height map for it. This changes the shape of the model so the height values will
not be correct. The low-res model must have exactly the same shape when the
map is created and when it is used for displacement. Also, MeshSmooth does not
use the same algorithm as the mental ray displacement smoothing, so using both
forms of smoothing won't work perfectly. The best results are obtained by not
smoothing the low-res model when the map is created and also not using mental
ray smoothing.

Also, avoid using a paint program to modify the height map. The values in
the height map depend on the shape of both the low-res and high-res models,
and it's easy to damage the mathematical accuracy. If you paint any changes
onto the map, you must be careful to preserve the faceted look, and avoid the
temptation to blur away the facets.

6000 | Chapter 19   Material Editor, Materials, and Maps



You might try painting in Additive and Subtractive mode to add or subtract
to the displacement, because Normal mode will set a fixed displacement,
making it difficult for an artist to control the result.

See also:

■ 3D Displacement Shader (mental ray) on page 5983

■ mental ray Displacement on page 6268

■ mental ray Connection Rollout on page 5385

■ mental ray Material on page 5638

Interface

Height Map Displacement (3dsmax) Parameters rollout

Be sure to enter the same values for Minimum and Maximum Height as the
equivalents on the Projection Options dialog, as specified below.

Minimum Height The “Min Height” value specified on the Render to Texture:
Projection Options dialog on page 6416 when creating the height map.
Default=-10.0.

Maximum Height The “Max Height” value specified on the Render to Texture:
Projection Options dialog on page 6416 when creating the height map.
Default=10.0.

Height Map The height map itself (usually a bitmap).

Material to Shader (mental ray)

Material Editor > mental ray Connection rollout > Assign a shader. >
Material/Map Browser > Material to Shader
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Material Editor > mental ray or DGS material > Assign a shader. > Material/Map
Browser > Material to Shader

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

Lets you use a regular 3ds Max material as a shader. Depending on the
component to which this shader is assigned (Surface, Shadow, Displacement,
Volume, and so on), the mental ray renderer uses the appropriate material
component.

For example, if you want a mental ray material's Surface component to look
like a standard material you have, assign Material To Shader as the Surface
shader, and then assign it the standard material.

NOTE Material To Shader doesn't work as an environment background. Use the
original 3ds Max material, instead.

TIP To edit the material assigned to Material To Shader, you can drag the button
to an unused sample slot in the Material Editor (be sure to choose Instance when
prompted). Or you can follow these steps:

1 In an unused sample slot, create the material and adjust its settings.

2 Save the material to a library.

3 Assign the Material To Shader to its component.

4 When you click the Material To Shader's shader button, browse from the
library and load the material you prepared in advance.

If you need to further adjust the material, you can repeat these steps (without
having to reassign the Material To Shader).

Interface

Material button Click to display the Material/Map Browser on page 5290 and
choose the material to use for shading.
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 mr Labeled Element Shader (mental ray)

Material Editor > any material > Click a map button > Material/Map Browser
> mr Labeled Element

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The mr Labeled Element shader doesn’t actually function as a shader, but
instead works in conjunction with the mr Labeled Element render element
on page 6363 to let you output any branch of a shader tree (a string of nested
maps) as a render element. For example, if you use the Checker map as a
diffuse map, and you use a Perlin Marble map as one of the two checker colors,
you can render only the checker-map components that contain the marble
map to a custom element for subsequent compositing.

For details on using the mr Labeled Element shader, see To use the mr Labeled
element: on page 6363.

Interface

Shader/Map to Store (Passthrough) Click the map button to assign a shader
or map or shader/map branch to be passed to the render element. If a shader
or map is already assigned, the button is labeled “M”; click the button to edit
the shader or map.

Label Enter the same name as that assigned to the render element.

Shader List (mental ray)

Material Editor > mental ray Connection rollout > Assign a shader. >
Material/Map Browser > Shader List

Material Editor > mental ray, DGS, or Glass material > Assign a shader. >
Material/Map Browser > Shader List
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Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The Shader List shader provides an interface for constructing a mental ray
shader list. A shader list combines the effect of multiple shaders: each shader
is called in turn, the first one's output being treated as input to the next, and
so on.

Interface

List of shaders Shows the names of the shaders in the list. Highlight a shader's
name to alter its position in the list, or to access its parameters.

Each active shader in the list is called in order, from top to bottom.

Up Moves the selected shader up in the list.

Down Moves the selected shader down in the list.

Add Shader Displays a Material/Map Browser on page 5290 so you can choose
a shader to add to the list.

Remove Selected Removes the selected shader from the list.
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Selection group

On When on, the shader is active. When off, the shader is inactive and isn't
called. You can use this toggle to disable a shader without removing it from
the list entirely.

Shader button Shows the name of the currently selected shader. Click the
button to view that shader's parameters in the Material Editor.

 When you are done adjusting an individual shader's parameters, you
can click Go To Parent to return to the Shader List Parameters rollout.

UV Generator Shader (mental ray)

Material Editor > Any shader with a Coords parameter (or other vector value).
> Click the shader button. > Material/Map Browser > UV Generator (3dsmax)

Material Editor > mental ray Connection rollout > Unlock the Surface
component and click the shader button. > Material/Map Browser > UV
Generator (3dsmax)

Material Editor > DGS material > Assign a shader to any component. >
Material/Map Browser > UV Generator (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The UV Generator shader returns 2D mapping coordinates. You can use its
settings to adjust a 2D map. The parameters for this shader are equivalent to
parameters on the Coordinates rollout for 2D maps on page 5782.

Interface

The interface for this shader consists of two rollouts:

UV Generator Parameters Rollout on page 6006

Shaders Rollout (UV Generator) on page 6010
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UV Generator Parameters Rollout

Material Editor > Any shader with a Coords parameter (or other vector value).
> Click the shader button. > Material/Map Browser > UV Generator (3dsmax)
> UV Generator (3dsmax) Parameters rollout

Material Editor > mental ray Connection rollout > Unlock the Surface
component and click the shader button. > Material/Map Browser > UV
Generator (3dsmax) > UV Generator (3dsmax) Parameters rollout

Material Editor > DGS material > Assign a shader to any component. >
Material/Map Browser > UV Generator (3dsmax) > UV Generator (3dsmax)
Parameters rollout

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The parameters for this shader are equivalent to parameters on the Coordinates
rollout for 2D maps on page 5782.

6006 | Chapter 19   Material Editor, Materials, and Maps



Interface
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MapSlotType Chooses whether the map is applied as an environment map
or a texture map. Default=0 (Texture).

■ 0 is for a Texture map.

■ 1 is for an Environment map.

EnvType If the map is applied as an environment map, this value chooses
the mapping type. If the map is applied as a texture map, this value is ignored.
Default=4 (screen).

■ 1 is for Spherical.

■ 2 is for Cylindrical.

■ 3 is for Shrink-Wrap.

■ 4 is for Screen.

Screen projection projects as a flat backdrop in the scene. See UVW Map
Modifier on page 1931 for a description of spherical, cylindrical, and shrink-wrap
projection.

MapChannel If the map is applied as a texture map and UVWSource is set to
0 (Explicit), this value sets the map channel index; otherwise, this value is
ignored. Range=1 to 99. Default=1.

UVWSource If the map is applied as a texture map, this value chooses the
source of UVW coordinates. If the map is applied as an environment map,
this value is ignored. Default=0 (Explicit).

■ 0 is for Explicit.
When Explicit is the source, use MapChannel to set the specific map
channel.

■ 1 is for Object XYZ.
Object XYZ uses planar mapping based on the object's local coordinates
(disregarding the pivot point location). For rendering purposes, planar
mapping doesn't project through to the back of the object unless you turn
on ShowMapOnBack.

■ 2 is for World XYZ.
World XYZ uses planar mapping based on the scene’s world coordinates
(disregarding the object’s bounding box). For rendering purposes, planar
mapping doesn't project through to the back of the object unless you turn
on ShowMapOnBack.
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ShowMapOnBack When on, planar mapping (Planar from Object XYZ, or
with the UVW Map modifier) projects through to render on the back of the
object. When off, planar mapping doesn't render on the object's back.
Default=on.

This toggle is available only when Tiling is off in both dimensions. Its effect
is visible only when you render the scene.

NOTE In viewports, planar mapping always projects to the back of the object,
whether Show Map On Back is turned on or not. To override this, turn off Tiling.

UOffset Changes the U position of the map in UV coordinates on page 8161.
The map moves in relation to its size. Default=0.0.

For example, if you want to shift the map its full width to the left, and half
its width downward from its original position, you enter -1 in the U Offset
field and 0.5 in the V offset field.

UScale Determines the number of times the map is tiled on page 8148 (repeated)
along the U axis. Default=1.0.

UWrap Turns tiling on or off in the U axis. Default=on.

UMirror Mirrors on page 8148 the map left-to-right along the U axis. Default=off.

VOffset Changes the V position of the map in UV coordinates. Default=0.0.

VScale Determines the number of times the map is tiled (repeated) along the
V axis. Default=1.0.

VWrap Turns tiling on or off in the V axis. Default=on.

VMirror Mirrors the map top-to-bottom along the V axis. Default=off.

UAngle, VAngle, and WAngle Rotate the map about the U, V, or W axis (in
degrees). Default=0.0.

UVAxis Changes the mapping coordinate system used for the map. The default
UV coordinates project the map onto the surface like a slide projector. The
VW and WU coordinates rotate the map so that it is perpendicular to the
surface. Default=0 (UV).

■ 0 is for UV.

■ 1 is for VW.

■ 2 is for WU.

Clip When on, UVs are clipped. When off, UVs are wrapped. Default=on.
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Blur Affects the sharpness or blurriness of the map based on its distance from
the view. The farther away the map is, the greater the blurring. The Blur value
blurs maps in world space. Blur is primarily used to avoid aliasing on page 7904.
Default=1.0.

BlurOffset Affects the sharpness or blurriness of the map without regard to
its distance from the view. Blur Offset blurs the image itself in object space.
Use this option when you want to soften or defocus the details in a map to
achieve the effect of a blurred image. See Blur / Blur Offset on page 7928.
Default=0.0

Noise When on, noise settings affect the map. When off, no noise is applied.
Default=off.

Animate Determines if the noise effect is animated. This parameter must be
turned on if you intend to animate the noise. Default=off.

Amount Sets the strength of the fractal function, expressed as a percentage.
If the amount is 0 there is no noise. If the amount is 100 the map becomes
pure noise. Default-1.0.

Size Sets the scale of the noise function relative to geometry. At very small
values, the noise effect becomes white noise. At large values, the scale can
exceed the scale of the geometry, in which case it has little or no effect.
Range=0.001 to 100. Default=1.0.

Level Or iterations: the number of times the function is applied. The effect
of the level is dependent on the Amount value. The stronger the amount, the
greater the effect of increasing the Level value. Range=1 to 10. Default=1.

Phase Controls the speed of the animation of the noise function. Default=0.0.

RealWorldMapSize Controls the scaling method used for texture mapped
materials that are applied to the object. The scaling values are controlled by
the Use Real-World Scale settings found on the applied material's Coordinates
rollout. Default=on.

Shaders Rollout (UV Generator)

Material Editor > Any shader with a Coords parameter (or other vector value).
> Click the shader button. > Material/Map Browser > UV Generator (3dsmax)
> Shaders rollout
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Material Editor > mental ray Connection rollout > Unlock the Surface
component and click the shader button. > Material/Map Browser > UV
Generator (3dsmax) > Shaders rollout

Material Editor > DGS material > Assign a shader to any component. >
Material/Map Browser > UV Generator (3dsmax) > Shaders rollout

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The controls on this rollout let you assign a map or shader to one of the basic
parameters of the UV Generator shader. This is comparable to mapping a
component of a standard material; by adding shaders, you can create a shader
tree that generates complex effects.
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Interface

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
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Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.

IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

UV Coordinate Shader (mental ray)

Material Editor > Any shader with a Coords parameter or other vector value.
> Click the shader button. > Material/Map Browser > UV Coordinate (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

This shader is identical to the UV Generator shader on page 6005, except that
it returns two values instead of one.

■ The UV coordinate (same value as UV Generator would return)
This value is named UV.

■ The UV coordinate's derivative
This value, also a vector, is named dUV.

When you choose this shader, a Connect Parameter To Shader dialog on page
5981 is displayed, prompting you to choose which of the two values to use. You
can later change the choice of value by using the “dot” button to the right of
the main shader button.

Interface

The UV Coordinate shader has the same parameters as the UV Generator
shader. See UV Generator Parameters Rollout on page 6006 for a description of
the basic settings.

XYZ Generator Shader (mental ray)

Material Editor > Any shader with a Coords parameter (or other vector value).
> Click the shader button. > Material/Map Browser > XYZ Generator (3dsmax)
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Material Editor > mental ray Connection rollout > Unlock the Surface
component and click the shader button. > Material/Map Browser > XYZ
Generator (3dsmax)

Material Editor > DGS material > Assign a shader to any component. >
Material/Map Browser > XYZ Generator (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The XYZ Generator shader returns 3D mapping coordinates. You can use its
settings to adjust a 3D map. The parameters for this shader are equivalent to
parameters on the Coordinates rollout for 3D maps on page 5861.

Interface

The interface for this shader consists of two rollouts:

XYZ Generator Parameters Rollout on page 6014

Shaders Rollout (XYZ Generator) on page 6016

XYZ Generator Parameters Rollout

Material Editor > Any shader with a Coords parameter (or other vector value).
> Click the shader button. > Material/Map Browser > XYZ Generator (3dsmax)
> XYZ Generator (3dsmax) Parameters rollout

Material Editor > mental ray Connection rollout > Unlock the Surface
component and click the shader button. > Material/Map Browser > XYZ
Generator (3dsmax) > XYZ Generator (3dsmax) Parameters rollout

Material Editor > DGS material > Assign a shader to any component. >
Material/Map Browser > XYZ Generator (3dsmax) > XYZ Generator (3dsmax)
Parameters rollout

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The parameters for this shader are equivalent to parameters on the Coordinates
rollout for 3D maps on page 5861.
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Interface

CoordinateSystem Chooses the source coordinate system. Default=0 (Object
XYZ).

■ 0 is for Object XYZ.
Object XYZ uses the object’s local coordinate system.

■ 1 is for Explicit Map Channel.
Lets you use the MapChannel value to choose any channel from 1 to 99.

■ 3 is for World XYZ.

MapChannel When Explicit Map Channel is the coordinate system source,
this value lets you set the map channel; otherwise, it is ignored. Range=1 to
99. Default=1.

Offset Moves the map pattern in X, Y, and Z. Default=(0.0, 0.0, 0.0).

Tiling Tiles on page 8148 the map pattern in X, Y, and Z, and makes the pattern
narrower. Default=(1.0, 1.0, 1.0).

Angle Rotates the map pattern in X, Y, and Z. Default=(0.0, 0.0, 0.0).

Blur Affects the sharpness or blurriness of the map based on its distance from
the view. The farther away the map is, the greater the blurring. The Blur value
blurs maps in world space. Blur is primarily used to avoid aliasing. Default=1.0.

BlurOffset Affects the sharpness or blurriness of the map without regard to
its distance from the view. Blur Offset blurs the image itself in object space.
Use when you want to soften or defocus the details in a map to achieve the
effect of a blurred image. Default=0.0.
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Shaders Rollout (XYZ Generator)

Material Editor > Any shader with a Coords parameter (or other vector value).
> Click the shader button. > Material/Map Browser > XYZ Generator (3dsmax)
> Shaders rollout

Material Editor > mental ray Connection rollout > Unlock the Surface
component and click the shader button. > Material/Map Browser > XYZ
Generator (3dsmax) > Shaders rollout

Material Editor > DGS material > Assign a shader to any component. >
Material/Map Browser > XYZ Generator (3dsmax) > Shaders rollout

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

The controls on this rollout let you assign a map or shader to one of the basic
parameters of the XYZ Generator shader. This is comparable to mapping a
component of a standard material; by adding shaders, you can create a shader
tree that generates complex effects.

Interface

 The button to the right of each main shader button is for shaders that
can return multiple parameters. If a shader that returns multiple parameters
is assigned to the component, the button's tooltip shows the parameter name.
Clicking the button displays a Connect Parameter To Shader dialog on page
5981, which lets you change which parameter is being used.
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IMPORTANT UV Coordinates on page 6013 and XYZ Coordinates on page 6017 are
the only shaders with multiple return values provided with 3ds Max. You might
encounter multiple return values in shaders provided with other shader libraries
or custom shader code.

XYZ Coordinate Shader (mental ray)

Material Editor > Any shader with a Coords parameter or other vector value.
> Click the shader button. > Material/Map Browser > XYZ Coordinate (3dsmax)

Note: Shaders appear in the Browser only if the mental ray renderer is the
currently active renderer.

This shader is identical to the XYZ Generator shader on page 6013, except that
it returns two values instead of one.

■ The XYZ coordinate (same value as XYZ Generator would return)
This value is named XYZ.

■ The XYZ coordinate's derivative
This value, also a vector, is named dXYZ.

When you choose this shader, a Connect Parameter To Shader dialog on page
5981 is displayed, prompting you to choose which of the two values to use. You
can later change the choice of value by using the “dot” button to the right of
the main shader button.

Interface

The XYZ Coordinate shader has the same parameters as the XYZ Generator
shader. See XYZ Generator Parameters Rollout on page 6014 for a description of
the basic settings.

 Production Shaders

The Production Shaders category of advanced mental ray shaders comprises
several texture shaders, a lens shader, and two output shaders, all covered in
this section. Also part of the Production Shaders library is the
Matte/Shadow/Reflection material on page 5622.
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Texture Shaders

 Environment/Background Switcher (mi)

Environment and Effects dialog > Click Environment Map button. >
Material/Map Browser > Environment/Background Switcher (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently
active renderer.

The Environment/Background Switcher map lets you use one map as a
background and another as an environment map, to provide environmental
reflections.

In typical usage, you use the Environment/Background Switcher as an
Environment map. As the Background map you apply a background image,
preferably using the  Environment/Background Camera Map (mi) on page 6020
shader.

As the Environment/Reflections map, use an environment map. If you have
a plain photograph of a chrome ball taken from a similar camera angle as the
background, you can use  Environment Probe/Chrome Ball (mi) on page 6023
shader for easy, automatic unwrapping, or, if you have a fully unwrapped
environment-map image, use a Bitmap map in Spherical Environment mode.

For details, see the following procedure.

NOTE While the Environment/Background Switcher is most commonly used as
an environment map, it can be used in other places as well. It will use the
Background result for anything that is seen directly by the camera, and the
Environment/Reflection for anything seen indirectly, as in reflections, refractions,
etc.
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Procedure

To use the Environment/Background Switcher map:

This procedure assumes you have two photographs: one of a background, and
another an image of a mirror/chrome ball, both taken from roughly the same
camera position. The photo of the chrome ball should be cropped so that it
exactly touches the edges of the ball. The best result is obtained if at least the
chrome ball photo is HDR, but good results can be achieved with a traditional,
non-HDR phogograph.

NOTE This workflow applies to stills or video sequences with only slight camera
movement. For any complex fly-around camera motion, the simple
"auto-unwrapping" performed by the Environment Probe/Chrome Ball shader will
not suffice.

1 Open the Environment And Effects dialog to the Environment panel on
page 6689.

2 On the Common Parameters rollout, click the Environment Map button.
This opens the Material/Map Browser.

3 From the browser list, choose Environment/Background Switcher (mi).

The Environment Map button label now shows the name of the map.

4 Open the Material Editor.

5 Drag the Environment Map button to a sample sphere in the Material
Editor. Confirm the Instance choice.

This displays the Environment/Background Switcher (mi) Parameters
rollout in the Material Editor.

6 Click the Background map button. From the Material/Map Browser,
choose a map;  Environment/Background Camera Map (mi) on page 6020
is the recommended choice.

This displays the map’s parameters rollout. Click the Map button
(“Browse”) and choose a bitmap file for the background image.

7  Click Go To Parent to return to the Switcher controls.

8 Click the Environment/Reflections map button. From the Material/Map
Browser, choose a map;  Environment Probe/Chrome Ball (mi) on page
6023 is the recommended choice.
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This displays the map’s parameters rollout. Click the Map button
(“Browse”) and choose a bitmap file for the background image. Ideally,
the bitmap is an HDR photograph of a chrome or mirror ball taken from
the camera perspective in the scene, but a non-HDR photo also works
well.

Or, if you have a fully unwrapped environment map photo, use it as a
Bitmap map and, on the Coordinates rollout, choose Environ and set
Mapping to Spherical Environment.

9 Adjust the various maps’ parameters as necessary and then render the
scene.

Interface

Background Specifies the background color or map. The background shows
up wherever it is not blocked by a foreground object, or transmitted by a
transparent object.

Environment/Reflections Specifies the environment color or map. This image
or color shows up in reflective surfaces.

 Environment/Background Camera Map (mi)

Material Editor > Click any map button. > Material/Map Browser >
Environment/Background Camera Map (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently
active renderer.

This shader is similar in function to using a Bitmap map with environment
mapping set to Screen as an Environment Map. However, Screen mapping
simply chooses a pixel from the map based on the coordinates of the currently
rendered pixel. This does not work well with reflections.
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In contrast, the Environment/Background Camera Map shader correctly renders
“back transformation.'' In other words, for a point seen in a reflection, it takes
the reflected point’s 3D coordinate, convert it to its matching onscreen position
(if any), and looks up the map based on this new 2D location (or returns a
special value if the point is offscreen).

Back Transformation

In the following discussion of back transformation in the context of the
Environment/Background Camera Map, refer to this illustration:

Imagine the green ray coming from the camera hitting the screen (blue
rectangle) at the green "+". Using the Bitmap map set to Screen environment
mapping mode as the Environment Map, the background-image location
corresponding to this screen coordinate will be used for anything that happens
to this ray. Even when it hits the teapot and bounces to the floor (green dot),
this would be still be textured with the texture background pixel from the
green "+" location.

In contrast, the Environment/Background Camera Map shader would transform
the point (green dot) to a new screen coordinate (imaginary red ray) and use
the value from the red "+" instead.
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The yellow ray, however, hits the reflective object at some other location, and
its reflected location (yellow dot) is outside the screen. For these cases, the
shader would use its Off-screen settings.

Interface

Map Click the Browse button to specify a bitmap file containing the
background image. Alternatively, click the map button to specify a procedural
map.

Multiplier A multiplier for the background image.

Reverse Gamma Correction Applies inverse gamma correction to the texture.

Per-Pixel Matching Matches the image to the background on a pixel-per-pixel
basis, with the bottom-left pixel of the map matched exactly to the bottom-left
rendered pixel. If the pixel size of the map differs from the pixel size of the
rendered output, the renderer issues a warning. However, it still renders the
image, cropping or padding it as necessary.

Force Transparent Alpha When on, forces the background alpha to 0. When
off, mental ray uses the actual alpha from the bitmap image or procedural
map. If the file contains no alpha data, returns opaque alpha values when off.

Off-screen Rays return Environment When on, uses the scene environment
for off-screen points.

Because the shader back-transforms points such as those seen in reflections
into screen space, it might happen that parts of surfaces reflect points that
are not on the screen. Because the projected map contains data only for points
on the screen, this option allows a reasonable alternative for off-screen points.
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Off-screen Color (When Above Off) Defines the color of off-screen points
when Off-Screen Rays Return Environment (see previous) is off.

 Environment Probe/Chrome Ball (mi)

Material Editor > Click any map button. > Material/Map Browser >
Environment Probe/Chrome Ball (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently
active renderer.

This shader is intended as an environment shader (apply as an Environment
Map), because it looks up based on the ray direction. It maps the proper
direction to a point on the chrome ball and retrieves its color.

In the visual effects industry it is common practice to photograph a chrome
ball (also known as a “light probe”) on set, as well as a gray ball on page 6024
for lighting reference.

Ideally, one shoots these at multiple exposures and uses software such as
Photosphere (Macintosh) or HDRShop (PC) to combine them into a single
high-dynamic-range image and/or unwrap the chrome/gray ball into a spherical
environment map.

However, it is often difficult to regain the proper orientation of spherical map
so it matches the camera used to render the CG scene. Furthermore, a single
photo of a chrome/gray ball contains poor data for certain angles that one
might want to avoid seeing in the final render.

These shaders are intended to simplify a special case: When the chrome/gray
ball is already shot from the exact camera angle from which the final image
is to be rendered.

It simply utilizes the mental ray camera coordinate space and applies the
chrome/gray ball in this space, hence the orientation of the reflections will
always “stick” to the rendering camera.

For additional information and illustrations, see Help menu > Additional Help
> mr Production Shader Library > Chapter 6: Mirror/Gray Ball Shaders.
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Interface

Chrome/Mirror Ball Image Click the Browse button to specify the file
containing the chrome ball image. The image should be cropped so the ball
exactly touches the edges of the image. Alternatively, click the map button
to specify a procedural map.

Multiplier A multiplier for the chrome ball image.

Reverse Gamma Correction Applies an inverse gamma correction to the
texture.

Blur (literal mental ray image files only) Blur the image. This applies only
to literal mental ray textures; that is, bitmap images specified with the Browse
button, rather than maps specified with the map button.

 Environment Probe/Gray Ball (mi)

Material Editor > Click any map button. > Material/Map Browser >
Environment Probe/Gray Ball (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently
active renderer.

This shader can be used either as an environment shader or a texture shader,
because it looks up based on the direction of the surface normal. It will map
the normal vector direction to a point on the gray ball and retrieve its color.

In the visual effects industry it is common practice to photograph a chrome
ball on page 6023 (also known as a “light probe”) on set, as well as a gray ball
for lighting reference.

Ideally, one shoots these at multiple exposures and uses software such as
Photosphere (Macintosh) or HDRShop (PC) to combine these into a single
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high-dynamic-range image and/or unwrap the chrome/gray ball into a spherical
environment map.

However, it is often difficult to regain the proper orientation of spherical map
so it matches the camera used to render the CG scene. Furthermore, a single
photo of a chrome/gray ball contains poor data for certain angles that one
might want to avoid seeing in the final render.

These shaders are intended to simplify a special case: When the chrome/gray
ball is already shot from the exact camera angle from which the final image
is to be rendered.

It simply utilizes the mental ray camera coordinate space and applies the
chrome/gray ball in this space, hence the orientation of the reflections will
always “stick” to the rendering camera.

For additional information and illustrations, see Help menu > Additional Help
> mr Production Shader Library > Chapter 6: Mirror/Gray Ball Shaders.

Interface

Chrome/Mirror Ball Image Click the Browse button to specify the file
containing the gray ball image. The image should be cropped so the ball
exactly touches the edges of the image. Alternatively, click the map button
to specify a procedural map.

Multiplier A multiplier for the gray ball image.

Reverse Gamma Correction Applies an inverse gamma correction to the
texture.

Blur (literal mental ray image files only) Blur the image. This applies only
to literal mental ray textures; that is, bitmap images specified with the Browse
button, rather than maps specified with the map button.
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 Utility Gamma & Gain (mi)

Material Editor > Click any map button. > Material/Map Browser > Utility
Gamma & Gain (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently
active renderer.

This is a simple shader that applies a gamma and a gain (multiplication) of a
color or map. Many similar shaders exist in various OEM integrations of mental
ray, so this shader is primarily of interest for standalone mental ray and for
cross-platform phenomena development.

The shader can also be used as a simple gamma lens shader, in which case the
input is not used, but the eye ray color is used instead.

Interface

Input Specifies the input color or map.

Gamma The gamma applied to the input.

Gain (multiplier) The multiplier for the input.

Reverse Gamma Correction (De-Gamma) When off, the shader takes the
input, multiplies it by the Gain value, and then applies a gamma correction
of Gamma to the color. When on, the shader takes the input, applies a reverse
gamma correction of Gamma to the color, and then divides it by the Gain
value.
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Lens Shader

 Render Subset of Scene/Masking (mi)

Render Setup dialog > Renderer panel > Camera Effects rollout > Camera
Shaders group > Lens button > Material/Map Browser > Render Subset of
Scene/Masking (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently
active renderer.

This shader allows re-rendering a subset of the objects in a scene, defined by
object or material. It is intended for a “quick fix” solution when almost
everything in a scene is perfect, but just one object or material needs a small
tweak.

NOTE This shader works for first-generation rays only. Thus, for example, refracted
or reflected rays from an object do not show up in the rendering.

Procedure

To use the Render Subset of Scene/Masking map:

1 Open the Render Setup dialog to the Renderer panel on page 6272.

2 On the Camera Effects rollout, click the Camera Shaders group > Lens
button. This opens the Material/Map Browser.

3 From the browser list, choose Render Subset of Scene/Masking (mi).

The Lens button label now shows the name of the map.

4 Open the Material Editor.

5 Drag the Lens button to a sample sphere in the Material Editor. Confirm
the Instance choice.

This displays the Render Subset of Scene/Masking (mi) Parameters rollout
in the Material Editor.

6 Specify an object list or material to render and make any necessary
additional settings.
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TIP If you specify a material, choose it from the scene (set Browse From to
Scene).

7 Render the scene.

Only the specified objects render.

Interface

Object List The object or objects to be rendered. Use the Add, Replace, and
Delete buttons to edit the list.

Material Specifies a material to render.

NOTE If you specify a material but no objects, all objects containing that material
will render. If you specify a material as well as several objects with different
materials, only objects with the specified material will render.

NOTE The Render Subset of Scene/Masking shader does not support the
Multi/Sub-Object material on page 5720. However, it does support component
materials of a Multi/Sub-Object material.
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Mask Only Outputs only the mask color (see following) in the specified
objects’ locations; this is very fast. Use this if you only want to locate the
objects in the scene.

Rays not hitting any objects return the Background color, and rays hitting
any object not in the subset return the Other Objects color.

Mask Color The color returned for specified objects when Mask Only is on.

Color of Background The color returned for the background when Mask
Only is on.

Color of Other Objects The color returned for non-specified objects when
Mask Only is on.

Calculate FG on All Objects (Entire Image) Determines whether the final
gather (FG) preprocessing should apply to all objects, or only those in the
subset. Because FG blends neighboring FG samples, a given object might use
information in FG points coming from nearby objects not in the subset. This
is especially true if the objects are coplanar. Therefore it is advised to let the
FG prepass “see” the entire scene.

Turning off this option and creating FG points only for the subset of objects
is faster, but there is a certain risk of boundary artifacts, especially in
animations. If the scene uses a saved FG map, this option can be left off.

Output Shaders

 Motion Vector Export (mi)

Render Setup dialog > Renderer panel > Camera Effects rollout > Camera
Shaders group > Output button > Material/Map Browser > Motion Vector
Export (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently
active renderer.

This shader is intended for those who wish to do compositing work before
applying motion blur, or to use a specific third-party motion-blur shader. Its
purpose is to export motion in pixel space (mental ray’s standard motion
vector format is in world space) encoded as a color.
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Most third-party tools expect the motion vector encoded as colors where red
is the X axis and green is the Y axis. To fit into the confines of a color
(especially when not using floating point and a color range extends only from
black to white), the motion is scaled by a factor (here called Max Displace)
and the resulting value range, which is -1 to 1, is mapped to the color channel’s
0 to 1 range. The shader also support a couple of different floating point output
modes.

Interface

Max Displace (pixels) Sets the maximum encoded motion vector length.
Motion vectors of this number of pixels or above are encoded as the maximum
value that is possible to express within the limit of the color (that is, white or
black).

To maximally utilize the resolution of the chosen image format, it is
recommended that you use a Max Displace value of 50.0 (the default) for
eight-bit images (which are not really suitable for this purpose) and a value
of 2000.0 for 16-bit images. The shader outputs an informational statement
of the maximum motion vector encountered in a frame to aid in tuning this
parameter. For details, consult the documentation for your third-party
motion-blur shader.

If Max Displace is 0.0, motion vectors are encoded relative to the image
resolution. For example, for an image 600 pixels wide and 400 pixels high, a
movement of 600 pixels in positive X is encoded as 1.0 in the red channel,
while a movement 600 pixels in negative X is encoded as 0.0. A movement
in positive Y of 400 pixels is encoded as 1.0 in the blue channel etc.

Blue Channel is Magnitude When on, the blue color channel represents the
magnitude of the blur, and the red and green channels encode the 2D direction
only. When off, the blue channel is unused and the red and green channels
encode both direction and magnitude.

Floating Point Format When not set to 0, the shader writes real, floating-point
motion vectors into the red and green channels. They are not normalized to
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the max displace length, not clipped, and contain both positive and negative
values. When this option is used, neither Max Displace nor Blue Channel Is
Magnitude have any effect.

The floating-point format options are:

■ 1 The actual pixel count is written as-is in floating point.

■ 2 The pixel aspect ratio is taken into account such that the measurement
of the distance the pixel moved is expressed in pixels in the Y direction,
and the X component will be scaled by the pixel aspect ratio. This format
is compatible with Autodesk Toxik.

Blur Environment/Background When on, motion vectors are generated for
the empty background area controlled by the camera movement.

NOTE This option does not work when the Scanline rendering algorithm on page
6279 is enabled.

 HDR Image Motion Blur (mi)

Render Setup dialog > Renderer panel > Camera Effects rollout > Camera
Shaders group > Turn on Output. > Output button > Material/Map Browser >
HDR Image Motion Blur (mi)

NOTE Shaders appear in the Browser only if the mental ray renderer is the currently
active renderer.

This shader applies fast, grain-free motion blur as a post process. It works by
using pixel motion vectors stored in the rendering phase and “smearing" these
into a visual simulation of motion blur.

Like using the rasterizer, this means that features such as mirror images or
even objects seen through foreground transparent object will “streak" together
with the foreground object. Furthermore, since the motion frame buffer only
stores one segment, the “streaks" are always straight, never curved.

The major advantage of this method is rendering speed. Scene or shader
complexity has no impact. The blur is applied as a mental ray “output shader"
that is executed after the main rendering pass. The execution time of the
output shader depends on how many pixels need to be blurred, and how far
each pixel needs to be “smeared.”
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NOTE Because the shader works in post, it does not blur shadows or reflections
of moving objects. If these effects are necessary, use standard motion-blur methods.

Interface

Shutter Duration (frames) The amount of time the shutter is “open.” In
practice this means that after the image has been rendered the pixels are
smeared into streaks in both the forward and backward direction. Each smear
length is half the distance the object moves during the shutter time.

Shutter Falloff (Blur Softness) The drop-off speed of the smear; that is, how
quickly it fades to transparent. This setting controls the “softness" of the blur.

NOTE The perceived length of the motion blur diminishes as the Falloff value
increases, so it might be necessary to compensate by increasing the Shutter
Duration value slightly.

Thus, falloff is especially useful for creating the effect of over-bright highlights
“streaking" convincingly: By using an inflated shutter length (above the
cinematic default of 0.5) and a higher falloff, over-brights have the potential
to smear in a pleasing manner.

Blur Environment/Background Determines whether the camera environment
(that is, the background) should be blurred by the cameras movement or not.
When on, pixels from the environment are blurred, and when off they are
not.

NOTE This option does not work when the Scanline rendering algorithm on page
6279 is enabled.

6032 | Chapter 19   Material Editor, Materials, and Maps



Calculation Color Space (Gamma) Defines the gamma color space in which
blur calculations occur. Because mental ray output shaders act on written
frame buffers, and these buffers (unless floating point) already have any gamma
correction applied, it is important to apply post effects with the appropriate
gamma.

Min. Motion Threshold (pixels) The minimum motion-vector length
(measured in pixels) an object must move for blur to be added. If set to 0.0,
it has no effect, and every object with even sub-pixel movement will have a
slight amount of blur. While this is technically accurate, it might cause the
image to be perceived as overly blurry.

Background Distance The distance to the background, which helps the
algorithm calculate the depth layout of the scene. This value should be about
the same as the scene depth; anything farther from the camera than this
distance would be considered “far away" by the algorithm.

Blur More Objects Near Camera When on, the blurring of objects closer to
the camera is more opaque than that of more-distant objects. Because this
can result in the blurs of objects very close to the camera to be unrealistically
opaque, use this option only when necessary; that is, when the blurs of
more-distant objects overwrite those of closer objects.

Normal Bump Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Normal Bump

The Normal Bump map lets you use a texture-baked Normals map (see Baked
Texture Elements on page 6376). Typically you assign it to a material's Bump
component, Displacement component, or both. Using the map for
Displacement can correct edges that otherwise look unrealistically smooth;
however, this adds faces to the geometry.

TIP A Normals map for the indicated material component is generated
automatically if you turn on Output Into Normal Bump in the Selected Elements
Unique Settings group of the Render To Texture dialog's Output rollout on page
6406.
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Interface

Normal As a rule, contains a Normals map generated by Render To Texture
on page 6371.

Use the toggle to enable or disable use of the map (default=on). Use the spinner
to increase or decrease the map's effect.

Additional Bump This optional component can contain an additional map
to modify the bump or displacement effect. It is treated as a regular bump
map on page 5478.

Use the toggle to enable or disable use of the map (default=on). Use the spinner
to increase or decrease the map's effect.

Channel Direction group

By default, the Normals map's red channel indicates left versus right, while
green indicates up versus down (and blue indicates vertical distance). The
controls in this group let you adjust that interpretation.

Flip Red (X) Flips the red channel so that left and right are reversed.

Flip Green (Y) Flips the green channel so that up and down are reversed.

Swap Red & Green Swaps the red and green channels so that normal mapping
rotates 90 degrees.
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Method group

The Method group lets you choose which coordinate to use on the normals.
These controls are the same as those in the Projection Options dialog on page
6416.

■ Tangent (The default.) Project at a tangent to the target object's surface.
This is the method to use for objects that both move and deform, such as
animated characters.

■ Local XYZ Project using the object's local coordinates.
This method can be used for stationary or moving objects, but not for
objects that deform: if the object deforms, the projection will appear
incorrect at some frames.

■ Screen Project using screen coordinates; that is, flat projection in the Z
axis. X is horizontal, increasing in a positive direction to the right; Y is
vertical, increasing in a positive direction upward; and Z is perpendicular
to the screen, increasing in a positive direction toward the viewer.
This method is useful mainly for stationary objects seen only from a single
angle; for example, a statue seen through a window.

■ World Project using world coordinates.
This is useful mainly for objects that don't move or deform; otherwise, a
moving object with world-projected normals will appear to “swim” through
the texture.

Camera Map Per Pixel Map

Material Editor > Maps rollout > Click a Map button. > Material/Map Browser
> Camera Map per Pixel

The Camera Map Per Pixel map lets you project a map from the direction of
a particular camera. It is meant as an aid to 2D matte painting: You can render
a scene, adjust the rendering using an image-editing application, then use this
adjusted image as a matte that is projected back onto the 3D geometry.

TIP Final rendering can be slow. Script-driven network rendering on page 6433 can
help improve performance.
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Limitations

The Camera Map Per Pixel does not handle these situations:

■ Animated objects.
The projection does not use UVW mapping.

■ Animated textures.

■ Occlusion based on a Z-depth channel is handled in a limited way only.

Procedures

To use Camera Map Per Pixel:

1 Create the 3D model.

2 Set up a camera.

3 Set up the rendering resolution you want.

To get good results, the plate should be at least 2K pixels; 3K to 6K, or
higher is recommended.

4 Render the scene to an editable image format such as TIFF on page 7372.

5 Render the scene again, this time to a format such as RPF on page 7366 that
has a Z-depth component. Make sure the Z option is turned on.

6 Use an image-editing application to make changes you want to the
editable image.

7 Apply Camera Map Per Pixel to the diffuse component on page 5460 of the
geometry on which you want the matte to appear. Use these settings:

■ Set Camera to the same camera you used for the renderings.

■ Set Texture to the matte image you edited.

■ Set ZBuffer Mask to the Z-depth rendering (the RPF or RLA file).
Adjusting (which usually means increasing) the value of ZFudge can
improve the quality of edges of the projection.

Usually it is a good idea to have Remove Back Face Pixels turned on.
Another way to adjust the projection edge is to adjust this control's
Angle Threshold.

TIP If you have persistent problems with seams, try generating a mask
with an alpha channel and using it to clean up the edge of the projection.
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If you have multiple mattes to project, you might need to slice geometry
to make each map's target a separate object.

Interface

Map Channel Sets which map channel to use. Default=1.

Camera Click to turn on, and then choose a camera in the scene by selecting
it in a viewport, or press H to use the Pick Object dialog on page 228.

Once you have assigned a camera, its name appears on this button.

This camera should be the one used to render the map used in the Texture
and ZBuffer Mask components.

Texture Click to assign the texture to project. You can assign any kind of
map, but typically this is a Bitmap on page 5795 that contains an image file that
you first rendered from the same camera, and then possibly edited with a
different application.

ZBuffer Mask Click to assign a map that contains Z-depth data used to mask
the projection from unwanted surfaces. Typically this is an RPF file on page
7366 or an RLA file on page 7364 rendered using the same camera, with the Z
channel option turned on.
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Use the toggle to turn use of the ZBuffer Mask on or off. By default, it is off,
and it is not turned on automatically when you assign the ZBuffer Mask.

■ ZFudge ZFudge values other than 1.0 add a margin of deviation to the
use of the Z-depth data, letting you fine-tune the Z-Buffer masking.
Default=1.0.

Mask Behaves like the mask in the Mask map on page 5925 by letting you view
one map through another. Black areas of the mask are transparent, white areas
are opaque, and gray areas are partially transparent, based on the percentage
of the gray.

■ Mask Uses the Camera Projection When on, the mask uses the same
camera projection as the Texture and ZBuffer Mask. When off, it uses the
object's UVW coordinates. Default=on.

Remove Back Face Pixels When on, sets the projection to exclude surfaces
that face away from the camera, based on the value of Angle Threshold.
Default=on.

■ Angle Threshold Specifies the angle to use as a cutoff when removing
backface pixels. Default=90.0.
At the default of 90 degrees, faces perpendicular to the camera, or at a
greater angle, are not projected.

Material, Mapping, and Vertex Color Utilities

Assign Vertex Colors Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Assign
Vertex Colors

The Assign Vertex Colors utility assigns vertex colors based on the material
assigned to the object and the lighting in the scene. The utility applies a
VertexPaint modifier on page 1959 to the object when Assign To Selected is
clicked. Once the VertexPaint modifier has been applied to the object, go to
the Modify panel or click Edit to access the VertexPaint tools.
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TIP To render vertex colors, you must apply a material that has a Vertex Color
map on page 5943 in its diffuse component. To view vertex colors in viewports,
right-click the object, choose Object Properties on page 305 from the quad menu,
and then turn on Vertex Channel Display in the Display Properties group and make
sure the drop-down option is set to Vertex Color.

The Assign Vertex Colors utility supports light inclusion or exclusion when
using the Scene Lights option.

All of the commands found within the Assign Vertex Color utility are also
available from the Modify panel when a VertexPaint modifier has been applied
to an object.

Vertex Colors and Radiosity

The Vertex Colors utility supports radiosity on page 6168. If you use radiosity
with assigned vertex colors, be sure to turn on the option Re-Use Direct
Illumination From Radiosity Solution. This option is in the Rendering
Parameters rollout. See Radiosity Controls on page 6188. When this option is
on, the renderer simply displays the vertex colors assigned by the radiosity
solution: strictly speaking, it is not rendering at all.

The additional option Render Direct Illumination, also on the Rendering
Parameters rollout, causes direct lighting not to be saved in the corresponding
mesh. This corresponds to the options Radiosity, Render Direct Illumination,
in which case Assign Vertex Colors gets indirect illumination from the radiosity
mesh but renders direct illumination separately; or Radiosity, Indirect
Illumination Only, in which case Assign Vertex Colors doesn't apply direct
illumination to vertices at all.

See also:

■ VertexPaint Modifier on page 1959

■ Vertex Color Map on page 5943

Procedures

To use the Assign Vertex Colors utility:

1 Assign materials to the objects you want to affect. These can be mapped
or unmapped materials.

2 Light the objects.
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3 Select the objects you want to affect.

4 Open the Object Properties dialog for each object, click to turn off the
By Layer button, turn on Vertex Channel Display, and click OK.

5 Expand the Display Properties rollout in the Display panel and turn on
Vertex Colors.

6 Access the Assign Vertex Colors utility.

7 Choose one of the Light Model options.

8 Choose one of the Color Assignment choices.

9 Click Assign to Selected.

VertexPaint modifiers are applied to the selected objects, and the vertex
colors for the objects are taken from their materials and from the lighting
in the scene, depending on the options you choose under Light Model.

Changing the material or the lighting in the scene won’t change the
vertex colors. To do this, click the Update All button.

NOTE The new vertex colors are stored in the Vertex Paint modifier. If you
want to access them, go to the Modify panel and access the parameters in
the rollouts there. You can also use the tools found in the Vertex Paint floating
dialog to create layers, paint, blur or adjust color. The Vertex Paint floater
launches when you go to the Modify panel and the object is selected.

Example: To use the Assign Vertex Colors utility on a specific object:

1 Create a sphere with 24 segments.

2 Apply a mapped material to the sphere, and turn on Show Map In
Viewports.

The mapped sphere is displayed in the viewport.

3 Apply a mapped material to the sphere.

NOTE Choose a simple, well-defined map with large, easily-distinguished
areas.

4 Open the Object Properties dialog for the sphere, turn on Vertex Colors,
and click OK.

5 Open the Object Properties dialog for the sphere, click to turn off the By
Layer button, turn on Vertex Channel Display, and click OK. The sphere
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turns white because you're now displaying its vertex colors, and they're
all white as a default.

6 With the sphere selected, open the Assign Vertex Colors utility.

7 Choose Shaded and turn on Use Maps.

8 Turn on Mapping.

9 Click Assign To Selected.

A blurred version of the mapping appears on the sphere. The vertices are
now colored based on the material and the lighting in the scene. The
mapping is blurred because the resolution of the mesh at 24 segments is
much lower than the pixel resolution of the map.

10 Go to the Modify panel and note the VertexPaint modifier.

11 Move down in the Stack to the creation parameters, click Yes at the
warning prompt, and increase the Segments to 70.

The new vertices shift the already assigned vertices.

12 Return to the VertexPaint level of the stack, and click Assign in the Assign
Vertex Colors rollout. Had we returned to the Utilities panel, we would
have added another Vertex Paint modifier to the stack; clicking Assign
in the VertexPaint Modifier only updates that modifier.

TIP Vertex colors will only show up in a rendered scene if you assign the
Vertex Color map to the diffuse channel. However, if you do this, you can't
properly update your vertex colors with the Assign Vertex Colors utility. The
solution is to assign a Blend material to your object. Assign the straight diffuse
bitmap to Material 1, and the Vertex Color map to Material 2 of the Blend.
Switch to 100 percent of Material 2 when rendering, and 100 percent of
Material 1 when updating the vertex colors.

Assign Vertex Colors Utility | 6041



Interface
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Channel group

Here you'll find tools to choose which channel type the vertex color utility
will assign. If you choose map channel, you can also specify the map channel
ID number.

■ Vertex Color Choose this to assign a vertex color layer.

■ Vertex Illum Choose this to assign a vertex lighting layer.

■ Vertex Alpha Choose this to assign a vertex transparency layer.

■ Map Channel Choose this to assign a specifically numbered map channel.
Map channel spinner
Use this to define the channel number. Available only when Map Channel
is chosen.

Name If a channel has a name defined, it will appear here. Channels can be
named using the Channel Info Utility on page 6047.

NOTE Although the Color, Illum, and Alpha channels have specific names, in fact
3ds Max does not enforce what kind of data is saved in them, and any of the three
channels can contain four-channel (RGBA) vertex color data.

Light Model group

Provides options that let you specify how the surface of the object appears to
be illuminated.
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■ Lighting + Diffuse Uses the current scene lighting and materials to affect
the vertex colors.

■ Lighting Only Uses only lighting to assign vertex colors, ignoring material
properties.
When this option is chosen, Shadows and Mapping are disabled in the
Rendering Options rollout.

■ Diffuse Uses the material's diffuse color, ignoring the lighting.

Color Assignment group

Lets you specify how colors are interpolated across surfaces.

■ Color by Face (The default.) Colors are interpolated between the center
of each face.
Color By Face samples fewer points, so it is the quicker method. On the
other hand, results are less accurate.

■ Color by Vertex Colors are interpolated between vertices.
For each face, this method uses three points instead of one, so it is slower
but usually more accurate. An exception can occur when an object's shadow
falls between two vertices: in such a case, the object should occlude lighting,
but because only vertices are taken into account, the shadow is not
calculated and a “light leak” occurs.
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Rendering Options group

The options in this group let you choose whether to include shadows, texture
maps, or a radiosity solution in vertex colors.

NOTE You can save a radiosity solution in vertex colors, but not Light Tracer on
page 6154 illumination, which is not stored in the scene's geometry.

Shadows When on, shadows are used when the vertices are shaded.
Default=off.

TIP You can soften the shadow edge by using the VertexPaint modifier's Paint or
Blur tools.

Mapping When on, texture maps are used when the vertices are shaded.
Default=off.
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The radio buttons specify how to use radiosity data.

■ No Radiosity (The default.) Do not use the radiosity solution when
assigning vertex colors.

NOTE This option is the only one available unless a radiosity solution on page
6168 is present in the scene.

■ Radiosity, Reuse Direct Illum. from Solution Includes radiosity in the
vertex color assignments, and uses the direct illumination from the
solution.
This is comparable to the choice Re-Use Direct Illumination From Radiosity
Solution on the Rendering Parameters rollout on page 6208.

This choice disables the Shadows toggle, because shadows don't need to
be recomputed.

■ Radiosity, Render Direct Illumination Includes radiosity in the vertex
color assignments, but uses a separate pass to render direct illumination.
This is comparable to the choice Render Direct Illumination on the
Rendering Parameters rollout on page 6208.

■ Radiosity, Indirect Illum. Only Includes only indirect illumination from
the radiosity solution in the vertex color assignments.
This choice disables the Shadows toggle, because shadows don't need to
be recomputed.

Reminder field Displays a message that says whether regathering is enabled
or disabled. Regathering provides the most accurate radiosity results, but it
can add considerable time to radiosity calculations.

Radiosity Setup Click to display the Advanced Lighting panel on page 6153 of
the Render Setup dialog, where you can set up and generate a radiosity
solution.

If the mental ray renderer is the active renderer, this button is not available.

Assign to Selected Assigns vertex colors to the selected objects based on the
assigned material, and the choices specified in the preceding group boxes.
Assign to Selected creates a VertexPaint modifier and adds it to the stack of
the selected objects.

Edit Click to display the VertexPaint Paintbox on page 1969, the floating dialog
that holds the vertex painting tools.
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This button is unavailable if you haven't yet clicked Assign To Selected.

Channel Info Utility

Utilities panel > More button > Channel Info > Click Channel Info button.

Tools menu > Channel Info

The Channel Info utility gives game artists and others direct access to objects'
channel information that might not otherwise be easily available. All objects
in 3ds Max have mapping channels, which hold information pertinent to
texture mapping as well as vertex color, illumination, and alpha. Mesh objects
also have geometry and vertex-selection channels. The Channel Info utility
lets you view an object's channels, give them meaningful names, delete unused
channels, and copy information between channels.

The utility's Map Channel Info dialog shows all the channel data for selected
objects. It displays the number of channels, the number of vertices per channel,
and how much memory the channel uses. It also lets you name channels, as
well as clear (or delete), copy, and paste channels. Each of these commands
except renaming puts a modifier on the stack to achieve the results.

NOTE Channel Info supports mesh, polygon, and patch objects. It does not
support NURBS objects.

See also:

■ Vertex Color Map on page 5943

■ Skin Utilities on page 3875

■ Select By Channel Modifier on page 1659

■ UVW Mapping Add Modifier on page 1954

■ UVW Mapping Clear Modifier on page 1954

■ UVW Mapping Paste Modifier on page 1954

Procedures

To use the Channel Info utility:

1 Select an object or objects to use with the utility.
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2 Open the utility.

The Map Channel Info dialog opens.

3 To create a map channel, click any channel and then click the Add button.

The new, empty channel appears at the end of the list.

4 Most channels have three components. For example, a mesh or map
channel has X, Y, and Z components, and an alpha channel has R, G,
and B components. To expand all three-component channels, click the
SubComp button. To collapse all expanded channels, click SubComp
again.

5 To copy one channel to another, click the source channel, click Copy,
and then click the destination channel and click Paste.

In some cases, you might need to expand or collapse the component
display (see previous step). For example, when copying a vertex selection
(vsel) channel to a map channel, you must paste the vsel channel to a
component channel.

6 To minimize a channel's memory footprint, click the channel and then
click the Clear button.

This removes most all or of the data from the channel, so first make sure
the data is unnecessary or is available elsewhere. If the cleared channel
is the last one in the list, it might be deleted from the list.

Interface

The primary user interface of the Channel Info utility is the Map Channel
Info dialog, which you open by clicking the utility's Channel Info button on
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the command panel. This modeless dialog shows information about all map
channels belonging to the current selection, at the object level. If you change
the selection, the dialog automatically updates to reflect the selection.

The dialog consists of two parts: a button toolbar at the top, and a tabular
display of map channels belonging to each object in the current selection.

Channel Info toolbar

Copy Copies the channel data from the highlighted channel to the copy
buffer, where it becomes available for pasting. After you copy a channel, its
name appears on the line below the button toolbar.

Paste Pastes the contents of the copy buffer to the highlighted channel.

You can copy and paste only between channels with the same topology, or
you can copy from any channel to a channel with no vertices.

Source and destination channels need not be of the same type. For instance,
you can copy from a mesh channel to a map channel, and vice-versa.

Name Lets you rename the highlighted channel. Click this button to open a
small dialog that displays the current channel name and lets you edit this
name or enter a new one from the keyboard.

Clear Use this function to remove channels or delete data from a map channel
(including alpha, illumination, and vertex color channels). Clear has no effect
on geometry or vertex selection channels.

The specific result depends on the type of object and which channel you clear.
In terms of reducing the object's memory footprint, the utility is most effective
with Editable Poly objects.

■ Geometric primitive or Editable/Edit Mesh object Deletes the highlighted
texture map channel if it is the last map channel in the object, and it's not
the default map channel (1:map). If the highlighted channel is not the
last, Clear deletes all vertices in the channel. The faces remain, so the
memory-footprint reduction is partial.

NOTE This also applies to objects that collapse to editable mesh, such as Loft
objects.

■ Editable Poly object Deletes the highlighted texture map channel if it is
the last map channel in the object, and it's not the default map channel.
If the highlighted channel is not the last, Clear deletes all vertices and
faces in the channel.
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■ Patch object Deletes the highlighted texture map channel if it is the last
map channel in the object, and it's not the default map channel. If the
highlighted channel is not the last, Clear has no effect.

NOTE When you use the Clear function, the software adds a UVW Mapping Clear
modifier to the object's modifier stack. You can recover the deleted data by
removing the modifier from the stack, or changing its Map Channel setting.

Add Appends a new map channel to the object's channel list. If multiple
objects are selected, Add becomes available only after you click a track, so the
software knows which object to add the channel to.

NOTE If you apply mapping with a channel number higher than any existing
channels, the software automatically creates all intermediate channels. For example,
if you apply a UVW Mapping modifier to a standard object and set Map Channel
to 5 in the modifier, the software adds map channels 2, 3, 4, and 5.

SubComp Toggles display of the channels' subcomponents. When displayed,
you can rename, copy, and paste each subcomponent independently of its
parent channel.

Each channel except vsel has three subcomponents. Mesh and map channels'
subcomponents are labeled X, Y, and Z; those of alpha, illumination, and
vertex color channels are R, G, and B (red, green, and blue).

Lock Retains the current mapping data information in the table even if you
change the selection.

For example, if you want to see mapping data for a specific object or objects
constantly, first select the objects and then click Lock. Thereafter, if you select
different objects in the viewport, the table continues to display the data for
the selection when you clicked Lock. If you turn off Lock, the table updates
to show data only for the current selection.

If you click Update when Lock is on, the software will refresh the table contents
to reflect the current selection, and then retain that data.

Update Refreshes the displayed data to reflect any changes in the objects or
mapping, or, when Lock is on, the selection.

For example, if you apply mapping to an object, or change its mapping, click
Update to display the changes in the Map Channel Info dialog.

Channel Info table

The table functions similarly to a spreadsheet. If not all rows or columns are
visible, you can scroll the table using standard methods, including rolling the

6050 | Chapter 19   Material Editor, Materials, and Maps



mouse wheel for vertical scrolling. To highlight a row, click anywhere in the
row. You can highlight only one row at a time. To resize a column, drag the
vertical divider at the right of the column heading. To automatically set a
column's width to the size of the longest entry, double-click the vertical divider
to the right of the column heading.

Following is a brief explanation of each of the columns in the table:

Object Name The name of the object. If you change the name in the Modify
panel, click the dialog's Update button to display the new name in the dialog.

ID The type of channel. The available channel types are:

■ mesh/poly The object's mesh or poly data, depending on whether it's a
mesh or poly object: vertices and faces. You can copy this channel and
paste it to any other three-component channel.
This channel is not available for patch objects.

■ vsel The vertex selection. You can copy this channel and paste it to other
channels' subcomponents.
This channel is not available for patch objects.

■ -2:Alpha The vertex alpha channel. You can transfer all vertex alpha
values between objects with the same topology by copying and pasting
this channel.
You can apply vertex alpha information to objects with the VertexPaint
modifier on page 1959, and to editable surfaces with the Vertex Properties
settings (editable poly on page 2150) and Surface Properties (editable mesh
on page 2091 and editable patch on page 2038).

■ -1:Illum The vertex illumination channel. You can transfer all vertex
illumination values between objects with the same topology by copying
and pasting this channel.
You can apply vertex illumination information to objects with the
VertexPaint modifier on page 1959, and to editable surfaces with the Vertex
Properties settings (editable poly on page 2150) and Surface Properties
(editable mesh on page 2091 and editable patch on page 2038).

■ 0:vc The vertex color (vc) channel. You can transfer all vertex color values
between objects with the same topology by copying and pasting this
channel.
You can apply vertex color information to objects with the VertexPaint
modifier on page 1959, and to editable surfaces with the Vertex Properties
settings (editable poly on page 2150) and Surface Properties (editable mesh
on page 2091 and editable patch on page 2038).
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■ 1:map The default mapping channel. You can transfer all UVW mapping
information between objects with the same topology by copying and
pasting this channel.
You can create additional mapping channels by various means, including
with the Channel Info utility.

Channel Name The name of the channel. By default, a channel has no name,
as indicated by the entry “-none-”. To name or rename the channel, click the
channel to highlight it and then click the Name button at the top of the
dialog, or right-click the channel and choose Name from the right-click menu.

NOTE Most channels can be split into subcomponents on page 6050. You can name
the subcomponents separately from the channel itself.

Num Verts The number of vertices in the channel. To paste one channel to
another, they must have the same number of vertices.

Some channels have faces but no vertices. This is typically the case with Alpha,
Illumination, and vertex color channels in newly created non-poly objects.
In such cases, these channels function as placeholders for the corresponding
data should you add it later. They do consume a small amount of memory,
so if you have no intention of using a channel, you can save some memory
by converting the object to Editable Poly.

Num Faces The number of faces in the channel.

If a channel has faces but not vertices, that means it's a placeholder. See Num
Verts, above, for more information.

Dead Verts The number of unused map vertices in the channel. Such vertices
can be left over from sub-object editing.

Size(KB) The approximate amount of memory consumed by the channel. Use
this figure to check for unused channels that are using up memory.

Clean MultiMaterial Utility

Material Editor > Utilities menu > Clean MultiMaterial

Select an object. > Utilities panel > More button > Clean MultiMaterial > Click
Find All button.

The Clean MultiMaterial utility parses Multi/Sub-Object materials and displays
any that contain sub-materials are not assigned to any material IDs in the
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scene. You can then choose to remove any unused sub-materials, thus
consolidating your Multi/Sub-Object materials.

This utility searches an entire scene. You do not need to select objects or
materials.

Procedures

To clean all materials:

1 Open a scene.

2 On the Material Editor, open the Utilities menu and choose Clean
MultiMaterial.

The Clean Multi-Materials dialog opens, displaying the following:
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The dialog displays a list of all Multi/Sub-Object materials that contain
unassigned sub-materials. All the Multi/Sub-Object materials are
automatically turned on, and thus subject to cleaning.

3 Click the OK button.

All unused sub-materials are deleted and the dialog closes.

To clean specific Multi/Sub-Object materials:

When you create a Multi/Sub-Object material, you might create extra
sub-materials in anticipation of objects that haven't been added to the scene
yet. In such cases, you can prevent the utility from removing the extra
sub-materials.

1 Open a scene.

2 On the Material Editor, open the Utilities menu and choose Clean
MultiMaterial.

The Clean Multi-Materials dialog opens.
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3 In the list, turn off any Multi/Sub-Object materials you do not want to
clean.
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4 Click OK.

All unused sub-materials are deleted from the indicated materials and
the dialog closes.
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Interface

The Clean dialog presents you with a list of all Multi/Sub-Object materials in
the scene that contain unassigned sub-materials. You can then select materials
from which to remove unassigned sub-materials.

The dialog consists of two parts: a status field at the top and a list of
Multi/Sub-Object materials.

Status Field

The Status Field is not interactive. It displays prompts about the unused
materials.
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Materials list

This list displays Multi/Sub-Object materials that have sub-materials that are
not currently being used in the scene. When the Clean MultiMaterial utility
opens, it lists all Multi/Sub-Object materials with unused sub-materials and
turns them on to be cleaned. Click the check box next to a material name to
turn it off and prevent the utility from cleaning it.

Clean Deletes unused sub-materials from Multi/Sub-Object materials that are
turned on.

Cancel Cancels the operation.

Instance Duplicate Maps Utility

Material Editor > Utilities menu > Instance Duplicate Map

Utilities panel > More button > Instance Duplicate Maps > Click Find All
button.

The Instance Duplicate Maps utility searches an entire scene for materials that
have duplicate Bitmap maps and give you the option to instance them. If your
scene has different materials that use the same texture maps, creating instances
will reduce the load on your video card, which can improve viewport
performance.

For example, if you render a scene containing three materials that reference
the texture map MyMap.bmp, the software searches for that texture map three
times: once for each material it is used in. However, if you use the Instance
Duplicate Maps utility, you can create instances of the duplicate maps so the
renderer will find the first reference to MyMap.bmp and use it for any
subsequent material that uses the same maps.

This utility searches an entire scene. You do not need to select objects or
materials.

NOTE In order to be eligible for instancing, the Bitmap maps must be identical
in all aspects with regard to their initial settings. For example, if two materials use
the same bitmap image applied as Diffuse maps, but have different initial Tiling
settings, their maps aren't eligible for instancing.

Animation is not supported as a criterion for determining duplication, so any
differences in the animation of Bitmap map parameters will be lost from the
use of this utility. For example, if two materials use the same bitmap image
applied as Diffuse maps, and have the same initial Tiling settings, but their
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Tiling settings are animated to different subsequent values, after using the
utility both maps will have the same animation as the first map.

Procedures

To instance all duplicate maps:

1 Open a scene.

2 On the Material Editor, open the Utilities menu and choose Instance
Duplicate Map.

The Instance Duplicate Maps dialog opens, displaying the following:

The dialog displays a list of all texture maps found to have exact duplicates
in the scene. The search will include all copies found to have identical
paths and settings.

3 Click the Instance All button.

All identical maps are instanced and the dialog closes.
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To instance only specific maps:

Perhaps you only want to instance a few of the texture maps found in specific
materials.

NOTE You have to select at least two maps from the Duplicates list

1 Open a scene.

2 On the Material Editor, open the Utilities menu and choose Instance
Duplicate Map.

The Instance Duplicate Maps dialog opens.

3 From the Duplicated Textures list, click the arrow button to open the list
of duplicated textures and choose a texture you want to instance.

4 From the Duplicate list, select at least two map entries.
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If you don't select at least two entries, you will see a warning in the status
field at the top of the dialog.

5 Click Instance.
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Since all three of the maps were instanced, the dialog now shows there
are 42 duplicated textures.

6 Continue instancing texture or click Close when you are done.
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Interface

The primary user interface of the Instance Duplicate Maps utility is the Instance
Duplicate Maps dialog, which you open from the Utilities menu in the Material
Editor. This utility works globally, so you do not need to select objects or
materials in order to use it.

The dialog consists of three parts: a status field at the top, a drop menu
containing duplicated texture maps and a list of map names and the materials
that belong to.

Status Field

The Status Field is not interactive. It shows you prompts and warnings about
the duplicate textures and maps. Some of the messages displayed in this section
include:

■ “No duplicate textures were found in the scene.” – when the utility is run
in a scene containing no duplicates.
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■ “Select duplicates and press “Instance” to consolidate.” – when the utility
is run in a scene containing duplicates.

■ “The selected duplicates contain parameters that are animated. Animation
is not supported as criteria for determining duplication so differences in
the animation will be lost.” – when animation is present in a set of
duplicates.

■ “At least two maps must be selected in order to proceed.” – when the
Instance button is pressed with one or no duplicates selected.

Duplicated Textures list

This drop-down list contains all the maps in the scene found to be identical
in every way, including texture map path and name, and initial parameter
settings. The number after “Duplicated Textures” indicates how many sets
were found in the scene. This list appears with the first entry visible and once
active can be scrolled using the up/down arrow keys.

Duplicates list

When you choose a texture in the Duplicated Textures list, the software
displays its duplicates in the Duplicates list, showing the map name and the
name of the parent material. The number after “Duplicates” indicates how
many copies were found in the scene. Textures in this list can be chosen
individually. Only duplicates chosen in this list will be consolidated into the
final instance if you click the Instance button. The name of the resulting
instance is that of the first chosen duplicate in the list.

Instance All Performs the consolidation on all duplicates in the scene
regardless of selections made from the Duplicated Textures or Duplicates lists.

Instance Performs the consolidation on only the duplicates chosen on the
Duplicates list. Selected duplicates will disappear from this list after
consolidation. If all are selected, the corresponding texture will disappear from
the first list as well.

Close Closes the operation at its current point.
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Rendering

Rendering "fills in" geometry with color, shadow, lighting effects, and so on.

Rendering shades the scene's geometry using the lighting you've set up, the materials you've
applied, and environment settings, such as background and atmosphere. You use the Render
Setup dialog on page 6067 to render images and animations and save them to files. The rendered
output appears in the Rendered Frame Window on page 6073, where you can also render and
do some setup.
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TIP When you render a very large image, you might get a message that says “Error
Creating Bitmap,” or that says you are out of RAM. If this happens, turn on the Bitmap
Pager on page 7771 on the Rendering panel of the Preferences dialog. The Bitmap Pager
prevents a rendering from stopping unexpectedly due to the lack of sufficient memory.
On the other hand, it slows down the rendering process.

NOTE 3ds Max does not append any color-space information to rendered output. If
necessary, you can apply a color space such as sRGB to output images in an
image-editing program like Adobe Photoshop.

Environments and Rendering Effects

A variety of special effects, such as film grain, depth of field, and lens simulations, are
available as rendering effects. Another set of effects, such as fog, are provided as environment
effects.

Environment settings on page 6689 let you choose a background color or image, or choose
an ambient color value for when you render without using radiosity. One category of
environment settings is the exposure controls on page 6732, which adjust light levels for
display on a monitor.

Rendering effects on page 6583 provide a way for you to add blur or film grain to a rendering,
or to adjust its color balance.

See also:

■ Rendering Commands on page 6091

■ Rendering with ActiveShade on page 6102

■ Rendering Previews on page 6422

■ Network Rendering on page 6433

■ Rendering Effects on page 6583

■ Environment and Atmosphere Effects on page 6687

Object-Level Rendering Controls

You can control rendering behavior at the object level. See Object Properties on page 305.
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Render Setup Dialog 
Rendering menu > Render Setup

Main toolbar > Render Setup button

Keyboard > F10

Rendered Frame Window >  Render Setup button

Rendering creates a 2D image or animation based on your 3D scene. It shades
the scene's geometry using the lighting you've set up, the materials you've
applied, and environment settings such as background and atmosphere.

The Render Setup dialog has multiple panels. The number and name of the
panels can change, depending on the active renderer. These panels are always
present:

■ Common panel on page 6121
Contains the main controls for any renderer, such as whether to render a
still image or an animation, setting the resolution of rendered output, and
so on.

■ Renderer panel on page 6138
Contains the main controls for the current renderer.

Additional panels whose presence depends on the active renderer include:

■ Render Elements panel on page 6336
Contains the controls for rendering various image information into
individual image files. This can be useful when you work with compositing,
image-processing, or special-effects software.

■ Raytracer panel on page 6221
Contains global controls for ray-traced maps and materials.

■ Advanced Lighting panel on page 6153
Contains controls for generating radiosity and light tracer solutions, which
can provide global illumination for your scene.

■ Processing on page 6230 and Indirect Illumination on page 6295 panels
Contain special controls for the mental ray renderer on page 6230.
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At the bottom of the Render Setup dialog are controls that, like those in the
Common Parameters rollout on page 6121, apply to all renderers. These are
described in this topic's “Interface” section, below.

TIP When you render a very large image, you might get a message that says “Error
Creating Bitmap,” or that says you are out of RAM. If this happens, turn on the
Bitmap Pager. You turn on the Bitmap Pager in Rendering Preferences on page
7768. The Bitmap Pager prevents a rendering from hanging because of overuse of
memory. On the other hand, it slows down the rendering process.

Choice of a Renderer

Three renderers are provided with 3ds Max. Additional renderers might be
available as third-party plug-in components. The renderers provided with 3ds
Max are:

■ Default scanline renderer on page 6141
The scanline renderer is active by default. It renders the scene in a series
of horizontal lines.

Global illumination options available for the scanline renderer include
light tracing on page 6154 and radiosity on page 6168.

The scanline renderer can also render to textures on page 6371 (“bake”
textures), which is especially useful when preparing scenes for game
engines.

■ mental ray renderer on page 6230
The mental ray renderer created by mental images is also available. It
renders the scene in a series of square “buckets.”

The mental ray renderer provides its own method of global illumination,
and can also generate caustic lighting effects.

In the Material Editor, a variety of mental ray shaders on page 5974 provide
effects that only the mental ray renderer can display.

■ VUE file renderer on page 6334
The VUE file renderer is a special-purpose renderer that generates an ASCII
text description of the scene. A view file can include multiple frames, and
specify transforms, lighting, and changes of view.

Standard and ActiveShade Renderers

In 3ds Max, there are two different types of renderings. Production rendering
is active by default, and is typically the one you use for finished renderings.
This type of rendering can use any of the three aforementioned renderers.
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The second type of rendering is called ActiveShade on page 6102. An ActiveShade
rendering uses the default scanline renderer to create a preview rendering that
can help you see the effects of changing lighting or materials; the rendering
updates interactively as you change your scene. Rendering iwth ActiveShade
is, in general, less precise than production rendering.

Another advantage of production rendering is that you can use different
renderers, such as the mental ray or VUE file renderer.

To choose between production and ActiveShade rendering, use the radio
buttons described in the Interface section, following. To change the renderer
assigned to production rendering, use the Assign Renderer rollout on page 6135.

See also:

■ Render Setup  on page 6092

Procedures

To render a still image:

1 Activate the viewport to render.

2  Click Render Setup.

The Render Setup dialog opens, with the Common panel active.

3 On the Common Parameters rollout, check the Time Output group to
make sure the Single option is chosen.

4 In the Output Size group, set other rendering parameters or use the
defaults.

5 Click the Render button at the bottom of the dialog.

By default, rendered output appears in the Rendered Frame Window on
page 6073.

TIP  To render a view without using the dialog, click Render on page
6101.

To render an animation:

1 Activate the viewport to render.
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2  Click Render Setup.

The Render Setup dialog opens, with the Common panel active.

3 On the Common Parameters rollout on page 6121, go to the Time Output
group and choose a time range.

4 In the Output Size group, set other rendering parameters or use the
defaults.

5 In the Render Output group, click Files.

6 On the Render Output File dialog on page 6086, specify a location, name,
and a type for the animation file, and then click Save.

Typically, a dialog appears that lets you configure options for the chosen
file format. Change settings or accept the defaults, and then click OK to
continue.

The Save File check box turns on.

7 Click the Render button at the bottom of the dialog.

NOTE If you set a time range and do not specify a file to save to, the
animation is rendered only to the window. This can be a time-consuming
mistake, so an alert warns you about it.

TIP  Once you have rendered the animation this way, you can render it
again without using the dialog by clicking Render or pressing F9.

Interface
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[rendering mode]

■ Production/Iterative Choose whether to render in production on page
6101 or iterative on page 6101 mode. (This is the default.)

■ ActiveShade Choose to use ActiveShade on page 6102.

Preset From this drop-down list you can choose a set of preset rendering
parameters, or load or save rendering parameter settings. See Preset Rendering
Options on page 6114.

Viewport Chooses the viewport to render. By default, this is the active
viewport. You can use this drop-down list to choose a different one. The list
contains only currently displayed viewports.

 Lock View When on, locks the view to the one shown in the Viewport
list. This enables you to adjust the scene in other viewports (which become
active as you use them), and then click Render to render the viewport you
originally chose. When off, Render always renders the active viewport.

Render Renders the scene.

When ActiveShade is chosen, the name of this button changes to ActiveShade,
and clicking it opens a floating ActiveShade window on page 6102.

If the scene you're rendering contains bitmaps that cannot be located, a Missing
External Files dialog on page 7130 opens. This dialog lets you browse for the
missing maps, or continue to render the scene without loading them.
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Rendering Progress dialog
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When you click Render, a rendering progress dialog shows the parameters
being used, and a progress bar. The rendering dialog has a Pause button to
the left of the Cancel button. When you click Pause, the rendering pauses,
and the button's label changes to Resume. Click Resume to continue with the
rendering.

NOTE The mental ray renderer does not support the Pause button. You can cancel
a mental ray rendering, but you can't pause it.

Rendered Frame Window 
Main toolbar > Rendered Frame Window

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
> Rendered Frame Window opens.

Rendering menu/main toolbar > Render > Rendered Frame Window opens.

File menu > View Image File > Choose a file to view. > Open > Rendered Frame
Window (reduced functionality) displays the file.

NOTE  The Rendered Frame Window that opens when rendering offers a
significantly expanded feature set in Autodesk 3ds Max 2009. Most of these settings
already exist elsewhere in the program, but their addition to this dialog means
that you can change parameters and re-render your scene without having to resort
to other dialogs, thus speeding your workflow considerably.

The Rendered Frame Window displays rendered output. It has controls to:

■ Set the area to render (region, etc.).

■ Choose the viewport to render.

■ Choose a render preset.

■ Render the scene.

■ Save the image to a file.

■ Place a copy of the rendered image on the Windows clipboard, ready for
pasting into another graphics application.
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■ Create a clone of the window. This displays a new window so you can
create another rendering and compare it with the previous one.

■ Open a new Rendered Frame Window.

■ Toggle display of the red, green, and blue color channels.

■ Display the alpha channel on page 7905.

■ Display only monochrome (gray scale).

■ Clear the image from the window.

■ Print the rendered output.

■ Change a number of mental ray-specific settings.

When you choose the View Image File command from the File menu, 3ds
Max displays still images and image sequences in a feature-reduced version
of the Rendered Frame Window. When you view sequentially numbered image
files or images in an IFL file on page 7339, this window displays navigation
arrows that let you step through the images.

Procedures

To zoom and pan in the Rendered Frame Window:

You can zoom in and out and pan the image in the Rendered Frame Window.
You can even do this while a scene is rendering.

■ To zoom in, hold down Ctrl and then click. To zoom out, use
Ctrl+right-click.

■ To pan, hold down Shift and then drag.

If you have a wheel mouse, you can use the wheel to zoom and pan:

■ To zoom in or out, roll the wheel.

■ To pan, press the wheel and drag.

NOTE You can use any third-button pointing device to pan the image. To
enable this, open the Customize menu > Preferences dialog. Go to the
Viewports panel on page 7753, and in the Mouse Control group choose the
Pan/Zoom option (this is the default).
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Interface

This first section documents the controls on the main Rendered Frame
Window. For information about the additional control panel that appears
below the main window when using mental ray, see  mental ray Rendering
Options on page 6080.

 Rendered Frame Window Rendering Controls

These controls provide access to rendering settings such as presets and the
viewport to render, as well as the Render command. To toggle display of these
controls, click the Toggle UI button at the right end of the Rendered Frame
Window toolbar.

Area to Render This drop-down list provides the available Area to Render on
page 6095 options. Choose View, Selected, Region, Crop, or Blowup.

When using Region, Crop, or Blowup, set the region with the Edit Region
control (see following) or with the Edit Render Region command on page 7583
on the viewport right-click menu. Alternatively, you can set the region
automatically to the current selection with the Auto Region Selected option
(also see following).

 Edit Region Enables manipulation of the region window: resize by
dragging the handles, and move by dragging inside the window. When Area
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To Render is set to Region, you can edit the region both in the Rendered Frame
Window and in the active viewport.

If Area To Render is set to View or Selected, clicking Edit Region switches to
Region mode.

When Area To Render is set to Crop or Blowup, you can edit the region only
in the active viewport, because in those cases the Rendered Frame Window
doesn’t necessarily reflect the same area as the viewport. Hence, also in Crop
and Blowup modes, a warning icon on page 6076 appears to the right of the
Auto Region Selected. The icon’s tool tip suggests that you edit the region in
the viewport. A warning also appears in Region mode if the Rendered Frame
Window area doesn’t match the active viewport.

Turning on Edit Region automatically activates the Show Safe Frame on page
7583 function in the active viewport.

NOTE 3ds Max maintains two separate render regions: one for Region and Crop,
and another for Blowup. Changing the Area To Render option activates the relevant
render region.

The same command is available from the viewport right-click menu, as  Edit
Render Region on page 7583.

 Auto Region Selected When on, sets the region for Region, Crop, and
Blowup automatically to the current selection. This auto-region is calculated
at render time and does not overwrite the user-editable regions.

If Area To Render is set to View or Selected, clicking Auto Region Selected
switches to Region mode.

 [warning] This warning symbol appears when Area to Render on page
6075 is set to Crop or Blowup, accompanied by a tool tip that tells you to edit
the Crop or Blowup region in the viewport. It also appears in Region mode if
the Rendered Frame Window doesn’t show the same area as the viewport (that
is, if you previously rendered in Crop or Blowup mode).

Viewport Shows the viewport that renders when you click the Render button.
The drop-down list contains all visible viewports. To specify a different
viewport to render, choose it from the list or activate it in the main user
interface.

Activating a different viewport in the main interface automatically updates
this setting if Lock To Viewport is off.
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 Lock To Viewport When on, only the viewport active in the Viewport
list renders, even if you activate a different viewport in the main interface.
However, you can still choose a different viewport to render from the list.

When off, activating a different viewport in the main user interface updates
the Viewport value.

The same toggle is available from the viewport right-click menu, as Lock
Render to this View on page 7583.

Render Preset Choose a preset rendering option on page 6114 from the
drop-down list.

 Render Setup Opens the Render Setup dialog on page 6067.

 Environment and Effects Dialog (Exposure Controls) Opens the
Environment and Effects dialog to the Environment panel on page 6689. You
can set an exposure control on the Exposure Control rollout.

Production/Iterative Choose the result of clicking the Render button:

■ Production Renders using all the current settings on the Rendered Frame
Window, Render Setup, dialog, and so on.

■ Iterative Ignores network rendering, rendering of multiple frames, file
output, export to MI files, and email notification. Also, with the scanline
renderer, rendering Selected on page 6097 leaves the rest of the Rendered
Frame Window intact in Iterative mode.
Use this option when doing quick iterations on the image, usually in parts;
for example, working on final gather settings, reflections, or specific objects
or areas of the scene.

This choice is also available from a drop-down in the bottom-left corner of
the Render Setup dialog. And you can render in either mode from the render
flyout on page 6100 on the main toolbar.

Render Renders the scene using the current setup.
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Rendered Frame Window toolbar

 Save Image Allows you to save the rendered image displayed in the
Rendered Frame Window.

 Copy Image Places an exact copy of the visible portion of the rendered
image on the Windows clipboard, ready for pasting into a paint program or
bitmap editing software. The image is always copied as displayed, so, for
example, if the Monochrome button on page 6079 is on, the copied data consists
of an eight-bit grayscale bitmap.

NOTE No HDR (high-dynamic-range) data is copied.

 Clone Rendered Frame Window Creates another window containing
the displayed image. This allows you to render another image to the Rendered
Frame Window and compare it with the previous, cloned image. You can
clone the Rendered Frame Window any number of times. The cloned window
uses the same initial zoom level as that of the original.

NOTE A cloned window provides minimal functionality, and cannot be re-rendered
or cloned.

 Print Image Sends the rendered image to the default printer as defined
in Windows (in Windows XP, see Start menu > Settings > Printers And Faxes).
The background prints as transparent.

 Clear Clears the image from the Rendered Frame Window.

 Enable Red Channel Displays the red channel of the rendered image.
When turned off, the red channel is not displayed.

 Enable Green Channel Displays the green channel of the rendered
image. When turned off, the green channel is not displayed.
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 Enable Blue Channel Displays the blue channel of the rendered image.
When turned off, the blue channel is not displayed.

 Display Alpha Channel Displays the alpha channel on page 7905.

 Monochrome Displays an 8-bit grayscale of the rendered image.

Channel Display List Lists any channel rendered with the image. When you
choose a channel from the list, it is displayed in the Rendered Frame Window.

For most kinds of files, only the RGB and alpha channels are available. If you
render an RPF file on page 7366 or RLA file on page 7364, additional channels can
be present.

The Rendered Frame Window displays nonvisual channels, such as Material
Effects or the G-Buffer, using colors it assigns at random to distinct values.

Color Swatch Stores the color value of the last pixel you right-clicked. You
can drag this color swatch to other color swatches in the program. Clicking
the color swatch displays the Color Selector on page 391, which displays more
information about the color.

You can leave the Color Selector displayed while you right-click over other
pixels in the Rendered Frame Window. (Changing the current value in the
Color Selector changes the color swatch on the Rendered Frame Window's
toolbar, but it does not change the color of pixels in the rendered image.)

 Toggle UI Overlays When on, displays the frame that shows
the Region, Crop, or Blowup area when one of those options is active. To
disable display of the frame, turn off this toggle.

NOTE The frame is still active when not displayed.

 Toggle UI When on, all controls are available. When off, disables
display of the rendering controls at the top of the dialog as well as the mental
ray controls on the separate panel below the dialog. To simplify the dialog
interface and allow it to take up less space, turn this off.

TIP When off, you can resize the window smaller than is possible when Toggle
UI is on.
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Layer This setting appears on the Rendered Frame Window toolbar when you
render to the RPF on page 7366 or RLA on page 7364 file format. It lets you see the
information at different layers of the following channels:

■ Z Depth

■ Normal

■ Non-Clamped Color

■ Coverage

■ Node Render ID

■ Color

■ Sub-Pixel Weight

■ Sub-Pixel Mask

Layer shows no additional information for other channels. It is useful primarily
when the scene contains objects that occlude each other, and you have turned
on the Render Occluded Objects toggle for these objects. (See Object Properties
on page 305.) Be aware that rendering occluded objects increases render time.

TIP Rendering occluded objects can help you create 3D effects when you
composite images with the Autodesk Combustion software.

 Frame-Steps (arrows) When viewing sequentially numbered files
(such as image0005.jpg) or IFL files, the arrows display the next or the previous
file in the sequence. To jump to the first image or the last image in the
sequence, hold down Ctrl and click an arrow.

Available only when you use the View Image File command on the File menu.

 mental ray Rendering Options
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This additional panel appears below the Rendered Frame Window when mental
ray is the active renderer.

NOTE Most of the settings on this panel are linked to settings on the Render Setup
dialog, as noted in the following descriptions. Changing a setting here makes the
same adjustment to the respective Render Setup setting, and vice-versa. If you
change a setting here, the Render Setup dialog setting updates automatically, but
the reverse is not true. If you change a setting on the Render Setup dialog, to see
the change on this panel, you must click the panel.

Include in Render group

Reflections When on, mental ray traces reflections. Turn off to improve
performance when you don’t require reflections. See  Enable Reflections on
page 6281.

■ Max Sets the number of times a ray can be reflected. At 0, no reflection
occurs. At 1, the ray can be reflected once only. At 2, the ray can be reflected
twice, and so on. Default=4.

Refractions When on, mental ray traces refraction. Turn off to improve
performance when you don’t require refraction. See  Enable Refractions on
page 6281.

■ Max Sets the number of times a ray can be refracted. At 0, no refraction
occurs. At 1, the ray can be refracted once only. At 2, the ray can be
refracted twice, and so on. Default=6.

Soft Shadows When on, renders shadows from area lights normally. When
off, renders all area lights or shadows as if they were emitted from point objects,
speeding up rendering time. See Area Lights/Shadows as Points on page 6128.

Final Gather When on, the mental ray renderer uses final gathering on page
6295 to create global illumination or to improve its quality. Default=on.

The equivalent Render Setup dialog control is Enable Final Gather on page
6299.

■ Bounces Sets the number of times mental ray calculates diffuse light
bounces for each diffuse ray. Default=0.
The equivalent Render Setup dialog control is Diffuse Bounces on page 6300.

Subset Pixels (of selected objects) When on, rendering the scene applies only
to selected objects. Unlike using the Selected option for rendering, however,
using this option takes into account all scene elements that affect its
appearance. This includes shadows, reflection, direct and indirect lighting,
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and so on. Also, unlike Selected, which replaces the entire contents of the
Rendered Frame Window (except for selected objects) with the background
color, this option replaces only pixels used by the re-rendered selected objects.

Subset pixel rendering is particularly useful when performing iterative
rendering and refinement of lighting, shadows, and other scene elements for
a particular object or set of objects in the scene. It lets you re-render repeatedly
to view the results of isolated changes without disturbing the rest of the
rendered output.

TIP Objectionable outlines might appear around objects rendered in Subset Pixel
mode at low antialiasing settings. To eliminate any such outlines, increase the
antialiasing setting on page 6083. For best results, use Medium antialiasing (Min
1/4, Max 4) or better.

The equivalent Render Setup dialog control is  Render changes to selected
objects only on page 6281.

Reuse group

These commands let you save rendering time by reusing translated geometry
and final gather solutions. The Final Gather controls are available only when
Final Gather on page 6081 is on.

 Lock Geometry Translation Determines whether changed geometry
is retranslated to mental ray format at render time. When on, sub-object-level
changes such as vertex editing or adjusting a modifier such as Bend are ignored
and don’t cause retranslation. However, object-level changes such as moving
or rotating an object are retranslated.

The equivalent Render Setup dialog control is Translator Options rollout >
Geometry Caching group >  Lock Geometry Translation on page 6321.

Geometry When on, rendering uses geometry caching. During the first render,
the translated geometry is saved to the cache file. Then, in subsequent
renderings of the same scene, the renderer uses the cached geometry for any
unchanged objects instead of retranslating it. Any changed geometry is
retranslated. Default=off.

The equivalent Render Setup dialog control is Translator Options rollout >
Geometry Caching group > Enable on page 6321.

NOTE Network rendering does not support this option.
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 Clear Geometry Cache Deletes the cached geometry.

The equivalent Render Setup dialog control is Translator Options rollout >
Geometry Caching group >  Clear Geometry Cache on page 6321.

 Lock Final Gather Determines whether or not mental ray uses the
final gather map file as is. When off, mental ray can add new final gather
points if necessary. When on, mental ray uses only the data in the specified
file, and does not generate any new final gather points during the
pre-processing stage. Available only Reuse > Final Gather is on (see following).
Default=off.

The equivalent Render Setup dialog control is  Read Only (FG Freeze) on page
6301.

Final Gather When on, generates (when necessary) and then uses a disk-based
final gather map (FGM file) to save rendering time. If no FGM file is specified
on the Render Setup dialog > Final Gather rollout (see Final Gather Map group
on page 6300), 3ds Max uses the file name temp.fgm.

The equivalent Render Setup dialog control is Read/Write File on page 6300.

 Clear Final Gather Cache Deletes the cached final gather solution.

The equivalent Render Setup dialog control is Final Gather Rollout > Final
Gather Map group >  Delete File on page 6301.

Clear All Deletes the cached geometry and final gather solution.

Image Precision/Final Gather Precision

These sliders provide handy presets for groups of antialiasing and final-gather
settings.

Image Precision (Antialiasing) Provides presets for a number of recommended
combinations of minimum and maximum Samples Per Pixel settings. For
details, see Samples per Pixel group on page 6274.

Final Gather Precision Provides a quick, easy solution for final gather. The
default presets are: Draft, Low, Medium, High, Very High, and Custom (the
default choice). Available only when Final Gather is on. For details, see FG
Precision Presets on page 6299.
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Pixel Data

When you right-click the Rendered Frame Window, the color swatch is
updated, and information about the rendering and the pixel beneath the
mouse is displayed.

If you hold the right mouse button down while dragging, the information
changes with each new pixel the mouse crosses.

The display includes the following information:

Image group

Width The width of the image in pixels.

Aspect The pixel aspect ratio.

Height The height of the image in pixels.

Gamma The gamma value carried in the bitmap file.

Type The type of image, based on color depth. For example, 64 bits (RGBA)
or 32 Bits per Channel Floating-Point (RGBA).

Pixel group

Pixel information includes the pixel location in the bitmap, in parentheses
following the Pixel group heading. The counting starts at 0. For example, in
the above illustration, the pixel in question is the 308th from the left edge
and the 141st from the top edge. Also shown in this group are channel values
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for red, green, blue, alpha, and monochrome, both as 16-bit integers (0 to
65535) and as floating-point values between 0.0 and 1.0.

NOTE With high-dynamic-range images, the floating-point values can be greater
than 1.0 or less than 0.0.

Red The red component value (0 to 65535) and the floating-point value.

Green The green component value (0 to 65535) and the floating-point value.

Blue The blue component value (0 to 65535) and the floating-point value.

Alpha The alpha component value (0 to 65535) and the floating-point value.

Mono The monochrome values of the pixel, using the same formula used by
monochrome material map channels such as bump and opacity maps.

Extra Pixel Data (G-Buffer Data) group

If the rendering output uses a format that contains additional channels, such
as RPF on page 7366 or RLA on page 7364, the informational pop-up shows this
data in the Extra Pixel Data group. The group includes all the possible channels.
If a channel is not present, its value is displayed as "N/A," for "not applicable."

Z Depth Displays Z-Buffer information in repeating gradients from white to
black. The gradients indicate relative depth of the object in the scene.

Material ID Displays the Effects Channel used by a material assigned to an
objects in the scene. The Effects Channel is a material property set in the
Material Editor.

Object ID Displays the G-Buffer Object Channel ID assigned to objects using
the Object Properties dialog on page 305.

UV Coordinates Displays the range of UV mapping coordinates.

Normal Displays the orientation of normal vectors.

Non-Clamped Color Displays the "real" color value delivered to the renderer
in RGB order. The renderer uses a floating-point range of 0.0 to 1.0 to represent
the range of each color channel. Thus, 1.0 is 100%, or 65535 (real color values
can be greater than 1, but are clamped by the renderer to 1).

Coverage Displays the coverage of the surface fragment from which other
G-Buffer values (Z Depth, Normal, and so on) are obtained. Z-Coverage values
range from 0 to 255.

Node Render ID Displays an object’s G-Buffer Object channel.
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Color Displays the color returned by the material shader for the fragment.

Transparency Displays transparency returned by the material shader for the
fragment.

Velocity Displays the velocity vector of the fragment relative to the screen.

Sub-Pixel Weight Displays the sub-pixel weight of a fragment. The channel
contains the fractions of the total pixel color contributed by the fragment.
The sum of all the fragments gives the final pixel color. The weight for a given
fragment takes into account the coverage of the fragment and the transparency
of any fragments that are in front of a given fragment.

Sub-Pixel Mask Displays the sub-pixel alpha mask. This channel provides a
mask of 16 bits (4x4) per pixel, used in antialiased alpha compositing.

Render Output File Dialog
Rendering menu > Render Setup > Render Setup dialog > Common panel >
Common Parameters rollout > Render Output group > Click Files. > Render
Output File

The Render Output File dialog lets you assign a name to the file that the
rendering will output. You can also determine the type of file to render.
Depending on your choice of file type, you can also set up options such as
compression, and color depth and quality.

See also:

■ Image File Formats on page 7324

Procedures

To name the render output file:

1 Choose Rendering > Render Setup, and then in the Render Output group
of the Common Parameters rollout, click Files.

This opens the Render Output File dialog.

2 Use the Save In field near the top of the dialog to choose the directory
in which to save the rendered file.

3 In the File Name field, enter the name for the file to be rendered.
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TIP If you enter a filename extension as well (for instance: myimage.bmp)
and then press Tab, the Setup button activates and you can click it to change
the file settings.

4 Choose the type of file you want to render from the Save As Type
drop-down list.

TIP If you entered the filename extension as part of the file name, you can
skip this step.

5 Click Save to close the Render Output File dialog.

Clicking Save also opens a dialog that lets you set the options for the file
format you chose. Adjust these settings (or leave them at their defaults),
and then click OK.

6 On the Render Setup dialog, click the Render button to render the scene
and save the file.

NOTE If a file of the same name already exists, a dialog opens to let you
confirm overwriting it. This dialog also provides a check box for automatically
overwriting render-output files without being prompted for the duration of
the session.

To set up options for the render-output file:

1 Choose Rendering > Render and then in the Render Output group of the
Common Parameters rollout, click Files.

The Render Output File dialog opens.

2 In the File Name field, enter the name for the file to be rendered.

3 Navigate the Save In field to choose the directory where you want the
rendered file to be saved.

4 Choose the type of file you want to render from the Save As Type
drop-down list, then click Save.

A dialog is displayed that lets you set the options for the file format you
chose. Adjust these settings (or leave them at their defaults), and then
click OK.

NOTE You can also view the setup dialog by clicking Setup, if this button is
available.
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WARNING Make sure the file name extension in the File Name field matches
the file type in the Save As Type field. Changing the file type does not update
the file name automatically. The file options dialog depends on the type
indicated by the file name, not the type indicated by Save As Type.

5 If the Render Output File dialog is still open, click Save.

Interface

History Displays a list of the most recent directories searched. Whenever an
image is selected, the path used is added to the top of the history list as the
most recently used path.
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The history information is saved in the 3dsmax.ini on page 83 file.

Save In Opens a navigation window to browse other directories or drives.

 Up One Level Moves you up a level in the directory structure.

 Create New Folder Lets you create a new folder while in this dialog.

 View Menu Provides several options for how information is displayed
in the list window:

■ Thumbnails: Displays the contents of a directory as thumbnails, without
the details.

■ Tiles: Displays the contents of a directory as large icons, without the details.
If you widen the dialog, these tile across the width.

■ Small Icons: Displays the contents of a directory as small icons, tiled across
the width, without the details.

■ List: Displays the contents of a directory without the details.

■ Details: Displays the contents of a directory with full details such as size
and date.

List of files Lists the contents of the directory, in the format specified by the
View menu.

TIP When the active display format is Details, the contents of the directory are
displayed with Name, Size, Type, Date Modified, and Attributes. You can sort the
list according to a column's contents by clicking that column's label.

File name Displays the file name of the file selected in the list.

Save as type Displays all the file types that can be saved. This serves as a filter
for the list.

NOTE The choice in this field determines the file type saved, regardless of the file
name extension entered in the File Name field.

Save Sets the file information for saving upon rendering. Closes the dialog if
you haven't changed the output file type.
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If you've changed the file type, clicking Save opens the Setup dialog for the
specified file type. Change the settings as necessary, and then click OK to close
both the Setup and the Output dialogs, or click Cancel to return to the Output
dialog.

Cancel Cancels the file save and closes the dialog.

Devices Lets you choose the hardware output device, for example, a digital
video recorder. To use the device, the device, its driver, and its 3ds Max plug-in
must all be installed on your system.

Setup Displays controls for the selected file type. These vary with each different
file format. Change the settings as necessary, and then click OK or Cancel.

Info If you highlight an existing file in the list, clicking Info displays expanded
information about the file such as frame rate, compression quality, file size,
and resolution. The information here depends on the type of information
saved with the file type.

View If you highlight an existing file in the list, clicking View displays the
file at its actual resolution. If the file is a movie, the Media Player is opened
so the file can be played.

Gamma group

To set up gamma options for the output file, Enable Gamma Correction must
be on in the Gamma panel on page 7758 of the Preferences dialog (Customize
> Preferences > Gamma). Otherwise, the Gamma controls are unavailable in
the Render Output File dialog.

■ Use Image’s Own Gamma This option is not available in this dialog.

■ Use System Default Gamma Uses the system default gamma, as set in
the Gamma panel of the Preferences dialog.

■ Override Defines a new gamma for the bitmap that differs from the
system default.
Using Override is not recommended for bitmaps that you render. It is
better to set a system default value, based on the graphic display you use,
and use this same gamma value for all your renderings.

Sequence This is not available in the Render Output File dialog.
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NOTE To render a sequence of still images, choose the Active Time Segment or
define a range of frames in the Common Parameters rollout of the Render Setup
dialog. If you have selected a still image file type, each frame will append a
four-digit number to the name you have selected, incremented with each frame.

Preview When on, enables display of the image as a thumbnail.

Image thumbnail Displays a thumbnail of the selected file. Preview must be
turned on.

Statistics Displays the resolution, color depth, file type, and number of frames
of the selected file.

Location Displays the full path for the file.

Rendering Commands
The main commands for rendering are on the main toolbar on page 7499 and
the Rendered Frame Window  on page 6073. Another way to invoke some of
these commands is to use the default Rendering menu on page 7493, which
contains other commands related to rendering.

Render Setup on page 6092

Area to Render on page 6095

Render Production  on page 6101

ActiveShade  on page 6102

ActiveShade Viewport on page 6110
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Preset Rendering Options on page 6114

Render Last  on page 6117

See also:

■ Render Setup Dialog  on page 6067

■ Rendering with ActiveShade on page 6102

■ ActiveShade Commands (Quad Menu) on page 6111

■ Rendering Effects on page 6583

■ Environment and Atmosphere Effects on page 6687

■ Network Rendering on page 6433

Render Setup 

Main toolbar > Render Setup

Rendering menu > Render Setup

Keyboard > F10

Rendering "fills in" geometry with color, shadow, lighting effects, and so on.

This command opens the Render Setup dialog on page 6067, which lets you set
the parameters for rendering. Rendering creates a still image or an animation.
It shades the scene's geometry using the lighting you've set up, the materials
you've applied, and environment settings such as background and atmosphere.

Rendering is multi-threaded and multi-processed on multiple-processor
configurations. A two-processor or dual-core system can render in nearly half
the time a single-processor system can.
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Rendering can also take place on multiple systems by using a network. See
Network Rendering on page 6433. For the mental ray renderer, also see
Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6326.

Missing Mapping Coordinates

If the renderer finds a parametric object that requires mapping, it automatically
sets its Generate Mapping Coordinates toggle before rendering the scene. The
toggle remains set after the rendering is done.

In the following cases, however, 3ds Max is unable to supply mapping
coordinates automatically:

■ Non-parametric objects, such as imported meshes, don't have built-in
coordinates.

■ Some third-party (plug-in) objects aren't provided with mapping
coordinates.

In these cases, 3ds Max is unable to render the scene completely. It displays
a Missing Mapping Coordinates dialog on page 5780 that lists the objects the
renderer couldn't map. To resolve the problem apply a UVW Map modifier
on page 1931 to the objects that the dialog lists.

NOTE If a material has Show Map In Viewport set when that material is assigned
to an object, the object's Generate Mapping Coordinates toggle is set, if it was
not previously set. (The state of Show Map In Viewport is saved with each material.)

Procedures

To render a still image:

1 Activate the viewport to render.

2  Click Render Setup.

The Render Setup dialog on page 6067 appears.

3 In the Time Output group, make sure Single is on.

4 In the Output Size group, set other rendering parameters or use the
defaults.

5 Click Render.

By default, the rendering appears in a window.
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TIP  To render a view without using the dialog, click Render on page
6101 or use Render Last on page 6117 (press F9).

To render an animation:

1 Activate the viewport to render.

2  Click Render Setup.

The Render Setup dialog on page 6067 appears.

3 Open the Common Parameters rollout on page 6121. Choose a time range
in the Time Output group.

4 In the Output Size group, set other rendering parameters or use the
defaults.

5 In the Render Output group, click Files.

6 A Render Output File dialog on page 6086 is displayed.

7 Use the file dialog to specify a name and a type for the animation file,
and then click Save.

A configuration dialog opens that lets you set the options for the file
format you chose. Adjust these settings or leave them at their defaults,
and then click OK.

The configuration dialog closes, and on the Render Setup dialog >
Common Parameters rollout, the Save File toggle is now available and
on.

8 Click Render.

NOTE If you set a time range and do not specify a file to save to, the
animation is rendered only to the window. This can be a time-consuming
mistake, so an alert warns you about it.

TIP  To render a view without using the dialog, click Render Production
on page 6101 or use the Keyboard Shortcut F9 to Render Last on page 6117.
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Area to Render

Rendered Frame Window > Area to Render drop-down list

Area To Render lets you render only a portion of the scene.

The Area To Render list on the Rendered Frame Window  on page 6073 lets you
specify the portion of the scene that will be rendered.

Procedures

To render only selected objects:

1 Open the Rendered Frame Window.

2 From the Area To Render drop-down list in the top-left corner of the
window, choose Selected.

3 Activate the viewport to render.

4 Select the objects to render.

5 Render the scene.

3ds Max displays a progress dialog that shows the progress of rendering
and the rendering parameter settings. To stop rendering, click Cancel in
this dialog, or press Esc.
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To render a region:

1 Activate the viewport to render, or choose it from the Viewport drop-down
list on the Rendered Frame Window.

2  On the Rendered Frame Window, click the Edit Region button.

This automatically sets the Area To Render option to Region, and displays
the region window in the Rendered Frame Window and the active
viewport. The window has editing handles and a close box (X).

3 To move the region window, drag inside it. To adjust its size, drag the
handles.

To preserve the window's aspect ratio, press and hold Ctrl before you drag
a handle.

4 Render the scene.

3ds Max renders the region only. In Production mode, the Rendered
Frame Window is cleared before rendering, but in Iterative mode, the
area of the window outside the region remains intact.

To render a blowup:

1 Open the Rendered Frame Window and choose the viewport to render.

2 Choose Blowup from the Area To Render list.

 The Edit Region button appears on the Rendered Frame Window,
to the right of the Area To Render list, and the Blowup region window is
displayed in the active viewport. This window is different from the one
used for Region and Crop.

The Blowup region window does not appear in the Rendered Frame
Window because the region extents might exceed the window area,
depending on the rendering history.

3 To move the window, drag inside it. To adjust the window size, drag its
handles.

The window is constrained to the aspect ratio of the current output size.

4 Render the scene.
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3ds Max displays a progress dialog that shows the progress of rendering
and the rendering parameter settings. To stop rendering, click Cancel in
this dialog, or press Esc.

Interface

The following choices are available on the Area To Render drop-down list.

NOTE The Box Selected, Region Selected, and Crop Selected options previously
available are no longer necessary and have been removed from the software. To
achieve the equivalents, combine an Area To Render option with the Auto Region
Selected  on page 6076 option on the Rendered Frame Window.

View (The default.) Renders the active viewport.

Selected Renders the currently selected object or objects only. Rendering a
selection with the scanline renderer leaves the remainder of the Rendered
Frame Window intact. However, mental ray renders the background first, thus
effectively clearing the rest of the frame.

TIP Rendering Selected renders the selection in isolation, without any contribution
from the rest of the scene, such as shadows, reflections, etc. When rendering with
mental ray, to render a selection with full contribution from the other scene
contents, use the Subset Pixels on page 6081 option instead.
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TIP  To remove any existing image from the window when rendering with
the scanline renderer, use the Clear button before rendering.

Region Renders a rectangular region within the active viewport. Using this
option leaves the remainder of the Rendered Frame Window intact except
when rendering an animation, in which case it clears the window first. Use
the Region option when you need to test-render a part of the scene.

When you choose Region from the Area To Render list, the  Edit Region on
page 6075 control activates. This causes an editable version of the region to
appear in both the Rendered Frame Window and the active viewport. To move
the region or change its size, drag either region box or its handles, respectively.
If you turn off Edit Region, the region remains visible in the Rendered Frame
Window, but is no longer editable. Alternatively, to set the region to the
current selection automatically, turn on  Auto Region Selected on page 6076.

TIP  To remove any existing image from the window, use the Clear button
before rendering.

NOTE Region rendering is meant to create a draft rendering of a selected area of
a view. As such, Region rendering uses only an Area filter for antialiasing, regardless
of which antialiasing is chosen in the Render Setup dialog.
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Crop Lets you specify the size of the output image using the same region box
that appears for the Region option.

After you choose Crop from the Area To Render list, turn on  Edit Region on
page 6075 to cause a rectangular render region to appear in the active viewport.
To move the region or change its size, drag the region box or its handles,
respectively. Alternatively, to set the region to the current selection
automatically, turn on  Auto Region Selected on page 6076.
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Blowup Renders a region within the active viewport and enlarges it to fill the
output display.

After you choose Blowup from the Area To Render list, turn on  Edit Region
on page 6075 to cause a rectangular render region to appear in the active
viewport. To move the region or change its size, drag the region box or its
handles, respectively. Alternatively, to set the blowup region to the current
selection automatically, turn on  Auto Region Selected on page 6076.

Render Flyout

Main toolbar > Render flyout

The Render flyout lets you choose among these buttons:

■ Render Production on page 6101

■ Render Iterative on page 6101

■ ActiveShade on page 6102
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The Render buttons let you render the scene using the settings without using
the Render Setup dialog on page 6067. Choosing one of these buttons also
changes which rendering settings are active on the Render Setup dialog.

Invoking the Render command from the Rendering menu or by pressing
Shift+Q uses the active mode on the Render flyout.

By default, all the rendering options use the default scanline renderer on page
6141. You can change the renderer assigned to Production or ActiveShade by
using the Assign Renderer rollout on page 6135 on the Render Setup dialog >
Common panel.

Render Production 

Main toolbar > Render flyout > Render Production

The Render Production command, available on the Render flyout on page 6100
on the main toolbar, renders the scene using the current production render
settings without opening the Render Setup dialog on page 6067. You can activate
Production rendering mode without rendering from the drop-down list in the
bottom-left corner of the Render Setup dialog, and in the top-right corner of
the Rendered Frame Window.

You assign which renderer to use for production rendering on the Assign
Renderer rollout on page 6135 of the Render Setup dialog > Common panel.

See also:

■ Render Iterative  on page 6101

■ ActiveShade  on page 6102

 Render Iterative 

Main toolbar > Render flyout > Render Iterative

The Render Iterative command, available from the Render flyout on page 6100
on the main toolbar, renders the scene in iterative mode without opening the
Render Setup dialog on page 6067. You can activate Iterative rendering mode
without rendering from the drop-down list in the bottom-left corner of the
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Render Setup dialog, and in the top-right corner of the Rendered Frame
Window.

Iterative rendering ignores file output, network rendering, rendering of multiple
frames, export to MI files, and email notification. Use this option when doing
quick iterations on the image, usually in parts; for example, working on final
gather settings, reflections, or specific objects or areas of the scene.

Also, when rendering in Iterative mode, rendering Selected on page 6097 or
Region on page 6098 leaves the rest of the Rendered Frame Window intact.

See also:

■ Render Production  on page 6101

■ ActiveShade  on page 6102

ActiveShade 

Main toolbar > Render flyout > ActiveShade

Keyboard > Shift+Q (Uses the Render mode currently active on the toolbar:
either Production or ActiveShade)

The ActiveShade button, available from the Render flyout on page 6100, creates
an ActiveShade on page 6102 rendering in a floating window.

You assign which renderer to use for ActiveShade rendering on the Assign
Renderer rollout on page 6135 of the Render Setup dialog on page 6067 > Common
panel.

See also:

■ Render Production  on page 6101

■ Render Iterative  on page 6101

Rendering with ActiveShade

Main toolbar > Render flyout > Render (ActiveShade)

Right-click viewport label. > Views > ActiveShade
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ActiveShade gives you a preview rendering that can help you see the effects
of changing lighting or materials in your scene. When you adjust lights or
materials, the ActiveShade window interactively updates the rendering.

ActiveShade preview of material changes

Above left: Before the update

Above right: After changing the material for the fabric to a mapped material and
increasing the highlights on the material for the wood
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ActiveShade preview of lighting changes

Above left: Before moving a light in a viewport

Above right: After moving the light

There are two ActiveShade options:

■ Viewport The ActiveShade rendering appears in the active viewport.

■ Floater The ActiveShade rendering appears in its own window.

Only one ActiveShade window can be active at a time. If you choose one of
the ActiveShade commands while an ActiveShade window is already active,
you get an alert that asks whether you want to close the previous one. If the
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previous ActiveShade window was docked in a viewport, the viewport reverts
to the view it previously showed.

TIP You can drag and drop materials from the Material Editor on page 5284 to
ActiveShade windows and viewports, as you can with other viewports.

NOTE  You can't make a maximized viewport an ActiveShade window, or
maximize an ActiveShade window.

ActiveShade Commands

When you right-click an ActiveShade window, the quad menu on page 7516
displays an ActiveShade menu. This menu contains a number of ActiveShade
commands on page 6111.

ActiveShade and Object Selection

If you select an object before you invoke ActiveShade, ActiveShade is done
only for that object. This can greatly increase the speed of ActiveShade.

Similarly, once the ActiveShade window is open, the initialize and update
steps on page 7899 (whether automatic or manual) are done only for the selected
object.

In a "docked" ActiveShade viewport, you can select objects by right-clicking,
turning on Select Object in the Tools (lower-right) quadrant of the quad menu,
then clicking the object you want to select. In an ActiveShade viewport, only
one object at a time can be selected.

TIP When an object in an ActiveShade window has a mapped material, select it
before you change a map or adjust its parameters.

What ActiveShade Does and Doesn't Do

For the sake of interactivity, the ActiveShade window is limited in what it can
update interactively. An ActiveShade rendering is typically less precise than
a final production rendering.
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TIP When you change geometry by transforming it or modifying it, right-click
the ActiveShade window and choose Tools > Initialize from the quad menu
(lower-right quadrant). This updates the ActiveShade rendering.

■ Moving an object does not update the ActiveShade window.

■ Applying a modifier or otherwise changing object geometry does not
interactively update the ActiveShade window.

■ Reflections are rendered only in the Initialize pass.

■ Materials are displayed as RGBA data with 8 bits per channel.

■ Multiple changes to a material might lead to deterioration in image quality.
If you see this happening, right-click the ActiveShade window and choose
Tools > Initialize from the quad menu (lower-right quadrant).

■ Masks are reduced from 8x8 to 4x4 subdivisions per pixel. The mask is
corrected to 6-bit opacity (0 to 63 rather than 0 to 255). This might result
in some visual noise around object edges.

■ Because of the preceding item, filters are coarser than in full-scale
renderings, but they still have significant subpixel information.

■ There is a limitation of 16 subdivisions per pixel. Because of this, any
objects behind the sixteenth occluding object for a given pixel will be
ignored. Rendered back faces count as separate objects.

■ Reshading uses compressed normals and other direction vectors. This
should have no visible effect.

■ ActiveShade does not render atmospheric effects, rendering effects, or
ray-traced shadows (the only shadows it can render are shadow-mapped
shadows).

Procedures

To display an ActiveShade window in a viewport:

■ Right-click the viewport label, choose Views, and then ActiveShade.

NOTE  You can't make a maximized viewport an ActiveShade window,
or maximize an ActiveShade window.

6106 | Chapter 20   Rendering



To display a free-floating ActiveShade window:

■  Choose ActiveShade from the Render flyout on page 6100.

NOTE As with the Render command, the ActiveShade window respects the Output
Size setting from the Render Setup dialog on page 6067. To use a different render
size, set it first with Render Setup, and then open the ActiveShade window.

To update an ActiveShade window after moving an object or changing object
geometry:

1 Right-click the ActiveShade window.

2 In the Tools (lower-right) quadrant of the quad menu, choose Initialize.

To see the toolbar in an ActiveShade viewport:

1 Click the viewport to make it active.

2 Press the Spacebar to display the toolbar.

Pressing spacebar again toggles the toolbar off, and so on.

You can also turn toolbar display on or off by right-clicking and using
the quad menu.

To change an ActiveShade viewport to another kind of viewport:

1 Turn on the toolbar in the ActiveShade viewport.

2 Right-click the toolbar.

3 In the pop-up menu, choose the type of view to display.

You can also restore the viewport to its previous status by right-clicking
the viewport and choosing View (upper-left) quad > Close.

To zoom and pan in an ActiveShade window:

You can zoom in and out and pan the image in the ActiveShade window. You
can even do this while a scene is rendering.

1 Hold down Ctrl and then click to zoom in, right-click to zoom out.

2 Hold down Shift and then drag to pan. (The window must be zoomed
in.)
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If you have a three-button mouse, you can use its third button or wheel to
zoom and pan:

1 Roll the wheel to zoom in or out.

2 Press the wheel, and drag to pan.

NOTE You can use any third-button pointing device to pan the image. To
enable this, choose the Pan/Zoom option on the Viewports panel on page
7753 of the Preferences dialog

Interface

Both the viewport and floating versions of the ActiveShade window have the
same controls as a Rendered Frame Window on page 6073. In an ActiveShade
viewport, the toolbar is off by default. In a floating ActiveShade window, the
toolbar is always visible.

TIP In an active ActiveShade viewport, you can toggle toolbar display by pressing
the Spacebar. (This is a main user interface shortcut, so the Keyboard Shortcut
Override Toggle can be either on or off.)
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TIP If you clear the image, you can redisplay it by right-clicking the ActiveShade
window and choosing Tools > Initialize or Tools > Update Shading from the
lower-right quadrant of the quad menu.

ActiveShade Floater

Main toolbar > Render flyout > ActiveShade

To create an ActiveShade rendering in its own window, choose the ActiveShade
command from the Render flyout on the main toolbar.

You can open only one ActiveShade window at a time. If you change a viewport
to an ActiveShade view while a floating ActiveShade window is open, you get
a message that asks whether you want to close the floating window or stop
the operation.

See also:

■ Rendering with ActiveShade on page 6102
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■ ActiveShade Commands (Quad Menu) on page 6111

■ ActiveShade Initialize and Update on page 7899

ActiveShade Viewport

Right-click viewport label. > Views > ActiveShade

Creates an ActiveShade rendering on page 6102 that is "docked" in a viewport.

Only one ActiveShade rendering can be displayed at a time. If you try to
display a floating ActiveShade window while an ActiveShade viewport is
displayed, you get a message that asks whether you want to close the docked
ActiveShade rendering, or stop the operation. If you go ahead and close the
docked ActiveShade rendering, the viewport reverts to the view it previously
showed.

ActiveShade Commands

When you right-click an ActiveShade viewport, the quad menu on page 7516
displays an ActiveShade menu. This menu contains a number of ActiveShade
commands on page 6111.

ActiveShade and Object Selection

If you select an object before you invoke ActiveShade, ActiveShade is done
only for that object. This can greatly increase the speed of ActiveShade.

Similarly, once the ActiveShade window is open, the initialize and update
steps on page 7899 (whether automatic or manual) are done only for the selected
object.

In a "docked" ActiveShade viewport, you can select objects by right-clicking,
turning on Select Object in the Tools (lower-right) quadrant of the quad menu,
then clicking the object you want to select. In an ActiveShade viewport, only
one object at a time can be selected.

TIP When an object in an ActiveShade window has a mapped material, select it
before you change a map or adjust its parameters.
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Procedures

To display the toolbar for the ActiveShade viewport:

■ Press the Spacebar.
The Spacebar toggles the toolbar display. In viewports, the toolbar is off
by default.

(This is a main user interface shortcut, so the Keyboard Shortcut Override
Toggle can be either on or off.)

The controls on the toolbar for an ActiveShade viewport are the same as for
a floating ActiveShade window on page 6109.

To change the ActiveShade viewport to another kind of viewport, do one of
the following:

■ Right-click the ActiveShade viewport, and choose Close from the View
(upper-left) quadrant of the quad menu.
The viewport reverts to the view it previously showed.

■ If the toolbar is not visible, press the Spacebar to display it, then right-click
the toolbar and choose the kind of view to display.

ActiveShade Commands (Quad Menu)

When you right-click an ActiveShade window, the lower-left quadrant of the
quad menu displays a set of commands for ActiveShade on page 6102.

Interface
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Render quadrant (upper right)

These are general-purpose commands.

Show Last Rendering Displays the last rendering in a Rendered Frame Window
on page 6073. Not available if no rendering has been made during this session.

Render Setup Displays the Render Setup dialog on page 6067. When you use
the ActiveShade quad menu, Render Setup is set to render the ActiveShade
window initially.

Render Last Repeats the last render, using the last viewport from which you
rendered.

Material/Map Browser Opens a modeless Material/Map Browser on page 5357
dialog.

Material Editor opens the Material Editor on page 5284.

Tools quadrant (lower right)

These are the commands that perform ActiveShade operations.

Draw Region When on, lets you draw a rectangular region of the ActiveShade
window. While it is active, only the region is updated by interactive reshading.
This can save time, and also help you concentrate on just a portion of the
image to be rendered. Default=off.

To turn off Draw Region, click outside the rectangular region. The entire
ActiveShade window is updatable again.

Initialize Initializes the ActiveShade window. To keep the ActiveShade window
current, you need to choose Initialize after transforming, modifying, or
otherwise changing geometry. If you have turned off Automatic
Reinitialization, you also need to choose Initialize after you update a mapped
material.

Rendering can be slow. The initialize pass is meant to take care of the most
time-consuming portions of rendering, to allow the update pass to take place
as quickly as possible. Initialization includes the following steps:

■ Evaluate the scene geometry into meshes.

■ Apply space warps.

■ Do transformations and clipping.

■ Evaluate textures and shade materials.
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■ Perform optimizations to speed later processing, such as merging fragments
from the same surface that are in the same pixel.

The result of initialization is a buffer. This is a compressed rendering that, like
a G-Buffer on page 7991, contains the rendering plus additional information
used by the second step, updating.

During the initialize pass, progress is indicated by a row of pixels (white by
default) that traverses the top edge of the ActiveShade window.

Update Updates the ActiveShade window. Updating shading takes the buffer
created by the first pass, initialization, and uses information in that buffer to
change the color of pixels when you make changes to lights and materials in
the scene.

During the update pass, progress is indicated by a row of pixels (white by
default) that descends the right edge of the ActiveShade window.

To keep the ActiveShade window current, you need to choose Update Shading
if you have previously turned off Automatic Shading Update.

Select Object (viewports only) When on, you can select an object in the
ActiveShade window by clicking. You can select only one object at a time.

When an objects is selected in the ActiveShade window, the Initialize pass
resamples textures for that object alone. This improves the window's rendering
speed, and is useful when you are adjusting texture display.

Toggle Toolbar (viewports only) Toggles display of the ActiveShade window
toolbar in viewports.

Keyboard shortcut: Spacebar

NOTE  The Keyboard Shortcut Override toggle on page 7858 must be on for
the spacebar to toggle the ActiveShade toolbar.

Options quadrant (lower left)

These commands control how the ActiveShade window behaves.

Act Only On Mouse Up When on, changes you make to light and material
parameters (for example, the RGB or Multiplier spinners) update the
ActiveShade window only after you release the mouse. When off, changes to
these parameters are updated immediately, as you drag the mouse. Default=on.

Turning off Act Only On Mouse Up can make the ActiveShade window more
responsive to changes, but it can also slow performance.
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Auto Initialization When on, changes you make to textures (mapped
materials) automatically cause the ActiveShade window to initialize.
Default=on.

Initialization can be time consuming in complex scenes. To save time, you
can turn off Automatic Reinitialization, or use Draw Region to restrict
initialization and shading updates to only a portion of the scene.

Auto Update When on, changes you make to lighting, and materials without
maps, automatically cause an update of the ActiveReshade window. Default=on.

View quadrant (upper left)

Close Closes the ActiveShade window. If the ActiveShade window was docked
in a viewport, the viewport reverts to the view it previously displayed.

Preset Rendering Options

Render Setup dialog > Preset drop-down list (near the bottom of the panel)

Rendered Frame Window > Render Preset drop-down list (in the top row of
controls)

Render Shortcuts toolbar on page 7506 > drop-down list

Preset rendering options are available on the Render Setup dialog on page 6067,
the Rendered Frame Window  on page 6073, and the Render Shortcuts toolbar
on page 7506. Some of the presets are tailored for relatively quick, preview
renderings; others are for slower but higher quality renderings. You can save
and load presets as RPS files.
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In addition to the default presets that ship with 3ds Max, you can create your
own. At the bottom of the Preset list, two choices let you use and create your
own custom presets:

Load Preset When you choose Load Preset, 3ds Max opens a file selector
dialog that lets you choose the RPS file to load.

Each category corresponds to one panel of the Render Setup dialog. Choose
which panel's settings you want to load from the RPS file, and click Load.
Once you load a custom preset file, its name appears on the drop-down list,
along with the default choices.
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IMPORTANT Although you assign the renderer on the Common panel of the
Render Setup dialog, the renderer assignment is not among the Common category
settings in the RPS file. Instead, each preset has a separate category for the current
renderer assignment. For example, if the current renderer is the Default Scanline
Renderer, the Select Preset Categories dialog will have a category labeled Default
Scanline Renderer.

Save Preset When you choose Save Preset, 3ds Max first opens a file selector
dialog that lets you name the RPS file. After that, the Select Preset Categories
dialog opens.

Each category corresponds to one panel of the Render Setup dialog. Choose
which panel's settings you want to save, and then click Save. Once you save
a custom preset file, its name appears on the drop-down list, along with the
default choices.

IMPORTANT Even though the renderer is assigned on the Common panel of the
Render Setup dialog, the renderer assignment is not saved with the Common
category in the RPS file. The renderer assignment has its own category on the
Select Preset Categories dialog. For example, if the current renderer is the Default
Scanline Renderer, the Select Preset Categories dialog will have a category labeled
Default Scanline Renderer.

The RPS files that provide the default presets are in the \renderpresets subfolder
of the program folder. We recommend you save your own presets in this
subfolder as well. If you choose a different location, 3ds Max saves the full
path name. (You can also use the Configure User Paths dialog > File I/O panel
on page 7733 > RenderPresets setting to specify a custom location.)
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Render Last

Keyboard > F9

The Render Last command repeats the last render (whether a render view,
render region, render blowup, or render selected) using the last viewport from
which you rendered.

WARNING Render Last does not save to a file, even if the previous rendering did
so.

Print Size Wizard

Rendering menu > Print Size Assistant

The Print Size Wizard feature is useful when you plan to print a rendered
image. It lets you specify output size, resolution, and orientation in terms of
the printed image; that is, using a standard measuring system rather than
pixels. It also indicates the approximate uncompressed size of the image file.
You can render directly from the wizard on your computer or over a network,
or transfer the settings to the Render Setup dialog on page 6067.

Procedures

To use the Print Size wizard:

1 Set up a scene to render.

2 From the Rendering menu, choose Print Size Assistant.

3 Choose a preset paper size, or specify a custom size in inches or
millimeters. Alternatively, specify an image size in pixels.

4 Choose or specify a DPI (dots per inch) ratio for the printed output.

5 Choose an output orientation: Portrait or Landscape.

6 When ready to render to a file, turn on Save File, click the Files button,
and use the resulting Select TIFF File dialog to specify an output image
file.

7 Do one of the following:

■ To render immediately, click Render.

■ To set further rendering properties, click Render Setup.
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Interface

Paper Size group

drop-down list The Paper Size drop-down list lets you choose from several
standard print resolutions and aspect ratios. Choose one of these formats, or
leave it set to Custom to use the other controls in the Paper Size group. These
are the options you can choose from on the list:

■ Custom

■ A - 11 x 8.5 in. (at 300 dpi)

■ B - 17 x 11 in. (at 200 dpi)

■ C - 22 x 17 in. (at 150 dpi)

■ D - 34 x 22 in. (at 100 dpi)
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■ E - 44 x 34 in. (at 75 dpi)

■ A0 - 1189 x 841 mm (at 75 dpi)

■ A1 - 841 x 594 mm (at 100 dpi)

■ A2 - 594 x 420 mm (at 150 dpi)

■ A3 - 420 x 297 mm (at 200 dpi)

■ A4 - 297 x 210 mm (at 300 dpi)

■ A5 - 210 x 148 mm (at 300 dpi)

■ Letter (11 x 8.5 in. at 300 dpi)

■ Legal (14 x 8.5 in. at 300 dpi)

■ Tabloid (17 x 11 in. at 300 dpi)

TIP You can customize the Paper Size list by editing the file plugcfg\printwiz.ini.
If you choose to edit the file, first be sure to save a backup copy of the original.

Portrait/Landscape Choose Portrait for vertically oriented output or Landscape
for horizontal output. The window image provides a graphic depiction of the
orientation.

NOTE Changing between Portrait and Landscape simply switches the Width and
Height settings. The actual orientation depends on the image dimensions. For
example, if you choose Portrait, and then specify a custom size whose width is
greater than its height, the resulting orientation will be horizontal.

TIP After changing this setting, be sure to preview the image using the Show Safe
Frame on page 7583 function from the viewport right-click menu. This shows how
the output orientation corresponds to the viewport.

Choose Unit Lets you specify whether the measurement units for Paper Width
and Paper Height are in millimeters (mm) or inches.

Choose DPI Value Provides four buttons for commonly used dots-per-inch
settings: 72, 150, 300, and 600. Click one to set it in the DPI property, below.

Paper Width/Height Specifies the output width and height in mm
(millimeters) or inches, depending on which is chosen under Choose Unit.

NOTE Changing either setting also changes the corresponding Image size setting.
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Image Width/Height Specifies the output width and height in pixels.

NOTE Changing either setting also changes the corresponding Paper size setting.

DPI Specifies the output resolution in dots per inch. The easiest way to set
this is by clicking one of the buttons under Choose DPI Value. If you're using
a different resolution, set it here manually.

Only TIFF files on page 7372 support DPI information. If you render to a different
image format, you might have to later adjust the image resolution using an
image-processing application.

NOTE Changing the DPI setting also changes the Image Width/Height settings,
keeping the same aspect ratio.

Uncompressed File Size Displays the size of the rendered TIFF image file if
no compression is used.

Rendering group

Rendering directly from the Print Size Wizard allows you to output the current
frame to a disk file in TIFF format on page 7372. This format is commonly used
in the publishing industry. To render to a different format, use the wizard's
Render Setup button.

Save File When on, the software saves the rendered image to disk when you
render. Save File is available only after you specify the output file using the
Files button. Default=off.

Files Opens the Select TIFF File dialog, which lets you specify the output file
name and location. If, during the current session, you already rendered an
image to disk using the Render Setup dialog on page 6067, the last file name
you used appears in this field.

Save Alpha Channel When on, the software includes an eight-bit alpha
channel on page 7905 in the rendered TIFF file on page 7372. Default=off.

Compress File When on, uses compression when saving the file.

Render Setup Opens the Render Setup dialog on page 6067 and transfers any
settings (such as image size) you've made in the Print Size Wizard. Here you
can make further changes and then render the scene.

Render Renders the scene to the Rendered Frame Window on page 6073. Also
renders to a disk file if you've turned on Save File and specified a file name.
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Common Panel (Render Setup Dialog)
Render Setup dialog on page 6067 > Common panel

The Common panel of the Render Setup dialog contains controls that apply
to any rendering, regardless of which renderer you have chosen, and that lets
you choose renderers.

Interface

Common Parameters Rollout (Render Setup Dialog) on page 6121

Email Notifications Rollout on page 6131

Scripts Rollout (Render Setup Dialog) on page 6133

Assign Renderer Rollout on page 6135

Common Parameters Rollout (Render Setup Dialog)

Rendering menu > Render Setup > Render Setup dialog > Common panel >
Common Parameters rollout

The Common Parameters rollout sets parameters common to all renderers.

Procedures

To set the size of the image, do one of the following:

1 In the Output Size group, click one of the preset resolution buttons.

2 In the Output Size group, choose one of the pre-formatted film or video
formats from the drop-down list.

3 In the Output Size group, choose Custom from the drop-down list, and
then adjust the Width, Height, and Aspect Ratio values manually.

TIP Smaller images render much more quickly. For example, you can use
320 x 240 to render draft images, then change to a larger size for your final
work.

To save the rendered still image in a file:

1 In the Render Output group, click Files.
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2 In the file dialog, specify a name and a type for the image file, and then
click OK.

The Save File toggle turns on.

You can later turn off Save File if you want only to view the rendering
on screen.

NOTE The file dialog has a Setup button. This displays a subdialog that lets
you choose options specific to the file type you are saving to.

To alter the pixel aspect ratio:

■ In the Output Size group of the Render Setup dialog > Common panel >
Common Parameters rollout, adjust the Pixel Aspect setting to fit the
requirements of your output device.
The Image Aspect field updates to show the aspect ratio of the rendered
output.

If you alter the pixel aspect ratio but also render to a window or a file, the
rendered image might appear distorted.

To speed up rendering time for the purpose of a test (or draft) rendering:

1 In the Options group of the Common Parameters panel, turn on Area
Lights/Shadows As Points.

2 Set any other parameters and click Render.

All area and linear lights in the scene are treated as point lights during
the rendering. This reduces rendering time, however some quality is lost.
When you are ready to render at high quality, you can simply turn off
Area Lights/Shadows As Points and render again.

NOTE Scenes with radiosity on page 6168 are not affected by the Area
Lights/Shadows As Points toggle, as area lights do not have a significant effect
on the performance of a radiosity solution.
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Interface
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Time Output group

Select which frames you want to render.

Single Current frame only.

Active Time Segment The Active Time Segment on page 7898 is the current
range of frames as shown in the time slider.

Range All the frames between and including the two numbers you specify.

Frames Nonsequential frames separated by commas (for example, 2,5) or
ranges of frames, separated by hyphens (for example, 0-5).

■ File Number Base Specifies the base file number, from which the file
name will increment. Range= -99,999 to 99,999. Available only for Active
Time Segment and Range output.

■ Every Nth frame Regular sample of frames. For example, type 8 to render
every 8th frame. Available only for Active Time Segment and Range output.

For example, if the Range of frames is set to 0-3, Every Nth Frame is 1, and
the File Number Base is 15, the output files are file0015, file0016, file0017,
file0018.

You can specify a negative number base, as well. For example, if you're
rendering frames 50-55, and set the File Number Base to -50, the result is
file-050, file-051, file-052, file-053, file-054, file-055.

NOTE If you begin render a range of frames, but haven't assigned a file in which
to save the animation (using the Files button on page 6129), an alert box appears
to warn you about this. Rendering animations can take a long time, and usually
it doesn't make sense to render a range without saving all frames to a file.

Output Size group

Select one of the predefined sizes or enter another size in the Width and Height
fields (in pixels). These controls affect the image's aspect ratio on page 7914.

Drop-down list The Output Size drop-down list lets you choose from several
standard film and video resolutions and aspect ratios. Choose one of these
formats, or leave it set to Custom to use the other controls in the Output Size
group. These are the options you can choose from on the list:

■ Custom

■ 35mm 1.316:1 Full Aperture (cine)
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■ 35mm 1.37:1 Academy (cine)

■ 35mm 1.66:1 (cine)

■ 35mm 1.75:1 (cine)

■ 35mm 1.85:1 (cine)

■ 35 MM Anamorphic (2.35:1)

■ 35 MM Anamorphic (2.35:1) (Squeezed)

■ 70mm Panavision (cine)

■ 70mm IMAX (cine)

■ VistaVision

■ 35mm (24mm X 36mm) (slide)

■ 6cm X 6cm (2 1/4" X 2 1/4") (slide)

■ 4" X 5" or 8" X 10" (slide)

■ NTSC D-1 (video)

■ NTSC DV (video)

■ PAL (video)

■ PAL DV (video)

■ HDTV (video)

NOTE The values of the Image Aspect and Width and Height buttons can change,
depending on which output format you select from this list.

Aperture Width (mm) Lets you specify an aperture width for the camera that
creates the rendered output. Changing this value changes the camera's Lens
value. This affects the relationship between the Lens and the FOV values, but
it doesn't change the camera's view of the scene.

For example, if you have a Lens setting of 43.0 mm, and you change the
Aperture Width from 36 to 50, when you close the Render Setup dialog (or
render), the camera Lens spinner has changed to 59.722, but the scene still
looks the same in the viewport and the rendering. If you use one of the preset
formats rather than Custom, the aperture width is determined by the format,
and this control is replaced by a text display.
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Width and Height Let you set the resolution of the output image by specifying
the width and the height of the image, in pixels. With Custom format, you
can set these two spinners independently. With any other format, the two
spinners are locked to the specified aspect ratio, so adjusting one alters the
other. The maximum width and height is 32,768 x 32,768 pixels.

Preset resolution buttons (320x240, 640x480, and so on) Click one of these
buttons to choose a preset resolution. You can customize these buttons:
right-click a button to display the Configure Preset dialog on page 6130, which
lets you change the resolution specified by the button.

Image Aspect Lets you set the aspect ratio of the image. Changing this value
changes the Height value to maintain the correct dimensions for the active
resolution. When you use a standard format rather than Custom, you can't
change the aspect ratio, and this control is replaced by a text display.

In 3ds Max, the Image Aspect value is always expressed as a multiplier value.
In written descriptions of film and video, often aspect ratio is also described
as a ratio. For example, 1.33333 (the default Custom aspect ratio) is often
expressed as 4:3. This is the standard aspect ratio for broadcast video (both
NTSC on page 8059 and PAL on page 8078) when letterboxing is not used.
(Letterboxing shows the full width of a wide-screen film format, framed by
black regions above and below.)

 When using a custom output size, the lock button to the left of Image
Aspect locks the aspect ratio. When it is on, the Image Aspect spinner is
replaced by a label, and the Width and Height spinners are locked to each
other; adjusting one alters the other to maintain the aspect-ratio value. In
addition, when the aspect ratio is locked, altering the Pixel Aspect value alters
the Height value to maintain the aspect-ratio value.

NOTE In viewports, the camera's cone changes to reflect the image aspect ratio
you set in the Render Setup dialog. This change takes place when you exit the
Render Setup dialog.

Pixel Aspect Sets the aspect ratio of the pixels for display on another device.
The image might look squashed on your display but will display correctly on
the device with differently shaped pixels. If you use one of the standard formats
rather than Custom, you can't change the pixel aspect ratio and this control
is disabled.
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 The lock button to the left of Pixel Aspect locks the pixel-aspect ratio.
When it is on, the Pixel Aspect spinner is replaced by a label, and you can't
change the value. This button is available only with the Custom format.

Images with different pixel aspects appear stretched or squashed on a monitor with
square pixels.

NOTE For standard NTSC on page 8059, the pixel aspect ratio is 0.9. If you are
creating 16:9 (0.778) anamorphic images for NTSC, the pixel aspect ratio should
be 1.184. (As in the previous discussion of Image Aspect, this assumes the image
is not letterboxed.)

Options group

Atmospherics Renders any applied atmospheric effects, such as volume fog,
when turned on.

Effects Renders any applied rendering effects, such as Blur, when turned on.

Displacement Renders any applied displacement mapping.
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Video Color Check Checks for pixel colors that are beyond the safe NTSC on
page 8059 or PAL on page 8078 threshold and flags them or modifies them to
acceptable values.

By default, "unsafe" colors render as black pixels. You can change the color
check display by using the Rendering panel on page 7768 of the Preference
Settings dialog on page 7743.

Render to Fields Renders to video fields on page 7973 rather than frames when
creating animations for video.

Render Hidden Geometry Renders all geometric objects in the scene, even
if they are hidden.

Area Lights/Shadows as Points Renders all area lights or shadows as if they
were emitted from point objects, speeding up rendering time.

This switch is also available on the Rendered Frame Window as Soft Shadows
on page 6081.

TIP This option is useful for draft renderings, as point lights render much faster
than area lights.

NOTE Scenes with radiosity on page 6168 are not affected by this toggle, as area
lights do not have a significant effect on the performance of a radiosity solution.

Force 2-Sided 2-Sided rendering on page 7893 renders both sides of all faces.
Usually, you'll want to keep this option off to speed rendering time. You may
want to turn it on if you need to render the inside as well as the outside of
objects, or if you've imported complex geometry in which the face normals
are not properly unified.

NOTE This switch does not apply to objects that use the mental ray materialArch
& Design on page 5544. In such cases, turn on the material's Advanced Rendering
Options rollout > Back Face Culling check box on page 5573.

Super Black Super Black rendering on page 8141 limits the darkness of rendered
geometry for video compositing. Leave off unless you're sure you need it.

Advanced Lighting group

Use Advanced Lighting When on, the software incorporates a radiosity
solution on page 6168 or light tracing on page 6154 in the rendering.

Compute Advanced Lighting When Required When on, the software
computes radiosity when required on a per-frame basis.
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Normally, when rendering a series of frames, the software calculates radiosity
only for the first frame. If, in an animation, it might be necessary to recalculate
the advanced lighting in subsequent frames, turn this option on. For example,
a brightly painted door might open and affect the coloring of a nearby white
wall, in which case the advanced lighting should be recalculated.

Bitmap Proxies group

Displays whether 3ds Max is using full-resolution maps or bitmap proxies for
rendering. To change this setting, click the Setup button.

Setup Click to open the Global Settings and Defaults for Bitmap Proxies dialog
on page 7115.

Render Output group

Save File When on, the software saves the rendered image or animation to
disk when you render. Save File is available only after you specify the output
file using the Files button.

Files Opens the Render Output File dialog on page 6086, which lets you specify
the output file name, format, and location.

You can render to any of the still or animated image file formats on page 7324
that are writable.

If you render multiple frames to a still-image file format, the renderer renders
individual frame files and appends sequence numbers to each file name. You
can control this with the File Number Base setting on page 6124.

Put Image File List(s) in Output Path(s) Turn on to create an image sequence
(IMSQ) file on page 7346, and save it in the same directory as the rendering.
Default=off.

3ds Max creates one IMSQ file (or IFL file) per render element on page 6336. The
files are created when you click Render or Create now. They are generated
before the actual rendering.

Image sequence files can be created by the following kinds of rendering:

■ The Render Setup dialog

■ The Render command

■ Batch rendering

■ Command-line rendering

■ MAXScript rendering
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■ ActiveShade rendering

They are not created by the following kinds of rendering:

■ Rendering to textures

■ Video Post rendering

■ Rendering a panorama

■ Create Now Click to create the image sequence file “by hand.” You must
first choose an output file for the rendering itself.

■ Autodesk ME Image Sequence File (.imsq) When chosen (the default),
creates an Image Sequence (IMSQ) file on page 7346.

■ Legacy 3ds max Image File List (.ifl) When chosen, creates an Image File
List (IFL) file on page 7339 of the kind created by previous versions of 3ds
Max.

Use Device Sends the rendered output to a device such as a video recorder.
First click the Devices button to specify the device, for which an appropriate
driver must already be installed.

Rendered Frame Window Displays the rendered output in the Rendered
Frame Window on page 6073.

Net Render Enables network rendering on page 6433. If this is on, when you
render you'll see the Network Job Assignment dialog on page 6481.

Skip Existing Images When activated and Save File is on, the renderer will
skip images in a sequence that have already been rendered to disk.

Configure Preset Dialog

Main menu > Render Setup > Render Setup Dialog > Common panel >
Common Parameters rollout > Output Size group > Right-click a preset
resolution button. > Configure Preset dialog

This dialog lets you change the preset resolution on a button in the Output
Size group of the Common Parameters rollout.
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Interface

Width Sets the output width, in pixels.

Height Sets the output height, in pixels.

Pixel Aspect Sets the output pixel aspect ratio.

Get Current Settings Gets the current Width, Height, and Pixel Aspect settings
from the Output Size group, and assigns them to the spinners on this dialog.

Email Notifications Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog >
Common panel > Email Notifications rollout

This rollout lets a rendering job send email notifications, as network rendering
does. Such notifications can be useful when you launch a lengthy render, such
as an animation, and don't care to spend all your time near the system doing
the rendering.
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Interface

Enable Notifications When on, the renderer sends an email notification
when certain events happen. Default=off.

Categories group

Notify Progress Sends emails to indicate rendering progress. An email is sent
every time the number of frames specified in Every Nth Frame has completed
rendering. Default=off.

■ Every Nth Frame The number of frames used by Notify Progress.
Default=1.

TIP If you turn on Notify Progress, almost certainly you want this value to be
greater than the default!

Notify Failures Sends an email notification only if something occurs to prevent
the completion of a rendering. Default=on.

Notify Completion Sends an email notification when a rendering job is
complete. Default=off.

Email Options group

From Enter the email address of the person who initiates the rendering job.
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To Enter the email address of the person who needs to know the rendering
status.

SMTP Server Enter the numeric IP address of the system you use as a mail
server.

Scripts Rollout (Render Setup Dialog)

Rendering menu/main toolbar > Render Setup > Render Setup dialog >
Common panel > Scripts rollout

The Scripts rollout lets you specify scripts to run before and after rendering.
The script to execute can be:

■ A MAXScript file (MS)

■ A macro script (MCR)

■ A batch file (BAT)

■ An executable file (EXE)

If relevant to its format, the script can have command-line arguments.

The pre-render script is executed before rendering (but after any other
MAXScript scripts that are registered using the #preRender callback
mechanism). The post-render script is executed after rendering has completed.
You can also use the “Execute Now” buttons to run the scripts “by hand.”
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Interface

Pre-Render group

Specifies a script to run before you render.

Enable When on, the script is enabled.

Execute Now Click to execute the script “by hand.”

File name field When a script is selected, this field shows its path and name.
You can edit this field.

File Click to open a file dialog and choose the pre-render script to run.

 Delete File Click to remove the script.

Execute Locally (Ignored by Network Rendering) When on, the script must
run locally. If you use network rendering, the script is ignored. Default=off.

Post-Render group

Specifies a script to run after you render.

Enable When on, the script is enabled.

Execute Now Click to execute the script “by hand.”

File name field When a script is selected, this field shows its path and name.
You can edit this field.
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File Click to open a file dialog and choose the post-render script to run.

 Delete File Click to remove the script.

Assign Renderer Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog >
Common panel > Assign Renderer rollout

The Assign Renderer rollout displays which renderers are assigned to the
production and ActiveShade categories, as well as the sample slots in the
Material Editor.

The Render flyout on the toolbar also lets you choose which renderer to use:

■  The Render Production and Render Iterative buttons use
the production renderer.

■  The ActiveShade button uses the ActiveShade renderer.

These are the renderers that ship with 3ds Max:

Default Scanline Renderer on page 6141

mental ray Renderer on page 6230 (not available for ActiveShade)

VUE File Renderer on page 6334 (not available for ActiveShade)

Additional renderers might be available if you've installed them as plug-ins.
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Interface

For each rendering category, the rollout shows the name of the renderer
currently assigned, and a button that lets you change the assignment.

Choose Renderer (“...”) Click the button with the ellipsis to change the
renderer assignment. The button displays a Choose Renderer dialog on page
6136.

■ Production Chooses the renderer used to render graphic output.

■ Material Editor Chooses the renderer used to render sample slots on page
5304 in the Material Editor.

 By default, the sample slot renderer is locked to be the same as the
production renderer. You can turn off the lock button to assign a different
renderer for sample slots.

■ ActiveShade Chooses the ActiveShade on page 6102 renderer used to
preview the effects of lighting and material changes in the scene.
The only ActiveShade renderer that ships with 3ds Max is the default
scanline renderer.

Save as Defaults Click to save the current renderer assignments as defaults,
so they will be active the next time you restart 3ds Max.

Choose Renderer Dialog

Rendering menu/main toolbar > Render Setup > Render Setup dialog >
Common panel > Assign Renderer rollout > Click a Choose Renderer (“...”)
button.

6136 | Chapter 20   Rendering



This dialog appears when you click one of the Choose Renderer (“...”) buttons
on the Assign Renderer rollout on page 6135.

Procedures

To change the renderer assigned to the category you picked, do one of the
following:

■ Highlight another renderer's name in the list, and then click OK.

■ Double-click another renderer's name in the list

Interface

The scrollable list shows the names of renderers that you can assign, exclusive
of the renderer that is currently assigned to the rendering category you are
reassigning.
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Renderers

Renderer Panel (Render Setup Dialog)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Renderer
panel

The Render Setup dialog > Renderer panel contains the main controls for the
active renderer. Depending on which renderer is active, additional panels can
become available.

TIP The default scanline renderer on page 6141 and the mental ray renderer on
page 6230 have different and unique capabilities. Based on these, you decide which
renderer you want to use for each scene. It is a good idea to design materials with
a particular renderer in mind. The mental ray Connection rollout on page 5385 lets
you add features unique to the mental ray renderer to basic 3ds Max materials.
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Interface

When the Default Scanline Renderer Is Active

The Renderer panel contains a single rollout:

Default Scanline Renderer Rollout on page 6141

Additional panels are:

■ Advanced Lighting Panel on page 6153

■ Raytracer Panel on page 6221

■ Render Elements panel on page 6336
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When the mental ray Renderer Is Active

The renderer panel contains these rollouts:

Sampling Quality Rollout (mental ray Renderer) on page 6272

Rendering Algorithms Rollout (mental ray Renderer) on page 6277

Camera Effects Rollout (mental ray Renderer) on page 6283

Shadows & Displacement Rollout (mental ray Renderer) on page 6292

Additional panels are:

■ Indirect Illumination panel
Caustics and Global Illumination Rollout (mental ray Renderer) on page
6306

Final Gather Rollout (mental ray Renderer) on page 6295

■ Processing panel
Translator Options Rollout (mental ray Renderer) on page 6316
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Diagnostics Rollout (mental ray Renderer) on page 6324

Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6326

When the VUE File Renderer Is Active

The Renderer panel contains a single rollout:

VUE File Renderer on page 6334

Default Scanline Renderer Controls

Default Scanline Renderer Rollout

Main toolbar/Rendering menu > Render Setup > Render Setup dialog > Assign
Renderer rollout > Choose Default Scanline Renderer as the production
renderer. > Renderer panel > Default Scanline Renderer rollout
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This rollout sets parameters for the default scanline renderer on page 8116.

NOTE If your scene includes animated bitmaps (e.g., AVI files), including materials,
projector lights, environments, and so on, each animation file is reloaded once
per frame. If your scene uses multiple animations, or if the animations are
themselves large files, this reloading can hamper rendering performance. To
improve performance, use image sequences (each animation frame in a separate
image file) instead.

Environment Alpha Toggle and Filtering

To control whether or not the renderer uses the environment map's alpha
channel in creating the alpha for the rendered image, choose Customize >
Preferences > Rendering on page 7768, and then turn on Use Environment Alpha
in the Background group. If Use Environment Alpha is off (the default), the
background receives an alpha value of 0 (completely transparent). If Use
Environment Alpha is on, the alpha of the resulting image is a combination
of the scene and the background image's alpha channel. Also, when you render
to TGA files on page 7370 with premultiplied alpha on page 8096 turned off,
turning on Use Environment Alpha prevents incorrect results.

You can also control whether or not a background image is affected by the
renderer's antialiasing filter. Choose Customize > Preferences > Rendering,
and then turn on Filter Background in the Background group. Default=off.

TIP If you plan to composite 3ds Max objects in another program such as
Combustion or Photoshop, render the objects against a black background.
Otherwise, a fringe of environment or background color can appear around the
3ds Max objects.

Plate Match Filtering

This section describes the Plate Match/MAX R2 antialiasing filter (see
Antialiasing group on page 6146 for descriptions of other filtering options).

In versions of 3ds Max prior to R2.5, antialiasing affected only geometric
edges, with the filtering of bitmaps being controlled in the Bitmap Map
parameters (pyramidal, summed area, or no filtering). Current antialiasing
filters affect every aspect of the object, filtering textures along with geometric
edges.

While the method used in R2.5 and subsequent versions provides superior
results, this method also produces inconsistencies when rendering objects
that are supposed to match the environment background, because the
antialiasing filters do not affect the background by default (FilterBackground=0
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in the [Renderer] section of the 3dsmax.ini on page 83 file or Customize menu
> Preferences > Rendering tab > Background group > Filter Background). In
order to correctly match an object’s map to an unfiltered background image,
you need to use the Plate Match/MAX R2 filter so the texture is not affected
by the antialiasing.

There are three ways you can render objects to blend seamlessly into a
background environment:

■ Assign a matte/shadow material on page 5699.

■ Assign a 100% self-illuminated diffuse texture to an object using Camera
Mapping on page 1223.

■ Assign a 100% self-illuminated diffuse texture using Environment/Screen
projection (see Coordinates Rollout (2D) on page 5782).
Use Plate Match/MAX R2 antialiasing when you need to match foreground
objects with an unfiltered background, or when you need to match the
antialiasing qualities of the 3ds Max 2 renderer.

Procedures

To set up an object for motion blurring:

1 Select the object to blur.

2 Right-click the object, and then choose Properties from the quad menu.

The Object Properties dialog is displayed.

3 In the Motion Blur group, click By Layer to change it to By Object.

The other Motion Blur controls are now enabled.

4 In the Motion Blur group, choose either Object or Image.

5 If you chose Image, you can adjust the Multiplier spinner. This increases
or decreases the length of the blurred object's streak.

6 Click OK.

To add motion blur when you render the animation:

1 Click Render Setup.

The Render Setup dialog appears.
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2 On the Default Scanline Renderer rollout, turn on Apply in the Object
Motion Blur group or the Image Motion Blur group.

■ For Object Motion Blur, set Duration, Duration Subdivisions, and
Samples.

■ Increase Duration to exaggerate the motion blur effect. Decrease it to
make the blur more subtle.

■ If Samples is less than Duration Subdivisions, the slices used are
selected randomly, giving a grainy look to the blur. If Samples equals
Duration Subdivisions, the blur is smooth. The smoothest blur results
from larger, equal values of these two parameters, but be aware that
this can slow down rendering by a factor of three to four.

■ For Image Motion Blur, adjust Duration and Apply to Environment
Map.

■ Increase Duration to exaggerate the streaking. Decrease it to make it
more subtle.

3 Turn on Apply to Environment map to have camera orbit movement
blur the environment map. This works only with Spherical, Cylindrical,
or Shrink-Wrapped environments.

4 Set other rendering parameters, and then click Render.
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Interface
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Options group

Mapping Turn off to ignore all mapping information to speed up rendering
for tests. Affects automatic reflections and environment maps as well as
material mapping. Default=on.

Auto Reflect/Refract and Mirrors Ignores automatic reflection/refraction
maps to speed up rendering for tests.

Shadows When off, cast shadows aren't rendered. This can speed up rendering
for tests. Default=on.

Force Wireframe Set to render all surfaces in the scene as wireframes. You
can choose the thickness of the wireframe in pixels. Default=1.

Enable SSE When on, rendering uses Streaming SIMD Extensions (SSE). (SIMD
stands for Single Instruction, Multiple Data.) Depending on the CPU (or CPUs)
of your system, SSE can improve render time. Default=off.

Antialiasing group

Antialiasing Antialiasing on page 7904 smoothes the jagged edges that occur
along the edges of diagonal and curves lines when rendering. Turn off only
when you are rendering test images and greater speed is more important than
image quality.

Turning off Antialiasing disables the Force Wireframe setting. Geometry renders
according to the material assigned it even if Force Wireframe is turned on.

Turning off Antialiasing also disables render elements on page 6336. If you need
to render elements, be sure to leave Antialiasing on.

Filter drop-down list Lets you select a high-quality table-based filter to apply
to your rendering. Filters are the last step in antialiasing. They work at the
sub-pixel level and allow you to sharpen or soften your final output, depending
on which filter you select. Below the controls in this group, 3ds Max displays
a box with a brief description of the filter and how it is applied to your image.

TIP Render Region and Render Selected give reliable results only when rendered
with the Area filter.
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The following table describes the available antialiasing filters.

DescriptionName

Computes antialiasing using a variable-size

area filter.

This is the original 3ds Max filter.

Area

A 25-pixel filter that is sharp, but without

edge enhancement.

Blackman

A blend between sharp area and Gaussian

soften filters.

Blend

A 25-pixel reconstruction filter with a slight

edge-enhancement effect.

Catmull-Rom

A general-purpose filter. Values of 1 to 2.5

are sharp; higher values blur the image.

Cook Variable

A 25-pixel blurring filter based on a cubic

spline.

Cubic

Two-parameter filter; a trade-off of blur-

ring, ringing, and anisotropy. If the ringing

Mitchell-Netravali

value is set higher than .5 it will impact the

alpha channel of the image.

Uses the 3ds Max 2 method (no map filter-

ing) to match camera and screen maps or

Plate Match/MAX R2

matte/shadow elements to an unfiltered

background image.

See the section “Plate Match Filtering,”

above, for a discussion of how and why

you might want to use this filter.

A 9-pixel blurring filter based on a quadrat-

ic spline.

Quadratic
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DescriptionName

A sharp nine-pixel reconstruction filter from

Nelson Max.

Sharp Quadratic

An adjustable Gaussian softening filter for

mild blurring.

Soften

A 25-pixel blurring filter optimized for

NTSC and PAL video applications.

Video

Filter Maps Turns on or off the filtering of mapped materials. Default=on.

TIP Leave Filter Maps turned on unless you are making test renderings and want
to speed up rendering time and save memory.

Filter Size Allows you to increase or decrease the amount of blur applied to
an image. This option is available only when a Soften filter has been selected
from the drop-down list. The spinner is unavailable when any other filter has
been selected.

Setting the Filter Size to 1.0 effectively disables the filter.

NOTE Some filters show additional, filter-specific parameters below the Filter Size
control.

When you render separate elements on page 6336, you can explicitly enable or
disable the active filter, on a per-element basis.

Global SuperSampling group

Disable all Samplers Disables all supersampling on page 8141. Default=off

NOTE SuperSampling settings are ignored by the mental ray Renderer on page
6230, which has its own sampling method.

Enable Global Supersampler When on, applies the same supersampler to all
materials. When turned off, materials set to use the global settings are
controlled by the settings appearing in rendering dialog. All other controls in
the Global SuperSampling group of the rendering dialog will become disabled,
except for the Disable All Samplers. Default=on.
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Supersample Maps Turns on or off supersampling for mapped materials.
Default=on.

TIP Leave Supersample Maps on unless you are making test renderings and want
to speed up rendering time and save memory.

Sampler drop-down list Lets you choose which supersampling method to
apply. Default=Max 2.5 Star.

The options for a supersampling method are the same as those that appear
on the SuperSampling rollout on page 5381 in the Material Editor. Some methods
offer expanded options that let you better control the quality of the
supersampling and the number of samples taken during rendering.

Object Motion Blur group

You determine which objects have object motion blur on page 8063 applied to
them by setting Object in the Motion Blur group of the Properties dialog for
that object. Object motion blur blurs the object by creating multiple "time-slice"
images of the object for each frame. It takes camera movement into account.
Object motion blur is applied during the scanline rendering process.

Apply Turns object motion blur on or off globally for the entire scene. Any
objects that have their Object Motion Blur property set are rendered with
motion blur.

Duration Determines how long the "virtual shutter" is open. When this is set
to 1.0, the virtual shutter is open for the entire duration between one frame
and the next. Longer values produce more exaggerated effects.

The effect of changing duration.
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Samples Determines how many Duration Subdivision copies are sampled.
The maximum setting is 32.

When Samples is less than Duration, random sampling within the duration
occurs (which is why there might be a slight granular look to the motion blur).
For example, if Duration Subdivision=12 and Samples=8, there are eight
random samples out of 12 possible copies within each frame.

When Samples=Duration, there is no randomness (and if both numbers are
at their maximum value (32), you get a dense result (which costs between 3–4
times the normal rendering time for that specific object).

If you want to obtain a smooth blur effect, use the maximum settings of 32/32.
If you want to cut down rendering time, values of 12/12 will give you much
smoother results than 16/12.

Because sampling happens within the duration, the Duration value always
has to be less than or equal to Samples.

Duration Subdivisions Determines how many copies of each object are
rendered within the Duration.

Left: Same value for Samples and Subdivisions.

Right: Samples value is less than Subdivisions.
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Image Motion Blur group

You determine which objects have image motion blur on page 8010 applied to
them by setting Image in the Motion Blur group of the Properties dialog for
that object. Image motion blur blurs the object by creating a smearing effect
rather than multiple images. It takes camera movement into account. Image
motion blur is applied after scanline rendering is complete.

The coin on the right has Image Motion Blur applied

You can’t put image motion blur on objects that change their topology.

TIP When blurred objects overlap, sometimes blurring doesn't work correctly and
there are gaps in the rendering. Because image motion blur is applied after
rendering, it can't account for object overlap. To fix this problem, render each
blurred object separately, to a different layer, and then composite the two layers
using the Alpha Compositor in Video Post.
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NOTE Image motion blur doesn't work for NURBS objects that are animated so
their tessellation (surface approximation on page 2554) changes over time. This
happens when sub-objects are animated independently of the top-level NURBS
model on page 8061. Nor does image motion blur work on any of the following:

■ Anything with an Optimize.

■ Any primitive with animated segments.

■ MeshSmooth of any type with a "Smoothness" value (under iterations)
other than 1.

■ MeshSmooth on polygons with Keep Faces Convex on.

■ Anything with Displacement Material.

In general, if you have objects with changing topology, use scene or object
motion blur rather than image motion blur.

Apply Turns image motion blur on or off globally for the entire scene. Any
objects that have their Image Motion Blur property set are rendered with
motion blur.

Duration Specifies how long the "virtual shutter" is open. When this is set to
1.0, the virtual shutter is open for the entire duration between one frame and
the next. The higher the value, the greater the motion blur effect.

Apply to Environment Map When set, image motion blur is applied to the
environment map as well as to the objects in the scene. The effect is noticeable
when the camera orbits.

The environment map should use Environment mapping: Spherical,
Cylindrical, or Shrink-Wrap. The image motion blur effect doesn't work with
Screen-mapped environments.

Transparency When on, image motion blur works correctly with transparent
objects that overlap. Applying image motion blur to transparent objects can
increase rendering time. Default=off.

Auto Reflect/Refract Maps group

Rendering Iterations Sets the number of inter-object reflections in non-flat
automatic reflection maps. Although increasing this value can sometimes
enhance image quality, it also increases rendering time for reflections.
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Color Range Limiting group

Color Range Limiting allows you handle over-brightness by toggling between
either Clamping or Scaling color components (RGB) that are out of range (0
to 1). Typically, specular highlights can cause color components to rise above
range while using filters with negative lobes can cause color components to
be below range. You choose one of two options to control how the renderer
handles out of range color components:

■ Clamp To keep all color components in range Clamp will change any
color with a value greater than 1 down to 1 while any color below 0 will
be clamped at 0. Any value between 0 and 1 will not change. Very bright
colors tend to render as white when using Clamp since hue information
can be lost in the process.

■ Scale To keep all color components in range Scale will preserve the hue
of very bright colors by scaling all three color components so that the
maximum component has a value of 1. Be aware that this will change the
look of highlights.

Memory Management group

Conserve Memory When on, rendering uses less memory at a slight cost of
memory time. Memory saved is in the range of 15 to 25 percent. The time
cost is about four percent. Default=off.

Advanced Lighting Panel

Rendering menu > Render Setup > Render Setup dialog > Assign Renderer
rollout > Set Production to Default Scanline Renderer. > Advanced Lighting
panel > Select Advanced Lighting rollout

Main toolbar > Render Setup > Render Setup dialog > Assign Renderer rollout
> Set Production to Default Scanline Renderer. > Advanced Lighting panel >
Select Advanced Lighting rollout

The Advanced Lighting rollout lets you select one of the advanced lighting
options. Two are provided with the default scanline renderer on page 6141:

■ Light Tracer on page 6154

■ Radiosity on page 6168
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The Light Tracer provides soft-edged shadows and color bleeding for brightly-lit
scenes such as outdoor scenes. Radiosity provides physically accurate modeling
of the light in a scene.

Interface

Until you choose an advanced lighting option, the Advanced Lighting panel
displays a single rollout, Select Advanced Lighting.

List of plug-ins Choose an advanced lighting option from this drop-down
list. Default=No advanced lighting chosen.

Active When an advanced lighting option is chosen, use Active to toggle
whether the advanced lighting is used when you render your scene.
Default=On.

Light Tracer

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose
Default Scanline Renderer as the active production renderer. > Advanced
Lighting panel > Select Advanced Lighting rollout > Choose Light Tracer from
the drop-down list.
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Character lit by Skylight and one spotlight, and rendered with light tracing

Model by Sonny Sy — orange_3D@yahoo.com — www.geocities.com/orange_3D
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The Light Tracer provides soft-edged shadows and color bleeding for brightly-lit
scenes such as outdoor scenes. It is typically used in conjunction with a
Skylight on page 5065. Unlike radiosity on page 6168, the Light Tracer does not
attempt to create a physically accurate model, and can be easier to set up.

Outdoor scene lit by Skylight and rendered with light tracing

TIP While you can use light tracing for indoor scenes, radiosity is usually the better
choice in such cases.

Previewing the Effect of Light Tracing

■ To get a quick preview of the effect the Light Tracer will have, lower the
values of Rays/Sample and Filter Size.
The result will be a grainy version of the full effect.

■ Another way to get a quick preview is to make sure Adaptive Undersampling
is turned on. In this group, set the Initial Sample Spacing sampling and
the Subdivide Down To setting to the same value. In the General Settings
group, lower the value of Rays/Sample, and set Bounces equal to 0.0. This
gives a rather blotchy but fast preview of the rendering. Increase the
Rays/Sample and Filter Size values to improve the image quality.
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In general, you can get good, fairly quick results with a lower Filter Size
value as long as Rays/Sample has a high value and Adaptive Undersampling
is on.

Other Tips for Using the Light Tracer

■ To improve rendering time, use the Object Properties dialog on page 305
to disable light tracing (or radiosity solving) for objects that don't have a
great impact on the final effect.

TIP You can also use the Advanced Lighting Override material on page 5734 to
alter the effect of light tracing on particular objects. For example, if you
encounter visual artefacts with a bump-mapped material, convert it to an
Advanced Lighting Override material and reduce the Indirect Light Bump Scale
value.

■ Experiment with the Adaptive Undersampling group settings, which restrict
light tracing to the areas of your scene that need it.

■ To increase the amount of color bleeding, increase the values of both
Bounces and Color Bleed. Color bleeding is usually a subtle effect.

■ If there are glass objects in the scene, increase the Bounces value to an
amount greater than 0. But be aware that this increases rendering time.

■ If the main scene lighting is a Skylight on page 5065, and you need specular
highlights in your scene, add a second light: for example, a Directional
light that parallels the Skylight. Make sure Shadows are turned on for this
light, and on the light's Advanced Effects rollout on page 5108, turn off
Diffuse.
If the objects with highlights don't greatly affect shadows or color bleeding,
you can leave Diffuse on for this light, and use Object Properties to exclude
the objects from light tracing.

■ Set Key filters are not taken into account when you animate Light Tracer
settings. If you wish to use Set Key to create keys for animating the Light
Tracer parameters, Shift+right-click the spinner to create those keys.

IMPORTANT If you use a texture map with the Skylight, you should use an
image-processing program to thoroughly blur the map before using it. This
helps reduce variance and the number of rays needed for light tracing. You
can blur the map beyond recognition, and it will still look correct when used
for regathering.

Default Scanline Renderer Controls | 6157



Procedures

To set up a scene for the Light Tracer:

This is a typical use case:

1 Create the geometry for an outdoor scene.

2 Add a Skylight on page 5065 to illuminate it.

One or more spotlights can also work well. If you use the physically based
IES Sun or IES Sky lights, using an exposure control on page 6732 is essential.

3 Choose Rendering > Advanced Lighting > Light Tracer.

This opens the Render Setup dialog to the Advanced Lighting panel and
activates Light Tracer.

4 Adjust the Light Tracer parameters, activate the viewport to render, and
then activate the Common panel.

5 Adjust your rendering settings, and then click the Render button at the
bottom of the dialog.

The scene renders with soft-edged shadows and color bleeding.
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Interface

General Settings group

Global Multiplier Controls the overall lighting level. Default=1.0.
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Left: Lower Global Multiplier value

Right: Higher Global Multiplier value

Object Multiplier Controls the level of light reflected by objects in the scene.
Default=1.0.

NOTE This setting has little effect unless Bounces is greater than or equal to 2.

Sky Lights [toggle] When on, enables regathering from the Skylights in the
scene. (A scene can contain more than one Skylight.) Default=on.

Sky Lights [amount] Scales the intensity of the Skylights. Default=1.0.

Above: Increasing the Sky Lights value

Below: Increasing the Object Multiplier value

Color Bleed Controls the strength of color bleeding. Color bleeding results
when light is interreflected among scene objects. Default=1.0.
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NOTE This setting has little effect unless Bounces is greater than or equal to 2.

Above: Excessive color bleeding

Below: Color bleeding eliminated by setting Color Bleed to 0.0

Rays/Sample The number of rays cast per sample (or pixel). Increasing this
value increases the smoothness of the effect, at a cost of render time.
Decreasing this value results in a grainier effect, but renders more quickly.
Default=250.

TIP To get a “first draft” preview of the effect of light tracing, reduce the value
of Rays/Sample and the Filter Size.
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Changing the number of rays per sample

The higher the value, the less grain

Color Filter Filters all light falling on objects. Set to a color other than white
to tint the overall effect. Default=white.

Filter Size The size, in pixels, of the filter used to reduce noise in the effect.
Default=0.5.

TIP Filter Size is especially useful when Adaptive Undersampling is turned off, and
Rays/Sample has a low value.
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Changing the Filter Size value

Increasing Filter Size reduces noise in the rendering.

Extra Ambient When set to a color other than black, adds that color as extra
ambient light on objects. Default=black.

Ray Bias Ray Bias, like Ray-Trace Bias for shadows on page 8102, adjusts the
positioning of the bounced light effects. Use it to correct rendering artifacts,
such as the banding that can occur when an object casts shadows on itself.
Default=0.03.

Bounces The number of light-ray bounces that are traced. Increasing this
value increases the amount of color bleeding. Lower values give faster results
with less accuracy, and typically produce darker images. Higher values allow
more light to flow through the scene, resulting in brighter, more accurate
images at a cost of rendering time. Default=0.

When Bounces equals 0, the Light Tracer disregards volumetric lighting.

TIP If your scene has transparent objects such as glass, increase Bounces to be
greater than zero. Be aware that this increases rendering time.
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Increasing the number of bounces increases the level of global illumination and the
amount of color bleeding in the rendering.

Cone Angle Controls the angle used for regathering. Reducing this value can
result in slightly higher contrast, especially in regions where lots of small
geometry casts shadows on a larger structure. Range=33.0 to 90.0. Default=88.0.

All rays initially cast are limited by the cone angle

Volumes [toggle] When on, the Light Tracer regathers light from volumetric
lighting effects such as Volume Light on page 6721 and Volume Fog on page
6713. Default=on.

For volumetric lighting to work with light tracing, Bounces must be greater
than 0.
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Volumes [amount] Multiplies the amount of light regathered from volumetric
lighting effects. Increase to increase their impact on the rendered scene,
decrease to decrease their effect. Default=1.0.

Increasing the Volumes value increases the effect of volumetric lighting in the rendering.

Adaptive Undersampling group

These controls can help you speed up rendering time. They reduce the number
of light samples taken. The ideal settings for undersampling vary greatly from
scene to scene.

Undersampling initially takes samples from a grid superimposed on the pixels
of the scene. Where there is enough contrast between samples, it subdivides
that region and takes further samples, down to the minimum area specified
by Subdivide Down To. Lighting for areas not directly sampled is interpolated.
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Initial sampling uses a regular grid.

Adaptive undersampling concentrates on transition areas.

TIP If you use adaptive undersampling, try adjusting the Subdivision Contrast
value to obtain the best results. The effect of this control depends on the value of
Rays/Sample.
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Adaptive Undersampling When on, the Light Tracer uses undersampling.
When off, it samples every pixel. Turning this off can increase the detail of
the final rendering, but at a cost of rendering time. Default=on.

Initial Sample Spacing The grid spacing for the initial samples of the image.
This is measured in pixels. Default=16x16.

Initial sample spacing values

Subdivision Contrast The contrast threshold that determines when a region
should be further subdivided. Increasing this value causes less subdividing to
occur. Too low a value can cause unnecessary subdividing. Default=5.0.

Decreasing the subdivision contrast threshold can reduce noise in soft shadows and
bounced lighting.

Subdivide Down To The minimum spacing for a subdivision. Increasing this
value can improve render time at a cost of accuracy. Default=1x1.

Depending on the scene geometry, grids larger than 1x1 might still be
subdivided below this specified threshold.

Default Scanline Renderer Controls | 6167



Show Samples When on, sample locations render as red dots. This shows
where the most sampling has taken place, which can help you choose the
optimal settings for undersampling. Default=off.

Modeling Global Illumination with Radiosity

Radiosity is rendering technology that realistically simulates the way in which
light interacts in an environment.

This topic provides you with a conceptual overview of what radiosity is and
how this global illumination technique relates to other rendering techniques
available in 3ds Max. This information will help you decide which technique
is most suitable for the visualization task you want to perform. By more
accurately simulating the lighting in your scene, radiosity offers you significant
benefits over standard lights:

■ Improved Image Quality: The radiosity technology of 3ds Max produces
more accurate photometric on page 8088 simulations of the lighting in your
scenes. Effects such as indirect light, soft shadows, and color bleeding
between surfaces produce images of natural realism that are not attainable
with standard scanline rendering. These images give you a better, more
predictable representation of what your designs will look like under specific
lighting conditions.

■ More Intuitive Lighting: In conjunction with radiosity techniques, 3ds
Max also provides a real-world lighting interface. Instead of specifying
lighting intensity with arbitrary values, light intensity is specified using
photometric units (lumens, candelas, and so on). In addition, the
characteristics of real-world lighting fixtures can be defined using
industry-standard Luminous Intensity Distribution files (such as IES on
page 5034, CIBSE on page 7935, and LTLI on page 8029), which are obtainable
from most lighting manufacturers. By being able to work with a real-world
lighting interface, you can intuitively set up the lighting in your scenes.
You can focus more on your design exploration than on the computer
graphic techniques required to visualize them accurately.
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Top: A scene rendered without radiosity.

Bottom: The same scene rendered with radiosity.
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Computer Graphics Rendering

The 3D models created in 3ds Max contain geometric data defined in
relationship to a 3D Cartesian coordinate system, referred to as world space
on page 8175. The model also contains other information about the material of
each of the objects and the lighting in the scene. The image on a computer
monitor is made up of many illuminated dots, called pixels on page 8092. The
task in creating a computer graphics image of a geometric model is to
determine the color for each pixel based on the model information and a
specific viewpoint (camera).

The color of any specific point on a surface in a model is a function of the
physical material properties of that surface and the light that illuminates it.
Two general shading algorithms: local illumination and global illumination are
used to describe how surfaces reflect and transmit light.

Local Illumination

Local illumination algorithms describe only how individual surfaces reflect
or transmit light. Given a description of light arriving at a surface, these
mathematical algorithms, called shaders in 3ds Max, predict the intensity,
color, and distribution of the light leaving that surface. In conjunction with
a material description, different shaders will determine, for example, if a surface
will appear like plastic or metal or if it will appear smooth or rough. 3ds Max
provides a robust interface for defining a wide array of different surface
materials.

After defining how an individual surface interacts with light at the local level,
the next task is to determine where the light arriving at the surface originates.
With the standard scanline rendering system on page 8116 of 3ds Max, only the
light coming directly from the light sources themselves is considered in the
shading.

For more accurate images, however, it is important to take into account not
only the light sources, but also how all the surfaces and objects in the
environment interact with the light. For example, some surfaces block light,
casting shadows on other surfaces; some surfaces are shiny, in which case we
see in them the reflections of other surfaces; some surfaces are transparent,
in which case we see other surfaces through them; and some surfaces reflect
light onto other surfaces.

Global Illumination

Rendering algorithms that take into account the ways in which light is
transferred between surfaces in the model are called global illumination
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algorithms. 3ds Max offers two global illumination algorithms as an integral
part of its production rendering system: ray-tracing and radiosity.

Before an explanation of how ray-tracing and radiosity work, it’s useful to
understand how light is distributed in the physical world. Consider, for
example, the room shown in the illustration below.

Kitchen lit by two lights

This kitchen above has two light sources. One theory of light considers the
light in terms of discrete particles called photons, that travel from the light
source until they encounter some surface in the kitchen. Depending on the
surface material, some of these photons are absorbed and others are scattered
back out into the environment. The fact that photons traveling at a particular
wavelength are absorbed while others are not is what determines the color of
the surface.

Surfaces that are very smooth reflect the photons in one direction, at an angle
equal to the angle at which they arrive at the surface, the angle of incidence.
These surfaces are known as specular surfaces, and this type of reflection is
known as specular reflection. A mirror is an example of a perfectly specular
surface. Of course, many materials display some degree of both specular and
diffuse reflection.
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Left: Specular reflection

Right: Diffuse reflection

The way in which the photons are reflected from a surface depends primarily
on the smoothness of the surface. Rough surfaces tend to reflect photons in
all directions. These are known as diffuse surfaces, and this type of reflection
is known as diffuse reflection (shown above). A wall painted with flat paint
is a good example of a diffuse surface.

The final illumination of the kitchen is determined by the interaction between
the surfaces and the billions of photons emitted from the light source. At any
given point on a surface, it is possible that photons have arrived directly from
the light source (direct illumination) or else indirectly through one or more
bounces off other surfaces (indirect illumination). If you were standing in the
kitchen, a very small number of the photons in the room would enter your
eye and stimulate the rods and cones of your retina. This stimulation would,
in effect, form an image that is perceived by your brain.

In computer graphics we replace the rods and cones of a retina with the pixels
of the computer screen. One goal of a global illumination algorithm is to
re-create, as accurately as possible, what you would see if you were standing
in a real environment. A second goal is to accomplish this task as quickly as
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possible, ideally in real time (30 images per second). Currently, no single global
illumination algorithm can accomplish both goals.

Ray-Tracing

One of the first global illumination algorithms developed is known as
ray-tracing. The ray-tracing algorithm recognizes that although billions of
photons may be traveling about the room, the photons we primarily care
about are the ones that enter the eye. The algorithm works by tracing rays
backward, from each pixel on the screen into the 3D model. In this way, we
compute only the information needed to construct the image. To create an
image using ray-tracing, the following procedure is performed for each pixel
on the computer screen.

1 A ray is traced back from the eye position, through the pixel on the
monitor, until it intersects with a surface. We know the reflectivity of
the surface from the material description, but we do not yet know the
amount of light reaching that surface.

2 To determine the total illumination, we trace a ray from the point of
intersection to each light source in the environment (shadow ray). If the
ray to a light source is not blocked by another object, the light
contribution from that source is used to calculate the color of the surface.

3 If an intersected surface is shiny or transparent, we also have to determine
what is seen in or through the surface being processed. Steps 1 and 2 are
repeated in the reflected (and, in the case of transparency, transmitted)
direction until another surface is encountered. The color at the subsequent
intersection point is calculated and factored into the original point.

4 If the second surface is also reflective or transparent, the ray-tracing
process repeats, and so on until a maximum number of iterations is
reached or until no more surfaces are intersected.
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Ray-tracing: Rays are traced from the camera through a pixel, to the geometry,
then back to their light sources.

The ray-tracing algorithm is very versatile because of the large range of lighting
effects it can model. It can accurately account for the global illumination
characteristics of direct illumination, shadows, specular reflections (for
example, mirrors), and refraction through transparent materials. The main
disadvantage of ray-tracing is that it can be very slow for environments of
even moderate complexity. In 3ds Max, ray-tracing is used selectively on
objects with ray-trace materials on page 5490 that specify ray-tracing as their
shading option. Ray-tracing can also be specified for light sources as the
method for rendering the shadows they cast.

A significant disadvantage of both ray-tracing and scanline rendering is that
these techniques do not account for one very important characteristic of global
illumination, diffuse inter-reflections. With traditional ray-tracing and scanline
rendering, only the light arriving directly from the light sources themselves
is accurately accounted for. But, as shown in the room example, not only does
light arrive at a surface from the light sources (direct lighting), it also arrives
from other surfaces (indirect lighting). If we were to ray-trace an image of the
kitchen, for example, the areas in shadow would appear black because they
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receive no direct light from the light sources. We know from experience,
however, that these areas would not be completely dark because of the light
they would receive from the surrounding walls and floor.

In scanline rendering and traditional ray-tracing (versions of 3ds Max prior
to v5), this indirect illumination is usually accounted for simply by adding
an arbitrary ambient light value that has no correlation to the physical
phenomena of indirect illumination and is constant throughout space. For
this reason, scanline and ray-traced images can often appear very flat,
particularly renderings of architectural environments, which typically contain
mostly diffuse surfaces.

Radiosity

To address this issue, researchers began investigating alternative techniques
for calculating global illumination, drawing on thermal engineering research.
In the early 1960s, engineers developed methods for simulating the radiative
heat transfer between surfaces to determine how their designs would perform
in applications such as furnaces and engines. In the mid-1980s, computer
graphics researchers began investigating the application of these techniques
for simulating light propagation.

Radiosity, as this technique is called in the computer graphics world, differs
fundamentally from ray-tracing. Rather than determining the color for each
pixel on a screen, radiosity calculates the intensity for all surfaces in the
environment. This is accomplished by first dividing the original surfaces into
a mesh of smaller surfaces known as elements. The radiosity algorithm calculates
the amount of light distributed from each mesh element to every other mesh
element. The final radiosity values are stored for each element of the mesh.
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Radiosity: A ray of light that hits a surface is reflected by multiple diffuse rays, which
can themselves illuminate other surfaces. Surfaces are subdivided to increase accuracy
of the solution.

In early versions of the radiosity algorithm, the distribution of light among
mesh elements had to be completely calculated before any useful results could
be displayed on the screen. Even though the result was view-independent,
the preprocessing took a considerable amount of time. In 1988, progressive
refinement was invented. This technique displays immediate visual results
that can progressively improve in accuracy and visual quality. In 1999, the
technique called stochastic relaxation radiosity (SRR) was invented. The SRR
algorithm forms the basis of the commercial radiosity systems provided by
Autodesk.
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An Integrated Solution

Although the ray-tracing and radiosity algorithms are very different, they are
in many ways complementary. Each technique has advantages and
disadvantages.

DisadvantagesAdvantagesLighting
Algorithm

Computationally
expensive. The

Accurately
renders direct illu-

Ray-Tra-
cing

time required tomination, shad-
produce an imageows, specular re-
is greatly affectedflections, and
by the number of
light sources.
Process must be
repeated for each

transparency ef-
fects.
Memory Efficient

view (view de-
pendent).
Doesn’t account
for diffuse interre-
flections.

3D mesh requires
more memory

Calculates diffuse
interreflections
between surfaces.
Provides view in-
dependent solu-

Radiosity

than the original
surfaces.
Surface sampling
algorithm is moretions for fast dis-
susceptible toplay of arbitrary

views. imaging artifacts
than ray-tracing.Offers immediate

visual results. Doesn’t account
for specular reflec-
tions or transpar-
ency effects.

Neither radiosity nor ray-tracing offers a complete solution for simulating all
global illumination effects. Radiosity excels at rendering diffuse-to-diffuse
inter-reflections, and ray-tracing excels at rendering specular reflections. By
integrating both techniques with a production quality scanline rendering
system, 3ds Max offers the best of both worlds. After you create a radiosity
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solution, you can render a two-dimensional view of it. In your 3ds Max scene,
ray-tracing adds effects in addition to those that radiosity provides: lights can
provide ray-traced shadows, and materials can provide ray-traced reflections
and refractions. The rendered scene combines both techniques, and appears
more realistic than either technique alone could provide.

By integrating ray-tracing and radiosity, 3ds Max offers a full range of
visualization possibilities, from fast, interactive lighting studies to images of
exceptional quality and realism.

See also:

■ How Radiosity Works in 3ds Max on page 6178

■ Radiosity Workflows on page 6181

■ Animation with Radiosity on page 6186

■ Radiosity Controls on page 6188

■ Lighting Analysis on page 6219

■ Radiosity Preferences on page 7786

■ Advanced Lighting Override Material on page 5734

How Radiosity Works in 3ds Max

This is an overview of how radiosity works in 3ds Max:

1 Object by object, 3ds Max loads a copy of the scene into the radiosity
engine.

2 3ds Max subdivides each object according to the Global Subdivision
Settings in the Radiosity Meshing Parameters rollout, or according to the
object's individual object properties, if those differ from the global settings.

3 3ds Max emits a certain amount of rays, based on the average scene
reflectance and number of polygons. The brightest light source will have
more rays to emit than the weakest light source.

4 These rays bounce around randomly in the scene and deposit energy on
the faces.

5 3ds Max updates the viewports by taking all the energy from the faces
and spreading it to the closest vertex.
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See the section that follows, “Refinement Steps for Radiosity,” for a more
detailed description of the solution process.

Refinement Steps for Radiosity

The radiosity process involves three stages of increasing refinement. The first
two stages occur during the primary radiosity processing, and the third stage
can be used during the final rendering.

Within each of the first two stages, you can stop and start the processing at
any time. This can be useful for evaluating interim results or increasing the
level of accuracy you desire. For example, you can interrupt the Initial Quality
stage at 50% and jump ahead to the Refine stage if you wish. However, once
you enter the Refine stage, you cannot continue further iterations of Initial
Quality unless you restart the solution.
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The stages of a radiosity solution are Initial Quality, Refine, and then Regathering.

1 Initial Quality

In the Initial Quality stage, the distribution of diffuse lighting in the
scene is calculated by essentially mimicking the behavior of real photons.
Rather than tracing the path of an essentially infinite number of photons,
statistical methods are used to choose a much smaller set of “photon
rays” whose distribution in space is representative of the actual
distribution. As with any statistical sampling process, the greater the
number of rays used in the approximation, the greater the accuracy of
the solution. During the initial quality stage, the overall appearance of
the lighting level of the scene is established. The results can be
interactively displayed in shaded viewports.
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The initial quality stage performs repeated passes, which are shown in
the dialog’s progress bar.

2 Refine Iterations (All Objects) and Refine Iterations (Selected Objects)

Because of the random nature of the sampling during the initial quality
stage, some of the smaller surfaces or mesh elements in the scene might
miss being hit by enough rays (or any rays at all). These small surfaces
remain dark, and result in the appearance of “variance” or dark spots. To
alleviate these artifacts, the Refine stage “regathers light” at every surface
element.

You can perform the Refine stage for the entire scene, or for selected
objects in the scene.

3 Regathering

Even after the Refine stage, it is still possible for visual artifacts to appear
in a scene because of the topology of the original model. These artifacts
sometimes appear as shadow or light “leaks.” To eliminate even these
model-based artifacts, a third, optional refinement stage known as Pixel
Regathering occurs at the time of image rendering. This involves a final
“regather” process for each pixel of the image. Regathering can add a
considerable amount of time to the rendering of a final image, but it also
produces the most detailed and artifact-free images possible.

One benefit of using Regathering is that it means the initial modeling
and mesh resolution don’t need to be nearly as “refined” or “tight” as
would otherwise be required.

Radiosity Workflows

The following sections describe how to set up a scene for use with radiosity.

Set Units Correctly Before Processing Radiosity

For imported geometry, you must make sure that units are consistent in your
scene before processing radiosity (for example, a wall is 8 feet high, not 8
kilometers high). Units in 3ds Max must match the units of the model because
the radiosity engine always uses an inverse square falloff for lights. Therefore,
distance is crucial.

To make sure your units are setup correctly, use the Units Setup dialog on
page 7809. The Scene Unit is the most important unit in this dialog. This is the
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unit that 3ds Max uses for its calculations. The Display Unit is just a tool that
lets you customize how units are displayed in the user interface.

The following two scenarios show how to set unit scales after importing
geometry that has been created using different units than what is currently
set in 3ds Max:

Example 1: You import a table that was created in AutoCAD using metric
scale. The table is 9 units long, which corresponds to an actual length of 90
centimeters. When the table is imported into 3ds Max, it will measure 9 scene
units. Therefore, in the Units Setup dialog, you must set Scene Unit Scale to
1 Unit=10 centimeters. Your table is now the correct units because it is 90
centimeters long in 3ds Max model.

Example 2: You have an AutoCAD model that was created using Architectural
Units. The model is a room measuring 20’-4” long. In AutoCAD, Architectural
Units are stored as inches. Therefore, before importing the model to 3ds Max,
make sure to set the Scene Unit Scale to 1 Unit=1 inch. Once imported to 3ds
Max, the room will measure 244 units long (20’*12+4”).

TIP Use the Measure Distance tool on page 2613 to quickly check dimensions in
3ds Max.

Physically Based Workflow

Use radiosity on page 6168 to create physically based lighting simulations. When
doing so, keep in mind the following:

■ Scene dimensions: Make sure your scenes are accurately dimensioned, with
consistent units (a light bulb in a room 120 meters high would look a lot
different than it would in a room 120 inches high).

■ Lights: You should work exclusively with Photometric lights on page 5005.
You should also make sure that the light intensities are within a normal
range.

■ Natural Lighting: To simulate natural light, you should only use IES sun
on page 5154 and IES Sky on page 5157. These provide accurate photometric
representations of sunlight and skylight based on a specified location, date
and time.

■ Material Reflectance: You should ensure that the materials you use in your
scene have a reflectance value on page 5324 within the range of the physical
materials they represent. For example, a painted white wall should have
a maximum reflectance of approximately 80%; however, a pure white color

6182 | Chapter 20   Rendering



material (RGB:255, 255, 255) would have a reflectance of 100%. This means
that the material reflects 100% of the energy received.

■ Exposure Control: The exposure control is the equivalent of the aperture
of a camera. Make sure you enable the exposure control and set a value
that provides the final results you desire.

To process radiosity for photometric lights using a physically based workflow:

1 Ensure that your geometry is set to a physically correct scale and that the
materials have valid reflectance values.

2 Place photometric lights in your scene. The benefit of this workflow is
that it allows you to place lights in your scene the same way you would
in the real world. You can create new photometric lights or, using the
asset browser on page 7132, drag and drop preset luminaire objects on page
295 from the included library.

You can also refer to Common Lamp Values on page 5014.

3 Choose Rendering > Environment to display the Environment panel on
page 6689. Select the type of exposure control you want to use (typically
Logarithmic on page 6740).

4  To preview the lighting, click Render.

At this stage, no processing of radiosity occurs, but you can quickly
confirm that the direct lighting is correct. If you like, adjust the position
of the lights.

5 Choose Rendering > Advanced Lighting > Radiosity, and then confirm
any alerts that appear. On the Select Advanced Lighting rollout, make
sure Active is on.

6 To process radiosity, on the Radiosity Processing Parameters rollout, click
Start.

Once the Radiosity calculation has been completed, you should see your
results in the viewports. The light levels are stored with the geometry
and you can navigate the model interactively without reprocessing the
scene.

7  Click Render again.
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The renderer calculates the direct lighting and shadows and then
integrates the radiosity solution (indirect lighting) as a modulated ambient
light.

Lighting Analysis

After you generate a radiosity solution, you can use the Lighting Analysis tool
on page 6219 to analyze the lighting levels in your scene. This dialog provides
data on material reflectance, transmittance, and luminance.

You can also visualize the light levels in the scene interactively with the Pseudo
Color Exposure Control on page 6753. Rendering to the Rendered Frame Window
displays an additional rendered frame with a legend below the image. The
legend correlates lighting levels and color values.

If you need to generate a lighting report, you can use the Lighting Data
Exporter utility on page 6759 to export the luminance and illuminance data to
a 32-bit LogLUV TIFF file on page 7372 or a pair of PIC files on page 7359 (one
each for luminance and illuminance).

NOTE To obtain the most accurate quantitative analysis of lighting levels, avoid
using colored materials and diffuse maps.

Non-Physically Based Workflow

You don’t necessarily have to work with physically based lights and materials
in order to incorporate radiosity effects into your renderings. But there are a
number of issues that you need to consider:

■ Lights: Because the radiosity engine is physically based, the engine
interprets Standard lights on page 5049 as Photometric lights on page 5005.
For example, a Standard Spot light with a multiplier value of 1.0 is
translated as a Physically Based Spot light with an intensity value of 1500
candelas (default value). This translation value corresponds to the Physical
Scale value in the various exposure controls.
In addition, if your Standard lights use custom attenuation settings (for
example, no attenuation, manual attenuation, or linear decay), the radiosity
engine always solves for these lights using inverse square attenuation,
which is physically correct. This means that the amount of energy that
bounces between surfaces might not be equivalent to the way the Standard
lights render.
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■ Natural Lighting: To simulate natural lighting without using the physically
based workflow described above, you can use only a Direct Light on page
5057 for the Sun and Skylight on page 5065 to produce skylight on page 8129.

■ Exposure Control: Standard lights are not physically based, so use the
Logarithmic Exposure Control on page 6740 for the radiosity solution. Be
sure to turn on Affect Indirect Only. The Brightness and Contrast controls
of the exposure control will affect only the radiosity solution and your
lights will render as usual.

To process radiosity with standard lighting:

1 Ensure that your geometry is set to a physically correct scale.

2  On the Create panel, click Lights. Create and position
standard lights on page 5049 in your scene.

3  To preview the lighting, click Render.

At this stage, the radiosity is not processed, but you can quickly confirm
that the direct lighting is correct. Adjust the position of the lights if
desired.

4 Choose Rendering > Advanced Lighting > Radiosity and confirm any
alerts that appear. On the Select Advanced Lighting rollout, make sure
Active is on.

5 To process radiosity, on the Radiosity Processing Parameters rollout, click
Start. Once the Radiosity calculation has been completed, you should see
your results in the viewports.

6 To display the Environment panel on page 6689, where you set exposure
controls, in the Interactive Tools group of the Radiosity Processing
Parameters rollout, click Setup.

7 When working with non-physically based lights, always use the
Logarithmic Exposure Control on page 6740. On the Logarithmic Exposure
Control Parameters rollout, turn on Affect Indirect Only.

This causes the exposure control to affect only the results of the radiosity
solution. This way you maintain the way your direct lights render without
radiosity. Use the Brightness and Contrast controls of the exposure control
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to adjust the intensity of the radiosity solution to match the lighting at
an appropriate level.

TIP You can use the thumbnail preview to adjust brightness and contrast
interactively.

8  To render the scene after radiosity processing, click Render.

Summary

The following table is designed to help you obtain good results with radiosity.

Non-Physically
Based Workflow

Physically Based
Workflow

Standard Lights on
page 5049

Photometric Lights
on page 5005

Lights

Directional Light
on page 5057 and

IES Sun on page
5154 and IES Sky on
page 5157

Daylight

Skylight on page
5065

Logarithmic on
page 6740 − turn on

AnyExposure
Control

Affect Indirect
Only.

Make sure your
scene is set to the
appropriate scale.

Make sure your
scene is set to the
appropriate scale.

Units

Animation with Radiosity

By default, a radiosity solution on page 6168 is calculated at the current frame.
If you are animating objects and you want to perform a radiosity solution at
every frame, turn on Compute Advanced Lighting When Required in the
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Render Setup dialog > Common panel > Common Parameters rollout on page
6121 > Advanced Lighting group.

Once the renderer starts processing each frame of your animation, it computes
the radiosity solution for each frame as required. This occurs, for example,
when an object moves or a light intensity changes. If nothing changes in the
scene from one frame to the next, the radiosity engine does not recalculate
the solution.

NOTE Due to the random statistical sampling used by the radiosity engine, there
might be some flickering between frames. If this occurs, increase the value of Initial
Quality or the number of Refine Iterations to solve the problem.

TIP Before launching a lengthy animation with radiosity, process a radiosity solution
manually for a single frame to make sure the results are acceptable.

TIP If you animate only the camera as in an architectural walkthrough, you can
save time by calculating a radiosity solution for only the first frame of the animation.
You can then reuse it in all subsequently rendered frames by turning off Compute
Advanced Lighting When Required on the Common Parameters rollout of the
Render Setup dialog.

Avoid using the Automatic Exposure Control on page 6735 for animations. This
exposure control can change from frame to frame, creating a flickering effect.

Object Animation

The radiosity solution is calculated for each frame if any object is animated
in the scene (the default is to calculate the current frame only). You specify
the parameters (goals/quality) you want to reach on the Advanced Lighting
panel. Before rendering the entire animation, we recommend first running a
solution to verify that it’s successful. These parameters are then reprocessed
for each frame.

You go to the Render Setup dialog > Common Parameters rollout and enable
the option Compute Advanced Lighting When Required, and then render the
scene. The radiosity is processed for the first frame and then rendered. 3ds
Max then moves to the next frame, processes radiosity, renders, and so on.

Camera Animation

If objects remain static in the scene and only the camera moves, you can solve
radiosity at frame 0, and when you render the animation, turn off Compute
Advanced Lighting When Required.

Default Scanline Renderer Controls | 6187



Radiosity Controls

Render Setup dialog > Choose Default Scanline Renderer as the production
renderer. > Advanced Lighting panel > Choose Radiosity.

Rendering menu > Advanced Lighting > Radiosity > Render Setup dialog >
Advanced Lighting panel > Radiosity is chosen.

Radiosity is a technique to calculate indirect light. Specifically, radiosity
calculates the interreflections of diffuse light among all the surfaces in a scene.
To make this calculation, radiosity takes into account the lighting, materials,
and environment settings in the scene.

Radiosity processing is distinct from the rendering process. You can render
without radiosity. However, to render with radiosity, you must calculate
radiosity first.

Once a radiosity solution for a scene exists, you can use it in multiple
renderings, including multiple frames of an animation. If the scene contains
moving objects, radiosity might need to be recalculated; see Animation with
Radiosity on page 6186.

For an overview of radiosity and how radiosity works in 3ds Max, see Radiosity
Solution on page 6168.

For suggestions regarding workflow for using radiosity, see Radiosity Workflows
on page 6181.

NOTE Radiosity is a method for global illumination.

IMPORTANT If the dimensions of your scene are not realistic, then radiosity cannot
show realistic lighting.

See also:

■ Modeling Global Illumination with Radiosity on page 6168

■ How Radiosity Works in 3ds Max on page 6178

■ Radiosity Workflows on page 6181

■ Animation with Radiosity on page 6186

■ Lighting Analysis on page 6219

■ Radiosity Preferences on page 7786
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■ Advanced Lighting Override Material on page 5734

Procedures

To set units correctly:

Follow these steps if your scene does not already use real-world units.

1  Right-click 3D Snap Toggle and on the Snaps panel, turn off all the
settings. Then turn on Vertex to enable vertex snapping. Close the dialog.

2 Use Tools > Measure Distance to measure some object in the scene for
which you know the size; for example, a door or window. The distance
displays in the Coordinate Display of the status bar.

3 Choose Customize > Units Setup and adjust the Scene Unit Scale.

For example, if your object measures 35 scene units long, and your model
uses US Standard measurement, then you would enter 1 for the scale,
and choose Inches from the drop-down list. This would give you an object
35 inches long.

If your object measures 90 scene units long, and your model uses Metric
measurement, then you would enter 1 for the scale, and select Centimeters
from the drop-down list. This would give you an object 90 centimeters
long.

Example: To process radiosity with photometric lighting:

1 Use a scene that has geometry set to the correct scale. For more
information, see To set units correctly on page ?.

For example, if the ceiling is 96 scene units high in the model, make sure
the units are set to US Standard (inches) and not Metric.

2  On the Create panel, click Lights.

3 Choose Create > Photometric Lights > Target Point Light.

4 Choose Photometric from the drop-down list. (The default is Standard.)

5 In the Object Type rollout, click Target Point.
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6 Drag in a viewport. The initial point of the drag is the location of the
light, and the point where you release the mouse is the location of the
target.

The light is now part of the scene.

7 Set the creation parameters.

TIP  You can use the Move transform to adjust the location of the
light or its target.

8 On the Modify panel, adjust the light's settings.

9 To preview the lighting, click Render.

Make any changes you need to adjust the rendering.

10 Choose Rendering menu > Environment to open the Environment panel
on page 6689 of the Environment And Effects dialog.

11 On the Exposure Control rollout of the Environment panel, choose
Logarithmic Exposure Control from the drop-down list. Click Render
Preview.

The thumbnail preview shows the effect of exposure control.

12 On the Logarithmic Exposure Control rollout on page 6740, adjust the
settings until the scene lighting is acceptable. For example, a brightness
of 65 and a contrast of 50 can be good values for interior scenes.

The thumbnail preview updates as you adjust settings.

13 Choose Rendering > Advanced Lighting > Radiosity to display the
Advanced Lighting panel with Radiosity chosen as the advanced lighting
type.

The rollouts for radiosity are displayed.

14 Choose Rendering > Radiosity to display the Radiosity panel.

15 On the Radiosity Processing Parameters rollout on page 6193, click Start to
begin processing radiosity.

16 To render the scene after radiosity processing completes, click Render.
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Example: To process radiosity with standard lighting:

Photometric lights are recommended for use with radiosity. But if you are
working on a scene that already contains standard lights, you can follow these
guidelines.

1 Create or load a scene containing the appropriate geometry for lighting.
There is no need to adjust any scale factors.

2  On the Create panel, click Lights.

Standard is the default choice of light type.

3 In the Object Type rollout, click a light type such as Target Spot.

4 Drag in a viewport. The initial point of the drag is the location of the
spotlight, and the point where you release the mouse is the location of
the target.

The light is now part of the scene.

5 Set the creation parameters for the light.

6  To preview the lighting, click Render.

Make any changes you need to adjust the rendering.

7 Choose Rendering > Advanced Lighting to display the Advanced Lighting
panel. On the Select Advanced Lighting rollout, choose Radiosity as the
advanced lighting type.

The rollouts for radiosity are displayed.

8 Choose Rendering > Advanced Lighting > Radiosity to display the
Advanced Lighting panel with Radiosity chosen as the advanced lighting
type.

The rollouts for radiosity are displayed.

9 On the Radiosity Processing rollout, under Interactive Tools, click Setup
to display the Environment panel on page 6689 where you set exposure
controls.

NOTE The exposure controls allow you to control only the intensity of the
indirect lighting. 3ds Max retains the original intensity and effect for the
direct lighting.
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10 On the Exposure Control rollout of the Environment panel on page 6689,
choose Logarithmic Exposure Control from the drop-down list.

11 On the Logarithmic Exposure Control rollout on page 6740, turn on Affect
Indirect Only.

12 On the same rollout, use the Physical Scale setting to assign the standard
light a photometric value in candelas.

13 Render the scene again after radiosity processing.

Interface

Radiosity controls appear as rollouts on the Advanced Lighting panel of the
Render Setup dialog. To choose radiosity, use the Select Advanced Lighting
rollout on page 6153.
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Radiosity Processing Parameters Rollout on page 6193

Radiosity Meshing Parameters Rollout on page 6200

Light Painting Rollout (Radiosity) on page 6206

Rendering Parameters Rollout (Radiosity) on page 6208

Statistics Rollout (Radiosity) on page 6217

Radiosity Rollouts

Radiosity Processing Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose
Default Scanline Renderer as the active production renderer. > Advanced
Lighting panel > Select Advanced Lighting rollout > Choose Radiosity from
the drop-down list. > Radiosity Processing Parameters rollout

Contains the main controls for processing a radiosity solution.
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Interface

Reset All When you click Start, a copy of the 3ds Max scene is loaded into
the radiosity engine. Clicking Reset All clears all the geometry from the engine.

Reset Clears the light levels from the radiosity engine, but doesn’t clear the
geometry.

Start Starts the radiosity processing. Once the radiosity solution has reached
the percentage amount specified by Initial Quality, this button changes to
Continue.

If you click Stop before reaching the full Initial Quality percentage, then clicking
Continue causes radiosity processing to resume, until the full percentage is
reached, or you click Stop once more. You can click Stop and then Continue
more than once.
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In addition, you can calculate radiosity up to an Initial Quality less than 100
percent, then later increase the value of Initial Quality, click Continue, and
resume solving radiosity.

In either case, Continue saves time by avoiding regenerating the radiosity
solution from scratch.

Once the full Initial Quality percentage has been reached, clicking Continue
has no effect.

Stop Stops the radiosity processing. The Start menu changes to Continue. You
can later click Continue to resume radiosity processing, as described for the
Start menu.

Keyboard shortcut: Esc

Process group

The options in this group set the behavior of the first two stages of the radiosity
solution, Initial Quality and Refine.

Initial Quality Sets the quality percentage at which to stop the Initial Quality
stage, up to 100%. For example, if you specify 80%, you will get a radiosity
solution that is 80% accurate in energy distribution. A goal of 80 to 85% is
usually sufficient for good results.

During the Initial Quality stage, the radiosity engine bounces rays around the
scene and distributes energy on surfaces. Between each iteration, the engine
measures the amount of variance (noise between surfaces) that was computed.

Most of the brightness of the scene is distributed in the early iterations. The
contribution to the scene’s average brightness decreases logarithmically
between iterations. After the first few iterations, the brightness of the scene
does not increase much, but subsequent iterations reduce the variance in the
scene.
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NOTE The “quality” refers to the accuracy of energy distribution, not to the visual
quality of the solution. Even at a high Initial Quality percentage, the scene can still
show considerable variance. This variance is resolved by the subsequent stages of
the solution.

Increasing the percentage value of Initial Quality.

Increasing quality does not greatly increase the average brightness of the scene, but
it decreases the variance between different surfaces in the scene, such as the faces of
the sphere.

Refine Iterations (All Objects) Sets the number of Refine iterations to perform
for the scene as a whole. The Refine Iterations stage increases the quality of
the radiosity processing on all objects in the scene. Gathers energy from each
face in order to reduce the variance between faces using a different process
from the Initial Quality stage. This stage does not increase the brightness of
the scene, but it improves the visual quality of the solution and significantly
reduces variance between surfaces. If you don’t reach an acceptable result after
processing a certain number of Refine iterations, you can increase the number
and continue processing.
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TIP If you plan to use Regathering at render time, you generally don’t need to
perform the Refine stage to get good-quality final renderings.

NOTE After 3ds Max processes Refine Iterations, Initial Quality is disabled and you
can’t change it until you click Reset or Reset All.

Large image with no iterations has areas of uneven illumination.

Inset images: After a number of iterations, the uneven areas have been corrected.

Refine Iterations (Selected Objects) Sets the number of Refine iterations to
perform for selected objects, using the same method as Refine Iterations (All
Objects). Make an object selection and then set the number of iterations you
require. Refining selected objects rather than the entire scene can save a lot
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of processing time. Typically, this option is useful for objects that have a lot
of small surfaces and show a lot of variance, such as railings or chairs or highly
subdivided walls.

NOTE After 3ds Max processes Refine Iterations, Initial Quality is disabled and you
can’t change it until you click Reset or Reset All.

Process Refine Iterations Stored in Objects Each object has a radiosity
property called Refine Iterations. Each time you refine an object selection, the
number of steps stored with these objects is incremented.

When you reset the radiosity solution and then start it again, the steps for
each objects are refined automatically, provided this toggle is turned on. This
is useful when you are creating animations, when the radiosity needs to be
processed at every frame, and the same level of quality between frames has
to be maintained.

Update Data When Required on Start When on, the radiosity engine must
be reset and then recalculated if the solution is invalidated. In this case, the
Start menu changes to read Update & Start. When this is pressed, the radiosity
solution is reset and the calculation starts over again.

When this toggle is off, the radiosity solution does not need to be reset if it is
invalidated. You can continue processing your scene with the invalid solution.

NOTE The radiosity solution is invalidated any time an object or light is added,
removed, moved, or altered in any way.

Interactive Tools group

The options in this group help you adjust the display of the radiosity solution
in the viewport and in the rendered output. These controls take effect
immediately on an existing radiosity solution and do not require any additional
processing for you to see their effects.

Indirect Light Filtering Reduces the amount of noise between surface elements
by averaging the indirect lighting levels with the surrounding elements. A
value of 3 or 4 is usually sufficient. If you use too high a value, you risk losing
detail in the scene. Because Indirect Light Filtering is interactive, you can
readily evaluate the result and adjust it as you need.

Direct Light Filtering Reduces the amount of noise between surface elements
by averaging the direct lighting levels with the surrounding elements. A value
of 3 or 4 is usually sufficient. If you use too high a value, you risk losing detail
in the scene. Direct Light Filtering is interactive, so you can readily evaluate
the result and adjust it as you need.
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NOTE Direct Light Filtering works only when you use Shoot Direct Lights on page
6205. If you're not using Shoot Direct Lights, everything is considered indirect
lighting.

For a 65% quality solution, increasing the Indirect Light Filtering value from 0 to 3
creates a smoother diffuse light. The results are comparable to a much higher-quality
solution.

No Exposure Control Selected Displays the name of the current exposure
control.

(When you change the exposure control by choosing Rendering menu >
Environment, the name display in the Radiosity dialog updates automatically.)

■ Setup Click to display the Environment panel on page 6689, where you
access the Exposure Control rollout; there, you can choose the exposure
control and set its parameters.

Display Radiosity in Viewport Toggles the display in the viewports between
radiosity and standard 3ds Max shading. You might want to do turn off
radiosity shading to increase display performance.
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Radiosity Meshing Parameters Rollout

Render Setup dialog > Choose Default Scanline Renderer as the active
production renderer. > Advanced Lighting panel > Select Advanced Lighting
rollout > Choose Radiosity from the drop-down list. > Radiosity Meshing
Parameters rollout

Controls the creation of a radiosity mesh and its size in world units.

In order to create the lighting of a scene, the software calculates the intensity
for discrete points in the environment by subdividing the original surfaces
into elements which are part of a radiosity mesh. This rollout allows you to
determine whether you want a mesh or not, and to specify the size of the
mesh elements in world units. For quick tests, you might want to turn off the
mesh globally. The scene will look flat, but the solution will still give you a
quick impression of the overall brightness.

The finer the mesh resolution is, the more accurate the lighting detail will be.
But there is a trade-off in time and memory.

Meshing (shown in light red) subdivides flat surfaces in the scene.
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Left: No mesh. The solution looks very flat.

Middle: Coarse mesh, every 24 inches. The lighting improves.

Right: Fine mesh, every 4 inches. The lighting reveals more subtle effects.

NOTE A tight meshing is not necessary when you use the regathering feature on
the Rendering Parameters rollout on page 6208.
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Interface

NOTE You can override the subdivision settings in this group with the Advanced
Lighting panel on page 316 of the Object Properties dialog. This allows you to have
a different mesh resolution on some objects. For example, you might want to have
a finer mesh on an important wall surface that you know will have a lot of detail.
To display the Object Properties dialog, right-click a selected object and choose
Properties from the quad menu.
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Global Subdivision Settings group

Enabled Turns on the radiosity mesh for the entire scene. Turn off the mesh
when you want to perform quick tests.

■ Use Adaptive Subdivision Turns adaptive subdivision on and off.
Default=on.

NOTE The Mesh Settings group parameters Minimum Mesh Size, Contrast
Threshold, and Initial Meshing Size are available only when Use Adaptive
Subdivision is on.

Left: A simple box with no subdivision

Middle Left: The box faces are subdivided

Middle Right: The box faces are subdivided with a smaller Meshing Size

Right: The box faces are subdivided with Adaptive Subdivision
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Mesh Settings group

Adaptive Subdivision using the default mesh and light settings

Max Mesh Size The size of the largest faces after adaptive subdivision.
Default=36” for imperial units and 100cm for metric units.

When Use Adaptive Subdivision is turned off, Max Mesh Size sets the size of
the radiosity mesh in world units.

Min Mesh Size Faces are not divided smaller than the minimum mesh size.
Default=3” for imperial units and 10cm for metric units.

Contrast Threshold Faces that have vertex illuminations that differ by more
than the Contrast Threshold settings are subdivided. Default=75.0.

Radiosity solutions with different Contrast Threshold values. The best solution is at the
center, with Contrast Threshold=60.
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Initial Meshing Size When improving the face shape, faces that are smaller
than the Initial Meshing Size are not subdivided. The threshold for deciding
whether a face is poorly shaped also gets larger as the face size is closer to the
Initial Mesh Size. Default=12 inches (1 foot) for US Standard units and 30.5cm
for metric units.

Light Settings group

Shoot Direct Lights When adaptive subdivision or shoot direct lights is on,
the direct lighting on all of the objects in the scene is calculated analytically,
based on the following switches. Lighting is analytically computed without
modifying the object's mesh which produces lighting that is less noisy and
more pleasing to the eye. This switch is implicitly enabled when using adaptive
subdivision since it is a requirement. Default=on.

This switch is available when the Use Adaptive Subdivision switch is turned
off.

Adaptive Subdivision with light settings turned off

NOTE Lighting from lights that are not included while shooting direct light are
calculated using random sampling. These lights also are not able to affect the
adaptive subdivision of objects.
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Include Point Lights in Subdivision Controls whether point lights are used
when shooting direct lights. If this switch is off, then point lights are not
included in illumination calculated directly at vertices. Default=on.

Include Linear Lights in Subdivision Controls whether linear lights are used
when shooting direct lights. If this switch is off, then linear lights are not used
in calculating the illumination at vertices. Default=on.

Include Area Lights in Subdivision Controls whether area lights are used
when shooting direct lights. If this switch is off, then area lights are not used
in illumination calculated directly at vertices. Default=on.

Include Skylight When turned on, skylight is used when shooting direct
lights. If this switch is turned off, then skylight is not used in illumination
calculated at vertices directly. Default=off.

Include Self-Emitting Faces in Subdivision This switch controls how
self-emitting faces are used when shooting direct lights. If this switch is turned
off, then self-emitting faces are not used in illumination calculated at vertices
directly. Default=off.

Minimum Self-Emitting Size This is the minimum size that a self-emitting
face will be subdivided when calculating its illumination. Minimum size is
used rather than the number of samples to allow larger faces to be sampled
more than smaller ones. Default=6.0.

Light Painting Rollout (Radiosity)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose
Default Scanline Renderer as the active production renderer. > Advanced
Lighting panel > Select Advanced Lighting rollout > Choose Radiosity from
the drop-down list. > Light Painting rollout

The light painting tools in this rollout allow you to touch up shadowed and
illuminated areas manually. You can use these tools to touch up shadow and
light-leak artifacts without having to do additional remodeling or radiosity
processing. Using Pick Illumination, Add Illumination, and Remove
Illumination, you can add or remove illumination on one selection set at a
time.

To use the light painting tools, you first select objects, and then choose a light
painting tool: Pick Illumination, Add Illumination, or Remove Illumination.
The active button is highlighted in yellow, and when it is over a selected
object, the cursor changes to a crayon icon for the Add and Remove
Illumination tools, or to an eyedropper icon for Pick Illumination.
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You can pick, add, or remove illumination through objects. For example, if
you select the floor as an object, you can work under the bookshelf, by working
through it. Once in light painting mode, you can’t select another object unless
you cancel the operation.

Interface

Intensity Specifies the intensity of the illumination in lux or candelas
depending on the units you have selected in the Customize > Units Setup
dialog on page 7809.

Pressure Specifies the percentage of the sampled energy to be used when you
add or remove illumination.

 Add Illumination Adds illumination starting at the vertex of a selected
object. 3ds Max adds illumination based on the amount in the Pressure spinner.
The pressure amount corresponds to a percentage of the sampled energy. For
example, if a wall has about 2,000 lux on it, Add Illumination adds 200 lux
to the surface of the selected object.

 Remove Illumination Removes illumination starting at the vertex of a
selected object. 3ds Max removes illumination based on the amount in the
Pressure spinner. The pressure amount corresponds to a percentage of the
sampled energy. For example, if a wall has about 2,000 lux on it, Remove
Illumination removes 200 lux from the surface of the selected object.

 Pick Illumination Samples the amount of illumination from a surface
that you select. To save you from inadvertently making bright or dark spots,
Pick Illumination uses an amount of illumination relative to the surface
illumination you sample. Click the button, and move the eyedropper cursor
over the surface. When you click a surface, the amount of illumination in lux
or candelas is reflected in the Intensity spinner. For example, if you used Pick
Illumination over a wall that has 6 lux of energy, then 0.6 lux displays in the
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Intensity spinner. The amount of illumination 3ds Max adds or removes on
the surface will be this value multiplied by the Pressure value.

Clear Clears all the changes you made. Processing additional radiosity
iterations or changing the filtering amount will also discard any changes to
the solution you made with the light painting tool.

Using light painting to add or remove light in a radiosity solution.

Rendering Parameters Rollout (Radiosity)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose
Default Scanline Renderer as the active production renderer. > Advanced
Lighting panel > Select Advanced Lighting rollout > Choose Radiosity from
the drop-down list. > Rendering Parameters rollout

Provides parameters for controlling how to render the radiosity-processed
scene.

By default, when you render, 3ds Max first recalculates the shadows from light
objects, and then adds the result of the radiosity mesh as ambient light.
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The first two options on the rollout control how the renderer treats direct
illumination. Re-Use Direct Illumination From Radiosity Solution provides a
quick render that displays colors from the radiosity mesh. Render Direct
Illumination uses the scanline renderer to provide direct illumination and
shadows. This second option is usually slower but more accurate. With Render
Direct Illumination, the radiosity solution provides only the indirect lighting.

When you choose the Render Direct Illumination method, you can turn on
regathering to correct artifacts and shadow leaks. Regathering provides the
slowest but the best-quality rendering.

NOTE Regathering is extremely intensive for your CPU and uses a lot of RAM, so
it might not be practical for print-resolution images (for example, 4000 x 4000
pixels).

Interface

Re-Use Direct Illumination from Radiosity Solution 3ds Max doesn’t render
direct lights, but uses the direct lighting stored in the radiosity solution. If

Default Scanline Renderer Controls | 6209



you turn on this option, the Regather Indirect Illumination option is disabled.
The quality of shadows in the scene depends on the mesh resolution. Capturing
fine shadow details might require a fine mesh, but in some situations this
option can speed up overall rendering time, especially for animations, because
the lights don’t have to be recalculated by the scanline renderer.

If you are using the Assign Vertex Colors utility on page 6038, turn this option
on.

Left: Direct light only is stored in the radiosity mesh.

Middle: Indirect light only is stored in the radiosity mesh.

Right: Direct and indirect light both stored in the radiosity mesh (the shadows are
usually very coarse).

WARNING If you choose this option but haven't generated a radiosity solution,
rendering generates a completely black image.

Render Direct Illumination 3ds Max renders shadows from the lights at each
rendering frame, and then adds indirect light from the radiosity solution. This
is the default rendering mode.

Left: Direct light calculated only by the scanline renderer.

Middle: Indirect light calculated only by the radiosity mesh.
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Right: Direct and indirect light combined.

Regather Indirect Illumination In addition to recalculating all the direct
lighting, 3ds Max recalculates the indirect lighting at each pixel by regathering
illumination data from the existing radiosity solution. Using this option can
produce the most accurate, artifact-free images, but it can add a considerable
amount of rendering time.

NOTE If you know that you want to use the regathering option, then typically
you don’t need as dense a mesh for the radiosity solution. Even if you don’t
subdivide the surfaces at all and do an Initial Quality of 0%, the regathering will
work, and might provide an acceptable visual result (useful for quick tests as well).
However, accuracy and subtle details depend on the quality of the radiosity solution
stored in the mesh. The radiosity mesh is the foundation for the regathering
process.

In the following illustrations, solutions were processed with an Initial Quality
of 0%. There is a high variance between small surfaces when a dense mesh is
used. Regathering gives acceptable results regardless of mesh density. But more
subtle details appear with a denser mesh; for example, at the base of the
sculpture.

No mesh

Left: Model subdivision

Middle: Viewport result

Right: Result of regathering
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Coarse mesh

Left: Model subdivision

Middle: Viewport result

Right: Result of regathering

Fine mesh

Left: Model subdivision

Middle: Viewport result

Right: Result of regathering

Rays per Sample The number of rays 3ds Max casts for each sample. 3ds Max
casts these rays randomly in all directions to calculate (“regather”) the indirect
illumination from the scene. The more rays per sample, the more precise the
sample will be. Fewer rays per sample produce more variance, creating a more
grainy effect. Processing speed and precision are affected by this value.
Default=64.

Filter Radius (pixels) Averages each sample with its neighbors in order to
reduce the noisy effect. Default=2.5 pixels.
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NOTE Pixel radius varies according to the output resolution. For example, a 2.5
radius is OK for NTSC resolution, but it might be very large for smaller images, or
too precise for very large images.

Pixel radius of 2

Left: 10 rays per sample

Middle: 50 rays per sample

Right: 150 rays per sample

Pixel radius of 5

Left: 10 rays per sample

Middle: 50 rays per sample

Right: 150 rays per sample
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Pixel radius of 10

Left: 10 rays per sample

Middle: 50 rays per sample

Right: 150 rays per sample

Increasing the number of rays per sample can greatly increase rendering time.
The images on the right can take nearly six times as long to render as the
images on the left. Increasing the filter radius also increases render time, but
not as dramatically.

Clamp Values (cd/m^2) This control is expressed as a luminance value.
Luminance (candelas per meter squared) represents how brightly you perceive
a material. Clamp Value sets an upper limit on the luminance that will be
considered in the Regathering stage. Use it to avoid the appearance of bright
spots.
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Bright polygons in the scene can create a “sparkle” effect of bright spots.

These bright spots are artifacts not of the number of samples cast, but rather
of the presence of bright polygons in your scene. During the Initial Quality
stage, this bright energy gets bounced in random directions, leading to a
“sparkle” effect. Typically you can detect these polygons before regathering.

During the final Regathering stage, bright spots can be avoided by setting
Clamp Values somewhat below the luminance of these bright surfaces and
spots.
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Bright spots have been reduced by clamping.

TIP You can query the luminance of these surfaces by using the Lighting Analysis
tool on page 6219.

TIP Use Render Region on page 6095 to render just the area of the bright spots to
find rapidly the right clamp value to use.

Be careful with this control: Clamp Values let you clamp any intensity, and
the rendering might become darker than it should be because you have
clamped indirect illumination that is to be expected, thus dimming the effect
of the radiosity solution.
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Adaptive Sampling group

These controls can help you shorten rendering times. They reduce the number
of light samples taken. The ideal settings for adaptive sampling vary greatly
from scene to scene.

Adaptive sampling initially takes samples from a grid superimposed on the
pixels of the scene. Where there is enough contrast between samples, it
subdivides that region and takes further samples, down to the minimum area
specified by Subdivide Down To. Lighting for areas not directly sampled is
interpolated.

TIP If you use adaptive sampling, try adjusting the Subdivision Contrast value to
obtain the best results.

Adaptive Sampling When on, the radiosity solution uses adaptive sampling.
When off, it does not. Turning off adaptive sampling can increase the detail
of the final rendering, but at a cost of rendering time. Default=off.

Initial Sample Spacing The grid spacing for initial samples of the image. This
is measured in pixels. Default=16x16.

Subdivision Contrast The contrast threshold that determines when a region
should be further subdivided. Increasing this value causes less subdividing to
occur. Reducing this value can cause unnecessary subdivide. Default=5.0.

Subdivide Down To The minimum spacing for a subdivision. Increasing this
value can improve render time at a cost of accuracy. Default=2x2.

Depending on the scene geometry, grids larger than 1x1 might still be
subdivided below this specified threshold.

Show Samples When on, sample locations render as red dots. This shows
where the most sampling has taken place, which can help you choose the
optimal settings for adaptive sampling. Default=off.

Statistics Rollout (Radiosity)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose
Default Scanline Renderer as the active production renderer. > Advanced
Lighting panel > Select Advanced Lighting rollout > Choose Radiosity from
the drop-down list. > Statistics rollout

Lists information about the radiosity processing.
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Interface

Radiosity process group

Lists the current level of quality and number of refine iterations in the radiosity
process.

Solution Quality The current level of quality in the radiosity process.

Refine Iterations The number of refine iterations in the radiosity process.

Elapsed Time The time spent processing the solution since the last reset.

Scene Information group

Lists information on the radiosity processing of the scene.

Geometric Objects Lists the number of objects processed.

Light Object Lists the number of light objects processed.

NOTE Self-illuminated objects count as one light per face.

Meshing Size Lists the size of radiosity mesh elements in world units.

NOTE Transparent, 2–sided, and translucent objects' faces are counted twice.

Mesh Elements Lists the number of elements in the mesh processed.
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Lighting Analysis

Select an object that has radiosity solution information. > Rendering menu >
Advanced Lighting > Lighting Analysis

To query light levels, analyze the data, and produce reports, use the Lighting
Analysis dialog. This dialog provides rendering data on material reflectance,
transmittance, and luminance.

For example, a lighting engineer might need to know if light fixtures in a
scene provide an even level of illumination on the walls of a building. The
engineer uses the Lighting Analysis dialog after placing the lights in the ceiling
and processing radiosity. The engineer inspects the light levels and material
reflectance in the scene and then adjusts the brightness of lights, changes
units, or reduces material reflectance.

To use the Lighting Analysis tools, a radiosity solution must be calculated and
displayed in the scene. For better feedback, use it in conjunction with the
Pseudo Color Exposure Control on page 6753. This tool maps luminances or
illuminances to pseudo colors that show the brightness of the values 3ds Max
converts.

TIP You can also export LogLUV TIFF files on page 7372 or PIC files on page 7359 for
analysis by other software; do this by using the Lighting Data Exporter utility on
page 6759.

See also:

■ Modeling Global Illumination with Radiosity on page 6168

■ Radiosity Workflows on page 6181

■ Radiosity Controls on page 6188

■ Radiosity Preferences on page 7786

■ Lighting Data Exporter Utility on page 6759
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Interface

Statistics group

Displays the radiosity solution lighting statistics for the object you select.

Quantity Indicates the desired photometric value:

■ Luminance The amount of energy leaving a surface.

■ Illuminance The amount of energy arriving at a surface.

Point The luminance or illuminance at the point on the object where you
clicked.

Point Reflectance The reflectance of the surface material at the point on the
object where you clicked.

Point Transmittance The transmittance of the surface material at the point
on the object where you clicked.

Object Avg The amount of light intensity for the object as a whole.

Object Min The object’s minimum luminance or illuminance value.

Object Max The object’s maximum luminance or illuminance value.

Scene Max The scene’s highest luminance or illuminance value.
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Selection Information group

Object Name The name of the selected object.

Object Area The area size of the selected object.

Point Location The X,Y,Z coordinate of the point on an object you clicked.

Raytracer Panel

Raytracer Global Parameters Rollout

Rendering menu > Raytracer Settings

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Choose
Default Scanline Renderer as the active production renderer. > Raytracer panel
> Raytracer Global Parameters rollout

These parameters control the raytracer globally. That is, they affect all Raytrace
materials and Raytrace maps in your scene. They also affect the generation of
Advanced Ray-traced shadows on page 8103 and Area shadows on page 7913.

NOTE These controls adjust ray-trace settings for the scanline renderer only. The
settings of these controls have no impact on the mental ray renderer, which has
its own ray-tracing controls.
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Interface

Ray Depth Control group

Ray depth, also known as recursion depth, controls how many times the
renderer allows a ray to bounce before it is considered lost or trapped.
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Upper left: Ray depth is zero

Upper right: Ray depth of 2

Lower middle: Extremely high ray depth

Maximum Depth Sets the maximum recursion depth. Increasing this value
potentially increases the realism of your rendered scene, at a cost of rendering
time. You can reduce this value to reduce rendering time. Range=0 to 100.
Default=9.

Cutoff Threshold Sets a cutoff threshold for adaptive ray levels. If the
contribution of any ray to the final pixel color drops below the cutoff
threshold, the ray is terminated. Default: 0.05 (5% of the final pixel color).
This can speed up your rendering time considerably.

Color to use at Max Depth As a rule, when a ray reaches the maximum depth,
it is rendered the same color as the background environment. You can override
the color returned at maximum depth by either selecting a color, or setting
an alternative environment map. This can make the "lost" ray invisible in the
scene.
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TIP If you are having trouble with getting complex objects to render, especially
glass, specify the maximum recursion color to something obvious, like magenta,
and your background color to something that contrasts, like cyan. The chances
are that a lot of your rays are getting lost in either maximum recursion or just
being shot off into the world, totally missing anything you think they should strike.
Try rendering the scene again. If this is the problem, try reducing the Maximum
Depth value.

■ Specify Specifies what color the raytracer returns when the ray is
considered lost or trapped. Click the color swatch to change this color.

■ Background (The default.) Returns the background color when the ray
is considered lost or trapped. For Raytrace material, the background color
is the global environment background or the environment specified locally
for the material. For Raytrace map, the background color is either the global
environment background, or is set locally in the Raytracer Parameters
rollout on page 5954.

Global Ray Antialiaser group

Controls in this group let you set global antialiasing for raytraced maps and
materials.
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Above: No antialiasing

Below: Antialiasing of reflections

TIP Turning on Supersample for a Raytraced material (in the Raytrace Basic
Parameters rollout on page 5493) usually provides adequate antialiasing. Use one
of the raytrace antialiasers (Fast Adaptive or Multiresolution Adaptive) when you
want to blur reflections or refractions.

On When on, uses antialiasing. Default=off.

Drop-down list Chooses which antialiasing settings to use. There are two
options:

■ Fast Adaptive Antialiaser Uses the Fast Adaptive antialiaser, regardless of
the global setting.
Click ... to open the Fast Adaptive Antialiaser dialog on page 5522.

■ Multiresolution Adaptive Antialiaser Uses the Multiresolution Adaptive
antialiaser, regardless of the global setting.
Click ... to open the Multiresolution Adaptive Antialiaser dialog on page
5524.
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Global Raytrace Engine Options group

These options are comparable to the local options on Extended Parameters
rollout on page 5502 and the Raytracer Controls rollout on page 5506. Their setting
affects all Raytrace materials and Raytrace maps in the scene, unless you set
local overrides.

Enable Raytracing Turns the raytracer on or off. Default=on.

Even with raytracing off, Raytrace material and Raytrace map still reflect and
refract the environment, including both the environment map for the scene,
and the environment map assigned to the Raytrace material.

Raytrace Atmospherics Turns the raytracing of atmospheric effects on or off.
Atmospheric effects include fire, fog, volume light, and so on. Default=on.

Enable Self Reflect/Refract Turns self reflection/refraction on or off.
Default=on.

Can an object reflect itself? For example, a teapot's body reflects the teapot's
handle, but a sphere will never reflect itself. If you don't need this effect, you
can improve render time by turning off this toggle.

TIP If you have a transparent object such as glass, and Enable Self Reflect/Refract
is on, you don't have to make the object 2-sided on page 7893. The raytracer sees
back faces when exiting refractive objects.

Reflect/Refract Material IDs When on, the material reflects effects assigned
to material IDs in the renderer's G-buffer on page 7991 on or off. Default=on.

By default, Raytrace material and Raytrace map reflect effects assigned to a
material's ID, so that G-buffer effects are not lost. For example, if a raytraced
object reflects a lamp made to glow with the Video Post Glow filter (Lens
Effects Glow), the reflection glows as well.

Render objects inside raytraced objects Toggles the rendering of objects
inside raytraced objects. Default=on.

Render atmospherics inside raytraced objects Toggles the rendering of
atmospheric effects inside raytraced objects. Atmospheric effects include fire,
fog, volume light, and so on. Default=on.

Enable Color Density / Fog Effects Toggles the color density and fog features.

Acceleration Controls Opens the Raytracing Acceleration Parameters dialog
on page 5518.
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Exclude Opens the Raytrace Exclude/Include dialog on page 5519, which lets
you exclude objects from ray-tracing.

Show Progress Dialog When on, rendering displays a window with progress
bars titled Raytrace Engine Setup. Default=on.

Show Messages When on, displays a window, Raytrace Messages, that shows
status and progress messages from the raytrace engine. Default=off.

Using Multi-Pass Rendering Effects

Create panel > Cameras > Target button or Free button > Parameters rollout
> Multi-Pass Effect group

Multi-pass rendering effects use multiple renderings of the same frame, with
slight camera movement between each rendering. The multiple passes simulate
the blurring that film in a camera would register under certain conditions.
The included multi-pass effects are provided:

■ Depth of field on page 5230 (Default Scanline Renderer)
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Multi-pass depth of field

Top: Focus is in the middle distance; near and far objects are blurred.

Bottom left: Focus on near objects, far objects are blurred.

Bottom right: Focus on far objects, near objects are blurred.

■ Motion blur on page 5234 (Default Scanline Renderer)
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Above: Motion blur applied to wings of the flying dragon

Below: Multiple passes appear in successive refreshes of the Rendered Frame
Window.

■ Depth of Field (mental ray) on page 5229

See also:

■ Motion Blur with the mental ray Renderer on page 6248

■ Depth of Field with the mental ray Renderer on page 6249
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mental ray Renderer

The mental ray® renderer from mental images® is a general-purpose renderer
that can generate physically correct simulations of lighting effects, including
ray-traced reflections and refractions on page 6245, caustics on page 6255, and
global illumination on page 6261.

NOTE mental images and mental ray are registered trademarks, and photon map
is a trademark of mental images GmbH & Co. KG, Berlin, Germany.

Scene rendered with the default 3ds Max scanline renderer
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Same scene rendered with the mental ray renderer

The second rendering, done with the mental ray renderer, shows caustics cast by
refraction through the martini glass. Caustics are also visible in the reflection on the
cocktail shaker.

The mental ray renderer in 3ds Max supports the mental ray version 2 (mi2)
and version 3 (mi3) formats. It does not support the mental ray version 1
(mi1) format.

Differences Between the mental ray Renderer and the Default Scanline
Renderer

Compared to the default 3ds Max scanline renderer, the mental ray renderer
relieves you of the need to simulate complex lighting effects "by hand" or by
generating a radiosity solution. The mental ray renderer is optimized to use
multiple processors and to take advantage of incremental changes for efficient
rendering of animations.

Unlike the default 3ds Max renderer, which renders scanlines from the top of
the image downward, the mental ray renderer renders rectangular blocks called
buckets. The order in which the buckets are rendered can vary, depending on
the method you choose. By default, mental ray uses the Hilbert method, which
picks the next bucket to render based on the cost of switching to the next
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one. Because objects can be discarded from the memory to render other objects,
it’s important to avoid having to reload the same object multiple times. This
is especially important when you have enabled placeholder objects (see the
Processing panel > Translator Options rollout on page 6316).

If you use distributed rendering to render a scene, it might be hard to
understand the logic behind the rendering order. In this case, the order has
been optimized to avoid sending lots of data over the network. Each CPU is
assigned a bucket as the bucket becomes available, so different buckets can
appear in the rendered image at different times. See the Renderer panel >
Sampling Quality rollout on page 6272.

NOTE The mental ray renderer can also be run in a standalone fashion, using a
command-line interface based on the mi2 or mi3 scene description format. This
is described in the manual mental ray Programming, which is written for
programmers writing custom shaders on page 8123.

See also:

■ Getting Good Results with mental ray Rendering on page 6235

■ 3ds Max Materials in mental ray Renderings on page 6239

■ mental ray Concepts on page 6245

■ Enhancements to Standard Features on page 6241

Procedures

To use the mental ray renderer:

1 Choose Rendering menu > Render Setup. The Render Setup dialog opens.

2 On the Common panel, open the Assign Renderer rollout, and then click
the “...” button for the Production renderer.

The Choose Renderer dialog opens.

3 On the Choose Renderer dialog, highlight mental ray Renderer and then
click OK.

TIP After you make the mental ray renderer the active production renderer,
you can make the mental ray renderer the default renderer for all new scenes
by clicking Save As Defaults. This is a convenient way to avoid extra setup
time.
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Now the Render Setup dialog contains the mental ray controls. You can choose
to render the scene with the built-in mental ray renderer, or simply to translate
the scene and save it in an MI on page 8044 file that you can render later, perhaps
on a different system. Controls for choosing whether to render, save to an MI
file, or both, are on the Translator Options rollout on page 6316.

Rendering with the mental ray Renderer

Rendering menu/main toolbar > Render Setup > Render Setup dialog >
Common panel > Assign Renderer rollout > Choose mental ray Renderer as
the Production renderer.

To use the mental ray translator and renderer, you must first choose mental
ray as the production renderer, as described the "Procedures" section below.
Once you have chosen mental ray rendering, the Render Setup dialog displays
panels and rollouts that control the mental ray renderer.

Common Parameters Rollout

When you render with mental ray, controls on the Render Setup dialog >
Common panel > Common Parameters rollout remain the same, and function
just as they do with the default scanline renderer.

Limitations

The mental ray renderer does not support certain rendering features, as
described here.

■ Output dithering options aren't supported (in Main menu > Customize >
Preferences > Preference Settings dialog > Rendering panel > Output
Dithering group).

■ The mental ray renderer does not fully support G-buffer options in post
processing and image file output. The mental ray renderer generates all
required G-buffer channels, but does not include transparency information.
If two transparent objects overlap each other, the mental ray render
generates information only for the frontmost object.

■ When you use a bitmap as an environment (that is, as a background), the
mental ray renderer samples and filters it. This can result in unwanted
blurring. To prevent background blurring, render the scene against a
solid-color background, and then composite the rendered scene with the
background image.
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■ Sometimes when you render objects that have no thickness, or an Extrude
modifier with zero thickness, the mental ray renderer generates rendering
artifacts that appear as streaks. In some cases, you can fix this by turning
on Force 2-Sided on the Render Setup dialog's Common Parameters rollout.
If the streaks persist, give the object or the Extrude modifier a nonzero
thickness.

See also:

■ Sampling Quality Rollout (mental ray Renderer) on page 6272

■ Camera Effects Rollout (mental ray Renderer) on page 6283

■ Caustics and Global Illumination Rollout (mental ray Renderer) on page
6306

■ Final Gather Rollout (mental ray Renderer) on page 6295

■ Shadows & Displacement Rollout (mental ray Renderer) on page 6292

■ Rendering Algorithms Rollout (mental ray Renderer) on page 6277

■ Translator Options Rollout (mental ray Renderer) on page 6316

■ Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6326

Procedures

To use the mental ray renderer:

1 Choose Rendering menu > Render Setup. The Render Setup dialog opens.

2 On the Common panel, open the Assign Renderer rollout, then click the
“...” button for the Production renderer.

The Choose Renderer dialog is displayed.

3 On the Choose Renderer dialog, highlight mental ray Renderer and then
click OK.

Now, when you render, the Render Setup dialog appears with the mental ray
controls. You can choose to render the scene with the built-in mental ray
renderer, or simply to translate the scene and save it in an MI on page 8044 file
that you can render later, perhaps on a different system. Controls for choosing
whether to render, save to an MI file, or both, are on the Translator Options
on page 6316 rollout.
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To make the mental ray Renderer the default renderer for new scenes:

■ After you make the mental ray renderer the active production renderer,
click Save As Defaults on the Assign Renderer rollout.

Getting Good Results with mental ray Rendering

Although the mental ray renderer is relatively easy to use once you’ve set it
up correctly, there are several "gotchas" that you might encounter immediately,
especially if you’re primarily accustomed to the 3ds Max scanline renderer
and its workflow. For example, see 3ds Max Materials in mental ray Renderings
on page 6239. Following are some basic rules of thumb for using mental ray in
3ds Max:

Using Lights with the mental ray Renderer

When you set up a scene for rendering with the mental ray renderer, keep the
following tips in mind:

■ The Overshoot parameter for lights doesn't work when you use mental ray
to render shadow-mapped shadows. To use Overshoot, use ray-traced
shadows.

■ Excluding an object from shadow casting doesn't work when you use
mental ray to render shadow-mapped shadows. To exclude objects from
shadow casting, use ray-traced shadows. (The Exclude button is on a light's
General Parameters rollout.)

■ When you assign a map to object shadows in the light's Shadow Parameters
rollout, the mental ray renderer does not recognize the toggle for the map
(to the left of the Map button), and renders the map whether the toggle
is on or off. To stop using the map, you must click the Map button and in
the Material/Map Browser, assign NONE as the map type.

■ Using the default scanline renderer, you can set a light to have a value of
zero, with a shadow color of white, and a shadow density of −1. With these
settings, the light casts shadows but does not illuminate the scene. To get
the same effect using the mental ray renderer, the light value must not be
zero. Instead, set it to a value close to zero (for example, 0.001 or –0.001).

■ The mental ray renderer disregards the bias parameters in the Shadow Map
Params rollout and the Ray Traced Shadow Params rollout.
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■ The mental ray renderer assumes that all directional lights come from
infinity, so objects that are behind the direct light object in the 3ds Max
scene will also be illuminated.

Ray Tracing

The mental ray ray tracer is fast and provides excellent quality images, but it’s
important to use it correctly.

The mental ray renderer does not fully support cubic maps for Reflect/Refract
maps on page 5964. It uses them if they have already been generated by the
default scanline renderer, but it does not generate them. If Source > From File
is active and the mental ray renderer can find the six cubic maps, it uses them.
If Source > Automatic is active, or if the cubic maps cannot be found, the
mental ray renderer generates ray-traced reflections or refractions instead.

Ray Tracing Setup

On the rendering menu, Ray Tracer Settings and Raytrace Global
Include/Exclude are disabled while the mental ray renderer is active. These
controls adjust ray-trace settings for the scanline renderer only. The settings
of these controls have no impact on the mental ray renderer. The ray-tracing
controls for mental ray appear on the Renderer panel > Rendering Algorithms
rollout on page 6277.

TIP While the mental ray renderer ignores the global inclusion or exclusion settings
for the ray tracer, you can enable or disable ray-tracing at the local level of a
Raytrace material or map.

Ray Tracing Rules of Thumb

Say you’re rendering a (lathed) wineglass, with an inner and outer surface and
a piece of geometry representing the wine. The wine geometry is just slightly
smaller than the inner surfaces of the wineglass, and capped with a flat top.
Now, you go to render the glass. After rendering the scene, however, there’s
something wrong: the inner surfaces of the glass don’t seem reflective enough,
and the wine isn’t refracting properly. What’s wrong?

It’s possible that you have the number of reflections and refractions set too
low for the number of surfaces you have. To check this, go to the Renderer
panel > Rendering Algorithms rollout on page 6277 and look at the Maximum
Trace Depth settings. If you haven’t changed the parameters, then you should
see Max. Reflections and Max. Refractions set to the default of 6, and Max.
Depth set to 6.
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There’s the problem: you actually have six surfaces that need to be traced by
the light rays for both reflections and refractions. The way to always calculate
the number of rays needed for a scene is to take the ray-traced objects in your
scene and draw an imaginary line through them, originating at the point of
view. Then, count the number of surfaces the line intersects.

For the wineglass and wine, you need at least six reflections and refractions
that correspond to the following surfaces:

■ Near outer glass surface (“near” relative to your Camera viewpoint)

■ Near inner glass surface

■ Near wine surface

■ Far wine surface

■ Far inner glass surface

■ Far outer glass surface

Therefore, increase the value of Max. Depth to 12.

Caustics and Global Illumination

Before rendering with caustics, there are several things you need to set up in
your scene:

■ For caustics to work properly, the generating object must use a material
that contains some degree of shininess, reflectivity, or refraction. Assign
a Raytrace or other map as either a Reflection map or Refraction map before
you render caustics.

■ Most often, you’ll be using very shiny, highly reflective materials (such as
chrome and other metals), or transparent or translucent materials (such
as glass goblets or water), to generate caustics in your scene. If you’re using
a glassy material, make sure it’s double-sided to create the proper results.

■ Make sure you have object properties on page 322 set to Receive Caustics
or Generate Caustics (or both). To set up these properties, right-click an
object and choose Properties. For example, if you’re rendering a wineglass
on a tabletop, you probably want the wineglass both to generate and receive
caustics (so that caustics are scattered within the glass itself), and the
tabletop only to receive caustics (unless it’s chrome, say, instead of wood).

■ If the rendering of your scene is washed out by light, double-check the
Multiplier settings: one in the Basic group of the Final Gather rollout on
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page 6295, and one each in the Caustics and Global Illumination (GI) groups
of the Indirect Illumination panel > Caustics And Global Illumination
rollout on page 6306. These apply to all lights in the scene. Reducing the
Multiplier values can eliminate washout.
If a single light object is causing the problem, you can reduce the Energy
multiplier's value in that light object's mental ray Indirect Illumination
rollout on page 5112, available on the Modifier panel.

■ To improve the quality of caustics, go to the Caustics group on page 6309 of
the Caustics And Global Illumination rollout on page 6306 and increase the
Max Num. Photons Per Sample setting.

■ Be careful of the total number of photons you’re emitting: A very high
number (100,000 and above) can dramatically increase your rendering
time. Then again, for some simple scenes, you might actually be able to
set these to 1,000,000 and still render in an acceptable amount of time.

WARNING The number of photons specified for each light indicates the
number of photons that need to be stored for each light, not the number of
photons to be shot. This is an important distinction: If a light points in a
direction where there is no surface, the mental ray renderer might shoot
photons forever. In the Messages Window on page 6244, the mental ray renderer
displays warnings that no photons are being stored. To avoid the slowdowns
related to this issue, make sure that every light points in the direction of a
surface (this is sometimes impossible to do with omni lights). Another way to
avoid this problem is to add a big sphere around your entire model.

■ In general, use an exposure control. The mr Photographic Exposure Control
on page 6744 works particularly well for adjusting overall exposure.

Coincident Faces

When it encounters coincident faces, the mental ray renderer can produce
artifacts, because it can't decide which face is nearer the camera (neither is).
To fix this, move or scale one of the objects so faces are no longer coincident.

Backface Culling

mental ray rendering correctly performs backface culling, and renders one-sided
faces much as the scanline renderer does.
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3ds Max Materials in mental ray Renderings

For the most part, the mental ray renderer treats 3ds Max maps and materials
the same way the default scanline renderer does. The exceptions are listed
below. In general, if the mental ray renderer does not recognize a map or
material, it renders it as opaque black.

WARNING The mental ray renderer does not necessarily support maps or materials
provided as plug-ins from third-party vendors. It supports third-party maps and
materials only if the vendor has explicitly used the mental ray SDK to add support
for the mental ray format. Unless the third-party vendor clearly specifies mental
ray support, you should assume the map or material is unsupported, and will
render as black.

See also:

■ mental ray Renderer on page 6230

■ Getting Good Results with mental ray Rendering on page 6235

Issues for Reflections and Refractions

The maps used to create reflections or refractions, Flat Mirror, Raytrace,
Reflect/Refract, and Thin Wall Refraction, are supported by the mental ray
renderer. However, the mental ray renderer simply uses these maps as
indications to use its own ray-tracing method, leading to some restrictions on
which parameters are supported, as described in the sections “Materials” and
“Maps,” below.

Map Blurring

When reflections and refractions are ray traced, applying Blur (or Distortion,
in Flat Mirror) does not apply to reflections or refractions of environment
maps. In general, Blur and Distortion render differently than they do with
the default scanline renderer, and you might have to experiment with
parameter values to get a comparable rendering result.

TIP If Blur effects are not rendering well with the mental ray renderer, try increasing
the Maximum number of samples in the Renderer panel > Sampling Quality Rollout
on page 6272.
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Materials

The mental ray renderer does not support these materials:

■ Advanced Lighting Override material

■ Lightscape material

■ Morpher material

Raytrace Material

The mental ray renderer supports all Raytrace material settings except for the
antialiasing parameters and the settings found under Rendering > Raytracer
Settings and Rendering > Raytrace Global Include/Exclude. All these options
are specific to the default scanline renderer.

TIP While the mental ray renderer ignores the global inclusion or exclusion settings
for the ray tracer, you can enable or disable ray-tracing at the local level of a
Raytrace material or map.

Maps

■ Bitmap
The mental ray renderer can't use the Progressive JPEG (.jpg) format as a
bitmap. Also, Summed Area filtering is not supported (in the Filtering
group of the Bitmap Parameters rollout).

PSD files are supported, but are translated into binary data, and because
of this, consume a lot of memory and increase render time. To reduce the
time involved, convert the PSD file to a format such as BMP.

The same is true of TIFF files. In addition, there are certain TIFF subformats
that the mental ray renderer does not support; specifically, LZW, CCIT
(fax), or JPEG compression; non-RGB color models such as CMYK, CIE, or
YCbCr; or multiple images in the same file (in this case, only the first image
is used). The mental ray renderer does support bilevel (1-bit), grayscale (4-
or 8-bit), color map (4- or 8-bits), RGB(A) (8-, 16-, or 32-bit) TIF images,
and TIF files with image strips.

■ Combustion map
The mental ray renderer doesn't support this map.

■ Flat Mirror map
Flat Mirror is supported by the mental ray renderer, except for the First
Frame Only and Every Nth Frame parameters.
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■ Raytrace map
The mental ray renderer supports all Raytrace map settings except for the
antialiasing parameters.

■ Reflect/Refract map
This map tells the mental ray renderer to use ray-traced reflections and
refractions. Most parameters are supported, but the parameters Blur Offset,
First Frame Only, Every Nth Frame, and Atmosphere Ranges are not
supported.

NOTE The mental ray renderer does not fully support cubic maps for
Reflect/Refract maps. It uses cubic maps if they have already been generated
by the default scanline renderer, but it does not generate them. If Source >
From File is active and the mental ray renderer can find the six cubic maps, it
uses them. If Source > Automatic is active, or if the cubic maps cannot be
found, the mental ray renderer generates ray-traced reflections or refractions
instead.

Enhancements to Standard Features

The primary interface to the mental ray renderer consists of rollouts on the
Render Setup dialog. To choose the mental ray renderer, use the Assign
Renderer rollout on page 6135, as described in this procedure on page ?.

In addition, object properties, lights, and the Material Editor have additional
controls to support mental ray rendering. Last but not least, 3ds Max offers a
special mr Proxy object for speeding up rendering of large, complex scenes.

Object Properties Enhancements

Parameters on the mental ray panel on page 322 of the Object Properties dialog
support displacement as well as the mental ray indirect illumination features:
final gather on page 6295, caustics on page 6255, and global illumination on page
6261.

mental ray Proxy Object

When working with high-resolution geometry, you can save memory and
translation time by using the special mr Proxy object on page 597 as a stand-in
for your models.

mental ray Renderer | 6241



Light Object Enhancements

Along with the mental ray renderer, mental ray-specific area light objects and
light settings are provided.

Light Objects

The area light on page 7909 is a feature of the mental ray renderer. Instead of a
point source, it emits light from a broader area around the source. There are
two basic types of mental ray area light: mr Area Omni Light on page 5070 and
mr Area Spotlight on page 5073. An additional, special-purpose mental area light
is the mr Sky Portal on page 5186. Area lights create soft-edged shadows. This
can help improve the realism of your rendering.

NOTE To render soft-edged shadows, shadows must be ray-traced, not
shadow-mapped: see the Renderer panel > Shadows & Displacement Rollout on
page 6292.

In 3ds Max, area lights are created and supported by the MAXScript scripts,
light-mentalray_areaomni.ms and light-mentalray_areaspot.ms. Both scripts are
found in the \stdplugs\stdscripts\ folder within the program install directory.
Because of this, when you create an area light, you actually create a target spot
or omni light for which the mental ray renderer uses the parameters on the
Area Light Parameters rollout. If you render with the default scanline renderer,
the light behaves like any other target spot or omni light. (You can change a
light from one type to another using the Type drop-down list on the light’s
General Parameters rollout.)

For area lights rendered with the mental ray renderer, you can still set and
use other lighting parameters, such as color, the Multiplier value, the spotlight
cone, and so on. Shadow maps are an exception. The mental ray renderer
ignores the light's local shadow map settings. Area lights always use ray-traced
shadows.

TIP You can use a MAXScript utility to convert standard 3ds Max light objects to
area lights, as described in this procedure on page ?.

Light Settings

The mental ray Indirect Illumination rollout on page 5112 has been added to
light objects to support the mental ray renderer’s indirect illumination effects
of caustics on page 6255 and global illumination on page 6261.

The mental ray Light Shader rollout on page 5115 has been added so you can
add mental ray light shaders to light objects.
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IMPORTANT To see the mental ray rollouts for lights, you must use mental ray
Preferences on page 7787 to enable mental ray extensions. These rollouts appear
only on the Modify panel, not on the Create panel.

Camera Enhancements

On the Parameters rollout on page 5210, a “Depth Of Field (mental ray)” choice
appears on the Multi-Pass Effect drop-down list to support the mental ray
renderer's depth-of-field effects. To use this, turn on both Enable in the
camera's Multi-Pass Effect group (default=off), and Depth Of Field on the
Render Setup dialog > Renderer panel > Camera Effects rollout on page 6283.

You can also assign mental ray lens, output, and volume shaders to cameras.
These controls are also on the Render Setup dialog > Camera Effects rollout.
(This rollout also contains some contour-shading controls.)

NOTE When you use the mental ray renderer, reflected or refracted light rays do
not always respect a camera's clipping planes (set in the Clipping Planes group of
the Parameters rollout). Also, large clipping-plane values can cause poor quality
in the rendering of shadow maps. To fix this, narrow the clipping range or switch
to ray-traced shadows.

Material Editor Enhancements

The Material Editor works as it does with the default scanline renderer. Certain
materials and maps, or some of their controls, aren't supported by the mental
ray renderer; see 3ds Max Materials in mental ray Renderings on page 6239.

By default, the Material Editor sample slots use the currently active renderer:
typically this is either the default scanline renderer or the mental ray renderer.
You assign the renderer for sample slots with the Render Setup dialog >
Common panel > Assign Renderer rollout on page 6135.

When mental ray extensions are enabled (using mental ray Preferences on
page 7787) and the mental ray renderer is active, the Material Editor displays
these additional mental ray features:

■ A mental ray Connection rollout on page 5385 lets you add mental ray
shaders to 3ds Max materials.

■ When you click a material's Type button, the Material/Map Browser displays
additional mental ray materials on page 5543.

■ When you click a map or shader button, the Material/Map Browser displays
additional mental ray shaders on page 5974.
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Shaders are provided in shader library (MI) files on page 8044. Some shaders
are customized for 3ds Max, some are provided by the lume library, and
most are provided by mental images libraries. Settings for the custom 3ds
Max shaders are provided in this reference. Settings for the third-party
lume and mental images shaders are provided in their own help files. This
reference links to those descriptions; see Shaders in the LumeTools
Collection on page 5980 and mental images Shader Libraries on page 5977.

mental ray Messages Window

Rendering menu > mental ray Message Window

The mental ray Messages window displays log messages (other than debug
messages) generated by the mental ray renderer.

Interface

Example of mental ray Messages window

Three status fields appear above the messages area:

■ Num. CPUs Shows the number of CPUs in use.

■ Num. threads Shows the number of threads being rendered.

■ mental ray version Shows the current mental ray renderer version, in
detail.
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The options beneath the messages area are equivalent to options on the mental
ray Preferences dialog on page 7787.

Information When on, the mental ray renderer generates information
messages. Default=off.

This is equivalent to the preference, Show/Log Information Messages.

Progress When on, the mental ray renderer generates progress messages.
Default=off.

This is equivalent to the preference, Show/Log Progress Messages.

Debug (Output to File) When on, the mental ray renderer generates debug
messages. Default=off.

This is equivalent to the preference, Log Debug Messages (To File).

NOTE Debug messages are never displayed by the Messages Window. They are
numerous, and would make it difficult to find or read other messages.

Open on Error When on, the Messages Window is displayed if the mental
ray renderer logs an error message. Default=off.

This is equivalent to the preference, Open Message Window On Error.

Clear Click to clear all messages from the messages area.

mental ray Concepts

These topics describe what the mental ray renderer can do, and explain how
it accomplishes these effects. For more technical detail about mental ray
capabilities, see the mental ray Reference, available from Help menu >
Additional Help, and the books Programming mental ray and Rendering with
mental ray, both by Thomas Driemeyer.

Ray-Traced Reflections and Refractions with the
mental ray Renderer

The mental ray renderer can generate reflections and refractions by ray tracing.
Ray tracing traces the path of rays sampled from the light source. Reflections
and refractions generated this way are physically accurate.
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Ray-traced reflections and Refractions

To reduce the time required to generate reflections and shadows, rays are
limited by trace depth. Trace depth limits the number of times a ray can be
reflected, refracted, or both.

You can turn off ray tracing. In this case, the mental ray renderer uses scanline
rendering only. Turning off ray tracing makes the controls for all the effects
that are specific to mental ray unavailable in the Renderer's rollouts.

Ray tracing uses one of two ray-trace acceleration methods on page 8102.

You enable ray tracing and set trace depth with the Render Setup dialog >
Renderer panel > Rendering Algorithms rollout on page 6277 controls.

Shadows with the mental ray Renderer

The mental ray renderer can generate shadows by ray tracing. Ray tracing
traces the path of rays sampled from the light source. Shadows appear where
rays have been blocked by objects. Ray-traced shadows have sharp edges.
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Ray-traced shadows

Turning off caustics makes the outlines of shadows in this scene easier to see.

You can tell the mental ray renderer to use shadow maps on page 8126 instead
of ray-traced shadows. This can improve performance at a cost of accuracy.

Shadow controls are on the Render Setup Dialog > Renderer panel > Shadows
& Displacement rollout on page 6292.

Shadow Generators and the mental ray Renderer

Light objects in 3ds Max let you choose a shadow generator: Ray Traced,
Advanced Ray Traced, Shadow Map, and so on. Because the mental ray renderer
supports only two kinds of shadow generation, ray tracing and shadow maps,
some of the 3ds Max shadow generators aren't fully supported.

In 3ds Max, a special shadow generator type, mental ray Shadow Map, is provided
to support the mental ray renderer. If shadows are enabled (on the Shadows
& Displacement rollout on page 6292 of the Render Setup dialog) but shadow
maps are not enabled, then shadows for all lights are generated using the
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mental ray ray-tracing algorithm. If shadow maps are enabled, then shadow
generation is based on each light’s choice of shadow generator:

■ mental ray Shadow Map Shadows are generated using the mental ray
shadow-map algorithm.

■ Shadow Map Settings on the Shadow Parameters rollout are translated
into a mental ray equivalent before shadows are generated. The quality of
shadows generated this way might not always meet expectations.

■ Area Shadows, Advanced Ray Traced Shadows, or Ray Traced
Shadows Shadows are generated using the mental ray ray-tracing
algorithm.

Motion Blur with the mental ray Renderer

Motion blur is a way to enhance the realism of a rendered animation by
simulating the way a real-world camera works. A camera has a shutter speed,
and if significant movement occurs during the time the shutter is open, the
image on film is blurred.

Motion blur added to rendering of an animated wheel as it speeds up and rolls forward
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To render motion blur with the mental ray renderer, you must turn on ray
tracing (the Ray Trace parameter) on the Render Setup dialog > Renderer panel
> Rendering Algorithms rollout on page 6277.

The mental ray renderer uses a Shutter parameter to control motion blur. This
simulates the shutter speed of a camera. At 0.0, there is no motion blurring.
At 1.0, the maximum amount of motion blurring occurs. Values between zero
and one adjust the amount of motion blur. The closer to 1.0, the greater the
blurring.

You turn on motion blur and adjust shutter speed on the Render Setup Dialog
> Renderer panel > Camera Effects rollout on page 6283.

If you render using shadow maps on page 8126, then by default mental ray
applies motion blur to these as well. See the Render Setup dialog > Renderer
panel > Shadows & Displacement rollout on page 6292.

TIP mental ray motion blur is not recommended for use with particle systems, as
this can increase rendering time considerably. Use a Particle MBlur map on page
5891 instead.

NOTE Motion blur with the mental ray renderer does not always follow curving
trajectories. Increasing the value of Motion Segments can help, but this works
better for rotary motion than for traveling motion.

Depth of Field with the mental ray Renderer

Depth of field is a way to enhance the realism of a rendering by simulating
the way a real-world camera works. With a broad depth of field, all or nearly
all of a scene is in focus. With a narrow depth of field, only objects within a
certain distance from the camera are in focus.
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Scene rendered using no depth of field

All apples are equally in focus.
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Same scene using depth of field to control focus

The middle apple is clearer than the other two.

To render depth-of-field effects with mental ray, ray tracing (the Ray Trace
toggle) must be enabled on the Render Setup dialog > Renderer panel >
Rendering Algorithms rollout on page 6277. You must also enable depth of field
for the camera: in the camera's Multi-Pass Effect group, choose “Depth Of
Field (mental ray)” as the depth-of-field type. (If you choose the scanline
renderer's Depth Of Field option, the rendering that results can be out of
focus.)

The mental ray renderer uses the camera’s target distance and f-Stop parameters
to control the depth-of-field effect.

The camera's target distance determines the focus plane. The focus plane is
the distance from the camera at which the scene is completely in focus.
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Focus plane in relation to a camera

Here it is set to the middle apple, as in the previous renderings.
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Focus plane in relation to a camera
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Here it is set to the nearest apple, as in the renderings that follow.

The f-stop controls the amount of blurring at distances other than the focus
plane distance. In a real-world camera, the f-stop measures the size of the
lens’s aperture. The lower the f-stop value, the larger the aperture and the
narrower the depth of field. So increasing the f-stop value broadens the depth
of field, and decreasing the f-stop value narrows the depth of field.

Decreasing the f-stop to narrow depth of field

Focal plane set at the nearest apple, and f-stop set to 0.1.
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Increasing the f-stop to broaden depth of field

Focal plane in same location, f-stop increased to 1.0.

You set the f-Stop in the camera's Depth Of Field rollout. See Depth of Field
Parameter (mental ray Renderer) on page 5229.

NOTE For Perspective viewports, which have no camera, the Render Setup dialog
> Renderer panel > Camera Effects rollout on page 6283 has explicit Focus Plane and
f-Stop settings.

Caustic Lighting Effects

Caustics are the effects of light cast onto an object via reflection off or
refraction through another object.
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Swimming pool rendered without caustics
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Reflective caustics added to swimming pool

To calculate caustics, the mental ray renderer uses the photon map technique
on page 8090. (Ray tracing can’t generate accurate caustics, and they aren’t
provided by the default scanline renderer.)

You enable caustics on the Render Setup dialog > Indirect Illumination panel
> Caustics And Global Illumination rollout on page 6309. In addition, you must
designate:

■ Which light objects can create caustics.

■ Which renderable objects can generate caustics.

■ Which renderable objects can receive caustics.

The settings for generating and receiving caustics are on the Object Properties
dialog > mental ray Panel on page 322.

mental ray Renderer | 6257



Refractive caustics rendered with the default of Radius turned off.

Radius size is based on scene extents; specifically, 1/100 the radius of the full scene.
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Radius value explicitly set to 1.0
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Radius value increased to 2.5.

Filter type changed to Cone.

6260 | Chapter 20   Rendering



Photon count increased to 50,000 (in Global Light Properties group) for greater detail
in the caustics.

Global Illumination with the mental ray Renderer

Global illumination enhances the realism in rendered images by simulating
all light interreflection effects in a scene (except caustics on page 6255). It
generates such effects as "color bleeding," where for example, a white shirt
next to a red wall appears to have a slight red tint.

The mental ray renderer offers two distinct toolsets for achieving global
illumination: photon tracing on page 6310 and final gathering on page 6295. The
primary difference between the two is that photon tracing goes from the light
source toward the ultimate illuminated target (taking bounces into account),
and final gathering goes the opposite way: from the illuminated surface toward
the light source. You can use either of these toolsets separately, or combine
them for optimal rendered results.
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Scene rendered without global illumination

6262 | Chapter 20   Rendering



Same scene with global illumination
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Global illumination made smoother by final gather

To calculate global illumination, the mental ray renderer uses the photon map
technique on page 8090.

NOTE The mental ray renderer generates global illumination without requiring
you to generate a radiosity solution. A photon map is a model of global illumination
in its own right.

NOTE In order to use global illumination in mental ray, the photons must be able
to bounce among two or more surfaces. This can be accomplished by having a
single object with some concavity in its surface that’s exposed to the light source,
or at least two objects, and at least one object must be set to receive global
illumination (see mental ray Panel (Object Properties Dialog) on page 322).
Otherwise you’ll receive error messages and no photons will be stored.

Using a photon map can cause rendering artifacts such as dark corners and
low-frequency variations in the lighting. You can reduce or eliminate these
artifacts by turning on final gathering on page 6295, which increases the number
of rays used to calculate global illumination.

You enable global illumination on the Render Setup dialog > Indirect
Illumination panel > Caustics And Global Illumination rollout on page 6306,
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and final gathering on the Final Gather rollout on page 6295. In addition, you
must designate:

■ Which light objects can generate global illumination.

■ Which renderable objects can generate global illumination.

■ Which renderable objects can receive global illumination.

The settings for generating and receiving global illumination are on the Object
Properties dialog > mental ray Panel on page 322. By default, all objects in 3ds
Max are set to generate and receive global illumination.

mental ray Volume Shading

Volume shading shades a three-dimensional volume, rather than a surface.
Typically, volume shaders provide atmospheric effects such as mist and fog.

Model rendered with no volume effect
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Same model rendered in mist

Mist applied as a camera volume shader; realistic falloff on

There are two ways to assign a volume shader:

■ To a camera
This effectively makes the entire scene a single volume.

■ To a material
This makes a volume out of objects to which the material is applied.

Usually when you assign a volume shader to a material, you want to make
its surface transparent so the shading within the volume is visible. You
can do this with the mental images Transmat shader.

To assign a volume shader to a camera, use the Render Setup dialog. To assign
a volume shader to a material, use the material's Volume shader component.
This component is found on the mental ray Connection rollout on page 5385,
and in the mental ray material on page 5638 itself. See the “Procedures” that
follow.
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Procedures

To apply volume shading to a camera:

1  On the main toolbar, click Render Setup.

If the active renderer is not already the mental ray renderer, go to the
Common panel, and on the Assign Renderer rollout, click the “...” button
for the Production renderer. A Choose Renderer dialog is displayed.
Highlight “mental ray Renderer” in the list, and then click OK.

2 Click the Renderer tab to go to the Renderer panel. On the Camera Effects
rollout, find the Camera Shaders group, and click Volume.

The Material/Map Browser on page 5290 is displayed.

3 Choose a volume shader from the list in the Browser, and then click OK.

To apply volume shading to an object:

1 Choose Customize > Preferences. Go to the mental ray panel, and turn
on Enable Mental Ray Extensions.

2  On the main toolbar, click Render Setup.

If mental ray is not already the active renderer, go to the Common panel,
and on the Assign Renderer rollout, click the “...” button for the
Production renderer. The Choose Renderer dialog opens. Highlight
“mental ray Renderer” in the list and then click OK.

Leave the Render Setup dialog open, or minimize it.

3  Open the Material Editor. Use the mental ray Connection rollout
on page 5385 to assign a volume shader to the Volume component.

Another technique would be to use the mental ray material on page 5638,
and assign a shader to the Volume component.

4  Also on the mental ray Connection rollout, click the lock button
to unlock the Surface component. Click the shader button (“None”) and
use the Browser to assign the Transmat (physics) shader to the surface.

(If you are using the mental ray material, you don't need to first unlock
the Surface component.)
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5 Apply the material to objects you wish to use as shaded volumes.

mental ray Displacement

Displacement shading with the mental ray renderer is similar to displacement
mapping on page 5487 of standard materials. One advantage of using mental
ray displacement is that the additional polygons of displaced surfaces are
stored only in the mental ray scene database, not in your 3ds Max scene, so
they do not increase the memory requirements of your scene, except at render
time. This can be a big improvement in performance over displacement
mapping with standard materials and the scanline renderer.

Procedures

To add displacement to a mental ray rendering:

1 Choose Customize > Preferences. Go to the mental ray panel, and turn
on Enable Mental Ray Extensions.

2  On the main toolbar, click Render Setup.

If the active renderer is not already the mental ray renderer, go to the
Common panel, and on the Assign Renderer rollout, click the “...” button
for the Production renderer. A Choose Renderer dialog is displayed.
Highlight “mental ray Renderer” in the list, and then click OK.

Leave the Render Setup dialog open, or minimize it.

3  Open the Material Editor.

4  On the mental ray Connection rollout, click the lock button to
unlock the Displacement component. Click the shader button (“None”)
and use the Browser to assign a displacement shader to the surface.

WARNING This overrides any displacement assigned to the base material as
a standard map.

Another technique would be to use the mental ray material on page 5638,
and assign a shader to the Displacement component. (If you are using
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the mental ray material, you don't need to first unlock the Displacement
component.)

5 Apply the material to objects you wish to show the displacement.

mental ray Contour Shading

Contour shading lets you render vector-based contour lines. Contours are
similar to the ink component of the Ink 'n Paint material.

Model rendered without contours
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Model with contours added to the rendering

Simple contour shader

You add contour rendering by assigning one of the contour shaders to the
Contour component of a material. (This component is found on the mental
ray Connection rollout on page 5385 and on the mental ray material's Advanced
Shaders rollout on page 5646). Then when you render, use the Camera Effects
rollout on page 6283 to enable contours.

On the Camera Effects rollout, additional shaders can modify the contours,
or control how they are rendered. For example, if you assign a Contour Only
shader to the Contour Output component, the rendering consists of just the
contours, and not the shaded model.

Rendering of the model's contours only

Contours Only output shader, background set to white
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NOTE Contour shading does not work with distributed bucket rendering.

Procedures

To add contours to a mental ray rendering:

1 Choose Customize > Preferences. Go to the mental ray panel, and turn
on Enable Mental Ray Extensions.

2  On the main toolbar, click Render Setup.

If the active renderer is not already the mental ray renderer, go to the
Common panel, and on the Assign Renderer rollout, click the “...” button
for the Production renderer. A Choose Renderer dialog is displayed.
Highlight “mental ray Renderer” in the list, and then click OK.

Leave the Render Setup dialog open, or minimize it.

3  Open the Material Editor. For the materials of objects you want to
render with contours, use the mental ray Connection rollout on page 5385
to assign a shader to the Contour component.

Another technique would be to use the mental ray material on page 5638,
and assign shaders to both the Surface and Contour components.

TIP The Simple contour shader renders uniform lines whose color and width
you can control. The other contour shaders provide variant contour styles
with more direct user controls.

4 On the Render Setup dialog, go to the Renderer panel. On the Camera
Effects rollout, turn on Enable in the Contours group.

To simply add contour lines to a rendering, leave the shaders in the
Camera Effects rollout set to their defaults. For other options, see Camera
Effects Rollout (mental ray Renderer) on page 6283.

mental ray Renderer Interface

Render Setup dialog > Renderer panel/Indirect Illumination panel/Processing
panel
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This section covers the Render Setup dialog panels specific to mental ray
rendering:

■ Renderer panel

■ Indirect Illumination panel

■ Processing panel

For information on the common rendering panels, see:

■ Common Panel (Render Setup Dialog) on page 6121

■ Render Elements Panel and Rollout on page 6336

NOTE  In Autodesk 3ds Max 2009, a number of default settings have been
changed to improve quality, convenience, or rendering time when you use the
mental ray renderer.

Renderer Panel (mental ray)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Indirect
Illumination panel

Note: The Processing panel appears only when mental ray is the active renderer.

The Indirect Illumination panel controls concern themselves with methods
for rendering bounced light within an environment, including final gathering,
caustics, and photons.

Sampling Quality Rollout (mental ray Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Renderer
panel > Sampling Quality rollout

Note: The Sampling Quality rollout appears only when the mental ray renderer
is the currently active renderer.

The controls on this rollout affect how the mental ray renderer performs
sampling on page 8112 for antialiasing rendered images.
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Procedures

To use low sampling for previews:

■ Leave the Minimum and Maximum values at their default settings of 1/4
and 4, or reduce them to 1/16 and 1/4.

TIP Do not assign Minimum and Maximum the same value.

To use high sampling for final renderings:

■ Increase the Minimum and Maximum values to 4 and 16, respectively, or
to higher values.

TIP Do not assign the same value to both Minimum and Maximum.

To view the sampling pattern:

■ On the Diagnostics rollout on page 6324, choose Sampling Rate, then render
the scene.
Instead of rendering the image, mental ray draws a diagram that shows
the range of applied sampling values. White lines indicate edges in the
scene, where the mental ray renderer took the maximum number of
samples. If fractional sample limits are used (sampling down), lighter dots
indicate the higher value while darker dots indicate the lower value.

To assist with analysis, View Samples also draws red lines around each
bucket, or separately rendered block.

When the Minimum and Maximum number of samples are equal, the
diagram shows all buckets as white.
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Interface

Samples per Pixel group

Set the minimum and maximum sample rates for antialiasing the rendered
output.

NOTE Presets for several sample rate combinations are available on the Rendered
Frame Window as the Image Precision (Antialiasing) slider on page 6083.

Minimum Sets the minimum sample rate. The value represents the number
of samples per pixel. A value greater than or equal to 1 indicates that one or
more samples are computed per pixel. A fractional value indicates that one
sample is computed for every N pixels (for example, 1/4 computes a minimum
of one sample for every four pixels). Default=1/4.

Maximum Sets the maximum sample rate. If neighboring samples find a
difference in contrast that exceeds the contrast limit, the area containing the
contrast is subdivided to the depth specified by Maximum. Default=4.

The values of the Minimum and Maximum lists are "locked" together so that
the value of Minimum can't exceed the value of Maximum.

Filter group

Filter type Determines how multiple samples are combined into a single pixel
value. Can be set to Box, Gauss, Triangle, Mitchell, or Lanczos. Default=Box.
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TIP For most scenes the Mitchell filter gives the best results.

■ Box filter: Sums all samples in the filter area with equal weight. This is the
quickest sampling method.

■ Gauss filter: Weights the samples using a Gauss (bell) curve centered on
the pixel.

■ Triangle filter: Weights the samples using a pyramid centered on the pixel.

■ Mitchell filter: Weights the samples using a curve (steeper than Gauss)
centered on the pixel.

■ Lanczos filter: Weights the samples using a curve (steeper than Gauss)
centered on the pixel, diminishing the effect of samples at the edge of the
filter area.

Width and Height Specify the size of the filtered area. Increasing the value
of Width and Height can soften the image, however it will increase rendering
time.

Default=Depends on the Filter type you choose:

■ Box filter: Width=1.0, Height=1.0

■ Gauss filter: Width=3.0, Height=3.0

■ Triangle filter: Width=2.0, Height=2.0

■ Mitchell filter: Width=4.0, Height=4.0

■ Lanczos filter: Width=4.0, Height=4.0

Spatial Contrast group

This control sets the contrast value used as thresholds to control sampling.
Spatial contrast applies to each still image.

If neighboring samples in a frame differ by more than this color, the mental
ray renderer does recursive supersampling (that is, more than one sample per
pixel), up to the depth specified by the Maximum samples per pixel on page
6274 value. Increasing the Spatial Contrast values decreases the amount of
sampling done, and can speed the rendering of a scene at the cost of image
quality.

■ R, G, B Specify the threshold values for the red, green, and blue
components of samples. These values are normalized, and range from 0.0
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to 1.0, where 0.0 indicates the color component is fully unsaturated (black,
or 0 in eight-bit encoding) and 1.0 indicates the color component is fully
saturated (white, or 255 in eight-bit encoding). Default=(0.05, 0.05, 0.05).

■ A Specifies the threshold value for the alpha component of samples. This
value is normalized, and ranges from 0.0 (fully transparent, or 0 in eight-bit
encoding) to 1.0 (fully opaque, or 255 in eight-bit encoding). Default=0.05.

■ [color swatch] Click to display a Color Selector on page 391 to let you
specify the R, G, and B threshold values interactively.

Options group

Lock Samples When on, the mental ray renderer uses the same sampling
pattern for every frame of an animation. When off, the mental ray renderer
introduces a quasi-random (Monte Carlo) variation in the sample pattern from
frame to frame. Default=on.

Varying the sample pattern reduces rendering artifacts in animations.

Jitter Introduces a variation into sample locations; see Sampling on page 8112.
Turning on Jitter can help reduce aliasing. Default=on.

Bucket Width Determines the size of each bucket in pixels. Range=4 to 512
pixels. Default=48 pixels.

To render the scene, the mental ray renderer subdivides the image into
rectangular sections, or “buckets.” Using a smaller bucket size causes more
image updates to be generated during rendering. Updating the image consumes
a certain amount of CPU cycles. For scenes with little complexity, smaller
buckets can increase the rendering time, while larger buckets can make things
render faster. For more complex scenes, the reverse is true.

Bucket Order Lets you specify the method by which mental ray chooses the
next bucket. If you are using placeholders or distributed rendering, use the
default Hilbert order. Otherwise, you can choose a method based on how you
prefer to see the image appear as it renders in the Rendered Frame Window.

■ Hilbert (best) (The default.) The next bucket chosen is the one that will
trigger the fewest data transfers.

TIP Always use Hilbert order when you use placeholders (see the Translator
Options rollout on page 6316) or distributed rendering (see the Distributed
Bucket Rendering rollout on page 6326).

■ Spiral The buckets begin at the center of the image, and spiral outward.
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■ Left to right Buckets are rendered in columns, from bottom to top, left
to right.

■ Right to left Buckets are rendered in columns, from bottom to top, right
to left.

■ Top-down Buckets are rendered in rows, from right to left, top to bottom.

■ Bottom-up Buckets are rendered in rows, from right to left, bottom to
top.

Frame Buffer Type Lets you choose the bit depth of the output frame buffer:

■ Integer (16 bits per channel) Outputs 16 bits per channel of color
information.This is the default output format.

■ Floating-Point (32 bits per channel) Outputs 32 bits per channel of color
information. This method supports high-dynamic-range imagery (HDRI).

Rendering Algorithms Rollout (mental ray
Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Renderer
panel > Rendering Algorithms rollout

The controls in this rollout let you choose whether to render using ray-tracing,
scanline rendering, or both. You can also choose the method used to accelerate
ray-tracing.

The Trace Depth controls the number of times each ray can be reflected,
refracted, or both.

Procedures

To set trace depth for reflections and refractions:

1 Count the number of times you want an object to be reflected or refracted
in the scene.

2 On the mental ray: Rendering Algorithms rollout, turn on Enable
Reflections and enable Refractions.

3 Set Max. Reflections to the number of reflections you want, and Max.
Refractions to the number of refractions you want.
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4 Set Max. Trace Depth to the sum of the values for Max Reflections and
Max Refractions.

The greater the number of reflections and refractions, the more slowly
your scene will render. On the other hand, too low a value for Max.
Reflections or Max. Refractions (or Max. Trace Depth, controlling both)
can make your rendering look unrealistic.

Interface

By default, both Scanline and Ray Tracing are enabled, which lets the mental
ray renderer use the two methods in combination to render the scene. Scanline
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rendering is used for direct illumination (“primary rays”) only; ray tracing is
used for indirect illumination (caustics and global illumination) as well as
reflections, refractions, and lens effects.

You can disable one or the other option, but not both. For example, if only
ray tracing is enabled and you turn it off, 3ds Max enables scanline rendering.

Scanline group

Enable When on, the renderer can use scanline rendering. When off, the
renderer uses the ray-tracing method only. Scanline rendering is faster than
ray tracing, but cannot generate reflections, refractions, shadows, depth of
field, or indirect lighting. Default=on.

Use Fast Rasterizer (Rapid Motion Blur) When on, uses a fast rasterizer
method to generate the first generation of rays to trace. This can improve
rendering speed. Default=off.

This option works well with object motion blur, and also with scenes that
have no motion blur.

The following settings are available for the fast rasterizer:

■ Samples per Pixel Controls the number of samples per pixel used by the
fast rasterizer method. More samples result in greater smoothness, at a cost
of render time. Range=1 to 225. Default=16.

■ Shades per Pixel Controls the approximate number of shading calls per
pixel. Greater values result in more accurate renderings, at a cost of render
time. Range=0.1 to 10000 (ten thousand). Default=2.0.

NOTE mental ray provides a Time Samples setting specifically for motion blur in
the fast rasterizer. When Use Fast Rasterizer is on, the Camera Effects rollout >Time
Samples on page 6287 label changes to Time Samples (Fast Rasterizer) to indicate
that this version of Time Samples is now in effect.

Ray Tracing group

Enable When on, mental ray uses ray tracing to render reflections, refractions,
lens effects (motion blur and depth of field), and indirect lighting (caustics
and global illumination). When off, the renderer uses the scanline method
only. Ray tracing is slower but more accurate and more realistic. Default=on.

To render reflections, refractions, depth of field, and indirect lighting (caustics
and global illumination), Ray Tracing must be enabled.
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Use Autovolume When on, uses the mental ray autovolume mode. This lets
you render nested or overlapping volumes such as the intersection of two
spotlight beams. Autovolume also allows a camera to move through the nested
or overlapping volumes. Default=off.

To use Autovolume, Ray Trace must be on, Scanline must be off, and the
shadow mode must be set to Segments. (You set the shadow mode on the
Shadows And Displacement rollout on page 6292.) If these conditions aren't met
when you click to turn on Autovolume, an alert warns you about this, and
gives you the option of making the appropriate setting changes.

Raytrace Acceleration Group

Method The drop-down list sets which algorithm to use for raytrace
acceleration on page 8102. The other controls in this group box change,
depending on which acceleration method you choose. These are the
alternatives:

■ BSP
(The default.) The BSP method has Size and Depth controls. See Ray-Trace
Acceleration: Parameters for the BSP Method on page 6282.

This method is the fastest on a single-processor system. Use it for
small-to-medium size scenes (less than one million triangles) on a single
processor. BSP is also the best method to use when ray tracing is turned
off.

■ BSP2
The BSP2 method is configured automatically by mental ray and has no
controls. This method is optimized for large scenes containing more than
a million triangles.

BSP2 requires less memory than BSP and is able to flush memory when
necessary. However, there could be a small performance loss when using
it with smaller scenes.

Reflections/Refractions group

Trace depth controls the number of times a light ray can be reflected or
refracted. At 0, no reflection or refraction occurs. Increasing these values can
increase the complexity and realism of a scene, at a cost of greater rendering
time.
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TIP In some cases, you might want to set Max. Refractions high and Max.
Reflections low. For example, you might have the camera looking through several
glasses that are lined up, so they're overlapping from the camera's point of view.
In this situation, you might want the light rays to refract twice for each glass (once
for each layer), so you'd set Max. Refractions to 2 x [number of glasses]. However,
to save rendering time, you could set Max. Reflections to 1, resulting in accurate
multi-layer refraction with a relatively fast rendering time.

Max. Trace Depth Limits the combination of reflection and refraction. Tracing
of a ray stops when the total number of reflections and refractions reaches
the Max. Trace Depth. For example, if Max. Trace Depth is set to 3 and the
two trace depths are both set to 2, a ray can be reflected twice and refracted
once, or vice-versa, but it can’t be reflected and refracted four times. Default=6.

Enable Reflections When on, mental ray traces reflections. Turn off
to improve performance when you don’t require reflections.

■ Max. Reflections Sets the number of times a ray can be reflected. At 0,
no reflection occurs. At 1, the ray can be reflected once only. At 2, the ray
can be reflected twice, and so on. Default=4.

These controls are also available on the Rendered Frame Window, as Include
In Render > Reflections and Max on page 6081.

Enable Refractions When on, mental ray traces refraction. Turn off
to improve performance when you don’t require refraction.

■ Max. Refractions Sets the number of times a ray can be refracted. At 0,
no refraction occurs. At 1, the ray can be refracted once only. At 2, the ray
can be refracted twice, and so on. Default=6.

These controls are also available on the Rendered Frame Window, as Include
In Render > Refractions and Max on page 6081.

Subset Pixel Rendering group

Render changes to selected objects only When on, rendering the
scene applies only to selected objects. Unlike using the Selected on page 6097
option for rendering, however, using this option takes into account all scene
elements that affect its appearance. This includes shadows, reflection, direct
and indirect lighting, and so on. Also, unlike Selected, which replaces the
entire contents of the Rendered Frame Window (except for selected objects)
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with the background color, this option replaces only pixels used by the
re-rendered selected objects.

Subset pixel rendering is particularly useful when performing iterative
rendering and refinement of lighting, shadows, and other scene elements for
a particular object or set of objects in the scene. It lets you re-render repeatedly
to view the results of isolated changes without disturbing the rest of the
rendered output.

This setting is also available on the Rendered Frame Window, as Subset Pixels
(of selected objects) on page 6081.

Ray-Trace Acceleration: Parameters for the BSP
Method

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Renderer
panel > Rendering Algorithms rollout > Raytrace Acceleration group > Choose
BSP as the Raytrace Acceleration method.

When you choose BSP as the Raytrace Acceleration method on the Rendering
Algorithms rollout on page 6277, the parameters described here are displayed.
BSP stands for Binary Space Partitioning.

NOTE If the scene contains too many faces (triangles) to fit in a tree of the size
specified by the Size and Depth parameters, mental ray disregards the Size value
and creates larger leaf nodes. This can significantly slow down rendering. To avoid
this problem, increase the value of Depth.

Interface

Size Sets the maximum number of faces (triangles) in the leaf of a BSP tree.
Increasing the Size value reduces memory consumption but increases rendering
time. Default=10.

Depth Sets the maximum number of levels in the BSP tree. Increasing the
Depth value reduces rendering time, but increases memory consumption and
preprocessing time. Default=40.
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TIP For large scenes, increasing the Depth value to 50 or more can greatly improve
rendering time.

Camera Effects Rollout (mental ray Renderer)

Rendering menu > Render Setup > Render Setup dialog > Renderer panel >
Camera Effects rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Renderer
panel > Camera Effects rollout

Note: The Camera Effects rollout appears only when the mental ray renderer
is the currently active renderer.

The controls in this rollout are for the camera effects depth of field on page
6249 and motion blur on page 6248, as well as for contour shading on page 6269
and adding camera shaders.

Procedures

To use depth of field for a Camera view:

1 On the camera’s Parameters rollout, in the Multi-Pass Effect group, turn
on Enable and choose Depth Of Field (mental ray).

2 Set the camera’s target distance to the range at which you want objects
to be clearly in focus.

For a Target camera, you can select the camera’s target object and move
it. For a Free camera, you adjust the Target Distance on the Parameters
rollout.

3 On the Camera’s Depth Of Field rollout, decrease the f-Stop value to
narrow the depth of field, or increase the f-Stop value to broaden the
depth of field.

You might need to experiment with f-Stop values to get the effect you
want.

4 Render the scene.

To use depth of field for a Perspective view:

1 On the Render Setup dialog, go to the Renderer panel > Camera Effects
rollout, and in the Depth Of Field (Perspective Views Only) group, turn
on Enable.
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2 Set the Focus Plane distance to the range at which you want objects to
be clearly in focus.

3 Decrease the f-Stop value to narrow the depth of field, or increase the
f-Stop value to broaden the depth of field.

You might need to experiment with f-Stop values to get the effect you
want. If you have trouble getting good results with f-Stop, use the
drop-down list to change the method to In Focus Limits, then adjust the
Near and Far values to enclose the region of the scene you want to be
clearly in focus.

4 Render the scene.

To use motion blur:

1 Select each object you want to be blurred by motion, right-click and
choose Properties, then on the Object Properties dialog > General panel,
make sure that in the Motion Blur group, Enable is turned on and Object
is chosen.

The mental ray renderer won't generate motion blur if Image is the chosen
type.

2 On the Render Setup dialog, go to the Renderer panel > Camera Effects
rollout, and in the Motion Blur group turn on Enable.

NOTE With the mental ray renderer, don't use Motion Blur as a Multi-Pass
Effect.

3 Increase the Shutter value to increase the blurriness caused by motion
blur.

4 On the Render Setup dialog, go to the Rendering Algorithms rollout, and
make sure Ray Trace is turned on.

Motion blur is not rendered when the mental ray renderer uses scanlines
only.

5 Render the scene.

To render with contours:

1 Use the mental ray Connection rollout to assign a contour shader to an
object's material.

The mental ray material also lets you assign a contour shader.
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2 On the Render Setup dialog > Renderer panel > Camera Effects rollout,
in the Contours group, turn on Enable.

3 Change the contour output shader if you so desire.

NOTE By default, only one contour contrast and store shader are provided
with 3ds Max. You can adjust the contour contrast shader's settings; the
contrast store shader has no parameters.

4 Render the scene.

To change a contour output shader:

NOTE By default, only one contour contrast and store shader are provided with
3ds Max. You can adjust the contour contrast shader's settings; the contour store
shader has no parameters.

1 Click the button for the Contour Output shader.

The Material/Map Browser is displayed.

2 Choose a contour output shader from the Browser list, and then click
OK.

To assign a camera shader:

1 Click the button for a camera Lens, Output, or Volume shader.

The Material/Map Browser is displayed.

2 Choose a shader from the Browser list, and then click OK.

To adjust the settings for a contour or camera shader assigned on this rollout:

1  Open the Material Editor.

If you need to, arrange the open dialogs so you can see the Material Editor
and the Render Setup dialog at the same time.

2 Drag the shader button from the Render Setup dialog to an unused sample
slot in the Material Editor.

An Instance (Copy) Map dialog is displayed. Be sure to choose Instance, and
then click OK.
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If you don't choose Instance, changes you make to the shader settings in
the Material Editor won't have any effect on the Render Setup dialog.

TIP If you forgot to choose Instance, change the shader settings as you
choose, and then drag the shader's sample slot or its Type button back to
the button in the Render Setup dialog. This updates the Render Setup dialog
copy of the shader.

The Material Editor displays the shader parameters rollout.

3 Adjust the parameters.

Interface
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Motion Blur group

TIP mental ray motion blur is not recommended for use with particle systems, as
this can increase rendering time considerably. Use a Particle MBlur map on page
5891 instead.

NOTE Motion blur with the mental ray renderer does not always follow curving
trajectories. Increasing the value of Motion Segments can help, but this works
better for rotary motion than for traveling motion.

The Rendering Control Properties (lower-right) quad of the rendering quad
menu (Ctrl+Alt+right-click) has a Motion Blur toggle for a single, selected
object. You can turn on Motion Blur for lights and cameras: moving lights
and cameras can generate motion blur when rendered with mental ray.

Enable When on, the mental ray renderer calculates motion blur on page 6248.
Default=off.

Blur All Objects Applies motion blur to all objects, regardless of their object
property setting. Default=on.

Shutter Duration (frames) Simulates the shutter speed of a camera. At 0.0,
there is no motion blurring. The greater the Shutter Duration value, the greater
the blurring. Default=0.5.

Shutter Offset (frames) Sets the beginning of the motion-blur effect relative
to the current frame. The default value, 0.0, centers the blurring around the
current frame for a photorealistic effect. Default=–0.25.

Motion Segments Sets the number of segments for calculating motion blur.
This control is for animations. If motion blur appears to be tangential to the
actual motion of an object, increase the Motion Segments value. Larger values
result in more accurate motion blur, at a cost of rendering time. Default=1.

Time Samples When the scene uses motion blur, controls the number of
times the material is shaded during each time interval (set by Shutter Duration
on page 6287). Range=0 to 100. Default=5.

By default, the material is shaded only once, and then blurred. If the material
changes rapidly during the shutter interval, it might be useful to increase this
value, in order to obtain more accurate motion blur. Rapid changes in
reflections or refractions might require a higher Time Samples value.
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NOTE When Rendering Algorithms rollout > Use Fast Rasterizer on page 6279 is on,
the label for this parameter changes to Time Samples (Fast Rasterizer) to indicate
that this version of Time Samples is now in effect. The default value for the Fast
Rasterizer version of Time Samples is 1, and the range is 1 to 128. If you change
the value for either version, the software remembers the changed setting when
you switch.

Contours group

These controls enable contours, and let you use shaders to adjust the results
of a contour shader. You assign the primary contour shader to the Contour
component of the mental ray Connection rollout on page 5385 or a mental ray
material (see Advanced Shaders Rollout (mental ray Material) on page 5646).

NOTE Contour shading does not work with distributed bucket rendering.

Enable When on enables rendering of contours. Default=off.

Click a button to change a shader assignment for adjusting contours. A default
is already assigned to the three components, as the button labels indicate.

Contour Contrast The contour contrast component can be assigned the
following shader:

LibraryShader

contourContour Contrast Function Levels

Contour Store This component stores the data on which contours are based.
It can be assigned the following shader, which has no parameters to set:

LibraryShader

contourContour Store Function

Contour Output The contour output component can be assigned one of these
shaders:

LibraryShader

contourContour Composite

contourContour Only
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LibraryShader

contourContour PS (PostScript)

To adjust the settings for a shader assigned to one of these components, drag
the shader's button to an unused Material Editor sample slot. When prompted
to use an instance or a copy, be sure to choose Instance. (If you edit a copy of
the shader, you will have to drag the sample slot back to the shader button
on the Camera Effects rollout before you see any changes take effect.)

Camera Shaders group

These controls let you assign mental ray camera shaders. Click a button to
assign a shader to that component. After a shader is assigned, its name appears
on the button. Use the toggle on the left to temporarily disable a shader that
has been assigned.

Lens Click to assign a lens shader. This component can be assigned one of
these shaders:

LibraryShader

lumeDistortion

lumeNight

3ds MaxShader List on page 6003 (Lens)

lumeWrap Around

Output Click to assign a camera output shader. These are the output shaders
you can assign:

LibraryShader

lumeGlare Shader (mental ray) on page 5997 (The

default.)

lumeShader List on page 6003 (Output)
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Volume Click to assign a volume shader to the camera. These are the volume
shaders you can assign:

LibraryShader

lumeBeam

3ds MaxMaterial to Shader on page 6001

lumeMist

physicsParti Volume

3ds MaxShader List on page 6003 (Volume)

lumeSubmerge

NOTE You can also assign Volume shaders to the Volume component of the
mental ray Connection rollout on page 5385 and the mental ray material (see Material
Shaders Rollout (mental ray Material) on page 5638).

Depth of Field (Perspective Views Only) group

These controls are comparable to the depth-of-field controls for cameras. They
apply only to Perspective viewports. You can render depth-of-field effects for
either Camera or Perspective views. Depth-of-field effects don’t appear when
you render orthographic viewports.

For a Perspective view, use the controls in this group. For a Camera view,
choose “Depth Of Field (mental ray)” as the multi-pass rendering effect, then
adjust the f-Stop setting. See Depth of Field Parameter (mental ray Renderer)
on page 5229.

Enable When on, the mental ray renderer calculates depth-of-field on page
6249 effects when rendering a Perspective view. Default=off.

[method drop-down list] Lets you choose the method for controlling
depth-of-field. Default=f-Stop.

■ f-Stop Controls depth-of-field with the f-Stop setting.

■ In Focus Limits Controls depth-of-field with the Near and Far values.
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In most cases, the f-Stop method is easier to use. The In Focus Limits method
can help when the scale of objects in the scene makes it difficult to control
depth of field using the f-Stop value alone.

Focus Plane For Perspective viewports, sets the distance from the camera, in
3ds Max units, at which the scene is completely in focus. Default=100.0.

For Camera viewports, the focus plane is set by the camera's target distance.

f-Stop When f-Stop is the active method, sets the f-stop for use when you
render Perspective views. Increasing the f-stop value broadens the depth of
field, and decreasing the f-stop value narrows the depth of field. Default=1.0.

The f-Stop can have a value less than 1.0. This is not realistic in terms of an
actual camera, but it can help you adjust the depth of field for scenes whose
scale does not use realistic units.

Near and Far When In Focus Limits is the active method, these values set the
range, in 3ds Max units, within which objects are in focus. Objects lose focus
when they are closer than the Near value or farther than the Far value. These
values are approximate, because the transition from in-focus to out-of-focus
is gradual, not abrupt.

The Near and Far values are related to each other and to the value of Focus
Plane. Changing the value of Near changes Far as well, and vice versa.
Specifically, if

H = Hyperfocal distance, the Focus Plane value at which the Far limit becomes
infinity

D = The Focus Plane distance

Dn = The Near distance

Df = The Far distance

Then

Dn = HD / (H + D)

Df = HD / (H − D)
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Shadows & Displacement Rollout (mental ray
Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Renderer
panel > Shadows & Displacement rollout

Note: The Shadows & Displacement rollout appears only when the mental
ray renderer is the currently active renderer.

The controls in this rollout affect shadows on page 6246 and displacement on
page 6268.

NOTE You can disable displacement globally by turning off Displacement in the
Options group on the Common Parameters rollout on page 6121.

Interface

Shadows group

Enable When on, the mental ray renderer renders shadows. When off, no
shadows are rendered. Default=on.

When Enable is off, the other shadow controls are unavailable.
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Mode The shadow mode can be Simple, Sort, or Segments. Default=Simple.

■ Simple Causes the mental ray renderer to call shadow shaders in a random
order.

■ Sort Causes the mental ray renderer to call shadow shaders in order,
from the object to the light. Sort applies to third-party, external shadow
shaders on page 8123.

■ Segments Causes the mental ray renderer to call shadow shaders in order
along the light ray from the volume shaders to the segments of the light
ray between the object and the light.

TIP Choose Simple for regular shadows, Segments for volume shadows.

Shadow Maps group

These controls specify a shadow map on page 8126 used to render shadows.
When you specify a shadow map file, the mental ray renderer uses the shadow
map instead of ray-traced shadows.

To stop using a shadow map and use ray-traced shadows, delete the map's
name from the file name field.

Enable When on, the mental ray renderer renders shadow-mapped shadows.
When off, all shadows are ray-traced. Default=on.

When Enabled is off, the other controls in this group are unavailable.

If shadows are enabled but shadow maps are not enabled, then shadows for
all lights are generated using the mental ray ray-tracing algorithm. If shadow
maps are enabled, then shadow generation is based on each light’s choice of
shadow generator:

■ mental ray Shadow Map Shadows are generated using the mental ray
shadow-map algorithm.

■ Shadow Map Settings on the Shadow Parameters rollout are translated
into a mental ray equivalent before shadows are generated. The quality of
shadows generated this way might not always meet expectations.

■ Area Shadows, Advanced Ray Traced Shadows, or Ray Traced
Shadows Shadows are generated using the mental ray ray-tracing
algorithm.

Motion Blur When on, the mental ray renderer applies motion blur on page
6248 to shadow maps. Default=on.
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WARNING Turning on Motion Blur for both cameras and shadows can cause
shadows to shift position. To avoid this effect, turn on motion blur for cameras
only.

Rebuild (Do Not Re-Use Cache) When on, the renderer saves the recalculated
shadow map (.zt) file on page 8177 to the file specified by the Browse button.
Default=on.

■ Use File When on, the mental ray renderer either saves the shadow map
to a ZT file, or loads an existing file. The state of Rebuild determines
whether the ZT file is saved or loaded.
This option is unavailable until you click the ellipsis button (see following)
to provide a name for the ZT file.

■ ... [browse] Click to display a file selector dialog, which lets you specify
a name for the shadow map ZT file and the folder where it is saved.

■ File name After you specify a shadow map file (see preceding), this field
displays its name and path.

■ Delete File Click to delete the current ZT file.

Displacement group

View Defines the space for displacement. When View is on, the Edge Length
specifies the length in pixels. When off, the Edge Length is specified in world
space units. Default=on.

Smoothing Turn off to have the mental ray renderer correctly render height
maps. Height maps can be generated by normal mapping; see Creating and
Using Normal Bump Maps on page 6384.

When using only height maps in the scene, make sure this option is off. If
some objects in the scene use height maps while others use standard
displacement, apply smoothing on a per-object basis (see mental ray Panel
(Object Properties Dialog) on page 322).

When on, mental ray simply smoothes the geometry using the interpolated
normals, making the geometry look better. This result, however, cannot be
used for height map displacement because smoothing affects geometry in a
way that is incompatible with height mapping.

Edge Length Defines the smallest potential edge length due to subdivision.
The mental ray renderer stops subdividing an edge once it reaches this size.
Default=2.0 pixels.
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Max. Displace Controls the maximum offset, in world units, that can be
given to a vertex when displacing it. This value can affect the bounding box
of an object. Default=20.0.

TIP If displaced geometry appears to be “clipped,” try increasing the value of
Maximum Displace.

NOTE When using placeholders (see the Translator Options rollout on page 6316),
if this value is larger than it needs to be, it can reduce performance. If you
experience slow times while displaced objects when Use Placeholder Objects is
on, try lowering the Max. Displace value.

Max. Subdiv. Controls the extent to which mental ray can recursively
subdivide each original mesh triangle for displacement. Each subdivision
recursion potentially divides a single face into four smaller faces. Choose the
value from the drop-down list. Range=4 to 64K (65,536). Default=16K (16,384).

For example, using the default value means that mental ray can subdivide
each displaced mesh triangle into as many as 16,384 smaller triangles.

Indirect Illumination Panel

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Indirect
Illumination panel

Note: The Processing panel appears only when mental ray is the active renderer.

The Indirect Illumination panel controls concern themselves with methods
for rendering bounced light within an environment, including final gathering,
caustics, and photons.

Final Gather Rollout (mental ray Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Indirect
Illumination panel > Final Gather rollout

Note: The Indirect Illumination panel appears only when the mental ray
renderer is the currently active renderer.

Final gathering is a technique for estimating global illumination for a given
point by either sampling a number of directions over the hemisphere over
that point (such a set of samples is called a final gather point), or by averaging
a number of nearby final gather points since final gather points are too
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expensive to compute for every illuminated point. In the former case, the
hemisphere orientation is determined by the surface normal of the triangle
on whose surface the point lies.

For diffuse scenes, final gathering often improves the quality of the global
illumination solution. Without final gathering, the global illumination on a
diffuse surface is computed by estimating the photon density (and energy)
near that point. With final gathering, many new rays are sent out to sample
the hemisphere above the point to determine the incident illumination. Some
of these rays strike diffuse surfaces, and the global illumination at those points
is then computed by the material shaders at these point, using illumination
from the photon map, if available, and from other material properties. Other
rays strike specular surfaces and do not contribute to the final gather color
(since that type of light transport is a secondary caustic). Tracing many rays
(each with a photon map lookup) is very time-consuming, so it is done only
when necessary. In most cases, interpolation and extrapolation from previous
nearby final gathers is sufficient.

Final gathering is also useful without photon tracing; this takes only
first-bounce indirect light into account but often gives good results where
complete physical accuracy is not required.

Interior rendered with final gathering only

Final gathering is useful in scenes with slow variation in the indirect
illumination, such as purely diffuse scenes. For such scenes, final gathering
eliminates photon map artifacts such as low-frequency noise and dark corners.
With final gathering, fewer photons are needed in the photon map and,
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because each final gather averages over many values of indirect illumination,
lower accuracy is sufficient.

In film production work, final gathering increasingly replaces photon mapping,
except for caustics. Without multiple-bounce effects, which are performed by
photons by default and by final gathering only if the shaders adjusts the trace
depth, tends to have far less impact on the final image than the first bounce
that final gathering supports by default. Although physical correctness is lost,
this is often sufficient for film production, and final gathering is easier to
control than photons emanating from distant light sources. However, for
accurate indoor illumination simulations and other CAD-related applications,
photon mapping is still the method of choice.

Procedures

To use an environment map as a final gather light source:

Illumination from which final gathering is derived can be provided by an
actual light source, of course, but it can also be provided by an object to which
a self-illuminated material is applied, or even an environment map. In the
latter case, follow this procedure:

1 Add a skylight on page 5065 to the scene.

2 Do either of the following:

■ On the Skylight Parameters rollout, make sure Sky Color (the default)
is chosen, click the map button (“None”) to open the Material/Map
Browser dialog and then choose a map.

■ On the Skylight Parameters rollout, choose Use Scene Environment.
Use the Environment panel on page 6689 controls to assign an
environment map.

Thereafter, rendering with final gather enabled take the skylight map
into account when calculating final gather illumination.

TIP For extra realism, use an HDR image on page 7334 as a Bitmap map image
on page 5795.
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Interface

Basic group
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Enable Final Gather When on, the mental ray renderer uses final gathering
on page 7978 to create global illumination or to improve its quality. Default=on.

This setting is also available on the Rendered Frame Window, as Final Gather
on page 6081.

TIP Without final gathering, global illumination can appear to be patchy. But final
gathering increases rendering time. Leave Final Gather off to preview the scene,
and then turn it on for the finished rendering. (Increasing the number of photons
used to calculate global illumination can also improve global illumination.)

Multiplier / color swatch Use these to control the intensity and color of the
indirect light accumulated by final gathering. The defaults, 1.0 and white,
produce physically correct rendering.

This is useful for adjusting the contribution of the final gather effect, thus
improving the quality of an image.

FG Precision Presets Provides a quick, easy solution for final gather. The
default presets are: Draft, Low, Medium, High, Very High, and Custom (the
default choice). Available only when Enable Final Gather is on.

The presets affect the following settings:

■ Initial FG Point Density

■ Rays per FG Point

■ Interpolate Over Num. FG Points

The preset settings are defined in the text file mentalray_fg_presets.ini, found
in the \plugcfg folder in the program installation. You can modify the existing
presets and add new ones by editing this file.

This setting is also available on the Rendered Frame Window, as Final Gather
Precision on page 6083.

Initial FG Point Density A multiplier for the density of final gather points.
Increasing this value increases the density (and thus the quantity) of final
gather points in the image. The points will therefore be closer together and
more numerous. This parameter is useful for solving geometry problems; for
example, near edges or corners. Default=1.0.

TIP When adjusting final render settings it's often helpful to visualize the final
gather points; to do so, turn on Diagnostics on page 6324 and choose the Final
Gather option.
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Rays per FG Point Sets how many rays are used to compute indirect
illumination in a final gather. Increasing this value makes global illumination
less noisy, but also increases rendering time. Default=250.

Interpolate Over Num. FG Points Controls the number of final gather points
that are used for an image sample. It is useful for solving noise problems and
getting smoother results.

For each final gather point, mental ray interpolates (averages) indirect light
values over the nearest N final gather points, with N specified by the value of
this parameter, as opposed to points within the specified radii as with the
alternate method on page 6305. Increasing the value increases the smoothness
of the result, and the required number of calculations, hence the render time
(but not as much as you might expect).

This setting is unavailable when Use Radius Interpolation Method on page
6305 is enabled.

Diffuse Bounces Sets the number of times mental ray calculates diffuse light
bounces for each diffuse ray. Default=0.

Like Maximum Reflections and Maximum Refractions, this value is subject to
the restriction of Max Depth. If you set Diffuse Bounces higher than Max
Depth, the latter setting is automatically raised to the Diffuse Bounces value
in the MI output file, but this is not reflected in the 3ds Max interface.

This setting is also available on the Rendered Frame Window, as Bounces on
page ?.

NOTE When Global Illumination on page 6310 is on, changing this setting has no
effect.

Weight Controls the relative contribution of the diffuse bounces to the final
gather solution. The value scales from "using no diffuse bounces" (value=0.0)
to "use full diffuse bounces" (value=1.0). Default=1.0.

Final Gather Map group

These controls tell mental ray how to calculate the final gather map for indirect
illumination. The map uses the FGM file format on page 7971.

Read/Write File When on, the mental ray renderer saves the final gather map
to the specified FGM file, if it doesn't already exist. If the file exists, mental
ray loads it and uses the map data it contains instead of generating a new one.

This setting is available on the Rendered Frame Window as Reuse > Final
Gather on page 6083.
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 Read Only (FG Freeze) Determines whether or not mental ray uses the
final gather map file as is. When off, mental ray can add new final gather
points if necessary. When on, mental ray uses only the data in the specified
file, and does not generate any new final gather points during the
pre-processing stage. It can still generate new  final gather points while
rendering when using the radius method. Available only when you've specified
an FGM file. Default=off.

This setting is available on the Rendered Frame Window as Reuse >  Lock Final
Gather on page 6083.

... [Browse] Click to display a file selector dialog, which lets you specify a
name for the final gather map (FGM) file, and the folder where it is saved.

[file name] After you specify a final gather map file using the browse control
(see preceding), the name field displays its name and path.

This field can also be filled automatically with the default path and the file
name temp.fgm by turning on the Rendered Frame Window > Reuse group >
Final Gather on page 6083 check box.

 Delete File Click to delete the current FGM file.

 Generate Final Gather Map Now Processes the final gather pass for
all animation frames (as specified in the Common Parameters rollout > Time
Output group on page 6124). Generates the maps to the specified file without
rendering the scene. To reduce flicker when rendering an animation with a
networked render farm, use this function first to generate the final gather
solution for all frames, and then turn on Read Only (FG Freeze) before
rendering.

Advanced group

Noise Filtering (Speckle Reduction) Applies a median filter using neighboring
final gather rays that are shot from the same point. This parameter lets you
choose a value from a drop-down list. The options are None, Standard, High,
Very High, and Extremely High. Default=Standard.

The practical effect of increasing the Noise Filtering value is to make the scene
illumination smoother, at a cost of render time. However, increasing filtering
can also make the illumination somewhat darker.

Noise Filtering works by eliminating stray rays that are considerably brighter
than most of the rest. For example, in a situation in which most of the rays
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are within 10 percent of each others’ brightness, but a few are 50 percent
brighter than the rest, using Noise Filtering will tend to disregard the latter
rays in computing the Final Gather solution.

As a result, in low-light situations, setting Noise Filtering=None can greatly
increase the overall illumination. In the following rendered image, an interior
scene, lit only by skylight entering through the window, is very dark with
Noise Filtering set to Standard (Diffuse Bounces=1).

Noise Filtering=Standard

In the next illustration, the same scene renders much brighter with Noise
Filtering set to None. Note, however, the unevenness of the illumuniation.
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Noise Filtering=None

In cases like this, you can achieve superior results with slightly longer rendering
times by setting Noise Filtering to Standard and using a sky portal on page
5186 in the window opening, as shown in the following illlustration:
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Noise Filtering=Standard + Sky Portal

The above illustration is also improved by the realistic shadows cast by the
chair and table legs from the Sky Portal light.

Draft Mode (No Precalculations) When on, final gathering skips the
precalculation phase. This results in a rendering with artifacts, but begins
rendering more quickly, so it can useful when you want to do a series of trial
renderings. Default=off.

Trace Depth group

The Trace Depth controls are similar to those for calculating reflections and
refractions, but they refer to the light rays used by final gathering, rather than
to rays used in diffuse reflection and refraction.

Max. Depth Limits the combination of reflection and refraction. Reflection
and refraction of a light ray stop when the total number of both equals the
Maximum Depth setting. For example, if Maximum Depth equals 3 and the
trace depths each equal 2, a ray can be reflected twice and refracted once, or
vice versa, but it can’t be reflected and refracted four times. Default=2.
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Max. Reflections Sets the number of times a ray can be reflected. At 0, no
reflection occurs. At 1, the ray can be reflected once only. At 2, the ray can
be reflected twice, and so on. Default=5.

Max. Refractions Sets the number of times a ray can be refracted. At 0, no
refraction occurs. At 1, the ray can be refracted once only. At 2, the ray can
be refracted twice, and so on. Default=5.

Use Falloff (Limits Ray Distance) When on, uses the Start and Stop values
to limit the length of light rays used for regathering before using the
environment color. This can help improve regathering time, especially for
scenes that are not fully enclosed by geometry. Default=off.

■ Start Specifies the distance, in 3ds Max units, at which rays begin. You
can use this value to exclude geometry that is too close to the light source.
Default=0.0.

■ Stop Specifies the maximum length, in 3ds Max units, of a light ray. If
the ray reaches this limit without encountering a surface, then the
environment is used for shading. Default=0.0.

FG Point Interpolation group

These settings provide access to the legacy method of final gather point
interpolation.

Use Radius Interpolation Method When on, makes the remaining controls
in this group available. Also makes the Interpolate Over Num. FG Points check
box on page 6300 unavailable, indicating that these controls override that setting.

Radius When on, sets the maximum radius within which final gathering is
applied. Reducing this value can improve quality at a cost of rendering time.
If Radii In Pixels is off, the radius is specified in world units, and defaults to
10 percent of the maximum circumference of the scene. If Radii In Pixels is
on, default=5.0 pixels.

If both Radii In Pixels and Radius are off, the maximum radius is the default
value of 10 percent of the maximum scene radius, in world units.

Radii in Pixels When on, the radii values are specified in pixels. When off,
radii units depend on the value of the Radius toggle. Default=off.

Min. Radius When on, sets the minimum radius within which final gathering
must be used. Decreasing this value can improve render quality but increase
rendering time. Unavailable unless Radius is turned on. Default=0.0. If Radii
In Pixels is on, default=0.5.
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TIP In general, increasing the point density on page 6299 is better than decreasing
Min. Radius.

TIP To minimize flickering in animations, keep the two Radius values as close to
each other as possible.

Caustics and Global Illumination Rollout (mental
ray Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Indirect
Illumination panel > Caustics and Global Illumination rollout

Note: The Indirect Illumination panel appears only when the mental ray
renderer is the active renderer.

The controls in this rollout are for the effects of caustics on page 6255 and global
illumination on page 6261.

Procedures

To render with caustics:

1 Select each object you want to generate caustics, either by reflection or
refraction. Right-click and choose Properties, then on the mental ray
panel of the Object Properties dialog, turn on Generate Caustics.

Objects receive caustics by default. If you think this value might have
changed for the objects you want to receive caustics, use those objects’
Object Properties dialog to make sure Receive Caustics is turned on. Also,
to speed rendering time, you might want to turn off Receive Caustics for
those objects that don’t need to show them.

2 On the Render Setup dialog, go to the Caustics And Global Illumination
rollout and turn on Caustics.

3 Adjust the caustics parameters to get the effect you want.

4 Render the scene.
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To render with global illumination:

Objects generate and receive global illumination by default. If you think these
settings might have changed for any objects in the scene, use the Object
Properties dialog to make sure the proper settings are enabled.

1 Select each object you want to generate and/or receive global illumination.
Right-click and choose Properties, then on the mental ray panel of the
Object Properties dialog, turn on Generate Global Illumination and/or
Receive Global Illumination. Also, to speed rendering time, you might
want to turn off Receive Global Illumination for those objects that don’t
need it.

2 On the Render Setup dialog, go to the Indirect Illumination panel >
Caustics And Global Illumination rollout > Global Illumination (GI)
group and turn on Enable.

3 Adjust the global illumination parameters to get the effect you want.

4 For the final rendering, turn on Final Gather as well as Global
Illumination. See Final Gather Rollout (mental ray Renderer) on page 6295.

5 Render the scene.
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Interface
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Caustics group

IMPORTANT For caustics to render, you must also make sure to set up these other
conditions in your scene:

■ At least one object must be set to generate caustics. This is off by default.

■ At least one object must be set to receive caustics. This is on by default.

■ At least one light must be set to generate caustics. This is off by default.

The settings for generating and receiving caustics are located on the Object
Properties dialog > mental ray Panel on page 322.

Enable When on, the mental ray renderer calculates caustics effects.
Default=off.

Multiplier/color swatch Use these to control the intensity and color of the
indirect light accumulated by caustics. The defaults, 1.0 and white, produce
physically correct rendering.

This is useful for adjusting the contribution of the caustics effect, thus
improving the quality of an image.

Maximum Num. Photons per Sample Sets how many photons are used to
compute the intensity of the caustic. Increasing this value makes caustics less
noisy but also more blurry. Decreasing this value makes caustics more noisy
but less blurry. The larger the Samples value, the greater the rendering time.
Default=100.

TIP To preview a caustic, set Samples to 20, then increase the value for a final
rendering.

Maximum Sampling Radius When on, the spinner value sets the size of
photons. When off, each photon is calculated to be 1/100 of the radius of the
full scene. Maximum Sampling Radius default=off; value default=1.0.

In many cases, the default photon size (Radius=off) of 1/100 the scene size
gives useful results. In other cases, the default photon size might be too large
or too small.

When photon reflections overlap, the mental ray renderer uses sampling to
smooth them together. Increasing the number of samples increases the amount
of smoothing and can create more natural-looking caustics. When photons
have a small radius and don't overlap, the Samples setting has no effect. Low
Radius values with a large number of photons result in dotty caustics.
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Filter Sets the filter to use for sharpening caustics. Can equal Box, Cone, or
Gauss. The Box option requires less rendering time. The Cone option makes
caustics appear sharper. Default=Box.

The Gauss filter uses a Gauss (bell) curve, and can be smoother than the Cone
filter.

Filter Size Controls the sharpness of caustics when you choose Cone as the
caustic filter. This value must be greater than 1.0. Increasing the value makes
caustics more blurry. Decreasing the value makes caustics sharper, but also
slightly more noisy. Default=1.1.

Opaque Shadows when Caustics Are Enabled When on, shadows are opaque.
When off, shadows can be partially transparent. Default=on.

Opaque shadows render more quickly than transparent shadows.

Global Illumination (GI) group

These settings let you control the usage of photons by mental ray for generating
global illumination on page 6261. By default, all objects generate and receive
global illumination. The settings for generating and receiving GI are located
on the Object Properties dialog > mental ray Panel on page 322.

NOTE In order to render global illumination in mental ray, the photons must be
able to bounce among two or more surfaces. This can be accomplished by having
a single object with some concavity in its surface that’s exposed to the light source,
or at least two objects, and at least one object must be set to receive global
illumination (see mental ray Panel (Object Properties Dialog) on page 322).
Otherwise you’ll receive error messages and no photons will be stored.

Enable When on, the mental ray renderer calculates global illumination.
Default=off.

Multiplier/color swatch Use these to control the intensity and color of the
indirect light accumulated by global illumination. The defaults, 1.0 and white,
produce physically correct rendering.

This is useful for adjusting the contribution of the GI effect, thus improving
the quality of an image.

Maximum Num. Photons per Sample Sets how many photons are used to
compute the intensity of the global illumination. Increasing this value makes
global illumination less noisy but also more blurry. Decreasing this value
makes global illumination more noisy but less blurry. The larger the Samples
value, the greater the rendering time. Default=500.
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TIP To preview global illumination, set Samples to 100, then increase the value
for a final rendering.

Maximum Sampling Radius When on, the numeric value sets the size of
photons. When off, each photon is calculated to be 1/10 of the radius of the
full scene. Default=off, 1.0.

In many cases, the default photon size (Maximum Sampling Radius=off) of
one-tenth the scene size gives useful results. In other cases, the default photon
size might be too large or too small.

When photons overlap, the mental ray renderer uses sampling to smooth
them together. Increasing the number of samples increases the amount of
smoothing and can create more natural-looking caustics. When photons have
a small radius and don't overlap, the Samples setting has no effect. For global
illumination, photons should overlap. To get good results, you might need
to turn on Maximum Sampling Radius and increase the photon size.

Merge Nearby Photons (saves memory) Enables reduction of the memory
footprint of the photon map. When on, use the numeric field to specify the
distance threshold below which mental ray merges photons. The result is a
smoother, less-detailed photon map that uses significantly less memory.
Default=off, 0.0.

NOTE Loading a legacy file uses the default value of 0.0. Also, using a value of
0.0 is equivalent to turning the feature off.

Optimize for Final Gather (Slower GI) If turned on before you render the
scene, the mental ray renderer computes information to speed up the
regathering process. Specifically, each photon stores additional information
about how bright its neighbors are. This is particularly useful when combining
Final Gather with Global Illumination, in which case the additional
information allows Final Gather to quickly determine how many photons
exist in a region. The fast lookup computation can take a long time, but it can
greatly reduce the total rendering time. Default=off.

The fast lookup computation can be can be stored as additional data inside a
photon map file on page 8093, and then reused in subsequent renderings.

Volumes group

The controls in this group and the ones that follow are for the photon maps
on page 8090 used to calculate caustics and global illumination. This group
controls volumetric caustics. Volumetric caustics require a material to have a
volume shader assign to its Photon Volume component.
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Maximum Num. Photons per Sample Sets how many photons are used to
shade the volume. Default=100.

Maximum Sampling Radius When on, the numeric setting determines the
size of photons. When off, mental ray calculates each photon to be one-tenth
the size of the scene extents on page 8117. Default: off; value=1.0.

The numeric setting is unavailable when the check box is off.

Photon Map group

These controls tell mental ray how to calculate the photon map for indirect
illumination.

NOTE If you've specified a photon map here, mental ray continues to use that
map instead of generating a new one. To cause the photon map file to be rebuilt,
delete the existing file.

Read/Write File When on, if the specified photon map (PMAP on page 8093)
file does not yet exist, mental ray generates a new map file when rendering.
If the specified file does exist, mental ray loads and uses the file.

This option becomes available after you click Browse (“...”) and provide a
name for the PMAP file.

... [browse] Click to display a file selector dialog, which lets you specify a
name and path for the photon map (PMAP) file. This automatically turns on
Read/Write File.

[file name] When you have used the [...] button to specify a photon map file,
this field displays its name and path.

 Delete File Click to delete the current PMAP file.

 Generate Photon Map Now Processes the photon-mapping pass for
all animation frames (as specified in the Common Parameters rollout > Time
Output group on page 6124). Generates the photon maps to the specified file
without rendering the scene. To reduce flicker when rendering an animation
with a networked render farm, use this function first to generate the GI solution
for all frames, and then make sure Read/Write File (see preceding) is on before
rendering.
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Trace Depth group

The Trace Depth controls are similar to those for calculating reflections and
refractions, but they refer to the photons used by caustics and global
illumination, rather than to rays used in diffuse reflection and refraction.

Max. Depth Limits the combination of reflection and refraction. Reflection
and refraction of a photon stop when the total number of both equals the
Maximum Depth setting. For example, if Maximum Depth equals 3 and the
trace depths each equal 2, a photon can be reflected twice and refracted once,
or vice versa, but it can’t be reflected and refracted four times. Default=10.

Max. Reflections Sets the number of times a photon can be reflected. At 0,
no reflection occurs. At 1, the photon can be reflected once only. At 2, the
photon can be reflected twice, and so on. Default=10.

Max. Refractions Sets the number of times a photon can be refracted. At 0,
no refraction occurs. At 1, the photon can be refracted once only. At 2, the
photon can be refracted twice, and so on. Default=10.

Light Properties group

Controls in this group affect how lights behave when calculating indirect
illumination. By default, the energy and photon settings apply to all lights in
a scene. Use the mental ray Indirect Illumination rollout on page 5112 for light
objects to adjust an individual light either by multiplying the global values,
or by setting local values (using multipliers is the recommended method).

Average Caustic Photons per Light Sets the number of photons emitted by
each light for use in caustics. This is the number of photons in the photon
map on page 8090 used for caustics. Increasing this value increases the accuracy
of caustics, but also increases the amount of memory used and the length of
render time. Decreasing this value improves memory usage and render time,
and can be useful for previewing caustic effects. Default=10000.

Average GI Photons per Light Sets the number of photons emitted by each
light for use in global illumination. This is the number of photons in the
photon map used for global illumination. Increasing this value increases the
accuracy of global illumination, but also increases the amount of memory
used and the length of render time. Decreasing this value improves memory
usage and render time, and can be useful for previewing global-illumination
effects. Default=10000.

Decay Specifies how photon energy decays as it moves away from each light
source. This value is given by 1/(distancedecay), where distance is the distance
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between the light source and an object, and decay is the value of this setting.
Default=2.0.

The most common values are:

■ 0.0 The energy doesn't decay, and photons can provide indirect
illumination throughout the scene.

■ 1.0 The energy decays at a linear rate, proportionally to its distance from
the light. That is, a photon's energy is 1/distance, where distance is the
distance from the light source.

■ 2.0 (The default.) The energy decays at an inverse square rate. That is, a
photon's energy is the inverse of the square of the distance from the light
source: 1/distance2.

In the real world, light decays at an inverse square rate (Decay=2.0), but this
gives strictly realistic results only if you provide a realistic value for the energy
of the light. Other values of Decay can help you adjust indirect illumination
without worrying about physical accuracy.

NOTE Decay values of less than 1.0 are not recommended, and can cause
rendering artifacts.

Geometry Properties group

All Objects Generate & Receive GI and Caustics When on, at rendering
time, all objects in the scene can generate and receive caustics and global
illumination, regardless of their local object properties settings. When off, an
object's local object properties determine whether it generates or receives
caustics or global illumination. Turning this on is an easy way to ensure that
caustics and global illumination are generated, though it can increase rendering
time. Default=off.

This setting does not alter the object's local object properties settings for mental
ray. When you turn off All Objects Generate & Receive GI And Caustics, the
prior object properties settings are in effect once again.

Processing Panel

Rendering menu/main toolbar > Render Setup > Render Setup dialog >
Processing panel

Note: The Processing panel appears only when mental ray is the active renderer.
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The Processing panel is an additional Render Setup dialog on page 6067 panel
whose controls relate to managing how the renderer operates. It also lets you
generate diagnostic renderings in pseudo color.

Interface

The Processing panel contains three rollouts:

Translator Options Rollout (mental ray Renderer) on page 6316

Diagnostics Rollout (mental ray Renderer) on page 6324

Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6326
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Translator Options Rollout (mental ray Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog >
Processing panel > Translator Options rollout

Note: The Processing panel appears only when the mental ray renderer is the
currently active renderer.

Controls in this rollout affect the operation of the mental ray renderer with
respect to translation of the scene to the format the renderer requires. They
also let you save the translated scene to an MI file on page 8044, which you can
then use with a standalone renderer. The translated output uses the mental
ray version 3 (mi3) format. The translator does not support mental ray version
1 (mi1).

See also:

■ Distributed Bucket Rendering Rollout (mental ray Renderer) on page 6326

Procedures

To save the mental ray renderer settings:

■ When you have a set of rendering settings you want to keep, go to the
Render Setup dialog and open the Preset drop-down list at the bottom.
Choose Save Preset (at the bottom of the list), enter a file name, and click
Save. Next, use the Select Preset Categories dialog to highlight the parameter
categories to store in the preset and click Save. Thereafter you can choose
your custom setup from the Preset drop-down list.

To create a rendering from multiple passes:

1 Use the Render Type on page 6095 > Selected option to choose only a
portion of the scene to render.

2 On the Translator Options rollout, in the Render Passes group, click the
ellipsis [...] button next to Save.

3 A Save As dialog is displayed. Use it to enter a name and location for the
PASS file.

4 Click Render.

The partial rendering is saved in the PASS file you specified.
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5 Repeat steps 1 through 4 until you have generated all the passes for the
rendering (or all the passes but the last).

WARNING If your scene includes an environment, render it only in the final
pass. Rendering the environment in multiple passes is time consuming, and
can lead to artifacts such as unwanted color changes to the background.
Render all passes but the last one using a default black background.

6 In the Render Passes group, click Add to add the various pass files to the
list.

7 Turn on Merge.

At this point, you might also want to turn off Save, unless you want the
final result to be saved as a PASS file as well as a rendering.

8 Click Render.

The rendering consists of all the passes merged into one.

TIP For some purposes, you might want to create the passes, then create a new
3ds Max scene with no objects, set the rendering resolution to match the passes,
you created, then merge the passes as described in steps 7 and 8 above.
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Interface

Memory Options group

Use Placeholder Objects When on, 3ds Max sends geometry to the mental
ray renderer only on demand. Initially, the mental ray scene database is
populated only with the size (bounding box) and position of objects in the
3ds Max scene. When the mental ray renderer renders a bucket that contains
an object, the object's geometry is sent to the rendering engine only at that
point. Default=off.

This option can improve rendering speed when a large amount of the scene's
geometry is outside of the view you are rendering.
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TIP When you use placeholders, 3ds Max always calculates buckets in Hilbert
order on page 6276.

When the mental ray renderer is low on memory (as defined by the Memory
Limit setting), Use Placeholder Objects enables it to increase available memory
by deleting object geometry from the scene database. This can dramatically
reduce memory usage, but with a possible cost in rendering speed.

Memory Limit The mental ray renderer keeps a count of the memory it uses
at render time. If it reaches the specified memory limit and Use Placeholder
Objects (see preceding) is on, 3ds Max discards the geometry for some objects
in order to allocate memory for other objects. If Use Placeholder Objects is
off, or if after deleting geometry more memory is still needed, the renderer
releases texture-map memory as well. Default=650 MB.

TIP If you’d like to use a different Memory Limit setting on a regular basis without
having to change the value manually every time, store the value in a rendering
preset on page 6114 and then be sure to load that preset before rendering.

Use mental ray Map Manager When on, maps are read from disk and if
necessary, translated to a format that the mental ray renderer can read. When
off, maps are accessed directly from memory, and translation is unnecessary.
Default=off.

Following is a complete list of differences between turning this option on and
off:

When on:

■ mental ray reads textures directly from disk (mental ray is able to flush
textures out of memory when memory is low). Also, textures are loaded
only if needed.

■ mental ray uses its built-in pyramid filtering system. These pyramid lookup
tables can be flushed out of memory when memory is low.

■ Texture formats not supported directly by mental ray are read by 3ds Max
and sent, before rendering begins, as binary data to mental ray.

When off:

■ 3ds Max reads the textures from disk, and then sends individual pixel
colors to mental ray as they are needed.
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NOTE 3ds Max reads the textures from disk and keeps them stored in memory
between renders. This can make renders faster, because the bitmaps don’t
need to be reloaded every time. 3ds Max will not read the texture from disk
if it was already loaded previously (for example, in a previous render, for a
Material Editor preview, or for displaying the map in a viewport).

■ Rendering uses a pyramid filter shader that is identical to the standard 3ds
Max pyramid filter system.

Turning this option on is useful for large scenes that take a lot of memory to
render. Turning it off is quicker, because textures already loaded in memory
don’t have to be reloaded by mental ray. But turning it off might use more
memory and doesn’t allow for flushing when memory is low, unless you use
the 3ds Max bitmap pager on page 7768.

NOTE Turning the option on and off might result in very small differences between
rendered images because of the different algorithms used in the mental ray map
manager and the 3ds Max map manager.

You must turn on “Use mental ray Map Manager” when performing these
actions:

■ Using distributed bucket rendering.
See Distributed Bucket Rendering Rollout (mental ray Renderer) on page
6326.

When rendered with distributed bucket rendering and the mental ray map
manager, images with textures can look different than when rendered with
3ds Max alone, because the filtering technique is different.

■ Exporting to an MI file.
See below.

Conserve Memory Tells the translator to be as memory efficient as it can.
This can slow down the translation process, but reduces the amount of data
being sent to the mental ray renderer. Default=off.

This option is useful when you are trying to render a huge scene and time is
not necessarily an issue. When you render to an MI file, this option can also
help reduce the size of the output file.

When on, this toggle also tells the mental ray renderer to save frames as
temporary .map files. This allows you to render extremely large frames without
running out of random-access memory.
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The location of the temporary map files is chosen in the following order:

1 If the file \[program folder]\mentalray\rayrc contains a registry entry called
_MI_REG_FBDIR, the renderer uses this directory.

The entry should have the form

registry "{_MI_REG_FBDIR}" value "<path>" end registry

where <path> is the directory you want to use.

2 If the rayrc file has no registry entry, the renderer uses the directory
specified by the TMPDIR environment variable.

3 If there is no TMPDIR environment variable, the renderer uses the
directory specified by the TEMP environment variable.

 Geometry Caching group

Geometry caching lets you save the translated scene contents to a temporary
file for reuse in subsequent renders. This can save time by omitting the
translation step, especially with geometry-heavy scenes. Two levels of caching
are available: standard and locked.

Enable When on, rendering uses geometry caching. During the first render,
the translated geometry is saved to the cache file. Then, in subsequent
renderings of the same scene, the renderer uses the cached geometry for any
unchanged objects instead of retranslating it. Any changed geometry is
retranslated. Default=off.

This control is available on the Rendered Frame Window lower panel as Reuse
> Geometry on page 6082.

 Lock Geometry Translation When on, sub-object-level changes such
as vertex editing or adjusting a modifier such as Bend are ignored and don’t
cause retranslation. However, object-level changes such as moving or rotating
an object are retranslated.

This control is available on the Rendered Frame Window lower panel as Reuse

>  Lock Geometry Translation on page 6082 (  button).

Clear Geometry Cache Deletes the cached geometry.

This control is available on the Rendered Frame Window lower panel as Reuse
>  Clear Geometry Cache on page 6083.
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Material Override group

Material Override allows you to render a scene with all its materials replaced
by a single master material. For example, if you need to do a wireframe pass,
you can create a Wire material and then specify it here. When you render, all
surfaces will use the Wire material.

Enable When on, rendering uses the override material for all surfaces. When
off, surfaces are rendered with the material applied to them in the scene.
Default=off.

Material Click to display the Material/Map Browser on page 5290 and choose
a material to use as the override. Once you have chosen an override material,
this button displays the material name.

Export to .mi File group

These controls let you save the translated scene in a mental ray MI file on
page 8044. Before exporting, you must specify an export file by clicking the
ellipsis [...] button.

NOTE Exporting to an MI file is not available when you render to texture on page
6371.

Export on Render When on, saves the translated file to an MI file instead of
rendering when you click Render. Available only after you have clicked the
ellipsis [...] button to specify an MI file. Default=off.

Un-compressed When on, the MI file is not compressed. When off, the file
is saved in a compressed format. Default=on.

Incremental (Single File) When on, exports an animation as a single MI file
that contains a definition of the first frame and descriptors of the incremental
changes from frame to frame. When off, exports each frame as a separate MI
file. Default=off.

When you export an animation, turning on Incremental can save a
considerable amount of disk space.

■ ... [browse] Click to display a file selector dialog, which lets you specify
a name for the MI file, and the folder where it is saved.

■ File name After you've used the ellipsis [...] button to specify an MI file,
this field displays its name and path.
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Render Passes group

Controls in this group let you create a rendering out of multiple passes that
render portions a scene. This can be a useful way to render large scenes or
scenes that have complex effects. It can also be a way to divide the labor on
a composited (“merged”) rendering. See the “Procedures” section, above, for
more information.

NOTE You cannot render to passes when you render to texture on page 6371.

Save When on, saves the image currently being rendered (prior to merging)
inside the specified PASS file.

■ ... [browse] Click to display a file selector dialog, which lets you specify
a name for the PASS file and the folder where it is saved.

■ File name After you have specified a PASS file, the name field displays
its name and path.

If you are rendering a time segment (that is, an animation), the PASS files are
created with sequence numbers appended to the main file name (for example,
test0000.pass, test0001.pass, and so on).

Merge When on, the PASS files specified in the list will be merged into the
final rendering.

■ List of PASS files Lists the PASS files that will be merged into the final
rendering (possibly including the pass that is currently being rendered and
saved).

■ Add Click to add a PASS file to the list.
If you choose a PASS file with a sequence number appended to its name,
3ds Max asks if you want to use the individual file or the entire sequence.

■ Delete Click to delete the highlighted PASS file from the list.

Merge Shader Lets you choose the shader used to merge the PASS files. Clicking
the shader button displays a Material/Map Browser so you can choose the
shader (when a shader is chosen, its name appears on the button). When the
toggle is on, this shader is used for merging.

IMPORTANT No merge shaders are provided with 3ds Max. This option is provided
for users who plan to write a custom merge shader appropriate to their particular
compositing project.
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Mapping group

Skip Maps and Textures When on, rendering ignores maps and textures,
including projection maps, and uses only surface colors (diffuse, specular, and
so on). Default=off.

Turning off maps can be useful, and save time, when you are adjusting global
illumination.

Diagnostics Rollout (mental ray Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog >
Processing panel > Diagnostics rollout

Note: The Processing panel appears only when the mental ray renderer is the
currently active renderer.

The tools on the Diagnostics rollout can help you understand why the mental
ray renderer is behaving in a certain way. The Sampling Rate tool, in particular,
can help explain the renderer's performance.

Each of these tools generates a rendering that is not a photorealistic view, but
a schematic representation of the functionality you have chosen to analyze.

Interface

Enable When on, the renderer renders the graphic representation for the tool
you have chosen.
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Sampling Rate When chosen, renders an image that shows where samples
were collected during rendering; see Sampling (mental ray Renderer) on page
8112. This can help you adjust the contrast and other sampling parameters.

Coordinate Space Renders an image that shows the coordinate space of
objects, the world, or camera.

■ Object Shows local coordinates (UVW). Each object has its own coordinate
space.

■ World Shows world coordinates (XYZ). The same coordinate system
applies to all objects.

■ Camera Shows camera coordinates, which appear as a rectangular grid
superimposed on the view.

Size Sets the size of the grid. Default=1.0.

TIP To avoid busy moiré patterns in the grid, increase the value of Size.

Photon Renders the effect of a photon map in the screen. This requires that
a photon map be present (to render caustics or global illumination). If no
photon map is present, the Photon rendering looks just like the nondiagnostic
rendering of the scene: the mental ray renderer first renders the shaded scene,
then replaces it with the pseudocolor image.

■ Density Renders the photon map as it is projected into the scene. High
density is displayed in red, and lower values render in increasingly cooler
colors.

■ Irradiance Similar to the Density rendering, but shades the photons based
on their irradiance. The maximum irradiance is rendered in red, and lower
values render in increasingly cooler colors.

BSP Renders a visualization of the parameters used by the tree in the BSP
ray-trace acceleration method on page 6282. If a message from the renderer
reports excessively large depth or size values, or if rendering seems unusually
slow, this can help you locate the problem.

■ Depth Shows the depth of the tree, with top faces in bright red, and
increasingly deep faces in increasingly cool colors.

■ Size Shows the size of leaves in the tree, with differently sized leaves
indicated by different colors.

NOTE The BSP diagnostic works with the BSP method only; the BSP2 method
does not support it.
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Final Gather Renders the scene with pre-processing final-gather points
displayed as green dots, and tile-rendering (final render) final-gather points
displayed as red dots.

For animation purposes, the presence of red dots is undesirable. To resolve
this, use the Interpolate Over Num. FG Points setting on page 6300 instead of
the Radius Interpolation Method on page 6305, or, if you prefer the latter, keep
the Min. Radius setting as close as possible to the Radius setting; that is, the
maximum radius.

Distributed Bucket Rendering Rollout (mental ray
Renderer)

Rendering menu/main toolbar > Render Setup > Render Setup dialog >
Processing panel > Distributed Bucket Rendering rollout

Note: The Processing panel appears only when the mental ray renderer is the
currently active renderer.

Controls on this rollout are for setting up and managed distributed bucket
rendering. With distributed rendering, multiple networked systems can all
work on a mental ray rendering. Buckets are assigned to systems as they become
available.

While distributed bucket rendering can be used for offline rendering of
animation frames, as in standard network rendering, it's best suited for speeding
up the rendering of single images as you work. Especially when rendering
high-resolution still images, you can get much faster results with distributed
bucket rendering.

TIP When you use distributed bucket rendering, be sure to:

■ Turn on Use Placeholder Objects on the Translator Options rollout on
page 6316.
When placeholder objects are enabled, geometry is sent to the renderer
only on demand.

■ Leave Bucket Order set to Hilbert on the Sampling Quality rollout on page
6272.
With Hilbert order, the sequence of buckets to render uses the fewest
number of data transfers.

NOTE Contour shading does not work with distributed bucket rendering.
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NOTE You cannot use distributed bucket rendering when you render to texture
on page 6371.

IMPORTANT To use distributed bucket rendering, you must set up host systems
that are capable of running the mental ray renderer. There are two ways to do so:
set up satellite systems, or install mental ray standalone licensing on remote hosts.

Satellite Systems

“Satellite” processors allow any owner of a 3ds Max license to freely use up
to eight slave CPUs to render an image using distributed bucket rendering
(not counting the one, two, or four processors on the “master” system that
runs 3ds Max).

Each satellite system must have the following files installed:

■ rayrc

■ raysat_3dsmax<X>.bat

■ raysat_3dsmax<X>.exe

■ raysat_3dsmax<X>server.exe

where <X> is the current 3ds Max version number.

You can use the 3ds Max installation program to install these files: see the
Installation Guide for more information.

In addition, information about each satellite should be stored in the RAYHOSTS
file on page 8104. You can set up satellite systems by using the Add button on
the Distributed Bucket Rendering rollout, as described in the “Interface”
section, below.

Host Systems with SPM Licenses

When you use mental ray SPM licenses, remote hosts (that is, all systems other
than the one running 3ds Max) must have the mental ray renderer (ray.exe)
and a mental ray SPM license server running. To obtain this, you must run
the mental ray installer on all remote hosts, then configure and run the SPM
license server. Instructions about how to do so are provided with the mental
ray renderer sold by mental images.

Once the remote hosts have been configured to run a licensed instance of
ray.exe, you can use them for distributed rendering simply by naming them
in the RAYHOSTS file on page 8104. You can add hosts to the RAYHOSTS file
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using the Add button described in the “Interface” section, below, just as you
would add a satellite processor.

Batch Rendering (Using Backburner or the Command Line)

You can launch distributed bucket rendering from the command line, using
3dsmaxcmd.exe.

If you use satellite processors, you cannot use Backburner to manage distributed
bucket rendering. When host processors have SPM licenses, you can use
Backburner to manage distributed bucket rendering.

You can use the environment variable MRMAX_OFFLINE_DBR_OVERRIDE to
control whether batch rendering uses distributed bucket rendering. The state
of this variable overrides the “DBR enable” flag. If it is set to “yes,” “true,” or
“on,” distributed bucket rendering is enabled; if it is set to “no,” “false,” or
“off,” distributed bucket rendering is disabled. All other values of this variable
are ignored.

See also:

■ Translator Options Rollout (mental ray Renderer) on page 6316

Procedures

To use mental ray distributed rendering:

1 On the Render Setup dialog, go to the Processing panel. On the Distributed
Bucket Rendering rollout, turn on Distributed Render.

NOTE The Net Render option on the Common Parameters rollout has no
effect on distributed bucket rendering.

2 Click to select the names of those satellite or host systems you want to
use for distributed rendering.

You can click All to select all the host names in the list, or None to select
none of the hosts.

3 If other host systems have maps installed on them, with exactly the same
file names and path names as on your local host, turn on Distributed
Maps.

With Distributed Maps turned on, remote renderers can use their local
copy of maps, which saves time.
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4 Render the scene.

Each system renders the buckets assigned to it. The final rendering appears
on your local system, with buckets “arriving” in an indeterminate order.

Example: To use mental ray distributed bucket rendering with Backburner:

This procedure demonstrates how to multiply the number of CPUs used for
rendering without having to purchase mental ray standalone licenses, using
the 3ds Max satellite technology.

If you have a few machines with 3ds Max licensed, and many machines
without, you can use both the distributed rendering technology and
Backburner so a rendering job would use 10 CPUs per Backburner server,
thereby increasing the rendering speed.

For the purpose of this procedure, we're using a render farm comprising three
machines named A, B, and C, each running a licensed copy of 3ds Max.

NOTE The number of machines you can use depends on the number of machines
running licensed copies of 3ds Max. You are able to use only eight external (or
satellite) CPUs per licensed copy of 3ds Max: four dual-processor machines or
eight single-processor machines (or equivalent).

1 Choose which machines (other than machines A, B, and C) will serve as
satellites, install 3ds Max on each, and write down each machine's IP
address.

2 Use the Windows Notepad program or a text editor to open the
max.rayhosts file on machine A, located in mentalray subdirectory within
the program folder.

3 In the max.rayhosts file, under the “localhost” entry enter the IP address
of each satellite CPU to be used; up to eight in all (see Figure 1).

Figure 1 - Example of a rayhost file
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4 Repeat the previous step on machines B and C with the remaining IP
addresses.

5 Launch Backburner Manager on the machine submitting the job or any
other machine. Launch the Backburner Server on machines A, B, and C.

WARNING It is necessary for the machine running the Backburner Server to
have 3ds Max licensed. A mental ray standalone license will not enable you
to use the distributed bucket rendering feature, and Backburner will prompt
you with a license error.

6 On the machine submitting the job choose mental ray as the renderer,
and then turn on Use Placeholder Objects, Use mental ray Map Manager
(see Figure 2), and the Distributed Render (see Figure 3).

Figure 2 – Translator Options
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Figure 3 – Distributed Bucket Rendering

7 Submit the job to the Backburner network rendering farm.

The job is submitted to the network rendering farm and is picked up by
machines A, B, and C. Each machine uses its internal CPU as well as its
satellite CPUs to render the job.
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Interface

Distributed Render When on, the mental ray renderer can use multiple
satellite or host systems for distributed rendering. The list specifies which
systems to use. Default=off.

NOTE The Net Render option on the Common Parameters rollout has no effect
on distributed bucket rendering.

The other distributed rendering controls are unavailable unless Distributed
Render is on.

Distributed Maps When on, specifies that all texture maps can be found on
each of the slave machines doing distributed rendering. This saves time by
avoiding the necessity for mental ray to distribute all the maps to each slave
via TCP/IP. When off, specifies that all maps used in rendering reside on the
local system; that is, the system on which you start rendering. Default=off.

If Distributed Maps is on but the maps are not found on the slaves, those maps
simply will not render on the slaves, and rendered output will be incorrect.
Also, an error message will appear in the mental ray message window.

If you are doing local rendering only, this setting has no effect.

Maps on all systems in distributed rendering must have exactly the same name
and directory path.
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[name field] Displays the RAYHOSTS file's on page 8104 name and path.

[list of hosts] After you choose a RAYHOSTS file, this list shows the host
systems available for distributed mental ray rendering. You can use this list
to choose only those hosts you want to use for this particular rendering. When
you render with Distributed Render on, the mental ray renderer uses only the
hosts whose names are highlighted in this list. Click a host name to select it.
To deselect a selected host name, click it again.

NOTE The RAYHOSTS file, and therefore the host list, can contain duplicate entries.
However, before you render you must select only processors that are not duplicates;
otherwise, at render time 3ds Max will display an error message.

If Distributed Render is on but the list of hosts is empty when you click Render,
3ds Max will not perform distributed bucket rendering.

All Highlights all system names in the hosts list.

None Clears the highlight from all system names in the hosts list.

Add Click to display an Add/Edit DBR Host dialog on page 6334, which lets you
add a host processor to the RAYHOSTS file.

Edit Click to display the Add/Edit DBR Host dialog on page 6334, and edit the
highlighted host processor's entry in the RAYHOSTS file. Available only when
a single list entry is highlighted.

Remove Click to remove the currently highlighted host processors from the
list and the RAYHOSTS file. Available only when one or more list entries are
highlighted.

Clicking Remove displays a Remove Selected Hosts dialog, which warns you
that the host descriptors will be removed from both locations:

To restore a host that you have removed, use the Add button once again.
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Add/Edit DBR Host Dialog

The Add/Edit DBR (Distributed Bucket Rendering) Host dialog opens when
you click Add on the Distributed Bucket Rendering rollout on page 6326. It lets
you add a host (or “satellite”) processor to use when you render using
distributed buckets. As the text on the dialog reminds you, the new host is
added to the text of the RAYHOSTS file on page 8104.

Interface

Port Number Lets you enter a port number for the processor. This control is
unavailable unless you turn off Use Default Port. When Use Default Port is
off, the default port value appears in this field.

Name or IP Address Enter the name or the numeric IP address of the processor
you want to add.

Use Default Port When on, 3ds Max assigns a port number to the new
processor. The Port Number control is unavailable while Use Default Port is
on. Default=on.

VUE File Renderer

Rendering menu > Render Setup > Render Setup dialog > Common panel >
Assign Renderer rollout > Choose VUE File Renderer as the active production
renderer. > Renderer panel > VUE File Renderer rollout
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The VUE File Renderer creates VUE (.vue) files. VUE files on page 8165 use an
editable ASCII format.

Procedures

To create a .vue file:

1 Use the Render Setup dialog > Assign Renderer rollout to assign the VUE
File Renderer as the Production renderer.

You can't assign the VUE File Renderer to be the ActiveShade renderer.

2 Activate a camera viewport.

NOTE You must render from a camera viewport in order to include the
coordinates for the camera itself.

3 Use the VUE File Renderer rollout to specify a file name.

4 Render the scene.

The VUE file is written to disk. The Rendered Frame Window on page
6073 is displayed, but it doesn't display an image.

Interface

... [Browse] Click to open a file selector dialog and then specify a name for
the VUE file to create.

[File name The text field displays the name of the file.

Rendering Elements Separately
Rendering to elements lets you separate various types of information in the
rendered output into individual image files. This can be useful when you work
with some image-processing, compositing, and special-effects software.

Rendering Elements Separately | 6335



Render Elements Panel and Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout

This topic describes the available types of render elements and how to use
them.

These are the elements you can choose to render separately:

■ Alpha: A grayscale representation of the alpha channel, or transparency,
of the scene. Transparent pixels appear in white (value=255) and opaque
in black (value=0). Translucent pixels appear in gray. The darker the pixel,
the more transparent it is.
The alpha channel can be useful when you composite elements.

■ Atmosphere: The atmospheric effects in the rendering.

■ Background: The background of the scene.
Other elements do not include the scene background. Include this element
if you want to use the background in compositing.

The background is not trimmed against geometry, so elements should be
composited over the background. See Compositing Rendered Elements on
page 6342.

■ Blend: A custom combination of the previous elements.
The Blend element displays an additional Blend Element Parameters rollout
on page 6355.

■ Diffuse: The diffuse component of the rendering.
The Diffuse element displays an additional Diffuse Texture Element rollout
on page 6370.

■ Hair and Fur: The component of the rendering created by the Hair and Fur
modifier on page 1119. See Hair and Fur Render Element on page 6356.

■ Illuminance HDR Data: Generates an image containing 32–bit floating-point
data that can be used for analyzing the amount of light that falls on a
surface perpendicular to its normal. The illuminance data ignores material
characteristics such as reflectance and transmittance.
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Illuminance is not related to surface properties.

For best results, render with mental ray or another renderer that supports
32–bit floating-point output and set the output format to PIC, HDR, or
EXR. If using the scanline renderer or another renderer that doesn't support
32–bit floating-point output, set the Scale Factor parameter, which acts as
a multiplier, to adjust the range of values for the output data.

■ Ink: The Ink component (borders) of Ink 'n Paint materials on page 5742.

■ Lighting: The effect of direct and indirect lights and shadows in the scene.
The Lighting element displays an additional Lighting Texture Element
rollout on page 6356.

■ Luminance HDR Data: Generates an image containing 32–bit floating-point
data that can be used for analyzing the perceived brightness of a surface
after light has been “absorbed” by the material of the surface. The
luminance data considers material characteristics such as reflectance and
transmittance.
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Luninance takes surface properties into account.

For best results, render with mental ray or another renderer that supports
32–bit floating-point output and set the output format to PIC, HDR, or
EXR. If using the scanline renderer or another renderer that doesn't support
32–bit floating-point output, set the Scale Factor parameter, which acts as
a multiplier, to adjust the range of values for the output data.

■ Material ID: Retains the material ID information assigned to an object.
This information is useful when you are making selections in other
image-processing or special-effects applications, such as Autodesk
Combustion. For example, you could select all of the objects with a given
material ID in Combustion. The material ID corresponds to the value you
set for the material with the material ID channel. Any given material ID
will always be represented by the same color. The correlation between a
specific material ID and a specific color is the same in Combustion. See
Material ID Channel  on page 5348.

■ Matte: Renders a matte mask, based on selected objects, material ID channel
(effects IDs), or G-Buffer IDs.
The Matte element displays an additional Matte Texture Element rollout
on page 6357.

■ mr A&D: These elements render various components of the Arch & Design
material to HDR compositors such as Autodesk Toxik. For details, see  mr
A&D Elements on page 6358.
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■ mr Labeled Element: Renders a branch of a map tree that you specify using
a label. For details, see  mr Labeled Element Parameters Rollout on page
6363

■ mr Shader Element: Outputs the raw contribution of any mental ray shader
in the scene. This includes standard 3ds Max materials and maps that are
converted to mental ray shaders in the translation process. For details, see
mr Shader Element Parameters Rollout on page 6365

■ Object ID: Retains the object ID information assigned to the object.
Roughly comparable to the material ID, the object ID information is useful
for selecting objects based on an arbitrary index value in another
image-processing or special-effects application. If you know that you will
want to select several objects at once, at a later time, you can assign them
all the same object ID in 3ds Max. By rendering with the object ID, this
information will be available in other applications.

You assign the object ID with the Object Properties dialog > General panel
> Object Channel parameter on page 315. A given object ID is always
represented by the same (arbitrary) color. The correlation between a specific
material ID and a specific color is the same in Combustion.

When an Object ID entry is highlighted in the element rendering list on
page 6347, the Object ID Element rollout appears on the Render Elements
panel. This rollout lets you choose whether to base the render color of a
given object ID on the object color or the Object ID. If you choose Object
Color, the render color is the object's base color, as shown on the Create
panel > Name And Color rollout and at the top of the other command
panels, and is not based on the Object ID. If you choose Object ID, an
arbitrary color is assigned to each object based on its Object ID.

■ Paint: The Paint component (surfaces) of Ink 'n Paint materials on page
5742.

■ Reflection: The reflections in the rendering.

■ Refraction: The refractions in the rendering.

■ Self-Illumination: The self-illumination component of the rendering.

■ Shadow: The shadows in the rendering. This element saves black-and-white
shadows only. See Compositing Rendered Elements on page 6342.

NOTE The mental ray renderer does not include shadows created by global
illumination on page 6306and final gathering on page 6295 in the Shadow render
element output.
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■ Specular: The specular component of the rendering.

■ Velocity: The motion information which can be used in other applications
for things such as creating motion blur or retiming an animation.
The Velocity element displays an additional Velocity Element Parameters
rollout on page 6367.

■ Z Depth: A grayscale representation of the Z depth, or depth within the
view, of objects within the scene. The nearest objects appear in white, and
the depth of the scene in black. Intermediate objects are in gray, the darker
the deeper the object is, within the view.
The Z Depth element displays an additional Z Element Parameters rollout
on page 6369.

When you render one or more elements, a normal complete rendering is also
generated. In fact, the element renderings are generated during the same
rendering pass, so rendering elements costs little extra render time.

Rendering to elements is available only when you do production rendering
with the default scanline renderer on page 6141 or the mental ray renderer on
page 6230.

NOTE The default scanline renderer supports a maximum of 32 render elements
per scene. The mental ray renderer does not limit the number of render elements.
If you're using a third-party renderer, check the product documentation for a
possible limit on the number of render elements.

NOTE When using the default scanline renderer, Antialiasing on page 6146 must
be on in order to render elements. With Antialiasing off, rendering elements is
disabled.

Example

Here is a rendering of a fountain, against a checkered background, and various
elements.
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On the right is the fully rendered fountain.

On the left, from top to bottom, are diffuse, specular, shadow, and reflection elements.

Two more elements not directly related to the objects in the scene, but important
when compositing the image to other sources:

on the left is the background, on the right is the alpha channel.
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On the left is an atmosphere element, in this example, a light fog on the back side of
the fountain.

On the right is the Z-depth. The fog uses the depth of the image and objects to
determine its density. The Z-depth element contains these depth values.

Compositing Rendered Elements

In general, you can composite elements using additive composition, which
is independent of the compositing order.

The main exceptions are the background element, atmospheres, and shadows.

■ Background: The background is not trimmed against geometry, the
background should be composited under the other elements.

■ Atmosphere: The atmosphere element should be composited over all other
elements.

■ Black-and-white shadows: Black-and-white shadows should be composited
over the rest of the image (aside from the atmosphere), to dim color in the
shadowed areas. This technique does not take colored lighting into account.

In other words, the layers when you composite using black-and-white shadows
appear like this:

Top: Atmosphere

Second from top: Shadow element

Middle: Diffuse + Specular + ... (other elements)

Bottom: Background
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"Screen" Compositing for Specular and Reflection Elements

The other exception to additive composition is when specular or reflection
elements have been generated by certain material shaders. These shaders
generate specular and reflection elements you must composite differently:

■ Anisotropic

■ Multi-Layer

■ Oren-Nayar-Blinn

Shaders are assigned on a per-material basis, in the Material Editor. If you
render specular or reflection elements in a scene that uses these shaders, then
composite them with the diffuse and other foreground components (aside
from colored shadows, as described above), by overlaying them using an
operation called "Screen" in some compositing programs.

Screen compositing uses this formula to combine elements:

Background * (1 - Foreground) + Foreground

The background is multiplied by the inverse of the foreground color, and then
the foreground color is added to the result.

For more information, see the documentation for the compositing program
you use.

Procedures

To have the Render Elements dialog assign names to the rendered element
files automatically:

1 Assign an output file name and file type for the (entire) rendered scene
using the Files buttonFiles on page 6129 on the Common Parameters rollout
of the Render Setup dialog.

2 On the Render Elements rollout, use the Add button to specify elements
for rendering (see following procedure).

To render elements to files without rendering the entire scene to a file, follow
this procedure, and then turn off Common panel > Common Parameters
rollout > Render Output group > Save File.

To add an element for rendering:

1 Click Add.
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2 On the Render Elements dialog, do one of the following:

■ Highlight the name of an element, and then click OK.

■ Double-click the name of an element.
If you have assigned a file name for the entire rendering, the new
element is assigned a file name automatically. Otherwise, use the Files
button in the Selected Element Parameters group to assign an output
file name and file type for the element rendering.

3 If the element is one (such as Blend or Z Buffer) that has additional
parameters, adjust these parameters in the appropriate rollout.

To render the separate elements:

1 Add the elements you want to render.

TIP You can use the Enable button (in the Selected Element Parameters
rollout) to disable individual elements for a particular rendering pass.

2 If you haven't assigned file names automatically (see the first procedure,
preceding), use the Browse [...] button in the Selected Element Parameters
group to assign an output file name and file type for the element
rendering.

3 Make sure Elements Active (at the top of the Render Elements rollout) is
turned on, and then click Render to render the scene.

The rendered elements are also displayed on the desktop, each in its own
window. (The windows cascade on top of each other.)

To generate a Combustion™ workspace (CWS) file that contains the rendered
elements:

1 In the Output to Combustion group, turn on Enable.

If you have assigned a file name for the entire rendering, the new element
is assigned a file name automatically. Otherwise, use the Files button in
the Output to Combustion group to assign an output file name for the
CWS file.

2 If you want to change the file or pathname click ... [ellipsis].

3 Do one of the following:

■ Render the scene. The CWS file is created at the time of the rendering.

■ Create Combustion Workspace Now.
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Use this button to create a Combustion workspace at any time. You
do not have to render for the workspace to be created.

NOTE This only works if there is at least one Render Element selected
and if your Render Output file type (set on the Common panel) is AVI,
RPF, CIN, JPG, PNG, MOV, RGB, RLA, TGA, TIF, or EXR.
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Interface

Add Click to add a new element to the list. This button displays the Render
Elements dialog on page 6349.

6346 | Chapter 20   Rendering



Merge Click to merge the render elements from another 3ds Max scene. Merge
displays a file dialog so you can select the scene file to get the elements from.
The list of render elements in the selected file is added to the current list.

Delete Click to delete the selected elements from the list.

Elements Active When on, clicking Render renders the separate elements.
Default=on.

Display Elements When on, each rendered element is displayed in its own
window, which is a feature-reduced version of the Rendered Frame Window
on page 6073. When off, the elements are rendered to files only. Default=on.

The windows for each rendered element open cascaded on top of each other.
Move one element's window to see another's.

Element Rendering list

This scrollable list shows the elements to render separately, and their status.
To resize the columns in the list, drag the border between two columns.

The list includes the following columns:

Name Shows the name o f the element. You can change the default name of
elements, in the Selected Element Parameters group.

To select an element, click its name in the list. Use Ctrl+click to select additional
elements, or Shift+click to select a contiguous group of additional elements.

Enabled Shows whether the element is enabled.

Filter Shows whether the active antialiasing filter is enabled for the element.

Type Shows what type of element this is.

This field is useful if you have changed the name of an element.

Output Path Shows the path and file name for the element.
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Selected Element Parameters group

These controls are for editing selected elements in the list.

Enable Turn on to enable rendering the selected elements. Turn off to disable
rendering. Default=on.

The Enabled column of the elements list shows whether or not an element is
enabled.

Enable Filtering When on, applies the active antialiasing filter on page 6146
to the rendered element. When off, the rendered element does not use the
antialiasing filter. Default=on.

The Filter column of the elements list shows whether or not the filter is enabled
for an element.

Disabling antialiasing can improve rendering time, although the rendered
element that results might appear jagged.

NOTE Turning off Enable Filter disables only general antialiasing and map filtering.
Edge blending still occurs when this switch is off.

Name Shows the name of the currently selected element. You can type in a
custom name for the element.

This control is unavailable when multiple elements are selected.

[...] (Browse) The text box lets you enter a path and file name for the element.
Alternatively, click the [...] ( ellipsis) button to open the Render Element
Output File dialog on page 6350, which lets you choose a folder, file name, and
file type for the element.

This control is available only when a single element is highlighted.

NOTE If you first assign a file name and path for the complete rendering on the
Render Setup dialog > Common Parameters rollout on page 6121, the render
elements feature uses this name and path automatically as the basis for names of
the various elements. It appends an underscore (_) and then the name of the
element to the basic file name.

For example, if the render file name is "C:\render\image.jpg", when you add a
Specular render element, the default path and file name for the rendered
specular element is "C:\render\image_specular.jpg".

Similarly, when you enable output to a Combustion workspace (CWS) file on
page 7329, the file name you assigned is the default name of the CWS file.

For example, if the render file name is "C:\image.jpg", when you enable
Combustion output, the default path and file name is "C:\image.cws".
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Output to Combustion group

When on, generates a Combustion Workspace (CWS) file on page 7329 that
contains the elements you are rendering. You can use this file in the
Combustion software, and you can use Combustion workspaces in the
Combustion map on page 5811.

WARNING If you are rendering elements to composite over a background, make
sure that the file format for the Diffuse, Shadows, and Alpha elements supports
an alpha channel. The formats we recommend for this purpose are: RLA on page
7364, RPF on page 7366, PNG on page 7360, or TGA on page 7370.

WARNING 3ds Max supports some file types that Combustion does not. For use
with Combustion, do not render elements as EPS files. If you render to this format,
the CWS file is not saved. See your Combustion documentation for more
information on supported file formats.

Enable When on, creates a CWS file that contains the elements you have
rendered.

[...] (Browse) The text box lets you enter a path and file name for the CWS
file. Alternatively, click the [...] (ellipsis) button to open the Save To
Combustion dialog, which lets you choose a folder and file name for the CWS
file.

Create Combustion Workspace Now When clicked, creates a Combustion
workspace (CWS file). This button makes it possible to create a Combustion
workspace without rendering.

NOTE You must add at least one render element for this file to be created and
the Render Output type on the Common panel must be set to AVI, RPF, CIN, JPG,
PNG, MOV, RGB, RLA, TGA, TIF, or EXR.

Render Elements Dialog

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout > Add button > Render Elements
dialog

This dialog lets you choose elements to render.
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Procedures

To choose an element to render separately, do one of the following:

■ Highlight the element's name in the list, and then click OK.

■ Double-click the element's name in the list.

To highlight multiple elements, do any of the following and then click OK:

■ To highlight non-contiguous elements, click an element's name in the list,
and then Ctrl+click further elements.

■ To highlight contiguous elements, drag from the first to the last.

■ To highlight contiguous elements, click the first element's name in the
list, and then Shift+click another element.

Interface

The scrolling list shows the names of elements you can render separately.
These are described in Render Elements Panel and Rollout on page 6336.

Render Element Output File Dialog

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements Rollout > Selected Element Parameters
group > Browse ([...]) button

The Render Element Output File dialog lets you assign a name to a file that
saves one element of the rendering. You can also determine the type of file
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to render, and set up options such as compression, color depth, and quality,
depending on the file type.

See also:

■ Image File Formats on page 7324

Procedures

To specify the render element output file and its settings:

1 Choose Rendering > Render Setup, and then, on the Render Elements
rollout, in the Selected Element Parameters group, click the Browse ([...])
button.

The Render Element Output File dialog opens.

2 In the File Name field, enter the name for the file to be rendered.

3 Navigate the Save In field to choose the directory where you want the
rendered file to be saved.

4 In the Save As Type field, choose the type of file you want to render.

5 Click Save to open the Setup dialog for the specified output file type.

Thereafter, the Setup button becomes available on the Render Element
Output File dialog; you can click this to change the settings.

6 Change any settings as necessary, and then click OK to close the Render
Element Output File dialog. Alternatively, clicking Cancel returns you to
the Render Element Output File dialog.

7 Click Render to render and save the file.
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Interface

History Displays a list of the most recent directories searched. Whenever an
image is selected, the path used is added to the top of the history list as the
most recently used path.

The history information is saved in the 3dsmax.ini on page 83 file.

Save In Opens a drop-down list to browse other directories or drives.

 Up One Level Moves to the next-highest level in the directory structure.

 Create New Folder Lets you create a new folder while in this dialog.

 View Menu Provides several options for how information is displayed
in the list window:

■ Thumbnails: Displays the contents of a directory as thumbnails, without
the details.

■ Tiles: Displays the contents of a directory as large icons, without the details.
If you widen the dialog, these tile across the width.
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■ Small Icons: Displays the contents of a directory as small icons, tiled across
the width, without the details.

■ List: Displays the contents of a directory without the details.

■ Details: Displays the contents of a directory with full details such as size
and date.

List of files Lists the contents of the directory, in the format specified by the
View menu.

TIP When the active display format is Details, the contents of the directory are
displayed with Name, Size, Type, Date Modified, and Attributes. You can sort the
list according to a column's contents by clicking that column's label.

File Name Displays the file name of the file selected in the list.

Save as File Type Displays all the file types that can be saved. This serves as
a filter for the list.

NOTE The choice in this field determines the file type saved, regardless of the
extension entered in the File Name field.

Save Sets the file information for saving upon rendering. Closes the dialog if
you haven't changed the output file type.

If you've changed the file type, clicking Save opens the Setup dialog for the
specified file type. Change the settings as necessary, and then click OK to close
both the Setup and the Output dialogs, or click Cancel to return to the Output
dialog.

Cancel Cancels the selection and closes the dialog.

Devices Lets you choose the hardware output device, for example, a digital
video recorder. To use this function, the device, its driver, and its 3ds Max
plug-in must all be installed on your system.

Setup Click to open a dialog with controls for the output file type. These vary
with each different file format.

NOTE The Setup button becomes available after you specify a file name or type.
If you first choose a type from the Save As Type drop-down list, click anywhere
on the dialog to activate Setup. If you first enter a file name and extension (such
as test.png), press Tab to activate Setup. Also, clicking Setup uses the filename
extension, even if it doesn't agree with the Save As Type setting.
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Info Displays expanded information about a highlighted file such as frame
rate, compression quality, file size, and resolution. The information available
depends on the file type.

View Displays the file at full resolution. If the file is a movie, Windows Media
Player opens to play the file.

Sequence This is not available in the Render Element Output File dialog.

NOTE To render a sequence of still images, choose the Active Time Segment or
define a range of frames on the Common Parameters rollout of the Render Setup
dialog. If you are rendering to a still-image file type, the software appends a
four-digit frame number to the file name name, incremented with each frame.

Preview When on, enables display of the image as a thumbnail in the Image
Window.

Image Window Displays a thumbnail of the selected file, when Preview is
turned on.

Gamma group

To set up gamma options for the output file, Enable Gamma Correction must
be on in the Gamma panel on page 7758 of the Preferences dialog (Customize
> Preferences > Gamma). Otherwise, the Gamma controls are unavailable in
the Render Output File dialog.

■ Use Image’s Own Gamma This option is not available in this dialog.

■ Use System Default Gamma Uses the system default gamma, as set on
the Gamma panel of the Preferences dialog on page 7758.

■ Override Defines a new gamma for the bitmap that differs from the
system default.
Using Override is not recommended for element bitmaps. Using the system
default gamma value ensures that all elements have consistent renderings.

Statistics/Location

Statistics Displays the resolution, color depth, file type, and number of frames
of the highlighted file.

Location Displays the full path and name of the highlighted file.
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Blend Element Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout > Add button > Render Elements
dialog > Add Blend element to the elements list (or select an existing Blend
element in the list).

The Blend element is a custom combination of several other elements. By
default, all elements are turned on in this rollout, and the Blend rendering is
identical to the full, normal rendering, except for the scene background. Use
the check boxes to choose your own combination of elements to appear in
the Blend rendering.

Interface

Ambient When on, include the ambient color component. Default=on.

Diffuse When on, include the diffuse color component. Default=on.

Specular When on, include the specular color component. Default=on.

Self-Illumination When on, include self-illumination. Default=on.

Reflection When on, include reflections. Default=on.

Refraction When on, include refractions. Default=on.

Apply Atmosphere When on, include atmospheric effects. Default=on.

Apply Shadows When on, include shadows. Default=on.

Paint When on, include the Paint component of Ink 'n Paint materials on
page 5742. Default=on.

Ink When on, include the Ink component of Ink 'n Paint materials.
Default=on.
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Hair and Fur Render Element

Rendering menu/main toolbar > Render Setup > Render Elements panel > Add
> Render Elements dialog > Hair and Fur

The Hair And Fur render element produces an additional image that depicts
only the elements in the scene generated by the Hair And Fur modifier on
page 1119. This image can be used for compositing.

NOTE The Hair And Fur render element supports only the ”buffer” rendering
method on page 6590 using the default scanline and mental ray renderers.

Lighting Texture Element Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout > Add button > Render Elements
dialog > Add Lighting element to the elements list (or highlight an existing
Lighting element in the list).

The lighting element contains the effects of lighting within the scene,
including color, shadows, direct and indirect light.

This rollout lets you determine which parts of the lighting are included in the
rendering.

Interface

Direct Light On  When on, the render element includes information from
any direct lights in the scene. The light’s color and projection map should
appear.

NOTE The final color for direct lighting takes surface normals into consideration.
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Indirect Light On  When on, the render element includes information from
ambient or bounced lighting in the scene.

NOTE When using radiosity, expect effects such as color bleed.

Shadows On  When on, the render element includes shadows.

Matte Texture Element Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout > Add button > Render Elements
dialog > Add Matte element to the elements list (or highlight an existing Matte
element in the list).

The Matte render element displays a matte mask for a selected object, material
effects channel (effect ID) on page 5348, or G-Buffer ID on page 7991. Each
matching element is represented with a white pixel on the mask.

For more info on matte behavior, see Matte Object on page 8042.

WARNING The Matte render element does not work for objects to which the
mental ray material on page 5638 is applied.

Interface

Effect ID  Sets the material effects channel on page 5348 to include in the Matte
render element.

G-Buffer ID Sets the G-Buffer ID on page 7991 to include in the Matte render
element.

Include  Opens the Exclude/Include dialog on page 5096, where you can select
objects in the scene to exclude or include in your Matte mask.
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When including, all selected objects are rendered with white pixels.

When excluding, all pixels are white, by default. Selected objects are rendered
as black pixels.

WARNING If you use Exclude, make sure the Effect ID and G-Buffer ID parameters
are not on. These modes provide inferior results when used in combination.

 mr A&D Elements

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout > Add button > Render Elements
dialog > Add one or more mr A&D elements to the elements list (or highlight
an mr A&D entry in the list).

NOTE As their names suggest, these render elements pertain only to objects to
which the Arch & Design material on page 5544 is applied, rendered with mental
ray.
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The mr A&D elements let you specify as render elements the most important
components of the Arch & Design material on page 5544, generally in three
different contribution types: raw, level, and output. You can save these as
HDR image files for subsequent compositing in a program such as Autodesk
Toxik.

With most of the elements, raw is the unscaled contribution, and level is the
scaling, and the output component, calculated by multiplying the raw and
level components, is the resultant contribution of the element to the full
rendered output. The level is often related to an input parameter (or
combinations thereof), and has been modified to abide by the
energy-conservation feature of the Arch & Design material.

Hence the elements contain some redundancy: For example, if you just want
the current reflections in a separate channel, use the Output Reflections
element, but if you want more control over the amount of reflections in
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post-production, you can instead use Raw Reflections and Level Reflections,
multiplying them (with optional, additional processing) in the compositing
phase prior to adding them to the final color.

Reflections: Raw (left) * Level (center) = Output (right)

NOTE In order to maintain a correct compositing equation, the effects of the mr
Photographic exposure control on page 6744 are intentionally excluded from the
A&D render elements output.

TIP When rendering mr A&D elements for compositing in an HDR application
like Toxik, be sure to set Frame Buffer Type on page 6277 to Floating-Point (32 bits
per channel), which allows raw-element values to exceed 1.0, and save output
files in the OpenEXR format on page 7349.

List of All Outputs

Following is a list of all available render elements for the Arch & Design
material (each has the “mr A&D” prefix):

■ Output: Beauty The main, blended output. It is identical to the single
output of the Arch & Design material.

■ Diffuse Direct Illumination Output is the resulting diffuse on page 5547
component after lighting, including textures. Raw is the diffuse lighting
itself, without textures, and Level Diffuse is the diffuse texture color
adjusted by the energy conservation.

■ Diffuse Indirect Illumination Output is the resulting indirect illumination,
including ambient occlusion on page 5564 effects, multiplied by the diffuse
color. Raw is the raw result from indirect illumination. There is no Level
component.

■ Ambient Occlusion Raw is the raw contribution of the ambient occlusion
on page 5564.
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■ Diffuse Indirect Illumination with AO Xtra is the indirect illumination
affected by ambient occlusion but without being multiplied by the diffuse
color.

■ Opacity Output (Opacity Background) is the final contribution of any
background of the object as a result of the input cutout on page 5578 opacity
(as determined by the assigned map) being less than 1.0. Raw contains the
background without scaling by the opacity. If the cutout opacity is 1.0,
these outputs contain black, because no transparency is rendered in such
cases.
The Level output contains the actual opacity itself. Care must be taken if
opacity equals zero, because this mean that the material has performed no
shading whatsoever and none of the other outputs will contain any value
at all.

■ Reflections Output is the resulting Reflection group on page 5548
component. Raw is the unalloyed (full-intensity) reflection, and Level is
the actual reflectivity, including reflection color and BRDF on page 5557
settings.

WARNING The Arch & Design material samples very-low-level reflections in
the rendering phase at low quality (for performance), so avoid doing huge
modifications to reflection intensity in post.

■ Self Illumination Output contains the Self Illumination (Glow) on page
5559 component.

■ Specular Output is the resulting specular component. Raw is determined
by the Reflection > Glossiness on page 5549 value and the Anisotropy on
page 5556 settings, while Level is determined by the BRDF on page 5557 settings,
the Reflectivity on page 5548 and Reflection > Color on page 5549 values, and
the Relative Intensity of Highlights on page 5571 value.

■ Translucency Translucency is the combined result of the Weight on page
5554 and Color on page 5555 settings. Output is the resulting translucency
component, Raw is the raw translucency, and Level is the actual
translucency level, adjusted by the energy conservation.

■ Transparency Transparency is the combined result of the Refraction
group on page 5569 settings, including the Translucency settings. Output is
the resulting transparency component, Raw is the raw transparency, and
Level is the actual transparency level, adjusted by the energy conservation.
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Proper Compositing

Due to the redundancy available in the outputs, there are several ways to
composite them to yield the same result as the beauty render. Here we outline
two compositing pipelines in equation form. You can use these in Autodesk
Toxik and other HDR compositing applications.

First we have the “simple” variant, which is simply a sum of the various result
parameters. This version allows only minimal post-production changes to the
overall balance between the materials. Its advantage is in not needing as many
files, as well as working reasonably well in non-floating-point compositing.

Beauty = Output Diffuse Direct Illumination + Output Diffuse Indir

ect Illumination + Output Specular +

Output Reflections + Output Transparency + Output Translucency +

Self Illumination

Then we have the more “complex” variant, which uses the various raw and
level outputs, thus allowing much greater control in post production.

Note that the raw outputs need to be stored and composited in floating point
to maintain the dynamic range. The level outputs always stay in the 0.0-1.0
range and do not require floating-point storage.

Beauty = Level Diffuse * (Raw Diffuse Direct Illumination + (Raw

Diffuse Indirect Illumination * Raw Ambient Occlusion)) +

Level Specular * Raw Specular +

Level Reflections * Raw Reflections +

Level Transparency * Raw Transparency +

Level Translucency * Raw Translucency +

Self Illumination

Interface

All mr A&D render elements have the same settings:

Multiplier Scales the brightness of the output.
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TIP When rendering A&D elements for compositing in Autodesk Combustion,
bear in mind that Combustion does not support HDR imagery, so to avoid clamping
it will be necessary to adjust the Multiplier value for each element.

Apply Shadows When on, the output includes shadows cast on the surface.

 mr Labeled Element Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout > Add button > Render Elements
dialog > Add mr Labeled Element to the elements list (or highlight an mr
Labeled Element entry in the list).

The mr Labeled Element is a render element that lets you output one or more
branches of a material tree to a custom render element. (A branch comprises
a map or shader and any sub-elements, such as maps assigned to the map’s
map slots.)

To use this element, assign the mr Labeled Element shader on page 6003 as the
parent of the branch to render, give it a label, and then use the same label for
the render element. For details, see the following procedure.

Procedure

To use the mr Labeled element:

1 In the Material Editor, determine which branch of a material to output
as a separate element. For example, an Arch & Design material might
contain a Gradient map assigned as a Diffuse > Color shader, and one of
the Gradient maps could be assigned a Checker map, and one of the
Checker maps could be assigned a Noise map. This procedure will assume
you want to render the Checker map and its constituent Noise map to
an element.

So the material structure would be like this:

A&D material > Gradient (Diffuse Color) > Checker (Gradient Color #1)
> Noise (Checker Color #1)

2 In the Material Editor, click the map button at the top of the branch you
want to output. In this example, you’d click the Diffuse > Color map
button in the Arch & Design material to open the Gradient map settings.
You’d then click the first map button (Color #1) on the Gradient
Parameters rollout to open the Checker map settings.
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3 Click the map button just above the map rollouts on the right side of the
Material Editor (in this example, Checker) to open the Material/Map
Browser.

4 On the Material/Map Browser, double-click the mr Labeled Element item.
This opens the Replace Map dialog.

5 Make sure “Keep old map as sub-map?” is chosen, and then click OK.

6 You now see the mr Labeled Element Parameters rollout. If you click the
Shader/Map To Store (Passthrough) button, labeled “M”, you can access
the branch that will be output to the render element: the Checker map
containing the Noise map.

7 If you clicked the M button, go back up to the parent mr Labeled Element
shader, and then enter a name for the element in the Label field. In this
example, the name could be checker/marble branch.

The material structure would now be like this (new map in italics):

A&D material > Gradient (Diffuse Color) > mr Labeled Element shader
(Gradient Color #1) > Checker (mr Labeled Element shader map) > Noise
(Checker Color #1)

8 On the Render Setup dialog > Render Elements panel > Render Elements
rollout, click Add. Choose the mr Labeled Element item from the list.

9 On the Parameters rollout for the element, enter the name you specified
in step 7 in the Label field.

10 Set up the other Render Element parameters as necessary and then render
the scene.

Your custom element is rendered to an image file.

The following illustration shows the example described in the preceding
procedure. The left-hand image shows the full material, with the Noise
inside the Checker inside the Gradient, and the right-hand image shows
a labeled element containing only the Noise inside the Checker. The
element renders only the part of the Checker map that is used by the
Gradient map.
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Left: Full rendering; Right: Labeled element

Interface

Label Enter the name of the element you specified in the mr Labeled Element
Shader > Label field.

Multiplier Scales the brightness of the rendered output.

Apply Shadows When on, the output includes shadows cast on the surface.

 mr Shader Element Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout > Add button > Render Elements
dialog > Add mr Shader Element to the elements list (or highlight an mr Shader
Element entry in the list).

The mr Shader element outputs the raw contribution of any mental ray shader
in the scene. This includes standard 3ds Max materials and maps that are
converted to mental ray shaders in the translation process. The output of this
element does not figure into the final rendered output.
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For example, you could use the mr Shader element to render a few different
ambient occlusion passes (see mental images Shader Libraries on page 5977).

NOTE The mr Shader element is intended primarily for rendering shaders, not
full materials. While you can, in most cases, most "material-style" shaders might
contain their own code to write to render elements, and in some circumstances
this can cause odd conflicts. For example, piping a Standard material through a
Material To Shader shader on page 6001 into the mr Shader element is not
recommended because it could cause the Standard material’s render element to
collide with the original render elements from the main render.

Procedure

To use the mr Shader element:

1 In the Material Editor, determine which shader to output as a separate
element. For example, an Arch & Design material might contain a
Gradient map assigned as a Diffuse > Color shader, and one of the
Gradient maps could be assigned a Checker map, and one of the Checker
maps could be assigned a Noise map. This procedure will assume you
want to render the Checker map and its constituent Noise map to an
element.

So the material structure would be like this:

A&D material > Gradient (Diffuse Color) > Checker (Gradient Color #1)
> Noise (Checker Color #1)

2 On the Render Setup dialog > Render Elements panel > Render Elements
rollout, click Add. Choose the mr Shader Element item from the list.

3 On the Parameters rollout for the element, click the Shader button; this
opens the Material/Map Browser dialog.

4 Make sure Browse From on the dialog is set to Scene. If the object to
which the shader is applied is selected, you could also choose Selected.
In the material tree, highlight the shader to output as an element.

NOTE Any subordinate shaders are also included in the element output.

5 Set up the other Render Element parameters as necessary and then render
the scene.

Your Shader element is rendered to an image file.

The following illustration shows the example described in the preceding
procedure. The left-hand image shows the full material, with the Noise
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inside the Checker inside the Gradient, and the right-hand image shows
a Shader element containing only the Noise inside the Checker. The
element renders the entire Checker map even though only part of it is
used by the Gradient map.

Left: Full rendering; Right: Shader element

Interface

Shader The shader to render as an element. Click the button and then choose
a shader or material from the list in the Material/Map Browser. Typically you’d
want the element to output a shader in the scene, so you’d make sure Browse
From is set to Selected or Scene.

Multiplier Scales the brightness of the rendered output.

Apply Shadows When on, the output includes shadows cast on the surface.

Velocity Element Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout > Add button > Render Elements
dialog > Add Velocity element to the elements list (or highlight an existing
Velocity element in the list).
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The Velocity element generates a rendering that contains information about
the motion of objects in the frame. You can use the Velocity rendering to
generate motion blur when you use a composition application such as
Combustion or Flame. There are plug-ins for compositors that generate motion
blur; for example, those created by RE:Vision Effects, Inc.

The advantages of rendering a Velocity element are that the composition
application might give you finer control over the motion blur than 3ds Max
does; you can render a “beauty” frame that does not contain motion blur;
and the Velocity element is quicker to render than using one of the 3ds Max
motion-blur effects.

Another use of the Velocity element is to re-time clips rendered in 3D. There
are specialized applications that allow you to re-time an image sequence, using
velocity data to generate more accurate inbetween frames.

In the Velocity rendering, the motion information is saved as RGB color
information:.red saves movement on the X axis, green saves Y-axis movement,
and blue saves Z-axis movement, relative to the plane of the rendered frame.

The mental ray renderer supports this element, but the mental ray Motion Blur
camera effect must be turned off. Also, some mental ray materials do not support
render elements.

Controls on the element's rollout let you improve the precision of the motion
data saved in the rendering. See the procedure, following.

Procedures

To render a velocity element for an animation sequence:

1 On the Render dialog > Render Elements panel > Render Elements rollout,
click Add. In the Render Elements dialog that appears, highlight Velocity,
and then click OK.

2 Highlight the Velocity element in the Element Rendering list.

3 On the Velocity Element Parameters rollout, turn on Update, then render
several test frames. (Choose frames where object velocity appears to be
the greatest.)

4 After each test frame, make a note of the Maximum Velocity value. If
you need to do so, enter the largest of these values as the Maximum
Velocity to use.

Having a specific Maximum Velocity value will give you more accurate
velocity data.
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5 Turn off Update.

Now the Maximum Velocity will remain constant.

6 Render the animation.

Interface

Maximum Velocity Enter a Maximum Velocity value based on the result
collected by Update. Setting a Maximum Velocity increases the precision of
the motion information. See the procedure, above: Procedures on page 6368.
Default=1.0.

Update Turn on when you render test frames, as described in the above
procedure. After each rendering, Maximum Velocity is set to the value recorded
by update. Use the largest of these values, and then turn off Update before
you render the full animation. Default=off.

NOTE The Update control does not work with mental ray distributed bucket
rendering.

Z Element Parameters Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout > Add button > Render Elements
dialog > Add Z Depth element to the elements list (or select an existing Z
Depth element in the list).

The Z-depth element is a grayscale representation of the Z depth, or depth
within the view, of objects within the scene. The nearest objects appear in
white, and the depth of the scene in black. Intermediate objects are in gray.
The darker the gray, the deeper the object is, within the view.

This rollout lets you adjust what portion of the scene is shown in the Z-depth
rendering. By default, the rendering includes objects near the front of the
view (Z Min=100.0), and extends for 300 3ds Max units into the scene (Z
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Max=300.0). If your scene is deeper than 300 units, you need to increase the
value of Z Max.

You can use the Update option to let the software automatically determine
the depth extents of objects in the rendered view.

Interface

Z Min The minimum distance to include in the Z-depth rendering. This is a
value in 3ds Max units, and cannot be less than 0.0. Default=100.0

Z Max The maximum distance to include in the Z-depth rendering. This is a
value in 3ds Max units. Default=300.0

Update Lets the software automatically determine the depth range of objects
in the rendered view. When on, after completion of a rendering, the software
changes the Z Min and Z Max values to reflect what the renderer determined.
Typically, you would make a single test rendering with this on, and then turn
off the check box.

Diffuse Texture Element Rollout

Rendering menu/main toolbar > Render Setup > Render Setup dialog > Render
Elements panel > Render Elements rollout > Add button > Render Elements
dialog > Add Diffuse element to the elements list (or select an existing Diffuse
element in the list).

The Diffuse render element displays the diffuse color component of objects
in the scene.

Interface
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Lighting  When on, the diffuse render element displays the color of objects
after lighting has been applied.

When Lighting is turned off, the element displays the diffuse color of objects
before the lighting gets applied. For textured objects, this will look like a 3D
projection of the texture. However, objects with a single color will look “flat”.

Render to Texture
Make sure the default scanline renderer or the mental ray renderer is the active
renderer. > Select one or more objects. > Rendering menu > Render To Texture

Rendering to texture, or "texture baking,” allows you to create texture maps
based on an object's appearance in the rendered scene. The textures are then
“baked” into the object: that is, they become part of the object via mapping,
and can be used to display the textured object rapidly on Direct3D devices
such as graphics display cards or game engines.

You can render to textures using the mental ray renderer on page 6230

Typical Texture Baking Method

1 Set up a scene with lighting.

Banana object in a lighted room

2 Select the objects whose textures you want to bake.
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Banana object selected

3 Choose Rendering > Render To Texture.

4 A Render To Texture dialog on page 6397 appears. In this dialog, you choose
which elements on page 6376 of the rendering you want to bake. Elements
are aspects of the rendering such as diffuse color, shadows, alpha
(transparency/opacity), and so on.

In this dialog, you can also choose various display options on page 6383
for showing the baked texture in shaded viewports.

TIP If you have a Direct3D graphics display driver, you can use DirectX
viewport shaders on page 5393 to view the baked texture in shaded viewports.
They show how the baked texture will appear on DirectX devices.

5 Click Render.

After you click Render in the Render To Texture dialog, a number of things
happen. (This is a typical set of events; the dialog gives you a lot of control
over how texture baking actually occurs.)

■ The elements you chose are rendered, each to its separate bitmap file.
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Lighting map of the banana

By default, the texture type is Targa on page 7370, and the element maps are
placed in the \images subfolder of the folder where you installed the
program.

The new textures are “flat”: In other words, they are organized according
to groups of object faces.

■ In the modifier stack, a new modifier is applied to the object. It is called
Automatic Flatten UVs. It is simply an Unwrap UVW modifier on page 1841,
automatically applied.
This modifier manages the mapping of the flattened texture to faces of the
object, and lets you adjust that mapping if necessary.

Flattened texture-mapping coordinates for the banana
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■ A Shell material on page 5732 is applied to the object. This material is a
container for both the object's original material (you don't lose those maps
and settings), and the newly created baked material, with its new textures.
The Shell material lets you access both materials and adjust their settings,
if necessary. It also lets you choose which material to view, the original
material or the texture-baked material, in shaded viewports or in renderings.

New shell material contains the banana's original material (below left) and the
baked texture (below right).

Rendered light map applied to the banana
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With the light map, banana appears lit even when lights are turned off.

That is texture baking in a nutshell.

For best results, Logarithmic exposure control is recommended for Render To
Texture.

If Linear or Automatic exposure controls are used, each object will have
different lighting levels, generating a different histogram. Each object renders
as if it had a different light level and in some cases, you may not get a rendering
at all. This happens because Linear and Automatic exposure controls are view
dependent.

Logarithmic Exposure Control is not view dependent, and will reproduce the
image correctly. See the Exposure Controls on page 6732 topic for more
information about Linear, Automatic and Logarithmic exposure controls.

See also:

■ Baked Texture Elements on page 6376

■ Target Map Slot Assignments on page 6383

■ Render to Texture Dialog on page 6397

■ Render to Texture: General Settings Rollout on page 6399

■ Render to Texture: Objects to Bake Rollout on page 6401
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■ Render to Texture: Output Rollout on page 6406

■ Render to Texture: Baked Material Rollout on page 6410

■ Render to Texture: Automatic Mapping Rollout on page 6413

■ Render to Texture: Add Texture Elements Dialog on page 6415

■ Shell Material on page 5732

■ DirectX Manager Rollout on page 5393

■ LightMap Shader Rollout on page 5760

■ Metal Bump Shader Rollout on page 5761

Baked Texture Elements

Select objects. > Rendering menu > Render to Texture > Render to Texture
dialog > Output rollout > Click Add. > Add Texture Elements dialog > Choose
elements to render.

When you render to texture or “bake” a texture, you choose one or more
elements to render. These elements save aspects of the rendered scene: its
geometry, lighting, shadows, and so on. Some texture elements can display
in shaded viewports; others require a DirectX viewport shader on page 5393 to
view in 3ds Max.

When you add an element to render, it appears in a list in the Objects To Bake
on page 6401 rollout. In the list, you can disable or enable rendering of that
individual map, or select it to adjust which components it will include.

NOTE Automatically generated reflections and refractions do not work well with
rendered textures, although they are included in the Complete and Blend texture
maps.

The available element maps are described in the sections that follow.

Limitations of Composite and Blend Materials

If the object has a Composite or Blend material applied to it, only certain
elements render correctly. Which elements render correctly depend on the
renderer you are using.
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The default scanline renderer renders only these elements of a Composite or
Blend material correctly:

■ Diffuse color

■ Specular color

■ Reflections

■ Ambient color

■ Self-illumination color

■ Refractions

The mental ray renderer renders only these elements of a Composite or Blend
material correctly:

■ Lighting

■ Shadows

■ Normals

Component Options (Unique Settings)

Many element maps let you choose to include or not include components of
the rendered scene. When your element to render is highlighted in the list,
these options appear on the Selected Element Unique Settings group.

See also:

■ Render to Texture on page 6371

■ Render to Texture Dialog on page 6397

Complete Map

A complete map saves most surface properties of the rendered object;
specifically:

■ Lighting

■ Diffuse color

■ Specular color

Baked Texture Elements | 6377



■ Reflections

■ Shadows

■ Ambient color

■ Self-illumination color

■ Refractions

Component Options (Selected Elements Unique Settings)

For a complete map, you can choose not to render shadows.

Specular Map

A specular map saves only the specular color of the object.

Component Options (Selected Elements Unique Settings)

For a specular map, you can choose not to render lighting or shadows.

Diffuse Map

A diffuse map saves only the diffuse color of the object.

Component Options (Selected Elements Unique Settings)

For a diffuse map, you can choose not to render lighting or shadows.

Shadows Map

A shadows map saves only the shadows cast onto the object.

Component Options (Selected Elements Unique Settings)

There are no unique settings for a shadows map.

Lighting Map

A lighting map saves only the lighting cast onto the object.
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Component Options (Selected Elements Unique Settings)

For a lighting map, you can choose not to render shadows, direct light, or
indirect light.

Normals Map

A normals map saves a color gradient that indicates the direction of normals
on the surface of the object. With a normals map, Direct3D rendering can
make simple geometry appear more complex.

With DirectX 8, you can view a normals map in shaded viewports by using
the Metal Bump Direct3D viewport shader on page 5761.

With DirectX 9, you can view a normals map in any shaded viewport.

Component Options (Selected Elements Unique Settings)

There are two unique settings for a normals map:

Output into Normal Bump When on, assigns a Normal Bump map to the
Target Map Slot, and places the rendered Normal Bump map in the Normal
component of the Normal Bump map on page 6033. Default=off.

Render Height Map into Alpha Channel When on, renders a grayscale height
map and assigns it to the alpha channel of the Normal map. If you are
rendering to a file type that doesn't have an alpha channel, this setting has
no effect. Default=off.

Height Map

A height map is a grayscale map that stores the relative height of the source
object when you render with normal projection. (See Creating and Using
Normal Bump Maps on page 6384.) You can use the height map as a displacement
map on the target object. This is a way to add detail to the edges of the
low-resolution object, because edges are not affected by the normal bump
map itself.

NOTE When using a height map as a displacement map with the mental ray
renderer, be sure to use the Height Map Displacement shader on page 6000. Also,
turn off Smoothing, either globally on page 6294 or for the individual object on the
Object Properties dialog > mental ray panel on page 322. In addition, when
rendering with mental ray, if you're applying the height map to a standard material,
apply the map as a Displacement map on the mental ray Connection rollout on
page 5385 (unlock the map first), not on the Maps rollout.
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TIP Using a paint program such as Adobe Photoshop on a height map is possible,
but prone to error. The values in the height map depend on the shapes of both
the low-resolution and high-resolution models, and it's easy to damage the
mathematical accuracy. If you paint any changes onto the map, be careful to
preserve the faceted look, and avoid the temptation to blur away the facets. You
might try painting in Additive or Subtractive mode, to add to or subtract from the
displacement, because Normal mode will set a fixed displacement, making it
difficult for an artist to control the result.

Component Options (Selected Elements Unique Settings)

There are no unique settings for a height map.

Blend Map

A blend map is like a complete map, except that all its components, not just
shadows, are optional.

Component Options (Selected Elements Unique Settings)

For a blend map, you can choose not to render any of the following
components:

■ Lighting

■ Diffuse color

■ Specular color

■ Reflections

■ Shadows

■ Ambient color

■ Self-illumination color

■ Refractions

Alpha Map

An alpha map saves only the alpha channel of the rendered object.

Component Options (Selected Elements Unique Settings)

There are no unique settings for an alpha map.
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Ambient Occlusion (MR) Map

Use an ambient occlusion map when you want the surface information to
describe how much ambient light the surface can receive. The ambient
occlusion map considers the obstruction of the light by surface contours and
surrounding objects. By using the ambient occlusion map when rendering,
you do not need to set up special lighting, replace materials on the objects,
or use with global overrides because the ambient occlusion map already
accounts for these settings.

You can use ambient occlusion maps with or without a Projection modifier
and for many different purposes. Use them to mask layers in Adobe Photoshop,
for items such as painted edits and texture maps. Also use them as dirt maps,
or as masks for reflections or specular light.

NOTE By default, the shader used by the Ambient Occlusion bake element excludes
the low-resolution object from the ambient occlusion calculations whenever
performing projection-mapped texture baking. However, if the Projection Mapping
option Include Working Model on page 6419 is enabled, then the occlusion rays will
include the working model. In this case, projection rays also include the working
model. No undesired blank areas appear on the map, because there are no cases
where a projection ray passes though the lo-res model to hit a point on the high-res
model that is completely occluded by the low res.

NOTE This map is available only when the mental ray renderer is active.
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Original scene surrounded by rendered-to-texture ambient occlusion maps of the floor
object

Top left: Samples=8; Spread=0.8

Top right: Samples=32; Spread=0.8

Bottom left: Samples=16; Spread=0.5

Bottom right: Samples=16; Spread=0.99

Component Options (Selected Elements Unique Settings)

For an ambient occlusion map, you can set the following unique settings:

Samples  Sets the number of rays cast. More rays results in a smoother image.
Default=16.
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Spread Sets the spread of the ray, creating a cone shape. With a value of 0.0
a single point is sampled; with a value of 1.0 the entire hemisphere is sampled.
Range=0.0–1.0. Default=0.8.

NOTE You can set Spread to values greater than 1.0, but only values within the
specified range are useful.

Bright Sets the color in the map where no occlusion occurs. The default color
is white. Click the swatch to change the color.

Max distance Sets the range within which geometry is probed. A value of 0.0
samples the entire scene. For non-zero values, only objects within this range
are sampled. Default 0.0.

Dark Sets the color in the map where complete occlusion occurs. The default
color is black. Click the swatch to change the color.

NOTE Colors between the Bright and Dark values are used to indicate partial
occlusion.

Falloff Defines the amount of falloff of the ray. The greater the value, the
greater the falloff. Default=1.0.

Target Map Slot Assignments

Select objects. > Rendering menu > Render to Texture > Render to Texture
dialog > Output rollout > Target Map Slot: drop-down list > Specify how baked
textures appear in the material.

When you bake textures (render to texture), you have more control for how
the baked texture displays in shaded viewports. You set these in the Output
rollout on page 6406 of the Render To Texture dialog. Using the Target Map Slot
assignments, you can specify in detail which maps will be rendered to which
slots of the existing material.

NOTE The first time you use Render To Texture, all Target Map Slot assignments
are blank. After you set them and render the baked texture, those settings become
the default Target Map Slot settings for future modelling sessions. 3ds Max stores
the Target Map Slot assignments in the texturebake.ini file in the plugcfg folder
within the program directory.
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Creating and Using Normal Bump Maps

Normal bump mapping is a way of adding high-resolution detail to
low-polygon objects. It is especially useful for real-time display devices such
as game engines, and it can also be used in rendered scenes and animations.

A normals map is a three-color map, unlike the grayscale maps used for regular
bump mapping (see Bump Mapping on page 5478). The red channel encodes
the left-right axis of normal orientation, the green channel encodes the
up-down axis of normal orientation, and the blue channel encodes vertical
depth.

Basic Workflow

3ds Max provides a number of different ways to create and use normal bump
mapping, but the most straightforward and simplest workflow involves these
steps:

1 Create a detailed, high-resolution model.

2 Create a simpler, low-resolution model.

The low-resolution model should have the general shape and outlines of
the high-resolution model, and typically it should be a bit smaller, so
that projected detail in the high-res model will appear to be above its
surface.

3 Select the low-res model.

4 Choose Rendering > Render to Texture.

The Render To Texture dialog appears.

5 On the Objects To Bake rollout, in the Projection Mapping group, click
Pick.

A selection dialog appears.

6 Choose the high-res object, and then click Add.

3ds Max applies a Projection modifier on page 1628 to the low-res object.

7 In the Projection Mapping group, turn on Enable.

NOTE At this stage, often you will click Options to display the Projection
Options dialog on page 6416, which has a variety of settings for how to generate
the projection.
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8 On the Output rollout, add a NormalsMap element (see Baked Texture
Elements on page 6376). Assign Bump as its target map slot.

9 In the Selected Elements Unique settings group, turn on Output Into
Normal Bump.

10 Click Render.

3ds Max renders the Normals map, which stores normals data from the
high-res object. As for other kinds of texture baking, it creates a Shell
material and applies that to the low-res object, with the Normals map
assigned as the bump component.

Components of Normal Bump Mapping

In the 3ds Max interface, controls for normal bump maps appear in three
locations:

■ The Render To Texture dialog
Specifically, normal projection controls are found on the Objects To Bake
rollout on page 6401 and the Output rollout on page 6406.

■ The Projection modifier on page 1628
You can apply a Projection modifier yourself, or let Render To Texture do
so automatically.

■ The Normal Bump map type on page 6033
Render To Texture creates this automatically if you turn on Output Into
Normal Bump (step 9, above).

Viewing Normal Bump Maps

If your display driver uses DirectX 8, you can view normal maps in viewports
by using the Metal Bump shader on page 5761. If your graphics driver is DirectX
9, you can view normal maps in any shaded viewport. See Direct3D Driver
Setup Dialog on page 7800.

If your display driver is Software or OpenGL, you can't view normal maps in
viewports. However, you can still render them and use normal mapping in
renderings.

Normal Projection with Sub-Object Selections

You can associate different sub-object selections with different high-resolution
geometry. See Reference Geometry Rollout (Projection Modifier) on page 1633.
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Troubleshooting Normal Bump Maps

Because of the variety of geometry and different situations that can arise,
normal bump maps sometimes give unexpected results. Usually there is a
workaround for the problem, or more than one. This topic describes some
situations that can arise, and ways to correct them.

Parallel Projection Loses Detail

If the projection cage is set up so projected rays run parallel to part of the
high-resolution geometry, that portion of geometry can be lost in the normal
bump map.

For example, in this scene, the normal bump map is based on a high-resolution
cylinder that has indentations at the top and bottom.
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Default cage around high-res cylinder

However, the normal bump map does not show the end indentations.
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Indentation is missing from top and bottom of the cylinder's normal bump map.

The reason is that with the default projection cage, the rays parallel the sides
of the indentation, and so details are lost.

Projection rays (shown in red) parallel the sides of the indentation.
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To correct the problem, you can move the end of the cage upward, and scale
it inward a little, so the rays don't run so nearly parallel to the side of the
indentation.

Raising and scaling the upper end of the projection cage.

When the cage is adjusted this way, the indentation appears in the normal
bump map.
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With the corrected cage, the upper indentation appears correctly in the normal bump
map.

TIP In situtations like this, another solution can be to use Break on the vertices in
the region of the low-resolution object where detail is missing from the map. This
increases the number of vertices in the cage, and reduces the chances of geometry
being missed. If you use this method, it is likely you will need to make further
adjustments to the projection cage, as well.
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Breaking low-res vertices causes the indentations to render in the normal bump map.
However, projection now misses some areas of the geometry, so the cage needs to be
adjusted further.

Flipped Seams in Tangent Space

When you use tangent space for your normal bump map, usually the values
used for the tangents are consistent between the hardware shader, renderers,
and third-party applications. However, sometimes portions of the geometry
are flipped, relative to each other, causing discontinuities when you render
or use a hardware shader. Tangent space is the default option for normal bump
mapping, and it is the method you should use for objects that both move and
deform, such as animated characters. This problem does not arise when you
use the other coordinate spaces: world, screen, or local.

For example, in the following scene, the pants show discontinuities. They are
flipped relative to each other, as the arrows show.
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Flipped seams in rendering of pants

Left: Left side shows a discontinuous red stripe

Right: Right side shows a discontinuous blue stripe

The arrows show how the maps are misaligned.

When you render a normal bump map, you can generally see flipped areas as
showing a “flare” of reddish color to the right, and of bluish color to the left.
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Uncorrected normal bump map shows blue and red “flares.”

The solution is to use the UVW Unwrap modifier's Flip Horizontal command
for those sub-object selections that show flaring, or an excess of red areas.

Troubleshooting Normal Bump Maps | 6393



Normal bump maps corrected using Flip Horizontal

Red and blue are more evenly distributed, with blue predominating.

With the maps corrected, the full rendering, whether with 3ds Max or a
hardware renderer, looks better.
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Corrected normal maps render more smoothly, without discontinuity.

The arrows show how the maps are correctly aligned to wrap around the pant legs.

Noise when Rendering a Normal Bump Map with the mental ray
Renderer

If you use the mental ray renderer to render a normal bump map, and the
model has overlapping faces (for example, where the low-resolution and
high-resolution objects overlap in space), then the normal bump map can
show noise where the faces overlap.
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Red areas show noise from overlapping faces

The workaround is to adjust either the high-res or the low-res object so that
faces are not coincident. One way to do so is to use a Push modifier on page
1646. After you have generated the normal map, you can turn off the Push
modifier.

TIP If another object in the scene continues to cause problems with the map
rendering, you can make it invisible to normal projection by going to its Object
Properties dialog, and in the Rendering Control group, turning off Visible To
Reflection/Refraction.
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Overlapping UV Coordinates

Overlapping UV coordinates can cause rendering errors in Render To Texture.
The problem is especially noticeable on objects that have mirrored UVs, or
symmetrical mapping. If you are working with a character or other model that
has mirrored UVs, we recommend that you follow this procedure:

1 Either add an Unwrap modifier or go into an existing Unwrap modifier
where the symmetry exists.

2 Move half of the overlapping texture coordinates on the W axis so that
they’re slightly offset from the other half.

Render To Texture will use the texture coordinates with the higher W
value.

Edit Normals Modifier Makes Normal Bump Mapping Incorrect

Don't apply an Edit Normals modifier on page 1354 to the low-res object. Normal
bump projection relies on the low-res object having standard normals, and
altering them causes normal bump maps to have unpredictable results.

Render to Texture Dialog

Rendering menu > Render To Texture > Render to Texture dialog

Rendering to texture, or “texture baking,” is controlled by this dialog. Most
of this dialog's controls are contained in its rollouts.

See also:

■ General Settings rollout on page 6399

■ Objects To Bake Rollout on page 6401

■ Output Rollout on page 6406

■ Baked Material Rollout on page 6410

■ Automatic Mapping Rollout on page 6413
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Procedures

To bake an object's texture:

There are a lot of options for rendering to textures. These are the basic overall
steps.

1 Select an object.

Ideally, the object will have a texture assigned to it, or lights and shadows
that fall on it, and so on.

2 Choose Rendering > Render To Texture.

3 In the same dialog, go to the Output rollout.

4 Click Add, and in the Add Texture Elements dialog, choose the element(s)
you want to render.

5 Set Target Map Slots, if necessary.

6 Click Render.

The elements you chose to render are rendered to files, and the baked
texture is displayed in shaded viewports.

To bake the texture of multiple objects:

1 Set up the texture-baking parameters of each object you want to bake.
This corresponds to steps 2 through 5 of the previous procedure.

2 In the Objects To Bake rollout, change All Selected to All Prepared.

3 Click Render.

Textures are rendered for all the objects you previously set up.
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Interface

Render Renders the scene, or the elements listed in the Objects To Bake rollout.

Unwrap Only Applies the Automatic Flatten UVs modifier to all selected
objects without rendering anything.

Close Closes the dialog and saves any changes to settings you have made.

Original/Baked When set to Views, the original or baked material is displayed
in the viewports. When set to Render, the original or baked material is used
in the rendering.

Render to Texture: General Settings Rollout

Rendering menu > Render To Texture > Render to Texture dialog > General
Settings rollout

This rollout has the texture-baking controls for the current scene. It lets you
control automatic unwrapping of the baked textures, map size, render settings,
and where texture renderings are saved.

See also:

■ Render to Texture on page 6371

■ Render to Texture Dialog on page 6397

■ Render to Texture: Objects To Bake Rollout on page 6401

■ Render to Texture: Output Rollout on page 6406

■ Render to Texture: Baked Material Rollout on page 6410
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■ Render to Texture: Automatic Mapping Rollout on page 6413

Interface

Output group

Text field Specifies the folder where the rendered texture will be saved. You
can enter a different folder name in this field. Default=the \images subfolder
of the folder where you installed 3ds Max.

Click the ellipsis button to display a dialog that lets you browse to the
directory where you want the rendered texture to be saved.

Skip Existing Files Allows you to render only those maps that do not already
exist.

Rendered Frame Window When on, displays the complete map in a Rendered
Frame Window on page 6073 as the elements are rendered. When off, does not
open the Rendered Frame Window. Default=on.

NOTE The Rendered Frame Window does not open when you use Render To
Texture with the mental ray renderer. Instead, 3ds Max displays a progress dialog.

Render Settings group

These controls let you choose and set up Render Presets as well as activate
network rendering.
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Drop menu Lets you choose Load Preset on page 6114. A Render Presets Load
dialog appears where you can select an RPS file.

Setup Displays the Render dialog on page 6067, where you can adjust production
settings, draft settings, or both.

Network Render When on, you can assign the rendering task to Server
systems. If you click Render, the Network Job Assignment dialog on page 6481
displays where you can specify a server, or multiple servers, to take on the
task. Default=off.

3ds Max can use the Split Scan Lines option on page 6486 when rendering to
textures with a render farm. However, if you enable projection mapping and
turn on Sub-Object Levels, this option is unavailable.

Render to Texture: Objects to Bake Rollout

Rendering menu > Render To Texture > Render to Texture dialog > Objects to
Bake rollout

This rollout has controls for the texture baking of individual objects. It lets
you choose which map channel the texture will use, which elements will be
rendered, and at what sizes. It also lets you control filename generation, and
assign the format of rendered texture elements.

See also:

■ Render to Texture on page 6371

■ Render To Texture Dialog on page 6397

■ Render To Texture: General Settings Rollout on page 6399

■ Render To Texture: Output Rollout on page 6406

■ Render To Texture: Baked Material Rollout on page 6410

■ Render to Texture: Automatic Mapping Rollout on page 6413
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Interface
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Object and Output Settings group

This drop-down list lets you save presets comprising all current Render To
Texture settings, including map types and sizes, from a single object and then
load a preset onto any number of objects. Render To Texture presets use the
RTP filename extension. Presets contain all settings on the Objects to Bake
and Output on page 6406 rollouts and the Projection Options dialog on page
6416. The only exceptions are the Object Level and Sub-Object Levels radio
buttons in the Objects To Bake rollout > Projection Mapping group and the
Use Automatic Unwrap > Channel numeric values in the Objects To Bake
rollout > Mapping Coordinates group.

Preset Use the upper part of the drop-down list to choose an existing preset
to load. The preset is applied to all objects in the objects list. The list contains
up to the last 10 maps in the order that they were loaded or saved, with the
most recent at the top.

After you choose a preset to load, a dialog appears showing you the path and
name of the file containing the preset. Confirm or deny loading the preset by
clicking Continue or Cancel, respectively.

In addition, if Projection Mapping is enabled, the dialog might contain related
messages. For example, if the target object needs a Projection modifier, the
dialog suggests that you use the Pick function to add one.

Load Object Preset Lets you load a preset that’s not on the list. The preset is
applied to all objects in the objects list. This command appears only when
the list of objects contains one or more entries.

Save Object Preset Lets you save the current settings to a preset for later reuse.

NOTE You can save a preset only when the list of objects contains a single entry.
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Object list

List of objects Shows all selected objects. Because the dialog is modeless, you
can change the selection while it’s open, and the list updates dynamically.

■ Name column Lists the object's name.

■ Map Channel column Lists the object's current map channel setting.

■ Edge Padding column Lists the object's current edge padding setting.

Selected Object Settings group

Enable When on, the Channel and Padding controls are used for individual,
all selected, and all prepared objects. When off, only selected object texture
rendering uses these settings; “whole scene” rendering does not. Default=off.

Padding The amount, in pixels, that edges are allowed to overlap in the
flattened (“unwrapped”) texture. Default=2 pixels.

If the baked texture shows visible seams when you view it in shaded viewports
or renderings, try increasing this value.

Projection Mapping group

This group contains the controls for generating a normal bump projection.
See Creating and Using Normal Bump Maps on page 6384

Enabled When on, normal bump projection is enabled using a Projection
modifier on page 1628. When off, the Projection modifier is not used. Default=off.

To generate a normal map rather than a normal bump map, leave Enabled
turned off.

Modifier drop-down list When an object has been chosen, this list shows
the Projection modifier. If multiple Projection modifiers have been assigned,
their names are visible in the list as well.

Pick Click to designate the high-resolution object from which the Projection
modifier will derive normals. This opens the Add Targets dialog, which works
like the Select From Scene dialog on page 228 to let let you select one or more
objects on which to base the normal map.

Options Click to open the Projection Options dialog on page 6416, which
contains various normal bump projection settings. When Individual is chosen
(at the bottom of the Objects To Bake rollout), the options affect the selected
object; when All Selected or All Prepared is chosen, the options apply to all
selected or prepared objects.
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Object Level When on, projects from the object level of the high-resolution
object. Default=on.

■ Put to Baked Material (The default.) When chosen, the object-level
projection is rendered in the baked material.

Sub-Object Levels When on, uses the active sub-object selection, and makes
the Mapping Coordinates group > Sub-Objects controls available. Default=on.

■ Put to Baked Material When chosen, the sub-object level projection is
rendered in the baked material.

The following options apply to sub-object rendering, when only a portion of
the geometry is being rendered to the normal bump map:

■ Full Size (The default.) When chosen, the size of the normal bump map
is the same as if all geometry were being rendered.

■ Proportional When chosen, the size of the normal bump map is fitted
to the size of sub-object selection. The Proportional Multiplier on the
Projection modifier's Reference Geometry rollout on page 1633 can change
the default size of the proportional map.

For example, consider a plane that is 4 segments x 4 segments. Each "poly" in
the plane is a separate sub-object, for a total of 16 sub-objects. If the output
Map Size is 64, the object rendering output is 64 x 64 pixels. If Full Size is
chosen, each sub-object rendering is also 64 x 64 pixels. If Proportional is
chosen, each sub-object rendering is 16 x 16 pixels. If you change Proportional
Multiplier to 2.0 in the Projection modifier, each sub-object rendering is now
32 x 32 pixels.

Mapping Coordinates group

Object These controls are for basing the rendered texture on the object level
of the source object.

■ Use Existing Channel When chosen, unwrapping uses an existing map
channel.

■ Channel When Use Existing Channel is active, lets you choose the
channel to use for unwrapping.

■ Use Automatic Unwrap (The default.) When chosen, uses automatic
unwrapping, and applies an “Automatic Flatten UVs” (Unwrap UVW)
modifier on page 1841 to the objects whose texture is being rendered.
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Sub-Objects These controls are for basing the rendered texture on a sub-object
selection of the source object.

■ Use Existing Channel When chosen, unwrapping uses an existing map
channel.

■ Channel When Use Existing Channel is active, lets you choose the
channel to use for unwrapping.

■ Use Automatic Unwrap (The default.) When chosen, uses automatic
unwrapping, and applies an “Automatic Flatten UVs” (Unwrap UVW)
modifier on page 1841 to the objects whose texture is being rendered.

Clear Unwrappers Clears the unwrap modifiers from the stack.

The radio buttons at the bottom of the rollout let you choose which objects
to bake. See Render To Texture Dialog on page 6397 for procedures.

■ Individual Allows you to select each object and choose a set of output
maps and targets for it. The list will display all selected objects.

■ All Selected (The default.) Displays all the selected objects.

■ All Prepared The list will display all visible and unfrozen objects in the
scene, selected or not, which have unwrapped mapping on them.

Render to Texture: Output Rollout

Rendering menu > Render To Texture > Render to Texture dialog > Output
rollout.

This rollout lets you specify the elements to render and their attributes.

See also:

■ Render to Texture on page 6371

■ Render to Texture Dialog on page 6397

■ Render to Texture: General Settings Rollout on page 6399

■ Render to Texture: Objects To Bake Rollout on page 6401

■ Render to Texture: Baked Material Rollout on page 6410

■ Render to Texture: Automatic Mapping Rollout on page 6413
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Interface

Output List Shows maps names, element names, map sizes and designated
map slots.

■ File Name column Lists the name of the map that will be generated.

■ Element Name column Shows the element corresponding to the map.

Render to Texture Dialog | 6407



■ Size column Displays the map size.

■ Target Map Slot column Shows which map slot will be occupied by the
baked texture in the material.

The output list can display entries in black, gray and blank. If a group of objects
is selected that has already has output assignments, maps that are shared by
all will appear black, maps not shared by all will appear gray. If resolutions or
target types are shared they will appear black, if not they will be blank.

Add Click to display an Add Texture Elements dialog on page 6415 to choose
one or more element types to add to the list.

See Baked Texture Elements on page 6376 for a description of the different
element choices.

Delete Click to remove the currently highlighted element from the list.

Selected Element Common Settings group

Enable When on, renders this element. When off, disables rendering of this
element. Default=on.

Name Enter the element component of the file name. Default=the name of
the element type.

File Name and Type Enter the file name of the rendered texture. Default=the
object name followed by the element name, and TGA format on page 7370.

This field is disabled if All Selected or All Prepared is turned on in the Objects
To Bake rollout on page 6401.

Click this button to display a file dialog you use to choose a name,
directory, and file format for the rendered texture.

NOTE The File Name and Type setting specifies the path and filename only for
the selected element. To set a folder where all baked textures will be stored, set
the path in the Output group on the General Settings rollout on page 6399.

Target Map Slot Display all Map Types available to the materials assigned to
the objects selected minus the ones already slated for output in the current
Render To Texture session.

If more than one object is selected the all map types common to all the selected
objects will be listed. If you choose to Create New Baked on page 6410, then the
slots for the new baked material type will be displayed.
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Element Type This read-only field displays the type of element, such as
CompleteMap, that you specified when you added the element.

By default, the element name is the same as its type, but you can change it
using the Name field. Element Type remains constant.

Element Background Lets you set the background color of the rendered
output for the highlighted element.

Use Automatic Map Size When on, sets the texture size automatically, using
the values on the General Settings rollout on page 6399. When off, the texture
is the size specified by the following controls in this rollout. Default=off.

Width/Height Lets you specify dimensions for the texture. Range=0 to 8192.
Default=256.

NOTE Increasing texture resolution increases render time.

To force the texture to be square, often a requirement with real–time 3D
rendering engines, click the lock button next to Height.

Preset resolution buttons (128x128, ...) Click a button to specify a preset
resolution for the texture.

Selected Element Unique Settings group

The contents of the Selected Element Unique Settings group vary depending
on the active element. But the group always shows a list of toggles for various
components of a scene, and by default, all toggles are on.

The following table shows which components apply to which elements (if
the table shows “none,” the Selected Elements Unique settings group is not
displayed):

ComponentsMap Type

ShadowsComplete

Lighting
Shadows

Specular

Lighting
Shadows

Diffuse
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ComponentsMap Type

(none)Shadows

Shadows
Direct Light On

Lighting

Indirect Light On

Output into Normal Bump
Render Height Map into Alpha Channel

Normals

Lighting
Diffuse

Blend

Specular
Reflection
Shadows
Ambient
Self-Illumination
Refraction

(none)Alpha

(none)Height

For a fuller description of the rendered texture elements, see Baked Texture
Elements on page 6376.

Render to Texture: Baked Material Rollout

Rendering menu > Render To Texture > Render to Texture dialog > Baked
Material rollout

Material Baking operates on the entire Render To Texture session. It is not set
per individual object.

NOTE When you use Network Rendering, the Render To Baked Material option
is disabled.
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See also:

■ Render to Texture on page 6371

■ Render To Texture Dialog on page 6397

■ Render to Texture: General Settings Rollout on page 6399

■ Render to Texture: Objects To Bake Rollout on page 6401

■ Render to Texture: Output Rollout on page 6406

■ Automatic Mapping Rollout on page 6413

Interface

Baked Material Settings group

Output Into Source When on, replaces any target map slot in the object’s
existing material. Care should be used with this option, because the material
replacement cannot be undone.
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NOTE If a selected object to be rendered has a multi/sub-object material assigned
to it, the workflow will not change and the results will be as follows: output into
source will put the resulting map in all sub-material slots that match, instancing
all identical maps, if a sub-material doesn’t have the selected output type it will
be ignored; duplicate in baked will duplicate the entire Multi/Sub-Object Material
into the baked material and perform the above output; create new baked will
create a new single standard material.

Save Source (Create Shell) Makes a new Shell material and assigns it to the
object. When this option is turned on, you can then choose to either Duplicate
Source To Baked, or to Create New Baked.

Duplicate Source To Baked Makes a copy of the existing material as the Baked
material.

Create New Baked Puts a new material in the Baked Material slot. The type
of the new material is set by the drop-down list below and subsequently
determining the available Target Map Slots in the Output rollout.

Shader list Allows you to specify a shader to be used for the newly baked
texture.

Update Baked Materials Builds a Shell material for all selected objects, and
populates the baked material according to the current Render To Texture
settings.

Clear Shell Materials Removes the Shell material on page 5732 applied to the
texture-baked object, and replaces it with either the original material or the
texture-baked material.

The radio buttons below Clear Shell Materials give you a choice of which
material in the Shell material to retain:

■ Keep Source Materials When chosen, the original material replaces the
Shell material.

■ Keep Baked Materials When chosen, the baked material replace the Shell
material.

NOTE If you have already rendered a baked texture and decide you want to render
with a different shader from the list, you must first click Clear Shell Materials and
then re-render.

Render to Files Only When turned on, the baked texture files are rendered
to the folder you've specified in the Output Path field of the General Settings
rollout on page 6399. Default=off
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Render to Texture:Automatic Mapping Rollout

Rendering menu > Render To Texture > Render to Texture dialog > Automatic
Mapping rollout

These are options specify how Render To Texture should behave when it
automatically flattens UVs or chooses the map size of a baked texture.

See also:

■ Render to Texture on page 6371

■ Render To Texture Dialog on page 6397

■ Render to Texture: General Settings Rollout on page 6399

■ Render to Texture: Objects To Bake Rollout on page 6401

■ Render to Texture: Output Rollout on page 6406

■ Render to Texture: Baked Material Rollout on page 6410

Interface

Automatic Unwrap Mapping group

These are options for how to flatten UVs when Use Automatic Map is chosen
in the Objects To Bake rollout's Mapping Coordinates group.
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NOTE These controls are also provided by the Unwrap UVW modifier's Flatten
Mapping dialog on page 1892.

Rotate Clusters Controls whether clusters are rotated to minimize the size of
their bounding box. For example, the bounding box of a rectangle rotated 45
degrees occupies more area than one rotated 90 degrees. Default=on.

Threshold Angle The angle used to determine the face clusters to be mapped.
Default=45.0.

As faces are gathered to be mapped, the modifier uses this parameter to
determine which faces get put in a cluster. This is the maximum angle that
can exist between faces in a cluster.

The higher this number, the larger the clusters will be, with consequently
greater distortion introduced as a result of texture faces' proportions deviating
from their geometry-equivalent faces.

Fill Holes When turned on, smaller clusters will be placed in empty spaces
within larger clusters to take the most advantage of the available mapping
space. Default=on.

Spacing Controls the amount of space between clusters. Default=0.02.

The higher this setting, the larger the gap that appears between clusters.

Automatic Map Size group

Rendering to texture can choose a map size for you. Automatic map sizing is
enabled or disabled by a toggle on the Output rollout on page 6406. The controls
in this group specify how to create the map, when Automatic Map Size is
enabled. Automatic map sizing computes the total surface area of all objects
in the selection, then multiplies that value by Scale, and creates a square
texture map of those dimensions.

Scale The amount by which to scale the total surface area of generated texture.
Default=0.01.

Nearest power of 2 When on, rounds the map dimensions (length and width)
to the nearest power of 2. Default=off.

Min The minimum size, in pixels, of the length and width of the automatically
sized map. Default=32.

Max The maximum size, in pixels, of the length and width of the automatically
sized map. Default=1024.
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Render to Texture:Add Texture Elements Dialog

Rendering menu > Render To Texture > Render to Texture dialog > Output
rollout > Click Add to add a texture element. > Add Texture Elements dialog

This dialog lets you choose which elements will be part of a baked material.
Each element is an individual bitmap. When you display a baked texture in
shaded viewports, some elements might not display.

NOTE If the Direct3D display driver on page 7802 is active, you can use a DirectX
viewport shader on page 5393 to enhance baked texture display.

Interface

Available Elements Lists the elements available for rendering. See Baked
Texture Elements on page 6376 for a description of the available elements. Click
an element to select it. Use Ctrl+click to select (or deselect) additional elements
individually. Use Shift+click to select a group of contiguous elements.
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You can also double-click a single element name to add it to the list and close
the dialog.

Add Elements Click to add these elements to the list in the Objects To Bake
rollout on page 6401 of the Render To Texture dialog.

Render to Texture: Projection Options Dialog

Rendering menu > Render To Texture > Render to Texture dialog > Objects
To Bake rollout > Projection Mapping group > Click Options. > Projection
Options dialog

This dialog displays options for normal bump projection.
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Interface

Objects and Sources group

The text field displays the name of the projection's source object. If more than
one object is selected, it displays the source option chosen in the Render To
Texture dialog: a single object name for Individual, or “All Selected” (the
default), or “All Prepared.”

Synch All Click to set all Render-To-Texture sources to use the active source
object and the other current Projection Options settings. This button is
available only when there is an individual source object.
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Filtering Options group

Crop Alpha Removes antialiasing from the alpha channel.

Global Supersampler When the default scanline renderer is active, the text
field shows the type of global supersampling that is currently in use. When
the mental ray renderer is active, it shows the number of samples per pixel.
Default=None.

■ Setup Click to set up global sampling. When the default scanline renderer
is active, clicking Setup displays the Render dialog's Default Scanline
Renderer rollout on page 6141, whose Global Supersampling group lets you
globally enable supersampling, and choose the supersampling method.
When the mental ray renderer is active, clicking Setup displays the Render
dialog's Sampling Quality rollout on page 6272, which lets you adjust the
level of sampling.

Method group

These controls let you choose how to use normals from the source object.

■ Raytrace (The default.) When chosen, normals are ray-traced between
the source and target objects. The objects need to be perfectly aligned in
world space on page 8175. When you view both high-res and low-res objects
in viewports, they must line up with each other exactly. There are no
special requirements for the mapping coordinates of the high-res objects.

■ UV Match When chosen, normals are obtained by matching the target
object's local UV coordinates to those of the source. The objects' UV
coordinates on page 8161 need to be perfectly aligned. If you look at the
objects using the Unwrap UVW modifier's Edit UVWs dialog on page 1859,
the low-res and high-res objects must be lined up with each other exactly.
The high-res object needs to have mapping coordinates on the same map
channel you are using for the low-res object.
Typically, the high-res object will have an Unwrap UVW modifier assigned
to it, but this is not required.

With this option, the high-res object does not need to be in the same
physical location as the low-res object.

TIP You can reset the cage (on the Cage rollout on page 1635), because UV
Match does not use it.

Use Cage When on, bases projection on the Projection modifier's cage
sub-object. When off, uses an offset instead. Default=on.
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Offset Enabled only when Use Cage is turned off. Offset is the distance above
the surface of the source object from which normals are projected. Default=10.0
units.

Resolve Hit group

The two radio buttons are for scenes that have semitransparent objects, in
which case more than one hit can be found for each ray. The remaining
controls in this group are additional projection controls.

■ Closest If there are multiple hits, use the closest object.

■ Furthest (The default.) If there are multiple hits, use the farthest object.

Hit Only Matching Material ID When on, projection is only between material
IDs that match. Turning this option on enables a single map to contain normal
bump projections from different high-res source geometry. Default=off.

Include Working Model When on, bakes from the source object if no target
object can be found. Default=off.

Turning on Include Working Model can be a quick fix when a lot of the
projected rays miss the target object (the Ray Miss Color will be apparent in
the rendered normals map). However, if the low-res object occludes the high-res
object, then Include Working Model will not have the desired effect, and the
normal map will not show high-res details that you want it to. In this case,
adjust the Projection modifier's cage.

This toggle is also useful when the high-res geometry is discontinuous (for
example, a lattice or an array of cylinders).

Ray miss check When on, bakes missed rays as well as rays that hit into the
rendered texture, using the Ray Miss Color. Default=on

■ Ray miss color This color is baked into the texture when projection fails
to hit the target geometry. Click the color swatch to display a Color Selector
on page 391 and change the color used for missed rays. Default=red.

Normal Map Space group
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There are four methods for projecting the normals:

■ World Project using world coordinates. This is useful mainly for objects
that don't move or deform; otherwise, a moving object with world-projected
normals will appear to “swim” through the texture.

■ Screen Project using screen coordinates; that is, flat projection in the Z
axis. This method is useful mainly for stationary objects seen from a single
angle only; for example, a statue seen through a window.

■ Local XYZ Project using the object's local coordinates. This method can
be used for stationary or moving objects, but not for objects that deform:
if the object deforms, the projection will appear incorrect at some frames.

■ Tangent (The default.) Project at a tangent to the target object's surface.
This is the method to use for objects that both move and deform, such as
animated characters.

Orientation

The orientation settings determines what the red and green colors will indicate
in your normal map. The orientation settings are different for the Tangent
method than for the other methods.

The correct setting for red and green depend on what kind of hardware shader
or texture will be used to view the map. Different shaders have different
requirements. The Normal Bump map has controls to flip the red and green;
the Normal Bump texture should work correctly if the map was created with
the default X and Y or Left and Right settings, but if the map was created with
different settings, change the Normal Bump settings to make the map render
correctly, instead of rendering a whole new map.

Orientation: Tangent

For the Tangent method red indicates normals that are pointed either left or
right and green indicates normals that are pointed up or down.

As an example, if you use Tangent mode with Red set to right and Green set
to down, areas that are red in your normal map would indicate that the
normals were facing towards the right and areas that were green would indicate
that your normals were facing downwards.

The following are the possible values for the Tangent method:

■ Red Can be Left or Right. Default=Right.
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■ Green Can be Up or Down. Default=Down.

Orientation: World, Screen, and LocalXYZ

For World, Screen, and LocalXYZ, red indicates that the normals are pointed
toward either a positive or negative X value, while green indicates that the
normals are pointed toward either a positive or negative Y value.

Foir example, if you use World mode with Red set to –X and Green set to –Y,
areas that are red in your normal map indicate that the normals face toward
–X, and green areas indicate that the normals face toward –Y.

The following are the possible values for World, Screen, and Local XYZ
methods:

■ Red Can be –X or +X. Default=+X.

■ Green Can be –Y or +Y. Default=+Y.

Height Map group

Min Height Sets a minimum height for displaced normals. Default=0.0 units.

Max Height Sets a maximum height for displaced normals. Default=10.0
units.

 Min and Max Height eyedropper Enable the eyedropper to pick the
minimum or maximum height for the displaced normals by picking or dragging
in a viewport. With the button enabled, click at the desired height. You can
also drag this value until the desired result is achieved. The minimum or
maximum height value is updated based on your selection.

Buffer min Height After you render a normal bump projection, this value is
set to the minimum distance that a projection ray travelled. Default=0.0.

Buffer max Height After you render a normal bump projection, this value is
set to the maximum distance that a projection ray travelled. Default=0.0.

If you want to use the Height Map texture element, you can render a normal
bump map to obtain the Buffer values, and then set Min Height and Max
Height accordingly, in order to get the best-looking possible Height Map.
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Rendering Previews
A preview is an AVI file on page 7326 that can help you preview the animation
in your scene. The preview uses lighting but not materials, so it renders much
more quickly than a fully rendered animation.

The preview commands are on the Animation menu on page 7490.

Make Preview on page 6422

View Preview on page 6425

Rename Preview on page 6425

Make Preview

Animation menu > Make Preview

Make Preview displays the Make Preview dialog, enabling you to create an
AVI on page 7326 file or custom file type preview of the animation in the current
viewport. You can also render a preview to a specified device.

When the preview is complete, the software starts the Media Player with the
preview _scene.avi file ready to play. (If you don't want the Media Player to
start, choose Customize > Preferences > General and, in the UI Display group,
turn off Autoplay Preview File on page 7744.)

NOTE Do not open any other program windows that cover up the viewport while
rendering a preview. Anything that covers the viewport will be rendered into the
preview AVI file.

Procedures

To create a preview:

1 Choose Animation menu > Make Preview.

The Make Preview dialog appears.

2 Change the preview parameters or accept the defaults, and then click
OK.

If the output type is AVI, the software renders the preview and saves it
in a file called _scene.avi, in the path specified by Configure User Paths >
File I/O on page 7733 > Preview. Immediately after rendering the preview,
the software runs Media Player with this animation loaded.
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3 View the preview by clicking Play in Media Player.

If you dismiss Media Player and then want to view the preview again,
choose Animation > View Preview. This restarts Media Player with
_scene.avi.

You can save the preview under a different name, so it won't be
overwritten the next time you make a preview. To do so, use Animation
> Rename Preview on page 6425.

Interface
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Preview Range group

Specifies the frames to be included in the preview, either the active time
segment on page 7898 or a custom range of frames.

Frame Rate group

Specifies the playback frame rate on page 7987 in frames per second. Use Every
Nth Frame to preview a regular sampling of the animation. For example, a
value of 8 includes only every eighth frame in the preview.

Image Size group

Sets the resolution of your preview as a percentage of the current output
resolution. You set the output resolution on the Render Setup dialog. For
example, if the rendering output resolution is 640x480, and you set Percent
Of Output to 50, the preview resolution is 320x240.

NOTE The size of the preview image is limited by the size of the viewpanel region
(the region that contains the viewports). The setting is clamped to the maximum
value that allows the preview image to fit in the viewpanel region.

Display in Preview group

Specifies the types of objects to include in the preview. Frame Numbers prints
a frame number in the upper-left corner of each frame of the AVI file.
Background includes the assigned viewport background in the preview.

Camera View group

Specifies whether the preview should include multi-pass rendering effects on
page 6227.

Rendering Level group

Rendering Level drop-down list Specifies the viewport rendering method
on page 7819 to use in the preview.

Output group

Specifies the preview output format.

AVI When chosen, the preview is output as an AVI file. The button to the
right displays the current AVI codec on page 7936. Click it to adjust the assigned
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codec, or choose a different codec. The quality of your output AVI file depends
on the type of codec you use and the codec settings, which vary. For the
highest visual quality, choose the highest compression quality. The higher
the compression quality, the lower the compression, and the larger the
resultant file.

Custom File Type Outputs the preview to the specified file format. When
this option is chosen, and the Create button is clicked, a file selector appears,
where you name the file and specify the output file type. For example, you
can output the preview as a Quicktime movie by specifying a file name with
a .mov extension. If you specify a single-image format, such as .tga, the preview
is output as a series of sequentially numbered files.

Use Device Lets you output the preview to an external device, such as a digital
recorder. The button at right displays the name of the currently assigned
device. Click it to either change the settings of the device, or assign a different
device.

Render Viewport This list shows the names of the currently visible viewports,
letting you choose which viewport to render from within the Make Preview
dialog. Default=active viewport.

View Preview

Animation menu > View Preview

View Preview displays the Windows-standard Media Player to view the current
preview file.

When you use Make Preview, 3ds Max stores the output preview in a file called
_scene.avi by default. View Preview loads this file. If you want to keep the
preview file, use Rename Preview to save it under another file name, otherwise,
the next Make Preview will overwrite _scene.avi.

The Media Player has its own Help system.

Rename Preview

Animation menu > Rename Preview

Rename Preview renames the _scene.avi preview file.

When you use Make Preview, 3ds Max stores the output preview in a file called
_scene.avi by default. View Preview loads this file. If you want to keep the
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preview file, use Rename Preview to save it under another file name; otherwise,
the next Make Preview will overwrite _scene.avi.

Procedures

To rename the preview file:

1 Choose Animation > Rename Preview.

2 Specify a folder and a name for the preview file.

3 Click Save.

Panorama Exporter Utility
Rendering menu > Panorama Exporter

Utilities panel > Utilities rollout > More button > Utilities dialog > Panorama
Exporter

The Panorama Exporter is a rendering utility that lets you create and then
view 360 degree spherical panoramas.
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NOTE You need at least one camera in your scene to use the Panorama Exporter.

Panorama Exporter creates a 360-degree spherical rendering.

Interface
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The Panorama Exporter rollout has two buttons, which let you create or view
a panoramic rendering.

Render Opens the Render Setup dialog on page 6428 for the Panorama Exporter.

Viewer  Opens the Panorama Exporter viewer on page 6431.

Panorama Exporter Render Setup Dialog

Rendering menu > Panoramic Exporter > Render button

Utilities panel > Utilities rollout > More button > Utilities dialog > Panorama
Exporter > Render button

The Panorama Exporter Render Setup dialog is a modal on page 8045 version of
the Render Setup dialog on page 6067 specially configured for generating
panoramic output.

NOTE You need at least one camera in your scene to use the Panorama Exporter.

TIP For best results, high resolutions might be necessary. We recommend a
resolution of 2048x1024 or higher unless you're working on drafts.

Interface

This topic covers the main rollout parameters. Additional rollouts might be
available depending on the current renderer. For more information, see Render
Setup dialog on page 6067.
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Output Size group

Choose one of the predefined sizes or enter another size in the Width and
Height fields (in pixels). These controls affect the image's aspect ratio on page
7914.

Width and Height Lets you set the resolution of the output image by
specifying the width and the height of the image, in pixels.

Preset resolution buttons (512x256, 1024x512, and so on) Click one of
these buttons to choose a preset resolution.

Aperture Width Lets you specify an aperture width for the camera that creates
the rendered output. Changing this value changes the camera's Lens value.
This affects the relationship between the Lens and the FOV values, but it
doesn't change the camera's view of the scene.

For example, if you have a Lens setting of 43.0 mm, and you change the
Aperture Width from 36 to 50, when you close the Render Setup dialog (or
render), the camera Lens spinner has changed to 59.722, but the scene still
looks the same in the viewport and the rendering. If you use one of the preset
formats rather than Custom, the aperture width is determined by the format,
and this control is replaced by a text display.
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Options group

Atmospherics Renders any applied atmospheric effects, such as volume fog,
when turned on.

Render Hidden Geometry  Renders all geometric objects in the scene, even
if they are hidden.

Effects Renders any applied rendering effects, such as Blur, when turned on.

Area/Linear Lights as Point Lights Renders all area or linear lights as if they
were point lights, speeding up rendering time.

Displacement Renders any applied displacement mapping.

Force 2-Sided 2-sided rendering on page 7893 renders both sides of all faces.
Usually, you'll want to keep this option off to speed rendering time. You might
want to turn it on if you need to render the inside as well as the outside of
objects, or if you've imported complex geometry in which the face normals
are not properly unified. Default=off.

Video Color Check Checks for pixel colors that are beyond the safe NTSC on
page 8059 or PAL on page 8078 threshold and flags them or modifies them to
acceptable values.

By default, "unsafe" colors render as black pixels. You can change the color
check display by using the Rendering panel on page 7768 of the Preference
Settings dialog on page 7743.

TIP This is useful for draft renderings, as point lights render much faster than area
lights.

NOTE Scenes with radiosity on page 6168 are not affected by this toggle, as area
lights do not have a significant effect on the performance of a radiosity solution.

Super Black Super Black rendering on page 8141 limits the darkness of rendered
geometry for video compositing.

TIP Leave this off unless you're sure you need it.

Advanced Lighting group

Use Advanced Lighting When on, the software incorporates a radiosity
solution on page 6168 or light tracing on page 6154 in the rendering.

Compute Advanced Lighting When Required When on, 3ds Max computes
radiosity when required on a per-frame basis.
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Normally, when rendering a series of frames, 3ds Max calculates radiosity only
for the first frame. If, in an animation, it might be necessary to recalculate the
advanced lighting in subsequent frames, turn this option on. For example, a
brightly painted door might open and affect the coloring of a nearby white
wall, in which case the advanced lighting should be recalculated.

Render Output group

Save File Saves the rendered panorama to disk. This is unavailable until you
have defined a file name by clicking the Files button.

Files Lets you specify the name, location, and file type for the rendered
panorama file.

Rendered Frame Window Enables or disables the panorama exporter’s
rendering display.

Display Viewer When on, the Panorama Exporter viewer on page 6431 opens
upon rendering the panoramic rendering.

Viewport Chooses the camera viewport to render. When you render a
panorama, this drop-down list shows only the cameras in the scene.

Render Click to render the panorama.

Cancel Click to cancel the rendering.

Close Click to close the dialog, saving any changes you've made.

Panorama Exporter Viewer

Renderingmenu > Panoramic Exporter > Viewer button

Utilities panel > Utilities rollout > Panorama Exporter > Viewer button

The Panorama Exporter viewer lets you navigate a rendered panorama. You
can use the viewer to export the panorama rendering with a cylindrical,
spherical, or QuickTime VR format.
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NOTE Exporting to QTVR format requires that QuickTime® 5 or higher be installed
on your system. You can download the latest version from
http://www.apple.com/quicktime/download. For QTVR export, you must choose
the “Recommended Install” rather than a custom or minimal installation. In
particular, your installation must include these components:

■ QuickTime Authoring

■ QuickTime Internet Extras

■ QuickTime Essentials

Procedures

To navigate a rendered panorama:

1 Hold down the left button to rotate the camera around the panorama.

If you move the mouse, the camera rotates in that direction until you
move the mouse again. (The view of the panorama moves in the opposite
direction from the mouse and camera.)

2 Hold down the middle button and move the mouse up and down to
zoom in and out.

3 Hold down the right button and move the mouse to rotate the camera
around the panorama.

With the right button, you must drag the mouse to see any movement,
and the view of the panorama moves in the same direction as the mouse.

To export a rendered panorama:

1 Open a rendered panorama in the Panorama Exporter Viewer.

2 Click File > Export.

Choose Cylinder, Sphere, or QuickTimeVR to set the format for your
exported file.

A dialog opens, prompting you to enter the name, location, and type of file.
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Network Rendering
Network rendering is a means of mass-processing multiple rendering tasks or
jobs. In order to facilitate network rendering, Autodesk BackburnerTM is
installed with 3ds Max. The Backburner software is responsible for coordinating
how job assignments are processed.

You can perform network rendering with both the default scanline and mental
ray renderers. In its most efficient form, network rendering uses multiple
computers, connected over a network, to perform rendering tasks; typically
the rendering of animations with hundreds or thousands of frames. Even a
small network of three or four PCs can save substantial rendering time and
help you meet deadlines.

However, network rendering can be equally useful if you have only a single
PC and need to render a number of images. You can assign the jobs that need
to be rendered and Backburner can manage the rendering of each job while
you're away from the computer. Commonly, jobs are assigned submitted just
before you leave the office. when you arrive the next morning, all your
rendering are waiting for you to review.

Network rendering is designed to render whatever is set up in your scene; that
is, it will render the viewport, part of a viewport, camera view, and so on, as
saved in the scene file. You can also pass batch-rendering tasks to Backburner
from the Batch Render tool on page 6553. You can queue up tasks from any
number of cameras in a scene. Each task can load a save scene state or use a
particular rendering preset.

The requirements and procedures presented here assume you are the
administrator of a closed network set up exclusively for network rendering.
In practice, you can use the network for file sharing and other purposes, but
if conflicts arise, you might need to cancel those uses. The easiest network to
set up, operate, and maintain is one dedicated to rendering.

NOTE For specific information about setting up network rendering on a single
system, refer to Basic Procedure 1: Single-System Network Rendering on page 6436.

If you're a system administrator for a more complex network, you can use the
information in this file as a guideline. The basic approach is the same for any
network.

IMPORTANT It is strongly recommended that you follow these procedures for
setting up and running network rendering. Do not attempt network rendering
without reading the instructions that follow.
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The links on this page are ordered like chapters in a manual: a sequence of
major topics containing more specific nested topics. Links marked Next Step
indicate the next topic in the sequence. Moving from one topic to the next
takes you through the necessary steps to set up your network for rendering.

NOTE Network rendering functions are also available from MAXScript. See
“Network Render Interface” and “Interface: NetRender” in the MAXScript
Reference.

About Backburner

Network rendering is performed by software named Backburner. Functionality
is primarily the same as in previous versions of 3ds Max with the addition of
the following:

■ The Batch Render tool on page 6553 can pass a queue of rendering tasks to
the Network Job Assignment dialog. When submitted, Backburner manages
the rendering of all the active tasks and

■ You can now assign various servers to groups in Backburner. From the
Network Job Assignment dialog you can choose a group as the current set
of servers.

Backburner Documentation

The following table summarizes the Backburner Documentation set.

See:For Information About:

This Network Rendering section.Using Autodesk Backburner with 3ds Max

Autodesk Backburner User’s Guide (In 3ds
Max go to Help > Additional Help > Back-
burner User's Guide)

Autodesk Backburner User Interface (Man-
ager, Server, and Monitor), Troubleshoot-
ing, and Administering Autodesk Backburn-
er

Autodesk Backburner Installation Guide (In
3ds Max go to Help > Additional Help >
Backburner Installation Guide)

Autodesk Backburner Configuration
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3ds Max Install Guide (Click the Document-
ation link on the Autodesk 3ds Max 2009
Install DVD 1.)

Installing Autodesk Backburner with 3ds
Max

About Mental Ray

Network rendering with the mental ray Renderer

The mental ray renderer supports network rendering via Backburner and the
command line. The steps for setting up and submitting jobs are exactly the
same as those you'd use for the scanline renderer. No additional licensing or
fees are necessary.

Next Step

How Network Rendering Works on page 6448

See also:

■ Checking Requirements on page 6461

■ Setting Up for Network Rendering on page 6463

■ Basic Procedures for Network Rendering on page 6435

■ Network Job Assignment Dialog on page 6481

■ The Queue Monitor Application  on page 6522

■ Installing Network Services on page 6503

■ Batch Rendering on page 6548

■ Troubleshooting Guide on page 6455

Basic Procedures for Network Rendering

This topic contains basic procedures to follow when network rendering with
3ds Max. The following conditions are assumed:

■ 3ds Max has been installed on all machines to use as rendering servers.
Note: You needn't license the software on machines to be used only as
rendering servers.
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■ All network communications and protocols are installed and operating
correctly.

■ The computers run Windows XP Pro, Windows 2000, or NT 4.0. Limitations
of other operating systems could cause network rendering to be unreliable.

■ All of the computers have names that start with letters. Machine names
that start with a number will fail.

■ You haven't previous attempted network rendering. If you have already
attempted network rendering and want to return to the original state,
delete everything in the \Program Files\Autodesk\Backburner\Network folder
except nrres.dat.

■ Manager and Server have not been installed as services.

Summary of Procedures

■ Procedure 1 - Use this procedure for configuring a single system to render
jobs to itself; in other words, to perform batch rendering that is managed
by Backburner.

■ Procedure 2 - Use this procedure for configuring a Backburner Manager
system to render to one or more Backburner Server systems. The Manager
system will not be involved in the rendering tasks.

■ Procedure 3 - Use this procedure for configuring the Backburner Manager
and Backburner Server systems to render tasks together.

Special Consideration for Procedures 2 and 3

To use a render farm, you must output a frame sequence in a still-image file
format; for example, a series of BMP files. You cannot render animated file
formats such as AVI or MOV to multiple systems. You must render animated
files to a single system. When rendering to an animated file format, the Use
All Servers check box in the Network Job Assignment dialog is unavailable.

Basic Procedure 1: Single-System Network Rendering

This procedure describes usage of network rendering on a single computer.
The main advantage to this method over standard rendering is that you can
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submit multiple rendering jobs for the computer to render. In effect, this lets
you perform batch rendering.

1  Go to Start menu > Programs > Autodesk > Backburner and choose
the Manager menu item.

This starts Manager and creates the backburner.xml file in the
Backburner\Network folder.

When you run Manager for the first time, you will see the Backburner
Manager General Properties dialog, shown below.

Backburner Manager General Properties dialog.
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2 Click OK to accept the default settings.

The Backburner Manager dialog displays.

3  Go to Start menu > Programs > Autodesk > Backburner and choose
the Server menu item.

This starts Server and creates the server data that is stored in the
backburner.xml file.

You will see the Backburner Server General Properties dialog, shown
below, when you run Server for the first time.

Backburner Server General Properties dialog.

4 Click OK to accept the default settings.

The Backburner Server dialog displays. After a few moments, messages
appear in both the Server and Manager windows indicating that the Server
has successfully registered with the Manager.

5 Start 3ds Max and load the first scene you want to render.

6  From the Rendering menu, choose Render Setup, or click the
toolbar Render Setup button.
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7 Set the rendering parameters and specify an output file name. In the
Render Output group on the Common tab, turn on Net Render, and then
click the Render button.

The Network Job Assignment dialog appears.

Network Job Assignment dialog showing the server station that is also running
Manager.

8 Enter a job name (it's a good idea to change the default name) and then
click the Connect button.

The name of your computer (that is, the Server) appears in the Server
window to the right. It has a green dot next to it meaning that it is a
Server system that is ready to start rendering.
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9 Click the Server name to highlight it in the list window, and then click
the Submit button.

The Manager submits the job to the Server, both running only on this
system, and the Server begins rendering each still frame or the animation.

10 To render additional jobs, load each into 3ds Max, and then repeat steps
6-9.

You can submit as many jobs as you like. The software will queue the
jobs up and render them in the order that you submitted them.

Basic Procedure 2: Network Rendering from Server (not Manager)

When rendering across a network, you first assign one machine to be Manager,
and then any number of others as Servers. In this procedure, you won't use
the Manager as a rendering Server.

1  Go to Start menu > Programs > Autodesk > Backburner and choose
the Manager menu item.

This starts Manager and creates the backburner.xml file in the
Backburner\Network folder.

When you run Manager for the first time, you will see the Backburner
Manager General Properties dialog, shown below; this is normal.
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Backburner Manager General Properties dialog.

2 Click OK to accept the default settings.

The Backburner Manager dialog displays.

3 Move to a Server system.

4  Go to Start menu > Programs > Autodesk > Backburner and choose
the Server menu item.

This starts Server and creates the server data that is stored in the
backburner.xml file.
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You will see the Backburner Server General Properties dialog box, shown
below, when you run Server for the first time.

Backburner Server General Properties dialog.

5 Click OK to accept the default settings.

The Backburner Server dialog displays. After a few moments, messages
appear in both the Server and Manager windows indicating that the Server
has successfully registered with the Manager.

6 Repeat steps 3-5 on all the Server systems you intend to make available
for your rendering jobs.

7 Return to the Manager system, start 3ds Max, and load the first scene
you want to render.

8  From the Rendering menu, choose Render Setup, or click the
toolbar Render Setup button.

9 Set the rendering parameters and specify an output path and file name.
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TIP So that the Servers can find the output path, specify the path in the
Render Output File dialog starting with Save In > My Network Places. Then
navigate to the output folder, specify a file name and output format (Save
As Type), and click Save.

10 In the Render Output group, turn on Net Render, and then click the
Render button.

The Network Job Assignment dialog appears.

Network Job Assignment dialog showing all the server stations. The manager
station is excluded.

11 Enter a job name (it's a good idea to change the default name) and then
click the Connect button.
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The names of all Servers appear in the Server window to the right. Those
with green dots next to their names are ready to start rendering.

By default, all the Servers that are listed will take part in the rendering
job. To assign a specific Server to render a job, first turn off Use All Servers
in the Options group, and then highlight the server(s) that you want to
render the job.

12 Click the Submit button.

The Manager submits the job to the Servers, which begin rendering .

At this point, you can load and submit additional scenes. When the first
job is complete, the next job will automatically begin rendering on the
Servers.

Basic Procedure 3: Network Rendering from Manager and Servers

When rendering across a network, you first assign one machine to be Manager,
and then any number of others as Servers. In this procedure, you'll use the
Manager computer as a rendering Server as well.

1  Go to Start menu > Programs > Autodesk > Backburner and choose
the Manager menu item.

This starts Manager and creates the backburner.xml file in the
Backburner\Network folder.

When you run Manager for the first time, you will see the Backburner
Manager General Properties dialog, shown below; this is normal.

6444 | Chapter 20   Rendering



Backburner Manager General Properties dialog.

2 Click OK to accept the default settings.

The Backburner Manager dialog displays.

3  On the same computer, go to Start menu > Programs > Autodesk
> Backburner and choose the Server menu item.

This starts Server and creates the server data that is stored in the
backburner.xml file.

You will see the Backburner Server General Properties dialog box, shown
below, when you run Server for the first time.
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Backburner Server General Properties dialog.

4 Click OK to accept the default settings.

The Backburner Server dialog displays. After a few moments, messages
appear in both the Server and Manager windows indicating that the Server
has successfully registered with the Manager.

5 Repeat steps 3-4 on all the Server systems you intend to make available
for your rendering jobs.

6 Return to the Manager system, start 3ds Max, and load the first scene
you want to render.

7  From the Rendering menu, choose Render Setup, or click the
toolbar Render Setup button.

8 Set the rendering parameters and specify an output path and file name.

TIP So that the Servers can find the output path, specify the path in the
Render Output File dialog starting with Save In > My Network Places. Then
navigate to the output folder, specify a file name and output format (Save
As Type), and click Save.
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9 In the Render Output group, turn on Net Render, and then click the
Render button.

The Network Job Assignment dialog appears.

Network Job Assignment dialog showing all the server station plus the manager
station that is running Server.

10 Enter a job name (it's a good idea to change the default name) and then
click the Connect button.

The names of all Servers appear in the Server window to the right. Those
with green dots next to their names are ready to start rendering.

By default, all the Servers that are listed will take part in the rendering
job. To assign a specific Server to render a job, first turn off Use All Servers
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in the Options group, and then highlight the server that you want to
render the job.

11 Click the Submit button.

The Manager submits the job to the Servers, which begin rendering .

At this point, you can load and submit additional scenes. When the first
job is complete, the next job will automatically begin rendering on the
Servers.

How Network Rendering Works

Rendering networks are sometimes called “render farms.”

In the software, one computer is set up as the network Manager. The Manager
"farms out" or distributes the work to rendering Servers. You can also have
the same computer function simultaneously as both Manager and Server, so
computing cycles don't go to waste.

Once rendering is under way, the Queue Monitor program lets you directly
monitor and control the operation of the network rendering workload. The
Queue Monitor allows you to edit job settings as well as to activate, deactivate,
and reorder both jobs and servers involved in your render farm.

Important: When rendering using a render farm, it is recommended to render
with single-frame formats such as BMP or PNG. Movie file formats such as
AVI output all frames into a single file which cannot be split between different
servers to take advantage of network rendering.

How Work Is Divided

The software breaks up the task of network rendering among the rendering
Servers, assigning one frame at a time to each Server. The completed output
of the Servers accumulates in a common, shared directory.

Rendered frame files can also be written to a local directory on each machine,
if the same path defines the directory. Frame files are sequentially numbered,
making them easy to assemble later.

The Manager takes a number of different factors into account in determining
how to assign frames and jobs, always striving for the most efficient usage of
the rendering network. An idle rendering Server is automatically detected by
the Manager and is considered for job or frame assignment. If a Server goes
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off-line for some reason, the Manager reclaims the Server's current frame and
reassigns the frame to the next available rendering Server.

The Basic Process

Following is a step-by-step description of the sequence of events when you
use network rendering:

1 The user submits a job to the network Manager.

2 On the submitting machine, the MAX file gets zipped up. If the user
turned on Include Maps, all maps and XRefs are also zipped up.

3 Once the file is zipped up, the ZIP file is copied to the Manager machine's
Backburner\Network\Jobs\<jobname> folder. In the folder is an XML file
describing the job itself, specifying frame size, output filename, frame
range, render settings, etc.

4 Once the Manager receives the ZIP and XML files, it looks to see which
servers are sitting idle and can render jobs. It assigns the job to four servers
at a time. (This is the Max Concurrent Assignments setting on the
Manager General Properties dialog. See Starting Network Rendering on
page 6450 ).

5 Each Server machine receives the ZIP and XML files into the
Backburner\Network\jobtemp folder.

6 The MAX file gets unzipped, along with the maps and XRefs if they were
included.

7 3ds Max is launched and loads the MAX file. If the maps and XRefs were
not included, the software searches for them as they are defined in the
MAX file. For instance, if an XRef is in d:\foo\xref.max, the Server will look
for xref.max in d:\foo\ on the local machine. If there are additional map
paths set in the 3dsmax.ini on page 83 file on the rendering server, it will
search in those paths as well. If it does not find the maps and XRefs, the
server fails for that particular job.

This is why it is important to use UNC paths for all maps and XRefs in
your scene file, so that all render servers can find them. However, if the
maps and XRefs were included, then 3ds Max will get the ones that were
unzipped into the \jobtemp folder.

8 When a frame is finished rendering, 3ds Max on the Server saves the
frame to the location specified via the Render Setup dialog before you
submitted it.
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9 Once a Server successfully renders one frame, the Manager assigns a block
of frames to the server to render; it might assign 20 consecutive frames.
This minimizes the amount of communication needed between the Server
and Manager.

10 The Server continues rendering frames for the job until the job is done.

11 The Server then closes 3ds Max, and goes idle. If the queue contains
additional jobs, the Server picks up the next job and starts the process
all over again.

You can use this explanation to help determine the basic requirements
for your network rendering setup, based on the type of usage. If your
frames render quickly, you'll need a fast file server machine to handle
the constant output from a number of different rendering servers. The
same holds true of your scene uses a large quantity of map files that are
stored in a central location. If you typically render large files, rendering
will take longer, and most of the bandwidth will be required at the start,
when the files are distributed to the rendering servers.

Next Step

Checking Requirements on page 6461

Starting Network Rendering

Once you've set up the network rendering system and software on page 6474,
there are two steps to starting a network rendering session:

■ Start the Manager program on one machine and the Server program on
every other machine in the network. See Basic Procedures for Network
Rendering on page 6435. The machine being used as a manager can also be
used as a rendering server.

■ Start a rendering job from the software on a networked machine with an
authorized copy of 3ds Max.

The Manager and Server programs need to be started and left running during
a network rendering session. Either program remains in operation until you
shut it down or shut down the machine.
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When you've set up the Manager and Server network services, you're ready to
submit an animation to the network rendering queue. There are two stages
to starting network rendering:

■ On the Render dialog, set all desired rendering parameters, including
resolution and rendered output file type, and render the scene. In 3ds Max,
you can render from the Render Setup dialog on page 6067, or the Render
To Texture dialog on page 6397.

■ In the Render dialog, set all desired rendering parameters, including
resolution and rendered output file type, and render the scene.

■ Turn on Net Render, found in the Render Output, Render Settings or Output
groups, and then click Render to open the Network Job Assignment dialog
on page 6481, which lets you make final decisions about the job and submit
your animation to the rendering servers.

Next Step

Network Rendering Manager  on page 6509

Network Rendering Server on page 6516

Procedures

These procedures explain how to start and submit a network rendering job in
3ds Max.

This procedure explains how to render a job over the network, once the
Backburner Manager and Server are running. (See the Autodesk Backburner
Installation Guide for information on setting up the Backburner Manager and
Server.)

To start the Manager program:

1 Run the Manager program from the Start menu > Programs > Autodesk
> Backburner folder.

The first time you run the Manager after installation or after deleting the
backburner.xml file, the Manager Properties dialog appears. In most cases,
you can accept the default settings and click OK to continue.

Thereafter, when you start the Manager, its window appears and the
"Starting Network Manager" message is displayed in the window. The
machine is now running the Manager in Desktop mode. You can leave
this window open to see messages relating to what the Manager and
Servers are doing as they appear, or you can minimize it, whereupon it
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resides in the taskbar tray. To reopen the window when minimized, click
its icon in the taskbar tray.

NOTE If you're running Windows 2000 and have the NetBEUI protocol
installed, and you have unplugged your network cable, when you start the
manager, you'll see an error message, "Error starting network subsystem,
cannot start manager." If this happens, reconnect the network cable and try
again.

2 Alternatively, you can run the Manager as a service, as described in
“Setting Up Backburner Manager as a Windows Service” in the Autodesk
Backburner Installation Guide. Once set up, the Manager automatically starts
when you boot the system and it's always available.

To start the Server program:

1 Run the Server program from the Start menu > Programs > Autodesk >
Backburner folder.

The first time you run the Server after installation or after deleting the
backburner.xml file, the Server Properties dialog appears. By default,
Automatic Search is turned on, and the subnet mask is set to
255.255.255.0. This should work with most networks. Alternatively, turn
off Automatic Search and enter the manager name or its IP address in
the Manager Name or IP Address field.

Thereafter, when you start the Server, its window appears and the "Starting
Backburner Server" message is displayed in the log window. After a few
seconds you should also see the "Registration to (manager IP address)
accepted" message in the Server window. This message indicates that the
server has found the manager and is correctly communicating with it. If
you do not see the "Registration to ..." message in the Server window, see
“Troubleshooting Backburner” in the Autodesk Backburner User’s Guide.

The machine is now running as a rendering Server in Desktop mode. You
can leave this window open to see other messages as they appear, or you
can minimize it to the taskbar tray. To reopen the window when
minimized, click its icon in the taskbar tray.

2 Alternatively, you can run the Server as a service, as described in Network
Rendering Server on page 8058. Just running the Manager as a service, once
it's installed and started, it's always available, even after rebooting.
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To start a network rendering job:

1 Start the Backburner Manager and Backburner Server.

2 Start the software on a machine with an authorized copy of the program.

3 Open the scene you want to render.

4 Choose Rendering menu > Render Setup to display the Render Setup
dialog.

You can also render from the Execute Video Post dialog or the Render To
Texture dialog.

5  In the Render Output group, click the ellipsis button to display the
Render Output File dialog.

6 In the File Name field, enter the Universal Naming Convention (UNC)
on page 8160 name of the output directory, followed by the name of the
output file. For example:

\\machine1\project1\images\output.tga

As an alternative to entering the UNC name from the keyboard, you can
go to Save In > My Network Places and navigate to the machine and
shared directory where you want the servers to write the rendered frames.
After selecting the machine and shared directory in the Map Network
Drive dialog, enter the output file name (for example, output.tga), and
then click OK. The software automatically converts the shared directory
to the UNC format.

If the output directory is mounted, enter the name and extension of the
output file and choose the drive mounted for the output directory from
the Save In list.

7 Click OK to display the Setup Options dialog for the file format type you
have selected.

8 Make the desired settings and click OK.

9 Click OK again to return to the Render Setup dialog.

Save File is turned on once you assign an output file.

10 After setting any other rendering parameters, turn on Render Output
group > Net Render and click Render.

The Network Job Assignment dialog appears.
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If you use Video Post, set the file location with an Add Image Output
Event. After you click Execute Sequence, be sure to turn on Net Render
before you click Render.

To submit a network rendering job:

1 Start the Backburner Manager and Backburner Server.

2 On the Network Job Assignment dialog, make sure the Automatic Search
option is on, and then click Connect.

In most cases, the software detects the Manager machine and displays
its attached Servers in the Server list. If auto-detect fails, turn off Automatic
Search and manually enter the name or IP address of the network machine
acting as the Manager, and then click Connect.

All rendering Servers running under the network Manager should be
listed with green dots next to them. Even if a server is running an
interactive session of the software, it will still render an assigned job by
launching a second copy of the software.

3 By default, the job will use all available Servers. To use only specific
Servers, turn off Use All Servers and choose the machines you want to
use from the Server list.

4 Click Submit.

The job is submitted to the Manager, which then distributes the job to
the machines assigned in the Network Job Assignment dialog. Network
rendering begins.

When network rendering begins on a rendering Server, the Rendering
dialog appears on machines running serverapp.exe. If a machine is running
the service version, no dialog appears.
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Troubleshooting Guide

This is a guide to solving common problems associated with network rendering.
Solutions to these problems vary, depending on whether you are using the
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network rendering programs as installed Windows Services, or running them
in Desktop mode. Also see “Troubleshooting Backburner” in the Autodesk
Backburner User’s Guide.

PROBLEM:When I try to assign a job in the Network Job Assignment
dialog, some of the servers display a gray or yellow icon.

SUGGESTION

Regardless of their state in the Network Job Assignment dialog, servers can
always be assigned new jobs.

The gray icon means that the server is currently not available to render a job.
This state can occur for several reasons, including:

■ The server has not been correctly started. (See “Setting Up Backburner
Server” in the Autodesk Backburner Installation Guide.)

■ The server has been disallowed for the current time period in the Properties
dialog of the Monitor. (See “Setting the Availability for Rendering Nodes”
in the Autodesk Backburner User’s Guide.)

■ The server has experienced abnormal termination.
If you've checked for and corrected these conditions and the servers are
still unavailable, stop running Server on each of the problem machines,
and restart the service after a few seconds. This "purges" the server and
may solve the problem. Then click Refresh in the Network Job Assignment
dialog to display the most recent information about the server.

The yellow icon means that the server is busy rendering another job. If the
server should not be busy, verify that the queue is clear of jobs by opening
the Queue Monitor and connecting to the Manager. If the queue is clear of
rendering jobs and the server is still flagged as busy, stop running server on
each of the problem machines, and restart the service after a few seconds.

PROBLEM:When I submit a job to be rendered, the server fails.

SUGGESTION

Servers can fail for a variety of reasons during a network render job. Many of
these reasons are covered in “Troubleshooting” in the Autodesk Backburner
User’s Guide. One reason that is specific to 3ds Max which can cause a server
to fail is the presence of a scene which does not contain texture coordinates.
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All errors are recorded in the appropriate log file. You can learn more about
log files in “Configuring Backburner Log Files” in the Autodesk Backburner User’s
Guide.

Here are some of the error messages related to 3ds Max, along with a likely
cause, that you will see in the Errors tab of the Queue Monitor when a failed
server is selected:

ERR: ----- Render Error:

ERR: D:\MAPS\3DS.CEL [where this is the location of a map in the submitted
scene]

The Server could not find 3ds.cel in the local path specified, which means that
the path to this map is not been correct for network rendering. To fix the
problem, do one of the following:

■ If all maps are being shared from a single directory, make sure the directory
is correctly shared with full permissions. See Sharing a Directory on page
6477.

■ Make sure that you have used either the full UNC path name for the
bitmaps or that the maps directory has been mounted to the same drive
letter on each machine. In this case, verify that particular path has been
added to the Configure User Paths dialog > External Files panel on page
7735 of every server's local version of the software or that the particular path
was used when assigning bitmaps in the scene to be rendered.

■ Verify the bitmaps still reside in the shared directory.

■ Add an Alternate Map Path on the Network Job Assignment dialog that
points to the folder containing the missing map.

ERR: Object (UVW 1): Sphere01 requires texture coordinates and may not
render correctly

Open the scene and make sure the errant object is assigned texture coordinates.
This can be as simple as adding a UVW Map modifier to the object.

ERR: Frame error

Texture coordinates must be applied to the specified object to render it on
the server.

ERR: Load Error: Missing DLL'S

Following this error, you will also receive a listing of each of the missing DLLs
in the scene. Files needed by the server are not available to render the job.
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Make sure that all the plug-in DLLs used in a job reside on each of the servers
rendering the job.

ERR: Job not found. Ok if just deleted

When you delete a job, the Manager sends out a notification to all clients
(Monitors) telling that the job has changed. This is the same message sent
when the job completes, gets suspended, resumed, etc. The monitors in turn
request the job status from the manager. The manager doesn’t find the job (it
was just deleted) and returns this error to the monitor.

ERR: Targa - The device is not ready. (0x15)

ERR: Frame error

The server could not write the output file. "Targa" represents the file output
type, and will change depending on the output file type you selected. This
problem can occur for several reasons:- If you are running the Backburner
Server as an installed Windows service, make sure that the user account that
the service is logged to has adequate permissions. Administrative permissions
are recommended.

■ Check to make sure the target output directory is shared, with both read
and write permissions.

■ Verify that the path for saving file output on the Render Setup dialog (or
the Output Event dialog in Video Post) is set to a valid UNC path name.

■ If you are writing to a shared directory mounted locally on each server,
verify that the directory is mounted to the same drive letter on each server,
and that the file output path is set for that drive letter.

PROBLEM:The Server fails to render a frame and displays the
following error:

Rebooting 3ds Max by force due to load timeout.

SUGGESTION

The Server has exceeded either the Wait For 3ds Max To Load or Wait For 3ds
Max To Render value. This is usually caused by attempting to render large
files over the network. Increase these values in the Advanced Settings dialog
on page 6497.
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PROBLEM: I cannot assign more than one server to a job in the
Network Job Assignment dialog.

If the output of a network-rendering job is an AVI or MOV file, or a single
user device, the job can be assigned to a single server only. The Network Job
Assignment dialog changes, depending on the file output type of a job. For
example, if you are network rendering to one of the file formats above, the
All and None buttons do not appear and the dialog title bar contains the word
"Single."

If a job that has an AVI or MOV file output type is stopped for any reason (to
deactivate it, or because a machine goes down), re-rendering the file restarts
at the first frame. Frames cannot be appended later to these file types.

SUGGESTION

To take advantage of the distributed power of network rendering we suggest
you first render to a series of Targa files. Then use the Targa files as either an
animated background in an empty 3ds Max scene, or as an image input event
in Video Post and render the sequence out to the desired output type (for
example, AVI).

PROBLEM:When I click the Render button on the Render Setup
dialog, I get an error dialog stating:

Error Retrieving Configuration File

This error usually is the result of a corrupt installation of the Backburner
applications which caused an errant registry setting.

SUGGESTION

Try reinstalling the Backburner components of the program or manually edit
the system registry.

Editing the registry:

1 Choose Start > Run.

2 Enter RegEdit and click OK

3 Browse to HKEY_LOCAL_MACHINE > SOFTWARE > Autodesk >
Backburner > 2008.1

4 Check the CfgPath entry. Make sure the value is set to c:\Program
Files\Autodesk\Backburner\Network\nrapi.conf.
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5 Close the Registry Editor.

PROBLEM: Backburner not found message when clicking Render
button:

Cannot network render. Backburner not found or not installed.

This error dialog appears because the path to Backburner is either not set
properly in the Path environment variable or Backburner is missing altogether.

SUGGESTION

Verify that the Path variable is set properly and make sure you've installed the
latest version of Backburner.

PROBLEM: Clicking Render button results in Backburner plugin error:

Error creating 3ds Max plugin instance for Backburner.

The path to 3ds Max is not set in the PlugPath section of the
\Backburner\Network\nrapi.conf file.

SUGGESTION

Verify the presence of the \Backburner\Network\nrapi.conf file and check the
PlugPath. It should look like this:

PlugPath=C:/Program Files/Autodesk/Backburner/

PROBLEM:The manager and server windows display strange, garbled
text:

Your error message includes @#$$#@.

This error occurs if the nrres.dat file is missing or damaged. This file is located
in: C:\Program Files\Autodesk\Backburner\Network

SUGGESTION

Copy the nrres.dat file from another system that is not exhibiting the problem,
or reinstall Backburner.
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System Setup

Checking Requirements

Checking Requirements

Setting up even a small render farm can require a substantial amount of time.
As a first step, verify that your proposed network meets the basic requirements.
You should also be acquainted with the software required to render over the
network.

Hardware Requirements

■ One machine on the network must have the software set up and authorized.
This system is used to submit network rendering jobs.

■ One machine runs a network manager to communicate with rendering
servers. You can set up any machine in the network for this purpose. No
authorization is required if this machine will not run as a 3ds Max
Workstation.

■ To install the software, at least one machine needs a DVD-ROM drive
mounted for access over the network. Instructions for setting up the
network-rendering software are found in the Setting Up Rendering Software
on page 6474 section.

■ Other machines operate as rendering servers. No authorization is required
on these machines.
Rendering servers should meet the minimum requirements for running
the software. To improve rendering performance, use machines with faster
processors, additional memory, and more swap space. A rendering server
does not require a monitor while rendering, although it's helpful to have
one for setup. Display adapters and accelerators make no difference in
rendering performance.

Network Requirements

For operating system requirements, see “Backburner Component Requirements”
in the Autodesk Backburner Installation Guide. You must also be connected over
a network with TCP/IP protocol properly installed. See Instructions for
configuring TCP/IP for network rendering on page 6466.
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Software Requirements

One authorized copy of the software is the minimum requirement. With this
one copy, you can set up the software on multiple machines for the purpose
of network rendering. Later topics provide explicit details for doing a custom
setup on each machine. During this setup, programs required to render over
a network are installed and registered.

Four separate programs interact to accomplish network rendering. The
following descriptions identify these programs and provide an overview of
their use.

■ 3dsmax.exe
3ds Max is used to launch job assignments. You submit a network rendering
job from the Render Setup, Render to Texture, or Execute Video Post dialog.
The application is also used by the rendering servers to render the job.

■ manager.exe
When run, this application sets up one computer as a network manager.
Alternatively, you can run Manager as a service by installing managersvc.exe.
See Installing Network Services on page 6503.

The manager program manages communication with the rendering servers
during a network rendering job. This can be set up on any machine in the
network. However, if large files are to be submitted and many rendering
servers are going to be used, a fast computer with a large amount of disk
space is the best choice. In almost all network-rendering scenarios, you
only have a single manager running on the entire network.

■ server.exe
When run, this application sets up the computer it's run on to be used as
a rendering server. Alternatively, you can run Server as a service by
installing serversvc.exe. See Installing Network Services on page 6503.

The server program sends its local IP address to the Manager program,
which in turn registers the Server so it will be available for network
rendering a job assignment. When the server receives a job from the
network manager, it launches a local copy of the software to perform the
rendering. The server then sends the completed frame to a target directory
and begins rendering the next frame sent to it by the manager. The server
shuts down the 3dsmax.exe3dsviz.exe process when it is no longer needed.

■ monitor.exe
This standalone program, named Queue Monitor, provides a Windows
interface that lets you monitor and schedule network rendering. Since the
Queue Monitor is a standalone program, you can start it at any time from
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any computer in your network. The only requirement is that you establish
a TCP/IP connection with the computer running the manager.

You can load Queue Monitor on each rendering server and use it to monitor
rendering progress locally. You can also connect with Queue Monitor
remotely using Windows NT Remote Access.

Setting Up for Network Rendering

Whenever different groups need to cooperate on a project, accurate
communication and common procedures are essential. A rendering farm is
such a project.

Network setup can be difficult to configure, but you only need to do it once.
Take your time to get the right setup. Read each topic in order and complete
the steps described.

These instructions are for creating a new network dedicated specifically to
network rendering. If you are configuring network rendering for an existing
network or for a network that will be used for other purposes, these instructions
are intended as a reference example only.

Next Step

Setting Up TCP/IP on page 6463

See also:

■ Setting Up Rendering Software on page 6474

■ Setting Up Directories on page 6475

■ Initial Setup for Manager and Server Programs on page 6501

Setting Up TCP/IP

The software uses the standard network protocol, TCP/IP, for network
rendering. TCP/IP is a two-part acronym. TCP (Transport Control Protocol)
communicates data between applications. IP (Internet Protocol) communicates
data between an application and the physical network. Each computer in your
rendering network needs to be configured for this protocol.
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Before continuing, be sure that:

■ You have administrative privileges on each machine.

■ The network is operational, with network adapter cards installed in each
machine.

The TCP/IP protocol requires a device, called a network adapter or Network
Interface Controller (NIC), to bind with in order to communicate with other
machines. Typically, the network adapter is a network card, but if you are
linked to the Internet by modem, a dial-up adapter (the modem) is used.

TCP/IP uses IP addresses to identify the computers on a network. For
convenience, you can assign real names to computers. An IP address is a serial
number of four integers separated by periods, for example, 192.100.100.1.

IP addresses can be fixed (as in the example above) or automatic, supplied
dynamically each time you connect to the network by a system known as
DHCP (Dynamic Host Configuration Protocol).

The software uses the NIC number, which can be thought of a unique serial
number assigned to each network card, to identify each machine in the
network. This allows the use of DHCP since the IP address usually changes
when a machine using DHCP is rebooted.

In some cases, you may want to specify a fixed IP address, for example:

■ When you have more than one Manager running on the same network,
each with its own set of dedicated Servers, you need to specify which
Manager to use. DHCP can be used in this case, but you will have to specify
the Manager name instead of its IP address.

■ The second case is when the Server or Queue Monitor is outside the local
network (as in the case of a WAN or a multi-segmented network connected
through a router). In this case, Servers connected to the same network can
still use DHCP, provided the Manager has a fixed name and IP address.

■ If your network is set peer-to-peer without an NT server (as is the case with
most home networks), it is easier to set the machines with permanent,
fixed IP addresses.

■ Finally, you can use batch rendering on page 6548 without being connected
to a network. In that case, you will need to set up a fixed TCP/IP address
and configure the Microsoft Loopback adapter.

In the case of fixed addresses, it is important that IP addresses be properly
assigned. In this step, you make up a list of machine names and their
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corresponding IP addresses to use during TCP/IP configuration. The list will
also be used when installing the software’s rendering services.

Using the Manager name is particularly useful when its IP address is assigned
dynamically via DHCP, and can change from session to session.

On a closed network, you don't have to worry much about conflicts with the
IP addresses of other network domains. However, the addresses need to follow
a consistent pattern and each must be unique within your network.

WARNING On an open network, such as those in many large corporations, do
not alter IP addresses in any way. In such cases, to avoid potentially disastrous
consequences, always work with your system administrator to make IP address
changes.

Procedures

To create machine names and IP addresses:

■ Create a list of machine names and IP addresses.
Unless you have specific needs for later compatibility with another network,
use the following list as a model.

Since the Manager machine can also act as a server, start naming your
servers to match their IP addresses as shown in the list below. Remember,
any one machine can act as a manager under network rendering. Like an
IP address, each name must be unique. Also keep in mind that you must
not use the numbers 0 or 255 in the last group (or octet) of an IP address
as they are reserved.

WARNING Machine names should not start with numbers or have spaces or
underscores in them, as those will result in illegal names in TCP/IP. This will cause
unexpected behavior in the network rendering system.

IP AddressMachine Name

192.100.100.1server001

192.100.100.2server002

192.100.100.3server003

......
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IP AddressMachine Name

192.100.100.254server254

Configuring TCP/IP

From the previous step, Setting Up TCP/IP on page 6463, you should have a list
of machine names and IP addresses. With that list, go to each machine and
follow these procedures.

On an open network, such as those in many large corporations, do not alter
IP addresses, machine names, workgroup names, or domain names in any
way. In such cases, to avoid potentially disastrous consequences, always work
with your system administrator to make IP address changes.

Procedures

Some of the following procedures are for Windows XP Professional; others
are for Windows 2000. Find your operating system at the end of the procedure
heading and follow that set of instructions.

NOTE During the writing of these procedures, Windows XP was set to display a
Classic Windows interface.

To assign a name and workgroup or domain (Windows 2000):

1 From the Windows taskbar, open Start menu > Settings > Control Panel
> System.

This displays the System Properties dialog.

2 Click the Network Identification tab, and then click the Properties button
to display the Identification Changes dialog.

If you've already assigned a name to the computer, the name should
appear in the Computer Name field on the Network Identification tab.
Check this name against your list.
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3 To change the name, in the Computer Name field, enter a name for the
machine.

■ The first character of a valid machine/host name must not be a
numeral.

■ Do not use underscores or spaces in the machine/host name.

4 In the Member Of group, enter either a workgroup or domain name,
depending on how your network is going to be set up.
Workgroup An organizational unit that is used to group computers that
don't belong to a domain. If you are setting up a simple network for the
purpose of Network Rendering, use the Workgroup option.

Domain A more complex way of grouping servers that share a common
security policy and user account database. A domain requires you to set
up a Primary Domain controller. You should select the Domain option
only if your Network Administrator has a Domain already set up and
functioning correctly.

To assign a name and workgroup or domain (Windows XP):

1 From the Windows taskbar, open Start menu > Settings > Control Panel
> System.

This displays the System Properties dialog.

2 Click the Computer Name tab, and then click the Change button to
display the Computer Name Change dialog.

If you've already assigned a name to the computer, the name should
appear in the Computer Name field on the Computer Name tab. Check
this name against your list.

3 To change the name, in the Computer Name field, enter a name for the
machine.

■ The first character of a valid machine/host name must not be a
numeral.

■ Do not use underscores or spaces in the machine/host name.

4 In the Member Of group, enter either a workgroup or domain name,
depending on how your network is going to be set up.
Workgroup An organizational unit that is used to group computers that
don't belong to a domain. If you are setting up a simple network for the
purpose of Network Rendering, use the Workgroup option.
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Domain A more complex way of grouping servers that share a common
security policy and user account database. A domain requires you to set
up a Primary Domain controller. You should select the Domain option
only if your Network Administrator has a Domain already set up and
functioning correctly.

To add the TCP/IP protocol (Windows 2000):

1 From the Windows taskbar, open Start menu > Settings > Network and
Dial-up Connections > Local Area Connection.

This opens the Local Area Connection Status dialog.

2 Click the Properties button.

This opens the Local Area Connection Properties dialog.

3 Check the list for "Internet Protocol (TCP/IP)".

If you find this listing, TCP/IP is installed on this machine. Go on to
either of these procedures in the current topic:

■ To configure TCP/IP in DHCP mode on page ?

■ To configure TCP/IP with fixed IP addresses on page ?
If TCP/IP is not installed, make sure none of the list items is
highlighted (click in a blank area of the list), and complete the
remaining steps in this procedure.

4 Click the Install button.

This opens the Select Network Component Type dialog.

5 In the list, click Protocol, and then click the Add button.

6 In the Select Network Protocol dialog, select Internet Protocol (TCP/IP),
and then click OK.

A message appears: "Do you want to use DHCP?". Consult your system
administrator to see if your network is DHCP-compatible; if it is, click
"Yes". If you are unsure, click "No" and proceed to set your workstations
with fixed IP addresses.

TCP/IP is added to the list of installed protocols.

7 Click the Close button.
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To add the TCP/IP protocol (Windows XP):

1 From the Windows taskbar, open Start menu > Settings > Network
Connections.

This opens the Network Connections dialog.

2 Right-click Local Area Connection and click the Properties button.

This opens the Local Area Connection Properties dialog.

3 Check the list for "Internet Protocol (TCP/IP)".

If you find this listing, TCP/IP is installed on this machine. Go on to
either of these procedures in the current topic:

■ To configure TCP/IP in DHCP mode on page ?

■ To configure TCP/IP with fixed IP addresses on page ?
If TCP/IP is not installed, make sure none of the list items is
highlighted (click in a blank area of the list), and complete the
remaining steps in this procedure.

4 Click the Install button.

This opens the Select Network Component Type dialog.

5 In the list, click Protocol, and then click the Add button.

6 In the Select Network Protocol dialog, select Internet Protocol (TCP/IP),
and then click OK.

A message appears: "Do you want to use DHCP?". Consult your system
administrator to see if your network is DHCP-compatible; if it is, click
"Yes". If you are unsure, click "No" and proceed to set your workstations
with fixed IP addresses.

TCP/IP is added to the list of installed protocols.

7 Click the Close button.

To configure TCP/IP in DHCP mode (Windows 2000):

1 From the Windows taskbar, open Start menu > Settings > Network and
Dial-up Connections > Local Area Connection.

This opens the Local Area Connection Status dialog.

2 Click the Properties button.

This opens the Local Area Connection Properties dialog. You should see
your network adapter card listed as "Connect Using" at the top of this
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dialog. If your adapter is not listed, follow the instructions in Windows
2000 documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties.

The Internet Protocol (TCP/IP) Properties dialog appears.

4 Make sure the option "Obtain an IP address automatically" is chosen.

5 Click OK to close each dialog in turn.

Windows 2000 finishes configuring the software.

6 Reboot the computer to complete the configuration.

7 Repeat all the steps on this page on every machine in your network.

To configure TCP/IP in DHCP mode (Windows XP):

1 From the Windows taskbar, open Start menu > Settings > Network
Connections.

This opens the Network Connections dialog.

2 Right-click Local Area Connection and click the Properties button.

This opens the Local Area Connection Properties dialog. You should see
your network adapter card listed as "Connect Using" at the top of this
dialog. If your adapter is not listed, follow the instructions in Windows
XP documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties.

The Internet Protocol (TCP/IP) Properties dialog appears.

4 Make sure the option "Obtain an IP address automatically" is chosen.

5 Click OK to close each dialog in turn.

Windows XP finishes configuring the software.

6 Reboot the computer to complete the configuration.

7 Repeat all the steps on this page on every machine in your network.

To configure TCP/IP with fixed IP addresses (Windows 2000):

1 From the Windows taskbar, open Start menu > Settings > Network and
Dial-up Connections > Local Area Connection.

This opens the Local Area Connection Status dialog.

2 Click the Properties button.
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This opens the Local Area Connection Properties dialog. You should see
your network adapter card listed as "Connect Using" at the top of this
dialog. If your adapter is not listed, follow the instructions in Windows
2000 documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties.

The Internet Protocol (TCP/IP) Properties dialog appears.

4 Choose “Use The Following IP Address”.

5 In the box for IP Address, enter the address for that machine.

Check your list to make sure the entry is correct.

6 In the box for Subnet Mask, type these numbers (these are the same for
every machine):

255.255.255.0

If you are on a large corporate network, this subnet mask might be
different. In this case, use the mask that your network administrator
specified. Also, change the network mask when setting up a server to
connect to a manager as well as in the Network Job Assignment dialog
to match the subnet mask in order for Automatic Search to work.

7 Click OK to close each dialog in turn.

Windows 2000 finishes configuring the software.

8 Reboot the computer to complete the configuration.

9 Repeat all the steps on this page on every machine in your network.

Remember that each machine needs to have a unique IP Address and
machine name so no conflicts arise.

To configure TCP/IP with fixed IP addresses (Windows XP):

1 From the Windows taskbar, open Start menu > Settings > Network
Connections.

This opens the Network Connections dialog.

2 Right-click Local Area Connection and click the Properties button.

This opens the Local Area Connection Properties dialog. You should see
your network adapter card listed as "Connect Using" at the top of this
dialog. If your adapter is not listed, follow the instructions in Windows
2000 documentation on adapter setup.

3 In the list, highlight Internet Protocol (TCP/IP) and click Properties.
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The Internet Protocol (TCP/IP) Properties dialog appears.

4 Choose “Use The Following IP Address”.

5 In the box for IP Address, enter the address for that machine.

Check your list to make sure the entry is correct.

6 In the box for Subnet Mask, type these numbers (these are the same for
every machine):

255.255.255.0

If you are on a large corporate network, this subnet mask might be
different. In this case, use the mask that your network administrator
specified. Also, change the network mask when setting up a server to
connect to a manager as well as in the Network Job Assignment dialog
to match the subnet mask in order for Automatic Search to work.

7 Click OK to close each dialog in turn.

Windows XP finishes configuring the software.

8 Reboot the computer to complete the configuration.

9 Repeat all the steps on this page on every machine in your network.

Remember that each machine needs to have a unique IP Address and
machine name so no conflicts arise.

Creating a Special User Account

If you run the Server as a Service, you should create a special user account,
which gives the Server the right to access other machines on the network for
necessary maps, xrefs and output directories. This account must be identical
across all rendering server machines.

By assigning a user to the rendering Server service, you configure the rendering
server to operate with the permissions and access rights of that user account.
Without this assignment, the rendering server operates with system
permissions, which do not let the server service access map, xref, image, or
output directories on other machines.

NOTE These steps require you to have administrative privileges on every machine
where you set up this account.

For the following procedures, Windows XP was set to display a Classic Windows
interface.
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Procedures

To create a new user (Windows 2000 and XP):

1 From the Start menu, select Settings > Control Panel > Administrative
Tools > Computer Management.

2 In the Computer Management dialog, go to System Tools > Local Users
and Groups > Users.

3 In the right-hand pane, right click in a blank area and choose New User
to display the New User dialog. If the New User option is unavailable,
you don't have the required administrative privileges.

4 In the New User dialog, do the following:

■ Enter a user name for the new account in the Username text box. This
can be any name, but it should be the same across all network
rendering machines.

■ Enter a password for the new account in the Password and Confirm
Password boxes. Like the user name, this password needs to be the
same for all rendering servers.

■ Turn off “User Must Change Password At Next Logon” and turn on
“Password Never Expires”.
This will bypass errors when you assign this special user account to
the rendering service.

■ Click Create to create the new user and password.
When the network is part of a domain it is a good idea to have your
network administrator create a special user account on the domain.
This user account would have read/write access to the network servers
where maps, xrefs and frames are stored.

■ Click Close.

5 Do not close Administrative Tools.

To assign a user to a rendering service (Windows 2000 and XP):

Do the following on every computer used as a rendering server:

1 Make sure each server system is set up with the Network Rendering Server
on page 6516 running as a service.

2 From the Administrative Tools windows, choose Services to display the
Services dialog.
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3 From the Service list, right-click the Backburner Server item.

4 Choose Properties to display the Properties dialog.

5 On the Log On tab, choose This Account and enter the name of the new
user you created for the special user account.

If a user account was created on the domain, you would enter [domain
name]\[user name] as This Account, or you can browse the domain for
the user.

6 In Password and Confirm Password fields, enter the password for the
special user account.

7 Click OK to exit the Properties dialog.

8 If the service is started, stop it by right-clicking the item and choosing
Stop.

9 Right-click the item and choose Start to restart the service with the newly
assigned user.

NOTE If you did not turn off “User Must Change Password At Next Logon”
when setting up the new account, you will encounter errors. You will need
to re-login the newly assigned user so you can first change the password.
Once the password is changed, the Backburner Server should start.

10 Close the Services dialog

Setting Up Rendering Software

When you've configured the computers on your rendering network for TCP/IP,
you're ready to load the software.

You need to install 3ds Max on each system you plan to use for network
rendering. After you've installed 3ds Max on all the systems, at least one of
them needs to be authorized. This is the copy of the software that you will
run interactively and is used to submit jobs for network rendering.

Refer to the Installation Guide for details about installing 3ds Max.

NOTE A system using the scanline renderer, that is intended to act a dedicated
rendering server, does not require authorization for 3ds Max.

6474 | Chapter 20   Rendering



Setting Up Directories

During network rendering, common directories (directories that are shared
across the network) allow access to files needed by all the rendering servers.
You can organize, share, and (if necessary) mount these directories.

There are two types of common directories:

■ Map directories One or more directories where maps and images are
stored. These can be both project-specific and general locations.

■ Output directory A single directory where completed frames are sent
from each rendering server, also called the target directory. You specify
this directory for each job. This can also be a local directory on each
machine.

The network rendering system uses the Universal Naming Convention (UNC)
to identify directories and files. UNC names begin with a double backslash
and do not include a drive letter. This is the convention:

\\machine_name\directory\subdirectory\filename

IMPORTANT To simplify network rendering, use UNC names whenever possible
within a 3ds Max scene, even if the directory is on the local machine.

TIP When entering UNC names, omit the \\ before the computer name until
you've entered the entire path and file name. This eliminates search delays when
entering UNC path names into file selection dialogs.

Some networks require drive letters instead of UNC names. Directories on
such networks can be mounted as drive letters and shared over the network.
See Mounting a Directory on page 6478.

Organizing Directories

Correctly organizing directories is critical to the success of your rendering
farm. Every element in a scene needs to be available to each server for a
complete rendering. The goal is to give every machine in your network the
same "picture" of where files are located. Follow these rules when organizing
your directories:

■ Share directories on page 6477 to make them available to the network.

■ Use UNC file specification when assigning maps files and output directories,
even when the directory is on a local machine.
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Creating Map Directories

As you assign materials in a scene, the software stores the complete path to
each map you use. The program searches for that particular location. If
necessary, the program continues to look through the directory containing
the scene file and its subdirectories.

Maps, specific to a project, should be kept in a dedicated directory that has
been set up for that project. You can create subdirectories below this directory
to organize files. This directory needs to be shared using Windows Explorer.

Maps for general use, such as texture libraries, can be organized as you choose.
The computers containing such libraries need to be on the network, and the
directories need to be shared.

Creating a Common Output Directory

A common output directory is a single directory on one hard disk where
rendered frames accumulate during network rendering. When creating a
common output directory, follow these guidelines:

■ Decide on a machine to accept final output. It should have enough disk
space to store the largest completed animation file you're likely to render.

■ Create or choose a directory for final output.

■ Share that directory as a resource available to the network.

Creating a Local Output Directory

A local output directory lets you use available storage on each rendering server.
Rendered frame files are sequentially numbered when assigned by the network
manager. When you collect the finished frames, they automatically sort in
the proper order. When creating a local output directory, follow these
guidelines:

■ Use the same path and name for all local directories. For example, use
\3dsmax_files\images\.

■ Use the same path and name for all local directories. For example, use
\Program Files\Autodesk VIZ 2008\images.

■ Specify this path for the output directory when you start network rendering.
All rendering servers will then send their output to this local directory.
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On any one rendering job, use either a common or local output directory.
They cannot be mixed.

See also:

■ Mounting a Directory on page 6478

■ Using Configure User Paths on page 6479

Sharing a Directory

You share a directory from the machine where the directory is located. This
gives other machines on your network access to that directory. The instructions
below are general. See your Windows Vista, Windows XP, or Windows 2000
documentation for details.

Next Step

Initial Setup for Manager and Server Programs on page 6501

See also:

■ Mounting a Directory on page 6478

■ Using Configure User Paths on page 6479

Procedures

To share a directory:

1 Go to the machine that contains the directory you want to share.

2 In Windows Explorer, right-click the directory to share, and then choose
Sharing from the right-click menu.

3 If using Windows XP or Windows 2000, on the Sharing tab, choose the
Share This Folder option.

4 If using Windows NT4, on the Sharing tab, select the Shared As option.

5 Use the default Share Name.

6 Click Permissions and make sure permissions are set to Everyone/Full
Control. Click OK to exit the Permissions dialog.
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7 Click OK to accept the changes.

NOTE If you plan to use more than 10 rendering servers, both the output
path and location of all scene maps should be on a system running Windows
XP or Windows 2000 Server, as both Windows XP Professional and Windows
2000 Professional have a limit of 10 simultaneous connections.

Mounting a Directory

You can mount a directory to a drive letter as an alternative to using UNC
names on page 8160. In mixed UNIX/XP/2000 networks, for example, you might
need to mount the output directory.

For network rendering, you mount (or map) the directory on all machines in
the network. This gives all rendering servers access to the shared directory.

Before beginning this setup, choose a common drive letter for all servers to
mount. If you have other drives mounted, you might need to switch
assignments to free the drive letter for this mount.

If a Map or Target directory is on a rendering server, mount the directory on
this machine like all the others, even if the directory is on the local disk.

When using a mounted directory, be sure that the directory to be mounted
is correctly shared. When assigning bitmaps, always use the path with the
common drive letter.

The steps below are general. See your Windows XP or 2000 documentation
for more details.

NOTE During the writing of these procedures, Windows XP was set to display a
Classic Windows interface.

See also:

■ Sharing a Directory on page 6477

■ Using Configure User Paths on page 6479
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Procedures

To map a directory to a drive letter (Windows 2000 or XP):

1 In Windows Explorer, choose Tools > Map Network Drive to display the
Map Network Drive dialog.

2 Set the Drive drop-down menu value to the common drive letter you've
chosen.

3 In Folder, enter the exact location of the output directory, using UNC
convention.

You can also map a directory to a drive letter by choosing the machine
and shared directory with the Browse button in the Map Network Drive
dialog.

4 Click Finish to complete the mount.

NOTE If the drive maps to a server on a large corporate network, you may
be required to enter your user name and password to gain access.

Using Configure User Paths

Render-only machines do not require any form of authorization. However,
you cannot use unauthorized versions of the software to access the Configure
User Paths dialog on page 7729 to specify alternative locations for servers to
search for bitmap files.

If you do not want to concern yourself with configuring paths on render-only
machines (servers), then turn on the Use Alternate Map Path or Include Maps
option on the Network Job Assignment dialog on page 6481.

The Use Alternate Map Paths option lets you specify an alternate folder where
the rendering server can look for bitmaps if they are not found in the primary
bitmap path.

If using Include Maps, network rendering will take care of making copies of
the bitmaps and send them to the server assigned for rendering. When the
rendering job is done, the copies are erased from the server hard drive. The
files are placed in a \network\serverjob subdirectory of the software.

If a server cannot find a bitmap image in the path specified in the file, it then
searches the paths listed in its own Bitmaps panel. Only after searching in all
locations will the server fail due to missing maps. If you have followed

Setting Up Rendering Software | 6479



instructions in the previous topics (Setting Up Directories on page 6475, Sharing
a Directory on page 6477, and Mounting a Directory on page 6478), then you know
that a common map directory on the network is the best way to proceed. Use
the following steps to properly configure your paths on the machine running
the authorized copy of the software and on the servers meant for render-only
purposes.

See also:

■ Sharing a Directory on page 6477

■ Mounting a Directory on page 6478

Procedures

To add bitmap paths to the External Files panel from within the software:

1 Run the software on a machine running an authorized copy of the
program.

2 Choose Customize > Configure User Paths to open the Configure User
Paths dialog, and then click the External Files tab, if necessary.

3 Use the Add button to specify the paths (UNC on page 8160 or mounted)
to every directory on the network where bitmap files are stored for
rendering. Make sure you use UNC or mounted directories, even if the
maps are on the local drive.

4 Click OK.

To add bitmap paths to render-only machines using the initialization file:

Use the following steps if you do not want to authorize the software on the
server machine(s).

1 Install the 3ds Max core software on the server station(s).

2 Copy the 3dsmax.ini on page 83 file from your authorized 3ds Max
workstation to the program directory of each of your server(s).

If you followed the previous procedure, the copied initialization file contains
information about UNC or mounted directories that stores the required bitmap
files.
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NOTE To prevent mishaps, it is usually a good idea to edit the INI file once it is
copied to the server. Remember that the server machine can be configured
differently than your 3ds Max workstation: The drive letter, program directory,
and subdirectories may be different. Use a word processor to edit all entries under
the [Directories] section to match entries of the server machine.

For example:

[Directories]

Fonts=d:\3dsmax\fonts

Scenes=d:\3dsmax\scenes

Import=d:\3dsmax\meshes

Export=d:\3dsmax\meshes

...

Network Job Assignment Dialog

Rendering menu > Render Setup > Render Setup dialog > Turn on Net Render
(Render Output group) > Render

Rendering menu > Render To Texture > Render To Texture dialog > Turn on
Net Render (Render Settings group) > Render

Rendering menu > Video Post > Set up a sequence with an Image Output Event
> Turn on Net Render (Output group) > Render

Use the Network Job Assignment dialog to name rendering jobs, specify the
computers that will participate in the rendering, and submit jobs to the
rendering servers.

You can submit as many jobs as you like in a single session. Open each file
you want to render and submit it following the standard procedure. Each job
is placed behind the last one submitted. If you submit a job in which the
frame output name is the same as another job in the queue, a warning dialog
asks you if you want to overwrite the output frames from the other job.

You can divide the work of rendering a single image among any number of
rendering servers. This is particularly useful when rendering a single, extremely
high-resolution image intended for print. To use this feature, turn on the Split
Scan Lines option on page 6486.
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Procedures

To use the Network Job Assignment dialog:

The Network Job Assignment dialog is accessible when you turn on the Net
Render toggle. The Net Render toggle can be accessed from three different
dialogs used for rendering.

1 Rendering menu > Render Setup > Render Setup dialog > Render Output
group

2 Rendering menu > Render To Texture > Render Setup dialog > Render
Settings group

3 Video Post dialog > Execute Sequence > Execute Video Post dialog >
Output group

4  In the Render Setup dialog > Render Output group, click the ellipsis
button and then specify an output file name and path using Universal
Naming Convention (UNC) on page 8160. The easiest way to specify a UNC
path is to start with Save In > My Network Places.

5 Turn on Net Render.

6 Click the Render button.

The Network Job Assignment dialog appears.

7 On the Network Job Assignment dialog, specify a job name.

By default, this is the file name of the current scene. Click the plus (+)
button next to the Job Name field to increment the job name. Unlike the
plus button in the file dialogs, this button does not automatically launch
the job.

NOTE The software does not let you submit multiple jobs with the same
name.

8 Determine whether to find the Manager automatically or manually. By
default, the software searches automatically for the Manager using a
network mask that you specify in the dialog. Alternatively, turn on Manual
Search and enter the name or IP address of the computer running the
Manager program.

9 Click Connect to continue.

You see a listing of all servers available for network rendering. Each server
is marked with a colored icon to denote its current status:
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Green Running and not rendering any jobs.

Yellow Rendering another job. You can assign jobs to busy servers, and
the jobs will be rendered in the order received.

Red Failed. Try rebooting the server or see Troubleshooting on page 6455
for more information on failed servers.

Gray Absent. Verify that the Server is currently running and that it has
not been "Disallowed" in the Week Schedule. See “Scheduling the
Availability of a Render Node Using the Backburner Monitor” in the
Autodesk Backburner User’s Reference.

If a rendering Server is running on a workstation that also has an
interactive session of the software, you can still select that machine for
rendering. A second copy of the software is launched to execute the
network render.

You can view statistics of a particular Server by right-clicking its name
and choosing Properties.

10 Determine whether you will use the selected server, all servers, or a group
of servers.

11 Click Submit to send the job to the rendering queue.
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Interface

Job Name Provides a field for you to name the job (mandatory). The + button
beside the field adds incremental numbering (Job01, Job02, and so on).

NOTE The software does not let you submit multiple jobs with the same name.

Description Enter an optional description of the job.

Enter Subnet Mask/Enter Manager Name or IP Address group

Enter Manager Name or IP Address When Automatic Search is turned off,
enter the name of the Network Manager on page 8057 machine or its IP address.
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Enter Subnet Mask When Automatic Search is on, enter a subnet mask for
automatic search. For information on using subnet masks.

Connect/Disconnect Connects to the network Manager. The software
preserves the connection as a global setting so that you need to change it only
when you want to specify an alternative Manager. If connected to the network
manager, click Disconnect to disconnect from the current manager so you
can choose a different manager.

Automatic Search Determines whether the software connects to a specific
manager or searches for one using a subnet mask when you click Connect.
When off, the software attempts to connect to the manager you specify in
this group. When on, it searches the network for a manager using the specified
subnet mask.

Refresh Updates the Server and Job lists.

By default, all servers are used for the job. When the Options group > Use All
Servers check box is turned off, you can choose one or more servers to render
the job. If rendering to a multiple-frame file format, such as an AVI or MOV
file, you can choose only one server.

Priority group

Priority Specifies a priority ranking for the job. The lower this setting, the
higher the job priority. Default=50.

For example, consider a job with priority 1 (Job B) that is submitted to a
network manager that's already rendering a job with priority 2 (Job A). Because
Job B has a higher priority, Job A will be suspended and Job B rendered. When
Job B is finished, the software will resume rendering Job A.

If two or more jobs have the same priority, they're executed in order of
submission.

Critical Sends the job to the head of the queue, preempting the existing jobs.
If a server is currently rendering and a critical job is sent to the queue, the
server will stop rendering its current job and begin rendering the new, critical
job. When finished with the critical job, the server returns to the next job it
has been assigned in the queue.

Dependencies Opens the Job Dependencies dialog on page 6490, which you
can use to specify existing jobs that must finish before the current job can
start.
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Options group

Enabled Notifications Lets the software send rendering-related messages via
email. When this is on, its Define button becomes available. For information,
see the Notifications dialog on page 6492 topic.

Define Opens the Notifications dialog, which lets you set notifications
parameters.

Split Scan Lines Lets you subdivide the rendering of each frame among the
rendering servers. This is useful when rendering a single, extremely
high-resolution image intended for printing. For information, see the Strips
Setup dialog on page 6494 topic.

When Split Scan Lines is on, its Define button becomes available.

NOTE This feature does not support Render Elements. Also, it's unavailable when
rendering to textures with projection mapping enabled and Sub-Object Levels on.

Define Opens the Strips Setup dialog, which lets you set parameters for the
Split Scan Lines option.

Ignore Scene Path When off, the server attempts to copy the scene file from
the manager to the server. If the manager is running on Windows 2000
Professional, only 10 servers will copy the file from the manager; any machines
over the limit 10 will use TCP/IP to retrieve the file. When turned on, the
servers get the file via TCP/IP only. Default=off.

Rendered Frame Window During rendering, displays the Rendered Frame
Window on all servers running serverapp.exe (not serversvc.exe). Default=on.

Include Maps Archives the scene, with all of its maps, any inserted Xrefs and
their maps, into a proprietary-format compressed file. The compressed file is
sent to each Server, where it is uncompressed into a temporary directory named
serverjob in the \network subdirectory of the program and rendered. Default=off.

Use this feature if you have access only to Servers that exist over the Internet
or if you have a slow network setup. It is not meant for heavy production use.
However, if you don't use it, you must first ensure that all network servers
have access to all map and Xref paths referred to in the scene.

Initially Suspended Adds the named job to the queue in an inactive state.
The job is not started until you activate it manually from the Backburner
Monitor. See “Monitoring and Managing Jobs” in the Autodesk Backburner User’s
Guide.
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Server Usage Group

You choose between using all available servers, all servers in a group, or selected
servers. See “Configuring Server Groups” in the Autodesk Backburner User’s Guide
for an explanation of how to set up server groups. In a 3ds Max setup it can
be useful to set up servers in groups. For example, during busy times you can
assign high priority jobs to a group of high performance servers.

Use Selected Uses only the servers that you have highlighted in the Server
list.

Use Group Uses all of the servers in a group.

TIP Note that the servers are assigned to a group in the Autodesk Backburner
monitor.

Group drop-down list Choose the group of servers that you want to use for
your render.

Use All Servers Uses all Servers in the active Server group for rendering the
job. Available only after you submit a multi-frame rendering job.

Path File Group

Use Alternate Path File Allows you to specify an alternate path file in the
MXP format that rendering servers can use to find bitmaps that are not found
on the primary map paths. When on, you can manually enter the path and
file name in the field below the check box, or click the ellipsis button and
browse to the MXP file.

NOTE Create MXP files with Configure User Paths on page 7729.

Status group

Displays text messages describing the current status of the job assignment.

Server list

The Server list, located on the upper-right side of the Network Job Assignment
dialog, displays all network rendering servers on page 8058 registered with the
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network manager after you connect to the manager. There are two types of
tabs in the Server list:

■ All Servers Lists all of the available servers that can be used for your
render. When this tab and Use All Servers are enabled, all servers will be
used to render the job.

■ [group name] Lists all of the servers assigned to a group. When this tab
and Use Group are enabled, all servers listed on the tab will be used to
render the job.

NOTE If a server is unavailable it will be skipped and the next available server will
be used.

If more groups are available than can fit in the space above the list, arrow
buttons for scrolling the group list horizontally appear above the list's top-right
corner. Click these arrow buttons to scroll the list left or right to view
additional group tabs.

By default, each Server is marked with a colored status icon:

■ Green Running and not rendering any jobs.

■ Yellow Rendering another job. You can assign jobs to busy Servers, and
the jobs will be rendered in the order received.

■ Red Failed. Try rebooting the Server or see Troubleshooting on page 6455
for more information on failed Servers.

■ Gray Absent. Verify that the network Server is currently running and
that it has not been "Disallowed" in the Backburner Monitor. See
“Launching the Backburner Monitor” in the Autodesk Backburner User’s Guide
for information on viewing activities in the monitor.

NOTE You can change the height of the server list window relative to the job list
window below it by dragging the partition vertically.

Server list right-click menu

By default, servers are listed by name only. To see more information about a
server, right-click its name in the list. A menu appears with these options:

Properties Displays the Server Properties dialog, which shows aspects of the
server hardware and operating system, including memory and disk space.
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All Server Details This toggle, when on, displays all details about each server
to the right of its name. When off, restores the last saved set of partial server
details unless the last saved set was All Server Details, in which case it restores
the default set: name only. See the following item for the list of available
details.

NOTE You can see more details by scrolling the list with the horizontal scroll bar
at the bottom, or by widening the dialog by dragging its right side with the mouse.

Partial Server Details Opens the Set Server Property Tabs dialog, which lets
you specify which details are shown in the Server list. The dialog provides
check boxes for turning on and off the display of these details:

■ Status: See Server list on page 6487 for status details.

■ Number of CPUs

■ Total Physical Memory - in bytes

■ Operating System

■ Work Disk Space - in megabytes

■ Historical Performance Index - see note below

■ Handle - a hexadecimal identification number for the machine

■ User - current user name

NOTE The Historical Performance Index value, listed under the Perf. Index heading
in the Server list window, offers information on the relative speed of the listed
servers. The fastest machine is rated at 1.0, while the other servers are rated as
fractions of the fastest. A machine whose average is twice as long would receive
a .50 index. Each machine is rated by measuring the time it takes to complete
each frame, and the accumulated time is divided by the number of frames, resulting
in the average time per frame, in seconds.

Several factors can affect a machine's performance. CPU power isn't necessarily
a concern when large file transfers are involved. For example, if a certain job
uses several map files from a centralized server, the performance of the network
throughput plays a much larger part than CPU performance, as most machines
will spend the majority of the time reading maps. On the other hand, if the
machine has all maps locally it will have a huge advantage (local access versus
network access) regardless of which CPU it is using. The performance index
provides you with information regarding your servers' rendering performance

Network Job Assignment Dialog | 6489



to help analyze your network rendering setup and better distribute the
workload.

Job list

The job list, located on the lower-right side of the Network Job Assignment
dialog, displays all jobs submitted to the network manager. Also shown are
each job's priority, status, and output file path.

To change job settings and manage jobs, use the Backburner Monitor. See
“Modifying Job Settings” and “Monitoring and Managing Jobs” in the Autodesk
Backburner User’s Guide.

Advanced Opens the Advanced Settings dialog on page 6497, where you can
make settings for Per-Job Timeouts, TCP port number, Pre-Render MAXScripts
and Job Handling.

Submit Click Submit to exit this dialog and send the current job to the
Network Manager, which places it in the queue for rendering.

When you submit a rendering job, if the output file name to be used by the
job is the same as that used by an existing job, you're asked if you want to
overwrite the existing file(s). Also, if the name of the submitted job replicates
one already in the rendering queue, an alert notifies you; click OK, change
the job name, and submit it again.

NOTE Submitting a job creates a folder for the job on the manager machine in
the \Program Files\Autodesk\Backburner\Network\jobs\ folder. In that folder is a
compressed file with a .maz extension containing the scene file. You can extract
the scene from the command prompt using the maxunzip.exe program, found in
the 3ds Max program directory. For example, to extract a file named testfile.maz,
assuming the program is installed in a folder named \3ds Max 2009\, open the
command prompt, navigate to the \Program Files\Autodesk\Backburner\Network\jobs
folder, and enter this: “\Program Files\Autodesk\3ds Max 2009\maxunzip”
testfile.maz. You must specify the .maz file-name extension; otherwise you'll get
an error message.

Cancel Discards changes and exits the dialog.

Job Dependencies Dialog

Rendering menu > Render Setup > Render Setup dialog > Turn on Net Render
(Render Output group). > Render > Network Job Assignment dialog > Connect
to a Manager. > Priority group > Dependencies
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Rendering menu > Render To Texture > Render To Texture dialog > Turn on
Net Render (Render Settings group) > Render > Network Job Assignment dialog
> Connect to a Manager. > Priority group > Dependencies

Rendering menu > Video Post > Set up a sequence with an Image Output Event
> Turn on Net Render (Output group) > Render > Network Job Assignment
dialog > Connect to a Manager. > Priority group > Dependencies

This dialog lets you specify jobs that shouldn't begin rendering until other
jobs finish. Use the two lists and the Add and Remove buttons to build a list
of jobs that must finish rendering before the current job can start.

Interface
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Existing Jobs list Lists all previously submitted jobs. To specify a dependency
for the current job, add one or more of these to the Jobs Your Job Depends
On list.

Add Select one or more jobs your job is to depend on, and then click Add to
add them to the Jobs Your Job Depends On list.

Add All Adds all jobs in the Existing Jobs list to the Jobs Your Job Depends
On list.

Remove Removes highlighted jobs from the Jobs Your Job Depends On list.

Remove All Removes all jobs from the Jobs Your Job Depends On list.

Jobs Your Job Depends On list Lists all previously submitted jobs. To specify
a dependency for the current job, add one or more of these to the Jobs Your
Job Depends On list.

Notifications Dialog

Rendering menu > Render Setup > Render Setup dialog > Turn on Net Render
(Render Output group) > Render > Network Job Assignment dialog > Options
group > Turn on Enabled Notifications. > Define

Rendering menu > Render To Texture > Render To Texture dialog > Turn on
Net Render (Render Settings group) > Render > Network Job Assignment dialog
> Options group > Turn on Enabled Notifications. > Define

Rendering menu > Video Post > Set up a sequence with an Image Output Event
> Turn on Net Render (Output group) > Render > Network Job Assignment
dialog > Options group > Turn on Enabled Notifications. > Define

This dialog lets a network rendering job send notifications via email. Such
notifications can be useful when you launch a lengthy render, such as an
animation, and don't care to spend all your time near the network manager
system.

See also:

■ “Configuring Backburner Log Files” in the Autodesk Backburner User’s Guide

6492 | Chapter 20   Rendering



Interface

Categories group

Notify Progress Triggers a notification to indicate rendering progress. A
notification is triggered every time the number of frames specified in Every
Nth Frame has completed rendering. Default=off.

Every Nth Frame The number of frames used by Notify Progress. Default=1.

Notify Failures Sends an email notification only if something occurs to prevent
the completion of a rendering. Default=on.

Notify Completion Sends an email notification when a rendering job is
complete. Default=on.
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Email Options group

Send Email Notifies via email.

Include Summary Includes a summary of the network rendering progress
with the notification email. Available only when Send Email is turned on.

From Enter the email address of the person who initiates the rendering job.

To Enter the email address of the person who needs to know the rendering
status.

SMTP Server Enter the numeric IP address of the system you use as a mail
server.

Strips Setup Dialog

Rendering menu > Render Setup > Render Setup dialog > Common tab > Turn
on Net Render (Render Output group) > Render > Network Job Assignment
dialog > Options group > Turn on Split Scan Lines. > Define

The Strips Setup dialog lets you specify how to split up the rendering of a
single, large image among several different servers on the network. The software
automatically subdivides the rendering based on settings you provide, and
then fits the pieces together into the final image.

NOTE A version of this feature was known as Region Net Render in previous
versions of the software.

Procedures

To render a large image with a networked render farm:

1 Set up a scene to render.

2 Set up your system for network rendering on page 6433.

3 From the Rendering menu, choose Render Setup.

The Render Setup dialog opens, with the Common tab active.

4 In the Output Size group, specify the size to render.

5 In the Render Output group, specify an output file name and location,
and turn on Net Render.

6 Click the Render button.
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The Network Job Assignment dialog appears.

7 In the Options group, turn on Split Scan Lines, and then click Define.

The Strips Setup dialog appears. The dialog displays the output resolution,
and lets you determine how to split up the rendering job by specifying
the number of horizontal strips into which the image will be subdivided.

8 Specify the vertical size of each strip in pixels or as a percentage of the
total image height, or set the number of strips. Changing one also changes
the other.

9 Set the overlap in pixels or as a percentage.

Using overlap isn't always necessary, but if you notice anomalies where
the strips meet, increase this value.

10 Connect to the manager, specify a job name, choose one or more servers
on which to render, and then click Submit.

The job is sent to the network rendering manager, which supervises the
network rendering job. The job consists of first rendering each slice, and
then combining, or “stitching,” the slices into the final image.

11 Monitor the job via the Backburner Monitor. See “Monitoring and
Managing Jobs” in the Autodesk Backburner User’s Guide.

Rendering and stitching passes are designated “Slice Pass” and “Stitch
Pass,” respectively. When all slices are finished, the job status will be
Complete.
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Interface

Output Resolution This read-only field displays the horizontal and vertical
resolution of the final image, in pixels.

Strip Height Sets the height of each horizontal strip in pixels or as a percentage
of the total height. Default=10 percent of the total image height, in pixels.

This setting is interdependent with and inversely proportional to the Number
Of Strips setting; increase one, and the software decreases the other.

Number of Strips Sets the number of horizontal strips to be rendered by the
available servers. Default=10.

The value determines the maximum number of machines to which the job
can be farmed out. For example, if you use the default setting of 10 strips, the
job can be performed by 10 machines at most. In that case, assuming equal
performance of all 10, rendering would take approximately one-tenth the
time required by one machine.
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TIP For optimal results with render farms that comprise machines of different
speeds, use a value high enough that the job can be completed most efficiently.
For example, consider a two-server network with one machine four times as fast
as the other. If you set Number Of Strips to 2, the job won't be finished until the
slower machine renders its half of the final image. But if you set Number Of Strips
to 4, the faster machine can render three of the strips while the slower machine
renders one, effectively halving the total render time.

This setting is interdependent with and inversely proportional to the Strip
Height setting; increase one, and the software decreases the other.

Overlap Set the amount by which each strip overlaps the adjoining one(s).
You can set this in pixels or as a percentage of the final image height.

A certain amount of overlap is necessary to compensate for image artifacts
created by antialiasing and render effects. If you notice anomalies where the
image slices meet, try increasing the Overlap setting.

Pixels/Percentage Determines whether the Strip Height and Overlap settings
represent pixels or a percentage of the final image height. Choosing a different
option automatically changes the two values accordingly.

Delete Temporary Images Upon Completion Deletes the “slice” images after
the final image is created. Default=off.

Advanced Settings Dialog

Rendering menu > Render Setup > Render Setup dialog > Render Output group>
Turn on Net Render > Render > Network Job Assignment dialog > Advanced

Rendering menu > Render To Texture > Render To Texture dialog > Turn on
Net Render (Render Settings group) > Render > Network Job Assignment dialog
> Advanced

Rendering menu > Video Post > Set up a sequence with an Image Output Event
> Turn on Net Render (Output group) > Render > Network Job Assignment
dialog > Advanced

The Advanced Settings dialog lets you set job timeouts on a per-job basis,
assign the TCP port number, specify pre-render scripts and affect job handling
and archive settings.
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Interface

Per Job Timouts Group

Enable Turns on the ability to set timeouts on a per-job basis. The remaining
settings in this group become available only when Enable is turned on.

Wait for MAX to Load Specifies the amount of time after a job is submitted
that the Manager waits for a server to report that it received the frame and is
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rendering. If this value is exceeded, an error message is logged for a failed
frame, and the frame is assigned to a different server.

Wait for MAX to Render Specifies the amount of time the manager waits
between when a server reports that it has started and finished rendering a
frame. If a server exceeds the specified value, it is flagged as "failed" by the
manager, and no more frames from that job are sent to it.

Wait for MAX to Unload When a job is complete, the manager tells the server
to unload the software, then waits for a reply from the server saying 3ds Max
is down and it's ready for a new job. This spinner specifies the amount of time
the Manager will wait for the Server to reply to this notification. If a server
exceeds the specified value, it is flagged as "failed" by the manager, and no
more frames are sent to it.

Connection to Manager group

Use this setting to specify the Manager for this job.

TCP Port Number Specifies the port number of the Manager to which this
job is to report.

Submit Job As radio button Specifies which platform your scene is rendered
on. Use this button when you want to render your scene on a different platform
(either 32- or 64-bit) from the platform where you created your scene. This is
particularly useful in situations where you are working on a given platform
which differs from the platform of the render farm. The most consistent results
are achieved when you submit jobs are created and rendered on the same
platform.

NOTE This is an advanced option provided to accommodate specific render farm
configurations. By default this option is set to the most compatible platform that
avoids rendering to platforms where data-loss may result.

Server Assignment Limit

Enable Limit Sets the maximum number of servers that will be allocated for
a specific job. This limit can be overridden with the Use Server Limit field in
the Backburner Manager General Properties dialog , so that the administrator
of a render farm can control job sharing globally.

MAX server count Specifies the number of servers.

Network Job Assignment Dialog | 6499



Job Handling group

Enable Task Blocking Allows the job to override the task blocking set in the
Manager. Some jobs will have their frames processed more efficiently if task
blocking is turned off. Default=on.

Override Global Settings This switch lets you override job archiving settings
made in the Backburner Manager General Properties dialog. It lets you set the
archive settings for the job about to be submitted. When Override Global
Settings is turned on, the following three switches become active. Default=off.

NOTE Any setting made while Override Global Settings is turned on, remains
active from one 3ds Max session to the next. For example, if you choose to leave
jobs in the queue, submit the job and exit 3ds Max, the setting will be active when
you choose to submit jobs in the future.

Leave It In The Queue This switch tells the network manager to leave the
job in the queue without deleting it or archiving it.

You might use this switch if you are submitting a job that might need to be
re-rendered at a higher resolution without making any other changes to the
scene.

Archive It When turned on, the job is archived when the rendering is
complete. Default=on.

Archiving is useful when you submit a final version of the scene and you know
that there won't be any more changes to the scene. Before submitting the job,
you set the job to archive upon completion.

Delete It Upon completion, the job is deleted from the queue when this switch
is turned on.

If the scene you're network rendering is just a test shot and you're just doing
a quick test of the scene, you don't really want to keep the job in the queue
once it's completed. Before submitting the job, turn on this switch.

Defaults Returns all settings to their defaults.

OK Accepts any changes and closes the dialog.

Cancel Closes the dialog without saving changes.
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Manager and Server

Initial Setup for Manager and Server Programs

The files necessary for network rendering are copied to the Backburner root
directory when you install the software. Two of these files, manager.exe and
server.exe, require initialization before they can be run. Set up the Manager
program first, then the Server. When you're finished, you can start network
rendering. After setup, you can run both Manager and Server as services by
installing managersvc.exe and serversvc.exe, respectively.

You need to initialize only one machine as network Manager. This can be any
machine on the network, and can be used on a machine running the Server,
3ds Max, or both.

You need to initialize every machine used as a rendering Server. This is done
once to establish the connection between the rendering Server and the network
Manager.

The Manager and Server programs can be run in application mode as explained
in the procedures that follow, or as Windows 2000 or XP services, in which
case they run in the background and provide less feedback on the progression
of the rendering job. To learn more about installing these programs as services,
see Installing Network Services on page 6503.

Initialization is done only once for each service. Each initialization process
creates or updates the following:

■ A subdirectory called \Network under the Backburner root directory,
containing several further subdirectories, including \Jobs, \Servers, and
\ServerJob. By default, the Backburner directory is called Backburner, and is
found in the \Program Files\Autodesk\ directory.

■ A file with initialization parameters (backburner.xml).

■ A log file that keeps track of what the services do (backburner.log).

Next Step

Starting Network Rendering on page 6450
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Procedures

To initialize the Manager program:

■  Run the Manager program from the Start menu > Programs >
Autodesk > Backburner menu.
The first time you launch the Manager, it creates the backburner.xml file,
which stores the manager configuration settings.

The Backburner Manager General Properties dialog also appears the first time
you run Manager. In most cases, you can safely proceed by accepting the
default settings and clicking OK. Thereafter, you can modify the configuration
settings by choosing Edit menu > General Settings to open the General
Properties dialog. For the new settings to take effect, you need to close the
manager and restart it.

The settings in the General Properties dialog are described in depth in
Backburner Manager General Properties Dialog on page 6512.

To initialize the Server program:

1  Run the Network Rendering Server program from the Start menu
> Programs > Autodesk > Backburner menu.

The first time you run Server, its General Properties dialog appears.

2 By default, the Subnet Mask field is set to 255.255.255.0 with the
Automatic Search option turned on. In most cases, you should leave this
option on. The software detects the machine acting as the manager.

At this point, do not make any other changes in the software’s Backburner
Server General Properties dialog. Settings in the this dialog are described
in detail in Backburner Server General Properties Dialog on page 6520.

3 Click OK on the Backburner Server General Properties dialog to save the
current configuration.

4 The Server starts, and attempts to connect to a Manager automatically.
If no Manager is found on the network, the Server times out and reports
that the Manager is not responding.

5 If the Server eventually fails to connect to the Manager:

■ Check the subnet mask setting in your TCP/IP network configuration.
If it is set to something other than 255.255.255.0, in the Server
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application, go to Edit menu > General Settings, in the dialog, set the
subnet mask to match it and click OK. You will need to shut down
the Server application and restart it for the changes to take effect.

■ If you do not want the Server to connect automatically or the Server
will not connect automatically to the Manager, go to Edit menu >
General Settings and turn off Automatic Search. Click in the Manager
Name Or IP Address field and enter the name or IP address of the
workstation running Manager, and then click OK. You will need to
shut down the Server application and restart it for the changes to take
effect.
This updates the backburner.xml on page 6508 file, which now stores
the Server configuration settings. The next time the Server is run, the
application is launched and the configuration settings are used.

This completes Server initialization.

Installing Network Services

To install the network Manager and network Server as network services under
Windows 2000 or XP, start by doing the following:

1 Run the Application versions of the Manager and Server to properly
configure the applications and make your rendering network operational.

2 Use your network in production so you are sure it is running reliably.

Do not proceed unless these conditions are met.

Installing the network Manager and rendering Servers as Windows 2000 or
XP services allows background rendering and is convenient, but it also means
that you have less information on the rendering server’s screen about problems
when they occur. This is why your network needs to be running smoothly
before taking this step. Running the Manager and Server as services does not
change the information shown in the Queue Monitor.

In the procedures that follow, the Manager and Server services are installed
and registered under Windows 2000 or XP. This installation replaces the use
of application mode (running the Manager and Server manually each time
you want to use them). The services are started automatically every time you
boot the computer, but can also be set for manual startup. The \Network
subdirectory and initialization and LOG files from application mode remain
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in place, but the services operate under Windows 2000 or XP instead of in a
separate process.

You can run the Manager and Server as services directly from a Command
Prompt window or the Run dialog using the -i switch (install as a service).
Then go to Services and start the Manager and/or Server, or reboot.

To remove the Manager or Server once it has been installed as a service, you
must run the program directly from a Command Prompt window or the Run
dialog using the -r switch (remove service).

See also:

■ Creating a Special User Account on page 6472

Procedures

To set up the Manager as a service:

1 Go to the machine on which you will install the Manager as a service.

2 Open a Command Prompt window and change the directory to the
program’s root directory (for example, \Program Files\Autodesk\Backburner\.

3 Type managersvc -i

The following message should be displayed:

Backburner Manager ... Service Installed

4 Go to Windows Control Panel > Administrative Tools > Services,
right-click Backburner Manager, and choose Start.

If you choose Properties from the right-click menu, you can also set users,
passwords, and other parameters.

To set up the Server as a service:

1 Go to the machine on which you will install the Server as a service.

2 Open a Command Prompt window and change the directory to the
Backburner root directory.

3 Type serversvc -i

The following message should be displayed:

Backburner Server ... Service Installed
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4 Go to Windows Control Panel > Administrative Tools > Services,
right-click Backburner Server, and choose Start.

If you choose Properties from the right-click menu, you can also set users,
passwords, and other parameters.

5 Repeat these steps on every machine on which you want to set up Server
as a service.

Logging Properties Dialog

Windows Start menu > Programs > Autodesk > Backburner > Manager or Server
> Edit menu > Log Settings

The Logging Properties dialog lets you specify the types of messages that appear
in the list window on the Manager or Server window and those that are sent
to a log file. Each type of log message is explained below.

Log Message Types

Error

Fatal errors that halt a server's rendering of a job. These errors are preceded
by a red "ERR" in the Manager or Server list window, and include the following:

■ Failed Renderings and Frame Errors (caused by missing bitmaps, missing
texture coordinates, invalid output directory, etc.)

■ Manager not found

■ Error registering server(s)

■ Error writing output file

■ Error Starting 3ds Max

■ Loading timeouts

NOTE You can see a more detailed explanation for server failure in the Queue
Monitor's Server list window.
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Warning

Non-fatal warning information. These errors are preceded by a brown "WRN"
in the Manager or Server list window, and include the following:

■ Manager and/or Servers shutting down

■ Server(s) flagged as failed

■ Loading timeout set too low

■ Rendering timeout set too low

Info

General information about the current status of the Manager or Server. These
errors are preceded by a aqua "INF" in the Manager or Server list window, and
include the following:

■ Booting Network Manager/Server

■ Connection to Server(s)

■ Registration to Manager

■ Job Submitted

■ Job Received

■ Frame Complete

Debug and Debug Extended

Detailed information about TCP/IP packets and the current state of the
Manager and Server. Debug Extended provides a more verbose listing than
Debug. When in doubt, use both. These messages are preceded by a blue "DBG"
in the Manager or Server list window, and include the following:

■ TCP/IP Packets sent and received

■ TCP/IP Packet collection

■ Command Line Arguments used to launch 3ds Max

■ Frames Assigned

■ Log files creation and sent
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■ Assignment Threads

Interface

Log To Screen group

The Log To Screen options determine which types of messages are displayed
in the list window of the Manager or Server window.

Turn on each type of message that you want to be displayed. Error, Warning,
and Info are on by default.

Log To File group

The Log To File options determine which messages saved to log files. These
are the same messages that appear on the screen. Turn on any of the following
categories to save it in a log file. When any one of these categories is turned
on, a manager.log file or server.log file is created in your \network directory.
Error, Warning, and Info are on by default.

Buffer Limit Specifies the maximum size of the buffer holding the messages.

Clear Log Clears the buffer holding the messages in the list window.
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Clear Log File Deletes the associated manager.log and/or server.log file.

WARNING Log files are cleared only when you click the Clear Log File button.
When categories are enabled for either or both log files, the files will continue to
grow in size each time you render.

The backburner.xml File

When you run the Manager, Server, or Queue Monitor application, or access
the Network Job Assignment dialog, the software creates or updates an
initialization file named backburner.xml in the \Network subdirectory of the
Backburner directory.

You can change most of the settings in the backburner.xml file using the
Manager Properties dialog on page 6512 and Server Properties dialog on page
6520.

You can change the parameters listed here only by editing the XML file in a
text editing application, such as Notepad. Do so only if you are experiencing
network problems with the network renderer.

Make sure the Manager and Server applications are shut down (or services
uninstalled) before editing the backburner.xml file. The changes will take place
when the Manager and/or Server are restarted.

backburner.xml

■ MaxBlockSize Located under the <GeneralCfg> heading, this value is the
maximum size of a data packet sent when transferring large blocks, such
as projects. For slow connections like modems, it uses a smaller packet
size, for example, 1024.

■ Acknowledgment Timeout Located under the <TimerCfg> heading as
AckTimeout, this value is the amount of time (in seconds) that the system
will wait for an acknowledgment of commands (like Ping) sent back and
forth between the Manager and Server. Default=20 seconds.

■ Acknowledgment Retries Located under the <TimerCfg> heading as
AckRetries, this value determines how many times the sender retries if no
acknowledgment is received. The default is six tries. After that, the machine
is considered down and is put off-line.
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Network Rendering Manager 

Windows Start menu > Programs > Autodesk > Backburner > Manager

The application version of the network rendering Manager provides a graphical
user interface for control and monitoring purposes. It runs as a foreground
process on your desktop, and remains active unless specifically shut down.
Its components include a menu bar, list window, and status bar.

Once you initially set up the Manager using the application version, you can
run it as a service from then on. The service version provides no user interface,
but once it's installed as a service and started, it's always available when the
system is booted. Whichever version you use, you can monitor and control
the rendering queue and system with the Queue Monitor on page 6522.

To start the Manager service, execute the following from a Command Prompt
window or the Start menu > Run function:

“[drive letter]:\Program Files\Autodesk\Backburner\managersvc.exe” -i

Replace "[drive letter]" with the letter of the drive the software is installed on.
If you used a different install path, change the command line accordingly.

Then either reboot the computer or go to Control Panel > Administrative
Tools > Services and start the service. Thereafter the service will remain resident
and active, even surviving reboots.

NOTE When you run the Manager program, you might see this warning message:
Job share not defined. This happens if neither the program folder nor the drive
on which it resides is shared on page 6477. Normally, the servers copy files to be
network rendered from the source machine using standard Windows file-copy
routines, which require sharing to be in effect. If sharing is not in effect, the
manager issues the warning, and then the servers use TCP/IP to copy the files. To
avoid getting the warning message, you can implement sharing, but it's not really
necessary.

To remove the manager service from memory, execute the following from a
Command Prompt window or the Start menu > Run function:

“[drive letter]:\Program Files\Autodesk\Backburner\managersvc.exe” -r
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TIP You can run multiple Managers on the same network. This is especially useful
when using many rendering Servers, to lessen the burden on individual Managers.
When using multiple Managers, it is best to turn off Automatic Search on the
rendering servers and specify a Manager to which to connect, otherwise the
rendering servers will connect to the first Manager they find.

Interface

Menu bar

The menu bar provides access to the functions available in the Network
Rendering Manager application.

File menu

Close Closes the window and minimizes the application to the taskbar tray.
The application remains active when you close it with this menu item or the
close box (X) in the upper-right corner.

Shutdown Quits the application and removes it from memory.

Edit menu

General Settings Opens the Backburner Manager General Properties dialog
on page 6512.

Log Settings Opens the Backburner Manager Logging Properties dialog on
page 6505, which lets you filter the types of messages to appear in the list
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window, and specify whether the messages are sent to the list window or a
log file.

View menu

Status Bar Toggles the display of the status bar, which appears at the bottom
of the Server window. When on, a check mark appears next to this menu item.
Default=on.

Font Size Lets you choose the size of text that appears in the list window.
Choices range from Smallest to Largest.

Autoscroll List Toggles automatic scrolling of the list window. When on, new
items that appear in the list window cause previous contents to scroll up.
When off, you must scroll the window manually to see the latest entries after
it fills up. Default=on.

Help menu

About Manager Displays information about the Manager program, including
version and copyright.

List Window

This area of the Manager interface lists different types of information regarding
the current status of the Manager. Depending on the selections made in the
Logging Properties dialog on page 6505, messages are displayed alerting the user,
for example, to the following:

■ Connection and registration between the Manager and Server(s)

■ New job assignments

■ Which machine is the queue controller (that is, running Queue Monitor)

■ Frames assigned/rendered

■ Acknowledge packets sent between the Manager and Server(s)

■ Manager/Server(s) shutting down

■ Any rendering errors encountered
This information can be filtered using the Logging Properties dialog on
page 6505.
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Manager General Properties Dialog

Windows Start menu > Programs > Autodesk > Backburner > Manager > Edit
menu > General Settings > General Properties dialog

The Manager Properties dialog contains the configuration settings for the
Network Manager. The default settings should work in most cases, but certain
situations may require adjustments. The information specified in the Manager
Properties dialog is written to and contained in backburner.xml (in the \Network
subdirectory). If you run the Manager and the backburner.xml file does not
exist, you're prompted to configure it with this dialog. When configuration
is complete, click OK to run the Manager.
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Interface

TCP/IP group

The two spinners in the TCP/IP group box specify the port numbers to be used
by the software. These numbers must be unique to the software, but every
Server must have the same number.

Manager Port Specifies the port number used by the network Manager.

Server Port Specifies the port number used by the network Server(s).
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NOTE Port numbers are like extensions for different users of the same phone
number. They represent two channels of communication between the Server and
the Manager. Only a trained network administrator should change these settings.

General group

Max(imum) Concurrent Assignments Specifies the number of jobs the
Manager sends out at once. This number is dependent upon the speed of the
processor on the Manager machine, the size of the jobs being sent out, and
the speed of the network system. Generally, a default value of 4 is adequate.
You may want to decrease the value in case the jobs are huge and you have
a modest setup. Similarly, you may want to increase this value if you have a
high-end setup and the jobs are small. Be aware that too high a value may
result in an increased number of timeouts because the jobs are sent faster than
the Servers can handle them. In such a case, decrease the value or leave it at
the default.

User Server Limit Sets the maximum number of servers that will be allocated
for a specific job. This feature overrides the server limit settings in the 3ds
Max Advanced Settings Dialog on page 6497.

Task Error Limit Defines the number of times a server will retry a task before
suspending the task. This option is available only in the Manager General
Properties dialog.

Failed Servers group

This option allows the Manager to automatically restart Servers that have
failed jobs.

Restart Failed Servers Activate to enable automatic Server restarting. If this
option is turned off, the Server will not attempt to render the job again after
the first failure. Default=on.

Number of Retries Specifies the number of times the Manager attempts to
restart a failed Server. Default=3. Range=1 to 1024.

Seconds Between Retries The time, in seconds, between each retry.
Default=30.
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NOTE The state of a Server is kept on a per-job basis. If Restarts Failed Servers is
turned on, the Manager keeps track of when a Server fails a particular job. The
Manager regularly goes through the list of Servers for that job, checking for failures.
If one is found, the Manager checks how long it has been since it failed. If the time
elapsed is greater than the specified Seconds Between Retries, the Manager
decreases the Number of Retries by one and resets the failed flag from the Server.

If a Server fails repeatedly on a specific job (failures are monitored on a per-job
basis), the failure count reaches the specified Number of Retries, and the
Manager stops trying to restart that Server for that particular job. If, on the
other hand, a Server restarts and completes a frame, it is flagged as active and
resumes rendering until the job is complete.

Direct Access To Jobs Path group

Job paths can be useful when dealing with situations where it's not conducive
to have jobs placed on the manager system. Such situations might be as follows:

■ You have a lack of drive space on the C: drive where Backburner is installed.
Drive D: has plenty of space so you set up a folder called MyJobs where jobs
will be placed when submitted. Enter a UNC path such as
\\machinename\MyJobs.

■ You're running a large render farm that causes a lot of network traffic on
the manager system that you use concurrently to build models. To alleviate
the traffic, you set up a shared job folder, backburnerJobs for example, on
a file server that is separate from the manager system. The UNC job path
would be set to \\fileserver\backburnerJobs and jobs you submit will be placed
on the file server.

Use Jobs Path Turning on this switch allows you to define the location of
jobs to be somewhere other than on the manager machine. This tells the
render servers to get the job files from the new location, therefore minimizing
the file I/O traffic on the manager.

Win32 Path Enter the path where jobs are located into this field or click the
Browse button to the right to search your system for the job location.

Unix Path This field functions the same as the Win32 path except you can
enter a Unix path structure.
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Default Job Handling group

The settings in the Default Job Handling group allow a user to archive a
completed job to a specified location after x number of days, delete a completed
job after x number of days or just leave the job indefinitely in the queue.

Using these controls lets you maintain the job queue, clearing completed jobs
that can cause excess overhead and stress to the manager system, thus
instigating performance problems. The archiving functionality allows you to
automatically store files used for completed jobs.

NOTE These settings can be overridden from the Advanced Settings dialog on
page 6497 accessed from the Network Job Assignment dialog on page 6481.

Do Nothing When turned on, a completed job is left in the queue.

Use this switch if you are submitting a job that may need to be re-rendered
at a higher resolution without making any other changes to the scene.

Delete It Upon completion, the job is deleted from the queue when this switch
is turned on.

If the scene you're rendering is just a test shot and you're just doing a quick
test of the scene, you don't really want to keep the job in the queue once it's
completed.

Delete After ... Day(s) Upon completion, the job is kept in the queue for the
specified number of days. Once the number of days are exceeded, the job is
then deleted from the queue.

Archive It When turned on, the job is archived when the rendering is
complete. Default=on.

Archiving is useful when you submit a final version of the scene and you know
that there won't be any further changes.

Archive After ... Day(s) Upon completion, the job is kept in the queue for
the specified number of days. Once the number of days are exceeded, the job
is archived.

Network Rendering Server

Windows Start menu > Programs > Autodesk > Backburner > Server

The application version of the network rendering Server provides a graphical
user interface for control and monitoring purposes. It runs as a foreground
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process on your desktop, and remains active unless specifically shut down.
Its components include a menu bar, list window, and status bar.

Once you initially set up the server using the application version, you can run
it as a service from then on. The service version provides no user interface,
but once it's installed as a service and started, it's always available when you
boot the system. Whichever version you use, you can monitor and control
the rendering queue and system with the Queue Monitor on page 6522.

To start the server service, execute the following from a Command Prompt
window or the Start menu > Run function:

“[drive letter]:\Program Files\Autodesk\Backburner\serversvc.exe” -i

Replace "[drive letter]" with the letter of the drive the software is installed on.
If you used a different install path, change the command line accordingly.

Then either reboot the computer or go to Control Panel > Administrative
Tools > Services and start the service. Thereafter the service will remain resident
and active, even surviving reboots.

NOTE In order for the rendering servers to be able to save the frames to the
specified location, set the logon for the installed service to a user name and
password that exists on the network. Also, that user name must have sufficient
read/write permissions to get the required bitmaps and xrefs for the scene to
render as well as write the frames to specified location.

To remove the server service from memory, execute the following from a
Command Prompt window or the Start menu > Run function:

“[drive letter]:\Program Files\Autodesk\Backburner\serversvc.exe” -r

Procedures

To start/stop the server service upon logoff/logon:

If you work on a computer that's part of a render farm, you probably don't
want the computer to be available for rendering while you're using it. By
following this procedure, you can have the computer automatically turn off
the server service while you're logged on, and turn it back on when you log
off.

1 Install the Backburner Server as a service that starts automatically at
startup, as described above. This is the default setup for the server service.

You'll start by creating two batch files.

2 Open a text editor such as Notepad and enter the following line:
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net start backburner_srv_200

3 Save this as a text file named Netstart_BB_Server.bat.

4 Create a new file containing the following line:

net stop backburner_srv_200

5 Save this as a text file named Netstop_BB_Server.bat.

Next, you'll to edit the logon and logoff policy for the system.

6 Go to the Windows Start menu, choose the Run command, and enter
gpedit.msc.

The Group Policy dialog appears. It lets you edit and manage the Group
Policy for the system.

7 In the dialog, expand User Configuration > Windows Settings, and then
click Scripts (Logon/Logoff).

The right-hand pane lists Logon and Logoff.

8 In the right pane, right-click Logon and choose Properties.

9 In the Properties dialog, click Add, click Browse, and browse to the
Netstop_BB_Server.bat file you created. Click OK twice to close the Logon
Properties dialog.

10 Similarly, open the Properties dialog for Logoff and specify the
Netstart_BB_Server.bat file.

11 Close the Group Policy dialog.

You have now set up the system to stop the Backburner service at any
user logon, and to start it at any user logoff.
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Interface

Menu bar

The menu bar provides access to the functions available in the Network
Rendering Server application.

File menu

Close Closes the window and minimizes the application to the taskbar tray.
The application remains active when you close it with this menu item or the
close box (X) in the upper-right corner.

Shutdown Quits the application and removes it from memory.

Edit menu

General Settings Opens the Network Server General Properties dialog on page
6520.

Log Settings Opens the Network Server Logging Properties dialog on page 6505,
which lets you filter the types of messages to appear in the list window, and
specify whether the messages will be sent to the list window, a log file, or
both.
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View menu

Status Bar Toggles the display of the status bar, which appears at the bottom
of the Server window. When on, a check mark appears next to this menu item.
Default=on.

Font Size Lets you choose the size of text that appears in the list window.
Choices range from Smallest to Largest.

Autoscroll List Toggles automatic scrolling of the list window. When on, new
items that appear in the list window cause previous contents to scroll up.
When off, you must scroll the window manually to see the latest entries after
it fills up. Default=on.

Help menu

About Server Displays information about the Server program, including
version and copyright.

List Window

This area of the Server interface lists different types of information regarding
the current status of Server. Depending on the selections made in the Logging
Properties dialog on page 6505, messages are displayed alerting the user, for
example, to the following:

■ Connection and registration between the Manager and Server(s)

■ New job assignments

■ Frames assigned/rendered

■ Acknowledge packets sent between the Manager and Server(s)

■ Manager/Server(s) shutting down

■ Any rendering errors encountered
This information can be filtered using the Logging Properties dialog on
page 6505.

Server General Properties Dialog

Windows Start menu > Programs > Autodesk > Backburner > Server > Edit
menu > General Settings > General Properties dialog
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The Server General Properties dialog contains configuration settings for the
Network Rendering Servers. The default settings in this dialog work in most
cases, but certain situations may require adjustment of these settings, mostly
the Manager or IP settings in case the Automatic detection fails. The
information specified in the Server Properties dialog is contained in the
backburner.xml file (in the \Network subdirectory). If you run Server and the
backburner.xml file does not exist or does not contain information pertinent
to the Server, the backburner.xml file is created or updated.

Interface

TCP/IP group

Manager Port Specifies the port number used by the Network Manager.

Server Port Specifies the port number used by the Network Server(s).

These settings specify the port number to be used by the software. These
numbers must be unique to the software, but every Server must have the same
number.

NOTE Port numbers are like extensions for different users of the same phone
number. They represent two channels of communication between the Server and
the Manager. Only a trained network administrator should change these settings.
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Automatic Search When on, starting the Server searches for a Manager using
the default subnet mask of 255.255.255.0. In most cases, you should leave
this option on. The software will detect the machine acting as a Manager. The
Server may fail to detect a Manager if the network subnet mask (in the
Windows TCP/IP Network Configuration dialog) is set to some other value
than the standard 255.255.255.0.

If that is the case, change the subnet mask setting in the Server General
Properties dialog to match the system setting. Start the Server again and it
should detect the Manager. When multiple Managers are running on the same
network, you may want to turn off Automatic Search and specify which
Manager the Server should connect to. Otherwise, the Server connects to the
first Manager it finds.

Enter Subnet Mask/Manager Name or IP Address With Automatic Search
turned on, specifies the subnet mask used to search for the Manager. With
Automatic Search turned off, specifies the IP address or DNS name of the
Manager to which to connect. Use the Manager system's name or IP address
when multiple Managers are running on the same subnet. Use the Manager
system's IP address to avoid any problems or conflicts caused by improper
implementation of the Domain Name System.

Queue Monitor

The Queue Monitor Application 

Windows Start menu > Programs > Autodesk > Backburner > Monitor

The Queue Monitor application (monitor.exe) lets you manage, view, and receive
status updates about all jobs currently submitted to the network rendering
queue. This executable file is copied to the Backburner root directory during
setup, and is available from the Start menu.

NOTE In previous versions of 3ds Max, this program was called Queue Manager.

Queue Monitor helps you adapt to changing needs and priorities. Jobs can be
activated, deactivated, reordered, and removed, and servers can be unassigned
to free up resources on workstations, or brought back online as they become
available again.
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You can run Queue Monitor from any computer connected to the rendering
network. Once started, you can connect to any available network Manager.
You can launch as many Queue Monitors as you want from anywhere on your
network and connect to a Manager machine. All except the first Queue Monitor
connecting to the Manager appear in "read only" mode. If there is already a
Queue Monitor connected to the Manager, subsequent connections alert you
that you are in read-only mode, and "Read Only" appears in the title bar. In
read-only mode, you can view network render activity, but cannot change
anything in the queue unless you obtain queue control on page 6526.

To view all current jobs in the rendering queue, you first connect to the
Manager that all of the servers are "talking to." To do this, you can either
connect automatically to the Manager by searching with a subnet mask, or
connect to a specific Manager by supplying the IP address or machine name
of the machine where you started the Manager.

See also:

■ Viewing Jobs and Servers with the Queue Monitor on page 6540

■ Activating and Deactivating Jobs in the Queue on page 6544

■ Activating and Deactivating Servers in the Queue on page 6545

■ Managing Jobs in the Queue on page 6546

Procedures

To view all current jobs in the rendering queue:

1  On the Queue Monitor toolbar, click the Connect button.

The Connect To Manager dialog appears.

2 After you connect to a Manager once, the dialog remembers the Manager
information and you can just click OK to connect to the same Manager.

If this is the first time you're connecting, or you're connecting to a
different Manager, and you're using Automatic Search, just click OK. If
you're not using Automatic Search, you need to specify the Manager to
connect to. In the text field, enter the name or IP address of a network
Manager. This is the same information you specified in the Server General
Properties dialog on page 6520.

3 Click OK.
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The Queue Monitor connects to the network Manager and activates its
various display windows.

To suspend a job:

As requirements change, you can temporarily deactivate an active or pending
job in the rendering queue, or reverse the process and restart jobs that are
inactive.

When you suspend a job, the Servers assigned to the job either drop the frame
they are rendering or finish writing the frame, depending on where they are
in the rendering process. The next pending job becomes active and begins to
render.

NOTE You can activate or deactivate multiple jobs at the same time.

1 Select one or more active or pending jobs in the Job list.

2 Do one of the following:

■  Click the Suspend button on the toolbar.

■ Choose Suspend from the Jobs menu.

■ Right-click a highlighted job name in the Job list to display a pop-up
menu, and then choose Suspend.

 If necessary, use Refresh to view the new queue status.

To activate a suspended job:

1 Select the suspended job (denoted by a gray movie-frame icon).

 The Activate button on the toolbar becomes active.

2 Click Activate, or use the menu bar or right-click menu.

The job becomes either Started or pending in the queue (Active),
depending on whether or not another job is currently rendering.
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Interface

The Queue Monitor user interface comprises a menu bar, a toolbar, a status
display, and four windows: job list, job information, server tree view (or
hierarchical list), and server list.

Menu bar

The menu bar includes these menus and functions:

Manager menu

Use to control aspects of the Queue Monitor and the network Manager.

Connect Connects to a Manager using the Connect To Manager dialog. In
the dialog, turn on Auto Search to search for a Manager using the specified
subnet mask, or turn off Auto Search to search for a Manager using a specific
Manager name or IP address. Click OK to perform the search, or Cancel to
exit without connecting.

If the Manager is found, current Servers and jobs appear in their respective
lists in the Queue Monitor. If the Manager cannot be found, an alert appears.

Disconnect Disconnects from the current Manager. Available only after a
connection is made.
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Auto-Connect When this switch is turned on, you can automatically connect
to a manager without the Connect To Manager dialog appearing. Whatever
setting have been made in the Connect To Manager dialog will be used.

Request Queue Control Lets you gain control over the rendering queue.
Available only when Queue Monitor is running on two or more machines in
the network, and your copy was not the first one run.

When you request queue control, a dialog appears on the controlling machine
informing that user of the request. The dialog counts down 10 seconds, and
if no response is made during that time, or the OK button is clicked, control
transfers to the requesting Queue Monitor, which then informs the requestor
of the transfer. If the request is denied, the requesting user is informed of that
fact.

Request Client List Displays a dialog listing the rendering servers on the
network, and showing which is the controller (i.e., the active Queue Monitor)
and the user name. Use this to determine which server is currently controlling
the queue.

Auto-Refresh When on, Queue Monitor automatically updates the information
in its windows every 20 seconds, or whenever information changes if
information changes less frequently. When off, to update the windows you
must click the toolbar Refresh button on page 6529. Default=on.

Unless you are the only person managing the queue, we recommend leaving
Auto-Refresh on. The danger of turning it off is the possibility of getting out
of sync with the state of the queue. For instance, if another person deletes a
job and you decide to edit that job, when you finish editing that job, the
Manager will send you an error message saying the job no longer exists.

Module Info Report Choosing this command opens the Module Info Report
dialog on page 6533. For troubleshooting purposes, this command lets you
generate a delimited file that shows you the version and location of Backburner
plug-ins and the Backburner application itself for each network rendering
system.

Properties Opens a window that displays information about the current setup
of the machine that is running the network Manager, including job and server
statistics, the Manager's system configuration, and TCP/IP statistics.

Exit Quits the Queue Monitor program.
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Jobs menu

Use to obtain information about rendering jobs. Most Jobs menu functions
are available only when at least one job is highlighted in the Job list, and
many require that only one job be highlighted.

These commands are also available by right-clicking a job in the job list.

Edit Settings Opens the Job Settings dialog on page 6535, with settings for
job-related functions such as frame range and output size.

Change Priority Opens the Change Job Priority dialog, which lets you set a
new priority or set the job to be critical.

If you change a job's priority so that a different job moves to the beginning
of the list, the software pauses the current job and begins rendering the newly
elevated job.

Clone Job Makes an identical copy of the highlighted job and adds it to the
end of the list.

Dependencies Opens the Job Dependencies dialog on page 6490, which you
can use to specify existing jobs that must finish before the current job can
start.

Report Opens the Job Report dialog on page 6541 for generating text files
containing job reports.

Column Chooser Opens the Job Columns dialog, with additional columns
you can drag into the Job list title row. As you drag a column over the title
row, arrows appear indicating where the column will be inserted.

To remove a column, right-click its title and then choose Remove This Column.
You cannot remove the Job or Order column.

Activate Starts a suspended job or jobs.

Suspend Pauses an active job or jobs.

Restart Job Starts a job over at the first frame set in Job Settings.

Archive Job Archives a job currently stored in the queue. Archived jobs are
removed from the Job queue and stored in the Job Archives.

Job Archives Accesses the Job Archives where jobs are stored after clicking
the Archive Jobs command or if they're assigned to automatically archive
upon completion. Choosing this command opens the Job Archive dialog on
page 6543 where you can choose to Delete, Activate or Refresh jobs.

Delete Removes the highlighted job or jobs from the queue.
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Servers menu

Use to control and obtain information about job servers.

These commands are also available by right-clicking a server in the server list.

Assign to Selected Jobs Assigns the highlighted servers or servers to the
highlighted job or jobs.

Remove from Selected Jobs Removes the highlighted job or jobs from the
highlighted servers or servers.

Remove from Selected Group Removes the highlighted server or servers from
the highlighted group in the tree view.

Column Chooser Opens the Server Columns dialog, with additional columns
you can drag into the Server list title row. As you drag a column over the title
row, arrows appear indicating where the column will be inserted.

To remove a column, right-click its title and then choose Remove This Column.
You cannot remove the Job or the Order column.

Week Schedule Opens the Week Schedule dialog on page 6547 for the
highlighted server, for defining when the server is available to render jobs.

Delete Server Lets you remove the current server from the server list, making
it unavailable for rendering jobs.

Properties Opens a window that displays information about the current setup
of the machine that is running the network Manager, including job and server
statistics, the Manager's system configuration, and TCP/IP statistics.

Reset Server Index Lets you set the Performance parameter back to 0. Use
this if you've changed the server setup (for instance, you've added memory
or substituted a faster machine) and want to reevaluate the servers' relative
performance during a rendering job.

View menu

Toolbar Toggles display of the Queue Monitor toolbar.

Status Bar Toggles display of the Queue Monitor status bar. When on, the
status bar appears at the bottom of the Queue Monitor window and displays
status prompts on page 6533.

Save View... Saves the current window view with column and filter settings.

Load View... Loads a saved view.
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Help menu

About Queue Monitor Displays information about the Queue Monitor
program, including version and copyright.

Toolbar

Contains buttons for performing various common Queue Monitor functions.

 Connect See Connect on page 6525.

 Disconnect See Disconnect on page 6525.

 Refresh Forces the Queue Monitor to update the information shown
in its windows.

The software automatically refreshes the windows every 10 seconds when
information is changing.

 Delete Removes the highlighted job or jobs from the queue.

 Activate Starts a suspended job or jobs.

 Suspend Pauses an active job or jobs.

 Assign Server Assigns the highlighted servers or servers to the
highlighted job or jobs.

 Remove Server Removes the highlighted job or jobs from the
highlighted servers or servers.
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Job List

The Job List window lists all current jobs, along with progress and status.
Additionally, a status icon before each job's name provides a graphical
indication of its status. See Viewing Jobs and Servers with the Queue Monitor
on page 6540.

Right-click a job name to access the Jobs menu on page 6527.

Click a column title to sort the list by the column contents (alternating clicks
sort in ascending and descending order). Right-click a column title to access
a menu that lets you sort the column, specify its alignment, remove the column
(if it's optional), access the Column Chooser for adding optional columns,
and display only the default columns.

Job Information Window

The Job Information window contains tabs for viewing information about
different aspects of a single highlighted job in the Job List window. If no job
is highlighted or multiple jobs are highlighted, this window is blank.

You can sort and filter columns in the Job Information Window. Click 
in the column you wish to filter and select the Column Filter options.

Job Summary Lists important job-related information, including Job Options
settings and Output settings.

Task Summary Lists frames in the job (under “Task ID”), along with each
frame's status, rendering time, rendering server, and date and time of
assignment.

Right-click the frame you wish to view under “Task ID” to view its output file.
This is available only for completed tasks.
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Job Details Lists the job's rendering parameters, scene statistics, and gamma
settings.

Errors Lists each frame for which an error occurred, which server registered
the error, and a description of the error, including missing maps, missing
texture coordinates, and invalid output directories.

Server Tree View

This window presents a hierarchical list of all Server groups, lets you create,
delete, and rename global and local Server groups, and see which Servers can
render your job.

Server groups are logical combinations of Servers that you can use to easily
assign specific Servers to render a job. Global groups are available to all
machines in the rendering network, while local groups are available only on
the computer on which they are created. To create a global or local Server
group, right-click any item in the Server Tree view, and choose Create Global
Group or Create Local Group. After you choose either command, the new
group appears in its respective category with the name New Global/Local
Group; at this point, you can rename it by typing a new name.

After you define a group, its name shows up as a tab in the Server list in the
Network Job Assignment dialog on page 6481. Only global groups appear on
machines other than the one on which they're created.

To remove a Server group, right-click its name in the Server Tree view and
choose Delete Group. To rename a Server group, right-click its name in the
Server Tree view, choose Rename Group, and then enter a new name.

Following is a list of default list entries in the view. Click the item for the
described result.

All Servers Shows all Servers assigned to the current manager.

Global Groups Click the + icon next to this entry, if it exists, to display global
Server groups. To see the Servers in a global group, click the group name.

Local Groups Click the + icon next to this entry, if it exists, to display local
Server groups. To see the Servers in a local group, click the group name.

Plugins Shows which applications can be controlled with the render network.
Click the + icon next to this entry, if it exists, to display applications available
on the render network. To see the Servers that have a particular rendering
application installed, click the renderer name.
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Server List

The Server List window shows all Servers in the current group (selected in the
Server Tree view). For each listed server, the windows displays, by default, its
status, the job it's currently rendering (if any), and the last message it sent to
the Manager. Additional, optional details can be shown using the Column
Chooser command.

Click a column title to sort the list by the column contents (alternating clicks
sort in ascending and descending order). Right-click a column title to access
a menu that lets you sort the column, specify its alignment, remove the column
(if it's optional), access the Column Chooser for adding optional columns,
and display only the default columns.

You can sort and filter columns in the Server List Window. Click  in the
column you wish to filter and select the Column Filter options.

A status icon before each server's name provides a graphical indication of its
status. See Viewing Jobs and Servers with the Queue Monitor on page 6540.

Right-click a server name to access the Servers menu on page 6528.
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Status Prompt

Visible at the bottom of the Queue Monitor window, the status prompt
provides a non-interactive display of activity in the Queue Monitor and
provides help information on the command over which the mouse cursor is
positioned.

Module Info Report Dialog

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > Jobs menu > Report

You can generate delimited ASCII reports containing detailed statistics about
the version and location of Backburner plug-ins and the Backburner application
itself for each network rendering system.
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Interface

Header group

Specifies the type of header to include in the report file, in addition to the
body information.

Long Adds a heading to the report.

Short Includes only the column titles in the report.

Record Delimitation group

Specifies the type of delimiter used between the fields. For example, if you use
a tab delimiter, the report will import correctly into Microsoft's Excel or Access
applications.

Tab Inserts a tab between fields in the report.

Space Inserts a space between fields in the report.

Comma Inserts a comma between fields in the report.

Use Quotes Brackets each field with double quotes.

Output File group

(Text Field) Specifies the report's file name. You can specify a complete path,
if you want. By default, the path is the directory containing the monitor.exe
file.
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TIP If you use a shortcut icon to launch Queue Monitor, you can specify the path
for your report's output file in the Start In field in the Properties dialog for the
shortcut.

Browse Displays a file selector where you can specify a file path for the report.

Queue Monitor: Job Settings Dialog

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > Jobs menu > Edit Settings

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > right-click menu > Edit Settings

NOTE This topic covers the 3ds Max-specific aspects of the Queue Monitor on
page 6522.

Use the Job Settings dialog to change job-related settings such as frame range,
output size, and output directory, without having to use the Render Setup
dialog and resubmit the job.

You can change job settings for a job while it's suspended or while it's
rendering. By default in either case, after you click OK to exit the dialog, the
rendering job restarts from the first frame. You can turn this feature off with
the Restart Job option.

Most settings are either toggle switches or editable from the keyboard. To
change a toggle setting, double-click its entry (in the right-hand column). If
a setting is editable, its value turns green when you click it. To change an
editable setting, click it to get the keyboard cursor, and then enter a new value
from the keyboard. If you double-click the value when it's green, it highlights,
and anything you type replaces it.

NOTE Your machine must have control of the network for this Job Settings Dialog
to be accessible.
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Interface
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Job Name group

The job name cannot be changed from this dialog.

Job Description Displays a brief description of the job. Editable from keyboard.

Restart Job When on (Yes), changing one or more job settings in the middle
of a rendering job causes the job to restart at the first frame in the range, so
all frames are rendered with the same settings. When off (No), the job
continues rendering without restarting. Toggled by double-clicking the entry.
Default=No.

You might want to turn this off if you're rendering an animation test and
change a relatively minor setting, such as Video Color Check, in the middle
of a job. For final renderings, you should always restart a job from the
beginning after changing job settings.

Override Global Blocking Tasks This setting corresponds with the Override
Global Settings as set in the Advanced Setting dialog on page 6497. Default=Yes.

Enable Blocking Tasks A Yes/No toggle that controls task blocking as set in
the Advanced Setting dialog. When set to Yes, the task blocking set in the
Manager General Properties dialog is active. Toggled by double-clicking the
entry. Default=Yes.

Use All Available Servers Uses all servers in the active Server group for
rendering the job.

[program name] General Settings group

Frame Sequence This toggle setting alternates between Frames and Range,
and, by default, uses the Range and Frames settings in the Render Setup dialog
on page 6067. When set to Range, the job uses the First/Last Frame and Every
Nth settings; when set to Frames, the job uses the Frames setting. Toggled by
double-clicking the entry. Default=Range.

First Frame Displays the first frame in the range to be rendered. Defaults to
the first frame as submitted. Editable from keyboard.

Last Frame Displays the last frame in the range to be rendered. Defaults to
the last frame as submitted. Editable from keyboard.

Every Nth Regular sample of frames. For example, enter 8 to render every 8th
frame. Editable from keyboard.

Frames Non-sequential frames separated by commas (for example, 2,5) or
ranges of frames separated by hyphens (for example, 0-5). Editable from
keyboard.
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Width/Height Lets you set the resolution of the output image by specifying
the width and the height of the image, in pixels. Defaults to the output size
as submitted. Editable from keyboard.

Render Options group

These settings are the same as those found on the Render Setup dialog >
Options group on page 6127, with several additions:

Skip Existing Frames When on, the software checks the output path for
existing rendered frames, and doesn't render them again. When off, starting
or restarting a job always begins rendering with the first frame, overwriting
any existing frames. Toggled by double-clicking the entry. Default=No.

Display RFW Displays the Rendered Frame Window on all servers during
rendering. Toggled by double-clicking the entry. Default=Yes.

Gamma Correction When enabled, lets you defines a new gamma for the
bitmap, using the Input/Output Gamma settings. Toggled by double-clicking
the entry. Default=Disabled.

Input/Output Gamma Change system input and output gamma settings for
processing bitmaps. See Gamma Preferences Settings on page 7758 > Bitmap
Files group. Editable from keyboard.

Pixel Aspect Ratio Sets the shape of the pixels for display on another device.
The image may look squashed on your display but will display correctly on
the device with differently shaped pixels. Editable from keyboard.

Render Elements When enabled, renders any render elements on page 6349 in
the scene. Toggled by double-clicking the entry. Default=Enabled.

Video Color Check Checks for pixel colors that are beyond the safe NTSC or
PAL threshold. Toggled by double-clicking the entry. Default=No.

Two Sided 2-Sided rendering renders both sides of all faces. Toggled by
double-clicking the entry. Default=No.

Render Hidden Renders all geometric objects in the scene, even if they are
hidden. Toggled by double-clicking the entry. Default=No.

Render Atmosphere Renders any applied atmospheric effects, such as volume
fog, when set to Yes. Toggled by double-clicking the entry. Default=Yes.

Super Black Limits the darkness of rendered geometry for video compositing.
Toggled by double-clicking the entry. Default=No.
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Dither 256 Intersperses pixels when rendering to an eight-bit image format
for a greater apparent color range. Toggled by double-clicking the entry.
Default=Yes.

Dither True Color Intersperses pixels when rendering to a 24-bit (or higher)
image format for a greater apparent color range. Toggled by double-clicking
the entry. Default=Yes.

Render Fields Renders to video fields rather than frames when creating
animations for video. Toggled by double-clicking the entry. Default=No.

Displacements Any displacement mapping is rendered. Toggled by
double-clicking the entry. Default=Yes.

Scene Effects Any applied rendering effects, such as Blur, are rendered when
turned set to Yes. Toggled by double-clicking the entry. Default=Yes.

Multithread Causes the software to treat the rendering task as separate threads.
This option works with multiprocessor systems. Toggled by double-clicking
the entry. Default=Yes.

Field Order Selects the field on page 7973 order of rendered images when the
Render Fields option is turned on. Default=Odd.

Some video devices require that the even field be first, other video devices
require that the odd field be first. Determine the correct field order for your
video device. If the video output of your device is strobing or appears jittery,
it may be due to incorrect field order. Try changing this parameter and
re-rendering your animation.

Alternate Paths group

Comparable to setting the alternate paths in the Network Job Assignment
dialog on page 6481.

Alt Bitmap Path Lets you enter an alternate path where the servers search
for bitmaps. Editable from keyboard.

Alt XRef Path Lets you enter an alternate path where the servers search for
XRefs. Editable from keyboard.

Timeouts group

These settings are covered in Advanced Settings Dialog on page 6497.
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Notifications group

These settings are covered in Notifications Dialog on page 6492.

Viewing Jobs and Servers with the Queue Monitor

All rendering jobs submitted to the network rendering queue are shown in
the Job list window, located on the upper-left side of the Queue Monitor
dialog, immediately below the toolbar. Below it is the Server list window,
which shows all servers attached to the manager and their status.

Interface

Each job is denoted by an icon reflecting its current status. The servers are
also denoted by specific icons that reflect their current status.

Job Icons

Job is started and has rendered one or more frames. The job is either
currently rendering or is awaiting an available server.

Job is active, but has not yet rendered any frames.

Job is suspended.

The job was submitted as suspended or was suspended with the Queue Monitor.
Suspended jobs must be manually reactivated to give them a started or active
status.

Job is in an error condition.

In the Queue Monitor, check the Errors tab in job information window, to
the right of the jobs list, for details regarding the error, such as missing bitmaps,
plug-ins, texture coordinates. See Troubleshooting on page 6455.

Job is completed.

All frames in the sequence have been rendered successfully. You may delete
this job from the queue if you want.
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Server Icons

A bar through the server icon indicates that it's assigned to the currently
highlighted job or jobs.

Server is active.

The server is rendering the current started job.

Server is absent.

The server is assigned to the rendering task but is not currently rendering.
This can occur, for example, when the server is turned off or is not running
the Server application.

Server is in an error condition.

Check the Server list Job Status column in the Queue Monitor for details
regarding the error, such as missing bitmaps, plug-ins, texture coordinates.
See Troubleshooting on page 6455.

Server is idle.

The server can be assigned the highlighted job with the toolbar Assign Server
button.

Job Report Dialog

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > Jobs menu > Report

You can generate ASCII reports containing detailed statistics about a particular
job selected in the Job Queue list.

See also:

■ Week Schedule Dialog on page 6547
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Interface

Header group

Specifies the type of header to include in the report file, in addition to the
body information.

Long Includes information above the body of information, including Job
Name, Submitted by, Frame Start/End, Output Width/Height, Pixel Aspect
Ratio, and Image Aspect Ratio.

Short Includes only the column titles in the report.

Record Delimitation group

Specifies the type of delimiter used between the fields. For example, if you use
a tab delimiter, the report will import correctly into Microsoft's Excel or Access
applications.

Tab Inserts a tab between fields in the report.

Space Inserts a space between fields in the report.

Comma Inserts a comma between fields in the report.

Use Quotes Brackets each field with double quotes.
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Output File group

(Text Field) Specifies the report's file name. You can specify a complete path,
if you want. By default, the path is the directory containing the monitor.exe
file.

TIP If you use a shortcut icon to launch Queue Monitor, you can specify the path
for your report's output file in the Start In field in the Properties dialog for the
shortcut.

Browse Displays a file selector where you can specify a file path for the report.

Job Archives Dialog

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > Jobs menu > Job Archives

Windows Start menu > Programs > Autodesk > Backburner > Monitor >
Highlight a job. > right-click menu > Job Archives

Use the Job Archives dialog to delete, activate and refresh jobs that have been
archived. Jobs are placed here when you select a job from the Job list on the
Queue Monitor and click the Archive Job command. This brings up the
Backburner Job Archives dialog Jobs are also placed in the Job Archives if you
set them to automatically archive when the rendering is completed.

Interface

This dialog consists of a toolbar and list of archived jobs.
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Toolbar

The Job Archives toolbar has three commands.

Delete Deletes a selected job from the archive. You are warned and must
accept confirmation before the deletion to occurs. This button is active only
when a job is selected.

Activate When you select a job from the list, you can click the Activate button.
When a job is activated, it is removed from the Job Archives and placed back
in the Job list in the Queue Monitor on page 6522. Then you can choose to Edit
Settings on page 6535 and restart the job.

Refresh Forces the Job Archives dialog to update the information shown in
the job list

Job List

The Job List shows the Job Name, Owner, Description, Type (render plugin),
original Submission date, and Completion date. Unlike other lists in the Queue
Monitor, you cannot add or remove columns. You can make multiple selections
of jobs by holding down either the SHIFT or CTRL keys.

Activating and Deactivating Jobs in the Queue

As requirements change, you can deactivate an active or pending job in the
rendering queue, or reverse the process and restart jobs that are inactive.

When you deactivate a job, the servers assigned to the job either drop the
frame they are rendering or finish writing the frame, depending on where
they are in the rendering process. The next pending job becomes active and
begins to render.

You can reactivate a suspended job, or a job that was submitted as Initially
Suspended from the Network Job Assignment dialog.

Procedures

To deactivate a job:

1 Select a started or active job in the Job list.
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2 Do one of the following:

■ Click the Suspend button on the toolbar (the red light-bulb icon).

■ Choose Jobs menu > Suspend.

■ Right-click the job name to display a pop-up menu, and then choose
Suspend.
If necessary, click the toolbar Refresh button to view the new queue
status.

To activate a suspended job:

1 Select the inactive job (denoted by a gray box).

The Activate button on the toolbar becomes active.

2 Click Activate, or use the menu bar or right-click menu.

The job becomes either started or active in the queue, depending on
whether or not another job is currently rendering and whether or not
any of the job's frames have already rendered.

Activating and Deactivating Servers in the Queue

When prioritizing jobs and dividing up the network render load, you might
need to pull individual servers off one job and place them on another.

When you remove a server from the current rendering job, and the server is
assigned to another started or active job, it is used by that job. If the server
has no further job assignments, it stops rendering.

You can assign machines that become available for network rendering to any
job.

You can tell whether a server is assigned to a particular job by highlighting
the job in the Queue Monitor > Job list and looking at the server's icon in the
Server list. If a horizontal bar appears through the server icon, then it is
assigned to the job; if no bar appears, then it isn't assigned to the job.

Alternatively, just highlight the job and then click Selected Job in the Server
Tree view, to list only servers assigned to that job.

Next Step

Managing Jobs in the Queue on page 6546
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Procedures

To remove a server or servers from the highlighted rendering job or jobs:

■ Highlight the server in the Server list and click the Remove Server icon on
the toolbar.

To assign an unassigned server or servers to highlighted rendering job(s), do
one of the following:

1 Highlight the unassigned server(s) in the servers list and choose Assign
To Selected Jobs from the Servers menu.

2 Right-click the server name in the queue list to display the pop-up menu
and choose Assign To Selected Jobs.

Managing Jobs in the Queue

Reordering lets you change the job order in the queue to meet changing
deadlines or priorities. You can delete jobs from the queue at any time.

Procedures

To re-order a job in the queue:

1 In the Job list window of the Queue Monitor, right-click the job to move.

2 Choose Change Priority, and use the Change Job Priority dialog to set a
new Priority value.

NOTE You can reorder multiple jobs at the same time. They will end up with
the same priority.

To delete a single job from the job queue, do one of the following:

1 Highlight the job and then click Delete on the toolbar.

2 Use the right-click menu > Delete command.

You can delete multiple jobs by first highlighting the jobs by using the CTRL
or SHIFT keys and then clicking the Delete button or Jobs menu > Delete.
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Week Schedule Dialog

Queue Monitor > Highlight a Server and right-click. > Week Schedule

Queue Monitor > Highlight a Server. > Servers menu > Week Schedule

By default, all servers are available at all times. Using the Queue Monitor's
Week Schedule feature, you can arrange the hours during which each server
is available for network rendering.

You can specify certain hours for any day of the week. This is useful, for
example, if the server is used as a modeling workstation during normal business
hours and you do not want it being used as a network render server during
this time.

Procedures

To schedule a set of active hours for a server or servers:

1 In Queue Monitor's Server list, right-click a Server and choose Week
Schedule, or select one or more Servers and choose Servers menu > Week
Schedule.
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2 In the dialog that appears, select a time using one of the following
methods:

■ Select a one-hour block for network rendering by clicking one of the
top buttons.

■ Select an entire day by clicking a side button.

■ Select the entire week by clicking the large top-left button.
The selection is shown in white.

3 Click the Allow button. The selection is shown in green. (By default, all
hours are allowed).

4 To apply the time selection to the selected Server, click OK.

To schedule hours when servers are unavailable:

1 In Queue Monitor's Server list, right-click a Server and choose Week
Schedule, or select a Server and choose Servers menu > Week Schedule.

2 In the dialog that appears, select a time using one of the following
methods:

■ Select a one-hour block for network rendering by clicking one of the
top buttons.

■ Select an entire day by clicking a side button.

■ Select the entire week by clicking the large top-left button.
The selection is shown in white.

3 Click the Disallow button. The selection is shown in red.

4 To apply the time selection to the selected Server, click OK.

Batch Rendering
“Batch rendering” is a term used to describe the process of rendering a series
of tasks or jobs that have been assigned to a queue. Batch rendering is useful
when you need to render images without supervision or when you want to
render a number of test studies showing different day or night lighting, or for
producing shadow studies of various sun angles. Batch rendering can also be
used when you want to see how your project looks from different camera
viewpoints.
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Several methods for setting up batch rendering are available in 3ds Max. These
methods entail using the Batch Render tool on page 6553 or network rendering
on page 6433 with Backburner, or a combination of the two.

The three available methods for setting up batch rendering are as follows:

■ Build a queue of camera tasks that are managed by the Batch Render tool.
If you have a MAX file that contains one or more cameras and saved scene
states on page 7399, you can set up a camera queue to render different camera
viewpoints. Each camera can be set to automatically load a scene state to
give you several visualizations of your model.

■ Set up a series of jobs as network rendering assignments to be coordinated
by Backburner.
If you have a number of separate scenes that are part of a single project or
part of several projects, use network rendering even if you're rendering to
a single computer. Use this method also if you have scenes that don't have
a camera set up and you want to render a Perspective, Front, Left or Right
viewport view.

■ Use the Batch Render tool to set up a queue of camera tasks to render
different views and pass them to Backburner for rendering management.
The Batch Render tool has an option to send each camera task in the batch
render list as a separate network rendering job. Use this method if you
want to split the rendering of the different views among multiple
computers.

See also:

■ Batch Rendering - Batch Render Dialog on page 6553

Quick Start Batch Rendering

The following provides bare-bone steps on how to set up and use the
Backburner Manager and Server utilities to perform batch rendering.

If your system is already properly configured for TCP/IP protocols (for example,
your computer has an internet connection), information in this topic will
help you get started with batch rendering in a few basic steps.
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Procedures

To render in batch mode:

You need Windows XP (Home or Professional) Service Pack 1 (or higher) or
Windows 2000 Service Pack 4.

NOTE Backburner rendering is not supported under Windows 95, 98 or ME.

1 Run the Backburner Manager and Server applications from the Start menu,
in the same program group as 3ds Max.

2 Start 3ds Max, and load the first scene you want to batch render.

3 Open the Render Setup dialog and adjust the various rendering parameters
for the way you want to render the scene, including active viewport, file
output, etc.

4 Turn on Net Render in the Render Output group, and then click Render.

5 In the resulting Network Job Assignment dialog on page 6481, click the
Connect button.

6 Click the Submit button.

NOTE Each job should have a unique output file name and/or path to avoid
overwriting output files. If you get an alert dialog that says, "Another job is
using the same output name…," you can click the No button, click Cancel
to exit the Network Job Assignment dialog, and then change the output
name and/or path. Otherwise, you can click the Yes button and let the job
overwrite the frames from the other job in the queue.

7 Load the next scene you want rendered, and then repeat steps 4 through
7.

Once you’ve submitted all rendering jobs, you can exit 3ds Max, if you want.
If power is lost before all jobs are rendered (either by accident or by intentional
powering down of your computer), when you restart the Backburner Manager
and Server programs, the rendering process will resume where it left off.

Using Backburner for Batch Rendering

Using Backburner for batch rendering is a simple matter of starting the
software, running the Backburner Manager and Server programs, specifying
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the scenes you want rendered, and then proceeding with the rendering. In
this case, Backburner coordinates a series of rendering tasks that are network
rendered on a single computer.

The process is very similar to rendering over a network. With network
rendering, the scenes you submit to the rendering queue are called 'jobs'. The
following steps show how to submit multiple jobs to the rendering queue.

Your system has to be properly configured in the TCP/IP protocol (see “TCP/IP
Settings” in the Autodesk Backburner Installation Guide) to perform Backburner
batch rendering. If you do not have a network card or if you are not connected
to the internet, then you may need to configure TCP/IP with the Microsoft
Loop Back Adapter.

NOTE  Batch rendering by means of Backburner differs from batch rendering
with the Batch Render tool on page 6553. However, you can use the Batch Render
tool to create a queue of rendering tasks and then pass the tasks to Backburner
to coordinate the rendering process.

Network Files

When Backburner Manager begins a job, a series of files are created in the
\network\jobs folder of your Backburner folder. Among other things, this means
that you can shut down your computer completely (either on purpose or by
accidental power failure), and when you next start Backburner Manager and
Server, they’ll pick up where they left off and continue with your rendering
queue.

NOTE The exception to the above rule is when rendering multiframe file formats,
such as AVI and MOV. Due to limitations in these file formats, if you stop in the
middle of rendering one of these files, when you begin rendering again, the entire
file will have to be rendered from the beginning.

Procedures

To batch render several jobs:

1 Start 3ds Max.

2 Start Backburner Manager.

The Backburner Manager window appears. Its window displays the words:
“Starting Network Manager.”

3 Start Backburner Server.
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The Backburner Server window appears. Its window displays the words:
“Starting Backburner Server,” followed by additional startup messages.

4 In 3ds Max, load the first scene you want rendered.

5 Activate the viewport you want rendered, and click the Render Setup
button on the toolbar.

6 Set up the various rendering parameters as you would if you were
rendering only this scene.

7 In the Render Output group, turn on Net Render.

8 Click Render.

To assign network jobs:

At this point, the Network Job Assignment dialog on page 6481 appears. Its main
purpose is submit the current job to the Backburner Manager with all its render
settings, including job name and net rendering specifics. The Backburner
Manager then takes over and begins the rendering process.

1 In the Job Name field, either accept the default name (the name of the
scene), or specify a new one.

2 Click the Connect button to connect the software to the Manager. After
a moment, your TCP/IP address appears in the field over the window,
and the Server appears in the window.

3 Click the server in the window so that its icon displays a green circle with
an arrow through it.

4 Click the Submit button.

NOTE Each job should have a unique output file name and/or path to avoid
overwriting output files. If you get an alert dialog that says, "Another job is
using the same output name…," you can click the No button, click Cancel
to exit the Network Job Assignment dialog, and then change the output
name and/or path. Otherwise, you can click the Yes button and let the job
overwrite the frames from the other job in the queue.

5 The Job Assignment dialog goes away, and the rendering begins. The
Manager reports: “Job (job name) submitted.” The Server reports that it
has received the job, and then begins reporting each frame it’s completed.

6 At this point, you can open the next scene to be rendered, and then
repeat the steps, beginning with step 4 in the previous procedure.
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Once you’ve submitted the jobs you want rendered, you can exit 3ds Max (do
not shut down the Backburner Manager or Server), or you can begin working
on a new scene, or editing an old scene. Keep in mind, however, that your
processor is spending most of its time working on rendering, so your computer
will slower than usual.

If you need to monitor the batch render processes, you can use the Backburner
monitor for that purpose. (See “Understanding the Backburner Monitor” in
the Autodesk Backburner User’s Guide.)

Batch Rendering - Batch Render Dialog

Rendering menu > Batch Render

The Batch Render tool offers you an efficient, visual approach to setting up a
sequence of different tasks or scene states to render automatically. From the
Batch Render dialog, you control the following:

■ Image resolution, pixel aspect ratio or time sequence if it differs from the
default rendering settings found on the Render Setup dialog on page 6067.

■ Whether to render a specific camera view or the active viewport.

■ Which camera view to render.

■ The output path where rendered images get stored.

■ Which scene state on page 7399 is restored prior to rendering.

■ Which rendering preset on page 6114 is used per rendered view.

■ Whether all the batch rendering tasks should be sent to Backburner for
network rendering on page 6433 by multiple systems for even faster rendering.

■ Exporting the batch rendering tasks and all parameters set in the Batch
Render dialog to a BAT file for later command line rendering on page 6562.

NOTE The Batch Rendering dialog is for rendering different aspects of the same
scene, such as views from different cameras. To batch-render a number of different
scenes, use Backburner on page 6550 or command-line rendering on page 6562.

Batch Render Completed

If a problem is encountered by the Batch Renderer, you will be notified by
means of the Batch Render Completed dialog. This is an error dialog that

Batch Rendering - Batch Render Dialog | 6553



appears and notifies you about which batch renders did not complete and, if
possible, provides a description of why the failure occurred.

If the cause of the error cannot be identified, then the error entry will simply
state Failed. The most common causes for failure are:

■ Missing texture maps for materials that are assigned to objects in the scene.
This shows up as Failed. Missing External File. Once the texture map is found
or map paths are properly set, this error will not occur.

■ Missing UVW coordinates for objects that have texture mapped materials
assigned to them. This is reported as Failed. Missing Map Coordinates on Object
and can be alleviated by making sure new objects are created with the
Generate Mapping Coords switch turned on and by assigning a UVW Map
modifier to the object that is not displaying its texture mapping.

Procedures

To use the Batch Render tool:

1 Open or create a MAX scene.

2 Choose Rendering menu > Batch Render.

The Batch Render dialog opens.

3 On the Batch Render dialog, click the Add button.

This adds your first rendering task to the batch render queue.

By default, the Camera parameter is set to Viewport, which means that
the task will render the active viewport. To change to a set view, make
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sure the scene contains at least one camera, and then choose the camera
view to render from the Camera drop-down list on page 6559.

4 Review the Selected Batch Render Parameters settings and, if necessary,
turn on Override Preset and then change the Frame Start, Frame End,
Width, Height, and Pixel Aspect settings.

5 Click the Output Path button to set a drive location, file name and file
format for the rendered image.

6 If you've saved any scene states with the model, you can choose which
one is loaded during the rendering operation by opening the Scene State
drop list.

7 Repeat steps 3 through 6 to continue adding rendering tasks to the batch
render queue, as necessary.

8 When all your tasks are set, click the Render button.

To use the Batch Render tool with Backburner:

Before attempting to use the Batch Render tool with Backburner for network
rendering, make sure the Backburner Manager is running on your managing
workstation and that Backburner Server is running on all the other workstations
that will receive the rendering assignments. For more information on setting
up Backburner Network Rendering, refer to Network Rendering on page 6433.

1 Set up a series of rendering tasks in the Batch Render queue as documented
in the previous procedure.

2 Turn on Net Render and then click the Render button.

The Network Job Assignment dialog opens.

3 Enter a subnet mask, or, with Automatic Search off, enter the Manager
name or IP address, and then click Connect.

The available rendering servers show up in the list on the right side of
the Network Job Assignment dialog.

4 Click the Submit button to send all the Batch Render camera tasks to
Backburner for network rendering to all the workstations that are running
Backburner Server.

If you are running the Backburner Queue Monitor, you'll see all the
camera tasks listed as rendering jobs in the Job section of the Queue
Monitor.
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Interface

Add Adds a new rendering task to the queue, using the default settings. By
default, a new task is set to render the active viewport. To set it to render a
particular camera, choose the camera from the Camera drop-down list on
page 6559.

Duplicate Adds a copy of the highlighted rendering task to the queue.

All rendering parameters that were part of the original task are duplicated for
the new task.

Delete Deletes the highlighted rendering task.
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No warning appears to confirm deletion and you cannot undo a deletion.

[Task Queue] This is a listing of all the camera tasks that have been chosen
for batch rendering. The task queue consists of eight columns that show all
the parameters that have been set for a particular camera task. You can control
which tasks are rendered by toggling the check boxes in the list.

Selected Batch Render Parameter group

By default, any tasks you've designated for batch rendering use the current
Time Output and Output Size parameters from the Render Setup dialog on
page 6067.

For example, if the Output Size settings on the Render Setup dialog shows
that you have a Time Output settings of Single and an of 800 width and 600
height, when you add a camera, its Selected Batch Render Parameters will
mimic those settings. Likewise, if the Render Setup dialog has a Time Output
set to Range and frame 0 to 25, the Frame Start and Frame End settings on
the Batch Render dialog will default to those Time Output settings.

This group gives you access to changing those default parameters.

Override Preset When on, you can override any of the default settings for
the highlighted task via the Frame Start, Frame End, Width, Height, and Pixel
Aspect settings. Default=off.

Frame Start The first frame to be rendered for the highlighted task. The default
setting for this parameter matches the Time Output group settings on the
Common panel of the Render Setup dialog.

Frame End The last frame to be rendered for the highlighted task. Its default
state also matches the Time Output group settings on the Common panel of
the Render Setup dialog.

The default Frame Start and Frame End parameters correspond to the Render
Setup dialog parameters as follows:

Batch Render dialog
Frame Start/End

Render Setup dialog
>Time Output

Defaults to the frame set

by the time slider.

Single
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Batch Render dialog
Frame Start/End

Render Setup dialog
>Time Output

Defaults to 0 (zero) and

the last frame of the anim-

Active Time Segment

ation as set in the Time

Configuration dialog on

page 7565.

Defaults to the range of

frames specified, such as 0

(zero) To 14 or 6 To 11.

Range

The Frame Start and End settings also conform to the current time
configuration format; i.e. Frames, SMPTE, Frame:Ticks, or MM:SS:Ticks.

Width Allows you to specify a new image width setting if Override Preset is
on. If Override Preset is off, this value matches the width set on the Render
Setup dialog.

Height Allows you to specify a new image height setting if the Override Preset
is on. If Override Preset is off, this value matches the height set on the Render
Setup dialog.

Pixel Aspect Sets the aspect ratio of the pixels for display on another device.
The image might look squashed on your display but will display correctly on
the device with differently shaped pixels. By default, this mimics the value
set on the Render Setup dialog.

Name Lets you change the default name of the highlighted task. The default
naming structure for camera tasks uses “View” plus an incremented view
number, such as View01 or View02. If you want, you can change the task's
name to something more descriptive.

NOTE After changing the name, you must press Enter for the change to register.

NOTE If you're rendering elements on page 6336 as part of the batch, the task name
is appended to each rendered element's specified file name. For example, if the
task name is View01 and the render element output file name is Test_Diffuse.tga,
then the batch-rendered element output becomes Test_Diffuse_View01.tga.

If you're rendering an element without specifying a file name for the element,
the batch renderer appends the element type to the batch output file name.
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For example, if the batch output file name is MyBatch.png, and you're rendering
an Atmosphere element, then the element output name becomes
MyBatch_Atmosphere.png.

Output Path The ellipsis (...) button opens the Render Output File dialog on
page 6086 where you can specify the output path, file name and file format for
the rendered image of the selected camera task.

Once set, the output path and file name appears in the output path field and
the file name appears in the Output Path column of the task queue.

X [Clear Output Path] Removes the output path and file name from the
Output Path field and task queue.

Camera This drop-down list shows any cameras in the scene.

By default, a task is set to render the active viewport, as indicated by the
“Viewport” entry in the Camera column of the task queue. You can use this
list choose a camera from any in the scene for the highlighted task. The new
camera is shown in the Camera column of the task queue.

To set the highlighted task to render the active viewport, choose the dashed
line (-------------------------) from the top of the drop-down list.

Choose the dashed line to render the active viewport.

NOTE Choosing a camera changes only the camera the task uses. It does not
change the name of the task.

Scene State This drop-down list displays the scene states on page 7399, if any,
that you can assign to the highlighted task. If no scene state is active then
current scene settings are used.

Preset Lets you choose a render preset for the highlighted task. If no render
preset is active and there is no override, then the current render settings are
used.

If you choose Load Preset from the drop-down list, the Render Presets Load
dialog opens.

Net Render When on, opens the Network Job Assignment dialog on page 6481
when you click the Render button.
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Each camera task in the Batch Render dialog is passed to the Network Job
Assignment dialog as an individual rendering job instead of a single job. By
default, the Network Job Assignment dialog uses the name of the MAX file as
its job name, and it then appends the name of the camera task. For example,
if you have a scene named Athena_High_Rise and camera tasks for three
cameras, the jobs will look like this in the monitor: Athena_High_Rise Camera02
View01, Athena_High_Rise Camera01 View02 and Athena_High_Rise Camera01
View03.

Export to .bat Creates a batch file for command line rendering. This button
opens the Batch Render Export To Batch File dialog where you can specify a
drive location and name for the batch file that is saved.

Render Starts the batch rendering process or opens the Network Job
Assignment dialog if Net Render is turned on.

Batch Render Tool - Batch Render Warning Dialog

Rendering menu > Batch Render > Click Render to render tasks that do not
have an output path set.

Rendering menu > Batch Render > Click Render to render tasks that could
overwrite previously saved files.

The Batch Render Warning dialog informs you of certain conditions you may
have overlooked while assigning the rendering tasks. The dialog that displays
is context-sensitive, meaning that the warning will indicate when either of
these two conditions exist:

■ When you risk overwriting an existing file or if you have not specified an
output path and output file name.

■ When the output path that was specified has been renamed or no longer
exists.

Interface

Task Queue

Both formats of the Batch Render Warning dialog include the Task Queue
columns that are shown in the in the Batch Render dialog. The key difference
is the exception of the check boxes that let you specify which cameras are use
in the render. This Task Queue only shows the cameras that may overwrite a
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saved file, or do not have a path/file name set for output, or if they show an
output path that is invalid.

Missing Output Path/Filename or File Overwrite

This version of the Batch Render Warning dialog appears if you click the
Render button on the Batch Render dialog and one or more of the tasks to be
rendered does not include an output path/file name. The dialog also appears
if there is a chance you will overwrite a previously rendered image.

OK Allows you to continue with the batch rendering tasks even though there
are some tasks without an output path/file name or some files could be
overwritten. Tasks without an output path/file name are not automatically
saved and only appear in the Rendered Frame Window on page 6073.

Cancel Cancels the batch rendering.

Invalid Output Path

This version of the Batch Render Warning dialog only appears if you are
rendering to a file that has invalid output paths. For example, if you're
rendering a client's model and they've set their own output paths.
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Update Path Allows you to browse to a new directory and reassign the output
path for all the entries in the Task Queue. The specified output file name
remains the same.

NOTE If you don't want to assign the same path to all the cameras shown in the
dialog, you should Cancel and set the correct paths for each camera from the
Batch Render dialog.

Continue Allows you to continue with the batch rendering tasks even though
there are some tasks without an output path. Tasks without an output path
are not automatically saved and only appear in the Rendered Frame Window
on page 6073.

Cancel Cancels the batch rendering.

Command-Line Rendering
The command-line rendering tool lets you perform batch rendering jobs
without having to manipulate parameters by hand in a MAX file. Simple,
“one-shot” rendering jobs can be submitted from the Start > Run dialog. More
elaborate, batched jobs can be rendered through the use of text files; for
example, MyRender.bat or MyRender.xml. The ability to edit text files is what
provides the power to this tool. You can quickly make changes to your
rendering parameters, or output formats, simply by opening your text editor
and editing the batch settings.

Command-line rendering is provided by the 3dsmaxcmd.exe program, found
in your program install folder.

6562 | Chapter 20   Rendering



You can submit command-line rendering jobs that are rendered on a single
workstation, or you can take advantage of network rendering on page 6433 and
let the Backburner utility manage the jobs across multiple systems.

The Batch Render tool on page 6553 is another way to quickly create BAT files
that can be used with the command-line rendering. The Batch Render tool
lets you create a queue of camera tasks with specific output parameters,
rendering presets or automatic loading of scene states. Once your queue is
complete, you can export the tasks to a BAT file that is stored in the \scenes
folder.

WARNING Command-line rendering is a professional feature and can perform
destructive operations. You will not see messages or warning dialogs informing
you about potential mistakes, such as overwriting an existing frame on your drive.

See also:

■ Command-Line Rendering Switches on page 6566

Procedures

To view the 3dsmaxcmd help file:

The 3dsmaxcmd.exe file contains a built-in help system that you can access
from a command prompt.

1 Open a command prompt window (for example, Windows Start > Run
> enter CMD).

2 Enter the following: “c:\program files\autodesk\[program folder
name]\3dsmaxcmd” -? and press Enter.

The list of switches and options will scroll on to the window.

To view a list of sample command lines with descriptions of what they do:

The 3dsmaxcmd.exe file also has an extensive list of sample text strings that
describe many of the most common scenarios you'd use command-line
rendering to accomplish.

1 Open a command prompt window.

2 Enter the following: “c:\program files\autodesk\[program folder
name]\3dsmaxcmd” -x and press Enter.
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Setting up the simplest rendering:

In its simplest form, just a render command using all the settings that are
stored with a scene, would look like this:

1 Open a command prompt window.

2 Enter the following: “c:\program files\autodesk\[program folder
name]\3dsmaxcmd” “c:\program files\autodesk\[program folder
name]\scenes\myscene.max” and press Enter.

Example: Rendering to a JPG file at 800x600 resolution:

Perhaps the last time you rendered your scene, you had the output resolution
set to 320x240 and rendered a BMP file. Re-rendering the scene using different
output settings is fast and efficient with command-line rendering.

1 Open a command prompt window.

2 Enter the following:

“c:\program files\autodesk\[program folder name]\3dsmaxcmd”
-outputName:“c:\program files\autodesk\[program folder
name]\renderoutput\myImage.jpg” -w 800 -h 600 “c:\program
files\autodesk\[program folder name]\scenes\myscene.max”

and press Enter.

NOTE The specified output path must already exist. If it doesn't, the image
doesn't render and you get an error message.

Network rendering from the command line:

If you have your system networked and have access to other systems, you can
take advantage of network rendering.

NOTE A command-line job cannot be run on a system already running the
Backburner server.

1 Open a command prompt window.

2 Enter the following:

“c:\program files\autodesk\[program folder name]\3dsmaxcmd” -submit
“c:\program files\autodesk\[program folder
name]\scenes\myscene.max”

and press Enter.
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Example: Rendering from a text file:

Command-line rendering gives you the ability to set a series of common
switches that can be quickly re-used for rendering a single job from Start >
Run, or for rendering a group of scenes specified in a BAT file. You can build
your text file using any text editor.

NOTE A TXT file can specify only a single scene to render. For multiple scenes,
use a BAT file.

1 Open your text editor.

2 Enter your list of commands, such as:

-bitmapPath=\\mapServer\maps\myMaps

-cam=myCamera

-width=800

-height=600

-vfb=true

-frames=all

-force2Sided=true

3 Once all the switches are entered, save the files as a TXT file, such as
myrender.txt.

4 To render the scene, open the Windows Start > Run dialog.

5 Enter the following:

“c:\program files\autodesk\[program folder name]\3dsmaxcmd”
@c:\myrender.txt -o=“c:\program files\autodesk\[program folder
name]\renderoutput\myImage.tga” “c:\program
files\autodesk\[program folder name]\scenes\myscene.max”

and click OK.

Using a TXT file that contains your favorite settings, in conjunction with
a command line that specifies the output file format and scene of your
choice, gives you the flexibility to re-use the TXT file without having to
edit it each time you want to render. You can create several TXT files
with settings for different stages of scene development, such as
testrender.txt or finalrender.txt.

Example: Rendering from a BAT file:

If you want to render several scenes in a batch process, you can create a BAT
file containing all the scenes and switches needed to get the results you want.
Just like a text file, you can build your BAT file using any text editor. For this
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example, let's say you have three scenes, in various stages, and you want each
rendered using different settings.

1 Open your text editor.

2 On the first line, enter the following text. This example assumes that the
scene is far from finished, but that you want to test a chunk of animation.

“c:\program files\autodesk\[program folder name]\3dsmaxcmd”
-o=“c:\program files\autodesk\[program folder
name]\renderoutput\scene1.jpg” -w=320 -h=240 -frame=1-33
“c:\program files\autodesk\[program folder name]\scenes\scene1.max”

The second scene is almost ready, but you need to test the look of some
materials and do a video color check:

“c:\program files\autodesk\[program folder name]\3dsmaxcmd”
-o=“c:\program files\autodesk\[program folder
name]\renderoutput\scene2.jpg” -w=640 -h=480 -force2Sided=true
-videoColorCheck=true “c:\program files\autodesk\[program folder
name]\scenes\scene2.max”

The last scene is complete, and you want to render a higher-resolution
image using settings you've saved in a TXT file that you always use for
final renderings:

“c:\program files\autodesk\[program folder name]\3dsmaxcmd”
@c:\finalrender.txt -o=“c:\program files\autodesk\[program folder
name]\renderoutput\scene3.jpg” “c:\program files\autodesk\[program
folder name]\scenes\scene3.max”

3 After entering these three command lines, save your file as a BAT file.

4 From the Windows Start > Run dialog, browse to the BAT file and click
Open.

5 Click OK to start rendering.

Command-Line Rendering Switches

In order to use command-line rendering, you should be familiar with DOS
and understand the structure of command lines.
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Command-Line Switches

You can use the following switches after 3dsmaxcmd on the command line
of a command prompt window, or as entries in a text file. The following tables
show switches and their effects.

NOTE Switches are not case sensitive.

At Verbosity level 5, the output message from command-line rendering includes
both a timestamp and a date stamp. The timestamp is separated from the
main message by a semicolon, and the elapsed time message is separated from
the Frame Completed message by a semicolon. This lets you pipe the message
to a file, and then open it in a spreadsheet program with appropriate columns
by setting the delimiter character.

Separators

Many switches are displayed in the following charts with trailing colons, such
as -w: or -h:. The use of a colon separator is optional, and can be replaced with
a space or an equal sign (=). Therefore, command lines such as:

“c:\program files\autodesk\[program folder name]\3dsmaxcmd”
-outputName:“c:\program files\autodesk\[program folder
name]\renderoutput\myImage.jpg” -w:640 -h:480 “c:\program
files\autodesk\[program folder name]\scenes\myscene.max”

“c:\program files\autodesk\[program folder name]\3dsmaxcmd”
-outputName “c:\program files\autodesk\[program folder
name]\renderoutput\myImage.jpg” -w 640 -h 480 “c:\program
files\autodesk\[program folder name]\scenes\myscene.max”

“c:\program files\autodesk\[program folder name]\3dsmaxcmd”
-outputName=“c:\program files\autodesk\[program folder
name]\renderoutput\myImage.jpg” -w=640 -h=480 “c:\program
files\autodesk\[program folder name]\scenes\myscene.max”

will give you the same results. The use of the equal sign can give your
command-line files more of an INI file appearance.

NOTE The switch -submit:[manager_name] is the only case where a colon is
necessary.
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On/Off Command-Line Switches

Many of the switches you'll use are simple on/off toggles, such as the -rfw:
and -renderFields: switches. If you prefer, instead of using a 1 or 0 to designate
their states, you can use True or False. For example, to render a scene to a
specified file type and display the Rendered Frame Window, your command
line might look like this;

“c:\program files\autodesk\[program folder name]\3dsmaxcmd”
-outputName=“c:\program files\autodesk\[program folder
name]\renderoutput\myImage.jpg” -rfw=true “c:\program
files\autodesk\[program folder name]\scenes\myscene.max”

Basic Options

EffectSwitch

Displays a list of these switches in
the DOS window.

-?

Shows a list of example command
lines.

-x

Sets the verbosity level, where # is
an integer from 0 (least verbose)
to 5 (most verbose).

-v:#

Points to a separate file containing
command-line options.

@command_file
or -cmdFile:com-
mand_file

Uses a render preset file where
<filename> is the name of the pre-
set file.

-preset:<file-
name> or -
rps:<filename>

Loads the specified scene state file
before rendering the image.

-sceneState:<scene-
state-name>

Renders all enabled tasks in the
Batch Render dialog.

-batchRender
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EffectSwitch

Renders batch renders in the file
named batch-render-name.

-bat-
chRender:<batch-
render-name>

Uses a pre-render script where <fi-
lename> is the name of the script
file.

-preRender-
Script:<file-
name> or -
script:<filename>

Uses a post-render script where
<filename> is the name of the
script file.

-postRender-
Script:<file-
name>

Root location for job data folders.-workPath:<path-
name>

Path configuration file (MXP
format).

-pathFile:<path-
name>

(obsolete) Provides an extra bit-
map path. Multiple paths can be

-bitmap-
Path:<path-
name> entered and UNC naming conven-

tions can be used.

(obsolete) Lets you specify extra
XRef paths. Multiple paths can be

-xrefPath:<path-
name>

entered and UNC naming conven-
tions can be used.

Split render: number of strips,
overlap amount.

-split:<strips,
overlap>

Split render: number of strips,
overlap amount, strip number

-strip:<strips,
overlap, strip>

(starting with 1). This is similar to
the -split switch, but lets you
render a specific, individual strip.
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EffectSwitch

NOTE The strip value has no ef-
fect when submitting the job to
Backburner. The job will still
render all strips. Split and Stitch
functionality is intended for local
rendering only.

Stitches strips (see above), combin-
ing them into a single image:

-stitch:<strips,
overlap>

number of strips, overlap amount.
Stitch functionality is intended for
local rendering only.

Specifies a date format to be used
in message timestamp, at verbos-

-date-
Format:<date-
format> ity level 5. Defaults to locale-de-

pendent format. For details, use
the 3dsmaxcmd3dsvizcmd -x op-
tion.

Specifies a time format to be used
in message timestamp, at verbos-

-time-
Format:<time-
format> ity level 5. Defaults to locale-de-

pendent format and 24–hour
clock. For details, use the 3dsmax-
cmd -x option.

Render Parameters

NOTE Any command-line switches that are on/off toggles can be switched by
entering either 1, 0, on or off.

EffectSwitch

Sets an output file name
and format.

-outputName:<file-
name> or -o:<filename>
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EffectSwitch

Specifies a camera name.-camera:<string> or -
cam:<string>

Sets the output width in
pixels.

-width:<integer> or -
w:<integer>

Sets the output height in
pixels.

-height:<integer> or -
h:<integer>

Sets the pixel aspect ratio.-pixelAspect:<number>

Sets the rendering se-
quence start frame.

-start:<integer>

Sets the rendering se-
quence end frame.

-end<integer>

Sets the Every Nth Frame
value.

-nthFrame<integer>

Lets you specify a frame
list; for example, (1,3,5-12)
or all.

-frames<string>

Indicates that this is a still-
frame render; no frame
suffix will be added.

-stillFrame or -sf

Image-sequence file cre-
ation: 0=none; 1=.imsq;
2=.ifl

-imageSequence-
File:<0/1/2>

Toggles gamma correction.
“1”=On, “0”=Off.

-gammaCorrec-
tion:<1/0>

Sets the Input Gamma
value.

-gammaValueIn:<num-
ber>
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EffectSwitch

Sets the Output Gamma
value.

-gammaValueOut:<num-
ber>

If an error is encountered,
the software attempts to
continue rendering.

-continueOnError

Turns Video Post on page
6773 on or off for the job.

-videopostJob:<1/0>

Render Flags

EffectSwitch

Toggles the Rendered
Frame Window. “1”=On,
“0”=Off.

-showRFW:<1/0> or -
rfw:<1/0>

Toggles Skip Existing Im-
ages. “1”=On, “0”=Off.

-skipRendered-
Frames:<1/0>

Toggles Video Color
Check. “1”=On, “0”=Off.

-videoColorCheck:<1/0>

Toggles Force 2-Sided.
“1”=On, “0”=Off.

-force2Sided:<1/0>

Toggles Render Hidden.
“1”=On, “0”=Off.

-renderHidden:<1/0>

Toggles Atmospherics.
“1”=On, “0”=Off.

-atmospherics:<1/0>

Toggles Super Black.
“1”=On, “0”=Off.

-superBlack:<1/0>
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EffectSwitch

Toggles Render Fields.
“1”=On, “0”=Off.

-renderFields:<1/0>

Toggles Field Order. De-
fault=”Odd”.

-fieldOrder:even or odd

Toggles Displacement
Mapping. “1”=On,
“0”=Off.

-displacements:<1/0>

Toggles Render Effects.
“1”=On, “0”=Off.

-effects:<1/0>

Toggles area lights/shad-
ows. “1”=On, “0”=Off.

-useAreaLights:<1/0>

Toggles use advanced
lighting. “1”=On,
“0”=Off.

-useAdvLight:<1/0>

Toggles compute ad-
vanced lighting. “1”=On,
“0”=Off.

-computeAdv-
Light:<1/0>

Toggles Output Dithering
(paletted). “1”=On,
“0”=Off.

-ditherPaletted:<1/0>

Toggles Output Dithering
(true-color). “1”=On,
“0”=Off.

-ditherTrueColor:<1/0>

Toggles render elements
(true-color). “1”=On,
“0”=Off.

-renderElements:<1/0>
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Backburner Job Submission

These switches concern submitting a rendering job for network rendering. For
further information, see Network Rendering on page 6433. Also, for a different
method of network rendering via the command line, see Backburner Command
Line Control on page 6579.

EffectSwitch

Submits the scene, <filename>
to a specific manager system for
network rendering.

NOTE This is the only switch
that requires a colon separator.

-submit[:man-
ager_name] or -
s[:manager_name]

Specifies a manager port num-
ber.

-port:<integer>

Lets you specify a network mask
other than 255.255.255.0.

-netmask:<string>

Lets you specify a job name to
render.

-jobName:<string>

Sets job priority.-priority<integer>

Toggles initially suspended.
“1”=Yes, “0”=No.

-suspended:<1/0>

Writes all job settings to an XML
file. The file uses the same name

-writeJobFile

as the MAX file, so, for example,
test.max produces test.xml.

Reads all job settings from an
XML file.

-readJobFile:<file-
name>

The amount of time to wait for
3ds Max to load, in minutes.
Default=20.

-waitLoad:<in-
teger>
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EffectSwitch

The amount of time to wait for
3ds Max to render, in minutes.
Default=600.

-waitRender:<in-
teger>

The amount of time to wait for
3ds Max to unload, in minutes.
Default=10.

-waitUnload:<in-
teger>

The platform (either 32– or
64–bit) that your scene will be

–platform:32 or
64

rendered on. Use this switch
when you want to render your
scene on a different platform
from the platform where you
created your scene.

Bitmap Parameters

EffectSwitch

Sets the type of BMP file being
rendered. “2”=paletted,
“8”=true 24-bit.

-BMP_TYPE:2 or 8

Sets the JPG quality value.
Ranges from 1 to 100.

-JPEG_QUALITY:1
to 100

Sets the JPG smoothing value.
Ranges from 1 to 100.

-JPEG_SMOOTH-
ING:1 to 100

Sets the color depth for TGA
files.

-TARGA_COL-
ORDEPTH:16, 24
or 32

Toggles TGA Compression.
“1”=On, “0”=Off.

-TARGA_COM-
PRESSED:<1/0>
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EffectSwitch

Toggles TGA Alpha Split.
“1”=On, “0”=Off.

-TARGA_ALPHAS-
PLIT:<1/0>

Toggles TGA Pre-Multiplied Al-
pha. “1”=On, “0”=Off.

-TARGA_PREMUL-
TALPHA:<1/0>

Sets the TIF type. “0”=mono,
“1”=color, “2”=logl, “3”=logluv,
“4”=16–bit color.

-TIF_TYPE:<0/1/2/3/4>

Toggles TIF file alpha. “1”=On,
“0”=Off.

-TIF_ALPHA:<1/0>

Toggles TIF Compression.
“1”=On, “0”=Off.

-TIF_COMPRES-
SION:<1/0>

Sets the dots-per-inch value for
TIF files.

-TIF_DPI:<num-
ber>

For each of the following -RLA_xxxx switches, there is a corresponding
-RPF_xxxx option.

EffectSwitch

Sets the RLA color
bitdepth.

-RLA_COLORDEPTH:8, 16 or
32

Toggles RLA Alpha.
“1”=On, “0”=Off.

-RLA_ALPHA:<1/0>:

Toggles RLA Premulti-
plied Alpha. “1”=On,
“0”=Off.

-RLA_PREMULTALPHA:<1/0>

Lets you specify an
RLA description (in
quotes).

-RLA_DESCRIPTION:<string>
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EffectSwitch

Lets you specify an
RLA author name (in
quotes).

-RLA_AUTHOR:<string>

Toggles RLA Z-Depth
Channel. “1”=On,
“0”=Off.

-RLA_ZDEPTHCHAN-
NEL:<1/0>

Toggles RLA Material
Effects Channel.
“1”=On, “0”=Off.

-RLA_MTLIDCHANNEL:<1/0>

Toggles RLA Object
Channel. “1”=On,
“0”=Off.

-RLA_OBJECTIDCHAN-
NEL:<1/0>

Toggles RLA UV Co-
ordinates Channel.
“1”=On, “0”=Off.

-RLA_UVCHANNEL:<1/0>

Toggles RLA Surface
Normals Channel.
“1”=On, “0”=Off.

-RLA_NORMALCHAN-
NEL:<1/0>

Toggles RLA Non-
Clamped Color

-RLA_NONCLAMPEDCOL-
ORCHANNEL:<1/0>

Channel. “1”=On,
“0”=Off.

Toggles RLA Cover-
age Channel.
“1”=On, “0”=Off.

-RLA_COVERAGECHAN-
NEL:<1/0>
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The following -RPF_xxxx switches do not have corresponding -RLA_xxxx options.

EffectSwitch

Turns on RPF Node
Render ID Channel.

-RPF_NODERENDERID-
CHANNEL

Turns on RPF Color
Channel.

-RPF_COLORCHANNEL

Turns on RPF Transpar-
ency Channel.

-RPF_TRANSPCHANNEL

Turns on RPF Velocity
Channel.

-RPF_VELOCCHANNEL

Turns on RPF Sub-Pixel
Weight Channel.

-RPF_WEIGHTCHAN-
NEL<1/0>

Turns on RPF Sub-Pixel
Mask Channel.

-RPF_MASKCHANNEL

EffectSwitch

EXR use exponent
on/off

-EXR_USEEXPONENT

EXR exponent value
(decimal)

-EXR_EXPONENT

EXR premultiplied alpha
on/off

-EXR_PREMULTALPHA

EXR save alpha compon-
ent on/off

-EXR_ALPHA

EXR save red compon-
ent on/off

-EXR_RED
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EffectSwitch

EXR save green compon-
ent on/off

-EXR_GREEN

EXR save blue compon-
ent on/off

-EXR_BLUE

EXR bit depth: 0=8–bit
integers; 1=half float;
2=float

-EXR_BITDEPTH

EXR use number of
frame digits on/off

-EXR_USEFRAMENUMDI-
GITS

EXR number of frame
digits (integer)

-EXR_FRAMENUMDIGITS

EXR compression type:
0=no compression;

-EXR_COMPRESSIONTYPE

1=RLE; 2=ZIP (1 scan-
line); 3=ZIP (16 scan-
lines); 4=PIZ

EXR use RealPix RGB
data on/off

-EXR_USEREALPIX

Backburner Command Line Control

The Backburner command line plug-in allows you to submit batch, executable,
or script files to Backburner as “custom” jobs. This cmdjob.exe tool, found in
the Backburner program folder, provides more flexibility in running custom
jobs than is offered by the 3ds Max 3dsmaxcmd.exe plug-in.

For a list of the command-line switches that you can use with the Backburner
command line plug-in, see Command-Line Rendering Switches on page 6566.
Some examples of how these commands can be used with 3ds Max are listed
below.
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NOTE In order to use command-line rendering, you should be familiar with DOS
and understand the structure of command lines.

Examples of a CmdJob Usage

Please see the online version of the Help for details.

See also:

■ Command-Line Rendering on page 6562
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Effects and Environments

A variety of special effects, such as film grain, depth of field, and lens simulations, are available
as rendering effects on page 6583. Another set of effects, such as fog, are provided as environment
effects on page 6687. Also available in the environment settings are exposure controls on page
6732, also known as tone mappers.

The fog environment effect adds atmosphere to a street scene.

In 3ds Max, rendering effects and environments are accessed from a single Environment and
Effects dialog on page 6582.

21
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Environment and Effects Dialog
Rendering menu > Environment

Rendering menu > Effects

Rendered Frame Window > Environment and Effects Dialog Toggle

You apply effects and environments by using the Environment and Effects
dialog.

Interface

The Environment and Effects dialog has two panels, described in the following
topics:
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Effects Panel and Rollout on page 6585

Environment Panel on page 6689

Rendering Effects
Rendering Effects enable you to add post-production effects without having
to render the scene to see the results. Through the Effects panel on page 6585
on the Environment and Effects dialog, you can add various effects and view
them prior to final rendering of an image or animation.

Rendering Effects let you work interactively. As you adjust an effect's
parameters, the Rendered Frame Window on page 6073 is updated with the final
output image of both the scene geometry and the applied effects. You can
also choose to continually work with an effect and then update the effect
manually.

The following topics explain each Rendering Effect in detail.

Hair and Fur Render Effect on page 6588

Lens Effects Rendering Effects on page 6594

Blur Rendering Effect on page 6664

Brightness and Contrast Rendering Effect on page 6673

Color Balance Rendering Effect on page 6675

Depth of Field Rendering Effect on page 6683

File Output Rendering Effect on page 6676

Film Grain Rendering Effect on page 6679

Motion Blur Rendering Effect on page 6681

Rendering Effects and 32–bit Floating-Point Output

Most rendering effects in 3ds Max are not compatible with 32-bit floating-point
output, such as that provided optionally by the mental ray renderer (see Frame
Buffer Type on page 6277). If you render using one or more unsupported effects,
the following dialog appears:
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You can choose to continue rendering without the unsupported effects, or
cancel the render.

The only supported effects are File Output and Color Balance; the rest (shown
in the dialog above) are unsupported.

Rendering Effects Command

Rendering menu > Effects > Environment and Effects dialog > Effects panel

Effects displays the Effects panel on page 6585 on the Environment and Effects
dialog, which lets you set parameters for post-rendering effects.

From this panel, you can select and assign a class of plug-in called Render
Effect, which is a post-rendering image-processing effect. This lets you apply
image processing without using Video Post.

Render Effects have the added advantage of allowing animated parameters
and references to scene objects. You can also adjust and view the effects
interactively.
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Effects Panel and Rollout

Rendering menu > Effects > Environment and Effects dialog > Effects panel

Rendered Frame Window > Environment and Effects Dialog Toggle > Effects
panel

You can use the Effects panel to:

■ Assign a Render Effects plug-in.

■ Apply image processing without using Video Post.

■ Adjust and view effects interactively.

■ Animate parameters and references to scene objects.

Interface
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The Effects panel has one main rollout, Effects, with the following options:

Effects Displays a list of selected effects.

Name Displays the name of the selected effect. Edit this field to rename the
effect.

Add Displays a dialog listing all available rendering effects. Select the effect
you want added to the window list, and then click OK.

Delete Removes a highlighted effect from the window and from the scene.

Active Specifies whether the selected effect is active in the scene. On by default;
you can deactivate an effect without actually removing it by selecting it in
the window and turning off Active.

Move Up Moves the highlighted effect up in the window list.

Move Down Moves the highlighted effect down in the window list.

Merge Merges rendering effects from scene (.max) files. Clicking Merge displays
a file dialog from which you can choose a .max file. A dialog then appears
listing all rendering effects in that scene.

Preview group

Effects When All is chosen, all of the active effects are applied to the preview.
When Current is chosen, only the highlighted effects are applied to the
preview.

Interactive When on, changes occur interactively in the Rendered Frame
Window on page 6073 as you adjust the parameters of an effect. When Interactive
is not activated, you can click one of the update buttons to preview the effect.

Show Original/Show Effects toggle Click Show Original to display the original
rendered image without any of the effects applied. Click Show Effects to display
the rendered image with the effects.

Update Scene Updates the Rendered Frame Window with all changes made
in Rendering Effects as well as any changes made to the scene itself.

Update Effect Manually updates the preview Rendered Frame Window when
Interactive is not on. What is shown in the Rendered Frame Window is only
an update of any changes made in Rendering Effects. Any changes made to
the scene itself will not be rendered.
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Merging Effects

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Merge

The Merge button on the Effects panel on page 6585 lets you merge effects from
other 3ds Max (.max) scene files.

See also:

■ Merge on page 7058

■ Replace on page 7070

■ Merge Animation on page 7063

Procedures

To merge an atmospheric effect:

1 Choose Rendering menu > Effects to display the Effects panel.

2 On the Effects rollout, click Merge.

A Merge Effect dialog appears for file selection.

3 Choose a MAX file.

A Merge Atmospheric Effects dialog lists the effects in the specified file.

4 Select one or more of the effects, and then click OK to merge them into
the scene.

Only atmospheric effects appear in the merge list, but when an effect is
merged, any lights or gizmos bound to the effect are merged as well.
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To resolve conflicts when merged effects have the same name:

■ If an effect of the same type and name already exists in the scene, an alert
appears. Choose from among these options:

■ Name field Allows you to rename the incoming effect.

■ Merge Results in two effects in the scene with the same name.

■ Delete Old Removes the existing effect in the scene.

■ Apply To All Duplicates Performs the same action on all subsequent
matching effects.

Hair and Fur Render Effect

Rendering menu > Effects > Environment And Effects dialog > Effects panel
> Add > Add Effect dialog > Hair and Fur

Hair and Fur modifier > Tools rollout > Render Settings button

To render hair, the scene must contain a Hair And Fur render effect. The render
effect is automatically added to the scene the first time you apply the Hair
And Fur modifier to an object, or 3ds Max adds one (with default values) at
render time if an active Hair And Fur modifier is applied to an object. If for
some reason the render effect doesn't exist in the scene, you can add one by
clicking the Render Settings button. This opens the Environment And Effects
dialog and adds a Hair And Fur render effect. You can change the settings, or
simply accept the default settings by closing the dialog after it opens.
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Interface
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Hair Rendering Options group

Hairs Sets the method to be used for rendering hair:

■ buffer (The default) Procedural hair generated by Hair at render time
based on the modifier parameters. Buffer hair is generated by a special
renderer within Hair and offers the benefit of being able to create millions
of hairs with minimal memory requirements. Only one hair is in memory
at a time. Also, using Buffer render offers a variety of compositing options
(described below).

■ geometry Creates actual geometry for the rendered hair at render time.
This geometry is assigned the material ID set by the Hair And Fur modifier
> Geom Mat ID parameter on page 1168.

NOTE “Geometry” hair derives its texture from the growth object, not from
any maps applied via the Material Parameters rollout.
Compositing options aren't available with “geometry” hair.

The “geometry” option works with both the default scanline renderer and
the mental ray renderer.

■ mr prim Hair is generated by a procedural mental ray shader that
generates mental ray curve primitives directly into the mental ray rendering
stream at render time.
Choose this option only when you are rendering hair with the mental ray
renderer on page 6230.

mr Voxel Resolution Available only for the “geometry” and “mr prim” Hairs
options. At render time, hair boundaries are subdivided into volume cubes or
“voxels.” 3ds Max calculates which hairs are in each voxel, and when a ray
enters a voxel, it calculates for those hairs. This allows unneeded voxels to be
removed from memory during calculation.

With “geometry” rendering, voxels are used only for calculating instanced
hairs.

This value gives the resolution of the subdivision. For example, a value of 3
subdivides the volume into 3 x 3 x 3 voxels, for a total of 27. The higher this
value, the more efficient calculations can be. Default=5.

Lighting

■ native (The default.) Uses standard 3ds Max calculations for light falloff.

■ emulation Performs a simpler internal calculation for light falloff within
the buffer render. It applies only to the buffer hair rendering itself, not the
3ds Max scene. This mode omits features such as illumination textures on
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the hair, and light falloff calculation might be slightly inaccurate, but
rendering is somewhat faster.

Raytrace the Reflections/Refractions Available only for the “buffer” Hairs
option. When on, reflections and refractions are ray-traced. When off, they
are calculated as usual. Turning this option on can increase realism at the cost
of render time. Default=off.

Motion Blur group

In order to render motion-blurred hairs, Motion Blur must be enabled for the
growth object.

Duration The number of frames over which motion blur is calculated for each
frame.

Interval The point in the duration at which the “snapshot” of the hair is
captured, before blurring. The choices are “start”, “middle”, and “end”. The
default is “middle”, which causes blurring to occur at the start and end of the
duration.

Buffer Rendering Options group

This setting applies only to the ”buffer” rendering method on page 6590.

Oversampling Controls the level of antialiasing applied to the Hair “buffer”
render. The available choices are “draft”, “low”, “medium”, “high”, and
“maximum”. The “draft” setting uses no antialiasing; “high” is suitable for
most final renders; in extreme cases, use “maximum”. The higher the
Oversampling level, the greater the memory requirements and render time.
Default=”low.”

 Tile Memory Usage Sets the maximum amount of main memory to
be used by a “tile.” Hair And Fur renders hair one tile at a time. Default = 70
Megabytes.

 Transparency Depth Sets a maximum depth for rendering transparent
or translucent hairs. Default=30.
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Composite Method group

This option lets you choose the method by which Hair composites hair with
the rest of the scene. Compositing options are available only with the “buffer”
rendering method.

■ None Renders the hair only, with occlusion. The resulting image is ready
to composite.

■ Off Renders hair shadows but not the hair.

■ Normal (The default.) Does standard rendering and composites the
occluded hair with the rest of the scene in the Rendered Frame Window.
Because of the occlusion, hair will not appear behind (through) transparent
objects.

■ GBuffer Buffer-rendered hair appears behind most transparent objects.
Transparent refractive objects aren't supported.

Occlusion Objects group

This setting lets you choose which objects will occlude hair in the scene; that
is, if the object is closer to the camera than part of the hair array, the hairs
behind it won't render. By default, all objects in the scene occlude hair behind
them.

■ Auto (The default.) All renderable objects in the scene occlude hair behind
them.

■ All All objects in the scene, including non-renderable objects, occlude
hair behind them.

■ Custom Lets you specify the objects that will occlude hair. Choosing this
option makes the buttons on the right slide of the list available. If you
choose Custom but don't specify any occlusion objects, no objects will
occlude the hair; that is, the hair will appear in front of all objects, whether
or not it's closer to the camera than the objects.

List The list of custom occlusion objects. To edit this list, choose Custom and
then use the buttons on the right side of the list.

Add Adds a single object to the list. Click Add and then in a viewport, click
the object to add.
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Add List Adds multiple objects to the list. Click Add List and then in a
viewport, click each object to add in turn. To finish, right-click the viewport
or click Add List again to turn it off.

Replace To replace an object in the list, highlight its name in the list, click
Replace, and then in a viewport click the replacement object.

Delete To remove an object from the list, highlight its name in the list and
then click Delete.

 Global Illumination group

Apply Skylight When on, Hair And Fur supports takes sky light into account,
provided it is present in the scene. Default=off.

Multiplier Available only when Skylight is turned on. This Multiplier value
lets you adjust the amount of sky light that is used when rendering hair.

Lighting group

These settings control the illumination of hair and shadow-casting from hair
by supported lights in the scene.

The following light types are not supported when rendering hair with the
“buffer” method: Skylight, mr Area Omni, mr Area Spot, IES Sun, IES Sky, mr
Sky and mr Sun. However, mr Area Omni, mr Area Spot, mr Sky, and mr Sun
are supported for hair when you use the “mr prim” method and the mental
ray renderer.

NOTE For the purposes of rendering shadows in hair, Direct lights are treated as
point (omni) lights.

Shadow Density Specifies the relative darkness of the shadows. At the default,
highest value, 100.0, shadows are darkest. At the lowest value, 0.0, shadows
are fully transparent, so they don't render. Range=0.0 to 100.0. Default=100.0.

Use all lights at render time When on, causes all supported lights in the
scene to illuminate and cast shadows from hair when the scene is rendered.
(Shadows are cast only from lights whose Shadows toggle is on.) When off,
for a light to cast shadows from hair, you explicitly must add hair properties.
In either case, shadow maps for hair use the settings from the Hair Light
Attr(ibutes) rollout on page 5094 Default=on.

NOTE These settings apply only to “buffer”-rendered hair (the default type, set
in the Hair Rendering Options group, as described above).
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Add hair properties Adds the Hair Light Attr(ibutes) rollout on page 5094 to
selected lights in the scene. If you want to assign hair-specific shadow
properties on a per-light basis, this rollout is necessary. Available only when
at least one supported light is selected.

When Use All Lights At Render Time is off, only lights with hair properties
can illuminate hair.

Remove hair properties Removes the Hair Light Attr(ibutes) rollout on page
5094 from selected lights in the scene. Available only when at least one light
with hair properties added is selected.

Lens Effects Rendering Effects

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects

Lens flares added as lens effects

Lens Effects is a system used to create real-life effects commonly associated
with a camera. These effects include Glow on page 6599, Ring on page 6606, Ray
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on page 6616, Auto Secondary on page 6623, Manual Secondary on page 6631, Star
on page 6638, and Streak on page 6645.

Procedures

To add an effect:

1 Select the desired effect from the list on the left side of the Lens Effects
Parameters rollout.

2 Click the (>) arrow button to move it into the column on the right.

To delete an applied effect:

1 Select the effect from the list on the right side of the Lens Effects
Parameters rollout.

2 Click the (<) arrow button to remove it from the list.

Interface

Lens Effects Parameters rollout

The Lens Effects system allows you to apply effects to your rendered image
by choosing a particular effect from the list on the left and adding it to the
list on the right. Each effect has its own rollout of parameters, but all effects
share two panels of global parameters.
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Lens Effects Globals rollout, Parameters panel

Load Displays the Load Lens Effects file dialog that enables you to open an
LZV file. The LZV file format contains information saved from a previous
configuration of Lens Effects. This allows you to load and use Lens Effects that
have been saved from previous sessions of the software.

Save Displays the Save Lens Effects file dialog that enables you to save an LZV
file. The LZV file format contains information saved from a previous
configuration of Lens Effects. This allows you to save several types of Lens
Effects and use them in multiple 3ds Max scenes.

NOTE Saving an effect as an LZV file will only save the attributes of the effect on
the frame that it is saved at. The LZV file format doesn’t save the animation keys
of an animated parameter.

Size Affects the size of the overall Lens Effect. This value is a percentage of
the size of the rendered frame.

Intensity Controls the overall brightness and opacity of the Lens Effect. Higher
values produce a bright, more opaque effect, and lower values produces a dim,
transparent effect.
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Seed Gives the random number generator in Lens Effects a different starting
point, which creates a slightly different Lens Effect without changing any
settings. Using Seed guarantees a different Lens Effect, even if the differences
are very small. For example, if you set up a Ray effect, you will get slightly
different rays in the lens flare if you adjust the seed value.

Angle Affects the amount that the Lens Effect rotates from its default position,
as the position of the effect changes relative to the camera.

Squeeze Squeezes the size of the overall Lens Effect, either horizontally or
vertically to compensate for different frame aspect ratios. Positive values stretch
the effect horizontally, and negative values stretch it vertically. The value is
a percentage of the size of the flare. Range=100 to -100.

Lights group

Allows you to choose lights to apply Lens Effects to.

Pick Light Enables you to select a light directly through the viewports. You
can also select a light by pressing H to open the Pick Object dialog.

Remove Light Removes a selected light.

Drop-down list Provides quick access to lights that you have added to the
Lens Effect.
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Lens Effects Globals rollout, Scene panel

Affect Alpha Specifies whether or not the Lens Effect affects the alpha channel
of an image when the image is rendered in a 32-bit file format. The alpha
channel is an extra 8 bits of color (256 colors) that indicate transparency in
an image. Alpha channels are used to composite one image seamlessly over
the top of another. If you want to composite a Lens Effect, or an image that
contains a Lens Effect, over the top of another image, enable this option. If
you are not rendering to a 32-bit file, do not enable this option.

Affect Z Buffer Stores an object's distance from the camera. The Z-Buffer is
useful for optical effects. When this option is enabled, the linear distance of
the Lens Effect is recorded, and can be used in special effects that make use
of the Z-Buffer.

Distance Affects Allows distance from the camera or viewport to affect the
size and/or the intensity of the effect.

Off-Center Affects Allows an effect that is off-center from the camera or
viewport to affect the size and/or the intensity of the effect.

Direction Affects Allows direction of spot lights with respect to the camera
or viewport to affect the size and/or the intensity of the effect.
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The size and intensity of the effect are at a maximum when the light is pointed
at the camera (or viewport).

Occlusion group

Occlusion is used to determine when a Lens Effect will be affected by an object
that comes between the effect and the camera. By using two spinners to
determine occlusion you can have scene objects realistically affect the look
of your effect. The outer radius will determine when another scene object will
begin to occlude and the inner radius will determine when the scene object
will cause the effect to reach maximum occlusion.

Inner Radius Sets the inner radius around the effect that another scene object
must intersect in order to completely occlude the effect.

Outer Radius Sets the outer radius around the effect that another scene object
must intersect in order to begin to occlude the effect.

Size Decreases the size of the effect when being occluded.

Intensity Decreases the intensity of the effect when being occluded.

Affected by Atmosphere Allows Atmospheric Effects to occlude Lens Effects.

Glow Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Glow, and click the (>) arrow
button.
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Adding glow to the light

Glow lets you add a glowing aura around any assigned object. For example,
for an exploding particle system, adding a glow to the particles makes them
seem as though they are brighter and hotter.

WARNING This effect is not supported by the mental ray renderer on page 6230.
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Interface

Glow Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many
different effects under one instance of Lens Effects. To keep them in order, it
is often necessary to name them to make sure that when you change
parameters you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated.

Size Determines the size of the effect.
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Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Glow Behind Gives the effect the ability to be displayed behind objects in
your scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated the
effect will be squeezed according to Lens Effects Globals under the Parameters
panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are applying
the effect to and the color or mapping set in the Radial Color or Circular Color
parameters. A value of 0 uses only the values set in the Radial Color and
Circular Color parameters while a value of 100 uses only the light or objects
source color. Any value between 0 and 100 will render a mix between the
source color and the effect’s color parameters.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
You can also use bitmaps such as Gradient or Cellular to determine the radial
color.

Falloff Curve Displays the Radial Falloff dialog on page 6658 in which you can
set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens
Effects source.

Circular Color group

Circular Color determines the color of the effect by using four different color
swatches that are matched to the four quadrants of the effect. A map can also
be used to determine circular color.

Mix Mixes colors set in Radial Color and colors set in Circular Color. Setting
the spinner at 0 will only use values set in Radial Color while setting the
spinner at 100 will only use values set in Circular Color. Any value between
0 and 100 will mix between the two values.
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Falloff Curve Displays the Circular Falloff dialog on page 6652 in which you
can set weights for the colors used in Circular Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6661. Using the Radial Size
dialog you can create points on a line and move those points along a graph
to determine where the effect should be placed around the light or object.
You can also use a map to determine where the effect should be placed. A
check box is used to activate the map.

Glow Element rollout, Options panel
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Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that have
a corresponding G-Buffer on page 7991 (or Object) ID. The G-Buffer is a geometry
buffer and can be defined when you right-click any object and select Properties
from the menu. Then, set the Object Channel ID under the G-Buffer ID
controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5348 assigned to it. Assign the Material ID
channel in the Material Editor, using the Material ID channel flyout on page
5350. The Lens Effect will be applied only to areas of the geometry where that
particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255). The
software keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that the Lens Effect is applied to. Pure white
has a pixel value of 1. When this spinner is set to 1, any pixels with a value
above 255 will be glowed. You can invert this value by clicking the I button
to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle of
the surface normal to the camera. A value of 0 is coplanar, or parallel to the
screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf
Norm to 45, only surfaces with normal angles greater than 45 degrees will be
glowed. You can invert this value by clicking the I button to the right of the
spinner. This parameter can be animated.
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Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.

Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner
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Hue Filters the source objects by their hue. Select the hue by clicking the color
swatch next to the spinner. You can choose hue values from 0 to 255. The
spinner beside the Hue color swatch lets you enter a variance level so that the
glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.

Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6655. Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Ring Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Ring, and click the (>) arrow
button.
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Adding a ring to the light

The ring is a circular color band that surrounds the center of the source object.

WARNING This effect is not supported by the mental ray renderer on page 6230.
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Interface

Ring Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many
different effects under one instance of Lens Effects. To keep them in order, it
is often necessary to name them to make sure that when you change
parameters you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated. Default = on.

Size Determines the size of the effect.
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Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Plane Sets the location of the effect along the axis of the effect which extends
from the center of the effect through the center of the screen.

Thickness Determines the thickness, in pixels, of the effect.

Glow Behind Gives the effect the ability to be displayed behind objects in
your 3ds Max scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated the
effect will be squeezed according to Lens Effects Globals under the Parameters
panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are applying
the effect to with the color or mapping set in the Radial Color or Circular
Color parameters. A value of 0 uses only the values set in the Radial Color and
Circular Color parameters while a value of 100 uses only the light or objects
source color. Any value between 0 and 100 will render a mix between the
source color and the effect’s color parameters.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
You can also use bitmaps such as gradient or cellular to determine the radial
color.
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Ring using radial colors as seen in lower left inset

Falloff Curve Displays the Radial Falloff dialog on page 6658 in which you can
set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff.

Circular Color group

Circular Color determines the color of the effect by using four different color
swatches that are matched to the four quadrants of the effect. A map can also
be used to determine circular color.
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Ring using circular colors as seen in lower right inset

Mix Mixes colors set in Radial Color and colors set in Circular Color. Setting
the spinner at 0 will only use values set in Radial Color while setting the
spinner at 100 will only use values set in Circular Color. Any value between
0 and 100 will mix between the two values.
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Ring using radial and circular colors mixed 50/50

Falloff Curve Displays the Circular Falloff dialog on page 6652 in which you
can set weights for the colors used in Circular Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6661. Using the Radial Size
dialog you can create points on a line and move those points along a graph
to determine where the effect should be placed around the light or object.
You can also use a map to determine where the effect should be placed. A
check box is used to activate the map.
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Ring Element rollout, Options panel

Apply Element To

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that have
a corresponding G-Buffer on page 7991 (or Object) ID. The G-Buffer is a geometry
buffer and can be defined when you right-click any object and select Properties
from the menu. Then, set the Object Channel ID under the G-Buffer ID
controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5348 assigned to it. Assign the Material ID
channel in the Material Editor, using the Material ID channel flyout on page
5350. The Lens Effect will be applied only to areas of the geometry where that
particular ID channel is present.
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TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255). The
software keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that the Lens Effect is applied to. Pure white
has a pixel value of 1. When this spinner is set to 1, any pixels with a value
above 255 will be glowed. You can invert this value by clicking the I button
to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle of
the surface normal to the camera. A value of 0 is coplanar, or parallel to the
screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf
Norm to 45, only surfaces with normal angles greater than 45 degrees will be
glowed. You can invert this value by clicking the I button to the right of the
spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.

Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
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Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the color
swatch next to the spinner. You can choose hue values from 0 to 255. The
spinner beside the Hue color swatch lets you enter a variance level so that the
glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.

Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6655. Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.
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Ray Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Ray, and click the (>) arrow
button.

Adding rays to the light

Rays are bright lines that radiate from the center of the source object, providing
the illusion of extreme brightness for the object. Rays let you emulate scratches
in the lens elements of a camera.
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Interface

Ray Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many
different effects under one instance of Lens Effects. To keep them in order, it
is often necessary to name them to make sure that when you change
parameters you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated. Default = on.
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Size Determines the size of the effect.

Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Num Specifies the overall number of rays that appear in the lens flare. Rays
are randomly spaced around the radius.

Angle Specifies the angle for the rays. You can enter both positive and negative
values so, when animated, the rays rotate in a clockwise or counterclockwise
direction.

Sharp Specifies the overall sharpness of the rays. Higher numbers produce
crisp, clean, and clear rays. Lower numbers produce more of a secondary glow
look. Range=0 to 10.

Glow Behind Gives the effect the ability to be displayed behind objects in
your 3ds Max scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated, the
effect will be squeezed according to Lens Effects Globals under the Parameters
panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are applying
the effect to and the color or mapping set in the Radial Color or Circular Color
parameters. A value of 0 uses only the values set in the Radial Color and
Circular Color parameters while a value of 100 uses only the light or objects
source color. Any value between 0 and 100 will render a mix between the
source color and the effect’s color parameters.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
You can also use bitmaps such as Gradient or Cellular to determine the radial
color.

Falloff Curve Displays the Radial Falloff dialog on page 6658 in which you can
set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens
Effects source.
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Circular Color group

Circular Color determines the color of the effect by using four different color
swatches that are matched to the four quadrants of the effect. A map can also
be used to determine circular color.

Mix Allows you to mix between colors set in Radial Color and colors set in
Circular Color. Setting the spinner at 0 will only use values set in Radial Color
while setting the spinner at 100 will only use values set in Circular Color. Any
value between 0 and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 6652 in which you
can set weights for the colors used in Circular Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6661. Using the Radial Size
dialog you can create points on a line and move those points along a graph
to determine where the effect should be placed around the light or object.
You can also use a map to determine where the effect should be placed. A
check box is used to activate the map.
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Ray Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that have
a corresponding G-Buffer on page 7991 (or Object) ID. The G-Buffer is a geometry
buffer and can be defined when you right-click any object and select Properties
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from the menu. Then, set the Object Channel ID under the G-Buffer ID
controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5348 assigned to it. Assign the Material ID
channel in the Material Editor, using the Material ID channel flyout on page
5350. The Lens Effect will be applied only to areas of the geometry where that
particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255). The
software keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that the Lens Effect is applied to. Pure white
has a pixel value of 1. When this spinner is set to 1, any pixels with a value
above 255 will be glowed. You can invert this value by clicking the I button
to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle of
the surface normal to the camera. A value of 0 is coplanar, or parallel to the
screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf
Norm to 45, only surfaces with normal angles greater than 45 degrees will be
glowed. You can invert this value by clicking the I button to the right of the
spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.
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Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Edge filter applied to rays emanating from object

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.
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Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the color
swatch next to the spinner. You can choose hue values from 0 to 255. The
spinner beside the Hue color swatch lets you enter a variance level so that the
glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.

Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6655. Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Auto Secondary Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Auto Secondary, and click
the (>) arrow button.
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Adding secondary flares to the light

Secondary flares are the small circles you would normally see coming out from
the source of the lens flare along an axis relative to the camera position. These
are caused by light refracting off the different lens elements in the camera. As
the camera position changes relative to the source object, the secondary flares
move.

6624 | Chapter 21   Effects and Environments



Interface

Auto Secondary Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many
different effects under one instance of Lens Effects. To keep them in order, it
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is necessary to name them to make sure that when you change parameters
you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated. Default = on.

Min Controls the minimum size of secondary flares in the current set. This
number is defined as a percentage of the overall image.

Max Controls the maximum size of secondary flares in the current set. This
number is defined as a percentage of the overall image.

Axis Defines the overall length of the axis the automatic secondary flares will
be distributed along. Increasing the value creates more space between the
flares, while decreasing the value creates less space between the flares. You
can set the axis from 0 to 10 degrees.

Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Qty Controls the number of secondary flares that appear in the current set of
flares.

Use Source Color Mixes the source color of the light or object you are applying
the effect to with the color or mapping set in the Radial Color or Circular
Color parameters. A value of 0 uses only the values set in the Radial Color and
Circular Color parameters while a value of 100 uses only the light or objects
source color. Any value between 0 and 100 will render a mix between the
source color and the effect’s color parameters.

Sides Controls the shape of the secondary flares for the current set. The default
is circular, but you can choose from 3- to 8-sided secondary flares.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Presets (drop-down list) Displays a list of preset values that can be selected
and applied to the rendered scene.

Squeeze Determines whether the effect will be squeezed. When activated, the
effect will be squeezed according to Lens Effects Globals under the Parameters
panel in the Squeeze spinner.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
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Each color swatch has a percentage spinner that determines at what point
that color should stop and the next should start. You can also use bitmaps
such as gradient or cellular to determine the radial color.

Falloff Curve Displays the Radial Falloff dialog on page 6658 in which you can
set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens
Effects source.

Circular Color group

Circular Color determines the color of the effect by using four different color
swatches that are matched to the four quadrants of the effect. A map can also
be used to determine circular color.

Mix Allows you to mix between colors set in Radial Color and colors set in
Circular Color. Setting the spinner at 0 will only use values set in Radial Color
while setting the spinner at 100 will only use values set in Circular Color. Any
value between 0 and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 6652 in which you
can set weights for the colors used in Circular Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6661. Using the Radial Size
dialog you can create points on a line and move those points along a graph
to determine where the effect should be placed around the light or object.
You can also use a map to determine where the effect should be placed. A
check box is used to activate the map.

Lens Effects Rendering Effects | 6627



Auto Secondary Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that have
a corresponding G-Buffer on page 7991 (or Object) ID. The G-Buffer is a geometry
buffer and can be defined when you right-click any object and select Properties
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from the menu. Then, set the Object Channel ID under the G-Buffer ID
controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5348 assigned to it. Assign the Material ID
channel in the Material Editor, using the Material ID channel flyout on page
5350. The Lens Effect will be applied only to areas of the geometry where that
particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255). The
software keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that the Lens Effect is applied to. Pure white
has a pixel value of 1. When this spinner is set to 1, any pixels with a value
above 255 will be glowed. You can invert this value by clicking the I button
to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle of
the surface normal to the camera. A value of 0 is coplanar, or parallel to the
screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf
Norm to 45, only surfaces with normal angles greater than 45 degrees will be
glowed. You can invert this value by clicking the I button to the right of the
spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.
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Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the color
swatch next to the spinner. You can choose hue values from 0 to 255. The
spinner beside the Hue color swatch lets you enter a variance level so that the
glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.
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Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6655. Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Manual Secondary Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Manual Secondary, and click
the (>) arrow button.

Manual secondary flares are additional secondary flares that are individually
added to the lens flare. These can be used in addition to, or in place of auto
secondary flares on page 6623.

You use Manual Secondary flares when you want to add unique flares that
you don't want repeated.
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Interface

Manual Secondary Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects you can have many
different effects under one instance of Lens Effects. To keep them in order, it

6632 | Chapter 21   Effects and Environments



is necessary to name them to make sure that when you change parameters
you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated. Default = on.

Size Determines the size of the effect.

Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Plane Controls the distance, in degrees, between the flare source and the
manual secondary flare. By default, the flare plane exists at the center of the
chosen node source. Positive values place the flare in front of the source, while
negative values place the flare behind the flare source.

Use Source Color Mixes the source color of the light or object you are applying
the effect to and the color or mapping set in the Radial Color or Circular Color
parameters. A value of 0 uses only the values set in the Radial Color and
Circular Color parameters while a value of 100 uses only the light or objects
source color. Any value between 0 and 100 will render a mix between the
source color and the effect’s color parameters.

Sides Controls the shape of the secondary flares for the current set. The default
is circular, but you can choose from 3- to 8-sided secondary flares.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Presets (drop-down list) Displays a list of preset values that can be selected
and applied to the rendered scene.

Squeeze Determines whether the effect will be squeezed. When activated, the
effect will be squeezed according to Lens Effects Globals under the Parameters
panel in the Squeeze spinner.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
You can also use bitmaps such as gradient or cellular to determine the radial
color.

Falloff Curve Displays the Radial Falloff dialog on page 6658 in which you can
set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
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You can also use a map to determine the falloff when a light is used as a Lens
Effects source.

Circular Color group

Circular Color determines the color of the effect by using four different color
swatches that are matched to the four quadrants of the effect. A map can also
be used to determine circular color.

Mix Mixes colors set in Radial Color and colors set in Circular Color. Setting
the spinner at 0 will only use values set in Radial Color while setting the
spinner at 100 will only use values set in Circular Color. Any value between
0 and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 6652 in which you
can set weights for the colors used in Circular Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6661. Using the Radial Size
dialog you can create points on a line and move those points along a graph
to determine where the effect should be placed around the light or object.
You can also use a map to determine where the effect should be placed. A
check box is used to activate the map.
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Manual Secondary Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that have
a corresponding G-Buffer on page 7991 (or Object) ID. The G-Buffer is a geometry
buffer and can be defined when you right-click any object and select Properties
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from the menu. Then, set the Object Channel ID under the G-Buffer ID
controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5348 assigned to it. Assign the Material ID
channel in the Material Editor, using the Material ID channel flyout on page
5350. The Lens Effect will be applied only to areas of the geometry where that
particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255). The
software keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that the Lens Effect is applied to. Pure white
has a pixel value of 1. When this spinner is set to 1, any pixels with a value
above 255 will be glowed. You can invert this value by clicking the I button
to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle of
the surface normal to the camera. A value of 0 is coplanar, or parallel to the
screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf
Norm to 45, only surfaces with normal angles greater than 45 degrees will be
glowed. You can invert this value by clicking the I button to the right of the
spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.

6636 | Chapter 21   Effects and Environments



Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the color
swatch next to the spinner. You can choose hue values from 0 to 255. The
spinner beside the Hue color swatch lets you enter a variance level so that the
glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.
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Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6655. Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Star Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Star, and click the (>) arrow
button.

Adding a star to the light

A Star is larger than a Ray effect on page 6616 and is composed of 0 to 30 spokes,
instead of hundreds like a ray.
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Interface

Star Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects, you can have many
different effects under one instance of Lens Effects. To keep them in order, it
is necessary to name them to make sure that when you change parameters
you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated.
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Size Determines the size of the effect.

Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Width Specifies the width of the individual spokes, as a percentage of the
overall frame.

Angle Sets the starting angle in degrees in which the star spokes point. You
can enter both positive and negative values so, when animated, the star spokes
rotate in a clockwise or counterclockwise direction.

Taper Controls the taper of the individual spokes of the star. Taper widens
or narrows the tips of the individual star points. Low numbers create a sharp
point, while high numbers flare the points.

Sharp Specifies the overall sharpness of the star. Higher numbers produce
crisp, clean, and clear stars. Lower numbers produce more of a secondary glow
look. Range=0 to 10.

Qty Specifies the number of spokes in the star effect. The default is 6. Spokes
are spaced at equidistant points about the center of the flare.

Glow Behind Gives the effect the ability to be displayed behind objects in
your 3ds Max scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated, the
effect will be squeezed according to Lens Effects Globals under the Parameters
panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are applying
the effect to and the color or mapping set in the Radial Color or Circular Color
parameters. A value of 0 uses only the values set in the Radial Color and
Circular Color parameters while a value of 100 uses only the light or objects
source color. Any value between 0 and 100 will render a mix between the
source color and the effect’s color parameters.

Radial Color group

The Radial Color settings affect the inner and outer colors of the effect. You
can set the color swatches to set the inner and outer colors of the Lens Effect.
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You can also use bitmaps such as gradient or cellular to determine the radial
color.

Falloff Curve Displays the Radial Falloff dialog on page 6658 in which you can
set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens
Effects source.

Section Color group

Selection Color determines the color of the effect by using three different color
swatches that are matched to the three sections of the effect. A map can also
be used to determine section color.

Mix Mixes colors set in Radial Color and colors set in Section Color. Setting
the spinner at 0 will only use values set in Radial Color while setting the
spinner at 100 will only use values set in Section Color. Any value between 0
and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 6652 in which you
can set weights for the colors used in Section Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6661. Using the Radial Size
dialog you can create points on a line and move those points along a graph
to determine where the effect should be placed around the light or object.
You can also use a map to determine where the effect should be placed. A
check box is used to activate the map.
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Star Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to the rendered image using parameters set in Image
Sources.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that have
a corresponding G-Buffer on page 7991 (or Object) ID. The G-Buffer is a geometry
buffer and can be defined when you right-click any object and select Properties
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from the menu. Then, set the Object Channel ID under the G-Buffer ID
controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5348 assigned to it. Assign the Material ID
channel in the Material Editor, using the Material ID channel flyout on page
5350. The Lens Effect will be applied only to areas of the geometry where that
particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255). The
software keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that the Lens Effect is applied to. Pure white
has a pixel value of 1. When this spinner is set to 1, any pixels with a value
above 255 will be glowed. You can invert this value by clicking the I button
to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle of
the surface normal to the camera. A value of 0 is coplanar, or parallel to the
screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf
Norm to 45, only surfaces with normal angles greater than 45 degrees will be
glowed. You can invert this value by clicking the I button to the right of the
spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.
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Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the color
swatch next to the spinner. You can choose hue values from 0 to 255. The
spinner beside the Hue color swatch lets you enter a variance level so that the
glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.
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Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6655. Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Streak Lens Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose Streak, and click the (>) arrow
button.

Adding a streak to the light

A streak is a wide band that runs through the center of the source object. In
real camera work, it is produced when using anamorphic lenses to film a scene.
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Interface

Streak Element rollout, Parameters panel

Name Displays the name of the effect. With Lens Effects, you can have many
different effects under one instance of Lens Effects. To keep them in order, it
is necessary to name them to make sure that when you change parameters
you are changing the parameters to the correct effect.

On Applies the effect to the rendered image when activated.

Size Determines the size of the effect.
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Intensity Controls the overall brightness and opacity of the individual effect.
Higher values produce a bright, more opaque effect, and lower values produces
a dim, transparent effect.

Width Specifies the width of the streak, as a percentage of the frame.

Angle Specifies the angle for the streak. You can enter both positive and
negative values so, when animated, the streak rotates in a clockwise or
counterclockwise direction.

Taper Controls the taper of the individual spokes of the streak. Taper widens
or narrows the tips of the individual streak points. Low numbers create a sharp
point, while high numbers flare the points.

Sharp Specifies the overall sharpness of the streak. Higher numbers produce
crisp, clean, and clear streaks. Lower numbers produce more of a secondary
glow look. Range=0 to 10.

Glow Behind Gives the effect the ability to be displayed behind objects in
your 3ds Max scene.

Occlusion Determines how much the Lens Effects Scene Occlusion parameters
will affect the particular effect. The value entered determines what percentage
of occlusion set in the Lens Effects Globals panel will be applied.

Squeeze Determines whether the effect will be squeezed. When activated, the
effect will be squeezed according to Lens Effects Globals under the Parameters
panel in the Squeeze spinner.

Use Source Color Mixes the source color of the light or object you are applying
the effect to and the color or mapping set in the Radial Color or Circular Color
parameters. A value of 0 uses only the values set in the Radial Color and
Circular Color parameters while a value of 100 uses only the light or objects
source color. Any value between 0 and 100 will render a mix between the
source color and the effect’s color parameters.

Radial Color group

Falloff Curve Displays the Radial Falloff dialog on page 6658 in which you can
set weights for the colors used in Radial Color. By manipulating the Falloff
Curve you can make the effect use more of one color or map than the other.
You can also use a map to determine the falloff when a light is used as a Lens
Effects source.
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Section Color group

Section Color determines the color of the effect by using three different color
swatches that are matched to the three sections of the effect. A map can also
be used to determine section color.

Mix Mixes colors set in Radial Color and colors set in Section Color. Setting
the spinner at 0 will only use values set in Radial Color while setting the
spinner at 100 will only use values set in Section Color. Any value between 0
and 100 will mix between the two values.

Falloff Curve Displays the Circular Falloff dialog on page 6652 in which you
can set weights for the colors used in Section Color. By manipulating the
Falloff Curve you can make the effect use more of one color or map than
another. You can also use a map to determine the falloff when a light is used
as a Lens Effects source.

Radial Size group

Determines the radial size around the particular Lens Effect. Clicking the Size
Curve button displays the Radial Size dialog on page 6661. Using the Radial Size
dialog you can create points on a line and move those points along a graph
to determine where the effect should be placed around the light or object.
You can also use a map to determine where the effect should be placed. A
check box is used to activate the map.
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Streak Element rollout, Options panel

Apply Element To group

Lights Applies the effect to lights picked in Lens Effects Globals under the
Parameters tab in the Lights group box.

Image Applies the effect to objects that have a corresponding Object ID
channel.

Image Centers Applies to the center of an object or to portions of an object
as determined by the Image Filters.

Image Sources group

Object ID Applies the Lens Effect to particular objects in your scene that have
a corresponding G-Buffer on page 7991 (or Object) ID. The G-Buffer is a geometry
buffer and can be defined when you right-click any object and select Properties
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from the menu. Then, set the Object Channel ID under the G-Buffer ID
controls.

Material ID Applies the Lens Effect to an object or part of an object with a
specific Material ID channel on page 5348 assigned to it. Assign the Material ID
channel in the Material Editor, using the Material ID channel flyout on page
5350. The Lens Effect will be applied only to areas of the geometry where that
particular ID channel is present.

TIP In some cases you might want to apply different Lens Effects settings to
different pieces of geometry or IDs. To accomplish this, add additional Lens Effects
entries to the Lens Effects Parameters list. Then set each different Lens Effect entry
to affect a different Material ID or Object ID and proceed.

Unclamp An unclamped color is brighter than pure white (255,255,255). The
software keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that the Lens Effect is applied to. Pure white
has a pixel value of 1. When this spinner is set to 1, any pixels with a value
above 255 will be glowed. You can invert this value by clicking the I button
to the right of the spinner.

Surf Norm Applies the Lens Effect to part of an object, based on the angle of
the surface normal to the camera. A value of 0 is coplanar, or parallel to the
screen. A value of 90 is normal, or perpendicular to the screen. If you set Surf
Norm to 45, only surfaces with normal angles greater than 45 degrees will be
glowed. You can invert this value by clicking the I button to the right of the
spinner.

Whole Applies the Lens Effect to the whole scene, not just a particular piece
of geometry. This, in effect, makes each pixel in the scene a potential Lens
Effect source. The areas of the scene that have the Lens Effect applied to them
are determined by the settings in the Image Filters group box.

Alpha Applies the Lens Effect to the alpha channel of an image. The
transparency of an alpha channel is interpreted opposite that of the Mask
channel. Range=0 to 255.

Z Hi/Z Lo Highlights objects based on their distance (Z-Buffer distance) from
the camera. The Hi value is the maximum distance and the Lo value is the
minimum. Any objects between these two Z-Buffer distances will be
highlighted.
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Image Filters group

Filters the Image Sources selections to let you control how the Lens Effect is
applied. For example, you can have ten spheres in your scene, each with the
same Object ID, but different colors. If you set the Image Source as the Object
ID of the spheres, which selects all of the spheres, these will be the only objects
in the scene that Lens Effects will apply an effect to.

However, now that Lens Effects knows where the pixels are that effects can be
applied, it needs to know which ones to actually apply the effect to. Lens
Effects uses the filter controls to find out which source pixels to apply the
effect to.

All Selects all source pixels in the scene and applies the Lens Effect to them.

Edge Selects all source pixels along a boundary edge and applies the Lens
Effect to them. Applying a Lens Effect along the edges of objects produces a
soft halo that exists on both inside and outside edges of your object.

Perim(eter) Alpha Applies the Lens Effect only to the perimeter of an object
based on its alpha channel. Selecting this option applies the effect only on
the outside of an object without any spill on the interior. Whereas filtering
by Edge produces a spill onto the object, Perimeter Alpha keeps all of the edges
clean because it relies on the scene alpha channel to derive its effect.

Perim(eter) Applies the Lens Effect only to the perimeter of an object based
on Edge interference. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.

Bright Filters the source objects based on their brightness values. The effect
is only applied to objects with a brightness above the spinner setting This
option can be inverted by clicking the I button next to the spinner

Hue Filters the source objects by their hue. Select the hue by clicking the color
swatch next to the spinner. You can choose hue values from 0 to 255. The
spinner beside the Hue color swatch lets you enter a variance level so that the
glow can find several different hues in the same range as the chosen color

Additional Effects group

Additional Effects allows you to apply maps such as Noise to your Lens Effect.
You can display the Material/Map browser by clicking the long button next
to the Apply check box.

Apply Applies the selected map when activated.
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Radial Density Determines where and how much you would like the
additional effects applied. Clicking the Radial Density button displays the
Radial Density dialog on page 6655. Using the Radial Density dialog you can
create points on a line and move those points along a graph to determine
where the additional effect should be placed around the light. You can also
use a map to determine where the additional effect should be placed.

Lens Effects Dialogs

Circular Falloff Graph (Lens Effects)

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>)
arrow button. > Parameters tab of the rollout for that effect > Falloff Curve
(under the Circular or Section Color group)

The Circular Falloff graph allows you to add weight to a particular color applied
to your Lens Effect. By weighting the colors that you apply you can choose
to display more of one color than another. You can also make the transition
of colors gradual from one color to the next or you can create a sharp edge to
the transition.
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Rings with different Circular Falloff settings

The Circular Falloff graph has controls at the top for creating and moving
points on a curve on the graph below. The curve represents the range of colors
you have selected in the Circular Color group box to apply to the current Lens
Effect. When you open the graph you will notice that there is already a line
with a point on each end which represents the linear transition from one
color to the next. By placing points along the curve, you can drag these points
to increase or decrease a colors intensity or to eliminate it altogether.
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Buttons are available at the bottom of the graph that allow you to change the
display of the graph. You can also manually enter a horizontal or vertical
position by entering a value into the two entry boxes.

Interface

Move Moves selected points in any direction. Click and hold the Move button
to display the flyout where you can select a button to move in any direction,
move only in the horizontal direction, or move only in the vertical direction.
The Move function remains active until you click another button. The button
is yellow while it is active.

Scale Point Scales a point vertically. Click once to enable Scale Point. The
Scale Point function remains active until you click another button. The button
is yellow while it is active.

Add Point Allows you to add points anywhere along the Circular Falloff curve.
Click and hold the Add Point button to display the flyout from which you
can choose a button to add either a Corner Point or a Bezier-Smooth Point.
Click once to enable Add Point. The Add Point function remains active until
you click another button. The button is yellow while it is active.

Delete Point Deletes selected points.

Horizontal Position Allows you to manually enter a horizontal position value
for a selected point.

Vertical Position Allows you to manually enter a vertical position value for
a selected point.
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Pan Allows you to click and drag the Circular Falloff graph window to move
it left and right or up and down. Click once to enable panning. Pan remains
active until you click another button. The button is yellow while it is active.

Zoom Extents Fits the curve within the graph window both vertically and
horizontally so that the entire curve is visible.

Zoom Horizontal Extents Fits the curve horizontally within the graph window
so that the full length of the curve is visible.

Zoom Vertical Extents Fits the curve vertically within the Circular Falloff
graph window so that the full height of the curve is visible.

Zoom Horizontally Scales the width of the Circular Falloff graph window.

Zoom Vertically Scales the length of the Circular Falloff graph window.

Zoom Zooms in and out of the entire Circular Falloff graph window.

Zoom Region Allows you to drag a region in the Circular Falloff graph window
and scale that region to fill the window.

Radial Density Dialog (Lens Effects)

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>)
arrow button. > Options tab of the rollout for that effect > Radial Density
(under the Additional Effects group)

The Radial Density dialog allows you to add weight to any additional effect
applied to the Lens Effect. By weighting the density of the additional effect
that you apply you can choose particular areas in the effect to display more
of the additional effect or to eliminate it altogether. You can also use Radial
Density to gradually fade the additional effect from maximum density down
to zero or you can create a sharp edge to the transition.
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Object with different Ray effects due to different Radial Density settings

The Radial Density dialog has controls at the top for creating and moving
Points on a curve on the graph below. The curve represents the density of the
additional effect being applied to the Lens Effect. When you open the dialog
you will notice that there is already a line with a Point on each end which
represents the density of the effect. The default falloff is a fade from a density
value of 1 starting from the center of the effect toward the outer edges which
has a value of 0. This produces an effect with more density being rendered at
the center of the effect and a gradual fading out to no density at the edges.
By placing Points along the curve, you can drag these points to increase or
decrease the density of an additional effect or eliminate it in some areas
altogether.

Buttons are available at the bottom of the dialog that allow you to change the
display of the dialog. You can also manually enter a horizontal or vertical
position by entering a value into the two entry boxes.
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Interface

Move Moves selected points in any direction. Click and hold the Move button
to display the flyout where you can select a button to move in any direction,
move only in the horizontal direction, or move only in the vertical direction.
The Move function remains active until you click another button. The button
is yellow while it is active.

Scale Point Vertically scales a point up or down. Click once to enable Scale
Point. The Scale Point function remains active until you click another button.
The button is yellow while it is active.

Add Point Allows you to add points anywhere along the Radial Density curve.
Click and hold the Add Point button to display the flyout where you can select
a button to add either a Corner Point or a Bezier Point. Click once to enable
Add Point. The Add Point function remains active until you click another
button. The button is yellow while it is active.

Delete Point Deletes selected points.

Horizontal Position Allows you to manually enter a horizontal position value
for a selected point.

Vertical Position Allows you to manually enter a vertical position value for
a selected point.

Pan Allows you to click and drag the Radial Density dialog window to move
it left and right or up and down. Click once to enable panning. Pan remains
active until you click another button. The button is yellow while it is active.

Zoom Extents Fits the curve within the dialog window both vertically and
horizontally so that the entire curve is visible.

Zoom Horizontal Extents Fits the curve horizontally within the dialog
window so that the full length of the curve is visible.

Zoom Vertical Extents Fits the curve vertically within the Radial Density
dialog window so that the full height of the curve is visible.

Zoom Horizontally Scales the width of the Radial Density dialog window.

Zoom Vertically Scales the length of the Radial Density dialog window.

Zoom Zooms in and out of the entire Radial Density dialog window.

Zoom Region Allows you to drag a region in the Radial Density dialog window
and scale that region to fill the window.
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Radial Falloff Dialog (Lens Effects)

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>)
arrow button. > Parameters tab of the rollout for that effect > Falloff Curve
(under the Radial Color group)

The Radial Falloff dialog allows you to add weight to a particular color applied
to your Lens Effect. By weighting the colors that you apply you can choose
to display more of one color than another. You can also make the transition
of colors gradual from one color to the next or you can create a sharp edge to
the transition.
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Rings with different Radial Falloff settings

The Radial Falloff graph has controls at the top for creating and moving Points
on a curve on the graph below. The curve represents the range of colors you
have selected in the Radial Color group box to apply to the current Lens Effect.
When you open the dialog you will notice that there is already a line with a
Point on each end which represents the linear transition from one color to
the next. The default falloff is a fade from one color at a value of one to the
other color which ends at a value of zero. This produces an effect with more
intensity on the first color and a considerable fading out of the second color.
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By placing Points along the curve, you can drag these points to increase or
decrease a colors intensity or to eliminate it altogether.

Buttons are available at the bottom of the dialog that allow you to change the
display of the dialog. You can also manually enter a horizontal or vertical
position by entering a value into the two entry boxes.

Interface

Move Moves selected points in any direction. Click and hold the Move button
to display the flyout where you can select a button to move in any direction,
move only in the horizontal direction, or move only in the vertical direction.
The Move function remains active until you click another button. The button
is yellow while it is active.

Scale Point Vertically scales a point up or down. Click once to enable Scale
Point. The Scale Point function remains active until you click another button.
The button is yellow while it is active.

Add Point Allows you to add points anywhere along the Circular Falloff curve.
Click and hold the Add Point button to display the flyout where you can select
a button to add either a Corner Point or a Bezier Point. Click once to enable
Add Point. The Add Point function remains active until you click another
button. The button is yellow while it is active.

Delete Point Deletes selected points.

Horizontal Position Allows you to manually enter a horizontal position value
for a selected point.

Vertical Position Allows you to manually enter a vertical position value for
a selected point.
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Pan Allows you to click and drag the Radial Falloff graph to move it left and
right or up and down. Click once to enable panning. Pan remains active until
you click another button. The button is yellow while it is active.

Zoom Extents Fits the curve within the dialog window both vertically and
horizontally so that the entire curve is visible.

Zoom Horizontal Extents Fits the curve horizontally within the dialog
window so that the full length of the curve is visible.

Zoom Vertical Extents Fits the curve vertically within the Radial Falloff graph
so that the full height of the curve is visible.

Zoom Horizontally Scales the width of the Radial Falloff graph.

Zoom Vertically Scales the length of the Radial Falloff graph.

Zoom Zooms in and out of the entire Radial Falloff graph.

Zoom Region Allows you to drag a region in the Radial Falloff graph and scale
that region to fill the window.

Radial Size Dialog (Lens Effects)

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Lens Effects > Choose any effect, and click the (>)
arrow button. > Parameters tab of the rollout for that effect > Falloff Curve
(under the Radial Size group)

The Radial Size dialog gives you the ability to determine the size of your Lens
Effect. The Radial Size dialog displays a curve with a point on each end which
represents the Radial Size of your Lens Effect. The default position of the curve
is one which means the Lens Effect will have the same radius around the
center of the effect.
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Objects with different Radial Sizes settings applied to Glow

By adding and moving points along the curve you can make areas of the effect
extend further by moving a point above a value of one on the graph. You can
also diminish areas of the effect by moving a point between one and zero on
the graph. Finally, you can eliminate areas of the effect by moving a point
below zero on the graph.
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Buttons are available at the bottom of the dialog that allow you to change the
display of the dialog. You can also manually enter a horizontal or vertical
position by entering a value in the two entry boxes.

Interface

Move Moves selected points in any direction. Click and hold the Move button
to display the flyout where you can select a button to move in any direction,
move only in the horizontal direction, or move only in the vertical direction.
The Move function remains active until you click another button. The button
is yellow while it is active.

Scale Point Vertically scales a point up or down. Click once to enable Scale
Point. The Scale Point function remains active until you click another button.
The button is yellow while it is active.

Add Point Allows you to add points anywhere along the Radial Size curve.
Click and hold the Add Point button to display the flyout where you can select
a button to add either a Corner Point or a Bezier Point. Click once to enable
Add Point. The Add Point function remains active until you click another
button. The button is yellow while it is active.

Delete Point Deletes selected points.

Horizontal Position Allows you to manually enter a horizontal position value
for a selected point.

Vertical Position Allows you to manually enter a vertical position value for
a selected point.
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Pan Allows you to click and drag the Radial Size graph to move it left and
right or up and down. Click once to enable panning. Pan remains active until
you click another button. The button is yellow while it is active.

Zoom Extents Fits the curve within the dialog window both vertically and
horizontally so that the entire curve is visible.

Zoom Horizontal Extents Fits the curve horizontally within the dialog
window so that the full length of the curve is visible.

Zoom Vertical Extents Fits the curve vertically within the Radial Size graph
so that the full height of the curve is visible.

Zoom Horizontally Scales the width of the Radial Size graph.

Zoom Vertically Scales the length of the Radial Size graph.

Zoom Zooms in and out of the entire Radial Size graph.

Zoom Region Allows you to drag a region in the Radial Size graph and scale
that region to fill the window.

Blur Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Blur

The Blur effect allows you to blur your image in three different methods:
Uniform, Directional, and Radial. Blur works on individual pixels according
to selections made in the Pixel Selections panel. You can blur an entire image,
non-background scene elements, by luminance value, or by using a map mask.
Blur can give your animation added realism by rendering the illusion of object
or camera movement.
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Object before and after adding midrange Blur effect.

Blur Rendering Effect | 6665



Interface

Blur Parameters rollout, Blur Type panel

Uniform Applies the Blur effect evenly across the entire rendered image.

Pixel Radius Determines the intensity of the Blur effect. Increasing the value
increases the number of surrounding pixels that each pixel will use to compute
its blur. The more pixels used means a greater blur for the image.

Affect Alpha Applies the Uniform Blur effect to the alpha channel when
turned on.

Directional Applies the Blur effect in any direction according to the Directional
parameters. The U Pixel Radius and Trail blur the pixels horizontally while
the V Pixel Radius and Trail blur the pixels vertically. Rotation is used to rotate
the axis of the horizontal and vertical blurring.

U Pixel Radius Determines the horizontal intensity of the Blur effect.
Increasing the value increases the number of surrounding pixels that each
pixel will use to compute its blur. The more pixels used means a greater
horizontal blur for the image.
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U Trail Adds “direction” to your blur by weighting more blur to either side
of the U axis. This adds a streaking effect and creates the illusion that your
objects or your camera are rapidly moving in a particular direction.

V Pixel Radius Determines the vertical intensity of the Blur effect. Increasing
the value increases the number of surrounding pixels that each pixel will use
to compute its blur, and creates a greater vertical blur for the image.

V Trail Adds “direction” to your blur by weighting more blur to either side
of the V axis. This adds a streaking effect and creates the illusion that your
objects or your camera are rapidly moving in a particular direction.

Rotation Rotates the axis of the U and V pixels that will be blurred by the U
and V Pixel Radius spinners. By using Rotation with the U and V Pixel Radius
spinners you can have the Blur effect applied to any direction in your rendered
image. When rotation is 0, U corresponds to the image’s X axis and V
corresponds to the image’s Y axis.

Affect Alpha Applies the Directional Blur effect to the Alpha channel when
turned on.

Radial Applies the Blur effect radially. Using the Radial parameters you can
define a point within your rendered image to use as the center of the Radial
Blur. You can use an object as the center or an arbitrary location set by the X
and Y Origin spinners. The Blur effect will apply the least amount of blur to
the center origin of the effect and gradually increase the blur to the pixels
further away from the center. This can be used to simulate motion blur caused
by camera zoom.

Pixel Radius Determines the intensity of the Radius Blur effect. Increasing
the value increases the number of surrounding pixels that each pixel will use
to compute its blur. The more pixels used means a greater blur for the image.

Trail Adds “direction” to your blur by weighting more or less blur toward the
center of the Blur effect. This adds a streaking effect and creates the illusion
that your objects or your camera are rapidly moving in a particular direction.

X/Y Origin Specifies the center of the blur, in pixels, with respect to the
dimensions of the rendered output.

None Lets you specify an object whose center serves as the center of the blur
effect. Click this, select an object, and then turn on Use Object Center. The
object name appears on the button.

Clear Removes the object name from the button above.

Use Object Center When on, the object specified by the None button (tooltip:
Pick an object to center on.) serves as the center of the blur effect. If no object
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is specified and Use Object Center is on, no blur is added to the rendered
image.

Affect Alpha Applies the Radial Blur effect to the Alpha channel when turned
on.
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Blur Parameters rollout, Pixel Selections panel
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Whole Image Affects the entire rendered image when chosen. This is useful
when the Blur effect dims your rendered image. By using Brighten and Blend
you can maintain the original colors of the scene.

Brighten Brightens the entire image.

Blend Blends the Blur effect and the Whole Image parameters with the original
rendered image. This can be used to create a soft-focus effect.

Non-Background Affects everything but the background image or animation
when chosen. This is useful when the Blur effect has dimmed your scene
objects but not the background. By Using Brighten, Blend, and Feather Radius,
you can maintain the original colors of the scene.

Brighten Brightens the rendered image except for the background image or
animation.

Blend Blends the Blur effect and the Non-Background parameters with the
original rendered image.

Feather Radius Feathers the Blur effect applied to the Non-Background
elements of your scene. When using Non-Background as a Pixel Selection you
will notice that the scene objects have a hard edge to their blur since the
objects are being blurred but the background is not. Use the spinner to feather
the blur and eliminate the hard edge of the effect.

Luminance Affects any pixels that have luminance values that fall between
it’s Min and Max spinners.

Brighten Brightens pixels that fall between the Minimum and Maximum
luminance values.

Blend Blends the Blur effect and the Luminance parameters with the original
rendered image.

Min Sets the minimum luminance value necessary for each pixel in order for
the Blur effect to be applied to the pixel.

Max Sets the maximum luminance value a pixel can have in order for the
Blur effect to be applied to the pixel.

Feather Radius Feathers the Blur effect applied to pixels that fall between the
Minimum and Maximum luminance values. When using Luminance as a Pixel
Selection the Blur effect can create a hard edge on the effect. Use the spinner
to feather the blur and eliminate the hard edge of the effect.

Map Mask Applies the Blur effect according to the channel selected and mask
applied through the Material/Map Browser. After selecting a mask you must
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select a channel from the Channel list. Blur then examines the mask and
channel according to the values set in the Minimum and Maximum spinners.
Any pixels in the mask that are of the selected channel and between the Min
and Max values will have the Blur effect applied. This is useful for blurring
selected portions of a scene such as a winter morning as seen through a frost
covered window.

Channel Selects a channel that the Blur effect will be applied to. After selecting
a particular channel, use the minimum and maximum spinners to determine
the value a mask pixel must have in order to have the effect applied to it.

Brighten Brightens the portions of the image that the Blur effect is applied
to.

Blend Blends the Map Mask Blur effect with the original rendered image.

Min The minimum value (RGB, Alpha, or Luminance) a pixel must have in
order to have the Blur effect applied to it.

Max The maximum value (RGB, Alpha, or Luminance) a pixel can have for
the Blur effect to be applied to it.

Feather Radius Feathers the Blur effect applied to pixels that fall between the
Minimum and Maximum channel values. When using map mask as a Pixel
Selection, the Blur effect can create a hard edge on the effect. Use the spinner
to feather the blur and eliminate the hard edge of the effect.

Object ID Applies the Blur effect to an object or part of an object with a specific
Object ID (in the G-Buffer on page 7991), if the object matches the Filter settings.
To add or replace an Object ID, use the spinners or enter a value in the ID text
box and then click the appropriate button.

Min Lum The minimum luminance value a pixel must have in order to have
the Blur effect applied to it.

Max Lum The maximum luminance value a pixel can have for the Blur effect
to be applied to it.

Brighten Brightens the portion of the image that the Blur effect is applied to.

Blend Blends the Object ID Blur effect with the original rendered image.

F. Radius Feathers the Blur effect applied to pixels that fall between the
Minimum and Maximum luminance values. When using Luminance as a Pixel
Selection, the Blur effect can create a hard edge on the effect. Use the spinner
to feather the blur and eliminate the hard edge of the effect.
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Material ID Applies the Blur effect to a material or part of a material with a
specific Material Effects Channel on page 5348, if the material matches the Filter
settings. To add or replace a Material Effects channel, use the spinners or enter
a value in the ID text box and then click the appropriate button.

Min Lum The minimum luminance value a pixel must have in order to have
the Blur effect applied to it.

Max Lum The maximum luminance value a pixel can have for the Blur effect
to be applied to it.

Brighten Brightens the portion of the image that the Blur effect is applied to.

Blend Blends the Material Blur effect with the original rendered image.

F. Radius Feathers the Blur effect applied to pixels that fall between the
Minimum and Maximum luminance values. When using Luminance as a Pixel
Selection, the Blur effect can create a hard edge on the effect. Use the spinner
to feather the blur and eliminate the hard edge of the effect.

General Settings group
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Feather Falloff control curve

The Feather falloff curve allows you to determine the feather falloff off the
Blur effect based on a graph. You can add points to the graph to create a falloff
curve, and adjust the interpolation in those points.

Move Lets you move the points on the graph. This button is a flyout, providing
free movement (the default), horizontal, and vertical movement.

Scale Point Lets you scale the points on the graph. This moves each selected
point vertically, in proportion to its previous value. Click a point to scale, or
draw a selection rectangle around several contiguous points to select them,
and then drag any point in the selection to scale them all.

Add Point Lets you create additional points on the falloff curve. This button
is a flyout, providing linear points (the default) and Bezier points with handle.

Delete Point Removes points from the graph.

Brightening These radio buttons let you select additive or multiplicative
brightening. Additive brightening is brighter and more distinct than
multiplicative brightening. Additive brightening is useful when you use blur
in combination with a Glow effect on page 6599. Multiplicative brightening
provides a soft highlight to the Blur effect.

Brighten Curve Lets you edit the brightening curve in the Feather Falloff
curve graph.

Blend Curve Lets you edit the blend curve in the Feather Falloff curve graph.

Brightness and Contrast Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Brightness and Contrast
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Above: Original rendering is too dark.

Below: Increasing both brightness and contrast improves clarity of the rendering.

Brightness and Contrast allows you to adjust the contrast and brightness of
an image. This can be used to match rendered scene objects with background
images or animations.

Interface

The Brightness and Contrast Parameters rollout contains the following
parameters.

Brightness Increases or decreases all color components (red, green, and blue).
Range=0 to 1.0.
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Contrast Compresses or expands the latitude between maximum black and
maximum white. Range=0 to 1.0.

Ignore Background Applies the effect to everything in your 3ds Max scene
except the background.

Color Balance Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Color Balance

The Color Balance Effect allows you to manipulate additive/subtractive color
tinting through independent control of RGB channels.

Above: Color balance effect used to correct the color cast.

Below: Original rendering has a yellow cast.
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Interface

The Color Balance Parameters rollout contains the following parameters:

Cyan/Red Adjusts the red channel.

Magenta/Green Adjusts the green channel.

Yellow/Blue Adjusts the blue channel.

Preserve Luminosity When on, retains the luminosity of the image while
correcting the color.

Ignore Background When on, allows you to image correct a model without
affecting the background.

File Output Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > File Output

File Output allows you to take a “snapshot” of a rendering before some or all
of the other Render Effects are applied, depending on the placement of File
Output in the Render Effects stack. You can save different channels such as
Luminance, Depth, or Alpha to a separate file while rendering an animation.
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You can also use File Output to convert an RGB image into a different channel
and send that image channel back into the Render Effects stack. The rest of
the effects can then be applied to that channel.

Interface

Destination group

Files Opens a dialog so you can save the rendered image or animation to disk.

The rendered output can be a still image or an animation, in one of the
following file formats:

AVI File on page 7326 (AVI)
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BMP Image file on page 7328 (BMP)

Encapsulated PostScript on page 7332 format (EPS, PS)

JPEG File on page 7347 (JPG)

Kodak Cineon on page 7328 (CIN)

MOV QuickTime file on page 7348 (MOV)

PNG Image File on page 7360 (PNG)

RLA Image File on page 7364 (RLA)

RPF Image File on page 7366 (RPF)

SGI Image File Format on page 7369 (RGB)

Targa Image File on page 7370 (TGA, VDA, ICB, UST)

TIF Image File on page 7372 (TIF)

Devices Opens a dialog so you can send the rendered output to a device such
as a video recorder.

Clear Clears any file or device selected in the Destination group box.

Driver group

These buttons are available only when you choose a device as the image source.

About Provides information on the source of the image-handler software used
to bring the image into the software.

Setup Displays a setup dialog specific to the plug-in. Some plug-ins may not
use this button.

Parameters group

Channel Lets you choose which channel you wish to save or send back in to
the Render Effects stack. Choose Whole Image, Luminance, Depth, or Alpha
to display more options in the Parameters group box.

Affect Source Bitmap When activated, this will take in an image with any
effects previously applied, convert it to the channel selected, and send it back
into the stack for the rest of the effects to be applied. Your rendered image
will be saved in the channel selected. This parameter is not available to the
Whole Image channel.

Active Turns the File Output feature on and off. Unlike the Active check box
available in the Render Effects rollout, this check box is animatable allowing
you to save only desired portions of a rendered scene.
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Depth Parameters

When Depth is selected as a channel, new parameters are available for
determining what parts of the scene should be rendered into the Depth channel
image.

Copy After choosing a camera with the None button, click Copy to use the
camera’s clipping planes to determine which part of the scene should be
rendered into the Depth channel image file.

None Enables you to select a camera to use for copying clipping planes. Click
the none button to activate it. The None button will turn green until a camera
has been selected in the viewport. The camera’s name will then be displayed
on the button instead of None.

Near Z Specifies the beginning distance from the camera that should be used
in determining where to start rendering the scene’s geometry in the depth
channel image file.

Far Z Specifies the ending distance from the camera that should be used in
determining where to stop rendering the scene’s geometry in the depth channel
image file.

Fit Entire Scene Makes all other Depth parameters unavailable and will render
the entire viewport’s scene geometry in the Depth channel image file,
automatically calculating the near and far Z required.

Film Grain Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Film Grain

Film Grain is used to recreate the look of film grain in your rendered scene.
Film Grain also allows you to match film grain from source material used as
a background, such as an AVI, to the rendered scene created in the software.
When applied, Film Grain automatically randomizes to create the look of
moving frames.
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Before and after applying Film Grain to a scene
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Interface

The Film Grain Parameters rollout contains the following controls.

Grain Sets the amount of grain added to your image. Range=0 to 1.0.

Ignore Background Masks the background so that grain is applied only to
geometry and effects in the scene. Choose this option when you use film
(which already contains grain) as the background image.

Motion Blur Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Motion Blur
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Motion blur enhances the movement of the sword.

Motion Blur applies an image motion blur on page 8010 to your rendered scene
by blurring moving objects or the entire scene. Motion blur can enhance the
realism of a rendered animation by simulating the way a real-world camera
works. A camera has a shutter speed, and if significant movement of objects
in the scene, or of the camera itself, occurs during the time the shutter is open,
the image on film is blurred.

NOTE In addition, you must set motion-blur characteristics for objects to be
blurred using the Object Properties dialog on page 315.
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Interface

The Motion Blur Parameters rollout contains the following controls.

Work with transparency When on, motion blur is applied to objects behind
transparent objects. When off, objects behind transparent objects receive no
motion blur. Turning off this toggle can improve rendering speed. Default=on.

Duration Specifies how long the "virtual shutter" is open. When this is set to
1.0, the virtual shutter is open for the entire duration between one frame and
the next. The higher the value, the greater the motion blur effect. Default=1.0.

Depth of Field Rendering Effect

Rendering menu > Effects > Environment and Effects dialog > Effects panel >
Add > Add Effect dialog > Depth of Field
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Depth of field emphasizes the scooter.

The Depth-of-Field effect simulates the natural blurring of foreground and
background scene elements when viewed through a camera lens. Depth of
Field works by separating the scene in Z order into foreground, background,
and in-focus images. The foreground and background images are then blurred
according to the values set in the Depth of Field effect parameters and the
final image is composited from the processed originals.

NOTE When additional Render Effects are being applied to an image or animation,
the Depth-of-Field effect should be the last effect to be rendered. The order of the
rendered effects is listed in the Effects tab of the Environment and Effects dialog.

TIP To minimize sampling artifacts in out-of-focus areas with the default scanline
renderer, try using the Blend filter in the Render Setup dialog on page 6067 >
Renderer panel > Antialiasing group.
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Before and after applying Depth of Field effect to scene.
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Interface

The Depth of Field Parameters rollout contains the following parameters.

Affect Alpha Affects the alpha channel of the final rendering when on.

Cameras group

Pick Cam Enables you to interactively select from the viewport which camera
you want the Depth of Field effect applied to.
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Remove Deletes the camera currently selected in the drop-down list.

Camera Selection List Lists all of the cameras to be used in the effect. You
can use this list to highlight a specific camera and remove it from the list using
the Remove button.

Focal Point group

Pick Node Enables you to select an object to use as the focal node. When
activated you can select an object directly from the viewports to use as the
focal node. You can also press H to display the Pick Object dialog, which lets
you select a focal node from a list of objects in the scene.

Remove Removes the object selected as the Focal Node.

Use Camera Specifies that the focal length from the camera selected in the
Camera Selection list be used to determine the focal point.

Focal Parameters group

Custom Uses the values set in the Focal Parameters group box to determine
the properties of the Depth of Field effect.

Use Camera Uses the values from the camera highlighted in the Camera
Selection list to determine focal range, limit, and blur.

Horiz Focal Loss Determines the amount of blur along the horizontal axis
when Custom has been chosen.

Vert Focal Loss Controls the amount of blur along the vertical axis when
Custom has been chosen.

Focal Range Sets the Z distance, in units, to either side of the focal point in
which the image will remain in focus when Custom has been chosen.

Focal Limit Sets the Z distance, in units, to either side of the focal point where
blur will reach its maximum as specified by the Loss spinners when Custom
has been chosen.

Environment and Atmosphere Effects
Rendering menu > Environment > Environment and Effects dialog >
Environment panel

Environment displays the Environment panel on page 6689, which is used for
setting up atmospheric and background effects.
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You can use the environment functions to:

■ Set and animate the background color.

■ Use an image in the background of the rendered scene (screen environment)
or use texture maps as spherical, cylindrical, or shrink-wrap environments.

■ Set and animate the ambient light on page 7906.

■ Use atmospheric plug-ins, such as volumetric light, in the scene.

■ Apply exposure controls to renderings.

Atmospheres

Atmospheres are plug-in on page 8092 components that create lighting effects
such as fog, fire, and so on.

Fire Environment Effect on page 6696

Fog Environment Effect on page 6707

Volume Fog Environment Effect on page 6713

Volume Light Environment Effect on page 6721

See Environment dialog on page 6689 for all environment parameters.

Exposure Controls

One of the limitations of rendering perceptually accurate images is the limited
dynamic range of computer monitors. Dynamic range is the ratio of the highest
to lowest intensity a monitor can produce. In a dark room this ratio is
approximately 100 to 1. In a bright room, this drops to approximately 30 to
1. Real environments can have dynamic ranges of 10,000 to 1, or larger.

Exposure Controls on page 6732 map light-energy values to colors in a process
known as tone mapping. They affect the brightness and contrast of both
rendered images and viewport displays. They don’t affect the actual lighting
levels in the scene, but only how those levels are mapped to a valid display
range.

■ Automatic Exposure Control on page 6735

■ Logarithmic Exposure Control on page 6740

■ Linear Exposure Control on page 6738

■ mr Photographic Exposure Control on page 6744
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■ Pseudo Color Exposure Control on page 6753

Environment Panel

Rendering menu > Environment > Environment and Effects dialog >
Environment panel

Rendered Frame Window > Environment and Effects Dialog Toggle >
Environment panel

Use the Environment panel to:

■ Set and animate the background color.

■ Use an image in the background of the viewport and rendered scene (screen
environment) or use texture maps as spherical, cylindrical, or shrink-wrap
environments.

■ Set and animate the tint and ambient light on page 7906 globally.

■ Use atmospheric plug-ins, such as volumetric light, in the scene.
Atmospheres are plug-in components on page 8092 that create light effects
such as fire on page 6696, fog on page 6707, volume fog on page 6713, and volume
light on page 6721.

■ Apply exposure controls on page 6732 to renderings.

Procedures

To access environment functions, do one of the following:

1 Choose Rendering > Environment.

2 On the Environment and Effects dialog, click the Environment tab.

To set the background color:

1 Choose Rendering > Environment.

The Environment panel appears.

2 In the Background group, click the color swatch.

A Color Selector on page 391 appears.

3 Use the Color Selector to change the background color.
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The Renderer now uses this color as a background.

To choose an environment map:

1 Display the Material Editor.

You adjust the map's parameters with the Material Editor.

2 Choose Rendering > Environment.

3 Under Background on the Environment panel, do one of the following:

■ Click the Environment Map button. The Material/Map Browser
appears. Choose a map type from the list.

■ Drag a map to the Environment Map button. You can do this from a
map displayed in one of the Material Editor's sample slots, or from
any map button that has been assigned, either in the Material Editor
or from a projection light, and so on.
Drag a bitmap from the Material Editor's map preview to the
Environment Map button.

On the Environment panel, the name of the Environment Map button changes
to show the type of map you chose, and Use Map turns on.

After you have set up the map, you can later turn off Use Map to test rendering
the scene without the mapped background.

You have set up the environment map, but to assign a bitmap or adjust map
parameters, you need to use the Material Editor.

You can also create a standalone map in the Material Editor first, and then
choose it with the Material/Map Browser.

To put the map in the Material Editor:

■ Drag the Environment Map button to a sample slot.
The map is now in the Material Editor where you can adjust it by changing
its parameters.

To change the color and tint of global lighting:

1 Choose Rendering > Environment.

2 Click the color swatch labeled Tint.

A Color Selector on page 391 appears.
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3 Use the color selector to set the tint applied to all lighting except ambient
light.

4 Use the Level spinner to multiply the overall lighting of the scene.

Shaded viewports update to show global lighting changes.

5 Close the Environment dialog.

3ds Max uses the global lighting parameters when you render the scene.

To change the color of ambient light:

TIP You don't need to adjust ambient light if you are using radiosity on page 6168.

1 Choose Rendering > Environment.

2 Click the color swatch labeled Ambient.

A Color Selector on page 391 appears.

3 Use the color selector to set the ambient color.

Shaded viewports update to show ambient color changes.

3ds Max also uses the new ambient color when you render the scene.

The color of ambient light tints the scene. For most renderings, the color
of ambient light should be black.

4 Close the Environment dialog.

To change the intensity of ambient light:

TIP You don't need to adjust ambient light if you are using radiosity on page 6168.

1 Choose Rendering > Environment.

2 Click the color swatch labeled Ambient Light.

A Color Selector on page 391 appears.

3 Change the Value setting (the V component of the ambient light's HSV
description) to increase or decrease intensity.

Shaded viewports update to show changes in the ambient light intensity.

4 Close the Color Selector.

The intensity of ambient light affects contrast as well as overall
illumination (the higher the intensity of ambient light, the lower the
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contrast). This is because ambient light is completely diffuse, so the angle
of incidence is equal for all faces. Ambient light alone cannot show depth.

NOTE 3ds Max has a default ambient light setting. You can change the
default by using the Rendering panel of the Preference Settings dialog.

To add an atmospheric effect:

1 Choose Rendering > Environment.

The Environment and Effects dialog is displayed, with the Environment
panel visible.

2 Under Atmosphere on the Environment panel, click Add.

The Add Atmospheric Effect dialog appears.

3 Choose the kind of effect you want to use, and then click OK.

The effect has now been added. Use the Atmosphere rollout to adjust
parameters.

Interface

Common Parameters rollout

Background group

Color Sets the color for the scene background. Click the color swatch, then
select the color you want in the Color Selector. You can animate the color
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effect by changing the background color at a nonzero frame with the Auto
Key button on.

Environment Map The button for Environment Map on page 7964 displays the
name of the map, or “None” if none has been assigned. The map must use
Environmental mapping coordinates on page 8034 (spherical, cylindrical, shrink
wrap, and screen).

To assign an environment map, click the button and use the Material/Map
Browser to choose a map, or drag a map from a sample slot or map button in
the Material Editor (or anywhere else in the software; for example, a Projector
Map button) and drop the map on the Environment Map button. A dialog
asks if you want the environment map to be a copy (independent) or an
instance of the source map.

NOTE If your scene includes animated bitmaps, including materials, projector
lights, environments, and so on, the animation file is reloaded once per frame.
Rendering performance slows down when your scene uses multiple animations,
or the animations are themselves large files.

To adjust the environment map's parameters, for example to assign a bitmap
or change the coordinate settings, open the Material Editor, drag the
Environment Map button, and drop it over an unused sample window.

Use Map Uses a map for the background rather than the background color.

Global Lighting group

Tint Tints all lights in the scene (except for ambient light) if this color is
anything other than white. Click the color swatch to display the Color Selector,
on which you can choose the tint color. You can animate the tint color by
changing it at a nonzero frame with the Auto Key button on.

Level Multiplies all lights in the scene. A Level of 1.0 preserves the original,
individual light settings. Increasing the Level raises the lighting for the overall
scene, and decreasing the Level lowers the overall lighting. This parameter is
animatable. Default=1.0.

Ambient Sets the color for the ambient light. Click the color swatch, and
choose the color you want in the Color Selector. You can animate the light
effect by changing the ambient light color at a nonzero frame with the Auto
Key button on.
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Atmosphere rollout

Effects Shows the queue of effects that were added. The effects are evaluated
in linear order within the scene during rendering. Depending on the selected
effect, the Environment dialog adds the appropriate rollout for the effect's
parameters.

Name Gives a custom name to effects in the list.

For example, you might have different custom settings for different kinds of
fire, that you could name Spark and Fireball.

Add Displays the Add Atmospheric Effect dialog (all currently installed
atmospheric effects). Select an effect and click OK to assign an effect to the
list.
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Delete Deletes a selected atmospheric effect from the list.

Active Sets the on/off state for the individual effects in the list. This is a
convenient way to isolate effects within a list of complicated atmospheric
functions.

Move Up / Move Down Moves the selected item in the list up or down to
change the order in which the atmospheric effects are applied.

Merge Merges effects from other 3ds Max scene files.

When you click Merge, the Merge Atmospheric Effects dialog appears. Choose
a 3ds Max scene, and then click Open. The Merge Atmospheric Effects dialog
then lists the effects in the scene that can be merged. Select one or more of
the effects, and then click OK to merge them into the scene.

The list shows the names of the atmospheric effects only, but when you merge
an effect, the lights or gizmos bound to that effect are merged as well. If one
of these objects you’re merging has the same name as one already in the scene,
an alert appears giving you the following choices:

■ You can rename the incoming object by changing its name in the editable
field.

■ You can Merge the incoming object without renaming, resulting in two
objects in the scene with the same name.
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■ You can delete the existing object in the scene by selecting the Delete Old
button.

■ You can select Apply To All Duplicates, which performs the same action
to all subsequent matching objects.

NOTE To control whether or not the renderer uses the environment map's
alpha channel in creating the alpha for the rendered image, choose Customize
> Preferences > Rendering, and then turn on Use Environment Alpha in the
Background Antialiasing group.

If Use Environment Alpha is turned off (the default) the background receives
an alpha of 0 (completely transparent). If Use Environment Alpha is turned
on, the alpha of the resulting image is a combination of the scene and
background image's alpha. Also, when writing TGA files with Pre-Multiplied
Alpha set to off, turning on Use Environment Alpha prevents incorrect results.
Note that only background images with alpha channels or black backgrounds
are supported when compositing in other programs such as Photoshop®.

NOTE To control whether or not a background image is affected by the renderer's
antialiasing filter, choose Customize > Preferences > Rendering and then turn on
Filter Background in the Background Antialiasing group. Default=off.

Fire Environment Effect

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Atmosphere rollout > Add > Fire Effect
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Scene using fire

Use Fire to produce animated fire, smoke, and explosion effects. Possible uses
for Fire effects include campfires, torches, fireballs, clouds, and nebula.

You can add any number of fire effects to a scene. The order of effects is
important because effects near the bottom of the list are layered in front of
effects near the top of the list.

Each effect has its own parameters. When you select a fire effect in the Effects
list, its parameters appear in the Environment dialog.

Fire renders only in Camera or Perspective views. Orthographic or User views
don’t render Fire effects.

TIP Fire doesn't support completely transparent objects. Set the transparency of
Fire objects accordingly. Use visibility rather than transparency to make Fire objects
disappear.

NOTE The Fire effect does not cast any light or shadows in the scene. To simulate
illumination, you must also create lights. To cast shadows, you need to go to the
Shadows Parameters rollout on page 5099 of your lights, and turn on Atmosphere
Shadows.
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Procedures

To create fire effects:

1 Create one or more atmospheric apparatus objects to locate the fire effect
in your scene.

2 Define one or more fire atmospheric effects on the Environment panel.

3 Assign atmospheric apparatus objects to the fire effects.

Sample fire effects

Example: To create a campfire:

1 Click Helpers on the Create panel and choose Atmospheric Apparatus on
page 6761 from the subcategory list.

2 Click Sphere Gizmo. Drag the cursor in the Top viewport to define an
apparatus radius of about 20 units. Turn on the Hemisphere check box
in Sphere Gizmo Parameters.

3 Click Non-Uniform Scale. Click Yes in the Warning dialog (this warning
doesn't apply to atmospheric gizmos), and scale the apparatus 250 percent
along its local Z axis only. You can then model logs, embers, and rocks
around the base of the apparatus.

4 Open the Modify panel of the Sphere Gizmo. On the Atmosphere rollout,
click Add and choose Fire from the Add Atmosphere dialog.
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5 Highlight Fire in the Atmospheres list under the Atmospheres & Effects
rollout. Click Setup.

6 Set the following parameters under Shape and Characteristics:

■ Flame Type=Tendril

■ Stretch=0.8

■ Flame Size=18.0

■ Flame Density=30.0

7 Turn on Auto Key and advance to the end of the animation.

8 Set the following parameters under Motion:

■ Phase=300.0

■ Drift=200.0

The Fire effect doesn’t cast any light in the scene. If you want to simulate
illumination from the fire effect, you must create lights as well.

Example model with fire
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Interface
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You create a fire apparatus, or "gizmo," to position the effect in your scene
and to define the maximum boundaries of the effect. The apparatus is a Helper
object found in the Atmospheric Apparatus subcategory.

There are three kinds of apparatus: BoxGizmo on page 6762, SphereGizmo on
page 6768, and CylGizmo on page 6765.

You can move, rotate, and scale the apparatus, but you cannot apply modifiers.

Using non-uniform scale is a good way to change the shape of the apparatus
for effects. (You will see a warning when you use this transform. Because you
don't modify atmospheric apparatus, you can safely ignore the warning.)

Fire Parameters rollout

You must assign an atmospheric apparatus to a fire effect before you can render
the effect. Use buttons in the Gizmos area to manage the list of apparatus
objects.

Gizmos group

Gizmo for the fire in the scene shown at the beginning of this topic
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Pick Gizmo Click to enter Pick mode and click an atmospheric apparatus in
the scene. The apparatus displays the fire effect when you render. The name
of the apparatus is added to the apparatus list.

Multiple apparatus objects can display the same fire effect. For example, torches
on a wall can all use the same effect. Assign a different seed to each apparatus
to vary the effect.

You can assign single apparatus to multiple fire effects. For example, one
apparatus can display both a fireball and a tendril flame effect.

You can choose multiple gizmos. Click Pick Gizmo and press H. This opens
the Pick Object dialog, which lets you choose multiple objects from the list.

Remove Gizmo Removes the gizmo selected in the gizmo list. The gizmo
remains in your scene but it no longer displays the fire effect.

Gizmo List Lists apparatus objects assigned to the fire effect.

Colors group

You can set three color properties for a fire effect using the color swatches
under Colors. Click a color swatch to display the software’s Color Selector on
page 391.

Inner Color Sets the color of the densest part of the effect. For a typical fire,
this color represents the hottest part of the flame.

Outer Color Sets the color of the sparsest part of the effect. For a typical fire,
this color represents the cooler, dissipating edge of the flame.

The fire effect is colored using a gradient between the inner and outer colors.
The dense areas of the effect use the inner color and gradually blend to the
outer color near the edges of the effect.

Smoke Color Sets the color of smoke for use with the Explosion option.

If you turn on Explosion and Smoke, the inner and outer colors animate to
the smoke color. If you turn off Explosion or Smoke, the smoke color is
ignored.

Shape group

You control the shape, scale, and pattern of flames within the fire effect using
controls under Shape.

Two options set the direction and general shape of flames.
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Tendril Creates directional pointed flames with veins along their center. The
flames orient along the local Z axis of the fire apparatus. Tendril creates
campfire-like flames.

Fireball Creates round puffy flames. Fireballs are well suited for explosions.

Stretch Scales flames along the Z axis of the apparatus. Stretch works best
with Tendril flames, but you can use it to give Fireballs an oval shape.

Values less than 1.0 compress flames, making them shorter and thicker.

Values greater than 1.0 stretch flames, making them long and skinny.

You can combine Stretch with non-uniform scaling of the apparatus. Use
non-uniform scale to change the boundary of the effect and scale the shape
of the flames.

Use the Stretch parameter to scale only the flames inside the apparatus. You
can also use Stretch values to reverse the effect that scaling the apparatus had
on the flames.

Effect of changing Stretch

Value=0.5, 1.0, 3.0

Non-uniform scaling of an apparatus

Stretch=0.5, 1.0, 3.0
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Regularity Modifies how the flames fill the apparatus. Range=1.0 to 0.0.

A value of 1.0 completely fills the apparatus. The effect fades near the edges
of the apparatus, but the overall shape is still very noticeable.

A value of 0.0 produces a very irregular effect that might occasionally reach
the boundary of the apparatus, but usually gets trimmed back and is smaller.

Effect of changing Regularity

Value=0.2, 0.5, 1.0

Characteristics group

You set the size and appearance of flames using parameters under
Characteristics. All of these parameters depend on the apparatus size and are
interdependent on each other. Changing one parameter affects the behavior
of the other three.

Flame Size Sets the size of individual flames inside the apparatus. The size of
the apparatus affects the flame size. A larger apparatus requires a larger flame
size. Use a range from 15.0 to 30.0 for the best results.

Large values work best for Fireballs.

Small values work best for Tendrils.

If the flame size is very small, you might need to increase Samples to see
individual flames.
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Effect of changing Flame Size

Value=15.0, 30.0, 50.0

Radius of apparatus=30.0

Flame Detail Controls the amount of color change and edge sharpness seen
within each flame. Range=0.0 to 10.0.

Low values produce smooth, fuzzy flames and render faster.

High values produce patterned, sharp flames and render slower.

Use higher detail values for large flame sizes. If the detail value is greater than
4, you might need to increase Samples to capture the detail.

Effect of changing Flame Detail

Value=1.0, 2.0, 5.0

Density Sets the opacity and brightness of the fire effect. The size of the
apparatus affects the density. A large apparatus with the same density as a
small apparatus appears more opaque and brighter because of its larger size.

Low values make the effect less opaque and use more of the outer color. High
values make the effect more opaque and brighten the effect by gradually
replacing the inner color with white. The higher the value, the more white
the center of the effect is.
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If you turn on Explosion, Density animates from 0.0 at the start of the
explosion to the set density value at the peak of the explosion.

Effect of changing Flame Density

Value=10, 60, 120

Samples Sets the rate at which the effect is sampled. Higher values produce
more accurate results but take longer to render.

You might consider raising the samples value under the following conditions:

■ Flame Size is small.

■ Flame Detail is greater than 4.

■ Any time you see color banding in the effect. The chance of color banding
increases if a flat surface intersects the fire effect.

NOTE 100 percent transparent objects that intersect the effect become partially
visible. To use particles with Fire, consider using 3D particles instead of
opacity-mapped particles.

Motion group

Use the parameters in the Motion group to animate the churning and rise of
flames.

Phase Controls the rate of change for the fire effect. Turn on Auto Key and
change the phase value at different times.

Drift Sets how flames are rendered along the Z axis of the fire apparatus. The
value is the amount of rise in units.

Low values give a slow-burning, cool fire.

High values give a fast-burning, hot fire.
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For the best fire effects, drift should be a multiple of the height of the fire
apparatus.

You can also animate the location and size of the fire apparatus and most of
the fire parameters. For example, a fire effect can animate color, size, and
density.

Explosion group

Use the parameters in the Explosion group to automatically animate
explosions.

Explosion Animates size, density, and color automatically based on the
animation of the Phase value.

Smoke Controls whether or not the explosion creates smoke.

When on, fire colors change to smoke between Phase values 100 to 200. Smoke
clears between Phase values 200 to 300. When off, fire colors remain at full
density between Phase values 100 to 200. Fire fades away between Phase values
200 to 300.

Fury Varies the churning effect of the Phase parameter.

Values greater than 1.0 cause faster churning. Values less than 1.0 cause slower
churning.

Set Up Explosion Displays the Set Up Explosion Phase Curve dialog. You
enter a start time and end time, and then click OK. The Phase value animates
automatically for a typical explosion effect.

Fog Environment Effect

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Atmosphere rollout > Add > Fog
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Fog added to a scene

This command provides fog and smoke atmospheric effects. This plug-in on
page 8092 provides effects such as fog which causes objects to appear to fade as
they increase in distance from the camera (standard fog), or layered fog that
envelops all or parts of objects in a blanket of mist.

Fog renders only in Camera or Perspective views. Orthographic or User views
don’t render Fog effects.

Procedures

To use standard fog:

1 Create a Camera view of your scene.

2 In the camera's creation parameters, turn on Show in the Environment
Ranges group.

Standard fog is based on the camera's environment range values.

3 Set Adjust Near Range and Far Range to include the objects you want to
fog in your rendering.
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As a general guideline, set Far Range just beyond the objects, and Near
Range to intersect the object geometry closest to the camera.

4 Choose Rendering > Environment.

5 Under Atmosphere on the Environment panel, click Add.

The Add Atmospheric Effect dialog is displayed.

6 Choose Fog, and then click OK.

7 Make sure you choose Standard as the type of fog.

To use layered fog:

1 Create a Camera or Perspective view of your scene.

2 Choose Rendering > Environment.

3 Under Atmosphere on the Environment panel, click Add.

The Add Atmospheric Effect dialog is displayed.

4 Choose Fog, and then click OK.

5 Choose Layered as the fog type.

6 Set the parameters for layered fog.

You can have multiple fog layers in the scene by adding multiple Fog
entries to the list and choosing Layered.
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Interface

The Fog Parameters rollout appears when you select Fog under Effects in the
Environment dialog. The Fog Parameters rollout has the following controls.

Fog group

Color Sets the color for the fog. Click the color swatch, and then select the
color you want in the Color Selector on page 391. You can animate the color
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effect by changing the fog color at a nonzero frame with the Auto Key button
on.

Environment Color Map Derives the fog color from a map. You can map the
background and the fog color, you can animate the procedural map parameters
in Track View or Material Editor, and you can opacity-map the fog.

The large button displays the name of the color map, or None if no map is
assigned. The map must use Environmental mapping coordinates on page 8034
(spherical, cylindrical, shrinkwrap, and screen).

To assign the map you can drag a map from a Sample slot or Map button in
the Material Editor (or anywhere else in the software; for example, a projector
map button) and drop it on the Environment Color Map button. A dialog
asks if you want the environment map to be a copy (independent) or an
instance of the source map.

Clicking the Environment Color Map button displays the Material/Map
Browser, where you can choose a map type from the list. To adjust the
environment map's parameters, open the Material Editor and drag the
Environment Color Map button over an unused sample slot.

Use Map Toggles the effect of this map on or off.

Environment Opacity Map Alters the density of the fog.

You assign the opacity map, edit it, and toggle its effect in the same way as
the Environment Color Map.

Fog Background Applies the fog function to the background of the scene.

Type When you choose Standard it uses the parameters in the Standard section
and when you choose Layered is selected it uses the parameters in the Layered
section.

Standard Enables the Standard group.

Layered Enables the Layered group.

Standard group

Thins and thickens the fog based on the distance from the camera.

Exponential Increases density exponentially with distance. When turned off,
density increases linearly with distance. Activate this check box only when
you want to render transparent objects in volume fog.

TIP If you turn on Exponential, this increases the Step Size value to avoid banding.
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Near % Sets the density of the fog at the Near Range (Camera Environment
Range parameter).

Far % Sets the density of the fog at the Far Range (Camera Environment Range
parameter).

Layered group

Thins and thickens the fog between an upper and lower limit. You can have
multiple layers of fog by adding multiple fog entries to the list. Because you
can animate all the fog parameters, you can also animate fog rising and falling,
changing density and color, and add horizon on page 8005 noise.

Top Sets the upper extent (in world units) of the fog layer.

Bottom Sets the lower extent (in world units) of the fog layer.

Density Sets the overall density of the fog.

Falloff (Top/Bottom/None) Adds an exponential falloff effect so that the
density is reduced to 0 at either the Top or Bottom of the fog extent.

Horizon Noise Turns on the horizon noise system. Horizon Noise perturbs
just the horizon of the fog layer to add realism.

Size Scale factor applied to the noise. Larger scale values make the fog tendrils
larger. Default=20.

TIP If you want tendrils to really pop out, try making the density greater than
100.

Angle Determines the affected angle off the horizon line. For example, if the
angle is set to 5 (a reasonable value), then starting at 5 degrees below the
horizon, the fog will begin to break up.

This effect is mirrored above and below the horizon, which can produce strange
results when the height of the fog layer traverses the horizon. Typically you'd
want the fog to be either above or below the actual camera horizon. (You can
use the horizon line in the camera parameters as an aid to help you position
this.)

Phase Animating this parameter animates the noise. If Phase is moving in the
positive direction, then the fog tendrils will drift upward (and deform at the
same time). If your fog is above the horizon you may want to animate Phase
in the negative direction to make the tendrils fall downward.
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Volume Fog Environment Effect

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Atmosphere rollout > Add > Volume Fog

Volume fog added to a scene

Volume Fog provides a fog effect in which the fog density is not constant
through 3D space. This plug-in on page 8092 provides effects such as puffy,
cloudy fog that appears to drift and break up in the wind.

Volume Fog renders only in Camera or Perspective views. Orthographic or
User views don’t render Volume Fog effects.

Procedures

To use volume fog:

1 Create a Camera or Perspective view of your scene.

2 Choose Rendering > Environment.

3 Under Atmosphere on the Environment panel, click Add.
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The Add Atmospheric Effect dialog is displayed.

4 Choose Volume Fog, and then click OK.

5 Set the parameters for volume fog.

NOTE If there are no objects in your scene, rendering shows only a solid fog
color. Also, with no objects and Fog Background turned on, volume fog
obscures the background.

To create a volume fog gizmo:

Volume fog gizmo surrounds the scene.

1 In the Helpers category of the Create panel, choose Atmospheric Apparatus
from the pop-up menu.

2 Click one of the buttons to choose a gizmo shape: SphereGizmo,
CylGizmo, or BoxGizmo.

3 Drag the mouse in the viewport to create the gizmo.

You create Gizmos in much the same way as their matching geometry
types. Drag the mouse to create the initial dimensions. The Sphere gizmo
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has an additional Hemisphere check box that turns the sphere into a
hemisphere.

In addition, each gizmo has a Seed spinner and a New Seed button.
Different seed values generate different patterns. Clicking the New Seed
button randomly generates a new seed value for you.

To assign volume fog to a gizmo from an apparatus modify panel:

1 Open the Modify panel of an apparatus.

2 Open the Atmospheres & Effects rollout.

3 Click Add.

4 Select Volume Fog from the Add Atmospheres dialog and click OK.

5 Highlight Volume Fog from the Atmospheres list and click setup to adjust
the Volume Fog parameters.

To assign a gizmo to volume fog from the Environment panel:

1 On the Volume Fog Parameters rollout, click the Pick Gizmo button.

2 Click a gizmo in the viewport.

The name of the gizmo appears in the list field at right.

When you render, the volume fog will be confined to the shape of the
gizmo.

To remove an assigned gizmo:

1 In the Environment dialog, go to the Volume Fog Parameters rollout

2 Select the gizmo name from the pop-up list.

3 Click Remove Gizmo.

This action doesn’t delete the gizmo from the scene, but simply unbinds
it from the fog effect.
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Interface

The Volume Fog Parameters rollout appears when you select Volume Fog
under Effects in the Environment dialog. The Volume Fog Parameters rollout
has the following controls.
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Gizmos group

By default, volume fog fills the entire scene. However, you can choose a gizmo
(an atmospheric apparatus) to contain the fog. The gizmo can be a sphere, a
box, a cylinder, or some combination of these.

Pick Gizmo Click to enter Pick mode and click an atmospheric apparatus in
the scene. The apparatus contains the volume fog when you render. The name
of the apparatus is added to the apparatus list.

Multiple apparatus objects can display the same fog effect.

You can pick multiple gizmos. Click Pick Gizmo and then press H. This opens
the Pick Object dialog, which lets you choose multiple objects from a list.

Changing the dimensions of a gizmo changes the region that fog affects, but
doesn't change the scale of the fog and its noise. For example, reducing the
radius of a spherical gizmo crops the fog, and moving the gizmo changes the
fog's appearance.

Remove Gizmo Removes a gizmo from the volume fog effect. Select the gizmo
in the list, and then click Remove Gizmo.

Soften Gizmo Edges Feathers the edges of the volume fog effect. The higher
the value, the softer the edges. Range=0 to 1.0.

TIP Don't set this value to 0. At 0, Soften Gizmo Edges can cause aliased edges.

Volume group

Color Sets the color for the fog. Click the color swatch, and then select the
color you want in the Color Selector on page 391.

You can animate the color effect by changing the fog color at a nonzero frame
with Auto Key on.

Exponential Increases density exponentially with distance. When turned off,
density increases linearly with distance. Activate this check box only when
you want to render transparent objects in volume fog.

TIP If you turn on Exponential, increase the Step Size value to avoid banding.

Density Controls the fog density. Range=0 to 20 (anything over that tends
to obliterate the scene).
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Left: Original scene

Right: Increased fog density

Step Size Determines the granularity of the fog sampling; the "fineness" of
the fog. A large step size creates coarse (and to some extent, aliased) fog.

Max Steps Limits the amount of sampling so that computing the fog doesn't
take forever (literally). This is especially useful when the fog is of low density.

When both Step Size and Max Steps have low values, aliasing results.

Fog Background Applies the fog function to the background of the scene.
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Noise group

Left: Original scene

Right: Noise added to the fog

Noise options for volume fog are comparable to the noise options for materials.

Type Choose one of three types of noise to apply.

Regular The standard noise pattern.

Fractal An iterative fractal noise pattern.

Turbulence An iterative turbulence pattern.

Invert Reverses the noise effect. Dense fog becomes translucent and vice versa.

Noise Threshold Limits the noise effect. Range=0 to 1.0. When the noise
value is above the Low threshold and below the High threshold, the dynamic
range stretches to fill 0-1. This makes for a smaller discontinuity (First order
instead of 0 order) at the threshold transition, and thus produces less potential
aliasing on page 7904.

High Sets the high threshold.

Low Sets the low threshold.
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Left: Fog with noise

Right: Changing uniformity creates "blobby" fog

Uniformity Ranges from -1 to 1 and acts like a high-pass filter. The smaller
the value, the more transparent the volume is with discrete blobs of smoke.
Around -0.3 or so your image begins to look like specks of dust. Because the
fog becomes thinner as this parameter gets smaller, you'll probably need to
increase the density or the volume will start to disappear.

Levels Sets the number of times the noise is iteratively applied. Range=1 to
6, including fractional values. Enabled only for Fractal noise or Turbulence.

Size Determines the size of the tendrils of smoke or fog. Smaller values give
smaller tendrils.
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Left: Fog with noise

Right: Decreasing the size

Phase Controls the speed of the wind. If you have Wind Strength also set to
greater than 0, the fog volume animates in accordance with the wind direction.
With no Wind Strength, the fog churns in place. Because there's an animation
track for phase, you can use the Function Curve editor to define precisely how
you want your wind "gusts" to occur.

Wind Strength Controls how fast the smoke moves away from the wind
direction, relative to phase. As mentioned above, if the phase is not animated
then the smoke won’t move, regardless of the wind strength. By having the
phase animate slowly with a large wind strength, the fog moves more than it
is churns.

Wind from the Defines the direction the wind is coming from.

Volume Light Environment Effect

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Atmosphere rollout > Add > Volume Light
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Volumetric light used in a complex environment with shadows and noise.

Volume Light provides light effects based on the interaction of lights with
atmosphere (fog, smoke, and so on).

This plug-in on page 8092 provides effects such as radial glows for omni lights
on page 8066, conical glows for spotlights, and parallel beams of fog for
directional lights. Objects within the light volume can cast shadows within
the spotlight's cone, if using shadow maps as a shadow generator.

A simplified example where the light cone is clearly visible on the right.

Volume Light renders only in Camera and Perspective views. Orthographic
or User views don’t render Volume Light effects.
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Procedures

To use Volume Light:

1 Create a scene with lights.

2 Create a Camera or Perspective view of your scene.

TIP Avoid making the view axis parallel to the cone of a spotlight. This tends
to create only a washed-out scene, possibly with rendering artifacts.

3 Choose Rendering > Environment.

4 On the Environment panel, under Atmosphere , click Add.

The Add Atmospheric Effect dialog is displayed.

5 Choose Volume Light, and then click OK.

6 Click Pick Light, and then select a light in a viewport to add the light to
the list of volume lights.

You can also use the Pick Object dialog to select multiple lights from a
list. Click Pick Light, and then press H to open the dialog.

7 Set the parameters for volume light.

To add a light to the list:

1 Click Pick Light.

2 Click the light in a viewport.

To remove a light from the list:

1 Open the list of volume lights.

2 Choose the light you want to remove the volume light effect from.

3 Click Remove Light.

To assign volume light to a light through the Modify panel:

1 Open the Modify panel of a light.

2 Open the Atmospheres & Effects rollout.

3 Click Add.
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4 Select Volume Light from the Add Atmosphere or Effect dialog and click
OK.

5 Highlight Volume Light from the Atmospheres & Effects list and click
setup to adjust the Volume Light parameters.

NOTE Volume Lights don’t support negative multiplier values.
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Interface

The Volume Light Parameters rollout appears when you select Volume Light
under Effects in the Environment dialog. It has the following controls.

Volume Light Environment Effect | 6725



Lights group

Pick Light Click the light that you want to enable for volume light in any
viewport.

You can pick multiple lights. Click Pick Light and then press H. This opens
the Pick Object dialog, which lets you choose multiple lights from a list.

Remove Light Deletes a light from the list.

Volume group

Fog Color Sets the color for the fog that makes up the volume of the light.
Click the color swatch, and then choose the color you want in the Color
Selector on page 391.

You can animate the color effect by changing the fog color at a nonzero frame
with the Auto Key button on.

Unlike the other fog effects, this fog color combines with the color of the
light. Possibly the best effect is to use white fog and then color it with a colored
light.

Attenuation Color Attenuates volume light over distance. The volume light
ramps from the Fog Color to the Attenuation color over the light's Near and
Far attenuation distances. Clicking the color swatch displays a color selector
so you can change the attenuation color.

Attenuation Color interacts with Fog Color. For example, if your fog color is
red and your attenuation color is green, in the rendering your fog will shade
to purple. Typically the attenuation color should be very dark and
neutral—black is a good choice.

Use Attenuation Color Makes attenuation color active.

Exponential Increases density exponentially with distance. When turned off,
density increases linearly with distance. Activate this check box only when
you want to render transparent objects in volume fog.

Density Sets the density of the fog. The denser the fog, the more the light
reflects off it inside the volume. Densities of 2 to 6 percent probably make the
most realistic fog volumes.
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Left: Original scene

Right: Increasing the density

Max Light% Represents the maximum glow effect that you can achieve
(defaults to 90 percent). By turning this down, you can limit the brightness
of the glow so that it doesn't get denser and denser as it gets farther away from
the light and "whites out."

NOTE When your scene includes transparent objects inside a volume light, set
Max Light to 100 percent.

Min Light% Similar to an ambient light on page 7906 setting. If Min Light% is
greater than 0, areas outside the light volume will glow also. Note that this
means areas of open space (where the light ray can travel forever) will end up
the same as the fog color (just as with normal fog).

Without objects behind the fog, the scene will always be as bright as the fog
color if the Min Light% is greater than 0 (no matter what the actual value is).
This is because the fog goes to infinity and is accumulated infinitely. If you're
going to use min light% values greater than 0, you should make sure that you
enclose your scene by geometry.

Atten. Mult. (Attenuation Multiplier) Adjusts the effect of the attenuation
color.

Filter Shadows Allows you to get better quality volume-light rendering by
increasing the sampling rate (at the cost of some increased rendering time).
These are the options:
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Low The image buffer is not filtered but directly sampled instead. This option
is fine for 8-bit images, AVI on page 7326 files, and so on.

Medium Adjacent pixels are sampled and averaged. This produces a very
significant improvement in cases where you’re getting banding types of
artifacts. It is slower than Low.

High Adjacent pixels and the diagonal pixels are sampled, and each are given
different weights. This is the slowest method and provides somewhat better
quality than Medium.

Use Light Smp Range Blurs the shadows cast in the volume based on the
Sample Range value in the light's shadow parameters. Because increasing the
Smp Range value blurs the shadow cast by the light, this makes shadows in
the fog better match cast shadows, and helps prevent aliasing in the fog
shadows.

TIP With the Use Light Smp Range option, the higher the light's Smp Range value,
the slower the rendering. However, with this option you can usually get good
results with a lower Sample Volume % setting (such as 4), which reduces rendering
time.

Sample Volume % Controls the rate at which the volume is sampled. Ranges
1 through 10,000 (where 1 is the lowest quality and 10,000 is the highest
quality).

Auto Controls the Sample Volume % parameter automatically and disables
the spinner (this is the default). The preset sampling rates are as follows:

low=8; medium=25; high=50

Because the parameter ranges up to 100 there's still room to set it higher.
Increasing the Sample Volume % parameter definitely slows things down, but
in some cases you may want to increase it (for extremely high sample quality).
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Left: Original scene

Right: Increasing sample volume to improve quality

Attenuation group

The controls in this section are contingent upon the settings of the Start Range
and End Range attenuation on page 7915 parameters for the individual light.

NOTE Rendering Volume Light at some angles can introduce aliasing problems.
To eliminate aliasing problems, activate the Near and Far Attenuation settings in
the light object that the Volume Light applied to.

Start % Sets the start attenuation of the light effect, relative to the actual light
parameter's attenuation. It defaults to 100 percent, which means that it starts
attenuating at the Start Range point. When you reduce this parameter, it starts
attenuating the light at a reduced percentage of the actual Start Range value
that is, closer to the light itself.

Because you usually want a smooth falloff on page 8007, you can keep this value
at 0, and no matter what the light's actual Start Range, you'll always get a
smooth glow without hotspots on page 8007.

End % Sets the end attenuation of the lighting effect, relative to the actual
light parameter's attenuation. By setting this lower than 100 percent, you can
have a glowing attenuating light that casts light much farther than it actually
glows. Default=100.
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Left: Original scene

Right: Attenuation limits the range of the light.

Noise group

Noise On Turns the noise on and off. When noise is on there is a slight increase
in render time.

Amount The percentage of noise applied to the fog. If the amount is 0, there
is no noise. If the amount is 1, the fog becomes pure noise.

Left: Original scene

Right: Noise added
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Link To Light Links the noise effect to its light object, rather than to world
coordinates.

Usually you want noise to look like fog or dust motes in the atmosphere, in
which case, as the light moves, the noise should remain with the world
coordinates. For certain special effects, however, you might want the noise
linked to the light's coordinates. In these cases, turn on Link to Light.

Type Choose one of three types of noise to apply.

■ Regular The standard noise pattern.

■ Fractal An iterative fractal noise pattern.

■ Turbulence An iterative turbulence pattern.

Invert Reverses the noise effect. Dense fog becomes translucent and vice versa.

Noise Threshold Limits the noise effect. When the noise value is above the
Low threshold and below the High threshold, the dynamic range stretches to
fill 0-1. This makes for a smaller discontinuity (first order instead of 0 order)
at the threshold transition and thus produces less potential aliasing on page
7904.

■ High Sets the high threshold. Range=0 to 1.0.

■ Low Sets the low threshold. Range=0 to 1.0.

Uniformity Acts like a high-pass filter: the smaller the value, the more the
volume is transparent with discrete blobs of smoke. By around -0.3 or so your
image begins to look like specks of dust. Because the fog becomes thinner as
this parameter gets smaller, you'll probably need to increase the density or
the volume will start to disappear. Range=-1 to 1

Levels Sets the number of times the noise is iteratively applied. This parameter
is animatable. Enabled only for Fractal noise or Turbulence. Range=1 to 6,
including fractional values.

Size Determines the size of the tendrils of smoke or fog. Smaller values give
smaller tendrils.

Volume Light Environment Effect | 6731



Left: Volume light with noise

Right: Reducing the size value

Phase Controls the speed of the wind. If you have Wind Strength also set to
greater than 0, the fog volume animates in accordance with the wind direction.
With no Wind Strength, the fog churns in place. Because there's an animation
track for phase, you can use the Function Curve editor to define precisely how
you want your wind "gusts" to happen.

Wind Strength Controls how fast the smoke moves away from the wind
direction, relative to phase. As mentioned above, if the phase is not animated
then the smoke won’t move, regardless of the wind strength. By having the
phase animate slowly with a large wind strength, the fog moves more than it
churns.

Wind from the Defines the direction the wind is coming from.

Exposure Controls

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Exposure Control rollout

Exposure controls are plug-in components that adjust the output levels and
color range of a rendering, as if you were adjusting film exposure. This process
is known as tone mapping. These controls are especially useful for renderings
that use radiosity on page 6168, and when dealing with high-dynamic-range
(HDR) imagery.
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Exposure control compensates for the limited dynamic range of computer
displays, which is typically about two orders of magnitude: The brightest color
that appears on a display is about 100 times brighter than the dimmest. The
eye, by comparison, can perceive a dynamic range of about 16 orders of
magnitude. In other words, the brightest color we can perceive is about 10
million-billion times brighter than the dimmest. Exposure control adjusts
colors so they better simulate the eye's great dynamic range, while still fitting
within the color range that can be rendered.

The exposure controls included with 3ds Max are:

■ Automatic Exposure Control on page 6735 samples the rendered image and
builds a histogram to give good color separation across the entire dynamic
range of the rendering. It can enhance some lighting effects that would
otherwise be too dim to see.

■ Linear Exposure Control on page 6738 samples the rendering and uses the
average brightness of the scene to map physical values to RGB values.
Linear Exposure Control is best for scenes with a fairly low dynamic range.

■ Logarithmic Exposure Control on page 6740 uses brightness, contrast, and
whether the scene is outdoors in daylight to map physical values to RGB
values. Logarithmic Exposure Control is better for scenes with a very high
dynamic range.

■ mr Photographic Exposure Control on page 6744 gives you camera-like
controls including shutter speed, aperture, and film speed, as well as image
control over highlights, midtones, and shadows.

■ Pseudo Color Exposure Control on page 6753 is actually a lighting analysis
tool. It maps luminances to pseudo colors that show the brightness of the
values being converted.

IMPORTANT The mental ray renderer on page 6230 supports only the Logarithmic,
mr Photographic, and Pseudo Color exposure controls.

Left: Linear exposure control maps intensity evenly.

Right: Logarithmic exposure control maps most intensities to low and mid tones.
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Tips:

■ If the primary lighting from your scene comes from standard lights (rather
than photometric lights), use the Logarithmic exposure control and turn
on Affect Indirect Only.

■ Use Automatic exposure control for rendering still images. This method
is also useful for first-draft renderings.

■ Use Logarithmic exposure control for animations with a moving camera.
(Automatic and Linear exposure control with a moving camera can cause
excessive flickering.)

■ For rendering high-dynamic-range images with mental ray, use the mr
Photographic exposure control.

■ For outdoor scenes that use the Daylight system, turn on the Exterior toggle
to prevent overexposure.

Exposure and Attenuation for Standard Lights

When you use standard lights that are not attenuated, renderings tend to have
a low dynamic range, because light intensities don't vary greatly across the
scene. In this situation, adjusting light values might be all you need to do to
get a good rendering.

On the other hand, when lights are attenuated the illumination might be too
bright on near surfaces or too dim on distant surfaces. In this situation, the
Automatic exposure control can help, because it adjusts the larger dynamic
range of the (simulated) physical scene, into the smaller dynamic range of the
display.

Interface

Drop-down list Choose the exposure control to use.
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Active When on, the exposure control is used in rendering. When off, the
exposure control is not applied.

Process Background and Environment Maps When on, the scene background
and environment maps are subjected to exposure control. When off, they are
not.

Preview thumbnail The thumbnail displays a preview of the rendered scene
with the active exposure control applied. Once a preview has been rendered,
it updates interactively when you changed exposure control settings.

Render Preview Click to render the preview thumbnail.

Automatic Exposure Control

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Exposure Control rollout > Choose Automatic Exposure
Control from the list. > Automatic Exposure Control rollout

Auto exposure can affect the lighting of the whole image.

Automatic Exposure Control samples the rendered image and builds a
histogram to give good color separation across the entire dynamic range of
the rendering. It can enhance some lighting effects that would otherwise be
too dim to see.
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NOTE Automatic Exposure Control should not be used in animations, because
every frame will have a different histogram, causing your animation to flicker.

IMPORTANT The mental ray renderer on page 6230 does not support the Automatic
exposure control.

See also:

■ Environment Panel on page 6689

Interface

Brightness Adjusts the brightness of the converted colors. Range=0 to 200.
Default=50.

This parameter is animatable.

Contrast Adjusts the contrast of the converted colors. Range=0 to 100.
Default=50.

This parameter is animatable.

Exposure Value Adjusts the overall brightness of the rendering. Range=-5.0
to 5.0; Negative values make the image darker, and positive values make it
brighter. Default=0.0.

The exposure value is comparable to the exposure compensation setting in
cameras with automatic exposure. This parameter is animatable.

Physical Scale Sets a physical scale for exposure control to use with lights
that are not physically based. The result is an adjustment of the rendering
that approximates the eye's response to the scene.

Each standard light's Multiplier on page 8055 is multiplied by the Physical Scale
value to give a light intensity value in candelas. For example, with the default
Physical Scale of 1500, a standard omni light is treated by the renderer and
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radiosity as a photometric isotropic light of 1500 candelas. Physical Scale is
also factored into reflections, refractions, and self-illumination.

TIP You need to set the Physical Scale when you use ray-tracing with self
illumination. Set this value to the equivalent of the brightest light source in the
scene. This will set the appropriate conversion scale for reflections, self-illumination,
and all other non-physically based elements a material offers. In some cases, an
object might reflect or emit more light than the brightest light object in the scene;
in this case, use the object's Luminance value as the Physical Scale.

Range=0.0 to 200,000.0 candelas. Default=1500.0.

A single candle is approximately 1 candela (the unit can also be called a
"candle"). A 100-Watt (W) incandescent light bulb is approximately 139
candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the
same bulb with a reflector is about 4500 cd because the light flux is
concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value.

This parameter is animatable.

Color correction check box and color swatch When the check box is turned
on, color correction shifts all colors so the color displayed in the color swatch
appears as white. Default=off.

Clicking the color swatch displays a Color Selector on page 391 so you can
choose the color to adapt to.

You can use this control to simulate how the eye adjusts to lighting. For
example, even when the light in a room has a yellow hue from an incandescent
light bulb, we will continue to perceive objects that we know to be white,
such as printed pages, as white.

TIP For the best results, use a very pale color correction color, such as a pale blue
or pale yellow.

Desaturate Low Levels When on, renders dimly lit colors as if the light were
too dim for the eye to distinguish between colors. When on, renders even
dimly lit colors. Default=off.

Desaturate Low Levels simulates the eye's response to dim lighting. In dim
lighting, the eye does not perceive colors and sees tones of gray instead.

The effect of this setting is not apparent except at very low light levels, below
5.62 footcandles (lumens per square foot). When the illuminance is less than
0.00562 footcandles, the scene is completely gray.

NOTE 1 footcandle (fc) equals 10.76 lux (lumens per square meter).
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Linear Exposure Control

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Exposure Control rollout > Choose Linear Exposure
Control from the list. > Linear Exposure Control rollout

Linear Exposure Control samples the rendered image and uses the average
brightness of the scene to map physical values to RGB values. Linear Exposure
Control is best used for scenes with a fairly low dynamic range.

NOTE Linear Exposure Control should not be used in animations, because every
frame will have a different histogram, causing your animation to flicker.

IMPORTANT The mental ray renderer on page 6230 does not support the Linear
exposure control.

See also:

■ Environment Panel on page 6689

Interface

Brightness Adjusts the brightness of the converted colors. Range=0 to 200.
Default=50.

This parameter is animatable.

Contrast Adjusts the contrast of the converted colors. Range=0 to 100.
Default=50.

This parameter is animatable.
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Exposure Value Adjusts the overall brightness of the rendering. Range= -5.0
to 5.0. Negative values make the image darker, and positive values make it
brighter. Default=0.0.

The exposure value can be thought of as an exposure compensation setting
in cameras with automatic exposure control.

This parameter is animatable.

Physical Scale Sets a physical scale for exposure control to use with lights
that are not physically based. The result is an adjustment of the rendering
that approximates the eye's response to the scene.

Each standard light's Multiplier on page 8055 is multiplied by the Physical Scale
value to give a light intensity value in candelas. For example, with the default
Physical Scale of 1500, a standard omni light is treated by the renderer and
radiosity as a photometric isotropic light of 1500 candelas. Physical Scale is
also factored into reflections, refractions, and self-illumination.

TIP You need to set the Physical Scale when you use ray-tracing with self
illumination. Set this value to the equivalent of the brightest light source in the
scene. This will set the appropriate conversion scale for reflections, self-illumination,
and all other non-physically based elements a material offers. In some cases, an
object might reflect or emit more light than the brightest light object in the scene;
in this case, use the object's Luminance value as the Physical Scale.

Range=0.0 to 200,000.0 candelas. Default=1500.0.

A single candle is approximately 1 candela (the unit can also be called a
"candle"). A 100-Watt (W) incandescent light bulb is approximately 139
candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the
same bulb with a reflector is about 4500 cd because the light flux is
concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value.

This parameter is animatable.

Color Correction check box and color swatch When the check box is turned
on, color correction shifts all colors so the color displayed in the color swatch
appears as white. Default=off.

Clicking the color swatch displays a Color Selector on page 391 so you can
choose the color to adapt to.

You can use this control to simulate how the eye adjusts to lighting. For
example, even when the light in a room has a yellow hue from an incandescent
light bulb, we will continue to perceive objects that we know to be white,
such as printed pages, as white.
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TIP For the best results, use a very pale color correction color, such as a pale blue
or pale yellow.

Desaturate Low Levels When on, renders dimly lit colors as if the light were
too dim for the eye to distinguish between colors. When on, renders even
dimly lit colors. Default=off.

Desaturate Low Levels simulates the eye's response to dim lighting. In dim
lighting, the eye does not perceive colors and sees tones of gray instead.

The effect of this setting is not apparent except at very low light levels, below
5.62 footcandles (lumens per square foot). When the illuminance is less than
0.00562 footcandles, the scene is completely gray.

NOTE 1 footcandle (fc) equals 10.76 lux (lumens per square meter).

Logarithmic Exposure Control

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Exposure Control rollout > Choose Logarithmic Exposure
Control from the list. > Logarithmic Exposure Control rollout

Logarithmic Exposure Control uses brightness, contrast, and whether the
scene is outdoors in daylight to map physical values to RGB values. You can
use it with either the default scanline renderer on page 6141 and the mental ray
renderer on page 6230. Logarithmic Exposure Control is best for scenes with a
very high dynamic range.

Left: The intensity of an IES Sun light completely overexposes a scene.

Right: Logarithmic exposure control corrects the overexposure.

Logarithmic Exposure Control is the best type of exposure control for
animations because it doesn’t use histograms.
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TIP If you're rendering to texture on page 6371, use the Logarithmic exposure
control, not the Automatic or Linear control.

See also:

■ Environment Panel on page 6689

Interface

Brightness Adjusts the brightness of the converted colors. Range=0 to 200.
Default=50.

This parameter is animatable.

Contrast Adjusts the contrast of the converted colors. Range=0 to 100.
Default=50.

This parameter is animatable.

Mid Tones Adjusts the mid-tone values of the converted colors. Range=0.01
to 20.0. Default=1.0.

This parameter is animatable.

Adjusting the value of mid tones
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Physical Scale Sets a physical scale for exposure control to use with lights
that are not physically based. The result is an adjustment of the rendering
that approximates the eye's response to the scene.

Each standard light's Multiplier on page 8055 is multiplied by the Physical Scale
value to give a light intensity value in candelas. For example, with the default
Physical Scale of 1500, a standard omni light is treated by the renderer and
radiosity as a photometric isotropic light of 1500 candelas. Physical Scale is
also factored into reflections, refractions, and self-illumination.

TIP You need to set the Physical Scale when you use ray-tracing with self
illumination. Set this value to the equivalent of the brightest light source in the
scene. This will set the appropriate conversion scale for reflections, self-illumination,
and all other non-physically based elements a material offers. In some cases, an
object might reflect or emit more light than the brightest light object in the scene;
in this case, use the object's Luminance value as the Physical Scale.

NOTE The mental ray renderer treats Physical Scale in the same way the scanline
renderer does in terms of its effect on reflections and refractions. Physical Scale
does affect the appearance of self-illuminated materials.

Range=0.0 to 200,000.0 candelas. Default=1500.0.

A single candle is approximately 1 candela (the unit can also be called a
"candle"). A 100-Watt (W) incandescent light bulb is approximately 139
candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the
same bulb with a reflector is about 4500 cd because the light flux is
concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value.

This parameter is animatable.

Color Correction check box and color swatch When the check box is turned
on, color correction shifts all colors so the color displayed in the color swatch
appears as white. Default=off.

Clicking the color swatch displays a Color Selector on page 391 so you can
choose the color to adapt to.

You can use this control to simulate how the eye adjusts to lighting. For
example, even when the light in a room has a yellow hue from an incandescent
light bulb, we will continue to perceive objects that we know to be white,
such as printed pages, as white.

TIP For the best results, use a very pale color correction color, such as a pale blue
or pale yellow.
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Color correction can remove the color “cast” that comes from a light source.

Desaturate Low Levels When on, renders dimly lit colors as if the light were
too dim for the eye to distinguish between colors. When off, renders even
dimly lit colors. Default=off.

Desaturate Low Levels simulates the eye's response to dim lighting. In dim
lighting, the eye does not perceive colors and sees tones of gray instead.

The effect of this setting is not apparent except at very low light levels, below
5.62 footcandles (lumens per square foot). When the illuminance is less than
0.00562 footcandles, the scene is completely gray.

NOTE 1 footcandle (fc) equals 10.76 lux (lumens per square meter).

Affect Indirect Only When on, Logarithmic Exposure control is applied only
to areas of indirect lighting. Default=off.

Turn on this toggle when the primary lighting for your scene comes from
standard lights rather than photometric lights. When you use standard lights
and turn on Affect Indirect Only, radiosity and exposure control yield results
similar to the default scanline renderer. When you use standard lights but
leave Affect Indirect Only off, radiosity and exposure control yield results that
can be quite different from the default scanline renderer.

In general, you don’t need to turn on Affect Indirect Only when the primary
lighting for your scene comes from photometric lights.

Exterior daylight When on, converts colors for an outdoor scene. Default=off.
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The exterior daylight setting compensates for the extreme intensity of an IES sun light.

mr Photographic Exposure Control

Set mental ray as the renderer. > Rendering menu > Environment >
Environment and Effects dialog > Environment panel > Exposure Control
rollout > Choose mr Photographic Exposure Control from the list. > mr
Photographic Exposure Control rollout

The mr Photographic Exposure Control lets you modify rendered output with
camera-like controls: either a general exposure value or specific shutter speed,
aperture, and film speed settings. It also gives you image-control settings with
values for highlights, midtones, and shadows. It’s intended for
high-dynamic-range scenes rendered with the mental ray renderer on page
6230.

NOTE The mr Photographic Exposure Control contains a built-in gamma corrector
(gamma 2.2), but this correction is disabled if the 3ds Max gamma correction on
page 7758 is enabled on the Preferences dialog, letting the Rendered Frame Window
apply the view gamma instead.

The Logarithmic exposure control on page 6740 also has a curve similar to a
gamma correction, but unlike the Photographic exposure control, it is not
designed to disable its gamma correction when overall gamma correction is
on. For that reason, combining gamma correction with the Logarithmic
exposure control is discouraged, whereas using it together with the
Photographic exposure control is encouraged.
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Interface

TIP To see a definition of any numeric parameter on this rollout, hover the mouse
cursor over the parameter’s spinner.

Exposure group

This group comprises a drop-down list of exposure presets plus a choice of
Exposure Value or Photographic Exposure and associated parameters. Choosing
one method makes the other’s setting or settings unavailable, but they still
change based on adjustments you make to the available method. For example,
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when Exposure Value is active, adjusting its value also changes the
Photographic Exposure > Shutter Speed setting.

Preset Choose from the available options based on setting and lighting
conditions. The presets affect all of the remaining settings in this group.

Exposure Value (EV) Choose this option to specify a single Exposure Value
setting that corresponds to a combination of the three Photographic Exposure
values (see following). Each increment or decrement in the EV value
corresponds to halving or doubling, respectively, the effective exposure, as
expressed in the resultant change in the Shutter Speed value. Thus, higher
values yield darker images, and lower values yield brighter images.

For example, as shown above, the combination of a shutter speed of 1/125 of
a second, f/16, and ISO 100 results in an EV of 15. The same EV results from
halving the shutter speed to 1/250 second and doubling the aperture size to
f/11.

Photographic Exposure Lets you set the exposure using standard
camera-oriented controls. These controls affect exposure only: Shutter Speed
has no effect on motion blur; Aperture doesn’t influence depth of field; and
Film Speed has no effect on graininess.

■ Shutter Speed The duration, in fractions of a second, that the “shutter”
is open. The higher this value, the greater the exposure.

■ Aperture The size of the opening of the “camera iris,” expressed as a
ratio. The higher this value, the lower the exposure.

■ Film Speed (ISO) The sensitivity of the “camera film,” expressed as an
index. The higher this value, the greater the exposure.

Image Control group

Use these controls to adjust the relative brightness or highlights, midtones,
and shadows in the rendered image. The combination of these three settings
is depicted in the graph on the right side of the rollout. Additional controls
available here let you adjust color saturation, whitepoint, and vignetting.
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Rendering with default settings (with final gathering)

Highlights (Burn) Controls the level of the brightest areas of the image.
Higher values yield brighter highlights, while lower values darken the
highlights.
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Darkened (burnt-in) highlights

Midtones Controls the level of the areas of the image whose brightness lies
between the highlights and the shadows. Higher values yield brighter midtones,
while lower values darken the midtones.
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Elevated midtones

Shadows Controls the level of the darkest areas of the image. Lower values
yield lighter shadows, while higher values darken the shadows.
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Lightened shadows

Color Saturation Controls the intensity of colors in the rendered image.
Higher values result in more intense colors.
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Color Saturation=2.0

Whitepoint Specifies the main color temperature of the light sources. This is
similar to white balance controls on digital cameras. For daylighting, a value
of 6500 is recommended, for incandescent lighting, a value of 3700 is
recommended.

For example, photographs taken indoors might be lit by incandescent lights,
which are relatively orange compared to daylight. Defining "white" as daylight
will give unacceptable results when attempting to color-correct a photograph
taken with incandescent lighting.

Vignetting Reduces the image brightness in the image periphery compared
to the image center, resulting in a circular fully exposed area in the center,
with darker edges.
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Vignetting=25.0

Physical Scale Determines how the software calculates pixel values when
outputting HDR (high-dynamic-range) images. You can use the physical scale
inherent in the scene, or set an arbitrary physical scale for non-physically-based
lighting situations.

■ Physical Units: (cd/m2) Outputs physically correct HDR pixel values in
candelas per square meter. Use this option when lighting the scene with
photometric light sources.

TIP When you use this option, the renderer interprets all non-physical
(standard) illumination values in units of cd/m2. If you use as a background
image or texture map an HDR image with pixels correctly calibrated to cd/m2,
it will be correct in the scene. However, if you attempt to use a
low-dynamic-range photo such as a JPEG photo, it will appear too dark in the
rendered output. (The renderer interprets a white pixel in such an image as
"1 cd/m2" by default, which is darker than the deepest dungeon.) So you need
to increase the output on page 5774 of the image to match a useful cd/m2 value.
The sky can be around 3,000 cd/m2.

■ Unitless Lets you define how the renderer interprets the illumination
from standard lights, which are not physically based. Use the numeric
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setting to set the apparent illumination from these lights and the output
pixel values based on the scene lighting. For example, with the default
Physical Scale of 1500, a standard omni light is treated by the renderer as
a photometric isotropic light of 1500 candelas. Physical Scale is also factored
into the environment map and self-illumination.

NOTE This value does not affect apparent illumination of the rendered scene
with photometric lights. However, it does affect the apparent illumination cast
by non-physical (standard) lights. For predictable results, illuminate the scene
only with photometric or standard lights (not a mix), and use Physical Units
or Unitless, respectively.

Gamma/LUT Settings This group comprises text showing the status of the
current Gamma/LUT settings, and a Setup button that opens the Preference
Settings dialog to the Gamma and LUT panel on page 7758 so you can change
the settings.

Pseudo Color Exposure Control

Rendering menu > Environment > Environment and Effects dialog >
Environment panel > Exposure Control rollout > Choose Pseudo Color
Exposure Control from the list. > Pseudo Color Exposure Control rollout

Pseudo Color Exposure Control is actually a lighting analysis tool that provides
you with an intuitive way of visualizing and evaluating the lighting levels in
your scenes. It maps luminance on page 8029 or illuminance on page 8009 values
to pseudo colors that show the brightness of the values being converted. From
darkest to brightest, the rendering shows blue, cyan, green, yellow, orange,
and red. (Alternatively, you can choose a grayscale where the brightest values
are white, and the darkest are black.) The rendering includes the colored or
grayscale spectrum bar as a legend for the image.

After rendering the scene with pseudo color, 3ds Max displays a Rendered
Frame Window on page 6073 labeled “Illuminance,” with a legend of illuminance
values below the rendered image.

NOTE The Illuminance frame is not displayed if antialiasing is turned off.

NOTE You can use the Pseudo Color exposure control with the mental ray renderer
on page 6230.
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Pseudo color exposure of a scene with radiosity. Areas in red are overlit, areas in blue
are underlit, and areas in green have a good lighting level.

In the Rendered Frame Window labeled “illuminance,” a legend appears below
the image.

If you render a scene using this exposure control, the software creates a special
render element on page 6349 named Illuminance that helps obtain accurate
luminance and illuminance data.

TIP If you get a file write error when you try to render a pseudo color image,
check the path and file name of the Illuminance element, or the permissions of
the PNG file that saves the illuminance data.
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Three spheres at an equal distance from a light source. The sphere on the left has a
matte material, the sphere in the middle is glossy, and the sphere on the right is glossy
but has a much darker color.

A display of illuminance shows that it is the same for all three spheres.

A display of luminance shows that the two spheres on the left reflect about the same
amount of light, but the darker sphere on the right reflects little light except for its
highlight.
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See also:

■ Environment Panel on page 6689

Interface

Display Type group

Quantity Chooses the value being measured.

■ Illuminance (the default) displays values of light incident on surfaces.

■ Luminance displays values of light reflected off surfaces.

Style Chooses the way to display values.

■ Colored (the default) shows a spectrum.

■ Grayscale shows gray tones that range from white to black.
The spectrum bar displays the values the rendering will use.
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Pseudo color display style:

Left: Grayscale

Right: Colored scale

Scale Chooses the technique used to map values.

■ Logarithmic (the default) uses a logarithmic scale.

■ Linear uses a linear scale.
The Logarithmic scale is useful when the illumination of the surfaces of
interest is low compared to the maximum illumination in the scene.

Left: Linear scale

Right: Logarithmic scale

Display Range group

Minimum (Min.) Sets the lowest value to measure and represent in the
rendering. Values at this quantity or below it all map to the leftmost display
color (or grayscale level).

Maximum (Max.) Sets the highest value to measure and represent in the
rendering. Values at this quantity or above it all map to the rightmost display
color (or grayscale value).
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Physical Scale Sets a physical scale for exposure control to use with lights
that are not physically based. The result is an adjustment of the rendering
that approximates the eye's response to the scene.

Changing the value of Physical Scale is an optional step. Use it as a last resort
when the materials or maps are not rendering correctly. Changing this setting
will not affect anything in the scene unless your scene has an Ambient Color
different than black. If you do adjust it, set the Physical Scale value to the
equivalent of the brightest light source in the scene.

The software multiplies each standard light's Multiplier on page 8055 by the
Physical Scale value to produce a light intensity value in candelas. For example,
with the default Physical Scale of 1500, a standard omni light is treated by
the renderer and radiosity as a photometric isotropic light of 1500 candelas.
Physical Scale is also factored into reflections, refractions, and self-illumination.

TIP When you use ray-tracing with self illumination, set Physical Scale to the
equivalent of the brightest light source in the scene. This sets the appropriate
conversion scale for reflections, self-illumination, and all other non-physically based
elements a material offers. In some cases, an object might reflect or emit more
light than the brightest light object in the scene; in this case, use the object's
Luminance value as the Physical Scale.

Range=0.0 to 200,000.0 candelas. Default=1500.0.

A single candle is approximately 1 candela (the unit can also be called a
"candle"). A 100-Watt (W) incandescent light bulb is approximately 139
candelas (cd). A 60W bulb emitting in all directions is about 70 cd, while the
same bulb with a reflector is about 4500 cd because the light flux is
concentrated into a narrow angle.

Photometric lights are unaffected by the Physical Scale value.

This parameter is animatable.

Adjusting the range to analyze:
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Above: Correct range for a scene

Middle: Too narrow a range

Below: Too great a range

Narrowing the range to focus on a single object

General Guidelines for Physical Scale Values

■ If you use only Photometric lights on page 5005, IES Sun on page 5154, and
IES Sky on page 5157, the Physical Scale value is disregarded, and you don't
need to change it.

■ If you use Standard lights on page 5049, the Physical Scale value acts as a
conversion scale that the radiosity engine uses to calculate energy. Set it
to the equivalent of the brightest light source in the scene. This will set
the appropriate conversion scale for reflections, self-illumination, and all
other non-physically based elements a 3ds Max material offers.
However, if you use the Affect Indirect Only flag in the Logarithmic
Exposure Control on page 6740, you don’t need to worry about the physical
scale setting.

Spectrum bar Shows the spectrum-to-intensity mapping. The numbers below
the spectrum range from the Minimum to the Maximum settings.

When rendering with pseudo color, the spectrum bar is displayed beneath
the pseudo color image, labeled either Luminance or Illuminance.

Lighting Data Exporter Utility

Utilities panel > Utilities rollout > Lighting Data Export

The Lighting Data Exporter renders the active viewport to images that include
luminance on page 8029 and illuminance on page 8009 data that can be used for
lighting analysis.

The Lighting Data Exporter does not render the files unless you have applied
an exposure control on page 6732 to the scene.
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You can render to either the TIFF file on page 7372 format. If you export to a
TIFF file, the utility renders a single image file that has separate channels for
luminance and illuminance (the file is of the 32-bit SGI LogLUV image type).

You can also render to the PIC file on page 7359 format. If you export to a PIC
file, the utility renders two images: one containing luminance data, and the
other containing illuminance data (see the description of the File Name button,
below).

Interface

File Name Click the button to specify a file name for the rendering.

When you export to the PIC format, the Lighting Data Exporter renders two
files. It appends the string “_Illuminance” to the name of one file, and
“_Luminance” to the other. For example, if you type house as the file name,
the exporter renders to house_illuminance.pic and house_luminance.pic.

Image Size group

Width Sets the output width, in pixels. Default=640.

Height Sets the output height, in pixels. Default=480.

Export Click to render luminance and illuminance data.

WARNING Unlike the renderer, if you click Export more than once, this overwrites
previously rendered files.
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Atmospheric Apparatus

Create panel > Helpers > Atmospheric Apparatus (from drop-down list)

You can create three types of atmospheric apparatuses, or gizmos on page 7996:
box, cylinder, and sphere. These gizmos contain the fog or fire effect in your
scene.

BoxGizmo Helper on page 6762

CylGizmo Helper on page 6765

SphereGizmo Helper on page 6768

See also:

■ Fire Environment Effect on page 6696

■ Fog Environment Effect on page 6707

■ Volume Light Environment Effect on page 6721

Add Atmosphere Dialog

Select Atmospheric Apparatus object. > Modify panel > Atmospheres & Effects
rollout > Add button

The Add Atmosphere dialog lets you associate an atmosphere with the
Atmospheric Apparatus on page 6761.
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Interface

List of atmospheres Displays the atmospheres that you can associate with
the apparatus.

New or existing group

These radio buttons choose between new or existing atmospheres.

New Lists only new atmospheres.

Existing Lists only atmospheres that have been already assigned to other
apparatuses in the scene.

Adding an existing atmosphere creates a new atmosphere whose settings are
initially identical to the previous one.

BoxGizmo Helper

Create panel > Helpers > Atmospheric Apparatus (from drop-down list) >
BoxGizmo

Create menu > Helpers > Atmospherics > BoxGizmo
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BoxGizmo lets you create a box-shaped gizmo in your scene. Clicking the
BoxGizmo button displays the Box Gizmo Parameters rollout.

Box gizmo with volume fog

Procedures

To create the BoxGizmo:

1 Drag in a viewport to define the initial length and width, then release
the mouse and drag vertically to set the initial height.

2 Click to end BoxGizmo creation.

To add a new atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel, on the Atmospheres & Effects rollout, click Add.
This displays the Add Atmosphere dialog on page 6761.

3 Choose an atmosphere from the list.

4 Click OK.
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This associates a new atmosphere with the apparatus.

To add an existing atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel, on the Atmospheres & Effects rollout, click Add.
This displays the Add Atmosphere dialog on page 6761.

3 In the dialog, choose Existing.

4 Choose an atmosphere from the list.

5 Click OK.

This creates a duplicate atmosphere for the apparatus. Its settings are
initially identical to the atmosphere you chose. You can adjust them
using Setup.

Interface

Name and Color rollout

The Name and Color rollout on page 7631 lets you rename objects and change
their wireframe color.

Box Gizmo Parameters rollout

Length, Width, and Height Set the dimensions of the box gizmo.
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Seed Sets a base value used to generate the atmospheric effect. Each apparatus
in the scene should have a different seed. If more than one apparatus uses the
same seed and same atmospheric effect, they will produce nearly identical
results.

New Seed Click to generate a random number automatically and place it in
the seed field.

Atmospheres & Effects rollout

The Atmospheres & Effects rollout, available from the Modify panel, allows
you to add and set up atmospheres directly to the gizmo.

Add Displays the Add Atmosphere dialog on page 6761 from which you can
add an atmosphere to the BoxGizmo.

Delete Deletes a highlighted atmospheric effect.

Setup Displays the Environment panel on page 6689, where you can edit the
highlighted effect.

CylGizmo Helper

Create panel > Helpers > Atmospheric Apparatus (from drop-down list) >
CylGizmo

Create menu > Helpers > Atmospherics > Cylinder Gizmo
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CylGizmo lets you create a cylinder-shaped gizmo in your scene. Clicking the
CylGizmo button displays the Cylinder Gizmo Parameters rollout.

Cylinder gizmo with volume fog

Procedures

To create the CylGizmo:

1 Drag in a viewport to define the initial radius, then release the mouse
and drag vertically to set the initial height.

2 Click to end CylGizmo creation.

To add a new atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel on the Atmospheres & Effects rollout, click Add. This
displays the Add Atmosphere dialog on page 6761.

3 Choose an atmosphere from the list.

4 Click OK.
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This associates a new atmosphere with the apparatus.

To add an existing atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel on the Atmospheres & Effects rollout, click Add. This
displays the Add Atmosphere dialog on page 6761.

3 In the dialog, choose Existing.

4 Choose an atmosphere from the list.

5 Click OK.

This creates a duplicate atmosphere for the apparatus. Its settings are
initially identical to the atmosphere you chose. You can adjust them
using Setup.

Interface

Name and Color rollout

The Name and Color rollout on page 7631 lets you rename objects and change
their wireframe color.

Cylinder Gizmo Parameters rollout

Radius and Height Set the dimensions of the cylinder gizmo.

Seed Sets a base value used to generate the atmospheric effect. Each apparatus
in the scene should have a different seed. If more than one apparatus uses the
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same seed and same atmospheric effect, they will produce nearly identical
results.

New Seed Click to generate a random number automatically and place it in
the seed field.

Atmospheres & Effects rollout

The Atmospheres & Effects rollout, available from the Modify panel, allows
you to add and set up atmospheres directly to the gizmo.

Add Displays the Add Atmosphere dialog on page 6761 from which you can
add an Atmosphere to the CylGizmo.

Delete Deletes a highlighted atmospheric effect.

Setup Displays the Environment panel on page 6689, where you can edit the
highlighted effect.

SphereGizmo Helper

Create panel > Helpers > Atmospheric Apparatus (from drop-down list) >
SphereGizmo

Create menu > Helpers > Atmospherics > Sphere Gizmo

6768 | Chapter 21   Effects and Environments



SphereGizmo lets you create a sphere- or hemisphere-shaped gizmo in your
scene. Clicking the SphereGizmo button displays the Sphere Gizmo Parameters
rollout.

Sphere gizmo with volume fog

Procedures

To create the SphereGizmo:

1 Drag in any viewport to define the initial radius.

2 Adjust the radius with the spinner.

To add a new atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel on the Atmospheres & Effects rollout, click Add. This
displays the Add Atmosphere dialog on page 6761.

3 Choose an atmosphere from the list.

4 Click OK.
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This associates a new atmosphere with the apparatus.

To add an existing atmosphere:

1 Select the apparatus gizmo.

2 In the Modify panel on the Atmospheres & Effects rollout, click Add. This
displays the Add Atmosphere dialog on page 6761.

3 In the dialog, choose Existing.

4 Choose an atmosphere from the list.

5 Click OK.

This creates a duplicate atmosphere for the apparatus. Its settings are
initially identical to the atmosphere you chose. You can adjust them
using Setup.

Interface

Name and Color rollout

The Name and Color rollout on page 7631 lets you rename objects and change
their wireframe color.

Sphere Gizmo Parameters rollout

Radius Sets the radius of the default sphere.

Hemisphere When turned on, the bottom half of the SphereGizmo is
discarded, creating a hemisphere.
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Seed Sets a base value used to generate the atmospheric effect. Each apparatus
in the scene should have a different seed. If more than one apparatus uses the
same seed and same atmospheric effect, they will produce nearly identical
results.

New Seed Click to generate a random number automatically and place it in
the seed field.

Atmospheres & Effects rollout

The Atmospheres & Effects rollout, available from the Modify panel, allows
you to add and set up atmospheres effects directly to the gizmo.

Add Displays the Add Atmosphere dialog on page 5106 from which you can
add an Atmosphere to the SphereGizmo.

Delete Deletes a highlighted atmospheric effect.

Setup Displays the Environment panel on page 6689, where you can edit the
highlighted effect.
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Video Post

Video Post, available from the Rendering menu, lets you combine (composite) and render
output of various types of events, including the current scene, bitmap images, image-processing
functions, and so on.

A video post queue can include scene geometry, background images, effects, and masks for compositing
them.

22
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The result of video post: a composited frame

Video Post is a self-contained, modeless dialog, similar in appearance to Track View. The
edit window of the dialog shows when each event occurs in the finished video. Each event
is associated with a track that has a range bar.

The Video Post dialog contains the following window components:

Video Post Queue on page 6774: Shows the sequence of post-production events.

Video Post Status Bar/View Controls on page 6776: Shows information about the active Video
Post controls and lets you control the display of tracks in the event tracks area.

Video Post Toolbar on page 6797: Provides Video Post commands.

Video Post Queue
Rendering menu > Video Post > Video Post window > Video Post Queue

Video Post Queue provides a hierarchical list of the images, scenes, and events
to be composited.
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The Video Post queue in the Video Post dialog is similar to other hierarchical
lists in the Track View and Material Editor. In Video Post, the list items are
images, scenes, animations on page 7907, or external processes that together
make up the queue. The items in the queue are called events.

The order that the events appear in the queue is the order in which they are
executed, from top to bottom. Consequently, to correctly composite an image,
the background bitmap must appear before, or above, the image that is to
overlay it.

There is always at least one item in the queue (a placeholder labeled Queue).
It is the queue's parent event.

The queue can be linear, but some kinds of events, such as Image Layer,
combine other events and become their parent.

Procedures

To add an event to the queue:

■ Click an event button.
When you add an event, a dialog displays where you can specify settings
for that event. The settings offered on the dialog depend on the type of
event; some events have different kinds of subtypes.

In general, the new event appears at the end of the queue - but some kinds
of events require that you first select one or more events in the queue. An
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event button is unavailable if the selection in the queue (or the absence
of one) is not legal input to the button's type of event.

To highlight an event already in the queue, click its icon, label, or range-bar
area.

To delete any event in the queue:

■ Select the event and press the Delete key.
You can delete both enabled and disabled events, which are unavailable.

To switch the positions of two events in the queue:

1 Highlight both events.

2  Click Swap.

This operation might not be allowed if the result would be impossible to
execute. At the top level of the queue, you can almost always swap events;
at lower levels, an event's output must be legal input to its parent event.

To edit an event in the queue, do one of the following:

1 Select the event and click Edit Current Event on page 6799.

2 Double-click the event name.

3 Double-click the event's range-bar area in the edit window.

Use one of the second two methods for disabled events.

Video Post Status Bar / View Controls
Rendering menu > Video Post > Video Post Status Bar

The Video Post Status Bar contains an area for prompt and status information
and for buttons to control the display of tracks in the event tracks area.

Interface

Prompt Line
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Displays instructions for using the currently selected function.

Status (Start, End, Frames,Width, Height)

Displays the Start frame and End frame for the current event, the total number
of frames and the output resolution of the entire queue.

S/E Shows start and end frames of the selected track. If no track is selected,
shows the start and end frames of the entire queue.

F Shows the total frames in the selected track or for the entire queue.

W/H Shows the width and height of the image that results from the rendering
of all the events in the queue.

Pan

 Lets you drag horizontally in the event tracks area to shift the view left
and right.

Zoom Extents

 Adjusts the size of the event-track area horizontally so that all the frames
of the longest track bar are visible.

Use Zoom Extents to quickly reset the display to show all frames after zooming
in on a selection of frames with the Zoom Time button.

Zoom Time

 Displays a greater or lesser number of frames in the event tracks area,
allowing you to scale or zoom the display. The time ruler displays the current
time display unit.

Drag horizontally in the event tracks area to zoom time.

Drag right to display fewer frames in the track area (zoom in).

Drag left to display more frames in the track area (zoom out).
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Zoom Region

 Magnifies a region that you define by dragging a rectangle in the event
tracks area.

Troubleshooting Video Post
While Video Post offers many useful functions and creative effects, invariably
you will set up a queue that looks like it should work or even appears to render
correctly only to give you an animation that does not include the desired
effect. Here are some troubleshooting tips to reference when a queue just isn't
doing what you expect.

There are two key things that can cause a Video Post queue to fail. The first
is incorrect ordering and nesting of events in the queue. The second is faulty
positioning and/or overlapping of the range bars.

When you come up again a problem, especially if you're attempting to set up
a very complex queue, the best way to diagnose the problem is to create a new
queue that should only result in the effect that is failing. If you can get the
simplified queue to work, you can compare it to the structure of the failing
queue to see what might be out of order.

Here are two very common scenarios that look like they should work but
ultimately don't give you the result you expected. These examples are shown
in their simplified state, but could very easily be buried in more complex
queues.

■ The object simply disappears instead of fading out.
The first example illustrates a problem where you expect the scene to render
for fifteen frames before fading to black to finish the animation. However,
at frame sixteen, the scene abruptly goes black.
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This queue shows all the correct events in the proper order in the queue.
The problem is the timing and positioning of the range bars. The most
likely cause of this problem is using the Abut Selection on page 6808 when
it's not necessary. In order for the Fade event to work properly, it needs to
overlap the animation for the amount of time you want to fade to occur.
You need to take into account the number of frames where the scene
actually fades.

To fix this queue, you have to decide how many frames over which the
fade will occur. Let's say you want the scene to fade to black over ten
frames. You would need to drag the right end of the Perspective event
range bar ten frames to the right to overlap the Fade event.

■ The object glows during rendering, but not in the animation.
This second example is even more misleading than the first. The infuriating
thing about this problem is that while the scene is rendering, the object
in the scene shows the glow effect. When the resultant animation is played
back, the Glow effect is not present.
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Once again, this queue shows all the correct events, but the problem here
is the ordering of the events in the queue. This problem is commonly
caused when an event is selected while other events are being added. In
this case, the Perspective event was select when the Lens Effects Glow and
output events were added.

There are two ways to create this queue to give you the correct results. You
can recreate the queue and add each event so there is no nesting, or you
remove the current output event and add it again, making sure no other
events are selected. The following images show the two ways this queue
could be set up to successfully show the glowing object.
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Useful Video Post Procedures
Rendering menu > Video Post

There are some tasks that you will use Video Post for more than others. This
primer describes some of the more common sequences you'll find yourself
using Video Post to create. The procedures are outlined in their simplest forms.

The following procedures are outlined:

■ Make an object glow on page ?

■ Create an animation from a series of still images on page ?

■ Render a scene with a starfield on page ?

■ Set up a simple cross fade between two images on page ?

■ Resize a series of images on page ?

■ Composite two image sequences on page ?

■ Render a scene over an image sequence or an animation on page ?

■ Join two animations – end to end on page ?

■ Switch between views on page ?

■ Render a scene in reverse on page ?
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Procedures

Example: Make an object glow:

One of the most common things you'll want to do with the Glow filter is
make an object glow. Here's how to do it in its simplest form.

1 In the Perspective viewport, create a Sphere with a radius of about 30.

2 Choose Rendering > Video Post.

3  Click Add Scene Event on page 6808 and set the view to Perspective.

Click OK to close the Add Scene Event dialog.

4  Click Add Image Filter Event on page 6821 and choose Lens Effects
Glow from the Filter Plug-In list.

Click OK to close the Add Image Filter Event dialog.

5  Click Add Image Output Event on page 6828 and then click Files.

6 Set the output file format to BMP Image File and enter a filename like
MyGlow.

Click Save when you've set the name and format

7 Click OK to accept the default setting on the BMP configuration dialog.

Then click OK to close the Add Image Output Event dialog.

8 Right-click the Sphere to bring up the Quad Menus and select Properties.

9 Set the Object Channel in the G-Buffer group to 1 and click OK.

10  Click the Execute Sequence button on page 6802.

11 Click Render on the Execute Video Post dialog.

You'll see the a glowing sphere in the render window.
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Example: Create an animation from a series of still images:

Another common process you'll use Video Post to achieve is taking a series of
still images you've rendered and convert them to an animation. To accomplish
this task, you need an IFL file on page 7339.

1 Use the IFL Manager Utility on page 7344 to create an IFL file containing
the sequentially number image files you want to process.

2 Choose Rendering > Video Post.

3  Click Add Image Input Event on page 6814 and then click Files.

Choose the IFL file you created at step 1 and then click Open to close the
selection dialog.

4 Click OK to close the Add Input Image Event dialog.

5  Click Add Image Output Event on page 6828 and then click Files.

6 Set the output file format to AVI File on page 7326 and enter a filename
like MyAnimation.

Click Save when you've set the name and format

7 Select a codec on page 7936 from the Video Compression dialog and click
OK.

Then click OK to close the Add Image Output Event dialog.
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8  Click the Execute Sequence button on page 6802.

9 Click Render on the Execute Video Post dialog.

The final product is an animation.

Example: Render a scene with a starfield:

At some time, you'll want to create a night scene that requires a starry sky.
The key thing to remember when creating a star field is adding a camera to
the scene. The Starfield filter only works with a camera. Here are the steps to
set that up.

1 In the Top viewport, create a Sphere with a radius of about 30 and a
Target Camera.

Place the camera to one side and have it pointing at the center of the
sphere.

2 Right-click in the Perspective viewport and press C to change the viewport
display to Camera01.

3 Choose Rendering > Video Post.

4  Click Add Scene Event on page 6808 and make sure the view is set to
Camera01.

Click OK to close the Add Scene Event dialog.

5  Click Add Image Filter Event on page 6821 and choose Starfield from
the Filter Plug-In list.
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6 Click the Setup button to open the Stars Control dialog. Make sure Source
Camera (at the top) is set to Camera01, and then click OK.

7 Click OK to close the Add Image Filter Event dialog.

8  Click Add Image Output Event on page 6828 and then click Files.

9 Set the output file format to BMP Image File and enter a filename like
MyStarfield.

Click Save when you've set the name and format

10 Click OK to accept the default setting on the BMP configuration dialog.

Then click OK to close the Add Image Output Event dialog.

11  Click the Execute Sequence button on page 6802.

12 Set the time output to Single and click Render on the Execute Video Post
dialog.

The final product is a rendered image of a sphere against a starry
background.

Set up a simple cross fade between two images:

Sometimes you want to transition from one view or animation to another.
This set of steps with show you how to set up a cross fade from one image to
another. For this example the complete cross fade will occur over 20 frames
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displaying the first image for five frames, cross fade for ten frame and then
display the second image for the last five frames.

The resulting animation produced by this process could be used as an Image
Input Event for a different Video Post sequence.

1 Choose Rendering > Video Post.

2  Click Add Image Input Event on page 6814 and then click Files.

Choose your first image and click Open and then click OK to close the
Add Image Input Event dialog.

3  Click Add Image Input Event again and click Files.

Choose your second image and click Open and then click OK to close
the Add Image Input Event dialog.

4  Click Add Image Output Event on page 6828 and then click Files.

5 Set the output file format to MOV File and enter a filename like MyXFade.

Click Save when you've set the name and format

6 Click OK to accept the default setting on the Compression Settings dialog.

Then click OK to close the Add Image Output Event dialog.

7 Select the first Image Input Event and then hold down the Ctrl key while
selecting the second Image Input Event.

Both events will highlight in gold.

8  Click Add Image Layer Event on page 6824 and choose Cross Fade
Transition from the list of compositors and transitions.

Click OK to close the Add Image Layer Event dialog. Notice how the
Image Layer Event becomes the parent of the two Image Input Events.

9  Click Zoom Extents to view the entire set of tracks.

10 On the Queue track bar, click and drag the right-hand end of the range-bar
to frame 20.

This adjusts all the tracks.
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11 Select the Cross Fade Transition event and drag the left-hand end of the
range-bar to frame 5 and then drag the right-hand end of the range-bar
to frame 15.

This sets the period in time when the cross fade occurs.

12 Select the track for the first Image Input Event and the right-hand end
of the range-bar to frame 8.

By setting the end to frame 8 instead of 5, you'll have three frames during
which the first image will fade to black.

13 Select the track for the second Image Input Event and the left-hand end
of the range-bar to frame 12.

Similarly, setting this end to frame 12 ensures that the second image will
fade in over three frames and display in full color for the last five frame
of the transition.

14  Click the Execute Sequence button on page 6802.

15 Click Render on the Execute Video Post dialog.

Example: Resize a series of images:

Perhaps you've rendered a series of still images but it turns out they were at
the wrong resolution. You might normally think you have to re-render the
entire scene again which will tie up all the systems to do the same work they
just completed. Video Post can be used to resize the images without having
to use all the systems.

1 Use the IFL Manager Utility on page 7344 to create an IFL file containing
the sequentially number image files you want to resize.
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2 Choose Rendering > Video Post.

3  Click Add Image Input Event on page 6814 and then click Files.

Choose the IFL file you created at step 1 and then click Open to close the
selection dialog.

4 Click OK to close the Add Input Image Event dialog.

5  Click Add Image Output Event on page 6828 and then click Files.

6 Set the output file format for the new set of still images to TGA and enter
a filename like MyResize.

Click Save when you've set the name and format

7 Click OK to accept the default setting on the Targa Image Control dialog.

Then click OK to close the Add Image Output Event dialog.

8  Click the Execute Sequence button on page 6802.

9 On the Execute Video Post dialog, set the new output resolution you
want for the images and then click Render.

When the rendering is complete, you will have a new series of resized
images that have a name prefix of MyResize. So, if there were ten images
listed in the IFL file, there will be ten new images named MyResize0000.tga
through MyResize0009.tga stored in your image folder.
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Example: Composite two image sequences:

Compositing two sets of images together is one of the “workhorse” operations
of Video Post. This is commonly done when a project is nearing completion
and it lets you combine all the images your artists have been rendering.

1 Use the IFL Manager Utility on page 7344 to create an IFL file for each set
of images sequences you want to composite.

2 Choose Rendering > Video Post.

3  Click Add Image Input Event on page 6814 and then click Files.

Choose your first IFL file and click Open and then click OK to close the
Add Image Input Event dialog.

4  Click Add Image Input Event again and click Files.

Choose your second IFL file and click Open and then click OK to close
the Add Image Input Event dialog.

5  Click Add Image Output Event on page 6828 and then click Files.

6 Set the output file format to MOV File and enter a filename like
MyComposite.

Click Save when you've set the name and format

7 Click OK to accept the default setting on the Compression Settings dialog.

Then click OK to close the Add Image Output Event dialog.

8 Select the first Image Input Event and then hold down the Ctrl key while
selecting the second Image Input Event.

Both events will highlight in gold.

9  Click Add Image Layer Event on page 6824 and choose Alpha
Compositor on page 6909 from the list of compositors and transitions.

Click OK to close the Add Image Layer Event dialog. Notice how the
Image Layer Event becomes the parent of the two Image Input Events.

10  Click the Execute Sequence button on page 6802.

11 Click Render on the Execute Video Post dialog.
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Example: Render a scene over an image sequence or an animation:

This process in similar to the last one except you might have an animation
or series of still images you want to use as the background for your existing
scene.

1 Use the IFL Manager Utility on page 7344 to create an IFL file for the set of
images that will be the background for your current scene.

2 Choose Rendering > Video Post.

3  Click Add Image Input Event on page 6814 and then click Files.

Choose your IFL file or animation and click Open and then click OK to
close the Add Image Input Event dialog.

4  Click Add Scene Event on page 6808 and set the view to Perspective
or a Camera you have in the scene.

Click OK to close the Add Scene Event dialog.

5  Click Add Image Output Event on page 6828 and then click Files.

6 Set the output file format to AVI File and enter a filename like MyScene.

Click Save when you've set the name and format

7 Select a codec on page 7936 from the Video Compression dialog and click
OK.

Then click OK to close the Add Image Output Event dialog.
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8 Select the first Image Input Event and then hold down the Ctrl key while
selecting the Scene Event.

Both events will highlight in gold.

9  Click Add Image Layer Event on page 6824 and choose Pseudo Alpha
on page 6911 from the list of compositors and transitions.

Click OK to close the Add Image Layer Event dialog. Notice how the
Image Layer Event becomes the parent of the two Image Input Events.

10  Click the Execute Sequence button on page 6802.

11 Click Render on the Execute Video Post dialog.

Notice that the Image Input Event in this example is only ten frames
long. Normally, you'd choose a set of background images that equals the
number of frames in your scene. When this sequence is executed, as is,
the images in the IFL file will only appear for the first ten frames and
then disappear.

12 Select the Image Input Event just under the Pseudo Alpha layer event.

13  Add a Loop Event and set the number of times to 4.

The Image Input Event becomes further nested in the queue. If you want,
you can use the default Loop setting or change it to Ping Pong then click
OK to close the Add Loop Event dialog.

14  Click the Execute Sequence button again and render the scene.
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Join two animations—end to end:

If you're working in a production environment, you probably do not work on
an entire animation by yourself. Instead, you might work on one part while
other artists are working on other parts. At the end of the project, everyone's
animations need to be joined together.

1 Choose Rendering > Video Post.

2  Click Add Image Input Event on page 6814 and then click Files.

Choose your first animation file and click Open and then click OK to
close the Add Image Input Event dialog.

3  Click Add Image Input Event again and click Files.

Choose the next animation file and click Open and then click OK to close
the Add Image Input Event dialog.

4 Repeat the last step for any other animations that need to be joined.

5  Click Add Image Output Event on page 6828 and then click Files.

6 Set the output file format to MOV File and enter a filename like MyFinal.

Click Save when you've set the name and format

7 Click OK to accept the default setting on the Compression Settings dialog.

Then click OK to close the Add Image Output Event dialog.
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8 Select the first Image Input Event and then hold down the Ctrl key while
selecting the second Image Input Event.

Both events will highlight in gold.

9  Click the Abut Selected button on page 6808.

10 Repeat the last two step with subsequent Image Input Events.

11  Click Zoom Extents to view the entire set of tracks.

12 Select the Image Output Event and drag the right end of the range-bar
to match the total number of frames in the queue.

13  Click the Execute Sequence button on page 6802.

14 Click Render on the Execute Video Post dialog.

Switch between views:

It's not often that a final scene shows views from only one viewpoint. Either
the camera moves or there are multiple cameras from which images are
rendered. This sequence shows you how to switch from one camera view to
another.

1 In the Perspective viewport, create a Box with a length of 15, a width of
30 and a height of 15.

2 In the Top viewport, create two Target Cameras pointing at the box from
different angles.
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3 Right-click the viewport label in the Left viewport and choose Views >
Camera01.

4 Right-click viewport label in the Perspective viewport and choose Views
> Camera02.

5 Choose Rendering > Video Post.

6  Click Add Scene Event on page 6808 and set the view to Camera01.

Click OK to close the Add Scene Event dialog.

7  Click Add Scene Event again and set the view to Camera02.

Click OK to close the Add Scene Event dialog.

8 Select the first Scene Event and then hold down the Ctrl key while
selecting the second Scene Event.

Both events will highlight in gold.

9  Click the Abut Selected button on page 6808.

10 Click in an empty part of the queue to deselect the two Scene Events.

11  Click Add Image Output Event on page 6828 and then click Files.

12 Set the output file format to MOV File and enter a filename like MyViews.

Click Save when you've set the name and format

13 Click OK to accept the default setting on the Compression Settings dialog.

Then click OK to close the Add Image Output Event dialog.

14  Click the Execute Sequence button on page 6802.

15 Click Render on the Execute Video Post dialog.
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Render a scene in reverse:

It's not commonly done but when you need to render a scene in reverse you
could spend hours trying to accomplish it. Video Post makes it easy.

1 Choose Rendering > Video Post.

2  Click Add Scene Event on page 6808 and set the view to Perspective
or a camera in the scene.

3 In the Scene Range group, turn off Lock To Video Post Range and set the
Scene Start value to the last frame of animation.

4 Turn off Lock Range Bar To Scene Range and set the Scene End value to
0.
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5 Click OK to close the Add Input Image Event dialog.

6  Click Add Image Output Event on page 6828 and then click Files.

7 Set the output file format to AVI File and enter a filename like MyReverse.

Click Save when you've set the name and format

8 Select a codec on page 7936 from the Video Compression dialog and click
OK.

Then click OK to close the Add Image Output Event dialog.

9  Click the Execute Sequence button on page 6802.

6796 | Chapter 22   Video Post



10 Click Render on the Execute Video Post dialog.

Video Post Toolbar
Rendering menu > Video Post toolbar

The Video Post Toolbar contains tools for handling Video Post files (VPX files
on page 8165) and for managing the individual events displayed in the Video
Post queue and event tracks area.

New Sequence 

Rendering menu > Video Post > Video Post toolbar > New Sequence

The New Sequence button creates a new Video Post sequence by clearing
existing events from the queue.

You'll be prompted to confirm the deletion of any entries in the current queue.

Procedures

To create a new Video Post file:

■  Click New Sequence.
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WARNING This command erases all the current Video Post data.

Use New Sequence after you have saved to a different Video Post (VPX) file.
Choosing Video Post from the Rendering menu displays the Video Post data
(if any) saved with your 3ds Max scene.

Open Sequence 

Rendering menu > Video Post > Video Post toolbar > Open Sequence

The Open Sequence button opens a Video Post sequence stored on disk.

Video Post sequences contain all the information relating to the queue and
all associated settings and references. VPX files on page 8165 have the file
extension .vpx and are stored by default in the \3dsmax\vpost folder.

Procedures

To open an existing Video Post file:

■  Click Open Sequence.
Use the file selection dialog that appears to choose the VPX file you want
to execute or edit.

To import an existing Video Post sequence:

You can also use Open Sequence to import the Video Post queue from a 3ds
Max scene (MAX file).

1  Click Open Sequence.

2 On the Open Sequence dialog, change the Files Of Type setting to All
Files (*.*)

3 Browse to the folder where you store your MAX files.

4 Select the MAX file that contains the Video Post sequence you want to
execute or edit and click Open.

Video Post loads only the Video Post data from the existing .max file,
leaving your current scene unchanged.
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Save Sequence 

Rendering menu > Video Post > Video Post toolbar > Save Sequence

The Save Sequence button saves the current Video Post sequence to disk.

All of the Video Post configuration data, the queue events themselves, and
any queue event external data are saved in the MAX file. You can also save
the Video Post sequence to a separate file for sharing with other 3ds Max users.

Video Post sequence files contain all the information relating to the queue
and all associated settings and references. VPX files on page 8165 have the file
extension .vpx and are stored by default in the \3dsmax\vpost folder.

Procedures

To save the active Video Post data:

■  Click Save Sequence.
A file selection dialog appears to let you enter a name for the new Video
Post file.

By default, Save Sequence stores the VPX file to the \3dsmax\vpost
subdirectory. You can change the default path to another directory via the
Configure User Paths dialog > File I/O panel on page 7733.

Edit Current Event 

Rendering menu > Video Post > Video Post window > Select an event. > Video
Post toolbar > Edit Current Event

The Edit Current Event button displays a dialog that lets you edit the properties
of the selected event. The dialog depends on the type of event you've selected.
The controls in the edit dialogs are the same as those in the dialog you use to
add that type of event.

The top field in each event dialog is an editable label field. If the field is left
blank, the event uses its assigned label. If you enter an event name, the Video
Post Queue displays your event name in the field.

You can edit the following types of events:
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Add Scene Event  on page 6808

Add Image Input Event  on page 6814

Add Image Filter Event  on page 6821

Add Image Layer Event  on page 6824

Add Image Output Event  on page 6828

Add External Event  on page 6831

Add Loop Event  on page 6834

Procedures

To edit an event in the queue, do one of the following:

1  Select the event and then click the Edit Current Event button.

2 Double-click the event name.

3 Double-click the event's range-bar area in the edit window.

Use the second or third method above withdisabled events.

Delete Current Event 

Rendering menu > Video Post > Video Post window > Select an event. > Video
Post toolbar > Delete Current Event

The Delete Current Event button deletes the selected event from the Video
Post Queue.

You'll be asked to confirm event deletion.

Procedures

To delete any event in the queue:

■  Select the event and press the Delete key.
You can delete both enabled and disabled events, which are unavailable.
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Swap Events 

Rendering menu > Video Post > Video Post window > Select two events. >
Video Post toolbar > Swap Events

The Swap Events button switches the position of two selected events in the
queue.

This is useful if you have images in the wrong order for compositing. The
background image has to be first and the foreground image with the alpha
channel on page 7905 has to be second.

Procedures

To switch the positions of two events in the queue:

1 Highlight both events.

2  Click Swap.

Swap Events might not be allowed if the result would be impossible to execute.

In this sample queue, the two top level events, Front and Fade, could be
swapped. You can almost always swap events at the top level.
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However, at lower levels, where events start getting nested, the output of a
lower level event must be valid input to its parent event. In the sample queue,
the output of the Loop Once event would not be recognized by the Fade event,
so the Swap Events button remains inactive and you cannot swap them.

Execute Sequence 

Rendering menu > Video Post > Video Post toolbar > Execute Sequence

You execute the Video Post queue as the final step in creating a post-produced
video. Execution is different from rendering because rendering is done for
scenes only and you can use Video Post to composite images and animations
without including the current 3ds Max scene.

Although the Execute Video Post controls are similar to those of the Render
Setup dialog, the setting are independent, and do not affect each other.

During execution, you can move or close the rendered frame window, but
you cannot use the rest of 3ds Max until the execution is completed or
cancelled.

The rendering time for the last rendered frame in the Video Post sequence is
displayed in the prompt line of the main 3ds Max window.

Procedures

To execute the queue:

1  Click Execute Sequence.

An Execute Video Post dialog appears.

2 Set the time range and output size, and then click Render to create the
video.

3 When execution is done, click Close to dismiss the Video Post progress
dialog if it is still open.
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Interface

Time Output group

Select the frames to execute:

Single Current frame only.

You can execute a single frame only if it falls within the current range.

Range All the frames between and including the two numbers.

Every Nth frame Regular sample of frames. For example, enter 8 to execute
every 8th frame.

Output Size group

Format Choose Custom or a standard film or video format from the list. For
Custom, you can set the aperture width of the camera, the rendering output
resolution, and the image aspect ratio or pixel aspect ratio. When you choose
a standard format, the aperture width and aspect ratios are locked, but you
can change the resolution.

Width/Height Specify the width and height of the image, in pixels. For
Custom, you can set these two spinners independently. For other formats,
the two spinners are locked to the specified aspect ratio, so changing one
changes the other.

Resolution Buttons Specifies a preset resolution. Right-click a button to display
a subdialog on page 6804 that lets you change the resolution specified by that
button.
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Image Aspect Sets the aspect ratio of the image. As you alter the Image Aspect,
you also alter the Height value to maintain the correct aspect ratio. For standard
formats, the image aspect ratio is locked, and this spinner is replaced by a text
display.

If you lock the Image Aspect (by clicking the Lock button), Width and Height
are locked to each other, so that changing one changes the other to maintain
the image aspect ratio, and changing the Pixel Aspect value changes the Height
value to maintain the image aspect ratio.

Pixel Aspect Sets the aspect ratio of the pixels of the image. For standard
formats, the pixel aspect ratio is determined by the format and this spinner
is replaced by a text display.

If you lock the pixel aspect ratio (by clicking the Lock button), the Pixel Aspect
spinner is replaced by a text display. The Lock button is available only for the
Custom format.

Output group

Keep Progress Dialog Forces the Video Post Progress dialog to remain displayed
when the Video Post sequence has finished executing. By default, it closes
automatically. If this option is selected, you must click the Close button to
close the dialog.

Rendered Frame Window Displays the Video Post execution in a window
on the screen.

Net Render Enables network rendering on page 8057. If Net Render is turned
on, when you render you'll see the Network Job Assignment dialog on page
6481.

Configure Presets

Rendering menu > Video Post > Video Post toolbar > Execute Sequence >
Right-click any Resolution button. > Configure Presets dialog

If you use the Custom format for Execute Sequence on page 6802, you can change
the values for any preset resolution button by right-clicking the button.

If you use one of the standard formats, the Width and Height spinners are
locked to the standard's image aspect ratio, and the Aspect Ratio spinner is
replaced by a text display.

After you change these values and exit the Configure Presets dialog, you must
click the button to apply the new values to the Execute Sequence dialog.
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Interface

Width Specifies the width of the image, in pixels.

Height Specifies the height of the image, in pixels.

Aspect Ratio Sets the aspect ratio of the image. As you alter the Image Aspect
value, you also alter the Height value so that the correct aspect ratio is
maintained for the resolution.

Edit Range Bar 

Rendering menu > Video Post > Video Post toolbar > Edit Range Bar

The Edit Range Bar provides editing functions for the range bars that appear
in the event tracks area.

When Edit Range Bar is on, you can:

■ Select any event by clicking its range bar (it turns red when selected).

■ Move the range bar while maintaining its range by dragging in the middle
of the bar.

■ Change the start or end frame of the range by dragging either end of its
bar.

Procedures

To select a range bar, do one of the following:

1 Click the range bar in the event tracks area.

2 Click the associated event name or icon in the queue.
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To select multiple range bars:

1 Click a range bar.

2 Hold down Ctrl and click additional range bars.

To select multiple contiguous range bars:

1 Click a range bar.

2 Hold down Shift and click another range bar.

Both range bars you clicked and all range bars between them, if any, are
selected.

NOTE In a multiple selection, the last range bar you select becomes the
current event, displayed with red squares in its endpoints. The align
commands use the current event.

To move a range bar:

■ Click and drag the center of the range bar left or right.

To change the length of a range bar:

■ Click and drag one of range bar's endpoints left or right.
If multiple range bars are selected, dragging one endpoint changes all
selected range bars.

To change the number of frames in an event:

1 Double-click the range bar in the event tracks area or select the event and
click the Edit Current Event button.

2 Change the VP Start Time or VP End Time values.

Align Selected Left 

Rendering menu > Video Post > Video Post window > Select two or more range
bars. > Video Post toolbar > Align Selected Left

The Align Selected Left button left-aligns two or more selected range bars.

6806 | Chapter 22   Video Post



When you select two or more range bars, the last one selected is the current
event. The end boxes of the other events are white, while the end boxes of
the current event are red. When you click Align Selected Left, the current
event stays in place, and the remaining selected events are aligned to its left
end.

Procedures

To change the number of frames in an event, do one of the following:

1 Double-click the range bar in the event tracks area.

2 Click the Edit Current Event button in the toolbar.

Align Selected Right 

Rendering menu > Video Post > Video Post window > Select two or more range
bars. > Video Post toolbar > Align Selected Right

The Align Selected Right button right-aligns two or more selected range bars.

When you select two or more range bars, the last one selected is the current
event. The end boxes of the other events are white, while the end boxes of
the current event are red. When you click Align Selected Right, the current
event stays in place, and the remaining selected events are aligned to its right
end.

Procedures

To change the number of frames in an event, do one of the following:

1 Double-click the range bar in the event tracks area.

2 Click the Edit Current Event button in the toolbar.

Make Selected Same Size 

Rendering menu > Video Post > Video Post window > Select one or more
events. > Video Post toolbar > Make Selected Same Size
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The Make Selected Same Size button makes all selected events the same size
as the current event.

When you select two or more range bars, the last one selected is the current
event. The end boxes of the other events are white, while the end boxes of
the current event are red. When you click Make Selected Same Size, the current
event stays in place, and the remaining selected events are expand or shrink
to cover the same number of frames.

Procedures

To change the number of frames in an event, do one of the following:

1 Double-click the range bar in the event tracks area.

2 Click the Edit Current Event button in the toolbar.

Abut Selected 

Rendering menu > Video Post > Video Post window > Select events in the
queue. > Video Post toolbar > Abut Selected

The Abut Selected button places the selected events end-to-end, so that when
one ends the next one starts.

The selected events are placed end-to-end according to their order in the
queue.

Add Scene Event 

Rendering menu > Video Post > Video Post window > Make sure no events
are selected in the queue. > Video Post toolbar > Add Scene

Rendering menu > Video Post > Video Post window > Select a scene from the
Video Post Queue. > Video Post toolbar > Edit Current Event

The Add Scene Event button adds the scene in the selected camera viewport
to the queue. A Scene event is a view of the current 3ds Max scene. You can
choose which view to display and how to synchronize the scene with the final
video. Like Image Input events, Scene events place an image in the queue, but
a Scene event is the current 3ds Max scene and it must be rendered when you
execute the Video Post queue. The scene is rendered exactly as it would be by
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the scanline renderer on page 8116, with the additional options listed below.
The resulting scene image has an alpha channel on page 7905.

You can use multiple Scene events to show two views of the same scene
simultaneously or to cut from one view to another. If you have more than
one Scene event in the queue, and they occupy the same time range, composite
them with an Image Layer event on page 6824 such as Cross Fade or Simple
Wipe. Otherwise, the second Scene Event overwrites the first even though
your system has spent the time processing both events.

Procedures

To add a Scene event:

1 Make sure no events are selected in the queue.

2  Click Add Scene.

An Add Scene Event dialog appears.

3 Choose a view to use from the View list.

4 Click Render Setup to change rendering settings from the way you have
set them in the Render Setup dialog.

NOTE Unlike settings in the Execute Video Post dialog, changes you make
to the Scene event rendering options change the Render Setup dialog settings,
and vice-versa.

5 Set the Scene Range options and click OK.

The Scene event appears at the end of the queue.

To match the scene's frames with Video Post frames:

■ Make sure Lock To Video Post Range is selected.
Lock To Video Post Range is the default. Frames in the scene match Video
Post frames and have the same frame number. That is, frame 0 in the scene
is frame 0 in the Video Post dialog, frame 15 in the scene is frame 15 in
Video Post, and so on. The range bar for the Scene event represents which
portion of the scene is selected. If the range bar covers Video Post frames
25 to 35, executing the queue renders scene frames 25 to 35. Moving the
range bar for the scene is like moving a time window within the scene.

Other Scene Range options are disabled when Lock To Video Post Range
is selected.

Add Scene Event  | 6809



To offset the scene in time:

■ Select Lock Range Bar To Scene Range.
The Scene Start control is enabled but the Scene End control remains
disabled: synchronization is controlled by the Scene Start value and the
length of the range bar.

The Scene Start value is the scene frame number where playback begins.
If Scene Start is 0, frame 0 of the scene is the first frame played back; if
Scene Start is 12, frame 12 is the first frame to play, and so on.

The range bar length determines how many frames of the scene to play.
Dragging the end point of the range bar changes the length of the playback
range. Although Scene End is unavailable, its value updates to show the
frame number of the last scene frame that will be played.

Dragging the range bar changes where the scene is played within the final
video. For example, if you set Scene Start to 5 and move the range bar to
begin at Video Post frame 20, frame 5 is played at frame 20 of the final
video, and so on.

To offset the scene and change scene playback rate:

■ Turn off Lock Range Bar To Scene Range.
With Lock Range Bar to Scene Range off, both Scene Start and Scene End
are enabled. As before, Scene Start specifies the first scene frame to play.
Scene End specifies the last scene frame to play, and the length of the range
bar determines playback speed.

If the range bar specifies the same number of Video Post frames as there
are corresponding scene frames, then playback is at the scene's playback
rate. If the range bar specifies fewer frames, the scene is sped up. If the
range bar specifies more frames, the scene is slowed down. When it
executes, Video Post automatically skips frames or adds frames to control
the speed of scene playback.

For example, if Scene Start is frame 5 and Scene End is frame 35, the range
bar represents 30 frames overall. If the range bar covers only 10 Video Post
frames, scene playback is sped up to fit 30 frames into 10 of the final video.
If on the other hand, the range bar covers 120 frames, scene playback is
stretched to slow it down.

To render the full scene backwards:

1 Turn off Lock To Video Post Range.

2 Turn off Lock Range Bar To Scene Range.
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3 Set Scene Start to the last frame in the scene.

4 Set Scene End to the first frame in the scene.

The length of the range bar also determines the playback speed of the
reversed scene.

To add scene motion blur:

1 Select Scene Motion Blur in the Scene Event dialog.

2 Set the scene motion blur parameters.

The Scene event generates motion blur by simulating a camera with an
open shutter. It interpolates and then renders movement within a frame,
to generate a series of images of the moving object, instead of the default
single image.

Interface

The Add Scene Event and Edit Scene Event dialogs have the same controls.
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View group

Label Lets you edit the event name. A unique name can make the scene event
easier to distinguish in a long list of events.

Viewport Select the viewport you want to render.

Scene Options group

Enables various rendering effects.

Render Setup Displays a subset of the Render Setup dialog on page 6067
parameters. Changes you make here affect the Render Setup dialog as well.
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Scene Motion Blur Turns on the scene motion-blur on page 8117 effect for the
whole scene. This is different from object motion blur on page 8063, which
creates motion blur for individual objects in the scene.

When you render with Scene Motion Blur activated, the Render Progress dialog
tells you which subsample is being rendered. The information appears in
parentheses to the right of the "Rendering Image" text.

Duration Sets the virtual shutter speed for motion blur. When set to 1.0, the
virtual shutter is open for the entire duration between one frame and the next.
When set to a smaller number, such as 0.25, the number of subdivisions
specified in the Duration Subdivision field will be rendered within the specified
portion of the frame (in this example, in the first fourth of the duration
between one frame and the next).

Duration Subdivisions Determines how many sub-frame slices are rendered
within the Duration. The default is 2 slices, but you'll want at least 5 or 6 to
get a decent effect.

Dither % Sets the amount of dithering on page 7956 between blurred pixels of
overlapping frame slices. If Dither % is set to 0, no dithering occurs.

Scene Range group

Scene Start/End Sets the range of scene frames to be rendered.

Lock Range Bar to Scene Range Becomes available when you deselect Lock
To Video Post Range. When it's available, the End spinner is disabled and
locked to the Video Post range. When you change the Start spinner it
automatically updates the End spinner based on the Video Post range set for
this event.

If you turn off Lock Range Bar To Scene Range, you can change either Start
or End spinners to whatever you want. This allows you to keep your scene
range locked to its native length, and still provides flexibility for mapping an
arbitrary scene range to an arbitrary Video Post range.

Lock to Video Post Range Renders the same range of scene frames as Video
Post frames. You can set the Video Post range in the Execute Video Post dialog.

Video Post Parameters group

VP Start Time/End Time Sets the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.
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Enabled Toggles the event. When off, the event is disabled and Video Post
ignores it when rendering the queue. You must disable each event individually.
For example, disabling a composite layer event does not disable the composited
image events. The range bars of disabled events are unavailable in the event
track area.

Add Image Input Event 

Rendering menu > Video Post > Video Post window > Make sure no events
are selected in the queue. > Video Post toolbar > Add Image Input Event

Rendering menu > Video Post > Video Post window > Select an Image Input
Event. > Video Post toolbar > Edit Current Event

The Add Image Input Event adds a still or moving image to the scene. Image
Input events place an image in the queue, but unlike Scene events, the image
is either a file that was saved beforehand or a device-generated image.

The image can be in one of the following file formats:

AVI Files on page 7326

BMP Files on page 7328

CIN (Kodak Cineon) Files on page 7328

CWS (Combustion Workspace) Files on page 7329

GIF Files on page 7334

HDRI Files on page 7334

IFL Files on page 7339

MOV (QuickTime Movie) Files on page 7348

MPEG Files on page 7348

JPEG Files on page 7347

PNG Files on page 7360

PSD Files on page 7361

RLA Files on page 7364

RPF Files on page 7366

RGB (SGI Image) Files on page 7369
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TGA (Targa) Files on page 7370

TIFF Files on page 7372

YUV Files on page 7374

DDS Files on page 7330

Procedures

To add an Image Input event:

1 Make sure no events are selected in the queue.

2  Click Add Image Input Event.

An Add Image Input Event dialog appears.

3 Click Files to choose a bitmap or animation as the image, or click Devices
to choose an image-generating device.

If you click Files, a file dialog appears to let you choose the bitmap or
animation file.

If you choose Devices, a Select Image Input Device dialog appears. This
dialog has a list of installed device options.

4 Click Options to choose the size and placement of the image in the final
video frames.

An Image Input Options dialog appears.

5 Adjust other Image Input settings, and then click OK.

The Image Input event appears at the end of the queue.

TIP Think of images that share the same time range as layers, comparable
to matted film images in a compositor. Images that share a time range must
be composited with an Image Layer event on page 6824; otherwise, the second
image in the queue "overwrites" the first.

To align the input image, do one of the following in the Image Input Options
dialog:

1 Choose Presets and then click one of the preset alignment buttons.

2 Choose Coordinates and then enter the X,Y coordinates for the image's
location.
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The upper-left corner is (0,0) for both the input image and the output
frame. Increasing X moves the image to the right, and increasing Y moves
the image down. Negative values move the image in the opposite
direction. X and Y values specify pixels.

To set the input image size, do one of the following in the Image Input
Options dialog:

1 Choose Do Not Resize to maintain the image's original resolution.

2 Choose Resize To Fit to change the image size to match the output frame.

This can change the image resolution, causing it to be rescaled for every
frame.

3 Choose Custom Size and then enter the width and height of the image
in the output frame.

To control playback of an animated image:

1 In the Frames group of the Image Input Options dialog on page 6818, set
the input animation frame range and speed.

2 Turn on Loop At The End if you want the animation to repeat. Turn off
Loop At The End if you want the animation to stop after playback.

This option applies only when the input animation is shorter than the
final video.

Interface

The Add Image Input Event and Edit Image Input Event dialogs have the same
controls.
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Image Input group

Label Lets you give the event a unique name. A unique name can make the
image event easier to distinguish in a long list of events.

Files Lets you choose the bitmap or animation image file.

Devices Lets you choose an installed hardware input device; for example, a
digital disk recorder.

Options Displays the Image Input Options dialog on page 6818 to allow you to
set up alignment, size, and frame range for the input image.

Cache Stores a bitmap in memory. If you are using a single-image bitmap,
you can choose this option. Video Post won't reload or scale the image for
each frame.

Image Driver group

These buttons are available only when you choose a device as the image source.
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About Provides information on the source of the image-handler software used
to bring the image into 3ds Max.

Setup Displays a setup dialog specific to the plug-in. Some plug-ins might not
use this button.

Video Post Parameters group

VP Start Time/End Time Sets the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When this box is off, the event is
disabled and Video Post ignores it when rendering the queue. Each event must
be disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Image Input Options

Rendering menu > Video Post > Video Post window > Make sure no events
are selected in the queue. > Video Post toolbar > Add Image Input Event >
Select a file for input. > Options

The Image Input Options dialog contains controls for setting the image's size
and placement relative to the frames of video output. For animated input,
you also use it to synchronize the Image Input event with the frame sequence
of video output. The same dialog appears when you click Options from the
Mask area of the Filter Event and Layer Event dialogs.

Procedures

To align the input image, do one of the following in the Image Input Options
dialog:

1 Choose Presets and then click one of the preset alignment buttons.

2 Choose Coordinates and then enter the X,Y coordinates for the image's
location.

The upper-left corner is (0,0) for both the input image and the output
frame. Increasing X moves the image to the right, and increasing Y moves
the image down. Negative values move the image in the opposite
direction. X and Y values specify pixels.
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To set the input image size, do one of the following in the Image Input
Options dialog:

1 Choose Do Not Resize to maintain the image's original resolution.

2 Choose Resize to Fit to change the image size to match the output frame.

This can change the image resolution, causing it to be rescaled for every
frame.

3 Choose Custom Size and then enter the width and height of the image
in the output frame.

To control playback of an animated image:

1 In the Frames group, set the From, To and Step values.

2 Select Loop at the End if you want the animation to repeat. Clear Loop
at the End if you want the animation to stop after playback.

This option applies only when the input animation is shorter than the
final video.
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Interface

Alignment group

Presets Positions the image according to one of the preset buttons: Top-left,
Center, Top-right, and so on. Mutually exclusive with Coordinates.

Coordinates Positions the image according to coordinates you enter. Mutually
exclusive with Presets.

Size group

Do Not Resize Retains the image's original, stored dimensions.

Resize to Fit Resizes the image to the size of the Video Post rendered image
(default).

Custom Size Resizes the image according to width and height units you enter.
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Frames group

From/To Specifies the range of frames to use if the image input file is an
animation or video.

Step Sets the interval between the frames you want to use. For example, if
this spinner is set to 7, 3ds Max uses every seventh frame.

Loop at End Plays the frames from the beginning when the last frame is
reached. This will take effect if the frame range used is less than the Video
Post frame range.

Add Image Filter Event 

Rendering menu > Video Post > Video Post window > Make sure no events
are selected in the queue. > Video Post toolbar > Add Image Filter Event

Rendering menu > Video Post > Video Post window > Select a filter from the
Video Post Queue. > Video Post toolbar > Edit Current Event

The Add Image Filter Event provides image processing for images and scenes.
Several kinds of image filters are provided, see list below. For example, the
Negative filter inverts the colors of an image and the Fade filter fades an image
in or out over time.

An Image Filter event is usually a parent event with a single child (which can
itself be a parent with children), for example, a Scene event, an Image Input
event, a Layer event that contains Scene or Image Input events, or a Filter
event that contains Scene or Image Input events. You can also add an Image
Filter without a child event, in which case the Image Filter processes the result
of the previous events in the queue.

Available Image Filters

Contrast Filter on page 6837

Fade Filter on page 6838

Image Alpha Filter on page 6839

Lens Effects Filters on page 6840

Negative Filter on page 6841

Pseudo Alpha Filter on page 6842
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Simple Wipe Filter on page 6843

Starfield Filter on page 6844

Procedures

To add an image filter event:

1 Either select a valid child event, or make sure no event is selected in the
queue.

2  Click Add Image Filter Event.

An Add Image Filter Event dialog appears.

3 Choose the kind of filter you want from the Filter Plug-In list.

4 If the Setup button is enabled for this kind of filter, click Setup to set the
filter options.

5 Choose a mask if you want the filter to be masked or if the kind of filter
you're using requires it.

6 Adjust other Image Filter settings, and then click OK.

If you selected a child event, the Image Filter event becomes its parent.
If no event was selected, the Image Filter event appears at the end of the
queue.

To choose the mask file:

1 Click Files.

2 Use the file dialog to choose the mask file, and then click OK.

3 Choose the channel to use from the drop-down list of channels.

To position or resize the mask:

■ Click Options.
An Image Input Options dialog appears, identical to the dialog you use
with Image Input events.

If the mask is animated, you also use this dialog to specify its time range
and playback speed.
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Interface

The Add Image Filter Event and Edit Filter Event dialogs have the same
controls.

Filter Plug-In group

Label Lets you give the event a unique name. A unique name can make the
filter event easier to distinguish in a long list of events.

Filter List Lists the filter plug-ins on page 8092 you have installed.

See the separate help topics for a description of the filters that come with 3ds
Max by clicking any of the filters listed above.

About Provides version and source information specific to the plug-in.

Setup Displays a setup dialog specific to the plug-in. Some plug-ins might not
use this button.
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Mask group

Channels If you are using a bitmap as the mask file, you can use the Alpha
channel, the Red, Green, or Blue channel, Luminance, Z-Buffer, Material
Effects, or Object ID.

Files Select a file to use as a mask. The name of the selected file appears above
the Files button.

Options Displays an Image Input Options dialog on page 6818 where you can
set alignment and size, relative to the frames of video output. For animated
images, you can also synchronize the mask with the frame sequence of video
output. This is the same dialog used for Image Input Event options.

Enabled Enables the mask. If turned off, Video Post ignores any other mask
settings.

Inverted When turned on, the mask is inverted.

Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled
and Video Post ignores it when rendering the queue. Each event must be
disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Add Image Layer Event 

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer EventRendering menu
> Video Post > Video Post window > Select a Layer Event. > Video Post toolbar
> Edit Current Event

The Add Image Layer Event adds a compositing plug-in on page 8092 to layer
the selected images in the queue.

Provides compositing plug-ins that use the previous event in the queue as a
source, and composite the next event, using the parameters of the plug-in
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compositor. The list might include plug-ins for special transformations, such
as wipes, etc.

An Image layer event is always a parent event with two children. The children
can themselves be parents with children. The children of an Image Layer event
can be Scene events, Image Input events, Layer events that contain Scene or
Image Input events, or Filter events that contain Scene or Image Input events.

Available Image Layer Event Filters

Alpha Compositor on page 6909

Cross Fade Compositor on page 6910

Pseudo Alpha Compositor on page 6911

Simple Additive Compositor on page 6912

Simple Wipe Compositor on page 6913

Procedures

To add an image layer event:

1 Make sure the two child events are in the order you want the Image Layer
event to use them.

2 Select the two events.

Click to select the first event, then hold Ctrl and click to select the second.

3  Click Add Image Layer Event.

An Add Image Layer Event dialog appears.

4 Choose the kind of layer event you want from the Layer Plug-In
drop-down list.

5 If the Setup button is enabled for this kind of layer event, click Setup to
set the options.

6 Choose a mask if you want the layer event to be masked.

7 Adjust other Image Layer settings, and then click OK.

The Image Layer event becomes the parent of the two child events you
selected.
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To choose the mask file:

1 Click Files.

2 Use the file dialog to choose the mask file, and then click OK.

3 Choose the channel to use from the drop-down list of channels.

To position or resize the mask:

■ Click Options.
An Image Input Options dialog appears, identical to the dialog you use
with Image Input events.

If the mask is animated, you also use this dialog to specify its time range
and playback speed.

Interface

The Add Layer Image Event and Edit Layer Event dialogs have the same
controls.
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Layer Plug-In group

Label Lets you give the event a unique name. A unique name can make it
easier to distinguish the layer event in a long list of events.

Layer List Selects the compositor 3ds Max uses for layering the rendered
images in the queue. Alpha is the default compositor, but you can also choose
from any others you have installed. See the separate help topics for descriptions
of the compositors that come with 3ds Max.

About Provides version or source information specific to the plug-in on page
8092.

Setup Displays a setup dialog specific to the plug-in. Some plug-ins might not
use this button.

Mask group

Channels If you are using a bitmap as the mask file, you can use the Alpha
channel, the Red, Green, or Blue channel, Luminance, Z-Buffer or Material
Effects channel, or Object ID.

Files Select a file to use as a mask. The name of the selected file appears above
the Files button.

Options Displays the Image Input Options dialog on page 6818 where you can
set alignment and size, relative to the frames of video output. For animated
images, you can also synchronize the mask with the frame sequence of video
output. This is the same dialog used for Image Input Event options.

Enabled Enables the mask. If turned off, Video Post ignores any other mask
settings.

Inverted When turned on, the mask is inverted.

Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled
and Video Post ignores it when rendering the queue. Each event must be
disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.
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Add Image Output Event 

Rendering menu > Video Post > Video Post toolbar > Add Image Output Event

Rendering menu > Video Post > Video Post window > Select an Image Output
event. > Video Post toolbar > Edit Current Event

The Add Image Output Event provides controls for editing an output image
event.

Image Output events send the result of executing the Video Post queue to a
file or a device. You must add an Image Output event to the end of the queue
if you want to save the final video. Otherwise, the results are displayed in the
rendered frame window only. The Image Output event's range bar must include
the entire range of frames you want to output.

The rendered output can be a still image or an animation, in one of the
following file formats:

AVI Files on page 7326

BMP Files on page 7328

CIN (Kodak Cineon) Files on page 7328

EPS and PS (Encapsulated PostScript) Files on page 7332

HDRI Files on page 7334

JPEG Files on page 7347

PNG Files on page 7360

MOV (QuickTime Movie) Files on page 7348

RLA Files on page 7364

RPF Files on page 7366

RGB (SGI Image) Files on page 7369

TGA (Targa) Files on page 7370

TIFF Files on page 7372

You also have the option to direct the output to a VTR controller output
device. If you have multiple output image events, you can output to different
devices. This lets you monitor your queue with VTR output devices and view
your output at any level of the Video Post queue during rendering.
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Procedures

To add an image output event:

1  Click Add Image Output Event.

Image Output disregards whether any events in the queue are selected
or not.

2 Click Files to save the final video in a file, or Devices to send the video
to a device.

If you click Files, a file dialog appears to let you choose the bitmap or
animation file.

If you choose Devices, a Select Image Output Device dialog appears. This
dialog has a drop-down list of installed device options.

3 Adjust other parameters, and then click OK.

The Image Output Event appears at the end of the queue.

If you choose a device, its configuration controls are enabled:

Interface

The Add Image Output Event and Edit Output Image Event dialogs have the
same controls.
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Image File group

Label Lets you give the event a unique name. A unique name can make it
easier to distinguish the output event in a long list of events.

Files Lets you choose the output image file and its format.

Devices Lets you choose the hardware output device; for example, a digital
video recorder. The device, its driver, and its 3ds Max plug-in must all be
installed on your system to use device output.

Image Driver group

The two buttons in this area are available only when you choose a device as
the image source.

About Provides information on the source of the image-handler software used
to create the image from 3ds Max.

Setup Displays device-specific setup options.
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Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled
and Video Post ignores it when rendering the queue. Each event must be
disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Add External Event 

Rendering menu > Video Post > Video Post toolbar > Add External Event

Rendering menu > Video Post > Video Post window > Select an External event.
> Video Post toolbar > Edit Current Event

An External event is typically a program that performs image processing. It
can also be a batch file or utility that you want to run at a specific point in
the queue, or a way to transfer images from or to the Windows clipboard.

An External event is always a child event. If you select an event in the queue
before you add the External event, the External event becomes the selected
event's child. Child events are evaluated before their parents.

Procedures

To add an external event:

1 Select an event.

2  Click Add External Event.

An Add External Event dialog appears.

3 Click Browse.

A file dialog appears.

4 Use the file dialog to choose the external program you want to execute,
and then click OK.
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5 If the external program accepts command-line options, enter these in
the Command Line Options field.

6 If you want the external program to read the current Video Post image,
turn on Write Image To Clipboard.

7 If you want Video Post to use the result of the external program, turn on
Read Image From Clipboard.

8 Click OK.

If you selected an event, the External event becomes its child. If no event
was selected, the External event appears at the end of the queue.

WARNING The image that the External event reads from the clipboard is placed
in the Video Post queue. If the external program does not do what you want, this
can erase or overwrite the result of all Video Post post-processing.

Interface

The Add External Event and Edit External Event dialogs have the same controls.
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External Event group

Label Lets you give the event a unique name. A unique name can make the
external event easier to distinguish in a long list of events.

Browse Lets you select an external program. For example, you can specify
Adobe Photoshop™ or another image-processing application.
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Command-Line Options group

For external programs that accept command-line options, lets you send
real-time data to the external program. 3ds Max parses three special commands.
When found in a string, these commands are replaced with real-time data, as
follows:

■ %f is replaced with a 4-digit frame number (for example, 0001)

■ %w is replaced with a 4-digit image width (for example, 0640)

■ %h is replaced with a 4-digit image height (for example, 0480)

For example, if the given command-line option is:

-w%w -h%h -oframe%f.tga

The string sent to the external program might be:

-w0640 -h0480 -oframe0001.tga

Write image to clipboard When on, writes the current rendered image to
the Windows clipboard for retrieval by an external application.

Read image from clipboard When on, reads the contents of the Windows
clipboard after processing by the external application. When the processed
image is saved to the clipboard, it automatically appears in Video Post. With
an automated script, it is possible to run the image through any external image
processor and get it back automatically.

Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled
and Video Post ignores it when rendering the queue. Each event must be
disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Add Loop Event 

Rendering menu > Video Post > Video Post toolbar > Add Loop Event
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Rendering menu > Video Post > Video Post window > Select a Loop event. >
Video Post toolbar > Edit Current Event

Loop events cause other events to repeat over time in the output video. They
control sequencing, but perform no image processing.

A Loop event is always a parent event with a single child. The child itself can
be a parent with children. Any type of event can be the child of a Loop event,
including another Loop event.

The Loop event's range bar displays the original duration of the child event's
playback in color and the range of looped events in gray. You can change the
duration of the child event's playback by dragging the child's frame range or
the child's original range in the Loop event's track, but you can adjust the full
length of the loop (the gray part of the range bar) only by changing the
Number of Times parameter in the Edit Loop Event dialog.

Procedures

To add a loop event:

1 Select the child event.

2  Click Add Loop Event.

An Add Loop Event dialog appears.

3 Choose the loop settings, and then click OK.

The Loop event appears as the parent of the selected event.

The Loop event repeats the child event over the course of the Loop event's
range.

Interface

The Add Loop Event and Edit Loop Event dialogs have the same controls.
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Order group

Label Lets you give the event a unique name. A unique name can make it
easier to distinguish the loop event in a long list of events.

■ Loop (The default.) Repeats the child event by starting it over when the
child event reaches the end of its range.

■ Ping Pong Repeats the child event by playing it first forward, then
backward, then forward, and so on. The last frame of the child event is
not repeated.

Number of Times group

Specifies the number of times to repeat the loop or ping pong, in addition to
the first time that the child event is played.
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Video Post Parameters group

VP Start Time/End Time Set the starting and ending frames for the selected
event within the overall Video Post queue. Video Post renders the event over
the number of frames specified here.

Enabled Enables or disables the event. When turned off, the event is disabled
and Video Post ignores it when rendering the queue. Each event must be
disabled individually. For example, disabling a composite layer event does
not disable the composited image events. The range bars of disabled events
are unavailable in the event track area.

Filter Events

Contrast Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Contrast Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Contrast Filter.
> Video Post toolbar > Edit Current Event > Setup

The Contrast filter allows you to adjust the contrast and brightness of an
image.

Interface

Contrast Set the spinner between 0 and 1.0. This compresses or expands the
latitude between maximum black and maximum white by creating a 16-bit
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look-up table for any given gray value in the image. The computation of the
gray value depends on whether you select Absolute or Derived.

Brightness Set the spinner between 0 and 1.0. This increases or decreases all
color components (red, green, and blue).

Absolute/Derived Determines the computation of the gray value for Contrast.
Absolute uses the highest value of any of the color components. Derived uses
an average of the three color components.

Fade Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Fade Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Fade Filter. >
Video Post toolbar > Edit Current Event > Setup

The Fade filter fades an image in or out over time. The rate of the fade is
determined by the length of the Fade filter's time range.

Fade fades out to black or in from black, over time.
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Interface

In Fade in.

Out Fade out.

Image Alpha Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Image Alpha Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select an Alpha Filter.
> Video Post toolbar > Edit Current Event

The Image Alpha filter replaces the image's alpha channel with the channel
specified by the filter mask.

The filter takes whatever channel is selected in the channel options under
Mask (including g-buffer on page 7991 channel data) and applies it to the queue's
alpha channel, thereby replacing what's there.

If you don't choose a mask, this filter has no effect.

There are no setup options for this filter.

Procedures

To set an object's G-Buffer ID:

1 Select the object.

2 Right-click the object and then choose Properties on page 305 from the
popup menu.

3 In the Object Properties dialog, set G-Buffer Object Channel to a nonzero
value, and then click OK.
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The G-Buffer ID can be any positive integer.

If you give the same G-Buffer ID value to more than one object, all these
objects will be post-processed.

Lens Effects Filters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose a Lens Effects Filter from the Filter Plug-In list.

The Lens Effects filters add realistic camera flares, glows, gleams, glimmers,
and depth-of-field blurring to your scenes. Lens Effects can affect an entire
scene or can be generated around specific objects in your scene.

Lens Effects are applied through the Video Post interface. To learn about
adding scene and image filter events to the video post queue, see Add Scene
Event on page 6808, and Add Image Filter Event on page 6821.

Lens Effects includes the following filters:

■ Lens Effects Flare on page 6849: Creates the optical effect that occurs when
a bright light reflects across the lens of a camera.

■ Lens Effects Focus on page 6871: Creates a blur on objects based on their
distance from the camera. tracks an object’s distance from the camera
using a Z-Buffer. Focus uses the Z-Buffer information from the scene to
create its blurring effects.

■ Lens Effects Glow on page 6875: Creates a glowing light around any assigned
object, such as a laser beam or the thruster on a space ship.

■ Lens Effects Highlight on page 6887: Creates a bright cross star effect on a
designated object.

WARNING When you animate Lens Effects parameters, this creates pointers into
the actual scene, so Lens Effects animation is lost if you save the Video Post queue
in a VPX file on page 8165. To preserve the animation, save the Video Post data,
including Lens Effects animation, in the MAX file.

Procedures

Len Effects like Glow and Highlight can be set to affect specific objects in your
scene based on their G-Buffer ID on page 7991. This lets you apply glows and
highlights to the object, or to the material, or both.
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To set an object's G-Buffer ID:

1 Select the object.

2 Right-click the object and then choose Properties from the quad menu.

3 In the Object Properties dialog, set G-Buffer Object Channel to a non-zero
value, and then click OK.

The G-Buffer ID can be any positive integer.

If you give the same G-Buffer ID value to more than one object, all these
objects will be post-processed.

Negative Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Negative Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Negative Filter.
> Video Post toolbar > Edit Current Event > Setup

The Negative filter inverts the colors in the image, making it negative like a
negative color photograph.

Effect of negative filter

When you click the Setup button in the Edit Filter Event dialog for the Negative
filter, the Video Post dialog is replaced by a modeless Negative Filter dialog
with a Blend spinner. You can turn on Auto Key, move the time slider, and
change the Blend value to create keys. (You can also use other 3ds Max
functions; for example, you can create objects.) When you've set all the keys
you want, click the OK button to return to Video Post.
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After creating keys from the Video Post filter, you'll find the track for the new
keys as a child of the Video Post track in the Track View – Curve Editor.
Specifically, in the above example, you'll find the following hierarchy in the
Curve Editor:

Interface

Blend Sets the amount of blending that occurs.

Pseudo Alpha Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Pseudo Alpha Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Contrast Filter.
> Video Post toolbar > Edit Current Event

The Edit Pseudo Alpha filter creates an alpha channel for the image based on
the image's first pixel (the upper-left corner pixel). All pixels that have the
same color as this pixel become transparent.
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Because only one pixel color becomes clear, edges of the opaque areas are
aliased. The main use for this filter is when you want to composite a bitmap
whose format does not have an alpha channel.

There is also a layer event called the Pseudo Alpha Compositor on page 6911.

There are no setup options for this filter.

Simple Wipe Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Simple Wipe Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Simple Wipe
Filter. > Video Post toolbar > Edit Current Event > Setup

The Simple Wipe filter reveals or erases the foreground image with a wipe
transition. Unlike the Wipe Layer compositor on page 6913, Wipe Filter wipes
across a fixed image.

Wipe reveals an image by wiping from one side to the other, over time.

This filter wipes from image to image (or from an image to black). The filtered
image stays in place, but is revealed or erased with a wipe across the image.
If you're using a Wipe as a filter event, you'll usually want to use an Alpha
Compositor as a layer event as well.

A typical queue sequence would be: Alpha Compositor (layer)

-->Image #1

-->Simple Wipe (filter)

------>Image #2
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The rate of the wipe is determined by the length of the Wipe filter's time range.
The area not covered by the image renders as black unless you use an Image
Layer event to composite the Wipe filter with another image.

Interface

Direction group

Right-pointing arrow Wipes from left to right.

Left-pointing arrow Wipes from right to left.

Mode group

Push Reveals the image.

Pop Erases the image.

Starfield Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Starfield Filter from the Filter Plug-In list.

Rendering menu > Video Post > Video Post window > Select a Starfield Filter.
> Video Post toolbar > Edit Current Event > Setup

The Starfield filter generates a realistic starfield with optional motion blur.
The Starfield filter requires a camera view. Any motion of the stars is a result
of camera motion.
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Procedures

To use the Starfield filter:

1 Create a camera and (optionally) animate the camera's or target's position,
field of view, and roll.

2 Choose Rendering > Video Post and add a Scene Event, using the camera
for the view.

3  Select the Scene Event in the queue, click Add Image Filter, select
the Starfield filter, and click the Setup button.

4 In the Stars Control dialog, make sure that the selected camera matches
the camera used in the Scene Event.

If these don't match, the stars will not match the camera's motion. If
there is only one camera in the scene, the field will default to that camera.

5 Set the starfield parameters, then exit the Stars Control dialog and the
Edit Filter Event dialog.

6 Execute the Video Post sequence to see stars.
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Interface

Source Camera group

Source Camera Lets you choose from a list of cameras in the scene. Choose
the same camera as the one being used to render the scene.

General group

Set the brightness range and size of the stars.

Dimmest Star Specifies the dimmest star. Range = 0 to 255.

Brightest Star Specifies the brightest star. Range = 0 to 255.

Linear/Logarithmic Specifies whether the range of brightness is calculated
linearly or logarithmically.
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Star Size (Pixels) Specifies the size of the stars, in pixels. Range = 0.001 to
100.

Motion Blur group

These settings control the streaking effect of the stars when the camera moves.

Use When on, the starfield uses motion blur. When off, the stars appear as
dots, no matter what the camera's motion.

Amount The percentage of the frame time that the camera "shutter" is open.
Default = 75%.

Dimming Determines how the streaked stars will dim as their trails lengthen.
The default of 40 provides a good effect for video, dimming them a bit so they
don't appear to flash.

Star Database group

These settings specify the number of stars in the starfield.

■ Random Generates the number of stars indicated by the Count spinner,
using the random number Seed to initialize the random number generator.
Seed
Initializes the random number generator. By using the same Seed value in
different animations, you're guaranteed identical starfields.

Count
Specifies the number of stars generated when Random is chosen.

■ Custom Reads the file specified. A provided star database, earth.stb,
contains the brightest stars in Earth's sky.

Compositing group

■ Background (The default.) Composites the stars in the background.

■ Foreground Composites the stars in the foreground.
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Lens Effects Filters

Animating Lens Effects Properties

Lens Effects lets you use Track View to control parameters which can be
animated while Video Post remains open. Any parameter with a green arrow
button next to it can be animated.

When the Auto Key button is selected, the associated spinner or variable is
displayed in Track View and can be animated. If it is not selected, the green
button turns gray to indicate the parameter can no longer be animated.

There are two ways to set Lens Effects parameters for use in animation:

■ Enable the Auto Key button, set the frame in which you want to create a
key, and set the value.

■ Use Track View.

Using Track View

To use Track View with Lens Effects, one of the Lens Effects dialogs for a
particular filter must be open when you start Track View.

NOTE If you open Track View without one of the Lens Effects dialogs being open,
the first Lens Effects object does not appear in the Track View List. If you have
more than one Lens Effects object in the scene, you will see multiple Lens Effects
objects in Track View.

When Track View is open, the Lens Effects filters you have applied are listed
under Video Post on the left side of the Track View interface. Under each filter
are the parameters which can be animated. These are displayed individually.
You can animate only the parameters you need to.

When viewing Gradients in Track View, notice that the first two flags have
only a color track associated with them. This is because they are the start and
end points of the gradient and never move. Any flags created after the first
two will also have a position track associated with them. This means that you
can animate not only the color of any flag in any gradient, but also its position
over time as well.
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If you disable the animation capabilities for a particular lens flare parameter,
the corresponding entry in Track View immediately disappears. For more
information, see Track View on page 3503.

WARNING When you animate Lens Effects parameters, this creates pointers into
the actual scene, so Lens Effects animation is lost if you save the Video Post queue
in a VPX file on page 8165. To preserve the animation, save the Video Post data,
including Lens Effects animation, in the MAX file.

Lens Effects Flare Filter

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup

The Lens Effects Flare dialog lets you add lens flare effects as a post process to
rendering. Flares are usually applied to lights in your scene. The lens flare will
then be generated around that object. You can control all aspects of the lens
flare in the Lens Effects Flare dialog.

Procedures

To save your flare settings, do one of the following:

You can save all of your lens flare settings to a file, so you can reload them
any time. Lens Effects Flare files are saved to an LZF file on page 8029 (.lzf).

1 Click the Reset button.

This resets Lens Effects Flare to its default settings.

2 Click the Load button.

This displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

3 Click the Save button.

This displays a Windows-standard Save As dialog in which you specify a
directory and filename.
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Interface

Preview group

The large black window in the left corner is the main preview window. To the
right of this window are smaller preview windows for each part of the flare.
You can generate continual previews by clicking the Preview button under
the main preview window.

There are nine Lens Effects Flare preview windows. The main preview window
in the upper left corner of the Lens Effects dialog shows you the complete
scene. The eight smaller preview windows in the upper right corner show the
individual parts of the lens flare. Each small preview window has a check box
below the window to display the flare effect.

You might notice that an individual part of the lens flare effect might not
appear as bright in the smaller preview windows, compared to the main
preview. This is because the brightness of a lens flare in the main preview is
a result of combining the brightness of multiple effects, the total brightness
being greater than a single part.

All of the preview windows are multi-threaded to increase redraw speed and
take advantage of multi-processor systems. When you make an adjustment
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to a lens flare property and the preview window is active, the preview updates
automatically. A white line at the bottom of the main preview window
indicates that it is updating a change made within the lens flare dialog.

Preview When you click the Preview button, the window displays your flare
in the upper left corner if your flare has automatic or manual secondary
elements. If your flare does not contain these elements, the flare is centered
in the preview window. If the VP Queue button is not on, the preview displays
a generic flare to which you can make adjustments. Each time you change a
setting, the preview automatically updates. A white line appears at the bottom
of the preview window to indicate the preview is updating.

Update Redraws the entire Main Preview window, as well as the smaller
windows each time you click this button. This function is critical when you
need to view changes you have made in the Video Post queue, such as moving
the Time Slider to a different frame, changing your geometry or a light, or
changing another filter that precedes the current one in the Video Post queue.
The VP Queue button must be on to preview the contents of the Video Post
queue. In this case, clicking the Update button causes a small dialog to appear,
with an indicator showing the progress of the update.

VP Queue Displays the contents of the Video Post queue in the main preview
window. The Preview button must also be turned on. Rather than having to
test render every time you want to see the result of the effect in the scene, VP
Queue displays a final composite, combining the effect you are editing with
the contents of the Video Post queue.

NOTE If you leave the Preview and VP Queue buttons active when you exit Lens
Effects Flare, it will take several seconds to re-render the scene in the main preview
window the next time you start Lens Effects Flare.

The view in the main preview window also depends upon which lens flare
options you have set in the Preferences panel on page 6854.

Lens Flare Properties group

Specifies global settings for the flare, such as the source for the flare(s), the
size, seed number, rotation, and so on.

Seed Gives the random number generator in Lens Effects a different starting
point, which creates slightly different lens flares without changing any settings.
Using Seed guarantees a different lens flare, even if the differences are very
small. For example, if you set up a ray effect for your lens flare, you will get
slightly different rays in the lens flare if you adjust the seed value.
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Size Affects the size of the overall lens flare. This value is a percentage of the
size of the rendered frame. Default = 30.

Other parts of the lens flare, such as glow, ring, etc., also have size adjustments,
but this size setting affects the entire lens flare, including secondary flares.
Adjusting individual sizes does not affect this size variable, or vice versa. This
parameter can be animated on page 6848. Animating the Size parameter causes
flares to grow or diminish in size over the course of your animation.

Hue If Apply Hue Globally is selected, it controls the amount of Hue applied
to the Lens Flare effect. This parameter can be animated.

Apply Hue Globally Globally applies the Hue of the Node Source to the other
Flare effects.

Angle Affects the amount that the flare rotates from its default position, as
the position of the flare changes relative to the camera. This parameter can
be animated. The lock button to the right of the Auto Key button locks the
secondary flares so they do rotate. When the button is disabled, the secondary
flares will not rotate.

Animating the Angle parameter does not animate the manual and automatic
secondary flares unless you turn on the L button. The default behavior mimics
a camera, in which the aperture does not rotate.

Rays, stars, and streaks don't animate either unless you turn on their individual
Auto Rotate toggles.

Intensity Controls the overall brightness and opacity of the flare. Higher
values produce bright, more opaque flares, and lower values produce dim,
transparent flares. This parameter can be animated.

Squeeze Squeezes the size of the lens flare, either horizontally or vertically to
compensate for different frame aspect ratios. You can set Squeeze from 100
to -100. Positive values stretch the flare horizontally, and negative values
stretch it vertically. The value is a percentage of the size of the flare. This
parameter can be animated.

For example, if you convert a film for use on TV, applying Squeeze would
cause the lens flare to look correct on the smaller screen, and not thin and
tall, although a wide-screen 35-MM film image is much wider than a regular
TV.

Although Squeeze is a global setting, you can apply this effect to selected
portions of your flare through the Preferences panel on page 6854 so that only
the flare elements you want are distorted. The Squeeze spinner value is given
as a percentage of the size of the flare.
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Node Sources Lets you select the source object for the lens flare effect. The
source of the lens flare may be any object in the scene, but is generally a light,
such as a target spot light, or an omni light. Clicking this button displays the
Select Flare Objects dialog. You must select a source for the flare to key off.

NOTE If you select a source object, then rename the object later, you must reselect
the object to ensure the correct generation of the lens flare.

Lens Flare Effects group

Controls specific effects for the flare, such as fades, brightness, softening, and
so on.

Brighten Lets you set an overall brightness that affects the whole image. When
a bright effect, such as a lens flare, appears in an image, the whole image
should appear brighter. This effect is available only when the Brighten option
is enabled under the Render section of the Preferences panel. This parameter
can be animated on page 6848. Animating the Brighten spinner is an easy way
to create flares that "flash" the scene as they appear.

Dist Fade Causes the effect of the lens flare to fade with its distance from the
camera. This option is used only when the Dist Fade button is turned on. The
values are in 3ds Max world units. This option is used when you want to create
the effect of flares disappearing at a certain point away from the camera.

Cent Fade Fades the secondary flares near the center of the row of flares along
the main axis of the flare. This is an effect that can be seen in many lens flares
seen through a real camera lens. This value is in 3ds Max world units. This
setting is only active when the Cent Fade button is selected.

Dist Blur Blurs the flare based on its distance from the camera. This value is
in 3ds Max world units. This parameter can be animated.

Blur Int Controls the strength of the blur when it is applied to the lens flare.
The value set in this spinner takes full effect as the flare reaches the Dist Blur
distance in your scene. Flares closer to the camera plane get a percentage of
the intensity setting. This parameter can be animated.

Soften Provides an overall softening effect for the lens flare This parameter
can be animated.

Flare Parameter tabs

Let you create and control the lens flare. Each of the nine tabs controls a
specific aspect of the lens flare.
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WARNING When you animate Lens Effects parameters, this creates pointers into
the actual scene, so Lens Effects animation is lost if you save the Video Post queue
in a VPX file on page 8165. To preserve the animation, save the Video Post data,
including Lens Effects animation, in the MAX file.

A flare is composed of eight basic parts. Each part of a flare is controlled on
its own panel in the Lens Effects Flare interface. Each part of the lens flare can
be individually activated and deactivated to create different effects.

Prefs on page 6854: This page lets you control which parts of a lens flare are
active and how they effect the overall image.

Glow on page 6857: A general glow centered around the source object of the
flare. You can control the color, size, shape, and other aspects of the glow.

Ring on page 6858: A circular color band that surrounds the center of the source
object. You can control the color, size, shape, and other aspects of the ring.

A Sec on page 6860: Auto Secondary Flares. The small circles you would normally
see coming out from the source of the lens flare. As the camera position
changes relative to the source object, the secondary flares move. The secondary
flares are automatically generated when this option is active.

M Sec on page 6861: Manual Secondary Flares. Additional secondary flares added
to the lens flare effect. They appear in the same axis as the automatic secondary
flares and look very similar.

Rays on page 6863: Bright lines that radiate out from the center of the source
object, providing the illusion of extreme brightness for the object.

Star on page 6865: Bright lines that radiate out from the center of the source
object, generally composed of 6 or more spokes, (instead of hundreds, like a
ray). Stars are generally thicker and extend out farther from the center of the
source object than rays.

Streak on page 6867: Wide horizontal bands that run through the center of the
source object.

Inferno on page 6869: Lets you add special effects, such as explosions, to your
flare effect.

Flare Preferences

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Prefs tab
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In the Prefs panel, you can control whether or not specific parts of the lens
flare, such as the rays or the star are rendered by turning them on or off. You
can also control the axial transparency of the lens flare.

Interface

Affect Alpha Specifies whether or not the lens flare affects the alpha channel
of an image, when the image is rendered in a 32-bit file format. The alpha
channel is an extra 8 bits of color (256 colors) that indicate transparency in
an image. Alpha channels are used to composite one image seamlessly over
the top of another. If you want to composite a lens flare, or an image that
contains a lens flare, over the top of another image, enable this option. If you
are not rendering to a 32-bit file, do not enable this option.

Affect Z Buffer The Z-Buffer stores an object's distance from the camera. The
Z-Buffer is useful for optical effects such as fog. When this option is enabled,
the linear distance of the lens flare is recorded, and can be used in special
effects that make use of the Z-Buffer, for example, the Focus on page 6871 effect.
To use Focus with a lens flare, enable this option.
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Occlusion Radius A radius around the center of the flare that determines
when the lens flare effect will begin to fade as it passes behind another object.
This radius is measured in pixels.

When the lens flare or scene is animated and the source of the lens flare goes
behind another object, if occlusion is enabled, the flare dies down and
disappears until the source object reappears on the other side of the hiding
object. The radius makes the flare gently fade when it is occluded, instead of
blinking out.

Motion Blur Determines whether or not an animated lens flare is rendered
using Motion Blur. Motion Blur renders multiple copies in short increments
to the same frame, which gives the illusion of a blurred object in motion.
When an object is moving rapidly across the screen, it animates more smoothly
if motion blur is turned on. Using motion blur can add considerable time to
your rendering.

You can set the amount of blur with the Motion Blur spinner. Values range
from 0 to 100, and are based on the number of samples the motion blur should
use.

Axial Transparency A standard circular transparency gradient that affects
the transparency of the lens flare secondary elements along their axis and
relative to their source. This lets your secondary elements be brighter on one
side than the other, adding extra realism to your flare effects.

Render Specifies whether or not each part of the lens flare is rendered in the
final image. Use this set of check boxes to turn parts of the lens flare on and
off.

NOTE Effects such as secondary flares are available in sets. The Render button and
Off Scene determine whether the secondary flares are present in the scene. The
individual secondary flare sets are controlled on their respective pages.

Off Scene Specifies whether or not lens flares that have their sources outside
the scene will affect the image. For example, if a lens flare source is just off
the edge of a frame, the secondary flares, and possibly the star or ring, could
still be showing on the screen. Without Off Scene, the lens flare does not
appear at all. You can turn this option on or off for each part of the flare.

Squeeze Specifies whether the Squeeze setting affects a particular part of the
lens flare. This setting depends on the Squeeze setting in the lens flare
properties.

Inferno Defines whether the inferno on page 6869 settings are active for this
portion of the lens flare.
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Occlusion Defines the percentage of the flare part that appears when it is
occluded by another object. A value of 100 indicates that the whole object
will disappear. Lower settings cause the lens flare to wrap around the occluding
object, making it fade, but not disappear entirely. For example, if you look at
a cylinder with a bright light behind it, the light makes the cylinder appear
thinner at the brightest areas.

NOTE The Occlusion spinners work in conjunction with the Occlusion Radius
spinner in the top right of the Preferences panel.

Flare Glow Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Glow tab

The glow of a lens flare is centered around the source object of the flare. The
parameters on the Glow panel let you control each aspect of the glow.

Interface
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Size Specifies the diameter of the glow of the lens flare as a percentage of the
overall size of the frame. This value is separate from the overall size value set
in the Flare Properties on page 6849. This parameter can be animated on page
6848.

Hue Specifies the gradation of color for the glow. Clicking the green arrow
button lets you animate this control. This parameter can be animated.

Hide Behind Geometry Places the glow behind the geometric forms.

Gradients Use radial, circular, transparency, and size gradients on page 6902.
Glow gradients are subtler than flare gradients, because they are glowing an
area larger than a pixel.

Flare Ring Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Ring tab

The ring is a circular color band that surrounds the center of the source object.
You set ring options on the Ring panel of the Lens Effects Flare dialog.
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Interface

Size Specifies the overall size of the ring as a percentage of the overall frame
and represents the diameter of the ring. The ring radius should be larger than
the glow radius to make the lens flare look convincing. This parameter is
separate from the overall size spinner in the Lens Flare Effects section of the
dialog. This parameter can be animated on page 6848.

Thick Specifies the overall thickness of the ring, as a percentage of the overall
size of the frame. When the ring is fairly thick, the size of the ring is measured
to the inner radius. The thickness controls how thick the ring is from that
point outward. This parameter can be animated.

Hue Specifies the gradation of color for the ring. This parameter can be
animated.

Gradients Use radial, circular, transparency, and size gradients on page 6902.
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Automatic Secondary Flare Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > A Sec tab

Secondary flares are the small circles you would normally see coming out from
the source of the lens flare along an axis relative to the camera position. These
are caused by light refracting off the different lens elements in the camera. As
the camera position changes relative to the source object, the secondary flares
move. These secondary flares are automatically generated when this option
is selected in the Preferences section of the dialog.

You create sets of secondary elements that share common parameters instead
of building them one at a time. Many of the controls on the A Sec panel are
for individual sets of elements, not all sets.

Interface

Min Controls the minimum size of secondary flares in the current set. This
number is defined as a percentage of the overall image. This parameter can
be animated on page 6848.
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Max Controls the maximum size of secondary flares in the current set. This
number is defined as a percentage of the overall image. This parameter can
be animated on page 6848.

Sets Specifies which set of secondary flares you are working with. You can
have as many sets of automatic secondary elements as you wish, each having
their own properties. By default, seven sets are available. You can scroll through
them by clicking the forward and reverse arrow icons beside the name of the
set.

To add another set to your flare, click the Add button beneath the On check
box. To delete a set, click the Del button.

Axis Defines the overall length of the axis the automatic secondary flares will
be distributed along. Increasing the value creates more space between the
flares, while decreasing the value creates less space between the flares. You
can set the axis from 0 to 5 degrees. This parameter can be animated on page
6848.

On Defines whether a group or set of secondary flares is active or not.

Fade Determines whether or not axial fade is active for the current set of
secondary flares.

Hue Specifies the gradation of color of the secondary flares. This parameter
can be animated.

Qty Controls the number of secondary flares that appear in the current set of
flares. This parameter can be animated.

Shape Controls the shape of the secondary flares for the current set. The
default value is circular, but you can choose from 3 to 8 sided secondary flares.

Gradients Defines the gradient on page 6902 for the secondary flare.

Manual Secondary Flare Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > M Sec tab

Manual secondary flares are additional secondary flares that are individually
added to the lens flare. These can be used in addition to, or in place of
automatic secondary flares on page 6860.

You use Manual secondary flares when you want to add unique flares that
you don't want repeated.
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You can have groups of secondary flares, instead of just one set. Many of the
controls in this dialog are for a specific set of flares, not all sets.

Interface

Size Controls the size, as a percentage of the overall image, of the manual
secondary lens flare. This parameter can be animated on page 6848.

Plane Controls the distance, in degrees, between the flare source and the
manual secondary flare. By default, the flare plane exists at the center of the
chosen node source. Positive values place the flare in front of the source, while
negative values place the flare behind the flare source. This parameter can be
animated.

TIP In live camera work, there are often one or two secondary elements behind
the light source, so you should have one or two as well.

On Turns manual secondary flares on or off. This option must be selected in
both the Manual Secondary and Preferences tabs for the manual secondary
flares to render.
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Fade Specifies whether or not the current set of secondary flares has axial
fade.

Sets Specifies which set of secondary flares you are working with. You can
have as many sets of manual secondary elements as you wish, each having
their own properties. By default, seven sets are available. You can scroll through
them by clicking the forward and reverse arrow buttons next to the name of
the set.

To add another set to your flare, click the Add button beneath the On check
box. To delete a set, click the Del button.

Hue Specifies the gradation of color of secondary flares. This parameter can
be animated.

Scale Specifies how to scale secondary flares. This parameter can be animated.

Shape This menu controls the overall shape of the secondary flares.

Gradients Defines the gradient on page 6902 for the secondary flare.

Flare Ray Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Rays tab

Rays are bright single-pixel lines that radiate from the center of the source
object, providing the illusion of extreme brightness for the object. Rays let
you emulate scratches in the lens elements of a camera.

You control the parameters for rays in the Rays panel of the Lens Effects Flare
dialog.
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Interface

Size Specifies the overall length of the rays as they radiate from the center, as
a percentage of the frame size. This parameter can be animated on page 6848.

Angle Specifies the angle for the rays. You can enter both positive and negative
values so, when animated, the rays rotate in a clockwise or counterclockwise
direction. This parameter can be animated.

Group Forces the grouping of rays into eight equidistant groups of equal size.
Rays that are part of a group are evenly distributed within that group.
Increasing the number of rays makes each grouping more dense, and therefore
more bright.

Number Specifies the overall number of rays that appear in the lens flare.
Rays are randomly spaced around the radius. This parameter can be animated.

Auto Rotate Adds the angle specified in the Angle spinner on the Rays panel
to the angle set in the Angle spinner under Lens Flare Properties. Auto Rotate
also ensures that the rays maintain their relative position to the flare as it is
being animated.
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Hue Specifies the gradation of the color of the rays. This parameter can be
animated.

Sharp Specifies the overall sharpness of the rays. Higher numbers produce
crisp, clean, and clear rays. Lower numbers produce more of a secondary glow
look. Values range from 0 to 10. This parameter can be animated.

Gradients Defines the gradient on page 6902 for the rays.

Flare Star Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Star tab

A Star is larger than a ray effect and is composed of six or more spokes, instead
of hundreds like a ray. Stars are thicker and extend out farther from the center
of the source object than rays. You control the settings for stars on the Star
panel of the Lens Effects Flare dialog.
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Interface

Size Specifies the overall size of the star effect, as a percentage of the overall
frame. This parameter can be animated on page 6848.

Angle Sets the starting angle in degrees in which the star spokes point. You
can enter both positive and negative values so, when animated, the star spokes
rotate in a clockwise or counterclockwise direction. This parameter can be
animated.

Random Enables random spacing of star spokes around the flare center.

Qty Specifies the number of spokes in the star effect. Default = 6.

Spokes are spaced at equidistant points about the center of the flare. This
parameter can be animated.

Width Specifies the width of the individual spokes, as a percentage of the
overall frame. This option can be animated.

Auto Rotate Adds the angle specified in the Angle spinner on the Rays panel
to the angle set in Angle spinner under Lens Flare Properties. Auto Rotate also
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ensures that the stars maintain their relative position to the flare as it is being
animated.

Hue Specifies the gradation of the color of the star. This parameter can be
animated.

Sharp Specifies the overall sharpness of the star. Higher numbers produce
crisp, clean, and clear stars. Lower numbers produce more of a secondary glow
look. This parameter can be animated. Range = 0 to 10.

Taper Controls the taper of the individual spokes of the star. Taper widens
or narrows the tips of the individual star points. Low numbers create a sharp
point, while high numbers flare the points. This parameter can be animated.
Default = 0.

Gradients The gradients on page 6902 are the same for the Star effect as for
others, except for two gradients: Section Color and Section Transparency.
These options are useful when you want to create a "soft" look to the spokes.
Both gradients work from the center of each spoke to the outer edge of the
spoke.

Flare Streak Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Streak tab

A streak is a wide horizontal band that runs through the center of the source
object. In real camera work, it is produced when using anamorphic lenses to
film a scene. You set streak options on the Streak panel of the Lens Effects
Flare dialog.
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Interface

Size Specifies the overall size of the streak, as a percentage of the overall frame.
This parameter can be animated on page 6848.

Angle Specifies the angle for the streak. You can enter both positive and
negative values so, when animated, the streak rotates in a clockwise or
counterclockwise direction. This parameter can be animated.

Axial Align Forces the streak to align itself to the axis of the secondary flares
and the lens flare itself.

Width Specifies the width of the streak, as a percentage of the frame. This
parameter can be animated.

Auto Rotate Adds the angle specified in the Angle spinner on the Streak panel
to the angle set in Angle spinner under Lens Flare Properties. Auto Rotate also
ensures that the stars maintain their relative position to the flare as it is being
animated.

Hue Specifies the gradation of the color of the streak. This parameter can be
animated.
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Sharp Specifies the overall sharpness of the streak. Higher numbers produce
crisp, clean, and clear streaks. Lower numbers produce more of a secondary
glow look. Valid values are from 0 to 10. This parameter can be animated.

Taper Controls the taper of the individual spokes of the streak. Taper widens
or narrows the tips of the individual streak points. Low numbers create a sharp
point, while high numbers flare the points. Default = 0. This parameter can
be animated.

Gradients The gradients on page 6902 are the same for the Streak effect as for
others, except for two gradients: Section Color and Section Transparency.
These options are useful when you want to create a "soft" look to the streak
spokes. Both gradients work from the center of each spoke to the outer edge
of the spoke.

Flare Inferno Parameters

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose Lens Effects Flare from Filter Plug-In list. > Setup > Inferno tab

Infernos let you use lens flare to create explosions, fire, and smoke effects and
add a bit of fractal noise to any part of the lens flare. This noise comes in three
types: Gaseous, Electric, and Fiery.

Interface
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You add the Inferno effect to other lens flare effects. Inferno is selected in the
Preferences panel. The lens flare effect you are adding Inferno to, such as glow,
must also be selected for Inferno to work correctly. The Inferno panel is divided
into two sections: Settings and Parameters.

Settings group

Gaseous A loose and soft pattern, often used for clouds and smoke.

Fiery Fractal patterns with bright, well-defined areas, often used for fires.

Electric Long, well-defined tendril pattern that can be used to produce arcing
electricity, when animated. By adjusting the quality of the pattern to 0, you
can create the effect of water reflection.

Lock Effect Locks the inferno effect to the lens flare. When the lens flare
moves across the screen, the inferno effect moves with it. Use this option
when you want the noise pattern to move with the flare for effects like torches.

Lock Noise Locks the inferno noise patterns into the screen. When the lens
flare is animated and moving across the screen, the noise pattern stays in one
spot and the flare moves through it. This is often used for creating plasma
trails and cloud patterns.

Motion When you animate the inferno, motion specifies how fast the inferno
patterns move in the direction set by the Direction spinner. For example, if
you want to simulate a raging fire, you want the fractal patterns to move
upward. This parameter can be animated on page 6848.

Direction Specifies the direction, in degrees, of the inferno effect motion. By
default, 0 is aligned in the 12 o'clock position, and works clockwise. This
parameter can be animated.

NOTE The Motion and Direction spinners control the motion of the fractal pattern
in the X and Y directions. You can control the Z direction using the Speed option
under Inferno Parameters.

Quality Specifies the overall quality of the fractal noise patterns in the inferno
effect. Higher values result in more iterations of the fractals, more detail in
the effect, and slightly longer render times. This parameter can be animated.

Reseed The number that the fractal routines use as a starting point. Set this
spinner to any number to create different fractal effects. The Reseed button
randomly selects a new number.
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Parameters group

Size Specifies the overall size of the fractal patterns. Smaller numbers produce
small, grainy fractals. Higher numbers produce larger patterns. This option
can be animated.

Speed Sets the overall speed of the turbulence in the fractal patterns as they
are animated. Higher numbers produce faster turbulence in the pattern. This
parameter can be animated.

Base Specifies the brightness of the colors in the inferno effect. Higher values
result in brighter color ranges and brighter infernos. Lower values result in
dark, softer effects. The Base spinner only affects Fiery and Electric inferno
types This parameter can be animated.

Amplitude With the Base spinner, controls the maximum brightness for each
portion of the fractal inferno patterns. Higher values result in fractal patterns
with brighter colors. Lower values result in the same patterns, with muted
colors. This parameter can be animated.

Bias Shifts the colors of the effect toward one end of the color range or the
other. At a setting of 50, Bias has no effect. Above 50, the colors are brighter,
and below 50, they are darker and softer. This parameter can be animated.

Edge Controls the contrast between the light and dark areas of the fractal
patterns. High values produce a high contrast and more well-defined fractal
patterns. Low values result in less defined, subtler effects. This parameter can
be animated.

Radial Density Controls the density of the inferno effect in a radial fashion
from the center of the effect to the edge. Wherever there is white in the
gradient, you only see inferno noise. Where the gradient is black, you can see
the underlying flare. If you set the right side of the gradient to black and the
left side to white, and apply the Inferno to the Glow effect of a flare, the
inferno effect appears toward the outer edges of the glow, while the center of
the glow is still visible.

Lens Effects Focus Filter

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Focus from
Filter Plug-In list. > Setup

The Lens Effects Focus dialog lets you blur objects based on their distance
from the camera. Focus uses the Z-Buffer information from the scene to create
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its blurring effects. You can use Focus to create effects such as foreground
elements in focus and background elements out of focus.

Like Flare, Glow, and Highlight, you can load and save your focus settings for
future use. Focus settings are saved to LZO files on page 8030 (.lzo).

WARNING This filter is not supported by the mental ray renderer on page 6230.

Procedures

To save your focus settings, do one of the following:

You can save all of your lens focus settings to a file, so you can reload them
any time. Lens Effects Focus settings are saved as LZO files.

1 Click the Reset button.

This resets Lens Effects Focus to its default settings.

2 Click the Load button.

This displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

3 Click the Save button.

This displays a Windows-standard Save As dialog in which you specify a
directory and filename.
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Interface

The Lens Effects Focus dialog contains a preview window, and an area below
to control the parameters of Focus.

Lens Effects Filters | 6873



Preview group

Preview window Lets you quickly preview the Focus effect.

Preview Displays a generic scene to which you can quickly set up a Focus
effect. Appears light green when selected.

VP Queue Lets you preview the scene in the Video Post queue. Preview must
be selected for the VP Queue function to work.

Focus Control group

The settings on the left side of the panel let you select a method for blurring
your scene. The settings on the right side of the dialog let you determine how
much blurring is applied to the scene.

Scene Blur Applies the blurring effect to the entire scene, not just a portion
of it.

Radial Blur Applies the blurring effect to the entire scene in a radial fashion,
starting at the center of the frame. This is useful for emphasizing fish-eye lens
effects and effects where the edges of the frame are blurred. This type of Focus
depends on the Focal Range and Limit settings.

A scene with a radial blur is applied.

Focal Node Lets you select a specific object in the scene as the focal point for
blurring. The selected objects remains in focus, while objects outside of the
set Focal Limit are blurred.

Select Displays the Select Focal Object dialog so you can select a single 3ds
Max object to use as the focal object. The object you select can be animated
over time, which results in animated follow focus effects. You can also choose
your camera target as the focal object so its depth in the scene determines the
focus.

Affect Alpha When this option is selected, the blur effect is also applied to
the Alpha channel of the image when you render to a 32-bit format. Select
this option to composite the blurred image over another.

Horiz. Focal Loss Specifies the amount of blur applied to the image in the
horizontal (X-axis) direction. Values range from 0 to 100% focal loss. This
parameter can be animated on page 6848.

Lock Locks the horizontal and vertical loss settings together. When selected,
the vertical focal loss is automatically updated to match your changes to the
horizontal loss.
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Vert. Focal Loss Specifies the amount of blur applied to the image in the
vertical (Y-axis) direction. Values range from 0 to 100% focal loss. This
parameter can be animated.

Focal Range Specifies how far away from the center of the image (Radial Blur)
or from the camera (Focal Object) the blur effect begins. Increasing values
move the radius of the effect farther away from the camera or the center of
the image. This parameter can be animated.

Focal Limit Specifies the distance from the center of the image (Radial Blur)
or the distance from the camera (Focal Object) at which the blur effect is at
full strength. Setting a high Focal Limit with a low Focal Range, produces a
gradual increase in the amount of blur in the scene, while setting Focal Limit
and Range close together produces a rapid blur effect over a short distance.
This parameter can be animated.

NOTE Do not set Focal Range and Focal Limit to the same value. This produces
an abrupt change from a blur to a sharp focus, producing an undesirable visual
effect.

WARNING When you animate Lens Effects parameters, this creates pointers into
the actual scene, so Lens Effects animation is lost if you save the Video Post queue
in a VPX file on page 8165. To preserve the animation, save the Video Post data,
including Lens Effects animation, in the MAX file.

Button group

Reset Resets Lens Effects Flare to its default settings.

Load Displays a Windows-standard file open dialog from which you can select
the settings file you want to load.

Save Displays a Windows-standard Save As dialog in which you specify a
directory and filename. Lens Effects Focus settings are saved as LZO files.

Lens Effects Glow Filter

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from
Filter Plug-In list. > Setup

The Lens Effects Glow dialog lets you add a glowing aura around any assigned
object. For example, for an exploding particle system, adding a glow to the
particles makes them seem as though they are brighter and hotter.
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The Lens Effects Glow module is multi-threaded and will take advantage of
multi-processing machines.

Procedures

To save your glow settings, do one of the following:

You can save all of your lens glow settings to a file, so you can reload them
any time. Lens Effects Glow settings are saved to LZG files on page 8030 (.lzg).

1 Click the Reset button.

This resets Lens Effects Glow to its default settings.

2 Click the Load button.

This displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

3 Click the Save button.

This displays a Windows-standard Save As dialog in which you specify a
directory and filename.
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Interface

The Lens Effects Glow dialog contains a preview window, and an area below
to control the parameters of Glow.
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Preview group

Preview window Lets you quickly preview the glow effect. The preview
window is multi-threaded to take advantage of systems with multiprocessors,
and updates every time you make a change to any of the glow settings that
might affect the scene.

Preview Displays a generic scene to which you can quickly set up a Glow
effect. Appears light green when selected.

VP Queue Lets you preview the scene in the Video Post queue. Preview must
be selected for the VP Queue function to work.

Focus Control tabs

The Lens Effect Glow dialog contains four tabs:

Properties on page 6878, Preferences on page 6882, Gradients on page 6902, and
Inferno on page 6884

Button group

Reset Resets Lens Effects Glow to its default settings.

Load Displays a Windows-standard file open dialog from which you can select
the settings file you want to load.

Save Displays a Windows-standard Save As dialog in which you specify a
directory and filename. Lens Effects Glow settings are saved as LZG files.

Glow Properties

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from
Filter Plug-In list. > Setup > Properties tab

The Lens Effects Glow properties let you determine which pieces of geometry
in your scene will exhibit the effects of the glow filter, as well as how much
of a glow is applied.

Procedures

To set a material's Effects Channel ID:

1 In the Material Editor, make the material you want to be post-processed
the active material.
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2 Choose a non-zero ID from the Material Effects Channel flyout.

The Effects Channel ID can range from 1 to 15.

If you give the same Effects Channel ID value to more than one material,
all these materials will be post-processed.

NOTE For Multi/Sub-Object materials, post-processing applies at the
sub-object/sub-material level. The Effects Channel ID of the parent
Multi/Sub-Object material is ignored.

To set up an RLA file so it saves Object and Material Effects channel data:

1 Place an Image Output Event in the Video Post Queue.

2 In the Image Output Event dialog, click Files.

3 Choose the .rla file type on page 7364 and a file name, and then click Setup.

4 In the RLA Image File Format dialog, select Object, Material Effects, and
then click OK.

5 Click OK.

When the RLA file has saved the Object and Material Effects channels,
you can use the rendered scene file as an Image Input event or a Filter or
Layer mask, and continue to use the Object or Material Effects Channel
data.
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Interface

The Properties panel is divided into two sections: Source and Filter.

Source group

Specifies the objects in the scene to which a glow is applied. You can select
more than one source option at a time.

Whole Applies a glow to the whole scene, not just a particular piece of
geometry. This makes each pixel in the scene a potential glow source. The
areas of the scene that have glow applied to them are determined by the
settings in the Filter section of the dialog.

Object ID Lets you apply the glow to an object or part of an object with a
specific Object ID (in the G-buffer on page 7991), if the object matches the Filter
settings. To apply an Object ID glow for an object, right-click the object and
select properties from the menu. Then, set the Object Channel ID. Set this
field to match, and Lens Effects glow will apply the glow to that object and
any other objects with the same ID. This parameter can be animated on page
6848.

Effects ID Lets you apply the glow to an object or part of an object with a
specific Effects ID, if the object or part of the object matches the Filter settings.
You apply a Effects ID in the Materials Editor by assigning the material to one
of the available Material Effects channels. This parameter can be animated.

The glow will be applied only to areas of the geometry where the ID is present.
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NOTE To apply different glow settings to different pieces of geometry or IDs, add
more glow entries to the video post queue. Set each glow entry to affect a different
Effect or Object ID, and set the appropriate settings. This process will call the glow
routine multiple times, increasing your rendering time. Try to keep the number
of glow routines to a minimum per frame.

Unclamped An unclamped color is brighter than pure white (255,255,255).
3ds Max keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that is glowed. Pure white has a pixel value
of 1. When this spinner is set to 1, any pixels with a value above 255 will be
glowed. You can invert this value by clicking the I button to the right of the
spinner. This parameter can be animated.

Surf Norm Glows part of an object, based on the angle of the surface normal
to the camera. A value of 0 is coplanar, or parallel to the screen. A value of 90
is normal, or perpendicular to the screen. If you set Surf Norm to 45, only
surfaces with normal angles greater than 45 degrees will be glowed. You can
invert this value by clicking the I button to the right of the spinner. This
parameter can be animated.

Mask Glows the mask channel of an image. The spinner value represents the
level of grayscale present in a Mask. When this is set, any part of the Mask
images larger than the set value will be glowed in the final image. You can
invert this value by clicking the I button to the right of the spinner. This
parameter can be animated. Range = 0 to 255.

Alpha Glows the alpha channel of an image. The transparency of an alpha
channel is interpreted opposite that of the Mask channel. This parameter can
be inverted, and can also be animated. Range = 0 to 255.

Z Buffer Hi and Lo Glows objects based on their distance (Z-Buffer distance)
from the camera. The Hi value is the maximum distance and the Lo value is
the minimum. Any objects between these two Z-Buffer distances will be glowed.
These parameters can be animated.

Filter group

Filters the Source selections to let you control how the glow is applied. For
example, you can have ten spheres in your scene, each with the same Object
ID, but different colors. If you set the Source as the Object ID of the spheres,
which selects all of the spheres, that is the only place in your scene that Glow
applies an effect.
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However, now that Glow knows where the pixels are that can be glowed, it
needs to know which ones to actually apply the Glow to. Glow uses the filter
controls to find out which source pixels to apply a glow to.

All Selects all source objects in the scene and applies a glow to them.

Edge Selects all source objects along a boundary edge and applies a glow to
them. Applying a glow along the edges of objects produces a soft halo that
exists on both inside and outside edges of your object.

Perimeter Alpha Applies a glow only to the perimeter of an object based on
its alpha channel. Selecting this option glows only the outside of an object
without any spill on the interior. Perimeter Alpha keeps all the edges clean
because it relies on the scene alpha channel for its effect.

Perimeter Applies glow effect only to the perimeter of an object based on
Edge inferencing. Although not as precise as Perimeter Alpha, you might need
to use the Perimeter option at times when the alpha channel is unavailable.

Bright Filters the source objects based on their brightness values. Only objects
with a brightness above the spinner setting are selected and glowed. This
option can be inverted. This parameter can be animated.

Hue Filters the source objects by their hue. Select the hue by clicking the color
swatch next to the spinner. The spinner beside the Hue color swatch lets you
enter a variance level so that the glow can find several different hues in the
same range as the chosen color. This parameter can be animated. Range = 0
to 255.

Glow Preferences

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from
Filter Plug-In list. > Setup > Preferences tab

Glow Preferences define the size of the glow, its occlusion, and whether or
not it affects the Z-Buffer or alpha channels.
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Interface

The Preferences panel is divided into four sections: Scene, Distance Fade,
Effect, and Color.

Scene group

Affect Alpha Specifies whether or not the glow affects the alpha channel of
the image, when rendered to a 32-bit file format.

Affect Z Buffer Specifies whether or not the glow affects the Z-Buffer of the
image. When this option is enabled, the linear distance of the glow is recorded,
and can be used in special effects that make use of the Z-Buffer. For example,
Lens Effects Focus blurs objects based on their Z-Buffer information. To use
Focus with a glow, you must enable this option.

Distance Fade group

These controls fade the glow effect, based on its distance from the camera.
This is the same as distance fade for the lens flare.

Bright Lets you fade the brightness of the glow effect based on the distance
from the camera. This is ideal for submarine running lights and any other
effect where you want your glow to disappear into the distance. This parameter
can be animated on page 6848.

Size Lets you fade the size of the glow effect based on the distance from the
camera. In most circumstances, you want the overall size of the glow to
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diminish as it gets farther away from the camera. This parameter can be
animated.

Lock When selected, locks the Bright and Size values together, so that the
size and brightness fading is synchronized.

Effect group

Size Sets the size of the overall glow effect. This parameter can be animated.

Softness Softens and blurs the glow effect. Values range from 0 to 100. This
control is enabled only when you use Gradients as the color method (see the
next section). Softness is only available when the Gradient option in the Color
area is selected. This parameter can be animated.

Color group

Gradient Creates the glow based on the settings in the Gradients panel. When
you use this method, you can use the Softness spinner in the Effect area.

Pixel Creates the glow based on the pixel color of the object. This is the default
method. It is very fast.

User Lets you select a color for the glow effect. Click the color swatch to display
the Color Selector on page 391 and choose a color.

Intensity Controls the intensity or brightness of the glow effect. Values range
from 0 to 100. This control is enabled only when Pixel or User is the chosen
color method.

Glow Inferno

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Glow from
Filter Plug-In list. > Setup > Inferno tab

The Inferno panel lets you create explosions, fire, and smoke effects by
combining the lens flare glow with black and white fractal noise.

The Glow inferno effect is like the Inferno effect in Lens Flare on page 6869, but
it is applied to the Glow through the R, G, and B color channels.
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Interface

The Inferno panel is divided into two sections: Settings and Parameters.

Settings group

Gaseous A loose and soft pattern, often used for clouds and smoke.

Fiery Fractal patterns with bright, well-defined areas, often used for fires.

Electric Long, well-defined tendril pattern that can be used to produce arcing
electricity, when animated. By adjusting the quality of the pattern to 0, you
can create the effect of water reflection.

Reseed The number that the fractal routines use as a starting point. Set this
spinner to any number to create different fractal effects. The Reseed button
randomly selects a new number.

Motion When you animate the inferno, motion specifies how fast the inferno
patterns move in the direction set by the Direction spinner. For example, if
you want to simulate a raging fire, you want the fractal patterns to move
upward. This parameter can be animated on page 6848.

Direction Specifies the direction, in degrees, of the inferno effect motion. By
default, 0 is aligned in the 12 o'clock position, and works clockwise. This
parameter can be animated.
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NOTE The Motion and Direction spinners control the motion of the fractal pattern
in the X and Y directions. You can control the Z direction using the Speed option
under Inferno Parameters.

Quality Specifies the overall quality of the fractal noise patterns in the inferno
effect. Higher values result in more iterations of the fractals, more detail in
the effect, and slightly longer render times. This parameter can be animated.

Red/Green/Blue Selects the color channel to use for the Inferno effect.

Parameters group

Size Specifies the overall size of the fractal patterns. Smaller numbers produce
small, grainy fractals. Higher numbers produce larger patterns. This option
can be animated.

Speed Sets the overall speed of the turbulence in the fractal patterns as they
are animated. Higher numbers produce faster turbulence in the pattern. This
parameter can be animated.

Base Specifies the brightness of the colors in the inferno effect. Higher values
result in brighter color ranges and brighter infernos. Lower values result in
dark, softer effects. The Base spinner only affects Fiery and Electric inferno
types This parameter can be animated.

Amplitude With the Base spinner, controls the maximum brightness for each
portion of the fractal inferno patterns. Higher values result in fractal patterns
with brighter colors. Lower values result in the same patterns, with muted
colors. This parameter can be animated.

Bias Shifts the colors of the effect toward one end of the color range or the
other. At a setting of 50, Bias has no effect. Above 50, the colors are brighter,
and below 50, they are darker and softer. This parameter can be animated.

Edge Controls the contrast between the light and dark areas of the fractal
patterns. High values produce a high contrast and more well-defined fractal
patterns. Low values result in less defined, subtler effects. This parameter can
be animated.

Radial Density Controls the density of the inferno effect in a radial fashion
from the center of the effect to the edge. Wherever there is white in the
gradient, you only see inferno noise. Where the gradient is black, you can see
the underlying glow. If you set the right side of the gradient to black and the
left side to white, and apply the Inferno to the Glow effect of a flare, the
inferno effect appears toward the outer edges of the glow, while the center of
the glow is still visible.

6886 | Chapter 22   Video Post



Lens Effects Highlight Filter

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight
from Filter Plug-In list. > Setup

The Lens Effects Highlight dialog lets you assign bright, star-shaped highlights.
Use it on objects that have shiny materials. For example, a shiny, red car might
show highlights in bright sunlight.

Example of highlights

Another good example of an effect perfect for Highlight is the creation of
pixie dust. If you create a particle system and animate it moving in a straight
line with small four-point Highlight stars applied to each pixel, it will look a
lot like twinkling magic.

The Lens Effects Highlight module is multi-threaded and will take advantage
of multi-processing machines, making it one of, if not the fastest highlight
routines available.
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Procedures

To save your highlight settings:

You can save all of your lens highlight settings to a file, so you can reload
them any time. Lens Effects Highlight settings are saved as LZH files on page
8030 (.lzh). Do one of the following:

1 Click the Reset button.

This resets Lens Effects Highlight to its default settings.

2 Click the Load button.

This displays a Windows-standard file open dialog from which you can
select the settings file you want to load.

3 Click the Save button.

This displays a Windows-standard Save As dialog in which you specify a
directory and filename.
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Interface

When you select Lens Effects Highlight from the Image Filter Event drop-down
list and click Setup, the Highlight dialog is displayed.
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The Lens Effects Highlight interface is almost identical to the Glow module,
with a large preview window, and tabs to control every aspect of your highlight
effects.

Preview group

Preview window Lets you quickly preview the glow effect. The preview
window is multi-threaded to take advantage of systems with multiprocessors,
and updates every time you make a change to any of the glow settings that
might affect the scene.

Preview Activates a generic cross star filter so you can quickly set up a
Highlight effect. However, as with the Glow module, it is more effective seeing
your entire scene and how your effect will interact with your geometry.

VP Queue Lets you preview the scene in the Video Post queue. Preview must
be selected for the VP Queue function to work.

Highlight Control tabs

Similar to the Glow settings, Highlight is also broken down into tabbed sections
for fine control over each aspect of the Highlight effect. The four tabs are:

Highlight Properties on page 6890

Highlight Geometry on page 6895

Highlight Preferences on page 6900

Lens Effects Gradients on page 6902

Button group

Reset Resets Lens Effects Highlight to its default settings.

Load Displays a Windows-standard file open dialog from which you can select
the settings file you want to load.

Save Displays a Windows-standard Save As dialog in which you specify a
directory and filename. Lens Effects Highlight settings are saved as LZH files.

Highlight Properties

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight
from Filter Plug-In list > Setup > Properties tab
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The Lens Effects Highlight properties enable you to determine which parts of
your scene will have highlights applied to them, as well as how the highlights
are to be applied.

Interface

The Properties panel is broken down into two sections: Source and Filter.

Source group

The Source section lets you select any G-Buffer data in the scene that will have
a highlight applied to it. Lens Effects Highlight will begin the process by
finding the source pixels from your scene that you want to glow.

Whole Lets you apply highlights to the whole scene, not just a particular
piece of geometry. This, in effect, makes each pixel in the scene a potential
highlight source. The areas of the scene that have highlights applied to them
are determined by the settings in the Filter section of the dialog.

Object ID The Object ID Lets you apply highlights to particular objects in
your scene that have a corresponding G-Buffer (or Object) ID. The G-Buffer
is a geometry buffer and can be defined when you right-click any 3ds Max
object and select Properties from the menu. Then, set the Object Channel ID
under the G-Buffer ID controls. This parameter can be animated on page 6848.

Effects ID The Effects ID lets you apply the highlight to an object or part of
an object with a specific Effects ID assigned to it. Effects ID's are applied in
the materials editor by assigning the material one of the eight Material Effects
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channels that are available. See G-Buffer on page 7991. This parameter can be
animated.

The highlights are then only applied to areas of the geometry where that
particular ID is present.

NOTE In many instances, you may want to apply different highlight settings to
different pieces of geometry or ID's. To accomplish this, add additional Lens Effects
Highlight entries to the Video Post queue. Then set each different Highlight entry
to effect a different Effect or Object ID and proceed.

Unclamped An unclamped color is brighter than pure white (255,255,255).
3ds Max keeps track of these "hot" areas which tend to show up when your
scene contains bright metallic highlights or explosions. This spinner lets you
determine the lowest pixel value that is highlighted. Pure white has a pixel
value of 1. When this spinner is set to 1, any pixels with a value above 255
will be glowed. You can invert this value by clicking the I button to the right
of the spinner. This parameter can be animated.

Surf Norm Highlights part of an object, based on the angle of the surface
normal to the camera. A value of 0 is coplanar, or parallel to the screen. A
value of 90 is normal, or perpendicular to the screen. If you set Surf Norm to
45, only surfaces with normal angles greater than 45 degrees will be glowed.
You can invert this value by clicking the I button to the right of the spinner.
This parameter can be animated.

Mask Highlights the mask channel of an image. The spinner value represents
the level of grayscale present in a Mask. When this is set, any part of the Mask
images larger than the set value will be glowed in the final image. You can
invert this value by clicking the I button to the right of the spinner. This
parameter can be animated. Range = 0 to 255.

Alpha Highlights the alpha channel of an image. The transparency of an
alpha channel is interpreted opposite that of the Mask channel. Values range
from 0 to 255. This parameter can be inverted by clicking the I button to the
right of the spinner, and can also be animated.

Z Buffer Hi and Lo Highlights objects based on their distance (Z-Buffer
distance) from the camera. The Hi value is the maximum distance and the Lo
value is the minimum. Any objects between these two Z-Buffer distances will
be highlighted. These parameters can be animated.

Filter group

Filters the Source selections to let you control how the highlight is applied.
For example, you can have ten spheres in your scene, each with the same
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Object ID, but different colors. If you set the Source as the Object ID of the
spheres, which selects all of the spheres, that is the only place in your scene
that Highlight will apply an effect.

However, now that Highlight knows where the pixels are that can be
highlighted, it needs to know which ones to actually apply the highlights to.
Highlight uses the filter controls to find out which source pixels to apply the
highlight to.

All Selects all source pixels in the scene and applies a highlight to them.

Edge Selects all source pixels along a boundary edge and applies a highlight
to them. Applying a highlight along the edges of objects produces a soft halo
that exists on both inside and outside edges of your object.

Edge highlights

Perimeter Alpha Applies a highlight only to the perimeter of an object based
on its alpha channel. Selecting this option highlights only the outside of an
object without any spill on the interior. Whereas highlighting by Edge
produces a spill onto the object, Perimeter Alpha keeps all of the edges clean
because it relies on the scene alpha channel to derive it's effect.
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Perimeter alpha highlights

Perimeter Applies highlight effect only to the perimeter of an object based
on Edge inferencing. Although not as precise as Perimeter Alpha, you might
need to use the Perimeter option at times when the alpha channel is
unavailable.
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Perimeter highlights

Bright Filters the source objects based on their brightness values. Only objects
with a brightness above the spinner setting are selected and highlighted. This
option can be inverted by clicking the I button next to the spinner. This
parameter can be animated.

Hue Filters the source objects by their hue. Select the hue by clicking the color
swatch next to the spinner. You can choose hue values from 0 to 255. The
spinner beside the Hue color swatch lets you enter a variance level so that the
glow can find several different hues in the same range as the chosen color
This parameter can be animated.

Highlight Geometry

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight
from Filter Plug-In list > Setup > Geometry tab

The Geometry panel is where you set the initial rotation of the highlights as
well as how the elements are affected over time. The Geometry panel consists
of three areas: Effect, Vary, and Rotate.
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Interface

Effect group

Angle Controls the angle of the highlight points over the course of the
animation. This parameter can be animated on page 6848.

Clamp Determines the number of pixels highlight must read to place a single
highlight effect. In many cases, you want to key your highlight effects off of
the brightness of objects that can produce a lot of pixels to generate from.
The end result is something that looks like stadium lights from a Monday
Night Football game, where each pixel has the highlight cross drawn on top
of it, which blurs the overall effect. When you want only one or two highlights,
use this spinner to adjust how highlight processes the chosen pixels. This
parameter can be animated.
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Clamp value of 5

Clamp value of 15
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As you can see, the Clamp value lets you maximize or minimize the overall
number of highlights drawn over the same image. This can be a tremendous
time saver.

Alt. Rays Alternates the lengths of points around the highlight. It works on
every other ray point, changing from the ray's full length to a smaller one
based on the percentage spinner beneath it. This parameter can be animated.

Alt. Rays turned off
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Alt. Rays turned on and set to 40%

Vary group

The Vary group of controls adds randomness to your Highlight effects. You
can quickly adjust your effects so that no two look alike. In many instances,
you want to avoid having your Highlights rotate in formation, and the Size
and Angle buttons control that.

Size Varies the overall size of the individual Highlights.

Angle Varies the initial orientation of the individual Highlights.

Reseed Forces Highlight to use a different random number to generate parts
of its effects.

Rotate group

These two buttons let you have your highlights automatically rotate based on
their relative position in the scene.

Distance Automatically rotates the individual highlight elements as they
recede into the distance. The faster your elements recede, the faster they will
rotate.
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Pan Automatically rotates the individual Highlight elements as they move
laterally across the screen. If you have objects in your scene that are passing
by the camera, they can be automatically rotated based on their position. The
faster your elements move across the screen, the faster they will rotate.

Highlight Preferences

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight
from Filter Plug-In list > Setup > Preferences tab

The Preferences panel defines the size and number of points on the highlight,
occlusion settings, and whether or not it affects the Z-Buffer or alpha channels.

Interface

Scene group

Affect Alpha Determines whether or not the highlight settings affect the
alpha channel of the image when you render to a 32-bit file format.

Affect Z Buffer Determines whether or not the highlight affects the Z-Buffer
of the image. When this option is selected, the linear distance of the highlight
is recorded, and can be used in special effects that make use of the Z-Buffer.
For example, the Focus module that ships with Lens Effects blurs objects based
on their Z-Buffer information. If you want to use Focus to blur a highlight,
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you must select this option. If you are not sure about whether or not to select
this option, leave it disabled, because you probably don't need it.

Distance Fade group

Bright Lets you fade the brightness of the highlight effect based on the distance
away from the camera. This parameter can be animated on page 6848.

Lock Locks the Bright and Size spinner values together.

Size Lets you fade the size of the highlight effect based on the distance from
the camera. In most circumstances, you want the overall size of your highlights
to diminish as they get farther from the camera. This option takes care of that
for you. This parameter can be animated.

Effect group

Size Lets you determine the overall size of the highlight effect, and is calculated
in pixels. This parameter can be animated.

Points Controls the number of points to be generated for a highlight effect.
This parameter can be animated.

Color group

Gradient Lets you create the highlight based on the settings in the Gradients
panel.

Pixel Lets you create the highlight color based on the pixel color of the
highlighted object. This is the default method for Lens Effects Highlight and
is exceptionally fast.

User Lets you select a specific color for the highlights through the standard
3ds Max Color Selector on page 391. The color swatch shows you the currently
selected color.

Intensity Lets you control the intensity or brightness of the highlights. Values
range from 0 to 100. This spinner functions only when you are using either
the Pixel or User color methods to control the brightness of the highlight effect.
This parameter can be animated.
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Lens Effects Gradients

Video Post toolbar > Add Image Filter Event > Choose Lens Effects Highlight
from Filter Plug-In list > Setup > Gradients tab

A gradient is a smooth linear transition from one color or brightness to
another, as shown below. Lens Effects use gradients to control aspects of the
lens flares, such as colors and transparency. Lens Effects use several gradient
types on page 6907.

Lens Effects Gradients are always interpreted from left to right.

Gradient Flags

Gradients use Flags to indicate points along the gradient bar where you want
different colors or brightness values to be. The colors between the flags are
interpolated automatically by Lens Effects. Each Gradient inside Lens Effects
can contain up to 100 flags. The current flag is highlighted and green. The
position number above the gradient bar indicates the position of the current
flag, in relation to the overall length of the gradient.

A gradient always has non-moveable start and end flags. You can add up to
98 intermediate flags to alter the overall appearance of your gradients. You
can also change the color or brightness of the end flags to suit your needs.

When you place two gradient flags on top of one another, you create a sharp
break in the gradient. When a third flag is placed on top of the second flag,
a sharp edge appears in the gradient.

WARNING When you animate Lens Effects parameters, this creates pointers into
the actual scene, so Lens Effects animation is lost if you save the Video Post queue
in a VPX file on page 8165. To preserve the animation, save the Video Post data,
including Lens Effects animation, in the MAX file.

6902 | Chapter 22   Video Post



Procedures

To add an intermediate flag:

■ Click the gradient bar where you want to place the new flag.
The flag uses the color of the gradient at the point where you placed it. To
adjust the color, double-click to display the Color Selector on page 177.

To adjust the position of a flag:

■ Drag the flag left or right.
The gradient updates to show you the changes.

To delete a flag:

■ Drag the flag outside the gradient bar.
The flag turns red, and the mouse point changes to a down arrow pointing
to a bucket. When you let go of the mouse button, the flag is deleted.

To change a flag's properties:

1 Right-click the flag to display a menu.

2 Click Properties and change any settings you want.

Interface

Right-clicking a gradient flag and selecting Edit Properties displays the Flag
Properties dialog. To change gradient options on page 6904, right-click the
gradient bar, not the flags.
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The Flag Properties dialog lets you change the name of the flag, its color, and
its position.

Name By default, flags are named Flag #. You can enter a different name for
the current flag. The arrows to the right of the name box let you choose other
flags on the same gradient.

Color The Color swatch lets you control the color or brightness component
of the gradient at the position where the flag is located. Click the color swatch
to display the color picker and choose a different color. The green arrow to
the left of the color swatch indicates that this flag parameter can be animated
on page 6848.

Position Each gradient has 100 possible positions from left to right. The
number in the spinner represents the position of the flag along the gradient.
Gradients are read from left to right so a value of zero aligns the flag with the
left edge of the gradient. This flag parameter can be animated.

Gradient Options

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose a Lens Effects Filter from the Filter Plug-In list. > Setup > Gradient
tab

Each gradient in Lens Effects has a set of common options. Right-clicking the
gradient bar displays a shortcut menu with the following options.
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Interface

Reset Resets the gradient back to its default parameters. This action cannot
be undone.

Load Gradient Displays a file open dialog in which you can load a particular
gradient. Gradients are saved with a .dgr extension.

Save Gradient Displays a file save as dialog where you specify the path and
filename for the gradient.

Load UV Map Lets you load a bitmap image and use each row of pixels of
the bitmap as an animated gradient. When a bitmap is loaded into a gradient
control, Lens Effects reads the first 100 pixels across the top row of the image
(for the 100 divisions of its gradient controls) and makes them the gradient.
With each successive frame, Lens Effects reads in the next row of pixels as the
gradient. When you scrub the animation slider, you can see the gradient
change over time.

NOTE If the animation is longer than the chosen bitmap is tall, then the bitmap
pattern is repeated.

Load Bitmap Displays a 3ds Max file browser so you can select a bitmap to
use as your gradient. Unlike UV Map, the Load Bitmap option only reads the
first row of pixels for the entire animation. This is a good option when you
need to have a complex but static gradient.
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Flag Mode Indicates you are using flags to set the colors of your gradient
instead of using a bitmap as the source. Flag Mode is selected by default.

Compositing Methods

The last five options on the shortcut menu are different types of compositing
methods. When you work with Color and Transparency gradient controls in
any of the Lens Effects filters, you must be aware of both the Radial and Circular
gradients. Both Lens Effects color gradients and both Transparency gradients
are "locked together" and will work together based on the compositing method
you choose to create an effect.

Each compositing method works on a pixel-by-pixel basis on the positional
value in both gradients. The compositing methods define how the colors and
brightness values are combined to form a single color. When combining the
colors, the algorithms evaluate each color channel of the color to find the end
result. This lets you create five very different looking effects with the same
two gradients.

High Value When this option is selected, the higher color or brightness value
between the two gradients is selected. For example, if you had a color with
RGB values of 255,210,255 and another with 225,240,225, the resulting color
would be 255,240,255. This option generally results in a slightly brighter lens
flare than the default settings.

This is the most common way of using only one gradient. Set one gradient to
the color or brightness you desire, then set the other gradient to pure black.
This assures that all of the values you set in one gradient are used exclusively
to achieve the effect.

Average Calculates an average value between the colors. In the example above,
the resulting color would be 175, 225, 225. This option is good if you want
to mix gradient values and results in effects that are not as bright as High
Value.

Low Value Selects the lower color values, resulting in a less intense lens flare
and a more subtle overall effect. In the example above, the resulting color
would be 100,210,295.

Additive Adds colors values together, pushing their composite value toward
pure white, producing the brightest but most washed-out effects. Additive
compositing is good when you want to burn effects out.

Subtractive Subtracts colors values from each other, resulting in slightly muted
and less intense colors.
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These compositing methods may be applied to all types of gradients, except
size gradients. The type of compositing being used for a gradient is noted
above the gradient bar.

Compositing methods are applied to every gradient. Some gradients are linked
together, so if you assign a specific compositing method to one, the
compositing method is automatically assigned to the other.

Types of Gradients

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose a Lens Effects Filter from the Filter Plug-In list. > Setup > Gradient
tab

There are two different kinds of gradients in Lens Effects, Radial and Circular.
Between the two types, you can achieve almost limitless effects.

Interface

Radial Radial gradients work from the center point to the outer edge of a Lens
Effects feature, changing color or brightness in a straight line from left to right
as you scan the gradient bar. The left edge of the gradient is aligned with the
center of the effect and the right edge is aligned with the outer edge of the
effect.

Scheme of a radial gradient
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Circular Changes colors in a circular manner, working clockwise around a
Lens Effects feature. If you mark North, East, South, and West on a circle,
these points represent the 0%, 25%, 50%, and 75% marks of the gradient.

Each parameter panel in Flare, Glow, and Highlight that utilizes gradients
contain five gradient controls. The five controls are:

Scheme of a circular gradient

Color (Radial and Circular) Defines the colors used on page 6909 for an effect.
This is based on the RGB color system, but can also be set with HSV. Within
each set of gradient controls, there is a Radial and Circular Color gradient.
Radial Color works with Circular Color to produce the overall color for the
Lens Effects element.

Transparency (Radial and Circular) Varies the visibility of parts of the effect.
The transparency gradients only make use of brightness (or luminance) values,
which are essentially grayscale values. This black-to-white ramp of values
provides you with 256 levels of transparency for your effects. Just like the
Color gradients, both Transparency gradients are tied together to generate the
overall visibility of effect. See Gradient Options on page 6904.

Size Varies the size of specific parts of the Lens Effect. Most size gradients are
used to affect the radius of a lens flare part, such as a glow. Like transparency
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gradients, only the brightness values are used to provide you with 256 different
sizes.

The Radial Size gradient, for example, works both like a Radial and Circular
gradient. This gradient is applied in a clockwise fashion, starting at 12 o'clock.
The values in the gradient are applied from the center of the effect toward the
outer edge, with brighter values producing bigger sizes and darker values
producing shorter sizes.

Gradient Colors

Rendering menu > Video Post > Video Post toolbar > Add Image Filter Event
> Choose a lens effects filter from the Filter plug-in list. > Setup > Gradient
tab

Colors in 3ds Max are interpreted in two different ways: RGB and HSV. In
RGB (red, green, blue), you can select one of 256 shades of red, green, and
blue, giving you a palette of 16.7 million colors (24 Bit). In HSV (Hue,
Saturation, Value), you can select one of 256 hues of color, then adjust the
saturation or the value of the color. The saturation can also be considered the
blackness of a color and value can be considered the whiteness of a color.

For transparent and size gradients, you adjust the vertical whiteness slider just
to the left of the RGB and HSV sliders. The white triangle on the right side of
the vertical bar is the slider. This controls the overall value of the color in
terms of HSV. In RGB terms, it is the same as adjusting all three colors equally
at the same time. Higher values on the whiteness scale represent more
transparency, or smaller sizes.

See also:

■ Color Selector Dialog on page 391

Layer Events

Alpha Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
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the two events. > Video Post toolbar > Add Image Layer Event > Choose Alpha
Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select an Alpha
Compositor > Video Post toolbar > Edit Current Event

The Alpha compositor composites the two images using the alpha channel
on page 7905 of the foreground image. The background image appears in areas
where the foreground image's alpha channel is transparent.

Procedures

To use the Alpha Compositor filters:

1 Add two Scene or Image Input events to the queue.

2 Select both events and assign an Image Layer event consisting of the
Alpha Composite Filter.

3  Select the Image Layer event and click Edit Current Event.

Cross Fade Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer Event > Choose Cross
Fade Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Cross Fade
Compositor. > Video Post toolbar > Edit Current Event

The Cross Fade compositor composites the two images over time, cross-fading
from the background image to the foreground image. The rate of the cross
fade is determined by the length of the Cross Fade Transition filter's time
range.
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Cross Fade fades one image into another over time.

There are no setup options for this compositor.

Procedures

To use the Cross Fade Compositor:

1 Add two Scene or Image Input events to the queue.

2 Select both events and assign an Image Layer event consisting of the
Cross Fade Compositor.

Pseudo Alpha Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer Event > Choose
Pseudo-Alpha Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Pseudo-Alpha
Compositor. > Video Post toolbar > Edit Current Event

The Pseudo-Alpha compositor composites a foreground image against the
background by creating an alpha channel for the foreground image based on
the foreground image's upper-left-corner pixel. All pixels in the foreground
image that use this color become transparent.
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Pseudo Alpha compositing

Because only one pixel color becomes transparent, edges of the opaque areas
in the foreground image are aliased. Use this method when the foreground
image is a bitmap whose format does not have an alpha channel.

There are no setup options for this compositor.

There is also a Pseudo Alpha filter event on page 6842.

Procedures

To use the Pseudo Alpha Compositor:

1 Add two Scene or Image Input events to the queue.

2 Select both events and assign an Image Layer event consisting of the
Pseudo Alpha Composite Filter.

Simple Additive Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer Event > Choose Simple
Additive Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Simple Additive
Compositor. > Video Post toolbar > Edit Current Event

The Simple Additive compositor composites the two images using the second
image's intensity (HSV value) to determine transparency. Areas of full intensity
(255) are opaque; areas of zero intensity are transparent; and areas with
intermediate transparency are translucent.
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Additive compositing

This layer event can be useful when the second image is a bitmap whose format
does not have an alpha channel.

There are no setup options for this compositor.

Procedures

To use the Simple Additive Compositor:

1 Add two Scene or Image Input events to the queue.

2 Select both events and assign an Image Layer event consisting of the
Simple Additive Compositor.

Simple Wipe Compositor

Rendering menu > Video Post > Video Post window > Make sure the two child
events are in the order you want the Image Layer event to use them. > Select
the two events. > Video Post toolbar > Add Image Layer Event > Choose Simple
Wipe Compositor from the Layer Plug-in list.

Rendering menu > Video Post > Video Post window > Select a Simple Wipe
Compositor. > Video Post toolbar > Edit Current Event

The Simple Wipe compositor reveals or erases the foreground image with a
wipe transition. Unlike the Wipe filter on page 6843, the Wipe layer event moves
the image, sliding it in or out.

The rate of the wipe is determined by the length of the Wipe compositor's
time range.
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Wipe reveals an image by wiping from one side to the other, over time.

Procedures

To use the Simple Wipe compositor:

1 Add two Scene or Image Input events to the queue.

2 Select both events and assign an Image Layer event consisting of the
Simple Wipe Compositor.

3  Select the Image Layer event and click Edit Current Event.

4 Click Setup to display the Simple Wipe Compositor Setup dialog.

Interface
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Direction group

Right-pointing arrow Wipes from left to right.

Left-pointing arrow Wipes from right to left.

Mode group

Push Reveals the image.

Pop Erases the image.
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Managing Scenes and
Projects

These topics are concerned with managing scenes, projects, and the files that make them up.

Working with AutoCAD, Revit, and AutoCAD Architecture

3ds Max contains many features designed to streamline the design visualization workflow.
See Working with Drawing Files on page 6978. The File Link Manager on page 6987 allows you
to create a live link to a DWG file. You can then apply materials and animations in 3ds Max,
but still update your geometry if any changes are made to the original file.

File-Handling Commands

The principal commands for handling files on page 6919 are found on the default File menu
on page 7473, as in most Windows applications.

File-Handling Utilities

Several utilities help you manage files:

■ The Asset Browser on page 7132 provides another way to find and preview files and use them
in 3ds Max scenes

■ The Bitmap / Photometric Path Editor utility on page 7141 lets you view bitmap paths or
remove them from the scene file.

■ The File Finder on page 7143 is another resource for finding 3ds Max scenes.

■ The Resource Collector on page 7145 copies or moves a scene's bitmaps into a single directory.

■ The Fix Ambient utility on page 7147 resolves lighting issues with older versions of scene
files.

23

6917



■ The Bitmap Pager Statistics dialog on page 7150 provides information that helps you resolve
issues with scenes that require large amounts of memory for texture maps.

■ The Substitute modifier on page 1762lets you replace linked AutoCAD Architecture objects
with native 3ds Max geometry and objects.

Geometry File Formats

You can import a variety of geometry file formats on page 7161 into a scene.

Image File Formats

You can use image file formats on page 7324 in a variety of ways: as textures for materials, as
backgrounds to viewports, as background environments, as Image Input events in Video
Post, and as images projected from a light.

External References (XRefs) to Objects and Scenes

External references on page 6933 to objects and scenes are another powerful way to manage
a project, especially when it involves multiple contributors.

RAM Player

You can preview images by using the View File command on page 7127, or by using the more
interactive RAM Player on page 7374.

Scene Explorer

Scene Explorer on page 7379 is a powerful tool for organizing scene elements, selecting object
based on various criteria, changing object display properties, and creating and modifying
object hierarchies.

Scene States

The Scene States on page 7407 feature provides a fast way to save different scene conditions
with various properties that can be restored at any time and rendered to produce different
interpretations of a model.

Schematic View

Schematic View on page 7411 displays the scene as a graphic schema instead of as geometry.
It gives you an alternate way to select or rename the objects in your scene, and to navigate
among modifiers. It is especially useful for viewing objects in a hierarchy.
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Layers

Layers on page 7438 are like transparent overlays on which you organize and group different
kinds of scene information. The objects you create have common properties including color,
renderability, and display.

File-Handling Commands
The main file-handling commands are on the default File menu on page 7473.
These commands are for creating, opening, and saving scenes; importing and
exporting other 3D file formats; viewing a 2D image file; displaying or changing
a scene file's properties; exiting 3ds Max and other operations.

New on page 6920

Reset on page 6921

Open on page 6922

Open Recent on page 6927

Save on page 6927

Save As on page 6928

Save Copy As on page 6930

Save Selected on page 6931

XRef Objects on page 6936

XRef Scene on page 6959

File Link Manager Utility on page 6987

Merge on page 7058

Merge Animation on page 7063

Replace on page 7070

Load Animation on page 7077

Save Animation on page 7080

Import on page 7096

Export on page 7097

Export Selected on page 7099
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Asset Tracking on page 7100

Archive on page 7121

Summary Info on page 7122

File Properties on page 7124

View Image File on page 7127

Exit on page 7129

See also:

■ Asset Browser Utility on page 7132

■ Geometry File Formats on page 7161

■ Image File Formats on page 7324

■ RAM Player on page 7374

New

File menu > New

Keyboard > Ctrl+N

New clears the contents of the current scene without changing system settings
(viewport configuration, snap settings, Material Editor, background image,
and so on). The New command also gives you the option, when you use it
while a populated scene is active, to reuse objects from the current scene in
the new one.

Procedures

To create a new scene:

1 Choose File > New or press Ctrl+N.

2 In the New Scene dialog, specify the types of objects to keep, if any.

3 Click OK.
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Interface

The New Scene dialog has the following controls:

Keep Objects and Hierarchy Keeps the objects and the hierarchical links on
page 8002 between them, but removes any animation keys on page 8020.

NOTE If the current scene has any file links, 3ds Max performs a Bind operation
on all linked files.

Keep Objects Keeps the objects in the scene, but removes any links between
them and any animation keys.

WARNING This option should not be used when working with a scene containing
linked or imported objects.

New All (Default) Clears the contents of the current scene.

Reset

File menu > Reset

Reset clears all data and resets the program settings (viewport configuration,
snap settings, Material Editor, background image, and so on). Resetting restores
the startup defaults, saved in the file maxstart.max, and removes any
customization you might have done during the current session.
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Resetting has the same effect as exiting and restarting 3ds Max.

TIP To change the startup defaults, start 3ds Max and make the adjustments you
would like to see at startup. Then save the file to your scenes/ directory as
maxstart.max.

Procedures

If you have made changes since the last Save operation, a dialog prompts you
whether you want to save your changes.

To reset 3ds Max:

1 Choose File > Reset.

If you have made any changes since the last Save operation, a dialog
prompts you to save them. As further protection against data loss, a
confirmation dialog appears.

2 When asked if you really want to reset, click Yes.

Clicking No on this dialog cancels the Reset operation.

Open

File menu > Open

Keyboard > Ctrl+O

Open loads a scene file (MAX file), character file (CHR file), or VIZ Render file
(DRF File on page 7167) from an Open File dialog. You can also choose a
previously opened file and use command-line options on page 7468.

The MAX file type is a complete scene file.

A CHR file is a character file saved with Save Character. For more information
on the CHR file format, see Character Assembly on page 277 and Save Character
on page 303.

A DRF file is a scene file from VIZ Render, a rendering tool included with
AutoCAD Architecture (formerly Autodesk Architectural Desktop). The DRF
file type is similar to MAX files from previous versions of Autodesk VIZ.

If the file you're loading was created using plug-ins that are not installed, a
dialog lists them. You can still load the file, but any entities in the scene that
were created by the missing plug-ins are replaced with stand-ins; non-rendering
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boxes or placeholder modifiers. You can safely delete these from the scene,
unless you are sharing the scene with a user who has the plug-ins installed.

If the file you are loading contains bitmaps that cannot be located, a Missing
External Files dialog on page 7130 appears. This dialog lets you browse for the
missing maps, or continue opening the file without loading them.

Automatic Unit Conversion

When Respect System Units In Files is turned on in the System Unit Scale
group of the System Unit Setup dialog on page 7809, loaded files that have a
different scene unit scale display a File Load: Units Mismatch dialog on page
7815. This dialog lets you rescale the loaded scene to the current scene unit scale,
or change the current scene unit scale to match the one in the loaded file. No
conversion is done when loading files created in 3ds Max 1.x.

■ If you choose to match the units in the loaded file, the System Unit Scale
setting in the System Unit Setup dialog is changed to the setting in the
scene file.
This is the recommended choice, and it is the default in 3ds Max.

For example, if the current system unit scale is set to 1 unit = 1 inch, and
the incoming file was set to 1 unit = 1 foot, a sphere with a radius of 100
feet remains 100 feet.

■ If you rescale the file objects, the objects are scaled as if they had been
created using the current scene unit scale.
For example, if the current system unit scale is set to 1 unit = 1 inch, and
the incoming file was set to 1 unit = 1 foot, a sphere with a radius of 100
feet becomes 1200 inches in radius (assuming the unit display is set to
generic units).

If Respect System Units In Files is off (which is not recommended), 3ds Max
disregards the units chosen in the loaded scene file.

For example, a 100-unit radius sphere that was created in a 1 unit = 1 foot
scene becomes a 100-inch sphere in a 1 unit = 1 inch scene.

Procedures

To reopen a previously opened file:

■ From the bottom of the File menu, choose the file name.
You set the number of files listed by changing the Recent Files In File Menu
on page 7750 field on the Files panel of the Customize > Preferences dialog.
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To start 3ds Max and open a specific file:

■ In a command prompt window, specify the file name after the executable
name. For example:
“c:\Program Files\Autodesk\3ds Max 2009\3dsmax.exe” myproject.max

To start 3ds Max and open the last file you worked on:

■ In a command prompt window, type -L after the executable name:
“c:\Program Files\Autodesk\3ds Max 2009\3dsmax.exe” −l

Interface

The Open File dialog has standard Windows file open controls. At the right,
the Thumbnail area shows a preview of the scene whose file name is
highlighted in the list on the left.

TIP You can resize the dialog by dragging an edge or a corner.

 Clicking the plus button appends a sequence number to the file name
you entered, or increments the sequence number if the name already has one,
and then opens the file of that name, if it is present.

For example, if you have highlighted a file named test00.max, clicking the +
button changes the name to test01.max and then opens that file.
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Opening an Obsolete File

When opening a scene created in an earlier version of 3ds Max, you will see
an Obsolete File dialog.

If you resave the scene, you will overwrite the file. You can still edit it using
3ds Max, but you will no longer be able to edit it in earlier versions of the
software.

Don't display this message When turned on, you will not see the Obsolete
File dialog. The dialog is also controlled by the Display Obsolete File Message
switch on the Customize > Preferences > Files panel.

NOTE If you still need to open the scene using an earlier version of 3ds Max, use
File > Save As on page 6928 and save the file using a different name. Then you will
be able to open the orginal file with the earlier version.

Open from Vault

File menu > Open from Vault

The Open From Vault command lets you open a MAX file directly from
Autodesk Vault, the data-management provider included with 3ds Max. This
allows for secure control and versioning of assets used in the digital-content
creation process without the need to use the Vault client.

NOTE Open from Vault appears on the File menu only if you installed the Vault
plug-in, an optional part of the 3ds Max software installation

See also:

■ Asset Tracking on page 7099
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Procedures

To use Open From Vault:

1 Open the File menu and choose Open From Vault.

2 If you're not logged in to a provider, you're asked to log in via the Vault
Log In dialog on page 7105. Fill out the form and then click OK.

3 Use the Open File From Vault dialog to browse the vault and choose a
MAX file to open.

4 At this point, one of two things happens:

■ If the file is available for checkout, a dialog opens letting you know
that the file is under version control and asking you if you want to
check it out before making edits. Click Yes.

■ If another user has the file checked out, a dialog opens notifying you
of this and telling you that you won't be able to save edits. Click OK
to open the file in read-only mode. If you attempt to save this file, a
dialog appears notifying you that the scene file is read-only and will
not be overwritten.

5 If you attempt to open a different file or use the New or Reset command
while the file is checked out, a dialog appears asking if you want to check
the files back in. Enter a comment, if appropriate, and then click OK to
check the file in.

Alternatively, if you just want to create a new version on the provider,
turn on Keep Checked Out and then click OK. A new version will be
created, but the file will still be checked out to you.

Interface

NOTE If you haven't set a working folder, the following dialog appears when you
attempt to open a file from the vault:
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After you click OK, the Browse For Folder dialog opens, which you can use to
specify a working folder.

Open Recent

File menu > Open Recent

Open recent displays a list of recently opened and saved files. The list is sorted
in chronological order, with the most recent files at the top.

Procedures

To change the number of files displayed in the Open Recent list:

1 Choose Customize > Preferences > Files tab > File Handling.

2 Set a value for Recent Files In File Menu. The upper limit is 50.

Save

File menu > Save

Keyboard > Ctrl+S

Save updates the current scene by overwriting the last save of the scene. If no
scene was previously saved, this command works like Save As on page 6928.

See also:

■ Save As on page 6928

■ Save Copy As on page 6930

Saving to an Obsolete File

When you open a file that was created with an earlier version of the software,
and then attempt to save it in a current version of 3ds Max, an alert is
displayed, warning you are about to overwrite the obsolete file.

Open Recent | 6927



Choose Yes to go ahead and overwrite the original file, No to stop the Save.
If you choose No, you can use Save As on page 6928 to save the file under a
different name.

If you save to the original file name, you can still edit it using the current
version of the software, but you will no longer be able to edit it in earlier
versions of 3ds Max.

Interface

When you save a scene, you also save the program settings. When you open
the file again, it opens with the same viewport configuration, view and zoom
levels, snap and grid settings, and so on.

You can incrementally number saved files, and make automatic backup files
at specified time intervals. These options, Increment On Save and Backup On
Save, are on the Files panel on page 7750 of the Preference Settings dialog.

Save As

File menu > Save As

Save As lets you save the current scene filein MAX or CHR format under a
different file name.

A CHR file is a character file saved with Save Character. For more information
on the CHR file format, see Character Assembly on page 277 and Save Character
on page 303.
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NOTE 3ds Max lets you number saved files incrementally and make automatic
backup files at specified time intervals. The options to set up Increment On Save
and Backup On Save are on the Files panel on page 7750 of the Preference Settings
dialog.

See also:

■ Save on page 6927

■ Save Copy As on page 6930

Procedures

To save a file to a different name:

1 Choose File > Save As.

2 Do one of the following:

■ Enter a name in the File Name field.

■ Click the Increment button.

Interface

The Save File As dialog has standard Windows file save controls. At the right,
the Thumbnail area shows a preview of the scene whose file name is
highlighted in the list on the left.

TIP You can resize the dialog by dragging an edge or a corner.
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 Clicking the plus button appends a sequence number to the file name
you entered, or increments the sequence number if the name already has one,
and then saves the file to that name.

For example, if you have highlighted a file named test00.max, clicking the
plus button changes the name to test01.max and then saves test01.max.

Save Copy As

File menu > Save Copy As

Save Copy As allows you to save a copy of the current scene under a different
file name. It does not change the name of the file being worked on.

IMPORTANT Save Copy As does not update the original file name as Save does,
and Save does not update the file you last saved using Saved Copy As. For example,
if you make edits to a 3ds Max scene named filename.max, then use Save Copy
As with the file name filename01.max, make additional edits, and then click Save,
your second set of edits will be saved as filename.max but not as filename01.max.

See also:

■ Save on page 6927

■ Save As on page 6928

■ Auto Backup on page 7750

Procedures

To save a copy of the file to a different name:

1 Choose File > Save Copy As.

2 Browse or type the name of the file you want to create or update.

3 Click the Save button.
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Interface

Save Copy As displays a standard Windows save dialog. Save Copy As
increments the number at the end of the file name in order to propose unique
but similarly-named files each time the command is used.

Clicking the Save button saves the file to the name displayed in the File Name
text box.

TIP You can resize the dialog by dragging an edge or a corner.

 Clicking the plus button saves the file with a name ending in a number
one increment greater than that displayed in the File Name text box.

Save Selected

Select objects to save. > File menu > Save Selected

Save Selected saves the selected geometry as a scene file under a different file
name.

Identically named bitmaps with different properties are stored as different
files. Objects linked to a selected object are also saved. The following
dependencies are preserved for a Save Selected operation:

■ Ancestors of selected child objects are saved, all the way to the root of the
hierarchy.
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■ Space Warps to which selected objects are bound are saved.

■ IK follow objects to which selected objects are bound are saved.

Procedures

To save selected objects to a new file:

1 Select one or more objects.

2 Choose File > Save Selected.

3 Enter a name in the File Name field.

4 Click Save.

Set Project Folder

File menu > Set Project Folder

You can set a project folder when setting up a project, to provide a simple
way of keeping all of your files organized for a particular project. When you
open 3ds Max for the first time, the project folder defaults to the install folder,
but you can set the folder to a different location. When you set the project
folder, 3ds Max automatically creates a series of folders within it such as scenes
and renderOutput. Saving or opening files from the browser defaults to this
location.

Using a consistent project folder structure among team members is a useful
practice for both organizing and sharing files. You can also set the project
folder from the Asset Tracking Dialog on page 7100 > Paths menu.

Procedures

To set the project folder from the File menu:

1 Choose File > Set Project Folder.

2 Choose a path from the browser and click OK to set your project folder.
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Interface

Use the browser controls to navigate the disk structure to the project folder
to use, highlight the folder name, and then click OK.

Make New Folder Click this to create a folder named New Folder within the
highlighted folder. When first created, the folder name is highlighted so that
you can edit it; use the keyboard to rename the folder, or press Enter to accept
the default name.

External References (XRefs)

You can use two kinds of externally referenced files (XRefs): XRef Objects on
page 6936 and XRef Scenes on page 6959. Using these external references allows
for a team approach to animation, where the modeling, materials, transform
controllers, and animation can be handled in separate files by different artists.
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It can also make large files much easier to deal with through the use of proxy
objects.

You access the XRef Objects and XRef Scenes commands from the File menu.

The two types of references have distinct purposes:

■ An externally referenced scene displays the entire contents of an external
MAX file in the current scene. The objects within the external file are
visible as a reference but cannot be selected. This prevents accidental
changes to the referenced scene while allowing functionality such as Snap,
AutoGrid, and Clone and Align to position local objects in context, as well
as to pick objects as the target location for the clones. If you need to move,
rotate or scale the referenced scene, you can bind it to a local object.
Transforming the object the externally referenced scene was bound to will
transform all objects in the externally referenced scene. Scene externally
referenced objects can also be used as reference coordinate system on page
967. When changes to the externally referenced file are saved (such as objects
added, edited or deleted), an Update of Xref Scene will inherit those changes
locally.

■ Externally referenced objects appear in the scene and can be animated.
Depending on the object's XRef settings, you might or might not be able
to edit the object’s entities such as its transforms, materials, manipulators,
or modifiers. You can add modifiers and apply transform animation to the
referenced objects, but you cannot inadvertently change the model’s
structure. Referenced objects allow for the substitution of a proxy object,
so you can animate a low-polygon version of a complex model and then
render the polygon-intensive version.
You can also reference transform controllers externally in addition to
materials. This is part of the process of referencing objects, or you can also
use the special XRef controller on page 3269 or XRef material on page 5765,
respectively. By default, when referencing an object, its material and
transform controller is also referenced. Alternatively, you can create an
XRef controller or an XRef material that allows for referencing a transform
controller or a material from an external MAX file. These external references
can be assigned to any object in the scene, whether or not the object is
externally referenced.

NOTE Any atmospherics applied in an XRef object's source file will be carried
into the scene. Render Effects assigned to XRef objects are not externally
referenced.

6934 | Chapter 23   Managing Scenes and Projects



The use of referenced objects and scenes allows several people to work
collaboratively on the same objects as the work progresses, without having to
wait for the objects to be finalized. You can choose to have the objects update
automatically, as soon as changes are saved to the original file, or to update
manually, on demand.

There are also tools for easy conversion of scene objects into referenced objects,
and a button to merge referenced objects into the scene as normal objects.

Objects in a scene can be externally referenced, created and maintained by other users.
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XRef Objects

File menu > XRef Objects

Externally referenced objects, XRef objects, appear in your master (current)
scene, but are actually referenced from external 3ds Max files. As a result, the
source objects are protected from modifications you make to the XRef objects.
Updates or changes made to the source objects are also updated in the master
file when the source scene is reloaded. However, if an XRef object’s entities
are merged, the controls are local and can be modified. Therefore, they no
longer reference the original attributes.

For example, if you set the Modifiers option on page 6946 of the XRef Objects
dialog on page 6941 to XRef or Ignore, the only entry in the modifier stack will
be “XRef Object.” You can add additional modifiers to the object, but you
cannot access the original ones unless you merge the XRef object into the
scene. If you merge the modifiers into the master scene, you can edit them
in the stack. However, changes that you make to the modifier stack in the
master file have no effect in the source file.

An externally referenced object can be animated in the master file only if its
transform controller has been merged. In other words, no animation can be
added or blended with an XRef controller. However, an offset can be added,
but it then applies to the whole animation, and the offset cannot be animated.

NOTE The XRef behavior of world-space modifiers is different than the object-space
modifiers. World-space modifiers are not externally referenced. They are always
merged.

Transforms and manipulators in your source file will be treated according to
the Merge Transforms and Merge Manipulators setting in the XRef Objects
dialog.
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Objects in a scene can be XRefs from other scenes. They can be transformed and
positioned in the scene using a local offset.

When an XRef object is loaded into the master file, it can have an XRef material
on page 5765 as well as an XRef controller on page 3269 assigned to it. You can
either merge the material and transform information or you can maintain it
as a live connection with the source file.

XRef objects can be modified or transformed in your master scene just like
any other object. XRef objects also allow the use of proxy objects to stand in
or substitute for geometry. Use XRef objects to manage the complexity of your
master scene during animation by substituting “lightweight” proxy objects
for more complex geometry.

You can create a proxy by simplifying a clone of your existing model or you
can build simple substitute objects like boxes or cylinders, or you can save a
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copy of the model in the early stages of modeling before you add the detail.
You can even use an object from another scene.

A proxy object is substituted in the scene, but the reference to the real object is always
available.

Choosing XRef Objects displays the XRef Objects dialog on page 6941, where
you add externally referenced objects, transforms, and materials to your master
scene, and control their visibility, merge states, and other options.

If your XRef object relies on another object in the source scene, the relationship
will not be automatically preserved in the destination file. Examples of this
include objects with path constraints, atmospherics, particle arrays with object
emitters, or space warps bound to an object. To preserve the relationship
between the source objects in the master file, in the XRef Merge dialog, enable
Display Influences and select the object's influences. Objects that influence
each other must be referenced in the same record to maintain the relationship.

NOTE Render effects such as glow or flare are not carried in XRefs. To use render
effects from the source file, merge them in using the Merge buttons found in the
Environment And Effects dialog.
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Procedures

To add an XRef object:

1 Choose File > XRef Objects.

The XRef Objects dialog enables you to choose to Merge Transforms,
Merge Materials, and Merge Manipulators.

NOTE If you want to maintain externally referenced entities (transforms,
materials, manipulators, or modifiers), make sure Merge Transforms, Merge
Materials, and Merge Manipulators are off and the Modifiers setting is set to
XRef before you proceed to the next step.

TIP To include all objects, including influences, transforms, and materials,
and bypass the XRef Merge dialog, turn on Include All on the XRef Objects
dialog before you click Create XRef Record From File.

2  Click the Create XRef Record From File button in the XRef Objects
dialog. The Open File dialog appears. Choose the file you want by
highlighting it in the list, then click Open. The XRef Merge Dialog on
page 6956 appears.

If the Merge Manipulators toggle is off before you click Create XRef Record
From File, manipulators applied to XRef objects are linked to the
(externally referenced) source file. In a similar way, the Modifiers
drop-down list gives you three alternatives for how to handle object
modifiers.

If the Merge Materials toggle is off before you click Create XRef Record
From File, materials applied to XRef objects are linked to the (externally
referenced) source file. If Merge Materials is on, the materials are merged
with the master scene.

If the Merge Transforms toggle is off before you click Create XRef Record
From File, transforms applied to XRef objects are linked to the (externally
referenced) source file and cannot be keyframed in the master file. If
Merge Transforms is on, the transforms are merged with the master scene
and can be keyframed.

3 Select the objects that you’d like to appear in your master scene as XRef
objects.

You can choose as many as you want by holding down the Ctrl key and
highlighting them in the list. If the source scene has a lot of object types
you don't need to include, you can filter the list by using the List Types
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radio buttons. Use the All button to select all of the entries, the None
button to select no entries and the Invert button to highlight the opposite
of your current selection. You can also choose to display Influences and
Select Influences.

4 The XRef record appears in the upper list of the XRef Objects dialog and
has the same name as its source file. The externally referenced entities
appear in the lower list, where an entity can be either an object, a
controller, or a material. Make additional choices at this time if you like.
You can control how the objects will update (either automatically or on
demand). Updating is done at the XRef record level: all objects, transforms,
and materials from a single XRef record are updated at the same time.

To substitute an XRef object with a proxy object:

With proxy objects, you can avoid loading your detailed model in memory,
and speed up the time of test renderings.

1 Select an XRef object.

2  On the Modify panel > Proxy rollout, click the Browse button, and
use the File Open dialog to choose the file that contains the proxy.

The XRef Merge dialog appears.

3 Pick the object to use as a proxy.

When you have picked the proxy object, the Enable toggle should turn
on.

4 Turn on Use In Rendering to use the proxy object in renderings.

To add objects to an XRef record:

1 In the XRef Objects dialog, highlight an XRef record (in the top list) that
contains objects that have not already been added to the scene.

2  On the Entities List toolbar (the lower toolbar), click Add Objects.

This button is not available if all of the objects in the source file have
already been added to the XRef record.

The XRef Merge dialog appears.

3 Highlight the objects that you want to add as XRefs, and then click OK.
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The selected objects are added. Depending on the dialog settings,
transforms and materials might also be added as external references.

To change an XRef object into a scene object:

■  Highlight the XRef object in the Entities list (the lower list), and
then click Merge In Scene. The XRef object becomes a full-fledged object
in the scene, giving you access to its modifier stack.

TIP This button is also available in the upper Records list, where it merges all
entities from the highlighted source record into the master (current) scene.

XRef Objects Dialog

File menu > XRef Objects > XRef Objects dialog

The XRef Objects dialog provides the interface for loading XRef entities into
your master scene (the scene where you create the XRefs) from a source scene
(the scene file that contains the entities that you want to externally reference).
XRef entities can be XRef objects, transform controllers, materials, and
manipulators. An XRef record can be made up of one or more XRef entities.

The XRef Objects dialog is divided into the XRef Record section at the top
and the XRef Entities section at the bottom. The XRef Objects dialog provides
controls to add and remove XRef objects, controllers, and materials.

When you create XRefs, the mapping between each externally referenced item
and their source items is unique. This allows correct external referencing of
source items with identical node names. However, if you retarget an externally
referenced item by choosing a source object name that is not unique in the
source scene, 3ds Max might not map the externally referenced item to the
desired source object.
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Interface

TIP You can resize the XRef Objects dialog. This can be useful if you want to see
all of the columns in the XRef Entities list. You can also adjust the relative height
of the two lists in the dialog: Drag the horizontal line that is just above the XRef
Entities toolbar (the lower of the two toolbars).

XRef Record toolbar

Use these tools to create and update XRef records.

 Create XRef Record from File Launches an Open File dialog so you
can select the source file for your XRef record. When you a select a file, the
XRef Merge dialog on page 6956 appears.

Any transform animation assigned to the source objects can be merged along
with the XRef object, but it will not be updated with the source object.

NOTE If you want to maintain externally referenced transforms, materials, and
manipulators, make sure Merge Transforms, Merge Materials, and Merge
Manipulators in the XRef Objects dialog are off before you click Create XRef Record
from File.
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 Remove XRef Record Deletes the highlighted XRef record(s) after you
confirm the action. All entities associated with the highlighted record(s) are
removed from the scene.

NOTE Once you have removed an XRef record, you cannot undo this action.

 Combine XRef Records Click to combine the contents of more than
one XRef record from the same source file into one record. This is useful when
you want to clean up the organization of your XRef records. Rather than
having multiple records of the same file, you can group all of the objects,
controllers, and materials from that file under the same record. This button
is available only when you highlight two records that refer to the same file
name and path; both records must have identical settings. XRef records must
refer to the same file with the same XRef entities. Combine XRef Records only
allows you to consolidate all of the entities of one file into one XRef record
entry. It does not allow you to combine the contents of different files, even
if the files have the same name.

NOTE Nested externally referenced records cannot be combined.

 Update Refreshes the contents of the selected XRef record. If the objects,
controllers, materials, or manipulators referenced have changed in the source
scene, you will see these changes in your master scene.

NOTE The changes must be saved in the source file before you see them in the
master file. If you remove externally referenced entities from the master file using
the Delete XRef Entity button, these entities will not be externally referenced when
you update the XRef record, even though they continue to exist in the source
scene.

NOTE Reloading XRef items works correctly even when an object in the source
scene has been renamed, or deleted and then re-created with the exact same
name, including character case. However, if the source scene contains several
nodes with the same name, an XRef item corresponding to a node whose name
is not unique in the source scene might not necessarily resolve as you expect
during the update process. For best results, maintain unique names for all nodes
in the source scene.
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WARNING If you update an XRef in a scene with radiosity on page 6168, probably
this will invalidate the radiosity solution. After you update the XRef, reset the
radiosity solution and then recalculate it.

 Merge In Scene Converts all XRef entities of the highlighted record
into native (local) entities in your master scene. The objects, controllers,
materials, and manipulators are no longer referenced from the source file but
become part of your master scene. A prompt appears so you can confirm the
action. Since a merged XRef entity becomes part of the scene and is no longer
an XRef entity, its name is removed from the XRef Entities list. This works on
a XRef record basis, so all entities belonging to the highlighted XRef record
are converted. The contents of the source file are not affected by this button.

Merging an XRef object loads the full modifier stack of the source object into
the master scene (your current scene), while maintaining any additional stack
items that were added while the object was an external reference. Thus, you
can use Merge In Scene to update an object that has been modified as an
external reference. Similarly, merging an XRef controller into the master scene
maintains any offset transformation you might have applied to the controller
in the master scene.

 Convert Selected Object(s) to XRefs Creates a source file for currently
selected objects. This means that you can select objects in the current scene,
including their transform controllers and materials, and then save them to a
separate scene file. This file is then listed as an XRef record that contains the
entities you selected.

NOTE This option can be used on both—native (local) objects or externally
referenced objects. If you use it for an object that is already an XRef object, it
creates a nested XRef. Nested XRefs still behave as you expect, but they can reduce
performance when you open a scene or render it.

 Select Selects all entities that belong to the currently highlighted XRef
record or records. To add highlighted records’ entities to the selection, hold
Ctrl while clicking Select. To remove highlighted records’ entities from the
selection, hold Alt while clicking Select.

 Select by Name Opens the Select Objects dialog on page 228, which
lists all objects and highlights those belonging to the currently highlighted
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XRef record, as well as objects selected in the scene. Use this dialog to select
XRef objects.

 Highlight Selected Objects' XRef Records Based on the object(s)
selected in the scene, the corresponding record(s) that contain these objects
are highlighted in the XRef Objects dialog.

XRef Record list

Displays the names of the source files that contain the source objects used as
XRef objects in the current scene. These files are added using the Create XRef
Record button and removed using the Remove XRef Record button.

To see the full path of the source file, move the cursor over the name of an
XRef record. The full path is displayed in a tool tip.

If a source file itself contains external references, a plus/minus icon appears
to the left of its name. Click the icon to expand or collapse the display of
nested XRef entries. Nested XRef records that are missing and unresolved are
displayed in gray.

Right-clicking the XRef Record list displays a pop-up menu on page 6951 that
has additional options for managing the list and its records.

Enabled Turn off to disable all XRef objects referenced from the MAX files
currently highlighted in the XRef Record list. Disabled external reference files
and objects are are not loaded into memory. Default=on.

Include All If you turn this on before you add an XRef record, all the objects
in the source file are included as external references. This option bypasses the
XRef Merge dialog. Default=off.

If you create an XRef record when Include All is turned off, only those entities
selected for that XRef record (in the XRef Merge dialog) will be a part of the
record: any new objects created in the source file will not be part of the record.
If Include All is turned on when you create a record, any new objects created
in the source file will be included in the XRef record when you reopen or
Update the master file. If Include All is turned on before a record is updated
(after the first XRef), all new objects will be included in the XRef, but turning
if off later will not remove them from the record.

If the source scene includes nested external references, using Include All can
cause some confusion if you are not careful about your tree of scenes. Consider
the following arrangement:

master.max (Include All) --> a.max (Include All) --> b.max
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If you later open b.max, create objects, and save it, then open master.max
without first opening and saving a.max, you won't see the new objects created
in b.max. The scene master.max is simply reading a.max, and since a.max hasn't
changed, the new objects aren't present.

Automatic Update When on, changes made to externally referenced objects,
controllers, materials, and manipulators in the source scene are automatically
updated in the master file as soon as the source file is saved. There's no need
to click Update. Default=off.

NOTE You can change the state of Enabled, Include All, and Automatic Update
after a record is created.

Merge Transforms When on, combines all objects' externally referenced
transform controllers from the source file into the master file. This means that
the transform controllers will be loaded in the master file but will then no
longer have a live connection with the source file. This is useful if you don't
require the live connection, and want to alter the transform controllers in the
master scene without losing your edits upon Update. Default=off.

To use Merge Transforms, you must turn on this option before you add the
XRef record (source) file.

Merge Materials When on, combines all externally referenced materials from
the source file into the master file. This means that the materials will be loaded
in the master file but will then no longer have a live connection with the
source file. This is useful if you don't require the live connection, and want
to alter the materials in the master scene without losing your edits upon
Update. Default=off.

To use Merge Materials, you must turn on this option before you add the XRef
record (source) file.

When Merge Materials is on and there are name conflicts between materials
in the target scene and materials in the XRef source scene (or between materials
in two XRef records), 3ds Max displays a Duplicate Name dialog on page 5368
so you can resolve the conflicts.

Merge Manipulators  When on, any manipulator on page 2636 applied to the
XRef object in the source file is combined into the scene. Manipulators are
applied to the XRef object and can be changed. However, these changes have
no effect in the XRef source file. Default=off.

To use Merge Manipulators, you must turn on this option before you add the
XRef record (source) file.

Modifiers Determines how modifiers from the source file will be loaded into
your master file. Modifiers are not listed as XRef entities. To see an XRef
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modifier on the Modify panel, you must use the Merge option. Otherwise,
you have the choice of either not merging the modifier information at all
(with the Ignore option) or merging the information with the object with the
XRef Modifiers option.

You must choose the Modifiers option before you add the XRef record (source)
file.

■ XRef Modifiers are contained within the XRef object and cannot be
changed in the master scene. When you load the external reference file,
you will see the results of the modifier but they will not be listed separately
from the object on the Modify panel. Additional modifiers can be applied
to the XRef object, and will be a part of the scene; however, they will not
be reflected back to the source file.

NOTE World-space modifers remain at the top of the modifier stack and are
not merged with XRef objects.

■ Merge Modifiers assigned to the XRef object (in the source file) are
merged into the master scene. When you load the external reference file,
you will see the changes caused by the modifier and they will appear in
the modifier stack in the Modify panel. The modifiers are copies of the
original source modifiers. Although they inherit their original state, updates
to the XRef will not overwrite changes made in the master scene. However,
these changes are not reflected in the source file.

■ Ignore Any modifiers assigned to the XRef object (in the source file) are
disregarded and the base object is brought into the master scene as an XRef
object. When you load the external reference file, the modifiers are not
applied to the object so the modifications in the source file will not be
reflected in the master file.

Although the Merge Transforms, Merge Materials, Merge Manipulators, and
Modifiers settings are disabled after you add a record, when you highlight the
record in the XRef Record list, the toggles and list field show the settings used
when the record was created.

XRef Entities toolbar

 Add Objects Click to add further entities to the highlighted XRef record.
This button is available only when the highlighted XRef record contains
objects that you have not yet referenced externally. The XRef Merge dialog
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appears, with a list of the available objects. Highlight the objects to reference
externally, and then click OK.

NOTE If new objects have a relationship in the source file with objects that are
already in a record in the master file, update the record after Add Objects to refresh
the relationship. For example, if a car is referenced in a master scene, and the car
is later constrained to a new path in the source scene, adding the path with Add
Objects will not put the master car on the path. To do that, update the record.

 Delete XRef Entity Click to delete the highlighted XRef. An alert
prompts you to confirm the action. All highlighted entities are removed from
the scene. You can delete XRef objects, controllers, or materials.

NOTE Deleting XRef controllers is equivalent to merging them into the master
scene. The reason for this is that nodes must have a transform controller at all
times, in order to be positioned in the scene. Deleting XRef materials is equivalent
to merging them into the master scene. This action could could impact all objects
in the master scene that use an XRef material, and could have implications difficult
to be foreseen.

 Merge In Scene Merges the current selection in the XRef Entities list
into the master scene (the current scene). Use this button to change XRef
objects, controllers, or materials into objects, controllers, or materials that are
native to the current scene. The connection between the external entity from
the source scene and your master scene is broken, and the object, controller,
or material that you merged is no longer updated when the source scene
changes.

3ds Max prompts you to confirm the merge.

Since a merged XRef object becomes part of the scene and is no longer an
XRef object, its name is removed from the list.

Merging an XRef object loads the full modifier stack of the original object,
while maintaining any additional stack items that were added while the object
was an XRef object. Thus, you can use Merge to update an original object that
has been altered as an external reference. If you do this, use Convert Selected
Object(s) to XRefs to save out the “improved” original into a file, which then
can be merged back into the original source.
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NOTE It is also possible to merge into the master scene nested XRef entities. Once
they are merged, all externally referenced nesting levels are removed and the
scene entity from the lowest level source scene is merged into the master scene.
In case of XRef objects, modifiers applied in a nested source file are all merged
and present in the master scene.

 List Objects When on, shows the XRef objects for the current XRef
record in the XRef Entities list.

 List Materials When on, shows the XRef materials for the current XRef
record in the XRef Entities list.

 List Controllers When on, shows the XRef controllers for the current
XRef record in the XRef Entities list.

NOTE You can enable any combination of the List buttons to show certain types
of entities and hide others.

 Select Selects in the scene the XRef entities currently highlighted in
the XRef Entities list. To add highlighted entities to the selection, hold Ctrl
while clicking Select. To remove highlighted entities from the selection, hold
Alt while clicking Select.

 Select by Name Opens the Select Objects dialog on page 228, which lists
all objects and highlights the XRef objects selected in the XRef Entities list,
as well as any objects selected in the scene. If an XRef controller or XRef
material is highlighted in the XRef Entities list, the Select Objects dialog
highlights the object to which the XRef controller or material belongs to.

 Highlight Selected Object's XRef Records When XRef objects are
selected in the scene, the XRef record to which they belong is highlighted in
the XRef Record list and the XRef objects and their XRef entities are highlighted
in the XRef Entities list.
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XRef Entities list

Displays the XRef objects, controllers, and materials that belong to the record
that is currently highlighted in the XRef Record list. If no source file is
highlighted, this list is empty.

Right-clicking the XRef Entities list displays a pop-up menu on page 6954 that
has additional options for managing the list as well as the objects, controllers,
and materials in it.

The XRef Entities list includes the following information for each XRef entity:

■ Scene Name Name of the entity in the master (current) scene. By default,
the name of the entity in the master scene is the same as the name of the
entity in the source file. If you change the name of the entity on the
command panel on page 7631, the name will update in the XRef Entities
list.

■ Source Name Name of the entity in the source file. You cannot change
this name from the master file. If the name of the entity changes in the
source file, the XRef in the master file will become unresolved.

■ Type Whether the entity is an XRef object, controller, or material.

■ Status
Usually this field displays “XRef Resolved” to indicate that the XRef is
valid. When an external reference is unresolved this field displays
“Unresolved XRef” An unresolved XRef indicates that there is no longer a
connection between the entity in your master file and the source file. This
can happen for a number of reasons. For example, the entity in the source
file might have been renamed or deleted, or the file cannot be found.

NOTE If you resolve the cross reference, the XRef will be resolved again when
you click Update.

■ Proxy Whether a proxy is enabled for the entity. You enable and disable
proxies for XRef entities on the Proxy Object rollout. Displays “–––” when
the proxy is disabled and “Enabled” when the proxy is enabled.
You can assign a proxy object using the Proxy Object rollout on page 6974.

■ Proxy Render Whether the proxy will be used in the rendering. Displays
“–––” when the XRef object will be rendered and “Enabled” when the
proxy object will be rendered.

■ Proxy Name Name of the proxy object that will be used as the XRef
object.
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■ Proxy File Name Name of the file that contains the proxy object to use
for the XRef object.

■ Proxy Path Path of the file for the proxy object to use for the XRef object.

XRef Record List Right-Click Menu

File menu > XRef Objects > XRef Objects dialog > Right-click the list of XRef
Record list.

This contextual menu appears in the XRef Objects dialog on page 6941 when
you right-click the XRef Record list. It provides additional options for managing
the list.

Some of the options on this menu are unavailable unless you have highlighted
an XRef record.

Interface

Create XRef Record from File Launches an Open File dialog so you can select
the source file for your XRef record. When you a select a file, the XRef Merge
dialog on page 6956 appears.

Any transform animation assigned to the source objects can be merged along
with the XRef object, but it will not be updated with the source object.

NOTE If you want to maintain externally referenced transforms, materials, and
manipulators, make sure Merge Transforms, Merge Materials, and Merge
Manipulators in the XRef Objects dialog are off before you click Create XRef Record
from File.

Remove XRef Record Deletes the highlighted XRef record(s) after you confirm
the action. All entities associated with the highlighted record(s) are removed
from the scene.

NOTE Once you have removed an XRef record, you cannot undo this action.

File Submenu

Open Opens the source file. If you have not saved changes to the (current)
master file, 3ds Max prompts you to do so.
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Browse Displays the Open File dialog that enables you to browse for a new
source file. The file you choose replaces the highlighted XRef record in the
XRef Objects dialog. Available only when a single file is highlighted.

Reveal Location in Explorer Launches Windows Explorer, open to the folder
in which the highlighted source file resides with the source file highlighted.
Available only when a single file is highlighted.

Strip Path Removes path information from the file name, saving only the file
name. The source file location is saved relative to the master file location.

WARNING If you strip the path before you have saved the master file, the record's
XRefs can become unresolved. This is because there is no location for the Untitled,
unsaved MAX scene.

Resolve Path to UNC Location If the record's file name has had its path
stripped, this option restores the full path name.

Combine XRef Records Click to combine the contents of more than one
XRef record from the same source file into one record. This is useful when
you want to clean up the organization of your XRef records. Rather than
having multiple records of the same file, you can group all of the objects,
controllers, and materials from that file under the same record. This option
is available only when you highlight two records that refer to the same file
name and path; both records must have identical settings. XRef records must
refer to the same file with the same XRef entities. Combine XRef Records only
allows you to consolidate all of the entities of one file into one XRef record
entry. It does not allow you to combine the contents of different files, even
if the files have the same name.

NOTE Nested externally referenced records cannot be combined.

Update Refreshes the contents of the selected XRef record. If the objects,
controllers, materials, or manipulators referenced have changed in the source
scene, you will see these changes in your master scene.

NOTE The changes must be saved in the source file before you see them in the
master file. If you remove externally referenced entities from the master file using
the Delete XRef Entity button, these entities will not be externally referenced when
you update the XRef record, even though they continue to exist in the source
scene.
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WARNING If you update an XRef in a scene with radiosity on page 6168, probably
this will invalidate the radiosity solution. After you update the XRef, reset the
radiosity solution and then recalculate it.

Select Selects the entities that belong to the currently highlighted XRef record.

Select by Name Opens the Select Objects dialog on page 228, which lists all
objects and highlights those belonging to the currently highlighted XRef
record. Use this dialog to select XRef objects.

Highlight Selected Objects' XRefs Records Based on the object(s) selected
in the scene, the corresponding record(s) that contain these objects are
highlighted in the XRef Objects dialog on page 6941.

Highlight All Highlights all XRef records in the XRef Record list.

Highlight Inverse Highlights all XRef records in the XRef Record list except
the currently highlighted record(s).

Highlight None Turns off highlighting for any XRef records currently
highlighted in the XRef Records list.

Hide All Unresolved Hides all unresolved XRef records in the XRef Record
list.

Select All Unresolved Highlights all unresolved XRef records in the XRef
Record list.

Merge In Scene Converts all XRef entities of the highlighted record into native
(local) entities in your master scene. The objects, controllers, materials, and
manipulators are no longer referenced from the source file but become part
of your master scene. A prompt appears so you can confirm the action. Since
a merged XRef entity becomes part of the scene and is no longer an XRef
entity, its name is removed from the XRef Entities list. This works on a XRef
record basis, so all entities belonging to the highlighted XRef record are
converted. The contents of the source file are not affected by this option.

Merging an XRef object loads the full modifier stack of the original object into
the master scene (your current scene), while maintaining any additional stack
items that were added while the object was an external reference. Thus, you
can use Merge In Scene to update an object that has been modified as an
external reference. Similarly, merging an XRef controller into the master scene
maintains any offset transformation you might have applied to the controller
in the master scene.
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Convert Selected Object(s) to XRefs Creates a source file for the currently
selected objects. This means that you can select objects in the current scene,
including their transform controllers and materials, and then save them to a
separate scene file. This file is then listed as an XRef record that contains the
entities you selected.

NOTE This option can be used on both—native (local) objects or externally
referenced objects. If you use it for an object that is already an XRef object, it
creates a nested XRef. Nested XRefs still behave as you expect, but they can reduce
performance when you open a scene or render it.

XRef Entities List Right-Click Menu

File menu > XRef Objects > XRef Objects dialog > Right-click the list of XRef
entities (objects and materials).

This contextual menu appears in the XRef Objects dialog on page 6941 when
you right-click the XRef Entities list. It provides additional options for
managing the list.

Some of the options on this menu are unavailable unless you have highlighted
an XRef entity.

Interface

Add Objects Displays the XRef Merge dialog on page 6956 so you can add entities
to the XRef Entities list.

If all entities in the source scene are already externally referenced, this choice
has no effect.

Delete XRef Entity Deletes the highlighted XRef entities from the scene.

An alert prompts you to confirm the action.

NOTE Deleting XRef controllers is equivalent to merging them into the master
scene. The reason for this is that nodes must have a transform controller at all
times, in order to be positioned in the scene. Deleting XRef materials is equivalent
to merging them into the master scene. This action could impact all objects in the
master scene that use an XRef material, and could have implications difficult to
be foreseen.

Select Selects in the scene the XRef entities currently highlighted in the XRef
Entities list.
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Select by Name Opens the Select Objects dialog on page 228, which lists all
objects and highlights the XRef objects selected in the XRef Entities list. If an
XRef controller or XRef material is selected in the XRef Entities list, the Select
Objects dialog highlights the object to which the XRef controller or material
belongs to.

Highlight Selected Objects' XRefs When XRef objects are selected in the
scene, the XRef record to which they belong is highlighted in the XRef Record
list and the XRef objects and their XRef entities are highlighted in the XRef
Entities list.

Highlight All Highlights all XRef entities in the XRef Entities list.

Highlight Inverse Highlights all XRef entities in the XRef Entities list except
the currently highlighted XRef entities.

Highlight None Turns off highlighting for any XRef entities currently
highlighted in the XRef Entities list.

List Objects Toggles the display of XRef objects for the current XRef record
in the XRef Entities list.

List Materials Toggles the display of XRef materials for the current XRef record
in the XRef Entities list.

List Controllers Toggles the display of XRef controllers for the current XRef
record in the XRef Entities list.

The state of List Objects, List Materials, and List Controllers is the same as the
state of the toolbar buttons in the XRef Objects dialog. Changing the state in
the menu changes the button state, and vice versa.

Merge In Scene Merges the current selection in the XRef Entities list into the
master scene (the current scene). Use this option to change XRef objects or
materials into objects that are native to the current scene. The connection
between the external entity from the source scene and your master scene is
broken, and the object, controller, or material that you merged is no longer
updated when the source scene changes.

3ds Max prompts you to confirm the merge.

Since a merged XRef object becomes part of the scene and is no longer an
XRef object, its name is removed from the list.

Merging an XRef object loads the full modifier stack of the original object,
while maintaining any additional stack items that were added while the object
was an XRef object. Thus, you can use Merge to update an original object that
has been altered as an external reference. If you do this, use Convert Selected
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Object(s) to XRefs to save out the “improved” original into a file, which then
can be merged back into the original source.

NOTE It is also possible to merge into the master scene nested XRef entities. Once
they are merged, all externally referenced nesting levels are removed and the
scene entity from the lowest level source scene is merged into the master scene.
In case of XRef objects, modifiers applied in a nested source file are all merged
and present in the master scene.

Apply XRef Material(s) to Object(s) Applies the original, externally referenced
material(s) to the highlighted objects. This can be useful if you have assigned
a local material to the object (for example, to use in renderings of the master
scene) and now want to restore the object's original material. It can also restore
the externally referenced source material if the material was originally merged
into the master scene.

Apply XRef Controller(s) to Object(s) Applies the original, externally
referenced controller(s) to the highlighted objects. This can be useful if you
have assigned a local controller to the object (for example, to use in renderings
of the master scene) and now want to restore the object's original controller.
It can also restore the externally referenced source controller if the controller
was originally merged into the master scene.

Reset PRS Offset Sets the PRS transformation on page 3271of the XRef object
to its transformation defined in the source file.

NOTE You can undo this action.

XRef Merge Dialog

File menu > XRef Objects > XRef Objects dialog > Create XRef Record From
File button > Open File > XRef Merge dialog

The XRef Merge dialog lets you choose which objects to add as XRef objects
to the scene. This behaves similarly to the Merge command on page 7058.
Controls on this dialog are similar to those on the Selection Floater on page
231.

The Merge dialog lets you load and save influences with or without their
dependents. In many cases, objects should be referenced with their influences,
but the display only makes you aware of the relationships, it does not force
you to externally reference them.
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When you select an item in the list window and click Influences, the object’s
influences are selected in the list window. When you select an item in the list
window and Display Influences is on, the object’s influences are shown in
blue in the list window. When you select an item in the list window and Select
Influences is on, the object’s influences are also selected in the list window.

Procedures

To show an object's influences in the XRef Merge dialog:

■ Select an object in the list window and enable Display Influences.
The influences are shown in blue.

To select an object's influences in the XRef Merge dialog, do either of the
following:

■ Select an object in the list window and click Influences.

■ Select an object in the list window and enable Select Influences.
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Interface

XRef Merge Objects list

Objects are listed according to the current Sort and List Types selections.

Influences When you select an object in the list window and then click the
Influences button, the selected object's influences are highlighted as well.

All, None, and Invert These buttons alter the pattern of selection in the list
window.

Display Influences When this is on and you select an item in the list window,
all of its influences are shown in blue. If you want to highlight these influences,
click Influences.
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Select Influences When this is on and you select an item in the list window,
all of its influences are highlighted as well.

XRef Scene

File menu > XRef Scene

An externally referenced scene, or XRef scene, appears in your current file,
but is actually loaded temporarily from another MAX file. As a result, the
source scene is protected from any modifications you might make to the XRef
scene via the master scene. Updates or changes made to the source scenes are
also updated in the master file once the changes are made and saved to the
source file.

The XRef scene feature allows team members working on the same project to
have access to each other’s work without the risk of changing the files. A
modeler can create a setting, while a second modeler might create a character.
The animator can externally reference the setting as a scene and animate the
character in the setting without being able to make changes to the setting. If
the setting file is changed, those changes will be reflected in the animator’s
scene.

Objects loaded in the master file via XRef scenes cannot be selected nor
modified, and do not appear in the Select From Scene dialog or Scene Explorer,
the modifier stack, or the Track View. You can animate them in the current
file only by using the Bind To Parent function in the XRef Scenes window.

You can snap to externally referenced scene entities. You can use Snap,
AutoGrid, and Clone and Align to position local objects in context, as well as
to pick objects as the target location for the clones. If you need to move, rotate
or scale the referenced scene, you can bind it to a local object. Transforming
the object the externally referenced scene was bound to transforms all objects
in the externally referenced scene. You can also use externally referenced
objects in the scene as the reference coordinate system on page 967. When you
save changes to the externally referenced file (such as objects added, edited,
or deleted), updating the XRef Scene inherits those changes locally.
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Importing the whole village model into the building model as an XRef

Radiosity solution data cannot be part of an XRef if objects have duplicate
names. To solve this, change the duplicate names. Also, to reference radiosity
data externally, the Save Scene Information In MAX File switch must be on
in the Radiosity panel on page 7786 of the Preferences dialog. (It is on by default.)

Be aware that render effects are not carried into the master scene by XRef
scenes. To use the render effects (such as glow or flare) from the XRef file,
merge them in using the Merge buttons found in the Environment And Effects
dialog.

NOTE Atmospheric effects assigned to objects in the source file are carried into
the master file when the source file is used as an XRef scene.

Choosing XRef Scene displays the XRef Scenes dialog on page 6967.
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Overlays

Overlays allow multiple scene references without the risk of creating circular
dependencies. The scene XRef marked as overlay is loaded only into the master
scene that references it, and is not visible in other scenes that might XRef the
master file that uses the overlay. Consider two scenes that reference each
other:

Ordinarily, 3ds Max would recognize this as a circular dependency, and
disallow it. However, you can set up such a combination of XRefs by following
these steps:

1 In scene 2, XRef scene 1 and use the toggle to flag it as an overlay.

2 Save scene 2.

3 Open scene 1, and XRef scene 2.

Scene 2 is externally referenced into scene 1, without pulling scene 1 in
as a nested external reference.

The previous example is not particularly practical. But suppose you want to
mask off part of your scene so other artists who XRef the scene will not see
it. For example, you are working on a building and have XRefed a CAD file
that lays out the plumbing of the building, as well as a scene of ground terrain
that contains some XRefs to some trees. The XRef scene graph might look like
this:
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The building scene XRefs the terrain and the plumbing data. The terrain scene
XRefs the trees. You decide you are the only one who needs to see the CAD
plumbing data. The CAD plumbing data is needed only to line up where the
sinks need to be in the building, so you set up the CAD plumbing data XRef
to be an overlay. Other scenes that include the building scene won’t see the
plumbing. For example, another artist who is responsible for the lighting and
cameras sets up an XRef to the building scene. Now the XRef graph looks like
this:
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In this case, an overlay is used to simply hide data information from other
master scenes. Another use of overlays is to avoid circular XRefs. For example,
picture four artists working on a scene of a city block. Two of them are working
on individual buildings, one is working on a sky bridge that connects the two
buildings, and the fourth artist is setting up the cameras and the lights. The
graph of externally referenced scenes might look like this:
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But the artists working on Building A and the artist working on the sky bridge
need to see each other’s work to make sure everything lines up. The obvious
solution would be to externally reference each other’s scene file:
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However, 3ds Max detects a circular external reference and won’t allow this,
unless both the Building A scene and the Sky Bridge scene flag their external
reference as an Overlay.
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WARNING If you turn off the Overlay flag for an existing XRef scene, you can
cause circular external references to occur, that aren’t detected until you or another
user tries to open one of the scenes in the project.

Procedures

To add an XRef scene:

1 Choose File > XRef Scene.

2 Click the Add button. An Open File dialog appears that lets you locate
the MAX file you wish to reference. A thumbnail display is provided to
help you identify your file.

3 Click Open to bring the XRef scene into the current scene.
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4 The path and file name of the selected file appears in the XRef Files
window.

You can add as many files as you like; each one appears in the XRef Files
window.

5 Make additional choices in the XRef Scenes dialog if you want.

You can affect the display of the XRef scene, making it visible or not, or
making objects in the referenced scene appear as bounding boxes. You
can ignore the file's lights, cameras, shapes, helpers, or animation. You
can control when the file updates, either automatically or on demand.
You can have the file enabled or disabled, or you can merge it, severing
the XRef relationship and inserting the scene into your current file. You
can bind the scene to a Parent object to reposition or animate the XRef
scene.

To scale, rotate, or reposition an XRef scene:

1 Create an object in your current scene to be the parent object.

2 Choose the XRef scene from the XRef File window.

3 Click Bind (in the Parent group), and then select the parent object by
clicking it in the viewport.

4 Transform the parent object. The XRef scene will follow.

This works best if both the parent object and the XRef scene have their
pivot points positioned near the scene's origin (0,0,0).

If the XRef scene was created a large distance from the origin, you can
run into a problem. As you scale the parent object, the XRef scene will
move away from the center. To counteract this problem, you can create
a second parent object centered over the XRef scene. Then select and link
the original parent object to the centered parent object. You can then
scale the centered parent object and the XRef will not move toward or
away from the origin and use the original parent object to move the
externally referenced scene.

An alternative method for scale problems is to use the Rescale World
Units Utility on page 2682 on the original file.

XRef Scenes Dialog

File menu > XRef Scene > XRef Scenes dialog
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The XRef Scenes dialog lets you add and remove XRef scenes. It also gives you
tools to control the display of the XRef scene, options to ignore various
components of the scene, and the ability to bind to a parent object so you
can scale, rotate, or move the XRef scene.

Accessing XRef Scenes

Although XRefs are inaccessible “boxes” in the scene, they can be accessed in
various ways.

■ Cameras and lights in the XRef scenes can be accessed in the Viewports
list and assigned to viewports in the current scene.

■ Objects from the XRef scenes are included in the Summary Info dialog.

■ Objects can be snapped to or used for alignment purposes with AutoGrid
and Align.

■ AutoGrid works on XRef scene objects.

■ You can use objects from XRef scenes as target for cloning or reference
systems.

Nesting XRef Scenes

XRef scenes can be nested. That is, an XRef scene can contain other XRef
scenes, which can in turn contain other XRef scenes.

NOTE For a nested XRef scene to update automatically, all of its parent scene files
(files that include it as an XRef) must have Auto Update turned on.
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Interface

XRef File list Displays all XRef scenes in the current scene, and lets you select
them for operations. XRefs that have been disabled (by turning off Enabled)
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are listed in gray rather than black. If an XRef is listed in red, that means its
file could not be loaded. Either the file is corrupted, or the path is not pointing
to the correct directory or file name.

XRef File path field Lets you change the path or file pointed to by a selected
XRef scene. To use, choose one of the XRef scenes in the list, and then change
the information in the field. You can either directly enter a new file name or
path, or you can click the Browse button to the right of the field, and then
choose a new file from the Open File dialog. The new XRef scene that you
choose replaces the one currently highlighted in the list.

Add Displays the Open File dialog from which you can choose a MAX scene
file to be loaded into the current scene as an XRef. The selected scene appears
in the list at left, and the geometry appears in the viewports.

You can also add a scene by dragging a MAX file from the Windows Explorer
into the list, or by dragging a MAX file into a 3ds Max viewport, whereupon
you're presented with a menu with the following options: Open File, Merge
File, XRef File, and Cancel.

Convert Selected Lets you take any selected objects in your scene and create
XRefs from them. Basically, this does a Save Selected for the objects, which
are automatically cut from the MAX file and pasted into a new file. A file
dialog lets you name the new file. They remain in the current scene but are
now scene XRefs.

Remove Removes the XRef scene currently chosen in the list, and removes it
from the current scene. To use, choose one or more XRef scenes in the list,
and then click the Remove button.

Select buttons

These standard buttons change the pattern of selection in the list.

All Selects all items in the list.

None Deselects all items in the list.

Invert Inverts the current selection pattern in the list.

XRef File group

Enabled Turn this off to disable the highlighted XRef. When an XRef is
disabled, it’s listed in gray in the list, and it’s not loaded into memory.

Overlay When on, treats the referenced source scene as an overlay on page
6961. Default=off.
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Overlays allow multiple scene references without the risk of creating circular
dependencies. The scene XRef marked as overlay is loaded only into the master
scene that references it, and is not visible in other scenes that might XRef the
master file that uses the overlay. See Overlays on page 6961 for more information.

WARNING If you turn off the Overlay flag for an existing XRef scene, you can
cause circular XRefs to occur, that aren’t detected until you or another user tries
to open one of the scenes in the project.

Merge Click this to merge selected XRefs into the scene as real geometry. A
prompt appears so you can confirm the action. Since a merged XRef becomes
part of the scene and is no longer an XRef, its name is removed from the list.

Update File group

Determines how and when the XRef scenes are updated. These options are
applied to the selected XRefs; for example, one XRef can have automatic
updating, while another can have manual updating (using the Update Now
button).

WARNING If you update an XRef in a scene with radiosity on page 6168, you will
likely invalidate the radiosity solution. After you update the XRef, reset the radiosity
solution and then recalculate it.

Automatic When this check box is turned on, the selected XRef scene is
automatically updated when its source scene is saved.

Update Now Click this to update a selected XRef scene when you’re not using
Automatic (or when several XRef scenes are selected and some of them are
not set to Automatic). When you click Update Now, the XRef is updated to
match the latest saved version of the source scene.

Display Options group

These options let you specify how the selected XRefs are displayed in viewports.
These options have no effect on the rendered scene.

Visible Turn on or off to display or hide the selected XRefs. This affects the
visibility of the XRef in the viewports only (not in renderings). Note, also,
that this behavior is different from the “Enabled” check box. Turning off
Visible does not remove the XRef from memory.

Box Turn this on to display the selected XRefs as bounding boxes. Turn off
to display the full geometry.
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Ignore group

This group box lets you specify categories that you do not want included with
the XRef scene. For example, if you turn on Lights, the lights in the XRef
source scene are not included in the current, target scene. You can switch
these categories on and off at any time, but if you Merge an XRef scene while
a category is turned off, that category of objects will not be merged into the
scene.

Lights Turn this on to ignore the lights.

Cameras Turn this on to ignore the cameras.

Shapes Turn this on to ignore the shapes.

Helpers Turn this on to ignore the helpers.

Animation Turn this on to ignore the animation. All animation in the scene
is disabled and the scene appears as it would at frame 0 of the source scene.

WARNING Children of an ignored object are also ignored. For example, if you
have mesh objects linked as children to a dummy object and ignore Helpers, then
the mesh objects are ignored as well.

Parent group

These controls let you position and animate XRef scenes within the current
scene by binding the XRef scene to a parent object.

Parent Name field Displays the name of the parent for the currently selected
XRef.

Bind Click this, and then pick an object in the current scene to become the
parent of the highlighted XRefs. Once an XRef is bound to a parent object,
the transforms of the parent are inherited by the XRef. Thus, you can animate
the XRef by animating the transforms of the parent.

Unbind Click to unbind the highlighted XRefs from whichever parent they’d
been bound to.

Binding XRefs to objects is similar to linking objects, as performed with the
Link/Unlink buttons on the toolbar.

If you Merge a linked XRef scene, converting it to objects in the current scene,
the objects in the XRef scene become linked children of the binding parent.
At this point, you could Unlink them (using the toolbar command), and they’ll
maintain their offset position to the parent.

Close Click to close the dialog.
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XRef Object Rollout

Select an XRef object. > Modify panel > XRef Object rollout

When you've selected an XRef object in a scene, the XRef Object rollout appears
along with the Proxy Object rollout on page 6974 on the Modify panel. The
modifier stack for the XRef object simply displays “XRef Object.”

Interface

These controls let you change the file path, file name, and object name of the
source of the XRef object.

IMPORTANT The specified file must contain an object of the specified name, or
no XRef object will appear in your scene. Instead, a small X appears as a
placeholder.

 Highlight Corresponding XRef Record in the XRef Objects
Dialog Click to open the XRef Objects dialog on page 6941, with the selected
object's record highlighted.

File name field Displays the path and file name of the scene file containing
the source of the XRef object. You can edit this to point to a different path
and file.

File name display Displays the file name only, without the path.
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 Path button Click to display the Open File dialog from which you can
specify a different path and file name for the source file.

Object name field Displays the name of the source object pointed to in the
source file. You can edit the name field to reference another object.

Object name display Displays the name of the source object.

 Path button Click to display the XRef Merge dialog on page 6956 pointing
to the scene in the XRef File Name field. Here, you can specify a different
object to be used as the XRef object.

Proxy Object Rollout

Select an XRef object. > Modify panel > Proxy Object rollout

When you've selected an XRef object in a scene, the Proxy Object rollout
appears along with the XRef Object rollout on page 6973 on the Modify panel.
Use these controls to specify a low-resolution object to replace the original
XRef object for easier handling in the viewports, and optionally for test
rendering.
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Interface

Enable When on, displays the specified proxy object in the viewports. When
off, displays the original XRef object. Note: If you turn this on when no proxy
object has been specified, the XRef object appears in the viewports as a small
X.

Use in Rendering When on, the proxy object is also displayed in the rendering.
When off, the original XRef object is rendered.

File Name field Specify the path and file name of the scene file containing
the proxy object.

 Path button Click to display the Open File dialog from which you can
specify the scene file containing the proxy object.

Object Name field Specifies the name of the proxy object in the specified
scene.

 Path button Click to display the XRef Merge dialog listing the objects
in the specified scene file. From here, you can select an object to be used as
the proxy.
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Missing XRef Paths Dialog

File menu > Open > Open a file that references other missing files.

If you load or render a scene with XRefs, but the originally specified path of
the XRef object or scene can’t be found, or if the XRef object name doesn’t
match the object name in the source file, an alert appears telling you this. The
alert works in the same way as the missing bitmap dialog, and provides you
with three options, described below.

Interface

OK Lets you open the file. The referenced scene will have placeholders, but
will not exist in the scene.

Browse Displays the Configure XRefs Paths dialog which you can use to specify
the correct file path. This lets you modify, delete, add, and change the list
position of the paths 3ds Max uses to look for missing files.

This panel is similar to the one displayed by choosing Customize > Configure
User Paths > XRefs on page 7738.

If this problem occurs during network rendering, the dialog doesn’t appear,
but the errors are written to the network log file.

File Link

Data synchronization between drawing files created with AutoCAD, AutoCAD
Architecture (ACA), or Revit and 3ds Max is implemented using the File Link
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Manager, which keeps drawing data linked to the scenes. It is best understood
through a few simple principles:

■ Changes in AutoCAD, AutoCAD Architecture, or Revit can change the data
viewed in 3ds Max, but changes in 3ds Max never change the data in
AutoCAD, AutoCAD Architecture or Revit.
Creating a file link is a one-way process that supports the central role of
AutoCAD, AutoCAD Architecture or Revit in developing and keeping a
record of your core design database. Many changes made in AutoCAD,
AutoCAD Architecture, or Revit will appear in 3ds Max after a file link
reload. These include adding or removing objects, moving objects, changing
material assignments (specific to ACA and Revit drawings), and enabling
Live Section objects (specific to ACA drawings). Changes made in 3ds Max,
such as moving objects, changing material assignments, and adding lights,
will never appear in your AutoCAD, AutoCAD Architecture, or Revit
drawing.

■ Changes you can make in AutoCAD, AutoCAD Architecture, or Revit should
be made in AutoCAD, AutoCAD Architecture, or Revit.
Changes that you make in AutoCAD, AutoCAD Architecture, or Revit
become part of that database, whereas changes you make in 3ds Max appear
only in the renderings you produce.

■ Changes in AutoCAD, AutoCAD Architecture, or Revit aren't reflected in
3ds Max unless you choose them to be.
When you make changes to drawing files, those changes will not appear
in 3ds Max unless you use the Reload command on page 6987 on the File
Link Manager. When you reload a link in 3ds Max, you can choose to
update just the geometry from AutoCAD, AutoCAD Architecture, or Revit,
you can reload only specific objects, or (with AutoCAD Architecture and
Revit drawings) you can choose to update both the geometry and the
material assignments.

NOTE After changing your Revit project, you must export a new DWG file and
then reload that file into 3ds Max. 3ds Max cannot link a native Revit project,
RVT file, directly.

You can transform (move, rotate, or scale) AutoCAD, AutoCAD Architecture,
or Revit objects and blocks that appear in 3ds Max, and these types of
changes are not lost upon reload. If you have moved, rotated, or scaled
linked objects and want the objects to resume the position and scale they
have in the original drawing file, use the Reset Position function on page
7024.
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■ 3ds Max integrates linked AutoCAD, AutoCAD Architecture, or Revit data
with non-AutoCAD, AutoCAD Architecture, or Revit data.
In addition to the linked AutoCAD, AutoCAD Architecture, or Revit
geometry and material assignments, 3ds Max allows you to create or merge
into your scene many types of data from other sources, including:

■ Lighting objects for simulating light fixtures and daylight conditions.

■ Entourage objects such as surrounding buildings, terrain, trees, cars, and
people.

■ Advanced rendering material effects that simulate the rich visual variety
of any imaginable material. You can take advantage of materials that
appear on objects created in 3ds Max, and you can create your own
material effects using the Material Editor. Materials created with the
Material Editor can be assigned to any component in your scene.

■ Bitmaps for use as environment backgrounds. You can use still images
in a variety of formats, or even animated movies, as a rendering
background to create stunning photomontages that appear to place
your proposed design right into the actual location.

See also:

■ File Link Manager Utility on page 6987

■ Working with Drawing Files on page 6978

■ Resetting Transforms on Linked AutoCAD Objects on page 7024

Working with Drawing Files

You can attach any DWG file on page 7958 (or DXF file on page 7958) with the
File Link Manager on page 6987. This feature allows you to work in another
design software's environment, such as AutoCAD®, Autodesk® AutoCAD
Architecture, or Autodesk Revit® while maintaining a single design database.

NOTE For this documentation, the term “drawing” refers to DWG or DXF files
created with AutoCAD and AutoCAD Architecture, or exported from Revit.
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Creating Links to Files

You can establish, reload, and detach links to any number of linked files. You
can also edit out unnecessary information by using layers and other filters.
The File Link Manager defines which geometry is included in the scene from
the linked file, how the geometry is organized, and when it's regenerated. You
can also create links to files using the drag and drop feature. The objects that
you bring in from linked files behave just like any other object created in 3ds
Max. You can scale, rotate, and move them as well as attach modifiers and
materials.

When 3ds Max stores linked file data, you'll need to decide how the objects
from the linked files will be organized in the scene. For example, drawings
are commonly organized by layers, blocks, and objects, and 3ds Max scenes
are organized by hierarchies of objects. For translating between systems, 3ds
Max includes object types called VIZBlocks on page 8165 and Block/Style Parents
on page 7928.

Working with VIZBlocks and Block/Style Parents

A VIZBlock and a Block/Style Parent is like a nested block; it has an
object/sub-object or parent/child hierarchy structure. In many cases, linked
drawing data initially appears as a VIZBlock or Block/Style Parent (depending
on the Derive AutoCAD Primitives By options on page 7004 you choose). Using
VIZBlocks is helpful when you're working with layering and color schemes.
You can create multiple links to the same linked file, so you can use the same
geometry in different combinations.

Dynamic Blocks in 3ds Max

Dynamic Blocks give blocks flexibility and intelligence. A dynamic block
reference can easily be changed in a drawing while you work. You can
manipulate the geometry through custom grips or custom properties.

The File Link Manager handles dynamic blocks much the same way as any
other block found in a DWG file. Dynamic block instances, even those that
have been grip-edited, display certain types of instance behavior such as
material propagation. For more detailed information about dynamic block
handling in 3ds Max, see Blocks on page 7048.

Reloading, Binding and Detaching Links to Files

You can also reload or detach linked files. When you reload a linked file, any
changes you've made to the linked file are applied to the reloaded geometry
in your scene. Note, however, that 3ds Max won't edit or change your original
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linked file. The integrity of your other software's design database is never
compromised by the File Link Manager. Finally, if you decide to break a link
to a linked file, there are two options. You can use Bind to keep the objects
from the linked file in your scene, or you can use Detach to have them removed
along with the link. For more information, see File Link Tips on page 6981.

NOTE Both Detach and Bind are available from the Files panel of the File Link
Manager.

ObjectDBX Objects

3ds Max supports the display and use of custom AutoCAD objects. These
custom objects are created using the ObjectDBX™ or ObjectARX® APIs.
Applications and products that work with either of these APIs can read and
write to AutoCAD drawings, and ObjectARX products can extend the available
feature set of AutoCAD.

NOTE To improve file performance, some of the ObjectDBX rules have been
updated. This means that some DXF files, ones built by non-Autodesk products
or very old DXF files, may no longer import or file link into 3ds Max.

Object Enablers

AutoCAD and AutoCAD vertical applications, such as AutoCAD Architecture
(formerly Architectural Desktop or ADT), have custom objects that are unique
to the product. In order to view them in 3ds Max, you need the appropriate
Object Enabler (OE). Object Enablers let you access, display, and manipulate
these objects in 3ds Max, as well as the other vertical applications, including
3ds Max.

When you use the File Link Manager to Attach a DWG file to your scene, you
may encounter a Proxy Objects Detected dialog. This means there are custom
objects in the drawing that require special Object Enablers before you can edit
the objects in 3ds Max.
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Do not show this message again Check this option to not display this message
the next time proxy objects are detected.

For a list of downloadable OEs, see the
http://www.autodesk.com/autocad-object-enablersAutodesk Web site

NOTE Drawings that are exported from Revit do not require Object Enablers.

File Link Tips

Here are some tips for choosing File Linking options and avoiding common
pitfalls.

Linked Data and Face-Normal Conventions

Face normals on page 8059 can be a source of confusion when linking to
AutoCAD, AutoCAD Architecture, or Revit drawing files. In 3ds Max, every
face has a front and a back, corresponding to the inside or outside surface of
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a solid object. In a cube, for example, there is seldom the need to view the
inside surface of any of the six squares that make up the cube. So for many
viewing and rendering operations, 3ds Max ignores a face if it's facing away
(that is, if its face normal is directed away) from a point of view.

When you create objects in AutoCAD, AutoCAD Architecture, or Revit, 3ds
Max generally understands which way faces should be oriented and manages
face normals accordingly. However, occasionally you may encounter linked
drawing geometry that displays correctly in AutoCAD, AutoCAD Architecture,
or Revit, but doesn't strictly respect face-normal conventions. This can make
it appear as though elements visible in the drawing file are missing or appear
“inside-out” in 3ds Max.

If this happens, try one of these four options:

■ During file link or import of the DWG file, turn on the Unify Normals
switch in either the Basic panel of the File Link Settings dialog or the
Geometry Options group of the AutoCAD DWG/DXF Import Options
dialog.

■ If the drawing is already linked or imported, assign a Normal modifier on
page 1581 to the object that is not displaying properly. Turn on the Unify
Normals switch to force all the normals to face the same direction. If the
object then appears to be “inside-out,” turn on the Flip Normals switch as
well.

■ To render the faces correctly, turn on the Render Setup dialog on page 6067
> Force 2-Sided switch. Also, to display the faces correctly in the viewports,
turn on Viewport Configuration dialog > Rendering Method panel on page
7818 > Force 2-Sided.

■ Apply a material with the 2–Sided switch turned on.

NOTE Using the Force 2–Sided options can result in slower performance,
particularly when rendering. Using either of the Unify Normals options is the
preferred method of handling face normals.

If you experience a high volume of face normal problems in a particular file,
verify that the File Link Settings dialog on page 6998 > Weld switch is on, and
then reload the drawing. Weld forces nearby faces to share edges and vertices.
Welding can still result in groups of face normals that are flipped in 3ds Max,
in which case, turn on Unify Normals as well.

6982 | Chapter 23   Managing Scenes and Projects



NOTE The disadvantage of welding is that it can be time-consuming when you
attach and reload the linked file. The time penalty is much greater when 3ds Max
is creating objects that have very large numbers of individual faces.

Linking Files with High Numbers of Linear Line Segments

Two-dimensional elements in drawing files, such as lines, polylines, circles,
and arcs, are represented as splines in 3ds Max. These splines carry much more
information at each vertex than typical AutoCAD 2D structures. Since some
drawing files contain large quantities of 2D data, exercise caution when linking
files containing a high number of discrete line segments. There are two ways
these elements can be left out of your 3ds Max scene:

■ by freezing their layers in AutoCAD, AutoCAD Architecture, or Revit before
you start 3ds Max and before each subsequent reloading process.

■ by excluding specific layers during the File Link Attach/Reload process or
Import process so you do not have to freeze layers in the drawing. This is
the preferred workflow.

If you need this type of 2D geometry in your visualization, try to use polylines
instead of connected lines to get cleaner geometry in 3ds Max and to reduce
the final size of your scene.

Linked 3D Solids Objects

3D Solids objects that you link from a drawing file into 3ds Max are tessellated;
that is, turned into mesh objects with faces. The fineness of the tessellation
is controlled by the Maximum Surface Deviation For 3D Solids setting on page
7001on the File Link Settings dialog. A high value results in coarser tessellation.
3ds Max uses less memory in the scene, but poor approximations of curved
surfaces could result. For acceptable performance, keep this value as high as
possible.

TIP You can change the value of the Surface Deviation For 3D Solids control at
any time by turning on Show Reload Options on page 6996on the Files panel of the
File Link Manager dialog, and then adjusting when you reload the file.

Linked Spline Objects

Splines are not rendered in 3ds Max unless they have rendering parameters
applied. Normally, you have to collapse a shape to an editable spline object
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in order to apply rendering parameters; however, this is not possible with
spline objects from AutoCAD.

Instead, you can apply a Renderable Spline modifier on page 1652 to the spline.
This lets you set rendering properties without having to collapse to an editable
spline.

External References and Block Names

A linked AutoCAD or AutoCAD Architecture drawing can include xrefs that
reference files but use the same block names. 3ds Max keeps the blocks distinct
by prepending xref names to block names.

In Revit, a DWG, DXF or RVT file can be linked to the project. This kind of
link is called a RVT Link on page 8110. When the project is exported to a DWG
file, this type of link is represented in the exported drawing as an external
referenced drawing. In this case, more than one drawing file may be created,
with one referencing the other(s).

Circular References

An xref file that contains a sequence of nested references that refers back to
the xref file is considered a circular reference. 3ds Max resolves xrefs until it
detects a circular reference. For example, if you have the circular reference
A|B|C|A, 3ds Max detects and breaks the circularity between C and A. This is
consistent with the way AutoCAD and AutoCAD Architecture handle circular
xref dependencies.

Overlay External References

3ds Max treats overlay xrefs in the same way as AutoCAD when resolving
xrefs.

For more information regarding overlay xrefs, refer to your AutoCAD User
Reference.

Cloning Actively Linked Objects

If you want to clone actively linked objects, you should only use the Copy
option. Creating references or instances of actively linked objects is not
recommended, as reliability issues can arise when the instanced or referenced
object is deleted in the linked file.

When you copy actively linked objects, linked through the File Link Manager
on page 6987, the copies are automatically converted to editable mesh or editable
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spline objects. If your selection contains several objects which instance another
object, the resulting copies also instance the same object.

Compound Objects Containing Actively Linked Objects

If you use an actively linked object as part of a compound object, you should
always choose Copy when you specify how the linked object is transferred to
the compound object. Choosing Reference or Instance can cause instability
in the software.

Attaching Actively Linked Objects to an Editable Mesh, Poly, Patch,
or Spline Object

Actively linked objects should not be attached to editable objects, as this
introduces instability to the software. Instead, make a copy of the actively
linked object, and attach the clone to the editable object.

Creating Hierarchies with Actively Linked Objects

Creating parent-child links between actively linked objects AND 3ds Max
objects can cause unpredictable results. For this reason, 3ds Max does not
allow you to link an actively linked object to a 3ds Max object. However, you
can link a 3ds Max object to an actively linked object.

The existing hierarchies of linked objects cannot be broken in 3ds Max. This
would compromise the structure of Blocks and Styles. Any changes must be
made in the original DWG file.

Similarly, actively linked objects cannot be included in the creation of Group
on page 282 or Assembly on page 287 objects in 3ds Max.

Controller Assignments

Actively linked objects should not be included in any IK animation chains,
as they will cause unpredictable results. Likewise, animation controllers should
not be applied to actively linked objects.

Assignments to avoid include:

■ HI IK Solver on page 3392

■ IK Limb Solver on page 3444

■ Spline IK Solver on page 3445

■ HD IK Solver on page 3422

File Link | 6985



■ Inherit Link Info on page 3502

■ Link Inheritance Utility on page 3372

■ Assign Controller on page 3593

Interpreting Layer Data from AutoCAD,
AutoCAD Architecture, and Revit

3ds Max has its own Layer system that looks and operates like a simplified
version of the system you are familiar with from AutoCAD or AutoCAD
Architecture (formerly Architectural Desktop). As in AutoCAD or AutoCAD
Architecture, you can hide and unhide layers, freeze and unfreeze them, and
change the display color for all objects on the layer.

NOTE Categories in your Revit project are similar to Layers in AutoCAD. When
you export your project to a DWG, categories are mapped to AutoCAD Layers via
the Export Layers table. For more information regarding Export Layers, refer to
your Autodesk Revit Help file.

Layer operations are accessed through the tools on the Layers toolbar, and
also on an object-by-object basis using the quad menu on page 7516.

Unlinked objects, such as 3ds Max objects or drawing geometry that has been
bound into the scene using the Bind command, may be assigned to any layer
you choose, including layers created by the File Link Manager.

Linked objects from AutoCAD, AutoCAD Architecture, or Revit, with some
minor exceptions, will be assigned to the same layers they occupy in program
where the drawing was created.

Any changes made to the layer settings in 3ds Max (hidden/unhidden,
frozen/unfrozen, display color) affect linked objects just as they do unlinked
objects. Also, any changes you make to the layers are not reset when you reload
the drawing.

You can rename layers created by the File Link Manager. When the next reload
occurs, the renamed layer is not affected by the File Link Manager. Objects
on the renamed layer are updated; however, they remain on the same layer.
The original layer is only recreated when a new object has been created in the
DWG file. New objects are never placed on the renamed layer. You can also
delete layers imported by the File Link Manager on page 6987; but only if they
don't contain any objects.
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You can move actively linked objects between layers in 3ds Max. When the
next reload occurs, the objects are updated; however, they are not moved back
to their original layers. You can also place non-linked objects, such as 3ds Max
objects or drawing geometry that has been bound into the scene, on any of
the imported layers.

Objects contained in layers that are frozen in AutoCAD or AutoCAD
Architecture are not linked to 3ds Max. Objects that were originally linked to
3ds Max are removed if their layer is frozen in AutoCAD or AutoCAD
Architecture and the link is reloaded, but they are added again, upon reload,
after their layer is unfrozen in the program where the drawing is created.

NOTE This is only the case if Skip all Frozen Layers is active on the Select Layers
dialog on page 7017. If you select the layers individually from a list, you can bring
in data on frozen layers.

See also:

■ Using Layers to Organize a Scene on page 7438

Scale Synchronization

3ds Max automatically manages the scale conversion on linked geometry and
materials. 3ds Max has its own system unit for internal representation of
geometrical scale.

If you find that any geometry is not shown at the size you intended it to be,
it is because it was created at the improper scale in the originating program.

See also:

■ Using Units on page 2588

File Link Manager Utility

Utilities panel > Utilities rollout > Click the More button. > Utilities dialog >
File Link Manager

File menu > File Link Manager

The File Link Manager utility allows you to work in either another design
software's environment (such as AutoCAD) or in 3ds Max while maintaining
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a single design database. If you use AutoCAD drawings, this feature works
with drawings from AutoCAD Release 12 through AutoCAD 2005, including
the AutoCAD Mechanical/Architecture and Revit applications.

You can establish, refresh, and break links to any number of linked files. You
can also edit out unnecessary information by using layers and other filters.
The File Link Manager defines which geometry is included in the 3ds Max
scene from the linked file, how the geometry is organized, and when it's
regenerated.

The objects that you bring in from linked files behave just like any other object
created in 3ds Max. You can scale, rotate, and move them, as well as attach
modifiers and materials.

You can also refresh or break links to linked files. When you refresh a linked
file, any changes you've made to the linked file are applied to geometry in
your scene. Note, however, that 3ds Max won't edit or change your original
linked file. The integrity of your other software's design database is never
compromised with the File Link Manager.

Finally, if you decide to break a link to a linked file, you can either keep the
objects from the linked file in your scene or have them removed along with
the link.

TIP For optimal speed when bringing a DWG file that contains a lot of text into
3ds Max, use Import on page 7182 rather than File Link.

See also:

■ File Link on page 6976

■ File Link Tips on page 6981

■ Working with AutoCAD, AutoCAD Architecture, and Revit Files on page
7021

Support of Multiple Materials on Linked ACIS Solids

3ds Max supports multiple materials per object in DWG files exported as ACIS
solids from Revit Architecture/Structure/MEP 2008 and later, as well as solid
primitives created in AutoCAD Architecture 2008 (formerly ADT) and later.
Linked solids can have Multi/Sub-Object materials on page 5720 that you can
view and manipulate in the Material Editor.
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NOTE Previous versions of 3ds Max supported multiple materials for polymeshes
but only one material ID for each ACIS solid when linking a DWG file, regardless
of how many material IDs had been assigned to the solid.

Process

When 3ds Max links a ACIS solid DWG file from AutoCAD or Revit
Architecture (version 2008 and later) with either the Layer, Blocks as Node
Hierarchy, Split by Material” or the Entity, Blocks as Node Hierarchy derivation
methods, multiple material IDs are read and editable as Multi/Sub-Object
materials in the Material Editor.

3ds Max reads each face of a linked ACIS solid to determine if it contains any
material IDs that it can read. If more than one material ID is read from a solid,
each material ID is translated to a material ID on file link and re-assigned to
the object.

The program creates Multi/Sub-Object materials only if more than one material
ID is found; if an ACIS solid contains only one material ID, a standard
architectural material is created and assigned instead.

NOTE 3ds Max first evaluates the linked file to find any Revit material IDs, and
then looks for AutoCAD material IDs.

NOTE If you link a DWG file with the Layer, Blocks as Node Hierarchy, Split by
Materials” derivation method, the solid is not split to reflect its materials set.

Multi/Sub-Object Material Naming

In earlier versions, 3ds Max read the material ID information from the color
ID of the AutoCAD/Revit material ID’s face. Now, 3ds Max creates a
Multi/Sub-Object material for every translated per face material ID each time
you link a DWG file that contains an AutoCAD/Revit solid.

When the program finds multiple materials assigned to an ACIS solid and
creates a Multi/Sub-Object material, it consists of instances of standard
architectural scene materials.

Naming Conflicts

Material IDs are unique within one DWG file. However, the same material ID
may appear in two different files, such as Basic Wall: Generic – 12” Masonry.
If a naming conflict arises when two scenes are merged, the program applies
the last loaded material used in the Multi/Sub-Object material.
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For example, if file1.dwg and file2.dwg both contain a material named Brick,
and they are both linked, the Brick material used is the one from the second
file (file2.dwg).

Or, if file1.dwg contains a material named Brick that is internally stored as
material ID 222 and file2.dwg contains a different material stored as ID 222,
the material used in the scene when they are linked is file2.dwg’s material.

If two solids share the same material ID, they will share the same
Multi/Sub-Object material.

Non-AutoCAD Materials

3ds Max does not link non-AutoCAD material IDs. The only non-AutoCAD
Architecture IDs it preserves are the Color IDs.

ACIS Solids

DWG ACIS solids link as solid objects in 3ds Max. You cannot separate faces
of an ACIS solid object unless you apply the Edit Poly on page 1363 or Edit Mesh
on page 1353 modifier.

TIP You can access the material ID value assigned to this face with the Edit Poly
modifier.

ACIS Solids and Materials

ACIS solid materials display in the Material Editor along with any other linked
material.

When you apply a bitmap material to an ACIS solid, it is applied to every side
of the object. For example, a brick bitmap material that you apply to a wall
object appears on both sides and all edges of the wall. If you want to apply a
material to each face ID, you can use a multi/sub object material so you can
assign sub-materials to each face ID.

When you link ACIS solids into 3ds Max, procedural textures are not supported,
only materials. For example, a brick wall in Revit may have mortar lines
procedurally drawn on it in red, but if the object is an ACIS solid, the mortar
lines, which are procedural hatches, are lost in 3ds Max.

When an ACIS object’s materials display as Multi/Sub-Object materials in the
Material Editor, each material name appears in the Material/Map Browser, for
example, Default wall or Basic Wall: Generic – 12” Masonry.
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Polymesh

Polymesh DWGs link as polymesh geometry in 3ds Max. Unlike ACIS solids,
you can modify and edit any polymesh object’s face.

Polymesh Objects and Materials

When you link a polymesh DWG file, each polymesh face is considered as a
separate entity, with one material permitted per entity, which allows it to
contain multiple materials

You can apply a bitmap material to the different faces of polymesh geometry,
unlike ACIS solids, where you would need to use a Multi/Sub-Object material
to create the same effect. For example, you can select the outside face of wall
and apply a brick bitmap material and also apply a diffuse material on the
inside wall to simulate white paint.

When you link a polymesh DWG file, every material used in the scene appears
in the Material Editor as a separate material where you can edit it.

When a polymesh object’s materials are shown in the Material Editor, each
material name appears in the Material/Map Browser, for example, Default wall
or Basic Wall: Generic – 12” Masonry.

Procedures

To link a drawing file:

You can link drawings in the form of DWG or DXF files. A DWG is the native
file format for AutoCAD and  AutoCAD Architecture, but you must first export
a DWG when working from a Revit project. The File Link Manager does not
recognize RVT files.

1 Choose File menu > File Link Manager.

2 On the Attach panel, click Files to select a file from the appropriate
directory on either your local or network system, and click Open.

3 Choose a Preset from the pull-down list, if you have one defined.

TIP If this is your first File Linking, and you have not defined any presets, you
may want to create one on the Presets panel on page 7013 of the dialog.

4 Turn on the Rescale switch and adjust the Incoming File Units, if
necessary.

5 Click Attach This File.
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To reload a drawing:

Reload is most often used when your drawing or project has been changed in
AutoCAD, AutoCAD Architecture, or Revit, or if the linked drawing file has
been moved and you have to tell the File Link Manager where to find the
drawing.

NOTE If your Revit project has been updated, remember to export a new DWG
file that can be reloaded.

1 On the Files panel of the File link Manager, click the file name in the
Linked Files list and click Reload.

Linked files that have been changed are prefaced with the  symbol.

TIP Turn on the Show Reload Options switch if you want to make changes
to the settings used to link the drawing. Otherwise, the reload process will
use the same settings you originally used when creating the link.

2 If Show Reload Options is turned on, the File Link Settings dialog on page
6998 is displayed where you can change your settings in the Basic and
Advanced panels.

NOTE You cannot change the sorting or layer options when reloading a
drawing.

3 Click OK to reload the file.

Interface

The File Link Manager dialog contains three panels for listing linked files:

■ Attach on page 6993

■ Files on page 6995

■ Presets on page 6997

These panels let you attach files, update attachments and settings, and change
presets used by File Link. The terminology is similar to the terminology for
managing AutoCAD external references, or xrefs on page 8176.
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NOTE An xref is an AutoCAD external reference. This is different from a 3ds Max
Xref on page 8177, which is an externally referenced file that can be a 3ds Max
object or scene.

Attach panel

File Displays an Open dialog that you can use the browse for DWG and DXF
files that you want to link. When a file is selected, its path and name appears
in the File list.

File list The file to be attached to your scene. You can enter the file location,
or you can expand the list to display a history of the last ten attached files.

NOTE You can resize the File Link Manager dialog by dragging any corner or
edge. This is useful for viewing a file path if it's too long to fit in the file list field.

Preset Displays a list of preset settings you can choose to use when attaching
the file. Each list entry in this list represents a unique collection of attach and
reload settings. You can create additional presets in the Presets panel of the
File Link Manager dialog.

Rescale Alters the scale of the geometry from a linked file to match the system
unit scale on page 7812 in 3ds Max. When Rescale is on, you can specify what
the base units should be for the geometry in the linked file. For example, if
the length of a line in the linked file is 2 units, you can specify that these units
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be considered as any of the units listed under File Units (below), such as inches,
millimeters, or parsecs.

When Rescale is on, and the units you specify are different from the system
units currently set in the 3ds Max scene, the incoming objects are scaled
appropriately. For example, if a door measures 914 units in the linked file,
and you specify millimeters to convert from, the door will measure 36 inches
in the 3ds Max scene.

NOTE You can't change units when you reload a linked file.

NOTE By default, system units are inches in 3ds Max. Consider carefully before
changing the default system units. For more information, see Using Units on page
2588.

Incoming File Units Displays the unit of measure found in the original
drawing file and lists the units to which you can choose to rescale the attached
file. This is only active when Rescale is on.

Select Layers to Include Displays the Select Layers dialog on page 7017, which
you use to select the layers to import from the linked file.

Attach This File Attaches the selected file to your scene, using the settings
selected in the Preset list, if one was selected.

To cancel the File Link operation press Esc. You can do this at any time during
the process.

Cancelling the File Link operation removes every object the process has linked
to the scene until the moment you press Esc.

Close Cancels all changes to settings and closes the dialog.
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Files panel

Linked Files Lists linked files. The File Link Manager displays an icon next
to the path name of each linked file. The icon reflects the status of the linked
file, as described below:

 The linked file hasn't changed and there are no errors.

 The linked file can't be found at the specified location.

 The linked file has changed or another file has been selected by changing
the path or using the browser from this list. If you want to update your scene
with the changes in this file, you must reload on page 6995 your link.

You can change the path name by highlighting it and clicking again to enter
its location. This also displays a file browser button to the right of the file
name that you can use to locate a file. If the directory of a linked file is no
longer valid, then you must enter a new, valid path name.

Reload Refreshes the link between the file and the 3ds Max session. This
feature is useful when the file has been modified and you want to see the
changes reflected in your 3ds Max scene. If you turn on Show Reload Options,
the File Link Settings dialog on page 6998 displays when you click this button.

Changes that have been made to the base file will be applied to the objects at
the bottom of the 3ds Max modifier stack. If you have 3ds Max materials
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applied to walls in a floor plan in your scene, the same materials are applied
to the walls when you reload an updated version of the linked file.

To cancel the File Link operation press Esc. You can do this at any time during
the process.

Cancelling the File Link operation removes every object the process has linked
to the scene until the moment you press Esc.

NOTE This option is available only when the file is highlighted in the Linked Files
list.

Detach Removes an existing link to a file. Detach also removes all geometry
associated with or dependent on the link.

When you click this button, you receive a warning that you're about to remove
all objects associated with the linked file. You can either proceed or cancel
the operation.

NOTE This option is available only when the file is highlighted in the Linked Files
list.

Bind Removes the link to the file. The geometry in the scene remains
unchanged, but it's no longer linked back to the original file and, if the original
file changes, it can't be updated using Reload.

When you click this button, you receive a warning that you're about to break
the link between the objects in the current 3ds Max scene and the file.

NOTE This option is available only when the file is highlighted in the Linked Files
list.

Show Reload Options Displays the File Link Settings dialog on page 6998 when
you click Reload, and uses these settings for reloading. When you turn off this
option, the File Link Manager uses the reload settings stored in the current
scene.

Close Cancels all changes to settings and closes the dialog.
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Presets panel

Named Presets Lists all existing presets.

Modify Opens the File Link Settings dialog on page 6998, letting you change
the settings of the selected preset.

New Opens the New Settings Preset dialog on page 7013, creating a new preset
with default settings.

NOTE New is only available when no preset is selected in the list. If a preset is
selected, this button changes to Copy.

Copy Opens the New Settings Preset dialog on page 7013, creating a new preset
with the same settings as the currently selected preset.

NOTE Copy is only available when a preset is selected in the list. If no preset is
selected, this button changes to New.

Rename Opens the Rename Settings Preset dialog on page 7015, letting you
change the name of the selected preset.

Delete Deletes the selected preset.

Close Cancels all changes to settings and closes the dialog.
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File Link Settings Dialog

File menu > File Link Manager > Files tab > Turn on Show Reload Options. >
Click Reload.

Utilities panel > Utilities rollout > More button > File Link Manager > Files tab
> Turn on Show Reload Options. > Click Reload.

The File Link Settings dialog gives you control over the detailed aspects of
how geometry is translated from DWG or DXF files and interpreted in 3ds
Max. It also allows you to control whether only a portion of the 3ds Max
objects will be affected by subsequent reloading. The File Link Settings dialog
is displayed when Show Reload Options is turned on in the File Link Manager
dialog, or when editing a file link Preset.

The File Link Settings dialog lets you:

■ View and exclude layers in a linked file.

■ Control how geometry is converted.

■ Define how linked objects are converted to 3ds Max objects, referred to as
VIZBlocks.

The selections you make in the File Link Settings dialog can affect the amount
of memory used by 3ds Max to hold the linked data. Use the Select Layers To
Include option on page 7007 to reduce the amount of information added to
your scene.

In some cases, it might be more efficient to create multiple links to the same
file, making different file link settings for each file.

See also:

■ File Link Tips on page 6981

Basic File Link Settings

File Link Manager > Reload a linked file with Show Reload Options turned on.
> File Link Settings dialog > Basic panel

File Link Manager > Presets panel > Highlight a preset and click Modify. > File
Link Settings dialog > Basic panel
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The Basic panel of the File Link Settings dialog on page 6998 defines how 3ds
Max converts the linked file’s objects into corresponding 3ds Max objects.

Interface

Weld nearby vertices Sets whether to weld nearby vertices of converted
objects according to the Weld Threshold setting. Welding smooths across
seams and unifies normals of objects with coincident vertices. Welding occurs
only on vertices that are part of the same object.
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Weld threshold Sets the distance that determines whether vertices are
coincident. If the distance between two vertices is less than or equal to the
weld threshold, the vertices are welded together. To use the Weld Threshold,
turn on Weld.

Auto-smooth adjacent face Assigns smoothing groups on page 8130 according
to the Smooth-angle value. Smoothing groups determine whether faces on
an object render as a smooth surface or display a seam at their edges, creating
a faceted appearance.

Smooth-angle Controls whether smoothing occurs between two adjacent
faces. If the angle between the two face normals is less than or equal to the
smooth angle, the faces are smoothed (that is, put in the same smoothing
group).

Orient normals of adjacent faces consistently Analyzes the face normals of
each object and flips normals where necessary, so they all point in a direction
that is consistent with adjoining faces. If the imported geometry isn't properly
welded, or if the AutoCAD geometry did not contain or specify normal
information, normals might be oriented in the wrong direction. Use the Edit
Mesh on page 1353 or Normal on page 1581modifiers to flip normals.

When Unify Normals is off, normals are calculated according to the face vertex
order in the linked file. Face normals for AutoCAD solids are already unified.
Turn off Unify Normals when importing only AutoCAD solid models from
AutoCAD Architecture.

Cap closed splines Applies an Extrude modifier on page 1448 to all closed
objects, and selects the Cap Start and Cap End options of the modifier. The
Extrude modifier Amount value for a closed object with no thickness is set to
0. Capping makes closed objects with thickness appear solid and closed objects
without thickness appear flat. When Cap Closed Objects is off, the Extrude
modifier Cap Start and Cap End options for closed objects with thickness are
clear. No modifiers are applied to closed objects without thickness.

TIP Unless you chose the One-to-One sorting option, you won't immediately see
the Extrude modifier when selecting an object. To see it, look through the modifier
stack for the VIZBlock on page 8165 sub-objects. In a nested VIZBlock, the Extrude
modifiers appear at the bottom of the stack. You can then edit the Extrude modifier
parameters.

Texture Mapping The texture mapping setting can reduce the loading time
of models that have many objects with stored UVW Coordinates for texture
mapped materials.
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NOTE This setting applies only to geometry that is stored as a mesh in the scene.
Spline shapes marked as renderable have separate controls for UVW coordinate
generation; these are found on the Spline Rendering panel on page 7010.

■ Generate Coordinates For All Objects Automatically generates UVW
coordinates for all objects when the drawing is linked.
This option tells the File Link Manager to create UVW coordinates, but
loading time is increased while the coordinate generation occurs.

■ Generate Coordinates On Demand Does not generate texture coordinates
for linked mesh objects.
Actively linked objects generate UVW coordinates on demand, so if you
assign a material to an object and the material requires texture coordinates,
the texture coordinates are silently assigned to that object. If the material
or texture map is set to display in viewport, the coordinates are assigned
as soon as the material is applied; if not, the coordinates are assigned when
the scene is rendered.

This option gives you faster loading speed, but no UVW coordinate
generation.

NOTE Objects in drawings created in AutoCAD Architecture pass texture
coordinates explicitly to 3ds Max when you attach the drawing. If you specify
on-demand coordinate generation, they might not match the coordinates that
were specified in the original drawing. The map scaling is the same, but the
texture offsets may be altered.

Curve steps For objects such as splines, the number of knot points determines
the spline's shape and curvature. The Curve steps value defines the number
of segments between knot points. A low value gives you a more linear
interpolation between the knot points; a higher number gives you a more
accurate curve.

Maximum surface deviation for 3D solids Specifies the maximum allowable
distance from the 3ds Max surface mesh to the parametric AutoCAD solid
surface. Small numbers produce more accurate surfaces with a greater number
of faces. Large numbers produce less accurate surfaces with fewer faces.

Include group

This group allows you to toggle the inclusion of specific parts of a DWG file
during the file link process.

External references Imports xrefs attached to the DWG file.
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Lights Imports lights from pre-AutoCAD 2007 DWG files.

Sun and Sky Imports Sun and Shadows position from the drawing file
(AutoCAD / AutoCAD Architecture 2008 and Revit 2008 only).

NOTE You must set mental ray as the default renderer for you to see the Sun and
Sky effect. To set mental ray as the default renderer, see Choose Renderer Dialog
on page 6136.

Hatches Imports hatches from the DWG file.

WARNING This stores each line or dot in the hatch pattern as a separate spline
that defines the hatch; this can create a very large number of objects in your scene.

Views and Camera Imports named views from the DWG file, and converts
them to 3ds Max cameras.

NOTE Orthographic views do not translate correctly in imported DWG files.
However, there are no problems with Perspective views.

Points Imports points from the DWG file.

NOTE The imported point objects are represented in 3ds Max as Point Helper on
page 2628 objects.

UCSs (grids) Imports user coordinate systems (UCS) from the DWG file and
converts them to 3ds Max grid objects.

Advanced File Link Settings

File menu > File Link Manager > Reload a linked file with Show Reload turned
on. > File Link Settings dialog > Advanced panel

File menu > File Link Manager > Presets panel > Select an existing preset and
click Modify. > File Link Settings dialog > Advanced panel

File menu > File Link Manager > Presets panel > Create a new preset. > Select
the newly created preset and click Modify > File Link Settings dialog >
Advanced panel

Utilities panel > Utilities rollout > More button > File Link Manager > Reload
a linked file with Show Reload turned on. > File Link Settings dialog > Advanced
panel

7002 | Chapter 23   Managing Scenes and Projects



Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Highlight an existing preset and click Modify. > File Link Settings
dialog > Advanced panel

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Create a new preset. > Highlight the newly created preset and click
Modify > File Link Settings dialog > Advanced panel

The Advanced panel of the File Link Settings dialog on page 6998 controls how
the software derives AutoCAD primitives and whether 3ds Max uses the scene
material definitions when linking to or reloading the AutoCAD drawing. It
also lets you selectively reload your scene, so that you reload only specific
objects, not the entire file.
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Interface

Derive AutoCAD primitives by: Lists the options for deriving objects from
the linked DWG file. This setting is available only when modifying a preset
on page 7016.

NOTE This applies only to standard AutoCAD primitives. Specialized objects, such
as those from AutoCAD Architecture, are handled differently.

TIP For best results, use the Layer, Blocks as Node Hierarchy or Entity, Blocks as Node
Hierarchy options, except in special circumstances.
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There are six options to choose from:

■ Layer, Blocks as Node Hierarchy Linked objects on a given layer in the
AutoCAD drawing that aren't in blocks are combined into a single Editable
Mesh or Editable Spline object in 3ds Max. The name of each linked object
is based on the AutoCAD object's layer. The linked object name has a
“Layer:” prefix and is followed by the layer name. For example, all AutoCAD
objects residing on the layer Walls become part of the Editable Mesh named
Layer:Walls after they are linked in 3ds Max.
Each block is linked separately as a hierarchy, with the block itself as the
parent object and its constituent parts as child objects. The child objects
of the block are combined by layer.

TIP This is usually the best option for file linking. It preserves all ADT
information, and generally maintains the same granularity as you would expect
in AutoCAD.

■ Layer, Blocks as Node Hierarchy, Split by Material This works the same
as the Layer, Blocks as Node Hierarchy option, with the following additional
functionalities: The combination of non-block objects by layer, followed
by material and support for multiple materials assigned to ACIS solid and
polymesh geometry.

■ Non-block object layer combination:

For example, take an AutoCAD file with six objects in layer A: three have
a Brick material and three have a Stone material. Using this option, this
file would be linked to in the form of two objects, or nodes, one containing
the Brick material and the other with the Stone material.

Each block is linked to separately as a hierarchy, with the block itself as
the parent object and its constituent parts as child objects. The child objects
of the block are combined by layer.

■ Multiple material support

On import, ACIS solids and polymesh geometry can support multiple
materials. For polymesh geometry, one material is supported per face. For
an ACIS solid, if the solid has more than one material associated with it,
a multi/sub object material is created that contains the materials used. If
the solid has only one material associated with it, a standard/architectural
material is assigned instead.
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NOTE Multiple material support for ACIS solids applies to DWG files imported
or file linked from Revit Architecture 2008 or AutoCAD Architecture (formerly
Architectural Desktop or ADT) 2008 and later.

NOTE This derivation method is intended for use with AutoCAD 2007 (and
later) format files. Using this method with DWG files created with previous
versions of AutoCAD could result in data loss.

■ Entity, Blocks as Node Hierarchy Every linked object not in a block is
represented as a separate object in the 3ds Max scene, without regard to
layers. The nodes are then placed on scene layers that correspond to the
drawing layers. Each block is imported separately as a hierarchy, with the
block itself as the parent object and its constituent parts as child objects.
The child objects of the block are combined by layer.
One benefit of this option is that you can apply instanced animation
controllers on page 3109 to block subcomponents and thus, by transforming
a single member, transform all members at once. For example, in a scene
containing a conference table with six chairs around it, you could move
all of the chairs simultaneously by moving a single chair.

Another advantage is that all geometry is instanced, so edited UVs and
normals and other modifications need be done only once.

NOTE This derivation method might cause unreliable material propagation
when importing drawings containing dynamic blocks. Materials might
propagate to some block instances and not to others.

WARNING This option has the potential to create an enormous number of
objects in your scene.

Multiple materials per object are supported with this option, if needed. If
the object is an ACIS solid, and has more than one material associated
with it, a multi/sub object material is created containing the materials that
can be edited in the Materials Editor. If the solid has only one material
associated with it, a standard/architectural material is assigned instead. If
the object is polymesh geometry, one material per face is supported.

NOTE Multiple material support for ACIS solids applies on the DWG files
imported or file linked from Revit Architecture 2008 or AutoCAD Architecture
(formerly Architectural Desktop or ADT) 2007 and later.

■ Layer Linked objects are combined in 3ds Max according to their layer.
Objects in each of the associated application's layers are combined into
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one object, with the exception of blocks, each of which is represented as
an individual VIZBlock (not a hierarchy). Multiple inserts of the same block
are represented using instances in the scene. Material assignments are lost
but material IDs are preserved.

■ Color Linked AutoCAD objects are combined in 3ds Max according to
their color. All objects of the same color are combined into one object,
with the exception of blocks, each of which is represented as an individual
VIZBlock (not a hierarchy). Multiple inserts of the same block are
represented using instances in the scene. Material assignments are lost but
material IDs are preserved.

NOTE Blocks can contain objects with different colors. However, when sorting,
3ds Max considers only the color of the block itself. Also, 3ds Max objects can
only display one color, unless a material is applied.

■ Entity Provides a one-to-one correspondence between AutoCAD objects
and 3ds Max objects. For each linked object or block in the imported file,
the File Link Manager creates an independent object or VIZBlock,
respectively, in the scene. Material assignments are lost but material IDs
are preserved.

WARNING This option has the potential to create an enormous number of
objects in your scene.

NOTE When working with drawings exported from Revit, it is recommended
that you do not use this setting.

■ One Object All linked objects are combined into a single VIZBlock.
Material assignments are lost but material IDs are preserved.

Select Layers to Include Displays the Select Layers dialog on page 7017, which
you use to choose layers to import from the linked file. Available only when
reloading a linked file.

TIP Excluding unnecessary objects from linking can improve the performance of
the reload operation.

Create Helper at Drawing Origin When on, 3ds Max inserts the user
coordinate system icon as an origin point helper. 3ds Max places this helper
at the world origin of the linked file. It's a reference point for all the geometry
of the linked file. After attaching, the helper is selected, allowing you to easily
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move, rotate, or scale all the geometry that was just added to the scene. Each
linked file gets a unique helper object.

This setting is available only when modifying a preset on page 7016.

Use Extrude Modifier to Represent Thickness When on, linked objects with
thickness receive an Extrude modifier to represent the thickness value. You
can then access the parameters of this modifier and change the height
segments, capping options, and height value.

When off, objects with thickness (and closed capped objects) are converted
directly to a mesh.

This setting is available only when modifying a preset on page 7016, and not
using the Derive option Layer, Blocks as Node Hierarchy.

Create One Scene Object for Each ADT Object AutoCAD Architecture
(formerly Architectural Desktop or ADT) objects are linked as a single object
instead of being separated into their constituent components. This means
that if you link an AutoCAD Architecture door object, the door is represented
as one object instead of three. Turning on this switch make linking faster and
the scene size is smaller.

This setting is available only when modifying a preset on page 7016.

NOTE This switch presents several modeling concerns that you need to be aware
of.

■ Material assignments from AutoCAD Architecture are not translated during
the file link process.

■ If you want to assign materials to these objects, use Multi/Sub-Object
materials.

■ Depending on the Texture Mapping option you choose, UVW coordinates
are translated correctly.

Use Scene Material Definitions When on, 3ds Max checks the current scene
for any currently used materials with the exact same name as a material name
in the linked DWG file. If a match is found, File Link does not translate the
drawing’s material, but instead uses the material defined in the scene.

When off, the File Link Manager always uses the material definitions contained
in the DWG file, and will overwrite scene materials with the same name,
regardless of which objects the material is applied to. All material definitions
stored in the DWG file are reloaded (even when using a selective reload). If
you make changes to a linked material, in 3ds Max, then reload, those changes
will be lost (if the switch is off).
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If Use Scene Material Assignments on Reload is on at the same time as Use
Scene Material Definitions, standard/architectural materials, material
assignments, and face material IDs are left as they are.

If Use Scene Material Assignments on Reload is off at the same time as Use
Scene Material Definitions, only the material assignments and face material
IDs are updated and standard/architectural materials are not translated.

TIP When reloading a file, most of the materials from the DWG file will have
already been created in the scene by 3ds Max; they may not need to be
re-translated. If you want to update a scene material with the definition contained
in the drawing, turn this switch off.

NOTE Material name comparison is case-sensitive.

Use Scene Material Assignments on Reload When on, linked objects with
a material already assigned to them in the 3ds Max scene will not have that
material assignment changed. This is the case regardless of whether the material
was assigned automatically by the File Link Manager or manually by the user.

When off, linked objects have their material assignment “coordinated” with
the drawing, so that the two are in sync.

If Use Scene Material Definitions is on at the same time as Use Scene Material
Assignments on Reload, standard/architectural materials and material
assignments are left unchanged.

If Use Scene Material Definitions is off while Use Scene Material Assignments
on Reload is on, only standard/architectural materials are retranslated. Any
material assignments and Face Material IDs are left unchanged, so Multi/Sub
object materials are not retranslated but some sub-materials may have changed.

Selective Reload Lets you perform a partial reload of your linked file. Use a
partial reload when you know what has changed in the linked file, and want
to speed up the time it takes to reload the geometry.

The following options are available:

■ Selected in Scene Reloads only the objects currently selected in your
scene.

■ Selected in List Reloads only the objects that you choose from a named
list. This list is defined by clicking Linked Objects.

Linked Objects Allows you to reload only objects that you choose from a
named list. The list is created from the objects linked in the file. When you
click Linked Objects, the Select Linked Object dialog on page 7019 is displayed.
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Spline Rendering File Link Settings

File menu > File Link Manager > Reload a linked file with Show Reload turned
on. > File Link Settings dialog > Spline Rendering panel

File menu > File Link Manager > Presets panel > Select an existing preset and
click Modify. > File Link Settings dialog > Spline Rendering panel

File menu > File Link Manager > Presets panel > Create a new preset. > Select
the newly created preset and click Modify > File Link Settings dialog > Spline
Rendering panel

Utilities panel > Utilities rollout > More button > File Link Manager > Reload
a linked file with Show Reload turned on. > File Link Settings dialog > Spline
Rendering panel

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Highlight an existing preset and click Modify. > File Link Settings
dialog > Spline Rendering panel

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Create a new preset. > Highlight the newly created preset and click
Modify > File Link Settings dialog > Spline Rendering panel

The Spline Rendering panel of the File Link Settings dialog on page 6998 controls
how shapes will appear in the scene once the DWG or DXF file is linked. You
can control the appearance of the shape, its smoothing, mapping coordinates
and if they can be rendered.
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Interface

The controls on this panel are identical in name and operation to those found
on the Rendering rollout on page 615 for splines. The values of these settings
are set for all imported shapes. Once the import is complete, you can change
the settings as necessary for each object.

Enable in Renderer When on, the shape is rendered as a 3D mesh using the
Radial or Rectangular parameters set for Renderer. In previous versions of the
program, the Renderable switch performed the same operation.

Enable in Viewport When on, the shape is displayed in the viewport as a 3D
mesh using the Radial or Rectangular parameters set for Renderer. In previous
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versions of the program, the Display Render Mesh performed the same
operation.

Use Viewport settings Lets you set different rendering parameters, and displays
the mesh generated by the Viewport settings. Available only when Enable In
Viewport is on.

Generate Mapping Coords Turn this on to apply mapping coordinates.
Default=off.

3ds Max generates the mapping coordinates in the U and V dimensions. The
U coordinate wraps once around the spline; the V coordinate is mapped once
along its length. Tiling is achieved using the Tiling parameters in the applied
material. For more information, see Mapping Coordinates on page 5279.

Real-World Map Size Controls the scaling method used for texture mapped
materials that are applied to the object. The scaling values are controlled by
the Use Real-World Scale settings found in the applied material's Coordinates
rollout on page 5782. Default=on.

Auto Smooth If Auto Smooth is turned on, the spline is auto-smoothed using
the threshold specified by the Threshold setting below it. Auto Smooth sets
the smoothing based on the angle between spline segments. Any two adjacent
segments are put in the same smoothing group if the angle between them is
less than the threshold angle.

Threshold Specifies the threshold angle in degrees. Any two adjacent spline
segments are put in the same smoothing group if the angle between them is
less than the threshold angle.

Viewport Turn this on to specify Radial or Rectangular parameters for the
shape as it will display in the viewport when Enable in Viewport is turned on.

Renderer Turn this on to specify Radial or Rectangular parameters for the
shape as it will display when rendered or viewed in the viewport when Enable
in Viewport is turned on.

Radial Displays the 3D mesh as a cylindrical object.

Thickness Specifies the diameter of the viewport or rendered spline mesh.
Default=1.0. Range=0.0 to 100,000,000.0.
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Splines rendered at thickness of 1.0 and 5.0, respectively

Sides Sets the number of sides (or facets) for the spline mesh n the viewport
or renderer. For example, a value of 4 results in a square cross-section.

Angle Adjusts the rotational position of the cross-section in the viewport or
renderer. For example, if the spline mesh has a square cross section you can
use Angle to position a "flat" side down.

Rectangular Displays the spline's mesh shape as a rectangle.

Length Specifies the size of the cross–section along the local Y axis.

Width Specifies the size of the cross–section along the local X axis.

Angle Adjusts the rotational position of the cross-section in the viewport or
renderer. For example, if you have a square cross-section you can use Angle
to position a "flat" side down.

Aspect Sets the aspect ratio for rectangular cross-sections. The Lock check box
lets you lock the aspect ratio. When Lock is turned on, Width is locked to
Length that results in a constant ratio of Width to Length.

New Settings Preset Dialog

File menu > File Link Manager > Presets panel > Copy or New

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Copy or New
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The New Settings Preset dialog creates a new preset in the File Link Manager
on page 6987. The settings of the new preset either use default values (if you
clicked New), or they inherit the values of a selected preset (if you clicked
Copy).

After creating the preset, you can change its settings by clicking Modify.

Procedures

To create a new preset:

1 On the Presets panel of the File Link Manager, click New.

NOTE New is available only if no named presets are highlighted.

2 On the New Settings Preset dialog, enter a name for your preset, and click
OK.

A new preset is created with default settings.

To copy a preset:

1 On the Presets panel of the File Link Manager, choose a named preset.

2 Click Copy.

NOTE Copy is available only if a named preset is highlighted.

3 In the New Settings Preset dialog, rename the preset, and click OK.

A new preset is created with the same settings as the selected preset.

NOTE If you do not rename the preset, it will cancel the command.
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Interface

New Name The name of your preset.

Format The file type for the preset.

Rename Settings Preset Dialog

File menu > File Link Manager > Presets panel > Click a preset > Rename

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Click a preset > Rename

The Rename Settings Preset dialog lets you rename your preset.

NOTE You cannot use names beginning with 'Preset', so names like “Preset 1” or
“Preset with Welding” are not allowed.

Interface
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New Name The name of your preset.

Format The file type for the preset.

NOTE By default, presets can be created only for AutoCAD file types (DWG, DXF).
Other file types might be available, depending on the third-party plug-ins you
have installed.

Preset Editing

File menu > File Link Manager > Presets panel > Click a preset > Modify

Utilities panel > Utilities rollout > More button > File Link Manager > Presets
panel > Click a preset > Modify

After you've created a preset, you can use this function to adjust its settings.
For instance, you might want to make sure Weld is on, or perhaps to include
lights or views (cameras).

Procedures

To edit or modify a preset:

1 On the Presets panel of the File Link Manager, choose a named preset.

2 Click Modify.

The File Link Settings dialog on page 6998 is displayed.

3 From the Basic, Advanced and Spline Rendering panels, make the settings
you want associated with the preset and click Save.

Differences Between Layers and Blocks in
AutoCAD and 3ds Max

AutoCAD has special handling for objects in the block definition that are
associated with layer 0. When a block contains objects on layer 0, and those
objects have a color property of "ByLayer" or "ByBlock", the color of the object
is determined either by the color of the block or by the layer assigned to the
block reference on page 7927 in AutoCAD. When blocks are nested, this color
system can get complex.
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Select Layers Dialog

File menu > File Link Manager > Files panel > Reload button > File Link Settings
dialog > Advanced panel > Select Layers to Include button

Utilities panel > Utilities rollout > More button > File Link Manager > Files
panel > Reload button > File Link Settings dialog > Advanced panel > Select
Layers to Include button

This dialog lets you toggle a layer's include/exclude status and choose other
options, as described in this topic.

NOTE You toggle the include/exclude status of a layer by clicking anywhere on
a row in the list of layers. The dialog lists included layers with a check mark to the
left of the layer name. This list of included layers is retained for subsequent reloads
of the linked file. For informational purposes, the property icons display the state
of the layers' properties, but you can't change their status in this dialog.

See also:

■ Layer Properties Dialog on page 7451

Interface
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Skip all frozen layers Excludes all layers frozen in the linked file. All active
files are included.

Select from list Lets you select individual active layers to include/exclude. A
check mark beside the layer name indicates the layer is selected.

All Includes all layers in the linked file by selecting all of them. You can then
deselect just the layers you want to exclude.

None Excludes all layers in the linked file by deselecting all of them. You can
then select just the layers you want to include from importing.

Invert Reverses the current selection of layers in the linked file.

Resolve External Reference File Dialog

The Resolve External Reference File dialog is displayed when 3ds Max can't
find the externally referenced files it needs in an attached DWG file.

See also:

■ File Link Tips on page 6981

Interface
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Xref Stored File Name Displays the external reference path stored in the
attached drawing.

Referenced by Displays the path of the attached drawing.

As Block Name Displays the name of the block reference in the attached
drawing. The block name is usually the same as the xref name, but it can be
different.

File Name for File Link When 3ds Max can't locate the linked file, use this
field to enter another path and file name. 3ds Max verifies that the file exists
at that location and reports its status in the lower left of the dialog.

Browse Lets you use the file system to find another file for the link. Choosing
a file this way enters file path and name in the File Name For File Link field.

All Xref Files group

Controls whether and how 3ds Max resolves external references from File
Link.

Prompt Only if File Cannot be Found Searches for the externally referenced
file and all unresolved external references from File Link in the attached
drawing by using the stored file name in the locations listed in this dialog
and in the order they appear.

Do Not Resolve any Xrefs Doesn't resolve this externally referenced file or
any other unresolved external references from File Link in the attached
drawing. However, any external references from File Link resolved before you
turn on Do Not Resolve Any Xrefs will still be resolved.

OK Resolves this externally referenced file.

Don't Resolve This File Doesn't resolve this externally referenced file, but
will prompt for any other external references from File Link to resolve.

Select Linked Objects Dialog

File menu > File Link Manager > Files panel > Select file to reload. > Reload
button > File Link Settings dialog > Advanced panel > Turn on Selective Reload.
> Linked Objects

Utilities panel > Utilities rollout > More button > File Link Manager > Files
panel > Select file to reload. > Reload button > File Link Settings dialog >
Advanced panel > Turn on Selective Reload. > Linked Objects
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The Select Linked Objects dialog displays the linked objects associated with
the selected linked file, including VIZBlocks on page 8165, lights, and cameras.
You use this dialog when reloading a linked file so that you can include/exclude
specific objects from the reloading process. You might want to do this in order
to reload only the objects which have changed.

Interface

List of Objects Lists the VIZBlocks, cameras, and lights associated with the
selected linked file. A check mark beside the object name indicates the object
is selected; an X mark indicates the object is deselected.

All Selects all linked objects in the linked file. You can then deselect specific
linked objects by clicking their rows.

None Deselects all linked objects in the linked file. You can then select specific
linked objects by clicking their rows.

Invert Reverses the current selection of linked objects in the linked file.
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Working with AutoCAD,AutoCAD Architecture,
and Revit Files

3ds Max produces rich visualizations based on your drawing design data. In
order to produce high-quality visualizations, you need to add and adjust many
design variables that affect the visual impact of your design, but don't really
belong in your core AutoCAD, AutoCAD Architecture, or Revit data. You may
want to test your design under different lighting conditions, experiment with
different texture and material effects, animate components, or move through
a space. 3ds Max allows you to enhance your design with this “extra” data
while maintaining the integrity of the underlying AutoCAD, AutoCAD
Architecture, or Revit design.

Using the File Link Manager on page 6987, 3ds Max maintains a live data link
to AutoCAD, AutoCAD Architecture, or drawings exported from Revit that
allows you to use the linked object data in your 3ds Max scene. You can
perform various operations on this linked data in 3ds Max for visualization
purposes, but nothing you do in 3ds Max will change the base data you see
in the source application. The data link allows you to periodically refresh your
3ds Max scene with revised drawing data.
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If a live data link is not important to you, the DWG/DXF Import functionality
processes drawings, exported from Revit, in the same intelligent way as the
File Link Manager. You just don't have the benefit of the live data link.

See also:

■ Using Layers to Organize a Scene on page 7438

■ File Link on page 6976

■ Interpreting Layer Data from AutoCAD, AutoCAD Architecture, and Revit
on page 6986

AutoCAD Geometry in 3ds Max

The basis of your model in 3ds Max is the geometry of the objects, blocks,
and other entities that are transferred through the file linking functionality.
In many cases, these objects behave just like the editable meshes and splines
you create in 3ds Max. But because the link to the source drawing plays such
a central role in your workflow, 3ds Max has special rules and tools for
handling linked AutoCAD geometry.

When you are working with linked objects and blocks from AutoCAD, you
will find that these are composed as groups of related objects in 3ds Max.
These groups are organized hierarchically below a 3ds Max VIZBlock object.
VIZBlocks are special objects created by the file linking functionality that are
used to contain other file linked objects in a group. VIZBlocks don't contain
any geometry directly, so for example it is meaningless to apply modifiers to
them. However, they do reference the components below them so that
transforms applied to a VIZBlock will be applied to all the component objects
it contains.

See also:

■ Styles on page 7054

■ Instanced Objects on page 7047

■ Blocks on page 7048
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AutoCAD Entities and Blocks in 3ds Max

AutoCAD blocks in 3ds Max are treated similarly to AutoCAD objects, though
the rules for propagation of transforms are slightly different to mirror the
behavior of blocks in AutoCAD.

As with AutoCAD objects, linked AutoCAD blocks, of any type, and externally
referenced drawings appear in 3ds Max as objects hierarchically grouped below
a VIZBlock to reflect the structure of the block or xref in AutoCAD.

When non-nested blocks, of any type, are linked to a scene, the naming for
the incoming block instances are based on the original block definition in the
form of Block: block_name where block_name is the actual name of the block
definition. For example, if you link a drawing containing a series of blocks
named office chair, their name will show as Block: office chair in 3ds Max.

Nested blocks in AutoCAD will be analogously nested in 3ds Max under nested
VIZBlocks. The grouping and naming follows the parent-child structure of xref
drawing name:block name:nested block name:entity.

NOTE Entities that lie on layer 0 of an AutoCAD block definition will appear as
Layer:0 in 3ds Max, even though they may appear to reside on a different layer
when they are inserted in AutoCAD.

With linked AutoCAD Architecture objects, material assignments to linked
AutoCAD blocks can propagate automatically to all other instances of those
block components in the 3ds Max scene, depending on how Propagate
Materials To Instances on page 5328 is set. Modifiers applied to block
components, however, propagate automatically to all other block instances,
regardless of how Propagate Materials To Instances is set.

If you transform (move, rotate, or scale) the top-level VIZBlock that contains
a block reference, all the components of that block will be transformed together
and no other VIZBlocks will be affected. If, however, you transform a block
component, including a nested VIZBlock, that transformation will automatically
propagate to all other instances of that block in the scene. This mirrors the
behavior of blocks in AutoCAD when reference-editing a block definition.

See also:

■ Blocks on page 7048
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Resetting Transforms on Linked AutoCAD Objects

Select a linked AutoCAD object. > Modify panel > Linked Geometry rollout >
Reset Position

You can move, rotate, or scale linked AutoCAD objects in 3ds Max, and these
transformations will remain intact even after the linked AutoCAD drawing
has been reloaded. But you can choose to eliminate the transforms on an
object-by-object basis using the Reset Position function, available on the
Modifier panel.

NOTE The Reset Position functionality is only available for linked files. It is not
available when you Import a DWG file, or when you have bound a linked file.

Every linked AutoCAD object and component has a Reset Position function
associated with it. Clicking this button automatically resets all transformations
that have been applied to this object or component in 3ds Max, so that the
component resumes the location, rotation, and scale it held in the linked
AutoCAD drawing when it was last reloaded.

WARNING Transforms applied to block components are applied to all instances
of that component in all other linked block insertions in the 3ds Max scene.
Resetting the transformation of any instance will reset all of them.

To reset the transforms applied to a linked AutoCAD object:

1 Select a linked object in your scene.

2 On the Command panel, click the Modify tab to display the Modify
panel.

The name of the linked object appears at the top of the Modify panel,
and the modifiers that have been added to the object (if any) are shown
on the modifier stack.

3 At the bottom of the list of applied modifiers, click either Linked Geometry,
VIZBlock, or Block/Style Parent, whichever appears, if it is not already
highlighted.

A Linked Geometry rollout appears at the bottom of the Modify panel.

4 Click the Reset Position button

The linked object reverts back to its original location, rotation, and scale
in the linked AutoCAD drawing.
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NOTE When Reset Position is applied to a linked object that has been animated
(in other words, has transform keys for different frames) only the transform for
frame 0 is reset.

See also:

■ File Link on page 6976

Interface

Reset Position Resets the selected object's transforms to those of the original
AutoCAD object when the drawing was last reloaded.

Restrictions on Editing AutoCAD Geometry

Many operations that are allowed on mesh, spline, or shape objects in 3ds
Max are not allowed on linked AutoCAD geometry, and other operations
behave differently.

The following operations are not allowed on linked geometry:

■ Deletion

■ Altering the parent-child hierarchy

■ Collapsing the linked geometry into an editable mesh or an editable spline

If you must perform any of these operations, you must either do them in
AutoCAD or else bind the drawing data to 3ds Max, which breaks the link
back to AutoCAD.

Applying Modifiers to Linked AutoCAD Geometry

You can apply modifiers to linked AutoCAD geometry and these modifiers
will persist when you reload the geometry. This can be a very powerful way
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to intelligently manage your design intent, but it can also lead to some
unexpected results, especially when using topology-dependent modifiers.

“Topology-dependent” simply means that the modifier is relying on the
particular arrangement and number of faces and vertices that comprise the
mesh representation of the object. It is common, for example, for the modifier
to cause an action to be performed on the nth element it encounters, say the
“twelfth” face or the “fourth through the twentieth” vertex. It is easy to
perform edits on the base object in AutoCAD that would cause the definition
of the nth element to change, which would result in the modifier yielding
unexpected results when the drawing is reloaded in 3ds Max.

Not all modifiers are topology-dependent. When you attempt to use a
topology-dependent modifier on linked AutoCAD geometry, a warning dialog
is displayed that gives you an opportunity to continue or abort the operation.

When you use modifiers on linked AutoCAD objects and blocks, remember
that the VIZBlock object you see in 3ds Max does not contain any geometry
directly; applying modifiers to VIZBlocks will never have any visible effect.
Instead, apply modifiers to the component objects below the VIZBlock in the
3ds Max object hierarchy.

Copying Actively Linked Objects

You can copy actively linked objects in 3ds Max; the copies are automatically
converted to editable mesh objects. If your selection contains several objects
that instance another object, the resulting copies also instance the same object.

However, it is recommended that you do not instance or reference actively
linked objects, as this can introduce instability to the scene.

See also:

■ Using Modifiers on page 1085

AutoCAD Architecture Files

DWG files from AutoCAD Architecture (formerly Architectural Desktop or
ADT) often contain additional information, such as special objects, material
definitions, and styles. 3ds Max is thoroughly compatible with AutoCAD
Architecture, and it recognizes all of these specialized objects and definitions
during the file link process.
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AutoCAD Architecture Objects in 3ds Max

Each instance of an AutoCAD Architecture (formerly Architectural Desktop
or ADT) object is represented by multiple objects in 3ds Max. Whenever the
file link process detects a useful distinction between elements of an AutoCAD
Architecture object, it automatically separates, names, and groups the elements
in 3ds Max to make them easier to work with. The new objects created in 3ds
Max through file linking are grouped together hierarchically below a special
object called a VIZBlock, allowing you to deal with individual objects in the
hierarchy or with all of them as a group. You can view this hierarchy, but you
cannot change it in 3ds Max. You can only change the hierarchy indirectly
by editing the objects in AutoCAD Architecture, and then reloading them
into 3ds Max using the File Link Manager on page 6987.

Criteria for Subdividing AutoCAD Architecture Objects

The File Link Manager divides an AutoCAD Architecture object into multiple
objects in 3ds Max if it detects distinctions based on the following features:

■ Component name

■ Component subtype (for example, in sectioned bodies)

■ Layer

■ Material assignment

So, for example, if a window object in AutoCAD Architecture contained a
mullion component, but a portion of the component had a different material
assignment than the rest of it, the mullion component would appear as two
separate objects when linked into 3ds Max. The objects will be linked together
with all the other components of the window, but you could modify the
material properties of the two mullion objects separately. If you changed the
material assignments in AutoCAD Architecture so that the entire mullion
component only had one material assignment, then when you reloaded the
drawing in 3ds Max there would only be one mullion object present.

NOTE Material assignment and Layer are two of the properties used to separate
one component from another. When these are changed in the AutoCAD
Architecture drawing, new objects are created in 3ds Max, or geometry may move
from one object to another. In either case, some scene properties are changed,
such as assigned material or scene layer.
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3ds Max organizes and names file linked objects to reflect their structure in
AutoCAD Architecture, using a parent-child hierarchy. The parent object will
be a VIZBlock named object class <style>, and this VIZBlock will have one or
more child objects named object class <style name> component1, object class
<style name> component2, and so forth. Objects that originate in an xref drawing
in AutoCAD Architecture are grouped together under a VIZBlock that is named
for the xref drawing.

The following table lists some examples of the naming conventions of
AutoCAD Architecture objects that are file linked in 3ds Max.

RemarksName in 3ds Max

A VIZBlock containing one or
more objects found in draw-

Xref:Draw-
ing1XRef:5701

ing1.dwg, which is an xref in
the linked AutoCAD Architec-
ture drawing.

A VIZBlock for an object of
class=Window and style=Picture-

Window <Picture-
Arched>

Arched. There will one or more
components that belong to
this object instance, which will
be child objects with the VIZB-
lock as their parent.

A component to the object,
named Frame.

Window <Picture-
Arched> Frame

NOTE It is possible for instances of the same AutoCAD Architecture object to
subdivide differently into 3ds Max objects. AutoCAD Architecture objects are
considered instances of the same object if their type, style name, and component
name are exact matches, and this will affect their instancing behavior for 3ds Max
functions such as substitution as well as material propagation.

See also:

■ Instanced Objects, Elements, Blocks and Styles on page 7046

■ Styles on page 7054
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Materials and Linked AutoCAD Architecture
Objects

Materials in 3ds Max are vital to making your visualizations compelling and
realistic. The native material attributes that 3ds Max relies on are those that
tell it how to render the surface of an object given certain lighting conditions.
Those material properties that are so central to architectural visualization (that
convey surface coloring, surface texture, transparency, and so forth) are only
one of many sets of properties covered in an AutoCAD Architecture (formerly
Architectural Desktop or ADT) material definition. To make your work more
efficient, the rendering material properties stored and assigned in AutoCAD
Architecture are designed to flow transparently to 3ds Max through the File
Link Manager on page 6987.

See also:

■ Propagate Materials to Instances on page 5328

Assigning Materials to Linked AutoCAD
Architecture Objects

Material assignments exhibit special behavior on linked AutoCAD Architecture
objects and blocks, and the behavior is controlled by the Propagate Materials
To Instances toggle on page 5328.

In the default state, assigning a material to any component of any linked
AutoCAD Architecture object or block is equivalent to assigning the same
material to every instance of that component of that object or block
throughout your scene.

As an example, let's say you have multiple instances of a block named
Telephone in your AutoCAD Architecture drawing, which consists of two
nested blocks named Handset and Base. If you assign a material to one Handset
anywhere in your scene, all the Handsets in all the Telephones throughout
the scene will receive that material.

If you want to keep materials from propagating between instances in your
scene, turn off the Propagate Materials To Instances toggle on page 5328.
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See also:

■ Instanced Objects on page 7047

■ Blocks on page 7048

Making Changes to AutoCAD Architecture
Materials

AutoCAD Architecture (formerly Architectural Desktop) object components
frequently appear in 3ds Max carrying rendering material assignments that
were made in AutoCAD Architecture. You can use these materials, adjust them,
or replace them with new rendering materials for use in 3ds Max. If you modify
or replace the materials in 3ds Max, or if they change in the linked AutoCAD
Architecture drawing, you can choose either to retain the current material in
3ds Max or else to revise the material assigned in 3ds Max with the current
material in AutoCAD Architecture when you use the File Link Manager on
page 6987 to reload the linked drawing.

NOTE When 3ds Max encounters additional material references among xref files
that use a material name that is already in use, it compares the properties of the
two material definitions in an attempt to determine whether they really represent
identical materials. If the two materials appear to be the same material being used
in different drawings, 3ds Max will use only one of the material definitions for all
objects assigned either material. But if 3ds Max determines that this is merely a
naming conflict between two different materials, it will slightly modify the name
of one of the materials and keep the materials and their assignments distinct.

Legacy Materials in AutoCAD Architecture

Longtime users of AutoCAD may be familiar with an older form of material
creation and assignment associated with the RMAT command in AutoCAD
that is still present in AutoCAD Architecture. Materials developed in this way
can be viewed in AutoCAD Architecture and rendered with the legacy AutoCAD
renderer. Any assignments of these materials to geometry in AutoCAD
Architecture that is made through the RMAT command or its Material dialog
in AutoCAD Architecture will be ignored in 3ds Max.

In theory, RMAT materials could be assigned to AutoCAD Architecture objects
(not AutoCAD objects) by incorporating them into AutoCAD Architecture
material definitions, and using these material definitions in edits to AutoCAD
Architecture styles or object overrides. Materials created and assigned in this
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way would appear in 3ds Max assigned to the linked AutoCAD Architecture
objects. However, this practice is not recommended because the native 3ds
Max Architectural materials have more complete information on the surface
characteristics of objects, and are easier to create and share. In other words,
you work faster, share easier, and get better results using native 3ds Max
rendering materials in both AutoCAD Architecture and 3ds Max.

See also:

■ Material Editor, Materials, and Maps on page 5259

UVW Mapping in AutoCAD Architecture Objects

An important consideration in how many materials render is how they are
“mapped” to the surfaces of the objects they are assigned to. This is especially
important for materials that use bitmaps on page 7926 to define the diffuse color
of a material, or the bump and cutout special effects. As an example, you may
have scanned a picture of wood grain for use in a material, but when the
material is applied to an object, how large should the image of the wood grain
be? Which way do you want the grain to run, and how do you want the grain
to wrap around the corners of a three-dimensional object?

How two-dimensional maps are applied to three-dimensional surfaces is
represented by mapping coordinates on page 8034, which are stored as UVW
coordinates on page 8161. In cases where mapping coordinates are likely to be
important to the rendered appearance of an object, AutoCAD Architecture
(formerly Architectural Desktop) assigns UVW coordinates to object
components. 3ds Max translates these coordinates and stores them in the
object mesh that is displayed and rendered in the 3ds Max scene. You can
adjust these coordinates in 3ds Max using the UVW Xform modifier on page
1955, or you can redefine them all at once using the UVW Map modifier on
page 1931.

IMPORTANT Make sure that Rescale is turned on in the Attach Panel of the File
Link Manager dialog. Otherwise, if the units do not match, the UVW coordinates
will be incorrectly scaled when linked to 3ds Max.

Drawings Exported from Revit

The Export function in Autodesk Revit lets you export models to DWG or DXF
file formats. In Revit 6.1 and 7.0, the exported drawing entities contain
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additional information, “Revit data,” such as their originating Category, Family,
Type, and Material.

The File Link Manager on page 6987 and DWG/DXF Import functionality looks
for and processes this additional information. When “Revit data” is found
with an object, the object is treated differently by the import/file link process.
The primary differences are:

■ object naming conventions

■ scene organization of incoming geometry (how the objects are combined)

■ parent-child hierarchy of scene objects

■ possible automatic material assignments

IMPORTANT 3ds Max cannot directly import (or link) a native Revit project (RVT).
You must first export a DWG or DXF file from Revit before you can import the
model into 3ds Max. The imported or linked file will contain scene objects that
correspond directly to individual Revit objects. In addition, most materials are
translated and assigned to the objects, giving Revit customers a head start toward
better visualization and faster rendering of their models.

See also:

■ Revit Elements in CEV_ProdName_CEV on page 7032

■ Materials and Linked Revit Objects on page 7041

Revit Elements in 3ds Max

Whenever you use the File Link Manager or DWG/DXF Import functionality,
3ds Max detects a useful distinction between categories of a Revit elements.
It automatically separates names and groups the elements in 3ds Max to make
them easier to work with. The new objects created in 3ds Max through file
linking are grouped together hierarchically below a special object called a
Block/Style Parent on page 7928, allowing you to deal with individual objects
in the hierarchy or with all of them as a group. This hierarchy is similar to
the one created when AutoCAD Architecture objects are linked.

You can view this hierarchy, but you cannot change it in 3ds Max. You can
change the hierarchy only indirectly by editing the elements in Revit, exporting
an updated DWG, and then reloading the drawing.
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Criteria for Subdividing Revit Elements

The File Link Manager organizes Revit elements into multiple 3ds Max objects
based on the following classification of elements:

■ Categories Categories are the most general class of element. They are
subdivided into model categories and annotation categories. Model categories
include doors, windows, walls, and furniture. Annotation categories include
dimensions, grids, levels, and text notes.

■ Families Families are classes of elements within a category that group
elements with a common set of parameters (properties), identical use, and
similar graphical representation. Different elements within a family may
have different values of some or all properties, but the set of
properties—their names and meaning—is the same.
For example, six-panel colonial doors are one family, although the doors
that compose the family come in different sizes and materials. Most families
are component family files, which means you can load them into your
project or create them from family templates. You can determine the set
of properties and the graphical representation of the family. Other families
are called system families and are not available for loading or creating in
Revit. Autodesk Revit predefines the set of properties and the graphical
representation of system families; they include walls, dimensions, ceilings,
roofs, floors, and levels.

Besides being a class of elements, families are also a template that allows
you to generate new types of items that belong to this family.

■ Types Types, also called a family types, are a class of elements within a
family that have the exact same values for all type properties. For example,
all 32x78 six-panel doors belong to one type, while all 24x80 six-panel
doors belong to another type. Like a family, a type is also a template that
generates new instances of this type.

■ Instances Instances are the actual items that have specific locations in
the building (model instances) or on a drawing sheet (annotation
instances).

3ds Max organizes and names file linked objects to reflect their structure in
Revit, using a parent-child hierarchy. The parent object is a Block/Style Parent
named category <family : type>, and the Block/Style Parent has one or more
child objects named category <family : type> subcategory1, category <family : type>
subcategory2, and so forth.

For example, if a single-flush door object in Revit is linked to 3ds Max, it will
have a parent-child hierarchy displayed as a parent object, Doors <Single-Flush
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: 34” x 80”>, with three children, (2) Doors <Single-Flush : 34” x 80”>
Frame/Mullion and a Doors <Single-Flush : 34” x 80”> Panel. The objects will be
linked together with all the other components of the door, but you could
modify the material properties of the two frame/mullion objects separately.
If you changed the material assignments in Revit so that the entire
frame/mullion component only had one material assignment, then when you
reloaded the drawing in 3ds Max there would only be one frame/mullion
object present.

When working in Revit, you also have the ability to link AutoCAD drawings
or other Revit projects to your current project. This is comparable to using
exrefs in AutoCAD. Objects that originate as a linked drawing in Revit are
grouped together as Linked Geometry that is named for the linked drawing.
In this case, the parent object is named Import Symbol <drawing.dwg> and its
children are named Import Symbol <drawing.dwg> subcategory1, Import Symbol
<drawing.dwg> subcategory2, etc. The subcategories are derived from the layers
that the objects reside on in the drawing.

The following table lists some examples of the naming conventions of Revit
objects that are imported or file linked in 3ds Max.

RemarksImported/File
Linked Name

A Block/Style Parent for an
object of catagory=Door,

Door <Single-Flush :
34” x 80”>

family=Single-Flush and
type=34” x 80”. This parent
object has one or more com-
ponents, that are child objects
displayed as Linked Geometry.

A component to an object
named, Window <Casement

Window <Casement
with Trim : 24” x
48”> Frame/Mullion with Trim : 24” x 48”>. This is

a child object and is displayed
as Linked Geometry. In Revit,
the Frame/Mullion is a subcat-
egory of Windows.

A Block/Style Parent object
named, Casework <Base Cab-

Casework <Base
Cabinet-4 Drawers :
18”> inet-4 Drawers : 18”> and the
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RemarksImported/File
Linked Name

Casework <Base
Cabinet-4 Drawers :
18”>

two, child components, Case-
work <Base Cabinet-4 Drawers
: 18”> and Casework <Base

Casework <Base
Cabinet-4 Drawers :
18”> Cabinet

Cabinet-4 Drawers : 18”>
Cabinet

This object is Linked Geo-
metry containing one or more

Import Symbol
<drawing1.dwg>

components found in draw-
ing1.dwg, which is a drawing
that is linked to the Revit
drawing. This linkage is com-
parable to an xref in Auto-
CAD.

NOTE It is possible for instances of the same Revit element to subdivide differently
into 3ds Max objects. Revit elements are considered instances of the same element
if their category, family, and type name are exact matches, and this will affect
their instancing behavior for 3ds Max functions such as material propagation.

Revit Cameras and Views

In order to navigate a Revit drawing more efficiently, you might have set up
a series of 3D views by means of placing cameras at different viewpoints around
the drawing. The File Link Manager and Import functions of 3ds Max allow
camera views to be treated as 3ds Max cameras.

You must meet two conditions in order for 3ds Max to understand Revit
camera views.

■ A camera view must be active before you export the DWG file from Revit.

NOTE Only the active camera view is exported.

■ You have to make sure you've turned on the Views (cameras) switch in the
Basic File Link Settings dialog on page 6998.

When the drawing is linked to 3ds Max, that camera and its target appear in
the scene named Camera:viewname and Camera:viewname.Target.
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Light Sources

Drawing files, exported from Revit, can contain light sources, however, they
do not export with the DWG or DXF files. What does get exported is the 3D
mesh geometry representing the light fixture. Therefore, when you import or
link the drawing to 3ds Max, the light object is strictly geometry, not an actual
light source like a spotlight or omni light that you can adjust.

These pieces of geometry are still useful in that you can use them as reference
points for placing and aligning lights you add in 3ds Max.

DXF Files

Along with the ability to export DWG files, Revit can also export to the DXF
file format. The only difference is in how they handle drawings that are linked
(RVT links) to the Revit drawing.

When exporting to DXF, the linked drawings are automatically bound to the
drawing. Therefore, while exporting to a DWG honors the linked drawings
and treats them as AutoCAD xrefs, an exported DXF file will not have xrefs.
Instead, the linked drawings are converted to blocks.

The resulting scene organization will be slightly different when linking or
importing a DXF as opposed to a DWG, but only when RVT links are present
in the drawing.

See also:

■ Instanced Objects, Elements, Blocks and Styles on page 7046

■ Styles on page 7054

Suggested Settings and Workflow

Suggested Settings for Revit Projects

The File Link Manager and DWG/DXF Importer have many settings that you
can adjust so you get the best results when linking or importing a drawing
that you've exported from Revit. In this section, you'll find some recommended
settings that you can use when linking or importing your DWG files. These
settings are found on the Basic File Link Settings dialog on page 6998, the
Advanced File Link Settings dialog on page 7002, the Spline Rendering File Link
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Settings dialog on page 7010, and the AutoCAD DWG/DXF Import Options
dialog on page 7182.

Use the Revit Preset

3ds Max includes a preset named “Revit” that you can use when using File
Link to link a drawing that is exported from Revit. The Revit preset has many
of the following suggested settings turned on by default. Or, you can use the
Revit preset as a basis for your own customized Revit preset containing the
settings you prefer.

The Revit preset can be assigned from the Preset list on the Attach panel of
the File Link Manager on page 6987. You can edit the preset on page 7016 by
choosing the Revit preset shown on the Presets panel of the File link Manager.

If you plan on creating your own presets or modifying the Revit preset, use
these settings to streamline the file linking process.

Turn on Weld and set a Weld Threshold

■ Weld and Weld Threshold are found on the Basic panel of the File Link
Settings dialog or in the Geometry Options group of the AutoCAD
DWG/DXF Import Options dialog.

When Revit exports model geometry to a DWG file, objects are translated as
multiple surface meshes. For example, a single wall is made up of 6 or more
AutoCAD entities; each a polyface mesh with vertices that overlap their
neighbors. When the meshes get linked to 3ds Max, the File Link Manager or
DWG/DXF Importer recombines them back to a single object. However, when
the meshes are recombined, their vertices are not welded, so you end up with
a larger and less elegant model than expected. By turning on the Weld option
and setting an appropriate Weld Threshold (like 0.1" or smaller), coincident
vertices are welded together and the file structure is more efficient.

NOTE This is particularly important if you plan to do radiosity rendering because
gaps in the model can cause leaks that greatly increase the rendering time.

Turn on Views (cameras)

■ Views (cameras) is found in the Include group on the Basic panel of the
File Link Settings dialog and the AutoCAD DWG/DXF Import Options
dialog.
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If you've set up one or more cameras in your Revit project, the File Link
Manager or DWG/DXF Importer will recognize and link a camera when the
Views (cameras) option is turned on. There is, however, a catch. Before you
export a DWG from Revit, the camera view must be active and only the active
camera will be exported.

Avoid Entity and Entity, Blocks as Node Hierarchy

■ On the Advanced File Link Settings dialog, when choosing a Derive
AutoCAD Primitives By option, avoid Entity and Entity, Block as Node
Hierarchy.

Elements are occasionally missing Revit embedded data. When this data is
missing, the objects are "derived" according to the Derive AutoCAD Primitives
By setting. Deriving by either of the Entity choices will not, generally, give
you the end result you want and could result in a scene in 3ds Max that
contains a vast number of individual objects. In particular, these settings can
cause issues with railing balusters.

Use Layer, Blocks as Node Hierarchy

■ On the Advanced File Link Settings dialog, use Layer, Block as Node
Hierarchy, when choosing a Derive AutoCAD Primitives By option.

The Layer, Blocks as Node Hierarchy derive by option, often gives the best
results for linking DWG files, especially when the Revit project has other
drawings, RVT links on page 8110, linked to it. Combining by Layer (node
hierarchies or not) is the preferred setting. RVT links get exported to the DWG
as xrefs. If you want the File Link Manager to preserve color and material
assignments of those objects, Layer, Blocks as Node Hierarchy is the setting
to use.

Turn on Material Definitions and Assignments

■ The Use Scene Material Definitions and Use Scene Material Assignments
on Reload switches are on the Advanced File Link Settings dialog.

These two switches are quite important when you've got materials assigned
in your Revit project.

When the Use Scene Material Definitions switch is turned on, 3ds Max checks
the scene for any currently used materials matching the exact same name as
a material name in the linked DWG file. If a match is found, File Link does
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not translate the drawing’s material, and instead uses the material defined in
the scene.

When turned off, the File Link Manager always uses the material definitions
contained in the DWG file, and will overwrite scene materials with the same
name, regardless of which objects the material is applied to. In addition,
material definitions are always reloaded from the DWG file, so if you make
changes to a linked material, then reload, those changes will be lost.

If the Use Scene Material Assignments on Reload switch is turned on, linked
objects with a material already assigned to them in the 3ds Max scene will
not have that material assignment changed. When turned off, linked objects
have their material assignment ‘coordinated’ with the drawing, so that the
two are in-sync.

Determine how you want Splines Handled

■ The settings on the Spline Rendering File Link Settings dialog control how
shapes and splines are linked or imported into 3ds Max.

In your original project, you may have used 2D lines to represent joints
between sidewalk pavers or as mullions separating sections of a curtain wall.
The settings on the Spline Rendering panel let you use those lines more
advantageously.

When you turn on Enable In Renderer and/or Enable In Viewport, lines are
visible when you render the scene or are treated as selectable objects in the
scene. You can also adjust the appearance of lines by having them display as
radial or rectangular geometry.

TIP Using the Sweep modifier on page 1780 with 2D splines or shapes lets choose
a cross-sectional shape that is swept along the spline resulting in much more scene
detail.

Suggested Workflow for Revit to 3ds Max Projects

Most of the work you do on your Revit project will be done in Revit. The initial
design, layout and modeling all occurs from within the Revit program. 3ds
Max comes into play when you're ready to produce some higher end renderings
and perhaps add some final details.
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Following is a basic description of the expected workflow between Revit and
3ds Max:

1 You've completed most of the design work in Revit and you're ready to
add finishing touches and create some presentation renderings.

2 From Revit, export a DWG file.

Exporting to a DWG file is necessary because the File Link Manager cannot
accept the “native” Revit project (RVT) files.

3 Start 3ds Max and use the File Link Manager to link the DWG file.

Link the drawing using presets that include the linking settings you want
as described in the Suggested Settings for Revit Projects on page 7036 section.

4 Adjust materials or make final modifications in 3ds Max in preparation
for rendering.

Depending on the results at this stage, you may find that the Revit project
needs to be changed and updated.

5 In Revit, makes changes to the project like moving walls, adding new
doors and windows or adding/removing objects.

For structural changes like adjusting walls, doors, windows, etc., it's best
to make these changes in Revit because those changes need to be included
in the originating project. File Link is a one way link so any changes you
can make in Revit, should be made in Revit. Otherwise, you'd have to
remember to make the same changes in both 3ds Max and Revit.

6 When the changes are completed, export another DWG file with the
same name as the original DWG file you exported in step 2.

If you give a new name to the exported DWG, the File Link Manager will
not show that the currently linked file has been updated.

7 In 3ds Max, open the File Link Manager and review the Files panel. Select
the updated file link and click the Reload button — Turn on Show Reload
Options if you want to change link settings.

The changed model reloads to 3ds Max and changes made to the model
in 3ds Max prior to the reload are retained.

The  symbol means the DWG file has been updated.
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Materials and Linked Revit Objects

When you export a DWG or DXF from Revit projects, materials are translated
into a format that 3ds Max can understand. Revit creates materials in the same
format as used by AutoCAD Architecture, VIZ Render and 3ds Max. There are
two kinds of materials associated with the Revit project; AccuRender materials
and Revit materials. When a Revit material references an AccuRender material,
the AccuRender material’s parameters are used; otherwise, the Revit material
parameters are used.

There is an important caveat to this. AccuRender materials that reference a
bitmap file are translated in 3ds Max without any problems, while AccuRender
materials that are considered “procedural” are only translated at the most
basic level.

Therefore, an AccuRender material that uses a bitmap image in the base texture
definition will provide a more accurate translation to 3ds Max.

NOTE There are some limitations on what is translated between Revit/AccuRender
materials and 3ds Max materials because there is not a one-to-one correlation
between the two material definitions.

Material Assignments

The Revit DWG Exporter puts embedded information on each object it exports.
Amongst this information are identifiers specifying material assignments.
Revit creates the same kind of material definitions used by AutoCAD
Architecture, VIZ Render and 3ds Max. When imported or linked, 3ds Max
uses this information to translate and maintain the material assignment to
the resulting scene object.

Because the material identifier is embedded, if you opened the DWG in
AutoCAD, you would not see the applied materials.

Revit offers many options for specifying a material to an object or class of
objects. Likewise, there are many ways where material assignments can be
overridden. The results you see in the 3ds Max scene, in terms of how the
materials are applied, match what you see in the Revit model.

The exception to the rule would be if many of the materials are AccuRender
procedural materials. In these cases, you will see only the diffuse color.
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Texture Coordinates

Material textures on imported or linked objects have the same appearance as
within Revit or AccuRender. Of course, the exception to this rule is when
AccuRender procedural textures are used.

When materials from Revit are viewed in the 3ds Max Material Editor, you'll
notice that some settings are not translated or they are not set as you're used
to seeing in 3ds Max. For example, if the texture map of a flooring material
has a rotation of 45 degrees in the Revit project, the rotation setting does not
translate when the model is linked/imported to 3ds Max. The rotation for the
texture map is set to zero in the 3ds Max Material Editor.

Map Scaling

The scale of material textures is of primary importance. The File Link Manager
or DWG/DXF Importer attempts to read and translate the offset and tiling of
the materials so the texture maps appear in 3ds Max as they do in Revit.

However, map scaling may differ because the Tile Size settings in Revit are
measured in decimal feet or meters even if your Project Units are set to Decimal
Inches or Millimeters. Once the model is linked or imported to 3ds Max, you
can turn on Use Real-World Scale and match the Tile Size settings. The main
thing is to pay attention to the Tile Size settings when you create the material
in Revit.

As a example, let's say you've created a material in Revit that uses a brick
texture map with an X: Tile Size set to 20 and a Y: Tile Size set to 16. If you
open that material in the 3ds Max Material Editor, you will find that the Width
and Height Size settings are automatically set to 20' and 16' respectively. The
texture mapping will always be scaled correctly in the scene. How a material
is displayed in the Material Editor depends on whether Use Real-World Scale
is turned on or off.

See also:

■ Applying Materials to Linked Revit Objects on page 7043

■ Editing Revit Materials in 3ds Max on page 7043

■ UVW Mapping on Revit Objects on page 7045

■ Propagate Materials to Instances on page 5328
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Applying Materials to Linked Revit Objects

As with models that are imported or linked from AutoCAD Architecture, there
are special behaviors exhibited with materials assigned to linked Revit objects.
The behavior is controlled by the Propagate Materials To Instances toggle on
page 5328.

When applying materials to a linked drawing in 3ds Max, family and type
plays an important role in material management. Assigning a material to any
component of any linked Revit object is equivalent to assigning the same
material to every instance of that component in every object with the same
family and type throughout your scene.

As an example, say you have multiple instances of a Doors <Single-Flush : 34”
x 80”> door in your drawing, which consists of three components: two
Frame/Mullion components representing the inside and outside trim and a
Panel component. If you assign a material to one Panel component anywhere
in your 3ds Max scene, all the Panels for all the Doors of that family and type
throughout the scene will receive the new material.

If you want to keep materials from propagating between instances in your
scene, turn off the Propagate Materials To Instances toggle on page 5328 from
the Material Editor's Options menu.

See also:

■ Instanced Objects on page 7047

■ Blocks on page 7048

Editing Revit Materials in 3ds Max

Once a drawing is linked or imported to 3ds Max, you can modify or replace
the materials. The File Link Manager maintains a list of materials that it links
to 3ds Max. If you change the properties of an assigned material while working
in 3ds Max, the new properties can get overwritten the next time you reload
an updated drawing, exported from Revit.

During a File Link reload, if the Show Reload Options switch is turned on,
you can control how materials are handled by using the Use Scene Material
Definitions or Use Scene Material Assignments on Reload options.
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AccuRender Materials

AccuRender materials consist of one or more base materials. For each base
material you can set attributes such as color, reflectivity, transparency, index
of refraction, bump maps, and image maps.

The Procedures list displays the simple materials that combine to form your
final material definition and the rules for combining them. For simple
materials, there is only one item in the list: Base. For complex materials, a tree
indicates how the components combine. For example, the marble procedure
consists of a Base material and a Vein material. While the Base material is
considered a 'procedure', it is translated because it's at the bottom level of the
material. The Vein material is ignored.

AccuRender materials that are applied to objects in the Revit drawing are
translated when you link or import the drawing to 3ds Max. If the texture
used for the material is a digital bitmap like a BMP or JPG file, the texture will
be included with the material.

However, if the texture being used is one of the Procedures, the texture is not
translated when the drawing is brought into 3ds Max. In these cases, you will
see only the diffuse color.

See also:

■ Material Editor, Materials, and Maps on page 5259

Procedures

To retain material settings made in 3ds Max during a reload:

1 On the Files panel of the File Link Manager, make sure the Show Reload
Options switch is active.

2 Select the updated DWG file from the Linked Files list and click Reload.

3 Open the Advanced tab and turn on Use Scene Material Definitions and
then click OK.

The updated DWG file is reloaded and Revit materials retain the setting
changes you made in 3ds Max.
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UVW Mapping on Revit Elements

An important consideration in how many materials render is how they are
“mapped” to the surfaces of the objects they are assigned to. This is especially
important for materials that use bitmaps on page 7926 to define the diffuse color
of a material, or the bump and cutout special effects. As an example, you may
have scanned a picture of wood grain for use in a material, but when the
material is applied to an object, how large should the image of the wood grain
be? Which way do you want the grain to run, and how do you want the grain
to wrap around the corners of a three-dimensional object?

How two-dimensional maps are applied to three-dimensional surfaces is
represented by mapping coordinates on page 8034, which are stored as UVW
coordinates on page 8161. Revit assigns UVW coordinates to object components,
so in cases where mapping coordinates are important to the rendered
appearance of an object, 3ds Max translates these coordinates and stores them
in the object mesh that is displayed and rendered in the 3ds Max scene.

Using Revit Materials on 3ds Max Geometry

After you've linked a DWG file that has been exported from Revit, you may
find that some of the materials that were created in Revit could be used on
new geometry you're adding while working on the model in 3ds Max. Reusing
a material is often easier than creating a brand new one.

For example, let's say a wall element in the Revit project has a brick material
that you'd like to use on an object you added to the model while working in
3ds Max. If you simply apply the material to the new object, you'll find that
the texture map does not show as it does on the wall that came from Revit.
This is because UVW coordinates of the new object are not set up to coordinate
with the Tiling parameters of the Revit material.

When using Revit materials with objects created in 3ds Max, there are really
two things to keep in mind;

■ All materials from Revit use real-world scaling.

■ Real-world scaling must be active for objects you've created in 3ds Max.
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There are a few way to make sure your 3ds Max objects are using real-world
scale.

■ If you're working with a primitive object, like a box or cylinder, make sure
Real-World Map Size is active.

■ For more complex objects, apply a UVW Map modifier on page 1931 and
make sure Real-World Map Size is active.

■ Assign the object a MapScaler modifier on page 1514.

Instanced Objects, Elements, Blocks and Styles

The primary structural entities you will find in a model or project that is
linked/imported to 3ds Max from AutoCAD, AutoCAD Architecture, or Revit
are style-based objects on page 7054 (in ADT models), family elements (in Revit
projects) or blocks on page 7048 (in both ADT and AutoCAD files). Each
style-based object, family element, or block will most likely have many
instances on page 7047 in the 3ds Max scene.

■ Instances are multiple occurrences of objects such as style-based objects or
blocks that are clone instances. When you link a model or drawing that
contains instanced objects to 3ds Max, those objects remain instances of
one another.

■ Family Elements in a Revit project represent different items of a building
and are separated into two general categories; Model and Annotation. The
Model category includes such elements as walls, doors, windows and stairs
while the Annotation category includes dimensions, text notes and section
tags. When a DWG is exported from Revit and linked to 3ds Max, elements
appear in the Modifier panel as Block/Style Parents on page 7928, meaning
you've selected the element at its topmost level, or as Linked Geometry
on page 8024, meaning one of the element's subcomponents.

■ Blocks are reusable objects made in AutoCAD or Architectural Desktop.
Blocks are made of one or more objects that can be inserted into a scene
at different locations, scales and orientations. Blocks can also be an
amalgam of other blocks. A block that is made of other blocks is referred
to as a nested block. Once linked to 3ds Max, blocks appear in the Modifier
panel as VIZBlocks, meaning you've selected the block at its topmost level,
or as Linked Geometry, meaning one of the block's subcomponents.
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NOTE If you use one of the “node hierarchy” Derive By settings, you will see
Block/Style Parent objects in the Modifier panel and not VIZBlocks.

■ AutoCAD Architecture style-based objects are complex objects like Doors
and Windows whose components rely on style definitions to control how
they appear in the scene. For example, style definitions for a door set the
type of door, the door thickness, the materials assigned to the various
components, and so forth. Altering the style definitions changes the
appearance of the object in the scene.

See also:

■ Object Properties on page 305

Instanced Objects

Instanced objects are AutoCAD, Revit, or AutoCAD Architecture objects or
blocks that you can drag and drop into 3ds Max.

Modifiers and materials that are applied and assigned to an instanced object
propagate throughout all instances of the object. For example, if all the doors
in a scene have glass panes and you change the glass material of one door, all
the doors of the same style will adopt that material. Propagation of materials
can be controlled by toggling Propagate Materials To Instances on page 5328.

Once you link a model to 3ds Max, instanced objects can be transformed
(moved, rotated, or scaled). If you don't like the way an object is transformed,
you can use the Undo command or Reset Transform button on page 7024 on
the Modify panel.

Family Elements

When modifiers and materials are assigned to family elements that are
imported or linked to 3ds Max, they propagate throughout all instances of
the element if their family and type match exactly. For instance, one particular
part of your model shows a room with three doors. Two of the doors are Doors
<Single-Flush : 32” x 80”> and the third is a Doors <Single-Flush : 36” x 80”>. If
you change the panel material of one of the Doors <Single-Flush : 32” x 80”>
doors, the panel of the other Doors <Single-Flush : 32” x 80”> door will also
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change because their family, Doors, and type, Single-Flush : 32” x 80”, are
identical.

Propagation of materials can be controlled by toggling the Auto Material
Propagation Toggle on page 5328.

Blocks

The concept of blocks originated in AutoCAD. Blocks allow you to combine
one or more objects into a single reusable object. As you work in AutoCAD or
AutoCAD Architecture, you can insert blocks repeatedly in the drawing at
various locations, orientations, and scales. If you change a block, the changes
propagate automatically to all instances of that block throughout the drawing.

You then link the DWG file to 3ds Max, where your goal is to beautify the
scene in preparation for rendering. Some of those preparations include such
procedures as selecting a block instance so you can apply or adjust a material,
applying texture mapping coordinates, unifying or flipping normals, and
setting rendering properties. These procedures affect all other block instances
in the scene.

The structure of nested blocks, blocks that are made from multiple sub-blocks,
is maintained when you link an AutoCAD or AutoCAD Architecture drawing
to 3ds Max. For example, if the block Desk1 is made using several blocks, Desk,
Chair and Return, you will be able to select any of Desk1's sub-blocks to alter
their rendering properties or materials. You can only access rendering properties
for block components that appear as Linked Geometry on the Modifier panel.
Blocks or sub-blocks, that appear as VIZBlocks in the Modify panel, do not
have rendering properties because they are not renderable.

NOTE A change to the drawing in AutoCAD or AutoCAD Architecture is reflected
in 3ds Max when you reload the linked model. Changes made in 3ds Max do not
propagate back to AutoCAD or AutoCAD Architecture.

Block and Modifying Linked Geometry

Linked objects show up as linked geometry objects in the modifier stack. These
objects don't allow access to sub-object levels where minor editing can occur
at Vertex or Face levels. You must first add an Edit Mesh modifier to the object
in order to access sub-object levels where you can perform operations like
welding vertices or deleting faces. If you add a modifier to a block, the modifier
is applied to all instances of that block. Likewise, any sub-object level editing
to the originally selected block propagates to all other instances.
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NOTE Any modifiers you apply to a block or block component in 3ds Max are
preserved if you reload the file with the File Link Manager on page 6987.

If you move, rotate, or scale blocks or block components in 3ds Max, their
new transform is preserved even if the linked model is reloaded from AutoCAD.
Transforms applied to linked geometry in 3ds Max are relative to the transforms
applied to the same objects in AutoCAD. Further, the transform propagates
to all instances of that block or component. For example, if you move the
Chair component of Desk1, the Chair component of all Desk1s in the scene will
be moved. If the transform is undesirable, you can use the Reset Transform
button on page 7024 on the Modify panel to put the block or component back
to its original position.

When a modifier is applied to a block or block component, it propagates
throughout all instances of the block or block component in the scene.

Limitations of Blocks

Blocks have some limitations when you link a drawing to 3ds Max.

■ You cannot change the structure of actively linked blocks or their
components in 3ds Max. In order to delete a block or component, you will
have to bind the file, breaking the link.

■ You cannot change the color of linked blocks or their components. Their
color is set by layer when they're built in AutoCAD or AutoCAD
Architecture.

■ You can only access rendering properties for block components that appear
as Linked Geometry on the Modifier panel. Blocks or sub-blocks, that
appear as VIZBlocks in the Modify panel, do not have rendering properties
because they are not renderable.

■ You cannot collapse on page 1093 the modifier stack of an actively linked
on page 7897object.

■ Layer assignments of linked geometry cannot be changed in 3ds Max if
an object is actively linked. Layers can be reassigned if the model is bound.

■ Cloning a block or block component is not possible if it is actively linked.
You cannot select a block and use Shift+drag to duplicate it. This is also
true for tools like Array, Mirror, and the Spacing Tool. Once a block or
block component is bound, you can clone it.
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Blocks and Materials

When assigning a material in 3ds Max to an instance of a block or block
component, all the instances of that block or component are assigned the
same material automatically. This is called automatic material propagation. This
feature helps align 3ds Max behavior with that of AutoCAD Architecture.

If you find that a material you've assigned to a block or block component is
not what you wanted, you can undo the material assignment by choosing
Edit menu > Undo or pressing Ctrl+Z. If you undo a material assignment, the
undo will propagate to all instances of the objects to which you assigned the
material.

NOTE When assigning a material to a block or block component, you are not
prompted to accept or cancel the material propagation. You can only control
propagation of materials by toggling Propagate Materials To Instances on page
5328.

For more information about working with materials and assigning materials
to blocks in 3ds Max, see the Material Editor, Materials, and Maps on page
5259 topic.

Multi-View Blocks (MVBlocks)

3ds Max accommodates both AutoCAD blocks and AutoCAD Architecture
multi-view blocks through the file linking functionality, and for the most part
the two block types behave similarly in 3ds Max with some exceptions.

The structure of AutoCAD Architecture multi-view blocks is expressed
differently than AutoCAD blocks in 3ds Max. Rather than peer into the internal
structures of multi-view blocks, as is done with AutoCAD blocks, 3ds Max
relies on the multi-view block's own ability to draw its own 3D view, much
as it does in the AutoCAD Architecture Object Viewer. Because of this, you
will notice that multi-view blocks never exhibit nesting in their object structure
when they are file linked into 3ds Max.

Behavior of instanced AutoCAD Architecture multi-view objects is different
from that of AutoCAD blocks as well. Multiple instances of multi-view blocks
require more memory in 3ds Max than do multiple instances of AutoCAD
blocks. But multiple instances of multi-view blocks are better behaved when
being cut by live section objects than their AutoCAD counterparts.
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Dynamic Blocks

The File Link Manager handles dynamic blocks the same way as other blocks
found in a DWG file. When linked to a scene, the naming for the incoming
dynamic block instances are based on the original dynamic block definition
in the form of Block: block_name where block_name is the actual name of the
dynamic block definition.

Dynamic block instances, even those that have been grip-edited, display certain
types of instance behavior such as material propagation, if the setting is
activated from the Material Editor Options menu on page 5321. Below is a table
showing instance behavior of dynamic blocks.

BehaviorProperty

Modifiers applied to one component
are applied to the same component in

Modifiers

other instances, but only when those
instances have the same grip property
values.

When material propagation is turned
on, materials are applied to all block

Materials

instances. When turned off, materials
are applied only to the current selec-
tion set.

NOTE If you use the Entity, Blocks as
Node Hierarchy Derive By setting for
drawings containing dynamic blocks,
materials may propagate to some
block instances and not to others.

Changes to node properties are not
propagated to block instances.

Node Prop-
erties

Transforms, like move, rotate and
scale, of one component will affect

Transforms
(on compon-
ents) that same component in other block

instance only when those instances
have the same grip property values.
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Keep in mind that elements of a dynamic block can be turned on and off by
certain grip-edit operations depending on the way the dynamic block is
defined. When one instance has a component and another doesn't, instance
behaviors cannot occur between them because they are treated as instances
of one another.

Modifier behavior of Dynamic Blocks during a File Link Reload

There is no change in modifier behavior for dynamic blocks that have not
been grip-edited between one Reload and the next. All properties (materials,
modifiers, node properties) are preserved. Dynamic blocks that have been
grip-edited preserve their node name, node properties, scene-applied transform,
and materials, but may lose applied modifiers and/or may inherit modifiers.
This table shows the behavior of modifiers during a File Link Reload before
and after dynamic block editing.

The Block
Insert ...

... shows this modifier
behavior upon Reload.

... has
unique para-

... has
unique para-

meter valuesmeter values
after it was
edited.

before it was
edited.

Modifiers are pre-
served.

YesYes

Applied modifiers may
be lost, and it may in-

NoYes

herit modifiers from
the instance(s) it now
matches.

Applied modifiers are
lost.

YesNo

Applied modifiers may
be lost, and it may in-

NoNo

herit modifiers from
the instance(s) it now
matches.
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Blocks and Interactive Selection and Navigation

Once blocks and block components are linked to 3ds Max, you can begin
adjusting their materials and properties. In a drawing for a small apartment,
blocks are pretty easy to locate because the drawing is not very congested.
You can simply select a block or one of its components in the viewport and
alter it.

With complex drawings, finding the block or block instance you want can
pose a problem. For example, a common block you might add to a drawing
is a table. If you're designing a corporate headquarters that makes use of several
different types of tables, finding the one you want to change becomes more
difficult. There are several ways for you to find and select a block more precisely
in 3ds Max.

■ One way is by means of the block's name. When you link a drawing to
3ds Max, file linking creates a name such as Block: ConferenceTable. The first
part of the name identifies the object's type, Block. The second part of the
name indicates the block name, ConferenceTable. With this sort of naming
breakdown, you can easily find a block using the Select From Scene dialog
on page 228.

■ Another selection method uses the Layer or Color setting you made for
your block when you created it in AutoCAD Architecture. Because layer
and color data is also linked to 3ds Max, you can select entire groupings
of blocks using Select By Color or Select By Layer.

■ Finally, you can select blocks by the type of material that's applied to them.
Take care when selecting blocks this way because the material assigned to
the block may also be assigned to other objects in the scene.
Once you’ve selected a block or set of block instances, you can isolate them
from the remainder of the model to work on them more efficiently.

To select a block by color:

1 Choose Edit menu > Select By > Color.

2 Select a block in the scene.

All blocks that share that color are selected.

To select blocks by name:

1 Choose Edit menu > Select By > Name, or press the H key to open the
Select From Scene dialog on page 228.
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2 While holding down the Ctrl key, select blocks with common names.

You can also enter the block name in the name field at the top of the
dialog.

3 Click Select.

All blocks that share the specified name are selected.

To select blocks by layer:

1 Choose Edit menu > Select By > Layer.

2 Select a block in the scene.

All the blocks sharing that layer are selected.

To isolate selected objects:

1 Using one of the previous selection methods, select some blocks.

2 Choose Tools menu > Isolate Selection.

This hides all objects except for the selected blocks. A dialog is opens,
indicating that isolation mode is active.

Styles

Styles are sets of parameters that you can assign to objects in AutoCAD
Architecture to determine their appearance. This means an AutoCAD
Architecture object references a style in order to determine certain aspects of
its appearance. For example, a door style determines the type of door
represented in the drawing, such as single or double hung, bifold or hinged,
solid core or glass pane. You can assign one style to more than one object,
and you can modify the parameters of that style to change all the objects that
have the same style assigned to them.

For more information about how to work with styles in AutoCAD Architecture,
refer to the AutoCAD Architecture Reference.

A style is made up of components. Each component defines dimensions and
display properties per view. For example, the hatch pattern defined for
component1 in Plan view can be different from the hatch pattern for the same
component in Model view. Styles are grouped in categories that mirror the
categories of AutoCAD Architecture objects. You perform model management,
such as creating and deleting styles and style-components in AutoCAD
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Architecture, and reload the modified scene into 3ds Max using the File Link
Manager utility on page 6987.

When a model is linked to 3ds Max from AutoCAD Architecture, styles play
an important role in assigning render materials and texture coordinates to
AutoCAD Architecture object components described by style components.
Components of an AutoCAD Architecture object often have predefined
materials in their style definitions. This means that if you have many instances
of an object in your drawing, you can quickly replace materials on all the
objects without having to select each instance of the object.

'Style-based objects' is a more common term for AutoCAD Architecture objects
that reference styles.

Limitations of Styles

Styles-based AutoCAD Architecture objects do have some limitations when a
model is linked to 3ds Max.

■ Changes to styles and their components performed in 3ds Max will not
propagate back into AutoCAD Architecture.

■ You cannot use any transform commands (Move, Rotate, or Scale) to clone
an object that has an actively linked style. You have to make that type of
change in AutoCAD Architecture.

■ The structure of a style-based object in 3ds Max cannot be changed. You
cannot add components to or delete them from a linked object.

■ Objects on frozen layers in AutoCAD Architecture will not be displayed
when the model is linked to 3ds Max.

NOTE This is not the case when Skip All Frozen Layers is turned off in your File
Link settings.

Styles and Materials

The primary purpose of linking a model from AutoCAD Architecture to 3ds
Max is preparing the scene for presentation to your clients and rendering.
AEC Objects are made up of components that have default architectural
materials assigned through their styles. You can select components from the
Select From Scene dialog on page 228 or the Scene Explorer on page 7379 , and
you can assign new materials or alter the existing material in the Material
Editor.
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For example, a door that is assigned the “Hinged – Single – Full Lite” style is
made up of five components in AutoCAD Architecture: the Frame, Panel, Stop,
Glass, and Muntins. Each component has a material assigned to it. For instance,
the default material assigned to the Panel component of this type of door is
“finish carpentry.wood.mahogany.” To change the Panel material in 3ds Max,
you can select the Panel component and drag a new material to it from the
Material Editor.

Because the Panel material is part of the door's style, your new material
automatically propagates to any other door in the scene that is assigned the
“Hinged – Single – Full Lite” style.

NOTE If you need to apply a material to individual objects, or object selections,
rather than to all objects of the same style, you can use the command Propagate
Materials To Instances on page 5328.

For more information about working with materials and assigning materials
to objects in 3ds Max, see Materials on page 5259.

Styles and Interactive Selection and Navigation

Architectural drawings range from simple sketches to highly complex floor
plans, so finding different components of a drawing can be difficult. Style-based
objects from AutoCAD Architecture all have styles associated with them. So
if you link a drawing to 3ds Max, objects with styles will be associated with
them both in AutoCAD Architecture and in 3ds Max. Furthermore, in 3ds
Max, the name of the object will contain the AutoCAD Architecture object
category name (Door, for example), style name (Double Hinged) and
component name (Panel).

You make most object and component selections in 3ds Max by selecting
objects in the viewports. However, in complex models where objects and
components may be spread across multiple layers or located in congested
areas, style definitions help streamline the selection of reusable components
in a drawing.

Once objects and components are selected, you can also isolate them from
the remainder of the model to work on them more efficiently.

To select objects by style:

The Select Similar command has the same function in 3ds Max as it does in
AutoCAD Architecture.

1 In a scene imported or linked from AutoCAD Architecture, select an object
that contains the style of interest.
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2 Choose Edit menu > Select Similar.

All objects or components that share that style, as defined in AutoCAD
Architecture, are selected.

To select objects or components by color:

1 Choose Edit menu > Select By > Color.

2 Select an object in the scene.

All objects or components that share that color are selected.

To select objects or components by name:

1 Choose Edit menu > Select By > Name, or press the H key to open the
Select From Scene dialog.

Alternatively, you could use the Scene Explorer on page 7379, accessed from
the Tools menu. While functionally similar to the Select From Scene
dialog, the Scene Explorer is modeless and can remain open while you're
working.

2 While holding down the Ctrl key, select objects or components with
common names.

You can also enter the object or component name in the name field at
the top of the dialog.

3 Click Select.

All objects or components that share the specified name are selected.

To select objects or components by layer:

1 Choose Edit menu > Select By > Layer.

2 Select an object in the scene.

All objects or components that share that layer are selected.

To isolate selected objects:

1 Using one of the previous selection methods, select some objects.

2 Choose Tools menu > Isolate Selected.

All objects are hidden except for the selected objects or components. A
dialog appears indicating that isolation mode is active.
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Merge

File menu > Merge

Merge allows you to load objects from saved scene files into the current scene.
You can also use Merge to combine an entire scene with another. This behaves
similarly to the XRef Merge dialog on page 6956.

The Merge dialog lets you load and save influences on page 8012 with or without
their dependents. In many cases, objects should be referenced with their
influences, but the display only makes you aware of the relationships, it does
not force you to externally reference them.

When you select an item in the list window and click Influences, the object’s
influences are selected in the list window. When you select an item in the list
window and Display Influences is on, the object’s influences are shown in
blue in the list window. When you select an item in the list window and Select
Influences is on, the object’s influences are also selected in the list window.

Automatic Unit Conversion

When Respect System Units in Files is on in the Units Setup dialog on page
7809, in the System Unit Scale group, merged objects from a file with a different
scene unit scale are scaled to maintain their correct size in the new scene. No
conversion is done when merging files created in 3ds Max 1.x.

NOTE If Respect System Units is off (which is not recommended), a 100-foot
radius sphere that was created in a 1 unit = 1 foot scene becomes a 100-inch
sphere in a 1 unit = 1 inch scene.

Resolving Name Conflicts

Object Name Conflicts

When one or more incoming objects have the same name as objects in the
scene, an alert gives you the following options:

Merge Merges the incoming object using the name in the field at the right.
To avoid having two objects with the same name, type a new name before
proceeding.

Skip Does not merge the incoming object.

Delete Old Deletes the existing object before merging the incoming one.
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Apply to All Duplicates Treats all subsequent incoming objects with duplicate
names the same way you specified for the current object. No further alerts
will appear. This option is not available if you renamed the current object.

Cancel Cancels the merge operation.

Material Name Conflicts

When one or more materials assigned to incoming objects have the same
name as materials in the scene, an alert gives you the following options:

Rename Merged Material Defines the name for incoming material.

Use Merged Material Assigns the characteristics of the incoming materials
to the same-named scene materials.

Use Scene Material Assigns the characteristics of the scene materials to the
same-named incoming materials.

NOTE Only top-level material names (not sub-materials) are checked for duplicates.

Auto Rename Merged Material Automatically renames the incoming materials
to new names. Uses Material number names based on the next available
Material number.

Apply to All Duplicates Treats all subsequent incoming Materials with
duplicate names the same way you specified for the current object.

Parent Name Conflicts

When you merge an object that’s linked to a parent object in a source scene,
and an object of the same name as the original parent exists in the current
scene, the Merge File dialog on page 7062 opens, giving you the option to
re-create the same hierarchy.

See also:

■ Merge Animation on page 7063

■ Merging Effects  on page 6587

■ Open on page 6922

■ Replace on page 7070
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Procedures

To merge items:

This is the general procedure. Detailed steps follow.

1 Choose File > Merge.

2 Select a file from which to merge items.

3 Choose a group or an item to merge.

To specify object types to list, do any of the following:

1 Display or hide the subtree. If the subtree is not displayed, you can sort
items in the list alphabetically or by type or color.

2 Select the object types that you want displayed in the list box.

3 Click All or None to select or clear all of the object types.

To select objects to merge, do any of the following:

1 Enter the name of an item, or use wildcard characters to specify multiple
items that share a set of characters in their names.

2 Click to select single objects.

3 Press Ctrl and click to add and remove single objects from the selection.

4 Press Shift and click to select all objects between the previously selected
object and the current object.

5 Click All or None to select or deselect the entire list.

6 Click and drag to select items to merge from the list on the left.

Interface

Use the Merge File dialog to open the scene file to merge. This opens the Merge
dialog, whose controls are similar to those on the Selection Floater on page
231.
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Merge Objects list

Objects are listed according to the current Sort and List Types selections.

All/None/Invert These buttons alter the pattern of selection in the list
window.

Influences When you select an object in the list window and then click the
Influences button, the selected object's influences are highlighted as well.

Display Influences When this is on and you select an item in the list window,
all of its influences are shown in blue. If you want to highlight these influences,
click Influences.

Select Influences When this is on and you select an item in the list window,
all of its influences are highlighted as well.
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Merge File Dialog

File menu > Merge > Choose a file to merge. > Choose objects to merge.

When you merge an object that’s linked to a parent object in a source scene,
and an object of the same name as the original parent exists in the current
scene, you can re-create the same hierarchy using this dialog.

Interface

If you merge an object that’s linked to a parent object in a source scene, and
an object of the same name as the original parent exists in the current scene,
a dialog appears asking if you want to link the incoming object to the existing
parent object.

Yes Reparents the specified object and continues prompting for all subsequent
merging objects that might need reparenting.

Yes To All Reparents the specified object and all subsequent merging objects
that need reparenting.

No Merges the specified object without reparenting, but continues to prompt
for subsequent objects.
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No To All Doesn’t reparent any of the incoming objects. When an object is
merged without reparenting, it becomes a child of the world.

This feature can also be used to reconnect parent objects to children in the
scene.

Merge Animation

[Available only as a CUI action]

Merge Animation merges (transfers) animation data from one object to another.
Animation data can be transferred from one scene to another, or between
objects in the same scene. Animation data from several objects can be merged
at the same time.

IMPORTANT The Merge Animation command is available only as a Customize
User Interface on page 7697 action; to use it you must first add it explicitly to the
user interface. For transferring animation data between scenes, we highly
recommend that you use, instead of Merge Animation, the Save Animation and
Load Animation functions. See Saving and Loading Animation on page 7074.

Within the Merge Animation dialog, objects eligible for transferring or
receiving animation data are called nodes. Source nodes refer to objects from
which animation data can be transferred, while current nodes can receive
animation data. Merge nodes are source nodes that have been mapped to
(matched up with) current nodes in the Merge Animation dialog in preparation
for merging.

In order for a particular attribute's animation data to be transferred from a
merge node, the corresponding current node must have the same attribute.
For example, if a merge node has an animated Bend modifier applied to it,
the current node must also have a Bend modifier applied to it for the animation
data to transfer successfully.

The Merge Animation feature is ideal for transferring animation data between
similar hierarchies, such as character structures. In character creation, it is a
common practice to name bones for different characters with the character
name plus a suffix or prefix that describes the bone. For example, you might
have one character called Alien with bones named Alien_Pelvis,
Alien_LeftHand, etc. Another character called Chef would have bones named
Chef_Pelvis, Chef_LeftHand, etc. The Merge Animation dialog can
automatically filter prefixes and suffixes so you can quickly map the merge
nodes for complex hierarchies.
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NOTE If you plan to merge animation data to and from characters, the process
will be much easier if you use the same bone-name prefixes or suffixes for each
character.

See also:

■ Merge on page 7058

■ Merging Effects  on page 6587

■ Replace on page 7070

Procedures

To replace the animation in the current scene with the animation from another
scene:

1 Load the scene that will receive the merged animation data.

2 Choose File menu > Merge Animation.

3 In the Merge Animation dialog, click Source File to choose the file from
which to merge animation data. The objects appear under Source Nodes
in the Object Mapping rollout.

4 On the Object Mapping rollout, drag and drop the source nodes to the
Merge Nodes column, matching them with the appropriate current nodes.

5 In the Source Time Range group, choose Replace Animation.

6 Specify the source node attributes that will be merged.

7 Click Merge Animation to merge the animation data from the merge
nodes to the current nodes.

To insert animation data from one character to another:

The Source Objects and Current Objects entry fields allow you to enter wildcard
expressions to filter prefixes and suffixes of node names. The filtered text is
ignored by the Auto Name Mapping tool, so complex structures of
similarly-named nodes can be mapped quickly. This feature is handy for
transferring an animation between character structures, providing the source
and current nodes have been named with the same conventions.

1 Load the file with the character to which animation data will be merged.

2 Choose File menu > Merge Animation.
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3 Click Source File and choose the animation source file.

4 In the Merge Animation dialog, under Source Objects, use a wildcard
expression to specify multiple items that share a set of characters in their
names. For example, if the character bones are named Skater_Head,
Skater_RFoot, and so on, enter Skater* under Source Objects.

5 Click Refresh for Source Objects.

6 Under Current Objects, use a wildcard expression to filter the current
nodes' prefix or suffix. Click Refresh.

7 Click Auto Name Mapping.

Source nodes are placed in the Merge Nodes column, corresponding with
current nodes with the same prefix or suffix.

8 Specify whether to replace or paste animation data from the source file.
If pasting animation data, the frame times for the merge nodes are added
to the current nodes.

9 Specify the source node attributes that will be merged.

10 Click Merge Animation to merge animation data from merge nodes to
corresponding current nodes.

To insert animation from one character assembly to another:

For character assemblies on page 277, the Insert Animation feature can be used
to merge animation data.

1 Load the file into which the animation data will be merged.

2 Select the character assembly node.

3 On the Modify panel, click Insert Animation. Select the source file from
which animation data will be merged.

4 Follow the previous procedure from step 4.

To merge animation data from objects in the same scene:

1 Choose File menu > Merge Animation.

2 Click Source Object, and choose the object from which animation data
will be transferred. This object and its hierarchy appear under Source
Nodes in the Object Mapping rollout.
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3 On the Object Mapping rollout, drag and drop source nodes to the Merge
Nodes column, matching them with the appropriate current nodes.

4 Specify whether to replace or paste animation data from the source file.
If pasting animation data, the frame times for the merge nodes are added
to the current nodes.

5 Specify the source node attributes that will be merged.

6 Click Merge Animation to merge the animation data from the merge
nodes to the current nodes.

Interface

The Merge Animation dialog has the following controls.

Source Objects group

Source File Click to select a source file containing the animation data.
Animation data from this file will be merged into the current scene. All objects
in the scene are displayed under Source Nodes in the Object Mapping rollout.

Source Object Selects a source object from within the current scene. If a source
object is selected, the Source File selection is ignored.

Merge Animation Merges the animation data based on settings on this dialog.
Before animation data can be merged, Merge Nodes must be listed for their
corresponding Current Nodes on the Object Mapping rollout. The progress
bar at the bottom of the dialog shows the progress of the merge operation.
After merging, this dialog remains on-screen so you can check whether the
merge was performed properly before closing the dialog.
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Undo Last Merge Undoes the last merge. If the merge was not performed
properly, you can change settings and try again.

Source Time Range group

Replace Animation Completely replaces existing animation data in the current
scene with the animation data from the source file.

Paste to Existing Animation Appends the source file animation data to the
existing animation data based on the following time parameters.

Match Source File Time Sets the source time range to match the active time
segment in the source file.

Start Time Start Time and End Time set the frame range to merge from the
source file. Start Time sets the first frame in the range.

End Time Sets the end frame number to merge from the source file.

Insert Animation to Frame Sets the start time in the current scene. Animation
data will be pasted into the current scene starting at this frame. Any existing
animation data in the current scene prior to this frame will remain the same.

Relative Animation data pasted into the scene will change the current scene
objects relative to their current status. For example, if an object in the source
file is animated to move from the XYZ position 0,0,0 to 12,0,0, the object
receiving the animation data in the current scene will start at its current
position and move 12 units along the X axis.

Absolute Animation data pasted into the scene will replace the current
animation data. For example, if an object in the source file is animated to
move from the XYZ position 0,0,0 to 12,0,0, the object receiving the animation
data in the current scene will start at exactly 0,0,0 and animate to 12,0,0.

Main Attributes group

Specify the source file attributes whose animation data will be merged. Current
nodes must have the same attributes as merge nodes for the attribute animation
data to be merged.

Transform Enables selection of Position, Rotation and Scale animation data
for merging.

IK Merges animation data of IK chains created with IK solvers.

Position Merges Position transform animation data.

Rotation Merges Rotation transform animation data.
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Scale Merges Scale transform animation data.

Modifiers Merges animation data of modifiers. In order for animation data
of a modifier to be transferred, the current object must already have the same
modifier applied to it.

More Attributes group

Selects additional attributes to be merged from the source file.

Custom Attributes Merges animation data of any custom attributes on source
objects.

Add New Defs Adds custom attribute definitions to the current object if it
doesn't have the same definitions as the source object.

Base Objects Merges animation data of parameters at the object base level.
For example, if a sphere's Radius parameter is animated, checking this option
will merge the Radius animation data. This option will also merge animation
data at an object's sub-object level, such as the animation of vertices on a
spline or Editable Mesh object.

Materials/Maps Merges animation data of materials and/or maps.

Visibility Tracks Merges animation data of visibility tracks.
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Object Mapping rollout

Sets up a one-to-one correspondence (mapping) between source objects and
current objects. Animation data on objects in the Merge Nodes column will
be merged to the corresponding object in the Current Nodes column.

To move objects to the Merge Nodes column, drag them from the Source
Nodes column, or use Auto Name Mapping to automatically map objects with
the same names or partial names.

Source Objects Allows you to specify wildcard expressions for filtering source
objects. Click Refresh to view objects specified by the wildcard expression.

Refresh Refreshes the display based on wildcard expressions entered in the
Source Objects field.

Source Nodes Displays the object selected with the Source Object option, and
all its children. Objects with keyframed animation are listed in red, and objects
with procedural controllers (such as a Noise or Expression controller) are listed
in green. The display can be limited with wildcard expressions entered in the
Source Objects field.

Current Objects Allows you to specify wildcard expressions for filtering current
objects. Click Refresh to view objects selected by the wildcard expression.
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Refresh Refreshes the display based on wildcard expressions entered in the
Current Objects field.

Current Nodes Displays objects in the current scene. Animated objects are
listed in red. Display can be limited by wildcard expressions in the Current
Objects field.

Merge Nodes Lists the current objects that will receive animation data from
the corresponding object under Current Nodes. To place an object in the
Merge Nodes column, drag and drop the item from Source Nodes, or use Auto
Name Mapping to automatically map objects with the same or similar names.

Move Up Moves the selected Merge Node up one row.

Clear Selected Clears selected entries under Merge Nodes.

Move Down Moves the selected Merge Node down one row.

Auto Name Mapping Automatically maps source objects to the Merge Nodes
column, matching names with current objects. The mapping process filters
any wildcard expressions entered in the Source Objects and Current Objects
fields. If no wildcard expressions are entered, source objects are mapped only
to current objects with identical names.

Display Options group

Show Animated Only Displays animated objects only.

Indent Sets the number of characters by which child objects are indented in
the display.

Load Mapping Loads a previously saved .mnm file. This type of file can be
loaded and saved only on the Merge Animation dialog.

Save Mapping Saves the current mapping in an .mnm file. The name of the
source file and the mapping of source and current objects are saved. This type
of file can be loaded only with the Load Mapping option on the Merge
Animation dialog.

Replace

File menu > Replace

Replace lets you substitute the geometry of one or more objects in a scene by
merging objects with duplicate names. Use Replace when you want to work
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with less complex geometry to set up your scene and animation, and then
replace it with more detailed geometry before rendering.

■ When you replace an object in your scene, you replace its geometry,
including its modifiers, but not its transforms, space warps, hierarchy, or
materials.

■ To replace the object with all its characteristics, use Merge on page 7058.

■ If the object that you're replacing has instances in the scene, all of the
instances are replaced with the new object.

■ All objects in the scene with the same name as the incoming object are
replaced by that object. If you have more than one object in the scene
with the same name as the incoming object, all of those objects are
replaced.

See also:

■ Merging Effects  on page 6587

■ Merge Animation on page 7063

Procedures

To replace items:

1 Choose File > Replace to display the Replace File dialog.

To see more than one file type at a time, choose the All Files file type.

2 Select a file from which to choose replacement items.

3 On the Replace dialog for that file, choose a group or a replacement item.
(See the following procedure.)

An alert asks if you want to replace the materials along with the objects.

■ If yes, the materials from the incoming objects replace the current
materials.

■ If no, only the geometry is replaced, while the material assigned to
the original object is retained.
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To select objects to replace, do one of the following:

1 Enter the name of an item, or use wildcard characters to specify multiple
items that share a set of characters in their names.

2 Click to select single objects.

3 Press Ctrl and click to add and remove single objects from the selection.

4 Press Shift and click to select all objects between the previously selected
object and the current object.

5 Click All or None to select or deselect the entire list.

Interface

When you choose replace, a standard file selector dialog is displayed. Use the
file selector to choose the scene file with the replacement objects. After you
click Open, the Replace dialog is displayed.

TIP In the file selector, you can see more than one file type at a time by choosing
the All Files file type.
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In the Replace dialog, select the objects to replace. Either enter the object
name or select the object from the list.

All Selects all objects in the list.

None Deselects all objects in the list.

Invert Inverts the current list selection.

Display Subtree Displays object hierarchies in an indented format.

When this option is off, the Sort group is enabled.

Select Subtree When this option is on, all items indented below the selected
one are also selected.

Case Sensitive When on, distinguishes between upper and lower case in object
names.

Sort group

These are options for sorting the object list. If the Display Subtree check box
is on, these options are not available.

Alphabetical Sorts from A at the top to Z at the bottom.

By Type Sorts by category, using the same order as the check boxes in List
Types.

By Color Sorts by object wireframe color.

List Types group

Determines which object types are displayed in the list: geometry, shapes,
lights, cameras, helpers, space warps, or bone objects.

All Turns on all check boxes in the group.

None Turns off all check boxes in the group.

Invert Inverts the current state of the check boxes.
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Saving and Loading Animation

You can save and load animation data for any number of objects separately
from the actual scene via Load Animation and Save Animation commands
available on the File menu. These commands use two file types:

■ XAF (XML Animation File) contains the animation data.

■ XMM (XML Animation Map File) contains mapping information: how the
incoming animation data is assigned to objects in the current scene.

Mapping is quite flexible: as long as data is comparable, it can be assigned.
For example, each key for both position and rotation animation contains
three numbers, so you could, if you wanted, assign incoming position data
to a current object's rotation track, or vice versa.

See also:

■ Save Animation on page 7080

■ Load Animation on page 7077

■ Map Animation Dialog on page 7083

Procedures

To use the Save Animation and Load Animation commands:

You start by saving animation data from the current scene.

1 Select any number of objects in your scene that contain animation. The
animation can be of any type: procedural, manually keyframed, IK, and
so on.

The frame range from which the animation is saved is the same for all
objects, so make sure you select only objects from which you want to
save the same frame range.

NOTE Using this method, you can save animation only from selected objects.
Alternatively, you can save animation from specific tracks in Track View; see
Hierarchy Right-Click Menu on page 3538.

2 From the File menu, choose Save Animation on page 7080.

3 Set the save parameters.
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By default, the command saves all keys from animated tracks for selected
objects, including motion derived from constraints. For example, if an
object rotates because a LookAt constraint is applied to its Rotation track,
then when you save its animation with Include Constraints on, the
software generates rotation keys based on the constrained motion. It does
not save the actual constraint.

If you turn on Segment, you can then set a frame range from which to
save animation.

4 Specify a file name and then click Save, or click the + button next to Save
to increment the file name and save under the new file name.

If the selected objects contain no savable animation, the message “No
animation tracks to save” appears. If this happens, create animation to
save or change the Save Animation parameters as needed.

Next, you load the animation data.

5 Set up or load a new scene and then select any objects that are to receive
the loaded animation.

NOTE Using this method, you can load animation only to selected objects.
Alternatively, you can load animation to specific tracks in Track View; see
Hierarchy Right-Click Menu on page 3538.

6 From the File menu, choose Load Animation on page 7077.

7 Find and highlight the XAF file from which to load animation.

8 Click Load Motion. If the objects you're loading animation to are the
same as those you saved the animation from, the animation loads and
is mapped automatically. If mapping is required, you're given the
opportunity to set it up. Or, if you've already set up mapping for the
scene and incoming animation data, choose a mapping (XMM) file from
the Motion Mapping/Retargeting drop-down list and then click Get
Mapping. Otherwise, click Edit Mapping.

Clicking Edit Mapping opens the Map Animation dialog on page 7083,
which contains three lists: from left to right, Current, Mapped, and
Incoming. The Current list shows selected objects in the scene and their
animation tracks; the Incoming list shows animation tracks in the XAF
file, and the Mapped list shows, for each track in the Current list, the
animation track in the Incoming list that will map to it. In certain cases,
such as with objects that have the same name, some tracks are mapped
automatically and appear in the Mapped column as soon as you open
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the dialog. The tracks that are already mapped are shown in gray in the
Current and Incoming columns.

9 To map a pair of tracks manually, click a track in the Current list and
another in the Incoming list, and then click the left-arrow (<-) button to
the left of the Incoming list.

This places the name of the incoming track in the Mapped list, opposite
the Current-list track to which it is assigned.

10 To remove a mapping assignment, click its entry in the Mapped list, and
then click the -> button.

11 Continue setting up the mapping assignments as needed. When you're
finished, click Save Mapping or Save Mapping As, and then specify a file
name to save.

After you save the mapping file, the Load Motion button becomes
available, and you can proceed with loading the animation.

12 Click Load Motion.

The animation data is loaded and assigned to the selected objects, and
any animation keys appear on the track bar.

To retarget an incoming animation:

This is a continuation of the previous procedure, and explains the basic
workflow of node retargeting. Retargeting means to scale the animation so it
matches the objects onto which you are mapping the motion. You can use
this feature any time you need to transfer an animation between two objects
or rigs of different sizes and proportions. For example, an animation of a cat
stretching could be retargeted to a bigger dog model, resulting in a scaled
animation to fit the dog's skeleton.

Once your track-mapping assignments are complete, the Retargetable Nodes
list on the Retargeting rollout displays the mappings available for retargeting.

For steps that describe retargeting a character rig, see To retarget one character
onto another on page ?.

1 First, in the Scale Origin group, choose the Incoming and Current objects
to use as the origin and basis for scaling.

For example, when retargeting a rig, you would use each rig's root object.

2 Next, in the Derive Scale Between Chains group, chose comparable IK or
FK chains from the Incoming and Current models to obtain a Scale Factor
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that proportionally retargets the incoming animation onto the current
model.

3 Click Set to apply the retargeting.

4 If different portions of the model are differently proportioned, you might
need to repeat steps 2 and 3 for different selections of mapped tracks.
You might also need to use the FK Retargeting Extent group to account
for the different proportions. See Retargeting Rollout on page 7090 for more
details.

5 When you're finished, save your mapping to preserve the retargeted data,
and then click Load Motion to apply the animation to the currently
selected objects.

Retargeting is essentially a “by hand” process. You might need to try
different settings to get the result you need. You can remove retargeting
by highlighting a mapped track in the Retargetable Nodes list, and then
clicking Clear.

6 Close the Map Animation dialog.

Load Animation

Select one or more objects. > File menu > Load Animation

Track View > Hierarchy/Controller window > Highlight one or more tracks >
Right-click. > Load Animation

Load Animation lets you load animation from an XAF (XML Animation File)
file to objects in your scene. Part of the animation-loading process is mapping
the animation; that is, specifying which objects in the scene are to receive the
loaded animation tracks.

For a procedure that outlines the basic method of saving and loading
animation, see To use the Save Animation and Load Animation commands
on page ?.

See also:

■ Saving and Loading Animation on page 7074

■ Save Animation on page 7080

■ Map Animation Dialog on page 7083
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Interface

[file controls] The controls in the upper-left corner of the dialog are standard
file-browsing controls.

Load Into Active Layer Loads the animation file into the active layer.
Default=off.

This option makes it easier to load an animation file to an object that has had
Animation Layers on page 3164 enabled (or disabled) subsequent to saving the
animation files. Remapping is necessary in this case because enabling or
disabling Animation Layers causes the full controller names to change. For
example, if a sphere's X position track before enabling Animation Layers is
Sphere01\Transform\Position\X Position, then after enabling Animation
Layers it might change to Sphere01\Transform\Position\Base Layer\X Position
(the layer name is inserted into the controller name).

Whether Load Into Active Layer is on or off, when you load animation to an
object after changing its Animation Layers status, the software prompts you
to create a map file. If Load Into Active Layer is on, when you click Yes to
create the map file, the Map Animation dialog opens showing only the active
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layer's tracks in the Current list, and the tracks are already mapped correctly
in the Mapped list. All you need to do is save the mapping, and then load the
motion.

If Load Into Active Layer is off, clicking Yes to create the map file opens the
Map Animation dialog showing all animation tracks in all layers, and you
need to use the Map Animation controls to map the tracks before saving the
mapping and loading the motion.

Relative/Absolute Determines how incoming animation affects existing
values. Relative starts the loaded motion at the current values of the selected
objects in the scene. Absolute sets the values of objects in the scene the scene
to those of the motion; so, for example, it would move a character to a new
location and start the animation there. Default=Relative.

Replace/Insert Determines how existing keys are treated when the animation
is loaded. Replace overwrites the keys in the scene with the incoming motion,
starting at the chosen frame. Insert inserts the motion at the chosen frame
and moves any subsequent, existing keys to the end of the incoming motion.
Default=Insert.

At Frame The frame at which the incoming animation is applied. Default=0.

Load Motion If mapping information is available, loads the animation from
the file specified in the File Name field and applies it to current objects
according to the mapping information. If no mapping has been specified,
you're given the opportunity to create a map file. If you then click Yes, the
Map Animation dialog on page 7083 opens, but if you click No, no animation
is loaded.

Cancel Closes the dialog without loading any animation.

Motion Mapping/Retargeting group

File Shows the current mapping file, or “Default” if no mapping file has been
chosen. Choose a mapping file from the drop-down list.

The list contains the most recently loaded mapping files. If the file you want
to use isn't available in the list, use the Get Mapping button.

TIP If the paths in the drop-down list are too long to see the file name itself, you
can resize the dialog to make the dialog and the list wider.

Get Mapping Lets you browse to load a mapping file. Use this if the file doesn't
appear in the Use Mapping drop-down list. The file then appears in the list
for easy reloading.
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Edit Mapping Opens the Map Animation dialog on page 7083 for setting up
animation assignments between incoming tracks and existing tracks. Available
only after an animation (XAF) file has been chosen.

User Data group

The User Data list shows any user data present in the XAF file specified in the
File Name field. User data can be created via the Save Animation dialog, or by
editing the XAF file directly.

Save Animation

Select one or more animated objects. > File menu > Save Animation

Track View > Hierarchy/Controller window > Highlight one or more tracks >
Right-click. > Save Animation

Save Animation lets you store animation from your scene to disk in the XML
Animation File (XAF) format. The XAF file format lets you save and load
animation for any number of objects separately from the actual scene.

For a procedure that outlines the basic method of saving and loading
animation, see To use the Save Animation and Load Animation commands
on page ?.

See also:

■ Saving and Loading Animation on page 7074

■ Load Animation on page 7077

■ Map Animation Dialog on page 7083

Interface

To use Save Animation, select the objects from which to save animation data,
and then choose Save Animation from the File menu. Settings in the Save
XML Animation dialog apply only to objects that are selected when you save
the animation.
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File controls The controls in the upper-left corner of the dialog are standard
file-browsing controls.

Animated Tracks Saves only animated tracks. This is on by default, and should
generally be left on.

■ Include Constraints When on, includes motion derived from constraints.
For example, if an object rotates because a LookAt constraint is applied to
its Rotation track, then when you save its animation with Include
Constraints on, the software generates rotation keys based on the
constrained motion. It does not save the actual constraint. When off,
animation accomplished only by constraints, such as the Link constraint,
is not saved. Default=on.

NOTE This doesn't apply to constraints such as the Path constraint on page
3297. Because this constraint assigns the animation directly to the constrained
object, rather than deriving it from the constraining object, Save Animation
saves path-constrained animation even if Include Constraints is off.
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Keyable Tracks When on, saves only keyable on page 3563 tracks with
controllers, as defined in Track View. Turning this on allows keyless animation
tracks to be saved. Default=off.

If both Animated Tracks and Keyable Tracks are on, any tracks that contain
animation but are not keyable won't be saved. You can use this option to
avoid saving tracks that aren't relevant to the scene into which you're loading
the animation. For example, if you want to save constraint data, but not data
from a LookAt constraint (because LookAt tends to be specific to the scene),
you can turn off Keyable for the LookAt track, and then save with Keyable
Tracks on.

NOTE Animated Tracks overrides Keyable Tracks. If a track is keyable but doesn't
contain any animation data, and Animated Tracks is on, the track won't be saved
even if Keyable Tracks is on.

NOTE Tracks without controllers, such as nonanimated creation-parameter tracks,
won't be saved even if Keyable Tracks is on. To save a nonanimated
creation-parameter track, add a controller, turn off Animated Tracks, and turn on
Keyable Tracks.

Segment Lets you save a specific frame range, as opposed to the entire
animation. Default=off.

■ Active Time Range Click to set the From and To fields to the
currently active time range. Available only when Segment is on.

■ Objects Time Range Click to set the From and To fields to the time
range that corresponds to the keys of the currently selected objects.
Available only when Segment is on.

■ From Sets the starting frame for the range to save. Available only when
Segment is on.

■ From/To Sets the ending frame for the range to save. Available only when
Segment is on.

Key Per Frame Saves an animation key per frame, thus “baking” the animation
to keyframes.

This can be useful if you are applying a procedural animation, such as a
dynamics simulation, to an object that won't be participating in a dynamics
simulation in the target scene.
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+ Increments the number at the end of the file name and saves the animation
file with the new name. If the file name doesn't currently end with a number
of two or more digits, clicking + appends “01” to the file name (before the
extension), and then saves the file.

Save Saves the animation using the current file name.

Cancel Closes the dialog without saving any animation.

User Data group

These controls let you enter user attributes and names. This could simply be
notes about the animation file, or they could be actual data for use by custom
plug-ins and utilities.

To enter user data, type a value in the Attribute field, press Tab and type a
value in the Value field, and then press Enter to add the attribute and value
to the list below. These values are saved with the XAF file and can be viewed
with the Load Animation dialog.

Attribute Enter an attribute name.

Value Enter an attribute value. This can be any combination of alphanumeric
characters. To add the attribute and value to the file, press Enter while the
cursor is in this field.

 Delete User Data Deletes the highlighted attribute from the list along
with its corresponding value.

Attribute list Shows all attributes and values in the file. To change a value,
click the corresponding attribute in the list to highlight it and place it in the
Attribute and Value fields, edit the Value field, and then press Enter. You can
also edit the Attribute field, but this creates a new entry.

To remove an attribute, highlight its name in the list and then click Delete
User Data.

Map Animation Dialog

File menu > Load Animation > Open dialog > Edit Mapping

File menu > Load Animation > Open dialog > Load Motion > XML Animation
dialog > Click Yes.

Saving and Loading Animation | 7083



The Map Animation dialog lets you assign incoming animation tracks when
using the Load Animation on page 7077 command. The dialog is resizable and
contains three rollouts: for setting up basic parameters, doing the actual
mapping, and doing retargeting.

For a procedure that outlines the basic method of saving and loading
animation, see To use the Save Animation and Load Animation commands
on page ?.

See also:

■ Saving and Loading Animation on page 7074

■ Save Animation on page 7080

■ Load Animation on page 7077

Interface

Most controls on this dialog are contained in three rollouts:

Motion Mapping Parameters Rollout on page 7086

Map Track to Track Rollout on page 7089
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Retargeting Rollout on page 7090

Motion File Shows the path and name of the current animation (XAF) file.

■ New Click to display a file dialog and specify a new animation file to
load.
With this option, you don't need to return to the Load Animation dialog.

Map File Shows the path and name of the current map (XMM) file.

■ New Click to display a file dialog and specify a new map file to load.
With this option, you don't need to return to the Load Animation dialog.

Save Mapping Click to save the current mapping assignments to an XMM
file. If a file name is already displayed in the Map File field, it is overwritten;
otherwise, 3ds Max displays a file dialog so you can enter a name for the new
file.

Save Mapping As Click to save the current mapping assignments to an XMM
file using a different file name. This displays the Save XML Animation map
file dialog.

Load Motion Click to load the animation from the XAF file, and maps the
animation tracks as specified.

This button is available only when the Map File field contains a valid map
file name.

Replace / Insert These options determine how existing keys are treated when
you load an animation. Replace overwrites the current scene's keys (if any)
with the incoming motion, starting at the chosen frame. Insert inserts the
motion at the chosen frame and moves any existing keys to the end of the
incoming motion. Default=Insert.

■ At Frame The frame at which the incoming animation is written (Replace)
or inserted. Default=0.

Relative/Absolute These options determine how incoming animation affects
existing values. Relative starts the loaded motion at the current values of the
selected objects in the scene. Absolute sets the values of objects in the scene
to those of the incoming motion. For example, when you load a character
animation, Relative starts the animation from the character's current position,
while Absolute first moves the character to the position of the character in
the scene from which the animation was saved. Default=Relative.
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Motion Mapping Parameters Rollout

File menu > Load Animation > Open dialog > Edit Mapping

File menu > Load Animation > Open dialog > Load Motion > XML Animation
dialog > Click Yes.

This rollout provides controls for automatically mapping animation tracks
and for filtering tracks to reduce clutter.

Interface

Map Nodes group

These controls let you perform automatic mapping by name or hierarchical
order. Mapping is done first by node (object) name, and then within each
node's hierarchy by controller (track) name.

The default method of automatic mapping is Exact Name for both nodes and
controller. When you first open the Map Animation dialog, any node/controller
pairs whose names match exactly are automatically mapped. To change the
mapping, remove any existing assignments in the Mapped list (highlight them
and then click the -> button), and then choose an alternate method.

Exact Name This maps node to node, by name. If the names do not match
exactly, the tracks will not map, and the status line will report how many
nodes did not map

Closest Name Finds a match in the object names, and uses the Controller
options (described below) to confirm the match.

For example, if the incoming is R Toe 01 and the choice in the Current list is
between Right Index Toe and R Toe Helper, it will look at the controller structure
and compare by name, or type or order, and try to determine which node is
the closest to the incoming. When the choice is close like this, the status line
reports that there was another close match, and highlight the close, but
unmapped, nodes in the incoming list in red.

Hierarchy This option turns off the above options. It matches by node order;
for example, Bone01>Bone02>Bone03 would map to Leg>Calf>Foot, if Controller
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is set to Order and the leg is mapped to Bone01. The Hierarchy option ignores
the names.

Controller Determines how automatic mapping is performed within nodes:

■ Exact Name (The default.) Matches controllers by name, regardless of
order. This applies specifically to lists, morph channels, maps, custom
attributes, and any other tracks that are listed by a user-defined name that
might be reordered for some reason.

■ Order This maps by controller order only, regardless of name or type,
and it turns the other options off. For example, it will map the first
controller in a list to the first controller in a list. If necessary, it “bakes”
the animation by creating per-frame keys.
If any controllers are not mappable (for example, a Bezier controller getting
mapped into a script), the status line will report the error and highlight
the node that couldn’t map in the incoming list.

Type When on, allows mapping only between controllers of the same type.
It prevents mapping between two controllers of different types. For example,
a controller such as Noise and its parameters will map only to another Noise
controller. Default=off.

Filters group

The Filters options are similar to those available in Track View: they enable
viewing only certain types of tracks. Filtering is can be a help with large,
complex animation setups, because it lets you focus on tracks of specific
interest and ignore the rest.

The following information describes the action of filters that are on. Unless
otherwise specified, when a filter is off, the track type it applies to is hidden.
In some cases, a track will not be hidden because a different filter that is on
permits display of that track.

NOTE The Incoming list contains only animation tracks that were saved in the
XAF file, so it cannot display unavailable tracks. For example, if you don't animate
an object's creation parameters, toggling the Base Objects switch won't change
the Incoming list contents.

Current/Incoming Determines whether the filters are applied to the Current
list or the Incoming list.
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 Lock When the Lock button is on, the filters are applied to both lists.
Default=locked.

 When the Lock button is off, only one of these is active at a time, and
3ds Max remembers different sets of on/off values for the filtering parameters.

Animated Tracks Displays tracks that contain animation keys.

Include Constraints Displays constraint tracks, even if they are not animated.

Keyable Tracks Displays tracks that are set to keyable, regardless of whether
they contain animation.

Unmapped Tracks When on, hides mapped tracks. When off, all tracks are
displayed.

Visibility Tracks Displays visibility tracks.

Note Tracks Displays note tracks. When a note track is mapped, the notes
are added to an existing note track in the current scene.

Custom Attributes Displays custom attribute tracks.

Controller Types Displays controller types (names) in the list. For example,
the Position X track reads “Position X: Bezier Float.”

IK Controllers Displays any IK controllers.

Modifiers Displays animatable modifier tracks.

NOTE In order for modifier tracks to display in the Current column, the Base
Objects filter must also be on.

Base Objects Displays creation-parameter tracks for parametric objects such
as Box and Sphere.

Map Parameters Shows map tracks, such as Tiling for Bitmaps and Mix
Amount for Mix maps.

Material Parameters Shows tracks for materials; for example, animated Diffuse
color values, Opacity, and so on.

Expose World Transforms Displays tracks for world transforms. These let
you map all transform animation between two objects using a single track,
named Exposed World Transform.
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Transforms Enables or disables display of all transforms other than the exposed
world transforms. The toggles that follow control display of individual
transforms:

■ Position/X/Y/Z The Position check box lets you toggle display of all
Position tracks, while the X/Y/Z check boxes let you toggle display of the
track for each axis.

■ Rotation/X/Y/Z The Rotation check box lets you toggle display of all
Rotation tracks, while the X/Y/Z check boxes let you toggle display of the
track for each axis.

■ Scale/X/Y/Z The Scale check box lets you toggle display of all Scale tracks,
while the X/Y/Z check boxes let you toggle display of the track for each
axis.

Map Track to Track Rollout

File menu > Load Animation > Open dialog > Edit Mapping

File menu > Load Animation > Open dialog > Load Motion > XML Animation
dialog > Click Yes.

This rollout comprises three list windows. The left (Current) and right
(Incoming) show node/controller hierarchies, as in Track View.

Because the Map Nodes group functions apply to highlighted tracks, you can
use standard highlighting methods. Click to highlight an entry, Ctrl+click to
highlight multiple entries, and Shift+click to highlight a range. Also, in the
Current and Incoming windows, you can right-click to open a menu that lets
you highlight all tracks (Select All), invert the current highlighting (Select
Invert), and turn off highlighting for all tracks (Select None).

In addition, you can use the right-click menu to expand and collapse any
track with a - or + icon next to its name.
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Interface

Current[list Shows animation tracks for selected objects in the scene, using
the same hierarchical display as Track View. Unassigned tracks use black
characters, while assigned tracks use gray characters.

Status This read-only field shows the number of controllers and the number
of nodes mapped.

Mapped list Shows tracks that have been mapped.

<- Assigns the highlighted animation track in the Incoming list to the
highlighted animation track in the Current list. The assignment then appears
in the Mapped list, opposite the corresponding Current list entry.

If the two tracks don't contain comparable data, nothing happens when you
click the button.

-> Removes the highlighted Mapped list entry.

Incoming list Shows animation tracks in the loaded XAF file, using the same
hierarchical display as Track View. Unassigned tracks use black characters,
while assigned tracks use gray characters.

Retargeting Rollout

File menu > Load Animation > Open dialog > Edit Mapping

File menu > Load Animation > Open dialog > Load Motion > XML Animation
dialog > Click Yes.

When you map an animation from one rig or object onto another, use this
rollout to establish retarget references between the incoming nodes in regards
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to their scale dependency. Retargeting means to scale the animation so it
matches the objects onto which you are mapping the motion. You need to
retarget only when the size or proportions of the incoming model differ from
the size or proportions of the current model.

Retargeting applies to any kind of animation, from matching fight
choreographies, to changing a weather balloon's fly-through trajectory over
hills and valleys. The down side of this is that essentially you have to set up
the scaling relationships by hand; the good news is that the steps are fairly
straightforward, and that once you have retargeted, the settings are reusable
for all animation mapped between the same two sets of objects.

While retargeting is a general-purpose feature, it is especially useful for
transferring animation from one character to another, when the characters
are of different sizes, and possibly of different proportions (for example, a
human model to a gorilla, or vice versa). You can transfer IK animation onto
an FK rig, or vice versa. There are some rules of thumb when you work with
mapping character animation:

■ In a walk cycle, the root of a character moves, and all other movement is
typically rotation.
Because of this, usually you want to map the root motion and the rotation
tracks, and leave the others alone.

The exception to this is when arms or other parts (tentacles?) are animated
by IK. When IK is present, you need to take the additional step of mapping
and retargeting the IK goals.

■ The legs need to reach the “ground,” and feet should not slide.
Because of this, use the legs as the basis of recalculating the scale for the
target character.

■ Characters are usually symmetrical.
Because of this, usually retargeting one limb does the trick for both.

If a character's limbs are not symmetrical, retarget each of them individually.
If the current model uses forward kinematics, then use the FK Retargeting
Extent controls as well.

Procedures

To retarget one character onto another:

This procedure is not a detailed procedure, but an overall workflow. It assumes
you have already saved the incoming character's animation, then loaded it
onto the current character, as described in To use the Save Animation and
Load Animation commands on page ?.
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NOTE If the animation you are saving is unkeyed world-space animation (as
opposed to IK or FK), turn off Animated Tracks when you save.

1 On the Map Track To Track rollout on page 7089, map the motion tracks
of the incoming character's root to the current character's root.

For example, if you are retargeting a Biped on page 4147 onto another, you
would map the incoming Biped object's position and rotation tracks onto
the current Biped.

2 Map the rotation tracks of the incoming character's limbs onto the current
character's limbs.

There is one exception here: if a hand (for example) is going to use IK in
the current scene, either don't map it at all, so you can animate it later,
or if you are mapping from an FK model to an IK model, map the Exposed
World Transform to transfer the incoming FK trajectories to current IK
controls.

3 Go to the Retargeting rollout.

4 In the Scale Origin group, choose both the Incoming and Current root
objects.

If the characters are symmetrical and have the same proportions, you
can now choose all the mapped tracks in the Retargetable Nodes list. If
the characters are not symmetrical, or their proportions are different,
then you need to take further steps.

5 In the Derive Scale Between Chains group, choose the Start and End
nodes of both Incoming and Current chains to correspond to either the
left or right leg of the character: for example, Thigh to Toe.

Read the Scale Factor that is set on the basis of the two chains.

6 Click Set to retarget the highlighted mapped tracks.

If the two current legs are not the same length, repeat step 5 for the other
leg, then choose that leg's Foot (or Toe) node, turn on Enabled in the FK
Retargeting Extent group, and choose the top of the leg (for example,
Thigh) as the parent to use. Click Set.

7 Save the retargeted mapping file.

8 Click Load Motion to animate the current character, and then close the
Map Animation dialog.
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Interface

Retargetable Nodes list This list shows the tracks that have been mapped
using the Map Track To Track rollout on page 7089. Each of these mappings can
be retargeted.

The fields in this list are as follows:

■ Current Mapped Node Shows the node-to-node mapping, as in
“CurrentObject->IncomingObject.”

■ R When a mapping has been retargeted, this field shows an “X.”

■ Scale (X,Y,Z) Shows the current scaling factor for each dimension of the
current node.

■ Absolute When a mapping uses absolute scaling, this field shows an “X.”

■ Scale Origin (Incoming,Current) Shows the incoming and current scale
origins for this mapping. If the mapping hasn't been retargetted, this field
shows “Scene Root , Scene Root.”

■ Incoming Chain (Start,End) If the mapping has been retargeted, shows
the incoming chain used to calculate scale.

■ Current Chain (Start,End) If the mapping has been retargeted, shows the
current chain used to calculate scale.

■ FK Extent If a mapped track's FK extents have been recalculated, shows
the parent node used in the recalculation.
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Find Enter a name to search for a particular object, then press Enter. 3ds Max
highlights matching entries in the list.

Filter Retargeted Nodes When on, the list shows only those mappings that
have been retargeted. When off, all mappings are listed. Default=off.

Mapped Node Shows the currently highlighted mapped node. If more than
one list entry is highlighted, shows “—Multiple—.”

Scale group

■ Absolute When chosen, scaling for the currently highlighted mappings
is absolute, and based on the XYZ settings in this group alone.

■ Multiply Derived Scale (The default.) When chosen, scaling for the
selected mappings is based on both the XYZ settings in this group, and
calculations from the Derive Scale Between Chains group and the FK
Retargeting Extent group (if that is used).

X/Y/Z You can use these fields to explicitly set the scaling factor for the
currently highlighted mappings.

Scale Origin group

Incoming Choose the incoming object from which to derive the scaling
origin. This is a drop-down list obtained from the list of incoming nodes.

Current Click to display a Select dialog and chose the current object from
which to derive the scaling origin. The dialog shows all currently selected
objects.

Typically, you set these two to be the incoming root node and current root
node, whose motion tracks are already mapped.

Derive Scale Between Chains group

Resulting Scale Factor Displays the scale factor derived from the Scale Origin
and Incoming/Current Chain settings. Check this value to see that it matches
the apparent difference in proportion between the objects or characters you
are retargeting.

Incoming Chain These controls set the incoming IK or FK chain to use in
calculating the Scale Factor.

■ Start Choose the start of the incoming chain. This is a drop-down list
obtained from the list of incoming nodes.
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When retargeting character animation, typically you choose the top of the
incoming character's leg; for example, the thigh.

■ End Choose the end of the incoming chain. This is a drop-down list that
is restricted to children of the incoming Start object.
When retargeting character animation, typically you choose the end of
the incoming character's leg; for example, the toe.

Current Chain These controls set the incoming IK or FK chain to use in
calculating the Scale Factor.

■ Start Click to display a Select dialog and choose the start of the current
chain. The dialog shows all currently selected objects.
When retargeting character animation, typically you choose the top of the
current character's leg (using the same side as you used for the incoming
chain).

■ End Choose the end of the current chain. This is a drop-down list that
is restricted to children of the current Start object.
When retargeting character animation, typically you choose the end of
the current character's leg.

If a character's legs are symmetrical, which is usually the case, you only need
to calculate the retargeting scale for one leg, and then Set that value to both.
If the character's legs are not symmetrical, you need to calculate values for
both legs, and also use the FK Extents controls (described below).

FK Retargeting Extent group

When the current model uses IK, 3ds Max knows the extent to retarget because
it is defined by the IK solution. But if the current model uses FK, you should
specify the extent of retargeting. For example, mapping rotation animation
from a long leg to a short leg with different link lengths requires that the short
leg’s foot be chosen to retarget so it ends up meeting the floor in the same
way the long leg does. In order for 3ds Max to know how far up the chain
from the foot to do the retargeting, the parent of the desired chain (for
example, the thigh) must be specified. By defining the two chains to compare,
3ds Max can adjust the resulting rotations such that the feet don't slide.

When a character's limbs are not symmetrical, you can also use these controls
to keep rotations proportional. First, highlight the current child (for example,
a foot or toe) in the Retargetable Nodes list. Turn on Enabled, and then use
the drop-down list to choose the upper parent (for example, the thigh) of the
limb you are retargeting. Finally, click Set.

Saving and Loading Animation | 7095



Enabled Turn on to enable retargeting extents. Default=off.

Parent Node Choose the current upper parent of the limb you are retargeting.
This drop-down list is restricted to parents of the currently highlighted current
object.

Get Click to set controls in the Scale, Derive Scale Between Chains, and FK
Retargeting Extents groups based on the currently highlighted mapping in
the list.

If multiple mappings are selected, Get fetches the first highlighted mapping
in the list.

Set Click to apply the current Scale Factor to the mappings that are currently
highlighted in the list.

Clear Click to clear retargeting values from the mappings that are currently
highlighted in the list.

Import

File menu > Import

Import loads or merges geometry files that are not 3ds Max scene files. See
the following procedure for a complete list of file types you can import.

Procedures

To import a file:

1 Choose File menu > Import.

2 Choose an import file type from the Files Of Type list in the file selector
dialog. To see more than one file type at a time, choose the All Files file
type.

■ Autodesk (FBX) on page 7222

■ 3D Studio Mesh (3DS, PRJ) on page 7172

■ Adobe Illustrator (AI) on page 7178

■ Autodesk Collada (DAE) on page 7222

■ LandXML /DEM /DDF (DEM, XML, DDF) on page 7249

■ AutoCAD Drawing (DWG) on page 7182
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■ Legacy AutoCAD (DWG) on page 7201

■ Flight Studio OpenFlight (FLT) on page 7223

■ Motion Analysis HTR File (HTR) on page 7257

■ IGES (IGE, IGS, IGES) on page 7226

■ Autodesk Inventor (IPT, IAM) on page 7211

■ Lightscape (LS, VW, LP) on page 7253

■ gw::OBJ-Importer (OBJ) on page 7285

■ 3D Studio Shape (SHP) on page 7177

■ Stereolitho (STL) on page 7276

■ Motion Analysis TRC File (TRC) on page 7259

■ VRML (WRL, WRZ) on page 7290

■ VIZ Material XML Import (XML)

NOTE This applies the imported material directly to selected objects. See
Material XML Exporter Utility on page 5281 for information on creating this
file type.

3 Choose a file to import.

4 For some file types, a second dialog appears, with options specific to that
file type. Choose the import options you want.

Export

File menu > Export

Export converts and exports 3ds Max scenes in various formats. See the
following procedure for a complete list of file types you can export.

See also:

■ Export Selected on page 7099
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Procedures

To export a file:

1 Choose File menu > Export.

2 Choose an export file type from the Files Of Type list in the file selector
dialog:

■ Autodesk (FBX) on page 7222

■ 3D Studio (3DS) on page 7175

■ Adobe Illustrator (AI) on page 7179

■ ASCII Scene Export (ASE) on page 7180

■ Lightscape Material (ATR) on page 7251

■ Lightscape Blocks (BLK) on page 7251

■ Autodesk Collada (DAE) on page 7222

■ Lightscape Parameter (DF) on page 7251

■ Publish to DWF (DWF) on page 7216

■ AutoCAD (DWG) on page 7206

■ AutoCAD (DXF) on page 7209

■ Flight Studio OpenFlight (FLT) on page 7223

■ Motion Analysis HTR File (HTR) on page 7261

■ IGES (IGS) on page 7230

■ Lightscape Layers (LAY) on page 7251

■ Lightscape Preparation (LP) on page 7251

■ JSR-184 (M3G) on page 7233

■ gw::OBJ-Exporter (OBJ) on page 7281

■ StereoLitho (STL) on page 7279

■ Lightscape View (VW) on page 7251

■ Shockwave 3D Scene Export (W3D) on page 7264

■ VRML97 (WRL) on page 7292
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3 Enter a name in the File Name field.

4 Depending on the file type you choose, you might be presented with
options available for that export choice. If a second dialog appears, choose
the export options you want.

Export Selected

Select one or more objects. > File menu > Export Selected

Export Selected exports selected geometry in a variety of formats. For details,
see Export on page 7097.

When you choose Export Selected, a file dialog appears, from which you can
choose a type of format from the Save as type list. The list of formats available
with Export Selected is a subset of the Export list.

Procedures

To export selected objects to a file:

1 Select one or more objects.

2 Choose File menu > Export Selected.

3 Enter a name in the File Name field.

4 From the Save As Type drop-down list, choose a file format.

5 Click the Save button.

Asset Tracking

The Asset Tracking feature provides direct access within 3ds Max to asset
tracking systems (ATS), also known as providers. You use asset tracking systems
to share files such as scene files and bitmaps used in materials with other
members of your development team.

Asset tracking provides full support for the Autodesk Vault data-management
solution, and basic version-control support for other providers, such as Perforce
and Microsoft SourceSafe. In general, asset tracking supports version-control
providers that are capable of integrating into Microsoft Visual Studio,
sometimes referred to as MSSCC support. This topic assumes usage of Autodesk
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Vault. Autodesk Data Management Server and Autodesk Vault Explorer are
available to subscription customers and are also shipped with certain other
Autodesk softwares. See Manage Files with Autodesk Vault on page 29. The
Vault Plug-ins are included with 3ds Max.

NOTE When you have Vault installed, you can open files directly from the Vault
database with the File menu command Open from Vault on page 6925. This
command mimics the File Open process, but browses the vault instead of the file
system. In addition to opening the scene file, it downloads or updates any
dependent scene files, such as bitmaps and XRefs. You see Open from Vault in the
File menu only if you have installed the Vault Plug-in.

Asset Tracking with Autodesk Vault

The 3ds Max Vault Plug-in works with 3ds Max by adding data-management
tools to the interface. Through the Vault Plug-in, you can add files to a vault,
and check files out and in. The add-in works with many different types of files
including MAX and image files. The recommended method for performing
Vault operations depends upon your working environment.

When you work on a file that is checked out of the vault, you work on a local
copy of the file and not the original. At no point do you ever work on the
actual vaulted file. When you check a modified file back into the vault, the
modifications are available as the latest version in the vault. All past versions
of a file are maintained in the vault.

See also:

■ Asset Tracking Dialog on page 7100

■ Open from Vault on page 6925

■ Prompts Dialog on page 7118

■ Asset Tracking Dialog Icons on page 7119

Asset Tracking Dialog

File menu > Asset Tracking

With the Asset Tracking dialog, you can check files in and out, add files to
the Asset Tracking System (ATS), get different versions of files, etc., all from
3ds Max without the need to use separate client software. Another important
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function of the Asset Tracking dialog is for repathing; locating missing files.
For example, if you move bitmap files used by materials in your scene to the
same folder as the scene file, the bitmaps will be loaded when you open the
scene file, but the materials will still use the original, no-longer-valid path for
the bitmap files, and the Asset Tracking dialog will show the files as missing.
To resolve the incorrect paths, you can use the tools available from the Paths
menu.

Asset tracking provides full support for the Autodesk Vault data-management
solution, and basic version-control support for other providers, such as Perforce
and Microsoft SourceSafe. In general, asset tracking supports version-control
providers that are capable of integrating into Microsoft Visual Studio,
sometimes referred to as MSSCC support. This topic assumes usage of Autodesk
Vault.

The Asset Tracking dialog provides the principal functionality for working
with the Vault data-management solution from within 3ds Max, but you can
also work directly with Vault using the Vault Explorer client software, which
is included with 3ds Max. To run Vault Explorer, go to Windows Start menu
> Autodesk > Autodesk Data Management and choose Autodesk Vault Explorer.
To learn more about using Vault Explorer, open the Autodesk Vault Explorer
Help menu and choose Autodesk Vault Help Topics, or simply press F1 while
the Vault Explorer window is active.

See also:

■ Asset Tracking on page 7099

Filtering Files

You can configure individual asset-tracking-system providers via the provider
configuration file, ATSProviders.xml, which resides in \plugcfg in the program
install folder. 3ds Max reads this file, but doesn't write to it.

The primary configuration function is filtering. Filters define criteria the
software uses to determine whether a file should be excluded from a provider’s
control. If a file is determined to be excluded from a provider, the file is never
sent to the provider for status check or any other action. This feature is useful
when using multiple providers within the same pipeline or if your studio still
uses file servers for certain file types.

When a file is excluded, its icon is grayed out and its status message indicates
that it is excluded. You can also toggle the display of excluded files in the
dialog window with the Display Excluded Files option on page 7113.
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A example filter file, \plugcfg\ATSProviders_Example.xml is included with the
software, in the program install folder. The file includes comments, so you
can load it into a text editor to see how it works and edit it. If you're using
Autodesk Vault as your provider, you can rename the provider field (in the
<Provider> section, near the beginning of the file) to Autodesk Vault, as follows:

Change:

<Name>Sample Provider Name Example</Name>

to:

<Name>Autodesk Vault</Name>

One of the effects of the example file is to exclude FX files, as shown in the
following illustration:

Procedures

If you are using Vault as your asset management system, you will need to
login into the Vault the first time you access it, otherwise you will not be able
to check files in and out.

To start and login into the Vault from 3ds Max:

1 In 3ds Max choose File > Asset Tracking.

2 Select the version of Autodesk Vault that you want to login to from the
Autodesk Vault Version box.

3 In the Asset Tracking dialog choose Server > Log in.
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4 In the Log in dialog box enter the following:

User Name The name for the vault ac-
count. Default= Administrator

The password associated with
the vault account. De-
fault=<left blank>

Password

The name of the computer
on which the vault server is

Server

installed. Use “localhost” if
the server is installed on the
same machine as the client.
See your system administrat-
or if this does not work.

The name of a vault database
located on the specified serv-

Database

er. The default is “Vault”.
Click the browse button to
select from a list of available
databases on the server. De-
fault=Vault

NOTE Enable Use this settings next session if you want to be automatically
logged in future sessions.

Click OK when you have entered values in all fields.

NOTE Your system administrator may provide you with your own account
values which you will use instead of the defaults. If you are experiencing
problems, speak with your system administrator.

To set up a local working folder when using Vault:

When you are working with files in Autodesk Vault you need to have a working
folder set up. The working folder houses your files while you are working on
them (between checking files out of the vault and checking them back in to
the Vault). The working folder can be a folder on your local machine or a
folder on the network. Typically a system administrator will set up the working
folder on the network.
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NOTE If your system administrator has enforced a network working folder, you
may receive a message notifying you of this. You will not need to set your working
folder, though you may need to map the drive location that has been set up for
your working folder. For further information, speak with your system administrator.

1 In 3ds Max choose Server > Login and login on page 7105 to the Vault.

NOTE Make sure the version of Vault that you want to work with is selected
in the Autodesk Vault Version box.

2 Choose Server > Options.

3 Browse to the folder that you want to use and click OK to confirm.

To coordinate local files with Vault files:

For optimal coordination between your files and those in the Vault, you need
to maintain a one-to-one correspondence between the folder structure in the
database and the structure in your working folder and its subdirectories.

Create a local folder structure for Vault files and then use Options to map the
top of the local structure to the top of the Vault structure (i.e., Vault($)).

1 Create a working folder on a local drive to contain all files to be
coordinated with other users via the Vault. For example, you could call
the working folder My_Vault.

2 Open the Asset Tracking dialog and log in to the tracking database if
necessary.

3 On the Asset Tracking dialog, choose Server menu > Options.

4 On the Vault Options dialog, click the Change button and then use the
Browse For Folder dialog to choose the folder you created in step 1.

TIP You can also use the Browse For Folder dialog to create this folder.

Now, when you open a file from the Vault on page 6925, the folder structure
in which the file resides in the Vault is replicated in your local folder, if
necessary. Likewise, when you add a file to the Vault, the local structure
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is replicated in the Vault, if necessary. For example, if you open a character
mesh from Vault($)\max_files\characters\ and the file uses a bitmap stored
inVault($)\max_files\characters\face_maps\, the character mesh is stored
locally in My_Vault\max_files\characters\ and the map file is stored locally
in My_Vault\max_files\characters\face_maps\.

Interface

Menu bar

The menu bar provides access to most Asset Tracking functions. Most of the
menu functions are also available from the right-click menu available in the
dialog window.

NOTE If you highlight and then Ctrl+right-click one or more assets all of which
reside in the same directory, a version of the Windows Explorer context menu
opens. This lets you perform such functions as cutting or copying the file, or
sending it to the desktop as a shortcut for easy access.

Server menu

Log in Displays the Vault Log In dialog. Enter your user name, password,
server name, and database, and then click OK. After entering a server name,
you can click the ellipsis (...) button display all available databases and choose
one from the dialog.

Asset Tracking | 7105



You can log in automatically in future sessions without having to use the
Vault Log In dialog if you turn on “Use these settings next session.” This also
turns on Options > “Log in using saved settings.”

The login settings are stored in the file plugcfg\ATSVaultLogin.ini in the program
install folder.

Log out Logs you out of the database.

Options Opens the Vault Options dialog, where you can view the working
folder and specify a new one (click the Change button). Available only when
logged in.

IMPORTANT The working folder is a folder on your local drive that mirrors the
top-level folder of the provider database structure. For further information, see
this procedure on page ?.
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You can log in automatically in future sessions, bypassing the Vault Log In
dialog, if you turn on “Log in using saved settings.” This also turns on Vault
Log In > “Use these settings next session.”

Launch Provider Opens the database client program. This is the same as
running the program from the Start menu. It doesn't necessarily open to the
same database you're using in 3ds Max.

File menu

Most of the File menu commands are available only when you're logged in.

Checkout Lets you check out the highlighted assets in the Asset Tracking
dialog list of assets, if the assets are available for checking out. This opens a
dialog that lets you confirm the checkout, specify whether to replace the local
copies with the checked-out version, and enter a comment.

If you enter a comment, it's copied to the Working Comment dialog on page
7108.

TIP Always be sure to check out an asset before modifying it, even if you have a
writable version on a local drive. This prevents other users from modifying the file
at the same time, and lets you maintain strict version control over the asset.

Checkin Lets you check in the highlighted assets in the Asset Tracking dialog
list of assets. This opens a dialog that lets you confirm the checkin, specify
whether to keep the assets checked out, and enter a comment. Also, if the
assets have been edited but not saved locally, you're prompted to save first.

Checking in an asset increments the current version number of the asset as
stored in the database, and saves the current Comment text along with the
asset.

Undo Checkout Reverses a checkout, setting the highlighted assets' status to
checked in, without saving any changes.

Add Files Lets you add files in the scene, such as bitmaps used in materials,
to the provider database. To add a file, load it (such as a scene file) or add it
to the scene (such as a bitmap used in a material), highlight it in the Asset
Tracking dialog, and then use Add Files.

You can add multiple files at the same time.
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NOTE You cannot add a file that doesn't exist on a local drive, such as an unsaved
scene file. Also, you cannot add a file that's not in the working folder, as specified
via Options on page 7106. For best results, before adding a file, make sure it exists
in a local folder within a structure that mirrors the one in the Vault. For details,
see this procedure on page ?.

Get Latest Downloads the most recent (highest-numbered) version of the
highlighted asset from the database. Use this when a teammate has updated
an asset such as a bitmap.

History Opens a History dialog from which you can get any version of the
highlighted asset. When the dialog opens, highlight the version to get by
clicking it and then click Get Version. You can also right-click the asset and
choose Get Version from the context menu.

Properties Opens a read-only dialog that shows information about the
highlighted asset such as vault and local locations, versions, and check-out
status.

Get From Provider Lets you copy files from the database to the local working
folder. Use the Get Files dialog to navigate to the folder from which to get
files, highlight any number of files, and then click Open. The highlighted files
and any dependent files, such as bitmaps and XRefs, are copied to the local
folder, using the same folder hierarchy as that of the database.

Working Comment Opens a dialog that containing a common text buffer
for the current session.

When you check out a file, any comment you enter in the Asset Tracking
dialog is copied to the Working Comment dialog. You can edit this text at
any point during the session. When you check a file back in, all Working
Comment text appears in the Asset Tracking dialog; you can edit it as necessary
without affecting the original text before completing the check in. The
checked-in comments remain with that version of the file in the Vault.

Browse Lets you browse the local directories for missing files such as bitmaps.
Use the Browse dialog to find the file, and then click Open.

View Image File Opens a window showing the highlighted image file. The
file must be present in a local directory.

Reveal In Explorer Opens a Windows Explorer dialog showing the location
of the highlighted asset.

Custom Dependencies Opens a dialog that lets you specify files to be
dependents of the current scene; files that aren't necessarily present in the
current scene but should be associated with it. On the Custom Dependencies
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dialog, click the Add button and then use the Add Custom Dependencies file
browser to open dependent files.

The Custom Dependencies function lets you associate files that aren’t true
scene dependencies. A true dependent file is required for rendering, animation,
exporting, etc. A custom dependency might be reference art work, a text file
with scene documentation or tasks to accomplish, custom scripts, etc. Basically,
any collection of files that should “travel along” with the scene.

One potential use for a custom dependency is as a way to perform simple
project management. For example, you could add a file called GameTitle-A.txt
as a custom dependency to any scene file associated with GameTitle-A. You
could then instruct the provider client, such as Vault Explorer, to display all
files that are dependent on GameTitle-A.txt, which would give you a list of files
associated with that project.

Refresh Reloads the asset listing from the local scene and updates the window
contents.

Paths menu

The tools on this menu help you resolve file-path issues such as missing files.
They include functionality also available in the Bitmap/Photometric Path
Editor Utility on page 7141, but their integration into the Asset Tracking dialog
helps speed the workflow of managing scene assets.

Highlight Editable Assets Highlights all assets whose paths can be affected
by the remaining commands on this menu.

For example, if your scene materials use bitmaps from a number of different
folders, you could copy all the bitmaps to a common directory within your
working folder, use Highlight Editable Assets to highlight all the bitmap assets,
and then use Set Path (see following) to designate the common directory.

Set Path Opens a dialog for editing the scene's record of the highlighted asset's
or assets' path and, in the case of a single asset, the file name. Both versions
of the dialog include drop-down history lists for reverting to a previous path
or file name.

The primary function for this command is to change the path pointed to by
3ds Max for existing assets whose locations have changed. However, for output
files such as rendered images and render elements, you can also use Set Path
to create and use new output directories. If you change an output path to one
that doesn't exist, you're prompted to confirm that you want to create the
folder(s). if you confirm, the output paths are changed in all appropriate
locations, such as the Render Setup dialog.
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The version of the dialog that appears depends on the number of highlighted
assets:

■ If a single asset is highlighted, you can change the path and the file name.
The following dialog appears.

To change the path, edit the Path field or use the ellipsis [...] button to
browse for a new path. This changes the path only.

To revert to a previous path, choose it from the drop-down list.

To change the file name, edit the File field or choose a name from the
drop-down history list. Note that this changes only the name of the asset
file as pointed to in the scene; it doesn't change the actual asset file name.
Use this to update the scene if the asset file name has changed.

■ If multiple assets are highlighted, you can change the path but not file
names. The following dialog appears.

The dialog shows the portion of the current path that the highlighted
assets and lets you specify a new one, either by editing the Specify Path
field contents or by clicking the ellipsis [...] button and browsing to a
different path.

For example, if two assets are highlighted, and one asset's path is
c:\max_files\maps1\ while the other's is c:\max_files\maps2\, the Specify Path
field will show c:\max_files\. Changing this changes the complete path for
all highlighted assets. Of course, they must all be present there for the
program to find them.

To revert to a previous path, choose it from the drop-down list.
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To change only the portion of the path that all highlighted assets have in
common, use Retarget Common Root (see following).

Retarget Common Root Lets you change only the part of the path that all
highlighted assets have in common. This command opens a version of the
Specify Assets path dialog that shows the common path prefix for the
highlighted assets and lets you specify a new one, either by editing the Specify
New Common Path Prefix field contents or by clicking the ellipsis [...] button
and browsing to a different path. Use Retarget Common Root for repathing
multiple files, particularly those in different directories within the common
root.

For example, if all maps were originally in various subdirectories within
c:\maps\ and the entire subdirectory structure was moved to d:\resources\maps\,
you could repath all files simultaneously using Retarget Common Root.

To revert to a previous path, choose it from the drop-down list.

If you change the common root for output files to a path that doesn't exist,
you're prompted to confirm that you want to create the folder(s). if you
confirm, the output paths are changed in all appropriate locations, such as
the Render Setup dialog.

Strip Path Strips all path information from the highlighted assets, leaving
only the file names.

Stripped path information is saved in the Set Paths dialog drop-down list. To
restore stripped paths, highlight the assets, choose Paths menu > Set Paths,
and then choose the desired path to restore from the drop-down list.

Make Path Absolute Gives the complete path of the found asset file. This is
useful when a relative path is displayed and you want to see the entire path.

Make Path Relative to Project Folder This takes the current path of the found
asset file and makes it relative to your project folder on page 6932.
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Resolve Path to UNC Location Resolves highlighted paths that point to
mapped drives to Universal Naming Convention (UNC) format on page 8160.

Set Project Folder See Set Project Folder on page 6932.

Configure User Paths Opens the Configure User Paths dialog on page 7729,
which you can use to resolve locations for support files such as bitmaps.

NOTE This option makes it simple to share files between different users, even if
you are not using the same project folder. If user A loads a file from user B and
they do not have the same project folder, this will not be a problem.

Preferences Use this submenu to toggle these options:

■ Convert file paths to UNC When on, paths shown in the Asset Tracking
dialog for any added assets present on a mapped drive use Universal
Naming Convention (UNC) format on page 8160. When off, each path starts
with the mapped drive letter (e.g., w:\).
This switch is linked to the Convert file paths to UNC on page 7750 switch
on the Preferences dialog > Files panel. Toggling either one toggles both.

NOTE This switch affects only newly added paths. Toggling it has no effect
on existing paths. For example, if you add an asset from a mapped drive with
the switch on, turning it off does not change the path to the mapped version.

■ Convert local file paths to Relative When on, converts the file paths of
all newly added assets in a scene so that they are relative to the project
folder. Default=off.
This switch is linked to the Convert local paths to Relative on page 7751
switch on the Preferences dialog > Files panel. Toggling either one toggles
both.

Proxies menu

The Proxy system lets you determine how 3ds Max should create and use
proxy versions of bitmaps incorporated in materials. Proxies are intended for
use primarily in the viewports when building and editing scenes to reduce
the amount of memory required by the bitmapped textures, but you can also
use them at render time.

Enable Proxy System Toggles the Proxy system globally. When on, 3ds Max
replaces all bitmaps used in materials with proxies as specified on the Bitmap
Proxies dialog on page 7115. When off, the original bitmaps are used.

Global Settings Opens the Bitmap Proxies dialog on page 7115.
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Set Proxy Resolution Opens the Per-Bitmap version of the Bitmap Proxies
dialog on page 7115 for setting the resolution for proxies of only those bitmap
assets highlighted in the Asset Tracking dialog. Available only when one or
more bitmap assets are highlighted.

Generate Selected/Stale Proxies Generates the proxy image files as specified.
When one or more image assets are highlighted in the Asset Tracking dialog
list, the command is Generate Selected Proxies, and applies only to those
assets. When no asset is highlighted, the command is Generate Stale Proxies,
and applies to all assets whose settings, such as proxy resolution, have changed
since the previous generation, as well as any assets whose proxies are missing.

Options menu

Disable Asset Tracking Turns off asset-tracking functionality. Choosing this
command logs you out of the database and makes most asset-tracking functions
unavailable. To restore asset tracking, turn off Disable Asset Tracking and then
log back in.

Prompts Opens the Prompts dialog on page 7118, which lets you toggle two
different options for each of various actions in the Asset Tracking dialog:
actions and prompts.

Auto Login Logs you in to the Vault, if necessary, whenever you cause a MAX
scene file to be present in memory; for example when you load or save a scene.
You can bypass the Vault Log In dialog If you've turned on Options dialog >
“Log in using saved settings” or Vault Log In > “Use these settings next
session.”

Display Excluded Files Displays files that are set to Excluded status. When
off, these files aren't shown in the dialog window. For information about
excluding files, see Filtering Files on page 7101. You can also set output files to
Excluded status; see following.

Exclude Output Files Sets output files such as rendered images to Excluded
status; you can prevent the dialog from displaying such files by turning off
Display Excluded Files (see preceding).

Tree View Displays a simplified, hierarchical listing of the assets in the current
scene. You can expand and collapse hierarchy branches by clicking the + and
- icons to the left of the branch names.

Table View Displays listing of the assets in the current scene in tabular format
along with the full path and for the local version of each asset. The branches
are hierarchical, but cannot be expanded or collapsed.
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Toolbar

Refresh Reloads the asset listing from the local scene and updates the window
contents.

Status Log Opens a read-only window showing all status messages received
from the Vault during the current session.

Tree View Displays a simplified, hierarchical listing of the assets in the current
scene without path or status information. You can expand and collapse
hierarchy branches by clicking the + and - icons to the left of the branch
names.

Table View Displays listing of the assets in the current scene in tabular format
along with the full path and status for the local version of each asset. The
branches are hierarchical, but cannot be expanded or collapsed.

Folders

[folders] If the system administrator created files folders in Autodesk Vault,
they appear in the Asset Tracking dialog and help you maintain organization
of files.

[library folders] If your system administrator set library folders up in Autodesk
Vault, they appear in the Asset Tracking dialog. The system administrator sets
these folders up on the network and they can act as multiple network
workspaces for a team. Your team can use them to organize different types of
files. For example, you may have a library folder for materials, for maps, for
animations, and so on. Since these library folders are stored on the network,
files that are shared between team members can reside on the network at all
times, rather than on a user's local workspace. Library folders can also be used
to protect files because the system administrator can set up read/write
permissions so that only certain users can make changes to files. See your
system administrator for further details.

NOTE A regular folder looks the same as a library folder from the Asset Tracking
dialog. Different icons distinguish the two types of folders inside Autodesk Vault.
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[window]

Left: Asset Tracking dialog window in Tree View

Rightt: Asset Tracking dialog window in Table View

The Asset Tracking dialog window lists all assets in the current scene in a tree
or table view, depending on the current setting. Listed assets include the scene
file, any images used by the scene in materials, etc., XRefs, and photometric
files. By default, output files such as rendered images also appear in the window
listing; you can turn off on page 7113 display of these if you wish.

Also shown are icons for each assets showing the type of asset (3ds Max scene
file, map branch, etc.) and status, as appropriate. Most status icons are
documented in the Vault Explorer Help > Autodesk Vault Explorer Icon
Reference topic. For a reference to the most common icons, see Asset Tracking
Dialog Icons on page 7119.

NOTE No status icons appear if you don't have any version-control provider
installed.

In general, status errors can be resolved by being careful to coordinate the
local folder/file structure with that of the Vault, as described in the above
procedure.

You can access most dialog commands by right-clicking an asset in the window;
the commands applicable to the asset are available in the context menu. These
commands are the same as those documented above.

Global Settings and Defaults for Bitmap Proxies
Dialog

Render Setup dialog > Common panel > Common Parameters rollout > Bitmap
Proxies group > Setup
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Asset Tracking dialog > Proxies menu > Global Settings

Asset Tracking dialog > Highlight bitmap asset(s). > Proxies menu > Set Proxy
Resolution

Asset Tracking dialog > Right-click a bitmap asset. > Set Proxy Resolution

This dialog lets you determine how 3ds Max should create and use proxy
versions of bitmaps incorporated in materials. Proxies are intended for use
primarily in the viewports when building and editing scenes to reduce the
amount of memory required by the bitmapped textures, but you can also use
them at render time.

NOTE When you open this dialog using either of the Set Proxy Resolution
commands cited at the top of this topic, the title changes to Per-Bitmap Resolution
for Bitmap Proxies, the Enable Proxy System check box changes to Use Global
Settings, and you can set only the proxy resolution on page 7117.

Interface

Proxy Resolution group

The label and function of the first check box on the dialog depends on whether
you invoked it with Setup/Global Settings command or Set Proxy Resolution:

■ Enable Proxy System Toggles usage of the proxy system. When off, 3ds
Max uses only the original, full-resolution maps. Available only on the
Global version of the dialog (see note on page 7116).
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■ Use Global Settings When on, the proxy system applies the same settings
to all bitmaps subject to proxy substitution, as set via the Global version
of the dialog (see note on page 7116). When off, use the Downscale Map ...
setting (see following) to specify resolution only for bitmaps highlighted
before invoking Set Proxy Resolution. Available only on the Per-Bitmap
version of the dialog.

Downscale map to ... original size. Use the drop-down list to choose the
fraction to which the proxy system reduces the bitmap(s): Full (no reduction),
Half, Third, Quarter, or Eighth. The greater the reduction, the greater the
memory savings and speed improvement, especially in a scene with many
maps, but the less recognizable the map.

Proxy System group

These settings are available only when you open the dialog using the Setup
or Global Settings commands cited at the top of this topic.

Use proxy only if the original map's largest dimension is greater than ...
pixels. Lets you indicate that bitmaps smaller than the size you specify are
not to be reduced. Downscaling smaller maps isn't particularly efficient or
useful.

To ensure that the system creates proxies for all bitmaps, set this to 0.

Render Mode Lets you determine whether to use the proxies at render time.
The options, available from the drop-down list, are self-descriptive:

■ Render with Proxies (High Performance, Low Memory)

■ Render with Full Resolution Images and Keep them In Memory (High
Performance, High Memory)

■ Render with Full Resolution Images and Free them from Memory (Low
Performance, Low Memory)

Proxy Cache Folder This read-only field displays the path in which 3ds Max
stores proxy bitmap files. To change the path, go to Configure User Paths >
File I/O on page 7733 and edit the BitmapProxies entry.

OK, Generate Proxies Now Generates proxy bitmaps as specified by the dialog
settings and closes the dialog.

OK, Generate Proxies Later Saves the dialog settings and closes the dialog
but does not generate proxy bitmaps. You must generate the proxies manually
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using the Generate Selected/Stale Proxies command on page 7113 from the Asset
Tracking dialog.

Cancel Closes the dialog without saving any changed settings.

Prompts Dialog

File menu > Asset Tracking > Asset Tracking dialog > Options menu > Prompts

The Prompts dialog lets you specify what happens when you perform a number
of different functions via the Asset Tracking dialog on page 7100. For each
message, you can choose an action and toggle the prompt using a right-click
menu. If you turn off the prompt, the option you set on the top part of the
menu takes place automatically.

Procedures

To set prompts for asset tracking:

1 From the Asset Tracking dialog > Options menu, choose Prompts.
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2 Right-click the message to set prompts for.

The right-click menu shows check marks next to the active settings. For
each message, you have two options:

■ Yes/No or Ok/Cancel

■ Prompt/No Prompt

3 Change the options to suit your preferences.

For example, if you know that you always want to keep files checked out
that you add to the vault, set the option “When adding files, keep files
checked out?” to Yes and No Prompt.

The changed settings are saved with the program.

Asset Tracking Dialog Icons

The Asset Tracking dialog on page 7100 uses a number of icons to indicate the
status of assets listed in the dialog window. The following table lists these
icons and describes their functions:

MeaningIcon

If no icon is displayed, the file is under ver-
sion control, but you do not have a local
copy of the file on your computer.

File is under version control and available
to be checked out. The version in your
working folder is the same as in the pro-
vider. Also referred to as the Latest Version.

File is under version control and available
to be checked out, but the local version is
newer than the latest version. This typically
means that your local file was changed
without checking it out.

File is under version control and available
to be checked out, but the local copy is out
of date.
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MeaningIcon

File is checked out to you and the local ver-
sion is the latest.

File is checked out to you and the local copy
is newer than the latest version. This typic-
ally means that you made changes to the
file since it was checked out but have not
checked it back in.

File is checked out by someone else, and
the local copy is the same as on the pro-
vider. Also referred to as the Latest Version.

File is checked out to someone else, but the
local copy is newer than the latest version.

File is checked out to someone else, but the
local copy is older than the latest version.

File is checked out by someone else in a
setup where the working folder is shared
and the local copy is the same as on the
provider.

File is checked out by someone else in a
setup where the working folder is shared
on the network, but the local copy is newer
than the latest version.

File is checked out by someone else in a
setup where the working folder is shared
on the network, and the local copy is older
than the latest version.
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MeaningIcon

Status for the file could not be obtained.
This typically means you are not logged into
the provider.

The file is not under version control.

You are not logged in to the provider.

You are logged in to the provider.

Archive

File menu > Archive

Archive creates a compressed archive file or a text file listing the scene bitmaps
and their path names.

3ds Max automatically finds the files referenced in the scene and creates the
archive file in the executables folder. During the archiving process, a log
window is displayed.

Compressed archive files are created using an external program. You specify
the name and location of the archive program on page 7750 you want to use in
the Files tab of the Preferences dialog.

Procedures

To set up an external archive program:

1 Choose Customize > Preferences.

2 Click the Files tab to display the Files panel.
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3 In the Archive System group, enter the full path and executable file name,
and any command-line option you want for your external archive program
in the Program field.

To archive a file:

1 Choose File > Archive > Archive.

2 Enter a name for the archive in the File Name field.

Include the appropriate file extension (for example .zip).

3 Choose a file type: 3ds Max Archive or List Of Files.

■ To create an archive file, choose 3ds Max Archive in the Save As Type
list. The archive file contains the scene plus all bitmaps used for the
scene, including Video Post bitmaps.

■ To create a text file, choose List Of Files (*.txt) in the Save As Type
list. The resulting file is an ASCII list of scene files.

Summary Info

File menu > Summary Info

Summary Info displays statistics about the current scene.
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Interface

The Summary Info dialog includes the following information:

Scene Totals Number of objects in your scene listed by type.

Mesh Totals Total number of vertices and faces in the scene.

Memory Usage Physical and virtual memory used and available.

Rendering Time spent rendering the last frame, animation, and video post.

Description Lets you enter notes about the scene. Information that you add
to the Comments field on the File Properties dialog on page 7124 will appear in
the Description field and vice-versa.

Summary Info Lists materials in the scene. The information is sorted by
category and includes object name, assigned material name, type of material,
object vertex and face counts, and so on. Materials are listed at the bottom of
the list. Bitmaps used by the materials are listed with the materials.
Environmental and atmospheric maps are listed separately. The Other Maps
category lists all other maps used in the scene, such as Displace maps, and
any maps assigned by third-party plug-ins.

Video Post maps are not included.

The buttons at the bottom of the Summary Info dialog have the following
functions:
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Save to File Saves the contents of the dialog and descriptive text to a .txt (text)
file.

Plug-In Info Displays a subdialog with information about the plug-ins on
page 8092 used in the scene. By default, the subdialog shows the name and a
brief description of each plug-in.

Show Details Shows information about all of the classes supported by each
plug-in.

Show Used Only Restricts the view to only those plug-ins that have been
used in the scene.

File Properties

File menu > File Properties

File Properties allows you to enter information about a scene that can later be
read by Windows NT 4.0 or later and Windows 98 or later, using a program
such as Windows Explorer to view the properties of the scene file.

This information can also be used to locate scene files with the File Finder
utility on page 7143.

The Properties dialog comprises three tabs:

■ The Summary panel displays predefined fields that are commonly used.

■ The Contents panel displays scene information available after the scene
had been saved.

■ The Custom panel enables you to create new fields that can also be used
by the File Finder utility.
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Interface

Summary panel

Summary provides fields for entering information related to the saved scene.
Many commonly used fields are available from the Summary tab. If there is
a field you would like that is not represented in the Summary tab you can use
the Custom tab to define new fields for information.

Title Enter the title of your scene or animation here.

Subject Enter the subject of your scene or animation here.

Author Enter the author of your scene or animation here.
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Manager Enter the manager of your scene or animation here.

Company Enter the name of your company here.

Category Enter the category of your scene or animation here.

Keywords Enter keywords that identify your scene here.

Comments Enter personal comments here. Information that you add to the
Description field on the Summary Info dialog on page 7122 will appear in the
Comments field and vice-versa.

Contents panel

When a scene is saved, a summary list of everything contained in the scene
is generated and displayed in the Contents tab. If a scene has not been saved,
the Contents tab remains empty.

NOTE There is currently a bug in Windows NT 4.0 that causes the information in
the Contents tab to look garbled when you view a MAX file in Windows Explorer.
The problem has been corrected in Windows 98. Although the information looks
garbled, it is internally correct and the File Finder utility can still read it.

Custom panel

The Custom panel lets you create custom fields. Custom is useful when there
is more information that needs to be entered into the properties of a scene
but there is no field or no room in the Summary panel.

Name Enter the name of a custom field. You can manually enter anything
you want into the Name field. A drop-down list provides commonly used field
types.

Type Specifies the type of information to be entered into the Value field:
choose from Text, Date, Number, and Yes or No. This dictates the type of
information to be entered into the Value field.

Value Enter the data here.

Add Adds the Custom properties entered into the Name, Type, and Value
fields to the Properties list.

Delete Removes a selected Custom property from the Properties list.

Properties Displays all Custom properties entered into the scene.
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View Image File

File menu > View Image File

Choose and view still images, numbered image sequences, images in an IFL
file on page 7339, or animation files using options in the View File dialog. Still
images and numbered image sequences appear in a feature-reduced version
of the Rendered Frame Window on page 6073.

If you choose an IFL file in the file dialog, the Info button displays the contents
of the text file in Windows Notepad.

You can zoom in and out and pan the image. If you have a wheel mouse, you
can use its wheel button to zoom and pan. See the following procedures.

If you choose an animation file (AVI on page 7326 or QuickTime MOV on page
7348), the software starts the Windows Media Player so that you can play it. The
Media Player has its own Help system.

Procedures

To view a file:

1 Choose File > View Image File.

2 Choose a file type from the Files of Type list.

3 Choose a file to view.

NOTE The View File dialog uses the last location where a file was chosen,
rather than the default Images path defined on the Configure User Paths
dialog.

To zoom in the Rendered Frame Window:

■ Press Ctrl and click.

■ Using a wheel mouse, roll the wheel forward (away from you).

To zoom out in the Rendered Frame Window:

■ Press Ctrl and right-click.

■ Using a wheel mouse, roll the wheel backward (towards you).
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To pan the Rendered Frame Window:

■ Press Shift and drag.

■ Using a wheel mouse, drag with the wheel button held down. (You can
use any three-button device to pan the image.)

Interface

History Whenever an image is selected, the path used is added to the top of
the history list as the most recently used path.

File selections from other areas of the interface, such as Views > Viewport
Background, are stored here also. The history information is saved in the
3dsmax.ini on page 83 file.
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Look In Browses drives and directories.

File Name Displays the name of the selected file.

Files of type Selects the type of files to list in the directory window.

Devices Lets you choose the hardware output device, for example, a digital
video recorder. To use the output device, the device, along with its driver, and
its plug-in must all be installed on your system.

Setup This is unavailable in View Image File.

This option is available only in file dialogs like the Render Output File dialog
or the Viewport Background dialog. Displays a dialog to specify image attributes
for saved files or, in the Select Background Image dialog, the arguments for
creating an IFL file.

Info Displays image information.

View View the selected image or animation.

Gamma group

Selects the type of gamma to be used for the selected file. Available only when
Enable Gamma Selection is turned on in the Gamma panel on page 7758.

Use Image’s Own Gamma Uses the gamma of the incoming bitmap.

Use System Default Gamma Ignores the image’s own gamma and uses the
system default gamma instead, as set in the Gamma panel on page 7758.

Override Defines a new gamma for the bitmap that is neither the image’s
own, nor the system default.

Sequence This is unavailable in View Image File. This option is available in
the Views > Viewport Background > Files > Select Background Image dialog
on page 156. It is used in conjunction with Setup to create IFL files.

Preview Toggle the image preview display.

Preview Window Displays the selected image.

Displays file statistics and the file's full directory path.

Exit

File menu > Exit
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Exit closes 3ds Max. If you have unsaved work, you'll be asked if you want to
save it.

Procedures

To exit the program:

1 Choose File > Exit.

2 Click the Yes, No, or Cancel button.

If you click Yes the scene is saved, if you click No the scene is not saved,
if you click Cancel the Exit operation is canceled.

NOTE You can also click the Close button (the X) in the upper-right corner
of the 3ds Max window to exit.

Missing External Files Dialog

This dialog appears when you attempt to open or render a scene with bitmaps
on page 7926 or photometric files (IES on page 5034, CIBSE on page 7935, LTLI on
page 8029) whose path is no longer current. This can happen if the bitmaps
have been moved or deleted, or if the scene has been placed on a system with
a different drive mapping than the system on which it was created.

See also:

■ External Path Configuration on page 7735

■ Bitmap / Photometric Path Editor Dialog on page 7156

Interface

Two slightly different versions of the dialog exist: One appears when you load
a scene that references missing files, and the other appears when you attempt
to render such a scene.
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Top: This dialog appears at load time.

Bottom: This dialog appears at render time.

[List of external files] Lists the bitmaps or photometric files that cannot be
located, along with their path names.

Continue Opens or renders the file anyway, without loading the missing
bitmaps or photometric files.
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If you continue rendering the scene, the bitmaps do not appear, or the lights
assigned missing photometric files will render using the default isotropic
distribution.

Cancel Cancels the render. This button appears only at render time.

Browse Displays a Configure External File Paths dialog, to let you add the
missing files' paths to the search sequence. This dialog has the same controls
as the Configure User Paths dialog > Configure External Files Paths panel on
page 7735 .

Don't Display This Message at Render Time Appears only when loading a
scene with missing files. When on, the program does not display this dialog
if you render the scene without resolving the missing files.

Don't Display This Message Appears only at render time. When on, the
software does not display the dialog the next time external files cannot be
found.

File-Handling Utilities

Asset Browser Utility

Utilities panel > Utilities rollout > Asset Browser button

The Asset Browser provides access from your desktop to design content on
the World Wide Web. From within the Browser you can browse the Internet
for texture samples and product models. This includes bitmap textures (BMP,
JPG, GIF, TIF, and TGA), or geometry files (MAX, DWG, and so on). You can
drag these samples and models into your scene for immediate visualization
and presentation. You can use the Ctrl key to drag geometry into predefined
locations. You can also use the Asset Browser to browse thumbnail displays
of bitmap textures and geometry files on your hard disk or shared network
drives. Then you can either view them or drag them into your scene or into
valid map buttons or slots.

NOTE The thumbnail display of a geometry file is a bitmap representation of a
view of the geometry. Since the thumbnail display is not a vector-based
representation, you can't rotate it or perform zooms on it.

You can drag most graphic images that are embedded in a Web page into your
scene. The exception is images or regions of a Web page that are tagged as
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hyperlinks or other HTML controls (such as when a bitmap is tagged as a
button with hypertext links).

IMPORTANT Downloaded content might be subject to use restrictions or license
of site owner. User is responsible for obtaining all content license rights.

Drag and Drop

You can assign files represented by the thumbnail images by dragging the
thumbnails over various parts of the Asset Browser or the 3ds Max user
interface. There are three basic methods of using drag in the Asset Browser :

Local Drag and Drop: You can drag thumbnails to the directory tree, and you
can copy or move files from one directory to another. As the default, when
you drag to a folder within the same partition or device, you perform a move.
If you drag beyond the current partition or device (to another drive, for
example), you perform a copy. If you hold down the Ctrl key, you perform a
copy regardless of the destination. If you hold down the Shift key, you perform
a move. You can manipulate bitmap, 3ds Max scene, and DWG thumbnails
in this way.

Bitmap Drag and Drop: You can drag the thumbnails that represent bitmap
files to any bitmap or map slot in the interface or onto any object in a viewport.
You can also drag the thumbnails into the viewport background. When you
drag a bitmap onto an object, the program creates a new standard material
with the bitmap as the diffuse map and assigns the material to that object.

Scene Drag and Drop: You can drag the thumbnails representing .max scene
files directly over an active viewport to merge the scene with the current scene.
When you drag the thumbnail over the active viewport and release the mouse,
the objects in the file appear attached to the mouse. Place them where you
want them, and then click the mouse. Choose from the menu whether you
want to open the file, merge the file to the current scene, or XRef the file. To
cancel, you can select from the menu, or right-click. If you hold down the
Ctrl key, and drag the thumbnail over the active viewport, when you release
the mouse button the objects in the dragged file will snap into their old
location in their original file.

TIP When you drop scene files into your current scene, you can use AutoGrid on
page 2597 to position the geometry file on an object.
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Procedures

To drag scene files from the World Wide Web:

1 In the Address bar, enter the URL of the scene files on the World Wide
Web.

2 Select the thumbnail of the scene file with your mouse and drag it over
the active viewport.

The Internet Download dialog on page 7153 appears.

3 If you want objects placed in the viewport automatically, then in the
Options group, turn off Place Objects When Download Completes.

4 If you skipped step 3 (that is, if Place Objects When Download Completes
is still on), then when you release the mouse, the objects in the file appear
attached to the mouse. Place them where you want them, and then click
the mouse. Choose from the menu whether you want to open the file,
merge the file to the current scene, or XRef the file. To cancel, you can
select from the menu, or right-click. If you hold down the Ctrl key when
you drag the thumbnail, the objects in the file are placed at the world
space origin of the current scene.

To drag thumbnails to the directory tree:

1 In the Asset Browser directory tree, make sure the place you want to copy
or move the thumbnail to is visible.

2 Select the thumbnail with your mouse and drag it to the directory tree
destination.

3 As a default, if you drag to a folder within the same partition or device,
a move is performed. If you drag beyond the current partition or device
(to another drive, for example), a copy is performed. If you hold the Ctrl
key down, a copy is performed, regardless of the destination. If you hold
the Shift key down, a move is performed.

To drag bitmaps onto a map slot in the Material Editor:

1 Open the Material Editor and click the Maps rollout.

2 Open the Asset Browser and select the thumbnail of a bitmap with your
mouse.

3 Drag the thumbnail to the map button of your choice on the Material
Editor Maps rollout.
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This assigns the bitmap as a map type for use in the Material Editor.

To drag a bitmap onto an object in a viewport:

1 Select a thumbnail of the bitmap with your mouse and drag it onto an
object in a viewport.

NOTE If you miss the object, the bitmap becomes the viewport background
image.

The Bitmap Viewport Drop dialog is displayed:

A viewport background Puts the bitmap into the viewport as a
background.

An environment map Includes the bitmap when you render the
viewport.

2 A new standard material is created. The bitmap is assigned to its diffuse
component, and the new material is applied to that object.

To drag scene files from a local or shared disk:

1 From the Asset Browser's menu bar, choose Filter and then a geometry
filter such as All Geometry, Importable Files, or 3ds Max Files.

2 Select the thumbnail of the geometry file with your mouse and drag it
over a viewport.
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3 When you drag the thumbnail over the active viewport and release the
mouse, the merged objects appear attached to the mouse. Place them
where you want them, and then click the mouse. Choose from the menu
whether you want to open the file, merge the file to the current scene,
or XRef the file. To cancel, you can select from the menu, or right-click.
If you hold down the Ctrl key when you drag the thumbnail, the objects
in the file are placed at the world space origin of the current scene.

Interface

When you first start the Asset Browser, a window appears displaying the home
page that is installed locally on your computer system.

NOTE You can't change the home page on page 7140 for the Asset Browser.

Each subsequent time that you start the Asset Browser, it displays what was
displayed last in the previous Asset Browser session.

The Asset Browser window contains:

■ A menu bar on page 7136.

■ A toolbar on page 7140.

■ An address bar on page 7141.

■ A pane on the left displaying your computer system's directory hierarchy.

■ A pane on the right displaying a Web page, thumbnails, or an Explorer
view of file names.

At the bottom of the window, there is also a tabbed favorites bar on page 7141
(by default, it first contains a Startup button) and a status bar on page 7139.

Asset Browser menu bar

Contains the menus for the Asset Browser.

File menu

Contains commands for managing files.

Preferences Displays the Preferences dialog on page 7151, with which you can
manage the cache directory and control drag-and-drop operations.

Properties Displays information about the file of the selected thumbnail.
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Show Image Displays the currently selected bitmap thumbnail in a Rendered
Frame Window on page 6073. You can also double-click a thumbnail. This does
not work for geometry thumbnails.

Print Prints the page displayed in the Web pane. Print is available only when
a Web page is displayed.

Exit Closes the Asset Browser window.

Filter menu

Filters the display of thumbnails according to the category or file type you
select.

All images Displays thumbnails of all supported bitmap files, such as BMP,
JPG, GIF, TIF, and TGA.

All geometry Displays thumbnails of all supported geometry files, such as
DWG and MAX.

All in cache Displays thumbnails of all images stored in your cache directory.
When turned on, the left pane displaying the directory tree goes away, and
the thumbnails you see might be in various directories. Because the thumbnails
point to the correct directories, you can still use them to access the files and
display or drag them to areas in the 3ds Max user interface.

IMPORTANT If a file has been subsequently renamed, deleted, or moved from
the directory it was in when its thumbnail was first created, then the thumbnail
represents only the thumbnail bitmap itself. If you assign that image to a map slot
in the software, you'll be assigning the thumbnail bitmap rather than the original
image.

All files (*.*) Displays thumbnails for all files.

See the following topics for information on the file types listed on the Filter
menu:

AutoCAD DWG Files on page 7958

IGES Files on page 8008

AVI Animation File on page 7326

BMP Image File on page 7328

Kodak Cineon on page 7328

CWS (Combustion Workspace) Files on page 7329

GIF Image File on page 7334

Radiance Image File (HDRI) on page 7334
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IFL Image File on page 7339

JPEG File on page 7347

PNG Image File on page 7360

Adobe PSD File Reader on page 7361

MOV QuickTime File on page 7348

MPEG Files on page 7348

SGI's Image File Format on page 7369

RLA Image File on page 7364

RPF Image File on page 7366

Targa Image File on page 7370

TIF Image File on page 7372

YUV Image File on page 7374

Thumbnails menu

Sorts and sets the size of the displayed thumbnails.

Create Thumbnails Creates thumbnails for bitmap and geometry files.

Sort by Name Sorts by file names.

Sort by Type Sorts by file extensions.

Sort by Size Sorts by file size.

Sort by Date Sorts by file creation date.

Large (200X200) Sets the size to large (200 by 200 pixels).

Medium (100X100) Sets the size to medium (100 by 100 pixels).

Small (50X50) Sets the size to small (50 by 50 pixels).

Display menu

Controls the display of:

■ The left pane, where the directory tree displays your computer system's
folders.

■ The right pane, which can display files as thumbnails (a Thumbnail pane),
or Web pages (a Web pane).

■ The Favorites and status bars located at the bottom of the Asset Browser
window.
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■ Any available manufacturer data in the Product Information dialog that
appears over the right pane.

Directory Tree Turns the directory tree in the left pane on or off. The directory
tree displays the available directories on your system. You can navigate and
select the directories where you want to view images. When you select and
enter a directory containing valid bitmaps, the Browser displays their
thumbnails in the Thumbnail pane to the right. Right-clicking in the directory
tree pane displays a menu allowing you to change directories, delete directories,
and add a directory to your Favorites list.

TIP To refresh the contents of the directory tree, press Shift+F5.

Favorites Bar Turns the Favorites bar on or off. The Favorites bar is located
at the bottom of the Asset Browser window.

Status Bar Turns the status bar on or off. The status bar is located at the bottom
of the Asset Browser window.

Thumbnail Pane Displays valid bitmaps and geometry files of a selected
directory as thumbnails in the right pane.

Thumbnail bitmaps for MAXScript files (.ms, .mcr, and .mse), dropScript files
(.ds), and zipped script files (.mzp) display in the Thumbnail pane. By
right-clicking the thumbnail, you can view the file, look at its properties, run
the script, or open it in the Web Pane. By double-clicking the thumbnails for
.ms, .mcr, and .ds files, you can open them in the MAXScript editor window.
Double-clicking .mzp files will open them in the associated zip utility.

Explorer Pane Displays valid bitmaps and geometry files of a selected directory
as file name icons in the right pane. This is similar to how Windows displays
file name icons in the Explorer.

Web Pane If there's a file named maxindex.htm in the selected directory, the
program displays it as a Web page in the right pane. You can use the .htm file
to display selected bitmaps as a Web page. Also if you enter a URL in the
address bar, the program displays the page in this pane.

Favorites menu

Adds and deletes Web sites and path names to the Favorites menu and the
Favorites bar.

Add to Favorites Displays the Favorite Location dialog on page 7155.
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Delete All Favorites Removes all Web site and path name shortcuts from the
Favorites menu and the Favorites bar.

Browse menu

Allows you to refresh thumbnails and Web pages, to move forward and
backward between recently viewed Web pages, to return to your home page,
and to stop loading a Web page.

Refresh For a Thumbnail pane, rereads the directory and redraws the
thumbnails. For a Web pane, rereads the URL and redisplays the Web page.

Forward For a Web pane, displays a Web page you viewed before clicking the
Back button.

Back Returns to the last Web page viewed in the Web pane.

Home Returns to the local copy of the home page that is installed on your
computer system. This is the page that displays when you first start the Asset
Browser.

Stop Stops loading a Web page. Use this button when a page you're trying to
view takes too long to load.

Toolbar

The buttons on the toolbar provide some of the same functions as the menu
items on the menu bar.

Back to previous page Returns to the last Web page viewed in the Web
pane.

 Forward to next page Displays a Web page you viewed before clicking
Back to previous page.

 Stop Stops loading a Web page. Use this button when a page you're
trying to view takes too long to load.

 Refresh content For a Thumbnail pane, rereads the directory and redraws
the thumbnails. For a Web pane, rereads the URL and redisplays the Web
page.
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 Homepage Returns to local copy of the Browser home page that is
installed on your computer system. This is the page that displays when you
first start the Asset Browser.

 Add to Favorites Bar Displays the Favorite Location dialog that allows
you to add Web sites and path names to the Favorites menu and the Favorites
bar. When you want to open that page or view the files from a path name,
you can click the appropriate shortcut button from the Favorites bar, or click
the appropriate menu item from the Favorites menu

Address Displays the current path name or URL. Clicking the history arrow
at the right end of the address bar displays a list of recently viewed sites. You
can select one of these to return to that site.

Favorites Bar

The Favorites bar is at the bottom of the Asset Browser window. It displays
tabbed buttons for the startup page and for any shortcuts to directories and
Web pages that you added to your favorites list. Right-clicking over a favorites
tab that you've added displays a menu that you can use to modify on page
7155 or delete the favorites.

Startup Returns to the directory or Web page where the Asset Browser started
in the current session.

Status Bar

The status bar is under the Favorites bar at the bottom of the Asset Browser
window. The bar is divided into three sections. The first section displays a
progress meter when the program loads thumbnails. The second section
displays the current filter selection (such as "All in cache"). The third section
displays messages, file names, or Web page shortcut labels when you move
your cursor over such items.

Bitmap/Photometric Path Editor Utility

Utilities panel > Utilities rollout > More button > Utilities dialog >
Bitmap/Photometric Path Editor
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The Bitmap/Photometric Path Editor lets you change or remove the paths of
bitmaps on page 7926 and photometric distribution files (IES) used in the scene.
It also lets you see which objects use a resource in question.

By default, 3ds Max stores a path with the name of the files it references. This
can be a problem when you share scenes among different users. Another user
might have the same scene and resources, in the same directory structure, but
on a different disk drive; this will cause the scene to "lose" the resources.

Removing paths from resource references eliminates this problem. When paths
are not saved with the resource file, they are searched for in these directories:

1 The directory of the current scene.

2 The paths listed in the External Files panel on page 7735, starting at the
top of the list.

Removing paths from bitmap and photometric references can be useful for
network rendering on page 6433 as well.

See also:

■ Asset Browser Utility on page 7132

■ Configure Paths on page 7728

■ Resource Collector Utility on page 7145

Interface

Edit Resources Click to display the Bitmap/Photometric Path Editor dialog
on page 7156. Most of this utility's functionality is provided by this dialog.
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Include Materials Editor When on, the Bitmap Path Editor dialog shows
materials in the Material Editor, as well as those assigned to objects in the
scene. Default=on.

Include Material Library When on, the Bitmap Path Editor dialog shows
materials in the current material library, as well as those assigned to objects
in the scene. Default=off.

Close Click to close this utility.

MAX File Finder Utility

Utilities panel > Utilities rollout > More button > Utilities dialog >MAX File
Finder

Run maxfind.exe in the 3ds Max root directory.

The MAX File Finder utility lets you search for MAX files containing specific
properties, for example:

■ Search the hard drive for all MAX files containing the "Pink Carpet"
material.

■ Search the 3ds Max program directory and below for all MAX files using
the raymtl.dlt plug-in.

■ Search the c:\Program Files\Autodesk\VIZ2008 directory and below for all
MAX files using the raymtl.dlt plug-in.

The utility comes in two formats: a standard utility, and a standalone
executable. Both work identically.

File Finder demonstrates how to read a MAX file's properties from an external
application. These properties include predetermined data such as object and
plug-in names, plus information you provide via the File menu > Properties
dialog. You can also view this data from outside the software with Windows
Explorer or an equivalent program by viewing a file's properties.

TIP You can combine this tool with the powers of the Properties dialogs. If you
have a team of animators, you can have the individual animators use the File menu
> Properties dialog to create Categories, Keywords and Comments that you can
search for using the File Finder. They can also use the Contents and Custom Tabs
as well. All are searchable using the Finder.
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You can also create similar structures at the Object level. The Object Properties
dialog on page 305 has a User Defined tab to enter any properties you like, and
use that to organize your projects.

Interface

File menu

Reset Clears the list box of any files previously found.

Exit Exits the application
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Help menu

About Displays something fun to play with while Finder is searching for files.
The search continues in the background while this dialog is active.

Program window

Search Text Specifies the text to search for. If you leave the field empty, all
files that contain the specified property will be found.

File Spec Specifies which file types to search through. The predefined file type
is *.max. You can enter a different file type, such as *.dwg. To search through
all files, use *.*.

The currently selected item in this list is restored the next time you run Finder.

Property Specifies the property you want to search for. Use All to search for
any property.

Start Activates the search. During a search, the button title switches to Cancel.
Click Cancel to abort the search.

Browse Specifies the directory for the search, using the standard Windows
Browse for Folder dialog.

Include Subfolders When on, Finder searches the current directory and all
subdirectories. When off, only the current directory is searched.

File List Lists all files that were found and match the current search criteria.

Double-click a found file in this list to display the property viewer for the file.
The information presented in this dialog is the same that is displayed with
File menu > Properties inside the software. Use the << and >> buttons to step
to the previous or the next file in the found list.

While in the property viewer, the search continues in the background.

Resource Collector Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Resource
Collector

The Resource Collector gathers the resource files used by a scene (bitmaps on
page 7926, photometric distribution files (IES), and optionally, the scene itself
into a single directory.
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WARNING The Resource Collector does not collect maps used for displacement
mapping or as light projections.

See also:

■ Bitmap/Photometric Path Editor Utility on page 7141

Interface

Output Path Displays the current output path. This can be changed using
the Browse button.

Browse Click to display a Windows file dialog that lets you choose the output
path.
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Resource Options group

Collect Bitmaps/Photometric Files When on, the Resource Collector places
the scene's bitmaps, and photometric files, in the output directory. Default=on.

Include MAX File When on, the Resource Collector places the scene itself
(the .max file) in the output directory. Default=off.

Compress Files When on, compresses the files into a ZIP file, saved in the
output directory. Default=off.

Copy or Move Choose Copy to make a copy of the files in the output directory.
Choose Move to move the files (they are deleted from the directory in which
they originally were saved). Default=Copy.

Update Materials When on, updates material paths. Default=off.

Begin Click to collect the resource files according to the settings above this
button.

Fix Ambient Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Fix Ambient

The Fix Ambient utility solves a compatibility problem that sometimes occurs
when you use 3ds Max to open files from earlier versions of 3ds Max or
Autodesk VIZ.

In 3ds Max, the ambient on page 7906 and diffuse on page 7955 color channels
are locked for standard materials. However, this was not always the case with
earlier versions of 3ds Max and Autodesk VIZ. As a result, files might render
differently than expected.

The Fix Ambient utility looks for standard materials in the current scene whose
ambient and diffuse colors are different, presenting you with the option to
copy the diffuse color to the ambient color channel. This will ensure that your
renderings are consistent with earlier versions of products.
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Interface

Find All  The utility searches the entire scene for materials with different
ambient and diffuse colors.

Find Selected  The utility searches the current selection for materials with
different ambient and diffuse colors.

Help  Opens the help file to this topic.

Different Ambient and Diffuse Materials

This dialog appears after clicking Find All or Find Selected.
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Status Message  This area displays a message indicating whether your scene
(or selection) has materials with different ambient and diffuse values.
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Material List  Lists all of the materials with different ambient and diffuse
values.

Fix Selected  Locks the ambient and diffuse channel for the materials selected
in the dialog.

Cancel  Closes the dialog without making any changes.

Bitmap Pager Statistics Dialog

Customize menu > Customize User Interface > Category: All Commands or
Render > Action: Bitmap Pager Statistics Toggle > Assign to hotkey, menu, etc.

The Bitmap Pager Statistics dialog provides information to help you resolve
issues with scenes that require large amounts of memory for texture maps. It
is intended for advanced users to debug scenes and help shorten render times.

By default, the dialog is not available in the interface; it must be added as a
hotkey, menu item, or toolbar button via Customize User Interface on page
7697 functionality.

Interface
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The read-only dialog shows statistics in four categories:

■ Memory Usage

■ Number of Pages

■ Activity

■ Memory Limit

Asset Browser Subdialogs

Preferences Dialog (Asset Browser)

Utilities panel > Utilities rollout > Asset Browser button > File menu >
Preferences

Contains the settings with which you can manage the Asset Browser's cache
directory and control drag and drop operations.
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Interface

Cache Directory group

Provides settings and controls for the cache directory.

Browse Displays the Choose Cache Directory dialog where you can specify a
new directory to use for your cache. The adjacent text box displays the path
of the cache directory where the thumbnail images are stored. You can change
the path either by editing the field or choosing a directory from the pane
below the Folders field.

NOTE When you change directories, you're asked if you want to clear the cache
from the previous directory. If you choose to do so, the program erases all
thumbnail files from the cache directory you were using previously.

Delete Files Removes all thumbnail files from your cache directory.

Maximum Disk Space Sets the maximum size of the cache directory. When
you exit Asset Browser, the program selects the size of the cache directory. If
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it's over the maximum size, the program deletes the oldest thumbnail files
until the total size is 50 percent of the Maximum Disk Space setting.

Drag and Drop group

Provides controls for importing or linking files after dragging and dropping
them into a viewport.

Show the merge/import/XREF dialog Displays the merge/import/XREF
dialog after you drop a file into a viewport.

Always merge/import the file Imports the file without prompting for
confirmation after you drop it into a viewport.

Always XREF the file Links the file as an XREF without prompting for
confirmation after you drop it into a viewport.

Ask me each time Displays a popup menu to confirm importing or linking
after you drop a file into a viewport.

Internet Download Dialog

Utilities panel > Utilities rollout > Asset Browser button > Address bar > Enter
URL of geometry files on World Wide Web. > Drag thumbnail over active
viewport.

Menu bar > Tools > Asset Browser > Address bar > Enter URL of geometry files
on World Wide Web. > Drag thumbnail over active viewport.

When you drag geometry files from the World Wide Web using the Asset
Browser, the Internet Download dialog appears. How long this dialog remains
on-screen depends on the size of the file you're downloading.
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Interface

Download Information group

Displays the URL of the download, the pathname of the file being saved, and
a meter indicating the bytes downloaded.

Uniform Resource Locator (URL) Displays the URL and file name that you're
downloading.

Saved as Local File Displays the pathname of the file being saved as a result
of the download.

Options group

Specifies whether or not to place the objects when the download is complete.
If you leave this option selected, 3ds Max allows you to position the mouse
at the location of your choice.
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Favorite Location Dialog

Utilities panel > Utilities rollout > Asset Browser button > Favorites menu >
Add to Favorites

Menu bar > Tools > Asset Browser > Favorites menu > Add to Favorites

The Favorite Location dialog allows you to add Web sites and path names to
the Asset Browser Favorites menu and Favorites bar. When you want to open
that page or view the files from a pathname, you can click the appropriate
shortcut button from the Favorites bar, or click the appropriate menu item
from the Favorites menu.

Interface

Custom Label

The button displays the Load Custom Icon dialog. Use this dialog to select an
icon file to associate with the Web site or path name you're adding to the
Favorites. You must use icon files that have an .ico extension.

The text box adjacent to the button displays the URL of the Web page, or the
path name that you're adding to the Favorites. You can edit this to wording
of your choice. The unedited URL or pathname displays in the label below
the Custom Label group.
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Add to favorites pull down menu When you turn this on, Web site or
path-name shortcuts are added to the Favorites menu. When this box is not
selected, the Web site or path-name shortcuts are added only to the Favorites
bar.

Bitmap Path Editor Subdialogs

Bitmap / Photometric Path Editor Dialog

Utilities panel > Utilities rollout > More button > Utilities dialog >
Bitmap/Photometric Paths > Edit Resources button

This dialog is the main part of the interface to the Bitmap / Photometric Path
Editor utility on page 7141.

See also:

■ Asset Browser Utility on page 7132

■ Missing External Files Dialog on page 7130

■ Resource Collector Utility on page 7145

Procedures

To correct the path name for a missing map:

You must first locate the missing bitmap or photometric files. The Windows
Search program can help you with this.

1 On the Bitmap / Photometric Path Editor dialog, click Select Missing Files.

2 Click to select a single missing file in the list.

If a group of missing files are in the same directory, you can leave all of
them selected.

3 Click Strip Selected Paths.

4 Click Set Path.

5 Enter the correct path in the New Path field, or click the "..." button to
browse to the correct path in a Windows file dialog.
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The Bitmap/Photometric Path Editor updates the selected maps' path to
use the new path.

Interface

List of maps and photometric files Shows all bitmaps and photometric files
(IES on page 5034, CIBSE on page 7935, LTLI on page 8029) used in the scene, along
with their current path.

When no file is selected in the list, the only controls available in the dialog
are Close, Select Missing Maps, and Strip All Paths.

Close Click to close the dialog.

Info Click to display a Resource Information dialog on page 7158.

This button is available only when a single file is selected in the list.

Double-clicking a name in the list is another way to display the Resource
Information dialog.

Copy Files Copies the selected files to a directory you choose. This button
displays a Windows file dialog that lets you choose the destination directory.

Select Missing Files Highlights the names of missing files in the list.

Find Files Click to search for the maps or photometric files in the current
selection. This button displays an alert that shows how many files are findable,
how many files are missing.
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Strip Selected Paths Click to strip the path from the selected files. An alert
appears to warn you that the scene will lose this information.

Strip All Paths Click to strip the path from all files in the list. An alert appears
to warn you that the scene will lose this information.

Set Path Click to apply the New Path field to the selected files.

If the New Path field is identical to the selected file or files, clicking Set Path
clears New Path.

New Path Lets you enter a path for the currently selected file or files.
Default=The path of the currently selected file, or none if multiple files with
differing paths are selected.

"..." button (To the right of the New Path field.) Displays a Windows file dialog
to let you browse for a path.

Resource Information Dialog

Utilities panel > Utilities rollout > More button > Utilities dialog >
Bitmap/Photometric Path Editor > Edit Resources button > Select a single
bitmap or photometric file name. > Info button

Utilities panel > Utilities rollout > More button > Utilities dialog >
Bitmap/Photometric Path Editor > Edit Resources button > Double-click a
bitmap or photometric file name.

The Resource Information dialog displays information about where a bitmap
is used in other materials or photometric distribution files and shows an image
of the bitmap.
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Interface

Referenced by Nodes Lists the objects ("nodes") that are assigned materials
that use this bitmap or use a given photometric distribution file on page 5005.

Close Closes the dialog.

View Bitmap Displays a Rendered Frame Window on page 6073 that shows the
bitmap. This button is unavailable if the file is a photometric file, and it has
no effect if the map is missing.

Internet Access
The Asset Browser on page 81 can locate locally or network-stored materials,
textures, geometry, and other 3D assets that can be easily dragged and dropped
into the 3ds Max workspace. The Browser can also access the Internet to do
the same.

The Asset Browser provides embedded Web browser functionality, so you can
go directly to the Internet to capture 2D and 3D content for use in 3ds Max.
For example, a visit to any of several manufacturers' sites, such as
www.formica.com, can yield flooring, countertop, or other samples in bitmap
form. Provided a site encourages such use of its content (and most do), these
thumbnails can be dragged into 3ds Max with a single mouse movement and
dropped onto objects in a scene for instantaneous "what if" visualizations of
different textures and treatments. They can also be saved for later use.
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2D and 3D geometry can also be captured off the Internet and put to
immediate use in 3ds Max scenes. You can also use the Asset Browser with
topographical maps, detailed aerial and satellite photos, and any design data
in MAX or STL form. In this way, you are assured instant access to the latest
design content, free from leading vendors around the world, without leaving
your desktop.

For Web Content Providers

Any Web page that uses standard HTML source code can easily be enhanced
so that 3ds Max users can access it for content. Making bitmap textures (.BMP,
.JPG, .GIF, .TIF, etc.) available for downloading requires no special HTML
coding, but there are guidelines you should follow for optimum utility to 3ds
Max users. Making geometry (MAX) files (.max) available to 3ds Max users
requires some simple modifications to your HTML source code.

See also:

■ i-drop Indicator on page 7160

i-drop Indicator

In order to support the World Wide Web as a primary source of product
information, Autodesk has introduced the i-drop™ Indicator. This enables
manufacturers and design professionals to publish and acquire design data
using standard Web pages.

The i-drop Indicator is used to transfer content from the World Wide Web by
means of a drag-and-drop operation. The content can be any type of file (such
as a geometry or a raster file) that the content producer has made available
and that the application will accept.

For example, imagine that you are a lighting designer and require a specific
fixture to embed within your 3ds Max scene. Now imagine that a lighting
company such as ERCO has a Web site containing a library of their fixtures
online. You can browse this library, then drag and drop the appropriate fixture
into your scene. You don't need to download the file and then insert it. Now
you can drag any MAX file from an i-drop-enabled web site and drop its
geometry directly into your Autodesk product.

In addition to geometry, you can drag and drop photometric data, cost
information, materials, and so on.
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An i-drop object in a Web page is an open gateway between the content
provider's server and the Autodesk software user's desktop. Web pages that
contain i-drop objects can be designed to look and behave exactly like standard
Web pages in a standard Web browser. You simply drag the i-drop object from
the provider's Web page and drop it onto a desktop or into an application.

The desktop or application is the i-drop target. The i-drop target requests the
data in one or more specific clipboard formats and receives the content. This
is called being "i-drop aware." i-drop can also deliver data in any of the system
default clipboard formats. What the application gets depends on what
clipboard format it requires. For example, if the user drags to the desktop, the
desktop takes a file. If the user drags to a text editor, the text editor takes
textual data. What the desktop or application takes is independent of i-drop.

For more information, see http://idrop.autodesk.com.

Geometry File Formats
The Import on page 7096 and Export on page 7097 commands on the File menu
on page 7473 let you share 3D geometry with other 3D modeling programs. The
software can import and export a variety of file formats.

3ds Max can also open DRF Files on page 7167, which are created in VIZ Render,
a rendering tool packaged with AutoCAD Architecture.

See also:

■ Asset Browser Utility on page 7132

■ Internet Access on page 7159

■ i-drop Indicator on page 7160

Compatible File Formats

MAX Files (from Autodesk VIZ) on page 7164

VIZ Render (DRF) Files on page 7167

Importable File Formats

Importing 3DS Files on page 7172

Importing PRJ Files on page 7174
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Importing SHP Files on page 7177

Importing Adobe Illustrator 88 Files on page 7178

Importing AutoCAD Drawing Files on page 7182

Importing DXF Files on page 7209

FBX Files on page 7222

Flight Studio OpenFlight (FLT) Files on page 7223

Importing Autodesk Inventor Files on page 7211

Importing IGES Files on page 7226

Importing LandXML/DEM Models on page 7247

Importing Lightscape Files on page 7253

Importing HTR/HTR2 Files on page 7257

Importing TRC Files on page 7259

Importing STL Files on page 7276

Importing VRML Files on page 7290

Wavefront (OBJ, MTL) Files on page 7280

Exportable File Formats

Exporting 3D DWF Files on page 7216

Exporting to 3DS on page 7175

Exporting to Adobe Illustrator on page 7179

Exporting to ASCII on page 7180

Exporting AutoCAD DWG Files on page 7206

Exporting to DXF Files on page 7209

FBX Files on page 7222

Flight Studio OpenFlight (FLT) Files on page 7223

Exporting IGES Files on page 7230

JSR-184 Files on page 7233

Exporting Lightscape Files on page 7251

Exporting HTR/HTR2 Files on page 7261
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Exporting to Shockwave 3D on page 7264

Exporting to STL on page 7279

Exporting to VRML97 on page 7292

Exporting Wavefront Object (OBJ) Files on page 7281

Importing Geometry

When you import geometry, using the Import command on the File menu,
in most cases a dialog is displayed that asks whether you want the imported
geometry to be added to the scene, or to replace the scene entirely. For
example:

Merge objects with current scene Merges imported data with the current
scene.

Completely replace current scene Completely replaces the current scene
with the imported data.

In general, once you respond to this dialog, a second dialog with
geometry-specific options is displayed, as described in the topics that follow.
(For some geometry formats, only one dialog appears, and these options are
merged with the geometry-specific options.)
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Working with MAX Files from Autodesk VIZ

Although they share the same file type, 3ds Max files and Autodesk VIZ files
are quite a bit different. This topic describes some of the differences, and
recommends ways to obtain the desired results from your files.

See also:

■ Working with Drawing Files on page 6978

Defaults

3ds Max ships with several market-specific defaults sets. If you are working
on design visualization types of files, you should load the DesignVIZ default
settings. For more information on how to do this, see Market-Specific Defaults
on page 7694.

Objects

AEC objects (walls, doors, windows, etc.) in an Autodesk VIZ file retain all
their original properties as AEC objects when opened in 3ds Max. Autodesk
VIZ models can also contain File Link created objects that appear as VIZBlocks
or Linked Geometry.

File Linked VIZBlocks in 3ds Max

A VIZBlock is a compound object similar to a nested AutoCAD or Architectural
Desktop block. If a drawing containing nested blocks is file linked to Autodesk
VIZ, the block objects display in the Modify panel as VIZBlocks.

3ds Max recognizes VIZBlocks when you open a MAX file created in Autodesk
VIZ. You can access the sub-object hierarchy, rename sub-object components
and even extract sub-objects of the VIZBlock. You are also allowed to add
modifiers on top of the sub-objects. You cannot attach objects to a VIZBlock
as you could in Autodesk VIZ.
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The VIZBlock user interface on the Modify panel

NOTE VIZBlocks can contain both mesh and spline geometry. This can cause
some confusion when applying modifiers like Edit Mesh. If a spline component is
closed, it will be converted to a mesh with no extrusion. If a spline is not closed,
it will disappear and leave behind stray vertices in the mesh.

VIZBlocks are assigned a special controller called a LinkTM controller. If a
sub-object component is extracted and converted to an Editable Mesh or
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Editable Spline, the LinkTM controller is replaced with a PRS controller.
Likewise, if an entire VIZBlock is converted to an Editable Mesh or Spline, the
LinkTM controller for the node is replaced with a PRS controller.

When using Track View, sub-object components of VIZBlock do not display.
Data pertaining to the LinkTM controller is not displayed, however, you can
access the PRS subcontroller.

While working on VIZBlocks, it is very possible that the you might lose
portions of the original data organization of the scene, for example, when a
sub-object component is extracted from an instanced VIZBlock, the extracted
object is not instanced the same number of times.

File Linked Geometry in 3ds Max

This file linked object type appears in Autodesk VIZ when you use the Entity
Combine-By option or if you extract a component from a VIZBlock. These
objects display in the Modify panel as Linked Geometry. If a linked geometry
object is moved, rotated, or scaled, you can use the Reset Position option.

The Linked Geometry user interface on the Modify panel

3ds Max recognizes Linked Geometry objects when you open a MAX file
created in Autodesk VIZ. Since Linked Geometry objects offer no parameters
on the Modify panel, you have to modify these objects by converting them
to Editable Mesh or Splines or applying modifiers on top of them.
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Linked Geometry objects are also assigned a LinkTM controller. If the object
is converted to an Editable Mesh or Editable Spline, the LinkTM controller is
replaced with a PRS controller.

File Link Reloading

If you plan on working on an Autodesk VIZ scene in 3ds Max, you should
download the latest service pack for the product. The latest service pack
includes functionality that makes 3ds Max more compatible with Autodesk
VIZ.

Materials

In 3ds Max, the ambient on page 7906 and diffuse on page 7955 color channels
are locked for standard materials, however this is not the case in Autodesk
VIZ. As a result, MAX files from Autodesk VIZ may render differently in 3ds
Max.

To solve this issue, use the Fix Ambient utility on page 7147.

Missing Maps

Many times, when you open a MAX file from Autodesk VIZ, you will be
presented with a Missing External Files dialog on page 7130. To locate the missing
files, click Browse and then add the appropriate Autodesk VIZ directories to
the Configure External File Paths dialog on page 7735.

VIZ Render (DRF) Files

DRF is the file format for VIZ Render, a rendering tool formerly included with
AutoCAD Architecture. The DRF file type is similar to MAX files from previous
versions of Autodesk VIZ.

This file format is available only when you use the File menu > Open on page
6922 command. All DRF files must be saved as MAX files in 3ds Max. Likewise,
DRF files cannot be imported or merged into 3ds Max scenes.

NOTE You can open DRF files using drag-and-drop functionality.

Saving DRF Files

DRF files must be saved as MAX files in 3ds Max.
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Defaults

3ds Max ships with several market-specific defaults sets. If you are working
on design visualization types of files, you should load the DesignVIZ default
settings. For more information on how to do this, see Market-Specific Defaults
on page 7694.

Units

In VIZ Render, you can only use meters as your system unit. However, 3ds
Max lets you define your own system unit, and how units are displayed. For
more information on units, see Using Units on page 2588 and Units Setup Dialog
on page 7809.

Missing Maps

Many times, when you open a DRF file, you will be presented with the Missing
External Files dialog on page 7130. To locate the missing files, add the appropriate
VIZ Render directories to the Configure User Paths dialog > External Files
panel on page 7735.

Handling Linked Geometry in 3ds Max

Linked objects show up as Linked Geometry objects on the Modify panel.
These objects don't allow access to sub-object levels where minor editing can
occur. If a linked geometry object is moved, rotated or scaled you do have the
option to Reset Position.
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Linked Geometry user interface on the Modify panel.

3ds Max recognizes Linked Geometry objects when you open a MAX file
created in VIZ Render. Since linked geometry objects offer no parameters on
the Modify panel, you must first add an Edit Mesh modifier to the object or
collapse the linked geometry object to an Editable Mesh in order to access
sub-object levels. If you add a modifier to linked geometry, the modifier is
applied to all instances of that object.

Linked Geometry objects are assigned a special LinkTM controller. If a the
object is converted to an Editable Mesh, Poly, NURBS or Editable Spline, the
LinkTM controller is replaced with a PRS controller.

Substituted Objects

There is no substitution modifier in 3ds Max. However, if you open a DRF file
with substituted objects, 3ds Max will recognize the substitutions and will
add the substituted objects into the scene.

User Interface Changes

Some of the user interface elements in 3ds Max are not where you would
expect them if you are coming from VIZ Render. For example, the viewport
controls on page 7572 are in the bottom-right corner, instead of the top-left.

For more information on the user interface, see User Interface on page 7465.
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Render Presets

The Render Presets in 3ds Max are very different from the presets in VIZ Render.
For more information on using them, see Preset Rendering Options on page
6114.

Working with DRF Files in 3ds Max

Saving DRF Files

DRF files must be saved as MAX files in 3ds Max.

IMPORTANT Once you save a DRF file in 3ds Max, it becomes a MAX file and
you can no longer open it in VIZ Render.

Defaults

3ds Max ships with several market-specific defaults sets. If you are working
on design visualization types of files, you should load the DesignVIZ default
settings. For more information on how to do this, see Market-Specific Defaults
on page 7694.

Units

In VIZ Render, you can only use meters as your system unit. However, 3ds
Max lets you define your own system unit, and how units are displayed. For
more information on units, see Using Units on page 2588 and Units Setup Dialog
on page 7809.

Missing Maps

Many times, when you open a DRF file, you will be presented with the Missing
External Files dialog on page 7130. To locate the missing files, add the appropriate
VIZ Render directories to the Configure User Paths dialog > External Files
panel on page 7735.

Handling Linked Geometry in 3ds Max

Linked objects show up as Linked Geometry objects on the Modify panel.
These objects don't allow access to sub-object levels where minor editing can
occur. If a linked geometry object is moved, rotated or scaled you do have the
option to Reset Position.
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Linked Geometry user interface on the Modify panel.

3ds Max recognizes Linked Geometry objects when you open a MAX file
created in VIZ Render. Since linked geometry objects offer no parameters on
the Modify panel, you must first add an Edit Mesh modifier to the object or
collapse the linked geometry object to an Editable Mesh in order to access
sub-object levels. If you add a modifier to linked geometry, the modifier is
applied to all instances of that object.

Linked Geometry objects are assigned a special LinkTM controller. If a the
object is converted to an Editable Mesh, Poly, NURBS or Editable Spline, the
LinkTM controller is replaced with a PRS controller.

Substituted Objects

There is no substitution modifier in 3ds Max. However, if you open a DRF file
with substituted objects, 3ds Max will recognize the substitutions and will
add the substituted objects into the scene.

User Interface Changes

Some of the user interface elements in 3ds Max are not where you would
expect them if you are coming from VIZ Render. For example, the viewport
controls on page 7572 are in the bottom-right corner, instead of the top-left.

For more information on the user interface, see User Interface on page 7465.
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Render Presets

The Render Presets in 3ds Max are very different from the presets in VIZ Render.
For more information on using them, see Preset Rendering Options on page
6114.

3D Studio Mesh (3DS, PRJ) Files

Importing 3DS Files

File menu > Import > Select File To Import dialog > Files Of Type > 3D Studio
(*.3DS)

3DS is the 3D Studio® (DOS) mesh-file format. You can import 3DS files into
3ds Max.

When you import a 3DS file, you can merge the imported objects with the
current scene or replace the current scene completely. If you choose to merge
the objects with the current scene, you are asked whether you want to reset
the length of the animation in the scene to the length of the imported file (if
the imported file contains animation).

When you import a 3DS file, the following information is imported:

■ Backgrounds (solid, gradient, and bitmap).

■ Fog, Layered Fog, and Distance Cue.

■ Ambient light level.

■ Subtractive transparency is converted to 3ds Max "Filter" transparency and
the filter color is set equal to the diffuse color.

■ Transparency falloff settings.

■ All map channels that are enabled. Map channels that are turned off in
the 3DS file do not import into 3ds Max.

■ All map parameters, including UV transforms, Negative, Mirror, and
Rotation. Some Map parameters such as Blur, Luma, RGB, and Alpha work
much differently in 3ds Max. These values are converted to new values
that produce a similar affect.

■ Mask bitmaps are imported as 3ds Max mask textures.
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■ When materials with both Texture 1 and Texture 2 are imported, a
composite texture is created and added to the Standard material's Diffuse
channel.

■ Reflection maps, auto-cubics, and mirrors.

■ Automatic reflection map Nth frame and Map Size settings.

■ SXP translation for Marble and Noise materials.

■ 3DS/DOS R4 IK joint parameters.

■ 3D Surfer patch data.

When you import a PRJ file, all of the above items are imported, plus shapes.

When you import a 3DS file, the following information is not imported:

■ Morph keys.

■ Keyframer instances.

■ Map channels that are turned off.

■ Custom .cub-format cubic maps.

■ Decal transparency using the RGB color of the upper-left pixel of the map.

Interface
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Merge objects with current scene Merges imported data with the current
scene.

Completely replace current scene Completely replaces the current scene
with the imported data.

Convert units When turned on, the software assumes units in the imported
file to be in inches, and converts them to the current system of units. When
turned off, the software assumes the units in the imported file match the
current scene unit and doesn't convert the units.

Importing PRJ Files

File menu > Import > Select File To Import dialog > Files Of Type > 3D Studio
Project (*.3DS,*.PRJ)

PRJ is the 3D Studio (DOS) project-file format.

When you import a PRJ file, you can merge the imported objects with the
current scene or replace the current scene completely. If you choose to merge
the objects with the current scene, you'll be asked whether you want to reset
the length of the animation in the scene to the length of the imported file (if
the imported file contains animation).

You'll also be asked how you want the software to handle shapes on page 8127
in the incoming file: to make them into a single object or multiple objects.

Interface

When you import a PRJ file, you first see a 3DS Import dialog on page 7172. This
is identical to the dialog you see when you import a 3DS file. When you have
set the options and clicked OK in the 3DS Import dialog, you then see a Shape
Import dialog.
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When importing PRJ files, the software converts polygons to shape objects.
You choose an option in the Shape Import dialog to set how the shape objects
are created:

Import Shapes Turn on this option if you don't want to import shapes from
a .prj file.

Single Object All polygons in the .prj file are converted to Bezier splines and
placed inside a single composite shape object.

Multiple Objects Each polygon in the .prj file is converted to a Bezier spline
and placed inside an independent shape object.

Exporting to 3DS

File menu > Export > Select File To Export dialog > Save As Type > 3D Studio
(*.3DS)

3DS is the 3D Studio (DOS) mesh file format. You can export 3ds Max files to
this format.

When you export a 3DS file, the following information is exported:

■ Position, Rotation and Scale animation. If the controller is a TCB controller,
the TCB, Ease In, and Ease Out values are also saved. If the controller is
any other type of key controller, the keys are saved but the tangent
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information is lost. If the controller is not a key controller, only the object's
transformation at frame 0 is saved.

■ Basic material color/parameters from the Standard material.

■ Single maps with their amount, offsets, scales, etc.

■ Auto-cubics and Mirrors.

■ Target cameras, target spotlights and omni lights.

■ Most "static" parameters for cameras and lights, and animation tracks for
Roll, Falloff, Hotspot, and FOV.

When you export a 3DS file, the following information is not exported:

■ Composite and procedural maps.

■ Grouped object transformations. There's no concept of group hierarchy
in the 3D Editor. Groups export to the Keyframer because the Keyframer
understands hierarchies.

■ Global shadow parameters.

When you export a 3DS file, the following occur:

■ All non-mesh geometry, such as procedural primitives and patches, is
collapsed to meshes before export.

■ Objects are exported as they exist on the frame 3ds Max displays at export
time.
If you want to output morph targets, go to each frame and export the
target to a different file name.

■ Meshes are saved with edge display information and smoothing groups.

■ 3ds Max instances are saved as Keyframe instances.

■ Modifier and morph animation is frozen at the current frame, collapsed,
and exported as a simple mesh.
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Interface

When you choose 3DS as the export file format, enter a file name, and click
Save, an Export Scene To .3DS File dialog is displayed. This dialog has a single
option:

Preserve MAX's Texture Coordinates When on, preserves mapping
coordinates. When off, mapping information is discarded. Default=on.

Importing SHP Files

File menu > Import > Select File To Import dialog > Files Of Type > 3D Studio
Shape (*.SHP)

SHP is the 3D Studio (DOS) shape file format. You can import these files into
3ds Max.

A SHP file contains polygons created in the 2D Shaper in 3D Studio.

When importing an SHP file that contains multiple shapes, the software gives
you the option to either merge them all into one object or make multiple
incoming objects.

The shape importer looks at the vectors on incoming splines, and if they're
collinear within a couple of percentage points, it changes the angle to a
smoothed Bezier (otherwise, it's a Bezier corner).

Interface

When you import an SHP file, you first see a 3DS Import dialog on page 7172.
This is identical to the dialog you see when you import a 3DS file. When you
have set the options and clicked OK in the 3DS Import dialog, you then see
a Shape Import dialog.
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Import Shapes When on, imports the shape objects. When off, does not
import them. Default=on.

Import Shapes As group

Single Object (The default.) When chosen, imports all shapes in the SHP file
as a single editable spline object on page 659.

Multiple Objects When chosen, imports each shape in the SHP file as an
individual editable spline object.

Adobe Illustrator Files

Importing Adobe Illustrator 88 Files

File menu > Import > Select File To Import dialog > Files Of Type > Adobe
Illustrator (*.AI)

You can import Adobe Illustrator (AI88) files into 3ds Max.
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Interface

When importing AI88 files, the software converts polygons to shape objects.
You choose an option in the Shape Import dialog to set how the shape objects
are created:

Single Object All polygons in the .ai file are converted to Bezier splines and
placed inside a single composite shape object.

Multiple Objects Each polygon in the .ai file is converted to a Bezier spline
and placed inside an independent shape object.

Exporting to Adobe Illustrator

File menu > Export > Select File To Export dialog > Save As Type > Adobe
Illustrator (*.AI)

You can export shapes that can be converted to Bezier splines on page 7922.
The software exports these shapes in 2D only. It uses only the X and Y
coordinates of the shape's local coordinate system, discarding the Z coordinates.

Procedures

To export a file to Adobe Illustrator:

1 Select one or more shape objects.

2 Choose File menu > Export.

Adobe Illustrator Files | 7179



3 Select Adobe Illustrator (*.AI) as the file format.

4 Enter a file name, and click Save.

Exporting to ASCII

File menu > Export > ASCII Scene Export (*.ASE)

When you choose ASCII Scene Export (*.ase) as the Save As type, the exported
file is an ASCII representation of your scene. A dialog lets you specify which
scene components are included, and how they're output. This is helpful if you
are writing a program that requires you to parse the ASCII file.

Interface

Output Options group

Provides check boxes to specify which general options are included in the
ASCII file.

Mesh Definition Exports the definition of each mesh, including vertex and
face information for geometric objects. In addition, turning this on enables
the items in the Mesh Options group box, described below.
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Materials Includes the material description. If a material is not assigned to
an object, its wireframe color is exported. All levels of a material tree are
included, so this can produce a lot of text.

Transform Animation Keys Includes the transform animation data for the
objects. If the object is a target camera or spotlight, this will include target
animation data.

Animated Mesh Exports a complete mesh definition of every n frames. The
frequency is specified by the Controller Output spinner, described below. Each
block contains the same information specified in the Mesh Options group
box, described below. Turning this on can result in a huge file, even for small
scenes.

Animated Camera/Light Settings Exports the animation data for cameras
and lights, such as color, intensity, falloff, map bias, etc. Outputs a block every
n frames, as specified by the Controller Output spinner.

Inverse Kinematics Joints Exports the IK joint settings in the Hierarchy
branch.

Mesh Options group

These items are enabled only when Mesh Definition is turned on in the Output
Options group box.

Mesh Normals Exports the face and vertex normals. The normal of the face
is listed first, followed by the normals of the three vertices supporting the
face. Turning this on results in a much larger file.

Mapping Coordinates Exports a list of mapping vertices and faces, according
to the TVert and TVFace structures described in the 3ds Max Software
Development Kit. If an object uses face mapping, a face map list is exported
containing UVW coordinates for each face.

Vertex Colors Exports vertex colors.

Object Types group

The items here let you specify which category of object you want included in
the output. You can include geometric objects, shapes, cameras, lights, and
helper objects.
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Static Output group

Frame # Lets you specify which frame of the animation will be used to export
all static data, whether or not you output controller animation data.

Precision group

Decimals Lets you specify the precision (the number of digits after the decimal)
of the values exported to the ASCII file.

Controller Output group

Use Keys Exports key values. If the controller doesn't use keys, then the Force
Sample method is used. In the case of transform controllers, the Use Keys
option works only if all of the transform controllers are either Linear/TCB or
Bezier. If one of the transform tracks uses a different type of controller, then
the Force Sample method is used for all transform tracks.

Force Sample Samples controller values based on the frequency specified in
the Frames per Sample Controller.

Frames per Sample group

Controllers Specifies the frequency, in frames, with which to sample controller
values for export.

Animated Objects Specifies the frequency, in frames, with which to output
animation settings and mesh definitions.

AutoCAD (DWG) Files

Importing AutoCAD Drawing Files

File menu > Import > AutoCAD Drawing (*.DWG, *.DXF)

In most cases, when using the same data with two or more different Autodesk
products, it's preferable to use the File Link Manager on page 6987 to connect
to drawing files; this lets you maintain a “live” link between the applications.
However, if you prefer you can also use the Import command to bind to the
drawing file immediately.
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When you import a drawing file, 3ds Max converts a subset of the AutoCAD,
AutoCAD Architecture (formerly Architectural Desktop), or Revit objects to
corresponding 3ds Max objects.

After you select a drawing file to import, the AutoCAD DWG/DXF Import
Options dialog is displayed. After choosing options and proceeding with the
import, you are presented with editable meshes, editable splines, and PRS
controllers. Each nested block maintain its parent-child hierarchy and is
imported as “Block/Style Parent”. In addition, if a single drawing object creates
both mesh and spline geometry, you will find objects referred to as “Linked
Geometry” in the scene. Block/Style Parent and Linked Geometry objects
appear in the modifier stack on the Modify panel.

NOTE If you import multiple drawings, the importer merges the drawings together.

If you are using AutoSurf or AutoCAD Designer, use the AutoCAD command
3DSOUT to export mechanical models to 3ds Max. You can also explode the
mechanical models and then import the resulting file, but some data will not
appear in the AutoCAD drawing file.

IMPORTANT AutoCAD and its vertical applications, such as AutoCAD Architecture
(formerly ADT), have custom objects that are unique to the product. In order to
view them in 3ds Max, you need the appropriate Object Enabler (OE). Object
Enablers let you access, display, and manipulate these objects in AutoCAD, as well
as the other vertical applications, including 3ds Max. For a list of downloadable
OEs, see the http://www.autodesk.com/autocad-object-enablersAutodesk Web site.

Legacy DWG Importer

The current DWG import utility contains many improvements, including
enhanced DWG compatibility and greater user control and customizability;
however, some features were lost from the DWG Importer found in previous
versions of the software. For this reason, 3ds Max retains the legacy DWG
Import functionality on page 7201.

Support of Multiple Materials on Imported ACIS Solids

3ds Max supports multiple materials per object in DWG files exported as ACIS
solids from Revit Architecture/Structure/MEP 2008 and later, as well as solid
primitives created in AutoCAD Architecture 2008 (formerly ADT) and later.
Imported solids can have Multi/Sub-Object materials on page 5720 that you can
view and manipulate in the Material Editor.
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NOTE Previous versions of 3ds Max supported multiple materials for polymeshes
but only one material ID for each ACIS solid when importing a DWG file, regardless
of how many material IDs had been assigned to the solid.

NOTE Legacy AutoCAD DWG import does not support multiple materials on ACIS
solids.

Process

When 3ds Max imports a DWG file from AutoCAD or Revit Architecture
(version 2008 and later) with either the Layer, Blocks as Node Hierarchy, Split
by Material” or the Entity, Blocks as Node Hierarchy derivation methods,
multiple material IDs are readable and editable as Multi/Sub-Object materials
in the Material Editor.

3ds Max reads each face of an imported AutoCAD/Revit solid to determine if
it contains any material IDs that can be imported. If the program reads more
than one material ID from a solid, it translates each material ID on import
and re-assigns it to the object.

The program creates Multi/Sub-Object materials only if it finds more than one
material ID; if an ACIS solid contains only one material ID, 3ds Max creates
and assigns a standard/architectural material instead.

NOTE 3ds Max first evaluates the imported file to find any Revit material IDs, and
then looks for AutoCAD material IDs.

NOTE If you import a DWG file with the Layer, Blocks as Node Hierarchy, Split by
Materials derivation method, it does not split the solid to reflect its materials set.

Multi/Sub-Object Material Naming

In earlier versions, 3ds Max read the material ID information from the color
ID of the AutoCAD/Revit material ID’s face. Now, it creates a Multi/Sub object
material for every translated per face material ID each time you import a DWG
file that contains an AutoCAD/Revit solid.

When the program finds multiple materials assigned to an ACIS solid and
creates a Multi/Sub-Object material, the Multi/Sub-Object material consists
of instances of standard architectural scene materials.
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Naming Conflicts

Material IDs are unique within one DWG file. However, the same material ID
may appear in two different files, such as Basic Wall: Generic – 12” Masonry.
If a naming conflict arises when two scenes are merged, the program applies
the last loaded material used in the Multi/Sub object material.

For example, if you import two files, file1.dwg and file2.dwg, and they both
contain a material named Brick; the Brick material used is the one from the
second file (file2.dwg).

Or, if file1.dwg contains a material named Brick that is internally stored as
material ID 222 and file2.dwg contains a different material stored as ID 222,
the material used in the scene when they are imported is file2.dwg’s material.

If two solids share the same material ID, they will share the same
Multi/Sub-Object material.

Non-AutoCAD Materials

3ds Max does not import non-AutoCAD material IDs. The only non-AutoCAD
Architecture IDs it preserves are Color IDs.

ACIS Solids

DWG ACIS solids import as solid objects in 3ds Max. You cannot separate
faces of an ACIS solid object unless you apply the Edit Poly on page 1363 or Edit
Mesh on page 1353 modifier.

TIP You can access the material ID value assigned to this face with the Edit Poly
modifier.

ACIS Solids and Materials

ACIS solid materials display in the Material Editor, along with any other
imported materials.

When you apply a bitmap material to an ACIS solid, it is applied to every side
of the object. For example, a brick bitmap material that you apply to a wall
object appears on both sides and all edges of the wall. If you want to apply a
material to each face ID, you can use a Multi/Sub Object material so you can
assign sub-materials to each face ID.

When you import ACIS solids into 3ds Max, procedural textures are not
imported, only materials For example, a brick wall in Revit may have mortar
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lines procedurally drawn on it in red, but if the object is an ACIS solid, the
mortar lines, which are procedural hatches, are lost in 3ds Max

When an ACIS object’s materials are shown as a Multi/Sub-Object material in
the Material Editor, each material name appears in the Material/Map Browser,
for example, Default wall or Basic Wall: Generic – 12” Masonry.

Polymesh

Polymesh DWGs import as polymesh geometry in 3ds Max. Unlike ACIS solids,
you can modify and edit any face of a polymesh object.

Polymesh Objects and Materials

When you import a polymesh DWG file, 3ds Max considers each polymesh
face as a separate entity, with one material permitted per entity, which allows
it to contain multiple materials.

You can apply a bitmap material to the different faces of polymesh geometry,
unlike ACIS solids, where you would need to use a Multi/Sub-Object material
to create the same effect. For example, you can select the outside face of wall
and apply a brick bitmap material and also apply a diffuse material on the
inside wall to simulate white paint.

When you import a polymesh DWG file, every material used in the scene
appears in the Material Editor as a separate material, where you can edit it.

When the Material Editor shows a polymesh object’s materials, each material
name appears in the Material/Map Browser, for example, Default wall or Basic
Wall: Generic – 12” Masonry.

Procedures

To import a DWG or DXF file:

1 Choose File menu > Import.

2 Choose AutoCAD Drawing (*.DWG, *.DXF) in the Files of Type list.

3 Specify the file to import and click Open.

4 Set options in the AutoCAD DWG/DXF Import Options dialog.

5 Click OK to perform the import.
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Interface

The Import Options dialog contains three panels, documented in the following
topics:

DWG/DXF Import: Geometry Panel on page 7187

DWG/DXF Import: Layers Panel on page 7196

DWG/DXF Import: Spline Rendering Panel on page 7198

A Note on Large-Scale Drawings

If you attempt to import geometry that is created very far from the origin or
contains a very large bounding box in tools like AutoCAD, the 3ds Max
viewports and transform tools do not respond properly. When you use them,
the cursor does not move smoothly.

For example, if you have a file that is a mile wide, but your system units are
millimeters, you have a scene width of 1.6 million units, which is too great a
value. If you change your system unit to feet, this is less taxing on the system.

If any side of the scene's bounding box measures larger than   1,000,000 system
units, you will see the following dialog:

DWG/DXF Import: Geometry Panel

File menu > Import > AutoCAD Drawing (*.DWG, *.DXF) > Geometry panel

The Geometry panel of the Import Options dialog controls how the software
derives AutoCAD primitives and whether 3ds Max uses the scene material
definitions when linking to or reloading the AutoCAD drawing. It also presents
options for geometry translation and for toggling inclusion of certain elements
in the DWG or DXF file.
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Interface
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Model Scale group

Incoming file units This drop-down list lets you specify the base units in the
incoming file. Available only when Rescale is on.

Rescale Allows rescaling the incoming geometry by a factor corresponding
to the most common unit type used. The importer tries to detect the units of
the DWG file being imported, compares those units with the 3ds Max system
units, and then provides the appropriate conversion factor.

For example, if a drawing file is built in millimeters and 3ds Max has its System
Units set to inches, the AutoCAD DWG/DXF Import Options dialog
automatically has Rescale on and the Incoming File Units set to millimeters.

When there is a scale disparity, It's generally advisable to rescale an incoming
drawing to more realistic units to account for the precision limitations of 3ds
Max compared to AutoCAD. For instance, if you import an airport designed
in millimeters in AutoCAD, set Incoming File Units to Feet or Meters. For
further information, see A Note on Large-Scale Drawings on page 7187.

NOTE If the units are unspecified in the drawing, the drop-down list is blank. In
this case, if you click OK to perform the import with Rescale on, you are prompted
to select a value for Incoming File Units, and are then returned to the AutoCAD
DWG/DXF Import Options dialog.

Resulting model size Incoming geometry is evaluated to determine its
bounding box size. This field displays the scene extents based on three factors:

■ Incoming file units

■ System units in 3ds Max

■ Display units in 3ds Max

NOTE If the software cannot determine the size, the field shows “(Drawing Extents
Not Known)”.

Derive AutoCAD Primitives By group

This group box contains options for translating the geometry in the DWG or
DXF file to 3ds Max format.

[derivation method] Choose the method for deriving imported AutoCAD
primitives from this drop-down list. The options are as follows:

■ Layer, Blocks as Node Hierarchy All objects on a given layer in the
AutoCAD drawing that aren't in blocks are combined into a single Editable
Mesh or Editable Spline object when imported into 3ds Max. The name
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of each imported object is based on the AutoCAD object's layer. The
imported object name has a “Layer:” prefix and is followed by the layer
name. For example, all AutoCAD objects residing on the layer Walls become
part of the Editable Mesh named Layer:Walls after they are imported to
3ds Max.
Each block is imported separately as a hierarchy, with the block itself as
the parent object and its constituent parts as child objects. The child objects
of the block are combined by layer.

■ Layer, Blocks as Node Hierarchy, Split by Material This works the same
as the Layer, Blocks as Node Hierarchy option, with the following additional
functionalities: the combination of non-block objects by layer, followed
by material and support for multiple materials assigned to ACIS solid and
polymesh geometry.

■ Non-block layer combination

For example, take an AutoCAD file with six objects in layer A: three have
a Brick material and three have a Stone material. Using this option, this
file would be imported in the form of two objects, or nodes, one containing
the Brick material and the other with the Stone material.

Each block is imported separately as a hierarchy, with the block itself as
the parent object and its constituent parts as child objects. The child objects
of the block are combined by layer.

■ Multiple material support

On import, ACIS solids and polymesh geometry can support multiple
materials. For polymesh geometry, one material is supported per face. For
an ACIS solid, if the solid has more than one material associated with it,
a multi/sub object material is created that contains the materials used. If
the solid has only one material associated with it, a standard/architectural
material is assigned instead.

NOTE Multiple material support for ACIS solids applies to DWG files imported
or file linked from Revit Architecture 2008 or AutoCAD Architecture (formerly
Architectural Desktop or ADT) 2007 and later.

NOTE This derivation method is intended for use with AutoCAD 2007 (and
later) format files. Using this method with DWG files created with previous
versions of AutoCAD may result in data loss.

■ Entity, Blocks as Node Hierarchy Every imported object not in a block is
represented as a separate object in the 3ds Max scene, without regard to
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layers. The nodes are then placed on scene layers that correspond to the
drawing layers. Each block is imported separately as a hierarchy, with the
block itself as the parent object and its constituent parts as child objects.
The child objects of the block are combined by layer.
One benefit of this option is that you can apply instanced animation
controllers on page 3109 to block subcomponents and thus, by transforming
a single member, transform all members at once. For example, in a scene
containing a conference table with six chairs around it, you could move
all of the chairs simultaneously by moving a single chair.

Another advantage is that all geometry is instanced, so edited UVs and
normals and other modifications need be done only once.

Multiple materials per object are supported with this option, if needed. If
the object is an ACIS solid, and has more than one material associated
with it, a multi/sub object material is created containing the materials that
can be edited in the Materials Editor. If the solid has only one material
associated with it, a standard/architectural material is assigned instead. If
the object is a Polymesh, one material per face is supported.

NOTE Multiple material support for ACIS solids applies on the DWG files
imported or file linked from Revit Architecture 2008 or AutoCAD Architecture
(formerly Architectural Desktop or ADT) 2007 and later.

NOTE This derivation method setting might cause unreliable material
propagation when importing drawings containing dynamic blocks. Materials
may propagate to some block instances and not to others.

WARNING This option has the potential to create an enormous number of
objects in your scene.

■ Layer Imported objects are combined in 3ds Max according to their layer.
Objects in each of the associated application's layers are combined into
one object, with the exception of blocks, each of which is represented as
an individual VIZBlock (not a hierarchy). Multiple inserts of the same block
are represented using instances in the scene. Material assignments are lost
but material IDs are preserved.

■ Color Imported AutoCAD objects are combined in 3ds Max according
to their color. All objects of the same color are combined into one object,
with the exception of blocks, each of which is represented as an individual
VIZBlock (not a hierarchy). Multiple inserts of the same block are
represented using instances in the scene. Material assignments are lost but
material IDs are preserved.
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NOTE Blocks can contain objects with different colors. However, when sorting,
3ds Max considers only the color of the block itself. Also, 3ds Max objects can
only display one color, unless a material is applied.

■ Entity Provides a one-to-one correspondence between AutoCAD objects
and 3ds Max objects. For each imported object or block in the imported
file, the importer creates an independent object or VIZBlock, respectively,
in the scene. Material assignments are lost but material IDs are preserved.

WARNING This option has the potential to create an enormous number of
objects in your scene.

NOTE When working with drawings exported from Revit, it is recommended
that you do not use this setting.

■ One Object All imported objects are combined into a single VIZBlock.
Material assignments are lost but material IDs are preserved.

Use Extrude modifier to represent thickness When on, objects with thickness
receive an Extrude modifier to represent the thickness value. You can then
access the parameters of this modifier and change the height segments, capping
options, and height value. Unavailable with the Layer, Blocks As Node
Hierarchy option.

When off, objects with thickness (and closed capped objects) are converted
directly to mesh objects.

Create one scene object for each ADT object AutoCAD Architecture (formerly
Architectural Desktop or ADT) objects are imported as a single object instead
of being separated into their constituent components. This means that if you
import an ADT door object, the door is represented as one object instead of
three (frame, step, door). Turning on this switch makes importing faster and
the scene size smaller.
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NOTE This switch presents several modeling concerns that you should be aware
of:

■ Material assignments from ADT are not translated during the import
process..

■ If you want to assign materials to these objects, use Multi/Sub-Object
materials. The assigned material IDs match the color indices specified in
ADT (red=1, white=7, etc.).

■ Depending on the Texture Mapping option you choose, UVW coordinates
are translated correctly.

Use scene material definitions When on, 3ds Max checks the current scene
for any currently used materials with the exact same name as a material name
in the incoming DWG file. If a match is found, the importer does not translate
the drawing's material, but instead uses the material defined in the scene.

When off, the File Link Manager always uses the material definitions contained
in the DWG file, and will overwrite scene materials with the same name,
regardless of which objects the material is applied to. All material definitions
stored in the DWG file are reloaded (even when using a selective reload). If
you make changes to a linked material, in Autodesk VIZ, then reload, those
changes will be lost (if the switch is off).

Geometry Options group

Weld nearby vertices Sets whether coincident vertices of converted objects
are welded, according to the Weld Threshold setting. Welding smoothes across
seams and unifies normals of objects with coincident vertices.

Weld threshold Sets the distance that determines whether vertices are
coincident. If the distance between two vertices is less than or equal to the
Weld Threshold, the vertices are welded together.

Auto-smooth adjacent faces Assigns smoothing groups on page 8130 according
to the Smooth Angle value. Smoothing groups determine whether faces on
an object render as a smooth surface or display a seam at their edges, creating
a faceted appearance.

Smooth-angle Controls whether smoothing occurs between two adjacent
faces. If the angle between the two face normals is less than or equal to the
smooth angle, the faces are smoothed.

Orient normals of adjacent faces consistently Analyzes the face normals of
each object and flips normals to make their directions consistent. If the
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imported geometry is not properly welded, or if the software can’t determine
the object's center, normals might be oriented in the wrong direction. Use
the Edit Mesh or Normal modifiers to flip normals.

When this option is off, the software calculates normals according to the face
vertex order in the drawing file. Face normals for solid objects are already
unified. Make sure this option is off when importing drawings containing
solid objects.

You should also make sure this option is off when working with AutoCAD
Architecture files.

AutoCAD solids will never have their normals unified, regardless of the setting
of this import toggle. Solids generate faces and normals correctly.

Cap closed splines Applies an Extrude modifier to all closed objects, and turns
on the Cap Start and Cap End options of the modifier. The Extrude modifier
Amount value for a closed entity with no thickness is set to 0. Capping makes
closed entities with thickness appear solid and closed entities without thickness
appear flat. When Cap Closed Objects is turned off, the Extrude modifier Cap
Start and Cap End options for closed entities with thickness are turned off.
No modifiers are applied to closed entities without thickness, except for Circle,
Trace, and Solid.

NOTE If Use Extrude Modifier to Represent Thickness on page 7192 is off, the
software does not apply an Extrude modifier to closed objects.

Texture mapping The texture mapping settings affect the loading time of
models that have many objects with stored UVW Coordinates for texture
mapped materials.

NOTE This setting only applies to geometry that is stored as a mesh in the scene.
Spline shapes marked as renderable have separate controls for UVW coordinate
generation on the Spline Rendering panel.

■ No mapping coordinates When No Mapping Coordinates is used, the
software not generate texture coordinates for the mesh objects that are
imported.
When drawings are imported, objects are added to the scene as Editable
Mesh objects that do not have UVW coordinate assignments. Before
assigning materials to imported objects, you'll need to apply a UVW Map
modifier on page 1931 to add texture coordinates. When you then apply the
material and the material or texture map is set to Show Map in Viewport,
the texture map is displayed if the viewport is set to Smooth + Highlights.
If the UVW Map modifier is not applied, the object turns gray and you'll
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see a Missing Map Coordinates dialog on page 5780 when you render the
scene.

This option gives you faster loading speed, but no UVW coordinate
generation.

■ Generate coordinates for all objects This option forces all objects to have
UVW coordinates generated when the drawing is imported.
This option tells the DWG/DXF Importer to create UVW coordinates, but
loading time is increased while the coordinate generation occurs.

Curve steps Adjusts how smoothly an arc or curve appears when the drawing
is imported. Larger numbers result in smoother curves. Default=10.

Maximum surface deviation for 3D solids Specifies the maximum allowable
distance from the 3ds Max surface mesh to the parametric 3D solid surface.
Small numbers produce more accurate surfaces with a greater number of faces.
Large numbers produce less accurate surfaces with fewer faces. In most cases,
the default value suffices. Default=1.0.

Imported 3D solid with different Surface Deviation settings

Top: Surface Deviation=10.0

Center: Surface Deviation=1.0 (the default)
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Bottom: Surface Deviation=0.1

Include group

This group allows you to toggle the inclusion of specific parts of a drawing
file during the import process.

External References (xrefs) Imports xrefs attached to the drawing file.

Lights Imports lights from pre-AutoCAD 2007 drawing files.

Sun and Sky Imports Sun and Shadows position from the drawing file
(AutoCAD / AutoCAD Architecture 2008 and Revit 2008 only).

NOTE You must set mental ray as the default renderer for you to see the Sun and
Sky effect. To set mental ray as the default renderer, see Choose Renderer Dialog
on page 6136.

Hatches Imports hatches from the drawing file.

WARNING This stores each line or dot in the hatch pattern as a separate
component of the VIZBlock that defines the hatch; this can create a very large
number of objects in your scene.

Views and Cameras Imports named views and cameras from the drawing
file, and converts named views to 3ds Max cameras.

NOTE Orthographic views do not translate correctly in imported DWG files.
However, there are no problems with Perspective views.

Points Imports points from the drawing file.

NOTE The imported point objects are represented in 3ds Max as Point Helper
objects.

UCSs (grids) Imports user coordinate systems (UCS) from the drawing file
and converts them to 3ds Max grid objects.

DWG/DXF Import: Layers Panel

File menu > Import > AutoCAD Drawing (*.DWG, *.DXF) > Layers panel

The Layers panel of the Import Options dialog lets you choose specific layers
for importing from the DWG or DXF file.
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Interface

Layers panel

This interface is very similar to the Layer Manager on page 7441. Layer names
remain the same as specified in the drawing file.

Skip all Frozen Layers Excludes the import of objects on frozen layers.

Select from List Allows you to choose specific layers to import. A check mark
beside the layer name indicates the layer will be imported. Click the layer to
toggle the check mark.

All The All button is only active when Select From List is turned on. It quickly
lets you select all the layers in the list.
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None The None button is only active when Select From List is turned on. It
deselects any layers you've selected.

Invert The Invert button is only active when Select From List is turned on.
Clicking this button reverses the selection set: currently selected layers are
unselected and unselected layers are selected.

[layer list] This field displays all the layers that make up the drawing and
shows their status such as hidden/displayed or frozen/unfrozen.

DWG/DXF Import: Spline Rendering Panel

File menu > Import > AutoCAD Drawing (*.DWG, *.DXF) > Spline Rendering
panel

The Spline Rendering panel of the Import Options dialog lets you determine
how spline objects imported from DWG and DXF files are displayed in the
viewports and how they're treated by the 3ds Max renderer.

Interface

Spline Rendering panel

The controls on this panel are identical in name and operation to those found
on the Rendering rollout of editable spline on page 659 and Edit Spline on page
1447 objects. The values of these settings apply to all imported shapes. Once
the import is complete, you can change the settings as necessary for each
object with the Modify panel controls.
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Enable In Renderer When on, the shape is rendered as a 3D mesh using the
Radial or Rectangular parameters set for Renderer.
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Enable In Viewport When on, the shape is displayed in the viewport as a 3D
mesh using the Radial or Rectangular parameters set for Renderer.

Use Viewport settings Lets you set different rendering parameters, and displays
the mesh generated by the Viewport settings. Available only when Enable in
Viewport is turned on.

Generate Mapping Coords Turn this on to apply mapping coordinates.
Default=off.

3ds Max generates the mapping coordinates in the U and V dimensions. The
U coordinate wraps once around the spline; the V coordinate is mapped once
along its length. Tiling is achieved using the Tiling parameters in the applied
material. For more information, see Mapping Coordinates on page 5279.

Real-World Map Size Controls the scaling method used for texture mapped
materials that are applied to the object. The scaling values are controlled by
the Use Real-World Scale settings found in the applied material's Coordinates
rollout on page 5782. Default=on.

Auto Smooth If Auto Smooth is turned on, the spline is automatically
smoothed using the threshold specified by the Threshold setting below it.
Auto Smooth sets the smoothing based on the angle between spline segments.
Any two adjacent segments are put in the same smoothing group if the angle
between them is less than the threshold angle.

Threshold Specifies the threshold angle for smoothing, in degrees. Any two
adjacent spline segments are put in the same smoothing group if the angle
between them is less than the threshold angle.

Viewport Choose this to specify Radial or Rectangular parameters for the
shape as it will display in the viewport. Available only when Enable in Viewport
and Use Viewport Settings are on.

Renderer Choose this to specify Radial or Rectangular parameters for the
shape as it will display when rendered or viewed in the viewport when Enable
in Viewport is turned on.

Radial Displays the 3D mesh as a cylindrical object.

Thickness Specifies the diameter of the viewport or rendered spline mesh.
Default=1.0. Range=0.0 to 100,000,000.0.
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Splines rendered at thickness of 1.0 and 5.0, respectively

Sides Sets the number of sides (or facets) for the spline mesh n the viewport
or renderer. For example, a value of 4 results in a square cross section.

Angle Adjusts the rotational position of the cross-section in the viewport or
renderer. For example, if the spline mesh has a square cross section you can
use Angle to position a "flat" side down.

Rectangular Displays the spline's mesh shape as a rectangle.

Length Specifies the size of the cross–section along the local Y axis.

Width Specifies the size of the cross–section along the local X axis.

Angle Adjusts the rotational position of the cross-section in the viewport or
renderer. For example, if you have a square cross-section you can use Angle
to position a "flat" side down.

Aspect Sets the aspect ratio for rectangular cross-sections. The Lock check box
lets you lock the aspect ratio. When Lock is turned on, Width is locked to
Length that results in a constant ratio of Width to Length.

Legacy AutoCAD Import

File menu > Import > Legacy AutoCAD (*.DWG)

The new AutoCAD DWG/DXF Import Options dialog on page 7182 contains
many improvements, including enhanced DWG compatibility and greater
user control and customizability; however, some things were also lost from
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the DWG Import found in previous versions of the software. For this reason,
3ds Max retains the legacy DWG Import functionality.

Differences Between New and Legacy DWG Import

Features Unique to the new DWG Import System

■ Support for AutoCAD, AutoCAD Architecture and Revit Sun and Shadows
information.

■ Support for AutoCAD Architecture mapped UV textures on objects.

■ Support of multiple materials on ACIS solids from files imported or linked
from Revit Architecture 2008 or AutoCAD Architecture (formerly
Architectural Desktop or ADT) 2007 and later.

■ Support for all ObjectARX custom objects (ignored by the Legacy importer).

■ Specialized support for AutoCAD Architecture and Revit objects, including
style/component grouping and naming, style associations for material and
modifier propagation, and material translation and assignment.

■ Specialized support for AEC Civil contour objects (translated into a Terrain
object).

■ Support for Raster objects.

■ Support for axonometric named views (translated into cameras with the
Orthogonal toggle turned on). Both importers can translate perspective
views.

■ Support for attached drawing xrefs.

■ Support for DXF files.

■ Rescaling to imported drawings created with units that differ from the 3ds
Max system units.

■ Ability to skip frozen layers, or to select specific layers to import (or exclude)
from a list.

■ Ability to set shape rendering parameters before importing to 3ds Max.

■ Ability to maintain layer assignments from the drawing file.
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Features Unique to the Legacy DWG Import System

■ AutoCAD primitives are translated into 3ds Max primitives.

■ Support for Text (though not MText).

■ Imported blocks are represented as groups.

Interface

Derive Objects By group

Layer Names each 3ds Max object based on the object layers specified in the
drawing file. The layer name is followed by a number for each object from
that layer. For example, an object on the layer BASE becomes BASE.01. If
Convert To Single Objects is turned on, objects on the same layer become a
single 3ds Max object.
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Color Derives the name of each 3ds Max object based on the object's layer
color in the drawing. The AutoCAD color number is followed by a number
for each object using that layer color. For example, objects on a layer that is
set to the color red (Color number 001) become COLOR001.01. Colors assigned
by object are ignored in favor of colors assigned by layer. If Convert To Single
Objects is turned on, objects assigned the same layer color become a single
3ds Max object.

Entity Names each 3ds Max object based on the object type. The object type
name is followed by a number for each object converted. For example, a Line
object becomes Line.01. Drawings can contain thousands of entities, so
deriving objects by entity can create many 3ds Maxobjects.

General Options group

Convert to Single Objects Combines multiple objects in the drawing file into
a single 3ds Max object. Objects are combined according to the current Derive
Objects By setting and their 3ds Max object type. Explicit mesh objects are
combined. Shapes with no Z axis extrusion are combined, as are shapes with
the same Z axis extrusion amount. Shapes with differing amounts of Z axis
extrusion are assigned an Extrude modifier and are not combined.

Convert Blocks to Groups Places all objects in a block entity into a 3ds Max
group that uses the name of the block entity and the number .01. For example,
a block entity named CHAIR becomes a collection of 3ds Max objects inside
a group named [CHAIR.01].

Multiple insertions of the block entity are converted to instances of the 3ds
Max group. For example, a second insertion of the block, CHAIR, becomes an
instance of [CHAIR.01] named [CHAIR.02].

When Convert Blocks To Groups is turned off, block definitions are ignored
and block insertions are treated as separate objects, similar to exploding blocks
in AutoCAD.

Skip Off and Frozen Layers Excludes the import of objects on layers that are
hidden or frozen.

Skip Hatches and Points Excludes the import of hatch patterns and point
objects.

Hatch patterns are made of many short line segments and points. Importing
all the objects in hatch patterns can overload your 3ds Max scene.

NOTE Hatch patterns are stored in drawings as anonymous blocks. Skip Hatches
And Points skips any other anonymous blocks in the drawing file. Hatch patterns
created in AutoCAD R14 are skipped regardless of this setting.
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Group Common Objects Puts imported objects into a common group, based
on how they are derived. In other words, the group would include all objects
on a common layer, or color, and so on.

Geometry Options group

Weld Sets whether coincident vertices of converted objects are welded
according to the Weld Threshold setting. Welding smoothes across seams and
unifies normals of objects with coincident vertices. To use the Weld option,
first turn on Convert To Single Objects, because welding occurs only for vertices
that are part of the same object.

Weld Threshold Sets the distance that determines whether vertices are
coincident. If the distance between two vertices is less than or equal to the
Weld Threshold setting, the vertices are welded together.

Auto-Smooth Assigns smoothing groups according to the Smooth Angle
setting. Smoothing groups determine whether faces on an object render as a
smooth surface or display a seam at their edges, creating a faceted appearance.

Smooth Angle Controls whether smoothing occurs between two adjacent
faces. If the angle between the two face normals is less than or equal to the
Smooth Angle setting, the faces are smoothed.

Unify Normals Analyzes the face normals of each object and flips normals
where necessary, so they all point out from the center of an object. If the
imported geometry is not properly welded, or if the software can't determine
the object's center, normals might be oriented in the wrong direction. Use
the Edit Mesh or Normal modifiers to flip normals.

When Unify Normals is turned off, normals are calculated according to the
face vertex order in the drawing file. Face normals for 3D Solids are already
unified. Turn off Unify Normals when importing 3D Solid models.

Cap Closed Entities Applies an Extrude modifier to all closed entities, and
turns on the Cap Start and Cap End options of the modifier. The Extrude
modifier Amount value for a closed entity with no thickness is set to 0. Capping
makes closed entities with thickness appear solid and closed entities without
thickness appear flat. When Cap Closed Entities is turned off, the Extrude
modifier Cap Start and Cap End options for closed entities with thickness are
turned off. No modifiers are applied to closed entities without thickness, except
for Circle, Trace, and Solid.
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AutoCAD 3D Solids Group

Surface Deviation Specifies the maximum allowable distance from the 3ds
Max surface mesh to the parametric 3D solid surface. Small numbers produce
more accurate surfaces with a greater number of faces. Large numbers produce
less accurate surfaces with fewer faces.

Exporting AutoCAD DWG Files

File menu > Export > AutoCAD (*.DWG)

When you export an AutoCAD drawing file, you convert your 3ds Max objects
into AutoCAD objects. Because AutoCAD doesn't support animation, the
exporter produces objects in a static state defined by the current frame set by
the time slider.

If you used layers, instances, or colors to organize objects in the scene, that
structure is maintained when the model is exported.

Exported objects with modifiers assigned to them are affected by the current
state of the modifier. For instance, if the Taper modifier assigned to a box is
turned off, the exported scene shows a non-tapered box.

NOTE Layers created in 3ds Max are not exported to AutoCAD.

NOTE Exporting to an AutoCAD R14 drawing file is not supported. If you are
working with AutoCAD R14, export to 3DS or DXF file format.

What to Expect When Opening the DWG File

When you open an exported drawing in AutoCAD, you are presented with
an isometric (3/4) view looking toward the positive XY direction instead of a
Front elevation view.
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The isometric view of an exported model opened in AutoCAD

The exporter also sets two AutoCAD system variables:

■ INSUNITS, Insert Units, sets the drawing-unit value for blocks or images
inserted from AutoCAD Design Center. Therefore, if you have the units of
a model in 3ds Max set to millimeters, INSUNITS will be set to 4.

■ MEASUREMENT sets the drawing units either to English or Metric.

See also:

■ Exporting to DXF Files on page 7209

Procedures

To export a DWG file:

1 Choose File menu > Export.

2 From the Files Of Type drop-down list, choose AutoCAD (*.DWG).

3 Specify a file name to export.
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4 Set options in the Export to AutoCAD File dialog (described below).

Interface

Export version

Export version 3ds Max allows you to export to AutoCAD 2007, AutoCAD
2004, or AutoCAD 2000.

The next option lets you choose to export everything in the current scene or
only selected objects:

■ Entire Scene All objects in the scene are exported. This is the default
setting.

■ Selected Objects Only selected objects are exported. Choosing this is
equivalent to using File > Export Selected on page 7099.

Geometry Options group

Convert Instances To Blocks Converts instances to AutoCAD block insertions.
The block definition uses the same name as the first instance converted. When
turned off, each instance is converted as a separate AutoCAD object. References
are always exported as separate objects.

Skip Hidden Objects Toggles export of hidden objects. When on, hidden
objects are not exported.

Ignore Extrude Capping When on, exports shapes with Extrude modifiers
as 2D AutoCAD objects with a thickness property, and ignores the state of the
Cap Start and Cap End parameters. When off, shapes with Extrude modifiers
that also have Cap Start or Cap End on are exported as polyface 3D meshes.
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Extruded circles, donuts, and rectangle objects export as AutoCAD circles,
donuts, and trace objects with a thickness property.

AutoCAD Interchange (DXF) Files

Importing DXF Files

File menu > Import > Select File To Import dialog > Files Of Type > AutoCAD
(*.DXF)

If using a DWG file is not an option, the DXF file format is the next best
method of getting design data to and from 3ds Max. Most commonly, DXF
files are used to import and export modeling data to and from CAD programs
that have support for DXF but not DWG files.

When you import an DXF file, the software converts a subset of AutoCAD
objects to corresponding 3ds Max objects. Importing DXF files employs the
same methods as importing DWG files. For more information, see Importing
AutoCAD Drawing Files on page 7182.

Exporting to DXF Files

File menu > Export > Select File To Export dialog > Save As Type > AutoCAD
(*.DXF)

DXF files are used to import and export objects to and from AutoCAD (and
other programs that support this file format).

NOTE The DXF Exporter can export only mesh data. Therefore, all shapes and
splines on page 8127 are exported as mesh objects. Consequently, any open splines
(which cannot be converted to mesh objects) in your scene will not be exported.

See also:

■ Exporting AutoCAD DWG Files on page 7206
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Interface

Export version

Export version list Lets you choose the AutoCAD version to export. You can
export to AutoCAD 2007, AutoCAD 2004, or AutoCAD 2000, or AutoCAD
R12 DXF format.

■ Entire Scene (The default.) All objects in the scene are exported.

■ Selected Objects When chosen, only the selected objects are exported.
Choosing this option is comparable to using File > Export Selected on page
7099.

Geometry Options group

Convert Instances To Blocks Converts instances to AutoCAD block insertions.
The block definition uses the same name as the first instance converted. When
turned off, each instance is converted as a separate AutoCAD object. References
are always exported as separate objects.

Skip Hidden Objects Exports hidden objects. When turned off, hidden objects
are not exported.

Ignore Extrude Capping When turned on, exports shapes with Extrude
modifiers as 2D AutoCAD objects with a thickness property, and ignores the
state of the Cap Start and Cap End parameters. When turned off, shapes with
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Extrude modifiers that also have Cap Start or Cap End turned on, are exported
as polyface 3D meshes. Extruded Circles, Donuts, and Rectangles export as
AutoCAD Circles, Donuts and Traces with a thickness property.

Importing Autodesk Inventor Files

File menu > Import > Select File To Import dialog > Files Of Type > Autodesk
Inventor (*.IPT, *.IAM)

IPT and IAM are the native Autodesk Inventor® file formats for parts (IPT) and
assemblies (IAM). You can now import both file formats into 3ds Max without
having to copy scripts from the install CD.

The components of models that you import into 3ds Max retain their object
naming as assigned in Autodesk Inventor and appear as editable meshes on
page 2075. Once imported, you can edit the model just as you would any other
type of object that you construct. You can apply modifiers, alter materials,
add lighting and cameras, create animations, etc.

Requirements and Limitations

In order to be able to import models that originate from Autodesk Inventor,
Inventor 8, or later, is required to be installed along with 3ds Max on the
system.

At this time, there are some limitations to the Inventor Importer. They are as
follows:

■ Camera animation paths are not converted to 3ds Max cameras so any
animation you've set up in Inventor is lost during import.

■ Any lighting from brightness and ambience settings created in the Inventor
file are not imported. You will have to relight the scene once the import
is complete.

■ A model that is set up with constraints to limit the movement of parts will
lose those constraints upon import. You will need to use inverse kinematics
(IK) on page 3374 to restore the constraints.

■ Dragging and dropping an Inventor file into 3ds Max uses the settings last
set on the Inventor File Import dialog with the except for Mesh Resolution,
which always resets to 0.

■ 3ds Max uses the last version of Inventor that was opened to set the Import
version. For instance, let's say you have both Inventor 8 and Inventor 10
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on your system. If the last version of Inventor you ran was Inventor 8, you
cannot import Inventor 10 files. Inventor 8 must be closed and Inventor
10 opened, at least once, in order for you to successfully import Inventor
10 files.

Material Handling

Materials and material assignments made to the original Inventor model are
retained and imported along with the geometry. Materials are imported as
Architectural materials on page 5526 or if a single object has several materials
assigned to it, they are imported as a Multi/Sub-Object material on page 5720.

Procedures

To import an IAM or IPT file:

1 Choose File menu > Import.

2 Choose Autodesk Inventor (*.IPT, *.IAM) in the Files of Type list.

3 Specify a file name to import.

4 Set options in the Autodesk Inventor File Import dialog.
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Interface

Merge / Replace Options group

Merge With Current Scene Incoming geometry is merged with any existing
geometry that is already present in the scene. This setting is useful if you have
several separate files that contains components that you want to combine
into a single model.

Completely Replace Current Scene The file you're importing will completely
replace any existing geometry that is in the current scene. If your current
scene has not been saved, you are given the opportunity to save your changes
to the current scene before the import process continues. Default=on.
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Material Options group

Import Inventor Materials When turned on, all Inventor materials and
texture maps are translated and imported into the scene. If turned off, no
materials are imported with the model.

Assign Material IDs Lets you control whether material IDs are assigned to
objects that are imported from Inventor. You can assign different materials
to different surfaces of the same object while working in Inventor. When these
objects are imported to 3ds Max, material IDs are assigned to the faces of single
objects to which multiple materials are applied.

For example, you've created a single object that represents a knob that has a
threaded shaft and you've applied a black, plastic material to the knob and a
silver, metal material to the threaded shaft. If Assign Material IDs is turned
on when you import the model into 3ds Max, the faces of the object that have
the plastic material are assigned material ID #1 and the faces that have the
metal material are assigned material ID #2. If you choose to try different
materials while working in 3ds Max, you can quickly make sub-object selections
on page 220 based on the material IDs or apply a Multi/Sub-Object material
on page 5720 that contains materials that correspond to the IDs assigned to the
faces.

Mesh Resolution group

Mesh Resolution This slider lets you determine the degree of refinement
applied to mesh objects by the importation process. When set to 0 (zero), the
geometry is imported as it appears in Autodesk Inventor. When set less than
zero, the mesh is optimized with fewer faces thus reducing detail. If the mesh
resolution is set higher than zero, the mesh is tessellated with more faces,
giving you greater detail.

The mesh resolution slider is always set to 0 when you initiate an import.
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Left: Mesh Resolution=–7.

Center: Mesh Resolution=0.

Right: Mesh Resolution=+7.

NOTE The option to adjust mesh resolution is available only for models imported
from Autodesk Inventor 10 or later.

Inventor File Vertical Direction group

This option determines the model's orientation upon import. You can choose
which axis of the Inventor model is vertical.

X Axis The X axis of the model, as seen in Inventor, is rotated so it is vertical
when the model is imported.

Y Axis The model is imported with the Y axis oriented as the vertical axis.

Z Axis The imported model is rotated so its Z axis is the vertical axis.
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Left: Vertical axis set to X.

Center: Vertical axis set to Y.

Right: Vertical axis set to Z.

Exporting 3D DWF Files

File menu > Publish to DWF

File menu > Export > Publish to DWF

With 3D DWF publishing, you can export Design Web Format™ (.DWF™) files
of your three-dimensional models with nearly the same visual fidelity as in
rendered scenes. DWF files are relatively small files that you can easily share
with team members who might not have 3ds Max. It also provides a fast way
to view models without having to spend time animating and rendering them
because you can use the Orbit feature in the viewer to fly around the model.

For example, a DWF file of your scene can allow you and others to quickly
view an interactive model as well as the properties of each object.
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Recipients of 3D DWF files can view and print them using Autodesk® Design
Review, which is an optional part of the 3ds Max install program. For more
information about using the viewer, see the Autodesk Design Review help
system.

Feature Support with 3D DWF Export

■ 2D and 3D splines. The Enable In Viewport setting on the Rendering rollout
on page 615 does not need to be enabled in order to export splines.

■ 3D geometry

■ Texture-mapped materials with a diffuse map channel, UV mapping
channels, and material IDs

NOTE Materials that have Use Real-World Scale on page 5771 enabled display
more accurately in the Autodesk Design Review program.

■ Procedural materials, but only as a rough, low-resolution approximation.
Real-World Map Size should be off for objects with procedural materials.

■ Materials that have transparency are correctly exported and their opacity
values are recognized by the Autodesk Design Review program. Even when
you orbit the view, objects that pass behind other objects with transparent
materials are still visible.

Limitations of 3D DWF Export

Materials and Environments

■ Environment backgrounds do not export; the Design Review program uses
its own background color setting.

■ Environmental effects such as fog do not export.

■ Materials using reflection maps such as Flat Mirror do not produce
reflections when exported.

■ Two-sided materials are not supported. However, you can get around this
by turning on Force 2-Sided on the Render Setup dialog.

NOTE Turning on Force 2-Sided affects the entire scene. This can slow down
the performance of Design Review because it has to process the two-sided
display of everything in scene.
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■ Materials from third-party suppliers and mental ray materials are not
exported.
Objects that have unsupported materials display in their diffuse colors in
the viewer. AutoCAD Architecture materials are displayed in their ambient
color.

■ Export doesn’t support all material parameters, even with supported
materials. Therefore, materials you export to Design Review might not
look as they do in a rendered image.

Lights

■ You cannot export scene lighting.

Cameras and Animation

■ Named camera views are exported. The exporter creates a DWF view for
each camera in the scene. You can choose these views from the Views
panel in the Autodesk Design Review program, but the cameras are not
otherwise visible as objects in the scene.

■ Animations are not supported, however, the frame at the time of the export
is published.

Procedures

To export a 3D DWF file:

1 Set up the scene in the active viewport as you want it displayed in the
Autodesk Design Review program.

If you want to publish particular objects or layers, make a selection set
of those objects. Hide those objects or layers you do not want published.

NOTE You can also isolate objects in the viewer you want to hide or make
transparent.

TIP If you have a camera in the scene and want that view exported, make
sure the Camera viewport is active when you publish the DWF file.

2 Choose File menu > Export.

3 Choose Publish To DWF (*.DWF) from the Save as type list in the file
selector dialog.

4 Specify a file name to export.
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5 Click Save.

6 Use the DWF Publish Options dialog to make the desired settings, and
then click OK.

7 If you turn on Save Log file but do not want the existing log file to be
overwritten, enter a new name or specify a different folder.
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Interface
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Grouping Options group

Group by Object When on, objects are listed on the Navigator Pane in Design
Review by object name or group name.

Group by Layer When on, objects are grouped on the Navigator Pane of
Design Review by their respective layers.

Publishing Options group

Publish Object Properties When on, object property data is exported and
displayed in Design Review and reported in the log file if Save Log File is
enabled. The displayed properties are name, layer name, face count, vertex
count, and whether the object is frozen or hidden.

Publish Materials Exports objects with their assigned materials in Design
Review. When off, exports objects in their basic object colors. Material names
are not exported.

Publish Selected Objects Only Exports only objects that are selected when
you export.

Publish Hidden Objects Hidden objects are exported and displayed in the
viewer. When off, objects that are hidden or on layers that are hidden do not
appear. Hidden objects are listed in the log file if Save Log File is enabled.

NOTE Frozen objects and frozen layers are exported.

General group

Show DWF in a Viewer When on, Autodesk Design Review automatically
opens the exported DWF file. When off, you must run Design Review and
open the file manually.

Rescale Bitmaps When on, bitmap textures are automatically rescaled in the
DWF file to the size set for pixels for Maximum Resolution. When using large
texture files, turn this on to reduce the DWF file size.

NOTE This setting has no effect when Publish Materials is off.

Maximum Resolution (pixels)  Sets the maximum length, in pixels, of the
longest edge of all the bitmap images that are used as textures.

NOTE All bitmap images exported to the DWF file are compressed to JPG on page
7347 format in order to create small DWF files.
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Use Default DWF Lights Lets you control whether Design Review adds its
own default lighting. When turned off, the scene is displayed without lights
in the viewer, which can result in the scene objects being flat shaded making
them appear two dimensional. Turn Use Default DWF Lights off if the scene
contains lights that are already baked into textures with Render to Texture on
page 6371, otherwise it is recommended that DWF lights are used. Default=on.

NOTE When exporting a scene with all the lighting baked into the texture maps
after using Render to Texture, if Use Default DWF Lights is turned on the scene
may actually appear darker in Design Review, and the built-in DWF lights will cause
the scene lighting to change as you orbit around the objects in the scene. With it
turned off, the lighting will be constant as you move through the scene.

Save Log File  When enabled, 3ds Max creates a text file with the .log file
extension that lists objects, their layers, face and vertex counts that are
exported as well as the time and date of the export. Objects that were not
selected or hidden are also listed as not as not being exported. The log file is
overwritten each time a DWF file is created unless the log file name or file
location is changed. Default=on.

FBX Files

File menu > Import/Export > [Files of type]=Autodesk (*.FBX, *.DAE)

FBX is the file format native to Autodesk MotionBuilder, a system used for
the creation, editing, and blending of motion capture and keyframe animation.
You can import and export files in this format with 3ds Max.

Softimage and Maya can also use the FBX format, making it a bridge among
the four applications.

NOTE The FBX importer/exporter also supports the Collada (DAE) file format.

Interface

For the current version of the 3ds Max FBX Plug-in Guide, click the ? (Help)
button on the FBX Importer/Exporter dialog.

The FBX plug-in changes often, with the result that Autodesk updates it more
frequently than it does this program. Be sure to check regularly for updated
versions by clicking the Check For Web Updates button on the dialog.
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 Flight Studio OpenFlight (FLT) Files

This import/export format is commonly used in visual-simulation systems.
Also included is a related utility, available from Utilities panel > More > Flight
Studio.

Documentation is provided in a separate help file, available from Help menu
> Additional Help > Flight Studio 2009 Reference.

IGES Files

Overview of IGES in 3ds Max

The Initial Graphics Exchange Specification (IGES) is an ANSI standard that
defines a neutral form for the exchange of information among dissimilar
computer-aided design (CAD), computer-aided manufacturing (CAM), and
computer visualization systems. The software implements the IGES standard
for translating files between 3ds Max and IGES file formats used by the
mechanical engineering and entertainment industries. Using the IGES
import/export feature, you can read in and write out native NURBS on page
8060 data between 3ds Max and programs such as Mechanical Desktop release
3.0, Maya™, Pro/ENGINEER®, SOFTIMAGE®, CATIA®, and others. For complete
details on the IGES standard, see The Initial Graphics Exchange Specification
(IGES) Version 5.3.

What IGES Translates

The ideal file translation preserves the appearance and functionality of objects
(called entities in IGES) contained in a file. This process has limits. You should
be aware that some 3ds Max objects are not supported or not fully supported
by IGES. Similarly, be aware that some IGES entities are not supported by the
software. For example, you can't translate animation data and mapping
coordinates, as these elements are not supported by IGES.

As with all translations, concepts that can be expressed succinctly in one
language might not have exact equivalents in another language; conversely,
concepts common to two languages might be expressed differently by each.

Even when the objects you translate don't have an equivalent in the target
system, a one-time translation to or from IGES might not pose a serious
problem. However, data loss can become a concern if you maintain objects
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that will be repeatedly translated in and out of different formats through IGES.
By becoming familiar with the details of the systems and the IGES translators
you use, you can learn to structure files to minimize information loss.

WARNING The conversion of objects during translation is not fully symmetrical.
If you import an IGES file that you created by exporting to IGES, the resulting
objects might not be identical to the original.

NURBS

When you import an IGES file into the software, IGES meshes are converted
to NURBS on page 2237 surfaces, rather than to 3ds Max mesh objects. An IGES
file with multiple meshes imports as a single NURBS model. Each IGES mesh
is a surface sub-object within the model.

Each surface sub-object based on an IGES mesh is initially a rigid surface on
page 2257. To edit the surface and its CVs on page 7946, you must first make the
rigid surface independent. The following procedure explains how to do this.

Future Compatibility

The group that maintains and updates the IGES standard, the IGES/PDES
(Product Data Exchange Standard) consortium, attempts to keep IGES upwardly
compatible. It's likely that files generated by the software will be compatible
with future versions of IGES.

See also:

■ 3ds Max to IGES Export Table on page 7231

■ Exporting IGES Files on page 7230

■ IGES Log Files on page 7225

■ IGES to 3ds Max Import Table on page 7228

■ Importing IGES Files on page 7226

Procedures

To make rigid imported NURBS surfaces independent:

1 Select the object.
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2  Go to the Modify panel.

3 In the Modifier Stack rollout, choose Surface as the sub-object level.

4 Select the surface sub-object you want to edit.

5 In the Surface Common rollout, click Make Independent.

NOTE Making rigid imported NURBS surfaces independent can take a long
time if there are complicated surfaces in the file, or if the file is large. Avoid
selecting all surfaces and then clicking Make Independent. Rather, save your
file immediately after successfully importing it, and then use Make
Independent with care.

IGES Log Files

During the translation process, the software creates log files containing detailed
information about the processing of the model. This information includes
error messages and entity-mapping statistics. You can use this log file to
understand what occurred during the translation.

The software places log files in the directory where the IGES file is either
imported from or exported to. The log file name has the prefix name of the
3ds Max file name, with the extension of .xli (input) for import, and .xlo
(output) for export.

The log file provides the following information:

■ Name of the file processed.

■ Number and severity of errors encountered, a description of them, and an
explanation of what can be done, or what was done to the data in error.
(The software attempts to fix many errors itself.)

■ Summary of entities processed.

■ List of the entity types encountered and those created.

See also:

■ Overview of IGES in 3ds Max on page 7223

■ 3ds Max to IGES Export Table on page 7231
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■ Exporting IGES Files on page 7230

■ IGES to 3ds Max Import Table on page 7228

■ Importing IGES Files on page 7226

Importing IGES Files

File menu > Import > IGES (*.IGE, *.IGS, *.IGES)

IGES files are used to import and export NURBS objects to and from 3ds Max
(and other programs that support this file format). For more information, see
Overview of IGES in 3ds Max on page 7223.

In some cases, when you import an IGES file, the translation doesn't produce
exact replicas. To understand what happens to each entity when it's translated,
review the IGES import table on page 7228.

3ds Max imports an object containing multiple surfaces as a single NURBS
object. To work with a single surface of the object, detach it in sub-object
NURBS and work with only that object. This releases the rest of the object
from memory. For more information, see NURBS on page 7224.

When you import IGES files, 3ds Max creates a log file containing detailed
information about the processing of the model. The name of the file has the
form of filename.xli. For more information, see IGES Log files on page 7225.

NOTE 3ds Max creates and uses a few temporary files during translation.
Temporary files can be large. If there has been a computer or IGES translation
failure and temporary files remain on your system, they might need to be removed
to free up disk space. For storage of these temporary files in Windows, 3ds Max
uses the directory specified by the TEMP environment variable, or the current
directory if TEMP is not set.

See also:

■ 3ds Max to IGES Export Table on page 7231

■ Exporting IGES Files on page 7230

■ IGES Log Files on page 7225

■ IGES to 3ds Max Import Table on page 7228

■ Importing IGES Files on page 7226
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Procedures

To import an IGES file:

1 Choose File menu > Import.

2 Specify the IGES file to import from the file selector dialog.

You can choose IGES (*.IGE, *.IGS, *.IGES) from the Files Of Type list to
display only IGES files.

3 From the IGES Import dialog, select Merge Objects With Current Scene
or Completely Replace Scene.

4 To review the translation process, read the .xli log file with your preferred
text editor.

Interface

IGES Import

The IGES Import dialog has the following controls:

Merge objects with current scene Merges imported data with the current
scene.

Completely replace scene Completely replaces the current scene with the
imported data.
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IGES to 3ds Max Import Table

The following table lists IGES entities and the 3ds Max objects they translate
to when you import them. Any IGES entities not listed here do not import.

3ds MaxIGES entity nameIGES entity number

Arc ShapeCircular Arc100

Spline ShapeComposite Curve102

Spline ShapeConic Arc104

Spline ShapeCopious Data106

NURBS Surface (unboun-
ded converts to construc-
tion plane)

Plane108

Spline ShapeLine110

NURBS CurveParametric Spline Curve112

NURBS SurfaceParametric Spline Surface114

Point HelperPoint116

NURBS SurfaceRuled Surface118

NURBS SurfaceSurface of Revolution120

NURBS SurfaceTabulated Surface122

NURBS CurveRational B-spline Curve126

NURBS SurfaceRational B-spline Surface128
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3ds MaxIGES entity nameIGES entity number

NURBS CurveOffset Curve130

NURBS SurfaceOffset Surface140

NURBS SurfaceBoundary Curve141

NURBS SurfaceCurve on Parametric Sur-
face

142

NURBS SurfaceTrimmed Parametric Sur-
face

144

NURBS SurfaceBounded Surface143

NURBS SurfaceSolid186

InstanceSubfigure Definition308

NURBS ObjectGroup402

Notes

The 3ds Max objects translated from IGES can have surface sub-objects.

IGES import supports name and color mappings to 3ds Max names and colors.

When you import IGES files, names are mapped by using the level name
followed by a colon, and then the object name.

See also:

■ 3ds Max to IGES Export Table on page 7231

■ Exporting IGES Files on page 7230

■ IGES Log Files on page 7225

■ IGES to 3ds Max Import Table on page 7228

■ Importing IGES Files on page 7226
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Exporting IGES Files

File menu > Export > IGES (*.IGS)

IGES files are used to import and export objects to and from 3ds Max (and
other programs that support this file format). For more information, see
Overview of IGES in 3ds Max on page 7223.

In some cases, when you export 3ds Max objects to an IGES file, the translation
doesn't produce exact replicas. To understand what happens to each object
when it's translated, review the IGES export table on page 7231.

When you export IGES files, 3ds Max creates a log file containing detailed
information about the processing of the model. The name of the file has the
form of filename.xlo. For more information, see IGES Log files on page 7225.

NOTE If there are modifiers applied to surfaces in your scene, it's best to collapse
the stack before exporting to IGES. When 3ds Max exports to an IGES file, it skips
any surface that has any modifiers applied.

See also:

■ 3ds Max to IGES Export Table on page 7231

■ IGES Log Files on page 7225

■ IGES to 3ds Max Import Table on page 7228

■ Importing IGES Files on page 7226

■ Overview of IGES in 3ds Max on page 7223

Procedures

To export an IGES file:

1 Select the objects to export.

2 Choose File menu > Export.

3 Choose IGES (*.IGS) from the Save as type list in the file selector dialog.

4 Specify a file name to export.

5 Click Save.
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6 From the IGES Export dialog, select Export Hidden Objects or Export
Selected Objects Only.

7 To review the translation process, read the .xlo log file with your preferred
text editor.

Interface

IGES Export

The IGES Export dialog has the following controls:

Export Hidden Objects Exports objects that are currently hidden in the 3ds
Max scene.

Export Selected Objects Only Exports only objects that are currently selected.

3ds Max to IGES Export Table

The following table lists 3ds Max objects and the IGES ID and IGES Type they
translate to when you export them. Any 3ds Max objects not listed here do
not export.
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NOTE The convention for denoting the type of IGES entity is the numerical
construction type:form. For example, 214:2 is the IGES entity number 214, form
2. Form numbers can also be signed (given a positive or negative value).

IGES entity numberIGES entity name3ds Max object

128Rational B-spline SurfaceSurface

143Bounded SurfaceNURBS Surface

143/144Bounded SurfaceTrimmed Surface

126Rational B-spline CurveCurve

116PointPoint

402:7GroupGroup

308Subfigure DefinitionInstance

408Subfigure Definition(s)Instance(s)

Notes

When 3ds Max exports IGES, it supports name and color mappings to IGES
names and colors.

Since IGES requires unique names per element, 3ds Max will append a unique
identifier to multiple objects with the same name.

See also:

■ Exporting IGES Files on page 7230

■ IGES Log Files on page 7225

■ IGES to 3ds Max Import Table on page 7228

■ Importing IGES Files on page 7226

■ Overview of IGES in 3ds Max on page 7223
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JSR-184 Files

File menu > Export > JSR-184 (*.M3G)

3ds Max provides support for developing mobile games using the JSR-184
format. JSR-184 is a Java standard used to create 3D applications for mobile
phones. Once you have exported your scene to JSR-184 format, you can preview
the animation using the JSR-184 Standalone Player on page 7245.

Procedures

To export an M3G file:

1 Choose File menu > Export.

2 Choose JSR–184 (*.M3G) in the Files Of Type list.

3 Specify a file name to export, and then click Save. This opens the JSR-184
dialog, displaying the scene hierarchy for your 3ds Max scene. By default,
all of the elements in your scene are also listed for export in the JSR-184
scene.

NOTE If you wish to export a particular object in your scene, use File > Export

Selected, or delete the objects you do not wish to export by clicking 
. If an object is a descendant within an hierarchy, it will be exported with its
hierarchy. The same applies for objects in a group.

4 Modify the parameters of objects exported to JSR–184. See JSR-184 Object
Parameters on page 7236 for more info.

5 Click Export.

6 Preview your exported JSR-184 scene in the JSR-184 Standalone Player
on page 7245.
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Interface

The 3ds Max scene hierarchy is shown on the left of the dialog, and the
hierarchy of the JSR-184 scene to be exported is displayed on the right. Object
parameters for the JSR–184 scene are displayed on the far right-hand side of
the JSR-184 Export dialog. The exported m3g file contains all of the objects
and parameters included in the JSR-184 scene. Many of the parameters for the
objects in the JSR-184 scene can be modified prior to exporting the file. See
JSR-184 Object Parameters on page 7236 for more details.

Menu options:

 New JSR-184 Scene Creates an empty JSR-184 scene

 Add 3ds Max Scene Adds all objects that can be converted to the
JSR-184 format to the JSR-184 scene.
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 Add World Object Adds a World Object to the JSR-184 scene file. A
World Object contains sub-object hierarchies and has two special sub-objects:
Active Camera and Background.

 Add Group Adds an empty Group. Use this option to group objects
in your scene without the need to create a World Object.

 Convert Mesh to Sprite3D Converts a selected 3ds Max plane object
into a JSR-184 Sprite3D object. If you do not select this option, by default all
plane objects are converted to JSR-184 mesh objects.

 Texture Tool All the textures of objects in your 3ds Max scene are
placed in the Material Table level of JSR184 image file. Use the JSR-184 Texture
Tool on page 7241 to edit texture properties.

 Remove Object Removes the selected object from the JSR-184 scene.

Export Settings:

Authoring Message This message is required by the JSR-184 file format
standard and is usually reserved for entering copyright notice information.
This message is stored in the header portion of the M3G file.

Project Root Sets the location of the root of the project. If you do not enter
a path in this field, all external references within the M3G file are loaded from
the same location as the current file.

Show Hidden Objects Shows all the hidden objects in the 3ds Max scene
hierarchy.

Compress M3G File Compresses all the data in the exported M3G file.

Auto Assign User IDs Automatically assigns unique User ID values to all
exported objects.
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See also:

■ JSR-184 Object Parameters on page 7236

■ JSR-184 Texture Tool on page 7241

■ JSR-184 Log Files on page 7243

■ JSR-184 Standalone Player on page 7245

JSR-184 Object Parameters

File menu > Export > JSR-184 (*.M3G).

The JSR-184 data file is represented as the root object of your scene. Many of
the parameters of objects in the JSR-184 data file can be adjusted to optimize
the output of your scene. You can preview your exported scene using the
JSR-184 Standalone Player on page 7245.

NOTE All editable parameters are displayed in italic.

The JSR-184 Data File

Material Table

Material Table is a special object that contains all the materials and textures
used in the JSR-184 scene. The Material Table has a two-level structure: the
3ds Max material name is the first level and its associated textures comprise
the second level. The Material Table is represented as [Material Table] in the
JSR-184 scene tree.

The 3ds Max level displays the following parameters:

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Layers: Sets the rendering layer for the JSR-184 Appearance Object. When
rendering a World, Group, or Mesh, submeshes and sprites are rendered
in the order of ascending layers.

The texture level displays the following parameters:

■ Approx.Object Size: Shows the object size with sub-objects.
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■ User-defined ID: Displays the user ID for the object.

■ Blending: Specifies how to combine the filtered texture color with the
incoming fragment color in a texturing unit. This is equivalent to the
texture environment mode in OpenGL. Options are Add, Blend, Decal,
Modulate, and Replace.

■ WrappingS and WrappingT: The Repeat and Clamp texture wrapping
modes define the treatment of coordinate values that are outside the [0,1]
range.

■ Level Filter: Sets the texture filtering. Options are Nearest, Linear, and Base
Level.

■ Image Filter: Sets the image filtering. Options are Nearest, Linear, and Base
Level.

World

World is a special Group node that is a top-level container for scene graphs.
A World Object is represented as <<World>> in the JSR-184 scene tree. Every
world object has three sub-objects: [Background], [Active Camera], and
[Ambient Light]. A World object has the following parameters:

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Enable Rendering: Sets the picking enable flag of this node. The effective
rendering enable status for this node is the logical AND of the enable flags
on this node and all of its ancestors. This means that the World node is
disabled if any of its ancestors are disabled. The status of the World node
has an effect only if all its ancestors are enabled. If the effective status is
set to True, this node is enabled. If it is False, it is disabled.

■ Enable Picking: Sets the picking enable flag of this node. The effective
rendering enable status for this node is the logical AND of the enable flags
on this node and all of its ancestors. This means that the World node is
disabled if any of its ancestors are disabled. The status of the World node
has an effect only if all its ancestors are enabled. Options are True and
False.

■ Alpha Factor: Allows groups of mesh objects to fade in and out
conveniently, provided that certain preconditions related to their
appearance are met. The Alpha Factor is defined for each node, and its
value is between 0 and 255.
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■ Scope: Allows the scene graph nodes to form conceptual groups
independent of the scene graph hierarchy. By default, all objects are visible
to all cameras and lit by all light sources. The scope is an integer bitmask
set to -1 by default.

Background

Every world object has two sub-objects: [Background] and [Active Camera].
The only parameter available for the Active Camera is selecting an active
camera from sub-objects of the current World Object. Background parameters
are listed below:

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Image Mode X and Image Mode Y: Sets the background image repeat mode
for the X and Y directions. Image mode can be set to either Border or
Repeat.

■ Depth Clear Enabled: Enables or disables depth buffer clearing. If depth
buffer clearing is enabled, the portion of the depth buffer that corresponds
to the viewport is cleared to the maximum depth value. Set this parameter
to True to enable depth buffer clearing. Set it to False to disable.

■ Color Clear Enabled: Enables or disables color buffer clearing. If color buffer
clearing is enabled, the portion of the color buffer that corresponds to the
viewport is cleared with the background image and/or the background
color. Set this parameter to True to enable color buffer clearing. Set it to
False to disable.

Group

Group is a scene graph node that stores an unordered set of nodes as its
children. A Group object is represented as <<Group>> in the JSR-184 scene
tree.

NOTE Since most JSR-184 objects cannot contain any sub-objects, the JSR-184
exporter uses the Group object to represent the 3ds Max hierarchy. In this case,
the Group object is assigned a name such as <<ObjectName Group>>, where
ObjectName is the name of the 3ds Max object with sub-objects. Parameters
available for Group objects are the same as parameters for World objects.
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Camera

Camera is a scene graph node that defines the position of the viewer in the
scene and the projection from 3D to 2D. A Camera object is assigned the same
name as its counterpart in the original 3ds Max scene.

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Scope: Allows scene graph nodes to form conceptual groups independent
of the scene graph hierarchy. The default scope is -1, implying that all
nodes are in the same scope. By default, all objects are visible to all cameras
and are lit by all light sources.

■ Projection Type: Sets the projection mode for the Camera. Options are
Parallel and Perspective.

Ambient Light

Ambient light represents the ambient light color from the 3ds Max
environment setting. Ambient light parameters are the same as Light
parameters.

Light

Light is a scene graph node that represents different kinds of light sources. A
Light object is assigned the same name as its counterpart in the original 3ds
Max scene.

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Enable Rendering: Sets the light to On or Off. Options are True and False.

■ Scope: Allows scene graph nodes to form conceptual groups independent
of the scene graph hierarchy. The default scope is -1, implying that all
nodes are in the same scope. By default, all objects are visible to all cameras
and are lit by all light sources.

Sprite3D

Sprite3D is a scene graph node that represents a 2–dimensional image with a
3D position. The only way to create a Sprite3D object is to convert a
two-polygon 3ds Max mesh object. A Sprite3D object is named “Sprite,
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ObjectName,” where ObjectName is the name of the corresponding 3ds Max
mesh object.

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Enable Rendering: Sets the rendering enable flag of this node. The effective
rendering enable status for this node is the logical AND of the enable flags
on this node and all of its ancestors. This means that this node is disabled
if any of its ancestors are disabled. The status of this node has an effect
only if all its ancestors are enabled. If the effective status is set to True, this
node is enabled. If it is False, it is disabled.

■ Scope: Allows scene graph nodes to form conceptual groups independent
of the scene graph hierarchy. The default scope is –1, implying that all
nodes are in the same scope. By default, all objects are visible to all cameras
and are lit by all light sources.

Mesh

■ Approx.Object Size: Shows the object size with sub-objects.

■ User-defined ID: Displays the user ID for the object.

■ Scope: Allows scene graph nodes to form conceptual groups independent
of the scene graph hierarchy. The default scope is –1, implying that all
nodes are in the same scope. By default, all objects are visible to all cameras
and are lit by all light sources.

■ Projection Type: Sets the projection mode for the Camera. Options are
Parallel and Perspective.

Morphing Mesh

Morphing mesh is a scene graph node that represents a vertex-morphing
polygon mesh. A morphing mesh object is assigned the same name as its
counterpart in the original 3ds Max scene. Morphing mesh parameters are
the same as mesh object parameters.

NOTE Morphing animation is not supported. A Morphing mesh is exported with
morph targets. If you wish to export a morphing mesh animation, set animated
weights to morph targets during playback.
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Skinned Mesh

Skinned Mesh is a scene graph node that represents a skeletally-animated
polygon mesh. A skinned mesh object in the JSR-184 scene is assigned the
same name as its counterpart in the original 3ds Max scene. Skinned mesh
parameters are the same as Mesh Object parameters.

NOTE Biped meshes are not supported.

JSR-184 Texture Tool

File menu > Export > JSR-184 (*.M3G). > Name your file and click OK. > Select
a texture in your scene. > Click the Texture Tool button to edit the texture
properties.

You can edit the parameters that are exported for the textures in your JSR-184
scene. The Texture Tool dialog displays a preview of the texture with its current
settings. When you select different options, the preview is updated to reflect
the changes. You can modify the parameters described in this topic.

NOTE If the image is not a texture, then you can choose any palette in the Image
Format group.
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Interface

Image Width group

The JSR-184 format requires that texture sizes use the “power of two rule,”
and supports texture sizes less than or equal to 2562. You can select either 2,
4, 8, 16, 32, 64, 128, or 256.

If you want to modify the image width of all of the textures in your JSR-184
scene, turn on Apply To All; otherwise, the changes affect only the selected
texture.

Image Height group

These are the same options as Image Width: you can select either 2, 4, 8, 16,
32, 64, 128, or 256.

If you want to modify the image height of all of the textures in your JSR-184
scene, turn on Apply To All; otherwise, the changes affect only the selected
texture.

Image Format Group

Changes the color model of all textures in your JSR-184 scene.
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If you want to modify the image format of all of the textures in your JSR-184
scene, turn on Apply To All; otherwise, the changes affect only the selected
texture.

■ RGB 24 bit (16.7 Million of colors) Changes the color model to RGB color.

■ Grayscale 8 bit (256 grayscales ) Changes the color model to grayscale.

■ Optimized Palette (256 colors adaptive palette) Changes the color model
to a limited 256-color palette.
The Optimized Palette option is available only when the Save To External
File option is on. This palette does not support an alpha channel.

Save to External File
When on, saves the texture as an external file (in PNG format) in the same
directory as the M3G file. If you do not select this option, the texture is
saved as part of the M3G file only.

Alpha Channel
When on, saves the alpha channel with the texture.

JSR-184 Log Files

File menu > Export > JSR-184 (*.M3G).

When you export an M3G file, the JSR-184 Export feature creates a log file.
This log file is an HTML file, saved in the same directory as the M3G file. The
table contains an entry for all the objects exported to the M3G file format.

■ Object # Indicates the root object value. When multiple root objects
exist in the M3G file, this value is used by the JSR-184 Load object to load
the correct object.

■ Object Name Contains the name of the corresponding 3ds Max object.

■ Object Type Indicates the type of saved object.

■ User ID Displays the User ID for the object.

■ Object Size Shows the object size (in kilobytes) for the object.

■ Comments Displays additional information such as errors and
warnings.
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Below is a sample of a simple log file:

CommentsObject SizeUser IDObject
Type

Object
Name

Object #

1610Vertex Ar-
ray

890Vertex Ar-
ray

480Vertex Buf-
fer

2130Triangle
Strip Array

300Material

330Appearance

780MeshBox01

660Group

890CameraCamera01

900LightOmni01

260Group

500Light

400Background

580World0
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JSR-184 Standalone Player

Start menu > Programs > Autodesk > Autodesk 3ds Max 2009 [installed version]
> JSR184 Viewer

Once you have exported your 3ds Max scene to JSR-184 format, you can
preview how the animation is displayed on various mobile screens.

Interface

File menu

■ Open Opens an M3G file for viewing in the JSR-184 player.

■ Reopen Displays a list of recently opened files. The list displays the most
recently opened files at the top.

■ Exit Closes the JSR-184 viewer window.
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Tools menu

■ Handsets Allows you to add or edit phone profiles. You can modify the
vendor, model, screen width, screen height, and screen color depth.

NOTE You can also modify the handset profiles directly in the terminals.xml
file in the c:\Program Files\Autodesk\3ds Max 9\JSR directory.

Player controls

The player is controlled by the following buttons on the toolbar:

■  Opens the Choose Objects for Rendering dialog. This dialog allows
you to select the JSR-184 world object in the scene hierarchy in the event
that there are multiple world objects in the JSR-184 data file.

■  Steps one frame backward through the animation.

■  Plays the animation.

■  Stops the animation and returns to the first frame.

■  Pauses the animation.

■  Steps one frame forward in the animation.

Phone Profiles Displays the phone profiles defined in the Tools > Handsets
dialog.

Use Free Camera Switches to viewing the scene from the free camera. The
camera is controlled by the following keyboard shortcuts:

Rotate LeftLeft Arrow
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Rotate RightRight Arrow

Rotate UpUp Arrow

Rotate DownDown Arrow

Move LeftA

Move RightD

Move BackwardS

Move ForwardW

Move camera to defaultHome

LandXML (XML, DEM) Files

Importing LandXML/DEM Models

LandXML/DEM Model Import lets you import land development data into
3ds Max. Civil engineering data, from XML, DEM (digital elevation model),
or DDF files, is used to create a 3ds Max model.
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The LandXML/DEM Model Import dialog on page 7249 allows for interoperability
with Autodesk products such as Land Development Desktop 3, Land
Development Desktop 2005, Civil 3D™, and CAiCE Visual PE. Once imported,
the models are ready for high-quality photorealistic rendering and animations.

LandXML File Types

There are three file types you can import with the LandXML/DEM Model
Import dialog: XML, DEM, and DDF.

■ XML is the most robust file type for LandXML import. In addition to surface
elevation data, XML files can also contain Alignment (road) and Parcel
data.

■ The DEM (digital elevation model) file type is the most commonly available
large area surface data type supplied by the USGS and other government
and private organizations. DEM files contain only surface data.

■ The DDF file type is an SDTS (spatial data transfer standard) format grid
surface. DDF files are very similar to DEM files; however, DDF information
is shared across multiple files.
The LandXML/DEM Model Import utility searches for the key DDF file in
the selected directory, which is identified by the following pattern: xxxxCEzz,
where xxxx is usually numeric and zz typically 'L0'.

Like DEM files, DDF files only contain surface data.
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LandXML/DEM Model Import Dialog

File menu > Import > Select File to Import dialog > Files of Type >
LandXML/DEM (*.DEM, *.XML, *.DDF)

In the LandXML/DEM Model Generator, you determine which parts of your
land development data are imported to 3ds Max. 3ds Max then creates separate
objects for each of the land features, including terrain surfaces, road
alignments, and parcels.

Interface

Object List Lists the terrain surfaces, alignment data, and parcel data in the
file to be imported. You can toggle the import of individual objects or entire
groups with their corresponding check boxes.

Three types of civil engineering data stored in LandXML files are supported:

■ Surfaces 3D TIN ground and finished surface model. Terrain surface data
is imported to 3ds Max as an editable mesh.

■ Alignments 2D road centerlines. Alignment data is imported to 3ds Max
as a Shape object.
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NOTE DEM and DDF files do not contain Alignment data.

■ Parcels 2D legal parcel or lot boundaries. Parcel data is imported to 3ds
Max as a Shape object.

NOTE DEM and DDF files do not contain Parcel data.

NOTE 2D Alignment and Parcel shapes are created on top of the highest terrain
surface.

File Data group

The File Data group displays information about the file to be imported,
including date of creation, author, the application used to create the file, and
the units.

Object Creation Options group

The Object Creation Options group lets you set the import properties for
selected objects.

Color The color of the object when it is imported into 3ds Max. To change
this setting, click the color swatch and select a new color from the Color
Selector.

Smooth Surface Applies smoothing to the geometry, based on the Smoothing
Angle setting. Edges between faces that have an angle between them that is
greater than the specified smoothing angle will appear faceted in the scene.
Edges between faces that are below or equal to the specified angle are
smoothed.

NOTE This option is only available for terrain surface objects.

Smoothing Angle Determines the size of the smoothing angle.

NOTE This option is only available for terrain surface objects.

Model Creation Options group

Set Scene Units from file Changes the 3ds Max Scene Unit to match the units
of the incoming file.
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NOTE This setting is only available when the 3ds Max scene is empty. If there is
geometry in your scene, this setting is not available.

The units setting of the incoming file is displayed in the drop-down list.

Vertical Exaggeration Scale Artificially exaggerates the terrain surface to
enhance subtle details by applying a scale factors to the vertical dimensions.

TIP This can be useful for very flat surface models.

Exporting Lightscape Files

You can export your 3ds Max scenes to Lightscape. Lightscape is a visualization
application that uses radiosity and ray tracing to create accurate lighting for
3D models.

NOTE This feature is being retired. For more detailed information about Lightscape
export and import, you can refer to the 3ds Max 8 reference. You can download
the v8 reference from the Autodesk Web site: go to www.autodesk.com, choose
Support, pick the product Autodesk 3ds Max, and then choose Documentation.

You can export several Lightscape file formats from 3ds Max. The Lightscape
Preparation (*.lp) file is the main format Lightscape uses. Other Lightscape file
formats save selected portions of the information in the LP file. These are the
additional Lightscape file formats:

■ View file (*.vw): Exports the active view, or selected camera views.

■ Block file (*.blk): Exports materials, lights, and geometry. Blocks in a block
file can be selectively loaded into Lightscape.

■ Material file (*.atr): Exports materials.

■ Layer file (*.lay): Exports layers.

■ Parameter file (*.df): Exports processing parameters.

Overall Workflow for Exporting a Lightscape Preparation (LP) File

1 Select the object to be exported.

2 Open the Export Lightscape Preparation File dialog.
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3 If your scene uses standard lights, set the units and scale, and then set
the light conversion method.

4 If you are exporting an animation, select the frames to be exported.

5 If your scene uses daylight, set the daylight parameters.

6 Select the cameras to be exported.

7 Export the file on page ?.

Procedures

To export a Lightscape file:

1 Choose File > Export.

The Select File To Export Dialog is displayed.

2 Use the Save As Type list to choose which kind of Lightscape file format
you are exporting.

3 Use the Save In list to navigate to the appropriate directory.

4 In the File Name field, enter the name of the file that you want to create,
and then click Save.
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To get version information about the Lightscape exporter:

1 Export one of the Lightscape file types.

A dialog with options for that file type is displayed.

2 Click About.

An About dialog is displayed. The dialog shows the version of the
Lightscape exporter.

Importing Lightscape Files

Just as you can export a Lightscape Preparation (LP) file, you can also import
one into 3ds Max. You can also import Lightscape Solution (LS) and Lightscape
View (VW) files.

NOTE This feature is being retired. For more detailed information about Lightscape
export and import, you can refer to the 3ds Max 8 reference. You can download
the v8 reference from the Autodesk Web site: go to www.autodesk.com, choose
Support, pick the product Autodesk 3ds Max, and then choose Documentation.

The steps to import a Lightscape file include:

■ Accessing the import dialog.

■ Choosing to replace the current scene.

■ Choosing how to group the imported objects.

■ (LS files.) Specifying a prefix for imported Lightscape objects.

■ (LS files.) Choosing which Lightscape objects to import.

■ (LS files.) Choosing the conditions for importing Lightscape lights.

■ (LS files.) Choosing the radiosity mapping settings.

NOTE The Lightscape importer does not convert Lightscape layers into 3ds Max
scene layers, because it was written before that feature was implemented.

Procedures

To import a Lightscape (LS, VW, or LP) file:

1 Choose File > Import.
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The Select File To Import dialog is displayed.

2 Choose Lightscape (*.LS, *.VW, *.LP) from the Files Of Type drop-down
list.

3 Use the dialog's controls to browse to the directory that contains the file
you want to use. Highlight the name of that file, and then click Open.

Depending on the type of file you chose, an Import Lightscape Preparation
dialog or an Import Lightscape Solution dialog is displayed.

No dialog is displayed when you import a Lightscape view (VW) file.

To replace the current scene:

When you import a Lightscape Solution or Preparation file, you can choose
to add the imported objects to the current scene, or to replace entire scene.

1 In the Import Lightscape Preparation dialog, turn on Replace Current
Scene.

2 In the Import Lightscape Solution dialog, turn on Replace Scene Contents.

To group imported objects:

■ In the Import Lightscape Preparation or the Import Lightscape Solution
dialog, use the controls in the Entity Grouping group to choose how
imported Lightscape objects are grouped.
See each dialog's description for details about these options.

To get version information about the Lightscape file importer:

1 Access the Import Lightscape Solution dialog.

2 Click About.

An About Lightscape LS File Import dialog is displayed. This shows the
version of the importer that is currently installed.

Lightscape Materials Utility

Utilities panel > Click More. > Utilities dialog > Choose Lightscape Materials.
> Lightscape Materials rollout
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With the Lightscape Materials utility, you can add the Lightscape material on
page 5741 to multiple objects, and remove the Lightscape radiosity material
from multiple objects.

Interface

Selected Object group

Displays the name of the currently selected object. If no objects are selected,
displays None Selected. If more than one object is selected, displays Multiple
Selected.

Add to All Click to add a Lightscape material to all materials used by all objects
in the scene.
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An object's previous material, if any, becomes the Lightscape material's base
material. If a material is already using a Lightscape material, it remains
unchanged.

You set the new Lightscape material's values in the Radiosity Mapping group,
described below.

Add to Selected Clicking to add a Lightscape material to all materials used
by the current selection.

An object's previous material, if any, becomes the Lightscape material's base
material. If a material is already using a Lightscape material, it remains
unchanged.

You set the new Lightscape material's values in the Radiosity Mapping group,
described below.

Remove from All Click to remove the Lightscape material from all materials
used by all objects in the scene.

Each material's base material becomes the top-level material. If a material is
not using a Lightscape material, it remains unchanged.

Remove from Selected Click to remove the Lightscape material from all
materials used by the current selection.

Each material's base material becomes the top-level material. If a material is
not using a Lightscape material, it remains unchanged.

These parameters are used only when you add the Lightscape materials. They
set the initial values of the new Lightscape material.

Radiosity Mapping group

Brightness Controls the brightness of the displayed image on your monitor.
The setting of this control does not affect the actual lighting levels in the
model. Default=50.0.

Contrast Controls the contrast between light and dark regions in the model.
Default=50.0.

Ambient Light Controls the amount of 3ds Max ambient light that will be
mixed in with the radiosity calculations. If the value is 0.0, none of the 3ds
Max ambient light is used. If the value is 1.0, the full 3ds Max ambient light
is added into the radiosity calculations. Default=0.0.

Daylight Determines whether you want natural daylight to be used in the
calculation. Default=on.

Exterior Scene Used for exterior daylight simulations. Default=off.
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Motion Analysis Files (HTR/HTR2,TRC)

Importing HTR/HTR2 Files

File menu > Import > Motion Analysis HTR File (*.HTR)

The Motion Analysis HTR (Hierarchical Translation-Rotation) motion capture
file format is an alternative to the BVH on page 7922 format because it provides
flexibility in data types and ordering. It also has a complete base pose
specification, which consists of indicating the starting point for both rotations
and translations.

The stored data is grouped by segments; all motions from the first segment
are read, then those from the next segment, and so on.

The HTR format contains four sections: Header, Segment Names & Hierarchy,
Base Position, and the motion data section.

NOTE All section titles are displayed between square brackets ([]).

NOTE Comments within the HTR file are denoted by a hash mark (#).

The header section contains global parameter information:

■ file type

■ data type

■ file version

■ number of segments

■ number of frames

■ data frame rate

■ Euler rotation order

■ calibration units

■ rotation units

■ global axis of gravity

■ bone length axis

■ scale factor
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HTR2 is nearly identical to HTR, except that the data from the motion section
is organized differently in order to better suit a streaming data input (a
sample-major ordering is used to present the motion information).

On import, 3ds Max constructs a FK hierarchy rig from the incoming data.
The resulting bone skeleton is linked to a dummy object named after the HTR
file.

Interface

Skeleton group

Create Choose this option to build a new bone skeleton from the incoming
data. Default=on.

Segment Size Set this value to modify the scale factor for the weight and
height of all bones from the motion capture data. Only available if Create is
active.

NOTE This does not change the skeleton's scale.

End Effectors Toggle this option to import end effectors on page 7963 from the
incoming data, if they exist. Only available if Create is active.

Apply Choose this option to map the incoming data onto the children of the
selected skeleton root in your scene.

Keyframe Options group

Base Position  When on, imports only the keys of the base pose.

Animation When on, imports all animation keys. Default=on.
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Rotation Controller group

Euler/TCB Choose one of the two rotation controllers on page 3151 to apply
to the imported data.

Time Options group

These options (except Set Frame Rate) are only functional if the Animation
option in the Keyframe Options group is enabled.

All/Range Choose between using the entire animation range from the motion
capture file, or a defined portion.

From/To These values represent the start and end frames of the defined range.
Only available if Range is active.

Offset Sets the number of inserted empty frames before the imported
animation starts.

NOTE This does not affect the Base Position setting (in the Keyframe Options
group), which sets a key at frame 0.

Set Frame Rate When on, the frame rate on page 7987 from the HTR file
overwrites the current one in the Time Configuration dialog on page 7565.

Scale group

Global Sets the size of the resulting skeleton.

NOTE The scale value within 3ds Max remains 100.

Ok Proceeds with HTR/HTR2 import, using the current settings.

Cancel Cancels HTR/HTR2 import.

Importing TRC Files

File menu > Import > Motion Analysis TRC File (*.TRC)

The Motion Analysis TRC motion capture file format represents the raw form
(in ASCII) of tracking output. It contains a header section and a motion section.

All tracking markers stored in a TRC file contain global positioning data and
do not share parent-child relationships among themselves.
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On import, 3ds Max converts the incoming data as either spheres or points,
which are named according to the markers names.

You can convert an imported TRC motion into CSM format on page 3817using
the MACUtilities utility on page 3817 in order to map it onto a biped.

Interface

Cloud group

Create Choose this option to build a new set of marker objects. Default=on.

Apply Choose this option to map the incoming data onto the marker children
of the selected root in your scene.

NOTE The marker objects must be named to match the imported data.

Options group

Selected Items Only Imports the motion data only relative to the selected
objects in your scene. Available only if the Apply option (in the Cloud group)
is active.

Root Node Includes a root dummy on file import. Available only if the Create
option (in the Cloud group) is active.

Geometry group

These settings are available only if the Create option (in the Cloud group) is
active.
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Sphere/Point Choose between creating spheres or point helpers to illustrate
markers.

Size Sets the sphere diameter or point size, based on your choice above.

Time Options group

All/Range Choose between using the entire animation range from the motion
capture file, or a defined portion.

To/From These values represent the start and end frames of the defined range.
Only available if Range is active.

Offset Sets the number of inserted empty frames before the imported
animation starts.

Set Frame Rate When on, the frame rate on page 7987 from the TRC file
overwrites the current one in the Time Configuration dialog on page 7565.

Scale group

Global Sets the size of the resulting skeleton.

NOTE The scale value within 3ds Max remains 100.

Ok Proceeds with TRC import, using the current settings.

Cancel Cancels TRC import.

Exporting HTR/HTR2 Files

File menu > Export > Motion Analysis HTR File (*.HTR)

The Motion Analysis HTR (Hierarchical Translation-Rotation) motion capture
file format is an alternative to the BVH on page 7922 format because it provides
flexibility in data types and ordering. It also has a complete base pose
specification, which consists of indicating the starting point for both rotations
and translations.

The stored data is grouped by segments; all motions from the first segment
are read, then those from the next segment, and so on.

The HTR format contains four sections: Header, Segment Names & Hierarchy,
Base Position, and the motion data section.
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NOTE All section titles are displayed between square brackets ([]).

NOTE Comments within the HTR file are denoted by a hash mark (#).

The header section contains global parameter information:

■ file type

■ data type

■ file version

■ number of segments

■ number of frames

■ data frame rate

■ Euler rotation order

■ calibration units

■ rotation units

■ global axis of gravity

■ bone length axis

■ scale factor

HTR2 is nearly identical to HTR, except that the data from the motion section
is organized differently in order to better suit a streaming data input (a
sample-major ordering is used to present the motion information).

On export, the root object is named after your file name.

NOTE To have a successful export, you have to select the root of the desired
skeleton.

NOTE You can only export one bone hierarchy at a time.
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Interface

Base Position group

Saved Pose Choose this option to use the skeleton's pose at frame 0 as base
position data. Default=on.

Current Pose Choose this option to use the skeleton's pose at the current
frame as base position data.

Options group

Export Animation Enable to export all animation keys. Otherwise, only the
base position is exported.

Parent Transforms Enable to include the root object's animation data in the
export file.

Time Options group

These options are only functional if the Export Animation option in the
Options group is enabled.

Slider/Range Choose between using your scene's time slider on page 7528 range
or a defined portion.

From/To These values represent the start and end frames of the defined range.

Offset The exported animation starts after the number of frames set by this
value.
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Scale group

Global Sets the bone length scale factor in the export file.

Ok Proceeds with HTR/HTR2 export, using the current settings.

Cancel Cancels HTR/HTR2 export.

Exporting to Shockwave 3D

You can set up 3D scenes and animations in 3ds Max, and then export them
in Shockwave 3D (W3D) format for use in interactive presentations in
Macromedia Director. To start this process, choose File menu > Export, and
choose Shockwave 3D Scene Export (*.W3D) as the file type. Choosing this
format opens the Shockwave 3D Scene Export Options dialog on page 7265.

The Shockwave exporter in 3ds Max offers significant differences from the
3ds Max exporter previously available from Macromedia. When you prepare
a scene for exporting to Director, please be aware of the following:

■ Bones require special consideration when being exported to Shockwave
3D format. See “Exporting Bones” below.

■ Hidden objects are not exported. However, bones are exported whether
hidden or not.

■ The exporter supports specular lighting for light sources with Specular
turned on in the General Parameters rollout > Affect Surfaces group.

■ Some types of mapping distort or disappear on export. Whenever possible,
use Multi/Sub-Object materials rather than maps.

Exporting Bones

The exporter supports character animation using bones and the Skin modifier,
or a character studio® biped with the Physique® modifier. Bones are exported
not as geometry, but as Shockwave 3D bones.

If the bones deform a mesh with the Skin modifier, the scene must be arranged
in a specific manner to cause the bones and mesh to export properly:

■ All bones for each mesh object must be linked, and linked contiguously.
In other words, each bone must link to another bone, with one bone acting
as the root for the entire hierarchy.
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■ You'll get the best results if all bones are created in the same viewport, and
bones are created individually (not copied or mirrored).

■ All vertices in the skinned mesh must be assigned to at least one bone,
even if they constitute a part of the mesh that isn't animated. Otherwise,
the mesh will distort on export.

■ You must group the bones and the skinned mesh with the Group menu
> Group command prior to export. If you have more than one set of bones
with skinned meshes, create a separate group for each.

■ You can also export animation on IK chains and dummy objects. These
objects must be grouped with the skin and bones to export correctly.

For more tips on working with bones animation and the Shockwave 3D
Exporter, visit the
http://www.macromedia.com/support/director/work_3d/models_use_in_sw/models_use_in_sw07.htmlMacromedia
Web site. Also, search the Macromedia site for “bones shockwave export”
(without the quotes).

Shockwave 3D Scene Export Options Dialog

File menu > Export > Select File To Export dialog > Save As Type > Shockwave
3D Scene Export (*.W3D)

This dialog appears when you choose the Shockwave 3D format as the export
format for your scene.
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Interface

Resources to Export group

Scenegraph hierarchy Controls whether or not the parent-child hierarchy
between all geometry, light, group, and camera resources is written to the
Shockwave 3D file. This option should always be selected when exporting an
entire scene from 3ds Max. The Shockwave 3D scenegraph contains:

■ Information on parent-child relationships.

■ Information about what resources each scene element uses (for example,
the model resource used by a model in the scenegraph).

■ Controls for any modifiers associated with the geometry resources.
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■ Information about any cameras, lights, and groups in the scene. Shockwave
3D treats cameras, lights, and groups as less important resources, and stores
information about them only in the scenegraph.

The scenegraph hierarchy is the glue that binds most of the scene assets in
the Shockwave 3D file. If this option is turned off, only shader, texture, model,
and motion resources will be written to the W3D file, and all the other
information that specifies how objects exist in the scene, how the scene is
laid out, how the scene is lit, and how the scene is viewed will be missing. For
this reason, turn this option off only when exporting libraries of animations
or texture maps.

NOTE The exporter will remember this setting from one export to the next. Be
sure to turn on this option again before trying to export an entire scene. If you
do not, the result will be unusable (except as an object and texture library).

Geometry resources Exports all meshes and their associated bones to the
Shockwave 3D file. If this option is turned off, the preview window will be
completely black. All other designated resources will be written to the W3D
file.

Animations Writes out the animation on all objects supported by the exporter
to the Shockwave 3D file. The preview window is useful in quickly showing
which animations the exporter is capturing.

By default, the Shockwave 3D Exporter captures the animation of all objects
in the scene in every frame. This data is compressed into a streaming format
as the file is written. There may be times, however, when you only want to
capture part of an animation, or sample it more coarsely than once a frame.
If this option is cleared, the full scene will be displayed in the preview window
without any animations.
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NOTE 3ds Max supports direct animation of cameras and lights. If you animate
a camera or light, that animation will be exported, but an extra geometry node
will be inserted into the scene during the export process. This geometry node has
the animation of the camera or light applied to it, and the camera or light is made
a child of this extra node.

The exporter does this because the Shockwave 3D runtime engine supports
keyframes only on geometric nodes. The extra node that the exporter creates
is named "Dummy Animation Node xyz", where xyz is the name of the
animated camera or light. This dummy geometry node also has a dummy
material applied to it named Dummy Material, and the geometry is invisible.

Lingo™ programmers should note that the camera or lights transform is now
relative to the dummy geometry node, that is, its parent.

IMPORTANT Animation export compression collapses non-bone-based hierarchies
(simple linked hierarchies in 3ds Max), so only animation assigned to the root
exports properly. For example, in a simple head animation where the eyes and
eyelids are linked to the skull, the skull movements export but the eye and eyelid
animations do not. Because 3ds Max groups do not collapse on export, you should
link each element of your chain, and then group each element with its parent
starting from the bottom of the chain and working to the top. Arrange each group's
pivot point, and then animate only the group objects, and not their contained
elements.

Material resources Exports all basic materials associated with all objects
supported by the exporter to the Shockwave 3D file. Materials represent the
most basic properties that can be assigned to a surface, such as diffuse color,
opacity, and specular color.

We strongly recommend that you leave this option on when exporting any
geometry, shader, or texture map resources. Turn this option off only when
exporting just the animation in a scene; otherwise, the W3D file will not work
correctly with Director.

Texture map resources Exports all texture maps associated with all objects
supported by the exporter to the Shockwave 3D file. Texture maps in
Shockwave 3D are bitmap images or 2D procedural maps, such as Tile and
Gradient Ramp. All bitmap images used in 3ds Max are transformed by
Shockwave 3D into streaming JPEG images.
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NOTE The terms "Texture," "Map," and "Texture Map" are used interchangeably.
If this option is turned off, models will be untextured when first loaded into
Director, because they will have no texture information (despite their being visible
and fully shaded in the preview window). Once textures are assigned to the proper
shaders with Lingo, the models will look properly textured.

Shaders Exports all shaders in the Shockwave 3D file. Shaders are the
highest-level entities that describe surface properties. They bear no relationship
to the shaders used in 3ds Max. Shockwave 3D does not distinguish among
Blinn, Phong, Anisotropic, or any other shader algorithm that determines the
rendered look of materials and maps. Only Gouraud shading, which is most
closely emulated by the standard shaders in 3ds Max, is supported. Shockwave
3D shaders are primarily pointers to texture map resources on page 7268 and
material resources on page 7268.

NOTE The Shaders option should be used in conjunction with the Texture Map
Resources and Material Resources options. If this option is turned off, models will
be invisible when first loaded into Director, because they will have no shading
information (despite their being visible and fully shaded in the preview window).
Once shaders are assigned to the models with Lingo (Director's scripting language),
the models will become visible and look properly shaded.

Enable Toon and SDS When turned off, this option prevents the writing of
geometry data used by some of the more advanced Shockwave 3D technologies,
and thus reduces the overall file size.

If turned off, Toon and Subdivision Surfaces (SDS) data is not included in the
export file, which means that the Toon and Subdivision Surfaces modifiers
cannot be applied to the model in Director. A model missing this geometry
data can be used with all other Shockwave 3D technologies, however. Leave
this option turned on unless it is expedient to reduce the size of the W3D file.

NOTE There is no way to tell if a W3D file was exported with this option enabled
or disabled until you try to apply the Toon or SDS modifiers in Director. For this
reason, if you turn off this option, use a special naming convention to indicate
that a model doesn't have the Toon or SDS data in it.

Light resources Exports all lights in the scene to the Shockwave 3D file.

Turning this option off doesn't do anything unless the scenegraph hierarchy
option is also turned off. The only time you should turn this option off is
when exporting just the animation, geometry, or texture data in a scene.
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Camera Determines the viewpoint used for the scene in Director. This option
defaults to Active Viewport, but if any cameras exist in the scene, you can
choose one from the drop-down list.

NOTE In order to preview or export an animated camera, you must select that
camera from the list. Selecting Active Viewport with an animated camera will not
export that camera's animation.

Compression Settings group

The Shockwave 3D file contains all scene assets in a proprietary compressed
and streaming format. You can control the order in which data streams with
the user properties. The amount of compression of the scene assets is set by
three controls: Geometry Quality, Texture Quality, and Animation Quality.
The controls have values that range from 0.1 to 100.0, with higher values
giving less compression and better quality (a more faithful representation of
the original model).

A value of 100 means that the scene assets will be represented at the best
quality possible, but with some degree of compression still present. It does
not represent the value at which compression does not occur. Also, the
compression controls do not have a linear scale, so a setting of 20.0 doesn't
necessarily mean that the quality level of the resulting data is twice as good
as that produced with a setting of 10.0.

Geometry quality Controls how much the scene geometry data (such as
vertex positions and normals and texture coordinates) is compressed. The
default of 25.0 generally produces a good compromise between data accuracy
and space savings.

Texture quality Controls the compression of textures (images) in the scene.

Animation quality Controls the compression of animation data in the scene.
Higher compression levels (lower quality) tend to remove the finer motions
authored in the scene, especially motion-capture data, while occasionally
introducing small noise artifacts.

NOTE You might need to use larger values of the Animation Sampling Interval
control on page 7271 (below) along with greater values of this setting to minimize
the file space consumed by animation while still maintaining acceptable motions.

Texture Size Limits group

The Texture Size Limits setting lets you reduce the size of the W3D file by
limiting the size of the texture maps in the export.

7270 | Chapter 23   Managing Scenes and Projects



The reduced size of the texture maps will usually look fine on the model,
because the model's UVW texture coordinates will have already taken into
account the non-square dimensions of the image. Use the smaller settings if,
after tuning the compression settings and simplifying the scene in 3ds Max,
the W3D file is still too large. If the scene contains no textures, or only small
textures, limiting the texture size will not help to reduce the size of the W3D
file.

No limits on texture size Exports all texture maps in the scene at the full
resolution of the image as used in 3ds Max. For example, a 2048 X 4096-pixel
image will be written to the W3D file at these dimensions (compressed, of
course).

512 by 512 pixels maximum Exports the texture maps so that no image
exceeds 512 X 512 pixels. A 2048 X 4096-pixel image will be scaled to a 512
X 512-pixel image; a 128 X 1024-pixel image will be scaled to a 128 X 512-pixel
image.

256 by 256 pixels maximum Exports the texture maps so that no image
exceeds 256 X 256 pixels. A 2048 X 4096-pixel image will be scaled to 256 X
256 pixels; a 128 X 1024-pixel image will be scaled to 128 X 256 pixels.

Animation Options group

The Animation Options group contains the controls to change how an
animation is captured.

Sampling interval This setting is used to capture object animation once every
specified number of frames.

Range These Start and End controls indicate which frames of the scene
animations are to be captured. By default, these values are set to capture the
entire animation interval specified in 3ds Max, sampling all animations in
the scene every frame.

Export Controls

Author Check Opens a window displaying warning messages about possible
problems found converting the scene to the W3D file format. If no errors are
found, the window is blank.

These messages, which do not necessarily indicate problems with the scene,
can be useful in debugging problems such as why the scene looks different in
the preview window than it does in 3ds Max. If the scene uses any 3ds Max
features that are not supported by the exporter, they will be listed here.
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Analyze Opens the Shockwave 3D File Analysis window on page 7274, displaying
a graphic breakdown of the data in the W3D file.

Preview Opens the Shockwave 3D Export Preview window on page 7272,
showing the scene as it will be exported.

File Opens the Choose Export File dialog, which lets you specify the name
and location of the file to be exported. When you click Save, you're returned
to the Export Options dialog; the file name and path you specified appear in
the field next to the File button.

NOTE Clicking the Save button does not save the W3D file; you must click the
Export button to create the file.

Export Exports the Shockwave 3D file, using the path and name specified
next to the File button.

View after export After you export a file, this option lets you view it in the
Preview window on page 7272.

Shockwave 3D Export Preview

File menu > Export > Select File To Export dialog > Save As Type > Shockwave
3D Scene Export (*.W3D) > Preview

This window displays the scene as it has been captured by the Shockwave 3D
Exporter. This view lets you quickly identify scene elements that are not
supported by the Shockwave 3D Exporter.
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In many cases the export preview window will display scene resources you
had decided not to export. Remember that this window displays the scene as
captured by the exporter and not necessarily how it is written to the W3D
format. Only those scene assets indicated under the export options and
supported by the exporter will be written to the W3D file.

Export with a Top, Front, Right, or orthographic viewport active in 3ds Max,
and the scene will be viewed through an orthographic camera. Export with a
Perspective or Camera viewport active in 3ds Max, and the scene will be viewed
through a perspective camera.

NOTE When navigating a scene, keep in mind that only the parts of models that
are in front of the camera will be rendered. Parts of models that penetrate the
camera plane and are behind the camera will not render, resulting in visual artifacts
("black holes" or "tearing") in the model. This is particularly noticeable when you
dolly an orthographic camera forward, because the lack of perspective effects does
not hide models as the camera passes them. Dolly the camera back, and any visual
artifacts should disappear.

You can navigate the export preview window using the following controls.
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Rotation

■ Drag (move the mouse with the left button held down)=orbit

■ Y+drag=rotating the camera with "Y-up" (particularly useful if the scene
was created in the "Y-up" environment)

■ Shift+drag=roll; vertical movement is ignored

Dolly

■ Ctrl+drag=dolly

■ Ctrl+Shift+drag=dolly faster

Pan

■ Spacebar+drag=pan

■ Shift+Spacebar+drag=constrain the movement to be either horizontal or
vertical, depending on the initial direction when you start dragging

Shockwave 3D File Analysis Window

File menu > Export > Select File To Export dialog > Save As Type > Shockwave
3D Scene Export (*.W3D) > Analyze

This window provides a graphic breakdown of the data in the W3D file. Click
OK to close the window.
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Interface

Pie Chart Graphic display of the proportion of the file used by all of the W3D
file data types. Refer to the color-coded Categories list, which gives a percentage
and an absolute size in kilobytes of each asset:

■ Geometry (in the initial load segment, if a model has a zero priority in
the sw3d_stream_priority user property, or in the streamable portion of
the file, if a model has a non-zero streaming priority)

■ Shaders (only in the initial load segment)

■ Textures (in the initial load segment, if the model that uses the texture
has a zero priority in the sw3d_texture_stream_priority user property, or
in the streamable portion of the file, if a model has a non-zero streaming
priority)

■ Materials (only in the initial load segment)

■ Lights (only in the initial load segment)

■ Animations  (only in the initial load segment)

NOTE Large animations can greatly lengthen the time it takes to see the start
of a Shockwave 3D animation, because they must fully download before any
of the scene can becomes visible.
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■ Nodes or scenegraph hierarchy data (only in the initial load segment)

■ Unknown includes, for example, streaming priorities, names, and block
sizes.

File Organization Graphic display of the size of the entire file and its initial
load segment (ILS) portion. The ILS, in orange, consists of all the data that
must be loaded before Shockwave will display the scene (scenegraph data,
animations, shaders, and any textures or geometry with a streaming priority
of zero). The rest of the file, in light blue, represents all of the streamable data
with a non-zero streaming priority. This data will continue to load and fill
out the detail of the scene as the download proceeds.

Runtime Texture Information Approximate texture memory that will be
required at run time to display the textures in the scene. Scenes requiring
more than a few megabytes of texture memory will require accelerated graphics
cards to display textures at their full resolution.

Stereolithography (STL) Files

Importing STL Files

File menu > Import > StereoLitho (*.STL)

An STL file saves object data in a format used for stereolithography. STL files
have a filename extension of .stl. There is an ASCII STL format as well as a
binary STL format. You can choose which to create when you export a 3ds
Max scene.

STL files are generally used for purposes of rapid prototyping. A variety of
methods use the STL format to construct prototypes. For example, many STL
machines use a liquid polymer and harden it in small slices, creating a solid
plastic model. Other STL machines use metal powder to create a model in
steel. Still other machines use a special wax.

You can import and export STL files. See Exporting to STL on page 7279.
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Name Enter a name for the 3D Studio object created from the STL file. Default
is the file name (without extension) or the name saved internally in the STL
file.

Weld Vertices group

Welds coincident vertices in the STL file into single vertices in the 3D Studio
mesh.

Weld Threshold Determines the size of the area which vertices must occupy
to be welded. Vertices with distances equal to or less than this value are welded
into a single vertex.

Weld Turns on the Weld Vertices function. In most cases, you should leave
this box turned on because unwelded objects can't be unified or smoothed.

Use Threshold If on, STL import uses the standard 3D Studio welding method.
This can be a very slow process.

Quick Weld If on, STL import uses a welding algorithm optimized for the STL
format. This is up to thirty times faster than standard 3D Studio welding, and
is highly recommended.

Auto-Smooth group

Auto-Smooth Applies smoothing groups on page 8130 to the geometry based
on the smoothing angle set by the smooth angle spinner. Edges between faces
that have an angle between them that is greater than the specified smoothing
angle will appear faceted in the rendered image. Edges between faces that are
below the specified angle are smoothed

Smooth Angle Determines the size of the smoothing angle.

Auto-Smooth Turns on the Auto-Smooth function.

Miscellaneous group

Remove Double Faces Removes one of the pair wherever two faces are
occupying the same location. Recommended.

Unify Normals Forces the normals on page 8059 of all faces on each object to
face the same way (usually out). If, when you render your scene, the face
normals are pointing in the wrong direction, use the Normal modifier to flip
them. For best results, leave this box turned on.
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Exporting to STL

File menu > Export > StereoLitho (*.STL)

An STL file saves object data in a format used for stereolithography. STL files
have a file-name extension of .stl. There is an ASCII STL format as well as a
binary STL format. You can choose which to create when you export a 3ds
Max scene.

STL files are generally used for purposes of rapid prototyping. A variety of
methods use the STL format to construct prototypes. For example, many STL
machines use a liquid polymer and harden it in small slices, creating a solid
plastic model. Other STL machines use metal powder to create a model in
steel. Still other machines use a special wax.

An STL object must define a complete and closed surface. You can check
whether the geometry you want to export satisfies this criterion by using the
STL Check modifier on page 1749.

You can also import STL files. See Importing STL Files on page 7276.
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Interface

Object Name Enter a name for the object you want to save in STL format.

Binary/ASCII Choose whether the STL output file will be binary or ASCII
(character) data. ASCII STL files are much larger than binary STL files.

Selected Only Exports only objects that you selected in the scene.

Wavefront (OBJ, MTL) Files

3ds Max can import and export the text-based (ASCII) Wavefront formats OBJ
and MTL. An OBJ file contains geometry descriptions. A MTL file is also text
based, and contains material descriptions that supplement the OBJ file.
Exporting and importing MTL files is done as an adjunct to the OBJ
export/import.
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NOTE  In Autodesk 3ds Max 2009, the legacy OBJ/MTL export/import
plug-in has been replaced by software from GuruWare. This module provides
enhanced functionality and improved performance. However, as a consequence,
separate MTL export is no longer available. Export and import of MTL files attached
to OBJ files is fully supported.

See also:

■ Exporting Wavefront Object (OBJ) Files on page 7281

■ Importing Wavefront Object (OBJ) Files on page 7285

■ Map-Export Dialog (OBJ) on page 7288

Exporting Wavefront Object (OBJ) Files

File menu > Export > Save as type > gw::OBJ-Exporter (*.OBJ)

The ASCII-based OBJ format makes it possible to exchange graphical data
between many applications. Both polygons and freeform geometries such as
curves are supported with this format. You can export 3ds Max files to this
format.

See also:

■ Importing Wavefront Object (OBJ) Files on page 7285

■ Map-Export Dialog (OBJ) on page 7288

Procedure

To export scene geometry to an OBJ file:

1 From the File menu, choose Export. Or, to export only the current
selection, choose Export Selected.

The Select File To Export dialog opens.

2 Enter the file name, optionally with the .obj file name extension. If you
don’t enter the extension, open the Save As Type drop-down list and
choose gw::OBJ-Exporter (*.OBJ).

3 Click Save.

The exporter dialog opens.
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4 Set parameters manually, or choose the name of the target program from
the Preset drop-down list. Optionally click Map-Export and set map-export
parameters.

5 Click Export.

During export, a dialog showing progress and the names of exported
objects opens. When the export is finished, click DONE to return to 3ds
Max.

Interface
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Geometry group

Flip YZ-axis When on, transfers all Y-axis values to the Z axis and vice-versa.
Use this when exporting to Poser and other programs that use Y as the vertical
axis and Z as the depth axis.

Shapes/Lines Enables export of splines and NURBS curves.

NOTE NURBS curves are exported as splines.

Hidden Objects When on, hidden objects are exported.

Faces Choose whether the mesh faces are stored as triangles, quadrangles, or
polygons.

Texture coordinates When on, texture coordinates are stored with the
exported file. When you import the file in another application you will be
able to use this information if it is supported.

Normals When on, the normal information on page 8059 for the mesh is stored.

Smoothing groups When on, the information about color transition between
groups is stored. See Viewing and Changing Smoothing on page 403.

Scale Determines the scaling for the contents of the OBJ file. The default value
of 1.0 means no scaling is performed.

Material group

Use material Determines whether the materials associated with the scene
objects are also exported to the OBJ file.

Create mat-library Determines whether the exporter creates a separate file
to store information about the materials. This creates a MTL library file in the
same directory as the OBJ file.

If Use Material is on but Create Mat-library is off, the OBJ file contains a
reference to a like-named MTL file, but the MTL file is not saved. Use this to
save time if the MTL file already exists.

Force black ambient Sets the Ambient component of exported materials to
black.

Map-Export Click to open the Map-Export dialog on page 7288
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Output group

Target Sets the target operating system of the computer on which the exported
data is to be used. Technically, this setting determines the line-end characters
for the ASCII OBJ file.

Relative numbers Causes face vertex indices in exported files to be expressed
as relative (i.e., negative) numbers. This can cause compatibility issues when
importing with certain programs. If you're unable to import an OBJ file, make
sure this option is off and export again.

Precision The precision of the exported vertex data, as expressed by the
number of decimal places.

Optimize group

Optimize Removes duplicate elements of the indicated type or types: vertices,
face normals, and texture coordinates.

Write log to Export-folder Saves a log file to the same folder as the OBJ file
when exporting via script.

Preset When exporting to a specific application, choose the application from
the list. Presets comprise all export settings, including geometry and materials.

 [edit presets] Click to open a dialog that lets you edit the
presets. To change the map path for a preset, edit the map-path setting
manually or click the folder button at the right end of the row and navigate
to the new path.

While the Presets dialog is open, you can choose a preset by clicking its name
(the row highlights) and then clicking OK.

Export Saves the exported files (OBJ + optional maps and material library)
according to the current settings.

During the export, a dialog shows the progress and saved files. When it’s
finished, click DONE to close the dialog.

Cancel Cancels the OBJ export.

Help Opens the help file to this topic.

About Opens a small dialog with information about this plug-in. To close
the dialog, click the image.
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Importing Wavefront Object (OBJ) Files

File menu > Import > Files of type > gw::OBJ-Importer (*.OBJ)

Geometry imported from OBJ files appears in 3ds Max as editable mesh objects.
Import of associated materials and maps is supported.

See also:

■ Exporting Wavefront Object (OBJ) Files on page 7281

■ Map-Export Dialog (OBJ) on page 7288

Procedure

To import an OBJ file:

1 From the File menu, choose Import.

The Select File To Import dialog opens.

2 Choose an OBJ file to open and click Open.

The importer dialog opens.

3 Choose the objects to import and set the import parameters. For details,
see the Interface section, following.

4 Click Import.

During import, a dialog showing progress and the names of imported
objects opens. If a name conflict occurs, a dialog opens giving you the
opportunity to skip or rename the object.
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Interface

Objects group

Reset scene Deletes the current scene from memory before importing the OBJ
file.

Prefix The importer prepends any text entered here to the name of each
imported object.

Import as single mesh When on, the importer combines the contents of the
OBJ file into a single editable mesh object, and gives the object the same name
as the file (without the file name extension).
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For example, if you import as a single mesh a file named window_parts.obj, all
separate objects in the OBJ file are combined into a single editable mesh object
named “window_parts”.

[file info] Just above the list of objects in the file, appearing as read-only fields,
are the name of the OBJ file and the total number of faces in the file.

[object list] The objects in the imported OBJ file appear in this scrolling list.
Each entry consists of an object name and the number of faces in the object,
plus a check box to the left of the object name for enabling and disabling
import per object.

By default, import is enabled for all objects in the file. To toggle import for
an individual object, click its check box in the list. You can also use the controls
at the bottom of the list to enable and disable import (see following).

All/None/Invert Use these buttons to modify the state of the import
enable/disable check boxes. All enables all objects in the list; None disables
all objects; Invert reverses the state of each check box.

[text field] Enter search phrases with wild cards into the editable text field to
the right of the Invert button to enable only objects that satisfy the search
criteria. For example, to enable all list items whose names start with “Sphere”,
enter sph*.

You can also use the standard search character ? to represent a single character.
For example, to enable all four-character names starting with “Box”, use the
search string box?.

Geometry group

Flip ZY-axis When on, transfers all Y-axis values to the Z axis and vice-versa.
Use this when importing from Poser and other programs that use Y as the
vertical axis and Z as the depth axis.

Center Pivots Positions the pivot of each imported object at its center. When
off, the pivots are positioned at the world center: (0,0,0).

Shapes/Lines Enables import of splines.

Texture coordinates When on, texture coordinates are loaded from the
imported file, if present, and associated with the geometry.

Smoothing groups When on, the information about color transitions between
groups is loaded. See Viewing and Changing Smoothing on page 403.

Object Scale Determines the scaling for the contents of the OBJ file on import.
The default value of 1.0 means no scaling is performed.
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Material group

Unique Wire Color Determines the wireframe colors assigned when importing
multiple objects without materials. When on, each object is assigned a different
wireframe color. When off, each object is assigned the same wireframe color,
picked at random.

Import Materials When on, imports materials from the MTL file associated
with the OBJ file.

Prefix Prepends the indicated text to the name of each imported material.
Enter the prefix in the editable text field to the right of the Prefix check box.

Default bump The default amount of bump maps if the value is not specified
in the MTL file.

Force black ambient Sets the Ambient component of imported materials to
black.

Import into Mat-Editor Brings imported materials into the Material Editor.
If this is off at import time and you later want to edit a material, you need to
use Get Material  on page 5341 first.

Show maps in viewport Turns on Show Map In Viewport on page 5350 for
imported materials’ Diffuse maps.

Write log to Import-folder Saves a log file to the same folder as the OBJ file
when importing via script.

Import Loads the designated files (OBJ + materials and maps) according to
the current settings.

During the import, a dialog shows the progress. If a name conflict occurs, a
dialog appears giving you the option to skip the duplicate object or rename
it.

Cancel Cancels the OBJ import.

Help Opens the help file to this topic.

About Opens a small dialog with information about this plug-in. To close
the dialog, click the image.

Map-Export Dialog (OBJ)

File menu > Export > Save as type > gw::OBJ-Exporter (*.OBJ) > Material group
> Map-Export button
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The Map-Export dialog provides settings for exporting maps as part of material
definitions along with exported OBJ files.

See also:

■ Exporting Wavefront Object (OBJ) Files on page 7281

■ Importing Wavefront Object (OBJ) Files on page 7285

Interface

use map-path When off (the default), uses the same folder as the OBJ file for
maps. When on, uses the designated folder (see following), relative to the
folder containing the OBJ file, for maps.

[map path] When Use Map-Path is on, specifies the folder relative to the
folder containing the OBJ file where the exporter should save maps. Edit the
path from the keyboard, or click the folder button to the right of the text box
and navigate to the desired folder.

Map Channel Specify a map channel using the numeric field, or, to set the
channel automatically, click Auto (disables the numeric field).
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extended map-params When on, stores the Bump Amount value and UVW
offsets in the MTL file.

convert bitmaps When on, resaves existing bitmaps used in materials
according to the Format seting and, optionally, the Size setting (see following).
When off, uses the original bitmaps without resaving.

Resaved maps go in the same path as the OBJ file, or, if Use Map-Path is on
(see preceding), in the designated folder.

When converting bitmaps, you can optionally turn on either of the following
two options:

■ resize When on, saves bitmaps at the resolution specified by the Size
settings.

■ 2n Scales each dimension of converted bitmaps to the nearest power of
two. For example, resizes a bitmap of resolution 200 x 900 to 256 x 1024.
Use this option when your target is a real-time 3D graphics engine.

render procedurals Creates bitmap images of procedural textures such as
Checker on page 5808, using the specified Format and Size settings. Use this
option when the intended target program doesn’t support 3ds Max procedural
maps.

Format Choose a file format for converted bitmaps. Choices are BMP on page
7328, JPG on page 7347, PNG on page 7360, TGA on page 7370, and TIF on page 7372.

Setup Opens the setup dialog for the active file format. For details, click a link
in the Format definition, preceding.

Size For converted, resized bitmaps and rendered procedurals, sets the output
resolution on the horizontal and vertical dimensions.

Close Closes the dialog, saving any changes.

VRML Files

Importing VRML Files

File menu > Import > Select File To Import dialog > Files Of Type > VRML
(*.WRL, *.WRZ)

You can import VRML 1.0, VRBL, and VRML 2.0/VRML 97 files into 3ds Max.
3ds Max imports geometry, materials (including diffuse texture maps), lights,
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perspective cameras and viewpoints, transformations, and grouping nodes
created by other VRML tools. Once they are in the scene file, you can edit,
modify, and animate these objects.

3ds Max also imports basic transform animations, such as position, rotation,
and scale. Also included are animated color and light. These correspond to
the basic animation that is exported by the VRML 1.0/VRBL and VRML97
exporters. Helper objects are not created upon import. Lighting effects are
somewhat simplified from the full VRML lighting model.

■ VRML97 files don't indicate the duration of an animation. If you import
animation from a VRML97 file, you might want to set the animation length
in 3ds Max manually.

■ More elaborate forms of animation and simulation, including Script nodes,
MovieTexture nodes, and sensor nodes, are not supported.

■ The VRML 1.0 WWW Inline works only if the URL refers to a local file
residing in the same folder as the .WRL file. Internet URLs are not
supported.

Interface

Reset Scene Deletes any existing scene upon import. If you turn off this option,
the imported VRML world is merged into the 3ds Max scene.

Turn to 3DS Coordinates Rotates the imported VRML world from Y, which
is "up" in VRML, to Z, which is "up" in 3ds Max. If you turn off this option,
VRML X, Y, and Z coordinates are imported without change.

Create Primitives Converts the VRML Box/Cube, Cone, Cylinder, and Sphere
nodes to corresponding 3ds Max primitives, if possible. If the VRML object
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has a texture on it, or if only part of the VRML object is to be created, a general
triangular mesh object will be created instead. If you turn off this option, 3ds
Max will convert these objects to triangular mesh objects.

Exporting to VRML97

File menu > Export > Select File To Export dialog > Save As Type > VRML97
(*.WRL)

3ds Max scenes can be exported to VRML97 file format.

See also:

■ VRML97 Export on page 7297

Procedures

To export a file to VRML97:

1 Choose File menu > Export.

2 Choose VRML97 (WRL) as the file format.

3 Enter a file name, and click Save.

4 In the VRML97 Exporter dialog, set options as described below.
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Generate group

Turning on any of these options increases the size of the VRML97 file generated
by the export process.

Normals Generates real normals for objects. Some browsers need normals to
do smoothing properly. Check this box if you are exporting geometry that
uses smoothing groups in 3ds Max, to see the correct shading. Default=off.

Coordinate Interpolators Exports animation effects that involve actual
modifications of the mesh objects, and not just move, rotate, and scale.
Examples include modifiers whose parameters can be animated.the Taper,
Bend, and Twist modifiers, and space warps. This option can generate large
files, because the exporter has to calculate the position of every vertex for this
kind of animation.

If your animations aren't exporting correctly, try exporting with this option
chosen. An example of animation motion requiring Coordinate Interpolators
is a stick figure made up of simple rectangular boxes that have bones Linked
to the boxes as a skeleton. Even though these boxes move through space
without any noticeable shape morphing, their motion will not be exported
without the use of Coordinate Interpolators, because their motion isn't derived
from simple transforms. Any animation achieved using the modifier stack or
object parameters needs Coordinate Interpolators. This includes animated
XForm modifiers.

Certain types of animations are not possible with Coordinate Interpolators;
for example, when the mesh being animated changes size between frames.
An example of this is animating the number of segments in a sphere. 3ds Max
warns you if it detects this type of animation on export.

Indentation Indents the VRML97 source code so it is easy to read. Default=on.

Export Hidden Objects Exports hidden objects. Default=off.

Primitives Exports VRML97 primitives, which reduces the file size because
these primitives are described very simply (for example, a sphere is described
by its radius). To see how many polygons are in the scene, turn off this box
to export 3ds Max primitives, which have an indexed face set for each object.
Default=on.

Flip-Book Exports the scene to multiple files. The sample rate is set in the in
the Flip-Book section of the Sample Rates dialog. The file name you specify
becomes the base for the sequence of files. For example, if you specify the file
name test.wrl, choose one file per animation frame, and have five frames, 3ds
Max exports the following:

test.txt contains general info, start/stop times, and number of frames.
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test0.wrl through test4.wrl are snapshots of the animation in frames 0 through
4.

Color Per Vertex Exports the vertex colors of geometry. If this is turned on,
the Color Per Vertex Source lets you choose the source of the vertex color.

Polygons Type

Determines how geometric faces are written out as VRML97 IndexedFaceSet
nodes.

Ngons Writes faces with as many edges as possible.

Quads Writes quadrilateral faces where possible (otherwise triangles).

Triangles Writes only triangular faces.

Visible Edges Breaks faces at internal edges that are marked as being visible.

Initial View

Sets the entry camera for the scene and controls what first appears in the
browser. If there are no cameras in the scene, the scene appears with a default
viewpoint (which may give only a partial view).

All scenes should have at least one camera, so you can control how the scene
initially renders. Add more cameras to the scene than you might ordinarily
use, so the viewer can switch between cameras if his VRML97 browser allows
it. This lets you set up your scene with pre-installed vantage points. Otherwise,
if the world is very large, it can overpower the viewer’s system and make
navigation difficult. Some browsers animate camera moves, so the extra
cameras can make viewing the scene more pleasant.

Initial Navigation Info

Specifies the Navigation Info helper object on page 7306 to use when the world
loads in the browser.

Initial Background

Specifies the Background helper object on page 7317 to use when the world
loads in the browser.
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Initial Fog

Specifies the Fog helper object on page 7307 to use when the world loads in the
browser.

Digits of Precision

Sets the number of decimal points used for calculating dimensions. The default
of 4 is usually sufficient. Set this number greater than 4 if parts of your world
were created 100,000 units away from the center of the scene. Setting the
value to 3 reduces the file size.

Show Progress Bar

Gives you the option to view a progress bar as the scene is exported.

Vertex Color Source group

Lets you choose the source for the vertex color when Color Per Vertex is turned
on.

Use Max's Exports the current vertex color of the object defined in the scene.

Calculate on Export Calculates the diffuse color at the vertices during export,
based on the current lighting and the objects’ materials.

Bitmap URL Prefix group

Lets you specify a URL prefix for bitmaps assigned to objects in the scene. You
must keep all your texture bitmaps in either the same directory as the WRL
file or in one other location, which you specify here. If your maps are stored
in other locations, you will have to manually search for the map in the WRL
and change its location. Not all browsers will display error messages if the
maps aren’t found on the WWW server.

Use Prefix Enables the prefix mechanism. If this box is turned off, image maps
must be in the same location as the WRL file.

Prefix Adds the prefix you enter here to the names of all assigned bitmaps.
The name can be a full URL (beginning with HTTP), or it can be a relative
path (a subdirectory of the location of the VRML97 file). For example, if you
enter "Maps" for the prefix, when the browser opens a VRML97 file that has
a texture map assigned to it, it will look for the subdirectory "Maps." “Maps”
must be a directory that is directly under the directory where the VRML97 file
resides.
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Use forward slashes (not backslashes) to enter longer paths; for example:
Myfiles/maps.

Sample Rate

Displays a dialog that lets you specify sample rates for controller-based and
coordinate-interpolated animation, as well as the Flip-Book output rates.
Setting sample rates lets you trade off between animation fidelity and file size.
The default values give good results in most cases. For the greatest animation
precision, use a lower number (a higher sampling rate).

World Info

Lets you enter information about the world. This has no effect on the visual
appearance or behavior of the world. Some browsers can display what you
enter in the Title field, for example, in the browser window’s title bar. You
can use the Info field to provide author, version, and copyright information.

VRML97 Export

Vrmlexp.dle is for creating and exporting scenes in the VRML97 format.
VRMLEXP exports .wrl files, which can be viewed in any VRML97 browser.

Make sure that you have the most current version of your VRML browser and
check its documentation to insure that it supports VRML97.

This documentation covers:

VRML97 Helper Objects on page 7301

Exporting to VRML97 on page 7292

VRML97 Tips on page 7298

VRML97 Specification on page 7301

Procedures

To create VRML97 files:

1 Create the objects that make up the scene.

2 On the Create panel, choose Helpers.

3 Use the tools in the VRML97 Helpers on page 7301 to add actions and
triggers and prepare the scene.
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4 Choose File > Export and export the scene in the VRML97 format.

5 Open the VRML97 file in the browser and test it.

Interface

The VRML97 exporter supports the following:

Lights All VRML97 light types: direct, omni, and spot.

Cameras Free and targeted cameras.

Primitives Sphere, cone, box, and cylinder primitive objects. These objects
export as VRML97 primitive objects. This helps reduce the size of VRML97
files.

Animation All position, rotation, and scale animation on objects, as well as
animated hierarchies, inverse kinematics, and all controller types. Select
Coordinate Interpolators on page 7292 in the Export dialog to export animated
meshes, such as an animated Bend modifier or character studio Physique
animations.

VRML97 Tips

The following tips will help you make your work look as good as possible and
display and move as fast as possible.

Geometry

Use small texture maps, and use them sparingly. Keep the polygon count of
your objects down to achieve good performance. A complete scene with a
maximum of 5,000 to 10,000 polygons is manageable for most computers.
The Level of Detail on page 7311 helper lets you manage the polygon count of
objects in the scene. You can also use the software’s Optimize modifier to
simplify objects before exporting them to VRML97.

Use primitives whenever possible. For example, a scene containing only a
sphere exports to a VRML97 file of about 400 bytes, but if you apply an edit
mesh modifier and move one vertex on the sphere, the VRML97 file is about
7,400 bytes.

Use Show Statistics on page 2577 to keep track of the number of faces in your
scene.
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Call your VRML97 .wrl files from a standard HTML page and constrain the
viewer to a limited window on the screen using the embed command. This
decreases the number of pixels that must be rendered on every frame and
makes the VRML97 environment more responsive. Many users use high
resolution (800x600 or more), so the number of pixels during rendering and
navigation can be large and the video display may slow down. Frames may
be dropped as the browser attempts to keep up its real-time rendering, and
navigating the scene will become "chunky.” Use the embed command to avoid
this, for example, <embed SRC=myworld.wrl WIDTH=300 HEIGHT=200>

Hide faces on an object in the software, then export the object. The hidden
faces appear as a hole in the object. While the VRML97 plug-in can export
hidden objects, it does not export hidden faces. Hide faces that you know will
never be visible in the scene, such as the backs of objects or the bottom faces
of objects resting on a surface.

Use instances to reduce file size for objects that have the same geometry.

Whenever you use a Mirror transform, use the Reset Transform utility
immediately afterward. You can also use a Normal modifier immediately
followed by Unify Normals. VRML97 does not allow mirror transforms
(negative scales). The Reset Transform utility modifies the data in the actual
mesh object to create the mirroring effect.

Don’t change units when modeling for VRML97. To model in meters, keep
the units set to the default and use one world unit as one meter.

Animation

Beware of large file sizes when you use transform animation and
coordinate-interpolated animation. The VRML97 plug-in exports transform
animation (move, rotate, and scale), and coordinate-interpolated animation.
For example, you can animate modifiers such as Taper and Bend and you can
animate changing parameters, such as increasing or decreasing the radius of
a sphere.

When scenes using the Inherit Links function are exported to VRML97, child
objects always inherit their parents’ transforms. Inverse kinematics export
correctly to VRML97 with the exception of the Inherit Links function, which
determines whether child objects inherit the transforms of parent objects.

Always use TCB controllers for VRBL animations. These controllers provide
precise control and generate the smallest possible file size. Other kinds of
controllers, such as the default Bezier controller, create larger VRML97 files
that do not perform as well.
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Make sure your animations never change the face or vertex count over time.
VRML97 can not add or delete faces or vertices over time.
CoordinateInterpolators support morphing a mesh only, not changing the
number of vertices or faces.

To trigger an animation that is not on an object at the top-level of the
software’s linking hierarchy, use a TimeSensor helper object. If you trigger
an animation directly from a TouchSensor or ProximitySensor, without a
TimeSensor, you can animate only top-level objects. Animating from
TimeSensors does not have this limitation.

Turn off the Generate Primitives toggle in the Export dialog if you animate
the parameters of primitives (like the radius of a sphere), and want the
animation exported with CoordinateInterpolators. This applies to box, sphere,
cylinder and cone primitives only.

Materials

You can export only standard and multi/sub-object materials, and only the
following components of the material:

■ Diffuse, ambient, and specular color

■ One texture map, which must be in the Diffuse channel
Use JPEG or PNG format for your maps, because they are recognized by all
VRML97-compliant browsers and generally create the smallest files. (Some
older browsers may recognize GIF format and not PNG.) Multi/sub-object
materials export colors and textures. If an object has a multi/sub-object
material with textures, it exports as separate objects in VRML97, since
VRML97 does not support more than one texture map per object. Texture
maps slow down the browser and increase download time. Use them
sparingly.

■ Shininess (but not shininess strength)

■ Opacity

■ Wire frame

Make sure that all large flat surfaces have enough vertices in them that a few
vertices can be seen from all reasonable vantage points in your scene. Some
browsers cannot display textures on an object where all of its vertices are
outside the current viewport.

If you have several lights in you scene, lower the default multiplier value on
all the lights in the scene. Lights can oversaturate the scene and make all your
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geometry wash out toward white. Always add at least one camera and one
light to a scene exported to VRML97.

Helper Objects

Insert VRML helper objects into your scene in the top viewport. You can insert
VRML helper objects in any view, but if you insert them in the top viewport,
they appear properly oriented in the front viewport.

VRML97 Specification

You can find the complete VRML97 specification at
http://www.web3d.org/x3d/vrml/index.html.

This document describes the entire VRML97 language and provides technical
details on the behavior of exported VRML97 worlds.

VRML97 Helper Objects

Create panel > Helpers > VRML97 > Object Type rollout

The VRML97 helpers let you create online 3D scenes and interaction using
Virtual Reality Markup Language. Insert a VRML 97 Helper into the scene by
clicking and dragging at the desired location.

NOTE Some helper objects (for example, Billboard and Level Of Detail) are
position-sensitive, so be careful how and where you insert them. Usually, you have
the most control by creating the helper object in the Top viewport.

Anchor VRML97 Helper on page 7302

ProxSensor VRML97 Helper on page 7304

NavInfo VRML97 Helper on page 7306

Fog VRML97 Helper on page 7307

Sound VRML97 Helper on page 7308

LOD VRML97 Helper on page 7311

TouchSensor VRML97 Helper on page 7313

TimeSensor VRML97 Helper on page 7315
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Background VRML97 Helper on page 7317

AudioClip VRML97 Helper on page 7320

Billboard VRML97 Helper on page 7322

Inline VRML97 Helper on page 7323

Anchor VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Anchor

The Anchor rollout lets you specify a click-to-play trigger in the scene. This
trigger will be linked to a currently existing object in the scene. This allows
you to add links to other HTML pages, VRML97 worlds, or alternate cameras
in your VRML97 world.

Procedures

To set up an Anchor to jump to another VRML world:

1 Add an Anchor helper object by clicking the Anchor button and then
dragging in the Top viewport to create its icon.

2 Pick a Trigger Object in the scene that will be the object the viewer clicks
while browsing.

3 Choose Hyperlink Jump and designate a URL to jump to.

4 When the user clicks the Trigger Object geometry, the browser will replace
the current scene with the designated URL.
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Interface

The Anchor rollout contains the following options:

Pick Trigger Object Specifies the geometry that will be the trigger for this
anchor. Click this button, then select the geometry.
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Description Lets you enter a text description or message that will appear in
the browser's status bar when the mouse is over an object that has an Anchor
action defined for it.

Hyperlink Jump Creates an Anchor that jumps to a URL.

URL Specifies the location for Hyperlink Jump. Use your Bookmarks list, or
enter a location manually. If the URL points to another VRML97 world (a .wrl
file) you can append "#CameraName" to the end of the URL to have the
browser use the viewpoint named "CameraName" as the initial view.

Bookmarks Lets you select a URL location from a list of bookmarks. Click
Import List to import the list of bookmarks defined in your browser, or
manually enter new URLs into the list.

Parameter Lets you specify additional browser parameters for the hyperlink
jump. See the VRML97 specification on page 7301 for the uses of this field.

Set Camera Creates an Anchor that jumps to a given camera in the current
VRML97 world.

Camera Specifies the name of the camera for Set Camera.

Icon Size Determines the size of the helper in the scene.

ProxSensor VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > ProxSensor

The ProxSensor helper creates a VRML97 ProximitySensor node. This lets you
set up a rectangular region in space, so that entering the region in a VRML97
browser starts a set of objects animating.

Procedures

To create a Proximity Sensor object:

1 Add a Proximity Sensor object by clicking the ProxSensor button and
then click-dragging in the Top viewport to create its icon.

2 Select the geometry, camera, or sound to control.

When the user navigates inside the box, the specified objects animate or
the sound plays.
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Interface

The Prox Sensor rollout contains the following options:

Length/Width/Height Specifies the dimensions of the bounding box that
triggers the action.

Enable Activates the Proximity Sensor. When this check box is turned off,
the sensor has no effect, even if objects have been selected.

Pick Action Objects Specifies the objects in the scene to control with this
helper. The objects can be animated geometry, cameras, lights, or AudioClips.
Click this button then click the objects in the viewports.

Delete Deletes an object from the list of picked objects.

VRML Files | 7305



NavInfo VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > NavInfo

The NavInfo helper lets you create a VRML97 NavigationInfo node. This tells
the browser how to navigate around the VRML97 world.

Procedures

To create a NavInfo helper:

1 Add a NavInfo helper by clicking the NavInfo button and then
click-dragging in the Top viewport to create its icon.

2 Use the controls to adjust the behavior of the helper.

Interface

The NavigationInfo rollout contains the following options:
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Type Specifies the type of movement (Walk, Examine, Fly, and None) for
navigating the world. Implementation of these movement types may vary
from browser to browser.

Headlight Places a directional light at the viewpoint. The light always points
in the direction the user is looking.

TIP Don’t use this option if you have lights in the scene.

Visibility Limit Sets the far clipping plane. Any geometry beyond this point
is invisible. The smaller this value is, the closer the clipping plane is to the
camera. The larger this value is, the more of your scene is visible to the camera.
A value of 0 turns off the effect, making everything in the scene visible. Use
this option to show just part of large scenes.

Speed Determines the speed of navigation in units per second. Use this option
to allow the user to travel faster, if you’re building a large world (like a
cityscape), and slower, if you’re building a small world (like a room).

Avatar Size Specifies the user's physical dimensions in the world, to detect
collision distance and follow terrain.

Collision Specifies the allowable distance between the user's position and any
collision geometry before a collision is detected. For example, you can set this
so that a collision is detected one unit in front of a wall.

Terrain Specifies the height above the surface to maintain when following
terrain.

Step Height Specifies the highest object that can be "stepped over." If an object
like a staircase has steps that are lower than this value, the user can go up.

Icon Size Adjusts the size of the helper object in the viewports.

Fog VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Fog

The Fog helper lets you specify the color and range of fog in your VRML97
world. You can simulate atmospheric effects by blending objects with a color
based on the objects' distances from the viewer. For the best visual results, the
background (which is unaffected by the fog) should be the same color as the
fog.
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Procedures

To create a VRML 97 Fog helper:

1 Add a Fog helper by clicking the Fog button, then click-drag in the Top
viewport to create its icon.

2 Use the controls to adjust the type of fog in your VRML environment.

Interface

The Fog rollout contains the following options:

Type Specifies the fog type (linear or exponential). Linear means that the
amount of blending is a linear function of the distance, resulting in a
depth-cueing effect. Exponential uses an exponential increase in blending,
resulting in a more natural fog appearance.

Color Lets you select the fog color from the Color Selector dialog.

Visibility Range Specifies the distance from the viewer at which objects are
totally obscured by the fog. The smaller this value is, the closer the fog is to
the camera, and the less your scene is visible. The larger this value is, the more
of your scene is visible to the camera. A value of 0 turns off the effect, making
everything in the scene visible. A value of 0 means that there is no fog effect.

Icon Size Adjusts the size of the helper object in the viewports.

Sound VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Sound
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The Sound helper lets you place 3D (spatial) or ambient sounds in a scene.
The sound may be located at a point and emit sound in a spherical or ellipsoid
pattern. The ellipsoid is pointed in a particular direction and may be shaped
to provide more or less directional focus from the location of the sound. The
sound node may also be used to describe an ambient sound that tapers off at
a specified distance from the sound node.

The red ellipsoid of the helper represents the outermost range for which the
sound can be heard. The blue ellipsoid represents the range of the maximum
strength of the sound. The area between the red and blue ellipsoids represents
a falloff area in which the volume varies in intensity. The helper's arrow points
in the direction toward which the sound is emanating.

NOTE The Sound helper object must be linked to an existing audio clip in the
scene. Therefore, you must have an AudioClip on page 7320 helper object in the
scene in order for the Sound helper to play.

Procedures

To create a Sound helper object:

1 Add a Sound helper by clicking the Sound button, then click-drag in the
Top viewport to create its icon.

2 Press Pick Audio Clip and select an AudioClip helper object in the scene.

3 Rotate the icon to determine the direction in which the sound is
emanated.

4 Use the controls to adjust the range and strength of the playback sound.
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Interface

The Sound rollout contains the following options:

Intensity Sets the loudness of the sound. 1.0 is full volume.

Priority Sets the relative importance of the sound, if you have more than one
sound in the scene and the browser cannot play all of them. 0 is least
important. 1 is most important.

Spatialize Makes the sound 3D. A spatial sound has a particular source location
in the scene. If this box is turned off, the sound is ambient.

Min Back/Front, Max Back/Front Displays red and blue ellipsoids that allow
you to set the area of the sound effect. Inside the blue ellipsoid, the sound is
at full volume. Outside the red ellipsoid, the sound is inaudible. Between the
blue and red ellipsoids is a falloff area in which the volume varies in intensity.
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Pick Audio Clip Lets you choose an audio clip. Click this button, then click
an AudioClip helper object. The audio clip must already be in the scene and
have a sound file associated with it.

Icon Size Determines the size of the helper in the scene.

LOD VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > LOD

The Level of Detail (LOD) helper lets you specify objects with varying face
counts that are appropriate for different viewing distances. Browsers display
the less detailed objects when the viewer is far away from them and substitute
the more detailed objects at closer ranges.

Use LOD objects to speed up rendering of scenes in which highly detailed
objects are often far away from the viewer.

Objects used for LOD do not have to be of the same type or size, so you can
accomplish a crude form of morphing by using different objects as the LOD
components. For example, a tree might seem to grow if taller trees with more
limbs are substituted as the viewer gets closer.

Procedures

To create a Level of Detail helper object:

1 Create the objects to which you want to add level of detail.

2 Click the LOD button.

3 Click and drag in the scene to create a helper object.

4 Add the objects to the list with Pick Objects.

5 Use the Hide and Unhide commands, or the H key, to help pick the
objects and add them to the LOD list.

6 Select the objects in the list and use the Distance spinner to set the
distance.

To create all the objects and the LOD helper object at exactly the same
coordinates:

1 Create the LOD helper object.
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2 You can use Snap and create the helper object at the origin (0,0,0
coordinates), or use the Keyboard Entry rollout for a Standard Primitive
to specify an exact object origin.

3 Create the object with the most detail at the same coordinates. Name it
(for example, hicapsule).

4 Choose Edit/Clone.

In the Clone Options dialog, choose Copy and name the new object (for
example, medcapsule).

5 Repeat step 3 to create the other objects (for example, locapsule).

For the medium and low resolution objects, apply an Optimize modifier
to reduce the face count.

For primitives, you can reduce the face count by changing the creation
parameters in the modifier stack.

Interface

The Level of Detail rollout contains the following options:
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Pick Objects Selects objects of different face counts to substitute for the LOD
helper object. Create all the objects and the LOD helper object at exactly the
same coordinates.

Distance Sets the distance from the camera at which the user sees the selected
object. The distance specified for the object appears next to the object name.
For example:

hicapsule - 100 medcapsule - 300 locapsule − 500

Hicapsule is displayed when the distance between it and the camera is within
100 units. The lower resolution object (medcapsule) is displayed when the
camera is between 100 and 300 units. The lowest resolution object (locapsule)
is displayed when the camera is beyond 300 units. The greatest distance (500
in this case) is not actually used, but must be supplied.

Delete Deletes the selected object from the list.

Icon Size Sets the size of the LOD helper object.

TouchSensor VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > TouchSensor

The TouchSensor helper lets you set up an object so that selecting it in a
VRML97 browser starts a set of objects animating.

Procedures

To set up an object as a TouchSensor trigger:

1 Add a Touch Sensor object by clicking the Touch Sensor button and then
click-dragging in the Top viewport to create its icon.

2 Select the geometry to control.

When the user clicks the trigger geometry, the geometry, camera or light
animates, or the sound plays.
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Interface

The Touch Sensor rollout contains the following options:

Pick Trigger Object Specifies the geometry that will be the trigger for this
TouchSensor. Click this button, then select the geometry.

Enable Activates the Touch Sensor. When this box is turned off, the sensor
has no effect, even if objects have been selected.

Pick Action Objects Specifies the objects in the scene to control with this
helper.

Delete Deletes an object from the list of picked objects.

Icon Size Determines the size of the Touch Sensor helper in the scene.
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TimeSensor VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > TimeSensor

The TimeSensor helper lets you add time-based animation controls, such as
the start and end frames for a particular object's animation, and looping. Use
this helper to split up an object's animation keys over several triggers, to
automatically start an animation upon loading the .wrl file, or to make
animation endlessly loop.

Procedures

To assign an object to a TimeSensor helper:

1 Add a Time Sensor object by clicking the Time Sensor button and then
click-dragging in the Top viewport to create its icon.

2 Press Pick Objects and select the (animated) geometry to control.

3 Use the controls to adjust the start and end times of the animation, and
to loop the animation.
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Interface

The Time Sensor rollout contains the following options:

Loop Repeats the animation from the start-time frame to the stop-time frame.

Start on World Load Starts the animation so that it will be running when
the file is loaded into the browser.

NOTE This option is only available when Loop is turned on. Otherwise, the
animation will start and stop at the specified times.

Start Time/Stop Time Specifies the range of frames to play.

NOTE If the start time is after the end time, the animation will play from the
earliest frame to the last frame. It will not play the animation backward.
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Pick Objects Lets you select the objects to control with this TimeSensor.

Delete Deletes an object from the list of picked objects.

Icon Size Adjusts the size of the helper object in the viewports.

Background VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Background

The Background button displays the Sky Color, Ground Color, and Images
rollouts. Use these rollouts to specify colors and images for the sky and ground
in your VRML97 world.

Procedures

To create a Background helper object:

1 Add a Background helper object by clicking the Background button, then
click-drag in the Top viewport.

2 Use the controls to adjust the colors and layout of the background.
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Interface

Sky Colors rollout

Lets you provide a colored background to the world’s sky using a gradient of
up to three colors. The sky is an infinite sphere that encloses the objects of
the scene.

Number of Colors Specifies whether the sky is one solid color or a gradient
of two or three colors.

Color One/Two/Three Lets you select the colors from the Color Selector.
Color One is the base color.
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Angle Specifies the angle at which Color Two and Color Three merge with
the base color, in degrees from the North pole of the sky (straight up from the
viewer).

Icon Size Adjusts the size of the helper object in the viewports.

Ground Colors rollout

Lets you provide a colored background to the world’s ground plane using a
gradient of up to three colors. The ground appears inside the sky sphere and
below the objects of the scene.

Number of Colors Specifies whether the ground is one solid color or a gradient
of two or three colors.

Color One/Two/Three Lets you select the colors from the Color Selector.
Color One is the base color.
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Angle Specifies the angle at which Color Two and Color Three merge with
the base color, in degrees from the South pole of the sky (straight down from
the viewer).

Images rollout

Lets you specify a set of images that define a background panorama between
the ground/sky backdrop and the objects in the scene. The panorama consists
of six images, each of which is mapped onto a face of an infinitely large cube
centered in the local coordinate system.

Image URLs Specifies the location/file names of the images to use. The images
can be JPEG files or PNG files with or without transparency. Some browsers
also support GIF files.

See the VRML97 specification on page 7301 for diagrams of the typical image
configuration.

AudioClip VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > AudioClip

The AudioClip rollout lets you specify the name and characteristics of an audio
file that can be used by the Sound helper.
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Procedures

To create an AudioClip helper:

1 Press the AudioClip button, and click-drag in the Top viewport to create
the helper.

2 Enter the location of the sound file (.wav or .mid) you want to use in the
URL text box.

Interface

The rollout contains the following options:

URL Specifies the location/file name of the sound to use. Either.wav (waveform)
or .mid (MIDI) files can be used, but MIDI sound files may not be spatialized.
Some browsers do not support MIDI.

Description Lets you enter a text description of the sound, which is displayed
by some browsers.

Pitch Sets the relative pitch of the sound. 1.0 is normal pitch, and 0.5 is one
octave lower than normal.

Loop Repeats the sound.
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Start on World Load Starts playing the sound as soon as the world is loaded
into the browser.

Icon Size Determines the size of the AudioClip helper in the scene.

Billboard VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Billboard

The Billboard helper lets you create geometry that is camera-aligned in the
VRML97 browser. The objects always align to the viewpoint in the VRML97
browser.

Any geometry linked to the Billboard helper will rotate about the local Z axis
of the helper object to face the viewer. Since it rotates about the location of
the Billboard, it is best to center the Billboard on the object that you will link
to it.

The direction of the negative Y axis of the object, which will be its front, is
aligned with the negative Y axis of the helper, and will be the Billboard surface
that always faces the viewer. This is the side usually seen from the default
camera position.

Procedures

To create a Billboard helper object:

1 Press the Billboard button and click-drag in the Top viewport to create
the helper.

2 Link object(s) to the billboard to keep them aligned with the camera.

Interface

The Billboard rollout contains the following option:
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Screen Alignment Keeps the geometry linked to the Billboard helper aligned,
even when the viewer elevates, pitches, and rolls.

Icon Size Determines the size of the Billboard helper in the scene.

Inline VRML97 Helper

Create panel > Helpers > VRML97 > Object Type rollout > Inline

The Inline helper lets you reference another VRML97 file that is included in
your world when you load it into your VRML97 browser. These inline objects
are like instance objects, but they function at the browser level.

Procedures

To create an Inline helper object:

1 Click the Inline button.

2 Click and drag in one of the viewports.

You can modify the helper object with the tools in the VRML Inline
rollout.

Interface

If you create the objects in the scene to be inserted off-center (away from the
origin), they will appear in the browser off-center as well. Align the original
scene and the scene to be inserted correctly, in relation to the origin.
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The VRML Inline rollout contains the following options:

Insert URL Specifies the URL of the .wrl files to insert in place of the helper
object. The URL must be another VRML97 file.

Bookmarks Displays a dialog that lets you select a location from a list of
bookmarks. Click Import List to import the list of bookmarks defined in your
browser. Most browsers store bookmarks in a file called bookmark.htm.

Bounding Box Specifies whether an explicit bounding box size will be
exported. If you select “Use Icon Size,” the diameter of the icon will be written
into the VRML97 file for the width, length, and height of the bounding box;
the actual contents of the inline file should fit within that bounding box. If
you select “Calculate in Browser,” no bounding box size is exported and the
VRML browser will determine the size of the inline geometry.

Icon Size Sets the size of the helper object. You can transform this object like
any other object in the software. The scene that replaces the helper object will
be moved, rotated, or scaled in the same manner. The size shown is the radius
of the icon.

Image File Formats
Image files, also known as bitmaps, have a variety of uses in 3ds Max scenes.
You can use bitmaps as textures for materials, as backgrounds to viewports,
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as environment maps, as Image Input events in Video Post, or as images
projected from a light.

An image file can be a single still image, or a sequence of images that form a
video sequence or animation. When you assign an animation for use as a
bitmap, then the image changes over time when you render the 3ds Max
scene.

NOTE Bitmaps are reloaded automatically after they have been changed and
resaved by a graphic editing program. See the Reload Textures On Change toggle
in File Preferences on page 7750.

When you render a scene, you can render a still image or an animation. You
can render to most of the formats listed below. Some of the formats support
various options. If there are output options, these appear in a dialog that is
described along with the image file's format.

These are the image file formats supported by 3ds Max:

AVI Files on page 7326

BMP Files on page 7328

CIN (Kodak Cineon) Files on page 7328

CWS (Combustion Workspace) Files on page 7329

DDS Files on page 7330

EPS and PS (Encapsulated PostScript) Files on page 7332

GIF Files on page 7334

HDRI Files on page 7334

IFL Files on page 7339

IMSQ Files on page 7346

JPEG Files on page 7347

MOV (QuickTime Movie) Files on page 7348

MPEG Files on page 7348

OpenEXR Files on page 7349

PIC Files on page 7359

PNG Files on page 7360

PSD Files on page 7361
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RLA Files on page 7364

RPF Files on page 7366

RGB (SGI Image) Files on page 7369

TGA (Targa) Files on page 7370

TIFF Files on page 7372

YUV Files on page 7374

NOTE To save loading time, if a map with the same name is in two different
locations (in two different paths), it is loaded only once. This poses a problem only
if your scene includes two maps that have different content but the same name.
In this case, only the first map encountered will appear in the scene.

AVI Files

The AVI (Audio-Video Interleaved) format is the Windows standard for movie
files. The .avi file-name extension indicates a Windows AVI movie file.

3ds Max creates an AVI created when you make a preview animation on page
6422. You can also render your final output to an AVI file. Although 3ds Max
produces its highest-quality output by rendering single-frame TGA files or
rendering directly to a digital disk recorder, you can still get good results
rendering AVI files.

AVI files can be used as input to 3ds Max in several ways, for example:

■ As animated materials in the Material Editor

■ As viewport backgrounds for rotoscoping

■ As input images for compositing in Video Post

Interface

When AVI is the chosen output format, clicking Render or Setup on the Render
Output File dialog on page 6086 displays the Video Compression dialog.
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Compressor Use the drop-down list to choose the codec on page 7936
(compressor/decompressor) you want to use to compress the file. You can use
any codec that's installed on your system.

Alternatively, you can render uncompressed frames and then use an external
application to compress the animation. Video-file compression is a complex
subject, with many aspects to consider.

Compression Quality Available only for certain codecs. When available, use
the slider to specify the quality you want. The higher you set the quality, the
larger the file size will be.

Keyframe Rate Available only for certain codecs. When available, use this
setting to specify the interval between the delta keyframes used to compare
one frame with another and generate in-between frames. Too large an interval
will create loss of quality in the AVI file as a whole.

Setup Available only for certain codecs. Click this button to see any additional
options that are specific to the codec. These are vendor specific and vary from
codec to codec.
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BMP Files

BMP files are still-image bitmap files in the Windows bitmap (.bmp) format.

Interface

When BMP is chosen as the output format, clicking Render or Setup on the
Render Output File dialog on page 6086 displays the BMP Compression dialog.

8 Bit Optimized palette (256 Colors) Choose to render a smaller, 8-bit color
file.

RGB 24 bit (16.7 Million Colors) Choose to render a larger, true color (24-bit)
file.

CIN (Kodak Cineon) Files

A file format that stores a single frame of a motion picture or video data stream.
Each frame is saved as cineon version 4.5 with a CIN file-name extension. The
file contains no user-defined data such as a thumbnail, and supports 10-bit
log, and three colors per pixel. Alpha channels are not supported.

Interface

When CIN is chosen as the output format, clicking Render or Setup on the
Render Output File dialog on page 6086 displays the Cineon Image File Format
dialog.
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Printing Density Adjustment Represents the transfer function from printing
density (10-bit log) to 16-bit linear with the white point mapped to a maximum
code value of 65535.

Conversion of logarithmic printing density to a linear representation requires
both a scaling and an anti-log operation. With 16-bits linear, it is possible to
maintain the full printing density range. The 90% white card at code value
685 is mapped to maximum code value of 65535.

The White Pt and Black Pt spinners let you adjust the 90% white code and
the 2% black code.

CWS (Combustion Workspace) Files

The file format for the Combustion™ software from Autodesk. CWS is a
resolution-independent, vector/raster file format.

You can use CWS files in conjunction with the Combustion map on page 5811.
You can't use a CWS file as a general-purpose bitmap. You can also generate
a CWS file by using the Render Elements option on page 6336 when you render
a scene.

IMPORTANT Only Combustion 2.1 and later formats are supported. Maps in the
Combustion 1 format are not supported in 3ds Max.
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DDS Files

The DirectDraw® Surface (DDS) file format is used to store textures and cubic
environment maps, both with and without mipmap levels. This format can
store uncompressed and compressed pixel formats, and is the preferred file
format for storing DXTn compressed data. Microsoft® is the developer of this
file format.

You can use DDS files as texture maps.

With Direct3D 9, you can render to the DDS format. (With DX8 or DX9, DDS
files can be rendered using the Metal Bump shader on page 5761, as well.) If
your system does not support DX9, you can use DDS files as textures, but you
can't render them.

Interface
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Surface/Volume Format group

DDS supports a variety of output formats, which vary in the number of pixels
allocated to the red, green, and blue (RGB) channels, to the optional alpha
channel (transparency), and to possible unused bits. There is also a set of
compressed formats.

■ A8 R8 G8 B8 32 bits per pixel: 8 bits each for the RGB and alpha channels.

■ A1 R5 G5 B5 16 bits per pixel: 5 bits each for the RGB channels, and one
bit for the alpha channel.

■ A4 R4 G4 B4 16 bits per pixel: 4 bits each for the RGB and alpha channels.

■ R8 G8 B8 24 bits per pixel: 8 bits each for the RGB channels; no alpha.

■ R5 G6 B5 16 bits per pixel: 5 bits each for the R and B channels, 6 bits
for the G channel; no alpha.

■ A2 R10 G10 B10 32 bits per pixel: 10 bits each for the RGB channels; 2
bits for the alpha channel.

■ X8 R8 G8 B8 32 bits per pixel: 8 bits each for the RGB channels; 8 bits
unused; no alpha.

■ X1 R5 G5 B5 16 bits per pixel: 5 bits each for the RGB channels; 1 bit
unused; no alpha.

■ R3 G3 B2 8 bits per pixel: 3 each for the R and G channels, 2 bits for the
B channel; no alpha.

■ A8 R3 G3 B2 16 bits per pixel: 3 each for the R and G channels, 2 bits for
the B channel; 8 bits for the alpha channel

■ X4 R4 G4 B4 16 bits per pixel: 4 each for the RGB channels and 4 unused
bits.

■ A16 B16 G16 R16 64 bits per pixel: 16 bits each for the RGB and alpha
channels.

■ A16 B16 G16 R16F 64-bit floating-point format using 16 bits each for
each channel: alpha, blue, green, red.

■ A32 B32 G32 R32F 128-bit floating-point format using 32 bits each for
each channel: alpha, blue, green, red.

■ DXT1 Compressed format with 1-bit alpha.

■ DXT2 Compressed format with 4-bit premultiplied alpha on page 8096.
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■ DXT3 Compressed format with 4-bit alpha, no premultiplication.

■ DXT4 Compressed format with interpolated premultiplied alpha.

■ DXT5 Compressed format with interpolated alpha but no
premultiplication.

Generate Mipmaps When on, mipmaps are generated for the image.
Default=off.

Mipmaps are a set of lower-detail bitmaps. The first is half the size of the
original image, the next is half the size of that, and so on down to a single
pixel. (You can think of them as being arranged like a pyramid.) They are used
to optimize display time and reduce aliasing on page 7904 when the texture is
to be displayed at less than full size. For example, if your original DDS image
is 512 x 512 pixels, but the area in which it would be displayed is only 100
pixels square, the display device would interpolate between the 128 x 128
mipmap and the 64 x 64 mipmap.

EPS and PS (Encapsulated PostScript) Files

3ds Max can render images to Encapsulated PostScript format files, which
have the .eps or .ps extension.

PostScript is an Adobe page-description language for encoding graphics images.
It is supported by many printing devices and is widely used in desktop
publishing and graphic design as a means of porting images from one platform
to another. You can not view PostScript files with 3ds Max or use them as
bitmaps in materials or environments.

Interface

When PostScript is the chosen output format, clicking Render or Setup on the
Render Output File dialog on page 6086 displays the EPS File Output Options
dialog.
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Units Select inches or millimeters.

Image Orientation Select portrait (tall) or landscape (wide).

Data Format Select binary or ASCII.

File Type Select color or grayscale.

Preview Check to generate a thumbnail image so that file browsers can preview
the contents of the PostScript file.

Page Size Set width and height measurements.

Resolution Set width and height resolution in dots per inch (dpi).
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GIF Files

GIF is an 8-bit (256-color) format developed by Informix for the CompuServe®

information service. It was originally designed to minimize file transfer times
over telephone lines.

GIF is supported only as an input file format. You can use GIF files as
general-purpose bitmaps, but you can't render to a GIF file.

HDRI Files

HDRI is a file format used for high-dynamic-range images. Most cameras don't
have the capability to capture the dynamic range (the gamut of luminances
between dark and bright regions) that is present in the real world. However,
the range can be recovered by taking a series of pictures of the same subject
with different exposure settings, and combining them into one image file.

This type of image is called a high dynamic range image (HDRI) or radiance map.
HDRI files have an .hdr extension and radiance maps have a .pic extension.
The file actually contains all the data from all the pictures, so a wide luminance
range is present, from bright, white highlights to the darkest black.

HDR files are particularly useful as backgrounds for compositing, and as
reflection maps on composited objects. When using a HDR image as a skylight,
use the parameters in the Exposure group to control the brightness of the
scene.

Procedures

To use a HDR image as a background, or as a diffuse or reflection map:

1 In the Material Editor, choose Bitmap as the map type.

2 On the Select Bitmap Image File dialog, under Files Of Type, choose
Radiance Image File (HDRI). Open the HDR file you would want to use.

The HDRI Load Settings dialog appears, with the image displayed in its
preview window.

3 On the HDRI Load Settings dialog, look at the Measured Min/Max values
to see the luminance range for the image.

4 Turn on Black Point.
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5 Adjust the Black Point and White Point values until the red lines on the
histogram encompass the majority of the graph, and the preview image
is satisfactory.

TIP For the Internal Storage option, use the default choice of 16 bit/chan
Linear (48bpp) unless you have a specific reason for doing otherwise.

6 When you have finished adjusting values, note the Linear White Point
value, and click OK to accept the settings.

7 In the Material Editor, expand the Output rollout. Set the RGB Level to
the same value as the Linear White Point value on the HDRI Load Settings
dialog.

The result is a map with a wide range of deep blacks and very white
highlights. If such an image is used as both a background in the rendering
and a reflection map on an object, the object will appear to be extremely
shiny and reflective.

Interface

HDR Load Settings dialog

When you open a HDR file as a bitmap, the HDR Load Settings dialog appears.
This dialog allows you to specify the luminance range to use from the image,
and the method for storing the data.
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Histogram This graph shows the image's luminance values in a logarithmic
scale. The red lines indicate the current Black Point and White Point values.

The graph is visible only for luminance levels with substantial representation
in the image. In other words, if a luminance level only applies to one or two
pixels in the image, there will be no corresponding graph line on the
histogram. Compare with Measured Min/Max, which gives the entire range
of luminance levels in the image.

In general, the resulting image will have the most dramatic effect when the
histogram is used to set the Black Point and White Point range values, rather
than using the full range expressed by Measured Min/Max.

7336 | Chapter 23   Managing Scenes and Projects



Exposure group

Black Point When this option is turned on, you can set the luminance value
that you would like to be treated as the darkest color, or “black”. The value
can be set as a logarithm (Log) or as a linear value (Linear). All values below
this value will be clamped to black. When this option is turned off, the lowest
possible value is used as the Black Point.

Measured Min/Max Displays the actual minimum and maximum luminance
values in the image, expressed as both the logarithmic and linear values. Using
these values for the Black Point and White Point will result in the image's full
luminance range being used. However, the histogram might show that the
majority of the luminance levels fall into a much smaller range.

White Point Sets the luminance value that you would like to be considered
the brightest color, or “white”, either as a logarithm (Log) or linear value
(Linear). All luminance values in the image that are above this value will be
clamped to white. White pixel values inside HDR files can be much larger
than a Linear value of 1.

The image's extended luminance range is used only when the White Point's
Linear value is set above 1.0. In other words, setting White Point at or below
a Linear value of 1.0 will not use any of the HDR image's special luminance
properties, and will give results similar to other bitmap formats such as TIF
and JPG.

Log Sets the Black Point or White Point as a logarithmic value ranging from
–128 to 127. Changing this value changes the Linear parameter to the
corresponding value.

Linear Sets the Black Point or White Point as a linear value ranging from 0
to over 1 trillion. Changing this value changes the Log parameter to the
corresponding value.

Preview window Displays the selected HDR image.

Internal Storage group

Real Pixels (32 bpp) Compresses the luminance selections into a color space
with 32 bits per pixel. Premultiplied Alpha and Motion Blur do not work with
this option.

Def Exposure When on, the image will load as is without applying any
changes to the colors. When off, you can use the parameters in the Exposure
group to remap colors. Available only with the Real Pixels option.
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16 bit/chan Linear (48 bpp) Compresses the luminance selections into 16–bit
color space, at 48 bits per pixel. This is the recommended setting. To
decompress the luminance for use in the scene, set the RGB Level on the
image's Output rollout on page 5774 to the same value as the linear white value
on this dialog.

8 bit/chan Linear (24 bpp) Compresses the luminance selections into 8–bit
color space, at 24 bits per pixel. This compression method uses less memory
than other methods, but it is generally not adequate to display the range of
luminance in a HDR image, and can result in banding or other artifacts.

Display scaled colors by When on, this value scales the preview image's
luminance value by the specified amount.

L Locks the preview luminance scale to the white linear value. When off, you
can change the value manually. Default=on.

Mark White clamp Masks the white-clamped values in the preview window
with the color indicated by the color swatch. Click the color swatch to change
this color.

Mark Black clamp When Black Point is on, this option masks the
black-clamped values in the preview window with the color indicated by the
color swatch. Click the color swatch to change this color.

HDRI Save Settings dialog

3ds Max can render and save images with 32-bit floating-point channels.
Among the useful applications for this type of imagery are:

■ Compositing: Using 16–bit images in a compositing pipeline can quickly
become a problem as colors are manipulated. For example, banding may
appear.

■ HDR images are not bound to a specific range (e.g., 0-255 or 0-65535);
they have a dynamic range. As such, high-contrast and physically accurate
values can be stored in 32-bit floating-point pixels.

■ Because of their large range of values, HDR images can easily be modified,
and effects can be reapplied long after rendering, without affecting the
quality of the image. For example, changing the
contrast/brightness/exposure of a 16-bit image could cause banding, which
would require re-rendering the image. However, the same operation on
an HDR image should not affect its quality.
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Clicking Save or Setup in the Render Output File dialog on page 6086 displays
the HDR Save Settings dialog.

The dialog lets you choose the source of the values used for output:

■ Higher dynamic range and color precision than existing 8- and 10-bit
image file formats.

■ Support for 16-bit floating-point pixels. The pixel format, called "half," is
compatible with the half data type in NVIDIA's Cg graphics language and
is supported natively on their new GeForce FX and Quadro FX 3D graphics
solutions.

■ Multiple lossless image compression algorithms. Some of the included
codecs can achieve 2:1 lossless compression ratios on images with film
grain.

■ Extensibility. New compression codecs and image types can easily be added
by extending the C++ classes included in the OpenEXR software
distribution. New image attributes (strings, vectors, integers, etc.) can be
added to OpenEXR image headers without affecting backward compatibility
with existing OpenEXR applications.

IFL Files

An IFL (Image File List) file is an ASCII file that constructs an animation by
listing single-frame bitmap files to be used for each rendered frame. When
you assign an IFL file as a bitmap, rendering steps through each specified
frame, resulting in an animated map.
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(In a similar way, if you assign an AVI file or MOV file as a bitmap, rendering
steps through each frame of the animation.)

For example, if you assign a 10-frame animation of a blinking red "Danger"
sign to a material's diffuse component, apply the material to a cube, and then
render a 30-frame animation, the cube displays the blinking red Danger
animation three times.

The .ifl file lists the bitmap files to be used with each frame. You can append
an optional numeric argument to each file name to specify the number of
frames of rendered animation on which it is used. For example:

The IFL file listed above specifies sand.tga to be used for the first 20 frames,
pebble.tga to be used for the next 40 frames, stone.tif to be used for 20 frames,
and boulder.tif to be used for 20 frames.

TIP Specify only the file names in your IFL files. The file paths can be derived from
the map paths established in your preferences. See External Path Configuration
on page 7735. IFL files with path names can be used only on the system on which
you create them.

See also:

■ Image File List Control Dialog on page 7342

■ IFL Manager Utility on page 7344

Sequentially Numbered Files

You can use incrementally numbered bitmap files (for example, frame001.bmp,
frame002.bmp, and so on) to construct an IFL file. Either use the IFL Manager
Utility on page 7344, or use the Sequence check box in a file selector dialog, as
described in the following procedures.

Notes

■ If the IFL generator has a name conflict with an existing IFL file, it will
increment the new file's name to avoid overwriting the existing file.

■ If the IFL generator has any problems with write access while trying to
create the IFL file, the process will fail and the IFL file won't be created.
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Therefore, automatic IFL generation won't work when reading bitmaps
from a CD-ROM. You need to copy them to a directory on your hard disk
first. Likewise, automatic IFL generation won't work on network drives to
which you don't have write access.

Procedures

To construct an IFL file from sequentially numbered files:

1 In the file selector dialog, navigate to a directory that has a sequence of
incrementally numbered bitmaps.

2 Choose the name of one of the sequential files (for example, image01.bmp).

The Sequence check box becomes available.

3 Turn on the Sequence check box.

The Setup button becomes available.

4 Click Setup to display the Image File List Control dialog on page 7342.

5 In the Image File List Control dialog, choose the options you want, and
then click OK.

TIP Use the Browse button to set the Target Path to a directory on your hard
disk. Do not set this path to a CD-ROM drive, because you cannot save the
file there.

The Image File List (IFL) file is saved to the target directory.

6 In the file selector dialog, click OK.

This assigns the newly created IFL file as the bitmap.

Example: To select a set of still images as a viewport background:

1 Activate the viewport where you want the animated background.

2 Choose Views menu > Viewport Background.

3 In the Background Source group, click Files.

A Viewport Background dialog is displayed.

4 On Select Background Image dialog, use the Look In field to navigate to
the directory containing the files you want to use for the sequence.

If necessary, change the file type to match the file name extension of the
sequence, or choose All Formats.
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NOTE The Select Background Image File dialog uses the last location where
a bitmap was chosen, rather than the default bitmap path defined in
Customize menu > Configure User Paths.

5 Construct an IFL file as described in the previous procedure.

6 On the Select Background Image dialog, click OK.

The IFL file now provides the background for the viewport.

TIP The viewport background does not render. To render the IFL file's
animation, assign the IFL file as a rendering environment. (See the following
procedure.)

To render the frames in an IFL file as a movie (AVI or MOV format):

1 Choose Rendering > Environment.

2 On the Environment dialog, click Environment Map.

3 On the Material/Map Browser, choose Bitmap, and then click OK.

4 On the Select Bitmap Image File dialog, choose the IFL file, and then click
OK.

5  Click Time Configuration, and use the Time Configuration dialog
to make the animation length match the number of frames specified in
the IFL file.

6 Render a viewport to a movie-format file.

TIP The aspect ratio of the rendered movie should match the aspect ratio of
the frames in the IFL file.

Image File List Control Dialog

Views menu > Viewport Background > Select Background Image dialog >
Choose a directory with sequentially numbered files. > Sequence > Setup >
Image File List Control dialog

The Image File List Control dialog provides controls for creating an Image File
List (IFL file) on page 7339, which lists sequential still image files for rendering

7342 | Chapter 23   Managing Scenes and Projects



into backgrounds or materials. It is particularly useful if you are choosing a
sequence of files that are on a CD-ROM, because you can redirect the IFL file
to a different directory on your hard disk.

This dialog duplicates the functionality found in the IFL Manager utility on
page 7344.

Interface

Target Path Sets the directory where the IFL file is saved.

Browse Use this to navigate to the correct directory.

Options Sets additional options for creating the IFL file.

Start Frame Determines which file in the sequence will be the first frame. Use
this when you have a sequence but you don’t want to start with the first image
in the sequence.

End Frame Determines which file will be the last frame listed in the IFL list.

Nth Frame Skips frames in the image file list. Use this to match the length of
the sequence to the length of the animation.

Multiplier Increases the frames in the image file list. Each frame in the file
list can be repeated by this value to stretch out the length of the sequence.

Include Image Path Includes the path in the image file list.
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IFL Manager Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > IFL Manager

The IFL Manager utility generates an image file list (IFL) file on page 7339 from
an image file you choose from a numbered file sequence.

NOTE You can also generate an IFL file in a file selector dialog by selecting a
numbered bitmap, turning on Sequence, and then clicking Setup to display an
Image File List Control dialog on page 7342.

See also:

■ Image File List Control Dialog on page 7342

Procedures

To use the IFL Manager utility:

1 Open the IFL Manager.

2 Click the Select button to display a file selector.

3 Select any of the sequentially numbered image files that you want
included in the list, and click Open.

The prefix name of the file appears in the Working File Prefix group box,
and the spinners in the IFL Manager panel become enabled.

4 Set the Start spinner to specify the first numbered file in the sequence.
For example, set this to 5 to begin with file tree0005.jpg.

5 Set the End spinner to specify the last numbered file in the sequence.
The Start and End spinners default to the first and last number in the
existing numbered files.

NOTE You can invert the Start and End values (setting the greater value in
Start and the lesser in End) to create a reversed list in the .ifl file.

6 Click Create to display a file dialog where you can name and then save
your IFL file.

7 Click the Edit button to display a file dialog where you can choose an
IFL file, which then appears in the Windows Notepad.
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Interface

Working File Prefix group

After you use the Select button to select a sequentially numbered file, the
prefix name of the file appears here. For example, if the files are tree0000.jpg,
tree0001.jpg, tree0002.jpg, and so on, the title in this group box would be tree.

Spinners group

Start Displays the number of the first image file in the selected sequence.
Increase to specify a different starting image for the IFL file.

End Displays the number of the last image file in the selected sequence.
Decrease to specify a lower ending image for the IFL file.

Every nth Set to a number greater than 1 to skip a specified number of images
in the list.

Multiplier Adds a multiplier after each file in the IFL list. If you set to 3, each
image is used three times before the next image in the list is used.
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Button set

Select Displays a file dialog that lets you select a file in a sequential list. The
number appended to the file doesn't matter, as long as the prefix and file
name extension are the same. After selecting the file, the spinners in the IFL
Manager are enabled.

Create Displays a file dialog where you can name and save your IFL file.

Edit Displays a file dialog where you can select an IFL file. The selected file is
then displayed in the Windows Notepad editor.

Close Closes the utility.

IMSQ Files

The Autodesk ME Image Sequence (IMSQ) format is an XML file used by the
Autodesk products Cleaner and Toxik. You generate IMSQ files in the Render
Output group of the Render Setup dialog > Common Parameters rollout on
page 6121 by turning on Put Image File List(s) In Output Path(s) and then clicking
Create Now. The IMSQ file stores information about the rendering, including:

■ The name of the rendering file

■ The format of the rendering file

■ The range of frames
(Nonsequential frame sequences, such as 1, 7, 12–19, are not supported.)

■ The frame rate

■ The pixel aspect ratio

■ The output type, aperture width, and resolution (width x height)

■ The render element type and name

■ The camera name (when rendering a Camera view)

3ds Max generates a separate IMSQ file for each render element.
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JPEG Files

JPEG (.jpeg or .jpg) files follow the standards set by the Joint Photography
Experts Group. These files use a variable compression method that is called
lossy compression because of the loss of image quality as you increase the
compression. However, the JPEG compression scheme is extremely good and
you can sometimes compress the file up to 200:1 without severe loss of image
quality. JPEG is consequently a popular format for posting image files on the
Internet for minimum file size and fast download time.

Interface

When JPEG is the chosen output format, clicking Render or Setup in the
Render Output File dialog on page 6086 displays the JPEG Image Control dialog.

Quality Move the slider to the level of quality you want: the higher the quality,
the larger the file size. In general, files compressed with the slider set to Best
have compression ratios between 5:1 and 15:1.
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File Size Move the slider to the size of file you want: the larger the file, the
higher the quality.

Smoothing Move the slider to the level of smoothing you want: the higher
the level of smoothing, the larger the file size.

MOV (QuickTime Movie) Files

QuickTime® is a standard file format created by Apple® for storing common
digital media types such as audio and video. When you choose QuickTime
(*.mov) as the Save as Type, your animation is saved as a .mov file.

You can export animations to .mov for both rendering and previews. You can
also export audio if an audio track is present in Track View. To preview an
existing .mov file, you must have movieplayer.exe included in your environment
path. You can download the QuickTime movie player from
http://www.apple.com/quicktime/download.

NOTE The plug-in does not allow for the direct import of audio from a QuickTime
file.

Interface

When you create a new QuickTime file or choose Setup for an existing one,
you see a dialog that is typically titled Compression Settings. This dialog is
provided by the QuickTime codec on page 7936 installed with your system, and
can change depending on the version of QuickTime you've installed.

MPEG Files

The MPEG format is a standard for movie files. MPEG stands for Moving
Picture Experts Group. MPEG files can have a .mpg or .mpeg file name
extension.

MPEG is supported only as an input file format. You can use MPEG files as
texture maps.
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OpenEXR Files

3ds Max can both read on page 7355 and write on page 7350 image files in the
OpenEXR format. OpenEXR is both an image file format and a general
open-source API for reading and writing such files.

The best place to look for information on OpenEXR itself is
http://www.openexr.com/the official Website. The following is taken directly from
the OpenEXR home page:

OpenEXR is a high dynamic-range (HDR) image file format developed by
Industrial Light & Magic for use in computer imaging applications.

OpenEXR is used by ILM on all motion pictures currently in production. The
first movies to employ OpenEXR were Harry Potter and the Sorcerer's Stone,
Men in Black II, Gangs of New York, and Signs. Since then, OpenEXR has
become ILM's main image file format.

OpenEXR's features include:

■ Higher dynamic range and color precision than existing 8- and 10-bit
image file formats.

■ Support for 16-bit floating-point, 32-bit floating-point, and 32-bit integer
pixels. The 16-bit floating-point format, called "half," is compatible with
the half data type in NVIDIA's Cg graphics language and is supported
natively on their new GeForce FX and Quadro FX 3D graphics solutions.

■ Multiple lossless image compression algorithms. Some of the included
codecs can achieve 2:1 lossless compression ratios on images with film
grain.

■ Extensibility. New compression codecs and image types can easily be added
by extending the C++ classes included in the OpenEXR software
distribution. New image attributes (strings, vectors, integers, etc.) can be
added to OpenEXR image headers without affecting backward compatibility
with existing OpenEXR applications.

The OpenEXR Bitmap I/O software goes beyond the “standard” OpenEXR
format, taking advantage of the flexibility of the format itself. It can write
channels and attributes as well as general RGBA data in formats that many
OpenEXR file importers cannot understand, due to implementation limits as
well as limits to the current set of standards. The full-latitude 32-bit floating
point RGBA files that the output function can write is one example. While
the OpenEXR API itself fully supports this capability, and these files are written
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using the standard set of OpenEXR libraries, most software only reads the
16-bit “half” floating point RGBA files that are considered standard EXR files.

TIP To take best advantage of the OpenEXR format’s 32-bit support, use the
mental ray renderer and set Frame Buffer Type on page 6277 to Floating-Point (32
bits per channel).

Configuration File Usage

Most bitmap I/O plug-ins, including those integrated into 3ds Max, store their
configuration information in a binary CFG file that cannot be edited. To allow
external scripting support as well as ordinary preferences, the OpenEXR
software uses a standard INI file format to store its configuration data. The
file is named openexr.ini and is found in the plugcfg folder in the program
directory. The file is generated automatically the first time you edit the
OpenEXR configuration settings, and is updated each time you modify an
EXR loader. It is a standard text file and can be modified with any text editor.

When the INI file is written, it automatically generates a companion “help”
text file named openexr_ini_help.txt. This file contains the valid ranges for
various INI settings, as well as the various text strings used to specify
compression type and bit depth. This file is just a guide; editing it has no
effect, and it is overwritten whenever the INI file is updated.

To restore the default settings after editing the INI file, simply delete the
openexr.ini file and a new one with the original defaults will be generated the
next time you edit the configuration settings.

See also:

■ Saving OpenEXR Files on page 7350

■ Opening OpenEXR Files on page 7355

Saving OpenEXR Files

Render Setup dialog > Common panel > Common Parameters rollout > Render
Output group > Click Files. > Enter file name and set type to OpenEXR Image
File > Click Save. > OpenEXR Configuration dialog

Rendered Frame Window > Click Save Bitmap. > Enter file name and set type
to OpenEXR Image File > Click Save. > OpenEXR Configuration dialog
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Use the OpenEXR Configuration dialog dialog to set output parameters for
OpenEXR files. You can specify the format for saving the RGBA data as well
as which of the four standard channels should be saved. An option is available
to use RealPixel unclamped color information for Render Output saving. Also
available are color transforms to be applied, file compression type, and
additional attributes.

Interface

Compression Type Lets you choose the method of file compression. The
OpenEXR API provides for three general types of lossless compression,
including two different methods of Zip compression. For most images without
a lot of grain, the two Zip compression methods seem to work best, while the
PIZ compression algorithm is better suited to grainy images. The following
options are available:

■ None Disables all compression.

■ Run Length Encoding (RLE) A basic form of compression comparable to
that used by standard Targa files.

■ Zip (per scanline) Zip-style compression applied to individual scanlines.

■ Zip (16 scanline blocks) Zip-style compression applied to blocks of 16
scanlines at time. This tends to be the most effective style of compression
to use with rendered images that do not have film grain applied.

■ PIZ ( wavelet compression ) Uses a combined wavelet/Huffman
compression. This form of compression is best for grainy images.

OpenEXR Files | 7351



Standard Channels group

The standard channels in an image are: red, green, blue, and alpha
(transparency). This group lets you choose the general type of OpenEXR file
to save, as well as which of the four channels to save with the file. The most
widely supported format is Half Float - 64 bpp format. This stores each channel
of the image in a separate slice in the file using half-type 16-bit floating-point
data. The OpenEXR distribution has features that allow easy implementation
of reading and writing this type of file, and it is considered a standard OpenEXR
file.

Format Choose one of the following from the drop-down list:

■ Integer - 32 bpp This non-standard OpenEXR format contains only a
single 32–bit integer channel. It uses a packedIntRGBA image type in order
to support old-style bit depths, such as 32–bit Targa files. Only this plug-in
can read this format.

■ Half Float - 64 bpp This 16-bit-per-channel “half-float” format is standard
OpenEXR. Any software that supports OpenEXR can use this format.

■ Float - 128 bpp The 32-bit-per-channel “full-float” format is encoded
using standard OpenEXR channel tags. Most OpenEXR implementations
will have no problems reading this format.

R/G/B/Alpha Let you specify the channels to save: red, green, blue, and alpha.

Use RealPixel RGB Data When on, compresses the essential data of
floating-point color into 32 bits. For technical information, see the RealPixel
Struct Reference topic in the 3ds Max SDK Help.

NOTE Image motion blur is not applied to the RealPixel RGBA data by the renderer.
If you are using Image motion blur, you will not be able to save RealPixel
unclamped color data.

Exponent Enables and sets the power function exponent to use. This is
effectively a gamma curve, but the exponent is presented in an inverse manner
from typical gamma. The default value is what exrdisplay expects for input.

Pre-Multiply Alpha When on, the software uses premultiplied alpha on page
8096 when saving the file. Pre-multiplying saves computation time if you later
use this image in compositing.

Plugin About Opens a dialog that shows information about the OpenEXR
plug-in.
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Extra Channels and Attributes Opens a sub-dialog on page 7353 that lets you
specify additional information to save with the OpenEXR image file.

OK Accepts any changes and closes the dialog.

Cancel Discards any changes and closes the dialog.

Extra Channels and Attributes

To specify an extra attribute or channel to be included in the saved OpenEXR
file, click the corresponding + button and then choose the attribute or channel
from the list. To delete an attribute or channel, highlight it in the list and
then click the corresponding X button.

General Notes on Extended Attributes and Channels

Please note the following:

■ You can view the extended information via the File Info button on page
7358 on the input dialog.

■ A default File Tag string is provided when you add an attribute/channel.
You can change the file tag by highlighting the entry in the list and then
editing the File Tag field immediately below the list. You can also enable
and disable the attribute/channel with the check box to the left of the File
Tag field.
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NOTE Each saved attribute or channel must have a unique file tag. If you
specify multiple instances of a file tag, only the first attribute or channel with
that file tag is used.

■ All the current attributes are String type attributes that are stored in the
header for the file, and can be read in plain text via the exrheader.exe utility
(available from http://www.openexr.com/the official Website > Downloads
page).

■ Attributes and channels are stored in the file in alphabetical order according
to the ASCII file tag.

■ While this plug-in can write most of the 3ds Max G-Buffer on page 7991
channels, there is no software that can utilize them yet.

■ Attributes and channels are identified by plain-text (ASCII) strings. There
can be only one instance of a string tag in any file. Attributes are data that
is stored per frame, not per pixel, and they are embedded in the file's
header. Channels are data that is stored per pixel. In order to maximize
flexibility with other software, this plug-in lets you edit the file tags. You
should only do this if you know the tag required by some other software;
otherwise it is best to leave the file tags at their default values.

■ Channels that create multiple “slices” in the EXR file require multiple file
tags. In this case, the file tag in the user interface comprises several sub-tags
denoted by square brackets. For example, the Normal channel generates
three slices in the EXR file: one for the Normal vector x data, 1 for y, and
1 for z. In this instance, the tag string in the user interface would read
[NX][NY][NZ], and generate slices with the file tags "NX", "NY", and "NZ".
The file tag is used by software that is reading the EXR file to identify the
intended use of the channel data. Even standard image channels are
encoded this way, with the tags "R", "G", "B", and "A" used to denote red,
green, blue, and alpha channels respectively.

Extended Attributes

Comment A general-purpose comment string defined by the user. To define
the comment, highlight the Comment entry in the list and then edit the
Comments field immediately below the list.

Computer Name The name of the computer the image was saved from. In
the case of standard render output during a net render, this is the machine
that rendered the frame.

System Time The UTC (GMT) system time and date when the file was written.
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Local Time The local time and date (corrected for the time zone) when the
file was written.

Version OpenExr The plug-in version, OpenEXR API version, and ZLib version
in plain text form.

Version 3dsMax The release version of 3ds Max itself, the API number, and
the SDK revision used when the build of 3ds Max was compiled. This also
reports whether the file was generated using 3ds Max or Autodesk VIZ.

Extended Channels

Z-Buffer The standard buffer depth channel. (16-bit or 32-bit floating point)

Object ID The object ID from the Object Properties dialog on page 305. (32-bit
unsigned integer)

Material ID The material effects channel number on page 5348. (32-bit unsigned
integer)

Node Render ID A unique object ID set by the renderer. All objects in the
scene have a unique Render ID, though the value stored varies from renderer
to renderer. (32-bit unsigned integer)

UV Coords The UV coordinates for the object. Only one UV channel is stored.
(two slices, 16-bit or 32-bit floating point)

Velocity The 2D velocity vector for the pixel in screen space. (two slices, 16-bit
or 32-bit floating point)

Normal The surface normal. (three slices, 16-bit or 32-bit floating point)

Coverage The pixel coverage of the foremost object in the pixel. (32-bit
unsigned integer, 16-bit floating point, or 32-bit floating point)

Opening OpenEXR Files

Any command that opens an image file, such as View Image File > Specify an
EXR file. > Click Open. > OpenEXR Configuration dialog

This version of the OpenEXR Configuration dialog appears whenever you
open an EXR file. It lets you specify various color transformations to be applied
to the loaded image, designate the internal storage format to use, and preview
the loaded image with the color transforms applied. There is also a histogram
for viewing the brightness distribution in the image and adjusting the white
and black points interactively.
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Interface

Histogram

To view the histogram, click the Preview button. The histogram displays a
detailed bar graph of the distribution of brightness throughout the image.
The horizontal axis of the histogram defines the luminance value, and the
vertical axis indicates the percentage of the image covered by pixels of that
brightness. Histogram features are:

■ The histogram supports several display modes, which you can choose by
right-clicking the histogram display window. The menu lets you choose
between linear and logarithmic display, automatic or manual x-axis scaling,
y-axis scale options, and which channel is graphed: luminance, red, green,
or blue. The menu entries X-Axis Scale and Y-Axis Scale are simply labels,
and are thus unavailable for choosing.
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■ The vertical scale slider on the left side of the histogram lets you adjust
the automatically computed vertical scale.

■ To modify the luminance “window,” set X-Axis Scale to Manual and adjust
the minimum and maximum values in the numeric fields below either
end of the graph.

■ The background coloration indicates several pieces of information:

■ The area between the black and white points is shaded gray.

■ The area below 1.0 (low dynamic range) is a lighter shade of gray than
the area with luminance greater than 1.0, the high dynamic range
region.

■ The background of the region outside the currently selected
blackpoint/whitepoint region is tinted pink.

■ The vertical dotted lines indicate integer spacing (for example,
1...2...3...4). To see these, the maximum luminance value must be
greater than 1.0.

■ You can drag whitepoint/blackpoint markers in the histogram to place
them visually. The hot-spot is two pixels to either side of the marker line.
White point selection is tested first, so if the two lines are right next to
each other, the white point will be selected.

■ You can set the display itself to linear or logarithmic mode. Logarithmic
display remaps all values greater than 1.0 to a logarithmic curve. The dotted
spacing indicators are supplemented by heavier dotted lines that indicate
when the scale has changed by a factor of 10. This is useful for most HDR
images, as the HDR data is usually spread out over a wide range.

■ Setting X-Axis Scale to Auto mode causes the histogram to encompass the
entire spectrum of the image. If you switch back and forth, previous
manually set values are preserved and restored.

File Loading Parameters group

Storage Buffer Format Specifies the format in which the image data is stored
within 3ds Max. The base types are variations on 8-bits-per-channel and
16-bits-per-channel integer formats. There are two forms of each: one with
alpha (RGBA) and one without alpha (RGB). If you are loading an image with
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an alpha channel but don't require the alpha data, choose the RGB version
to save some memory. If you choose a storage type that supports alpha, but
load an image without alpha, no memory is allocated for the alpha channel;
the loader detects the situation and reverts to the alpha channel-free storage
option with equivalent RGB bit depth.

The options supports the HDR bitmap storage options. This allows storage of
the high-dynamic-range data within 3ds Max in three different HDR formats:
24- and 32-bit LogLUV formats and 32-bit RealPixel format.

EXR files loaded using these storage modes are suitable for use as environment
maps for reflections and skylight.

Color Transform Because EXR images often contain values brighter than
“white,” it is often desirable to change the luminance range in the source
image over which black to white occurs; that is, to remap the color data. When
Color Transform is on, you can adjust these luminance and general brightness
controls:

Exponent The exponent to apply when loading the file

Black Point Where black should be in the luminance range of the image

White Point The white point

RGB Level A standard multiplier for the RGB data

RGB Offset An additive offset for the RGB data

Preview The Preview window provides for interactive previewing of
color-transform options for loading EXR files. After choosing an EXR file to
open, click Preview to enable the preview window. The image file is loaded
into the preview window, and from then on any changes to the Color
Transform options update the thumbnail in real time.

The preview window ignores the aspect ratio of the image to make the most
of the small screen space available.

Plugin About Opens a dialog that shows information about the OpenEXR
plug-in.

File Info Opens the File Information dialog on page 7359, which lets you view
file statistics plus any attributes and channels stored in the file.

OK Accepts any changes, closes the dialog, and opens the image file.

Cancel Discards any changes and closes the dialog without loading the image
file.
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File Information dialog

This read-only dialog displays basic file statistics including date, time, size,
and resolution, plus any attributes and channel information stored with the
file. See Extra Channels and Attributes on page 7353.

PIC Files

3ds Max can import and export Radiance Picture (PIC) files. The PIC file is a
lighting-analysis format used for the same purpose as LogLUV TIFF files on
page 7372. The PIC format differs from the LogLUV TIFF format by creating
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separate files for luminance on page 8029 and illuminance on page 8009 channel
data (the LogLUV TIFF format creates one file containing both channels).

One way to create PIC files is with the Lighting Data Exporter utility on page
6759. You specify a file name by clicking the File Name button. When you click
Export, the Lighting Data Exporter renders two files. The string “_Illuminance”
is appended to the name of one file, and “_luminance” is appended to the
other. For example, if you type house as the file name, the exporter renders
to house_illuminance.pic and house_luminance.pic.

You can also open and save high-dynamic-range images in the PIC format
using the Radiance Image File format in input and output file browsers in 3ds
Max. For further information, see HDRI Files on page 7334.

See also:

■ Radiosity Workflows on page 6181

PNG Files

PNG (Portable Network Graphics) is a still-image file format developed for use
with the Internet and World Wide Web.

Interface

Clicking Render or Setup in the Render Output File dialog on page 6086 displays
the PNG Configuration dialog.
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Optimized palette (256) Choose to render a smaller, 8-bit color file.

RGB 24 bit (16.7 Million) Choose to render a true color (24-bit) file.

RGB 48 bit (281 Trillion) Choose to render a 48-bit color file.

Grayscale 8 bit (256) Choose to render a grayscale image with 256 shades.

Grayscale 16 bit (65,536) Choose to render a grayscale image with 65,536
shades.

Alpha Channel Turn on to save the alpha channel with the file.

Interlaced Turn on to make the file interlaced for faster display in Web
browsers.

PSD Files

PSD is the file-name extension for graphics files native to Adobe Photoshop.
This image format supports multiple layers of images superimposed to get the
final image. Each layer can have any number of channels (R, G, B, Mask, and
so on). It is a powerful file format because multiple layers can contribute to a
variety of special effects.
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Adobe provides many different modes of superimposing layers, including
normal, darken, lighten, difference, multiply, screen, dissolve, hard light, hue,
saturation, color, luminosity, overlay, and soft light.

You can use PSD files as bitmaps, viewport backgrounds, and so on. You can't
render to a PSD file.

3ds Max supports Photoshop 6.0 format, and allows you to use image layers
as bitmaps, as well as the entire composited graphic.

Limitations

Bits Per Channel Photoshop supports images with 1, 8, and 16 bits per channel
(1-, 24-, and 48-bit RGB images, respectively). 3ds Max supports PSD images
with 8 or 16 bits per channel. (In practice, there are very few images with 1
bit per channel.) While Photoshop can load images with 16 bits per channel,
layers are always 8 bits per channel.

Modes 3ds Max supports .psd files saved in the following modes:

■ RGB

■ Grayscale

3ds Max doesn't support the following Photoshop modes:

■ Indexed Color

■ Bitmap

■ Duotone

■ CMYK Color

■ Lab Color

■ Multichannel

Non-Image Layers Layers other than image layers (for example, text layers)
are not supported. In Photoshop, you can “rasterize” a non-image layer to
make it an image.

Compositing Options Compositing options between image layers, which
require processing by Photoshop, are not supported.
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Interface

When you open a PSD file as a bitmap, a dialog appears that lets you choose
how to use the image.

Collapsed Layers displays the entire image.

Collapsed Layers (The default.) Uses the entire composited image.

Individual Layer Uses a single layer of the image. When you choose this, the
dialog shows a list of the layers, with a thumbnail of each, and the layer names.
Click a layer to choose it, then click OK.
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Individual Layer displays list of layers to choose from.

Full Frame When on, uses the entire layer as the bitmap. When off, uses only
that portion of the layer occupied by image data. Default=on.

RLA Files

The RLA format is a popular SGI format that supports the ability to include
arbitrary image channels. While setting up a file for output, if you select RLA
Image File from the list and click the Setup button, you'll go to the RLA setup
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dialog. Once there, you can specify what channels (and what format) you
want to write out to the file.

See also:

■ RPF Files on page 7366

Interface

When RLA is the chosen output format, clicking Render or Setup on the Render
Output File dialog on page 6086 displays the RLA Image File Format dialog.

Standard Channels group

The standard channels are RGB color and the alpha (transparency) channel.

Bits per Channel Choose 8, 16, or 32 Floating Point as the number of bits
per channel. Default=8.

Store Alpha Channel Choose whether to save the alpha channel. Default=on.

Premultiply Alpha When on, premultiplies the alpha channel. Default=on.

Premultiplying saves computation time if you later use this image in
compositing. For more information, see Premultiplied Alpha on page 8096.

Optional Channels group

For output RLA files, there are eight additional channels that you can generate
(and view in the Rendered Frame Window):

Z Depth Displays Z-Buffer information in repeating gradients from white to
black. The gradients indicate relative depth of the object in the scene.
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Material ID Displays the Effects channel used by materials assigned to objects
in the scene. The Effects channel is a material property set in the Material
Editor and used during Video Post compositing. Each Effects Channel ID is
displayed using a different random color.

Object ID Displays the G-Buffer on page 7991 Object Channel ID assigned to
objects using the Object Properties dialog. The G-Buffer ID is used during
Video Post compositing. Each G-Buffer ID is displayed using a different random
color.

UV Coordinates Displays the range of UV mapping coordinates as a color
gradient. This channel shows where mapping seams might occur.

NOTE UV Coordinates will not be displayed on objects that have the UVW Map
Modifier applied unless a map has been applied that uses the coordinates.

Normal Displays the orientation of normal vectors as a grayscale gradient.
Light gray surfaces have normals pointing toward the view. Dark gray surfaces
have normals pointing away from the view.

Non-Clamped Color Displays areas in the image where colors exceeded the
valid color range and were corrected. The areas appear as bright saturated
colors usually around specular highlights.

Coverage This saves the coverage of the surface fragment from which other
G-buffer values (Z Depth, Normal, and so on) are obtained. Z-Coverage values
range from 0 to 255. To see Z Coverage, render to an RLA file after first
checking Z Coverage in the Setup subdialog, then choose Z-Coverage in the
Rendered Frame Window's Viewing Channel drop-down list.

The Z-Coverage feature is provided primarily for developers, and should aid
in the antialiasing of Z-buffers.

Descriptive Information group

This information is saved with the file.

Description You can enter descriptive text here.

Author You can enter your name here.

RPF Files

RPF (Rich Pixel Format) is the format that supports the ability to include
arbitrary image channels. While setting up a file for output, if you select RPF
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Image File from the list, you'll go to the RPF setup dialog. Once there, you can
specify what channels you want to write out to the file.

RPF files replace RLA files as the format of choice for rendering animations
requiring further post-production or effects work. Many channels available
in RPF files are exclusive to this format.

TIP When you create a scene you plan to render as an RPF file for use with the
Autodesk Combustion™ product, turn on Render Occluded Objects (on the Object
Properties dialog on page 305 ) for objects in the scene. This is important if you
want to use the Combustion G-Buffer Extract feature. When Render Occluded
Objects is enabled and you extract an object in Combustion, the objects behind
it are drawn correctly. If Render Occluded Objects is disabled (the default), objects
behind the extracted object appear with black holes where they were occluded.

Interface

When RPF is the chosen output format, clicking Render or Setup on the Render
Output File dialog on page 6086 displays the RPF Image File Format dialog.

Standard Channels group

The standard channels are RGB color and the alpha (transparency) channel.

Bits per Channel Choose 8, 16, or 32 Floating Point as the number of bits
per channel. Default=8.

Store Alpha Channel Choose whether to save the alpha channel. Default=on.

Premultiply Alpha When on, premultiplies the alpha channel. Default=on.

Premultiplying saves computation time if you later use this image in
compositing. See Premultiplied Alpha on page 8096 for more information.
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Optional Channels group

For output RPF files, there are additional channels that you can generate (and
view in the Rendered Frame Window):

Z Depth Saves Z-Buffer information in repeating gradients from white to black.
The gradients indicate relative depth of the object in the scene.

Material ID Displays the Effects channel used by materials assigned to objects
in the scene. The Effects channel is a material property set in the Material
Editor and used during Video Post compositing. Each Effects Channel ID is
displayed using a different random color.

Object ID Displays the G-Buffer on page 7991 Object Channel ID assigned to
objects using the Object Properties dialog. The G-Buffer ID is used during
Video Post compositing. Each G-Buffer ID is displayed using a different random
color.

UV Coordinates Saves the range of UV mapping coordinates as a color
gradient. This channel shows where mapping seams might occur.

NOTE UV Coordinates will not be displayed on objects that have the UVW Map
Modifier applied unless a map has been applied that uses the coordinates.

Normal Saves the orientation of normal vectors as a grayscale gradient. Light
gray surfaces have normals pointing toward the view. Dark gray surfaces have
normals pointing away from the view.

Non-Clamped Color Saves areas in the image where colors exceeded the valid
color range and were corrected. The areas appear as bright saturated colors
usually around specular highlights.

Coverage Saves the coverage of the surface fragment from which other G-buffer
values (Z Depth, Normal, and so on) are obtained. Z-Coverage values range
from 0 to 255. To see Z Coverage, render to an RLA file after first checking Z
Coverage in the Setup subdialog, then choose Z-Coverage in the Rendered
Frame Window's Viewing Channel drop-down list.

The Z-Coverage feature is provided primarily for developers, and should aid
in the antialiasing of Z-buffers.

Node Render ID Saves each object as a solid color according to its G-Buffer
Object channel (found under Object Properties).

Color Saves the color returned by the material shader for the fragment. This
channel displays any transparent fragment as a solid color.
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Transparency Saves transparency returned by the material shader for the
fragment. Any fragment with any degree of transparency will be rendered as
a solid gray object.

Velocity Saves the velocity vector of the fragment relative to the screen in
screen coordinates.

Sub-Pixel weight Saves the sub-pixel weight of a fragment. The channel
contains the fractions of the total pixel color contributed by the fragment.
The sum of all the fragments gives the final pixel color. The weight for a given
fragment takes into account the coverage of the fragment and the transparency
of any fragments that are in front of a given fragment.

Sub-Pixel Mask Saves the sub-pixel alpha mask. This channel provides a mask
of 16 bits (4x4) per pixel, used in antialiased alpha compositing. This mask is
especially useful with the Combustion compositing product.

Descriptive Information group

This information is saved with the file.

Description You can enter descriptive text here.

Author You can enter your name here.

RGB (SGI Image) Files

The SGI™ Image File format is a bitmap file type created by Silicon Graphics®.
SGI Image File support in 3ds Max lets you load and save files in both 8- and
16-bit color depth, with alpha channels, and RLE Compression.

Interface

Clicking Render or Setup in the Render Output File dialog on page 6086 displays
the RGB Image File Format dialog.
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Channel Bit Depth group

8 Bit Saves the RGB file as 8-bit color.

16 Bit Saves the RGB file as 16-bit color.

Use Alpha toggle

Use Alpha Saves Alpha channels with the RGB file.

TGA (Targa) Files

The Targa (TGA) format was developed by Truevision for their video boards.
The format supports 32-bit true color; that is, 24-bit color plus an alpha
channel, and is typically used as a true color format.

Targa files are widely used to render still images and to render sequences of
still images to video tape.

Some Targa files created by other applications have different file-name
extensions. 3ds Max can render the .vda, .icb, and .vst variants as well as .tga.

Interface

Clicking Render or Setup in the Render Output File dialog on page 6086 displays
the Targa Image Control dialog.
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When you render to a Targa file, you have the following options:

Image Attributes group

Bits-Per-Pixel Choose the color depth: 16-bit, 24-bit, or 32-bit.

Compress Applies lossless compression to the file.

Alpha Split Creates a separate file for the alpha channel. The file name created
for the alpha-channel file starts with a_ and then appends the full file name.
For example, if you check this box and render the file greek004.tga, 3ds Max
creates the file a_greek004.tga for the alpha channel. (Sometimes the name
will be longer than 8 characters.)

Pre-Multiplied Alpha When on, pre-multiplies the alpha channel.
Pre-multiplying saves computation time if you later use this image in
compositing. See Premultiplied Alpha on page 8096.

Additional Information group

Author Name, Job Name/ID, Comments These fields are available for you
to add information about the file.
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NOTE To control whether or not the renderer uses the environment map's alpha
channel in creating the alpha for the rendered image, choose Customize >
Preferences > Rendering, and then turn on Use Environment Alpha in the
Background Antialiasing group.

If Use Environment Alpha is turned off (the default) the background receives
an alpha of 0 (completely transparent). If Use Environment Alpha is turned
on, the alpha of the resulting image is a combination of the scene and
background image's alpha. Also, when writing TGA files with Pre-Multiplied
Alpha set to off, turning on Use Environment Alpha prevents incorrect results.
Note that only background images with alpha channels or black backgrounds
are supported when compositing in other programs such as Photoshop.

TIFF Files

TIFF (Tagged Image File Format) is a multiplatform bitmap on page 7926 format
originating on the Macintosh® and in desktop-publishing applications. TIFF
is a common choice if you plan to send your output to a print service bureau
or import the image into a page-layout program.

There are several classes of TIFF files, each varying in the color depth and color
palette that they support.

You can render TIFF files with alpha, luminance on page 8029, and UV color
coordinate information, which describes illuminance on page 8009. You also
have the option to render a compressed image. Luminance and illuminance
data are rendered by the Lighting Data Exporter utility on page 6759.

Interface

To open the TIF Image Control dialog, click Save or Setup on the Render
Output File dialog on page 6086.
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When you render to a TIFF file, you have the following options:

Monochrome Creates an 8-bit grayscale image.

Color Creates a 24-bit color image (no alpha channel).

Image Type group

Lets you choose the method for saving image information:

■ 8-bit Greyscale Creates an 8-bit grayscale image.

■ 8-bit Color Creates an 8-bit color image.

■ 16-bit Color Creates a 16-bit color image.

■ 16-bit SGI LogL Creates a color image that includes a logarithmic
encoding of the luminance channel.

■ 32-bit SGI LogLUV Creates a color image that includes a logarithmic
encoding of the luminance channel and UV color coordinate information.

Store Alpha Channel When on, stores the alpha channel along with other
image data. Alpha data adds 8 bits per pixel to the image type you selected.

Compression Type group

Lets you render a compressed TIFF file. Default=No Compression.

■ No Compression Does not compress the rendered image.
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■ Packbits Uses the TIFF Packbits algorithm to compress the file.

Dots Per Inch Sets the dots per inch (dpi) for the saved image. This setting
does not change the resolution of the final image, but can affect the way it
prints in documents.

YUV Files

YUV files are still-image graphics files in the Abekas Digital Disk format.

YUV is supported only as an input file format. You can use YUV files as
general-purpose bitmaps, but you can't render to a YUV file.

RAM Player
Rendering menu > RAM Player

The RAM Player loads a frame sequence into RAM and plays it back at selected
frame rates. The RAM Player has a channel A and a channel B. Two different
sequences can be loaded into the channels to play back together, giving you
the ability to compare them.

Clicking and dragging in the channel display window allows you to set the
A/B divider between the two channels. The right mouse button “scrubs” the
animation through all of its frames. Hold the right mouse button and move
the mouse left to move the animation back to the first frame. Move the mouse
right to advance the animation to its end.

For best RAM Player performance, Gamma should not be enabled in Customize
> Preferences > Gamma.
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Interface

Channel A/B

Open Channel Displays an Open File dialog that lets you select a file to load
into the channel. After you have selected a file, the RAM Player Configuration
dialog on page 7378 appears that allows you to set height, width, and memory
usage for that channel.

Open Last Rendered Image Loads the last rendered image into the channel.
Nothing is displayed if there is no last rendered image available.

Close Channel Unloads the image in the channel and frees up your memory.

Save Channel Displays a Save File dialog that lets you save the animation or
image from the respective channel. You can save the animation as a .avi file
or a numbered sequence of images.

NOTE The RAM Players converts everything it loads into 24-bit RGB which means
that some information may be lost when it is loaded. This may affect a file saved
in the RAM Player.

Channel A When selected, this button will show the file loaded into channel
A. Split screen markers are displayed if both channels are enabled. The split
screen markers are represented by two triangles. These markers indicate where
channel A ends and channel B begins. You can move the divider using the
left mouse button.

Channel B When selected, this button will show the file loaded into channel
B. Split screen markers are displayed if both channels are enabled. The split
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screen markers are represented by two triangles. These markers indicate where
channel A ends and channel B begins. You can move the divider using the
left mouse button.

Horizontal/Vertical Split Screen Toggles between the view of the two
channels side-by-side or one on top of the other.

Frame Controls

First Frame Automatically returns the RAM Player to the first frame of the
animation. If the RAM Player is at the first frame, First Frame returns the
animation to the last frame.

Previous Frame Backs up the RAM Player to the previous frame in the
animation. If the RAM Player is at the last frame, Previous Frame returns the
animation to the first frame.

Playback Reverse Plays the frames in the animation in reverse order. The
flyout contains an option to play the animation once and then stop.

Playback Forward Plays the frames in the animation in rendered order. The
flyout contains an option to play the animation once and then stop.

Next Frame Advances the RAM Player to the next frame in the animation.

Last Frame Automatically places the RAM Player at the last frame of the
animation.

Frame Rate Control Sets the desired frame rate in frames per second. When
playing back a movie, you see the frame rate displayed in the title bar of the
RAM Player. You can select a predefined frame rate or type in your own frame
rate value.

Color Selector Ctrl+right-clicking the mouse in the display window displays
the color of the pixel in the color selector swatch. Stop the animation to get
a correct pixel reading. The RGB of the pixel is also displayed in the title bar
of the RAM player.

Double Buffer Selecting Double Buffer ensures that the two frames in channels
A and B are synchronized. Enabling this function has a substantial impact on
the maximum frame rate.
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RAM Player Keyboard Shortcuts

The following keyboard shortcuts are available for the RAM Player.

Keyboard ShortcutRAM Player Function

HomeGo To Start Frame

EndGo To End Frame

Left ArrowGo To Previous Frame

Right ArrowGo To Next Frame

Up ArrowPlayback Reverse

Down ArrowPlayback Forward

Esc or Ctrl+CStop Playback

SpacebarToggle Playback or Stop

AToggle Channel A On/Off

BToggle Channel B On/Off

Ctrl+AOpen File in Channel A

Ctrl+BOpen File in Channel B

Alt+AOpen Last Rendered Image in Channel A

Alt+BOpen Last Rendered Image in Channel B

Ctrl+left mouse button or right mouse
button

Scrub Animation
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RAM Player Configuration Dialog

Rendering menu > RAM Player > Load a file into either channel. > RAM Player
Configuration dialog

The RAM Player Configuration dialog contains controls for resolution, frames,
memory usage, and alpha channel for playing back animations.

Interface

Resolution group

Width Defines the width at which the file is loaded.

Height Defines the height at which the file is loaded.

Lock Aspect Ratio When turned on, Lock Aspect Ratio forces the file to load
at the same aspect ratio, regardless of the Width and Height values you enter.

If you change the Width of the file, the Height adjusts according to the file's
original aspect ratio. Adjusting the Height does the same to the Width value.

Filter Input When turned on, Filter Input filters the image or animation so
that it best maintains the quality of the original file. When turned off, filtering
does not occur, and the image or animation could be distorted.
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Frames group

Start Frame Specifies a certain frame in an animation where you want the
RAM Player to begin loading. A value of 1 would start the animation at its
rendered beginning. A value of 5 would start the animation on frame five and
any frame before that would not be loaded.

Num Frames Specifies the total number of frames to be loaded into the RAM
Player.

Memory Usage group

Maximum Lets you configure the maximum amount of memory to use for
the RAM player. This value includes both channels.

Alpha group

Load Into Other Channels When turned on, this option loads a grayscale
alpha channel into the other channel. This allows you to wipe between an
RGB channel of the animation and the alpha channel of the animation.

Scene Explorer
Menu bar > Tools > New Scene Explorer

Menu bar > Tools > Open Explorer: [name of most recently used explorer]

Menu bar > Tools > Saved Scene Explorers > Choose a saved scene explorer.

Scene Explorer provides a modeless dialog for viewing, sorting, filtering and
selecting objects in 3ds Max, as well as additional functionality for renaming,
deleting, hiding, and freezing objects, creating and modifying object
hierarchies, and editing object properties en masse.

When working on a new scene, you open the Scene Explorer dialog with the
Tools menu > New Scene Explorer command. Each subsequent invocation of
this command opens a separate, additional Scene Explorer dialog. All scene
explorers persist in the scene, even if closed. You can open the most recently
used scene explorer with the Tools menu > Open Explorer command, or any
scene explorer with the Tools menu > Saved Explorer submenu.

TIP In a new scene, the keyboard shortcut Alt+Ctrl+O (letter O) creates a new
scene explorer. But when one or more scene explorers exist in the scene, the same
shortcut opens the most recently used explorer.
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All active scene explorers are saved and loaded with the scene. To save and
load scene explorers separately, and delete and rename them, use the Manage
Scene Explorer dialog on page 7393.

The Scene Explorer interface consists of a menu bar, two toolbars, and a table
view of objects in the scene, with a row for each object and a column for each
displayed object property. The default layout displays object name, color,
number of faces, and certain display properties, but you can easily customize
it to show only the properties you want. You can save customized Scene
Explorer setups, and set any custom setup to be the default view.

Scene Explorer Features

Following are some of the notable features of Scene Explorer:

■ Customize the dialog by setting any configuration of columns, hidden
and displayed categories, etc.

■ Open as many separate instances of the dialog as you like, each with a
different configuration.

■ Synchronize selection between Scene Explorer and the scene.

■ Save and load different configurations.

■ Set any configuration as the default.

■ Scene Explorer setup saved with your MAX scene file.

■ Use scripting to create custom columns such as an editable Radius field on
page ?.

■ Create and edit object hierarchies by dragging and dropping.

■ Sort on single or multiple columns.

■ Change object settings singly or en masse.
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■ Powerful, sophisticated search and filtration features.

See also:

■ Using Scene Explorer on page 7381

■ Scene Explorer Columns on page 7385

■ Scene Explorer Menus on page 7389

■ Scene Explorer Toolbars on page 7391

■ Manage Scene Explorer on page 7393

■ Advanced Search Dialog on page 7395

■ Advanced Filter Dialog  on page 7397

Using Scene Explorer

This topic includes procedures for using general functionality in the Scene
Explorer window on page 7379. You can find additional procedures for specific
Scene Explorer features in Scene Explorer Columns on page 7385, Advanced
Search Dialog on page 7395, and  Advanced Filter Dialog  on page 7397.

To highlight objects in Scene Explorer:

■ Optionally, set the filters on the Display toolbar to show only object types
you’re interested in. Next, do any of the following:

■ Click in the Find field, if necessary, and then, on the keyboard, enter
enough characters to distinguish the object or objects you want to
select from the rest. For example, if the scene contains several spheres
and several boxes, you can highlight all the spheres simply by typing
S (assuming the spheres still have their default names).

TIP The Scene Explorer dialog always opens with the keyboard focus in
the Find field, so in general you don’t need to click the field before entering
a search phrase.

■ Use the mouse:

■ To highlight a single item, click its name.
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■ To highlight multiple contiguous list entries, drag vertically in any
column. Alternatively, click the first item and then Shift+click the
last.

■ To highlight non-contiguous items, hold down the Ctrl key as you
click.
To remove highlighting from an item, Ctrl+click it.

■ On the upper toolbar, click Select All, Select None, or (after making
a selection), Select Invert.

■ If any named selection sets on page 239 exist, choose one from the
Selection Set drop-down list on the upper toolbar.

■ Use the Advanced Search function on page 7395: From the Scene Explorer
> Select Menu, choose Search, set any number of Boolean search terms,
and then click Select.

To edit properties for multiple objects:

1 Highlight several objects, as described in the preceding procedure.

2 Change a property for any of the highlighted objects. For example, turn
on Hidden, or change an object name.

All highlighted objects receive the changed value or property.

TIP You can toggle an on/off-type property, such as Hidden, by clicking
anywhere in the cell, not just in the check box.

NOTE Clicking a highlighted item’s row doesn’t remove highlighting from
other highlighted rows.

To synchronize selection between the scene and Scene Explorer:

Do any of the following:

■ Make a selection in Scene Explorer, and then right-click a selected item in
the list and choose Select In Scene.

■ On the Scene Explorer > Select menu, turn on Sync Selection. When this
is on, selecting an object in the viewport highlights it in Scene Explorer
and vice-versa.
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■ Make a selection in the viewport, and then right-click any cell in Scene
Explorer and choose Pull Selection from Scene.

To delete objects from the scene:

■ Highlight one or more items in Scene Explorer, and then right-click a
highlighted item in the list and choose Delete From Scene.
The objects are deleted from Scene Explorer and the scene.

TIP To undo such a deletion with the keyboard shortcut Ctrl+Z, first change
the focus from Scene Explorer to the main application by activating a viewport
or clicking the command panel.

To edit hierarchies with Scene Explorer:

■ To link one object to another (child to parent), drag an object’s icon (to
the left of its name) to another object. The first object will become a child
of the second object. When a yellow arrow appears to the left of the target
object, release the mouse button.

■ To unlink a child object from its parent, drag the object’s icon to the Scene
Root node at the top of the list.

To remove a column from the table:

1 Drag the column heading downward until the mouse cursor changes to
an X icon.

2 Release the mouse button.

To edit multiple items:

1 Make sure the value or values you want to change are exposed in the
Scene Explorer interface. If not, add them with the Column Chooser on
page ?.

2 Highlight multiple list entries.

3 Change a value for one of the entries.

Scene Explorer sets the same value for all of the highlighted entries.
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To rename an object:

This method applies to editing any text field, such as the custom Radius field
demonstrated in the next procedure.

1 Select the object in the list by clicking its name (or the field you want to
edit). Alternatively, select multiple list entries. The editing is applied to
all highlighted entries.

2 Do any of the following:

■ Press F2.
This highlights the object name.

■ Double-click an entry.
This places an insert cursor where you double-click.

NOTE You need not double-click a highlighted entry. If you double-click
a non-highlighted entry, you can edit it immediately, and the edit affects
only that entry. If you double-click a highlighted entry and edit it, the
edit affects all highlighted entries.

■ Wait a moment and then drag over the part of the name you want
to replace.
This highlights only the text over which you drag.

3 Edit the name using the keyboard. When finished, press Enter or Tab, or
click a different part of the dialog.

Example: To customize Scene Explorer:

With some knowledge of MAXScript, you can add custom fields to Scene
Explorer that lets you view and edit object properties of your choice. In this
example, you’ll add an editable Radius column that applies to object primitives
such as Sphere, Cylinder, and Teapot.

1 Open a text editor and enter the following (you can copy and paste this
listing):

showinterface sceneexplorermanager

function getter node=(return getuserprop node "user")

function setter node value=(setuserprop node "user" value)

sceneexplorermanager.addproperty "User" getter setter

function getrad node=(if isProperty node "radius" then return

node.radius)

function setrad node value=(if isProperty node "radius" then

node.radius=value as float)
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sceneexplorermanager.addproperty "Radius" getrad setrad

2 Save the file in text format in the Scripts folder in your program
installation. Use the file name radius.ms.

3 In 3ds Max, create some teapots and spheres.

4 From the MAXScript menu, choose Run Script, and then find and
highlight the script file from step 2 and open it.

This adds a new item to the Column Chooser.

5 Open a new Scene Explorer window, right-click a column heading, and
choose Column Chooser.

6 Scroll down to the bottom of the Column Chooser dialog, and then drag
the Radius item to one of the current column headings.

The new Radius column shows and lets you edit the Radius values for
the teapots and spheres. You can now, for example, highlight several of
the objects by dragging in the Radius column, press F2 to edit the first
item you clicked on, and enter a new value; this sets all highlighted items
to the new Radius value.

Using groups with Scene Explorer

■ By default, group on page 282 members do not appear in the Scene Explorer
list. To show group members, open on page 283 the group. When the group
is closed, only the group itself appears in the list.

■ Scene Explorer does not support grouping functionality. In other words,
you cannot add members to groups or remove members by dragging and
dropping items in Scene Explorer.

Scene Explorer Columns

Scene Explorer on page 7379 > Column headings

The Scene Explorer columns provide information on and means to edit various
properties of scene contents in 3ds Max. These include text strings, check
boxes, numeric quantities, and more. You can also sort the Scene Explorer
listing by clicking a column heading (a second click reverses the sort).
Additional methods for using columns are available; see the Procedures section
(following).
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Procedures

To add columns to the table:

1 Right-click a column heading and then choose Column Chooser from
the context menu.

This opens the Column Chooser dialog.

TIP Another way to access Column Chooser is from the Display menu.

2 Drag a column heading from the Chooser dialog to one of the Scene
Explorer column headings.

The new column is inserted to the left of the existing column.

3 Continue adding columns as desired. When finished, close the Column
Chooser.

To sort the list based on a column or columns:

1 Click a column heading.

This performs a single-level sort based on the column contents, in
ascending order, as indicated by up arrow on the right side of the heading.
For example, clicking the Name column sorts the table in ASCII order,
starting with punctuation, then numbers, then letters.

NOTE Object hierarchies remain together when the list is sorted. Child objects
at the same level are sorted only with respect to one another, not objects on
other hierarchical levels.

2 To reverse the sort order, click the same column heading again.
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Alternatively, right-click a column heading and choose Sort Ascending
or Sort Descending. You can sort any number of different columns this
way to perform a multi-level sort. For example, you could sort by type,
and then, within that sort, by whether the objects are hidden.

To rearrange columns:

■ Drag a column heading on top of another one. This moves the column to
the left of the target column.

To resize a column:

■ Drag the divider on the right side of the column heading.
Alternatively, to auto-resize a column, double-click the divider on the right
side of the heading.

Interface

This section lists the available columns, briefly describes each column’s
function, and notes whether the column appears by default in Scene Explorer.

Name The name on page 7631 of the object.

Default column.

Type The type of object, such as Geometry, Shape, Light, and so on.

Default column.

Color The wireframe color on page 7631 of the object.

Default column.

Faces The number of faces in the object. By default, this is the number of
triangular faces, but with polygon-type objects such as editable poly, it’s the
number of polygons. For example, the default box primitive has 12 faces, but
if you convert it to editable poly, the Faces column value changes to 6. Other
modifiers can also change this value.

Default column.

Hidden Shows whether the object is hidden (quad menu, Display panel, or
Display floater).

Frozen Shows whether the object is frozen (quad menu, Display panel, or
Display floater).

See-Through Shows whether the object is see-through (Object Properties).
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Display as Box Shows whether the object has box display (Object Properties).

Cull Back Faces Shows whether the object has culled backfaces (Object
Properties).

Edges Only Shows whether the object is set to display only edges (Object
Properties).

Vertex Ticks Shows whether the object displays vertex ticks (Object Properties).

Trajectory Shows whether the object has trajectory display (Object Properties).

Ignore Extents Shows whether the object’s extents are ignored when zooming
(Object Properties).

Show Frozen in Gray Shows whether the object is shown as gray when it is
frozen (Object Properties).

Display Vertex Channel Shows whether vertex channel display is active for
editable mesh, poly, and patch objects (Object Properties).

Viewport Lighting Shows whether viewport lighting and shading is active
for the object (quad menu).

Viewport Locked Lighting For a light, shows whether viewport lighting is
locked (quad menu).

Viewport Shadows For a light, shows whether viewport shadows are active
(quad menu).

Light Color Shows the color that a light casts (Modify panel).

Light Intensity For a light, shows the intensity (Multiplier) value (Modify
panel).

Light On Shows whether the light is turned on (Modify panel)

Shadow On Shows whether the light casts shadows (Modify panel).

Has Material Shows whether the object has a material (Material Editor).

 Revit Category If the object is imported from Revit, shows its
user-defined Category tag.

 Revit Family If the object is imported from Revit, shows its user-defined
Family tag.
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 Revit Level If the object is imported from Revit, shows its user-defined
Level tag.

 Revit Type If the object is imported from Revit, shows its user-defined
Type tag.

 Application Origin If the object is imported from an application other
than 3ds Max, shows the originating application.

Scene Explorer Menus

Scene Explorer on page 7379 > Menu bar

The principal Scene Explorer menus are available on the dialog menu bar. In
addition, several context menus are available by right-clicking different
user-interface elements on the dialog.

Interface

Select menu

Select All Highlights all objects in the list.

Select None Removes highlighting from all objects in the list.

Select Invert Highlights objects that weren’t highlighted and vice-versa.

Select Children When on, highlighting a parent object also highlights its
children.

Select Influences When on and you highlight an object with influences on
page 8012, the influencing objects also highlight.

Choosing this command turns off Select Dependents, if on.

Select Dependents When on and you highlight an object that influences
another, the object’s dependents on page 7951 also highlight.

Choosing this command turns off Select Influences, if on.

Find Case Sensitive When on, searching with the Find field results in only
exact matches with the case in the search phrase.

Find Using Wildcards When on, searching with the Find field lets you use
standard wildcards: ? stands in for a single character, while * stands in for

Scene Explorer Menus | 7389



multiple characters. For example, if you have objects named Set11, Set21,
Set31, and Set34, using the search phrase “Set?1” with Find Using Wildcards
on will highlight the first three but not the fourth. Searching for “Set*” will
highlight all four.

Find Using Regular Expressions When on, you can use regular expressions
in the Find field.

For example, to highlight all items that do not start with upper-case “A”, turn
on Find Case Sensitive and Find Using Regular Expressions, and use this search
term: [^A]. Or to highlight all items that start with “sph” and end with “1”,
turn on Find Using Regular Expressions, and use this search term: sph.*1.
Similarly, to find all light targets, use .*Target.

Sync Selection When on, selecting an object in the viewport highlights it in
Scene Explorer and vice-versa.

Search Opens the Advanced Search dialog on page 7395, which lets you set up
and use complex Boolean search terms.

Display menu

Object Types The submenu choices are All, None, and Invert; these are the
same as the buttons at the right end of the Display toolbar on page 7392. Also
available on the submenu is the Hide Toolbar command, which toggles display
of the Display toolbar.

Children Displays linked objects as parent-child hierarchies, with the children
as expandable branches below their parent objects. When off, lists all objects
in the specified sort order with no regard to hierarchies.

Influences When on and you highlight an object with influences on page
8012, contents of any text-based fields of the influential objects appear in blue.

Column Chooser Opens the Column Chooser dialog, which lets you add
columns by dragging new column headings to the existing column headings.

 Configure Advanced Filter Opens the Advanced Filter dialog on page
7397, which lets you set up and use complex Boolean filter terms.

 Enable Advanced Filter Activates the filter specified with the Advanced
Filter dialog on page 7397.
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Scene Explorer Toolbars

Scene Explorer on page 7379 > Upper (main) and lower (Display) toolbars

Interface

main toolbar

Find Entering a search phrase here highlights search results in the list in real
time. By default, Scene Explorer uses a simple text-search method, but you
can alternatively use regular expressions by turning on Select Menu > Find
Using Regular Expressions.

View Use the drop-down list to choose a different scene explorer, or click in
the text field to edit the name of the current explorer.

Selection Set If any object-level named selection sets on page 206 exist in the
scene, use this list to choose one. This selects all objects in the set.

 Select All Highlights all objects.

 Select None Removes highlighting from all objects.

 Select Invert Toggles all highlighting; highlights non-highlighted
objects and vice-versa.

 Sync Selection When on, selecting an object in the viewport highlights
it in Scene Explorer and vice-versa.

 Lock Cell Editing When on, prevents you from changing any names,
settings, etc. All selection functionality remains intact.
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Display toolbar

Use these controls to determine the type of objects that are displayed in the
dialog list.

The first part of the Display toolbar consists of a row of buttons that toggle
display of the different list types. When on (pushed in, orange background),
a button enables display of its list type; when off (pulled out, gray background),
Scene Explorer doesn’t list that type of object. The list types are:

■  Display Geometry

■  Display Shapes

■  Display Lights

■  Display Cameras

■  Display Helpers

■  Display Space Warps

■  Display Groups

■  Display Object XRefs
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■  Display Bones

 Display All Turns on all display filters; that is, display of all object
types is enabled.

 Display None Turns off all display filters; that is, display of all object
types is disabled.

 Invert Display Toggles display of all object types; those that were
enabled are disabled, and vice-versa.

 Toggle Advanced Filter Activates the filter specified with the
Advanced Filter dialog on page 7397.

 Advanced Filter Setup Opens the Advanced Filter dialog on
page 7397, which lets you set up and use complex Boolean filter terms.

Manage Scene Explorer

Tools menu > Manage Scene Explorer

Use the Manage Scene Explorer dialog to save and load custom scene explorers,
delete and rename existing instances, and set your favorite scene explorer as
the default.
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Interface

When you first open the Manage Scene Explorer dialog, it lists all current
scene explorers. To highlight one or more list items, use standard mouse-based
methods, including clicking, dragging, and Ctrl+clicking.

Load Opens a file dialog named Load Scene Explorer. Highlight an INI file
and then click Open.

If the file isn’t a valid saved Scene Explorer file, you receive an error message
and nothing is loaded.

Save Lets you save the highlighted scene explorer as an INI file. Available only
when a single scene explorer is highlighted.

TIP The default folder for saving scene explorers is the \plugcfg folder, but because
it already contains a number of INI files, if you use this feature much you might
want to create a dedicated folder for saving scene explorers.

Delete Eliminates all highlighted Scene Explorer instances from memory. This
is not undoable.

Rename Opens a small Rename Scene Explorer dialog, with the name
highlighted in an editable field. Available only when a single scene explorer
is highlighted.

7394 | Chapter 23   Managing Scenes and Projects



Set as Default Makes the configuration of the highlighted scene explorer the
default configuration, so when you add a new scene explorer the software
uses this configuration. Available only when a single scene explorer is
highlighted.

Advanced Search Dialog

Scene Explorer on page 7379 > Select menu > Search

The Advanced Search dialog lets you highlight objects in the Scene Explorer
list using combinations of search phrases to specify Boolean searches. For
example, you can use Advanced Search to show only hidden non-geometry
objects of a specific color whose name begins with “S”.

Procedure

To use the Advanced Search dialog in Scene Explorer:

1 From the Property drop-down list, choose a property for your search.

This choice determines the available options in the Condition and
Reference Value lists.

2 Choose the Condition.

For example, if you set Property=Name, then you could choose
Condition=Contains String to be able to search for a text string anywhere
in the object names.

3 Set the Reference Value. With some properties, such as Name, you enter
the value from the keyboard. With others, such as Type and Color, you
use the mouse to choose the Reference Value from a list.

4 Click Add.

This adds the search term to the dialog list.

5 Add enough search terms to create the search you want to perform.

For example, if you want to find all objects other than Helper objects
whose name begins with “House”, your search would look like this:
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TIP

If you add a search term and then later decide you don’t want to use it,
highlight it in the list and then click Remove.

6 When you’ve set up the search you want, click OK.

This closes the Advanced Search dialog and highlights items that meet
the search criteria.

Interface

Use the dialog controls to specify one or more search phrases and then initiate
the search. Successful search results can meet all or any specified criteria.

Property Choose the desired property to search for from the drop-down list.

Condition Based on the Property choice, choose an available condition.

Reference Value Enter a search term or choose one from the drop-down list,
depending on the Property choice.
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Match All/Match Any To use all terms for the search, choose Match All. To
highlight items that match any of the search terms, choose Match Any. In
Boolean terms, Match All is an AND search and Match Any is an OR search.

Add Click to add the search phrase to the list.

Remove Deletes the highlighted search phrase from the list.

[list of search phrases] When you click Add, the current combination of
search conditions (the search phrase) is added to this list.

Select Closes the dialog and performs the search, highlighting all objects in
the Scene Explorer list that satisfy the combination of search conditions.

Cancel Closes the dialog without performing a search.

Advanced Filter Dialog 

Scene Explorer on page 7379 > Display toolbar > Advanced Filter Setup button

Scene Explorer on page 7379 > Display menu > Configure Advanced Filter

The Advanced Filter dialog lets you limit object display in Scene Explorer
based on combinations of filter conditions (filter phrases). For example, you
can use Advanced Filter to list only hidden non-geometry objects of a specific
color whose name begins with “S”.

Procedure

To use the Advanced Filter dialog in Scene Explorer:

1 From the Property drop-down list, choose a property for your filter.

This choice determines the available options in the Condition and
Reference Value lists.

2 Choose the Condition.

For example, if you set Property=Name, then you could choose
Condition=Contains String to be able to filter for a text string anywhere
in the object names.

3 Set the Reference Value. With some properties, such as Name, you enter
the value from the keyboard. With others, such as Type and Color, you
use the mouse to choose the Reference Value from a list.
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4 Click Add.

This adds the filter phrase to the dialog list.

5 Add enough terms to create the filter you want to perform.

For example, if you want to show only objects other than Helper objects
whose name begins with “House”, your setup would look like this:

TIP

If you add a phrase and then later decide you don’t want to use it,
highlight it in the list and then click Remove.

6 When you’ve set up the filter you want, click OK.

This closes the Advanced Search dialog and activates the filter, with the
result that only items that meet the criteria you specified appear in the
Scene Explorer list.

7 One way that you can tell the filter is active is that the Toggle Advanced
Filter button on the Display toolbar is on:

To return to displaying the full list, turn off Toggle Advanced Filter.

Interface

Use the dialog controls to specify one or more filter phrases and then initiate
the search. Successful search results can meet all or any specified criteria.
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Property Choose the desired property to filter for from the drop-down list.

Condition Based on the Property choice, choose an available condition.

Reference Value Enter a term or choose one from the drop-down list,
depending on the Property choice.

Match All/Match Any To use all phrases for the filter, choose Match All. To
filter for items that match any of the search phrases, choose Match Any. In
Boolean terms, Match All is an AND search and Match Any is an OR search.

Add Click to add the filter phrase to the list.

Remove Deletes the highlighted filter phrase from the list.

[list of filter phrases] Shows all active filter phrases. When you click Add, the
current combination of filter conditions is added to this list.

OK Closes the dialog and activates the filter, displaying only objects in the
Scene Explorer list that satisfy the combination of filter conditions.

Cancel Closes the dialog without activating the filter.

Scene States
Tools menu > Manage Scene States

Right-click to open the quad menu. > Display (upper-right) quadrant > Manage
Scene States

The Scene States feature provides a fast way to save different scene conditions
with various lighting, camera, material, environment, and object properties
that can be restored at any time and rendered to produce numerous
interpretations of a model. You save and restore scene states with the Manage
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Scene States dialog on page 7402, which makes it a convenient way to quickly
compare how different parameter settings affect how each scene looks. Because
scene states are saved with the MAX file, they are easily accessible to everyone
on a design team.

Scene states also allow you to experiment with different scene setups without
having to save the entire MAX file each time a change is made. This means
you don't need to open and close files in order to render different conditions
of the same model. As well, scene states do not add to the size of the file.

When you save a scene state, you can choose which aspects of the scene to
record:

■ Light Properties Light parameters such as color, intensity, and shadow
settings are recorded with the scene for each light or luminaire.

■ Light Transforms Transforms such as position, orientation, and scale are
recorded for each light.

■ Object Properties Current Object Properties values are recorded for each
object. This includes settings for Advanced Lighting and mental ray.

■ Camera Transforms Camera transform modes such as position, orientation
and scale are recorded for each camera.

■ Camera Properties Camera parameters such as FOV and depth of field,
including any corrections made by the Camera Correction modifier on
page 5247 are recorded for each camera.

■ Layer Properties Records the settings for each layer in the Layer Properties
dialog at the time the scene state is saved.

■ Layer Assignment Records each object's layer assignment.

■ Materials All materials and material assignments used in the scene are
recorded.

■ Environment Records these Environment and Atmosphere Effects on
page 6687 settings: Background, Ambient, and Tint colors; Global Lighting
> Level; Environment Map; Environment Map on/off state; Exposure
Control rollout settings.

Tips for Managing Scene States

■ When first becoming familiar with scene states, minimize changes to make
it easier to keep track of what each scene state contains.
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■ Saving all scene aspects in a scene state allows you more flexibility when
restoring. When you include all the parts of the scene, you can choose to
restore all or just a few of the aspects that were originally saved.

■ Additions made to a scene after a scene state has been saved affect how
the restored scene will render. For example, say you already have a scene
state named Omni that contains omni lights. You then decide to save
another scene state named Free Spot that contains a free spot light. When
you restore the Omni scene state, the scene will contain both the omni
lights and the free spot light.

If you decide to add other lights to the scene that you don't want to render
with the existing lights, you need to remember to turn off the new lights
and overwrite any existing scenes that have Light Properties saved. See
Saving Changes to an Existing Scene State on page ? on how to overwrite
an existing scene state.

■ Use descriptive names for scene states. If scene state names are too long
to see in the dialog, resize the Manage Scene States dialog or use the scroll
bar at the bottom of the dialog.
If you select individual parts to be saved with a scene state, it is useful to
note in the scene state name which parts are recorded.

■ If the scene contains more than one camera, restore the desired scene state
first, then change the viewport to the desired camera view.

Scene State Limitations

■ Even though you can select multiple scene states from the Manage Scene
State dialog, only one scene state can be restored at a time.

■ The currently restored scene state name is not displayed in the user
interface. It's helpful to save rendered scenes by their scene state name as
a reference.

■ Materials must be reopened in the Material Editor after a scene state
containing objects with material assignments is restored.

■ If part of a scene state is later deleted or hidden, a warning does not display
when the scene state is restored indicating that there are missing parts or
that the scene will not be restored as it was when originally recorded.

■ Likewise, if you delete one or more scene states from the Manage Scene
States dialog, you are not presented with a warning that you are about to
delete them. However, you can restore deleted scene states with Undo.
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■ Viewport configurations are not saved as part of the scene state. Therefore,
you cannot use scene states to control which viewport is active or whether
viewports are minimized or maximized.

Scene States and Batch Render

Scene states do not store viewport layouts, such as which camera view is active,
so you can use the Batch Render tool on page 6553 to coordinate rendering from
any camera that is saved with the model. With each camera task that you
assign to the batch render tool, you can specify a saved scene state that will
be automatically loaded and rendered.

See also:

■ Manage Scene States Dialog on page 7402

■ Batch Rendering on page 6548

■ Batch Rendering - Batch Render Dialog on page 6553

Manage Scene States Dialog

Tools menu > Manage Scene States

Right-click to open the quad menu. > Display (upper-right quadrant) > Manage
Scene States

The Manage Scene States dialog is a modeless dialog where you can select,
save, rename, and delete scene states on page 7399.

Procedures

To save a scene state:

1 Set up the scene in the viewport.

TIP It is best to first render the scene to see if it is set up the way you want
before saving it. If it isn't, make the desired changes and render again before
proceeding to the next step.

2 Right-click in a viewport and choose Save Scene State from the quad
menu.
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3 In the Save Scene State dialog, highlight the parts you want saved in the
scene state, then enter a descriptive name. For descriptions of these parts,
see Managing Scene States on page 7399.

4 Click the Save button. This saves the scene state to the MAX file.

To restore a scene state:

1 Right-click in a viewport and choose Restore Scene State from the quad
menu.

2 Choose the scene state to restore from the flyout list.

3 Highlight the parts you want restored with the scene state. Only the parts
that were originally saved with the scene state are listed.

4 Click Restore.

The scene state is restored in the viewport.

To rename a scene state:

1 Right-click in a viewport and choose Manage Scene States from the quad
menu.

2 In the scene state list, highlight the scene state you want to rename.

3 Click the Rename button.

4 In the Rename Scene State dialog, enter a new name for the scene state.

5 Click OK. The new name is displayed in the scene state list.

To delete a scene state:

1 Right click in a viewport and choose Manage Scene States from the quad
menu.

2 In the scene state list, highlight the scene state you want to delete.

3 Click the Delete button. The scene state is deleted from the MAX file.

NOTE You can undo to restore the deleted scene state.
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To save changes to an existing scene state:

1 In the Manage Scene States dialog, highlight the scene state you want to
overwrite.

2 Click the Save button.

The Scene State Manager displays a message confirming if you want to
overwrite the scene state.

3 Click OK.

Interface

The dialog lists all the scene states that are saved in the MAX file.

Save Opens the Save Scene State dialog on page 7405 where you enter a name
for the current scene state. To select a continuous range of parts, drag or
Shift+click. To make a noncontinuous selection, use Ctrl+click.

Restore Opens the Restore Scene State dialog on page 7406 for the selected scene
state.

Rename Opens the Rename Scene State dialog on page 7407 for the selected
scene.

Delete Deletes the highlighted scene state(s) without first warning you if you
are sure you want to delete the scene. To select a continuous range of entries,
drag or Shift+click. To select noncontinuous entries, use Ctrl+click.
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Close Closes the Manage Scene States dialog.

Save Scene State

Enter a Scene State name A text field where you enter a descriptive name for
the scene state.

Select Parts Lists the parts you can save in the scene state. By default, all parts
are highlighted except for Materials and Environment. When you make a
different selection set, it is “sticky,” which means the next time the dialog is
displayed, the parts you highlighted previously are highlighted.

Save Saves the scene state with the name you supplied and the parts you
selected. The scene state is saved in the MAX file.

Cancel Closes the dialog without saving the scene state.
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Restore Scene State

Enter a Scene State name Displays the scene name that was selected in the
Manage Scene States dialog. Use the drop-down list to select a different scene
state to restore.

Select Parts Displays a list of scene parts from which you can restore for the
scene state. To highlight a continuous range of parts, drag or Shift+click. To
highlight noncontinuous items, use Ctrl+click.

Restore Click to restore the scene state in the active viewport.

Cancel Closes the dialog without restoring the selected scene state.
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Rename Scene State

Enter a Scene State Name Enter a new name in the Name field for the
highlighted scene state. Click OK to accept the change or Cancel to close the
dialog without renaming the scene state.

Schematic View 
Menu bar > Graph Editors > New Schematic View

Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic
view.

Main toolbar > Schematic View button

The Schematic View is a node-based scene graph that gives you access to object
properties, materials, controllers, modifiers, hierarchy, and non-visible scene
relationships such as wired parameters and instancing.

Here, you can view, create, and edit relationships between objects. You can
create hierarchies, assign controllers, materials, modifiers, or constraints.
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You can use the Schematic View Display floater to control what entities and
relationships you want to see and work with. Use Schematic View to navigate
complex hierarchies or scenes with large numbers of objects. Use Schematic
View to understand and explore the structure of files you didn't create yourself.

One powerful feature is the list view. You can see the nodes in a text list which
you can sort by criteria. The list views can be used to navigate extremely
complex scenes quickly. You can use the relationship or instance viewer within
Schematic View to see light inclusions or parameter wirings within the scene.
You can control the display of instances or see a list of object occurrences.

Schematic View also allows for background image or grid, and automatic
arrangement of nodes based on physical scene placement. This makes arranging
nodes for character rigs easier.

Choose between a variety of arrangement selections so you can auto-arrange,
or work in a free mode. The layout of the nodes is saved with the named
Schematic View window. You can load a background image as a template for
laying out the nodes in the window.

Schematic View Features

Here are some of the notable features of Schematic View:

■ Layouts are saved with the named Schematic View file.
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■ Text remains readable during window navigation.

■ Schematic View includes tools for displaying and arranging nodes including
a free mode.

■ You can use a background image or grid in the Schematic View window.

■ You can see and edit wired parameters.

■ A modeless display floater lets you turn on and off node display by category.

■ The Relationship List Viewer enables quick navigation and selection of
nodes. Relationships displayed includes Lights inclusion/exclusion, all
parameter wires, constraints, controllers, and modifier relationships such
as path deform paths and morph targets

■ You can copy and instance controllers.

■ You can assign controller types.

■ Schematic View offers extensive MAXScript exposure.

■ Ability to drill down to more properties (such as static values and custom
attributes).

How the Components of Schematic View Behave

Everything displayed in the Schematic View window is shown as a box with
a name. There are various conventions to indicate different states regarding
these objects.
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 Solid End Signifies that the entity is arranged.

 Open end Signifies that the entity is free.

 Red Border Signifies that the entity is animated.

 End Arrow Signifies that the entity shares a relationship with
another entity.

 White Fill Signifies that the entity is selected in the Schematic
View window.

 White Border  Signifies that the entity is selected in the viewport.

 Up Arrow Collapses the entity it springs from and all child entities
thereof up into the parent entity

 Down Arrow Expands the next child entity down from the entity
that the arrow springs from.

 Overlap Schematic View will prevent newly visible nodes from
overlapping with existing nodes. This applies to free mode: make an object,
free it, make another object and it will fall on top but to the right of the
original object so both can be accessed and moved.

Instances Schematic View will bold the text of instanced entities, for nodes
this will show up on the base object entity. In the example illustrated, Box02
and Box03 are instances.
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See also:

■ New Schematic View on page 7433

■ Delete Schematic View on page 7434

■ Saved Schematic Views on page 7434

■ Schematic View Selection Right-Click Menu on page 7434

Procedures

See Using Schematic View on page 7411

Interface

See the following topics describing the Schematic View user interface.

Schematic View Menus on page 7415

Schematic View List Views on page 7419

Schematic View Preferences Dialog  on page 7421

Schematic View Toolbars on page 7427

Schematic View Display Floater on page 7431

Using Schematic View

This topic includes procedures for using functionality in the Schematic View
window on page 7407.

To create hierarchies with Schematic View:

1 Select the objects you want to work with in the viewport.

2 Use Zoom Extents Selected to display these objects in the Schematic View
window.
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3  On the Schematic View toolbar, click the Connect button.

4 In the Schematic View window, drag from the child object to the parent.
A dotted line follows your cursor. Click to set the linkage.

 If you are in Hierarchy mode, the children will arrange themselves
into an indented list under the parent as you create linkages.

To assign controllers with Schematic View:

1 On the Schematic View toolbar, click Display.

The Display floater appears. It lets you control what you see in the
Schematic View window.

2 On the Display floater, in the Relationships group, click Controllers. In
the Entities group, click Controllers as well.

The buttons indent to show they are active. The Transforms now appear
in the Schematic View window.

3 In the Schematic View window, select the transform of the object you
want to assign a controller to.

4 Right-click the transform, from on the Tools quad, choose Assign
Controller.

5 Choose the controller you want to apply from the list, then click OK.

To wire parameters with Schematic View:

1 Using the Display Floater, turn on Param Wires in the Relationships
group.

2 In the Schematic View window, select one of the objects you want to
wire.

3 Right-click the selected object and choose Wire Parameters.

4 In the pop up that appears select the component you want to wire, either
a Transform or an Object parameter, for instance.

5 Drag to the other object you want to wire to.

6 Again in the pop up that appears, select the component you need to wire
to.
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7 The Wire Parameters dialog appears. Make the necessary selections and
connect the wires.

8 Once the wiring is established you can edit the wiring by double-clicking
the wire in Schematic View.

To save a Schematic View layout:

1 When you have a layout you like, name the layout using the Schematic
View name field in the toolbar, just to the right of the Preferences button.

2 Close the Schematic View window.

3 To load the saved view, go to Graph Editors > Saved Schematic View and
choose the schematic view from the history list.

To add a background image:

1 On the Schematic View Options menu, choose Preferences.

2 In the Background Image group, click the File: button to launch the File
Browser.

3 In the Browse Images for Input dialog, find and highlight the bitmap you
want to use, then click Open.

4 On the Schematic View Preferences dialog, in the Background group,
turn on Show Image.

The Background bitmap show up in the Schematic View window.

TIP Turn on Lock Zoom Pan, if you want to zoom in or pan the background
image.

To navigate complex scenes:

Complex scenes can be navigated quickly by using the list viewer combined
with the pan or zoom to selected option. For example suppose you need to
locate all the bones within a certain character.

1 Open Schematic View

2 Press H on the keyboard and enter the name of the object you're looking
for in the Select Objects field. Press Enter to select the object by name.

3  In the window navigation tools group, click Zoom Selected.
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The Schematic View window now clearly shows the object node.

4 On the List Views menu, choose Show Occurrences.

The List viewer displays the Object Occurrences dialog.

This is a sortable list. You can click the header title to sort by it.

NOTE Object Occurrence is being used as an example here. You can use any
of the List View menu choices to display a list of objects based on a certain
relationship.

5  On the Options menu choose Pan to Selected. Now click through
the nodes in the list.

The Schematic View window updates to display each node as you click.

This method makes navigation of very complex scenes much more
convenient. Also when working with lists such as relationships or
instances you have the additional ability to detach the relationship or
make the instance unique.

To arrange the nodes in Schematic View to match the viewport:

It can be useful sometimes to arrange the nodes in the Schematic View the
same as in the viewport. There is a script that can do this for you. In this
example we'll use the bones of a character rig.

1 Using Windows Explorer, copy
\3dsmax\scripts\maxscripttools\macro_schematicviewtools.mcr into
\3dsmax\ui\macroscripts.

2 Restart 3ds Max.

3 On the Customize menu, choose Customize User Interface.

4 Click the Quads tab, then choose the Schematic View category from the
drop-down list on the right

5 Drag the action named Project into Schematic View in the Schematic
View quad menu (any quad you like).

6 Drag the Spacing Tool item into Schematic View’s quad menu.

7 On the Graph Editors menu, choose New Schematic View.

8 In any viewport (other than Perspective or User), select the bones of the
rig that you want to arrange.
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9 In the Schematic View window, right-click and choose Project Into
Schematic View from the quad menu.

A new Schematic View named Projection shows the selected bones
arranged as in the viewport.

TIP If the components appear on top of one another, right-click again and
choose Spacing Tool from the quad menu. Drag the spacing slider to the
right to add space between the objects. If necessary manually reposition
components as needed.

Schematic View Menus

Menu bar > Graph Editors > New Schematic View > Menu bar

Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic
view. > Menu bar

Main toolbar > Schematic View button > Menu bar

Edit menu

Connect Activates the connect tool. The connect tool in Schematic View can
be used to create any relationship or constraint, are can be used to assign
modifiers.

Unlink Selected Disconnects the selected entities.

Delete Removes entities from Schematic View and from the scene. Disconnects
selected relationships.

Assign Controller Lets you assign controllers to transform nodes. Only
available when controller entities are selected. Opens the standard assign
controller dialog.

Wire Parameters Lets you wire parameters using Schematic View. This is
active only when entities are selected. This launches the standard Wire
Parameters dialog.

Object Properties Displays the Object Properties dialog on page 305 for the
selected nodes. Has no effect when no node is selected.
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Select menu

Select Tool Activates the Select tool when in Always Arrange mode and Select
and Move tool when not.

Select All Selects all entities in the current Schematic View.

Select None Deselects all entities in the current Schematic View.

Select Invert Deselects selected entities and selects unselected entities in the
current Schematic View.

Select Children Selects all children of currently selected entities.

Deselect Children Deselects children of all selected entities. Parent and child
must be selected for child to become unselected.

Select to Scene Selects in viewport all nodes that are selected in Schematic
View.

Select from Scene Selects in Schematic View all nodes that are selected in
viewport.

Sync Selection When on, selecting objects in Schematic View also selects
them in the viewport, and vice-versa.

List Views menu

See Schematic View List Views on page 7419.

Layout menu

Align Lets you define the following alignment options for selected entities in
the Schematic View window:

■ Left Aligns selected entities to the left edge of the selection, leaving
vertical positioning intact.

■ Right Aligns selected entities to the right edge of the selection, leaving
vertical positioning intact.

■ Top Aligns selected entities to the top edge of the selection, leaving
horizontal positioning intact.

■ Bottom Aligns selected entities to the bottom edge of the selection,
leaving horizontal positioning intact.

■ Center Horizontal Aligns selected entities to the horizontal center of the
selection, leaving vertical positioning intact.
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■ Center Vertical Aligns selected entities to the vertical center of the
selection, leaving horizontal positioning intact.

Arrange Children Arranges the display of children based on set arrangement
rules (align options) below the selected parent.

Arrange Selected Arranges the display of children based on set arrangement
rules (align options) below the selected parent.

Free Selected Frees all selected entities from arrangement rules, tags them
with a hole icon on their left end and leaves them in place. Use this to freely
arrange selected objects.

Free All Frees all entities from arrangement rules, tags them with a hole icon
on their left end and leaves them in place. Use this to freely arrange all objects.

Shrink Selected Hides all selected entities’ boxes, keeping arrangement and
relationships visible.

UnShrink Selected Makes all selected shrunk entities visible.

UnShrink All Makes all shrunk entities visible.

Toggle Shrink When on, shrinking entities works normally. When off, shrunk
entities are fully visible, but not unshrunk. Default=on.

Options Menu

Always Arrange Causes Schematic View always to arrange all entities based
on the chosen arrangement preference. Displays a pop-up warning before
doing so. Choosing this activates the toolbar button.

Hierarchy Mode Sets Schematic View to display entities as a hierarchy instead
of reference graph. Children appear indented below the parent. Switching
between Hierarchy and Reference mode is nondestructive.
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Reference Mode Sets Schematic View to display entities as a reference graph
instead of hierarchy. Switching between Hierarchy and Reference mode is
nondestructive.

Move Children Sets Schematic View to move all children of parent being
moved. When this mode is on, the toolbar button is activated.

Preferences Opens the Schematic View Preferences Dialog  on page 7421, which
lets you control what displays in the window by filtering for categories and
setting display options.

Display menu

Display Floater Displays or hides the Display Floater which controls what is
displayed in the Schematic View window.

Hide Selected Performs the action of hiding whatever is selected in the
Schematic View window.

Unhide All Reveals any hidden items.

Expand Selected Displays all child entities of selected entity.

Collapse Selected Hides all children of selected entity, leaving the selected
entity visible.

View Menu

Pan Activates the Pan tool, which lets you move horizontally and vertically
in the window by dragging the mouse.

Pan to Selected Centers selected entities in the window. If no entity is selected,
centers all entities in the window.

Zoom Activates the zoom tool. Lets you move closer to or further from the
Schematic display by dragging the mouse.
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Zoom Region Lets you zoom to a specific area by dragging a rectangle in the
window.

Zoom Extents Zooms the window so all the nodes in the Schematic View are
visible.

Zoom Extents Selected Zooms the window so that all selected nodes are
visible in the display.

Show Grid Displays a grid in the background of the Schematic View window.
Default=on.

Show Background Displays an image in the background of the Schematic
View window. Set the image via Preferences on page 7421.

Refresh View Redraws the contents of the Schematic View window with all
changes made to it or with changes made in the scene.

Schematic View List Views

Menu bar > Graph Editors > New Schematic View > Menu bar

Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic
view. > Menu bar

Main toolbar > Schematic View button > Menu bar

Schematic View supports several list views that display objects and their
relationships in a list. These include list views for instances, object occurrences,
and relationships. Use these lists to quickly edit your parameter wiring, detach
relationships, or make instances unique. Use the List options to synchronize
the list with the viewport or the node display in the Schematic View window.
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Interface

List view displaying relationships

All Relationships Opens or redraws List View with all relationships of currently
displayed Schematic View entities.

Selected Relationships Opens or redraws List View with all relationships of
currently selected Schematic View entities.

All Instances Opens or redraws List View with all instances of currently
displayed Schematic View entities.

Selected Instances Opens or redraws List View with all instances of currently
selected Schematic View entities.

Show Occurrences  Opens or redraws List View with all entities that share a
property or relationship type with currently selected entities

All Animated Controllers Opens or redraws List View with all entities that
have or share animated controllers.

Make Unique In the All Instances and Selected Instances views, this makes
the selected entity a copy and takes it out of the list.

Detach In the All Relationships and Selected Relationships views, eliminates
the selected relationship and takes it out of the list.

Options Menu in the List View Dialogs

Options for list view let you synchronize the list selection with the viewport
and the Schematic View window.

Sync selection When this is turned on, Schematic View selection corresponds
to selections made in the list.
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Pan to Selected When this is turned on, Schematic View pans to put the
entity selected in the list into the center of the Schematic View within the
existing zoom factor. For Instances and Occurrences this will be single entities,
for Relationships it will be two entities.

Zoom to Selected When this is turned on, Schematic View zooms extents
around the entity selected in the list. For Instances and Occurrences this will
be single entities, for Relationships it will be two entities

Respect display When this is turned on, the List View will only show entities
turned on for display by the Display Floater.

Schematic View Preferences Dialog 

Schematic View on page 7407 > toolbar > Preferences button

Schematic View on page 7407 > Options menu > Preferences

The Schematic View Preferences dialog controls what is shown and what is
hidden based on categories. You can filter the objects appearing in the
Schematic View window, so you see only what you need to.

You can add a grid or background image into your Schematic View window.
Here you can also choose the arrangement method and determine the
synchronization between viewport selection and Schematic view window
selection. You can also set the style for the node connections. By selecting the
appropriate filters in this dialog you can make working with Schematic View
more controllable.
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Interface

Include in Calculation group

Schematic View can traverse the entire scene, including materials, maps,
controllers, and so on. The Include In Calculation settings control which scene
components Schematic View will know about. The Display Floater then
controls what is displayed. So, if you don’t Include Materials, you can’t display
materials. If you don’t include controllers, you can't display controllers,
constraints, or parameter-wiring relationships.

If you have a huge scene and are interested only in using Schematic View for
selection, you can turn everything off except Base Objects. If you are interested
only in materials, you can turn off controllers, modifiers, and so on.

7422 | Chapter 23   Managing Scenes and Projects



Base Objects Turns on and off the display of the base objects. Use this to
remove clutter in the Schematic View window.

Modifier Stack Turns on and off the display of modifier nodes.

Materials/Maps Turns on and off the display of material nodes in the
Schematic View window. Hide the materials when you are animating and
don’t need to see them, display them when you want to select materials or
make changes to the material of various objects.

NOTE Schematic View does not support the ability to manipulate maps. You can
not paste a map from one material to another.

Controllers When this is turned on, controller data is included in the display.
When this is turned off Controllers, Constraints and Param Wires relationship
and entity buttons are unavailable in the Display floater. When this is on,
you can assign controllers or wire parameters using the tools quad of the
Schematic View right-click menu.

Static Values When this is turned on, unanimated scene parameters are
included in the Schematic View display. Turn this off to prevent the window
from filling up with everything seen in Track View.

Master Point Controller  When this is on, sub-object animation controllers
are included in the Schematic View display. This button prevents the window
from filling up with too many controllers in cases in which sub–object
animation is present.

Skin Details When this is turned on four controllers for each bone in the Skin
modifier are included in the Schematic View display (when Modifiers and
Controllers are also included). This button prevents the window from
stretching out around too many Skin controllers with normal use of the Skin
modifier.

Include Only group

Selected Objects Filters the display of selected objects. Check this box if you
have a lot of objects and only want Schematic View to display the viewport
selection.

Visible Objects Limits the display in Schematic View to the visible objects.
Hide objects you don’t need to display, then check this box to contain clutter
in Schematic View.

Animated Objects  When this is turned on, then only objects that have keys
and their parents will be included in the Schematic View display.
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Hide By Category group

These toggles control the display of objects and their children, by category.
The categories are:

■ Geometry Hides or displays geometric objects and their children.

■ Shapes Hides or displays shape objects and their children.

■ Lights Hides or displays lights and their children.

■ Cameras Hides or displays cameras and their children.

■ Helpers Hides or displays helper objects and their children.

■ Space Warps Hides or displays space warp objects and their children.

■ Bone Objects Hides or displays bone objects and their children.

Be aware that if you have a hierarchy linked to a helper such as a dummy,
and you hide the dummy, you’ll also hide the children.

Link Style group

Bezier Lines Displays the reference lines with arrowheads as Bezier curves.

Straight Lines  Displays the reference lines as straight lines instead of Bezier
curves.

Circuit Lines Displays the reference lines as orthogonal lines instead of curves.
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None  When this is chosen, link relationships will not appear in the Schematic
View display.

Grid group

This group controls the display and use of a grid in the Schematic View.

Show Grid Displays a grid in the background of the Schematic View window.

Snap to Grid When this is on, all moved entities and children of those entities
will snap their upper left corners to the nearest grid point. Entities not snapped
to a grid point when snap is enabled will not snap until they are subsequently
moved.

Grid Spacing: Sets the spacing units of the Schematic View grid. This uses
the standard that entities are 20 grid units high and 100 grid units long.

Arrange Method group

Arranging always takes place within the confines of the positive X and negative
Y space which is delineated by the darker grid lines.

Stacked When this is turned on, arranging via Always Arrange, Arrange
Children or Arrange Selected will result in the hierarchies being stacked below
a width that is determined by the extents of the highest entities in the view.

Horizontal When this is turned on arranging using Always Arrange, Arrange
Children or Arrange Selected will result in the hierarchies being distributed
along and below the y=0 line. Arranging always takes place within the confines
of the positive X and negative Y space.

Vertical When this is turned on arranging using Always Arrange, Arrange
Children or Arrange Selected will result in the hierarchies being distributed
along and to the right of the x=0 line. Arranging always takes place within
the confines of the positive X and negative Y space.
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Sync Selection group

Viewports When this is chosen, node entities selected in Schematic View will
have their corresponding nodes selected in the viewports. Likewise, nodes
selected in the viewports will have their corresponding entities selected in
Schematic View.

Everything When this is chosen, all entities selected in Schematic View will
have their corresponding entities selected in the appropriate places in the
interface, given that those places are open. For instance, selecting a material
in Schematic View will select it in the material editor if it is open and the
material is present, selecting a modifier in Schematic View will select it in the
stack is the Modify panel is open. Likewise, entities selected in the scene will
have their corresponding entities selected in Schematic View.

None When this is chosen, changes in the viewport selection do not affect
the Schematic View display, and selection changes in the Schematic View
display do not affect the viewport selection.

Background Image group

Show Image When on, the background bitmap (if one is chosen) is displayed.
When off, it is not displayed.

By default, the background image displays at screen resolution at the current
zoom factor of Schematic View.

Lock Zoom/Pan When this is turned on, zooming and panning resizes the
background image accordingly. When turned off, the bitmap will remain or
revert to actual pixels at screen resolution.

File button Click to choose an image file for the background of Schematic
View.

When no background image has been chosen, this button displays “None.”
If an image has been chosen, it shows the name of the bitmap file.

Preferences group

Double Buffer Allows for double buffer display to control viewport
performance.

Zoom About Mouse Pointer When this is turned on you can zoom into
wherever you place your cursor. You can also zoom with the zoom wheel, or
hold Ctrl and press the middle mouse button.
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Pan to Added Nodes When this is turned on the Schematic View window
will alter itself to accommodate new objects or nodes as they are added to the
scene. When this is turned off the view is unchanged. Leave this off and turn
off Auto arrange, and Schematic view will not disturb the layout of the nodes.

Use Wireframe Color Uses the wireframe color to shade the node in the
Schematic View window.

Display Layout Warning When this is on, Schematic View will show a layout
warning when Always Arrange is first turned on.

Only Update On Focus When this is turned on, Schematic View only updates
with additions or changes to the scene when it is given focus. This lets you
avoid constant redraws when making changes in the viewport to the scene
objects.

Move Children When this is turned off you can move the parent without
affecting the children. When this is turned on, moving a parent also moves
the children.

Show Tooltips Toggles the display of tooltips when the cursor is over the
node in the Schematic View window.

Snap Floaters Enables floating dialogs (Display and List) to snap to the edges
of the Schematic View window.

Relative Floaters Enables floating dialogs to move and resize as the Schematic
View window is moved and resized.

Schematic View Toolbars

Menu bar > Graph Editors > New Schematic View > Top and bottom toolbars

Menu bar > Graph Editors > Saved Schematic Views > Choose a saved schematic
view. > Top and bottom toolbars

Main toolbar > Schematic View button > Top and bottom toolbars

The Schematic View toolbar at the top of the window contains the following
buttons:

 Display Floater Displays or hides the Display Floater. Active button
means floater is open, inactive button means it’s hidden.
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 Select Lets you select objects in the Schematic View window and in the
viewport. Selecting objects in the Schematic View window turns the node
yellow. Selecting the objects in the viewport, outlines their Schematic View
representation box in white, but doesn’t select it in the Schematic view
window. If you want to the selection in Schematic view passed into the
viewport use the Sync Selection button. Whatever is selected in Schematic
view will become selected in the viewport as well.

 Connect Lets you create hierarchies. Just as you link objects in the
viewports, you can create linkages in Schematic View. Click the child and
connect to the parent. You also use this to add modifiers to objects, and to
wire parameters.

 Unlink Selected Unlinks whatever is selected in the Schematic View
window.

 Delete Objects Deletes whatever is selected in Schematic View. The
deleted selection disappears in the viewport and the Schematic View window.

 Hierarchy Mode Shows the parent/child relationships in a cascading
display. The parents are to the left and up, the children are indented toward
the right and down.

 References Mode Shows relationships based on instances and references
rather than hierarchy. Use this to view materials and modifiers.

 Always Arrange Sets Schematic View to always arrange all entities based
on arrangement preference (alignment options). Displays a pop-up warning
before doing so. When this mode is on it activates the toolbar button.

 Arrange Children Arranges the display of children based on set
arrangement rules (align options) below the selected parent.
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 Arrange Selected Arranges the display of children based on set
arrangement rules (align options) below the selected parent.

 Free All Frees all entities from arrangement rules, tags them with a
hole icon on their left end and leaves them in place. Use this to freely arrange
all objects.

 Free Selected Frees all selected entities from arrangement rules, tags
them with a hole icon on their left end and leaves them in place. Use this to
freely arrange selected objects.

 Move Children Sets Schematic View to move all children of parent
being moved. When this mode is on, the toolbar button is activated.

 Expand Selected Reveals the display of all child entities of selected
entity.

 Collapse Selected Hides the display of all children of selected entity,
leaving the selected entity visible.

 Preferences Displays the Schematic View Preferences dialog. This lets
you control what is displayed and hidden in the Schematic View window by
category. Various options are here to filter and control the display within the
Schematic View window. See Schematic View Preferences Dialog  on page 7421.

Schematic View Name field Use this field to give the particular configuration
of Schematic View a name. Simply typing the name and hitting enter will add
the named view to the list of Saved Schematic View windows available from
the Graph Editors menu.

Bookmark Name field Let's you define a selection of entities in the Schematic
View window as a bookmark, so you can easier return to them in a complex
scene with many objects.
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 Go to Bookmark Zooms and pans the Schematic View window so the
bookmarked selection is displayed.

 Delete Bookmark Removes the bookmark name that is displayed in
the Bookmark name field.

Buttons on the Lower Toolbar

 Zoom Selected Viewport Object Zooms in on whatever is selected in
the viewport. You can also type in the name in the text field next to this
button.

Selected Object text entry window Lets you type in the name of the object
you are looking for. Then click the Zoom Selected Viewport Objects button
and that object will appear in the Schematic View window selected.

Prompt Area Provides a one-line instruction to tell you how to use the
highlighted tool or button or provides you with details such as how many
objects are currently selected.

 Pan Lets you move horizontally or vertically in the window. You can
also achieve the same effect by using the scroll bars at the right and bottom
of the Schematic View window, or by using the middle mouse button.

 Zoom Lets you move closer to or further from the Schematic display.
When you first open your Schematic View window you will spend a moment
zooming and panning to gain the appropriate view of the objects in the display.
The display of the nodes changes as you move in or out.

You can also zoom by holding Ctrl and pressing the middle mouse button. To
zoom at the cursor, turn on Zoom About Mouse Point in the Schematic View
Settings dialog, accessed by click the Preferences button.

 Zoom Region Lets you draw a zoom window on the area of the
Schematic view you want to see up close.
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 Zoom Extents Zooms the window back so all the nodes in the Schematic
View are visible.

 Zoom Extents Selected Zooms the window back so that all the selected
nodes are visible in the display.

 Pan to Selected Pans the window to include the selected objects, within
the same zoom factor, so that all selected entities are visible within current
extents of the window.

Schematic View Display Floater

The Display Floater controls by category what is displayed in the Schematic
View window. The Schematic View Preferences dialog also filters that display
of the window. Use these to manage the clutter of the window, and the
performance speed. Note that unless you display the correct entity and
relationship, you will not be able to perform certain operations. If you want
to wire parameters, for instance, you must have Param Wires turned on. If
you want to wire the parameters of a material, you must also have Materials
chosen.
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Interface

Relationships group

Lets you choose which of the following relationships you want to display or
create: Constraints, Controllers, Parameter wiring, Light inclusion and
Modifiers.

Entities group

Selects which types of entities are displayed or edited:

Base Objects When active, all base object entities will display as children of
the node entities. When Sync Selection is on and the Modifier stack is open,
clicking on a base object will activate that level of the object’s stack.
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Modifier Stack When active, all modifiers in the object’s stack will display
as children, beginning with the Modified Object base entity. Modifiers can
be copied, instanced or moved between objects by using the Connect tool.
For example, connecting XForm to Box01, will display the Attach Modifier
dialog where you can choose between Copy, Move or Instance. Deleting the
modifier from the Schematic View will also remove it from the object’s stack
in the Modify panel.

Materials When active, all materials and maps assigned to the objects will
display as children of the objects. Materials can be instanced between objects
by using the Connect tool on the Schematic View toolbar. For example, drag
material Default1 to Box01 . Double clicking on a material will bring up the
Material editor if the Material is already in an sample material slot.

Controllers When this is active, all controllers other than position, rotation
and scale will display as children of the objects’ transform controller, which
also displays. Controllers can be added to objects only when this is active.
Controllers can be copied or instanced between objects by using the Connect
tool. For example dragging PositionXYZ from Box01 to Position List for Box02, for
instance, will open the Attach Controller dialog, where you can choose to
Copy, Move or Instance this controller.

PRS Lets you choose to display any combination of the three transform types
(position, rotation or scale).

Expand When turned on, entities that are activated will be displayed in
Schematic View. When turned off, only the triangle child indicator on the
bottom of the nodes will display. This toggle only applies at activation time,
it will not expand or contract entities that are already displayed.

Focus When this is turned on, only those entities that are related to others
and have their relationships displayed will be filled with their color, all others
will be displayed unshaded.

Schematic View Commands

New Schematic View

Menu bar > Graph Editors > New Schematic View

New Schematic View creates a new Schematic View window on page 7407. You
might want to create multiple Schematic view windows filtered in different
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ways that you recall for quick access to multiple objects. Name the new
schematic view using the Schematic View name field.

Delete Schematic View

Select a schematic view. > Menu bar > Graph Editors > Schematic View > Delete
Schematic View

Delete Schematic View opens the Delete Schematic View dialog. This dialog
displays all saved schematic views. Choose the view to be deleted from the
list, and then click the OK button.

For information on the Schematic View buttons and controls, see Schematic
View on page 7407.

Saved Schematic Views

Graph Editors menu > Saved Schematic Views > Schematic views by name

Saved Schematic Views displays a list of schematic views by name that were
previously created by New Schematic View on page 7433.

Schematic View Selection Right-Click Menu

Schematic View on page 7407 > Select any node. > Right-click.

The Schematic View right-click menu contains controls for selecting,
displaying, and manipulating selections of nodes. It gives you quick access to
List Views, Display Floater and lets you switch between Reference and Hierarchy
Mode quickly.
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Interface

Select quadrant

Select Tool  Activates the Select tool when Always Arrange is turned on.
Activates the Select and Move tool when Always Arrange is off.

Select All Choose Select All to select everything in the window.

TIP Hold down the Ctrl key to add to selections, and the Alt key to subtract from
them.

Select None  Choose Select None to deselect everything.

Select Invert Deselects selected entities and selects all other entities in the
current Schematic View.

Select Children Selects all children of the current selection.
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Deselect Children Deselects children of all selected entities. Parent and child
must be selected for child to become unselected.

Sync Selection Synchronizes the selection in the Schematic View window
with the viewport. Whatever you have selected in the Schematic View window
becomes selected in the viewport. Whatever you select in the viewport becomes
selected in Schematic View. It’s a two-way street.

Layout quadrant

Free All Frees all entities from arrangement rules, tags them with a hole icon
on their left end and leaves them in place. Use this to freely arrange all objects.

Free Selected Frees all selected entities from arrangement rules, tags them
with a hole icon on their left end and leaves them in place. Use this to freely
arrange selected objects.

Arrange Selected  Arranges the display of the selection based on the
arrangement preferences.

Arrange Children Arranges the display of children based on set arrangement
rules (align options) below the selected parent.

Unhide All Displays all the nodes in the scene. If the resulting Schematic
View is too cluttered to work with, try using Preferences to remove what you
don’t need to see. Or make individual selections and hide upstream or
downstream to unclutter the display.

Hide Selected Hides the selection in the Schematic View window.

Expand Selected Reveals the display of all child entities of selected entity.

Contract Selected Hides the display of all children of selected entity, leaving
the selected entity visible.

Edit quadrant

Connect Tool Activates the connect tool. This tool in Schematic View can be
used to create many Schematic View relationships such as parent, constraint,
copy modifier, copy controller, or copy material.

Unlink Selected  Disconnects the selected entities

Delete Selected Deletes entities from Schematic View and from the scene.
This also can be used to disconnect selected relationships.

Assign Controller Displays the Assign controller dialog. This is available only
when controller entities are selected.
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Wire Parameters Let's you wire parameters using Schematic View. This is
active only when entities are selected. This launches the standard Wire
Parameters dialog.

Edit Properties Displays the Object Properties dialog for the selected objects.

Options quadrant

Shrink Hides all selected entities’ boxes, keeps arrangement and relationships
visible.

Toggle Shrink Changes the state of entity shrinkage. Shrunken entities become
unshrunken, and the other way around.

Unshrink All Makes all shrunken entities visible.

Unshrink Selected Makes all selected shrunken entities visible.

Shrink Selected  Hides all selected entities’ boxes, keeps arrangement and
relationships visible.

List Views

Selected Occurrences  Opens or redraws List View with all entities that share
a property or relationship type with currently selected entities

Selected Instances Opens or redraws List View with all instances of currently
selected Schematic View entities.

All Instances Opens or redraws List View with all instances of currently
displayed Schematic View entities.

Selected Relationships Opens or redraws List View with all relationships of
currently selected Schematic Vie entities.

All Relationships Opens or redraws List View with all relationships of currently
displayed Schematic View entities.

Display Floater Opens the Display floater and activates the corresponding
toolbar button.

Move Children  Sets Schematic View to move all children of parent being
moved. When this mode is on, the toolbar button is activated.

Reference Mode  Sets Schematic View to display entities as a reference graph
instead of hierarchy. Switching between Hierarchy and Reference mode is
nondestructive.
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Hierarchy Mode  Sets Schematic View to display entities as a hierarchy instead
of reference graph. Children appear indented below the parent. Switching
between Hierarchy and Reference mode is nondestructive.

Always Arrange  Sets Schematic View to always arrange all entities based on
the chosen arrangement preference. Displays a pop-up warning before doing
so. Choosing this activates the toolbar button.

Using Layers to Organize a Scene
Layers are like transparent overlays on which you organize and group different
kinds of scene information. The objects you create have common properties
including color, renderability, and display. An object can assume these
properties from the layer on which you create it. Using layers makes it easier
to manage the information in your scenes. Layers are used primarily to control
the visibility of objects in your scene, however they also controls the color of
objects' wireframe and the frozen  on page 212 and hidden state of objects, as
well as their radiosity properties.

For example, you might want to set up a layer that will contain detailed,
custom furniture. To do this, you create a layer and set Viewport Display to
Bounding Box. Then you set the object's display properties to ByLayer (in the
Object Properties dialog on page 305). This will keep the viewport display quick.
Then, whenever you want to import new furniture, switch to this layer. You
don't need to set up your viewport display every time you import new
furniture. Also, if you don't want to render the furniture, you can turn off that
layer's Renderable property.

NOTE When you link an AutoCAD file into 3ds Max, any layers that are frozen
(and all objects that reside on these layers) are not imported.

NOTE Objects can be hidden and frozen on a per-object basis; however, an object
residing on a hidden or frozen layer will always adopt the hide/freeze state of its
layer.

TIP If you set lights' render control to ByLayer (in the General panel of the
Preferences dialog), you can use the Render column in the Layer Manager to
quickly turn lights on or off in your scene.
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Layers can help organize the contents of a scene.

Layer-Object Relationships

The Layer Manager on page 7441 displays layers, as well as their associated
objects. This makes it very easy to organize, and make changes to objects in
a scene. With the Layer Manager, you can adjust property settings at either
the layer level, or individually for each object. Each property can be toggled
between various states, including the ByLayer state on page 7933. When an
object’s property is set to ByLayer, the object inherits that setting from the
layer it is associated with.

NOTE The Hide and Freeze states of an object cannot be set to ByObject. Objects
can be hidden or frozen on a per-object basis; however, they will always follow
the behavior of their layer when it is hidden or frozen.

Special Layer 0

When you begin a new scene, 3ds Max creates a special layer named 0 (default).
By default, objects on layer 0 have their visibility settings on, renderability is
on, and viewport display is set. You can’t delete or rename layer 0.

If you haven’t created any layers, 3ds Max places objects you create on layer
0 by default. After you create objects, you can reassign them to different layers,
including those residing on layer 0.

Using Layers to Organize a Scene | 7439



Display Properties

In the Layer Properties dialog on page 7451, you can specify layer visibility
individually for each viewport. If you don’t want to display a certain layer,
you can hide that layer. 3ds Max hides the layer in the viewport, but not in
any output rendered image of the scene.

NOTE For hidden geometry to render, Render Hidden Geometry must be on on
the Render Setup dialog > Common Parameters rollout on page 6121.

You can specify layers to display objects shaded on page 7576, in wireframe
mode on page 8172, as a bounding box on page 7932, or as whatever is set on the
Viewport Properties menu on page 7576. Using this method, you can have
different objects displayed differently in the same scene.

You can display layers in See-Through mode on page 7454. See-Through mode
temporarily displays selected objects in translucent form so you can see through
them without applying special materials. You can toggle See-Through mode
for all objects per layer.

NOTE You can control whether newly created objects adopt the default layer
settings on a per-object basis by using Default To By Layer For New Nodes in the
General Preferences panel on page 7743.

You can also Freeze, Hide, or Isolate the layer of a selected object using the
corresponding command in the display quadrant of the quad menu.

Layer Names

You can create and name a layer for each conceptual grouping (such as walls
or terrain) and assign common properties to those layers. By grouping objects
into layers, you can control their display and make changes quickly and
efficiently. When you name layers, you can use names of variable length up
to 255 characters. These names can contain letters, digits, blank spaces, and
the special characters dollar sign ($), hyphen (-), and underscore (_).

NOTE Any layers from a linked AutoCAD file are automatically imported to 3ds
Max. 3ds Max names the converted layers based on the layer names from the
AutoCAD drawing.

See also:

■ Layer List  on page 7459

■ Layer Manager  on page 7441
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■ Layer Properties Dialog on page 7451

Layer Manager 

Main toolbar > Layer Manager

Layers toolbar > Layer Manager

Tools menu > Layer Manager

The Layer Manager, available from the main toolbar, is a modeless dialog
where you can create and delete layers. You can also view and edit the settings
for all of the layers in your scene, as well as the objects associated with them.
You can specify the name, visibility, renderability, color, and objects' and
layers' inclusion in the radiosity solution from this dialog.

Objects are organized by layer in the dialog, in an expandable list. By clicking
‘+’ or ‘-‘, you can expand or collapse (respectively) the object list for each layer.
You can also sort the layers by clicking any of the column heads.

 Another useful tool is the ability to open the Object Properties dialog on
page 305 and Layer Properties dialog on page 7451 for one or more highlighted
objects or layers directly from the Layer Manager by clicking the corresponding
icon.

NOTE You can change the property settings for each layer or object by clicking
the corresponding icon in the dialog. With each click, the icons cycle through the
various states of the property, including Off (  ) and By Layer on page 7933 (

 ), and, in the Render, Color, and Radiosity columns, By Object. When a
property is set to By Layer, the object inherits the property setting from its
associated layer.

Procedures

To create a new layer:

When you create new layers, 3ds Max names them sequentially by default:
Layer01, Layer02, and so on. After creating a layer, you can rename it. 3ds
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Max assigns a random color to all new layers. You can accept the default
settings or specify other colors.

1  On the main toolbar, click Layer Manager.

2  In the Layer Manager, click Create New Layer.

3ds Max displays a new layer in the list with the temporary name Layer01.

3 Click the Layer to enter a new name.

4 To create more than one layer, click New again and enter the new layer
name.

TIP If an existing layer is highlighted when you create a new layer, the new
layer inherits the properties of the highlighted layer. You can modify the
properties of the new layer, if necessary, as illustrated in the following
procedures.

To make a layer current:

1  On the main toolbar, click Layer Manager.

2  In the Layer Manager dialog, click the second column next to the layer
name.

 A check box appears indicating that the layer is current.

NOTE The current layer is also displayed in the title bar of the Layer Manager.

To make a layer current (alternate method):

■ On the Layers toolbar > Layer List, select a layer.
The highlighted layer becomes the current layer.

To hide a layer:

1  On the Layers toolbar, click Layer Manager.

2 In the Layer Manager, select the layers you want to hide.
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3  In the Hide column, click Off to turn Hide on for the highlighted
layer(s).

 The hide icon displays.

TIP  You can hide all layers by clicking Hide/Unhide All Layers on the
Layer Manager toolbar.

To freeze a layer:

Freezing layers is useful when you want to edit objects associated with
particular layers but also want to view, without editing, objects on other layers.
You can't edit or select objects on a frozen layer; however, the objects are still
visible if the layer is on. You can make a frozen layer current, and you can
add new objects to the frozen layer.

1  On the main toolbar, click Layer Manager.

2 In the Layer Manager, highlight the layers you want to freeze.

3  In the Freeze column, click Off to turn Freeze on for the highlighted
layer(s).

 The Freeze icon displays.

TIP  You can freeze all layers by clicking Freeze/Unfreeze All Layers on
the Layer Manager toolbar.

To assign a color to a layer:

You can assign a color to a layer using the Layer Manager dialog. For example,
you can assign the color red to a layer named HVAC to help you identify the
mechanical equipment in your scene.

1  On the main toolbar, click Layer Manager.

2 In the Layer Manager, select a layer and click the Color icon.

3 In the Layer Color dialog, select a color, and then click OK.
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To rename a layer:

You might want to rename a layer to better define how it's used in your scene.
You can rename a layer at any time during a 3ds Max session. However, you
can't rename Layer 0.

1  On the main toolbar, click Layer Manager.

2 In the Layer Manager, select a layer to rename.

3 Click the layer’s name again and enter a new name.

To delete a layer:

You can delete an empty layer at any time during a 3ds Max session. However,
you can't delete the current layer, Layer 0, or a layer that contains objects.

1  On the main toolbar, click Layer Manager.

2  In the Layer Manager, select one or more layers, and then click Delete
Empty Layer.

To open the Object Properties dialog for an object selection:

1  On the main toolbar, click Layer Manager.

2 Highlight one or more objects in the Layer Manager.

3  Click the Object Properties icon to open the Object Properties dialog
on page 305 for the highlighted objects.

To open the Layer Properties dialog for a layer selection:

1  On the main toolbar, click Layer Manager.

2 Highlight one or more layers in the Layer Manager.

3  Click the Layer Properties icon to open the Layer Properties dialog on
page 7451 for the highlighted layers.
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Interface

Title Bar

The title bar displays the word “Layer” followed by the name of the active
Layer. For example, if Layer02 is the active layer, the title bar will read Layer:
Layer02.

Layer Manager toolbar

 Create New Layer Creates a new layer containing any selected objects.

The new layer's name is generated automatically ("Layer01", "Layer02", etc.)
but you can change it by clicking the label.

NOTE The new layer becomes the current layer.
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 Delete Highlighted Empty Layers Deletes highlighted layers if they are
empty.

NOTE This button is not available if any of the following items are in your selection
set: nothing, the current layer, objects, Layer 0, or non-empty layers.

 Add Selected Objects to Highlighted Layer Moves currently selected
objects into the highlighted layer.

NOTE This button is not available if nothing is selected or if more than one layer
is highlighted.

 Select Highlighted Objects and Layers Selects all of highlighted objects,
as well as all objects contained in any highlighted layers.

NOTE This button is not available if nothing is highlighted.

 Highlight Selected Objects' Layers Highlights layers containing the
currently selected objects and automatically scrolls so that highlighted layers
are visible in the layer manager.

NOTE This button is not available if nothing is highlighted.

 Hide/Unhide All Layers Toggles the display of all layers.

TIP This is most useful if you hide all layers and then display only the layers you
want to work on.

 Freeze/Unfreeze All Layers Toggles the frozen state of all layers.

TIP This is most useful if you freeze all layers and then unfreeze only the layers
you want to work on.

List of layers

Displays layers, their associated objects, and their properties. To expand or
collapse the object list for each layer, click ‘+’ or ‘-’, respectively. To modify a
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property, click its icon. To select all layers quickly, right-click and choose
Highlight All. To open the Object/Layer Properties dialog, click on the icon
next to the layer or object.

Each property has a unique icon to indicate that it is turned on, while all

properties share the same icon for the off (  ) and By Layer (  ) states.

NOTE By Layer is available only at the object level, in the Render, Color, and
Radiosity columns.

TIP You can sort the layers by any of their properties by clicking the column name.

Layers Displays the names of the layers/objects. Click a name to select the
layer, or to rename the layer.

NOTE  Clicking the layer icon opens the Layer Properties dialog on page 7451
for all highlighted layers.

 Clicking the object icon opens the Object Properties dialog on page 305 for
all highlighted objects.

 Current Layer Toggle The unlabeled column to the right of the layer name
indicates the current layer and lets you make a different layer current.

 A check mark appears next to the current layer. Click the check box next
to another layer name to make it current.

 Hide Hides and unhides layers. When a layer is hidden, it's invisible. You
might want to hide layers that contain construction or reference information.

 Freeze Freezes layers. You can't select or edit objects on a frozen layer.
Freezing a layer is useful if you want to view information on a layer for
reference but don't want to edit objects on that layer.

 Render When on, objects appear in the rendered scene. Non-rendering
objects don't cast shadows or affect the visual component of the rendered
scene. Like dummy objects, non-rendering objects can manipulate other
objects in the scene.

Shape objects on page 606 have the Render option turned on by default. In
addition, they have a Renderable check box in their creation parameters.
When both check boxes are on, the shape is renderable. If either check boxes
are off, the shape isn’t renderable. If you apply a modifier that converts the
shape into a mesh object, such as a Lathe on page 1501 or Extrude on page 1448
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modifier, the shape automatically becomes renderable regardless of the state
of its local Renderable check box.

For shapes, the Renderable toggle in the Object Properties dialog on page 305
affects the main object, so it also affects all instances of and references to the
shape.

Color Changes the color associated with the highlighted layers. You can select
another color by clicking the color swatch to display either the Object Color
dialog on page 387 (for objects), or the Layer Color dialog (for layers).

You can set an object’s color independently, or turn on ByLayer in the Object
Color dialog to use the associated layer’s color.

 Radiosity When on, objects are included in the radiosity solution on
page 6168. Objects not included in the radiosity solution do not contribute to
indirect illumination. If these objects are lights, only their direct contribution
will be used for rendering.

NOTE Removing objects from the radiosity solution can significantly decrease
radiosity processing and rendering time, however it does sacrifice some accuracy
in the solution. It can be useful for creating quick test renders.
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Layer Manager Right-Click Menu

A standard popup menu is displayed over the Layer Manager by right-clicking
anywhere in the Layer Manager dialog. The menu contains a variety of layer
management and focus operations.

Some of the operations involve highlighted items or selected objects in your
scene. If the right-click is on a non-highlighted row, the highlight switches
to that row and the subsequent operation applies to the newly highlighted
item. If the right-click is on a highlighted row (or a group of highlighted rows),
all of the highlights are preserved and the subsequent operation applies to all
of the highlighted items.

NOTE To apply an operation to a group of objects or layers, you must hold Ctrl
when you right-click. If you have highlighted a group of objects and right-click
on one of them (without holding Ctrl), the selection group is cleared and only
that object will be highlighted.

Rename Initiates text editing mode for the highlighted layer's name. Unique
names are enforced. If a non-unique name is typed in, a modal dialog pops
up, stating “Invalid Layer Name. Layer names must be unique.”
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NOTE Rename is available only for layers; objects cannot be renamed in the Layer
Manager. Likewise, Rename is only available when a single layer is highlighted.

Cut Stores references to highlighted objects in memory so they can be pasted
into another layer.

Cut is only available when objects are highlighted; if there are no objects
highlighted or if a layer is part of a multiple selection, it is not available.

NOTE Objects are not actually cut from their assigned layer until they are pasted
to another one.

TIP If you cut a layer, 3ds Max cuts all objects in the layer.

Paste Moves cut objects into the highlighted layer.

Paste is available only when a single layer is highlighted and one or more
objects have been cut.

Collapse All Closes all expanded layers, hiding the object lists.

Expand All Expands all layers, displaying the objects within each.

Create New Layer Creates a new layer containing any currently selected
objects.

The new layer becomes the current layer. Its name is generated automatically
("Layer01", "Layer02", etc.) but can be changed by clicking its label.

Delete Deletes any empty highlighted layer.

NOTE This does not delete objects. Likewise, this command is not available when
your selection includes Layer0, any objects, or any layer containing objects.

Add Selected Objects Places objects currently selected in your scene into the
highlighted layer.

NOTE This command is available only when a single layer is highlighted.

Select Selects all of the currently highlighted objects or layers in the Layer
Manager.

NOTE If you use this command on a layer, all objects in that layer are selected.

Highlight Selected Objects' Layers Highlights all layers that contain objects
in the current scene selection.

Highlight All Layers Highlights all of the layers in your scene.
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NOTE This command does not highlight any objects.

Layer Properties Opens the Layer Properties dialog on page 7451 for the currently
highlighted layers.

Object Properties Opens the Object Properties dialog on page 305 for the
currently highlighted objects.

Layer Properties Dialog

Main toolbar > Layer Manager > Select one or more layers. > Click Layer icon.

Layer Manager > Right-click a layer. > Layer Properties

The Layer Properties dialog is similar to the Object Properties dialog on page
305. Here, you can change the rendering, motion blur, and display settings of
one or more selected layers. In addition, you can also change the advanced
lighting settings or hide/freeze one or more selected layers.
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Layer Information group

Controls layer information for objects on the selected layer.

Name Displays the selected layer name, which you can edit. The name can
contain up to 255 characters, including letters, digits, blank spaces, and the
special characters dollar sign ($), hyphen (-), and underscore (_).

Active Color Displays the color of the selected layer. You can select another
color by clicking the color to display the Layer Color dialog, which is identical
to the Object Color dialog on page 387, except that it doesn't have the By
Layer/By Object toggle.

Display Controls the display of the objects on the selected layer.

Viewport Displays the objects on the selected layer using the current settings
under Views on the viewport right-click menu on page 7576.

Bounding Box Displays the objects on the selected layer as a bounding box
on page 7932.

Wireframe Displays the objects on the selected layer in wireframe mode on
page 8172.

Shaded Displays the objects on the selected layer in Smooth+Highlight mode
on page 7576.
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General panel

Interactivity group

Hide Hides the selected layer.

Freeze Freezes the selected layer.

Display Properties group

Provides controls that alter the display of objects on the selected layer.

See-Through Makes objects on the selected layer translucent in viewports.
This setting has no effect on rendering, it simply lets you see what's behind
an object in a crowded scene, and especially to adjust the position of objects
behind or inside the See-Through object.

Display As Box Toggles the display of objects on the selected layers, including
3D objects and 2D shapes as bounding boxes on page 7932. Produces minimum
geometric complexity.
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Backface Cull For objects on the selected layer, toggles the display of faces
with normals on page 8059 pointing away from view. When on, you see through
the wireframe to the back faces. Applies only to Wireframe viewport display.

Edges Only For objects on the selected layer, toggles the display of face edges.
When set, only faces appear. When off, all mesh geometry appears. Applies
only to Wireframe viewport display.

Vertex Ticks Displays the vertices in objects on the selected layer as tick marks.

If the current selection has no displayed tick marks, the check box is clear. If
some of the vertices in the current selection display tick marks, the check box
contains a gray X. If all vertices in the current selection display tick marks,
the check box contains a black X.

Trajectory Toggles trajectory on page 8154 display for objects on the selected
layer. You can display an object's trajectory wherever you are in 3ds Max.

Ignore Extents When turned on, objects on the selected layer are ignored
when you use the display control Zoom Extents on page 7594.

Show Frozen in Gray When on, the object turns gray in viewports when you
freeze it. When off, viewports display the object with its usual color or texture
even when it is frozen.

Vertex Colors Affects editable mesh objects on page 2075 on the selected layer.
Displays the assigned vertex colors on page 305 in the viewport. You assign
vertex colors at the vertex or face sub-object levels.

Shaded Affects editable mesh objects on page 2075 on the selected layer. When
on, if the editable mesh has vertex colors, shaded viewports use vertex colors
to shade the mesh. When off, colors are unshaded.

Rendering Control group

Controls rendering settings for objects on the selected layer.

Visibility Controls the rendered visibility of the object. At 1.0, the object is
fully visible. At 0.0, the object is completely invisible when rendered.
Default=1.0.

Renderable Makes objects on the selected layer appear or disappear from the
rendered scene. For more information, see Renderable on page 7447.

NOTE This has the same functionality as the Render toggle in the layer list on
page 7459.
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Inherit Visibility Causes objects on the selected layer to inherit the visibility
of their parents (as determined by the parent's Visibility track in Track View).
When a group parent is assigned a visibility track, Inherit Visibility is
automatically turned on for all children in the group. Transparent materials
and hidden objects have no effect on this function.

Visible to Camera When on, the object is visible to cameras in the scene.
When off, cameras do not view this object.

Visible to Reflection/Refraction When on, the object is used in calculating
reflections and refractions. When off, the object does not appear in reflections
or refractions.

Receive Shadows When on, objects on the selected layer can receive shadows.

Cast Shadows When on, objects on the selected layer can cast shadows.

Apply Atmospherics When on, atmospheric effects are applied to the object.
When off atmospheric effects do not change the rendered appearance of this
object.

Render Occluded Objects Allows special effects to affect objects in the scene
that are occluded by this object. The special effects, typically applied by
plug-ins on page 8092 such as Glow on page 6599, use G-Buffer on page 7991 layers
to access occluded objects. Turning on this control makes the object
transparent for the purposes of special effects. This makes no difference when
you render to most image files. When you render to either the RLA on page
7364 or RPF on page 7366 file format, however, occluded objects appear with the
effect applied on their designated G-buffer layer.

Motion Blur group

Controls motion blur for objects on the selected layer.

Multiplier Affects the length of the motion blur streak.

Enabled When on, enables motion blur for this object. When off, motion
blur is disabled regardless of the other blur settings. Default=on.

None Turns off the state of motion blur for objects on the selected layer.

Object Object motion blur on page 8063 provides a time-slice blur effect for
objects on the selected layer.

Image Image motion blur on page 8010 blurs the image of each object on the
selected layer, based on the velocity of each pixel.
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Adv. Lighting panel

Radiosity Properties group

Exclude from Radiosity Processing When on, objects on a selected layer are
included in the radiosity solution. Objects not included in the radiosity solution
do not contribute to indirect illumination. If these objects are lights, their
direct contribution will only be used for rendering.

NOTE This has the same functionality as the Radiosity toggle in the Layer List.

Cast Shadows Determines whether objects on the selected layer will cast
shadows.

Receive Illumination Determines whether objects on the selected layer will
receive illumination.

Diffuse (reflective & translucent) When on, objects on the selected layer are
treated as diffuse (rough) in the radiosity process.
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Specular (reflective & transparent) When on, objects on a selected layer are
treated as specular (smooth) in the radiosity process.

Exclude from Regathering When on, objects on a selected layer are excluded
from the regathering process of the radiosity solution.

For more information on the Radiosity Properties group, see Radiosity Control
Panel on page 6188.

Object Subdivision Properties group

Use Global Subdivision Settings When on, the object's meshing settings
correspond to the global subdivision settings on the Radiosity Control Panel.
When off, you can change the meshing settings for each object. Default=on.

■ Subdivide When on, a radiosity mesh is created for the objects regardless
of the global meshing state. The subdivision that is performed is determined
by the Use Adaptive Subdivision switch. When off, the settings in the Mesh
Settings group are unavailable. Default=on.

■ Use Adaptive Subdivision Turns adaptive subdivision on and off.
Default=on.

NOTE The Mesh Settings group parameters Contrast Threshold, Min Mesh
Size, and Initial Mesh Size are available only when Use Adaptive Subdivision is
turned on.

Mesh Settings group

Max Mesh Size The size of the largest faces after adaptive subdivision.
Default=36” for imperial units and 100cm for metric units.

When Use Adaptive Subdivision is turned off, Max Mesh Size sets the size of
the radiosity mesh in world units.

Min Mesh Size Faces are not divided smaller than the minimum mesh size.
Default=3” for imperial units and 10cm for metric units.

Contrast Threshold Faces that have vertex illuminations that differ by more
than the Contrast Threshold settings are subdivided. Default=75.0.

Initial Mesh Size When improving the face shape, faces that are smaller than
the Initial Mesh Size are not subdivided. The threshold for deciding whether
a face is poorly shaped also gets larger as the face size is closer to the Initial
Mesh Size. Default=12” for imperial units and 30cm for metric units.
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Layer List 

Layers toolbar > Layer List

The Layer List, available from the Layers toolbar on page 7504, displays layer
names and their properties. You can control the properties of layers by clicking
the property icons. You can make a layer current by simply selecting it from
the list.

The controls available in the Layer List are a subset of the controls available
in the Layer Manager. For more information, see Layer Manager  on page 7441.

TIP The Layer List is most useful in conjunction with the other tools available on
the Layers toolbar on page 7504.

See also:

■ Using Layers to Organize a Scene on page 7438

Procedures

To make a layer current:

1 Click Layers toolbar > Layer List to display the list.

2 Click in the first (left) column next to the layer you want to make current.

A check mark appears next to the current layer.

3 Click the layer list again to collapse it.

4 Select the layer you want to make current from the list.

It is now the current layer.

To change the layer of a selected object:

1 Click Layers toolbar > Layer List to display the list.

2 Select the desired destination layer to make it current.

3  On the Layers toolbar, click Add Selected Objects to Current Layer.

To change a layer's properties:

1 Click Layers toolbar > Layer List to display the list.
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2 Click the layer property icon that you want to set.

You can change the following properties from the layer list: hide/unhide,
freeze/unfreeze, renderable/non-renderable, and color.

3 Click the Layer List again to collapse it.

Interface

You can change the following properties from the layer list: hide/unhide,
freeze/unfreeze, renderable/non-renderable, and color.

Unlike the Layer Manager, where one icon is used for all Off states, the 'Off'
icons for each property on the Layer List are unique.

The following are the On and Off icons for each toggled property in the Layer
List:

OffOnProperty

 (Visible) (Hidden)Hide/Unhide

 (Editable) (Frozen)Freeze/Unfreeze

 (Non-renderable) (Renderable)Renderable/Non-Render-
able

Create New Layer 

Layers toolbar > Create New Layer

Layers toolbar > Layer Manager > Create New Layer

Create New Layer creates a new layer the layer containing the currently selected
objects. The new layer's name is automatically generated (“Layer01”, “Layer02”,
etc.) but may be changed in the Layer Manager on page 7441.
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Add Selection to Current Layer 

Layers toolbar > Add Selection to Current Layer

Add Selection to Current Layer moves the current object selection to the
current layer.

Select Objects in Current Layer 

Layers toolbar > Select Objects in Current Layer

Select Objects in Current Layer selects all of the objects contained in the
current layer.

Set Current Layer to Selection's Layer 

Layers toolbar > Set Current Layer to Selection's Layer

Set Current Layer to Selection's Layer changes the current layer to the layer
which contains the currently selected objects.

NOTE This button is not available if your selection includes objects that reside on
different layers.
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Utilities

List of Available Utilities
The table of contents for this reference lists utilities alongside the features they
support. Here is a consolidated, alphabetical list.

Asset Browser Utility on page 7132

Assign Vertex Colors Utility on page 6038

Bitmap/Photometric Path Editor Utility on page 7141

Camera Match Utility on page 5249

Camera Tracker Utility on page 3819

Channel Info Utility on page 6047

Clean MultiMaterial Utility on page 6052

Collapse Utility on page 2016

Color Clipboard Utility on page 397

COM/DCOM Server Control Utility on page 7696

Dynamics Utility on page 3852

File Link Manager Utility on page 6987

Fix Ambient Utility on page 7147

Flight Studio on page 7223

Follow/Bank Utility on page 3796

IFL Manager Utility on page 7344
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Instance Duplicate Maps Utility on page 6058

Level of Detail Utility on page 2579

Lighting Data Exporter Utility on page 6759

Lightscape Materials Utility on page 7254

Link Inheritance (Selected) Utility on page 3372

MACUtilities Utility on page 3817

Material XML Exporter Utility on page 5281

MAX File Finder Utility on page 7143

MAXScript Utility on page 11

Measure Utility on page 2680

Motion Capture Utility on page 3798

Panorama Exporter Utility on page 6426

reactor Utility on page 3881

Rescale World Units Utility on page 2682

Reset XForm Utility on page 957

Resource Collector Utility on page 7145

Shape Check Utility on page 707

Skin Utilities on page 3875

Strokes Utility on page 7854

Surface Approximation Utility on page 2565

UVW Remove Utility on page 5284

Visual MAXScript Utility (See MAXScript Reference) on page 7679

See also:

■ Track View Utilities on page 3619
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User Interface

The 3ds Max user interface provides multiple ways to achieve the same goals. You can hide,
float on page 7957 or dock on page 7957, resize and rearrange the user interface elements into
your own personal design. For more information, see Customizing the User Interface on page
7683.

See the topics referenced below for detailed information on the major elements of the user
interface.

See also:

■ Menu Bar on page 7471

■ Toolbars on page 7498

■ Quad Menu on page 7516

■ Status Bar Controls on page 7524

■ Animation and Time Controls on page 7548

■ Viewport Controls on page 7572

■ Viewport Navigation on page 7585

■ Command Panel on page 7630

■ MAXScript Interface on page 7496

Additional Keyboard Commands
This topic describes some commands that are provided only as customizable
actions. You can assign them to a keyboard shortcut, a menu, or a button by
using the Customize User Interface dialog on page 7697.
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See also:

■ Keyboard Shortcuts on page 7857

■ Unwrap UVW Shortcuts on page 1878

Keyable Property

Keyable Property Toggle

Default key: None

In Track View, if you select any track or group of tracks, this command turns
the keyable property on page 3563 on or off. If a selected track is not keyable,
its children (sub-animations), if any, are toggled. For example, if you select a
transform controller track, this command toggles the keyable property of all
position, rotation, and scale tracks. If you select an object's track, its transform,
parameter, and material tracks are all toggled. If the object is part of a
hierarchy, all its child objects' tracks are also toggled.

This action can be undone.

Set Key

Clear Set Key Mode Buffer

Default key: None

While in Set Key mode, if you transform an object but haven't yet clicked Set
Key, this shortcut undoes the transformation and restores the viewport to
show the animation that existed before the change.

Another way to accomplish this is to move the time slider or to turn on Play.

Transforms

Create Position Lock Key and Create Rotation Lock Key

Default keys: None

A lock key is a key with Linear interpolation. If you create the lock key while
an existing key is selected, it changes that key's interpolation from Smooth
to Linear. (Different types of interpolation are described in Bezier Controllers
on page 3138.) You can create a lock key for position or for rotation.
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Lock keys are useful when you want an object to be stationary, but smooth
interpolation is causing it to "wobble" on its stationary spot.

Position to Zero

Default key: None

Like its counterparts on the Animation quad menu on page 7522, this shortcut
restores the object's position to the initial “frozen” pose (0,0,0).

NOTE Position To Zero works only if you have previously invoked Freeze Transform
or Freeze Rotation from the Animation quad menu.

Viewport Navigation

Pan Viewport

Default key: I (the letter “i”)

Pans the active viewport, centering it on the current location of the cursor.

You can use this shortcut while another command, such as Move, is active.

This action can be undone, using Shift+Z.

Toggling Dialogs
In most cases, you can close a dialog with the same command used to open
it. This applies to any combination of input methods, including menu, toolbar
button, and keyboard shortcuts. For example, you can open the Render Setup
dialog by choosing Rendering > Render Setup, and then close it by pressing
F10 (default keyboard shortcut). If a dialog is available from a menu, a check
mark appears next to the respective command while it's open.

If a dialog is minimized, invoking its command opens the dialog, and invoking
it a second time closes the dialog.

In addition, the keyboard shortcut Ctrl+~ (tilde) toggles display of any open
dialogs, in most cases.

The dialogs affected by this functionality are:

■ Asset Browser

■ Bone Tools
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■ Channel Info Editor

■ Clone and Align dialog

■ Display Floater

■ Environment and Effects dialog

■ Grid and Snap Settings dialog

■ Layer Manager

■ Light Lister

■ Material Editor

■ Material/Map Browser (modeless version)

■ mental ray Messages Window

■ Parameter Collector

■ Parameter Editor

■ Rename Objects

■ Render dialog

■ Render to Texture

■ Rigid Body Property editor

■ Selection Floater

■ Spacing Tool

■ Transform Type-In

■ Video Post

The one exception is Particle View, which is toggled by its keyboard shortcut
(6), but is not toggled by the Modify panel > Particle View button.

Starting 3ds Max from the Command Line
You can start the program from the command line in a Command Prompt
window, or include the command line in a batch file. There are a number of
switches that you can use on the command line.
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To start 3ds Max from the command line:

1 Open a Command Prompt window.

2 Change directory to the 3ds Max root directory, if this directory is not
in your PATH statement.

3 Type 3dsmax to start the program. Optionally, add a command-line
switch (see below).

Command-Line Switches

You can use the following switches after 3dsmax on the command line.

EffectSwitch

Starts program using othercui.cui instead
of maxstart.cui.

-c other-
cui

Causes Track View to use a double-buf-
fered display, which is smoother than the

-d

single-buffered display but uses more sys-
tem resources.

Makes background white (instead of gray)
in the following dialogs: Track View, RAM

-g

Player, Video Post, Loft, and Falloff Curve.
Useful for screen captures when using a
display mode less than 24 bits deep, for
avoiding background patterns.

Allows choice of graphics drivers: Software,
Open GL, Direct3D, and Custom.

-h

Starts program using otherfile.ini instead
of 3dsmax.ini.

-i other-
file

Loads the last .max file automatically.-l

Open maximized.-ma
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EffectSwitch

Open minimized.-mi

Disables network mode.-n

Starts program using otherfile.ini instead
of plugin.ini.

-p other-
file

Starts program "quietly," without the
splash screen.

-q

Starts program in server mode.-s

Opens utility.-u

Loads a display driver. See details follow-
ing, under "Using the −V Option."

NOTE It is not possible to select which
version of Direct3D you will use with this
switch.

-v

Writes version number to file. See details
following, under "Using the −Z Option."

-z

Starts the program and opens a file called
anyscene.max.

any-
scene

A space must separate the program executable name and the command-line
switch.

Examples:

3dsmax −l

3dsmax −i otherfile

3dsmax anyscene

3dsmax −c MaxCustom
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See also:

■ Startup Files and Defaults on page 82

■ Saving and Loading Custom User Interfaces on page 7722

■ Graphics Driver Setup Dialog on page 7790

■ Running Scripts from the Command Line on page 7680

Using the -V Option

You use the -V option to load a different display driver at startup. This option
overrides the setting in 3dsmax.ini.

Follow the -V with one of these letters for the driver you want to use:

s: Loads the software driver.

o: Loads the OpenGL driver.

d: Loads the Direct3D driver.

n: Loads a null driver.

For example, if you ordinarily run OpenGL and want to switch to the software
driver for a session, you would type: 3dsmax −vs

Using the -Z Option

If you call product support, the representative might ask you to run this option
to determine the exact version of your software. This option only writes to a
file; it does not start 3ds Max.

Follow the -Z with a file name:

3dsmax −z id.txt

The file (in this example, id.txt) is written to the 3ds Max root directory.

Menu Bar

The menu bar is located directly under the main window’s title bar. The title
of each menu indicates the purpose of the commands on the menu. Each
menu uses standard Microsoft Windows conventions.
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File Menu on page 7473

Edit Menu on page 7474

Tools Menu on page 7475

Group Menu on page 7477

Views Menu on page 7477

Create Menu on page 7478

Modifiers Menu on page 7485

Animation Menu on page 7490

Graph Editors Menu on page 7493

Rendering Menu on page 7493

Customize Menu on page 7494

MAXScript Interface on page 7496

Help Menu on page 7496

Interface

When you click a menu name, a number of commands are listed below it.

As an alternative to using your mouse (or other pointing device), each menu
name includes an underlined character. Pressing that character key while
holding down the Alt key opens the menu, unless that particular key
combination is assigned to a keyboard shortcut. Some commands and
subheadings in the open menu have an underlined character as well. While
the menu is open, pressing that character key invokes the command. While
navigating menus with the keyboard, you can also use the arrow keys to move
the highlighting and the Enter key to activate a command or open a submenu.

An ellipsis (…) after a command name indicates a dialog will appear.

A right-pointing triangle after a command name indicates that a submenu
will appear.

If a command has a keyboard shortcut, the menu displays it to the right of
the command name.

If a menu command is an on/off toggle, a check mark indicates its status: If
a check mark is present, the command is active.
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File Menu

Menu bar > File

The File menu contains commands for managing files.

New on page 6920

Reset on page 6921

Open on page 6922

Open from Vault on page 6925

Open Recent on page 6927

Save on page 6927

Save As on page 6928

Save Copy As on page 6930

Save Selected on page 6931

Set Project Folder on page 6932

XRef Objects on page 6936

XRef Scene on page 6959

File Link Manager Utility on page 6987

Merge on page 7058

Merge Animation on page 7063

Replace on page 7070

Load Animation on page 7077

Save Animation on page 7080

Import on page 7096

Export on page 7097

Export Selected on page 7099

Publish to DWF on page 7216

Asset Tracking on page 7100

Archive on page 7121

Summary Info on page 7122
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File Properties on page 7124

View Image File on page 7127

Exit on page 7129

File dialogs (such as Open, Save, Save As) uniformly remember the previous
path you used, and default to that location.

Edit Menu

Menu bar > Edit

The Edit menu contains commands for selecting and editing objects in a scene.

Undo/Redo  on page 262

Hold/Fetch on page 264

Delete on page 265

Clone on page 1034

Move on page 959

Rotate on page 960

Scale on page 962

Transform Type-In on page 944

Select All on page 249

Select None on page 249

Select Invert on page 250

Select Similar on page 250

Select Instances Selects all instances on page 8014 of the selected object.
Unavailable if the object has no instances, or if multiple objects are selected.

Select By on page 251

Selection Region on page 252

Manage Selection Sets on page 246

Object Properties on page 305

7474 | Chapter 25   User Interface



Tools Menu

Menu bar > Tools

The Tools menu displays dialogs that help you change or manage objects,
especially collections of objects, in your 3ds Max scene.

Open Scene Explorer on page 7379 (Opens the most recently accessed scene
explorer)

New Scene Explorer on page 7379

Manage Scene Explorer on page 7393

Saved Scene Explorers on page 7379 (when one or more scene explorers exist)

Isolate Selection on page 219

Display Floater on page 7666

Manage Layers on page 7441

Light Lister on page 5000

Manage Scene States on page 7399

Mirror on page 982

Array  on page 986

Align on page 7476

Snapshot  on page 992

Rename Objects on page 328

Assign Vertex Colors on page 6038

Color Clipboard on page 397

Camera Match on page 5249

Grab Viewport on page 145

Grids and Snaps on page 7476

Measure Distance on page 2613

Channel Info on page 6047
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Align Submenu

Menu bar > Tools > Align

The Align submenu contains functions for aligning objects in the scene, as
well as for creating aligned objects.

Align  on page 1009

Quick Align  on page 1015

Spacing Tool  on page 996

Clone and Align on page 1004

Align to View  on page 1021

Normal Align  on page 1015

Align Camera  on page 1020

Place Highlight  on page 1018

Grids and Snaps Submenu

Menu bar > Tools > Grids and Snaps

The Grid And Snaps submenu contains commands for using grids and snapping
tools to help lay out scenes precisely. The submenu contains the following
commands:

Grid and Snap Settings on page 2661

Show Home Grid on page 2648

Activate Home Grid on page 2649

Activate Grid Object on page 2650

Align Grid to View on page 2650

Snaps Toggle on page 2652

Angle Snap Toggle  on page 2654

Percent Snap Toggle  on page 2655

Snaps Use Axis Constraints on page 2675
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Group Menu

Menu bar > Group

The Group menu contains functions for grouping and ungrouping objects in
the scene.

Group on page 282

Ungroup on page 284

Open on page 283

Close on page 283

Attach on page 286

Detach on page 285

Explode on page 285

Assembly on page 286

See also:

■ Using Groups on page 266

■ Using Assemblies on page 269

Views Menu

Menu bar > Views

This menu contains commands for setting up and controlling viewports. Some
of the commands found on this menu can also be accessed when you
right-click a viewport label.

Undo View Change/Redo View Change on page 146

Viewport Configuration on page 7817

Redraw All Views on page 172

Set Active Viewport on page 7580

Save Active View on page 147

Restore Active View on page 147
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ViewCube on page 109 (also see ViewCube configuration on page 7837)

SteeringWheels on page 117

Create Camera From View on page 168

Show Materials in Viewport As on page 5350

Viewport Lighting and Shadows on page 4991

Viewport Background >

■ Viewport Background on page 148

■ Update Background Image on page 161

■ Reset Background Transform on page 162

Show Transform Gizmo on page 162

Show Ghosting on page 163

Show Key Times on page 164

Shade Selected on page 166

Show Dependencies on page 167

Update During Spinner Drag on page 174

Adaptive Degradation  on page 143

Expert Mode on page 175

NOTE The following commands, also influencing viewport behavior, are accessed
from a different menu:

Units Setup Dialog on page 7809

Grid and Snap Settings on page 2661

Create Menu

Menu bar > Create

The Create menu provides a way to create geometry, lights, cameras, and
helper objects on page 2614. It is organized into various submenus.
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See also:

■ Create Panel  on page 7631

Interface

Standard Primitives

Box on page 410

Cone on page 413

Sphere on page 416

GeoSphere on page 421

Cylinder on page 424

Tube on page 427

Torus on page 430

Pyramid on page 434

Teapot on page 437

Plane on page 440

Extended Primitives

Hedra on page 445

Torus Knot on page 448

Chamfer Box on page 452

Chamfer Cylinder on page 456

Oil Tank on page 459

Capsule on page 462

Spindle on page 465

L-Extrusion on page 469

Gengon on page 471

C-Extrusion on page 474

RingWave on page 477

Hose on page 485
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Prism on page 483

AEC Objects

Foliage on page 499

Railing on page 507

Wall on page 516

Pivot Door on page 571

Sliding Door on page 573

BiFold Door on page 575

Straight Stair on page 549

L-Type Stair on page 534

U-Type Stair on page 555

Spiral Stair on page 540

Awning Window on page 584

Casement Window on page 587

Fixed Window on page 589

Pivoted Window on page 591

Sliding Window on page 595

Projected Window on page 593

Compound

Morph on page 709

Scatter on page 717

Conform on page 731

Connect on page 739

BlobMesh on page 745

ShapeMerge on page 752

Boolean on page 757

Terrain on page 774
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Loft on page 786

Mesher on page 837

ProBoolean on page 844

ProCutter on page 862

Particles

Particle Flow Source on page 2829

Spray on page 3016

Snow on page 3020

Blizzard on page 3029

PArray on page 3042

PCloud on page 3034

Super Spray on page 3025

Patch Grids

Quad Patch on page 2069

Tri Patch on page 2072

NURBS

CV Surface on page 2280

Point Surface on page 2276

CV Curve on page 2293

Point Curve on page 2286

Dynamics

Damper on page 881

Spring on page 890

Shapes

Line on page 620

Rectangle on page 624
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Circle on page 626

Ellipse on page 628

Arc on page 629

Donut on page 633

NGon on page 634

Star on page 636

Text on page 638

Helix on page 643

Section on page 645

Extended Shapes

WRectangle on page 649

Channel on page 652

Angle on page 654

Tee on page 656

Wide Flange on page 657

Lights

Photometric Lights >

Target Light on page 5009

Free Light on page 5011

mr Sky Portal on page 5186

Standard Lights >

Target Spotlight on page 5051

Free Spotlight on page 5054

Target Directional on page 5057

Directional on page 5060

Omni on page 5063

Skylight on page 5065
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mr Area Spot on page 5073

mr Area Omni on page 5070

Daylight System on page 5139

Cameras

Free Camera on page 5203

Target Camera on page 5205

Create Camera From View on page 168

Helpers

Dummy on page 2615

Expose Transform on page 2616

Grid on page 2622

Point on page 2628

Tape Measure on page 2630

Protractor on page 2633

Compass on page 2635

Light Meter

Camera Point on page 5255

Delegate on page 4811

Crowd on page 4819

Atmospherics >

Box Gizmo on page 6762

Cylinder Gizmo on page 6765

Sphere Gizmo on page 6768

Manipulators >

Slider on page 2643

Plane Angle on page 2640

Cone Angle on page 2636
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Particle Flow >

Speed by Icon on page 2876

Find Target on page 2970

Space Warps

Forces >

Motor on page 2696

Push on page 2691

Drag on page 2706

Vortex on page 2701

Path Follow on page 2717

PBomb on page 2712

Displace on page 2727

Gravity on page 2721

Wind on page 2724

Deflectors >

PDynaFlect on page 2738

POmniFlect on page 2732

SDynaFlect on page 2745

SOmniFlect on page 2743

SDeflector on page 2751

UDynaFlect on page 2748

UOmniFlect on page 2746

UDeflector on page 2754

Deflector on page 2757

Geometric/Deformable >

FFD (Box) on page 2760

FFD (Cyl) on page 2767

Wave on page 2777
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Ripple on page 2781

Displace on page 2727

Conform on page 2785

Bomb on page 2789

Modifier-Based >

Bend on page 2793

Noise on page 2793

Skew on page 2793

Taper on page 2793

Twist on page 2793

Stretch on page 2793

Particles and Dynamics >

Vector Field on page 4917

Systems

Bones IK Chain on page 901

Biped on page 4147

Daylight System on page 5139

Modifiers Menu

Menu bar > Modifiers

The Modifiers menu provides a way to apply frequently used modifiers quickly.
It is organized into submenus. The availability of items on this menu depends
on the current selection. If a modifier doesn't apply to currently selected
objects, it is unavailable in the menu.

See also:

■ Modify Panel  on page 7633

■ Modifier Stack Controls on page 7635

■ List of Available Modifiers on page 1081
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Interface

Selection Modifiers

FFD Select on page 1466

Mesh Select on page 1527

Patch Select on page 1592

Poly Select on page 1613

Select by Channel on page 1659

Spline Select on page 1744

Volume Select on page 1992

Patch/Spline Editing

Cross Section on page 1329

Delete Patch on page 1337

Delete Spline on page 1339

Edit Patch on page 1360

Edit Spline on page 1447

Fillet/Chamfer on page 1467

Lathe on page 1501

Normalize Spline on page 1583

Renderable Spline on page 1652

Surface on page 1766

Sweep  on page 1780

Trim/Extend on page 1818

Mesh Editing

Cap Holes on page 1228

Delete Mesh on page 1336

Edit Mesh on page 1353

Edit Normals on page 1354

Edit Poly on page 1363
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Extrude on page 1448

Face Extrude on page 1452

MultiRes on page 1565

Normal Modifier on page 1581

Optimize on page 1587

Smooth on page 1736

STL Check on page 1749

Symmetry on page 1807

Tessellate on page 1815

Vertex Paint on page 1959

Vertex Weld on page 1957

Conversion

Turn to Mesh on page 1828

Turn to Patch on page 1830

Turn to Poly on page 1833

Animation Modifiers

Attribute Holder on page 1206

Flex on page 1471

Linked XForm on page 1511

Melt on page 1523

Morpher on page 1545

PatchDeform on page 1597

PatchDeform (WSM) on page 1193

PathDeform on page 1600

PathDeform (WSM) on page 1193

Skin on page 1672

Skin Morph on page 1708

Skin Wrap on page 1719

Skin Wrap Patch on page 1728
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SplineIK Control on page 1741

SurfDeform on page 1778

SurfDeform (WSM) on page 1202

Cloth

Cloth on page 1247

Garment Maker on page 1297

Hair and Fur

Hair and Fur (WSM) on page 1119

UV Coordinates

Camera Map on page 1223

Camera Map (WSM) on page 1113

Map Scaler (WSM) on page 1190

Projection on page 1628

Unwrap UVW on page 1841

UVW Map on page 1931

UVW Mapping Add on page 1954

UVW Mapping Clear on page 1954

UVW XForm on page 1955

Cache Tools

Point Cache on page 1604

Point Cache (WSM) on page 1199

Subdivision Surfaces

HSDS Modifier on page 1491

MeshSmooth on page 1532

TurboSmooth on page 1822

Free Form Deformers

FFD 2x2x2 on page 1454

FFD 3x3x3 on page 1454

FFD 4x4x4 on page 1454
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FFD Box on page 1460

FFD Cylinder on page 1460

Parametric Deformers

Affect Region on page 1203

Bend on page 1208

Displace on page 1344

Lattice on page 1506

Mirror on page 1543

Noise on page 1573

Physique on page 4670

Push on page 1646

Preserve on page 1622

Relax on page 1647

Ripple on page 1655

Shell on page 1660

Slice on page 1729

Skew on page 1668

Stretch on page 1752

Spherify on page 1739

Squeeze on page 1747

Twist on page 1837

Taper on page 1811

Substitute on page 1762

XForm on page 2004

Wave on page 2000

Surface

Disp Approx on page 1340

Displace Mesh (WSM) on page 1115

Material on page 1517
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Material by Element on page 1519

NURBS Editing

DispApprox on page 1340

SurfDeform on page 1778

Surface Select on page 1585

Radiosity Modifiers

Subdivide on page 1759

Subdivide (WSM) on page 1199

Cameras

Camera Correction on page 5247

Animation Menu

Menu bar > Animation

The Animation menu provides a set of commands related to animation,
constraints and controllers, and inverse-kinematics solvers.

Also present here are controls for custom attributes and parameter wiring, as
well as for creating, viewing, and renaming animation previews.

Interface

IK Solvers

HI Solver on page 3392

HD Solver on page 3422

IK Limb Solver on page 3444

Spline IK Solver  on page 3445

Constraints

Attachment Constraint on page 3288

Surface Constraint on page 3293

Path Constraint on page 3297

Position Constraint on page 3303

7490 | Chapter 25   User Interface



Link Constraint on page 3308

LookAt Constraint on page 3312

Orientation Constraint on page 3319

Transform Controllers

Link Constraint on page 3308

Position/Rotation/Scale on page 3220

Script on page 3261

Position Controllers

Audio  on page 3135

Bezier on page 3138

Expression on page 3154

Linear on page 3193

Motion Capture on page 3203

Noise on page 1573

Quaternion (TCB) on page 3258

Reaction on page 3222

Spring on page 3253

Script on page 3248

XYZ on page 3219

Attachment Constraint on page 3288

Path Constraint on page 3297

Position Constraint on page 3303

Surface Constraint on page 3293

Rotation Controllers

Audio  on page 3135

Euler XYZ on page 3151

Linear on page 3193

Motion Capture on page 3203

Noise on page 3214
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Quaternion (TCB) on page 3258

Reaction on page 3222

Script on page 3248

Smooth on page 3253

LookAt Constraint on page 3312

Orientation Constraint on page 3319

Scale Controllers

Audio  on page 3135

Bezier on page 3138

Expression on page 3154

Linear on page 3193

Motion Capture on page 3203

Noise on page 3214

Quaternion (TCB) on page 3258

Reaction on page 3222

Script on page 3248

XYZ on page 3246

Parameter Editor on page 329

Parameter Collector on page 347

Wire Parameters >

Wire Parameters on page 3322

Parameter Wire Dialog on page 3324

Animation Layers on page 3164

Reaction Manager on page 3228

Bone Tools on page 915

Set as Skin Pose on page 304

Assume Skin Pose on page 304

Skin Pose Mode on page 304

Make Preview on page 6422
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View Preview on page 6425

Rename Preview on page 6425

Toggle Limits Toggles all Limit controllers on page 3181 in the current scene.
If all Limit controllers are off, Toggle Limits turns them on, and if all are on,
it turns them off. If some are on and the rest are off, Toggle Limits turns them
all on.

Delete Selected Animation on page 7523

Walkthrough Assistant on page 5239

reactor on page 3887

Graph Editors Menu

Menu bar > Graph Editors

The Graph Editors menu gives you access to graphic sub-windows for managing
a scene and its hierarchies and animation.

Interface

Track View – Curve Editor on page 3518

Track View – Dope Sheet on page 3519

New Track View on page 3686

Delete Track View on page 3686

Saved Track Views on page 3688

New Schematic View on page 7433

Delete Schematic View on page 7434

Saved Schematic Views on page 7434

Particle View on page 2811

Motion Mixer... on page 3699

Rendering Menu

Menu bar > Rendering
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The Rendering menu contains commands for rendering scenes, setting up
environmental and render effects, compositing scenes with Video Post, and
accessing the RAM Player.

NOTE The presence on the menu of certain commands depends on which renderer
is currently active, as noted here.

Render on page 6100

Render Setup on page 6067

Rendered Frame Window  on page 6073

Indirect Illumination on page 6295 (mental ray Renderer)

Radiosity on page 6188 (Default Scanline Renderer)

Light Tracer on page 6154 (Default Scanline Renderer)

Exposure Control on page 6732

Environment on page 6687

Effects on page 6585

Raytracer Settings on page 6221 (Default Scanline Renderer)

Raytrace Global Include/Exclude on page 5519 (Default Scanline Renderer)

Render to Texture on page 6371

Material Editor on page 5284

Material/Map Browser on page 5290

Video Post on page 6773

Panorama Exporter on page 6426

Batch Render on page 6553

Print Size Assistant on page 6117

mental ray Message Window on page 6244 (mental ray Renderer)

RAM Player on page 7374

Customize Menu

Menu bar > Customize

7494 | Chapter 25   User Interface



The Customize menu contains commands for customizing the 3ds Max user
interface (UI).

Customize User Interface on page 7697

Load Custom UI Scheme on page 7724

Save Custom UI Scheme on page 7725

Revert to Startup Layout on page 7728

Lock UI Layout on page 7690

Show UI on page 7689

Custom UI and Defaults Switcher on page 7692

Configure User Paths on page 7729

Configure System Paths on page 7732

Units Setup on page 7809

Plug-In Manager on page 7690

Preferences on page 7743

You can create a custom user interface layout, including custom keyboard
shortcuts, colors, menus, and quad menus. You can load or save all of these
things individually in the Customize User Interface dialog, or you can load
or save all of them at once, using schemes. Schemes allow you to load all
customized features of the UI at one time.

You can hide, float or dock on page 7957, resize, and rearrange some UI elements
into your own personal design. You can also lock the UI once you’ve got it
set. Tools are provided in the Customize menu to load and save these custom
UI files, or to revert to the startup user interface.

System preferences such as keyboard shortcuts, viewport configuration, units
setup, grid and snap settings, and many important default settings, are also
on the Customize menu.

TIP You can access many of these commands with keyboard shortcuts or right-click
options. For example, you can display the Grid and Snap Settings dialog by
right-clicking the Snaps buttons on the main toolbar; you can display the Viewport
Configuration dialog by right-clicking the viewport label, and then choosing
Configure.
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MAXScript Interface

Menu bar > MAXScript

Utilities panel > MAXScript

MAXScript on page 11 is the software's built-in scripting language. Its main
interface, the MAXScript menu, contains the following commands for creating
and working with scripts:

New Script on page 7676

Open Script on page 7677

Run Script on page 7677

MAXScript Listener on page 7677

MAXScript Editor Toggles the MAXScript Editor window. For details, see the
MAXScript Help, available from Help menu > MAXScript Help.

Macro Recorder on page 7678

Visual MAXScript Editor on page 7679

MAXScript Debugger Dialog on page 7680

In addition, the status bar on page 7524 contains a MAXScript Mini Listener on
page 7525, and MAXScript functionality is also available from the Utilities panel
on page 7671.

For detailed information about MAXScript, open the MAXScript Help, available
from Help menu > MAXScript Help.

Help Menu

Menu bar > Help

The Help menu provides access to the 3ds Max online help systems.

Autodesk 3ds Max Help Opens the 3ds Max Help.

Learning Movies Opens a dialog that provides access to movies for learning
the essentials of using 3ds Max.

Learning Path Opens your Web browser to a page of resources for learning
how to use 3ds Max.

Tutorials Displays the online tutorials for 3ds Max.
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What’s New Opens the 3ds Max to the new features section.

MAXScript Help Displays the MAXScript Help online. See About MAXScript
on page 11.

Additional Help Opens a dialog that lets you choose to display the help for
installed third-party plug-ins and for add-on products from Autodesk.

By default, this command looks for additional help files in the \help
subdirectory. That location might have changed if you've edited plug-in path
settings. See 3rd Party Plug-Ins Path Configuration on page 7740.

Keyboard Shortcut Map Opens a page showing keyboard shortcuts.

Data Exchange Solutions Opens your Web browser to a page about software
for exchanging data among applications.

Customer Involvement Program When activated, lets Autodesk collect
anonymous information about your usage of 3ds Max to help us improve the
software. No personal information is collected. Choose whether or not to
participate, and then click OK.

Subscription e-Learning Catalog Opens your Web browser to a page about
electronic learning content for subscribers.

Edit Subscription Center Profile Opens your Web browser to a page that lets
you edit your subscription profile.

Create Support Request Opens your Web browser to a page about obtaining
technical support.

View Support Requests Opens your Web browser to a page about existing
requests for technical support.

3ds Max on the Web Displays a submenu whose options display a Web page
with additional information.

Activate 3ds Max Starts the 3ds Max registration wizard, which lets you enter
a new license authorization code. For example, you need to reauthorize 3ds
Max if you're changing from a trial license to a permanent license.

License Borrowing If you are using a network-licensed version of 3ds Max,
use this choice to borrow or return a license. For details, see the AutoCAD
License Borrowing help, which is available as the file acad_brw.chm, installed
in the \program files\common files\autodesk shared\enu folder on your local drive
(typically, drive C:).

Diagnose Video Hardware Lets you determine whether your system supports
certain display-related features. See  Diagnose Video Hardware on page 174.
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About 3ds Max Displays copyright and license information about your copy
of 3ds Max.

See also:

■ Using the 3ds Max Help on page 33

■ Copyrights and Trademarks

Toolbars
Many of the commands in 3ds Max are available as buttons on various toolbars.
By default, only the main toolbar on page 7499 is open, docked at the top of
the interface. You can open and close toolbars and place them wherever you
want. for more information, See Customizing the User Interface on page 7683.

Several additional toolbars are hidden by default, including Axis Constraints
on page 7503, Layers on page 7504, Extras on page 7506, Render Shortcuts on page
7506, Brush Presets on page 7509, and Snaps on page 7508. To toggle a toolbar,
right-click a blank area of the main toolbar and choose the toolbar's name
from the list.

See Customize Display Right-Click Menu on page 7687 for more information.

See also:

■ Main Toolbar on page 7499

■  InfoCenter Toolbar on page 7503

■ Axis Constraints Toolbar on page 7503

■ Layers Toolbar on page 7504

■ reactor Toolbar on page 7505

■ Extras Toolbar on page 7506

■ Render Shortcuts Toolbar on page 7506

■ Snaps Toolbar on page 7508

■ Animation Layers Toolbar on page 7508

■ Brush Presets Toolbar on page 7509
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Main Toolbar

The main toolbar, split in two for this illustration

The main toolbar provides quick access to tools and dialogs for many of the
most common tasks in 3ds Max.

NOTE Right-clicking the move, rotate, or scale button opens the Transform Type-In
dialog on page 944.

Undo/Redo  on page 262

Select and Link  on page 3343

Unlink Selection  on page 3344

Bind to Space Warp  on page 2691

Selection Filter List on page 235
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Select Object  on page 227

Select From Scene  on page 228

Selection Region Flyout on page 234

Window/Crossing Selection Toggle  on page 261

Select and Move  on page 959

Select and Rotate  on page 960

Select and Scale on page 962

Reference Coordinate System on page 967

Use Center Flyout on page 975
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Select And Manipulate  on page 2613

Keyboard Shortcut Override Toggle  on page 7858

2D Snap, 2.5D Snap, 3D Snap on page 2652

Angle Snap Toggle  on page 2654

Percent Snap Toggle  on page 2655

Spinner Snap Toggle  on page 2656

Edit Named Selection Sets on page 246

Named Selection Sets on page 239

Mirror on page 982
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Align Flyout on page 1009

Layer Manager  on page 7441

Curve Editor (Open) on page 3518

Schematic View (Open) on page 7407

Material Editor  on page 5284

Render Setup on page 6067

Rendered Frame Window  on page 6073

Render flyout:

■ Render Production  on page 6101
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■  Render Iterative  on page 6101

■ ActiveShade  on page 6102

 InfoCenter Toolbar

Right-click unused area of any toolbar > InfoCenter

The InfoCenter toolbar is displayed by default. For instructions on how to use
it, see Search For and Receive Information on page 13 and the topics that
follow that topic.

Axis Constraints Toolbar

Right-click unused area of any toolbar > Axis Constraints

The axis constraint buttons and flyouts appear on the Axis Constraints toolbar.
See Using the Axis Constraints on page 955.

NOTE The default UI does not display this toolbar: to see it, right-click an empty
portion of any toolbar, and choose Axis Constraints from the menu.

 Restrict to X
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 Restrict to Y

 Restrict to Z

Restrict to Plane flyout

 Restrict to XY Plane

 Restrict to YZ Plane

 Restrict to ZX Plane

Snaps Use Axis Constraints Toggle on page 2675

Layers Toolbar

Right-click any toolbar > Layers

The Layers toolbar simplifies interaction with the layer system in 3ds Max,
allowing you to easily organize the layers in your scene. Most of these
operations are available from the Layer Manager on page 7441, however the
Layers toolbar provides shortcuts to several common actions, as well as the
advantage of being able to work directly in the viewports.

NOTE The default UI does not display this toolbar; to see it, right-click an empty
portion of any toolbar, and choose Layers from the menu.

The Layers toolbar provides the following controls:
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Layer Manager  on page 7441

Layer List  on page 7459

Create New Layer  on page 7460

Add Selection to Current Layer  on page 7461

Select Objects in Current Layer  on page 7461

Set Current Layer to Selection's Layer  on page 7461

See also:

■ Using Layers to Organize a Scene on page 7438

reactor Toolbar

The reactor toolbar provides quick access to many of the objects and commands
for the reactor dynamics toolset. For more information, see reactor on page
3881.

NOTE The default UI does not display this toolbar; to see it, right-click an empty
part of any toolbar, and then choose reactor from the menu. When activated, the
reactor toolbar is docked on the left side of your interface by default.

For more information, see Customize Display Right-Click Menu on page 7687
and Customizing the User Interface on page 7683.
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Extras Toolbar

The Extras toolbar contains several miscellaneous tools for working with your
3ds Max scene.

NOTE The default UI does not display this toolbar; to open it, right-click an empty
portion of any toolbar, and choose Extras from the menu.

AutoGrid  on page 2597

Array Flyout on page 981

Preset Rendering Options on page 6114

Render Shortcuts Toolbar

Right-click the unused (gray) portion of the main toolbar or another toolbar.
> Render Shortcuts

The Render Shortcuts toolbar lets you assign settings to three custom preset
buttons. You can then use these buttons to switch among various render
presets.

7506 | Chapter 25   User Interface



Procedures

To define the presets for a button:

1 Choose one of the default shortcuts from the Presets drop-down list, or
use Load to load the presets from an RPS file.

The Select Preset Categories dialog appears. See Preset Rendering Options
on page 6114.

2 Choose the categories you want, and then click Save.

The preset render settings are now active.

3 Shift+click the button you want to define.

3ds Max assigns the presets to the file that corresponds to the button:
a.rps, b.rps, or c.rps.

To use a saved preset:

1 Click one of the buttons you defined.

The button's name appears in the field above the drop-down list: “a,”
“b,” or “c.”

If the button has not yet been defined, clicking it has no effect, and no
name appears in the preset field.

2  On the main toolbar, click Render.

The scene is rendered using the presets you chose.

Interface

Render Preset Slot A, B, and C Click a button to make its presets active.

If you haven't assigned presets to a button, clicking it has no effect. If presets
are assigned, then after you click the button, its name appears in the field
above the drop-down list: “a,” “b,” or “c.”
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After assignment, each button has its own render preset (RPS) file: a.rps, b.rps,
and c.rps. These are saved in the \renderpresets folder in the 3ds Max root
directory. The active preset status is not saved with the MAX scene, but it is
saved in the 3dsmax.ini on page 83 file.

Render Presets drop-down list Lets you choose from among a set of preset
rendering parameters, or load or save rendering parameter settings. See Preset
Rendering Options on page 6114.

This list is the same as the one that appears at the bottom of the Render Setup
dialog on page 6067.

Snaps Toolbar

Right-click unused area of any toolbar. > Snaps

The Snaps toolbar provides access to the most common Snaps settings.

To toggle display of the Snaps toolbar, right-click an empty area of the main
toolbar, such as the section under the Reference Coordinate System drop-down,
and choose Snaps. For details on the button functions, see Standard Snaps on
page 2666 and Snap Options on page 2671.

Animation Layers Toolbar

Right-click unused area of any toolbar. > Animation Layers

The animation layers toolbar provides quick access to commands related to
the Layer controller, such as enabling, adding, and collapsing layers. Some of
these commands are also accessible through the Layer Controller dialog on
page 3162. For more information, see Animation Layers on page 3164.
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Brush Presets Toolbar

Right-click unused area of any toolbar. > Brush Presets

The Brush Presets toolbar gives you quick access to up to 50 different brush
settings for use with the following paint-oriented tools:

■ Paint Deformation on page 2210 (Edit/Editable Poly)

■ Paint Soft Selection on page 2015 (Edit/Editable Poly)

■ VertexPaint modifier on page 1959

■ Skin modifier on page 1672

You can also use the toolbar to create new presets and to open the Brush Preset
Manager on page 7511, which lets you edit presets, and save and load groups of
presets. The current group of presets is saved when you quit 3ds Max and is
restored the next time you start the program.

NOTE Only one set of presets is available at a time. The Brush Presets feature
stores context-specific features, such as the VertexPaint color, but a given preset
has the same size (or size range) in every context. Other context-independent
settings are Strength and Mirror options (set via the Painter Options dialog on
page 1989.

Procedures

To use the Brush Presets toolbar:

1 Access any of the brush tools listed above.

The tool starts with a default brush.

2 Right-click an empty area on a toolbar, such as the main toolbar below
the Named Selection Sets drop-down list, and choose Brush Presets.
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This opens the Brush Presets toolbar.

3 Do either of the following:

■ Click any of the presets to use it instead of the default brush.

■  Change brush settings and click Add New Preset to add a new
button with the current settings.

4 Paint with the brush.

5 If you change brush settings with a preset brush active, the preset will
remember the changes between sessions. Common setting changes such
as Size will apply to use of the brush with any tool.

6  To change a preset's name, copy it, delete it from the toolbar, or
save or load all brush presets, click Brush Preset Manager on page 7511.

Interface
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The Brush Preset toolbar controls are available only when a brush tool such
as Paint Deformation on page 2210 is active.

 Brush Preset Manager Opens the Brush Preset Manager on page 7511
dialog, which lets you add, duplicate, rename, delete, save, and load brush
presets.

 Add New Preset Adds a new preset with the current brush settings to
the toolbar, first prompting you for a name for the brush. If you attempt to
exceed the maximum number of brush presets (50), a dialog alerts you.

[brush presets] Each preset is available on a button with a grayscale bitmap
showing its shape and relative size. Click a preset to activate it and use its
settings. Each preset contains all settings pertinent to the current tool, such
as Mode for Paint Deformation brushes. You can see a preset name by hovering
the mouse cursor over it; the tooltip that appears shows its name.

To deactivate a preset, click its preset again on the toolbar. Its settings remain
active, but changing the settings no longer modify the preset.

By default, the toolbar contains five brush presets, but you can add up to a
total of 50. To activate and use a preset, click its button on the toolbar. The
program remembers any changes you make to the brush settings while a preset
is active and automatically restores these at the start of the following session.

The button image updates automatically to reflect changes to the size (by
default, up to 40.0) and the falloff, which is depicted as a gradient on the
button image. Set the falloff with the Painter Options dialog on page 1989.

NOTE Changing a value for a setting the preset has in common with other
contexts, such as Size, changes it for all contexts. For example, if you set a preset
brush's size to 11.6, the brush will be that size when used with any other tool.

Brush Preset Manager

Brush Presets toolbar on page 7509 > Activate a brush tool. > Brush Preset
Manager

The Brush Preset Manager lists all brush presets, showing the context-specific
settings and lets you change contexts. It also lets you rename, add, copy, and
delete presets, and set the range for the depiction of brush sizes on the toolbar.
Lastly, it lets you save and load custom collections of brush presets using the
BPR file format.
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The Brush Presets feature recognizes four contexts:

■ VertexPaint modifier on page 1959

■ Paint Deformation on page 2210 (Edit/Editable Poly)

■ Paint Soft Selection on page 2015 (Edit/Editable Poly)

■ Skin modifier on page 1672

Procedures

To use the Brush Preset Manager:

1 Access any of the brush tools listed above.

The tool starts with a default brush.

2 Right-click an empty area on a toolbar, such as the main toolbar below
the Named Selection Sets drop-down list, and choose Brush Presets.

This opens the Brush Presets toolbar.

3  On the toolbar, click Brush Preset Manager.
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Interface

Context Choose the context for the settings in the list window. The Brush
Presets feature recognizes four contexts and shows the current context as
active:

■ VertexPaint (modifier) on page 1959

■ PaintDeform (Paint Deformation; Edit/Editable Poly) on page 2210

■ PaintSoftSel (Paint Soft Selection; Edit/Editable Poly) on page 2015

■ Paint Skin Weights (Skin modifier) on page 1672

Icon Size Min/Max Sets the range of the brush size depicted on the toolbar.
Changing the actual brush size between the minimum and maximum settings
changes the image of the brush as depicted on its button to show its size
relative to the other presets. Changes to the brush size outside these limits are
not reflected on the toolbar buttons.

Add Adds a new preset to the list, using the current brush settings. When you
click Add, you're prompted to enter a name for the new preset. Edit the name
and then click OK to create the new preset. The new preset appears highlighted
at the end of the list and the toolbar.

NOTE If 50 presets already exist, you won't be able to add any new ones.

Duplicate Adds a copy of the highlighted preset to the list. When you click
Duplicate, you're prompted to enter a name for the new preset. Edit the name
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and then click OK to create the new, duplicate preset. The preset appears
highlighted at the end of the list and the toolbar.

NOTE If 50 presets already exist, you won't be able to add any new ones via
duplication.

Delete Deletes the brush preset highlighted in the list from both the list and
the toolbar.

Load Lets you load a saved Preset (BPR) file. Click Load to open the Load
Brush Preset File dialog, click a BPR file to load, and then click Open. The
loaded Preset file replaces the current presets.

Save Lets you save a custom Preset (BPR) file, containing all current brush
presets. Click Save to open the Save Brush Preset File dialog, specify a BPR file
to save, and then click Save. You can then load the Preset file into 3ds Max
at any time.

[presets list] Shows all presets in a scrollable list. Each list entry shows a small
version of the button image, the preset name, ranges for Strength and Size,
Mirror and Mode settings, and other settings depending on the context.

To rename a button preset, double-click its name and then edit or enter a new
one. Other settings are available from the applicable rollout and the Painter
Options dialog on page 1989. For example, you can set the brush strength and
size on the applicable rollout, but to set the range, which is used by a
pressure-sensitive input device such as a pen and tablet, you must use the
Painter Options dialog. Mirror options are also available only from this dialog.

The list shows the following general and contextual information:

■ General (all contexts):

■ Strength (with range)

■ Size (with range)

■ Mirror on/off (with axis and offset, if on)

■ Falloff values (set via the Painter Options graph, displayed as a gradient
in the button image)

■ VertexPaint on page 1959

■ Mode (brush state: Paint, Erase, Blur Brush)

■ Color
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■ Opacity

■ BlurStrength (if Mode=Blur Brush)

■ PaintDeform on page 2210

■ Mode (brush state: Push/Pull, Relax, Revert)

■ Axis (if brush is Push/Pull)

■ Push/Pull Value (if brush is Push/Pull)

■ PaintSoftSel on page 2015

■ Mode (brush state: Paint, Blur, Revert)

■ Selection Value

■ Paint Skin Weights (Skin modifier) on page 1672

■ Mode (Paint, Blend [Paint Blend Weights=on])

Right-Click Menu for Scripted Toolbar Buttons

Any toolbar > Right-click a button that is implemented by a script. > Pop-up
button menu

When you right-click a toolbar button that is implemented by a macro script,
a pop-up menu appears.

Edit Button Appearance Displays the Edit Macro Button dialog, which lets
you change the button's appearance and its tooltip. This is documented in
the MAXScript Reference: see Customizing MacroScript Buttons.

Delete Button Deletes the button from the toolbar.
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NOTE There is no Undo for Delete Button, although Customize > Revert To Startup
Layout will restore the toolbar to its original appearance.

Edit Macro Script Opens a MAXScript Editor window, which lets you edit
the button's script.

Customize Opens the Toolbars panel on page 7700 of the Customize User
Interface dialog, which lets you customize the contents of the current toolbar
(or any other toolbar).

Quad Menu
When you click the right mouse button anywhere in an active viewport, except
on the viewport label (see Viewport Right-Click Menu on page 7576), a quad
menu is displayed at the location of the mouse cursor. The quad menu can
display up to four quadrant areas with various commands. These commands
can be customized on the Quads panel on page 7704 of the Customize User
Interface dialog on page 7697.

The quad menu allows you to find and activate most commands without
having to travel back and forth between the viewport and rollouts on the
command panel.

The two right quadrants of the default quad menu display generic commands,
which are shared between all objects. The two left quadrants contain
context-specific commands, such as mesh tools and light commands. Each of
these menus provides convenient access to functions found in the command
panel. You can also repeat your last quad menu command by clicking the title
of the quadrant.

The quad menu contents depend on what is selected, as well as any
customization options you may have selected in the Quads panel of the
Customize UI dialog. The menus are set up to display only the commands
that are available for the current selection; therefore, selecting different types
of objects displays different commands in the quadrants. Consequently, if no
object is selected, all of the object-specific commands will be hidden. If all of
the commands for one quadrant are hidden, the quadrant will not be displayed.

Cascading menus display submenus in the same manner as a right-click menu.
The menu item that contains submenus is highlighted when expanded. The
submenus are highlighted when you move the mouse cursor over them.
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Some of the selections in the quad menu have a small icon next to them in
the quad menu. Clicking this icon opens a dialog where you can set parameters
for the command.

To close the menu, right-click anywhere on the screen or move the mouse
cursor away from the menu and click the left mouse button. To reselect the
last selected command, click in the title of the quadrant of the last menu item.
The last menu item selected is highlighted when the quadrant is displayed.

Additional, specialized quad menus become available when you are working
in ActiveShade on page 6102, the Edit UVWs dialog on page 1859, or when you
press any combination of Shift, Ctrl, or Alt while right-clicking in any standard
viewport. For more information, see Additional Quad Menus on page 7520.

Interface

The following are the default commands for the right-click menu. You can
add, edit, or remove any of these commands in the Quads panel on page 7704
of the Customize User Interface dialog.
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Default quad menu for an editable poly object at the
Vertex sub-object level

Transform quadrant

These options are available from the Transform quadrant:

Move Lets you move objects. This is the same as clicking Select And Move on
page 959 on the main toolbar.

You can open the Transform Type-In on page 944 by clicking the icon to the
right of Move on this menu.

Rotate Lets you rotate objects. This is the same as clicking Select And Rotate
on page 960 on the main toolbar.

You can open the Transform Type-In on page 944 by clicking the icon to the
right of Rotate on this menu.
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Scale Lets you scale objects. This is the same as clicking Select And Scale on
page 963 on the main toolbar. If one of the other Select And Scale flyout on
page 962 buttons is active on the maintoolbar, that tool becomes active when
you click Scale on the quad menu.

You can open the Transform Type-In on page 944 by clicking the icon to the
right of Scale on this menu.

Select Lets you select objects.

Select Similar Automatically selects objects similar to the current selection.
See Select Similar on page 250

Clone Lets you clone objects. This is the same as choosing Clone on page 1034
from the Edit menu.

Object Properties Opens the Object Properties dialog on page 305 for a selected
object. This command is available only if an object is selected when you open
the quad menu.

Curve Editor Opens and displays the selected object at the top of the Track
View Hierarchy. This command is visible only if an object is selected when
you open the quad menu.

Dope Sheet Opens and displays the Dope Sheet on page 3519.

Wire Parameters Starts a wire parameter on page 3322 from the selected object.
This command is available only if an object is selected when you open the
quad menu.

Convert To This submenu lets you convert the selected object to an editable
mesh on page 2075, an editable patch on page 2019, an editable spline on page
659, a NURBS surface on page 2275, or an editable poly on page 2123. This command
is available only if an object is selected when you open the quad menu.

Display quadrant

These options are available from the Display quadrant:

Viewport Lighting and Shadows This submenu provides commands for
displaying shadows and accurate lighting in viewports. See Previewing Shadows
in Viewports on page 4991.

Isolate Selection The Isolate Selection tool on page 219 lets you edit your
selection while hiding the rest of the scene.

TIP You can use this iteratively to delve into a large selection set.
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Isolate Selection's Layer Isolates the layer of the selected object.

Unfreeze All Unfreezes all frozen objects.

Freeze Selection Freezes the selected objects. Frozen objects are visible in the
viewports, but cannot be manipulated.

Freeze Selection's Layer Freezes the layer of the selected object.

Unhide by Name Displays a version of the Select From Scene dialog on page
228 you can use to choose objects from a list to unhide.

NOTE You cannot unhide an object on a hidden layer. If you select and object
on a hidden layer, a dialog will prompt you to unhide the layer first.

Unhide All Unhides all hidden objects.

Hide Unselected Hides all visible objects that are not selected. Hidden objects
still exist in the scene, but do not appear in the viewports or in rendered
images.

Hide Selection Hides the selected objects.

Hide Selection's Layer Hides the layer of the selected object.

Save Scene State Opens the Save Scene State dialog where you enter a name
for the current scene and select the options you want saved with the scene.

Manage Scene States Opens the Manage Scene States dialog. This is a modeless
dialog where you can select, save, restore, rename, and delete scene states. See
Manage Scene States Dialog on page 7402.

Tools quadrants

The two quadrants on the left side of the default quad menu are called Tools
1 and Tools 2. These quadrants contain commands specific to various
geometries and modifiers such as: lights, editable geometries, and cameras.
These quadrants appear only if one of the corresponding geometries or
modifiers is selected when you open the quad menu.

Additional Quad Menus

Several specialized quad menus are available when you are working in certain
modes, such as ActiveShade on page 6102, Edit UVWs on page 1859, Track View
on page 3503, or when you press any combination of Shift, Ctrl, or Alt while
right-clicking any standard viewport.
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The ActiveShade quad menu provides many useful commands such as Render,
Draw Region, Update, as well as access to the Material Editor on page 5284.
Similarly, the Unwrap UVW quad menu contains many common UVW
commands.

You can create or edit any of these menus from the quad set list in the Quads
panel on page 7704, on the Customize User Interface dialog; however, they
cannot be deleted.

These are the additional quad menus and their default settings:

Biped Appears when you right-click any selected biped on page 4147 part. The
two left-hand quadrants, Tools 1 and Tools 2, provide quick access to many
commonly used biped tools, including Track Selection rollout commands and
Layers rollout commands.

ActiveShade Appears when you right-click an ActiveShade viewport or window
on page 6102. This menu provides quick access to many of the commonly used
actions in ActiveShade, including Draw Region, Initialize, and Update, as well
as access to the Material Editor.

Unwrap UVW Appears when you right-click an Edit UVWs dialog. This menu
provides quick access to many of the commonly used UVW actions.

Track View Key Appears when you right-click any Track View dialog. This
menu provides quick access to common key actions, such as Move, Add, Scale,
and Reduce Keys.

Shift+right-click Provides access to snap options and settings. See Grid and
Snap Settings dialog on page 2662.

Alt+right-click Provides several animation tools, letting you set the coordinate
system, set and assume skin poses, and set key frames.

Ctrl+right-click Provides several modeling tools that let you create and edit
many geometries, including standard primitives and editable geometries.

Shift+Alt+right-click Contains many reactor commands. For more information,
see reactor on page 3881.

Shift+Ctrl+right-click Available for assignment. Use the Quads panel to
customize it.

Ctrl+Alt+right-click Provides several lighting and rendering commands. The
default actions let you render your scene, access render effects and
environmental effects, and toggle object properties for the current selection.

Shift+Ctrl+Alt+right-click Available for assignment. Use the Customize menu
> Customize User Interface > Quads panel to customize this menu.
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There is also a Track View quad menu on page 3569 that appears only while you
are using Track View.

Animation Quad Menu

Alt+right-click a viewport. > Animation quad menu

The Alt+right-click quad menu has commands to assist in animation.

See also:

■ Additional Keyboard Commands on page 7465

Interface

Coordinates quadrant

Lets you change the active reference coordinate system on page 967.

Set quadrant

Keyframe Sets a key at the current frame. Set Key or Auto Key do not need to
be on.

Show Trajectories Toggle Toggles the display of trajectories on page 3121.
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Reaction Manager Opens the Reaction Manager dialog on page 3228.

Delete Selected Animation Deletes any existing animation keys for all selected
objects, as well as any sub-object animation. Each object remains in its state
at the frame in which you use this command.

Pose quadrant

Set Pref Angles For a hierarchy with history-independent (HI) IK applied to
it, sets the preferred angle for each bone in the chain.

Assume Pref Angles For a hierarchy with history-independent (HI) IK applied
to it, copies the X, Y, and Z preferred angle channels of each bone and places
them into its FK rotation subcontroller.

Set as Skin Pose Stores the selected objects' current position, rotation, and
scale as the skin pose. See Skin Pose Commands on page 304.

Assume Skin Pose Causes the selected objects to take on the stored skin pose.
See Skin Pose Commands on page 304.

Transform quadrant

Commands in this quadrant are meant primarily as aids to character animation.
Use the Freeze commands to set the character's initial pose. Then you can
later use the “to Zero” options to return to that initial pose.

Freeze Transform Sets the object's transform values to zero without actually
moving the object.

Freeze Rotation Sets the object's rotation value to zero without actually
moving the object.

Transform to Zero Transforms the object back to the zero pose established
by Freeze Transform.

Transform To Zero works only if you have previously invoked Freeze Transform
or Freeze Rotation.

NOTE There is also a Position To Zero command, which returns the object to the
zero position only (no rotation). You can use Position To Zero by creating a
keyboard shortcut for it. See Additional Keyboard Commands on page 7465.

Rotation to Zero Transforms the object back to the zero rotation established
by Freeze Rotation.

Rotation To Zero works only if you have previously invoked Freeze Transform
or Freeze Rotation.
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Status Bar Controls
The 3ds Max window contains an area at the bottom for prompt and status
information about your scene and the active command. There is a coordinate
display area in which you can type transform values, and on the left, a two-line
interface to the MAXScript Listener.

See also

Animation and Time Controls on page 7548

Viewport Navigation on page 7585

Time Slider and Track Bar

Time Slider on page 7528

Show Curves Click to display a version of the Track View Curve Editor
on page 3518 in place of the time slider and track bar.

When curves are displayed, you can click the Close button at upper left to
return to a view of the time slider and track bar.

Track Bar on page 7531

Status Bar

MAXScript Mini Listener on page 7525

Status Line  on page 7528

Selection Lock Toggle  on page 7539

Relative/Absolute Transform Type-In on page 944
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Coordinate Display on page 7541

Grid Setting Display  on page 7543

Prompt Line  on page 7525

Time Tag on page 7544

Prompt Line

Status bar > Prompt line

The prompt line, located at the bottom of the window under the status line,
provides ongoing feedback, based on the current cursor position and the
current program activity. When you don’t know what to do next, look down
here for instructions.

Depending on what you are doing, the prompt line displays instructions that
tell you what the program expects or what you can do next. For example,
when you click the Move button, the prompt line reads "Click and drag to
select and move objects."

Tooltips are also displayed on the prompt line as your cursor passes over icons
in any toolbar and the status bar.

MAXScript Mini Listener

Click the tag bar, to the left of the status and prompt lines, and drag it to the
right to display the MAXScript Mini Listener.

The MAXScript Mini Listener is a single-line view of the contents of the
MAXScript Listener window on page 7677.

The MAXScript Listener window is divided into two panes: one pink, and one
white. The pink pane is the MacroRecorder pane. When the MacroRecorder
is enabled, everything that is recorded is displayed in the pink pane. The pink
line in the Mini Listener shows the latest entry into the MacroRecorder pane.

The white pane is the Scripter window where you can create scripts. The last
line you type in the white area of the Listener will appear in the white are of
the Mini Listener. Use the arrow keys to scroll the display in the Mini Listener.
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You can type directly into the white area of the Mini Listener, and the
command executes in the viewports.

Right-click either of the Mini Listener lines to open the floating MAXScript
Listener window. It will also display a list of the last 20 commands recorded.
You can choose any of these commands and press Enter to execute them.

For more information about the MAXScript Listener window, as well as about
creating scripts, see the MAXScript Reference: choose Help > MAXScript
Reference.

Procedures

Example: To create a sphere using the Mini Listener:

1 Click the tag bar at the left end of the status bar, and drag it to the right
to expand the Mini Listener.

2 In the Scripter (white, lower) line, type sphere radius: 50 and press Enter.

A sphere appears in the viewports.

Example: To redo a command using the Mini Listener:

1 Click the tag bar at the left side of the status bar, and drag it to the right
to expand the Mini Listener.

2 Right-click the Mini Listener and choose Open Listener Window.

3 From the MacroRecorder menu, choose Enable.

4 Using the command panel, create a sphere in the perspective viewport.

5 Convert the sphere to an Editable Mesh.

6 Delete the sphere.

7 Make a box.

8 Right-click the MacroRecorder (pink, upper) line and choose macros.run
"Modifier Stack" "Convert_to_Mesh" from the list. The box has been collapsed
to an editable mesh.

Example: To make a script and add it to a toolbar:

For this very simple example, you’ll make a script that collapses an object to
an editable mesh, and then create a toolbar icon to run the script.

1 Right-click the Mini Listener, and choose Open Listener Window.
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2 From the MacroRecorder menu, choose Enable. Close the listener window.

3 Create a box in the Perspective viewport.

4 Right-click the box and choose Convert to: > Editable Mesh from the
quad menu.

5 Left-click in the MacroRecorder line.

The MacroRecorder line goes blank because the cursor goes to the last
line.

6 Press the upper-arrow key on the keyboard to move up the list of recorded
command scripts.

7 Click and highlight the macros.run "Modifier Stack" "Convert_to_Mesh" line.

Highlight the command script as you would highlight a line of text in a
text editor by clicking at the start of the line and dragging along the entire
length.

8 Click and drag the highlighted script from the Mini Listener to a toolbar.

Interface

MacroRecorder Line The pink, upper line displays the last thing recorded by
the MacroRecorder. If the MacroRecorder is not enabled, nothing will appear
in this line.

Scripter Line The white, lower line displays the last entry typed into the
Scripter window. You can type directly into this line and execute the
commands in the viewports

History List Right-clicking either of the Mini Listener lines displays a history
of the last twenty commands recorded by the Macro Recorder (provided it has
been enabled). Click any of these commands to execute them in the viewports.

Open Listener Window Right-clicking either of the Mini Listener lines displays
a dialog that allows you to open the MAXScript Listener window. You can
also open the Listener using the Utilities panel > MAXScript rollout. You can
display the Listener window in a viewport by right-clicking the viewport label,
then choosing Views > Extended > MAXScript Listener.
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Status Line

Status bar > Status line

The status line displays the number and type of object or objects selected. The
status line is located at the bottom of the screen, just above the prompt line
on page 7525.

If multiple objects are selected and all are of the same type, the number and
type of the objects are displayed: "2 cameras, 3 lights" for example. If multiple
objects of different types are selected, the status line displays the number plus
the word "objects": "6 objects" for example.

Time Slider

Status line > Time Slider

The time slider shows the current frame and lets you move to any frame in
the active time segment on page 7898. Right-clicking the slider bar opens the
Create Key dialog on page 3093, which lets you create position, rotation, or scale
keys without using the Auto Key button.

When you are in Auto Key on page 7549 mode, you can right-click and drag the
time slider to create a key that has the source at the initial time slider position,
and the destination at the subsequent time slider position.

In Set Key mode on page 7552, holding down the right mouse button and
dragging the time slider allows you to move a pose in time without losing it
in the viewport.

To move one frame back or forward, click the arrow on the left or right side
of the time slider, respectively. Or simply place your cursor anywhere on the
time line, click and the time slider will jump to your cursor position. In Key
Mode on page 7564, clicking an arrow jumps to the adjacent key.

The Track View Key window displays a time slider as well. The movement of
the two time slider is synchronized. Moving the time slider in the Track View
window also moves the time slider below the viewports, and vice-versa.
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Procedures

To move to a specific frame in the animation, do one of the following:

1 Drag (scrub) the time slider right or left until the frame number is
displayed on the time slider.

2  Type the frame number into the current
frame field in the time controls, and then press Enter.

To move ahead or back a frame or a key at a time, do one of the following:

By default, Key Mode on page 7564 is off, and these controls move a frame at a
time. To move by keys, click the Key Mode Toggle button; this turns on Key
Mode. When Key Mode is on, the button looks like this:

1 Click the < or > button at either end of the time slider.

2 Press the < or > key on the keyboard.

3  When Key Mode is off, click the Next Frame or Previous Frame
button in the time controls.

4  When Key Mode is on, click the Next Key or Previous Key
button in the time controls.

To move ahead or back many frames at a time:

■ Click in the empty track to either side of the time slider. The time slider
will jump to your cursor position. This is a faster way of moving in time
than dragging the time slider.

To move to the first or last frame of the active time segment:

■  Use the time control buttons Go To Start or Go To End.
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To display SMPTE time code on the time slider:

■  Click Time Configuration in the time controls, and then under Time
Display, choose SMPTE.

To display subframes on the time slider:

■  Click Time Configuration in the time controls, and then under Time
Display choose Frames:TICKS or MM:SS:TICKS.
Each frame is divided into subframes.

To use the time slider to adjust animation, do one of the following:

1 To copy a pose from one frame to another, with Auto Key on or off, and
Set Key off, right-click the time slider and drag to a new location.

The Create Key dialog appears with Source Time set to the frame you
were on when you right-clicked, and Destination Time set to the frame
to which you moved the time slider. Toggle the Position, Rotation, and
Scale check boxes as necessary and then click OK to create a key at the
destination frame for the pose at the source frame.

2 In Set Key mode, if you have posed your character on the wrong frame,
right-click and drag the time slider. The pose is moved in time to the new
time slider position. Click the Set Key button to set the keys.

To scrub the animation with the mouse but without dragging:

1 Go to Customize > Customize User Interface. On the Keyboard panel,
click in the Action list and then press T to jump to the T section. Scroll
down to find Time Slider Capture Toggle and click it.

2 Click the Hotkey field and then press a keyboard combination to assign
as a keyboard shortcut; for instance, Ctrl+T. Click the Assign button.

3 Close the Customize User Interface dialog and then press your hotkey
for Time Slider Capture Toggle.

4 Move the mouse left and right without pressing any buttons.

The time slider moves in tandem with the mouse.

5 To exit this mode, press the hotkey again or click any mouse button.
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Interface

By default, the active time segment is from frame 0 to frame 100. The slider
displays time in frames, SMPTE numbers on page 8131, or other measurements,
depending on the current setting in the Time Configuration dialog on page
7565.

The slider bar displays the current frame, followed by a slash (/), followed by
the total frames in the active time segment. For example 25/100 means frame
25 of 100 frames. The current frame also appears in the current frame field.
If animation on page 7907 exists in the scene, it's played back as you drag the
time slider.

The buttons on either side of the time slider bar move one frame to the left
and one frame to the right, like the Previous Frame and Next Frame buttons
in the time controls. If Key Mode  on page 7564 is on, these buttons duplicate
the Previous Key and Next Key buttons.

Key Mode can jump to all the keys or only the transform keys, depending on
the Key steps setting in the Time Configuration dialog.

TIP Right-click the slider bar to open the Create Key dialog. This lets you create
Position, Rotation, or Scale keys without using the Auto Key button. It also lets
you copy keys easily from one frame to another.

Track Bar

The track bar is located below the viewports, between the time slider and the
status bar.

The track bar provides a timeline showing the frame numbers (or appropriate
display units). It provides a quick alternative to Track View for moving,
copying, and deleting keys, and changing key properties. Select an object to
view its animation keys on the track bar. The track bar also displays keys for
multiple selected objects.
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The displayed keys use color coding, so you can easily determine what kind
of key exists at that frame. Position, rotation and scale keys are red, green,
and blue, respectively, and non-transformational keys such as modifier
parameters are gray. You can customize the colors in the Customize User
Interface dialog on page 7697, and depends on the selected/unselected state of
the key. The frame indicator is a similar bar displayed in blue.

A key on the track bar can represent any number of animated parameters for
the selected objects. Transformations, modifiers, and animated material
parameters can all have keys at a particular frame.

To display a list of all keyed values for a key on the track bar, right-click the
key. Choose a key type from the right-click menu to display its key properties
dialog. Delete keys and filter the track bar display using options on the
right-click menu.

The track bar right-click menu contains a submenu that lists any procedural
controllers (list controllers, expression, reactors, springs, noise, and so on)
assigned to the current object selection. If you select one of the controllers
from the submenu, the properties dialog for that controller displays in a
modeless dialog.

The track bar can display a waveform (.wav file) that has already been assigned
to the sound object in Track View. To display this feature, right-click the track
bar and choose Configure > Show Sound Track. If no waveform is currently
assigned to the sound object or if you are using a third-party sound object
plug-in that is not compatible with the waveform display, this part of the
track bar is unavailable.

You can modify the active time segment on page 7898 by pressing Ctrl and Alt
while dragging the track bar. Hold the left mouse button to slide the start of
the range, the right mouse button to slide the end of the range, and the middle
mouse button to change both the start and end frames together. A tooltip at
the cursor and a status bar message will indicate the range you are setting.

NOTE While the Auto Key button is depressed, the time slider background is
highlighted red, to indicate that 3ds Max is in automatic keyframing mode.

 You can expand the track bar to show curves. Click the Open Mini-Curve
Editor button at the left end of the track bar. The time slider and track bar are
replaced with the controller and key windows, and Track View toolbars. You
can resize the track bar window by dragging the border between the menu
bar and the toolbars (do this in an empty toolbar area).
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Track bar displaying curves

Procedures

To select keys on the track bar:

1 Click a key to select it.

2 Drag a window around a selection of keys to region-select multiple keys.

If the track bar right-click menu > Configure > Show Selection Range
option is on, when you select multiple keys, the range of the selected
keys is shown in the selection range bar at the bottom of the track bar.
You can then scale the selected keys proportionally by dragging either
end of the selection range bar, or move the keys by dragging the center
of the bar.

To move or clone keys on the track bar:

While keys are moved or cloned, small lines on the track bar mark the original
position of the keys. All keys at a particular frame are moved simultaneously
using the following procedures.

1 Drag a key selection to move it in time.
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2 Hold down Shift, then drag a key(s) to clone keys.

3 Right-click to abort a move or clone operation.

To move a single key from a frame with multiple keys:

If, for example, a frame has both a transform key and a material key for the
selected object, and only the transform key must move, display the Transform
Properties dialog and use the Time parameter to move the transform key.

1 Right-click a key on the track bar and choose a key on the pop-up window
key list.

A Key Properties dialog is displayed.

2 Change the Time parameter in the Key Properties dialog.

The key slides along the track bar to a new location.

To delete keys on the track bar:

1 Make a key selection on the track bar and press Delete.

All selected keys are deleted.

2 Make a key selection on the track bar, right-click anywhere on the track
bar to display the track bar menu, and then choose Delete Selected Keys
on the pop-up window.

All selected keys are deleted.

To delete a single key type on a frame with multiple keys:

An object can have many keys for different animated parameters at a particular
frame. Use this procedure to delete a key for a single parameter.

1 Right-click over a selected or unselected key on the track bar.

A pop-up window displays.

2 Move the mouse over Delete Key, then choose a key to delete in the
submenu.
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To change the length of the active time segment:

You can change the animation length using track bar.

■ Hold Ctrl+Alt and drag on the track bar:

■ With the left mouse button to change the active time segment's start frame.

■ With the right mouse button to change the active time segment end frame.

■ With the center mouse button to change the active time segment start and
end frames simultaneously.

To hide or show the track bar:

■ Choose Customize > Show UI > Show Track Bar.
This menu item is a toggle: a check mark shows that the track bar is
currently displayed.

To show curves on the track bar:

■  Click the Open Mini Curve Editor button at the left hand side of the
track bar.
The track bar keys are replaced with a menu bar, toolbars and the controller
and key windows.

Interface

Track Bar

■ Make an object selection in the viewports to display the object’s keys on
the track bar.
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■ Selected transformation keys are white; unselected keys are other colors.

■ Drag from an empty area of the track bar to region-select keys.

■ Drag a key to move it in time.

■ Hold Shift and drag a key to clone it.

■ Hold Ctrl+Alt and drag the track bar to change the active time segment,
that is, the animation range displayed on the track bar.
Dragging with the left mouse button will change the start of the range,
dragging with the right mouse button will change the end of the range,
and dragging with the middle mouse button will change both the start
and the end of the range.

■ Right-click to abort a move or clone operation.

■ During a move or clone operation, short, vertical, gray lines represent the
original key locations.

■ The cursor changes to a cross when over unselected keys.

■ The cursor changes to a two-sided arrow over selected keys, signifying a
move operation is possible.

■ Right-click anywhere on the track bar to display the track bar right-click
menu. Right-click over a key to access its keyed values from the right-click
menu, as well as other track bar-related commands.

■  Click the Open Mini Curve Editor button to expand the track bar.
When the track bar is expanded it displays the Track View menu, toolbars,
controller and key windows. You can hide or unhide UI Elements such as
scroll bars as well when this is expanded.

Track bar menu

Right-click a key on the track bar to display the track bar menu.
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List Displays the object name and key type for all keys at the current position.
Choose any of the keys in the list at the top of the track bar menu to display
a key properties dialog. For more information on this dialog, see Key Info
(Basic) on page 3127 and Key Info (Advanced) on page 3131.

■ A key with a check next to the name indicates the key is shared with other
instances in the list. Two selected objects might share the same Twist
modifier, for example.

■ The list displays keys for all selected objects. If there are more than 10 keys,
then the list turns to a submenu under Key Properties in the track bar
menu.

■ If there is no key properties dialog for a key type, the key is unavailable.

Controller Properties Displays a submenu that contains a list of all of the
procedural controllers (list controllers, expression controllers, reactors, springs,
noise, and so on) assigned to the object selection.

Delete Key Displays a submenu identical to the key properties list at the top
of the track bar menu. Choose a key type or choose All to delete one or all of
the keys.

All Deletes all keys at the current position.

Keys do not need to be selected on the track bar in order to use Delete Key.
Keys are deleted from the track bar key over which you right-clicked.

Delete selected keys Deletes the keys selected on the track bar. If no keys are
selected, this option is unavailable.
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Filter

Filter Displays a Filter submenu. Choose a filter to filter the track bar display;
showing only transformation keys, for example.

Right-click anywhere on the track bar, place the cursor over Filter in the track
bar menu to display the Filter submenu, then choose filter settings. The settings
determine which keys appear on the track bar.

The upper section of the Filter submenu lets you choose one of the following:

■ All Keys Displays all keys.

■ All Transform Keys Displays only keys for position, rotation and scale.

■ Current Transform Displays only keys that use the currently selected
transform: position, rotation or scale.

■ Object Displays object modifier keys. Excludes transformation and
material keys.

■ Material Displays material keys for the material assigned to the selected
objects.

The lower section of the Filter submenu lets you toggle each of the following,
for any combination of these filter options:

Keyable Tracks Only Controls the display of keyable tracks on the track bar.

Parameter Collector Keys Filters keys related to the Parameter Collector on
page 347.

List Controller – Active Only This filter lets you see only the keys on the
active control in a List Controller. Otherwise, you see all the keys on all the
controls.

List Controller – Hide Weights This filter hides the weight parameter keys
of a List Controller from the track bar.
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Layer Controller – Active Only This filter lets you see only the keys of the
active Layer controller on page 3164. Otherwise, you see all the keys of all Layer
controllers.

Layer Controller – Hide Weights This filter hides the weight parameter keys
of a Layer controller on page 3164 from the track bar.

Configure

Configure Displays a submenu that lets you change the track bar display and
behavior.

The Configure options are:

■ Show Frame Numbers Displays frame numbers in the track bar.

■ Show Selection Range Displays a selection range bar below the track bar,
whenever multiple keys are selected.
You can scale all selected keys by dragging either end of the selection range.
This lets you change the length of an animation segment while maintaining
the relative distance between animation keys. You can also move the
selected keys in time by dragging the selection range bar.

■ Show Sound Track Displays the waveform (.wav file) that is assigned to
the sound object in Track View.

■ Snap to Frames Keys snap to frame numbers when moved. If turned off,
you can place keys between frames.

Go to Time Moves the time slider to the cursor position.

Right-click anywhere on the track bar, and then click Go To Time.

Selection Lock Toggle 

Status bar > Selection Lock Toggle

Keyboard > SPACEBAR
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Selection Lock Toggle toggles selection locking on and off. Lock selections so
you don’t inadvertently select something else in a complex scene.

When your selection is locked, you can drag the mouse anywhere on screen
without losing your selection. The cursor displays the current selection icon.
When you want to deselect or alter your selection, click Lock Selection again
to turn off locked selection mode.

When you want to select something and you can’t, it's frequently because
you have locked your selection.

This button is off by default.

 Click to turn it on (it turns yellow). When Lock Selection is on, you can
click anywhere in a viewport and the program interprets it as clicking the
selected object(s). This is useful when you want to keep objects selected while
you make a different viewport active or when the selection is tiny, or crowded
and difficult to select.

Procedures

To transform an object without touching it:

1 Use the Selection Floater from the Tools menu, the Select By Name button
on the main toolbar or press the H key to select the object by name.

2 Click the transform button (move, rotate, or scale) from the main toolbar.

3  On the status bar, turn on the Selection Lock toggle or press the
Spacebar to lock the selection set.

4 Press and drag anywhere in the viewport.

The object transforms even though you are not touching it.

To avoid accidentally canceling a selection:

1 Make your object selection.

2 Click the Selection Lock toggle on the status line, or press Spacebar to
turn on Locked Selection mode.

To exit sub-object selection mode, do one of the following:

1 In the Modifier Stack display, choose the object level.
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2 Open another command panel. This turns off Sub-Object selection.

If you've turned off Sub-Object selection and object selection is still not
restored, one of the following may be true:

3 Your selection is locked. Turn off the Selection Lock toggle on the status
line.

4 You've set the Selection Filter in the toolbar to a specific category of
object, so you can't select any of the other categories. To fix this, choose
All in the Selection Filter list.

Coordinate Display

Status bar > Coordinate Display area

The Coordinate Display area shows the position of the cursor or the status of
a transform, and allows entry of new transform values.

The information in these fields varies, depending on what you are doing:

■ When you are simply moving the mouse in a viewport, these fields show
the current cursor location in absolute world coordinates on page 8174.

■ While you are creating an object, these fields also show the current cursor
location in absolute world coordinates.

■ While you are transforming an object by dragging in a viewport, these
fields always show coordinates relative to the object's coordinates before
the transformation was started.
While you are transforming an object, these fields change to spinners on
page 73, and you can type values directly in them, as described below in
“Using the Coordinate Display for Transform Type-In.” This is an easy
alternative to using the Transform Type-In dialog on page 944.

■ While a transform button is active and a single object is selected, but you
are not dragging the object, these fields show the absolute coordinates for
the current transform. See “Interface,” below.

■ While a transform button is active and multiple objects are selected, these
fields are blank.
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■ When no object is selected and the cursor is not over the active viewport,
these fields are blank.

See also:

■ Units Setup Dialog on page 7809

Procedures

To display the position of the mouse in feet or metric units:

1 Choose Customize > Units Setup.

2 Turn on one of the main categories (Metric, US Standard, Custom, or
Generic Units) and choose from the drop-down list.

The coordinate display is now in labeled units.

Example: To positioin an object in the center of the world:

1 Select an object in the viewport.

2 Right-click and choose Move from the quad menu

3 Select the value in the x coordinate field, then enter 0. Press Tab.

4 Type 0 in the Y coordinate field, and press Tab.

5 Type 0 in the Z coordinate field.

TIP Right-clicking the spinner arrows for a coordinate sets the value to zero.

Interface

When you are transforming an object, you can type coordinates directly in
the Coordinate Display fields. You can do this in two modes, Absolute or
Offset.

■  Absolute sets the exact coordinates of the object in world space.
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■  Offset transforms the object relative to its existing coordinates.

Click the Absolute or Offset button to toggle between the modes:

While you are typing in the Coordinate Display fields (X,Y,Z), you can use
the Tab key to move from one coordinate field to another.

When you transform an object, the information shown by these fields depends
on the type of transform:

■ Move displays the offset XYZ coordinates based on the current coordinate
system. For example, if you're moving an object and you're constrained to
the X axis, only the X readout will change, displaying the offset of the
move along the local X axis.

■ Rotate displays the offset angle in degrees about the axis or axes the
rotation is performed around. This is dependent on both the axis coordinate
system, and the local/center toggle button.

■ Scale displays the offset XYZ scale in percentages.

You can get the absolute as well as offset information through the Transform
Type-In dialog on page 944 available from the Tools menu or by right-clicking
a transform button that has been selected on the toolbar.

Grid Setting Display

Status bar > Grid Setting Display

The grid setting display shows the size of one grid square.

This value is constant in the active viewport. It does not change if you zoom
in very close or zoom out very far.

Procedures

To change the size of one grid square:

1 Right-click the Snap Toggle on the main toolbar to display the Grid and
Snap Settings dialog. Alternately, you can choose Customize menu > Grid
and Snap Settings.
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2 On the Home Grid tab, in the Grid Dimensions group, change the Grid
Spacing value.

The new value is displayed in the grid setting display.

3 Close the dialog by clicking the X at the upper right corner of the Grid
and Snap Setting dialog.

Time Tag

Status bar > Add Time Tag

Time tags are text labels that you can assign to any point in time in your
animation.

They let you easily jump to any point in your animation by selecting its tag
name. The tags can be locked to be relative to other time tags so that the
movement of one time tag will update the time position of another.

The time tags are not attached to keyframes. They are simply a way to name
events that occur in your animation and navigate to them. If you move your
keyframes, you will need to update your time tags accordingly.

Interface

Left-click or right-click the Time Tag box to display a menu with the following
items:

Add Tag Displays the Add Time Tag dialog on page 7544 that lets you define a
tag name for the current location in time.

Edit Tag Displays the Edit Time Tag dialog on page 7546 that lets you rename,
delete, or edit any defined tag.

The remainder of the menu displays frame numbers and their tag names.
Choose a tag name to jump to the spot in time defined by the tag.

Add Time Tag Dialog 

Status bar > Click in the Time Tag box. > Add Tag
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Use the Add Time Tag dialog to define a time tag on page 7544 for the current
spot in time.

Procedures

To use time tags:

1 Move to the spot in time where you want to add a tag.

2 Click in the Time Tag box, and choose Add Tag from the menu.

3 In the Add Time Tag dialog, enter the name of the tag. Choose whether
to lock it to time and whether to make it relative to another tag, and click
OK.

The name of the tag appears in the tag slot, and will reappear whenever
you go to that spot in time.

To jump to a defined tag, click the Time Tag slot and choose the tag name
from the list.

To rename, delete, or change the properties of a tag, click the Time Tag
field and choose Edit Tag on page 7546.

Interface

Tag Time Displays the current frame, to which the tag will be assigned.

Tag Name Enter the name of the tag. You can create a long tag name in this
field, but the tag slot will display only 15 characters.
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Lock Time Locks the tag to the current frame, regardless of subsequent scaling
of time.

For example, with Lock Time off, if you have a tag named "Forty" at frame 40,
and you scale time up 200 percent, the Forty tag will be at frame 80. If Lock
Time is on, the Forty tag remains at frame 40.

Relative To Lets you assign another tag to which the current tag will maintain
a relative offset.

For example, if you have a tag at frame 10 called First and you create a second
tag at frame 30 called Second, if you move the position of First to frame 25,
Second will move to frame 45 to maintain the 20-frame offset between the
two tags.

This is a one-way offset. If you change the time position of the second tag in
the example, the first tag is not affected. Circular dependencies are not allowed:
you can't have First relative to Second and Second relative to First.

Edit Time Tag Dialog 

Status bar > Click in the Time Tag box > Edit Tag

Use the Edit Time Tag dialog to alter the properties of any of the defined time
tags on page 7544.

Procedures

To edit a time tag:

1 Click in the Time Tag box and choose Edit Tag from the menu.

2 Choose the time tag you want to edit from the list.

3 Use controls in the Edit Time Tag dialog to rename it, or move it in time
relative to another time tag.
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Interface

All of the current tags, along with their associated frame numbers, appear in
the window at the top of the Edit Time dialog. Select the tag to edit, then
adjust the controls below the window.

Tag Name Use this field to rename the selected tag. You can create a long tag
name in this field, but the tag slot will display only 15 characters.

Time Lets you change the time where the tag is assigned.

Lock Time Locks the tag to the current frame, regardless of subsequent scaling
of time. For example, with Lock Time off, if you have a tag named Forty at
frame 40, and you scale time up 200 percent, the Forty tag will be at frame
80. If Lock Time is on, the Forty tag remains at frame 40.
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Relative To Lets you assign another tag to which the current tag will maintain
a relative offset. For example, if you have a tag at frame 10 called First and
you create a second tag at frame 30 called Second, if you move the position
of First to frame 25, Second will be moved to frame 45 to maintain the 20-frame
offset between the two tags.

This is a one-way offset. If you changed the time position of the second tag
in the previous example, the first tag is not affected. In addition, circular
dependencies are not allowed. You can't have First relative to Second and
Second relative to First.

Delete Tag Deletes the selected tag.

Animation and Time Controls
Between the status bar and the viewport navigation controls are the animation
controls, along with the time controls for animation playback within viewports.

Animation Controls

Auto Key Animation Mode  on page 7549 and Set Key
Animation Mode on page 7552

Default In/Out Tangents For New Keys on page 7557

Go To Start  on page 7560

Previous Frame/Key  on page 7560

Play/Stop  on page 7561
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Next Frame/Key  on page 7563

Go To End  on page 7563

Current Frame (Go To Frame)  on page 7563

Time Controls

Key Mode  on page 7564

Time Configuration  on page 7565

Auto Key Animation Mode 

Status bar > Time controls > Auto Key (Toggle Auto Key Mode)

Keyboard > N

The Auto Key button turns the keyframing mode on page 8020 called Auto Key
on or off. All movement, rotation, and scale changes are keyframed while the
Auto key button is on. When it's off, these changes are applied to frame 0.

You can also keyframe by using Set Key mode on page 7552, which allows you
to selectively add keyframes using the Set Keys button.

The Auto Key button is red when it’s on. The active viewport is also outlined
in red when the Auto Key mode is on; the time slider turns red as well. This
serves to remind you that you are in Animate mode, and that you are setting
keyframes with your actions.

WARNING Be sure to turn off Auto Key after keyframing, or you will inadvertently
create unwanted animation. Use Undo to remove the unwanted animation. Be
careful; it’s easy to forget.
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Within an existing animation, you can create keyframes for transforms without
the use of the Auto Key button by right-clicking the time slider and then
setting the source and destination time. For example, you can use this function
to copy an existing Move key to a later frame, so an object pauses its motion
momentarily (to keep the object still, you must use linear or step interpolation).
You can also set keyframes for other animatable parameters in Track View and
the Motion panel without using Auto Key.

See also:

■ Using Auto Key Mode   on page 3083

■ Set Key Animation on page 7552

■ Using Set Key Mode  on page 3086

Procedures

To animate an object using Auto Key:

1  Turn on the Auto Key button.

The Auto Key button, the time slider, and the highlight border around
the active viewport all turn red.

2 Drag the time slider to a time other than 0.

3 Do one of the following:

■ Move, scale, or rotate an object.

■ Change an animatable parameter.

For example, assume you start with a cylinder that has not been animated
yet and therefore has no keys. You turn on Auto Key, go to frame 20, and
rotate the cylinder 90 degrees about its Y axis. This action creates rotation
keys at frames 0 and 20. The key at frame 0 stores the original orientation
of the cylinder, while the key at frame 20 stores the animated rotation
of 90 degrees. When you play the animation in the viewport, the cylinder
rotates 90 degrees about its Y axis over 20 frames.

4  Turn off the Auto Key button when you are done.
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Example: To animate an object between three points using Auto Key:

1  Turn on the Auto Key button.

2 Drag the time slider (to frame 25, for example).

3 Move the object from point A to point B.

A Move key is created at frames 0 and 25. The establishing key at frame
0 describes the object's position at point A. The key at frame 25 describes
the object's position at point B.

4 Drag the time slider (to frame 50, for example).

5 Move the object from point B to point C.

A Move key is created at frame 50 that describes the object's position at
point C.

6  Click the Playback button.

The object moves from point A to point B over frames 0 to 25, then
proceeds to point C over frames 26 to 50.

7  The Playback button turns into a Stop button. Click it to stop
playback.

The position of the object in between the keyframes is determined by
the interpolation type used by the controller. Right-click the keys in the
track bar and select the transform key to see the controls for adjusting
the timing of the in-betweens.

8  Turn off the Auto Key button.

To remove the animation from a scene and start again:

1 Choose File menu > New.

If the scene has been modified, you are asked if you want to save it. After
you make that decision, a New Scene dialog is displayed.

2 In the New Scene dialog, turn on Keep Objects And Hierarchy and click
OK.

All the objects remain in the scene but all keyframes have been removed.
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3 To remove the animation from just certain objects, delete their keys in
Track View.

Example: To animate a deformation curve of a loft object:

1  Turn on the Auto Key button.

2 Set a current frame with the time slider.

3 Select one or more control points in the deformation curve of a loft object.

4 Use the Move Control Point or Scale Control Point buttons to transform
the control points.

To animate a hierarchy with IK interactively:

1 Select any hierarchy that does not already have an IK Solver applied.

2 Click IK on the Hierarchy panel.

3  Turn on the Auto Key button.

4 On the Inverse Kinematics rollout, turn on Interactive IK.

5 Select and move objects in the IK structure on different frames.

NOTE This will work on linked hierarchies and bones that do not already
have an HI, HD, or Limb Solver applied. This technique allows you to animate
hierarchies using IK methods on page 3374 without applying any IK solver on
page 3382.

Set Key Animation Mode

Set Key Animation mode allows you to create keys for selected objects
individual tracks using a combination of the Set Keys button and Key Filters.
Unlike the traditional method of 3ds Max animation, Set Key mode gives you
control over what you key and when. It allows you to pose a character (or
transform any object) and then if you like it, use that pose to create keys. If
you move to another point in time without keying, your pose is discarded. It
also works with object parameters.
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You can try out different values and then when you have what you like use
it to create keys. Combine this with keyable tracks in the Curve Editor to create
keys on just the object parameters you want to key.

Set Key Workflow

To animate something using Set Key mode, you first turn on Set Key Mode.
You can then select the object you want to animate and use the Key Filters
button to set which tracks you want to keyframe. You can also use Show
Keyable icons in Track View edit windows to make individual tracks keyable
or not. With all this setup work completed, you can create keys by clicking
the Set Key button (the large button with the key icon) or using Keyboard
shortcut (K). Move ahead in time, then make changes to your character or
object (transforms or parameter changes) and click Set Keys to use those
changes to create keys.

If you do not click the Set Keys button and move to another frame the object
changes will be lost, as if you had never made them. This is fundamentally
different behavior from Auto Key mode, where you would need to use undo
to lose the changes you made. Use the right mouse button on the time slider
to drag a pose or transform to a different point in time.

For faster workflow you can define keyboard shortcuts for the Key Filters and
Show Keyable tools by going to Customize menu > Customize User Interface
and assigning keystroke combinations in the Main UI group.

Procedures

To animate using Set Key mode:

1  Turn on Set Key mode.

2 Select the objects you want to keyframe, and then right-click and choose
Curve Editor.

3  On the Track View toolbar, click Show Keyable Icons, then use the
keyable icons in the controller window to define which tracks will be
keyed.

 A red key means the track will be keyed. Click a key to toggle keyable
status.
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4  Click Key Filters and then turn on the tracks you want
to keyframe. By default, Position Rotation, Scale, and IK Parameters are
on. For this example, turn off Rotation and Scale.

5 Go to a frame at which you want to set a key.

6 Move an object.

7  Click the Set Keys button.

 The Set Key button flashes red to show that it has set a key, and a
key appears on the track bar.

Repeat this process, moving the time slider and setting keys.

To keyframe all parameters using Set Key mode:

1  Turn on Set Key mode.

2 In the viewport, select the objects to which you want to add keyframes.

3  Click Key Filters and then turn on the Key All.

4 Move the time slider to the frame where you wish to set keys

5  Click the Set Keys button.

Keys will be added to all keyable parameters.

To move a pose or position in time without update:

1 Turn on Set Key.

2 Move to a particular frame (let's say frame 20).

3 Pose your character or position your object(s).

4 Move your cursor over the time slider, then press the right mouse button
down and drag.

The time slider moves, but the position does not change. The pose or
position is maintained and transferred to the new point in time.
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5 When you are at the appropriate frame, set the pose or position keys by
clicking Set Keys.

Interface

 Set Key Toggles Set Key mode.

 Set Keys Click this to set a key. This button will create a key on tracks
for the selection set. It checks that the tracks are keyable, and that Key filters
allow the tracks to be keyed. If both these are satisfied, a key is set. Set Keys
also sets keys in Auto Key mode, and in Layout mode (the mode when neither
Auto Key nor Set Key is turned on). Keyboard shortcut default for this
command is K.

 Key Filters Displays the Set Key Filters dialog where you can
define which type of tracks will be allowed or disallowed keys.

Selection List Gives quick access to named selection sets on page 239 and track
sets on page 3672 while working with Set Key. Lets you easily swap among
different selection sets and track sets.

NOTE Choosing a selection set from the list does not select objects in the
viewports. To accomplish this, use the Named Selection Sets on page 239 feature.

NOTE Selection set names appear between braces (example: {Biped Arms}) while
track set names appear between square brackets (example: [Throw Baseball]).

Set Key Filters dialog Turn on the tracks you want to key. Default=Position,
Rotation, Scale and IK Parameters.
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The following options are available:

■ All  allows for a quick way to key all tracks. When All is turned on, the
other toggles are unavailable. Clicking Set Keys with the All filter turned
on will result in a key placed on all keyable tracks.

■ Position  allows for position keys to be created.

■ Rotation  allows for rotation keys to be created.

■ Scale  allows scale keys to be created.

■ IK Parameters  allows inverse kinematic parameters to be keyframed.

■ Object Parameters  allows object parameters to be keyframed.

■ Custom Attributes  allows custom attributes to be keyframed.

■ Modifiers  allows modifiers to be keyframed. Note that you should turn
on Object parameters when you turn on modifiers, so you can keyframe
gizmos.

■ Materials  allows material properties to be keyframed.

■ Other allows for other parameters that don't fall in the above categories
to be keyframed using the Set Key technique. This includes such things as
helper properties and look-at controller tracks for target cameras and lights.
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WARNING If you turn on Object Parameters, all the object parameters of an object
will then receive keys, unless you have turned off the tracks using Keyable on the
Controller menu of Track View – Curve Editor. The same advice applies to Materials.

TIP You can also set keys on spinners by holding down the Shift key and
right-clicking a spinner.

Default In/Out Tangents For New Keys

Status bar > Animation controls > Default In/Out Tangents For New Keys
flyout

This flyout provides a quick way to set a default tangent type on page 3129 for
new animation keys created with Set Key Mode on page 7552 or Auto Key Mode
on page 7549. You can also access the tangent types on page 3129 from the Key
Info (Basic) rollout on page 3127 and the Curve Editor's Key Tangency toolbar
on page 3572.

NOTE Changing tangent types does not affect existing keyframes, only new ones.

On each new set keyframe, the Key Tangent flyouts on the Key Info (Basic)
rollout updates with the current default tangent type.

When you set a default tangent type, both the in and out tangents are set to
match that type. If you set different in and out tangents via the Controller
Defaults group of the Animation Preferences panel on page 7772, the current
flyout icon changes to a question mark.

NOTE Setting a default tangent type stores it in the 3dsmax.ini on page 83 file,
from which it is restored after a scene reset or session change.
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See also:

■ Specifying Default Controllers on page 3110

Procedures

Example: To set a default tangent type:

1 Create a sphere.

2  Turn on Auto Key, go to frame 10, and move the sphere on
all three axes.

3 Right-click the sphere. From the quad menu, choose Curve Editor.

The position curve with Flat
tangent.

4 Choose the Linear tangent type (second icon from the top) from the
Default In/Out Tangents For New Keys flyout.
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5 Go to frame 20 and move the sphere elsewhere in your scene.

The curve starts curvy at frame 10 but straightens out near frame 20. Its
interpolation transitions from an Flat out tangent to a Linear in tangent.

The position curve going from Flat to Linear tangents

6 Go to frame 30 and move the sphere again.

The curve interpolation from frame 20 to 30 is straight because both keys
have tangents set to Linear.
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The position curve going from Flat to Linear to Linear tangents

Go To Start 

Status bar > Time controls > Go To Start

Keyboard > Home

Go To Start moves the time slider to the first frame of the active time segment
on page 7898. The active time segment is set in the Start Time and End Time
fields of the Time Configuration dialog on page 7565.

Previous Frame/Key 

Status bar > Time controls > Previous Frame

Keyboard > , (comma)

Previous Frame moves the time slider on page 7528 back one frame.

 If Key Mode on page 7564 is on, the time slider moves to the previous
keyframe on page 8020. Keyframe options are set in the Key Steps group of the
Time Configuration dialog on page 7565.
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If Time Configuration dialog > Use TrackBar is on, Previous Key jumps to the
previous key of any kind. If Use TrackBar is off, Previous Key jumps to the
previous transform key, ignoring any other type of keys.

Play/Stop 

Status bar > Time controls > Play

Status bar > Time controls > Stop

Keyboard > /(to play); Esc (to stop)

The Play button plays the animation in the active viewport. If you click another
viewport to make it active, the animation continues playing in that viewport.
When the animation is playing, the Play button becomes a Stop button. The
Play button is a flyout for playing only the animation of selected objects.

TIP You can play the animation in all the viewports simultaneously by turning off
Active Viewport Only in the Time Configuration dialog on page 7565.

Procedures

To play the animation in the viewport:

1 Activate the viewport where you want to play the animation.

2  Click the Play button.

The animation plays in the viewport. The Play button becomes a Stop
button.

3  Click Stop to end the playback.

The speed of the animation playback is determined by the settings in the
Time Configuration dialog, the complexity of the scene and the speed
of the graphics card and processor.

To play the animation looped backward:

1  Click the Time Configuration button on the status bar.
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2 In Time Configuration dialog > Playback group, turn off Real Time.

The Direction buttons are now available.

3 Turn on Reverse and click OK.

4  Click the Play button.

The animation plays backward.

5 To play the animation front-to-back and then back-to-front in a
continuous loop, turn on Ping-Pong as the Direction.

To play the animation of a selected object only:

1 In a viewport, select a single animated object or a set of animated objects.

2  Click Play Selected on the Play/Stop flyout.

Only the selection is animated in the viewport.

3 To end playback, click the Stop button or press Esc.

Interface

The Play/Stop flyout contains two buttons. Both buttons become a Stop button
when in use.

 Play Plays the animation in the currently active viewport.

 Play Selected Plays the animation for selected objects only in the
currently active viewport.

 Stop Animation Replaces the Play button when an animation is playing.
Click to stop the playback.

 Stop Animation (Selected) Replaces the Play Selected button when
an animation is playing. Click to stop the playback.
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Next Frame/Key 

Status bar > Time controls > Next Frame

Keyboard > .  (period)

Next Frame moves the time slider on page 7528 ahead one frame.

 If Key Mode on page 7564 is on, the time slider moves to the next keyframe
on page 8020. Keyframe options are set in the Key Steps group of the Time
Configuration dialog on page 7565.

If Time Configuration dialog > Use TrackBar is on, Next Key jumps to the next
key of any kind. If Use TrackBar is off, Next Key jumps to the next transform
key, ignoring any other type of keys.

Go To End 

Status bar > Time controls > Go To End

Keyboard > END

Go To End moves the time slider on page 7528 to the last frame of the active
time segment on page 7898. The active time segment is set in the Start Time and
End Time fields of the Time Configuration dialog on page 7565.

Current Frame (Go To Frame) 

Status bar > Time controls > Current Frame (and Go To Frame)

Current Frame displays the current frame number, indicating the position of
the time slider on page 7528. You can also enter a frame number in this field to
go to that frame.

Procedures

To move to a particular frame, do one of the following:

1 To go to the specified frame, type the frame number and press Enter.
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2 Move the time slider and observe the frame number updating on the
time slider.

3 To change the value in the frame number field, click or drag the spinner.

Key Mode 

Status bar > Time controls > Key Mode

Key Mode lets you jump directly between keyframes on page 8020 in your
animation. By default, Key Mode uses the keys visible in the track bar below
the time slider. Other options are available on the Time Configuration dialog
on page 7565 in the Key Steps group.

When the Auto Key button on and you change an object’s creation parameters
or performed a transform on page 8157, or change a material or modifier applied
to that object, the software automatically creates a keyframe.

Key Mode can respect all keyframes, or you can restrict it to move only to
transform keys via the Key Steps options on the Time Configuration dialog.
When Key Steps > Use TrackBar is on, Key Mode jumps to keyframes of any
type. When Use TrackBar is off, Key Mode respects only transform keys.

Procedures

To use Key Mode:

1  Turn on Key Mode.

 The button turns blue when key mode is active.

2  Use the Previous Key on page 7560 and Next Key on page 7563
buttons to move from one keyframe to the next.

If you are not jumping to the keys, be sure the object is selected in the
viewport.

If you are still not jumping to the keys, configure Key Mode to Use
TrackBar, as described in the following procedure.
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To configure Key Mode:

1  Click Time Configuration, or right-click any animation-control
button, including Key Mode.

The Time Configuration dialog opens.

2 Choose options in the Key Steps group.

If you turn on Use TrackBar and turn Key Mode on, then clicking Next
Key advances to the next key for the selected object. This will respect
every type of key that appears in the track bar. If you turn Use TrackBar
off, only transform keys are used by key mode.

Time Configuration 

Status bar > Time controls > Time Configuration > Time Configuration dialog

The Time Configuration dialog provides settings for frame rate, time display,
playback, and animation on page 7907. You use this dialog to change the length
of your animation, or stretch or rescale it. You also use it to set the start and
end frames of the active time segment on page 7898 and your animation.

See also:

■ Setting Time Segments on page 3097

Procedures

To define the active time segment:

1  Click Time Configuration.

2 In the Time Configuration dialog > Animation group, set Start Time to
specify the beginning of your active time segment.

3 Do one of the following:

■ Set End Time to specify the end of your active time segment.

■ Set Length to specify the amount of time in the active time segment
and automatically set the correct End Time.
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You can enter positive or negative values in any spinner, but you must
use the same format used by the time display.

You can change the active time segment without affecting the keys
you've created. For example, if you have keys scattered over a range
of 1000 frames, you can narrow your active time segment to work on
only frames 150 to 300. You can only work on the 150 frames in the
active segment, but the remainder of the animation stays intact.
Returning the active segment from 0 to 1000 restores access and
playback of all the keys.

Changing the active time segment has the following effects: it restricts
the range of time you can use with the time slider, and it restricts the
range of time displayed when using the animation playback buttons.

The default setting for the active time segment runs from frames 0 to
100, but you can set it to any range.

To stretch out your existing animation over a longer time:

1 In the Time Configuration dialog > Animation group, click Re-scale Time.

2 Change the value in Length to be the number of frames you want the
action to fill.

3 Click OK.

The animation is rescaled to the new number of frames.

This also works to compress animations into a shorter space of time. To
avoid losing frames during the rescaling, see “To use sub-frame animation”
in this set of procedures.

To add frames onto your existing animation:

This procedure adds new frames to the end of your animation, without
affecting your existing work.

1 In the Time Configuration dialog > Animation group > End Time field,
enter the number of the last frame of the animation.

For example, if your existing animation is 100 frames long and you want
to add 50 frames, enter 150.

2 Click OK.

The number you entered is now the new length of the animation, shown
on the time slider.
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To move to an exact time in your animation:

■ In the Time Configuration dialog > Animation group, enter the frame
number in the Current Time field, and press Enter.
The viewport updates to this frame.

To set the frame rate of your animation:

In the Time Configuration dialog > Frame Rate group, do one of the following:

1 Choose one of the standard frame rates such as PAL or NTSC.

2 Choose Custom, and specify a frame rate in the FPS (frames-per-second)
field.

To configure viewport playback:

■ In the Time Configuration > Playback group, turn on or off the Real Time
and Active Viewport Only boxes.

To play your animation in reverse or back and forth:

1 In the Time Configuration > Playback group, turn off the Real Time.

2 Choose the direction of the animation playback by selecting Forward,
Reverse, or Ping-Pong.

3 Play the animation in the viewport using the Play button or the / key.

To play your animation only once:

1 In the Time Configuration > Playback group, turn off Loop.

2 Choose the direction of the animation playback by selecting Forward,
Reverse or Ping-Pong.

3 Play the animation in the viewport using the Play button or the / key.

The animation will play once and stop.

To play your animation in multiple viewports:

1 In the Time Configuration > Playback group, turn off Active Viewport
Only. Click OK.

2 Play your animation.

The animation now plays in all four viewports.
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To use sub-frame animation:

1 In the Time Configuration > Time Display group, turn on FRAME:TICKS
or MM:SS:TICKS. Click OK.

2 Move the time slider to set keyframes in between keys.

TIP Use this when you scale an animation down from a longer length to
insure that you won’t lose any keys. You can then move the keys to frames
and revert to frames without ticks.

To play an animation with sound:

■ In the Time Configuration > Playback group, be sure you have Real Time
turned on. If Real Time is not on, the sound will not play back during the
animation.

Interface

These are the controls for the Time Configuration dialog. You can display this
dialog by right-clicking any of the time control buttons to the right of the
Auto Key button.
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Frame Rate group

These four option buttons, labeled NTSC on page 8059, Film, PAL on page 8078,
and Custom let you set the frame rate on page 7987 in frames-per-second (FPS).
The first three buttons force the standard FPS for that choice. The Custom
button lets you specify your own FPS by adjusting the spinner.

FPS (Frames Per Second) Sets the frame rate of your animation in Frames per
Second. Use frame rates of 30 fps for video, 24 for film, and lower rates for
web and media animations.
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Time Display group

Specifies the method for displaying time in the time slider and throughout
the program. Choices are Frames or in minutes, seconds and ticks.

Specifies the method for displaying time in the time slider and throughout
the program (in frames, in SMPTE, in frames and ticks on page 8147, or in
minutes, seconds, and ticks).

For example, if the time slider is at frame 35, and the Frame Rate is set to 30
fps, the time slider would display the following numbers for the different Time
Display settings:

■ Frames: 35

■ SMPTE: 0:1:5

■ FRAME: TICKS: 35:0

■ MM:SS: TICKS: 0:1:800

SMPTE is the Society of Motion Picture Technical Engineers standard used to measure
time for video and television production.

Playback group

Real Time Real Time on page 8104 causes viewport playback to skip frames to
keep up with the current Frame Rate setting. A choice of five playback speeds
is available: 1x is normal speed, 1/2x is half speed, and so on. The speed settings
affect only the playback in the viewports.

These speed settings can also be used with the Motion Capture utility on page
3798.

When Real Time is off, viewport playback occurs as rapidly as possible and
displays all frames.

Active Viewport Only Causes playback to occur only in the active viewport.
When off, all viewports display animation.

Loop Controls whether the animation playback occurs only once, or
repeatedly. When on, playback repeats until you stop it by clicking an
animation control button or the time slider channel. When off, the animation
plays once and then stops. Clicking Play rewinds to the first frame and plays
again.

Direction Set the animation to play forward, reverse, or ping-pong (forward
and then reverse, repeating). This affects only the playback in the interactive
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renderer. It does not apply when rendering to any image output file. These
options are available only when Real Time is off.

You can recall these settings automatically upon startup or reset by saving a
maxstart.max file. See Startup Files and Defaults on page 82.

Animation group

Start Time/End Time Sets the active time segment on page 7898 displayed in
the time slider. Choose any time segment before or after frame 0. For example,
you can set an active time segment from -50 to 250.

Length Displays the number of frames in the active time segment. If you
make this greater than the total frames in the active segment, the End Time
field increases accordingly.

Frame Count The number of frames that will render. Always the length plus
one.

Current Time Specifies the current frame for the time slider. As you adjust
this, the time slider moves accordingly and the viewport updates.

Re-scale Time Stretches or shrinks the animation for the active time segment
to fit into the new time segment you specify. Relocates the position of all keys
on page 8020 in all tracks. As a result, the animation plays over a greater or lesser
number of frames, making it faster or slower.

Key Steps group

Controls in this group let you configure the method used when you turn on
Key Mode on page 7564.

Use TrackBar Allows key mode to honor all keys in the track bar. This includes
any parameter animation in addition to transform keys.

To make the following controls available, turn off Use TrackBar.

Selected Objects Only Considers only the transforms on page 8157 of selected
objects when you use Key Steps mode. If you turn this off, the transforms of
all (unhidden) objects in the scene are considered. Default=on.

Use Current Transform Disables Position, Rotation, and Scale and uses the
current transform in Key Mode. For example, if the Rotate button is selected
in the toolbar, you stop at each rotation key. If none of the three transform
buttons are on, Key Mode considers all transforms.

To make the following control available, turn off Use Current Transform.

Position, Rotation, Scale Specifies which transforms are used by Key Mode.
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Clear Use Current Transform to make the Position, Rotation, and Scale check
boxes available.

Viewport Controls
You can choose different views to display in these four viewports as well as
different layouts from the viewport right-click menu on page 7576.

See also:

■ Viewport Configuration on page 7817

■ Viewport Right-Click Menu on page 7576

Viewport Layouts

You can choose from other layouts different from the default configuration.
To choose a different layout, right-click the viewport label and choose
Configure. Click the Layout tab of the Viewport Configuration dialog to see
and choose the alternative layouts.

Typical viewport layout

NOTE The viewport layout is saved with your MAX file.
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TIP You can change the default viewport layout by saving a maxstart.max file with
the desired viewport configuration and placing it in the \defaults folder on page
7694.

Active Viewport Borders

When four viewports are visible, one viewport, marked with a highlighted
border, is always active. This is where commands and other actions take effect.
Only one viewport at a time can be active. Other viewports are for observation
only; unless disabled, they simultaneously track actions taken in the active
viewport. When Auto Key or Set Key is on, the active viewport border changes
from yellow to red.

In general, a viewport becomes active as you work in it. You can move an
object in one viewport, and then drag the same object in another viewport
to continue the move. To activate a viewport without changing the selection,
right-click it. If you left-click a viewport, the viewport is activated and whatever
you click is selected, or, if you click an empty area, everything is deselected.
You can restore previous selections with Undo.

Viewport Labels

Viewports are labeled in the upper-left corner. You can control many aspects
of a viewport by right-clicking the viewport label to display the viewport
right-click menu on page 7576.

Dynamic Resizing of Viewports

You can resize the four viewports so they are of unequal proportions. To do
so, drag the intersection of two, three, or four viewports, on the splitter bars.
To return to the original layout, right-click an intersection of the dividing
lines and choose Reset Layout from the right-click menu.

The new viewport proportions are saved in the scene. However, changing the
viewport layout on page 7824 always resets them.

World-Space Tripod
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The three-color world-space tripod is visible in the lower-left corner of each
viewport. The colors correspond to the three axes of world space: red=X,
green=Y, and blue=Z. The axes are labeled in these same colors. The tripod
always refers to world space, regardless of the current reference coordinate
system.

The world-space tripod is on by default. To turn off this feature, see “To turn
off the world-space tripod in all viewports” in the following procedures.

Viewport Tooltips for Object Names

When you’re working with objects in a viewport and pause the cursor over
any unselected object, a tooltip appears with the name of that object. If you
need to select something or link to something, wait until you see the tooltip
to be sure you have selected the object you want. These tooltips are disabled
when you work in sub-object mode.

Tooltips on page 7744 are on by default. To turn off this feature, see To turn off
object name tooltips on page ?, below.

See also:

■ Viewport Navigation on page 7585

■ The 3ds Max Window on page 67

Procedures

To make a viewport active, do one of the following:

1 Click any viewport.

If you click an object in the viewport, it is selected. If you click a space
where there are no objects, any selected objects are deselected.

2 Right-click any viewport.

Right-click activates a viewport without changing the selection state of
objects. (You can also do this by left-clicking the viewport label.)

To switch between single and multiple viewports:

Activate the viewport you want to minimize or maximize, and do one of the
following:

1 On the keyboard, press the W key.
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2 On the keyboard, press Alt+W.

3  Click the Maximize Viewport Toggle button in the lower-right
corner of the 3ds Max window.

To resize the viewports:

1 Drag the intersection of two, three, or four viewports to move the
horizontal and vertical splitter bars.

2 Move the intersection to any new location.

If you don't drag a corner, you can move the borders horizontally or
vertically only.

3 To reset the viewports, right-click an intersection and choose Reset Layout
from the right-click menu.

To change the number of viewports and their arrangement:

1 Right-click any viewport label. Choose Configure from the right-click
menu.

2 On the Viewport Configuration dialog, click the Layout tab.

3 Choose a layout from the choices at the top of the dialog.

4 Assign what each viewport will display in the lower window of the dialog
by right-clicking a viewport representation and choosing from the
right-click menu.

5 Click OK to make the change.

To turn off the world-space tripod in all viewports:

1 Choose Customize menu > Preferences to display the Preferences dialog.

2 Click the Viewports tab.

3 In the Viewport Parameters group, turn off Display World Axis.

4 Click OK to make the change.

To turn off object-name tooltips:

1 Choose Customize menu > Preferences to display the Preferences dialog.
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2 Click the General tab.

3 In the UI Display group, turn off Enable Viewport Tooltips.

4 Click OK to make the change.

Viewport Right-Click Menu

Right-click any viewport label. > Viewport right-click menu

The viewport right-click menu, also referred to as the Viewport Properties
menu, contains commands that let you change what is shown in the active
viewport. This is a shortcut menu. Some of the options are also available on
the Configuration dialog on page 7817.

The functions available on this menu include:

■ Change the view to any available viewport type (for example, Perspective,
Top, Bottom, User, Light, Camera, Grid, or Shape).
When your scene contains cameras or lights with targets, the viewport
right-click menu gives you selection options for the components. For
example, when you right-click the label of a target camera viewport, you
see two new commands, Select Camera and Select Camera Target, that let
you select the camera or target used by that view.

■ Set the type of shading displayed in the viewport (for example, Wireframe,
Smooth, or Edged Faces).

■ Set how transparency is displayed in the viewport.

■ Undo or redo a view change.

■ Enable texture correction if your display is not configured for OpenGL or
Direct3D.

■ Disable a viewport so it doesn’t update when you work in other viewports.

■ Toggle the display of the grids, safe frame, and viewport background.

NOTE A grid object must be active before you can select it from its viewport.

■ Display the Asset Browser, Schematic View or MAXScript Listener in a
viewport.
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■ Turn on Viewport Clipping. This interactively sets a near and far range for
the viewport. Geometry within the viewport clipping range is displayed.
Faces outside the range are not displayed.

TIP If the viewport right-click menu becomes disabled, you can restore it by
refreshing the UI scheme. Use Customize menu > Load Custom UI Scheme on
page 7724 to load a different CUI file, then reload the original CUI file again. The
right-click viewport menu will become available after either the new or original
UI scheme is loaded.

Procedures

To toggle display of the home grid in the active viewport, do one of the
following:

1 Choose Views menu > Grids, and click Show Home Grid.

2 Right-click a viewport label (this activates the viewport and opens a
menu), and then click Show Grid.

3 Press G.

To change a viewport to Camera view:

This procedure requires at least one camera object in your scene. As an
alternative, to create a camera and set it to a viewport at the same time, activate
a Perspective viewport and then press Ctrl+C.

1 Right-click a viewport label.

2 Click Views.

3 Choose one of the cameras in the Views list.

This assigns the camera to the viewport and changes the label to the
camera name.

A camera viewport tracks the view through the perspective of that camera.
As you move the camera (or target) in another viewport, you see the scene
swing accordingly. If you alter the camera's field of view on page 7596, you
see the changes as they are applied.

TIP You can also press C as a shortcut to change any active viewport to an
existing camera view.
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To change a viewport to a shape view:

This procedure requires at least one shape object in your scene.

1 Right-click a viewport label.

2 Choose Views > Shape from the menu.

To use viewport clipping:

1 Right-click a viewport label.

2 Choose Viewport Clipping on page 7818.

The viewport displays the viewport clipping controls.

3 Move the lower slider up until the geometry is clipped in the viewport
by the near clipping plane.

4 Adjust the upper slider to clip the geometry with the far clipping plane.

To display Schematic View in a viewport:

1 Right-click a viewport label to access the Viewport Properties menu.

2 Click Views > Schematic > New, or choose the name of the Schematic
View to display.

To display Track View in a viewport:

1 Right-click a viewport label to access the Viewport Properties menu.

2 Click Views > Track > New, or choose the name of the Schematic View
to display.

To display the Asset Browser or MAXScript Listener in a viewport:

1 Right-click a viewport label and then, from the right-click menu, choose
Views > Extended.

2 From the sub-menu, choose Asset Browser or MAXScript Listener.

The feature you choose is displayed in a dedicated viewport.

To return the viewport to normal usage, right-click the viewport toolbar
and choose the type of viewport.
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To access the Layout panel, do one of the following:

■ Choose Customize menu > Viewport Configuration, then click the Layout
tab.

■ Right-click a viewport label, and choose Configure, then click the Layout
tab.

To turn on safe frame display, do one of the following:

■ Right-click a viewport label, and then choose Show Safe Frame.

■ Press Shift+F.

■ Choose Customize menu > Viewport Configuration > Safe Frames panel,
and turn on Show Safe Frames In Active View.
See Safe Frames on page 7825.

To fix texture display problems in a viewport:

■ Right-click a viewport label, and then choose Texture Correction. This
applies only to the software display driver; OpenGL and Direct3D displays
automatically correct the display of textures.

TIP If you have materials with texture maps that are not displaying in the
viewport, you need to turn on Show Map In Viewport in the Material Editor
for each material that has this problem.

To change quickly between snapping options:

1 With nothing selected, hold Shift and right-click anywhere in the
viewport.

The Snaps shortcut menu is displayed.

2 Choose any of the Standard or NURBS snap options. You can also toggle
whether snaps use transform constraints.
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Interface

Views Displays a secondary menu that allows you to choose another view to
display in the viewport (Front, Top, Back, etc.).

TIP Another method for switching views is the  ViewCube on page 107.

Available views are:

■ Camera views on page 7604 (if the scene contains cameras)

■ Light views on page 7614 (if the scene contains spotlights or directional
lights)

■ Perspective on page 7591

■ Orthographic

■ Front

■ Back

■ Top

■ Bottom

■ Left

■ Right

■ Rendering with ActiveShade on page 6102
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■ Track: Choose an existing Track view on page 3503, if any, from the submenu,
or choose New to create a new one. To change a viewport when it contains
a Track view, right-click the menu bar and choose a different view.

■ Schematic: Choose an existing Schematic view on page 7407, if any, from
the submenu, or choose New to create a new one. To change a viewport
when it contains a Schematic view, right-click the menu bar and choose
a different view.

■ Grid on page 2622: Choose Front, Back, Top, Bottom, Right, Left, or Display
Planes. For details, see Viewing Grid Objects on page 2595.

■ Extended

■ Asset Browser on page 7132

■ Biped AnimationWorkbench on page 4483

■ Motion Mixer on page 3699

■ MAXScript Listener on page 7677

■ HW Standard Material

■ Shape: Automatically aligns view to the extents of a selected shape and its
local XY axes

The fastest way to change the viewport display is with keyboard shortcuts.
Press V to open the Viewports quad menu at the mouse position. You can
then choose from this menu with the mouse or use the first letter of the
viewport label as the keyboard shortcut (F for Front, for example. The exception
is K for back).

NOTE This menu appears at the mouse cursor, but it controls the view for the
active viewport, even if the mouse cursor is over a different viewport.

Smooth+Highlights Displays the smoothness and lighting of objects. You
can also display maps on the surface of objects. See Show Standard/Hardware
Map in Viewport  on page 5350. This happens on a map-by-map basis, but you
can display as many maps as you want simultaneously in the viewport. Maps
display only on objects that have mapping coordinates. Also, Show Map In
Viewport must be turned on for each map individually in the Material Editor,
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or globally using the Views menu > Global Viewport Rendering Setting
commands on page 173.

NOTE This and other shaded viewport options support self-illuminated materials
and 32 lights (depending on display mode and graphics card).

Wireframe Displays objects as edges only, as if they were made from wire.
Wire color is determined by object color (default).

Other Displays a cascading menu of other shading modes. These include:

■ Smooth Displays smoothing, but doesn’t show highlights.

■ Facets+Highlights Displays highlights, but doesn’t show smoothing.

■ Facets Shades faces, but doesn’t display smoothing or highlights.

■ Flat Renders each polygon in its raw, unshaded diffuse color, disregarding
any contribution from ambient lighting or light sources. This rendering
method is useful when it's more important to see each polygon than to
see its shading. It's also a good way to check the results of bitmaps created
with Render to Texture on page 6371.

■ Hidden Line A wireframe mode that hides faces and vertices with normals
on page 8059 pointing away from the viewpoint, as well as any parts of
objects that are obscured by closer objects. In this display mode only, the
wireframe color is determined by the Viewports > Hidden Line Unselected
color, not the object or material color. See Colors Panel on page 7712.

■ Lit Wireframes Displays edges as wireframe, but shows lighting.

■ Bounding Box Displays objects as a bounding box on page 7932 only.

Edged Faces Available only when the current viewport is in a shaded mode.
Displays the wireframe edges of objects along with the shaded surfaces. This
is helpful for when you want to edit meshes in a shaded display.

Edges are displayed using the object wireframe color, while surfaces use material
colors (if assigned). This lets you create contrasting colors between the shaded
surfaces and the wireframe edges. You can switch these assignments on the
Display Color rollout on page 177.

Transparency Sets the quality of transparency display in the selected viewport:

■ Best Highest quality transparency display; longer redraw time.

■ Simple Less accurate transparency display, however viewport redraw is
considerably faster with Simple.
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■ None Transparency is not displayed in the viewport.

NOTE The Transparency setting only affects viewport display, and does not affect
renderings.

Show Grid Turns on and off the display of the home grid. Does not affect
other grid display.

Keyboard > G

Show Background Turns on and off the display of any viewport background
image (or animation). To specify an image, choose Views menu > Viewport
Background.

TIP The keyboard shortcut for the Viewport Background dialog is Alt+B.

Show Safe Frame Turns on and off the display of safe frames on page 8110. You
define the safe frames in the Viewport Configuration dialog (see Configure,
below). The safe frame proportions conform to the Width and Height of the
output size of your rendering image output.

Edit Render Region When on, you can edit a region for restricting the
render to a specific rectangular area within the viewport. Available only when
the Rendered Frame Window > Area To Render on page 6075 drop-down list is
set to Region, Crop, or Blowup. This command is linked directly to the
Rendered Frame Window > Edit Region on page 6075 command. The main
difference is that you can edit the region for Crop or Blowup in the viewport,
but not in the Rendered Frame Window. You can edit the region for Region
in both.

While Edit Render Region is active, the only thing you can do in the viewport
is edit the region. To finish editing the region while keeping the same viewport
active, close the region window by clicking the X button in the upper-right
corner, or turn off the command on the viewport right-click menu.

NOTE Activating a different viewport while editing a render region turns off the
command and remembers the edited region. Also, 3ds Max uses two different
regions: one for Region and Crop, and a separate one for Blowup.

Lock Render to this View When on, 3ds Max always renders the
viewport that was active when you locked the render, even if the active
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viewport changes. You can change which viewport renders by using either of
these methods:

■ Turn off Lock Render To This View and activate a different viewport.

■ Choose a different viewport from the Viewport drop-down list on the
Rendered Frame Window on page 6076 or on the Render Setup dialog on
page 6071.

This toggle is also available from the Rendered Frame Window as the Lock To
Viewport button on page 6077.

Show Statistics Toggles the viewport display of the statistics on page 2577 for
the entire scene and your current selection.

Viewport Clipping Lets you set a near and far visibility range for the viewport
interactively. Geometry within the viewport clipping range is displayed. Faces
outside the range are not displayed. This is useful in complex scenes where
you want to work on details that are obscured from view.

Turning on Viewport Clipping displays two yellow slider arrows on the right
side of the viewport. Adjusting the lower arrow sets the near end of the range,
and the upper arrow sets the far end. Tick marks on the range slider indicate
the extents of the viewport.

You can also toggle Viewport Clipping on the Viewport Configuration dialog
on page 7817.

Texture Correction Redraws the viewport using pixel-interpolation
(perspective corrected).

NOTE This applies only to the software display driver. If you are using the OpenGL
or Direct3D display mode, texture correction is automatic.

Disable View Prevents the viewport from updating with changes made in
other viewports. While the disabled viewport is active, it behaves normally.
However, when you change the scene in another viewport, the view in the
disabled viewport does not change until you activate it. Use this function to
speed up screen redraws when you are working on complex geometry.

While active, the text “/Disabled” is appended to the viewport label.

Keyboard > D

Select Camera/Select Light Selects the camera or light to which the viewport
is set. Available only when the viewport is a camera or light viewport.
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Select Camera Target/Select Light Target Selects the target of the camera or
light to which the viewport is set. Available only when the viewport is a camera
or light viewport.

Undo Undoes the last viewport change.

Redo Cancels the last viewport undo.

Configure Displays the Viewport Configuration dialog on page 7817, which
contains many options for further control of the viewports.

Viewport Navigation

At the right end of the status bar are the buttons that control the display and
navigation of the viewports.

Some of the buttons change for camera and light viewports. The Field Of View
button changes for Perspective viewports.

The state of the navigation-button flyouts for all viewport types is saved in
the [Performance] section of the 3dsmax.ini on page 83 file.

Viewport Navigation Controls

The navigation controls depend on the active viewport. Perspective,
orthographic, camera, and light viewports all have specialized controls. The
term “orthographic” refers to User viewports as well as viewports like Top,
Front, and so on. The Zoom Extents All flyout and Maximize Viewport Toggle,
available in all viewports, are included with the Perspective and orthographic
viewport controls.

Many of these controls are modal on page 8045, meaning they stay on for
repeated use. The buttons highlights when on. To turn them off, press Esc,
right-click in a viewport, or choose another tool.

Controls Available in All Viewports

Zoom Extents All, Zoom Extents All Selected  on page 7588
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Maximize Viewport Toggle  on page 7589

Perspective and Orthographic Viewport Controls

Perspective and Orthographic Viewport Controls on page 7591

Zoom Viewport  on page 7592

Zoom All  on page 7593

Zoom Extents/Zoom Extents Selected on page 7594

Field-of-View Button  on page 7596 (Perspective) or Zoom Region  on page

7599

Pan View  on page 7600

Walk Through on page 135

Orbit, Orbit Selected, Orbit Sub-Object  on page 7602

Camera Viewport Controls

Camera Viewport Controls on page 7604

Dolly Camera, Target, or Both  on page 7605
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Perspective  on page 7607

Roll Camera  on page 7608

Field-of-View Button  on page 7596

Truck Camera  on page 7610

Walk Through on page 135

Orbit/Pan Camera  on page 7611

Light Viewport Controls

Light Viewport Controls on page 7614

Dolly Light, Target, or Both  on page 7616

Light Hotspot  on page 7618

Roll Light  on page 7620

Light Falloff  on page 7622

Truck Light  on page 7624
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Orbit/Pan Light  on page 7626

Controls Available in All Viewports

Zoom Extents All, Zoom Extents All Selected 

Activate any viewport. > Viewport Navigation controls > Zoom Extents All
flyout

Keyboard > Shift+Ctrl+Z

The Zoom Extents All flyout is available in all viewports. The flyout has two
options:

■ Zoom Extents All centers all visible objects in all viewports. This
control is useful when you want to see every object in a scene in every
available viewport.

■  Zoom Extents All Selected centers a selected object, or set of objects,
in all viewports. This control is useful when you want to navigate to small
objects lost in a complex scene.

Procedures

To zoom all objects in a scene:

1 Activate any viewport.

2  Click Zoom Extents All.

The viewports display all objects in the scene.
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To zoom to a specific object:

1 In any viewport, select the object by clicking it, or press H to select it by
name.

2  Click Zoom Extents All Selected.

The viewports display the selected object.

Interface

 Zoom Extents All Centers and magnifies views so all the visible objects
in the scene are shown in all viewports.

 Zoom Extents All Selected Centers and magnifies views so just the
selected objects or sub-object selections in the scene are shown in all viewports.
If no objects are selected, the effect is the same as Zoom Extents All.

Maximize Viewport Toggle 

Activate any viewport. > Viewport navigation controls> Maximize Viewport
Toggle

Keyboard > Alt+W

Maximize Viewport Toggle switches any active viewport between its normal
size and full-screen size.

TIP The keyboard shortcut Alt+W is especially useful for quick toggles.
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Walkthrough Controls for Perspective and
Camera Viewports

Pan/Truck and Walkthrough Flyout

In Perspective and Camera viewports, this flyout offers two separate buttons:

■  Walk Through

■  Pan or Truck

The Walk Through button on page 7590 is one way to turn on walkthrough
navigation on page 135.

The use of the Pan or Truck button depends on which kind of viewport you
are in:

■ Perspective viewports (Pan) on page 7600

■ Camera viewports (Truck Camera) on page 7610

This flyout doesn't appear for orthographic viewports or spotlight viewports.
These viewports don't provide walkthrough navigation.

Walk Through Button 

The Walk Through button is one way to begin walkthrough navigation on
page 135. (The other is to press Up Arrow.) It is available on the Pan/Truck And
Walkthrough flyout on page 7590.

The flyout and button don't appear for orthographic viewports or for spotlight
viewports. These don't provide walkthrough navigation.
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Perspective and Orthographic Viewport Controls

Right-click any viewport label. > Views > Choose a perspective or orthographic
view.

Right-click any viewport label. > Views > Grid > Choose any grid view.

Select a shape. > Right-click any viewport label. > Views > Shape

Keyboard > V (to open the Viewports quad menu), then P (Perspective), U
(User), F (Front), K (Back), T (Top), B (Bottom), L (Left)

Perspective, orthographic, user, grid, and shape viewports all share the same
viewport controls.

Perspective and orthographic viewport controls include the following. Two
of these controls are available in all viewports.

Zoom Viewport  on page 7592

Zoom All  on page 7593

Zoom Extents/Zoom Extents Selected on page 7594 (available in all viewports)

Field-of-View Button  on page 7596

Zoom Region  on page 7599

Pan View  on page 7600

Orbit, Orbit Selected, Orbit Sub-Object  on page 7602

Maximize Viewport Toggle  on page 7589 (available in all viewports)

Procedures

To undo changes to a Perspective or orthographic viewport, do one of the
following:

■ Right-click the viewport label and choose Undo. The type of Undo is
specifically named on the menu (for example, Undo Zoom Extents).

■ Press Shift+Z.
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NOTE This differs from camera and light viewports, which require the use of
the standard Undo function.

Zoom Viewport 

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Zoom

Keyboard > Alt+Z turns on Zoom ; [ zooms in; ] zooms out

Keyboard > Ctrl+Alt+middle mouse button (drag)

Roll your mouse scroll wheel.

When Zoom is active, you can adjust the view magnification by dragging in
a Perspective or orthographic viewport. By default, zooming occurs from the
center of the viewport.

TIP If you use a wheel mouse, you can turn the wheel to zoom the active viewport
in and out without first activating Zoom. The zoom center is the center of the
viewport.

Zooming takes place incrementally, based on the distance between the
viewpoint and its “virtual target,” an inaccessible hidden target used for
calculation purposes only. Use the Ctrl and Alt keys, respectively, to increase
or decrease the increments. You can move the virtual target by holding down
the Shift key during a zoom operation. Otherwise you will zoom increasingly
closer to the target, which does not move.

Procedures

To zoom a view:

1 Activate a Perspective or orthographic viewport.

2  Click Zoom.

The button highlights when it is on.
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3 Drag in a viewport to change magnification:

■ Drag upward to increase magnification.

■ Drag downward to decrease magnification.

4 To exit Zoom mode, press Esc or right-click in a viewport.

To increase zoom speed:

■ Hold down Ctrl as you drag in a viewport.

To decrease zoom speed:

■ Hold down Alt as you drag in a viewport.

To turn on an automatic zoom mode:

■ On the keyboard, hold down Ctrl+Alt, then hold down the middle mouse
button and drag in a viewport. This does not activate the Zoom button.

To zoom from the keyboard:

■ On the keyboard, press [ (left bracket) to zoom in, and ] (right bracket) to
zoom out.

Zoom All 

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Zoom All

Zoom All lets you adjust view magnification in all Perspective and orthographic
viewports at the same time.

By default, Zoom All zooms in and out of the center of the viewports.

Procedures

To zoom all views:

1 Activate a Perspective or orthographic viewport.
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2  Click Zoom All.

The button highlights when it is on.

3 Drag in a viewport to change magnification in all viewports.

■ Drag upward to increase magnification.

■ Drag downward to decrease magnification.

4 Press Esc or right-click to turn off the button.

To zoom all viewports except the Perspective viewport:

1 Click Zoom All.

2 Hold down Shift and drag in a viewport to zoom all the viewports except
the Perspective.

NOTE You can drag in a Perspective viewport, but you only see the zoom
in orthographic viewports.

Zoom Extents/Zoom Extents Selected

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Zoom Extents flyout

The Zoom Extents flyout displays the Zoom Extents button and the Zoom
Extents Selected button.

Zoom Extents centers all visible objects in an active Perspective or
orthographic viewport. This control is useful when you want to see every
object in a scene in a single viewport.
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Zoom Extents Selected centers a selected object, or set of objects, in an
active Perspective and orthographic viewport. This control is useful when you
want to navigate to small objects lost in a complex scene.

Procedures

To zoom all objects in one viewport:

1 Activate the Perspective or orthographic viewport you want to zoom.

2  Click Zoom Extents.

The viewport displays all objects in the scene.

To zoom on a specific object:

1 Activate the Perspective or orthographic viewport you want to zoom.

2 Select the object by clicking it, or press H to select it by name.

3  Click Zoom Extents Selected.

The viewport displays the selected object.

To exclude an object from Zoom Extents:

Use this procedure, for example, to ignore lights that are far away from the
other objects in the scene.

1 Click an object to select it.

2 Right-click the object and choose Properties.

3 In the Display Properties group, make sure properties are set to By Object.

4 Turn on Ignore Extents.

The object will now be excluded by Zoom Extents and Zoom Extents
Selected.
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Interface

 Zoom Extents Centers and magnifies views so all the visible objects in
the scene are shown in a single viewport.

Objects can be excluded from zoom extents all if the Ignore Extents box is
turned on under Object Properties.

 Zoom Extents Selected Centers and magnifies views so just the selected
objects or sub-object selections in the scene are shown in a single viewport.
If no objects are selected, the effect is the same as Zoom Extents.

Field of View Flyout 

Activate Perspective viewport. > Status bar > Viewport controls > Field of View
flyout

The Field of View flyout is available only for Perspective viewports. The flyout
has two options:

■ Field of View (FOV) on page 7596: Adjusts the amount of the scene
that is visible in a viewport and the amount of perspective flare.

■ Zoom Region on page 7599: Magnifies a rectangular area you drag
within a viewport.

Field-of-View Button 

Activate a Camera viewport. > Viewport controls > Field-of-View

Activate a Perspective viewport. > Viewport controls > Field-of-View (on
Field-of-View flyout)
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Field-of-View (FOV) adjusts the amount of the scene that is visible in a viewport
and the amount of perspective flare. The effect of changing FOV is similar to
changing the lens on a camera:

■ As the FOV gets larger, you see more of your scene and the perspective
becomes distorted, similar to using a wide-angle lens.

■ As the FOV gets smaller, you see less of your scene and the perspective
flattens, similar to using a telephoto lens.

Above: Narrow field of view

Below: Wide field of view

Although the effect of Field-of-View appears similar to a zoom, the perspective
is actually changing, resulting in increased or decreased distortion in the
viewport.

In a Perspective viewport, Field-of-View defines the width of your view as an
angle with its apex at your viewpoint and the ends at the sides of the view.

In a Camera viewport, Field-of-View controls the width of the area a camera
views, and represents the arc of the camera's horizon in degrees. For a selected
camera, you can adjust its FOV and Lens parameters on page 5210 directly to
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fine-tune the FOV you set in the viewport. See “To use FOV with Camera
parameters” in the following procedures.

Procedures

To adjust the field of view in a viewport:

1 Activate a Perspective or Camera viewport.

2  Click Field-of-View.

The button highlights in gold when it is on.

3 Drag in the viewport to adjust the FOV angle.

■ Dragging down widens (increases) the FOV angle, reduces lens length,
displays more of your scene, and exaggerates perspective.

■ Dragging up narrows (decreases) the FOV angle, increases lens length,
displays less of your scene, and flattens perspective.

4 To turn off the button, press Esc or right-click.

To enter an FOV value in a Perspective view:

1 Activate a Perspective viewport.

2  Right-click Field-of-View to display the Viewport Configuration
dialog.

3 Click the Rendering Method tab.

4 In the Perspective User View group, enter an angle in the FOV field.

5 Click OK to make the change.

To use FOV with Camera parameters:

1 Activate a Camera viewport.

2 Press H and select the viewport’s camera in the Select From Scene dialog
on page 228.

3 Open the Modify panel to view the camera’s Parameters rollout.
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4 As you drag Field-of-View in the viewport, the FOV and Lens parameters
update interactively.

5 Set the FOV and Lens parameters directly, or click a button in the Stock
Lenses group.

NOTE Only the FOV value is saved with the camera. The Lens value (focal
length) is another way to express and select the FOV.

See Common Camera Parameters on page 5210.

NOTE Using the Perspective button on page 7607 in a Camera viewport also
changes the FOV in concert with dollying the camera.

Zoom Region 

Activate an orthographic viewport. > Viewport navigation controls > Zoom
Region

Activate a Perspective viewport. > Viewport navigation controls > Zoom Region
(from Field of View flyout)

Keyboard > Ctrl+W

Zoom Region magnifies a rectangular area you drag within a viewport. This
control is available only when the active viewport is an orthographic on page
8073, Perspective on page 8087 or User-Axonometric view on page 7918. It is not
available for Camera viewports.

Zoom Region stays active until you right-click or select another command.

Procedures

To zoom a region:

1 Activate an orthographic or Perspective viewport.

2  Click Zoom Region or press Ctrl+W.

When you zoom a region in a perspective viewport, select Zoom Region
from the Field of View flyout.
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3 Drag a rectangular region in any viewport displaying a non-camera view.

When you release, the region is magnified to fill the viewport.

NOTE When using the Zoom Region in Perspective view, the zoom rectangle
is at a fixed distance from the camera. For this reason, if you draw the
rectangle large enough, you can zoom out from the scene.

Pan View 

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Pan View

Keyboard > Ctrl+P; I pans so the cursor location becomes the center of the
viewport.

Middle mouse button > Drag in the viewport with the middle mouse button
for instant access to pan the viewport.

Pan moves the view parallel to the current viewport plane.

Pan is modal on page 8045: it stays active until you right-click or select another
command.

To constrain panning of any viewport to a single axis, hold down the Shift
key. The pan is constrained to the axis you first move while the Shift key is
down.

To accelerate panning, hold down the Ctrl key.

You can also pan by dragging in a viewport while pressing the middle button
of a three-button mouse. This lets you pan without turning on the Pan button.

Procedures

To pan a viewport:

1  Activate a Perspective or orthographic viewport, and then click
Pan View.

2 Drag in the viewport in the direction you want to move.

3 To turn off the button, press Esc or right-click.
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To pan a non-Camera viewport:

1 Activate a Perspective or orthographic viewport.

2 Do one of the following:

■  Click Pan View.

■ Press Ctrl+P.

■ Press the middle mouse button.

3 Drag in the viewport in the direction you want to move, or use the arrow
keys.

To accelerate panning:

■ Hold down the Ctrl key as you pan.

To constrain panning to a single axis:

■ Hold down the Shift key as you pan.
The pan is constrained to the first axis you use.

If you drag vertically at first, the pan or orbit is constrained to be vertical;
if you drag horizontally at first, the constraint is horizontal.

Orbit Flyout

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Orbit flyout

Keyboard > Alt+middle mouse button

The Orbit flyout contains the Orbit, Orbit Selected, and Orbit Sub-Object
buttons. Use these to rotate your viewpoint around the view.
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For more information on these tools, see Orbit, Orbit Selected, Orbit Sub-Object
on page 7602.

Orbit, Orbit Selected, Orbit Sub-Object 

Activate a Perspective or orthographic viewport. > Viewport Navigation controls
> Orbit flyout

Keyboard > Alt+middle mouse button

The Orbit buttons, on the Orbit flyout on page 7601, spin the viewpoint freely
around a center.

Three variants are available: Orbit, Orbit Selected, and Orbit Sub-Object.

The Orbit function is modal on page 8045: It remains active until you right-click
or choose another command.

 Orbit respects Angle Snap on page 2654. If you turn on Angle Snap, the
Orbit mouse pointer displays a magnet, and the rotation snaps by the Viewport
Orbit Snap Angle setting on page 7782.

Orbiting uses a hidden “virtual target” as center of rotation. Holding down
the Ctrl key in Orbit mode has a special behavior: It performs a rotation of the
scene around the screen’s X and Y axis (at the position of the virtual target).
Moving the mouse horizontally yields rotation around world-coordinates
referential Z axis. Moving the mouse vertically yields rotation around
world-coordinates referential X axis. This differs from standard Orbit, in which
horizontal mouse movement rotates around screen-coordinates referential Y
axis.

TIP An alternative method for orbiting the viewport is the  ViewCube on page 107

Procedures

To use Orbit:

1 Activate a Perspective or orthographic viewport.

2 Click any of the three Orbit buttons.

A view-rotation “trackball” is displayed as a yellow circle with handles
placed at the quadrant points.
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3 Drag the mouse on and around the trackball to produce different types
of view rotations. The cursor changes to indicate the type of rotation in
effect:

■ To rotate the view freely within the viewport, drag inside the trackball.
The free rotation continues while dragging even if the cursor crosses
outside the trackball.

■ To constrain the rotation to the horizontal or vertical axis, drag the
trackball handles. Drag horizontally on the side handles, or vertically
on the top or bottom handle.

■ To rotate the view about the depth axis that is perpendicular to the
screen, drag outside the trackball. When the cursor crosses inside the
trackball during dragging, free rotation occurs. When the cursor crosses
back outside the trackball, spinning rotation is again in effect.

4 To exit the Orbit function, press Esc or right-click within the viewport.

To constrain rotation to a single axis:

■ Hold down the Shift key as you rotate.
The rotation is constrained to the first axis you use.

To rotate with keyboard and mouse:

■ Hold down the Shift key as you rotate.
The rotation is constrained to the first axis you use.

Interface

 Orbit Uses the view center as the center of rotation. If objects are near
the edges of the viewport, they might rotate out of view.

 Orbit Selected Uses the center of the current selection as the center of
rotation. The selected object remains at the same position in the viewport
while the view rotates around their center.

 Orbit SubObject Uses the center of the current sub-object selection as
the center of rotation. The selection remains at the same position in the
viewport while the view rotates around its center.
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Camera Viewport Controls

Right-click any viewport label. > Views > Choose a camera.

Keyboard > C

A Camera viewport shows the view from a camera, looking in the direction
it's aimed.

Camera viewport controls include the following. Two of these controls are
available in all viewports.

Dolly Camera, Target, or Both  on page 7605

Perspective  on page 7607

Roll Camera  on page 7608

Zoom Extents All, Zoom Extents All Selected  on page 7588 (available in all
viewports)

Field-of-View Button  on page 7596

Truck Camera  on page 7610

Orbit/Pan Camera  on page 7611

Maximize Viewport Toggle  on page 7589 (available in all viewports)

Activate a Camera view from the viewport right-click menu, under Views. If
the scene contains more than 10 cameras, the last entry in the list is "More
Cameras.” Choose this to display the Choose A View dialog, which shows the
complete list.

If a single camera is selected and you press C, the active viewport switches to
the view from that camera. If, when you press C, the scene contains more
than one camera and no camera or multiple cameras are selected, the Select
Camera dialog appears; choose a camera from the list.

Procedures

To undo changes to a Camera viewport, do one of the following:

■  Click Undo on the main toolbar.
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■ Press Ctrl+Z.

NOTE This behavior differs from that of orthographic viewports, which require
the use of Views menu > Undo, or Shift+Z.

Dolly Camera,Target, or Both 

Activate a Camera viewport. > Viewport navigation controls > Dolly Camera
or Dolly Target or Dolly Camera + Target

The buttons on this flyout replace the Zoom button when a Camera viewport
is active. Use them to move the camera and/or its target along the camera's
main axis, toward or away from what the camera is pointing at.

Dollying a camera

A free camera moves along its depth axis in the direction its lens is pointing.
Unlike a target camera, its target distance remains fixed, no matter how far
you dolly.
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NOTE The three buttons of the Dolly Camera flyout are available when a target
camera viewport is active. When a free camera viewport is active, the button
appears as a flyout, but only Dolly Camera is available for this type of camera. If
you activate a target camera viewport, the three buttons are again available.

See also:

■ Dolly Light, Target, or Both  on page 7616

Procedures

To dolly a camera:

1 Activate a Camera viewport.

2 Click one of the buttons on the Dolly Camera flyout.

3 Drag to move the camera.

■ Drag up to move the camera forward along its line of sight.

■ Drag down to move the camera backward along its line of sight.

4 Press Esc or right-click to turn off the button.

Interface

 The Dolly Camera flyout consists of the following individual buttons:

 Dolly Camera Moves only the camera to and from its target. If you go
past the target, the camera flips 180 degrees and moves away from its target.

 Dolly Target Moves only the target to and from the camera. You see
no visual change in the camera viewport, unless you dolly the target to where
it passes through the camera to the other side, at which point the camera view
is reversed. However, changing the relative position of the target to the camera
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affects other adjustments, such as Orbit Camera, which uses the target as its
rotational pivot.

This option is available only if the viewport’s camera is a target camera.

 Dolly Camera + Target Moves both the target and the camera to and
from the camera.

This option is available only if the viewport’s camera is a target camera.

Perspective 

Activate a Camera viewport. > Viewport navigation controls > Perspective

Perspective performs a combination of FOV on page 7972 and Dolly on page
7605 for target cameras and free cameras. It increases the amount of perspective
flare, while maintaining the composition of the scene.

Adjusting perspective

NOTE This button replaces the Zoom All button when a Camera viewport is active.
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TIP Hold down the Ctrl key to magnify the effect of the mouse on perspective
adjustment.

A target camera can pass through its target object while you are using
Perspective. When this happens, the FOV reaches its maximum angle of 180
degrees at the target location and cursor motion is reversed until you release
the drag.

A free camera continues moving along an infinite path but uses an implied
target position to control the FOV change rate. This implied target is defined
as a point specified by the Target Distance field in the Parameters rollout for
the free camera.

Procedures

To change perspective for a camera:

1 Activate a Camera viewport.

2  Click Perspective.

The button turns yellow when it is on.

3 Drag to change FOV and dolly simultaneously.

■ Drag up to move the camera closer to its target, widen the FOV, and
increase perspective flare.

■ Drag down to move the camera away from its target, narrow the FOV,
and decrease perspective flare.

4 Press Esc or right-click to turn off the button.

Roll Camera 

Activate a Camera viewport. > Viewport navigation controls > Roll Camera

Roll Camera rotates a target camera about its line of sight, and rotates a free
camera about its local Z axis.
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Rolling a camera

NOTE This button replaces the Zoom Extents button when a Camera viewport is
active.

Procedures

To roll a camera:

1 Activate a Camera viewport.

2  Click Roll Camera.

The button highlights when it is on.

3 Drag horizontally to roll the view.

4 Press Esc or right-click to turn off the button.
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Truck Camera 

Activate a Camera viewport. > Viewport navigation controls > Truck Camera

Truck Camera moves the camera parallel to the view plane.

Trucking a camera

For a target camera, dragging the mouse moves both the camera and its target
parallel to the Camera view.

This button replaces the Pan button when a Camera viewport is active.

Procedures

To truck a camera:

1 Activate a Camera viewport.

2  Click Truck Camera.

The button highlights when it is on.
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3 Drag to move the camera and its target.

The camera and its target move parallel to the view plane, which is
perpendicular to the camera's line of sight.

4 Press Esc or right-click to turn off the button.

To truck with the middle mouse button:

■ Hold down the middle mouse button and drag.

To constrain trucking to a single axis:

■ Hold down the Shift key.
The truck is constrained to the first axis you move while the Shift key is
down.

To accelerate trucking:

■ Hold down the Ctrl key.

Orbit/Pan Camera 

Activate a Camera viewport. > Viewport navigation controls > Orbit Camera

Orbit Camera rotates a camera about the target. Pan Camera rotates the target
about the camera.
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Orbiting a camera

Panning a camera
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NOTE This button replaces the Orbit button when a Camera viewport is active.

You can constrain the rotation to a single axis by first pressing Shift before
beginning the rotation. The rotation is constrained to the axis you begin
rotating about.

To accelerate panning, hold down the Ctrl key before you pan.

Procedures

To pan a camera:

1 Activate a Camera viewport.

2   Click Pan Camera.

The button highlights when it is on.

3 Drag to rotate the view about the camera.

■ Dragging rotates the view freely using the world X and Y axes.

■ Press Shift and drag horizontally to lock view rotation about the world
Y axis. This produces a horizontal pan.

■ Press Shift and drag vertically to lock rotation about the world X axis.
This produces a vertical pan.

4 Press Esc or right-click to turn off the button.

To orbit a camera:

1 Activate a Camera viewport.

2  Click Orbit Camera.

3 Drag to rotate the view around the target.

■ Dragging rotates the view freely using the world X and Y axes.

■ Press Shift and drag horizontally to lock view rotation about the world
Y axis. This produces a horizontal orbit.

■ Press Shift and drag vertically to lock rotation about the world X axis.
This produces a vertical orbit.
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4 Press Esc or right-click to turn off the button.

Interface

 Orbit Camera Rotates a target camera about its target. Free cameras use
the invisible target, set to the target distance specified in the camera Parameters
rollout.

  Pan Camera Rotates the target about a target camera. For a free camera,
rotates the camera about its local axes.

Light Viewport Controls

Right-click any viewport label. > Views > Choose a light.

Keyboard > $

A Light viewport shows the view from a spotlight or directional light, looking
at its target.

Light viewport controls include the following. Two of these controls are
available in all viewports.

Dolly Light, Target, or Both  on page 7616

Light Hotspot  on page 7618

Roll Light  on page 7620

Zoom Extents All, Zoom Extents All Selected  on page 7588 (available in all
viewports)

Light Falloff  on page 7622

Truck Light  on page 7624

Orbit/Pan Light  on page 7626

Maximize Viewport Toggle  on page 7589 (available in all viewports)
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For photometric lights on page 5005, the Light Hotspot control actually adjusts
the beam angle. At the beam angle, the light is 50 per cent of the maximum
intensity.

Targeted photometric lights can be used as views only when the light's
distribution is set to spotlight.

WARNING Switching to or from a light view clears the Undo/Redo lists.

Procedures

To set a Light viewport:

1 Activate the viewport you want to show the view from a spotlight or
directional light in the scene.

2 Do one of the following:

■ Press the keyboard shortcut $.

■ Right-click the Viewport label. Choose Views and then choose the
light from the Views submenu.

3 If you have more than one spotlight or directional light in the scene (and
none is selected), the Select Light dialog is displayed: choose the light
you want.

4 If there are more than 10 lights listed, the last entry is "More Lights."
Choose this to display the Choose a View dialog, which shows the
complete list.

To undo changes to a Light viewport, do one of the following:

1  Click Undo on the main toolbar.

2 Press Ctrl+Z.

NOTE This is different from orthographic viewports, which require the use
of Views menu > Undo, or Shift+Z.
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Dolly Light,Target, or Both 

Activate a Light viewport. > Viewport navigation controls > Dolly Light

Dolly Light, on the Dolly Light flyout (see below) moves the light or its target
or both along the light’s main axis, toward or away from what the light is
pointing at. A free light moves along its depth axis in the direction its lens is
pointing. On a target light, the target distance remains fixed, no matter how
far you dolly.

Dollying a light

When you dolly a light, the light source moves closer to and away from its
target. Because spotlights have conical beams, dollying a spotlight closer to
its target shrinks the area illuminated at the target. Similarly, dollying a
spotlight away from its target expands the area illuminated at the target.

The three buttons of the Dolly Light flyout are available when a target light
viewport is active. When a free light viewport is active, the button appears as
a flyout, but only Dolly Light is available for this type of light. If you activate
a target light viewport, the three buttons are again available.
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The buttons on this flyout replace the Zoom button when a Light viewport
is active.

See also:

■ Dolly Camera, Target, or Both  on page 7605

Procedures

To dolly a light:

1 Activate a Light viewport.

2  Click Dolly Light.

The button highlights when it is on.

3 Drag to move the light.

■ Drag up to move the light forward along its line of sight.

■ Drag down to move the light backward along its line of sight.

4 Press Esc or right-click to turn off the button.

Interface

 The Dolly Light flyout consists of the following buttons:

 Dolly Light Moves only the light to and from its target. If you go past
the target, the light flips 180 degrees and moves away from its target.

 Dolly Target Moves only the target to and from the light. You see no
visual change in the light viewport, unless you dolly the target to where it
passes through the light to the other side, at which point the light view is
reversed. However, changing the relative position of the target to the light
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affects other adjustments, such as Orbit Light, which uses the target as its
rotational pivot.

This option is available only if the viewport’s light is a target light.

 Dolly Light + Target Moves both the target and the light to and from
the light.

This option is available only if the viewport’s light is a target light.

Light Hotspot 

Activate a Light viewport. > Viewport navigation controls > Light Hotspot

Light Hotspot lets you adjust the angle of a light's hotspot on page 8007. This
button replaces the Zoom All button when a light viewport is active.

The floodlight has a narrow hotspot but a wide falloff area.
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Widening the hotspot creates a brighter light.

Click this button, then move the mouse in the light viewport to make the
cone of the hotspot narrower or wider (the hotspot cone is shown in blue,
the falloff on page 8007 cone is in gray).

Hold down the Ctrl key while moving the mouse to lock the initial angle
separation of the hotspot and falloff cones.

You can't adjust the hotspot larger than the falloff, because that would change
the falloff value. Likewise, when you reduce the falloff, it stops at the hotspot
size (in both cases, separated by the Angle Separation on page 7768, specified
on the Rendering page of the Preferences dialog).

To override the separation of the hotspot and falloff parameters and cause the
parameters to affect each other, hold down the Shift key.

For more information on the hotspot and falloff parameters, see Spotlight
Parameters on page 5090 and Directional Parameters on page 5088.

NOTE If the light is a photometric light on page 5005 with spotlight distribution,
this button controls the light's beam angle. At the beam angle, the light's intensity
has fallen to 50 per cent (rather than 100 per cent at the hotspot angle for a
standard light).
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Procedures

To change a light's hotspot:

1 Set up a Perspective viewport so you can see the light in 3D space.

2 Activate a Light viewport.

3 Press H to display the Select From Scene dialog on page 228. Select the
light.

The light and its cones should be visible in the Perspective viewport.

4  Click Light Hotspot.

The button highlights when it is on.

5 Drag in the Light viewport to change the hotspot angle.

The blue hotspot cone expands and contracts as you drag.

■ Drag down to widen (increase) the hotspot angle and illuminate more
of the scene. The hotspot grows inside the falloff as its angle increases.
By default, the hotspot can be no larger than the falloff cone.

■ Hold down Shift as you drag to override the default. This lets the falloff
cone increase in size as you increase the size of the hotspot cone.

■ Drag up to narrow (decrease) the hotspot angle and illuminate less of
the scene.

■ Hold down Ctrl as you drag to lock the initial angle separation of the
hotspot and falloff cones.

6 Press Esc or right-click to turn off the button.

Roll Light 

Activate a light viewport. > Viewport navigation controls > Roll Light

Roll Light rotates the light about its own line of sight (the light's local Z axis).

Although Roll does change the light view, it affects the light object only if the
light casts a rectangular beam or is a projector on page 8099.
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Rolling a light

Drag the mouse horizontally to roll a target light or rotate a free light about
its local Z axis.

This button replaces the Zoom Extents button when a light viewport is active.

Procedures

To roll a light:

1 Activate a Light viewport.

2  Click Roll Light.

The button highlights when it is on.

3 Drag horizontally to roll the view.

4 Press Esc or right-click to turn off the button.
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Light Falloff 

Activate a Light viewport. > Viewport navigation controls > Light Falloff

Light Falloff adjusts the angle of a light's falloff on page 8007. This button
replaces the Zoom Region button when a light viewport is active.

The light has a narrow hotspot but a wide falloff area.
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Making the falloff even wider illuminates a larger area.

Click Light Falloff, then move the mouse in the light viewport to make the
falloff narrower or wider (the falloff extents are shown in gray, the hotspot
on page 8007 is in blue).

Hold down the Ctrl key while moving the mouse to lock the initial angle
separation of the hotspot and falloff cones.

You can't adjust the hotspot larger than the falloff, because that would change
the falloff value. Likewise, when you reduce the falloff, it stops at the hotspot
size (in both cases, separated by the angle separation on page 7768, specified on
the Rendering page of the Preferences dialog).

To override the separation of the hotspot and falloff parameters and cause the
parameters to affect each other, hold down the Shift key.

For more information on the hotspot and falloff parameters, see Spotlight
Parameters on page 5090 and Directional Parameters on page 5088.
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Procedures

To change a light's falloff:

1 Set up a Perspective viewport so you can see the light in 3D space.

2 Activate a Light viewport.

3 Press H to display the Select Object dialog. Select the light.

The light and its cones should be visible in the Perspective viewport.

4  Click Light Falloff.

The button highlights when it is on.

5 Drag in the Light viewport to change the falloff angle.

The gray falloff cone expands and contracts as you drag.

■ Drag down to widen (increase) the falloff angle and illuminate more
of the scene.

■ Drag up to narrow (decrease) the falloff angle and illuminate less of
the scene. As its angle decreases, the falloff shrinks around the hotspot.
By default, the falloff cone can be no smaller than the hotspot cone.

■ Hold down Shift as you drag to override the default. This lets the
hotspot cone decrease in size as you decrease the size of the falloff
cone.

■ Hold down Ctrl as you drag to lock the initial angle separation of the
hotspot and falloff cones.

6 Press Esc or right-click to turn off the button.

Truck Light 

Activate a light viewport. > Viewport navigation controls > Truck Light

Truck Light moves a target light and its target parallel to the light view, and
moves a free light along its XY axis.
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Trucking a light

To constrain trucking of any viewport to a single axis, hold down the Shift
key. The truck is constrained to the first axis you move while the Shift key is
down.

To accelerate trucking, hold down the Ctrl key.

NOTE This button replaces the Pan button when a light viewport is active.

Procedures

To truck a light:

1 Activate a Light viewport.

2  Click Truck Light.

The button highlights when it is on.

3 Drag to move the light and its target.
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The camera and its target move parallel to the view plane, which is
perpendicular to the camera's line of sight.

4 Press Esc or right-click to turn off the button.

To truck with the middle mouse button:

■ Hold down the middle mouse button and drag.

To constrain trucking to a single axis:

■ Hold down the Shift key.
The truck is constrained to the first axis you use.

Orbit/Pan Light 

Activate a light viewport. > Viewport navigation controls > Orbit/Pan Light
flyout

Orbit rotates a light about the target. Pan rotates the target about the light.
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Orbiting a light
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Panning a light

To constrain panning or orbiting to a single axis, hold down the Shift key.
The pan or orbit is constrained to the axis you first move while the Shift key
is down.

To accelerate panning or orbiting, hold down the Ctrl key before you pan or
orbit.

NOTE This button replaces the Orbit button when a light viewport is active.

Procedures

To orbit a light:

1 Activate a Light viewport.

2  Click Orbit Light.

The button highlights when it is on.
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3 Drag to rotate the view around the target.

■ Dragging rotates the view freely using the world X and Y axes.

■ Press Shift and drag horizontally to lock view rotation about the world
Y axis. This produces a horizontal orbit.

■ Press Shift and drag vertically to lock rotation about the world X axis.
This produces a vertical orbit.

4 Press Esc or right-click to turn off the button.

To pan a light:

1 Activate a Camera or Light viewport.

2  Click Pan Light.

The button highlights when it is on.

3 Drag to rotate the view about the camera or light.

■ Dragging rotates the view freely using the world X and Y axes.

■ Press Shift and drag horizontally to lock view rotation about the world
Y axis. This produces a horizontal pan.

■ Press Shift and drag vertically to lock rotation about the world X axis.
This produces a vertical pan.

4 Press Esc or right-click to turn off the button.

Interface

 Orbit Light Rotates the light about its target. Free lights use the invisible
target, set to the target distance specified in the Modify panel > Spotlight
Parameters or Directional Parameters rollout.

 Pan Light For a target light, rotates the target about the light. For a
free light, rotates the light about its local axes.
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Command Panel
The command panel comprises six user-interface panels that give you access
to most of the modeling features of 3ds Max, as well as some animation
features, display choices, and miscellaneous utilities. Only one panel is visible
at a time. To display a different panel, you click its tab at the top of the
command panel.

These are the panels:

■ Create panel on page 7631
Contains controls for creating objects: geometry, cameras, lights, and so
on.

■ Modify panel on page 7633
Contains controls for applying modifiers on page 8048 to objects and editing
editable objects such as meshes and patches.

■ Hierarchy panel on page 7661
Contains controls for managing links in a hierarchy, joints, and inverse
kinematics.

■ Motion panel on page 7663
Contains controls for animation controllers and trajectories.

■ Display panel on page 7665
Contains controls that let you hide and unhide objects, along with other
display options

■ Utilities panel on page 7671
Contains miscellaneous utility programs.

By default, the command panel appears at the right of the 3ds Max window.
You can "dock" it along other edges of the program window, or make it a
floating panel. See Customizing the User Interface on page 7683.
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Object Name and Wireframe Color

Create panel > Any object category > Name And Color rollout

Modify, Hierarchy, Motion, Display, or Utilities panel > Name field and color
swatch

The name and color fields appear at the top of all command panels other than
the Create panel. On the Create panel, the fields are contained in a rollout.
You can change an object's name or color from any of these locations.

Interface

Name (text field) Displays the name of the selected object and lets you enter
a new name from the keyboard. Available only when a single object is selected.

Color (swatch) Displays the selected object's wireframe color and lets you
select a new one. The wireframe color is the one used to display the object in
viewports. Click the color swatch to display the Object Color dialog on page
387.

Create Panel 

Command panels > Create panel

The Create panel provides the controls for creating objects. This is the first
step in building a new scene in 3ds Max. Most likely, you will continue to add
objects throughout an entire project. For example, when it is time to render
a scene you might need to add more lights.

The Create panel groups the kinds of objects you create into seven categories.
Each category has its own button. Within each category there can be several
different subcategories of objects. A drop-down list lets you choose among
object subcategories, and each kind of object has its own button, which you
click to begin creation.

These are the categories of objects that the Create panel provides:

■ Geometry on page 377
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Geometry is the renderable geometry of the scene. There are geometry
primitives such as Box, Sphere, Pyramid, and more advanced geometry
such as Booleans, Lofts, and particle systems, as well as Doors and Stairs,
AEC Extended objects such as Terrain and Railing.

■ Shapes on page 606
Shapes are splines or NURBS curves. They have only one local dimension,
although they can exist in 2D space, such as a Rectangle shape, or 3D
space, such as a Helix.

You can give shapes a thickness so they will render, but primarily you use
them for constructing other objects such as Lofts, or for motion trajectories.

■ Lights on page 4970
Lights illuminate the scene and improve its realism. There are several kinds
of lights, each of which models different types of lighting in the real world.

■ Cameras on page 5194
Camera objects provide a view of the scene. The advantages of cameras
over the views in the standard viewports are that cameras have controls
similar to real-world cameras, and that you can animate a camera's position.

■ Helpers on page 2587
Helper objects are aids to constructing a scene. They help you position,
measure, and animate the scene's renderable geometry.

■ Space Warps on page 2685
Space warps produce various kinds of distortions in the space surrounding
other objects. Some space warps are meant especially for use with particle
systems.

■ Systems on page 899
Systems combine objects, controllers, and hierarchies to provide geometry
associated with some kind of behavior. Also contains Sunlight and Daylight
systems that simulate sunlight in your scenes.
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Modify Panel 

Command panels > Modify panel

From the Create panel of 3ds Max, you place basic objects in your scene,
including 3D geometry, 2D shapes, lights and cameras, space warps, and
helpers. As you do this, you give each object its own set of creation parameters,
which define its geometry and other characteristics depending on the type of
object. Once placed in a scene, objects carry their creation parameters with
them. You can change these parameters on the Modify panel.

You also use the Modify panel to assign modifiers on page 8048. Modifiers are
tools for reshaping an object. While they mold the final appearance of the
object, modifiers do not change its underlying creation parameters. See the
list of available modifiers on page 1081.

You use the Modify panel to:

■ Change the creation parameters for existing objects.

■ Apply modifiers to adjust the geometry of an object or a set of objects.

■ Change the parameters of modifiers and select their components.

■ Delete modifiers.

■ Convert a parametric object to an editable object; see Modifier Stack
Controls on page 7635.

NOTE Some space warps can be created as modifiers. See World Space
Modifiers (WSMs) on page 1113.

The Modify panel stays in view until you dismiss it by clicking the tab of
another command panel. The contents of the panel with its options and
controls update when you select an object, giving you access only to what
you can modify about that object.

What you can modify depends on whether an object is classed as a geometric
primitive like a sphere, or as another kind of object, such as a light or a space
warp. Each category has its own range of possibilities. The contents of the
Modify panel are always specific to the category as well as to the selected
object. When you make a change from the Modify panel, you immediately
see the results transferred to the object.
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You can change or delete modifiers by using the Modifier Stack Controls on
page 7635.

See also:

■ List of Available Modifiers on page 1081

Procedures

To use the Modify panel:

1 Select an object.

2  On the Command panel, click the Modify tab to display the Modify
panel.

The name of the object appears at the top of the Modify panel, and the
remainder of the panel displays settings for the object or the modifier at
the top of its stack.

3 You can now do any of the following:

■ Change the parameters for the object. As you change these parameters,
the object updates in the viewports.

■ Apply a modifier to the object.

■ Change the parameters for a modifier. As you change these parameters,
the object updates into the viewports.

■ Collapse the stack to create an editable surface such as an editable
mesh on page 2075.

To apply a modifier from the Modify panel:

1 Select an object.

2  On the Command panel, click the Modify tab to display the Modify
panel. On the Modify panel, click the Modifier List items to open the
drop-down list of modifiers.
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3 Scroll the list to find the modifier you want. You can use any standard
method to scroll the list:

■ From the keyboard, press Up Arrow or Down Arrow to scroll one item
at a time, or press Page Up or Page Down to scroll in screen-height
increments, or use Home or End to jump to the top or bottom of the
list. The name of the chosen modifier is highlighted, and the name
appears at the top of the list.

TIP If you know the modifier name, you can jump to its section by
pressing the keyboard key corresponding to first letter of the name. To
cycle through all modifiers starting with that letter, press the key
repeatedly.

■ With the mouse, slide the scroll bar on the right side of the list, or
turn the mouse wheel.

4 Apply the modifier. If using the keyboard, press Enter to apply the
highlighted modifier. If using the mouse, simply click the modifier name
to apply it.

Modifier Stack Controls

Make selection. > Modify panel

seeThe modifier stack controls appear near the top of the Modify panel, just
below the name and color fields. The modifier stack ("stack" for short) contains
the accumulated history of an object, including its creation parameters and
the modifiers applied to it. At the bottom of the stack is the original object.
Above the object are the modifiers, in order from bottom to top. This is the
order in which modifiers are applied to the object's geometry.
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Object with two modifiers applied to it in the
stack

See also:

■ Applying Modifiers on page ?

■ Using the Modify Panel on page 1086

■ Using the Modifier Stack on page 1090

■ List of Available Modifiers on page 1081

■ World-Space Modifiers (WSMs) on page 1113

■ Object-Space Modifiers on page 1202

Instances and References in the Modifier Stack Display

In the modifier stack display, objects and modifiers appear in normal type
unless they are an instance or a reference. Here is how instances and references
appear in the stack display:

■ The name of an instanced object appears in boldface.

■ The name of a modifier appears in boldface if it is part of an instanced
pipeline.
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Top: Plain object displayed in plain text

Bottom: Object instance displayed in boldface

Top: Pipeline displayed in plain text

Bottom: Pipeline instance displayed in boldface

■ If a modifier is applied to two or more pipelines, it is called an instanced
modifier. Its name appears in italic.

■ If a modifier is instanced and part of an instanced pipeline, its name appears
in boldface and italic.

Top: Instanced modifier displayed in italic
(modifier applied to two objects)

Bottom: Instanced modifier in an instanced
pipeline displayed in italic and boldface

■ A referenced object appears with a dark bar above it. Modifiers below the
bar are part of the current pipeline. Modifiers above the bar are unique to
the reference object.

NOTE You can also create instances of a reference. In this case, the modifier
above the reference bar apply to the reference and to its instances.
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■ A modifier above the reference object bar can itself be an instance and
appear in other pipelines, in which case its name would be italic (either
plain or boldface).

Top: Object reference shows a bar in the pipe

Bottom: Modifier applied to reference is not
bold, as it is unique to this reference

 The Make Unique button on page 7654 makes a pipeline or a modifier
instance unique. When you highlight the base object and then click Make
Unique, the whole pipeline becomes unique. When you highlight a bold
modifier and then click Make Unique, this also makes the pipeline unique. If
the modifier is an instanced modifier that belongs to an instanced pipeline
(it appears in boldface and italic), clicking Make Unique makes the modifier
unique but not the entire pipeline (the modifier's name is no longer italic,
but it is still bold).

See also:

■ How Instanced Modifiers Work on page 1110

■ Transforms, Modifiers, and Object Data Flow on page 1074

Most-Recently-Used Modifiers

3ds Max caches the results of evaluating most-recently-used modifiers. This
means that in general, you can see results more quickly as you move among
modifiers on the stack.

To conserve memory use, the list of most-recently-used modifiers has a fixed
length. Once the list is full, adding a new modifier removes the oldest modifier
in the list. By default, the list length is 1. You can increase it by adding an
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MRUModSize entry to the [Performance] section of the 3dsmax.ini on page 83
file. For example:

MRUModSize=10

A good rule of thumb for this value is 10, but results will vary depending on
how much main memory your system has.

Procedures

To adjust an object's creation parameters:

1 Choose the object by clicking its name in the stack.

Primitive objects have a Parameters rollout. Other kinds of objects (such
as meshes or NURBS) have a variety of rollouts.

2 Use the controls in the rollouts to adjust the object.

To apply a modifier to an object:

1 Select the object.

2 Do one of the following:

■ Choose a modifier from the Modifier List. This is a drop-down list at
the top of the Modify panel.

TIP
In many cases, multiple modifiers' names start with the same letter.
You can go directly to a particular modifier if you type the first few
letters (enough for a unique combination) in the desired modifier's
name quickly. For example, say you want to assign the Mirror modifier
to an object. Pressing M goes to Mesh Select, which isn't anywhere
near Mirror in the Modifier list, but typing MI goes directly to Mirror.

■ Choose a modifier from the Modifiers menu. This menu is organized
into sets by functionality.
Not all modifiers appear on the Modifiers menu.

■ If the modifier buttons are visible on the Modify panel and the
modifier you want is one of them, click the button.

 If the buttons are not visible but you want to use them, click
the Configure Modifier Sets button on page 7658 (below the modifier
stack display) and choose Show Buttons. A set of buttons with the
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names of modifiers appears between the modifier list and the stack
display. Click Configure Modifier Sets again, choose the set of
modifiers you want to use (for example, Free-Form Deformations),
and then click the button for the modifier you want to apply.

Rollouts are now displayed below the modifier stack display, showing
settings for the modifier. As you change these settings, the object updates
in viewports.

To remove a modifier:

■ Do one of the following:

■  Choose the modifier by clicking its name in the stack, and then
click Remove Modifier From The Stack. This button is one of the tools
beneath the display of the modifier stack.

■ Right-click the modifier's name in the stack and then choose Delete.

To turn the effect of a modifier off, do one of the following:

1  Click the light-bulb icon to the left of the modifier's name in the
stack to turn it off.

When you apply a modifier, the light-bulb icon is on by default.

2 Right-click the modifier in the stack display, and choose Off.

To turn the effect of a modifier back on, do one of the following:

1  Click the light-bulb icon to the left of the modifier's name in the
stack to turn it on.

2 Right-click the modifier in the stack display, and choose On.

To change the size of the modifier stack display:

1 Position the cursor over the shaded bar below the tool buttons beneath
the stack list.

The cursor changes to an up-and-down resize arrow (as it does on the
horizontal edges of a resizable window).
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2 Drag the bar up or down to change the size of the stack display in the
Modify panel.

To change a modifier's position in the stack:

1 Right-click the modifier's name in the stack, and choose Cut.

2 Right-click the name of the modifier you want the modifier to appear
before (that is, above), and choose Paste.

You can also drag-and-drop the modifier to a different location in the
stack.

NOTE The original object is always at the bottom of the stack, and
world-space modifiers are always at the top.

To use the modifier buttons:

■  Click Configure Modifier Sets, and choose Show Buttons.
This menu item is a toggle. It is either on or off. When you turn on Show
Buttons, the current button set appears between the drop-down modifier
list and the stack display.

See Configure Modifier Sets Dialog  on page 7658 for more information.

To turn the modified object into an editable mesh, do one of the following:

1 Right-click the modifier stack, and choose Collapse All.

A warning dialog is displayed that reminds you that the collapse operation
cannot be undone, and gives you the option of performing a Hold on
page 264 before creating the mesh.
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2 Right-click the object in a viewport, and choose Convert To > Convert
to Editable Mesh in the quad menu.

TIP You can also convert a modified object to an editable patch or editable
polygon surface. Use the quad menu to do this.

To adjust a modifier's component such as its gizmo or center point:

1  Click the plus-sign icon to display the modifier's hierarchy.

2 Choose the component you want to adjust, such as the Gizmo.

The component highlights to show it is active.

3 Adjust the component.

For example, you might use transforms to move a gizmo or a center point.

4  When done, you can click the minus-sign icon to hide the hierarchy
display. The modifier itself is highlighted again.

TIP You can also right-click the stack and use Show All Subtrees to view the
entire hierarchy, and Hide All Subtrees to view only objects and modifiers.

To go to a sub-object level for complex objects:

1  Click the plus-sign icon to display the object's hierarchy.

2 Choose the sub-object level you want to adjust.

The sub-object level highlights to show it is active.

Keyboard shortcut: Insert cycles through the different sub-object levels.

3 Adjust sub-objects.

When you add a new sub-object type, the modifier stack updates to show
the new sub-object levels. For example, when you add a point curve
sub-object to a NURBS surface, the Point and Curve sub-object levels
appear in the stack.

4 To leave the sub-object level, click to select the name of the top-level
object or a different top-level object.

TIP You can also right-click the stack and use Show All Subtrees to view the
entire hierarchy, and Hide All Subtrees to view only objects and modifiers.
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Interface

The Modifier Stack

Modifier List

The modifier list is a drop-down list that lets you choose a modifier to add to
the stack. When you choose an object-space modifier on page 1202 from this
list, it appears above the object, or above the modifier that was currently
selected in the stack. When you choose a world-space modifier on page 1113
from this list, it appears at the top of the stack.

Use Pivot Points The first item in the modifier list is the Use Pivot Points
toggle. It is unavailable unless multiple objects are selected.

When Use Pivot Points is turned on, 3ds Max uses the pivot point of each
object as the center of a modifier's operation. For example, if you bend a line
of trees around the Z axis, they all bend along their trunks.

When Use Pivot Points is turned off, 3ds Max calculates a central pivot point
for the entire selection set and modifies the selection as a whole. For example,
if you bend a line of trees around the Z axis, trees at the end of the line deform
more than those at the center where the pivot is located.
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NOTE You must turn on Use Pivot Points before you apply the modifier to multiple
objects. You can't change the setting afterward, although you can delete the
modifier and start over without deselecting the selection set.

Modifier Buttons

Between the modifier list and the stack display, you can display up to 32
buttons. The buttons are a shortcut way to add modifiers to the stack.

 To display the modifier buttons, click Configure Modifier Sets (below
the stack display) and choose Show Buttons.

 To customize the button set, click Configure Modifier Sets (below the
stack display) and choose Configure Modifier Sets on page 7658.

When a modifier's button is visible, clicking the button adds the modifier to
the stack. Object modifiers are applied immediately above the currently selected
object or modifier. World space modifiers are applied at the top of the stack.
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Stack Display

The modifier stack is organized as follows:

■ At the bottom of the stack, the first entry always lists the object type. Click
this entry to display the object's creation parameters so you can adjust
them.
When you click to choose an entry in the modifier stack, its background
highlights to show that the entry is current, and that the object's or
modifier's parameters are available for adjusting, in rollouts that appear
beneath the stack display.

■ Above the object itself are entries for object modifiers. Click a modifier
entry to display the modifier's parameters so you can adjust them.
This section lets you go back to any modifier you've applied and rework
its effect on the object. You can also delete the modifier from the stack,
canceling its effect.

Reminder:3ds Max applies transforms after it applies object modifiers but
before it applies space warps or world-space modifiers.

■ The top of the stack shows which space warps and world-space modifiers
the object uses. For example, if the object were bound to a Ripple space
warp, an entry in the top section would read Ripple Binding.

 To the left of each modifier in the stack is a light-bulb icon. When
the bulb appears white, the modifier is applied to the stack below it. When
the bulb appears gray, the modifier is turned off. Click to toggle the on/off
state of the modifier.

NOTE You can also turn off the effect of modifiers in viewports but not in
renderings, or vice versa. The light-bulb icon changes to show these states as well.
See Modifier Stack Right-Click Menu on page 7648.

 If the modifier has sub-controls such as a center or a gizmo, the
stack also shows a small plus/minus icon. Click this icon to open or close the
hierarchy.

Opening a modifier's hierarchy to access
sub-controls
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Opening a modifier's hierarchy to access
sub-controls

When the hierarchy is open, you can select a sub-control, such as a gizmo,
and then adjust it. The available sub-controls vary from modifier to modifier.

Objects that have a sub-object hierarchy, such as editable meshes on page 2075
and NURBS on page 2237, also show a collapsible hierarchy in the modifier
stack.

To work at a sub-object level, click to open the hierarchy, then click to select
the sub-object level. Controls for that particular level or type of sub-object
appear in rollouts below the stack display.

(Certain types of sub-objects display an icon at the right of the stack, to help
you see which sub-object type you are adjusting.)

Opening an object's hierarchy to access
sub-object levels
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Opening an object's hierarchy to access
sub-object levels

Opening an object's hierarchy to access
sub-object levels

Tool Buttons

Below the stack display is a row of buttons for managing the stack.
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 Pin Stack Locks the stack to the currently selected object so it remains
with that object regardless of subsequent changes in selection. The entire
Modify panel is locked to the current object as well.

Pin Stack is useful for transforming another object while keeping your place
in the modified object's stack.

 Show End Result Shows the selected object as it will appear after all
modifications in the stack have taken place, regardless of your current position
in the stack. When this toggle is turned off, the object appears as modified
up to the current modifier in the stack.

 Make Unique Converts an instanced modifier to a copy that's unique
to the current object. See Make Unique on page 7654.

 Remove Modifier Deletes the current modifier or unbinds the current
space warp.

 Configure Modifier Sets Click to display the pop-up Modifier Sets menu
on page 7657.

Modifier Stack Right-Click Menu

Modify panel > Modifier stack display > Right-click a modifier or object.

Some commands for managing modifiers are available by right-clicking the
modifier stack display. Some options are unavailable if they don't apply to
the current modifier. For example, Make Unique is available only if you select
an instanced modifier.

The main uses of the right-click menu for the modifier stack are:

■ Renaming modifiers

■ Rearranging modifiers with the cut, copy, and paste functions

You can cut, copy, and paste multiple modifiers at one time. You can also cut
and copy discontiguous selections of modifiers.

■ Creating instances of modifiers
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■ Collapsing the stack into a surface object such as an editable mesh

■ Controlling whether modifiers are on or off, off in viewports, or off in
renderings

Collapsing the Stack

Collapsing the stack removes modifiers from the object. Collapsing a stack
typically converts an object into an editable version of the original object
(unless the object was editable to begin with, such as a NURBS model). Collapse
To is unavailable unless you select one or more modifiers in the stack. Using
Collapse To removes all stack items from the creation parameters to and
including the uppermost selected stack item.

NOTE You can preserve custom attributes on page 7653 when collapsing the stack.

Following are suitable reasons to collapse a stack:

■ To simplify the scene geometry.

■ To discard applied modifiers, and convert the object to an editable object
while retaining the results of any applied modifiers.

■ To conserve memory.

After you collapse an object's stack, you can no longer parametrically adjust
either its creation parameters or its individual modifiers. Animation tracks
that were assigned to such parameters also disappear.

Procedures

To move one or more modifiers:

1 Select one or more modifiers in the modifier stack display.

To select multiple modifiers, click to select one modifier, then hold down
Ctrl and click to select the others. Holding down Shift selects the two
modifiers you click and all modifiers in between them.

2 Right-click and choose Cut.

3 Select a modifier above which to paste the cut modifiers. (This can also
be the object at the bottom of the stack.)

4 Right-click and choose Paste. The modifiers are pasted above the current
selection.
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To copy one or more modifiers:

1 Select one or more modifiers in the modifier stack display.

To select multiple modifiers, click to select one modifier, then hold down
Ctrl and click to select the others. Holding down Shift selects the two
modifiers you click and all modifiers in between them.

2 Right-click and choose Copy.

3 Select an item above which to paste the cut modifiers.

4 Right-click and choose Paste. The copied modifiers are pasted above the
current selection. Choose Paste Instanced to make the pasted modifiers
instances of those you copied.

To copy modifiers from one object to another:

1 Select one or more modifiers in the modifier stack display of the first
object.

To select multiple modifiers, click to select one modifier, then hold down
Ctrl and click to select the others. Holding down Shift selects the two
modifiers you click and all modifiers in between them.

2 Right-click and choose Copy.

3 Select the second object.

4 In the second object's modifier stack display, select an item above which
to paste the copied modifiers.

5 Right-click and choose Paste.

The modifiers from the first object are pasted above the current selection
in the second object. Choose Paste Instanced to make the pasted modifiers
instances of those you copied.
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Interface

Rename Lets you change the name of the modifier. For example, you might
change the name Bend to the more specific "First 45-degree bend." After
choosing Rename, enter the new name in the stack display, and then press
Enter. Pressing Esc cancels the name change.

Delete Deletes the modifier from the stack. The modifier is not available for
pasting.

Cut Cuts the modifier from the stack. The modifier is removed, but is available
for pasting.

Copy Makes a copy of the modifier that is available for pasting.

Paste Pastes the modifier into the stack. The modifier appears above the
currently selected object or modifier, unless it is a world space modifier, in
which case it is pasted at the top of the stack.

You can paste a modifier from one object into the stack of a different object.

Paste is unavailable when more than one modifier is selected in the stack.
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Paste Instanced Pastes an instance of the modifier into the stack. The modifier
instance appears above the currently selected object or modifier, unless it is
a world space modifier, in which case it is pasted at the top of the stack.

You can paste a modifier instance from one object into the stack of a different
object.

Paste Instanced is unavailable when more than one modifier is selected in the
stack.

Make Unique Converts an instanced modifier to a copy that's unique to the
current object. This button is unavailable unless the modifier you right-clicked
is instanced. See Make Unique on page 7654.

Collapse To Collapses a portion of the stack. Collapse To is unavailable unless
you select one or more modifiers in the stack. Using Collapse To collapses all
stack items from the object itself, up to and including the uppermost selected
stack item. If there are modifiers above the uppermost selection, they are not
changed.

The resultant object type depends on the uppermost modifier that outputs a
specific geometry type, if any. If the stack contains no such modifier, the result
is an editable mesh on page 2075. If the collapsed portion of the stack contains
a modifier that outputs a specific geometry type, and no other such modifier
is above it, the result is that type of object. For example, if the topmost such
collapsed modifier is Edit Poly, the resultant object is Editable Poly.

Collapse All Collapses the entire stack.

The resulting stack list shows a single entry: Editable Mesh, unless any
modifiers on the stack output a different type of geometry. For example, if
the topmost such modifier is Edit Poly, the resultant object is Editable Poly.

NOTE World-space modifiers on page 1113 don't collapse along with the rest of the
stack.

Convert To This menu item appears if no modifiers are applied to the object.
Choose one of the Convert To options:

■ Editable Mesh

■ Editable Spline

■ Editable Patch

■ Editable Poly

■ NURBS
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NOTE Depending on the object type, not all Convert To options might be
available.

Preserve Custom Attributes When on, collapsing an object's modifier stack
or converting it a different format such as Editable Poly preserves any custom
attributes on page 329 present in the stack.

On Turns on the effect of modifiers in both viewports and the renderer.

 The light-bulb icon to the left of the modifier name shows "on."

Off in Viewport Turns off the currently selected modifiers in viewports only.
Allows you to work in the viewport without the effects of the modifiers. You
see the effects when you render.

 The light-bulb icon to the left of the modifier name shows "off in
viewports."

Off in Renderer Turns off the currently selected modifiers in renderings only.
The effect of the modifiers is visible in viewports but not in renderings.

 The light-bulb icon to the left of the modifier name shows "off in
Renderer."

Off Turns off the currently selected modifiers without deleting them. This
can help you see the object without the effect of its modifiers.

 The light-bulb icon to the left of the modifier name shows "off."

Make Reference If the object is an instance, converts it to a reference. This
option is available only when the base object is selected, and only when the
base object is a reference.

When you make an instanced object into a reference, a heavy, "derived object"
bar appears at the top of the stack. You can select this bar and apply modifiers
above it. Modifiers applied above the bar affect the reference object only, and
not its parent object.
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Gray bar denotes a reference object at the base
of the stack

Show All Subtrees Expands the display of every hierarchical item in the stack
display, so that all items in the stack are visible, including sub-objects.

Hide All Subtrees Hides the subtree of every hierarchical item in the stack
display, so that only objects, modifiers, and space warp bindings are visible.

Make Unique 

Modify panel > Tool buttons > Make Unique

Modify panel > Right-click an instanced modifier in the stack display. > Make
Unique

Right–click an instanced object. > Make Unique

Make Unique lets you convert an instanced object to a copy that's unique. A
object is instanced when it is cloned (Shift+Move or Shift+Rotate). If you make
changes to an instanced object the changes are also reflected in the other
instances in your scene. Making objects unique lets you adjust or change those
objects independently without affecting any other objects in the scene.

TIP If you drag a material to a unique object and see the other instanced object
updating as well, turn off Automatic Material Propagation. Go to Customize menu
> Customize UI and choose Category: Instance Manager, then drag Automatic
Material Propagation to a toolbar or assign a keyboard shortcut to it. Using this
tool will allow the unique object to act uniquely.
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Procedures

Example: To use the Make Unique options with an instanced modifier:

1 Create a cylinder with some height segments, and then use Shift+Move
to create three copies, resulting in four identical cylinders.

2 Select all four cylinders, apply the Bend modifier, and adjust the Angle
setting just enough to see the results of the bend.

You now have four cylinders with a single instance of a Bend modifier
applied to them.

3 Choose Edit menu > Hold.

This lets you return to the current state of the scene at any time without
using Undo.

4  Select two of the cylinders and click Make Unique.

5 Choose Yes in the resulting dialog.

At this point, the two selected cylinders each have unique Bend modifiers,
while the remaining two cylinders share the original Bend. You can see
this by selecting each cylinder and changing the Bend Angle setting.

6 Choose Edit menu > Fetch, and answer Yes.

7 Select two cylinders again, and click Make Unique.

8 Choose No in the resulting dialog.

The two selected cylinders now share an instance of a Bend modifier, but
it's a different instance than that shared by the other two cylinders. Again,
you can see this by selecting each of the cylinders and changing the Bend
Angle spinner. You can also turn on Show Dependencies on page 167 in
the Views menu to see the relationship between the four cylinders and
the Bend modifier.

Example: To use Make Unique with an instanced object/modifier combination:

1 Create a cylinder with some height segments.

2 Apply a Bend modifier and adjust the Angle just enough to see the results
of the bend.

3 Use Shift+Move with the Instance option to create an instanced
object/modifier combination.
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4 Change the Bend Angle setting on one of the instances to demonstrate
that the cylinders and modifiers are truly instanced.

Both cylinders bend.

5 Select one of the instances, and then, in the modifier stack choose either
the Bend modifier or the cylinder itself.

6  Click Make Unique.

When you change the Bend Angle setting or cylinder base parameters
for one of the objects, the other doesn't change.

NOTE When you instance an object/modifier combination, all duplicates are
instances of a single master node containing the original object and modifier.
In such cases, you cannot selectively make the object or its modifier unique.
Clicking Make Unique for one or the other, makes both unique.

Interface

 Make Unique Detaches objects and modifiers (and combinations)
logically from the master node of which they're instances or references.

Go to the object or modifier level in the stack for an instanced or referenced
object or modifier (respectively), and click Make Unique.

For instanced object/modifier combinations, in the modifier stack, choose
either the modifier or the object itself.

Making New Instances

When you click Make Unique for a selection of two or more objects, a dialog
appears that asks: Do you want to make the selected items unique with respect
to each other? This gives you a choice of how you want to make the objects
unique.

■ Yes Makes the instanced modifiers assigned to the objects in the selection
unique for each object in the selection.

■ No All instanced modifiers assigned to the objects in the selection remain
instanced across the selected objects, but become unique from other objects
not in the selection.
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Modifier Sets Menu 

Modify panel > Configure Modifier Sets button

The button sets menu gives you options for managing and customizing
shortcut buttons for applying modifiers.

Procedures

To display the current button set on the Modify panel:

■  Click Configure Modifier Sets, and then choose Show Buttons to turn
on this item.
This item is a toggle. Choosing Show Buttons a second time turns off the
button display, and so on.

To configure a new modifier set:

■  Click Configure Modifier Sets, and then choose Configure Modifier
Sets on page 7658.

To change from one button set to another:

■ Click Configure Modifier Sets, and then choose the modifier set name
from the lower part of the menu.
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Interface

Configure Modifier Sets Displays the Configure Modifier Sets dialog on page
7658 to let you create a new, customized button set.

Show Buttons When on, buttons for the current modifier set are displayed
between the modifier list and the stack display. Default=off.

Show All Sets in List When on, the Modifier List is organized by sets. When
off, the Modifier List is organized simply into World-Space Modifiers and
Object-Space Modifiers, and is otherwise alphabetical except that the current
set appears at the top of the list. Default=off.

Saved button sets The bottom part of the Button Sets menu lists the names
of saved button sets. Choose one of these sets to make it the current button
set. The current set is displayed as buttons when Show Buttons is on. The
Modifier List drop-down is organized by sets when Show All Sets In List is on.

Configure Modifier Sets Dialog 

Modify panel > Configure Modifier Sets button > Configure Modifier Sets
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This dialog lets you create custom modifier and button sets for the Modify
panel.

Procedures

To choose a modifier and button set to edit:

■ Choose a button set from the Sets drop-down list.

To create a new modifier and button set:

1 Create a custom button set in the Modifiers group box. You use these
controls:

■ Use Total Buttons to change the number of buttons.

■ Drag a modifier from the Modifiers list to a button.

■ Highlight a button, and then double-click a modifier in the Modifiers
list. (When you assign a button by double-clicking, the highlight
moves to the next button in the Modifiers group.)

2 Enter the new set's name in the Sets edit field.

3 Click Save.

4 Click OK to leave the Configure Modifier Sets dialog.

To customize the current modifier and button set:

1 Use Total Buttons to choose the number of buttons in the set.

2 Assign buttons by dragging the names of modifiers in the dialog's
Modifiers list to buttons in the Modifiers group box.

3 Click OK.

3ds Max updates the Modifiers list. You can customize the set without
saving it, but if you save a new set under a new name, you can use it later.
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Interface

Modifiers Lists all modifiers currently available. It's organized into these
categories: Channel Info, Max Edit, Max Standard, Deformations, Max Surface,
Surface Tools, Modifiers, Radiosity, LIGHT, Max Additional, Shell, Spline Edits,
World Space Modifiers, and others. To add a modifier to the current button
set, drag the modifier's name from this list onto a button in the Modifiers
group box.

Sets This edit field and drop-down list lets you choose the modifier set to edit.
To create a new button set, enter the name in the edit field, and then click
Save.

Save Saves the current button set.

Delete Deletes the current button set.

IMPORTANT You can't undo deleting a button set.
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Total Buttons Sets the number of buttons in the button set. A button set can
have up to 32 buttons.

Modifiers group

Previews how the button set will appear on the Modify panel. Because the
box shows only 16 buttons at a time, a scroll bar on the right lets you see any
remaining buttons.

To change a button, drag the name of a modifier from the Modifiers list to a
button in this group box, or click the button (its border highlights) and then
double-click the modifier name.

Hierarchy Panel 

Command panels > Hierarchy panel

The Hierarchy panel provides access to tools to adjust the hierarchical linkage
between objects.

By linking one object to another, you create a parent-child relationship.
Transformations applied to the parent are also transmitted to the child. By
linking more objects to both parent and child objects you can create complex
hierarchies.
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Gyroscope assembled as a hierarchy.

The parent is the outer ring with handle.

The flywheel is the lowest child.

Common uses of linking are:

■ Creating complex motions.

■ Simulating jointed structures.

■ Providing the basis for inverse kinematics.

■ Setting rotational and sliding parameters for Bones.

The Hierarchy panel is divided into three areas:

Pivot  on page 3475

IK  on page 3485

Link Info on page 3500
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NOTE For important background information on hierarchies and kinematics, see
Animating with Forward Kinematics on page 3354 and Inverse Kinematics (IK) on
page 3374.

Motion Panel 

Select an object. > Command panels > Motion panel

The Motion panel provides tools to adjust the motion of the selected object.
Key timing and easing in and out of a key are parameters that you can adjust
with tools on the Motion panel, for example. The Motion panel also provides
an alternative to Track View for assigning animation controllers.

Additional rollouts display in the Motion panel if an assigned animation
controller has parameters. If a Path constraint is assigned to the position track
of an object, then a Path Parameters rollout is added to the Motion panel. A
Link constraint displays a Link Parameters rollout, a Position XYZ controller
displays a Position XYZ Parameters rollout, and so on.

Trajectories

Click Trajectories to chart a path that an object will travel along in the
viewports. Yellow dots along the path represent frames, giving you an idea of
velocity and easing. By turning on Sub-Object Keys, keys can be moved in
space, key properties can be changed, the trajectories will reflect all the
adjustments you make. You can also convert to and from splines and collapse
transforms using trajectories.

Interface

Parameters

Provides an alternative to Track View on page 3503 for adjusting transform
controllers and key information.

Assign Controller Rollout on page 7664

PRS Parameters Rollout on page 3126

Key Info (Basic) Rollout/Dialog on page 3127

Key Info (Advanced) Rollout/Dialog on page 3131
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Trajectories

Provides tools for working with objects' trajectories.

Trajectories on page 3121

Assign Controller Rollout

Select an object. > Motion panel > Parameters > Assign Controller rollout

The Assign Controller rollout assigns and appends different transform
controllers to individual objects. You can also assign controllers in Track View.

Animation controllers on page 3133 are plug-ins that handle all of the animation
tasks in 3ds Max. For a complete list of available animation controllers, see
Assign Controller (Track View) on page 3593.

Procedures

Example: To assign a TCB Rotation controller:

1 Select an object.

2 On the Motion panel, click Parameters, and open the Assign Controller
rollout.

3 Highlight the Rotation track in the Assign Controller list.

4  Click the Assign Controller button, choose TCB Rotation from the
Assign Rotation Controller dialog, and then click OK to close the dialog
and accept the change.

The default Euler XYZ Rotation controller is replaced with the TCB
Rotation controller.
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Interface

Assign Controller Displays the Assign Controller dialog. If no track is
highlighted, the Assign Controller button is unavailable.

Assign Controller dialog Choose a controller from a list of available controllers
in this dialog.

Depending on the type of track you've selected, the Choose Controller dialog
displays a subset of the different types of controllers. Rotation controllers, for
example, are available only for rotation tracks.

Display Panel

Command panels > Display panel

The Display panel provides access to tools that control the display of objects
in the scene.

Use the Display panel to hide and unhide on page 8002, freeze and unfreeze on
page 7989 objects, alter their display characteristics, speed up viewport displays,
and simplify your modeling procedures.

NOTE A target is considered part of its light or camera for purposes of hiding and
unhiding.
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Display Panel Rollouts

Display Color Rollout  on page 177

Hide By Category Rollout on page 178

Hide Rollout on page 179

Freeze Rollout on page 181

Display Properties Rollout on page 183

Link Display Rollout on page 188

Display Floater

Tools menu > Display Floater

This modeless dialog contains most of the functions on the Display panel.
You can leave the Display floater up while you work in your scene, making it
easier to change viewport displays without changing the current command
panel.

Interface

The Display floater has two panels: Hide/Freeze and Object Level.

Hide/Freeze panel

NOTE These functions are also available on the Display panel on page 7665 and
from the Display quadrant on page 7519of the default quad menu.
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Hide group

Selected Hides the selected object(s).

Unselected Hides all visible objects except the selected ones. Use this to hide
all the objects except the one you are working on.
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By Name Lets you select the objects to hide by name.

By Hit Causes any object you click in the viewport to be hidden. If you hold
the Ctrl key while selecting an object, that object and all of its children are
hidden. To exit Hide by Hit mode, right-click, press Esc, or select a different
function. This mode is automatically turned off if you hide all objects in the
scene.

Unhide group

All Unhides all hidden objects. The unhide buttons are only available when
you have specifically hidden one or more objects. They won't unhide objects
hidden by category.

By Name Displays a dialog in which you can unhide objects you select from
a list.

NOTE You cannot unhide objects on a hidden layer. If you select an object on a
hidden layer, you will be prompted to unhide the object's layer.

Freeze group

Selected Freezes the selected object(s) so they cannot move in the viewport.

Unselected Freezes all visible objects except the selected ones. Use this to
quickly freeze all the objects except the one you're working on.

By Name Lets you select the objects to freeze by name.

By Hit Causes any object you click in the viewport to be frozen. If you hold
the Ctrl key while selecting an object, that object and all of its children are
frozen. To exit Freeze By Hit mode, right-click, press Esc, or choose a different
function. This mode is automatically turned off if you freeze all objects in the
scene.

Unfreeze group

All Unfreezes all frozen objects.

By Name Displays a dialog in which you can unfreeze objects you select from
a list.

By Hit Causes any object you click in the viewport to be unfrozen. If you hold
the Ctrl key while selecting an object, that object and all of its children are
unfrozen.
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NOTE You cannot unfreeze objects on a frozen layer. If you select an object on a
frozen layer, you will be prompted to unfreeze the object's layer.

Hide Frozen Objects Toggles display of frozen objects on and off. You don’t
have to unfreeze objects to hide them; you can use Hide Frozen Objects instead
to hide or unhide frozen objects in a single step.

Object Level panel

Hide by Category group

Toggles the display of objects by their category (objects, cameras, lights, and
so on). Choose the check boxes to hide objects of that category. Use the All,
None, and Invert buttons to change the settings of the check boxes.
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NOTE These functions are also available on the Display panel on page 7665.

Display Properties group

Provides controls that alter the display of selected objects.

NOTE These options are also available on the Display panel on page 7665 and in
the Display Properties group on page 309 of the Object Properties dialog.

Display as Box Toggles the display of selected objects, including 3D objects,
2D shapes, and particle systems, as bounding boxes on page 7932. Produces
minimum geometric complexity.

Particle systems appear as bounding boxes when adaptive degradation takes
effect. Since particle systems naturally exist in world space, their bounding
box is always oriented parallel to the world planes.

Backface Cull Toggles the display of faces with normals on page 8059 pointing
away from view. When selected, you see through the wireframe to the back
faces.

Edges Only Toggles the display of hidden edges and polygon diagonals on
page 7953. When on, only outside edges appear. When off, all mesh geometry
appears. Applies to Wireframe viewport display mode, as well as other modes
with Edged Faces turned on.

Vertex Ticks Displays the vertices in the selected geometry as tick marks.

If the current selection has no displayed tick marks, the check box is clear. If
some of the vertices in the current selection display tick marks, the check box
contains a gray X. If all vertices in the current selection display tick marks,
the check box contains a black X.

Trajectory Toggles trajectory display on page 8154 for the selected object so you
can display its trajectory wherever you are in the software.

See-Through When on, makes the object or selection translucent in viewports.
This setting has no effect on rendering: it simply lets you see what’s behind
or inside an object in a crowded scene, and especially to adjust the position
of objects behind or inside the see-through object. Use this when you need
to see inside an object, such as a character with bones inside. Default=off.

You can customize the color of see-through objects by using the Colors panel
on page 7712 of the Customize > Customize User Interface dialog on page 7697.
Choose Geometry from the Elements list, and then choose See-Through.

Keyboard shortcut (default): Alt+X
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Ignore Extents Allows an object to be excluded from a zoom extents operation.
Choose this when you have lights or other distant objects that you don’t want
to use when you do a Zoom Extents on page 7594.

Show Frozen in Gray When on, the object turns gray in viewports when you
freeze it. When off, viewports display the object with its usual color or texture
even when it is frozen. Default=on.

Never Degrade When on, the object is not subject to adaptive degradation
on page 7900.

Utilities Panel 

Command panels > Utilities panel

The Utilities panel gives you access to a variety of utility programs. 3ds Max
utilities are provided as plug-ins on page 8092. 3ds Max ships with the utilities
listed below. Some utilities are available from third-party developers, so your
setup of 3ds Max might include utilities not described here. Look for
documentation describing these additional plug-ins by choosing Help >
Additional Help.

NOTE Documentation for MAXScript and Visual MAXScript is provided in a
separate help system. To access the MAXScript Reference, choose Help > MAXScript
Help. See About MAXScript on page 11.

See also:

■ List of Available Utilities on page 7463
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Interface

The Utilities panel contains one rollout for managing and invoking utilities.
While a utility is running, additional rollouts can appear. Some utilities use
a dialog rather than rollouts.

The Utilities rollout contains the following controls at the top:

More Displays a Utilities dialog that lists all utilities not already displayed in
buttons on the Utilities panel. Highlight a utility in the list and then click OK
to display its controls in the Utilities panel. (You can also double-click the
utility's name.)

Sets Displays a list of button sets to choose from. By default, there is only one
button set, called MAX Default. You can create custom button sets by clicking
Configure Button Sets.

Configure Button Sets Displays the Configure Button Sets dialog on page 7673,
where you can create custom button sets of up to 32 buttons.

Named utility buttons These buttons show a selection of utilities. Click one
of these buttons to run a utility. The utility's parameters can appear in rollouts
below the Utilities rollout. Some utilities use a dialog rather than rollouts.

While a utility is running, its button remains active until you click it again to
turn it off and close the utility, or when you click a different utility's button.

Many utilities have a Close button that appears at the bottom of their rollout.
This is another way to close a utility. If the utility controls appear in a dialog
rather than a rollout, closing the dialog closes the utility.
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Utilities Dialog

Utilities panel > Utilities rollout > More... button

This dialog lists all utilities that are not already displayed in current button
set of the Utility rollout.

Procedures

To run a utility shown in the Utilities dialog, do one of the following:

1 Choose a utility in the list and then click OK.

2 Double-click the utility's name.

Interface

Configure Button Sets Dialog 

Utilities panel > Utilities rollout > Configure Button Sets button
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This dialog lets you create custom button sets for the Utilities panel. Once
created, these utility sets are available from the Sets button on the Utilities
panel.

Procedures

To customize the current button set:

1 Use Total Buttons to choose the number of buttons in the set.

2 Assign buttons by dragging the names of utilities in the Utilities list to
buttons in the Utilities group box.

3 Clear buttons by dragging them to the Utilities list on the left.

4 Click OK.

3ds Max updates the Utilities rollout. You can customize the button set
without saving it, but if you save a new button set under a new name,
you will be able to use it later.

TIP Don't alter the Default button set. Create a new one instead.

To create a new button set:

1 Create a custom button set as described in the previous procedure.

2 Enter a new button set name in the Sets edit field.

3 Click Save.

To choose a button set to modify:

■ Choose a button set from the Sets drop-down list.
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Interface

Utilities List This lists all the utilities currently available to 3ds Max. It is
organized into a number of categories, including MAX STANDARD, Channel
Info, NURBS, Radiosity, Skin Tools, Strokes, MAXScript Tools, Internet
Extensions, Realviz Products, and reactor. To add a utility to the current button
set, drag the utility's name from this list to the Utilities group box.

Sets edit field and drop-down list Lets you choose the button set to modify.
By default, there is a single button set called MAX Default.

TIP Don't alter the Default button set. Create new sets as the need arises.

Save Saves the current button set.

Delete Deletes the current button set.

WARNING You can't undo the deletion of a button set.

Total Buttons Sets the number of buttons in the button set. A button set can
have up to 32 buttons.
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Utilities group

This group previews how the button set will appear in the Utilities rollout. A
scroll bar on the right lets you see other buttons when the set has more than
eight.

To change a button, drag the name of a utility from the Utilities list to a button
in this group.

MAXScript Interface
Menu bar > MAXScript

Utilities panel > MAXScript

MAXScript on page 11 is the software's built-in scripting language. Its main
interface, the MAXScript menu, contains the following commands for creating
and working with scripts:

New Script on page 7676

Open Script on page 7677

Run Script on page 7677

MAXScript Listener on page 7677

Macro Recorder on page 7678

Visual MAXScript Editor on page 7679

MAXScript Debugger Dialog on page 7680

In addition, the status bar on page 7524 contains a MAXScript Mini Listener on
page 7525, and MAXScript functionality is also available from the Utilities panel
on page 7671.

For detailed information about MAXScript, open the MAXScript Reference,
available from Help menu > MAXScript Reference.

New Script

MAXScript menu > New Script

Utilities panel > Click MAXScript. > MAXScript rollout > New Script
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New Script opens a new MAXScript Editor window. Use this window for writing
a new script.

For detailed information about the MAXScript utility, open the MAXScript
Reference, available from Help menu > MAXScript Reference.

Open Script

MAXScript menu > Open Script

Utilities panel > Click MAXScript. > MAXScript rollout > Open Script

Open Script opens a common file open dialog for choosing an existing script.
A new MAXScript Editor window then displays the selected script.

For detailed information about the MAXScript utility, open the MAXScript
Reference, available from Help menu > MAXScript Reference.

Run Script

MAXScript menu > Run Script

Utilities panel > Click MAXScript. > MAXScript rollout > Run Script

Run Script opens a common file open dialog for choosing an existing script.
MAXScript then reads and executes the selected script. Any output is printed
to the Listener window.

For detailed information about the MAXScript utility, open the MAXScript
Reference, available from Help menu > MAXScript Reference.

MAXScript Listener

MAXScript menu > MAXScript Listener

Mini Listener > Right-click menu > Open Listener Window

Utilities panel > Click MAXScript. > MAXScript rollout > Open Listener

Keyboard > F11

The MAXScript Listener window is an interactive interpreter for the MAXScript
language and works similar to a DOS command prompt window. You enter
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MAXScript commands in this window, and when you press Enter they are
executed immediately.

The Listener window is appropriate for performing interactive work and
developing small code fragments. Each command you execute in the Listener
is actually an expression with a result that the Listener prints out after each
execution. You can enter any MAXScript expression or sub-expression in the
Listener for evaluation, and the Listener prints out its result.

The Listener is divided into two panes. The top (pink) pane is the Macro
Recorder pane, and the bottom (white) pane is the output pane. When the
Macro Recorder is enabled, everything recorded is displayed in the Macro
Recorder pane. The output of results from scripts are displayed in the output
pane. The output of code executed in the Macro Recorder pane is always
directed to the output pane so as not to clutter the recordings. Both panes
allow you to cut-and-paste, drag-and-drop, edit, select, and execute code. You
can resize the panes by dragging the split bar between them.

The left-end of the status bar contains a resizable Mini Listener. If the Mini
Listener is not visible, drag on the vertical split bar at the left end of the status
bar to reveal the Mini Listener. The Mini Listener panes act as single-line
sliding windows for the current line in the corresponding Listener panes. The
Mini Listener panes always show what you are typing or where the edit cursor
is placed in the Listener panes. Conversely, anything you type into a Mini
Listener pane is entered into the corresponding Listener pane at the current
edit cursor position.

The MAXScript Mini Listener on the
Status Bar

You can install the Listener into any viewport by right-clicking the viewport
label, choose Views > Extended, and then MAXScript Listener.

For detailed information about the MAXScript utility, open the MAXScript
Reference, available from Help menu > MAXScript Reference.

Macro Recorder

MAXScript menu > Macro Recorder
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The MAXScript Macro Recorder captures many of the actions performed by
the user, and generates the MAXScript commands that correspond to those
actions. Output from Macro Recorder is displayed in the Macro Recorder pane
of the MAXScript Listener window. Several filtering options are available that
control what types of user actions are recorded, whether the generated
MAXScript commands contain explicit object references or are
selection-relative, and whether the generated MAXScript commands contain
absolute or relative transforms and coordinates. These options are set using
the MacroRecorder menu in the Listener window. The default option settings
are specified in the MAXScript page of the 3ds Max Preferences dialog, as
described in MAXScript Preferences on page 7782. You can also make and change
these settings by editing the [MAXScript] section of the 3dsmax.ini on page 83
file.

While many areas in the software generate Macro Recorder output, there are
also many areas that do not. In general, most of the buttons on the software’s
menu bar, toolbars, status bar, Create panel, and Modify panel will generate
Macro Recorder output. If the button invokes a secondary dialog, changing
settings or performing actions in the secondary dialog typically do not generate
Macro Recorder output. In the Create and Modify panels, Macro Recorder
output is typically generated if the object or modifier can be created by
MAXScript. In rare cases, the plug-ins implementing an object or modifier
have not been updated to support Macro Recorder, so that object or modifier
does not generate Macro Recorder output.

MAXScript supports text drag-and-drop onto toolbars to create Macro Script
buttons. You can select and drag text from any text window, such as the
Listener window panes or Editor window, onto any visible toolbar. The cursor
changes to an arrow with a + sign when it is permissible to drop the text.
Dropping it at that point adds a Macro Script button to the toolbar with the
dropped text as the body of the Macro Script. A typical usage of this would
be to drag text from the Macro Recorder pane onto a toolbar to make a button
that does the sequence of events just recorded.

For detailed information about the MAXScript utility, consult the MAXScript
Reference, available from Help menu > MAXScript Reference.

Visual MAXScript Utility (See MAXScript
Reference)

Utilities panel > Utilities rollout > More button > Visual MAXScript
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Visual MAXScript is a powerful interface to the 3ds Max scripting language,
making the MAXScript feature easier to learn and use. With Visual MAXScript,
you can quickly create UI elements and layouts for scripting.

For detailed information about Visual MAXScript, open the MAXScript Reference,
available from Help menu > MAXScript Reference.

MAXScript Debugger Dialog

MAXScript menu > Debugger Dialog

MAXScript Listener > Debugger menu > Debugger Dialog

MAXScript Editor > Debugger menu > Debugger Dialog

The MAXScript debugger implements the first half of a script development
and debugging environment. It allows the main thread of 3ds Max to be
suspended, the values of global and local variables to be examined and altered
while the thread is not running, MAXScript commands to be executed from
a command line, and the execution to be suspended using method calls from
inside the MAXScript code. The debugger also lets you stop or continue the
execution of the suspended code.

For detailed information about the MAXScript debugger, consult the MAXScript
Reference, available from Help menu > MAXScript Reference.

Running Scripts from the Command Line

3ds Max allows you to enter MAXScript commands directly on the command
line. When you launch 3ds Max from a DOS command line, you can have it
run a specified launch script. This can be useful for tasks such as unattended
batch-rendering. This capability uses the existing -U command line switch
that names a utility to be run when 3ds Max is started. The -U switch allows
an optional extra argument which, for MAXScript, is taken to be the name of
the launch script to run. The case (capitalization) of MAXScript must be as
shown in the following example (entered after you CD to the program
directory):

See the online Help to view this code sample.

This example command line would launch the 3ds Max executable , start
MAXScript, and then have it run the launch script rendercams.ms.
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The following example launch script loads two scenes, renders frames from
each of the cameras in them, and then quits 3ds Max:

See the online Help to view this code sample.

This example makes use of the quitMax() method to exit 3ds Max when the
script is finished. Launch scripts need not be batch scripts as in this example,
but may be used to condition 3ds Max for interactive use, for example by
loading a scene file and setting some user-interface options.

The normal startup scripts, startup.ms and those in the \scripts\startup directory,
are run before the launch script. It is also possible to install scripts into
individual scene files that run automatically when that scene is open or closed
or at certain other events.

NOTE Command line -U MAXScript startup scripts are run after 3ds Max has
completely booted and the standard scripts and startup scripts have been run.

MAXScript Command-Line Switches

The following switches work specifically with MAXScript files and functions.

EffectSwitch

Starts 3ds Max in a minimized mode –
but never allows you to open the win-
dow for interactive usage.

-mip

This switch is essentially the same as -U
MAXScript file.ms, but avoids the need

-mxs

for the .ms file. You can follow the
switch with MAXScript commands.

Comparable to the MAXScript com-
mand, setSilentMode, this switch sup-

-silent

presses all MAXScript and 3ds Max UI
dialogs so that batch scripts specified
by the –U command do not get interrup-
ted.

Opens a specified MAXScript file.-u MAX-
Script <file-
name>
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Examples of desired syntax usage:

See the online Help to view these code samples

7682 | Chapter 25   User Interface



Customizing the User
Interface

You can rearrange the components of the 3ds Max user interface, including the menu bar,
toolbars, and command panel. You can also dynamically resize the viewport windows. You
can specify which toolbars should appear and which should not, and create your own keyboard
shortcuts, custom toolbars, and quad menus. You can also customize the colors used in the
User Interface.

For procedures that tell how to rearrange and resize UI components, see Useful Customization
Techniques on page 7683. Various other customization options are available from the Customize
menu on page 7494.

See also:

■ Customize Display Right-Click Menu on page 7687

■ Customize User Interface Dialog on page 7697

■ Saving and Loading Custom User Interfaces on page 7722

■ Revert to Startup Layout on page 7728

■ Configure Paths on page 7728

■ Preferences on page 7743

Useful Customization Techniques
This topic offers procedures for customizing the 3ds Max user interface, including
methods for rearranging and resizing UI components. Various other
customization options are available from the Customize menu on page 7494.
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Procedures

To switch between a single-viewport and multi-viewport layout:

1  By default, 3ds Max starts with a multi-viewport. To switch to a
single-viewport layout, activate a viewport and click the Min/Max Toggle
on page 7589.

2  By default, 3ds Max starts with a single viewport. To switch to a
multi-viewport layout, click the Min/Max Toggle on page 7589.

To resize the windows in a multi-viewport layout:

■ With your cursor, click the splitter bar between any two viewports, or at
the intersection of all four viewports, and drag to a new location. When
you release the mouse, the new viewport layout is defined.
The dividers are saved in the scene, but are reset when you change the
layout. This feature does not allow you to define new layouts, only to
adjust the proportions of the currently existing ones.

To reset the viewport windows to the default layout:

1 Right-click the splitter bar between the viewports.

The Reset Layout button is displayed.

2 Click this button to restore the viewports to the default multi-viewport
layout.

To rearrange the order of rollouts in the command panel:

■ Click the rollout title bar, and drag to another location on the command
panel. A thick line indicates where the rollout will be placed. When you
release the mouse button, the rollout is moved to the indicated location,
and the other rollouts are shifted appropriately.
The order of rollouts is saved in the text file rolluporder.cfg, which is located
in the \ui subdirectory.
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To float a toolbar, do one of the following:

1 Click the tag bar of the docked toolbar (a narrow line displayed when
the toolbar is docked) and drag it away from its location. The toolbar is
now floating; you can reposition, resize, or dock it.

2 Right-click the tag bar of the docked toolbar (a narrow line displayed
when the toolbar is docked), and then choose Float.

To float the command panel, do one of the following:

1 Right-click the blank area at the upper-right corner of the command
panel, and then choose Float.

2 Click a corner of the upper portion of the command panel and drag it
into the viewport.

TIP If you find you tend to float the command panel accidentally, use Lock
UI Layout on page 7690.

To resize the docked command panel horizontally:

■ Move the cursor over the edge of the docked command panel that is nearest
the viewports. The cursor changes to a double arrow. Drag the cursor to
increase or decrease the width of the command panel.
The command panel grows or shrinks in column increments. Unless the
command panel is hidden, there is always at least one column. When the
command panel is docked, the columns must fit within the main 3ds Max
window.
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Multiple command panels are useful when working with objects such as particle
systems, which have many controls.

To resize the floating command panel horizontally:

■ Move the cursor over the left or right edge of the floating command panel.
The cursor changes to a double arrow. Drag the cursor to increase or
decrease the width of the command panel.
The command panel grows or shrinks in column increments. Unless the
command panel is hidden, there is always at least one column. When the
command panel is floating, you can display as many columns as you want.

To resize the floating command panel vertically:

■ Move the cursor over the top or bottom edge of the floating command
panel. The cursor changes to a double arrow. Drag the cursor to increase
or decrease the height of the command panel as you do for other windows
on the desktop.
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To dock a floating UI element, do one of the following:

1 Drag the panel by its title bar to the top, bottom, left, or right edge of
the program window. The mouse cursor and the panel outline change
shape at a docking location. Release the mouse.

2 Right-click the title bar, choose Dock from the pop-up menu, and then
choose Top, Bottom, Left, or Right.

3 Double-click the handle or title bar.

A UI element docks automatically when it approaches a "dockable"
location. The toolbars and menu bar can dock at the top or bottom, left
or right of the viewports. They can also dock on either side of the
Command panel.

To hide a panel or toolbar, do one of the following:

■ When a panel or toolbar is floating, you can hide it by clicking the X
control in the upper-right corner.

Customize Display Right-Click Menu
The Customize Display right-click menu displays when you right-click over a
blank area of a toolbar (not when the cursor is over a button). It is also available
when the cursor is immediately above, below, or to the right of the command
panel tabs: in these locations, the cursor changes to look like a stack of two
sheets of paper. In addition, the menu displays when you right-click at the
right edge of the command panel when docked, or, when floating, at the right
or left edge.
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Right-click a blank area of a toolbar to open the Customize Display right-click menu.

Use this menu to toggle the display of various user-interface elements,
customize the display of toolbars, and dock or float items such as the command
panel.

Interface

The following options are displayed in all cases:

Customize Opens the Customize User Interface dialog on page 7697, which lets
add commands and macro scripts to new and existing toolbars.

Command Panel Toggles the command panel display. Default=on.

Main Toolbar Toggles the main toolbar on page 7499. Default=on.

Axis Constraints Toggles the Axis Constraints toolbar on page 7503. Default=off.

Layers Toggles the Layers toolbar on page 7504. Default=on.

Reactor Toggles the reactor toolbar on page 7505. Default=off.
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Extras Toggles the Extras toolbar on page 7506. Default=off.

Render Shortcuts Toggles the Render Shortcuts toolbar on page 7506.
Default=off.

Snaps Toggles the Snaps toolbar on page 7508. Default=off.

Additional Options: Docking and Floating

Depending on the cursor location when you right-click, the menu can also
display these options:

Dock Docks the active item to the specified location: Top, Bottom, Left, or
Right.

NOTE For more information on docking toolbars, see Customizing the User
Interface on page 7683.

Float Floats the active item.

NOTE This option is available only for docked items.

Show UI
Customize menu > Show UI

The Show UI submenu lets you add or remove UI (user interface) elements
from the workspace, so that you can customize your screen as you work. You
can turn these elements on and off as you need by selecting them from the
menu, maximizing the efficiency of your workspace. The settings are stored
in the maxstart.cui file, so they will remain after you shut down and restart
3ds Max.

Choosing a UI element from the Show UI submenu toggles the display of that
element. The submenu displays a check mark next to the UI element when it
is currently being displayed.

Keyboard shortcuts for turning on and off UI elements are displayed next to
their corresponding UI elements in the Show UI menu.
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You can use the Show UI menu to hide or display the following UI elements:

Command Panel on page 7630

Floating Toolbars (toggles all toolbars other than the main toolbar, including
the Axis Constraints Toolbar on page 7503, Layers Toolbar on page 7504, and
Extras Toolbar on page 7506)

Main Toolbar on page 7499

Track Bar on page 7531

Lock UI Layout
Customize menu > Lock UI Layout

When the Lock UI Layout toggle is active, you cannot modify the user interface
layout by dragging interface elements. (You can still use the right-click menu
to do so, however.) Use this command to prevent user interface changes or
inadvertent actions, such as floating toolbars, from happening due to mouse
clicks.

TIP Use this command if you find you are inadvertently selecting and floating on
page 7957 UI elements such as the Command panel.

Procedures

To lock the UI layout:

■ Choose Lock UI Layout from the Customize menu.
You can no longer move or resize the UI elements. Use this command to
prevent user interface changes or if you find yourself accidentally floating
toolbars or the command panels on mouse clicks.

Plug-In Manager
Customize menu > Plug-in Manager

The Plug-in Manager lets you manage plug-ins dynamically without any
initialization required. The Plug-in Manager provides a list of all plug-ins found
in the 3ds Max plug-in directories, including the plug-in description, type
(object, helper, modifier, and so on), status (loaded or deferred), size, and
path. The Plug-in Manager provides options to load any plug-in, regardless
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where it resides on disk. The Plug-in Manager is similar to Summary Info on
page 7122, but with more options.

See also:

■ 3rd Party Plug-Ins Path Configuration on page 7740

Interface

When you start the Plug-in Manager, it scans through all the plug-in paths
specified in the plugin.ini file and lists them in the Plug-in Manager dialog.
The information is divided up into columns as described following.

Tag Use the right-click menu and select Tag Selected to add a check mark for
selected plug-ins. Tagging plug-ins lets you perform right-click menu actions
on them. Thus you can tag multiple plug-ins and perform a single operation
on all of them.

Name The filename of the plug-in.

Description A description of the plug-in.

Status Indicates whether the plug-in is loaded (green) or deferred (yellow).

Size File size of the plug-in.

Full Path The disk location of the plug-in file.
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Plug-in Directories

3ds Max uses the plug-in directories listed in plugin.ini. You can also configure
these paths with the 3rd Party Plug-Ins panel on page 7740 of the Configure
User Paths dialog. You can display or hide all the plug-ins in a directory by
toggling the check box.

Description Shows directory description from plugin.ini file.

Load Path The path of the plug-in directory.

Right-Click Menu

The right-click menu for the Plug-in Manager works in the list of plug-ins,
and in the blank area beneath the list. It does not work in the list of plug-in
directories. The commands apply to two possible states for the listed plug-ins:
selected (that is, highlighted) and tagged (a check mark appears to the left of
the plug-in name).

Selected Plug-ins To load plug-ins, highlight one or more plug-ins, choose
this item, and then choose Load.

Clear Selection Removes highlighting from all items in the list.

Tagged Plug-ins To load tagged plug-ins, choose this item, and then choose
Load.

Tag Selected Tags all highlighted plug-ins.

Clear Tags Clears all tags.

Load New Plug-in Loads a plug-in from the hard drive. Use the file dialog to
locate the plug-in, and then click Open.

Refresh View Refreshes the list of plug-ins.

Custom UI and Defaults Switcher
Customize menu > Custom UI and Defaults Switcher

Artists and designers in different industries use 3ds Max in different ways. The
Custom UI and Defaults Switcher lets you quickly change your program
defaults and UI scheme to more closely match the type of work you are doing.

The Initial settings for tool options control the default settings for various features
in 3ds Max, while the UI Schemes control how the 3ds Max interface looks.
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The dialog displays a detailed explanation for each of the four default sets and
two UI Schemes that ship with 3ds Max. If you create your own defaults or
UI Scheme, they also appear in the list. However, you cannot edit the general
description of custom default sets or UI schemes.

See also:

■ Market-Specific Defaults on page 7694

Interface

Initial settings for tool options This list contains different sets of default
settings for various tools in 3ds Max. Highlight the set that corresponds to
the tools you are using.
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3ds Max ships with four default sets:

■ Max contains the set of default settings for general animation use without
the mental ray renderer on page 6230.

■ Max.mentalray contains the set for general animation use with the mental
ray renderer.

■ DesignVIZ contains the set for design visualization use without the mental
ray renderer.

■ DesignVIZ.mentalray contains the set for design visualization use with the
mental ray renderer.

Highlight any of these sets to see detailed explanations of the affected settings.

For information on creating or editing defaults sets, see Market-Specific Defaults
on page 7694.

NOTE  To apply new defaults, restart 3ds Max.

UI Schemes This list contains all of the UI schemes defined in the \UI folder.
3ds Max ships with two UI schemes: DefaultUI, and ModularToolbarsUI, which
has the main toolbar on page 7499 broken up into smaller toolbars. Highlight
the name of the UI scheme in the list to see a description (and image) of the
interface.

This list also contains any UI schemes you have saved with the Save Custom
UI Scheme dialog on page 7725. However, no description or image is displayed
for these schemes.

Set Applies the selected default settings and UI scheme to 3ds Max.

NOTE  To apply new defaults, restart 3ds Max.

Cancel Closes the dialog without applying any changes.

Market-Specific Defaults
3ds Max is used in many different professional markets, including film, design,
and visualization, and games. The workflow and performance requirements
for users from these markets vary tremendously. As a result, different default
settings are ideal for different types of scenes.

For example, a typical animation scene has a small number of lights; shadow
maps on page 8125 provide a fast, accurate solution to generating shadows. On

7694 | Chapter 26   Customizing the User Interface



the other hand, a typical design visualization scene can contain hundreds of
lights, in which case shadow maps can cause memory issues. For this type of
scene, ray-traced shadows on page 8103 are much more appropriate.

In order to provide an efficient working environment for both project types,
3ds Max offers four sets of market-specific defaults, tailored specifically for
general animation scenes and for design visualization projects (both with and
without the use of the mental ray renderer on page 6230). The sets are each
located in their own subdirectories of the \defaults directory. These
subdirectories each contain an INI file (currentdefaults.ini), which contains the
global parameter defaults, a default material library (medit.mat), which
populates the Material Editor at startup, and a startup file (maxstart.max),
which is the file that opens when 3ds Max is started or when you reset. You
can edit any of these files, and you can also create your own sets, however
each set must be in a separate subdirectory of \defaults. in addition, each file
in the directory should have the same names (currentdefaults.ini, medit.mat, and
maxstart.max). If one of these files is not present in a custom defaults directory
that you have created, 3ds Max uses the corresponding file from the
\defaults\max directory in its place.

NOTE For your protection, both of the preset default directories have a subdirectory
named \factorydefaults, which contains the original files for each set. You can use
these files in the event that you have changed your defaults and are unhappy with
the results. They are also a useful starting point for creating your own set; copy
them to a new directory and edit them. It is highly recommended that you do not
edit the files in the \factorydefaults directories.

Default sets are assigned through the Custom UI and Defaults Switcher on
page 7692.

Procedures

To change the current set of defaults:

1 Choose Customize menu > Customize UI And Defaults Switcher.

2 Select one of the default sets from the Initial settings for tool options list and
click Set.

3 Restart 3ds Max to load the new default parameters.

Market-Specific Defaults | 7695



Interface

Include the following files in your default directory. If one or more of these
files is not present in the current Defaults directory, 3ds Max uses the
corresponding file from \defaults\max in its place.

currentdefaults.ini

The following table describes all of the sections that can be set in a default
INI file. Any parameter with a blank or invalid value uses the hard-coded
default.

NOTE See the online User Reference to view this table.

medit.mat

medit.mat is the default material library in your scene.

maxstart.max

The maxstart.max file is loaded when you start or reset 3ds Max.

COM/DCOM Server Control Utility
Utilities panel > Utilities rollout > More button > COM/DCOM Server Control

The COM/DCOM Server Control utility supports plug-ins and third-party
programs that use the COM (Component Object Model). The idea behind the
COM is to expose the core of 3ds Max so applications can invoke 3ds Max to
generate images.

The COM facility is intended for application developers. For more information
about applications development with 3ds Max, see the description of the COM
object interface in the help file (3dsMaxSDKFull.chm) for the 3ds Max Plug-In
Software Development Kit (SDK).

Procedures

To register 3ds Max as a DCOM server:

1 Start 3ds Max and go the Utilities panel. Click More, choose COM/DCOM
Server Control, and then click OK.
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2 If the button in the COM/DCOM Server Control rollout says Register,
then click it. If it says Unregister, then do nothing, as 3ds Max is already
registered.

Now 3ds Max is registered as a DCOM server and an instance of it can
be created from any COM client.

NOTE Not all products include this utility. You can build it from the source
located in \maxsdk\samples\utility\comsrv\. Copy the resulting comsrvui.dlu
to the 3ds Max \plugins directory.

It is also possible to register and unregister from the command line. There are
two command-line options that can be passed to 3ds Max:

3DSMAX -RegisterMAXRenderer

3DSMAX -UnregisterMAXRenderer

Customize User Interface Dialog
Customize menu > Customize User Interface

The Customize User Interface dialog lets you create an entirely customized
user interface, including shortcuts, quad menus, menus, toolbars, and colors.
You can also add commands and macro scripts by selecting either a text or
icon button to represent the command or script on the toolbar.

Most commands in the 3ds Max interface appear in this dialog as action items.
An action item is simply a command that you can assign to a keyboard
shortcut, toolbar, quad menu, or menu. The Keyboard, Toolbars, Quads, and
Menus panels of this dialog show tables of action items that you can assign.
(Tables in the Colors panel list UI elements, instead.)

NOTE A few action items do not correspond to any elements in the default user
interface. See Additional Keyboard Commands on page 7465.

Keyboard Panel on page 7698

Toolbars Panel on page 7700

Quads Panel on page 7704

Menus Panel on page 7709

Colors Panel on page 7712
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See also:

■ Customizing the User Interface on page 7683

■ Saving and Loading Custom User Interfaces on page 7722

Keyboard Panel

Customize menu > Customize User Interface > Keyboard tab

The Keyboard panel lets you create your own keyboard shortcuts. You can
assign shortcuts to most commands available in the software.

The same shortcuts can be assigned to multiple commands, as long as they
occur in different contexts. For example, in Video Post, the shortcut Ctrl+S is
assigned to Add Scene Event; however, in the Main UI, it is assigned to Save
File.

When you use a keyboard shortcut, the software looks for a context-specific
shortcut first. If none is found it then looks for the appropriate command in
the Main UI shortcuts.

for the context-specific shortcuts to work properly, the Keyboard Shortcut
Override toggle on page 7858 must be on (the default). If it is off, only the Main
UI keyboard shortcuts are available.

See also:

■ Keyboard Shortcuts on page 7857

Procedures

To create a keyboard shortcut:

1 Choose Customize menu > Customize User Interface > Keyboard panel.

2 Use the Group and Category lists to find the action for which you want
to create a shortcut.

3 Click action in the Action list to highlight it.

4 In the Hotkey field, enter the keyboard shortcut you want to assign to
the action.
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NOTE If the keyboard shortcut you enter is already assigned to an action,
that action name appears in the Assigned To field.

5 Click Assign.

Interface

Group Displays a drop-down list that lets you select the context you want to
customize, such as Main UI, Track View, Material Editor, and so on.

Active Toggles availability of context-specific keyboard shortcuts. When on,
you can use duplicate shortcut keys between contexts within the overall user
interface. For example, A can be the shortcut for Angle Snap toggle within the
Main UI, and also a shortcut for Assign Material to Selection when you are
working in the Material Editor. When Active is off, the shortcuts defined for
the appropriate context are not available. Default=on.
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Category Displays a drop-down list of all the available categories of user
interface actions for the selected context.

Action list Displays all the available actions and shortcuts, if defined, for the
selected group (context) and category.

Hotkey Allows you to enter a keyboard shortcut. Once the shortcut is entered,
the Assign Button is active.

Assigned To Displays the action a shortcut is assigned to if the shortcut you
entered is already assigned.

Assign Activates when you enter a keyboard shortcut in the Hotkey field.
When you click Assign, it transfers the shortcut information to the Action list
on the left side of the dialog.

Remove Removes all shortcuts for the selected action in the Action list on
the left side of the dialog.

Write Keyboard Chart Opens the Save File As dialog, where you can save
changes you made to keyboard shortcuts in a TXT file that you can print.

Overrides Active When on, holding keys for boldface shortcuts in the Edit
Poly and Editable Poly groups overrides standard functionality. For example,
while editing an Editable Poly object at the Polygon sub-object level, pressing
and holding Shift+Ctrl+B activates the Bevel tool temporarily, overriding the
current operation.

Delay To Override The delay before which the active keyboard shortcut
overrides the current operation (see Overrides Active, preceding).

Load Displays the Load Shortcut File dialog. Allows you to load custom
shortcuts, from a KBD file into your scene.

Save Displays the Save Shortcut File As dialog. Allows you to save any changes
you’ve made to the shortcuts to a KBD file.

Reset Restores the shortcuts to the default setup (defaultui.kbd).

Toolbars Panel

Customize menu > Customize User Interface > Toolbars tab

The Toolbars panel lets you edit existing toolbars and create your own custom
toolbars. You can add, remove, and edit buttons on existing toolbars, or you
can delete the toolbars entirely. You can also create custom toolbars with both
3ds Max commands and scripts.
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Procedures

To create and populate a toolbar:

1 Choose Customize menu > Customize User Interface > Toolbars tab.

2 Click New.

The New Toolbar dialog appears.

3 Enter the name of the toolbar and click OK.

The new toolbar appears as a small floater. Like any floating toolbar, you
can resize it and change proportions by dragging the corners and edges.

4 Use any of these three methods to add commands to the toolbar:

■ Drag a command to the toolbar from the Customize User Interface
dialog > Action list. If the action has a default icon assigned to it (it
appears next to the command in the action list), the icon will appear
as a button on your toolbar. If no icon is assigned to the command,
the name of the command will appear as a button on the toolbar.

■ To copy an existing button, Ctrl+drag the button from any toolbar
onto your toolbar.

■ To move an existing button, Alt+drag the button from any toolbar
onto your toolbar.

5 If you don’t want the new toolbar to appear in the interface by default,
choose it from the drop-down list on the right side of the Customize User
Interface dialog, and then turn on the Hide check box. Thereafter you
can toggle the custom toolbar by right-clicking a blank area of any toolbar
and choosing the toolbar name from the context menu.

To add commands to a toolbar:

1 Choose Customize menu > Customize User Interface > Toolbars panel.

Alternatively, right-click the label of a toolbar and then choose Customize.

2 If necessary, open the toolbar to customize using either of the following
methods:

■ Right-click a blank area of any toolbar and choose the toolbar name
from the context menu.

■ Choose the toolbar name from the toolbars drop-down list on the
right side of the dialog and then turn off the Hide check box.
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3 Use any of these three methods to add commands to the toolbar:

■ Drag a command to the toolbar from the Customize User Interface
dialog > Action list. If the action has a default icon assigned to it (it
appears next to the command in the action list), the icon will appear
as a button on your toolbar. If no icon is assigned to the command,
the name of the command will appear as a button on the toolbar.

■ To copy an existing button, Ctrl+drag the button from any toolbar
onto your toolbar.

■ To move an existing button, Alt+drag the button from any toolbar
onto your toolbar.

To record a script and add it to a toolbar:

Use this method to record a series of commands into a MAXScript command
sequence and then turn the script into a toolbar button. You can then re-invoke
that sequence at any time. No scripting knowledge is necessary.

1 Choose Customize menu > Customize User Interface > Toolbars panel.

Alternatively, right-click the label of a toolbar and then choose Customize.

2 Open a MAXScript Listener window by any of the following methods:

■ Press F11.

■ Choose MAXScript menu > MAXScript Listener.

■ Choose Utilities panel > MAXScript > MAXScript rollout > Open
Listener.

■ Right-click a viewport label, and then choose Views > Extended >
MAXScript Listener.

3 Choose MAXScript menu > Macro Recorder, or, from on the Listener
dialog, choose MacroRecorder > Enable.

4 Perform the actions you want to record.

The Macro Recorder records the actions you perform as a script in the
upper portion of the Listener dialog (pink background).

5 Highlight the lines you want in the recorded script, and then drag those
lines directly onto a toolbar.

NOTE Your macro might require some minor editing to remove extraneous
steps or to refine the procedure.
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You can edit the appearance of the text or icons on your toolbars with the
Edit Button Appearance on page 7720 command, which is available when you
right-click the toolbar button.

Interface

Group Displays a drop-down list that lets you choose the functional context
you want to customize. Contexts include Main UI (user interface), Track View,
and Material Editor.

Category Displays a drop-down list of available categories of user-interface
actions for the chosen group.

Action list Displays all available actions for the chosen group and category.

[toolbars drop-down list] Displays all existing toolbars.

Toolbars Panel | 7703



New Opens the New Toolbar dialog. Enter the name of the toolbar you want
to create and click OK. The new toolbar appears as a small floater.

Once you’ve created a toolbar, there are three ways to add commands:

■ Drag actions from the Action Window in the Toolbars panel of the
Customize User Interface dialog onto your toolbar.

■ Ctrl+drag buttons from any toolbar onto your toolbar. This action creates
a copy of the button on your toolbar.

■ Alt+drag buttons from any toolbar onto your toolbar. This action moves
the button from the original toolbar onto your toolbar.

Delete Deletes the toolbar item displayed in the Toolbars list.

Rename Displays the Rename Toolbar dialog. Select a toolbar from the Toolbars
list to activate the Rename button. Click Rename, change the name of the
toolbar, and click OK. The toolbar name changes in the toolbar floater.

Hide Toggles the display of the chosen toolbar in the toolbars list.

Load Displays the Load UI File dialog. Allows you to load custom user interface
files into your scene.

Save Displays the Save UI File As dialog. Allows you to save any changes to
the user interface in a CUI file.

Reset Restores the default setup (defaultUI.cui).

Quads Panel

Customize menu > Customize User Interface > Quads tab

The Quads panel lets you customize the quad menus on page 7516. You can
create your own quad menu sets, or you can edit existing sets. In the Quads
panel, you can customize menu labels, functionality, layout, and shortcuts.
The advanced quad menu options on page 7716 let you modify the color and
behavior of the quad menu system. You can also save and load custom menu
sets.

See also:

■ Additional Quad Menus on page 7520
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Procedures

To create a quad set:

1 Choose Customize menu > Customize User Interface > Quads tab.

2 Click New.

The New Quad Set dialog appears.

3 Enter the name of the quad set and click OK.

The new set appears in the Quad set list.

To add a command to a quad set:

1 Choose Customize menu > Customize User Interface > Quads tab.

2 Choose the quad set you want to edit from the upper-right drop-down
list.

If you want to change the name of the quad set, click Rename and enter
a new name in the Rename Quad Set dialog.

3 Select the quadrant where you want to place the command.

You can edit the name of the quadrant by changing the text in the Label
area.

4 Choose the appropriate Group and Category from the respective
drop-down lists.

5 Choose a command from the action list and drag it into the Quad Menu
window.

Use the same procedure to add menus and separators to your quad set.

To delete a quad set:

NOTE You cannot delete any of the default quad sets.

1 Choose Customize menu > Customize User Interface > Quads tab.

2 Choose the quad set you want to delete from the upper-right drop-down
list.

3 Click Delete.
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To remove a command from a quad set:

1 Choose Customize menu > Customize User Interface > Quads tab.

2 Choose the quad set you want to edit from the upper-right drop-down
list.

3 Choose the command you want to remove.

4 Press the Delete button.

Use the same procedure to remove menus and separators from your quad
set.

To move a command in a quad set:

■ Choose the command in the quad set list and drag it to a new position in
the list.
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Interface

Group Displays a drop-down list that lets you select the context you want to
customize, such as Main UI, Track View, Material Editor, and so on.

Category Displays a drop-down list of the available categories of user interface
actions for the selected context.

Action list Displays all the available actions for the selected group and
category. To add an action to a specific quad set, select it and drag it to the
quad menu window on the right side of this dialog. Right-click an action in
this window to edit the macro script that defines the action (if there is one).

Separator list Displays a separator line that you can use to separate groups of
menu items in a quadrant. To add a separator line to a specific quad set, select
it and drag it to the quad menu window on the right side of this dialog.
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Menus list Displays the names of all 3ds Max menus. To add a menu to a
specific quad set, select it and drag it to the quad menu window on the right
side of this dialog. Right-click a menu in this window to delete the menu,
rename it, or create a new, empty menu.

Quad set list Displays the available quad sets.

Additional quad menus on page 7520 appear in this list. They can be edited,
renamed, and reorganized; however, they cannot be deleted.

New Opens the New Quad Set dialog. Enter the name of the quad set you
want to create and click OK. The new quad set appears in the Quad set list.

Delete Deletes the item displayed in the Quad set list. Available only for
user-generated quad sets.

Rename Opens the Rename Quad Set dialog. To activate the Rename button,
choose a quad set from the list. To change the name, click Rename, edit the
name of the quad set, and then click OK.

Quad Shortcut Allows you to define a keyboard shortcut for displaying the
quad set. Enter the shortcut and click Assign to make the change.

Show All Quads When on, a viewport right-click shows all four quad menus.
When off, a viewport right-click shows only one quad at a time.

Label Displays the label for the highlighted quadrant (shown in yellow to the
left of the Label).

Quad Menu Window Displays the menu options for the currently selected
quad menu and quad set. To add menus and commands, drag options from
the Action and Menus windows to this window.

Items included in the quad menu are displayed only when they are available.
For example, if your quad menu contains Track View Selected, the command
will display only if a selection exists when you open the quad menu. if none
of the commands are available when you open the quad menu, the quadrant
does not appear.

When you right-click an item in the quad menu window, several actions
become available:

Delete Menu Item Removes the highlighted action, separator, or menu from
the quad menu.

Edit Menu Item Name Opens the Edit Menu Item Name dialog. To edit the
name, the Customize Name check box must be on. Enter the desired name
in the name text field and click OK. The item name is changed in the quad
menu, but not in the quad menu window.
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Flatten Sub-Menu Displays contents of selected submenu on top level of
quad. If you choose this item, the menu name is followed by the string: [FLAT].

Edit MacroScript Opens the macro script for the selected action in a
MAXScript editor window.

Advanced Options Opens the Advanced Quad Menu Options dialog on page
7716.

Load Displays the Load Menu File dialog. Allows you to load custom menu
files into your scene.

Save Displays the Save Menu File As dialog. Allows you to save changes to
the quad menus in a MNU file.

Reset Restores the default setup (defaultui.mnu).

Menus Panel

Customize menu > Customize User Interface > Menus tab

The Menus panel lets you customize the menus in the software. You can edit
existing menus or create your own. You can customize menu labels,
functionality, and layout.

Procedures

To create a menu:

1 Choose Customize menu > Customize User Interface > Menus tab.

2 Click New.

The New Menu dialog appears.

3 Enter the name of the menu, and click OK.

The new menu appears in the menu list.

To add a command to a menu:

1 Choose Customize menu > Customize User Interface > Menus tab.

2 Choose the menu you want to edit from the drop-down list.

If you want to change the name of the menu, click Rename, and enter a
new name in the Rename Menu dialog.
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3 Choose the appropriate Group and Category from the respective
drop-down lists.

4 Choose a command from the action list and drag it into the Menu
window.

Use the same procedure to add menus and separators to your menu.

To delete a menu:

1 Choose Customize menu > Customize User Interface > Menus tab

2 Choose the menu you want to delete from the drop-down list.

3 Click Delete.

To remove a command from a menu:

1 Choose Customize menu > Customize User Interface > Menus tab.

2 Choose the menu you want to edit from the drop-down list.

3 Choose the command you want to remove.

4 Press the Delete key.

Use the same procedure to remove menus and separators from your
menus.

To move a command in a menu:

■ Choose the command in the menu window and drag it to a new position
in the window.
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Interface

Group Displays a drop-down list that lets you select the context you want to
customize, such as: Main UI, Track View, Material Editor, and so on.

Category Displays a drop-down list of the available categories of user interface
actions for the selected context.

Action Window Displays all the available actions for the selected group and
category. To add an action to a specific menu, select it and drag it to the menu
window on the right side of this dialog. Right-click an action in this window
to edit the macro script that defines this action (if there is one).

Separator Window Displays a separator line that can be used to separate
groups of menu items. To add a separator to a specific menu, select it and drag
it to the menu window on the right side of this dialog.

Menu Window Displays the names of all menus. To add a menu to another
menu (shown in the Menu List), select and drag it to the menu window on
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the right side of this dialog. Right-click a menu in this window to delete the
menu, rename it, or create a new, empty menu.

Menu List Displays the default menus as well as any new ones you create or
load.

New Displays the New Menu dialog. Enter the name of the menu you want
to create and click OK. The new menu appears in the menu window on the
left side of the dialog as well as in the Menu List.

Delete Deletes the item displayed in the menu list window.

Rename Displays the Edit Menu Item Name dialog. Select a command in the
menu list window and click Rename. This dialog lets you specify a custom
name to be displayed in the menu. If you precede a letter in the custom name
with the “&” (ampersand) character, that letter is used as a menu accelerator.

Menu Window Displays the menu options for the menu currently selected
in the menu list. To add menus and commands (actions), simply select and
drag the options from the Action and Menus windows to this window.

There are several actions available when you right-click any item in the menu
window:

Delete Menu Item Removes the selected action, separator, or menu from the
menu.

Edit Menu Item Name Opens the Edit Menu Item Name dialog. The Customize
Name check box must be on to edit the name. Enter the desired name in the
name text field and press OK. The item name is changed in the menu, but
not in the menu window. If you precede a letter in the custom name with the
“&” (ampersand) character, that letter is used as a menu accelerator.

Edit MacroScript Opens the script for the selected action in a MAXScript
editor window.

Load Displays the Load Menu File dialog. Allows you to load custom menu
files into your scene.

Save Displays the Save Menu File As dialog. Allows you to save changes to
the menus in an MNU file.

Reset Restores the default setup (defaultui.mnu).

Colors Panel

Customize menu > Customize User Interface > Colors tab
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The Colors panel of the Customize User Interface dialog allows you to
customize the look of the software interface. You can adjust the colors for
almost every element in the interface, giving you the freedom to design your
own unique style.

The quad menu colors cannot be customized from the Color panel. To
customize quad menu colors, use the Advanced Quad Menu Options dialog
on page 7716.

Procedures

To change an interface element color:

1 From the Elements drop-down list, choose the category of the interface
element whose color you intend to change.

2 In the list below the Elements field, highlight the element whose color
you intend to change.

The Color swatch shows the current color of the element.

3 Click the Color swatch and then use the Color Selector dialog to choose
a new color. Click the Close button to set the color.

To restore the color that was active at the time that you opened the dialog,
highlight the element and click Reset.

4 Continue choosing elements and changing colors as necessary.

5 To finish and apply the color changes to the interface, close the dialog
by clicking the X button in the upper-right corner.

TIP If you change several colors and then want to restore all colors to the default
values, click the Load button and open DefaultUI.clr.
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Interface

Elements Displays a drop-down list that lets you select from the various
high-level groupings: Character, Geometry, Gizmos, Viewports, and more.

[UI elements list] Displays a list of the available elements in the active
category.

Color Displays the color for the selected category and element. Click to display
the Color Selector, where you can change the color. After choosing a new
color, click Apply Colors Now to make the change in the interface.

Reset Resets the color of the highlighted element to the value that was active
when you opened the dialog.

Intensity Sets a grayscale value for the display of the grid lines. 0 is black and
255 is white.
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This control is available only when you choose the Set By Intensity option
from the Grids element, and affects the intensity of the grid lines in the
viewports.

Invert Inverts the grayscale value for the display of grid lines. Dark gray
becomes light gray and vice-versa.

This control is available only when you choose the Set By Intensity option
from the Grids element.

Scheme Allows you to choose whether the main UI colors are set to the default
Windows colors or whether they can be customized. If Use Standard Windows
Colors is active, all of the elements in the UI Appearance list are disabled, and
you are unable to customize the UI colors.

[UI appearance list] Displays all the elements in the user interface that can
be changed.

Color Displays the color for the selected UI appearance item. Click to display
the Color Selector dialog, where you can change the color. After choosing a
new color, click Apply to make the change in the interface.

Reset Restores the highlighted UI appearance item to its color when you first
opened the dialog.

Saturation Sets a saturation scale of enabled or disabled icons in the UI. The
higher the saturation, the less gray the color. See Red, Green, Blue / Hue,
Saturation, Value on page 8105.

This control is only available when Icons: Enabled or Icons: Disabled is
highlighted in the UI Appearance list.

Value Sets the value scale of enabled or disabled icons in the UI. The higher
the value, the brighter the color. See Red, Green, Blue / Hue, Saturation, Value
on page 8105.

This control is available only when Icons: Enabled or Icons: Disabled is
highlighted in the UI Appearance list.

Transparency Sets the transparency value scale of enabled or disabled icons
in the UI. The higher the value, the more opaque the icon.

This control is only available when Icons: Enabled or Icons: Disabled is
highlighted in the UI Appearance list.

Invert Inverts the RGB value for the display of enabled or disabled icons in
the UI.

This control is only available when Icons: Enabled or Icons: Disabled is
highlighted in the UI Appearance list.
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Apply Colors Now Activates any changes in the user interface.

Load Displays the Load Color File dialog. Allows you to load custom color
files into your scene.

Save Displays the Save Color File As dialog. Lets you save changes to the user
interface colors in a CLR file.

Reset Restores the default setup (defaultui.clr).

Advanced Quad Menu Options

Customize menu > Customize User Interface > Quads panel > Advanced
Options

The Advanced Quad Menu Options dialog lets you customize the size and
colors of your quad menus. You can also customize other quad menu behaviors
such as repositioning, type font, and cursor behavior.

Interface

Save group

Load Lets you load a quad options (.qop) file.

Save Saves your settings to a .qop file.

Save as Startup Saves your current settings as the startup settings.

Reset to Startup Resets options to default settings (defaultui.qop).
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Colors group

The colors group allows you to customize the colors of your quad menus.

Starting Quadrant Lets you select which quadrant your cursor starts in when
you open the quad menu.

Color list Lists customizable elements of the quad menu and separates them
by quadrant. Click the color swatch to open a color selection dialog.

If the colors for a quad menu element are locked (indicated by a pressed “L”
button), each of the separate quadrants share the same color; when you change
the color in one quadrant, it changes all of the quadrants’ colors.

You can customize each quadrant separately by turning off the lock button
for the selected quad menu element.
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Display group

Uniform Quad Width When on, all displayed quadrants are the same width.
The widest quadrant determines the width.

Mirror Quads When on, text in the quad menus is justified to the inside edge
of the menu: The text in the right quadrants is left-justified, and text in the
left quadrants is right-justified.

When off, all text in the quad menus is left-justified.

Vertical Margins Sets the vertical spacing between commands in the quad
menu.

Opacity Amount Sets the opacity of the quad menu.

Opacity is not available in systems running on Windows NT.

Positioning group

Reposition Quad When Off Screen Automatically repositions the quad menu
when you open it with part of the menu off the edge of the screen. The menu
is moved so that the entire menu is displayed on the screen.

Move Cursor When Repositioned Moves your cursor to the new location of
the quad menu when it is repositioned.
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When off, hold down the mouse button when you right-click to display the
quad menu. After you move the cursor over the menu, release the mouse
button.

Return Cursor After Repositioned After you have selected an action from
the quad menu, the cursor is returned to the location on the screen where the
original right-click was made.

Fonts group

Title Font Sets the font of the quadrant titles.

Size Sets the font size of the quadrant titles.

Menu Font Sets the font of the text inside the quadrants.

Size Sets the font size of the text inside the quadrants.

Animation group

Type Sets the animation type for the quad menu from the following options:

■ None Quad menus display immediately upon right-clicking.

■ Stretch Quad menus open by expanding one quadrant at a time, in a
clockwise manner. They close similarly; contracting one quadrant at a
time, in a counterclockwise manner.
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■ Fade Quad menus open by fading in from transparent to opaque, and
close by fading out from opaque to transparent.

Steps The number of frames used to complete the animated display of the
quad menu.

As this value becomes larger, the transition (small to large, transparent to
opaque, and so on) becomes more gradual.

Pause The time between frames during the animated display of the quad
menu.

As this value becomes larger, the animated display of the quad menu slows
down.

Edit Button Appearance Dialog

Right-click any button on a custom toolbar. > Edit Button Appearance

Use this dialog to change the appearance of the selected button. You can
substitute a different icon for the button, or change to a text button instead.
You can also customize the tooltip.

Custom Icons

To make a custom icons, you need a series of four files, each beginning with
the same prefix which designates the icon group. You can create these images
in any paint program.

■ A 24x24 image for use when large icons are displayed. Suffix: _24i.bmp.

■ A 24x24 grayscale image showing the transparency of the 24x24 image,
with black pixels indicating see-through areas where the gray button
background shows through. Suffix: _24a.bmp.

■ A 16x15 image for use when small icons are displayed. Suffix: _16i.bmp.

■ A 16x15 grayscale image showing transparency of the 16x16 image. Suffix:
_16a.bmp

To use a file with multiple icons, arrange the icons in series, one after the
other. For example, if you want three icons to appear, the file that ends in
_24i.bmp would be 72 pixels wide and 24 pixels high, and contain the three
icons arranged in a row with no space between them.
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After you create the icon files, copy them to the UI/icons folder and restart 3ds
Max. This lets the software find and display the group when you access the
Edit Button Appearance dialog.

TIP For examples of how to arrange custom icons in image files, look at some of
the existing BMP files in the UI/icons folder.

Interface

Tooltip You can add your own tooltips to the buttons. The tooltip displays
when the mouse is over the tool button. You can edit this text to describe the
tool.

Text Button Lets you assign text to the button. You can enter whatever text
you like for the button.

Image Button Lets you assign an image (icon) to the button. You can use any
predefined icon that you want by selecting it from the display on the right.

Group Displays a list of button categories. The groups of icons change with
each category selection.

Odd Only Certain icon sets, including Internal, Classic, Main toolbar, and
others, are designed in pairs. In each pair, one icon depicts the button when
enabled, and the other shows how it looks when disabled. When Odd Only
is on, the interface displays only the odd-numbered icons (enabled), when
Odd Only is off, all of the icons, enabled and disabled, are displayed.
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Saving and Loading Custom User Interfaces
You can customize your workspace by saving and loading custom user interface
(UI) schemes.

A custom UI scheme is saved as a set of six files:

■ .cui: Stores toolbar and panel layouts.

■ .clr: Stores all color settings (except quad menu colors).

■ .mnu: Stores menu bar and quad menu contents.

■ .qop: Stores quad menu colors, layout, and behavior.

■ .kbd: Stores keyboard shortcut assignments.

■ .ui: Stores the icon scheme (Classic or 2D Black and White).

You can load and save each of these files individually from their respective
panels in the Customize User Interface dialog on page 7697. You can also load
an entire set of UI scheme files at once with the Load Custom UI Scheme
dialog on page 7724, and you can save the current UI scheme as a complete set
with the Save Custom UI Scheme dialog on page 7725.

By default, two sets of UI schemes are present in the 3dsmax\UI\ folder: maxstart
and defaultUI. Upon startup, 3ds Max uses the maxstart file series if it exists; if
not, it uses the defaultui series.

WARNING Do not save over any files that begin with defaultUI, as doing so
permanently overwrites the default UI scheme.

Procedures

To load a custom UI scheme:

1 Set up the custom UI scheme within 3ds Max using the options on the
Customize menu > Customize User Interface dialog on page 7697.

2 Save the custom UI scheme with Customize menu > Save Custom UI
Scheme.

3 During your current 3ds Max session or any later session, choose
Customize menu > Load Custom UI Scheme.

4 In the Load Custom UI Scheme dialog, select a type of customization file
(.cui, .mnu, .clr, .kbd, .qmo, or .ui) from the Files of Type drop-down list.
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5 Choose any file with the appropriate extension. The software will search
for (and load) any other type of UI scheme file with the same base file
name.

If you choose a UI scheme for which one of the six file types is not
present, the part of the user interface for which there is no file will not
be changed.

To return to the default UI scheme:

If you start 3ds Max and its user interface has an unfamiliar layout, you can
always return to the default UI scheme.

1 Choose Customize > Load Custom UI Scheme.

2 From the Load UI File dialog that displays, choose defaultui.cui, and click
Open.

All the default UI files begin with the base file name defaultui. When you
choose defaultui.cui, the software loads all default UI scheme files.

To start the software with a custom user interface:

1 Arrange the user interface as you would like it to appear when you start
3ds Max.

2 Choose Customize menu > Save Custom UI Scheme, and save your custom
UI scheme with the base file name maxstart.

The next time you start 3ds Max, the software uses the current UI scheme.

NOTE If the Save UI Configuration On Exit option on the Customize menu
> Preferences > General tab on page 7744 is on (which it is by default), the
state of the user interface when you close the program overwrites the maxstart
UI scheme files.

To start the software with a custom user interface from the command line:

1 Save your custom UI scheme with a descriptive base file name with the
Save Custom UI Scheme dialog on page 7725.

2 Right-click the 3ds Max icon on the Windows desktop, and choose
Properties.

3 In the Target field, change 3dsmax.exe to 3dsmax.exe -c, followed by the
name of your .cui file.
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Example: 3dsmax.exe -c myfile.cui. Be sure to leave a space both before
and after the -c.

If you want to move the UI scheme to a different computer, copy all the files
in the 3dsmax\UI\ folder that start with the custom UI scheme base name to
the new 3dsmax\UI\ folder. Alternately, you can add the path name to the
command line.

To save a single UI scheme file:

1 Choose Customize menu > Customize User Interface on page 7697.

2 Access the panel for the type of user interface item you want to save.

3 On the panel, click Save.

To change the icon display from Classic to 2D Black and White:

1 Choose Customize menu > Save Custom UI Scheme, enter a filename,
and click Save.

2 On the Custom Scheme dialog, next to Icon Type, choose the type of
icon you want to display.

3 Click OK to close the dialog and save the scheme.

4 Choose Customize menu > Load Custom UI Scheme and then open the
UI scheme you saved.

Load Custom UI Scheme

Customize menu > Load Custom UI Scheme

On the Load Custom UI Scheme dialog, you specify the base file name of the
custom UI scheme you want to load. You can select any type of UI scheme
file from the dialog, and the software will load any other type of UI scheme
files with the same base file name.

To save a custom UI scheme, use the Save Custom UI Scheme dialog on page
7725.

For more information on saving and loading custom user interfaces, see Saving
and Loading Custom User Interfaces on page 7722.
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You can also load a custom UI scheme with the Custom UI and Defaults
Switcher on page 7692.

Interface

TIP You can resize the dialog by dragging an edge or a corner.

Use the Look In field to navigate to other directories. Click the folder to choose
it. The files display in the window.

Use the Files of type drop-down list to search for other types of customization
files. The default is .cui, but you can also search for .clr, .mnu, .kbd, .qop, and
.ui files. When you choose a filename, all files with that base file name are
loaded.

Save Custom UI Scheme

Customize menu > Save Custom UI Scheme

This standard Windows file save dialog lets you save your customized UI
scheme.
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This dialog works differently from other dialogs that save files. In this dialog,
after you enter a base file name and click Save, the Custom Scheme dialog
appears. On the Custom Scheme dialog, you set the types of user interface
schemes to save. A file is saved for each type of scheme you select, each with
a specific extension for that type of scheme. When you load any one of the
custom UI scheme files with the Load Custom UI Scheme dialog on page 7724,
the entire set of files with the same base file name are loaded.

On the Save Custom UI Scheme dialog, the base name of the current UI scheme
is filled in by default. You can enter the name of the base file name in the File
Name field, or click in the list to choose an existing base file name. You can
click a file with any UI scheme extension to save to the base file name from
that file.

If you want the current UI to load automatically every time you load 3ds Max,
you can save to the base file name maxstart. Alternately, you can turn on the
Save UI Configuration On Exit option on the Customize menu > Preferences
> General tab on page 7744. This causes the UI scheme that is current at the
time you close 3ds Max to be saved to the base file name maxstart. This option
is on by default.

WARNING Do not save over the base file name defaultUI, as doing so permanently
overwrites the default UI scheme files.
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For more information on saving and loading custom user interfaces, see Saving
and Loading Custom User Interfaces on page 7722.

Interface

After you enter a file name and click Save, the Custom Scheme dialog opens,
letting you define which parts of the UI scheme will be saved.

TIP You can resize the dialog by dragging an edge or a corner.

Interface Layout (.cui) When on, saves the current toolbar and panel layout
to a CUI file with the UI Scheme base file name.

Keyboard Shortcuts (.kbd) When on, saves the current keyboard shortcuts
to a KBD file with the UI Scheme base file name.

Menus (.mnu) When on, saves the menu layout to an MNU file with the UI
Scheme base file name.

Quad Options (.qop) When on, saves the quad menus to a QOP file with the
UI Scheme base file name.

Colors (.clr) When on, saves the current color definitions to a CLR file with
the UI Scheme base file name.

Icon Type Selects the icon scheme for all toolbars, and saves this information
in a file with the extension .ui after the UI Scheme base file name.
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NOTE The icon scheme you choose is saved as part of the file set, regardless of
whether the chosen icon scheme matches the current scheme displayed on your
screen.

All Turns on all of the controls described preceding.

None Turns off all of the controls described preceding.

OK Closes the dialog, and saves all of the selected UI Scheme files.

Cancel Closes the dialog without saving any UI Scheme files.

Revert to Startup Layout

Customize menu > Revert to Startup Layout

Revert to Startup layout automatically loads _startup.ui, which returns the user
interface to its startup settings. This temporary system file is created
automatically when you start the program. Use this option to return the UI
to startup settings.

For information on how to load different UI schemes on startup, see Load
Custom UI Scheme on page 7724.

If the Preferences dialog > General panel on page 7744 > Save UI Configuration
On Exit switch is on when you exit the program, the current UI file is
overwritten.

Procedures

To revert to the startup UI:

■ Choose Customize > Revert To Startup UI Layout. UI elements are
rearranged to look as they did when you started the program.

Configure Paths
Customize menu > Configure User Paths

Customize menu > Configure System Paths
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Configure Paths functionality is available in two dialogs:

■ Paths that you use to specify locations for bitmaps, scenes, and so on, are
found on the Configure User Paths dialog on page 7729. In addition, the
latter dialog now lets you save, load, and merge path-configuration files,
which makes it easier for content-creation teams to set up the same folders
for all team members to use.

■ Paths used by 3ds Max for purposes such as loading fonts and defaults are
accessible on the Configure System Paths dialog on page 7732.

See also:

■ Asset Tracking dialog > Paths menu on page 7109

Configure User Paths

Customize menu > Configure User Paths

3ds Max uses stored paths to locate different kinds of user files, including
scenes, images, DX9 effects (FX), photometric, and MAXScript files. You use
the Configure User Paths command to display the Configure User Paths dialog
and customize these paths. This command is useful when you add new folders
to help you organize your scenes, images, plug-ins, backups, and so on.

You can save, load, and merge the paths that the Configure User Paths dialog
manages in MXP (max path) files. This capability makes it easy for all members
of content-creation teams to keep projects organized and work efficiently by
using the same paths.

See also:

■ Configure System Paths on page 7732

Procedures

In general, these procedures are common to all panels on the Configure User
Paths dialog. When you change a setting, it is written to the 3dsmax.ini on page
83 file, and is effective immediately.

To modify a path:

1 Click a path entry to highlight it.
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2 Click Modify.

3 Use the Choose Directory dialog to do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

4 Optional step (3rd Party Plug-Ins panel only): Edit the description of the
path in the Label field.

This description then appears in the path list.

5 Click Use Path.

The new path takes effect immediately.

To share User paths with team members:

1 Use the Configure User Paths dialog to set up all necessary user paths.

2 Click the Save As button and then use the Save Paths To File dialog to
save the path configuration as an MXP file.

3 Make the path configuration file available to other team members.

4 Each team member then opens the Configure User Paths dialog and uses
Load or Merge to open the path configuration file.

The new path configuration is now the same on each team member's
machine.

NOTE Using Load eliminates the existing path configuration; using Merge
overwrites only paths that exist in both the current configuration and the
new one.

To share files with team members using relative paths:

1 Ensure the Convert local file paths to Relative preference is enabled.

2 As you work, all files are saved relative to your project folder.

3 Give your scene to another user.

4 The second user opens the scene on a machine with a different project
folder and now 3ds Max searches for all files related to the scene file in
the second user's project folder.
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NOTE The Convert local file path to Relative preference is set when you
create the file. For example, if I load a material into my scene with this
preference on, this material is always treated as relative to the project folder.

Interface

The Configure User Paths dialog comprises three panels:

■ External Files on page 7735

■ File I/O on page 7733

■ XRefs on page 7738

In addition, the dialog provides command buttons on the right side and across
the bottom:

Project Folder Lets you set the project folder on page 6932.

Modify Lets you change the highlighted path.

Make Relative Lets you change an absolute or complete file path into a path
relative to the project folder on page 6932.
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NOTE For relative paths within the project folder, a leading “.\” represents the
project folder path. On the other hand, one or more instances of “..\” preceding
the path indicates that the path is in a sibling folder to the project folder, as
opposed to a subfolder. For example, if your project folder is c:\MyProject\Project1
and the asset location is c:\Resources\myresource.jpg, then the relative path from
the project folder to the resource is ..\..\Resources\myresource.jpg. If the asset was
in c:\MyProject\Resources\myresource.jpg, then the relative path would be
..\Resources\myresource.jpg.

Make Absolute Lets you make the path absolute, where a relative path is
currently being used. For example, if “.\” represents your project folder in the
path name, then when you make the path absolute the full name is used
instead.

Move Up/Down Lets you change the position of the highlighted path in the
list to alter its search priority. Available only on the External Files and XRefs
panels.

Save as Lets you save the path configuration as an MXP file for sharing with
team members.

Load Loads a path configuration from an MXP file. The loaded configuration
completely replaces the existing one.

Merge Merges a path configuration from an MXP file. The merged
configuration adds paths that exist only in the new file and replaces any
existing paths.

For example, if your File I/O panel > Scenes path is set to .\scenes (relative
path) and you merge a path configuration file in which the Scenes path is set
to the UNC path \\scene_server\max\scenes, the former path is replaced by the
latter one.

OK Exits the dialog and saves any changes.

Cancel Exits the dialog without saving changes.

Configure System Paths

Customize menu > Configure System Paths

The 3ds Max system uses paths to locate different kinds of files, including
defaults, fonts, and startup MAXScript files. You use the Configure System
Paths command to open the Configure System Paths dialog and customize
these paths.

7732 | Chapter 26   Customizing the User Interface



3ds Max saves the paths that the Configure System Paths command manages
in the 3dsmax.ini on page 83 file.

See also:

■ Configure User Paths on page 7729

Interface

The Configure System Paths dialog comprises two panels:

■ System Paths on page 7739

■ 3rd Party Plug-ins on page 7740

File I/O Path Configuration

Customize menu > Configure User Paths > Configure User Paths dialog > File
I/O panel

The File I/O panel of the Configure User Paths dialog contains most of the
file directories in which users store files.

For descriptions of the general dialog controls, see Configure User Paths on
page 7729.

NOTE By default these paths are relative to the project folder on page 6932.
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Procedures

To modify a file path:

1 On the Configure User Paths dialog, click File I/O, and then choose a
path entry.

2 Click Modify.

3 In the Choose Directory dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

4 Optional step: Enter a description of the path in the Label field.

This description later appears in the path list.

5 Click Use Path.

The new path takes effect immediately.

Interface
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Animations Path for animation files, including XAF, XMM, BIP, FIG, MFE,
and so on.

Archives Path for archive files.

AutoBackup Sets the default path for automatic backup files. If you use the
Auto Backup feature on page 7750, use either the \autoback directory, which is
specific to each running version of the software, or a directory not shared by
any other machine.

BitmapProxies Path for proxy bitmaps. See Global Settings and Defaults for
Bitmap Proxies Dialog on page 7115.

Downloads Path for i-drop on page 7160 files.

Export Path for exported files.

Expressions Path for text files used by expression controllers.

Images Path for image files.

Import Path for imported files.

Materials Path for material library (MAT) files.

MaxStart Path for maxstart.max, which provides initial 3ds Max scene settings.

Photometric Path for photometric files, which define various characteristics
of Photometric lights on page 5005

Previews Path for preview renders.

RenderAssets Path for mental ray and other rendering asset files, including
shadow maps, photon maps, final gather maps, MI files, and render passes.

RenderOutput Path for rendered output.

RenderPresets Path for Render Preset files.

Scenes Path for MAX scene files.

Sounds Loads sound files.

VideoPost Loads and saves Video Post queues.

External Path Configuration

Customize menu > Configure User Paths > Configure User Paths dialog >
External Files panel
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On the External Files panel of the Configure Paths dialog, you can add or
modify path directories for bitmaps on page 7926, DX9 effects (FX) files, on page
7990, and downloads; that is, files transferred from the Internet with i-drop on
page 7160. Bitmaps are used for background images and mapped materials on
page 8036 (textures, bump maps, displacement maps, and so on). FX files are
used by the DirectX 9 Shader material on page 5758.

NOTE By default the paths for \Maps\fx, \Maps, and the root folder are all relative
to the root directory of 3ds Max whereas the \downloads folder is relative to the
project folder by default.

3ds Max stores the path of any file you load. When the file is reloaded, the
search order is as follows:

1 The path saved with the file.

2 The directory of the current scene.

3 The paths listed in the External Files panel, starting at the top of the list.

NOTE To save loading time, if a map with the same name exists in two
different locations (paths), the software loads it only once. This can cause a
problem only if your scene includes two different maps with the same name.
In this case, only the first map encountered will appear in the scene.

4 Every subdirectory under the directory of the current scene.
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For descriptions of the general dialog controls, see Configure User Paths on
page 7729.

Procedures

To modify a file path:

1 On the External Files panel, choose a path entry.

2 Click Modify.

3 In the Choose Directory dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

4 Click Use Path.

The new path takes effect immediately.

To add a path for a file:

1 On the External Files panel, click Add.

2 On the Choose New Bitmap Path dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

3 If you want to include subdirectories in this path, turn on Add Subpaths.

4 Click Use Path.

The new path takes effect immediately.

To delete a path for a file:

1 On the External Files panel, choose a path entry.

2 Click Delete.

The path location is removed.

3 Click Cancel to restore the path.

This closes the Configure Path dialog without saving any path changes.
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To move a path up or down in the list:

1 On the External Files panel, choose a path entry.

2 Do one of the following:

■ Click Move Up to move the entry closer to the top of the list, giving
it a higher priority in the search process.

■ Click Move Down to move the entry closer to the bottom of the list,
giving it a lower priority in the search process.

XRefs Path Configuration

Customize menu > Configure User Paths > Configure User Paths dialog > XRefs
panel

On the XRefs panel of the Configure User Paths dialog, you can modify, delete,
or add to the directory locations 3ds Max searches for XRef objects and XRef
scenes. You can also use either relative or absolute paths.

You expand the default locations of external reference files by adding paths
to this panel. Use this technique to identify the directories most often used
in your scenes.

3ds Max stores the path of any external reference file you load. When the
external reference file is reloaded, the search order is as follows:

1 The path saved with the external reference file.

2 The directory of the current scene.

3 The paths listed in the Configure User Paths dialog > XRefs panel, starting
at the top of the list.

NOTE By default, this path is relative to the project folder.

For descriptions of the general dialog controls, see Configure User Paths on
page 7729.

Procedures

To modify an external reference file path:

1 On the XRefs panel, choose a path entry.
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2 Click Modify.

3 On the Choose Directory dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path, and click Use Path.

To add an XRef path:

1 On the XRefs panel, click Add.

2 On the Choose New XRef Path dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

3 Click Use Path.

The new path takes effect immediately.

To delete an external reference file path:

1 On the XRefs panel, choose a path entry.

2 Click Delete.

The path location is removed.

3 Click Cancel to restore the path.

This closes the Configure User Paths dialog without saving any path
changes.

To move a path up or down in the list:

1 On the XRefs panel, choose a path entry.

2 Do one of the following:

■ Click Move Up to move the entry closer to the top of the list.

■ Click Move Down to move the entry closer to the bottom of the list.

System Paths

Customize menu > Configure System Paths > System panel

System Paths | 7739



This dialog is especially useful if you are programming your own scripts for
3ds Max. When you start 3ds Max, it checks these folders and runs or otherwise
uses the corresponding files:

FunctionFile Type

Path for additional iconsAdditional Icons

Path for additional macrosAdditional Macros

Path for additional scriptsAdditional Scripts

Path for additional startup scriptsAdditional Startup Scripts

Path for data files related to 3ds MaxMaxData

Path for temporary filesTemp

Procedures

To modify a path:

1 Click a path entry to highlight it.

2 Click Modify.

3 Use the Choose Directory dialog to do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

4 Click Use Path.

The new path takes effect immediately.

3rd Party Plug-Ins Path Configuration

Customize menu > Configure System Paths > Configure System Paths dialog
> 3rd Party Plug-Ins panel
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On the 3rd Party Plug-Ins panel of the Configure System Paths dialog, you
can add or modify the directory paths of  plug-ins on page 8092 supplied by
third parties and independent software developers. You can also store plug-ins
in separate directories and use this panel to add the paths of those directories.
Changing the list order specifies the search order. Put the most frequently
used plug-ins at the top.

Path information is stored in the plugin.ini file.

NOTE To change the path for standard plug-ins included with 3ds Max, use the
Configure System Paths on page 7732 function.

For descriptions of the general dialog controls, see Configure User Paths on
page 7729.

Procedures

To modify a plug-in path:

1 On the 3rd Party Plug-Ins panel, choose a path entry.

2 Click Modify.

3 On the Choose Directory dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

4 Click Use Path.

The new path takes effect immediately.

To add a plug-in path:

1 On the 3rd Party Plug-Ins panel, click Add.

2 On the Choose Directory dialog, do one of the following:

■ Enter a path in the Path field.

■ Navigate to locate a path.

3 Type a description in the Label field.

4 If you want to include subdirectories in this path, turn on Add Subpaths.

5 Click Use Path.

The new path takes effect immediately.
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To delete a path:

1 On the 3rd Party Plug-Ins panel, choose a path entry.

2 Click Delete.

The path location is removed.

Network Plug-In Configuration

You can include paths to additional INI files within the local plugin.ini  file;
the software processes these files as if they were part of the original plugin.ini.
This capability is helpful in settings where several systems on a network are
using the same plug-ins. The network administrator maintains only a single
remote INI file, rather than having to update each machine individually.

Procedures

Example: To add remote INI files to your local plugin.ini:

1 Open your local copy of plugin.ini with your preferred text editor.

2 At the bottom of the file, type [Include] and press Enter.

3 After [Include], type these two lines:

myremote=\\remote_dir\remote_plugin.ini

anotherdir=d:\test\extra_plugin.ini
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NOTE You can give any title to the directory (in this case, myremote or
anotherdir,) and the directory can be any local or remote directory. In addition,
the INI file can have any name.

4 Save plugin.ini and exit the text editor.

The next time you start the software, it will load plug-ins from the
directories defined in plugin.ini, as well as plug-ins in any remote INI file
specified in plugin.ini.

You can add as many remote INI files as you need, making it easy to
organize groups of plug-ins.

Preferences
Customize menu > Preferences

3ds Max offers many options for its display and operation. These options are
available on the Preference Settings dialog in a series of tabbed panels.

The Preference Settings dialog contains the following panels:

General Preferences on page 7744
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File Preferences on page 7750

Viewport Preferences on page 7753

Gamma and LUT Preferences on page 7758

Rendering Preferences on page 7768

Animation Preferences on page 7772

Inverse Kinematics Preferences on page 7776

Gizmos Preferences on page 7778

MAXScript Preferences on page 7782

Radiosity Preferences on page 7786

mental ray Preferences on page 7787

General Preferences

Customize menu > Preferences > Preferences dialog > General tab

On the General panel of the Preference Settings dialog, you set options for
the user interface and for interactivity.

Interface on page 7745

Procedures

To set and toggle spinner snap:

1 Do one of the following:

■ Choose Customize menu > Preferences > Preference Settings dialog >
General tab.

■  Right-click the Spinner Snap button on the main toolbar.

Either method brings up the General tab. The two controls for spinner
snap are in the Spinners area of this panel.

2 Enter a value in the Spinner Snap field.

3 Turn on Use Spinner Snap.

When you exit the dialog, Spinner Snap is on.
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4 As you work, use the Spinner Snap button to toggle the use of this setting.

To set the Undo level:

1 Choose Customize menu > Preferences > Preference Settings dialog >
General panel.

2 Change the value of Scene Undo Levels.

The higher the value of Undo Levels, the more system resources are
required. The default value is 20.

Interface

Scene Undo group

Levels Sets the number of operations you can undo.
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Reference Coordinate System group

Constant Sets one coordinate system and transform center for Move, Rotate,
and Scale on the Main toolbar. The coordinate system displayed in the
coordinate dropdown list on page 967, and the transform center selected from
the Use Center flyout on page 975, are used for all transforms.

Normally, each transform switches to the coordinate system and transform
center used the last time the transform was active.

UI Display group

Enable Viewport Tooltips When on, and not at a sub-object level, this
function displays a tooltip when the cursor pauses over a non-selected object
in the viewport.

AutoPlay Preview File Starts the Media Player automatically at the end of a
Make Preview on page 6422.

Display Cross Hair Cursor Displays the mouse cursor as full-viewport cross
hairs, vertical and horizontal lines extending the full extent of the active
viewport.

Each movement of the mouse is redrawn, so the cross hairs are relatively slow.
If you want to create a keyboard shortcut, find Cross Hair Cursor toggle in
Customize menu > Customize User Interface > Keyboard panel and specify
the keys to use for the shortcut. To change the color of the cross-hairs cursor,
go to Customize menu > Customize User Interface > Colors panel > Viewports
> Cross Hair Cursor and use the color selector to change the cursor color.

Display Topology Dependence Warning Toggles the topology dependence
warning. This warning appears when you choose to edit a modifier or the base
object at the bottom of the modifier stack of an object with modifiers and
sub-object selections. The warning occurs because this action can affect the
object topology adversely. You can also turn off the warning on the warning
dialog. Default=on.

Display Stack Collapse Warning Toggles the stack collapse warning, which
appears if you choose to collapse the modifier stack. You can also turn off the
warning on the warning dialog. Default=on.

Save UI Configuration on Exit Restores panels and toolbars to the positions
they were in the last time you used the software. Turn off this switch to restore
panels to the state they were in before turning on this option.

Use Large Toolbar Buttons Toggles between large and small toolbar buttons.
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Horizontal Text in Vertical Toolbar Ensures that text buttons are displayed
horizontally.

If you create a vertical custom toolbar that uses text rather than image buttons,
you can use this option to display either horizontal or vertical text.

Fixed Width Text Button Specifies the maximum width of text buttons.

To use this feature, turn on the Horizontal Text In Vertical Toolbar switch,
turn on this option, and then set a maximum display size for the text button
in pixels. For custom vertical toolbars with text buttons, this option limits the
size of the text display.

Flyout Time Sets the pause, in milliseconds, between the mouse click and the
flyout popping up from the button. Increase this setting only if you need an
extra-long delay. Don't decrease the setting much or you might not be able
to execute button commands before the flyout takes over.

Color Selector Choose the default color selector on page 391, or a third-party
plug-in color selector in the list. The color selector you choose here is used
throughout 3ds Max whenever you specify a color.

Plug-In Loading group

Load Plug-Ins When Used When on, loads plug-ins on demand, as they are
needed.

Sub-Materials group

Assign Automatically Enables the automatic creation of a Multi/Sub-Object
material when you assign a material to a selection of face sub-objects in an
editable object. Default=on.

When on, the assigned material becomes part of the new Multi/Sub-Object
material, and is assigned to the face selection. When off, the assigned material
is assigned to the entire object.

NOTE If the face selection comprises faces with different material IDs, assigning
a material to the selection with Assign Automatically enabled results in the software
assigning the first unused material ID to all selected faces, thus changing their IDs.

See also Drag and Drop Sub-Object Material Assignment on page 5312.
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Scene Selection group

Auto Window/Crossing by Direction When on, the direction that you drag
a selection area determines whether it is a window or crossing selection on
page 260. This works for any selection area (rectangle, circle, fence, or lasso).

You can select which direction causes a window selection and which causes
a crossing selection in the Scene Selection group. When you drag a window
selection, the selection region is displayed with a solid line; when you drag a
crossing selection, the selection region is displayed with dashed lines.

Right-> Left => Crossing When you drag a selection region from right to left,
it is a crossing selection. Conversely, when you drag left to right, it is a window
selection.

Left-> Right => Crossing When you drag a selection region from left to right,
it is a crossing selection. Conversely, when you drag right to left, it is a window
selection.

Paint Selection Brush Size Sets the size of the brush used by Paint Selection
Region  on page 256.

Spinners group

Precision Sets the number of decimal places displayed in a spinner edit field.
Range=0 - 10 (where 0 is no decimal places).

Snap Sets the click increment and decrement values for all of the spinners in
3ds Max.

Use Snap Toggles spinner snap on and off.

Wrap Cursor Near Spinner Limits cursor wrapping to an area close to the
spinner when you drag to adjust spinner value.

Command Panel group

Rollout Threshold The number of pixels in a rollout that should be scrollable
in the command panel before the rollout is shifted into a separate command
panel column.

This option is applicable only when the command panel displays multiple
columns.
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Layer Defaults group

Default to By Layer for New Nodes When on, the software sets rendering,
motion blur, display, and advanced lighting properties for all new objects to
By Layer on page 7933.

New Lights Renderable By Layer When on and you create a light, the software
gets its Object Properties on page 305 > Renderable setting from the properties
of the active layer.

Propagate Unhide/Unfreeze Commands to Layers? When you unhide or
unfreeze an object on a hidden or frozen layer, this choice determines whether
the command affects the object or its layer.

■ Propagate Unhiding or unfreezing an object in a layer unhides or
unfreezes the layer.

■ Do Not Propagate Unhiding or unfreezing an object in a hidden or frozen
layer affects only the object.

■ Ask When this option is active and you unhide or unfreeze objects, a
dialog appears asking if you want to apply the operation to the associated
layers. If you do, the associated layers are unhidden or unfrozen. Otherwise
the operation is applied only to the specified objects.

Vertex Normal Style group

Use Legacy R4 Vertex Normals By default, 3ds Max uses a new, more accurate
method for computing vertex normals from smoothing groups, which improves
the way geometry displays in viewports and in rendered output. To use the
method from older versions of the software, for compatibility, turn on this
check box.

Texture Coordinates group

Use Real-World Texture Coordinates Controls whether real-world texture
coordinates are active or if the legacy method of applying texture coordinates
is in use. When off, texture-coordinate behavior reverts to the legacy method
and texture tile values have a default value of 1, and Real-World Map Size for
primitives is off. Default=off.

When Use Real-World Texture Coordinates is on, the Use Real-World Scale
and Real-World Map Size options are also on. Use Real-World Scale is present
in the Material Editor, on the Coordinates rollout for 2D maps. Real-World
Map Size is available for objects such as primitives and modifiers such as UVW
Map.
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File Preferences

Customize menu > Preferences > Preference Settings dialog > Files tab

On the Files panel of the Preference Settings dialog, you set options relating
to file handling. You can choose the program used for archiving and control
the options for log file maintenance. And the Auto Backup function lets you
save your work automatically at defined intervals.

Interface

File Handling group

Convert file paths to UNC When on, paths shown in the user interface for
any files present on a mapped drive use Universal Naming Convention (UNC)
format on page 8160. When off, each path starts with the mapped drive letter
(for example, w:\).
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This check box is linked to the Convert file paths to UNC on page 7750switch
on the Asset Tracking dialog > Paths menu. Toggling either one toggles both.

NOTE This switch affects only newly added paths. Toggling it has no effect on
existing paths. For example, if you load an image file into a Bitmap map on page
5795 from a mapped drive with the switch on, turning it off does not change the
file path to the mapped version.

Convert local paths to Relative Converts the file paths of all newly added
assets in a scene so that they are relative to the project folder on page 6932.
Default=off.

NOTE This is a system setting and is not saved with the scene file.

Backup on Save Creates a backup file if a file of the same name already exists.
The existing file is renamed maxback.bak and placed in the autoback directory
before the save occurs. You can edit the automatic backup settings in the Auto
Backup group on page 7752. Default=on.

Increment on Save Creates a new copy of the file in the same directory
whenever you save the file. The name of the new file is incremented by 1
(filename01.max, filename02.max, and so on). Default=off.

Compress on Save Saves the 3ds Max file in a compressed format. Depending
on the details of the file, the compressed file can be as small as one-fifth the
size of its uncompressed equivalent. Default=off.

You can determine whether a 3ds Max file is compressed or not by bringing
up Properties for the file in Windows Explorer. On the Contents panel, under
General, you'll see whether the file is compressed or uncompressed.

Save Viewport Thumbnail Image Saves a 64-pixel thumbnail of the active
viewport when you save each MAX file. The Asset Browser reads thumbnails.
Saving thumbnails adds about 9K to each MAX file. Default=on.

Save Schematic View When on, the active schematic view is saved with the
MAX file. Default=on.

Save File Properties When on, any data entered in the File Properties dialog
on page 7124 is saved with the scene file and can be accessed with Windows
Explorer and File Finder on page 7143. When off, the file properties information
is not stored with the file. Default=on.

Display Obsolete File Message Turns off the "Obsolete data format found -
Please resave file" alert that is displayed when you load a MAX file created in
an earlier version of 3ds Max. Default=on.
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There is a matching "Do not display this message" check box in the alert itself,
and you can also turn off the alert from there.

Reload textures on change When on, reloads bitmapped textures if the date
of the bitmap file has been updated. Default=on.

Recent Files in File Menu Sets the maximum number of recently edited MAX
files to display in the list File > Open Recent. Range=0 to 50. Default=9.

Auto Backup group

Auto Backup saves your work periodically. In the event of a power failure, if
you have not saved your work, you can load in an auto backup (autoback) file
from the autoback subdirectory in the program directory (or under \My
Documents\3dsmax\) and continue working with little lost work.

Auto Backup creates auto backup files based on a time interval. The name of
an auto backup file is AutoBackupN.max, where AutoBackup is the main part of
the name (AutoBackup is the default), and N is an integer from 1 to 99.

For example, if you've set Auto Backup to create three auto backup files at
one-minute intervals, Auto Backup will create AutoBackup1.max, and then a
minute later AutoBackup2.max, and then AutoBackup3.max. At the fourth minute,
the system overwrites AutoBackup1.max, and so on.

Enable Toggles Auto Backup.

Number of Autobak Files The number of backup files to write before
overwriting the first one. Range=1 to 99. Default=3.

Backup Interval (minutes) The number of minutes between backup file
generation. Default=5.0.

NOTE This interval takes effect only when the scene changes; for example, if you
move an object or apply a modifier. If nothing changes, for example, if you leave
your computer for a while, then no backups are created. Also, if you save the scene
file manually, Auto Backup resets the Backup Interval timer.

Auto Backup File Name Lets you enter an alternative name for the auto
backup file. Auto backup files with a different name still have the filename
extension .max. Default=AutoBackup.

Log File Maintenance group

The following controls affect the max.log file.
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Never Delete Log Determines how long the log file is maintained. When you
choose Never Delete, the max.log file remains on the hard disk and continues
to grow.

Maintain Only...Days Resets the file to zero bytes after it reaches the number
of days specified in this field.

Maintain Only... Kbytes Resets the file to zero bytes after it reaches the
number of kilobytes specified in this field.

Errors Writes fatal errors to the max.log file instead of generating Alert dialogs.
Alerts halt network rendering for one or more servers.

Warnings Writes warning messages to the max.log file instead of generating
Alert dialogs.

Info Writes general information to the max.log file instead of generating Alert
dialogs.

Debug Writes debug messages to the max.log file instead of generating Alert
dialogs.

The type of errors covered by these four categories include maps that can't be
found, missing UV coordinates, missing output directories, full disks, missing
DLLs, disks to which you don't have access, invalid meshes, and obsolete MAX
files

Import Options group

Zoom Extents on Import Automatically zooms all viewports to scene extents
after importing a file.

Archive System group

Program Specifies the name and location of the program to use for archiving.
The program must be independently installed on your system. You can add
command-line arguments to follow the executable file name. For example,
for the PKZIP program, the arguments might be:

project1.zip c:proj0?.max -o

Viewport Preferences

Customize menu > Preferences > Preference Settings dialog > Viewports tab
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On the Viewports panel of the Preference Settings dialog, you set options for
viewport display and behavior.

You can also set the current Display Driver.

See also:

■ Strokes on page 7842

■ Graphics Driver Setup Dialog on page 7790

■ Configure Driver on page 7793

Interface
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Viewport Parameters group

Use Dual Planes Uses the front/back plane system when redrawing the
viewport. The selected object is manipulated in the front plane and is redrawn,
while other objects remain on the back plane and are not redrawn. This default
setting provides the fastest redraws under normal circumstances. If your
assigned display driver doesn't support dual planes, this option is not available.

Turn off this setting to improve redraw speed if you are rotating the whole
scene or moving a camera through the scene (usually situations in which the
whole viewport needs to be redrawn anyway).

Show Vertices As Dots When on, the software displays vertices in mesh and
patch objects as small, solid-color squares, whose size you can set with the
Size parameter. When off, the vertex display is a tick mark.

Size Lets you specify the vertex size displayed in the viewports. Range=2 to
7. Default=2.

Handle Size Lets you specify the display size for handles attached to patch
vertices and spline vertices. Range=2 to 7. Default=3.

Draw Links as Lines Displays the hierarchical links on page 8002 between
parent and child objects as plain lines, rather than shapes when Display panel
> Link Display rollout > Display Link is on. Show Links is enabled in the Object
Properties dialog.

Backface Cull on Object Creation Determines whether to display faces with
normals on page 8059 pointing away from view. When on, you see through the
wireframe to the backfaces. This option applies to wireframe viewport displays
only. In most cases, keep this switch enabled. However, when modeling with
NURBS surfaces, which consist of single-sided planes, it's easier to view the
geometry from all angles when backface culling is off.

■ This control affects only the created objects, and you can reverse the effect
on each object by changing the Backface Cull setting in the Object
Properties dialog for that object.You might turn off Backface Cull On Object
Creation before creating your NURBS, and then turn it on again when your
finished.

■ You can globally change the display of backface culling in the viewports
by turning on Force 2-Sided on page 7817 on the Rendering Method panel
of the Viewport Configuration dialog.

Attenuate Lights Turns the display of attenuation effects on page 7915 on or
off from start to end in the interactive viewport renderer. When off, attenuated
lights behave as though unattenuated. Default=off.
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Mask Viewport to Safe Region By default, the viewport area outside the
outermost safe frame displays the contents of the viewport. When this switch
is on, that area is left blank.

Update Background While Playing Turns on the updating of bitmaps in the
viewport background when you play an animation. This capability lets you
check your action against a 2D rotoscoped on page 8109 background, even if
your animation plays at 1 frame per second. When on, an IFL file on page 7339,
AVI file on page 7326, or MOV file on page 7348 updates on each frame when you
click the Play button. To use this feature, turn off the real-time on page 8104
switch on the Time Configuration dialog on page 7565.

The viewport updates not only when you click Play, but also when you drag
the time slider.

Filter Environment Backgrounds Affects the background displayed in the
viewport only when the Viewport Background dialog > Use Environment
Background switch on page 154 is on.

When you turn on Filter Environment Backgrounds, the environment
background is filtered in the viewport, resulting in an antialiased image. When
you turn it off, the background image is not filtered, resulting in an aliased,
pixelated image.

Note the following:

■ Filtering slows down the recalculation of the viewport background image
about 30 to 40 percent. Unless you really need that smooth display, it's
best to leave the option off.

■ This option doesn't affect the rendered background image, and doesn't
effect the viewport backgrounds when you turn on Use Environment
Background.

Low Res Environment Background Reduces the size of the environment
background map by half, and then magnifies it to the size needed for the
viewport. This results in a chunkier, pixelated appearance, but speeds the
rendering in the viewport by four times (because it halves the width and the
height of the original image).

TIP Unless you need fine detail in your environment background, keep this switch
enabled.

Display World Axis When on, displays a world axis in the lower-left corner
of all viewports. Default=on.
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Grid Nudge Distance Sets the nudge distance for the Nudge Grid Down and
Nudge Grid Up functions, which you can use to move an active grid helper
object into position. See To nudge a grid object up or down: on page 2626.

Non Scaling Object Size Sets the display size of cameras, lights, and other
nonscaling objects. Default=1.

Display Drivers group

Currently Installed Driver Displays the name of the currently installed driver.

Choose Driver Displays the Display Driver Setup dialog on page 7790. Use this
dialog to select a different software display driver, or to switch drivers if you
installed a hardware accelerator card.

Configure Driver Displays the Configure Driver dialog on page 7793, where
you can change the driver options for your currently selected driver.

Ghosting group

Ghosting Frames Specifies the number of ghost images that appear before
and after the current frame when you choose Show Ghosting from the Views
menu. If you display ghosts both before and after the current frame, the total
number of ghosts is twice this number.

Display Nth Frame Specifies the number of frames between the appearance
of each ghost. The smaller this number, the closer the ghost images appear to
each other.

Ghost Before Current Frame Displays only ghost images that occur before
the current frame. This makes the ghosts trail the object.

Ghost After Current Frame Displays only ghost images that occur after the
current frame.

Ghost Before and After Displays ghosts both before and after the current
frame.

Ghost in Wireframe Displays ghosts in black wireframe in shaded viewports.
When off, the ghosts appear as shaded objects, using the same colors as the
wireframe ghosts.

Show Frame Numbers Displays a frame number in the upper-left corner of
each frame.
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Mouse Control group

Middle Button Pan/Zoom Sets the middle mouse button to pan in the
viewport if you have a three-button mouse. If you have a Microsoft
Intellimouse, you can also roll the middle wheel to zoom the viewport.

To Zoom with a three button mouse, press Ctrl+Alt and drag the center button.

NOTE By default, the Intellimouse slows the speed of the mouse when you hold
down the wheel button. You can increase the mouse speed in the Mouse Properties
dialog in the Windows Control Panel. Choose the Wheel tab, click the Settings
button in the Wheel Button group, and turn the slider up to Fast.

Stroke Assigns command shortcuts to stroke patterns applied by dragging
with the middle mouse button. See Strokes on page 7842.

Zoom About Mouse Point (Orthographic) When on, viewports zoom about
the point where you click the mouse. When off, viewports zoom about the
center of the view. Applies to orthographic viewports only.

Zoom About Mouse Point (Perspective) When on, viewports zoom about
the point where you click the mouse. When off, viewports zoom about the
center of the view. Applies to perspective viewports only.

Right Click Menu Over Selected Only Limits the right-click menu display
over a selected object. Default=off.

When this option is off, you can right-click anywhere in the viewports to
display a menu.

Wheel Zoom Increment Determines the sensitivity of the zoom when you
use the wheel on the mouse. Increase sensitivity up to a maximum value of
100 or reduce it to a minimum of 0.01. Default=1.0.

Gamma and LUT Preferences

Customize menu > Preferences > Preference Settings dialog > Gamma and LUT
tab

On the Gamma And LUT panel of the Preference Settings dialog, you set
options to adjust the Gamma on page 7994 and lookup-table (LUT) values for
input and output images and for the monitor display.
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Lookup-table (LUT) Correction

Lookup-table (LUT) correction provides compatibility with the same feature
used in other Autodesk Media & Entertainment products such as Combustion
and the systems suite: Inferno, Flint, Smoke, and so on. This feature allows
studios to implement a consistent way of displaying colors, assuming that
their monitors are calibrated to the same reference. Thus 3D artists can produce
results that are closer to what the compositor expects by eliminating a variable
in the equation: the way colors are displayed on screen.

NOTE The lookup table controls available here do not affect exposure control or
lighting of the scene. While they do affect the colors of the final image, this is with
regard to the display only. By having a reference across a studio (with calibrated
monitors), using standardized lookup tables minimizes variability in rendered
output.

Also, please note that the LUT system of the systems suite is complex and
offers a variety of controls and flavors of lookup tables. This feature integrates
the View LUTs only, such as that found in Combustion, where only the
displayed images are modified.

Gamma Correction

Gamma correction compensates for the differences in color display on different
output devices, so that images look the same when viewed on different
monitors, or are used as bitmaps or in printed matter.

The calculation of “gamma” is output_intensity = input_intensity(1/gamma). That
is, the result is the original value raised to the power of the inverse of the
gamma value. One result of this calculation is that a gamma value of 1.0 does
not adjust the image at all.
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Gamma = 1.0: no correction

I stands for Intensity.

Another result of the gamma calculation is that black is not affected by the
adjustment, and neither is white (or any fully saturated color). Gamma
adjustment affects only the midtones of an image.

Left: gamma = 1.8

Right: gamma = 2.2, the standard for video

The horizontal axis represents input (the original value) and the vertical axis represents
output (the gamma-corrected value).
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Computer monitors and videos don’t display color in a linear way (as in the
first illustration). Also, the brightness of a monitor tends to make an image
seem brighter than its intensity values really specify. Gamma correction fixes
this problem, and can ensure consistency between different applications or
different monitors. When you set gamma, find a value that makes middle
gray on your own monitor match a true middle (50 percent) gray.

Changing gamma value to match a monitor's middle gray

The standard gamma value for video is 2.2. This is the theoretically correct
value, making the linear color space stored in the bitmap and used by the
renderer appear to be linear on screen.

However, because the response of photographic film isn’t linear either, users
find that this theoretically correct value looks too bright and washed out. A
common compromise is to render to a gamma of 1.7 or 1.8, making things
look more photographic; that is, as if the image had been shot on photographic
film and then developed.

We recommend that you always turn on gamma correction when you share
bitmaps between different computers, between different applications on the
same computer, or create renderings to use in printed matter.

NOTE

If the only other applications that use your renderings are also Autodesk Media
& Entertainment products, you might want to use LUT correction instead of
gamma correction.
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Two common mistakes have to do with gamma correction:

■ Not applying gamma correction when it should be used. This results in
renderings or bitmaps that are too dark.

■ Inadvertantly applying gamma correction twice. This results in renderings
or bitmaps that are too bright.

See the Procedures section below for more detailed instructions.

Procedures

To set the gamma for renderings you will use as bitmaps or in printed matter:

1 Choose Customize > Preferences.

2 Turn on Enable Gamma/LUT Correction.

3 Turn on Load Enable State With MAX Files.

This step is optional but recommended. It ensures that the gamma settings
are used with all your scenes.

4 In the Display group at the left-hand side of the panel, choose Gamma.

5 Use the Gamma spinner to adjust the Gamma value until the gray square
in the center of the display shows no contrast with the surrounding
border.
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Above: A bad gamma value

Below: A good gamma value

The value you choose can vary, depending on your system's monitor.

6 Once you have a good gamma value, change Output Gamma in the
Bitmap Files group on the right-hand side of the tab to the same value
as Display gamma.

7 Click OK.

To set the gamma for incoming bitmaps generated (or edited) by other
applications:

1 Find out whether the other application has its own gamma correction.

2 If it does, choose Customize > Preferences > Gamma And LUT. Turn on
Enable Gamma/LUT Correction, and choose an Input Gamma value that
matches the application’s.

If the file type (for example, Targa) has an embedded gamma value, you
might need to set Input Gamma to the inverse (1/gamma) of the file’s
embedded gamma, to avoid applying gamma correction twice.

3 If it does not, choose Customize > Preferences > Gamma And LUT. Turn
on Enable Gamma/LUT Correction, then in the Bitmap Files group, change
the Input Gamma to a suitable value.
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Input gamma set to a value suitable for a different application

It might take some experimentation to find the gamma value that best
adjusts the bitmaps created by the other application. The bitmap should
appear the way it does in the other application: if it appears too light or
too dark in 3ds Max, try a different Input Gamma value.

IMPORTANT If you use bitmaps from multiple applications, and these
different applications have different ideal Input Gamma values, then turn on
gamma correction, but leave Input Gamma set to 1.0. Instead, for each
bitmap you read, use the individual Select Bitmap Image File dialog to set
the gamma value appropriate to the program that created the bitmap.

Example: To use gamma correction with Adobe Photoshop:

1 In Photoshop, make sure Edit > Color Settings is set to “North America
General Purpose Defaults”, with Working Space > RGB set to “sRGB
IEC61966-2.1”.

This is the default color correction in Photoshop.

2 Also in the Photoshop Color Settings dialog, change Color Management
Policies > RGB to “Convert To Working RGB”.

3 In Photoshop, click OK and then save the bitmap file.

4 In 3ds Max, choose Customize > Preferences > Gamma And LUT.

5 On the Gamma And LUT tab, turn on Enable Gamma/LUT Correction.
In the Display group, choose Gamma, then set the gamma value to 2.2.

6 In the Materials And Colors group, turn on both Affect Color Selectors
and Affect Material Editor.

7 In the Bitmap Files group, set both Input Gamma and Output Gamma
to 2.2.
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8 Click OK to close the Preferences dialog.

Now when you use a bitmap saved by Photoshop, the colors in 3ds Max
should preserve the bitmap’s original colors.

To use gamma with video hardware:

Video devices such as video tape recorders usually have their own hardware
gamma-correction circuitry.

■ If your video device has its own hardware gamma correction, do not turn
on gamma correction in 3ds Max.

■ If your video device does not perform gamma correction automatically,
follow the preceding steps for setting Input Gamma and Output Gamma,
using values approprate to your video device. Typically these will be Input
Gamma = 0.45 and Output Gamma = 2.2.

Typical input and output gamma settings for video that has no hardware gamma
correction
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Interface

Enable Gamma/LUT Correction Makes available the controls for adjusting
gamma or LUT correction. Turn off to disable gamma/LUT correction.
Default=off.

Load Enable State with MAX Files Loads the state of Enable Gamma/LUT
Correction with each 3ds Max file. Default=off.

When you choose Load Enable State, and load a scene file whose Enable
Gamma/LUT Correction state differs from the current state, you can make the
correction correspond with the setting in the current file or leave the setting
as is.

If you have a maxstart.max file and you choose this option, new sessions of
3ds Max use the Enable Gamma/LUT Correction state in the file. If you turn
this option, off, the file doesn't affect the state of Enable Gamma/LUT
Correction.
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Display group

Display gamma correction or lookup tables applies to viewports and the
Rendered Frame Window  on page 6073. Use the controls in this group to load
an Autodesk View LUT or adjust gamma numerically.

Autodesk View LUT Click the Browse button and then use the Load LUT File
dialog to find and open a LUT file. Thereafter the LUT file name appears in
the text field to the right of the button.

NOTE 3ds Max does not support generation of LUT files, and no LUT files are
included with the software. To create a LUT file, use a program such as Combustion.

Gamma Adjusts the gamma display for 3ds Max. The spinner value increases
or decreases the value (lightness or darkness) of the solid gray center square.
Adjust the value until the center square is as close as possible in value to the
surrounding checkered border. Range = 0.1 to 5.0.

If you're creating bitmaps or renderings that will be sent to someone else, set
Output Gamma to match the correct Display Gamma value. This ensures that
the image will look correct at the destination site.

You can also display these gamma settings from the Gamma button in the
File Browser dialog; for example, when you are rendering a scene to an image
file.

Materials and Colors group

By default, the Gamma setting affects the viewport display and rendered
frames, but not the Color Selector or the Material Editor. These switches can
enable gamma correction for either or both of these dialogs.

Affect Color Selectors When on, the Gamma setting affects the display of
colors on the standard 3ds Max Color Selector. This setting has no effect on
the Object Color dialog.

Affect Material Editor When on, the Gamma setting affects the display of
colors on the Material Editor dialog.

Bitmap Files group

Input Gamma Adjusts bitmaps that you load (for example, texture m aps),
provided that the bitmap type doesn't override the gamma with its own gamma
value. Range = 0.1 to 5.0.

In the case of Targa files, for example, the file's inherent gamma will override
the 3ds Max Input Gamma. In this case, set Input Gamma to the inverse
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(1/gamma) of the incoming gamma correction. This avoids applying gamma
correction twice, which will make the bitmap too bright.

Output Gamma The gamma correction applied to bitmaps that you render.
Set this to match the correct Display Gamma value. Range = 0.1 to 5.0.

Rendering Preferences

Customize menu > Preferences > Preference Settings dialog > Rendering tab

On the Rendering panel of the Preference Settings dialog, you set options for
rendering, such as the default color of ambient light in rendered scenes. The
many choices available enable you to reassign the renderers used for production
and draft rendering.

Interface
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Video Color Check group

Some pixel colors are beyond the safe NTSC on page 8059 or PAL on page 8078
threshold. You can choose to flag or modify them to acceptable values.

Flag with Black Flags all illegal pixels with black to show you the illegality
of your image. This mode teaches you how to make correct colors, instead of
depending on Scale options. Scale options force a natural discontinuity in the
color values. In some cases, that discontinuity can cause visible aliasing on
page 7904.

Scale Luma Scales the luminance to bring the color into range, and maintains
saturation. This generally makes the illegal areas appear darker than they
should be.

Scale Saturation Scales the chroma to bring the color into range, and
maintains saturation. Because this option keeps the brightness levels of the
pixels fairly equal to the unscaled ones, this is the more useful of the two scale
methods.

NTSC/PAL Determines the standard for the video color check. See NTSC
(Glossary) on page 8059 and PAL (Glossary) on page 8078.

Output Dithering group

Sets output dithering on page 7956 for all file types.

True Color Toggles dithering for any true color output device. For 24-bit work,
turn on True Color. For paletted work, turn it off.

Paletted Turns dithering on or off for any 8-bit paletted device.

Field Order group

Odd/Even Selects the field order of rendered images when the Render To
Fields option is enabled on the Render Setup dialog. Some video devices require
that the even field be first, other video devices require that the odd field be
first. Determine the correct field order for your video device. If the video
output of your device is strobing or appears jittery, it may be due to incorrect
field on page 7973 order, try changing this parameter and re-rendering your
animation.

Super Black group

Threshold Keeps the super black on page 8141 threshold above a certain level
primarily for luminance keying.
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HotSpot/Falloff group

Angle Separation Locks the spotlight hotspot on page 8007 and falloff on page
8007 cones at the angle separation defined by the spinner (degrees). This option
constrains the hotspot angle so that it can't equal the falloff and cause aliasing
artifacts.

Background group

Don't Antialias Against Background Ensures that the edges of rendered
geometry are not antialiased against the background. The inside of the
geometry is still antialiased. Keep this control off unless you're creating sprites
for game development, or require special compositing techniques because the
background will not be rendered. In these cases, turning on this option helps
avoid generating alpha antialiasing on the outlines of the geometry.
Default=off.

NOTE When Don’t Antialias Against Background is on, render only against a black
background.

Filter Background Controls whether the antialiasing filter of the renderer
affects the background image. See Plate Match /MAX R2.5/VIZ R2 Filter Types
in Default Scanline Renderer Rollout on page 6141 for detailed information of
filtering background and antialiasing.

Use Environment Alpha Controls whether or not the renderer uses the
environment map’s alpha channel in creating the alpha for the rendered
image. When off, the background is transparent. When on, the alpha of the
resulting image is a combination of the scene and image alpha.

NOTE Only background images with alpha channels or black backgrounds are
supported when compositing in other programs such as Photoshop.

Default Ambient Light Color group

Click the color swatch to change the default ambient light on page 7906 color
for renderings. This setting defines the darkest color for rendered shadows in
the scene.

Output File Sequencing group

Nth Serial Numbering Specifies whether output frame files generated using
a frame-step value other than 1 are numbered sequentially (on) or according
to their true frame numbers (off).
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Render Termination Alert group

Beep Beeps when the rendering has finished. You can set the frequency and
the duration.

Play Sound Plays a sound file when the rendering has finished.

Choose Sound Opens the Open Sound browser dialog, select a sound file
using the browser. You can test sound files with the Play button in the Open
Sound dialog. Press ESC to turn off the sound.

GBuffer Layers group

Maximum Number Limits the number of layers that are stored in the G-buffer
during rendering. Default=10; Range=1 to 999.

Memory requirements might dictate that you limit the number of G-buffer
layers. The RLA and RLF image formats, used for compositing, can store many
G-buffers for object Z buffer information, material ID, transparency, and so
on.

Multi-threading group

On Causes the software to treat the rendering task as separate threads. This
option works with multiprocessor systems. Each processor in your computer
handles a different thread, which makes full use of available processing power
and speeds up rendering to its maximum level. When off, 3ds Max treats a
rendering task as a single processing task and doesn't divide it up.

Bitmap Pager group

The Bitmap Pager can help with the rendering of scenes that have very large
textures, a large number of textures, or when rendering a high-resolution
image.

TIP You can access a Bitmap Pager Statistics dialog on page 7150 with useful pager
information such as memory usage: Go to Customize menu > Customize User
Interface, find the Bitmap Pager Statistics Toggle item in the Main UI list, and then
assign it as a keyboard shortcut or other UI element.

On When on, the software creates a series of temporary “page” files on the
drive where it is installed for use in rendering bitmaps.

Page Size (kB) Sets the size of the bitmap page. If textures are smaller than
the page size, the system allocates only the memory required.
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Bitmap Size Threshold (kB) Sets the minimum size (in kilobytes) that a
bitmap must be in order to be paged.

Memory Pool (kB) Controls the amount of memory used by the pager. All
pages remain in memory until this limit is reached. When the limit is reached,
the pager begins saving pages to disk. Pages that are not frequently used are
paged out; more frequently used pages are kept in memory.

Animation Preferences

Customize menu > Preferences > Preference Settings dialog > Animation tab

On the Animation panel of the Preference Settings dialog, you set options
relating to animation on page 7907. Options include displaying animated objects
in wireframe viewports, the assignment of sound plug-ins, and controller
defaults.

Procedures

To change the default transform center:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Animation tab.

2 Turn off Local Center During Animate in the Animate group.

This changes the default and activates all the transform center buttons.
You can now move about the selection, coordinate center, or local pivot.

To set the key bracket display:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Animation tab.

2 Use the controls in the Key Bracket Display group to specify how you
want key brackets displayed in wireframe viewports.

To specify default controller settings:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Animation tab.

2 Click Set Defaults in the Controller Defaults group.

The Set Controller Defaults dialog appears.
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3 Choose a controller type from the list of available controllers and click
the Set button.

A dialog containing the default settings supported by the selected
controller type appears in, for example, the In and Out tangents for a
Bezier controller.

4 Make changes to the controller settings.

Once you click OK in the Set Controller Defaults dialog, the controller
defaults are changed.

Changes to the controller default settings are written to your 3dsmax.ini
file and become the defaults for all newly assigned controllers and all
new scenes.

If you decide that you want to revert to the original 3ds Max defaults for
all controllers, you can click Restore To Factory Settings.
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Interface

Key Bracket Display group

When you move to a frame, the software displays white brackets around
objects that have transform keys on page 8020 at that frame, including cameras
and lights. These key brackets appear only in wireframe viewports.

All Objects/Selected Objects/None Specifies which objects display key
brackets.

Use Current Transform Displays brackets only on those frames containing
keys for the active transform tool on page 8157 (Move, Rotate, or Scale).

If no transform tool is active, brackets appear in frames containing any of the
three transforms.

To define which types of transform display brackets, turn off Use Current
Transform and use the Position/Rotation/Scale switches (see following) .

NOTE When actively scrubbing the frame slider, brackets always appear for all
transforms.
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Position/Rotation/Scale Specifies which types of transform display brackets.
For example, if only Rotation is on, brackets appear only on those frames
containing Rotation keys. These check boxes become available when Use
Current Transform is off.

Animate group

Local Center During Animate Locks the center method to local on page 8026.
Turn off if you want to animate around a non-local center such as world or
selection.

MIDI Time Slider Control group

Enables use of a MIDI device to control the time slider. Choose On to use the
MIDI device specified in the MIDI Time Slider Control Setup dialog on page
7807, which is displayed with the Setup button.

Sound Plug-In group

Assign Displays a dialog listing all sound plug-ins installed in the system.
Select a new plug-in to replace the current one.

Controller Defaults group

Sets the default values for animation controllers capable of supporting default
settings. For example, set the default values for tension, continuity and bias
in the TCB float controller.

Override Parametric Controller Range By Default When on, new parametric
controllers are active throughout the timeline, independent of their animation
range. Otherwise, they respect it and are only active within their range. Refer
to Ignore Animation Range on page 3598 and Respect Animation Range on page
3599 for more details. Default=on.

Spring Quick Edit Toggle to increase the accuracy of all spring controllers in
the scene. To be used with the Rollback input field. Default=off.

NOTE This option is saved in the 3dsmax.ini file as SpringsQuickEdit.

NOTE Turning on this option can impact scene performance.

Rollback Sets the number the frames a spring controller goes back before
becoming invalid. Default=6.
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NOTE This option is saved in the 3dsmax.ini file as SpringsRollingStart.

NOTE Setting a high number can impact scene performance.

Set Defaults Displays a dialog listing all controllers that can have their default
values changed. The Set button becomes available when you choose a
controller class from the list. Highlight a controller class, click Set, edit the
default key values, and then click OK.

Restore To Factory Settings Prompts you to verify if you want to reset all
controllers to the program's default settings. If you choose Yes, the defaults
are reset for all controllers currently in the system.

Auto Key Default Frame group

On When on, using Auto Key mode to set a key at a frame other than the
start frame (0 or 1) also creates a key at the start frame. When off, no key is
created at the start frame.

[default frame] When Auto Key Default Frame is on, this setting specifies the
start frame at which 3ds Max sets a key when you use Auto Key to set a key
at a frame other than the start of the animation.

The available settings are 0 and 1. When you set the default frame to 1, 3ds
Max uses the equivalent in the current time display system, set via the Time
Display setting on page 7570 on the Time Configuration dialog. For instance, if
Time Display is set to MM:SS:TICKS, the equivalent to frame 1 is 0:0:160.

Inverse Kinematics Preferences

Customize menu > Preferences > Preference Settings dialog > Inverse Kinematics
tab

On the Inverse Kinematics panel of the Preference Settings dialog, you set
options for both applied and interactive inverse kinematics on page 8016.

Procedures

To prevent transforming unlinked objects while working in IK mode:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Inverse Kinematics tab.
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2 On the Inverse Kinematics panel, turn off the option labeled Always
Transform Children Of The World.

Single, unlinked objects are hierarchies of one object. An unlinked object
is its own root and also a child of the world, so turning off Always
Transform Children Of The World prevents you from transforming single
objects in IK mode.

Interface

Applied IK/Interactive IK group

The threshold and iterations settings are a trade-off between accuracy and
speed. With the two groups of settings you can individually tune the behavior
of Interactive IK and Applied IK. Interactive IK provides fast, real-time response,
so you should set Interactive IK preferences for speed. Applied IK provides the
IK solution on page 8009 to match the follow objects on page 7985 very closely.
You should set applied IK preferences for accuracy.

Position Sets how close the end effector has to get to the follow object or
cursor position for the object to be considered a valid solution. The value
represents a distance in the current display unit system. Small values increase
accuracy but take longer to solve.
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Rotation Sets how accurately the end effector has to match the orientation
of the follow object to be considered a valid solution. The value represents a
rotation angle in degrees. Small values increase accuracy but take longer to
solve.

Iterations Sets the maximum number of times 3ds Max repeats the IK
calculations to find a valid solution. A high iterations value increases the
chance that 3ds Max can calculate a valid IK solution, but the calculation
takes longer to complete.

Ungrouped controls

Use Secondary Threshold Compares the second derivative of the end effector
on page 7963 to a very small threshold. If the derivative is within the threshold,
IK is terminated.

Always Transform Children Of The World Applies in both move and rotate
modes when IK is on. It affects only an object that is a direct child of the world
when the object is selected.

For example, if the root of an IK chain is a child of the world, and you're
manipulating an object at the end of the chain (the root object itself isn't
selected), the software observes any constraints set for the root object. However,
if you select the root object and try to move it, its constraints will be ignored.

Gizmos Preferences

Customize menu > Preferences > Preference Settings dialog > Gizmos tab

You set the display and behavior of the Transform gizmos on page 934 on the
Gizmos panel of the Preference Settings dialog.
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Interface

Transform Gizmos group

On When on, 3ds Max uses the Transform gizmo to enable more powerful
move, rotate, and scale options. When off, a basic tripod is displayed, with
no axis specificity.

Show Axis Labels Toggles the display of the axis labels on the Transform
gizmo.

NOTE Functionality is maintained when Show Axis Labels is off.

Allow Multiple Gizmos Toggles the display of more than one gizmo at a
time.

When off, a transform gizmo is displayed for only one object at a time in a
selection set.
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When on and the Use Center flyout > Use Pivot Point Center  on page 976
setting is active, each object in a selection set has its own transform gizmo.

Size Sets the size of the Transform gizmo as a percentage of the viewport size.
Range=1 to 100.

Move Gizmo group

Relative Size (%) Sets the size of the Move gizmo, relative to the Size value
of the Transform gizmo. Range= 0.0 to 500.0.

Plane Handles group

The plane handles let you constrain object movement along combinations of
any two axes.

On Toggles the use of plane handles on the Transform gizmo.

Size Sets the size of the plane handles, as a percent of the distance from the
Offset to the tripod axis. Range=0.0 to 100.0.

Offset The percentage of the distance from the gizmo's tripod axis to the outer
extent of the Primary axis handles.

For example, 0 = no plane handles; 100 = plane handles extend as far as the
Primary axis handles.

Center Box Handle group

The center box can be used as a handle for translations constrained parallel
to a viewport.

Move in Screen Space Toggles the use of the center box handle.

Rotate Gizmo group

Relative Size (%) Sets the size of the Rotate gizmo, relative to the Size value
of the Transform gizmo. Range= 0.0 to 500.0.

Free Rotation Toggles the ability to rotate about any combination of axes.

When off, you can rotate only about a specific axis, or, if Screen Handle is on
(see following), parallel to the screen.

Show Tripod Toggles display of an axis tripod at the pivot point. This tripod
also highlights the selected axis while rotating.

Screen Handle Toggles display of the screen orbit, which lets you rotate an
object parallel to a viewport.
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Show Pie Slice When on, a shaded pie slice acts as a visual indicator of the
direction and amount of rotation.

NOTE If you rotate more than 360°, the slice overlaps and the shading becomes
increasingly intense.

Angle Data When on, numerical feedback appears in the viewport during
single-axis rotation, indicating the amount of rotation around the X, Y, or Z
axis.

Rotation Method Sets the rotation method for the gizmo:

■ Linear Roll: Rotate the virtual trackball by dragging in a single direction,
tangent to the Rotate gizmo.

NOTE A tangent handle appears to show the best direction to drag the mouse.

■ Circular Crank: Rotate the virtual trackball by dragging around the Rotate
gizmo, in a circular manner.

■ Legacy R4: Turns off virtual trackball behavior, and uses the rotation
method from 3ds Max 4.

Planar Angle Threshold Determines when the Circular Crank rotation method
automatically switches to Linear Roll to prevent loss of control over the gizmo.

This occurs when a Primary axis is nearly 90 degrees to the view plane, making
it different to circle around. Any angle to the view plane that is higher than
this setting will use Crank mode, but any angle equal to or less than this
setting will always function as a Linear Roll.

Scale Gizmo group

Relative Size (%) Sets the size of the Move gizmo, relative to the Size value
of the Transform gizmo. Range= 0.0 to 500.0.

Uniform Handle Size (%) Sets the size of the handle for uniform scaling (the
distance from the transform center to the edge of the uniform handle), as a
percentage of the scale gizmo size.

2–Axis Handle Size (%) Sets the size of the handle for non-uniform scaling
along 2–axes (the distance from the edge of the uniform handle to the edge
of the 2–axis handle), as a percentage of the scale gizmo size.

Uniform 2–Axis Scaling Forces scaling using a 2–axis plane handle to be
uniform.
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Move/Rotate Transforms group

Controls the way you can move selected objects with the mouse in a
non-orthographic on page 8073 view such as Perspective on page 8087.

Intersection Shoots a ray from the mouse point into the screen. This makes
moving objects easier, but as you move toward the horizon on page 8005, the
object moves great distances.

Projection Projects the motion of the mouse onto the plane. This ensures
that there are no singularities at the horizon, and that motion is always smooth
and stable. However, it can become difficult to move objects when the plane
is not parallel to the screen.

Persp Sens Sets mouse sensitivity for projection transforms.

Rotation Increment Specifies the amount of rotation generated by moving
the mouse 1 pixel. Lower this value for angular rotations smaller than the
default .5 degrees. The lower this value, the more mouse movement is needed
to rotate objects.

Viewport Orbit Snap Angle Sets the viewport rotation increment in degrees.

 Turn on Angle Snap on the main toolbar, and then use Orbit on page
7602 to rotate a viewport. The viewport rotation snaps by the value set here.
The Orbit cursor displays a small magnet in the upper left to indicate that
Angle Snap is on.

MAXScript Preferences

Customize menu > Preferences > Preference Settings dialog > MAXScript tab

On the MAXScript panel of the Preference Settings dialog, you set MAXScript
and Macro Recorder preferences, enable or disable auto-loading of scripts, set
the initial heap size, change font style and size used in the MAXScript editor,
and manage all the settings for the Macro Recorder.

You can also change these settings by editing the [MAXScript] section of the
3dsmax.ini file.
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NOTE Two paths to support auto-startup scripts are on the Configure User Paths
dialog on page 7729 and Configure System Paths dialog on page 7732: ..\scripts and
..\scripts\startup. If you prefer to start scripts from a different directory, you can
change these default directories with the corresponding Customize menu
commands.

Choose Help > MAXScript Reference for details on MAXScript.

Interface

Startup group

You can start scripts automatically in two ways. You can create a file named
startup.ms that contains your startup code. MAXScript searches for this file in
the scripts directory first, then the 3ds Max root directory, and finally the
directories specified in the Windows PATH environment variable. MAXScript
stops searching after it finds the first occurrence of startup.ms.
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You can also place the script files you want auto-loaded into the \startup
directory inside the \scripts directory. MAXScript loads any script file with the
file name extension .ms or any encrypted script file with file name extension
.mse.

If you have both a startup.ms file and auto-load files in the \startup directory,
MAXScript always loads startup.ms first.

Load Startup Scripts Loads scripts automatically when 3ds Max starts.

Load/Save Scene Scripts Enables Scene Script loading and saving.

Load/Save Persistent Globals Enables load and save Persistent Globals.

MAXScript supports a limited form of variables. You declare that a particular
global is persistent and the value it contains is always saved to and restored
from scene files as they are opened and closed. In this way you can, for
example, keep direct references to objects in the scene in variables. Those
references will move across scene save and reload.

MAXScript Windows group

Font Choose a font for the MAXScript editor

Font size Choose a font size for the MAXScript editor.

Auto Open Listener On Output Opens the Listener if a script sends output
to a WindowStream value with no associated window. This would require a
MAXScript extension.

Runtime group

Use Fast Node Name Lookup When on, MAXScript indexes scene node
names in a cache, resulting in significantly faster resolution of non-wildcard
pathname values (for example, $box01) to node values. When off, the scene
nodes are enumerated as MAXScript looks for a scene node name that matches
the pathname, resulting in slower lookups.

Turn this off if you encounter an incompatibility with an existing script.

Memory group

Initial Heap Allocation (Mbytes) Sets the initial heap allocation.

MAXScript carves its own working memory (called a heap) out of the memory
that the software allocates. You can add to the heap at any time by increasing
the value here.
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Macro Recorder Group

Enable Macro Recorder Enables the Macro Recorder.

3ds Max starts with the macro recorder disabled and a minimized
Macro-Recorder pane in the MAXScript listener window.

You can also enable the Macro Recorder by turning on MAXScript > Macro
Recorder or by turning on Enable in the Macro Recorder menu on the
MAXScript Listener toolbar.

This state is stored in the 3dsmax.ini file. Turning it on once keeps it enabled
across restarts of the program.

Code Filters group

Command Panel Switchings Displays command panel switchings in the
code.

Tool Selections Displays tool selection in the code.

Menu Item Selections Displays menu selection in the code.

Code Generation group

The Code Generation parameters refer to whether or not the script emitted is
made selection-relative, if possible, or if it contains object references. By making
the script selection-relative, you can apply the recorded script to a different
selection, thereby making it more general. Absolute mode always works on
the same objects regardless of the current selection.

Explicit Scene Object Names Uses scene object names in the code.

Selection-relative Scene Object Names Makes Scene Object Names relative
in the code. Default=on.

Explicit Sub-object Sets Uses explicit sub-object sets in the code.

Selection-relative Sub-object Sets Uses selection relative sub-object sets in
the code. Default=on.

Absolute Transform Assignments Uses absolute transforms in the code.

Relative Transform Operations Uses selection relative transform operations
in the code.
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Radiosity Preferences

Customize menu > Preferences > Preference Settings dialog > Radiosity tab

On the Radiosity panel of the Preference Settings dialog, you set options for
the radiosity solution on page 6168.

See also:

■ Modeling Global Illumination with Radiosity on page 6168

■ Radiosity Controls on page 6188

Interface

Material Editor group

Display Reflectance & Transmittance Information When on, reflectance
and transmittance values on page 5324 are displayed in the Material Editor.

NOTE In order to make this change effective, you need to close and restart the
Material Editor.
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Interactive Display group

Display Radiosity in Viewports When on, radiosity effects are displayed in
the viewports.

Radiosity Processing group

Automatically Process Refine Iterations Stored in Geometric Objects When
on, all refine iterations stored in geometric objects are automatically processed.

Start/Reset Behavior

Display Reset Warning When on, a warning message is displayed whenever
you reset the radiosity solution in your scene.

Update Data When Required on Start When on, the radiosity engine must
be reset and then recalculated if the solution is invalidated. In this case, the
Start button changes to read Update & Start. When this is pressed, the radiosity
solution is reset and the calculation starts over again.

When this toggle is off, the radiosity solution does not need to be reset if it is
invalidated. You can continue processing your scene with the invalid solution.

NOTE The radiosity solution is invalidated any time an object or light is added,
removed, moved, or altered in any way.

File Save group

Save Scene Information in MAX file (Decreases Load Time) The light levels
from the radiosity solution are always saved with the file, however when this
is on, some additional radiosity information is saved with your scene.

mental ray Preferences

Customize menu > Preferences > mental ray panel
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Interface

General group

Enable mental ray Extensions When on, enables certain features that provide
additional support for the mental ray renderer. When off, these features do
not appear in the interface. Default=off.

These are the features enabled as mental ray extensions to 3ds Max:

■ mental ray Connection rollout on page 5385 for materials (Material Editor)

■ mental ray Light Shader rollout on page 5115 (Modify panel for lights)

WARNING If you have assigned shaders and adjusted their settings using the
mental ray Connection rollout, turning off Enable mental ray Extensions will lose
all these assignments and settings. The same applies to light shader assignments.

Rendering group

Show Brackets on Current Buckets Displays white selection brackets at the
corners of the bucket currently being rendered. Default=on.
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Show Visual Final Gather Progress When on, the Rendered Frame Window
on page 6073 displays a coarse image of the final gather points as those points
are being calculated. This provides visual feedback of the final gather solution
in progress. Default=on.

If you prefer that the final render directly overwrite the previous one in the
Rendered Frame Window for comparison purposes, turn this off.

Visual display of final gather calculation in progress

Clear Frame Window Before Rendering When on, before rendering the
Rendered Frame Window  on page 6073 turns to a gray shade by clearing every
other scanline. This makes it easier to see the progress of rendering. On the
other hand, it can make it more difficult to see the effect of small changes to
the model or the view. Default=on.

Messages group

Open Message Window on Error Whenever the mental ray renderer detects
an error, it generates an error message. When this option is on, the Messages
Window is displayed and the error message appears in it. Default=on.
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Show/Log Information Messages When on, displays informational messages
in the Messages Window. Default=off.

Show/Log Progress Messages When on, displays progress messages in the
Messages Window. Default=off.

Log Debug Messages (to file) When on, writes debug messages to the log file,
if one has been specified. Default=off.

Debug messages are never displayed in the Messages Window. The mental ray
renderer generates a large number of them, which would make the window
hard to read.

Write Messages to File When on, generates a mental ray log file on page 8028.
Default=off.

The other log file options are unavailable unless you turn on Write Messages
To File:

■ Append to File When on, appends messages to the existing file. When
off (or if the named file is not found), only new messages are written to
the file. Default=off.

■ File Click to display a file dialog that lets you choose the name and
location of the .log file.

■ File name field When you have specified a log file, this field shows its
name and its path.

Graphics Driver Setup Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Choose Driver button

(With Direct3D active) Customize menu > Preferences > Preference Settings
dialog > Viewports tab > Display Drivers group > Choose Driver button >
Direct3D Driver Setup dialog > Revert From Direct3D button

You choose and configure graphic display drivers on the Viewports panel of
the Preference Settings dialog. This topic explains driver options available on
the Display Driver Setup dialog and analyzes tradeoffs in performance.

You can also change the graphics driver when you start 3ds Max by going to
the Start menu and choosing Programs > Autodesk > Autodesk 3ds Max 2009
[installed version] > Change Graphics Mode.
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See also:

■ Configure Driver on page 7793

■ Configure Software Display Driver Dialog on page 7794

■ Configure OpenGL Dialog on page 7796

■ Configure Direct3D Dialog on page 7802

■ Direct3D Driver Setup Dialog on page 7800

Custom

Choose this if you have a custom driver installed on your system. Such custom
drivers don't use the software display driver (Heidi), OpenGL, or Direct3D. If
you don't have such a driver installed, this option is not available.

Interface

On the Display Driver Setup dialog, some options are unavailable if the
corresponding driver is not installed in the system. The currently installed
driver is listed in the Display Driver group.

NOTE The first time you launch 3ds Max Direct3D is selected be default.
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Software Display Driver

Choose this if you're using software rather than hardware acceleration. This
choice is always available.

OpenGL

Choose this option if you're using any form of hardware acceleration. The
software will use whatever driver has been installed in your operating system.

The OpenGL driver supports geometry acceleration as well as rasterization
acceleration. It offers the optimum display performance for animated
deforming meshes. It's tightly integrated into Windows NT and Windows
2000, and many 3D display cards were specifically designed to accelerate
OpenGL operations. OpenGL implementations have all of the scene data
necessary to optimize the entire 3D display process.

Because OpenGL is most efficient when run on systems with at least
rasterization acceleration, the software display driver/SZB option may work
best on systems with an ordinary 2D display card. However, with a 3D-enabled
card, you may see dramatic acceleration using the OpenGL driver.

The disadvantages of the Open GL driver are as follows:

■ All potentially visible scene data must be transferred to the driver, and this
can cause a communication bottleneck across the system bus. In particular,
this slows down the display of individual primitives (as opposed to strips
or polylines, like wireframe displays).

■ Because the OpenGL design supports a wide variety of display systems,
there is no guarantee that either incremental scene update methods (partial
window blits (Block Image Transfers) or dual planes) will work with a
particular implementation of OpenGL.

■ Because lighting and texturing are restricted to OpenGL-specified semantics,
mismatches between 3ds Max scene lighting and texturing and what
appears in an OpenGL viewport can occur. This applies especially to
attenuated lights and non-tiled texture display.)

Direct 3D

Choose this if you have a Direct3D (D3D) driver installed on your system. If
you don't have DirectX 8.1 or above installed, this option is unavailable.
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To configure the Direct3D driver, click the Advanced Direct3D button. This
button, which is available only when Direct3D is the active option, opens the
Configure Direct3D dialog on page 7802.

To switch to a different display driver when Direct3D is the active driver, click
the Choose Driver button on the Viewports tab of the Preference Settings
dialog to open the Direct3D Driver Setup dialog on page 7800, click Revert From
Direct3D, and then choose the new driver from the Graphics Driver Setup
dialog.

The Microsoft Direct3D API supports both rasterization and 3D scene-level
calls. It offers the optimum display performance for large modeling tasks, and
pixel and vertex shading. (3ds Max supports only D3D Version 8 or above,
which is included in DirectX 8.1.) D3D calls are accelerated if the display
hardware supports this.

Many inexpensive 3D display cards can use this driver efficiently. This driver
supports scene data culling efficiently, accelerates texture display (depending
on the specific display card), and performs perspective correction.

The driver works with high-color displays, which provide a good trade-off
between display quality and memory overhead. Incremental display update
works efficiently.

The disadvantages of the Direct3D driver are as follows:

■ The driver currently runs only under Windows 98, Windows Millennium,
Windows 2000, and Windows XP. (There is no multi-processor Windows
NT support.)

■ Dual-plane operations are slow (if available), and there can be some
additional overhead in minimizing/maximizing viewports due to the way
D3D allocates video memory.

You can download D3D drivers from this location:
http://www.microsoft.com/windows/directx/.

Configure Driver

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Configure Driver button

You configure the current display driver using the Viewports panel of the
Preference Settings dialog.
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Changes to a driver's configuration take effect immediately, and the
configuration persists between sessions. However, data downloaded to the
graphics card is not regenerated. For example, if you change the texture
resolution, the hardware continues to use the previous resolution until you
use the Material Editor to reload the texture.

The options in the driver configuration dialog vary, depending on which
driver is in use. This reference describes the options for the software display
driver on page 7794, Direct3D driver on page 7802, and Open GL driver on page
7796.

If you use a custom driver, the options depend on what the driver's
manufacturer provides. See the manufacturer's documentation for further
information.

See also:

■ Graphics Driver Setup Dialog on page 7790

■ Configure Software Display Driver Dialog on page 7794

■ Configure OpenGL Dialog on page 7796

■ Configure Direct3D Dialog on page 7802

Configure Software Display Driver Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Configure Driver button (when Software Display
Driver is the current driver)

The software display driver does not require hardware acceleration.
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Interface

Redraw Scene On Window Expose Redraws the whole scene when a dialog
over the viewports is moved, resulting in smoother dragging of dialogs such
as the Material Editor or Track View.

If your 3ds Max display easily becomes messy or "corrupted," turn this option
on and then redraw viewports by choosing Views > Redraw All Views (the
default keyboard shortcut for this is the ` (accent grave) key, on the left side
of the “1” key).

Use Triangle Strips Strips the geometry, which can more than double the
display speed. In some cases, such as when topology is constantly changed,
the time taken to strip the geometry can cause a slowdown instead. In such
cases, turn off this option. Otherwise, leave it on for speed.

Download Texture Size group

64, 128, 256, 512 These buttons specify the size of the bitmaps used to map
surfaces in the viewports. The larger the size, the better the resolution but the
slower the speed. High speed produces jagged maps and slower speeds produce
smooth maps.
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NOTE When Match Bitmap Size As Closely as Possible is on, these buttons are
overridden, however they are still available. The value is still used when procedural
textures are converted to bitmaps for viewport texture display.

Match Bitmap Size as Closely as Possible To allow the viewport to show
actual texture resolutions, bitmaps are individually resized in the display. This
means that small bitmaps don’t get overexpanded and large bitmaps retain
their resolution (but potentially use a lot more video RAM).

NOTE Bitmaps can be no larger than 4000 x 4000 pixels (or they will be scaled
down to this size) and no smaller than 32 x 32 (or they will be scaled up to this
size). Default=off.

Configure OpenGL Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Configure Driver button (when OpenGL is the current
driver)

The OpenGL display driver provides options that support hardware
acceleration.
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Interface

Implementation-Specific Settings group

Redraw Scene On Window Expose Redraws the whole scene when a dialog
over the viewports is moved, resulting in smoother dragging of dialogs such
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as the Material Editor or Track View. However, redrawing takes some time.
Default=on.

If your 3ds Max display easily becomes messy or "corrupted," turn this option
on and then redraw viewports by choosing Views > Redraw All Views (the
default keyboard shortcut for this is the "1" key).

This option has two subordinate options. How you should set them depends
on how the display card handles its back buffer, which is used for refreshing
the screen. Turn on one or the other, as appropriate.

Full Screen SwapBuffers Destroys Back Buffer If, after updating the screen,
the display card destroys the back buffer only when there's a single viewport,
turn on this sub-option. The OpenGL driver redraws the scene when a single
viewport is visible, but doesn't have to redraw when multiple viewports are
visible. Default=off.

Windowed SwapBuffers Destroys Back Buffer If, after updating the screen,
the display card destroys the back buffer when multiple viewports are visible,
turn on this sub-option. Default=off.

Use Triangle Strips Strips all geometric data before sending it to the driver.
In some cases, such as when topology is constantly changed, the time taken
to strip the geometry can cause a slowdown instead. In such cases, turn off
this option. Otherwise, leave it on for speed. Default=on.

This option has one subordinate option:

Display Wireframe Objects Using Triangle Strips Default=off.

Allow Dual Plane Support Uses the front/back plane system when redrawing
the viewport. The selected object is manipulated in the front plane and is
redrawn, while other objects remain on the back plane and are not redrawn.
This default setting provides the fastest redraws under normal circumstances.
If your assigned display driver doesn't support dual planes, this option is not
available.

Turn off this setting to improve redraw speed if you are rotating the whole
scene or moving a camera through the scene (usually situations in which the
whole viewport needs to be redrawn anyway).

Use Incremental Scene Updates Redraws only those scene objects that have
changed, or that intersect a region changed by another moving object. When
off, the entire scene is redrawn for each new frame. Default=on.

If the display becomes messy or "corrupted" as a result of incremental updates,
turn this option off and then redraw viewports by choosing Views > Redraw
All Views (the default keyboard shortcut for this is the ` [accent grave] key).
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Use BGRA Pixel Format When on, sends bitmaps using BGRA
(blue-green-red-alpha) ordering for pixels. This is the default order for
Windows. By default, OpenGL expects RGBA ordering. Because of this, under
default conditions, loading textures or backgrounds requires the pixels to be
reordered. OpenGL supports an extension that allows it to receive pixels in
BGRA order. This means that bitmaps can be displayed directly, without
reordering each pixel. Thus, assuming the OpenGL driver has efficient hardware
support for BGRA pixels, turning on this option makes loading textures and
background images much faster. Default=on.

Use Generalized Vertex Arrays When on, enables 3ds Max to use custom
driver code to render smoothly shaded objects. Typically this is much faster
than using standard OpenGL code, but has an effect only when the driver has
hardware-specific custom code. Default=on.

Use Wireframe Faces When on, makes wireframe display accessible to
hardware acceleration. Default=on.

This option is intended to allow display-card manufacturers to accelerate 3ds
Max wireframe displays in a way that is specific to the underlying display
hardware. Check with your display-card manufacturer to see if enabling this
option will yield faster wireframe rendering with your display card.

Appearance Preferences group

Enable Anti-Aliased Lines in Wireframe Views Draws lines slightly thicker
and much smoother. This is best used for wireframe-only views, and especially
if you're making a preview of wireframe objects.

Background Texture Size Unlike the Software Display driver, which uses
bitmaps to display viewport backgrounds directly, the OpenGL driver uses a
texture-mapped background rectangle. This allows for smoother zooms and
pans in orthographic views and can take less memory than the direct bitmap
method. However, background bitmap resolution may be lost. Increase the
resolution if you're using a maximized viewport to digitize.

Download Texture Size Lets you choose the size of the texture map that's
downloaded to the driver for texture-mapped scene objects. Larger maps look
better, but use more display card memory.

NOTE When Match Bitmap Size As Closely as Possible is on, these buttons are
overridden, however they are still available. The value is still used when procedural
textures are converted to bitmaps for viewport texture display.

Match Bitmap Size as Closely as Possible To allow the viewport to show
actual texture resolutions, bitmaps are individually resized before they are
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downloaded to the driver. This means that small bitmaps don’t get
overexpanded and large bitmaps retain their resolution (but potentially use
a lot more video RAM).

NOTE Bitmaps can be no larger than 4000 x 4000 pixels (or they will be scaled
down to this size) and no smaller than 32 x 32 (or they will be scaled up to this
size). Default=off.

Texel Lookup Specifies whether to use the nearest pixel on page 8092 or to
linearly interpolate the pixel value from the four closest texels on page 8147.
Using the nearest pixel is faster, but using texels produces a higher-quality
display. Default=Nearest.

MipMap Lookup Specifies whether to use one version of the texture map
(None) or to interpolate between a pyramid of progressively smaller maps.
With Nearest chosen, the texel lookup is done on the map level nearest the
ideal one, and with Linear, the texel values from the two closest map levels
are interpolated. Default=None.

NOTE When both Texel and MipMap lookup are set to Linear, a true trilinear
weighting of 8 texel values is used for a single pixel display. This is very accurate
and helps eliminate aliasing, but it is time consuming if the texture-mapping
hardware is not accelerated.

Direct3D Driver Setup Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Choose Driver button (if Direct3D is the active driver)

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Choose Driver button > Graphics Driver Setup dialog
> Choose Direct3D. > Advanced Direct3D button

When using the Direct3D display driver with 3ds Max, this dialog lets you
make some basic choices for setting up the driver. Further Direct3D
configuration options are available from the Configure Direct3D dialog on
page 7802.

To switch to a different display driver when Direct3D is the active driver, click
the Choose Driver button on the Viewports tab of the Preference Settings
dialog, click Revert From Direct3D, and then choose the new driver from the
Graphics Driver Setup dialog.
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Interface

Direct3D Version The available option is whichever version is currently active
in your system.

Direct3D Device The default option is Hardware (HAL). The Software (RefRast)
option is for use by software developers, and is unavailable unless the debug
version of DirectX is installed in your system.

Direct3D Use Flags The default option is Release. The Debug option is for use
by software developers, and is unavailable unless the debug version of DirectX
is installed in your system.

Revert from Direct3D Click this button to display the Graphics Driver Setup
dialog on page 7790, which lets you choose a different driver.

Graphics Driver Setup Dialog | 7801



Configure Direct3D Dialog

Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Display Drivers group > Configure Driver button (when Direct3D is the current
driver)

The Direct3D display driver provides options that support DirectX drivers.
You can download D3D drivers from this location:
http://www.microsoft.com/windows/directx/.

DirectX 10 Version

When DirectX 10 is active on your system, the dialog uses a simpler, more
straightforward interface:

The parameters are identical to those with the same names listed previously
in this topic, and one setting has been added:
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Maximum number of active lights Lets you define the number of active
lights used in the lighting calculations. Setting this too high can affect
performance.
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Implementation-Specific Settings: Geometry group

Display All Triangle Edges When on, all triangle edges are displayed in shaded
viewports. When off, triangle edges are not displayed. Default=on.

Turning off this option can improve viewport appearance, but at a cost of
display performance.

Use Cached D3DXMeshes When on, enables 3ds Max to use custom driver
code to render smoothly shaded objects. Typically this is much faster than
using standard Direct3D code, but has an effect only when the driver has
hardware-specific custom code. Default=on.

Use Wireframe Faces When on, makes wireframe display accessible to
hardware acceleration. Default=on.

This option is intended to allow display-card manufacturers to accelerate 3ds
Max wireframe displays in a way that is specific to the underlying display
hardware. Check with your display-card manufacturer to see if enabling this
option will yield faster wireframe rendering with your display card.

Use Triangle Strips Strips all geometric data out before sending it to the driver.
In some cases, such as when topology is constantly changed, the time taken
to strip the geometry can cause a slowdown instead. In such cases, turn off
this option. Otherwise, leave it on for speed. Default=on.

This option has one subordinate option:

■ For Wireframe Objects When on, uses triangle strips for wireframe objects.
Default=off.

Implementation-Specific Settings:Window Updates group

Redraw Scene On Window Expose Redraws the whole scene when a dialog
over the viewports is moved, resulting in smoother dragging of dialogs such
as the Material Editor or Track View. However, redrawing takes some time.
Default=on.

If the display becomes messy or "corrupted," turn this option on and then
redraw viewports by choosing Views > Redraw All Views (the default keyboard
shortcut for this is 1 on the numeric keypad).

This option has two subordinate options. How you should set them depends
on how the display card handles its back buffer, which is used for refreshing
the screen. Turn on one or the other, as appropriate.

■ Redraw In Maximized Viewport If, after updating the screen, the display
card destroys the back buffer only when there's a single viewport, turn on
this sub-option. The Direct3D driver redraws the scene when a single
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viewport is visible, but doesn't have to redraw when multiple viewports
are visible. Default=off.

■ Redraw In UnMaximized Viewports If, after updating the screen, the
display card destroys the back buffer when multiple viewports are visible,
turn on this sub-option. Default=off.

Allow Dual Plane Support Uses the front/back plane system when redrawing
the viewport. The selected object is manipulated in the front plane and is
redrawn, while other objects remain on the back plane and are not redrawn.
This default setting provides the fastest redraws under normal circumstances.
If your assigned display driver doesn't support dual planes, this option is not
available.

Turn off this setting to improve redraw speed if you are rotating the whole
scene or moving a camera through the scene (usually situations in which the
whole viewport needs to be redrawn anyway).

Use Incremental Scene Updates Redraws only those scene objects that have
changed, or that intersect a region changed by another moving object. When
off, the entire scene is redrawn for each new frame. Default=on.

If the display becomes messy or "corrupted" as a result of incremental updates,
turn this option off and then redraw viewports by choosing Views > Redraw
All Views (the default keyboard shortcut for this is 1 on the numeric keypad).

Appearance Preferences group

Enable Antialiased Lines in Wireframe Views Draws lines slightly thicker
and much smoother. This is best used for wireframe-only views, especially if
you're making a preview of wireframe objects.

Background Texture Size Unlike the software display driver, which uses
bitmaps to display viewport backgrounds directly, the Direct3D driver uses a
texture-mapped background rectangle. This allows for smoother zooms and
pans in orthographic views and can take less memory than the direct bitmap
method. However, background bitmap resolution may be lost. Increase the
resolution if you're using a maximized viewport to digitize.

Match Bitmap Size as Closely as Possible Displays background at full
resolution. This allows the viewport to behave like the Rendered Frame
Window  on page 6073, in regards to zoom and pan. Default=off.

Download Texture Size Lets you choose the size of the texture map that's
downloaded to the driver for texture-mapped scene objects. Larger maps look
better, but use more display card memory.
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NOTE When Match Bitmap Size As Closely as Possible is on, these buttons are
overridden, however they are still available. The value is still used when procedural
textures are converted to bitmaps for viewport texture display.

Match Bitmap Size as Closely as Possible To allow the viewport to show
actual texture resolutions, bitmaps are individually resized before they are
downloaded to the driver. This means that small bitmaps don’t get
overexpanded and large bitmaps retain their resolution (but potentially use
a lot more video RAM).

NOTE Bitmaps can be no larger than 4000 x 4000 pixels (or they will be scaled
down to this size) and no smaller than 32 x 32 (or they will be scaled up to this
size). Default=off.

Texel Lookup Specifies whether to use the nearest pixel on page 8092, to linearly
interpolate the pixel value from the four closest texels on page 8147, or to use
anisotropic filtering. Using the nearest pixel is faster, but using texels produces
a higher-quality display. The Anisotropic filter compensates for the distortion
caused by the difference in angle between the texture polygon and the plane
of the screen. Default=Nearest.

MipMap Lookup Specifies whether to use one version of the texture map
(None) or to interpolate between a pyramid of progressively smaller maps.
With Nearest chosen, the texel lookup is done on the map level nearest the
ideal one, and with Linear, the texel values from the two closest map levels
are interpolated. Default=None.

NOTE When both Texel and MipMap lookup are set to Linear, a true trilinear
weighting of 8 texel values is used for a single pixel display. This is very accurate
and helps eliminate aliasing, but it is time consuming if the texture-mapping
hardware is not accelerated.

MIDI Time Slider Control Setup Dialog

Customize menu > Preferences > Preference Settings dialog > Animation tab
> MIDI Time Slider Control group > Setup button

With the MIDI Time Slider Control Setup dialog you can specify and set up a
MIDI device to control animation playback.
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Procedures

To use a MIDI device to control the animation time slider:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Animation tab.

2 In the MIDI Time Slider Control group, choose On.

3 Click Setup.

4 Set the MIDI device options and click OK.

Interface

Presets Specifies the type of MIDI device used. You can choose the Media
Control Station 2, which is a MIDI device containing standard VCR-style
playback buttons along with a jog wheel, or you can choose Custom, which
specifies note events in the spinners. You can also use Custom to customize
the buttons used by the Media Control Station.

Channel Specifies the channel to which your MIDI device is assigned.

7808 | Chapter 26   Customizing the User Interface



Note Number group

With the controls in this group you can specify which note event triggers
which function.

Start Frame Goes to the start frame (the Rewind button in the Media Control
Station).

End Frame Goes to the end frame (the Fast-Forward button in the Media
Control Station).

Step Forward Moves one frame forward (the Fast-Forward button and Option
button in the Media Control Station).

Step Backward Moves one frame back (the Rewind button and Option button
in the Media Control Station).

Stop Stops playback (the square button).

Play Plays the animation (the arrow button).

Jog Wheel Controls the time slider with the jog wheel.

Sensitivity Controls the number of ticks that the time slider moves in response
to one unit of movement from the jog wheel. A lower value provides more
precise positioning of the time slider, while a higher value makes the time
slider move faster. If you set your time display to show ticks and set the
sensitivity to 1, you can move one tick at a time with the jog wheel.

Units Setup Dialog
Customize menu > Units Setup > Units Setup dialog

The Units Setup dialog establishes the unit display method, giving you the
choice between generic units and standard units (feet and inches, or metric).
You can also create custom units, which are used whenever you create an
object.

The units that you set up are used to measure geometry in your scene. In
addition to these units, the software also uses system units as an internal
mechanism. System units should only be changed before  you create your
scene or import a unitless file. Do not change the system unit in an existing
scene.

You can also set the lighting units using this dialog.
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System vs. Display Units

It is important to note the distinction between System and Display units.
Display units only affect how geometry is displayed in the viewports. System
units determine the actual scale of geometry. For example, if you import a
DXF file (unitless) containing a 1 x 1 x 1 Box, 3ds Max could import the box’s
dimensions in inches or miles, depending on the System unit. This can have
a significant impact on your scene, which is why you should always set up
the system unit before you import or create geometry.

Procedures

To change units to feet and inches:

1 On the Units Setup dialog, choose US Standard.

2 Choose from among the display options on the drop-down list.

■ If you want to display measurements as feet with inches, choose how
inches should appear: fractional or decimal. Also choose, for Default
Units, Feet or Inches

■ If you choose one of the Fractional display options, choose the fraction
on the drop-down list to the right.

To enter fractions in numeric fields:

■ When you enter fractions in numeric fields, they are converted to the
correct units. For example, if units are set to Feet w/ Decimal Inches, and
Default Units is set to Feet, type 37/45 and press Enter for the result 0'9.867",
or 37/45'.

To enter a fraction and a units specifier, place the specifier after the divisor.
For example, type 17/5', but not 17'/5.

To convert between unit types:

■ You can convert between unit types by entering any valid unit specifier,
along with the number, and then pressing Enter.
The number is converted to the current unit display type. For example, if
units are set to Meters, type 1/2 to get the result 0.5M. However, if you
type 1/2' or 6" the result is 0.152M.
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Interface

System Unit Setup Click to display the System Unit Setup dialog on page 7812
and change the system unit scale.

WARNING  Change the system unit value only before importing or creating
geometry. Do not change the system unit in an existing scene.
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Display Unit Scale group

Choose a unit scale option (Metric, US Standard, Custom, or Generic Units)
to activate its settings.

Metric Choose this option and then choose a metric unit: Millimeters,
Centimeters, Meters, or Kilometers

US Standard Choose this option and then choose a US Standard unit. If you
choose a fractional unit, the adjoining list activates to let you select the
fractional component. The decimal units require no additional specification.

The US Standards are as follows:

■ Fractional Inches

■ Decimal Inches

■ Fractional Feet

■ Decimal Feet

■ Feet w/ Fractional Inches

■ Feet w/ Decimal Inches

For the last two items, you can specify which unit is assumed when you enter
a value in a numeric field and press Enter without including a units specifier,
such as ' for feet or " for inches.

For example, if Feet is the default, typing 5 followed by Enter results in 5 feet.
Typing 5" followed by Enter results in 0'5". If Inches is the default, typing 5
followed by Enter results in 0'5". Typing 5' followed by Enter results in 5 feet.

Custom Fill in the fields to define a custom unit of measurement.

Generic Units This is the default option (one inch) and is equal to the system
unit used by the software.

Lighting Units group

The Lighting Units group lets you choose whether light values are displayed
in American or International units.

System Unit Setup Dialog

Customize > Units Setup > Click System Unit Setup.
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This dialog appears when you click System Unit Setup in the Units Setup
dialog on page 7809.

WARNING  You should only change the system unit value before importing or
creating geometry. Do not change the system unit in an existing scene.

Because of the nature of digital floating-point calculations, distances that are
extremely large or extremely small can cause round-off error. Symptoms of
round-off error include trouble navigating (zooming and panning become
too fast or too slow), unwanted viewport clipping, and unexpected flipping
of normals. Here are some general guidelines to avoid these problems:

■ Make sure your scene is roughly centered around the origin (0,0,0).
Round-off error increases at large distances from the origin.

■ Make sure no significant detail in the scene is smaller than one generic
3ds Max unit.

NOTE The Rescale World Units utility on page 2682 alters the scale of world units
throughout the entire scene, or selected objects.

Procedures

To change the system unit:

1 Choose Customize menu > Units Setup.

2 Click System Unit Setup.

3 Change the System Unit Scale value, and click OK.

The system unit is immediately reset. This setting remains in effect until
you change it.
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Interface

Unit and Measurement fields Change the scale of the 3ds Max unit. The
system unit is the standard measurement throughout 3ds Max. You should
only change the system unit value before importing or creating geometry.

Respect System Units in Files When on, if you open, merge, XRef, or drag
and drop geometry from file that has different system unit settings, a File
Load: Units Mismatch dialog on page 7815 is displayed. This dialog gives you
the choice of rescaling the geometry to match the current system units, or
adopting the units used in the file. When off, the dialog is not displayed, and
the file is assumed to have the same units as the current 3ds Max session.
Default=on.

Origin Slider, Distance from Origin,Accuracy

These controls provide a system unit calculator to help you determine the
unit scale for your project. The resolution of measurement diminishes as the
distance to the origin of space increases, so you need to consider space
granularity when you choose a scale for your project. If you're modeling an
island, for example, this calculator can help you determine the smallest object
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you should model on the island. In other words, don't use a unit scale of
millimeters if you plan on modeling an island that's many miles across.

When you use the slider or the text field to enter a distance from the origin,
the Resulting Accuracy changes to show what the round-off error will be at
that distance.

These controls don't change the unit settings in 3ds Max. They don't reflect
the extents of the current scene, either.

Origin Slider Move the slider for interactive feedback of distance and accuracy.
Right-click the scale to reset the slider to 0. Dragging the slider displays the
last slider position as a small square on the scale markings.

The slider covers distances from 0 to the maximum distance that's accurate
to one system unit.

Distance from Origin Enter the maximum distance you want to use in your
project to determine the maximum accuracy, which is displayed in the
Accuracy field. Values consider current settings for system scale and unit.

NOTE When you type a distance, you must press ENTER to update the Resulting
Accuracy field. Pressing TAB simply moves focus to Resulting Accuracy, without
doing the calculation.

Resulting Accuracy Enter the minimum resolution you will use to determine
the maximum size or distance that is most practical. Values consider current
settings for system scale and unit.

For example, if units are in feet and decimal inches in Customize menu >
Units Setup, and you type (1', 1 foot) in the Accuracy field, a value of
22369620'0.0" is displayed in the Distance From Origin field. If you move an
object that's one foot across, at this distance away from the origin of space, a
round-off error will occur, and the shape of the object will be compromised.

File Load: Units Mismatch Dialog

Change the system unit scale. > Open, Merge, XRef, or drag geometry from a
file with a different unit scale.

This dialog appears when you open or merge a file that has been saved with
system unit settings that are different from those of your current 3ds Max session.
The default system unit setting is Inches.

If you open a file with the system unit set to meters, for example, you will see
this dialog.
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When this happens, you have two options:

■ Rescale the File Objects to the System Unit Scale: You can choose to rescale
the objects from the incoming file to match the current system unit. This
changes the size of the incoming geometry

■ Adopt the File's Unit Scale: This changes the system unit in your 3ds Max
installation to match that of the incoming file. This setting will persist
between the current and future 3ds Max sessions until you reset your
system unit on page 7812. This is the default option.
Choosing File > Reset will not reset your system unit. You must either
change it using Customize > Units Setup > System Unit Setup, or manually
edit your 3dsmax.ini file.

NOTE This dialog appears only if Respect System Units In Files is enabled on the
System Unit Setup dialog on page 7812.

Interface

Rescale the File Objects to the System Unit Scale  Objects from the file are
rescaled to the current session's system unit scale.
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NOTE Many features depend on the scale of the scene, so choosing to rescale the
file objects can have unpredictable results, particularly in scenes using radiosity.
Reset and recalculate radiosity if you have rescaled the file objects.

TIP Use the Zoom Extents All button if the geometry is no longer visible in the
viewport after rescaling.

Adopt the File's Unit Scale The system unit scale is changed to match that
of the other file. This is the default option.

Choosing Adopt The File’s Unit Scale adds two settings to your 3dsmax.ini file:
UnitType= and UnitScale=. For this reason, this change is persistent between
sessions until you reset it manually.

To get back the default System Unit Scale, you can edit your 3dsmax.ini file
and remove those settings; or go to Customize > Units Setup > System Unit
Setup and change the units back to the default scale, Inches.

TIP Objects with a UVW Unwrap may lose their texture coordinate information
when you choose this option. If this occurs, choose the Rescale option rather than
the Adopt option.

Viewport Configuration
Views menu > Viewport Configuration

Right-click any viewport label. > Configure

The Viewport Configuration command displays the Viewport Configuration
dialog. You use controls on this dialog to set options for viewport control.

All the configuration options are saved with the MAX scene file. To configure
startup settings for your file, you can save a maxstart.max file. If this file exists,
3ds Max uses it to determine the viewport configuration and settings when
the software is loaded or reset.

Interface

Viewport configuration options are available in a series of tabbed panels on
the Viewport Configuration dialog:

Rendering Method on page 7818

Viewport Layout on page 7824

Safe Frames on page 7825
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Adaptive Degradation Options on page 7828

Regions on page 7832

Statistics on page 7834

Lighting and Shadows on page 7836

Lighting and Shadows on page 7836

SteeringWheels on page 7839

Rendering Method

Views menu > Viewport Configuration > Viewport Configuration dialog >
Rendering Method tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Rendering Method tab

You set the rendering method for either the current viewport or all viewports
on the Rendering Method panel of the Viewport Configuration dialog.

NOTE These controls operate on all objects depicted in the viewports; you can
also control display properties on a per-object basis.

Procedures

To set the viewport rendering method:

1 Choose Views menu > Configure > Viewport Configuration dialog >
Rendering Method tab.

2 In the Rendering Level group, choose the desired rendering level and any
options available for that level.

3 In the Apply To group, choose how to apply the rendering level to
viewports:

■ Active Viewport Only applies the rendering method to the active
viewport. This choice is the default.

■ All Viewports applies the rendering method to all configured
viewports.

■ All But Active applies the rendering method to all viewports except
the active one.
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TIP This option lets you work in full detail in the current view and easily
set other views to Wireframe or Bounding Box for quicker interactive
display.

To enter an FOV value in a Perspective viewport:

1 Right-click a Perspective viewport label and choose Configure. It isn’t
necessary to activate the viewport first.

This opens the Viewport Configuration dialog. If necessary, click the
Rendering Method tab.

2 In the Perspective User View group > Field Of View field, enter an angle.

Interface

When you open this dialog, the settings reflect the current viewport settings.

Rendering Level group

Determines how the software displays objects.

Smooth+Highlights Renders objects with smooth shading and displays
specular highlights. To toggle quickly between Smooth+Highlights and
Wireframe, press F3.

Smooth Renders objects with smooth shading only.
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Facets+Highlights Renders objects with flat shading and displays specular
highlights.

Facets Renders polygons as flat surfaces, shaded but with no smoothing or
highlights.

Flat Renders each polygon in its raw, unshaded diffuse color, disregarding
any contribution from ambient lighting or light sources. This rendering method
is useful when it's more important to see each polygon than to see its shading.
It's also a good way to check the results of bitmaps created with Render to
Texture on page 6371.

Hidden Line A wireframe mode that hides faces and vertices with normals
on page 8059 pointing away from the viewpoint, as well as any parts of objects
that are obscured by closer objects. In this display mode only, the wireframe
color is determined by the Viewports > Hidden Line Unselected color, not the
object or material color. See Colors Panel on page 7712.

Lit Wireframes Renders objects as wireframes with flat shading.

Wireframe Draws objects as wireframes with no shading applied. To toggle
quickly between Wireframe and Smooth+Highlights, press F3.

Bounding Box Draws objects as bounding boxes with no shading applied. A
bounding box on page 7932 is defined as the smallest box that completely
encloses an object.

Edged Faces Available only when the current viewport is in a shaded mode,
such as Smooth, Smooth+Highlights, Facets+Highlights, or Facets. When Edged
Faces is on in these modes, the wireframe edges of objects appear along with
the shaded surfaces. This is helpful for editing meshes in a shaded display.
Press F4 to toggle Edged Faces display.

Edges are displayed using the object wireframe color, while surfaces use material
colors (if a material is assigned). This lets you create contrasting colors between
the shaded surfaces and the wireframe edges. You can switch these around in
the Display Color rollout on page 177 in the Display panel.

Transparency group

None Objects with transparency assigned appear completely opaque, regardless
of the transparency settings.

Simple Objects with transparency assigned are displayed with a “screen door”
transparency effect.

Best Objects with transparency assigned are displayed with a two-pass
transparency effect.
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This option is smoother and closer to rendered transparency effects.

Apply To group

Applies the current settings to the active viewport only, to all viewports, or
to all the viewports except the active one.

NOTE This applies to the currently active viewport only; it is not a dynamic
function.

Rendering Options group

These check boxes modify either the shading modes or the wireframe modes.
They refer to the viewport renderer on page 8164 only, not to the scanline
renderer on page 8116 or any other renderer.

Disable View Disables the Apply To viewport selection. A disabled viewport
behaves like any other viewport while active. However, when you change the
scene in another viewport, the view in the disabled viewport does not change
until you next activate it. Use this function to speed up screen redraws when
you are working on complex geometry.

Disable Textures Select to turn off display of texture maps on page 8036 assigned
to objects. Turn off to show the maps assigned to objects.

Texture Correction Redraws the viewport using pixel interpolation
(perspective-corrected). The redrawn image remains until you force the
viewport to redraw for any reason. This command has an effect only when
the viewport is shaded and at least one object's map is displayed.

Z-Buffer Wireframe Objects Draws the wires ordered according to depth in
the scene. Otherwise wires may be drawn out of order to speed the viewport
display. This option is generally needed only when sub-object selections are
"hidden" by lines drawn out of order. For example, you select the front edges
of a box, but they don’t appear highlighted in red, because the white lines
from the rear may get drawn last. Activate this only if you find that selections
are obscured or if you need the viewport redrawn from back to front.

Force 2-Sided Set to render both sides of faces. See 2-Sided on page 7893. Turn
off to render only faces with normals on page 8059 toward the viewer. Usually,
you'll want to keep this option off to speed redraw time. You might want to
turn it on if you need to see the inside as well as the outside of objects, or if
you've imported complex geometry in which the face normals are not properly
unified.
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NOTE This switch has no effect when the Direct3D graphics driver on page 7790 is
active. In this case, to control the visibility of backfacing faces in the viewports,
use the Display Properties > Backface Cull on page 185 switch.

Default Lighting Turn on to use default lighting. Turn off to use the lights
created in the scene. If no lights exist in the scene, the default lighting is used
automatically, even when this check box is off. Default=on.

Sometimes the lighting you create in the scene makes the objects difficult to
see in the viewport. The default lighting displays the objects with even
illumination. You can use either one or two lights. By default, 3ds Max uses
one default light.

■ 1 Light Provides an over-the-shoulder light with 20% faster redraws at
the expense of less natural illumination.

A single default light is linked to the camera and moves when you change your
viewport point of view.

■ 2 Lights Provides more natural illumination, but slower viewport
performance.
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Two default lights are placed opposite to each other.

The key light, A, is in front of the object, on the upper-left side, while the fill light,
B, is behind on the lower-right side.

Shade Selected Faces When on, selected faces viewport display in a red
semitransparent state. This makes it easier to see selected faces in shaded
viewports. Keyboard shortcut=F2.

Use Selection Brackets Toggles the display of white selection brackets in the
viewport display. Turn this off in complex scenes when the display of multiple
selection brackets obscures the required view of selected objects.

Display Selected with Edged Faces Toggles the display of highlighted edges
for selected objects when the viewport is in a shaded mode, such as Smooth,
Smooth+Highlights, Facets+Highlights, or Facets. When on in these modes,
the wireframe edges of selected objects appear along with the shaded surfaces.
This is helpful when selecting multiple objects or small objects.

Viewport Clipping When on, interactively sets a near and far range for
viewport display. Two arrows at the edge of the viewport allow you to
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determine where the clipping occurs. Tick marks correspond to the extents
of the viewport, the lower tick is the near clipping plane, and the upper tick
sets the far clipping plane. This does not affect the rendering to output, only
the viewport display.

Fast View Nth Faces When on, speeds screen redraw by displaying fewer faces.
The Nth Faces spinner sets the number of faces that are displayed when the
Fast View mode is active. For example, a setting of 3 displays every third face.

Perspective User View group

Field Of View Sets the field of view angle for a Perspective viewport. This
spinner is not available when any other viewport type is active. You can change
the Camera field of view in the Modify panel.

Viewport Layout

Views menu > Viewport Configuration > Viewport Configuration dialog >
Layout tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Layout tab

You specify the division method of viewports, and assign specific types of
views to each viewport on the Layout panel of the Viewport Configuration
dialog.

The layout is saved with the MAX scene file, so you can store different layouts
in separate scene files. Load the file you want, then merge in the contents of
other files to maintain the layout.

TIP Through MAXScript, there are commands to set the current layout to any of
the 14 available setups. You can also activate any viewport and set the view type.
This enables you to create macros and custom user interface buttons to set any
layout you choose.
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Interface

The Layout panel is arranged in two general areas. At the top are icons
representing the possible division methods. Below these is a screen
representation of the currently selected layout. Click an icon to select the
division method, which appears in the larger screen representation.

To assign specific views, click the viewport in the screen representation. Choose
a viewport type from the menu that appears.

Safe Frames

Views menu > Viewport Configuration > Viewport Configuration dialog >
Safe Frames tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Safe Frames tab

Keyboard > Shift+F
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Safe frame borders show which portions of a viewport will be visible when rendered
to video.

You toggle the status of the video safe frame on page 8110 for the current
viewport and adjust its parameters on the Safe Frames panel of the Viewport
Configuration dialog.

Video Safe Frame displays a series of concentric rectangular frames in the
viewport. Use Safe Frame to see the proportions of your rendered output within
the viewport. This is particularly useful when you are rendering to output that
doesn’t match the viewport’s aspect ratio.

The primary purpose of Safe Frames is to suggest safe areas for work intended
for display on TV monitors. It is likely that the bezel will cover about 10% of
the image so you don’t want important objects or action to fall outside the
Action Safe area. High contrast titles falling outside the Title Safe area are likely
to bleed or be obstructed by the bezel of the TV screen.

When Safe Frames are displayed in the viewport and a bitmap image is assigned
as a viewport background on page 148 using either the Match Viewport or
Match Rendering Output options, the image is confined to the Live area of
the safe frames and matches the rendered background. This assumes that the
same bitmap is assigned to the Environment background using
Environment/Screen coordinates.
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You can toggle the status of safe frames on page 8110 on or off for the current
viewport, and use the Safe Frames panel of the Viewport Configuration dialog
to adjust the parameters.

When Safe Frame is displayed in the viewport and a bitmap image is assigned
as a background, and Show Background is on, the image is confined to the
Live area of the safe frame. If you are using a background image in your
rendering, make sure that your rendering output size matches the background
image size. This avoids distortion.

Interface

Setup group

The Safe Frames panel contains settings for the following frame types:

Live Area (yellow) The area that will actually be rendered, regardless of the
size or aspect ratio of the viewport.

Action Safe (green) The area in which it's safe to include your rendered action.
The Lock check box lets you lock the aspect ratio of the Action frame. When

Safe Frames | 7827



Lock is on, use the Both spinner to set the percentage of the live area that's
trimmed within the safe frame. When Lock is off, you can use the Horizontal
and Vertical spinners to set these parameters independently. Default=10%.

Title Safe (cyan) The area where it's safe to include titles or other information.
When used correctly, this is smaller than the Action frame. The Lock check
box lets you lock the aspect ratio of the Title frame. When Lock is on, use the
Both spinner to set the percentage size of the title frame relative to the action
area. When Lock is off, you can use the Horizontal and Vertical spinners to
set these parameters independently. Default=20% of Live Area.

User Safe Displays an additional safe frame that you can use for any custom
requirements. The Lock check box lets you lock the aspect ratio of the User
frame. When Lock is on, use the Both spinner to set the percentage size of the
user frame relative to the action area. When Lock off, you can use the
Horizontal and Vertical spinners to set these parameters independently.
Default=20% of Live Area.

12-Field Grid Displays a grid of cells (or fields) in the viewport. In this case,
"fields" are cells in the grid, and not scanline fields.

The "12-field grid" is a method used by video directors to refer to specific areas
of the screen. A director might ask you to move an object two fields to the
left and four fields down. The 12-field grid is a reference for this type of
placement.

4 x 3/12 x 9 Lets you choose between two matrices of either 12 or 108 cells.

Application group

Show Safe Frames in Active View Toggles the frame displays on or off for
the current viewport. This option is duplicated by the Show Safe Frame item
in the viewport right-click menu.

Ungrouped

Default Settings Resets all values to the default values.

Adaptive Degradation Options

 Status bar > Right-click the Adaptive Degradation button.
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Views menu > Viewport Configuration > Viewport Configuration dialog >
Adaptive Degradation tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Adaptive Degradation tab

You adjust the adaptive viewport redraw methods on the Adaptive Degradation
panel of the Viewport Configuration dialog. The adaptive degradation on page
7900 settings are saved with your MAX scene file.

To toggle adaptive degradation, click the Adaptive Degradation button on the
prompt line, or press O .

This is handy when you're adjusting lights and want to see their effect, real
time, in a shaded viewport. Or you might be adjusting the camera and need
to see complex geometry exactly as it is.

Example showing four degrees of adaptive degradation, depending on distance from
camera
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Interface

Adapt Object Display by Priority group

Turn on check boxes to indicate the rendering modes to step through during
necessary degradation. As the viewport redraw demands increase, the amount
of degradation increases through the active options from highest to lowest.
Objects with higher priority (based on the Prioritize Scene Objects settings)
will use the higher, more faithful display settings, while lower-priority objects,
typically smaller and/or farther from the point of view, will use the lower
display settings.

Maintain Frames Per Second Lets you set the frame rate on page 7987 in frames
per second that adaptive display will attempt to maintain. If the frame rate
drops below this, the software will increase the amount of degradation based
on the other settings on this panel.

Draw Backfaces during Degrade When on, forces the software to draw
polygons facing away from the point of view during degradation. Applies only
to wireframe views. When off, can improve performance by culling backfaces
during degradation.

Never Degrade Selected When on, selected objects are not subject to
degradation.

TIP You can use the Never Degrade object property on page 312 to specify that
3ds Max should not subject an object to degradation, regardless of its selection
status.
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Degrade to Default Lighting When on, improves performance by turning
off all viewport lights and enabling default lighting during degradation.

Never Redraw After Degrade When off, viewport display will restore as frame
rate improves, redrawing all degraded objects. If this takes too long, turn it
on. When on, objects will degrade but never redraw on mouse up, always
displaying at the most recent level of degradation.

NOTE  As viewport degradation occurs, the Adaptive Degradation button
on the status bar turns aqua, as shown here. Normally, when the degradation
stops, the color returns to gold, but when Never Redraw After Degrade is on, the
background remains aqua, even when active degradation is not happening. To
resolve this, either turn off Adaptive Degradation or turn off Never Redraw After
Degrade. Then, to redraw the screen, press ~.

Prioritize Scene Objects group

Distance from Camera/Screen Size Use this slider to specify whether the
software gives higher priority to objects based on their distance from the
camera or their screen size, regardless of distance from the camera. The two
criteria, represented by either end of the scale, are defined as follows:

■ Distance from Camera This sets the priority for each object based on its
distance from the camera or screen. The farther the object, the lower its
priority and the faster it will degrade. Higher values display closer objects
regardless of their size.

■ Screen Size The size of the bounding box in pixels. The smaller the object,
the lower its priority and the faster it will degrade. Higher values degrade
smaller objects regardless of their distance.

If you move the slider all the way to either end of the scale, the software sets
priorities based exclusively on that criterion. However, because it’s a sliding
scale, you can use both criteria on a weighted basis. For example, if you set
one end to 0.66, the other is set to 0.34, meaning that the software takes both
criteria into account in determining priorities, but gives the criterion set to
0.66 about twice as much weight as the other.

To return this parameter to its default setting (0.10/0.9), indicated by the tick
mark on the scale, right-click the slider.

Force objects displayed smaller than ... pixels to the lowest priority Objects
smaller than the specified size on the screen, in pixels, always use the lowest
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available priority setting (in the Adapt Object Display By Priority group) during
degradation.

Regions

Views menu > Viewport Configuration > Viewport Configuration dialog >
Regions tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Regions tab

On the Regions panel of the Viewport Configuration dialog, you specify default
selection rectangle sizes for the Blowup Region and the Sub Region, and the
parameters for setting up a virtual viewport.

The rectangular selection region appears when you render with either Blowup
or Region selected in the Render Type List on page 6095. You can change the
size of the region by dragging its handles.

The Virtual Viewport options let you zoom in on a sub-region of the current
viewport, creating a “virtual viewport” where you can perform any standard
navigation, but in a zoomed-in area. This function works only when you're
using an OpenGL driver. If you're using the software driver, these controls are
disabled.

You can use the virtual viewport on any type of viewport, but it's primarily
designed for zooming in on camera views. This lets you perform close-up
work, such as tracing, without distorting the relationship between the geometry
and a bitmap background. (See Lock Zoom/Pan in Viewport Background on
page 148 for similar functionality in orthographic views.)

Because you're actually zooming the viewport image itself, the viewport label
might be hidden from display, but you can still right-click in the upper-left
area of the viewport to display the menu. This takes advantage of zooming
features in the Open GL driver so that the software does not compute the
display change internally.

Procedures

To use the virtual viewport:

1 Make sure you're using an OpenGL driver on page 7790 for your display.

2 Activate the viewport to convert to a virtual viewport (typically a camera
viewport that is displaying a bitmap background).
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3 Choose Views menu > Viewport Configuration and click the Regions tab.

4 Click Use Virtual Viewport. A reduced image of the viewport displays in
the dialog, along with a white zoom rectangle representing the virtual
viewport.

5 Use the Zoom, X Offset, and Y Offset spinners to adjust the size and
position of the virtual window, or drag the white window anywhere
within the image.

6 Click OK.

The viewport is converted to a virtual viewport and displays the area of
viewport represented by the white rectangle. All viewport navigation
methods work the same, except that you're seeing only the zoomed
portion of the viewport.

7 To close the virtual viewport, go to Viewport Configuration > Region Tab
and turn off virtual viewport. You can get to the Viewport configuration
menu by right-clicking any of the viewport navigation tools or by going
to Views menu > Viewport Configuration.
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Interface

The Regions panel contains spinners for setting the four corners of the region
(in pixels), and the following options.

Virtual Viewport

Use Virtual Viewport Enables the virtual viewport. A reduced image of the
viewport appears in the dialog, along with a white zoom rectangle representing
the virtual viewport.

Zoom, X Offset, and Y Offset Adjusts the size and position of the virtual
window. You can also drag the white window anywhere within the image.

Statistics

Views menu > Viewport Configuration > Viewport Configuration dialog >
Statistics tab
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Right-click a viewport label. > Configure > Viewport Configuration dialog >
Statistics tab

Use these controls to display statistics in the viewports concerning the number
of vertices, polygons, etc., in the scene and/or the active selection, as well as
a real-time count of the number of frames per second displayed. To toggle
display of the statistics in a viewport on the fly, right-click the viewport label
(for example, Perspective) and choose Show Statistics.

Interface

Setup group

Polygon Count Enables the polygon count display.

Triangle Count Enables the triangle count display.

Edge Count Enables the edge count display.

Vertex Count Enables the vertex count display.

Frames Per Second Enables the FPS count display.

Total Displays only the statistics for the entire scene.

Selection Displays only the statistics for the current selection.
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Total + Selection Displays the statistics for the entire scene and current
selection.

Application group

Show Statistics In Active View Enables the statistics display.

Default Settings Returns all options to the original settings.

Lighting and Shadows

Views menu > Viewport Configuration > Viewport Configuration dialog >
Lighting And Shadows tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
Lighting and Shadows tab

The Lighting And Shadows tab sets preferences for lighting and shadow display
in shaded viewports. See Previewing Shadows in Viewports on page 4991.

Interface

Viewport Shading Chooses the level of viewport shading. These options are
equivalent to the same options on the Display quadrant of the quad menu
for supported lights (Viewport Lighting And Shadows > Viewport Shading >
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Off, Good, or Best): changing the setting here changes the active setting on
the quad menu, and vice versa.

■ Off (Legacy, no shadows, 8 light limit) Lights viewports as in versions
of 3ds Max prior to v10. No shadows appear.

■ Good (SM2.0 Option) Displays shadows at the SM2.0 level.

■ Best (SM 3.0 Option) Displays shadows at the SM3.0 level, with opacity
mapping.

Auto Display Selected Lights When on, light from selected lights is
automatically displayed in shaded viewports. Default=off.

Cast Shadows for Default light When on, default lights display shadows
(that is, when no other light object is present in the scene). Default=on.

Override Shadow Intensity Use this to lighten (greater than 1.0) or darken
(less than 1.0) shadows in viewports. This is simply an aid to previewing
shadows: it does not affect ambient light, or any light and shadow settings
that are used when you render. Default=1.0.

ViewCube

Views menu > ViewCube > Configure

Right-click the ViewCube. > Configure

Views menu > Viewport Configuration > Viewport Configuration dialog >
ViewCube tab

Right-click a viewport label. > Configure > Viewport Configuration dialog >
ViewCube tab

These controls affect interaction with the ViewCube feature on page 107. Any
changes in settings persist between sessions.
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Interface

Display Options group

Show the ViewCube Lets you choose whether to display the ViewCube in all
visible viewports, or only in the active viewport.

■ In All Views

■ Only in Active View

ViewCube Size Choose a size from the drop-down list. The choices are Tiny,
Small, Normal (the default), and Large. At Tiny, the cube does not contain
labels.

Inactive Opacity Sets the opacity of the ViewCube when not in use. Choose
an opacity value from the drop-down list. The choices are 0%, 25%, 50%,
75%, and 100%. At 0%, the ViewCube is visible only when the mouse cursor
is over its location. At 100%, the ViewCube is solid at all times. At lower
opacities, the ViewCube obscures the viewport contents to a lesser extent.
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When Dragging on the ViewCube group

Snap to closest view When on and you drag the ViewCube to rotate the view,
the viewpoint will snap to one of the fixed views when its angle is close to
that of one of the fixed views.

When Clicking on the ViewCube group

These settings apply specifically to clicking the ViewCube, not dragging it.

Fit-to-View on View Change When on, clicking the cube (face, corner, or
edge) automatically zooms the view to fit the current selection. When off, no
zooming is performed when clicking the cube.

Use Animated Transitions when Switching Views When on, and you change
the view by clicking the cube, the new view rotates into place. When off, the
new orientation snaps into view instantly. The latter mode is faster and is
recommended for experienced users, but new users should keep this switch
on to stay better oriented within the scene.

Keep Scene Upright Prevents the scene from appearing to flip over partially
or fully. For example, with this off, going to the Top view and then clicking
the upper edge of the ViewCube causes the scene to appear to rotate 45 degrees
upside-down. But with Keep Scene Upright on, doing so simply rotates to an
angled-down view.

Compass group

Show the Compass below the ViewCube When on, displays a compass below
the ViewCube for determining the view orientation in a geographic context.

Angle of North (degrees) Lets you specify the compass orientation. For
example, to rotate the compass a quarter-turn clockwise, set Angle of North
to 90.0.

 SteeringWheels

Views menu > SteeringWheels > Configure

Click the Wheel menu button at the lower-right corner of the SteeringWheels.
> Configure

Views menu > Viewport Configuration > Viewport Configuration dialog >
SteeringWheels tab
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Right-click a viewport label. > Configure > Viewport Configuration dialog >
SteeringWheels tab

These controls affect interaction with the SteeringWheels feature on page 114.
Any changes in settings persist between sessions.

Interface

Display Options group

Big Wheels Use the sliders to specify the size and opacity of the standard-size
wheels. The changes take place when you click OK.

■ Size Sets the size of the Full Navigation Wheel, View Object Wheel, and
Tour Building Wheel.

■ Opacity Sets the opacity of the Full Navigation Wheel, View Object
Wheel, and Tour Building Wheel.

Mini Wheels Use the sliders to specify the size and opacity of the small wheels.
The changes take place when you click OK.

■ Size Sets the size of the Mini Navigation Wheel, Mini View Object Wheel,
and Mini Tour Building Wheel.
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■ Opacity Sets the opacity of the Mini Navigation Wheel, Mini View Object
Wheel, and Mini Tour Building Wheel.

Show Tool Messages Toggles the display of tool messages such as “Press the
arrow keys to move” for the Look tool.

NOTE Not all tools have tool messages.

Show Tool Tips Toggles the display of the tool tips that display when you
hover the mouse cursor over a control.

Always Show the Pinned Wheel on Start When on, and you first start the
program, the SteeringWheels automatically appear at the mouse cursor
position. When off, the SteeringWheels must be activated manually.

Look Tool group

Invert Vertical Axis Affects how vertical mouse dragging controls view
movement with the Look tool. When on, dragging upward moves the
viewpoint upward, and dragging downward moves the viewpoint downward.
When off, dragging upward moves the viewpoint downward, and dragging
downward moves the viewpoint upward. Default=off.

Walk Tool group

Constrain Walk Movement Angle to Ground Plane When on, constrains
Walk motion (Forward, Backward, Left, Right, Up, and Down) relative to the
world XY plane regardless of the current Look Direction. When off, Walk
motion occurs perpendicular to the view plane. Default=on.

Speed Factor Sets the relative rate of Walk motion. Range=0.1 to 10.0.
Default=10.0.

Zoom Tool group

Incremental Zoom-in When on, and you’re using the Zoom tool on page
133 on the Full Navigation wheel on page 121, you can zoom in by a factor of
25 percent by clicking. When off, you must drag to zoom using the Zoom tool
on the Full Navigation wheel.

Orbit Tool group

Keep the Scene Upright Prevents the scene from rotating so that it appears
to be upside down when using the Orbit tool on page 127.
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Selection Sensitivity When on, using the Orbit tool on page 127 rotates the
view around the current selection, rather than a predefined center.

Strokes
Customize menu > Preferences > Preference Settings dialog > Viewports tab >
Mouse Control group > Stroke

Strokes are a way to assign command shortcuts to mouse or tablet drag patterns.
For many operations, strokes are more convenient than keyboard shortcuts
because they can select an object and apply a command to it.

For example, you can assign Orbit to a downward stroke. When you draw this
stroke, the software changes to Orbit mode. You can assign a circular stroke
to the Hide Selected command so that it both selects the objects and then
hides all the objects in the bounding extents of the stroke pattern.

You can use strokes in two ways:

■ If you have a middle mouse button, you can define and use strokes by
specifying the Stroke option for the middle mouse button in the Viewports
tab on page 7753 of the Customize menu > Preferences dialog.

■ To define and use strokes with the left mouse button, use the Strokes utility
on page 7854 and turn on Draw Strokes.

Using the Keyboard with Strokes

The same stroke pattern can perform four different functions by holding Shift,
Alt, or Shift+Alt when drawing the stroke:

■ Drawing a vertical line is one type of stroke.

■ Holding Shift while drawing the same line is another type.

■ Holding Alt while drawing it is a third type.

■ Holding both Shift and Alt while drawing the line is a fourth type.
Holding Ctrl while drawing a stroke indicates that you want to define a
new stroke, rather than use an existing stroke.

NOTE Changes you make to the set of strokes are saved with 3ds Max and
persist from session to session.
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See also:

■ Defining Strokes on page 7845

■ Reviewing and Editing Strokes on page 7849

■ Stroke Preferences Dialog on page 7851

■ Strokes Utility on page 7854

Procedures

To define and use strokes with the middle mouse button:

1 Choose Customize menu > Preferences > Preference Settings dialog >
Viewports tab.

2 In the Mouse Control group, turn on Stroke.

You must turn on this option for all Stroke functions to work with the
middle mouse button.

3 Hold the middle mouse button and drag in a viewport to make a stroke.
If the stroke hasn't been defined, a dialog appears where you can click
Define to define the stroke. If the stroke has already been defined, the
corresponding function is executed.

See Defining Strokes on page 7845 for information on defining and editing
strokes.

To define and use strokes with the left mouse button:

1 Choose Utilities panel > Utilities rollout > More button > Utilities dialog
> Strokes.

2 Turn on Draw Strokes.

3 Hold the left mouse button and drag in a viewport to make a stroke. If
the stroke hasn't been defined, a dialog appears where you can click
Define to define the stroke. If the stroke has already been defined, the
corresponding function is executed.

See Defining Strokes on page 7845 for information on defining and editing
strokes.

Example: To assign Object Properties to a stroke:

1 Use one of the first two procedures to activate strokes.
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2 Hold down Ctrl, and drag from top to bottom and then back up to the
starting point.

3 The Define Stroke dialog appears, and the name of the stroke is "HKKH."

NOTE Depending on how you drew your stroke sequence, it might be defined
by different letters. This is fine, as long as you use the same sequence to enact
the stroke after you have finished defining it.

If an alert appears, you've either drawn the stroke incorrectly, or this
stroke has already been assigned. Continue with the following steps to
replace the defined stroke.

4 Choose the Properties command from the Command To Execute list.

5 The option enabled is Single Object At Start Of Stroke, because that's the
logical choice for the Object Properties command.

6 Click OK.

7 Drag vertically down and back up over any object in the scene to display
the Object Properties dialog for that object.

Example: To assign Hide Selection to a stroke:

1 Use one of the first two procedures to activate strokes.

2 Hold down Ctrl, and drag vertically from top to bottom.

3 In the alert that appears, click Yes to redefine the stroke and display the
Define Stroke dialog.

The name of this stroke is HK.

NOTE Depending on how you drew your stroke sequence, it might be defined
by different letters. This is fine, as long as you use the same sequence to enact
the stroke after you have finished defining it.

4 Choose Hide Selection from the list.

5 Choose All Objects in the Selection Set.

6 Click OK.

7 Load a scene containing several objects, and select two or more objects.

8 Drag vertically from top to bottom in the viewport.

The selected objects are all hidden.
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Defining Strokes

Hold down Ctrl and the middle mouse button and drag in a viewport to create
the shape of an unused stroke. > Define Strokes dialog

Hold down the middle mouse button alone or with Shift, Alt, or both, and
drag in a viewport to create the shape of an unused stroke. > Define > Define
Strokes dialog

Utilities panel > Utilities rollout > More button > Utilities dialog > Strokes >
Draw Strokes > Hold down the left mouse button alone or with Shift, Alt, or
both, and drag in a viewport to create the shape of an unused stroke. > Define
> Define Strokes dialog

You define a stroke by creating the stroke in a viewport, then choosing the
command that the stroke defines. The next time you perform the stroke, the
command will be executed. You can define strokes to work in conjunction
with the Shift key, the Alt key, or both Shift and Alt.

You can define strokes with either the left or middle mouse button. If you
want to use your middle mouse button to define and use strokes, you must
first turn on Customize menu > Preferences > Preference Settings dialog >
Viewports tab on page 7753 > Mouse Control group > Stroke. To define and use
strokes with the left mouse button, choose Utilities panel > Utilities rollout >
More button > Utilities dialog > Strokes on page 7854 > Draw Strokes, then draw
the strokes.

In the Define Stroke dialog, you can see how the strokes are analyzed by
examining the grid under Stroke to Define. When you complete the drawing
of a stroke, a nine-square grid is centered around the stroke and fit to its
extents. The inner segments of the grid are assigned unique letters. Where the
stroke crosses a segment, the letter associated with that segment is added to
the stroke name. Thus, the direction and the shape of the stroke matter, but
the size of the stroke has no effect.

The stroke is always centered within the grid. If you draw a stroke vertically
from top to bottom, the stroke is named HK because it crossed the segments
labeled H and K, in that order. Had you drawn the stroke from bottom to top,
it would have been named KH.
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TIP You can define more than one stroke for the same command. For example,
you might assign a U-shape stroke to Undo, but find that you sometimes draw a
J shape when attempting the U. By assigning both the U and the J strokes to Undo,
you don't have to worry about missing that stroke.

The Command Should Operate On group of options is important. If the
command applies to selections, leave this option set to Single Object at Start
of Stroke, or change it to All Objects in the Selection Set. However, if the
command doesn't apply to selections, such as Orbit or Activate Grid Object,
change it to No Objects Just Execute the Command.

See also:

■ Reviewing and Editing Strokes on page 7849

■ Stroke Preferences Dialog on page 7851

■ Viewport Preferences on page 7753

■ Strokes Utility on page 7854

Procedures

To define a stroke using the Ctrl key:

1 Hold down the Ctrl key while drawing a stroke.

2 If the stroke already exists, a message asks you if you want to replace the
old stroke. Click Yes.

3 on the Define Stroke dialog that appears, assign the stroke.

To define a stroke by example:

1 Draw a stroke that doesn't exist.

2 A Stroke Not Found message appears. Click Define.

3 In the Define Stroke dialog that appears, assign the stroke.
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Interface

Stroke to Define group

Displays the name of the stroke and displays the stroke you just drew as a
series of white Xs connected by white lines. A green X represents the start of
the stroke and a red X represents the end. The labeled grid shows you how it
recognizes the stroke. Where the stroke crosses the labeled segments in the
grid, a letter is added to the name of the stroke.

Command to Execute group

Lists all commands to which you can assign a stroke. Select a command and
click OK to assign the stroke displayed in the grid to the selected command.
Depending on the type of command you choose in this list, various options
become available in the Command Should Operate On group.
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Currently assigned to stroke Displays the name of the stroke currently
assigned to the selected command. If you pressed Shift or Alt when the stroke
was drawn, they're added to the name. For example: "Shift + HK" or "Alt +
HK."

Command Should Operate On group

Provides a number of options that specify which objects (if any) are affected
by the command. These options are enabled or disabled depending on the
type of command you've selected in the list window.

No Objects Just Execute the Command This text is displayed when you
choose a command that's not specific to selected objects, such as Orbit. When
you select a command that can be applied to selected objects, the following
options become enabled:

Single Object at Start of Stroke Causes the command to act on the object
beneath the first stroke point in the active viewport.

All Objects in the Selection Set Causes the command to act on all objects in
the current selection set.

Multiple Objects Based On The Stroke Boundary group

Choosing one of the options in this group lets you use the stroke itself to
select multiple objects and then apply the command.

All Objects in Rectangle Extents Selects all objects defined by the rectangular
bounding of the stroke.

All Objects in Circular Extents Selects all objects defined by the largest circle
that fits within the rectangular bounding of the stroke.

Window/Crossing When you choose either of the previous two options,
these two options become available. Window selects only those objects entirely
within the rectangular or circular region. Crossing selects all objects within
or crossing the region.

Current Stroke Set group Displays the name of the current stroke set, so you
can review the strokes defined in that set. You can create and save a number
of different stroke sets. See Stroke Preferences on page 7851.

Review Click to display the Review Strokes dialog on page 7849, in which you
can choose from a list of defined strokes and then see the stroke itself. You
cannot edit strokes this way. To view, change, and delete strokes, draw the
Review Strokes stroke (by default, a horizontal line from left to right).
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Reviewing and Editing Strokes

Define Strokes dialog > Click Review.

Draw the Review Strokes stroke. By default, this is a horizontal line from left
to right.

You can view defined strokes in the Review Strokes dialog. Depending on how
you display this dialog, you can also change or delete defined strokes:

■ Click the Review button in the Define Strokes dialog on page 7845 to view
strokes, but not change or delete them.

■ Draw the Review Strokes stroke (by default, a horizontal line from left to
right) to view, change, and delete strokes. You can redefine the Review
Strokes stroke in the Review Strokes dialog.

Procedures

To change the command assigned to a stroke (or vice versa):

1 Select a command (or stroke) from the list.

2 Click Change. The Define Strokes dialog appears.

3 Select the new stroke to assign.

4 Click OK in the Define Strokes dialog to assign the selected stroke to the
command currently highlighted in the Review Strokes dialog.
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Interface

Defined Strokes

Displays a list of commands that currently have strokes assigned to them and
the name of the current stroke set.

Make Camera Active Point at a single camera (not the target), draw the stroke,
and that camera becomes active in the viewport in which you draw the stroke.

Change Light Color You can stroke this command over one or more lights.
The color selector appears, so you can change the color of the selected lights.

Light On/Off Toggle Stroke over a light to toggle it on and off. If you stroke
over two or more lights, all the lights are set to a common state, either all on
or all off.

Set Constraints Displays a small dialog with the available axis constraints.
Double-click to change the axis constraints for the current transform mode.

Move Mode (Set Constraints) Switches to Move transform mode and displays
a small dialog with the available axis constraints. Double-click to change the
axis constraints for the current transform mode.
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Rotate Mode (Set Constraints) Switches to Select and Rotate mode and
displays a small dialog with the available axis constraints. Double-click to
change the axis constraints for the current transform mode.

Scale Mode (Set Constraints) Switches to Select and Scale mode and displays
a small dialog with the available axis constraints. Double-click to change the
axis constraints for the current transform mode.

Review Strokes Displays the Review Strokes dialog.

Stroke Preferences Displays the Stroke Preferences dialog on page 7851.

Show As

Provides two options that specify how commands are displayed in the list.

Command Name Displays the assigned strokes by command name (for
example, Play Animation).

Stroke Name Displays the assigned strokes by their stroke name (for example,
HK).

Change Assigns a different stroke to the command, or vice versa, depending
on whether commands or strokes are displayed in the list.

NOTE This command is only available when the dialog is accessed by drawing
the Review Strokes stroke.

Delete Removes the selected command (or stroke) from the list, and the
command is no longer assigned to the stroke.

NOTE This command is only available when the dialog is accessed by drawing
the Review Strokes stroke.

Information on Selected Stroke

Displays the name and shape of the stroke selected in the list window.

Stroke Preferences Dialog

Draw the Stroke Preferences stroke. By default, this is an inverse L, drawn
vertically from bottom to top, and then horizontally from left to right.

Set up a stroke to access the Stroke Preferences dialog > Use the stroke
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With the Stroke Preferences dialog you can save sets of strokes and set other
stroke properties.

NOTE This dialog is available only by drawing its stroke (by default, an inverse L,
drawn vertically from bottom to top, and then horizontally from left to right). You
can redefine the Stroke Preferences stroke in the Review Strokes dialog on page
7849.

NOTE By default, the Strokes Preferences dialog is available only if you assign a
stroke to it, then use the stroke to access the dialog. See the following procedure.

Procedures

To access the Strokes Preferences dialog:

1 Set up strokes for your left or middle mouse button. See Strokes on page
7842 for information how to do this.

2 To define the stroke, hold down Ctrl and drag an inverted L shape (drag
vertically from bottom to top, and continue from left to right).

The name of this stroke is JGAB.

3 On the Define Strokes dialog, choose Stroke Preferences from the list.

4 Click OK to close the dialog.

5 Drag an inverted L shape to access the Strokes Preferences dialog.
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Interface

Current Stroke Set group

Displays the name and number of strokes in the current set.

■ To create a new set, enter a new name in the field and click Save.

■ To choose a different set, choose it from the list and click OK.

Save Saves the set displayed in the list.

Delete Deletes the set displayed in the list.
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Review Strokes Default Show As Order group

Specifies whether commands or strokes are initially listed in the Review Strokes
dialog.

Show Grid Time (ms)

The time it takes, in milliseconds, for the stroke analysis grid to appear in the
viewports when you complete a stroke. Set it to 0 to hide the grid. Default=300
(about 1/3 of a second); Range=0 to 2000.

Show Extents Time (ms)

The time it takes, in milliseconds, for the extents of the stroke to appear in
the viewports. Range=0 to 2000. Set it to 0 to disable this feature. Default=300
(about 1/3 of a second).

Strokes that operate on the First Point display a small X. Strokes that operate
on items in the bounding box of the stroke display the bounding box. Strokes
that operate on the circular extents display a circle that fits inside the square
bounding box of the stroke. Window selections appear solid. Crossing
selections appear dotted.

Stroke Point Size

The size, in pixels, of Xs drawn in the viewports that allow you to visualize
the stroke shape. Default=4; Range=3 to 20.

Strokes Utility

Utilities panel > Utilities rollout > More button > Utilities dialog > Strokes

The Strokes utility lets you launch commands by dragging left-button mouse
patterns in a viewport. When you launch the Strokes utility, a modeless dialog
appears containing a single Draw Strokes button. When the Draw Strokes
button is active, you can define and use strokes with the left mouse button.
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The Strokes system is also available as an option for the middle mouse button
that doesn't require the utility or the modeless dialog. This option can be
found on the Viewports tab on page 7753 of the Preferences dialog. For details,
see Strokes on page 7842.

Procedures

Example: To define a stroke pattern for Orbit:

1 On the Utilities panel, click the More button, and choose Strokes from
the list.

2 On the modeless dialog, click Draw Strokes.

3 Hold down the left mouse button and drag the mouse straight down
from top to bottom, then release the mouse button. The length of the
stroke doesn't matter, but the direction does.

A dialog appears asking you to define the pattern or continue.

4 Click Define to display the Define Stroke dialog.

5 Choose Orbit from the Command To Execute list and then click OK.

The pattern is now defined for Orbit.

Example: To turn on Orbit using the Strokes utility:

1 Turn on Draw Strokes in the modeless dialog.

2 In any viewport, hold down the left mouse button and drag the mouse
straight down from top to bottom. The length of the stroke doesn't matter,
but the direction does.

As you drag the mouse, small X's appear, displaying your stroke. When
you release the mouse, a 3x3 grid appears briefly, and then the program
switches to Orbit mode.

If a Stroke Not Found message appears, click Continue, and then repeat
step 2.
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Keyboard Shortcuts

Keyboard shortcuts are keyboard alternatives you can use to initiate actions (commands or
tools) normally accessed with the mouse. For example, to open the Select From Scene dialog,
you can press the H key, or you can change the active viewport to a view from the bottom
by pressing B. Keyboard shortcuts let you work faster and more efficiently.

Many keyboard shortcuts are already set for most commonly used actions. Throughout this
reference, command descriptions include the default shortcut, if there is one: look for the
path annotation (with a gray background) at the top of the page.

To modify or add new shortcuts, use the Keyboard panel on page 7698 of the Customize User
Interface dialog on page 7697. Keyboard shortcuts are separated by Groups or Categories of groups
and they organize Actions.

Groups organize the Actions for which you can set shortcuts. Default=Main UI.

Categories offer a further breakdown of the Actions in a Group to specific categories. This
lets you quickly find an Action so you can assign or adjust a shortcut.

Actions are commands or tools.

In most cases you can close a dialog with the same command used to open it. In general this
applies to any combination of input methods, including menu, toolbar button, and keyboard
shortcuts. For more information, see Toggling Dialogs on page 7467.

Viewing the Assigned Shortcuts

To see the currently assigned keyboard shortcuts, you can create a text (TXT) file of all the
actions and their shortcuts. Go to the Keyboard panel on page 7698 of the Customize User
Interface dialog on page 7697, and then click Write Keyboard Chart. All actions that can have
a shortcut assigned to them are listed. For actions with no default shortcut assigned, the
Shortcut column entry is blank.

If you click Reset on the Keyboard panel before you click Write Keyboard Chart, the text files
shows the default keyboard shortcut assignments. However, this loses any custom shortcuts
you might have created before.
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See also:

■ Biped Shortcuts on page 4471

■ Crowd Shortcuts on page 4811

■ Physique Shortcuts on page 4679

■ Track View Shortcuts on page 3524

■ Unwrap UVW Shortcuts on page 1878

Keyboard Shortcut Override Toggle 
Main toolbar > Keyboard Shortcut Override Toggle

The Keyboard Shortcut Override Toggle lets you toggle between using only
the "Main User Interface" shortcut keys and using both the main shortcuts
and shortcut keys for groups such as Edit/Editable Mesh, Track View, NURBS,
and so on.

When the Override toggle is off, only the Main User Interface shortcuts are
recognized. When Override is on, both Main UI and functional area shortcuts
are recognized; however, if there is a conflict between a shortcut assigned to
a feature and one assigned to the Main UI, when Override is on, the feature's
shortcut takes precedence.

You can customize keyboard shortcuts on the Keyboard panel on page 7698 of
the Customize User Interface dialog on page 7697. The lists in the keyboard
panel show which shortcuts have been assigned to which command or feature.

See also:

■ Keyboard Shortcuts on page 7857
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Troubleshooting 3ds Max

This section describes a collection of problematic situations and what you can do to diagnose
and fix them. These include many common problems that are reported to Autodesk Product
Support, and the things you can try in order to resolve the problems yourself.

When starting to diagnose a problem, by yourself or with the intent of contacting Product
Support, you should take stock of the situation by answering the following questions.

■ What's changed since the last time I ran 3ds Max?

■ Has the 3ds Max display configuration been changed?

■ Was an updated video driver or new operating system service pack installed recently?

■ Has 3ds Max been running successfully without lockups or crashes?

Handling File Corruptions
Few things are more aggravating when attempting to open a scene then
encountering an Assertion Failed error, File Open Failed error, or perhaps no
error at all. The file just does not load. This typically occurs when the file is
corrupt. A number of factors can cause file corruption, including the following:

■ Some component built in another program has been imported or referenced
with an XRef.

■ The scene failed to save properly due to a power failure or system crash.

■ A poorly coded plug-in corrupted an object in the scene.
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Problems and Resolutions

Assertion Failed Errors

The assertion failed error occurs commonly when you try to load a corrupt
file. The error gives you a line number and file name where the corruption
occurred. You are then left with the options to retry or cancel.

Unfortunately, the line number and file often don't help because that isn't
necessarily where the error is actually occurring. Most people click the Retry
option a couple of times then give up, fearing they've lost many hours of
work. Don't panic yet. There are a number of things you can try before you
have to start rebuilding.

The first thing to try is keep clicking the Retry button. If there is a corruption
to the vertices of an object, you might have to parse through each vertex until
you bypass the object completely. For example, Autodesk Product Support
once received a file that returned an Assertion Failed error referencing a tab.h
file. The scene recently had an AutoCAD component imported that 3ds Max
couldn't understand. However, after the support technician clicked the Retry
button 88 times, the scene finally opened. After resaving the scene, it opened
without incident.

Merging Corrupt Files

If normal attempts to open a scene fail, another thing you can try is merging
the scene. If the file is not too corrupted, you would be able to access the
Merge dialog which shows a list of the components in the scene. This is a
good sign because, with a little effort, you can fix the file yourself. You now
need to narrow down which object, or objects, are causing the load failure.

1 Start 3ds Max.

2 Choose File menu > Merge.

3 Browse to the folder containing the model, select the model and click
the Open button.

The Merge dialog is displayed, showing all the components in the scene.
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You'll start by seeing if any of the objects or shapes in the scene are
corrupt.

4 In the List Types group, on the right, turn off everything except Geometry,
Shapes, and Groups/Assemblies.

5 Click the All button at the lower left, and then click OK.

If the objects appear in the viewports, you know the scene components
are fine and you'll have to repeat these steps with other List Types turned
on.

If the objects merge successfully, and you have to try merging in other objects,
be sure to first save what you've just merged as a basis for rebuilding the scene.
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If you receive an error message, you know one of the objects is the offending
item. Then, do as follows.

1 Reset 3ds Max.

You now have to narrow down exactly which object in the previous list
is corrupt.

2 Once again, choose File > Merge and turn off everything except Geometry,
Shapes, and Groups/Assemblies.

3 Select the first 10 objects in the list of components and click OK.

If those objects merge successfully, save the scene and repeat the Merge
operation with the next set of 10 objects. Eventually, one of the sets of
objects you try to merge will report the error message.

4 Keep refining the number of objects you are merging until you have
singled out the object that reports the error.

5 Once you've found the corrupt object, reset 3ds Max and merge all the
objects and components except for the object you've singled out.

6 After everything is merged, save the scene and rebuild the object that
was corrupt.

Granted, this can be a long process, but it's well worth it if you can salvage
most of your previous work.

Remember Backup Files

By default, the 3ds Max automatic backup on page 7752 feature is active, and
writes a backup file every five minutes while you're editing the scene for a
total of three files. The files are stored in the \autoback folder. By default, this
folder is stored in  \My Documents\3dsmax\. Using backup files is especially
helpful if your file became corrupt due to a system crash or power outage.

1 Start 3ds Max and verify that you cannot load the scene.

2 Open Windows Explorer and browse to the \autoback folder.

3 Start by highlighting AutoBackup01.max and then copy the file (Edit >
Copy or Ctrl+C).

4 Browse to the \scenes folder, found in  \My Documents\3dsmax\ or in the
program install folder, and paste the file.

If you want, you can rename it.

7862 | Chapter 28   Troubleshooting 3ds Max



5 In 3ds Max, choose File > Open and try loading the file you just copied
from the \autoback folder.

If it opens, save the scene and rebuild what you lost in the last five
minutes.

If you'd like to adjust the Auto Backup settings, you'll find them on the Files
panel on page 7750 of the Preference Settings dialog, available via the Preferences
command on the Customize menu.

Fixing Boolean Problems
Boolean operations are a powerful addition to your modeling toolbox; however,
they can sometimes give strange or unexpected results. The Boolean button
is found on the Create panel in the Compound Objects list; it allows you to
join, subtract, intersect, and cut objects. Following is a list of problem scenarios
and steps you can follow to fix them.

TIP The ProBoolean compound object on page 844 represents a significant
improvement over the legacy Boolean compound object in a number of ways. In
most cases, it's highly recommended that you use ProBoolean rather than Boolean.

TIP Before performing a Boolean operation, you should save your scene or use
Edit > Hold. That way, you can quickly recover should anything not appear as
expected.

Problems and Resolutions

Boolean Objects Disappear

If you mistakenly perform an Intersection Boolean operation on two objects
that look like they intersect, but actually don't, you can end up in a situation
where the object completely disappears. In the Operands group, you see both
your objects listed but nothing on-screen.

1 Click the Undo button to retract the Operand B selection.

2 Right-click to exit the Boolean operation.

3 Verify that the objects intersect by checking them in two viewports, like
the Top and Left.

4 Click Boolean to turn on the operation, and click Pick Operand B.
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5 Click the intersecting object.

Creases or Ridges Show in Boolean Objects

Creases or ridges might be caused by a Boolean operation between an object
that has very few faces and an object that has considerably more faces, for
example, when you subtract a complex freeform object from a simple box.

3ds Max tessellates the surface of the box so there are additional faces for the
subtraction. Unfortunately, the faces are usually generated as long, slivered
faces that sometimes overlap and form creases or ridges in the resulting scene,
when rendered.

Before attempting the Boolean operation, try these steps.

1 Select the object that has the lower face count.

In this example, it would be the box.

2 Change the Length, Width or Height Segments of the surfaces where the
subtraction will occur.

3 From the Compound Objects buttons, click Boolean.

4 Perform the subtraction as you originally wanted.

By subdividing the surface with more faces, the Boolean operation has more
faces and edges to work with. This results in fewer long, sliver-like faces that
can produce creases or ridges.

Consecutive Booleans Results in Disappearing Components

Booleans are programmed to work with two operands, Operand A and Operand
B. If you plan to join or subtract many objects from the object that you've
selected as Operand A, you must click the Boolean button after each Operand
B selection. If you don't, and simply click the Pick Operand B button and pick
the next object, the previous operation is negated and the previous Operand
B disappears.

The most efficient means to use when joining or subtracting a large number
of objects to or from a single object is to attach all the objects before attempting
the Boolean operation.

As an example, let's say you're building a metal plate that has a circle of bolt
holes. So far, you have a flat box, Operand A, and ten cylinders, Operand B,
passing through it.
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The future metal plate with circle of bolts

1 Select one of the cylinders.

2 Right-click and convert it to an Editable Poly.

This automatically opens the Modify panel.

3  From the Edit Geometry rollout, click Attach List.
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This is the little button next to Attach.

4 From the Attach List dialog, select all the other Cylinders and click the
Attach button.

All the cylinders are a single object.

5 Select the Box and make sure it has Length, Width, or Height Segs values
that are greater than 1.

See Creases or ridges show in Boolean objects on page 7864.

6 Open the Create panel and from the drop-down menu that shows
Standard Primitives, choose Compound Objects.

7 Click the Boolean button and in the Parameters rollout > Operations
group, make sure Subtraction (A-B) is turned on.

8 On the Pick Boolean rollout, click Pick Operand B, and select the
Cylinders.
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The cylinders are subtracted to form holes in the box.

You only have to perform Boolean operations once instead of several times.
This method is far more efficient and less prone to errors. It is also very useful
for cutting rough openings for doors and windows into a wall if you're already
working with 3D geometry. Next, you'll find an example for working with 2D
spline objects.

Splines and Boolean Operations

Performing Boolean operations on splines made from the Create panel >
Shapes menu can be confusing. 2D spline shapes do not use the Boolean
operation you'd use for 3D geometry. Shapes, converted to Editable Splines,
offer Boolean functionality from the Modify panel > Geometry rollout. Unlike
Boolean operations performed on two separate pieces of 3D geometry, Boolean
operations can only be performed on single splines.

Therefore, one of two things must be done before you can perform Boolean
operations to spline shapes.

■ When originally creating the shapes, make sure Start New Shape is turned
off on the Create panel > Shapes > Object Type rollout. When turned off,
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you can create several overlapping shapes that are treated as a single shape
made up of several splines.

Start New Shape in the OFF state
(it is on, by default.)

■ If you didn't turn off Start New Shape, you'll have to attach all the spline
shapes to create a single shape comprised of multiple splines.

To illustrate the most common situation, let's say you've got three overlapping
rectangles and you want to subtract the two outer rectangles from the central
rectangle. You also forgot to turn off Start New Shape.

1 Start by selecting the central rectangle.
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2 Right-click and choose Convert To > Convert to Editable Spline from the
quad menu.

The Modify panel automatically opens.

3 In the Geometry rollout, click the Attach button and pick the two outer
rectangles.

Now, you've got a single shape made up of three sub-object splines.
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4 Turn off Attach and scroll up to the Selection rollout.

5  Turn on the sub-object Spline mode, and select the central rectangle.
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6  Scroll down the Geometry rollout and click the Boolean button.
Also click the Subtraction button to the right.

7 Pick the two outer rectangles.
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The final shape after subtracting the two outer rectangles

Tips for Successful Boolean Operations

Here, you'll find some general tips that will ensure that you're Boolean
operations work the first time.

■ Add a modifier and collapse the stack.
If a set of operands never seems to produce desired results, try adding a
modifier and collapsing the stack to create an Editable Mesh or Editable
Poly. You can also collapse objects to editable meshes and polys without
first applying modifiers. If you do this, use Edit > Hold or File > Save As
on the scene; you will not be able to adjust the parameters of the existing
modifiers in the stack.

■ Create objects with more faces.
In general, create objects that have more faces than you might normally
use. For instance, increase the Height, Width, and Length segments of a
Box, especially if the other object is more complex. Try to make the face
count of both operands similar in number. With a larger number of faces,
the edges created by the Boolean operation tend to be smoother and more

7872 | Chapter 28   Troubleshooting 3ds Max



refined. Once the Boolean operation gives you the results you want, apply
the Optimize modifier to reduce the number of faces on the object.

■ Apply the STL-Check modifier.
One way to check the validity of objects that you intend to use as operands
is by applying the STL-Check modifier. This modifier is primarily used to
verify that an object is a complete and closed surface in preparation for
exporting to STL files. Because Boolean operations work best with objects
that meet the same criteria, use STL-Check on your operands. After applying
the STL-Check to an object, turn on Check. The Status group tells you if
errors are present.

Performance Issues While Running 3ds Max
Slow or sluggish performance while running 3ds Max can usually be attributed
to either a video configuration conflict or a memory allocation problem. The
hard thing about performance problems is narrowing down the culprit. Here
are some common situations that can hamper operation of 3ds Max and steps
to take to rectify them.

Problems and Resolutions

3ds Max Doesn't Start Quickly

Autodesk Product Support often encounters an increase of this situation around
the time a new version or upgrade of the software is released. The question
usually posed by the customer is, “Why does the new version take longer to
start than the last version?” There are several reasons.

■ The size of the executable that starts 3ds Max and the additional overhead
needed to load the new features of a new release can cause a slowdown.
Code in a new executable may use the system processors in a different way
than the last version so a slowdown may be noticed. The important thing
is how 3ds Max performs once it is running.

■ Each version of 3ds Max is programmed and optimized to use newer video
technology than what was previously available. If you haven't upgraded
your video card in the last year, or at least updated video drivers, there is
a very good chance 3ds Max will not start as quickly as in previous versions.
You can also try a different 3ds Max video configuration.
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■ If you have not defragmented your system recently, 3ds Max could exhibit
a slower start time. Defragmenting the system can also streamline the
loading of large files that tend to swap to virtual memory.

Files Take a Long Time to Open

The size of a file often defines how quickly it loads into 3ds Max. However, if
you notice an increase in load time from one design session to another, it
could be an indication that 3ds Max is not finding enough memory to operate
efficiently or that the file needs to be optimized.

The first thing to check is your system memory allocation. Per the 3ds Max
system requirements, you should have a minimum of 256 MB of physical
memory (RAM) and 300 MB of swap space. Recommended RAM is 1 GB with
a 2 GB swap file. Here's how to check your memory and swap-file allocations.

To check RAM and swap-file allocation on Windows 2000:

1 Right-click the My Computer icon on your desktop and choose Properties
from the menu.

This opens the System Properties dialog.

On the General panel, you should see information about your computer.
The amount of RAM should be listed on this panel.

NOTE The RAM may be displayed in kilobytes (KB) instead of megabytes
(MB).

2 Open the Advanced panel, and click the Performance Options button.

The Performance Options dialog is displayed.

3 Check the “Total Paging File Size For All Drives” setting in the Virtual
Memory group.

If you have 256 MB of RAM, you should set the Virtual Memory to
approximately three times the RAM, or 768 MB.

To check RAM and swap-file allocation on Windows XP:

1 Right-click the My Computer icon on your desktop and choose Properties
from the menu.

This opens the System Properties dialog.

On the General tab, you should see information about your computer.
The amount of RAM should be listed on this panel.
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2 Open the Advanced tab and click the Performance Settings button.

The Performance Options dialog is displayed.

3 Click the Advanced tab, and check the “Total Paging File Size For All
Drives” setting in the Virtual Memory group.

If the physical and virtual memory are set appropriately, then you'll have to
check the model. If the model does eventually open, do the following:

■ From the File menu, choose Save As and save the scene under a different
name. Then try opening the new file to see if it loads faster.

■ Review some of the objects you know have large modifier stacks.
Performance can be improved if you collapse the stacks of objects that
you've completed.

■ If the model uses XRefs, make sure the XRefs are locally accessible. If they're
located on a network server, the long load time could be due to high
network traffic.

Slow Response to Open or Drag Dialogs

This situation is exhibited when you click a command that opens a dialog,
like the Material Editor or graph window, like Track View. After you click, you
notice an appreciable time lag until the dialog or window opens. If you then
attempt to drag it to a new location, the dialog or window does not smoothly
follow your cursor.

The usual cause for this is a video driver conflict or display configuration issue
because opening or dragging a dialog causes your graphic card to refresh the
screen. Try these steps to diagnose the problem.

1 Start 3ds Max.

2 From the Customize menu, choose Preferences.

3 Open the Viewports panel and check the Current Installed Driver.

Most likely, it will be set to OpenGL or Direct3D.

4 If set to OpenGL or Direct3D, click the Choose Driver button and choose
Software.

The Software setting is a generic driver that works for all video cards. It
doesn't have any video enhancements but it's a good place to begin
diagnostics.
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NOTE If you're switching from Direct3D, you first have to use Revert From
Direct3D before choosing the Software configuration.

5 Click OK to close the Graphic Driver Setup dialog.

You will be informed that you have to restart 3ds Max for the change to
take affect.

6 Close the Preferences dialog and exit 3ds Max.

7 Restart 3ds Max.

Try opening or dragging dialogs around to see if performance has improved.
If it has, do the following:

■ If the software was originally configured for OpenGL, try configuring 3ds
Max for Direct3D and see if performance is improved. Or vice-versa.

■ Verify that your graphic card supports your preferred display configuration
choice. Some cards do not fully support OpenGL or Direct3D.

■ Visit the Web site of your graphic card manufacturer and see if they have
any newer video drivers that you can download and install.

Sluggish Command Response

Sluggish command response is closely related to the previous situation. If you
create an object such as a Box, you might notice that the cursor suddenly
slows down when you drag it into a viewport. Clicking the corners to set the
length, width and height is equally time-consuming. Once again, the likely
cause is video-related.

1 Start 3ds Max.

2 From the Customize menu, choose Preferences.

3 Open the Viewports panel and check the Current Installed Driver.

4 Make sure you have 3ds Max configured for the software display driver.

5 Click OK to close the Graphic Driver Setup dialog.

You will be informed that you have to restart 3ds Max for the change to
take effect.

6 Close the Preferences dialog and exit 3ds Max.

7 Restart 3ds Max.
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Try using the command that was giving you trouble and see if it works correctly
now.

Problems Caused by Unit Settings
The unit settings of a model can often get you into trouble. Understanding
some of the common problems can help you avoid them.

This section addresses the two most common problems that modelers
encounter.

Problems and Resolutions

Objects Disappear When the Camera Gets Close

This situation can happen when you model things on a very tiny scale and
then have to get very close to them in a Camera or Perspective viewport.
Architectural walkthrough animations are notorious for this kind of behavior.
You've got a camera moving along a path and at some point it gets too close
to a wall and you're suddenly able to see through to a room on the other side.

NOTE This problem is quite common for designers working with the metric system
when you want to use real world metric units and you change the System Unit
Scale to 1 unit=1 meter. You don't have to change the System Unit Scale to metric
to work in Metric units; just change the units.

There are two solutions that often fix this problem.

Turn on the manual viewport clipping:

You can turn on the manual viewport clipping and adjust it to see the entire
object. Viewport clipping has a Near and Far range setting, if a camera gets
closer to an object than the Near Clip value, you will see through that object.
Likewise, objects that are located beyond the Far Clip value, will be invisible
to the camera.

1 Open the problematic scene and select the camera.

2 In the Parameters rollout > Clipping Planes group, turn on Clip Manually.

3 Adjust the Near or Far Clip value, or both.

When you can see the object again, your clipping plane is set properly.
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Scale the entire scene:

If it doesn't matter what units you work in, scale the entire scene so objects
are not affected by viewport clipping.

1 Open the problematic scene and select everything.

2  On the toolbar, click Select And Uniform Scale.

3 Enlarge the entire scene.

Not only do the objects in the scene get larger but the distance between
objects increases. So, the larger you scale the scene, the further your
camera is located from the surrounding objects.

If you need to work in real world units, such as inches or meters, you should
set the scale of the scene before you begin modeling by changing the System
Unit Scale value from the default of 1 unit=1 inch to something like 1 unit=0.1
inch or even 0.01 inch.

If you change the System Unit Scale after you have begun modeling, you will
need to use the Rescale World Units utility to rescale the scene.

Zooming and Panning Are Too Fast or Slow

If zooming and panning are too fast or too slow, the most likely cause is the
System Unit Scale. 3ds Max can exhibit round-off errors when dealing with
extremely large or small distances. These round-off errors can also cause
normals to be flipped or strange viewport clipping. 3ds Max does not have
the numerical resolution to zoom infinitely from the some remote corner of
the solar system down to an ant on your doorstep.

If you're going to change the System Unit Scale, you should change it before
beginning any modeling. If you do have to set it later, it's best to rescale the
entire scene with Rescale World Units. For example, if working on a tiny scale,
like modeling coins, you might change the System Unit Scale from the default
of 1 unit=1 inch to something like 1 unit=0.1 or 0.01 inch. For larger scaled
scenes, like an airport, increase the System Unit Scale.

As a rule of thumb, keep the scale such that the smallest detail is not less than
one generic unit. If this makes the scene too big to work with comfortably
and efficiently, you can create separate scenes for models that include cameras
for "close" and "far" shots.
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User Interface Problems and Recovery
It can be frustrating when you can't find something on the user interface,
especially when you saw it a few minutes ago and now it's gone missing. Of
course, you've been so engrossed in your modeling that you forget what you
might have done to cause the button, element or dialog to disappear.

This section addresses several common user-interface situations and how you
can fix them.

Problems and Resolutions

Large Fonts and 3ds Max

While some users like to configure their systems to use large fonts, this setting
is not recommended with 3ds Max. The 3ds Max user interface was designed
to operate with your system set to small fonts. Small fonts are the default
setting for both Windows 2000 and Windows XP.

If you have your system set to use large fonts, some of the most common
anomalies you can expect while running 3ds Max are as follows:

■ Buttons might be missing from the command panels.

■ Some text-entry fields may not allow you to type in them.

■ Garbled text appears in some dialogs.

■ Text labels in dialogs and rollouts might be cut off or overlap other fields.

■ Dialogs show cascading text fields and spinners.

To remedy these problems, set your system font back to small fonts.

1 Exit 3ds Max.

2 Go to Start > Settings > Control Panel, and click Display.

You can also right-click anywhere in the open desktop and choose
Properties.

3 Open the Settings panel and click the Advanced button.
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4 In the Display group of the General panel, click the arrow to open the
Font Size list and choose:

■ Small Fonts, if running Windows 2000

■ Normal Size, if running Windows XP

5 Click OK to exit the Display Properties dialog.

You will most likely have to reboot the system for these changes to take
effect.

Lost Dialogs and Windows

3ds Max has many dialogs or windows that float when you open them. This
feature allows you to drag them anywhere on your desktop. You can greatly
improve your design efficiency by positioning dialogs out of the way of the
main 3ds Max interface, such as on a second monitor if you have dual-monitor
functionality.

However, there are times when a dialog gets lost. Either you drag it someplace
and inadvertently let go of it, or some data is written incorrectly to an
initialization file and you end up with a lost dialog.

There are a couple of ways to recover a lost dialog; both entail working with
the 3dsmax.ini file found in the location indicated by the MaxData setting on
the Configure System Paths dialog on page 7732.

Thorough Method

In this example, let's say you've got a single monitor that's configured for
1280x1024 resolution and you've lost your Rendering Progress dialog.
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It was visible the last time you rendered, but that was awhile ago and someone
else has been using the system.

1 Open Windows Explorer and browse to the location indicated by the
MaxData setting on the Configure System Paths dialog on page 7732.

2 Make sure 3ds Max is not running.

The 3dsmax.ini file is constantly being updated while 3ds Max is running.
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3 Open a text editor and load 3dsmax.ini.

4 Scroll down the list of entries until you find the data block:

[RenderProgressDialogPosition]

Dimension=-425 152 379 866

A dialog's position is based off the location of the upper-left corner,
anchored by the first pair of digits. Therefore, in this example, the
upper-left corner of the dialog is -425 pixels from the left edge of the
screen and 152 pixels from the top. The second pair of digits describe the
horizontal and vertical size of the dialog, so this dialog is 379 pixels wide
and 866 pixels tall.

Since this example assumes a single monitor, configured for 1280x1024
resolution, this dialog is off-screen to the left. If the first number were
greater than 1280, the dialog would be off-screen to the right.

5 Place your cursor on the “Dimension” line and scroll over to the problem
number.

The problem number is usually the first or second, since the last two set
the width and height of the dialog.

6 Change the problem number to a value that is positive and within
1280x1024.

7 Save the 3dsmax.ini file and start 3ds Max.

The next time you render, the Rendering Progress dialog appears appear
on-screen.

This is the preferred method, because it causes no loss to other custom
configuration settings that are stored in the 3dsmax.ini file.

Quick Method

There are really only two reasons you'd use this method:

1 You've just installed 3ds Max and haven't made any customized settings
that get stored in the 3dsmax.ini file.

2 You're in a hurry and don't care about the customized settings that you
have stored in the 3dsmax.ini file.

3 Make sure 3ds Max is not running.

4 Open Windows Explorer and browse to the location indicated by the
MaxData setting on the Configure System Paths dialog on page 7732.
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5 Delete the 3dsmax.ini file.

6 Restart 3ds Max.

A new 3dsmax.ini file is automatically created using default settings.

You need to be careful when using this method, because you don't necessarily
know what custom settings are saved in the 3dsmax.ini file. Perhaps you have
3ds Max set to display the command panel on the left and you've changed
the viewport background color. Furthermore, if you have third-party plug-ins
installed, they sometimes write information to the 3dsmax.ini file. If you delete
the file, you will losing all those settings.

If you're not sure about customized settings that are stored in the 3dsmax.ini
file, you can rename the file to something like old3ds.ini. When you restart
3ds Max, you can continue working and, at a later time, compare the two files
and copy the data you need from the old one to the new one.

Material Editor Defaults to Architectural Materials

When you open the Material Editor, you encounter Architectural Materials
instead of original Autodesk VIZ Standard materials.

3ds Max allows you to set default user interfaces. If you build architectural
models or require photorealistic rendering, you can set the user interface to
default to features more relevant to the way you work. This is a new feature
that is set from the Customize menu > Custom UI and Defaults Switcher dialog
on page 7692

The program saves this setting to the 3dsmax.ini file and you have to restart
3ds Max after using the defaults switcher.

Missing Command Panel

The command panel normally appears along the right side on the user
interface. If you start 3ds Max and notice that the command panel is missing,
there are usually three causes.

■ The command panel is turned off.

■ You floated the command panel to another monitor and attempted to
drag it to a new location. When you released the mouse button, the
command panel disappeared.

■ A custom user interface is active that places the command panel off-screen.
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All of these situations can be quickly fixed by using the following steps.

1 Start 3ds Max.

2 From the main menu, choose Customize > Revert To Startup Layout.

You're warned that all UI settings you've made during the current session
of 3ds Max will be reset.

3 Click Yes.

The original user interface is restored.

Missing Transform Gizmos

Whenever you move, rotate or scale an object, the standard, red axis tripod
is replaced by a special purpose transform gizmo. It's possible to lose the
transform gizmo, but it's easy to get it back. If you find you've lost your
transform gizmo, try these steps.

1 Start 3ds Max.

2 Press the X key.

This is the keyboard shortcut that toggles the transform gizmo on and
off.

3 Press the = key.

This keyboard shortcut increases the size of the transform gizmo. The –
key reduces the size.

4 Open the Customize > Preferences > Gizmos panel, and match your
setting to the default settings shown in the following image.
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Multiple or Missing Buttons on the Toolbars

This is another tricky situation. You open a toolbar and find that there are
duplicate buttons present or the button you expect to find is no longer there.

NOTE This is generally caused by holding the Ctrl key and dragging a button on
the toolbar.

Three Select And Move buttons.
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This is clearly a user-interface problem, so reverting to the startup layout will
fix this problem.

1 Start 3ds Max.

2 From the Customize menu, choose Revert To Startup Layout, and confirm
the change.

If you have multiple buttons and don't want to reset the entire UI, you can
remove duplicate buttons manually by doing the following:

■ Hold down the Alt key and drag the duplicate button out of the toolbar.
Click Yes when asked to confirm the deletion of the button.

If buttons are missing, use Revert To Startup Layout.

Video Driver and Display Problems
Because 3ds Max heavily relies upon the graphics card in your system, many
problems that you may encounter while using the program can be attributed
to the video. Such problems could be slow performance, refresh delays, user
interface discrepancies, and so forth.

Problems and Resolutions

Basic Troubleshooting Start Point

As a rule of thumb, before attempting to diagnose any problem with 3ds Max,
you can be more efficient in your diagnostics by resetting the display
configuration to its default value. After you first install and start 3ds Max, it
runs by default in Direct3D mode, but if you use the Start menu > Change
Graphics Mode command, you're presented with the Graphics Driver Setup
dialog:
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If you're configured for OpenGL, Direct3D, or Custom, choose the Software
driver. By configuring for the Software driver, you can disqualify the video
card or drivers if the problem you're encountering persists while running 3ds
Max.

■ Resetting the configuration from within 3ds Max.

■ Choose Customize menu > Preferences.

■ Open the Viewport panel and check your currently installed driver.
If it's not the Software driver, proceed. Otherwise, you can cancel and
begin the diagnostics elsewhere.

■ If set to OpenGL, Direct3D, or a custom driver, click the Choose Driver
button.
The Graphics Driver Setup dialog is displayed.

■ Choose Software and click OK.
You'll see a message that the changes will take effect the next time you
start 3ds Max.

■ Exit 3ds Max and restart the program.

■ Try performing the task that was giving you problems.
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■ Resetting the configuration before starting 3ds Max.

1 From the Windows Start menu, navigate to the 3ds Max submenu
and choose Change Graphics Mode.
3ds Max starts up and displays the Graphics Driver Setup dialog.

2 Choose the Software driver and try performing the task that was giving
you problems once the program opens.

If the problem does not persist, you know that you've encountered a display
problem. If this is the case, check the following with regards to your video
card:

■ Verify that the video card supports the driver you attempted to use.
Some cards don't fully support OpenGL or Direct3D.

■ You might not have the latest video drivers for the card.
Contact the board manufacturer for updated drivers.

■ If you were originally configured for OpenGL, try Direct3D, or vice
versa.
The driver for the graphics card may have better support for one driver
than other.

Direct3D Failed to Initialize Message

You may need to update your video card drivers. Refer to your video card
vendor's website or contact your vendor directly for further information about
the DirectX support of your video card.

Receive DirectX Message Listing Missing dlls or Other Components

When configuring the display settings, you choose DirectX 9 or 10 (depending
on your system) and start 3ds Max only to receive a message that lists missing
dlls or other components.

Since certain components for DirectX are missing you should reinstall DirectX.
Refer to the Installation Guide for complete information about downloading
the correct version of DirectX.

Direct3D Reports a Memory Warning

You may encounter a memory warning when starting 3ds Max if you've
configured the program to use the Direct3D driver.
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This warning dialog usually appears if you have several programs, that heavily
impact the video memory of your graphics card, running and you have the
3ds Max interface maximized or stretched to cover most of the display.

Your quickest options for bypassing this warning are as follows:

■ Shut down some of the other programs that are concurrently running with
3ds Max.

■ Reduce the size of the 3ds Max interface.

■ Reconfigure 3ds Max to use a different display driver.

Dual-Monitor Configuration

Many board manufacturers are building graphic cards that support
multi-monitor configurations. The cards might advertise hardware features
like “Dual Head” or “Multi-Head” that have two monitor ports built into
them. Other manufacturers choose to handle dual configuration through
video drivers that let you configure your system display in “Wide” mode. Here
are the details of what you need to watch out for when configuring a
multi-monitor system.

■ Hardware “Dual Head” Solution
Many newer video cards offer this hardware solution for setting up a
dual-monitor system.

After installing the card and drivers, you want to follow the manufacturer's
instructions for configuring your system. Configuration is done through
your system's Display Properties dialog > Settings panel.
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You are presented with a diagram for each monitor and you can set the
resolutions independently by selecting a monitor and adjusting the screen
Area slider. You will also often find utilities included with the drivers that
enable special features for the graphics card.

The disadvantage to this configuration is that one monitor is a primary
while the other secondary, so performing some tasks can only be done on
applications positioned on the primary monitor. For instance, if you use
screen-capture software, you can have that program open on the secondary
monitor, but if you want to capture an image, you can only capture images
of applications that are located on the primary monitor.

■ Software Driver Solution
The software solution to multi-monitor configuration is often found in
older graphic cards that fit into your PCI slots. Each board has a single port
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to accept a monitor and the video drivers give you the option to configure
a single display in “Wide” mode to encompass multiple displays. Also,
because you have four PCI slots in your system, you could theoretically
drive four monitors. However, in order for these cards to operate at the
best resolutions, each card needs to have the same amount of video RAM
(vRAM) installed. So, if your had two cards and one had 32 MB of vRAM
and the other only had 8 MB, you can only configure to the highest
resolution supported by the 8 MB card.

Display configuration is normally done through the video drivers so you
have the option to configure wider screen areas. For example, instead of
configuring each display individually to 1280x1024, as described above,
you would treat both monitors as a single display and configure the screen
area to 2560x1024 pixels.

Spanning Across Monitors

Whenever, you start 3ds Max, the user interface spans across both monitors.
You find yourself constantly resizing the program to fit on one screen so you
can see the programs located on the other screen.

This is usually a problem on systems that let you configure both monitors as
one, in “Wide” mode. The utility software that loads with the graphic card
manufacturer's drivers probably has a feature that forces programs to open
across the entire expanse of the display. You can turn off this feature and
programs will open in the last position and size you gave them.

Viewport Transparency

After starting 3ds Max, the user interface appears but you can see the system
desktop through each of the viewports. This problem normally occurs if you
have the display configuration set to either OpenGL or Direct3D and your
graphics card does not completely support OpenGL or Direct3D.
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If configured for Direct3D, you might also see this problem coupled with the
“Direct3D initialization failed” message.

To remedy this problem, follow the steps outlined in Basic troubleshooting
start point on page 7886 and configure for Software. If 3ds Max opens correctly
in this mode, check the video card manufacturers for updated drivers for the
display mode you'd prefer to use.
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Glossary

This section of the Help system contains explanations of concepts and terms
used in the reference, arranged alphabetically.

2-Sided (Double Sided)

Rendering of a box with a double-sided material, and same box with a single-sided
material

In 3ds Max, faces are one-sided. The front is the side with the surface normal
on page 8059. The back side of the face is invisible to the Renderer; meaning
the face appears to be missing when viewed from the back. Objects are usually
created with the surface normals facing outward, but it is possible to create
objects with the faces flipped or to import complex geometry in which the
face normals are not properly unified.

There are two ways to render both sides of a face. Either turn on the Force
Two Sided option in the Render dialog, or apply a two-sided material to the
geometry.

Usually, you want two sided rendering turned off since it slows rendering
time. However, if you want to render the inside as well as the outside of objects,
or if you've imported complex geometry (for example, from AutoCAD) in
which the face normals are not properly unified, you can use one of the
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methods above to render each face regardless of its normal's orientation. You
can also unify normals explicitly by using the Normal modifier on page 1581.

2D Map
A two-dimensional image or pattern. A 2D map requires mapping coordinates
to render and appear in viewports. See 2D Maps on page 5782.

3D DWF
From Design Web Format. A highly compressed file format that is created from
a MAX file. DWF files are easy to publish and view on the Web using the
Autodesk Design Review program, included with 3ds Max.

3D Map
A pattern generated procedurally in three dimensions. A 3D map does not
require mapping coordinates in order to render. However, a 3D map will
appear in viewports only if the object to which it is applied has mapping
coordinates. See 3D Maps on page 5860

3DS and PRJ Files
3DS is the 3D Studio R4 mesh-file format and PRJ is the 3D Studio R4 (for
DOS) project-file format. You can import both these types of files into the
software, as well as DXF and SHP files. You can export 3DS files and DXF files.

See also:

■ Importing 3DS Files on page 7172

■ Importing PRJ Files on page 7174

■ Exporting to 3DS on page 7175
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Importing PRJ and 3DS Files

When you import a 3DS file, you get the following:

■ Backgrounds (solid, gradient, and bitmap).

■ Fog, Layered Fog, and Distance Cue.

■ Ambient light level.

■ Subtractive transparency is converted to "Filter" transparency, and the filter
color is set equal to the diffuse color.

■ Transparency falloff settings.

■ All map channels that are enabled. Map channels that are turned off in
the .3ds file do not import.

■ All map parameters, including UV transforms, Negative, Mirror, and
Rotation. Some Map Parameters such as Blur, Luma, and RGB and Alpha
work much differently. These values are converted to new values that
produce a similar effect.

■ Mask bitmaps are imported as a mask texture.

■ When materials with both Texture 1 and Texture 2 are imported, a
composite texture is created and added to the Standard material's Diffuse
channel.

■ Reflection maps, auto-cubics and mirrors.

■ Automatic reflection map Nth frame and Map Size settings.

■ SXP translation for Marble and Noise materials.

■ 3DS/DOS IK joint parameters.

■ 3DSurfer patch data.

The following information is not imported from a 3DS file:

■ Morph keys

■ Keyframer instances

■ Map channels that are turned off

■ Custom .CUB-format cubic maps

■ Decal transparency using the RGB color of the upper-left pixel of the map
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When you import a PRJ file, you get all of the above, plus Shapes.

Exporting to 3DS Files

The following rules determine what is exported to the 3DS format:

■ Position, Rotation, and Scale animation. If the controller is a TCB controller,
the TCB, Ease In, and Ease Out values are also saved. If the controller is
any other type of key controller, the keys are saved but the tangent
information is lost. If the controller is not a key controller, only the object's
transformation at frame 0 is saved.

■ Basic material color/parameters from the Standard material.

■ Single maps with their amount, offsets, scales, etc.

■ Composite and procedural maps don't export.

■ Auto-cubics and Mirrors export.

■ UV mapping coordinates can be exported.
UV mapping coordinates are exported if the toggle Preserve MAX's Texture
Coordinates is turned on in the Export Scene to .3DS File dialog. See
Exporting to 3DS on page 7175.

A vertex in a 3DS file can have only one texture coordinate. If a vertex in
the 3ds Max file has multiple mapping coordinates, it is split into multiple
3DS vertices on export, to preserve the mapping.

■ Grouped object transformations don't export to the 3D Editor because
there's no concept of group hierarchy in the 3D Editor. Groups do export
to the Keyframer because the Keyframer understands hierarchies.

■ Target cameras, target spotlights and omni lights.

■ Most "static" parameters for cameras and lights, and animation tracks for
Roll, Falloff, Hotspot, and FOV are exported. Global shadow parameters
are not exported.

■ All non-mesh geometry, such as procedural primitives and patches, are
collapsed to meshes before export.

■ Objects are exported as they exist on the frame that displays at export
time.

■ Objects are exported as they exist on the frame that displays at export
time. If you want to output morph targets, go to each frame and export
the target to a different file name.
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■ Meshes are saved with edge display information and smoothing groups.

■ Instances are saved as Keyframer instances.

Modifier and morph animation is frozen at the current frame, collapsed, and
exported as a simple mesh.

Action
Operators on page 8069 and tests on page 8147 in Particle Flow are known
collectively as actions.

Active Link

File Link Manager showing an actively linked drawing.

When you use the File Link utility to link a drawing to 3ds Max, the objects
have an active link with the original drawing in AutoCAD or Autodesk
Architectural Desktop. This means that any edit made to the drawing in
AutoCAD or Architectural Desktop can be immediately updated in 3ds Max
by reloading the link.

The red flag in the file list means the drawing has been changed in AutoCAD
or Architectural Desktop and you should click the Reload button to update
the scene in 3ds Max.

The Detach button will cause the drawing file that is linked to 3ds Max to be
removed from the scene and removed from the File Link Manager.
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Clicking the Bind button will bind the drawing to 3ds Max and sever the
active link with AutoCAD or Architectural Desktop.

Active Time Segment
The active time segment is the total range of frames that you can access using
the time slider on page 7528.

By default, the active time segment runs from frames 0 to 100, but you can
set it to any range from the Time Configuration dialog on page 7565. In addition,
the active time segment can include negative frame numbers, so you can
create keys before frame 0 and work in negative time.

You can change the active time segment whenever you want without affecting
the keys you've already created. You might think of it as a window in time,
specifying only that portion of your animation in which you want to work.
Thus, if you have keys scattered over a range of 1000 frames, you can narrow
your active time segment to work on only frames 200–300 without affecting
the keys outside of the segment.

Active/Inactive Footsteps

 When you first create footsteps for a biped in Footstep mode on page
4433, they are inactive. You must activate these footsteps using the Create Keys
For Inactive Footsteps button. Active footsteps have keys to animate the biped.
Inactive footsteps have not been given keys by character studio.

 You can make active footsteps inactive by clicking Deactivate Footsteps.

Both these buttons are on the Footstep Operations rollout on page 4438.

In the Track View – Dope Sheet editor, inactive footsteps are displayed with
a distinctive color to indicate they are inactive.

If you have upper body animation added to a biped, and you deactivate the
footsteps, then re-activate you will lose the existing upper body keys. Use
Adapt Locks on the Dynamics and Adaptation rollout to control which tracks
are affected by the create keys process.
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ActiveShade Initialize and Update
ActiveShade rendering on page 6102 is a two-step process:

■ Initialize

■ Update shading

The Initialize Pass

Rendering can be slow. The initialize pass is meant to take care of the most
time-consuming portions of rendering, to allow the update pass to take place
as quickly as possible. Initialization includes the following steps:

■ Evaluate the scene geometry into meshes.

■ Apply space warps.

■ Do transformations and clipping.

■ Evaluate textures and shade materials.

■ Perform optimizations to speed later processing, such as merging fragments
from the same surface that are in the same pixel.

The result of initialization is a buffer. This is a compressed rendering that, like
a G-Buffer on page 7991, contains the rendering plus additional information
used by the second step, updating.

During the initialize pass, progress is indicated by a row of pixels (white by
default) that traverses the top edge of the ActiveShade window.

The Update Shading Pass

Updating shading takes the buffer created by the first pass, initialization, and
uses information in that buffer to change the color of pixels when you make
changes to lights and materials in the scene.

During the update pass, progress is indicated by a row of pixels (white by
default) that descends the right edge of the ActiveShade window.
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Adapt Locks
By default, character studio automatically adapts biped keys when you edit
footsteps in a footstep animation on page 4176. You can avoid this adaptation
by using the Adapt Locks toggles on the Dynamics & Adaptation rollout on
page 4417. Each toggle locks a specific track so that character studio doesn't
adapt it when you edit footsteps.

Adapt Locks applies only to footstep animation, not to freeform animation.

Adaptation
In the Motion Mixer on page 8052, when the same clip is used more than once
on tracks, the clip versions are either instances on page 8015 or adaptations of
one another.

The same clip used more than once for one biped, or for different bipeds of
the same size, is an instance. The same clip used for different-sized bipeds is
an adaptation.

These terms are used because the Mixer adapts each loaded clip to the biped's
size. The first time a clip is loaded, the Mixer adapts the clip as needed. When
the clip is cloned or loaded again, the Mixer adapts the new clip to the biped
as needed, then compares the change to previously loaded versions to see if
it's the same. If so, the new clip and its previous versions are instances of one
another. If not, the new clip and previous versions are adaptations of one
another.

In footstep animation, the term adaptation refers to keys generated for a
footstep sequence. When you edit active footsteps, body and leg keys are
adapted automatically. By analogy, the footsteps become a kind of "gizmo"
for manipulating the keyframes of your character's animation. In most cases,
edits you make to footsteps will act upon your keys in an intuitive fashion.
See Footstep Animation on page 4176.

Adaptive Degradation
When you turn on Adaptive Degradation  on page 143, 3ds Max can change
the way it displays objects to keep up with the current operation. For example,
while you are zooming a viewport, some objects might change from shaded
to bounded boxes during the zoom operation, and then switch back to shaded
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display when you finish zooming. The settings on the Adaptive Degradation
panel on page 7828 of the Viewport Configuration dialog control how adaptive
degradation occurs.

When Adaptive Degradation is off, viewports retain their display settings at
all times, but operations such as zooming or animation playback cause a slow
screen refresh rate. In this state, animation playback might have to drop frames
to keep up with real-time playback.

You can set the parameters that control the trade-off between display quality
and display speed. The levels you activate determine which rendering levels
the software falls back to when it cannot maintain the desired display speed.
You can choose as many levels as you want, but for best results choose only
one or two levels.

Additive Opacity
An additive process adds two values together, such as two colors. When you
add colors in 3ds Max, the result is brighter than either of the two original
colors.
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Additive Opacity

Sphere on the right uses additive opacity.

Additive opacity brightens the colors behind the material by adding the
material's colors to the background colors. Additive opacity is good for special
effects such as light beams or smoke. You specify the use of additive opacity
on the Extended Parameters rollout on page 5408.

Additive Opacity and the Alpha Channel

By default, additive opacity does not generate an alpha value. In other words,
the alpha value is zero, indicating no transparency. This gives correct results
with backgrounds in renderings, but if you want to composite objects with
additive opacity using video post or a compositing program, you might want
to have additive opacity render with transparency. To do so, add the following
line to the [Renderer] section of the 3dsmax.ini file, and then restart 3ds Max:

AlphaOutOnAdditive=1

To revert to the default method of rendering additive opacity, in the 3dsmax.ini
file, change the value of AlphaOutOnAdditive back to 0 (zero), and then restart
3ds Max.
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See also:

■ Subtractive Opacity on page 8140

Adjust Talent Pose 
When you animate a biped with motion capture on page 4574, after you load
a marker file on page 8037, you can use Adjust Talent Pose to correct the biped's
position relative to the motion-capture markers. Align the biped limbs to the
markers, then click Adjust Talent Pose to compute this offset for all the loaded
marker data. This button is on the Motion Capture rollout on page 4584.

Affine Transformation
A geometric transformation such as move, rotation, or scale, that can alter
distances between points or angles between lines, but preserves straight lines
and the parallel relation between parallel lines. Transform operations are affine
transformations. NURBS on page 2261 are invariant under affine transformations.

Airborne Period
In footstep animation on page 4176, a "ballistic gait" is defined as any footstep
pattern in which there are periods with no feet on the ground, causing the
biped to become airborne, or ballistic. For example, running, hopping, and
jumping are ballistic gaits with airborne periods.
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Aliasing/Antialiasing

Pyramid is aliased on left, antialiased on right.

Aliasing is the staircase effect at the edge of a line or area of color when it's
displayed by an array of discrete pixels.

Antialiasing smoothes the staircase effect that occurs when diagonal or curved
lines or borders are drawn on raster displays consisting of square or rectangular
pixels. Antialiasing can be either on or off. Turn this off only when you're
rendering test images and want greater speed. Leave it on at all other times.

You can also turn antialiasing off for the Material Editor sample slots to speed
up redraw of the sample objects. Click the Options button in the Material
Editor and turn on the Antialias toggle on the Material Editor Options dialog.
Default=off.

NOTE To control whether or not a background image is affected by the renderer's
antialiasing filter, choose Customize > Preferences > Rendering and then turn on
Filter Background in the Background group. Default=off.

7904 | Glossary



Alpha Channel

Alpha channel shown in black, on the right

Alpha is a type of data, found in 32-bit bitmap files, that assigns transparency
to the pixels in the image.

A 24-bit truecolor file contains three channels of color information: red, green,
and blue, or RGB on page 8105. Each channel has a particular intensity or value
at each pixel. The intensity of each channel determines the color of the pixel
in the image.

By adding a fourth, alpha channel, the file can specify the transparency, or
opacity, of each of the pixels. An alpha value of 0 is transparent, an alpha
value of 255 is opaque, and values in between are semi-transparent.
Transparency is important for compositing on page 7937 operations, such as
those in Video Post, where several images are blended together in layers.

An alpha channel is particularly useful for the partly transparent pixels around
the aliased on page 7904 edge of an object in a rendered image. These pixels are
used for compositing. An image such as the one shown above can be
composited smoothly onto a different background if an alpha channel is
produced and saved with the image.

Each channel of a truecolor bitmap file is defined by 8 bits, providing 256
levels of intensity. Thus, an RGB file is 24-bit with 256 levels each of red,
green, and blue. An RGBA file (red, green, blue, alpha) is 32-bit, with the extra
8 bits of alpha providing 256 levels of transparency.

3ds Max creates the alpha channel automatically when you render. Any
background pixels in the rendered image are fully transparent, and the alpha
channel also accounts for any other transparency that you create via materials,
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etc. You can see this in the rendered frame window on page 6073 by clicking
the Display Alpha Channel button on the toolbar: In the resulting display,
black pixels are fully transparent, white pixels are opaque, and gray pixels
show degrees of transparency. To return to the regular display, click Display
Alpha Channel again.

To output a rendered image with alpha, save in an alpha-compatible format
such as TIFF or Targa. With Targa, the default settings include saving alpha;
with TIFF, be sure to turn on the Store Alpha Channel check box.

Ambient Color
Ambient color is the color of an object where it is in shadow. This color is
what the object reflects when illuminated by ambient light rather than direct
light.

Ambient color areas in the scene will not appear any darker than the ambient
light setting on page 7906.

You can lock a material's ambient color to its diffuse color so that changing
one automatically changes the other.

Ambient Light

Left: No ambient light

Middle: Low ambient light

Right: User-adjusted ambient light

Ambient light is the general light that illuminates the entire scene. It has a
uniform intensity and is uniformly diffuse. It has no discernible source and
no discernible direction.
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By default, there's no ambient light in a scene. If you examine the darkest
shadows on your model with the default ambient light setting, you cannot
make out the surface because it's unlit by any light. Shadows in your scene
will not appear any darker than the ambient light color, which is why you
usually keep ambient light set to black (or a very dark color).

If you use photometric lights and a radiosity solution on page 6168, ambient
light is accurately calculated. The other advanced lighting option, light tracing
on page 6154, also generates ambient lighting.

If you use standard lights, a good lighting test is to set your ambient lighting
to black (the default), set up all your lights, and then decide at the end if you
need to increase the ambient light.

Animated Texture
An animated texture is a material whose properties change over time. One
example of this is assigning a multi-frame bitmap (for example, an AVI file or
an IFL image-file sequence) as a map.

Animated textures can also be materials with keyframed parameters. In
addition, in the context of particle systems, a material that uses the Particle
Age map on page 5889 or the Particle MBlur map on page 5891 is considered to
be animated.

In general, when applying an animated texture to particles in Particle Flow,
be sure incorporate it in a Material Dynamic operator on page 2925.

Animation
Animation is based on a principle of human vision. If you view a series of
related still images in quick succession, your brain perceives them as
continuous motion. Each image is called a frame.

Historically, the major difficulty in creating animations has been that the
animator must produce a large number of frames. Depending on the quality
you want, one minute of animation might require between 720 and 1800
separate still images. Creating images by hand is a big job. That's where
keyframing comes in.

Most of the frames in an animation are routine, incremental changes from
the previous frame directed toward some predefined goal. Early animation
studios quickly realized they could increase the productivity of their master
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artists by having them draw only the important frames, called keyframes.
Assistants could then figure out the frames that were required in between the
keyframes. These frames were (and still are) called tweens.

Use the software as your animation assistant. As the master animator, you
create the keyframes that record the beginning and end of each transformation.
The values at these keyframes are called keys. The software calculates the
interpolated values between each key value, resulting in tweened animation.

3ds Max is not limited to animating transformations (such as position, rotation,
and scale). It can animate just about any parameter you can access. Thus, you
can animate modifier parameters, such as a Bend or a Taper angle, material
parameters, such as the color or transparency of an object, and much more.

Early animation studios also had to employ artists to add the ink and color
to each frame. Even today, production of a cartoon usually requires hundreds
of crafts people and artists to generate the thousands of images. With 3ds
Max, the renderer takes over the job of shading and rendering each frame and
storing it as you direct. The end result is a high-quality finished animation.

The quickest way to animate is to turn on Auto-Key on page 3083 and start
transforming objects at different frames. Each time you transform an object,
you set a key. Then you can play the animation onscreen on page 7561, or render
it to a file on page 6086.

Animation Controllers / Transform
Controllers

All animation in the software is performed through animation controllers.
The most common animation controllers, those for move (position), rotate,
and scale, are also referred to as transform controllers.

Each animation track has its own controller, and each controller can be
different.

In the hierarchy list, the controller tracks are represented by controller icons.
The icons can appear differently depending on the controller that is assigned,
for instance a Noise Float icon differs from a Bezier Float icon. You can also
see which specific controllers are assigned to each track by turning on the
controllers display in the Track View (right-click Filters in the Track View
toolbar, and choose Controller Types from the list). The controller names
appear beside the tracks to which they're assigned.
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You can assign different controllers to the tracks, affecting the way they
respond. The Bezier Controller, assigned by default to all the Position tracks,
lets you move objects using the Select and Move transform tool, and converts
those movements into Bezier splines. You can adjust the splines in Function
Curve editing mode.

Animation Layers
When you animate a biped or other object, you can add layers of animation
above the original biped animation. This is a powerful way of making global
changes to your animation. For example, when you add a layer and rotate the
spine forward at any frame, a run cycle becomes a crouched run. The original
biped motion is kept intact and can be viewed by switching back to the original
layer.

You can view layers individually or as a composite of all the animation in all
the layers. Layers behave like a freeform animation; the object can adopt any
position.

Layers used in conjunction with Biped let you easily adjust raw motion-capture
data, which contains keys at every frame. You do this by adding a layer and
keyframing the biped.

Layer controls for Biped are on the Layers rollout on page 4403. For other objects,
use the Animation Layers toolbar on page 7508.

Applied IK
A type of inverse kinematics where one or more parts of the IK structure follows
another animated object exactly. After the scene is set up, Applied IK generates
transform keys for every object in the IK chain.

See Animating with Applied IK on page 3462.

Area Lights (mental ray Renderer)
Area lights are a feature of the mental ray renderer. Instead of emitting light
from a point source, they emit light from a broader area around the source.
Area lights create soft-edged shadows. This can help improve the realism of
your rendering.
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Scene rendered with area light turned off

Shadows are ray-traced.

The yellow cube indicates the light's location.
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Scene rendered with area light turned on, showing soft shadows

The light in this rendering is a 2D (spot) area light.

Glossary | 7911



Scene rendered with a 3D (omni) area light

The light uses the default radius of 20.0.

NOTE To render soft-edged shadows, shadows must be ray-traced, not
shadow-mapped. See the Render Setup Dialog > Renderer panel > Shadows &
Displacement rollout on page 6292.

Area lights support global illumination, caustics, and other features of the
mental ray renderer.

TIP Area lights take longer to render than point lights. If you are interested in
creating a quick test (or draft) rendering, you can use the Area Lights/Shadows
As Points toggle to speed up your rendering. This toggle is on the Render Setup
dialog > Common panel > Common Parameters rollout on page 6121.
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Area Shadows

The shape of the shadow-casting region changes the shape of area shadows.

Area shadows simulate shadows generated by a light with area or volume.
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Aspect Ratio

Various aspect ratios

Aspect ratio describes the proportions of a still image or the frames in a movie,
expressed as the ratio of width to height, regardless of the image's resolution
on page 8108.

Aspect ratio is usually expressed either as a ratio of width to height (for
example, 4:3) or as a real value relative to 1 (for example, 1.333). For example,
pre-1950s movies and non-HD TV shows have an aspect ratio of 4:3.
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The aspect ratio is used wherever a bitmap is created or used. For example:

■ When preparing to render, you can specify an aspect ratio for your rendered
images with the Image Aspect parameter on the Render Setup dialog on
page 6067.

■ When setting up a viewport background on page 148, you can specify
whether to use the viewport, bitmap or rendering output aspect ratio to
display the bitmap.

■ When you make a spotlight a projector on page 5108, you can use the Bitmap
Fit option to match the spotlight's aspect ratio to the bitmap's, and thus
prevent the bitmap from distorting.

Attachments (IK)
In biped animation, the biped hands and feet can be linked to the world,
another object in the scene, or to the biped's own body. This linking is also
called IK attachment. Attachment can be blended: this lets you start with one
attachment and end with another. For example, if the biped is catching a ball,
you can start with the hand in body space and end with the hand in the
coordinate space of the ball.

Attenuation

Image on right rendered with attenuation

In the real world, the intensity of light diminishes over distance. Objects far
from the light source appear darker than objects near the source. This effect
is known as attenuation.
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In nature, light attenuates at an inverse square rate; that is, its intensity
diminishes in proportion to the square of the distance from the light source.
It is common for attenuation to be even greater when light is occluded by
small particles in the atmosphere, especially when there are clouds or fog
present.

Attenuation and Photometric Lights

Photometric lights always attenuate at the inverse square rate. This is one of
the reasons it is important for scenes with a radiosity solution to use real-world
dimensions and units.

Attenuation and Standard Lights

By default, standard lights don't attenuate. Consequently, an object's distance
from the light doesn't matter, and only the angle of light to the surface has
any effect on illumination unless you turn on attenuation. You can manually
control the rate of attenuation for standard lights. You can also use attenuation
with the Raytrace map. If your scene uses standard lights, you should consider
adding attenuation whenever possible, for two reasons:

■ Attenuation provides greater subtlety and realism in your lighting.

■ You can reduce rendering time, since attenuated lights don’t have to be
calculated for surfaces that are beyond the attenuation range.

For standard lights, you can explicitly set where attenuation begins and ends.
This is partly so you don't have to worry about setting up strictly realistic
distances between light objects and the objects they illuminate. More
importantly, this feature lets you fine-tune the effect of attenuation. In outdoor
scenes, attenuation can enhance the effect of distance. In an indoor setting,
attenuation is useful for low-intensity light sources such as candles.

For standard lights, you set attenuation parameters on the light's
Intensity/Color/Attenuation rollout on page 5083. For the Raytrace map, you
set the parameters on the map's Attenuation rollout on page 5957.

AutoGrid
AutoGrid is an option on the 3ds Max Create panel. It lets you create an object
on the surface of another object. You can turn on AutoGrid when you create
a biped, in order to position the biped on another object.
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AutoGrid can also be used when creating footsteps manually, to place footsteps
on an uneven terrain.

Avoid Behavior
In crowd animation on page 4761, the Avoid behavior lets you specify any object
or objects that delegates must keep away from. As delegates approach
designated objects during the crowd simulation, they steer clear of them while
turning or braking as necessary. This behavior uses three different methods
to let delegates avoid each other and other objects: Steer To Avoid (the
preferred method), Repel, and Vector Field. See Obstacle Avoidance on page
4780.

Avoidance Behavior
In crowd animation on page 4761, avoidance behavior consists of any
combination of slowing down, turning, and stopping. See Obstacle Avoidance
on page 4780.
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Axonometric View

Axonometric view of model

A projected view of 3-dimensional space that displays from one to three sides
of an object. The lines in an axonometric view do not converge to vanishing
points as they do in a perspective view, so lines that are parallel in 3D space
are parallel in the view. For this reason, diagonal and curved lines can appear
to be distorted.

Isometric on page 8019 and orthographic on page 8073 views are special cases of
axonometric views.

B-Spline
B-spline (basis spline) is a kind of spline generated by so-called basis functions.
The advantage of B-splines over Bezier curves on page 7922 is that the control
vertices (CVs) of a B-spline affect only their local region of the curve or surface.
B-splines also compute faster than Bezier curves.
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Balance Factor
Balance Factor positions the biped's weight anywhere along a line that extends
from the center of mass to the biped's head, affecting the degree to which the
hips or head (or both) swing away from their original vertical alignment when
the biped is bent over.

See Shifting the Biped's Balance on page 4212.

Balance Track
Each biped added to the Motion Mixer on page 3699 is automatically assigned
a balance track. You don't place clips on this type of track as you do with
transition tracks on page 8158 and layer tracks on page 8021. The weight curve on
page 8169 on the balance track is the only adjustable parameter.

By default, the Motion Mixer compensates for differences in upper and lower
body motion that might cause the biped to go off balance over the course of
the animation. It accomplishes this by changing the COM, pelvis and spine
animation.

When the weight curve across the balance track is set to 1.0 (the default),
balance compensation is enabled for the entire animation. You can adjust
nodes on the weight curve to disable balance compensation over all or part
of the animation. See Adjusting Biped Balance in the Mixer on page 3737.

Ballistic Gait
A "ballistic gait" is defined as any footstep pattern in which there are airborne
periods (periods with no feet on the ground) such as a jumping or running
pattern.

Ballistic Tension
Controls the amount of spring or tension when the biped lands or takes off
from a jump or run step. See Adjusting Vertical Motion on page 4217.
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Barycentric Coordinates
Given a triangle between points A, B, and C, each point X on the surface of
the triangle can be represented by a weighted sum of the corners:

X = a*A + b*B + c*C

where a, b, and c are numbers between 0 and 1 and a+b+c = 1.

These numbers are called the barycentric coordinates of the point X. There is
one unique set of barycentric coordinates for each point on the triangle.

Examples

The center of gravity of the triangle is given by the barycentric coordinates
(1/3, 1/3, 1/3): X = 1/3 A + 1/3 B + 1/3 C = (A+B+C)/3.

If one of the barycentric coordinates is zero, the point X must lie on the
opposite edge. For instance:

if a=0, X = b*B + c*C

where b+c=1

This means that X is on the line segment BC.

If a=1, on the other hand, then b=c=0, and X must be exactly the point A.

Behaviors
In crowd animation on page 4761, behaviors simulate a range of activities. Seek,
avoid, path follow, surface follow, repel, orientation, scripted, space warp,
surface arrive, wall repel, wall seek, and wander are all behaviors available in
a crowd simulation.

Behaviors let you assign procedural activity types to delegates and objects
linked to delegates. You can associate any number of behaviors with each
Crowd object, and then link delegates and teams of delegates to each behavior.
A specific behavior assigned to a Crowd object belongs only to that crowd; it
cannot be assigned to any other crowds.
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Bend Links 

Bend Links Mode active (left) and Bend Links Mode inactive (right)

When you turn on Bend Links Mode (on the Bend Links rollout on page 4363),
rotating a single chain link causes the other links to bend following a natural
curvature. When Bend Links Mode is off, rotating one link rotates all its
children links by the same amount.

TIP Bend Links works well on the biped spine, neck, tail and ponytail links.
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Bezier Curve

Bezier curve and the control points and tangent vectors about each vertex

A curve modeled using a parametric polynomial technique. Bezier curves can
be defined by many vertices. Each vertex is controlled by two other points
that control the endpoint tangent vectors. Bezier curves were developed by
P. Bezier for computer modeling in automobile design.

A vertex on a Bezier Curve affects the entire curve in that area. Compare with
B-splines on page 7918, where the control vertices (CVs) affect only their local
region of the curve or surface.

A segment on an editable spline on page 675 that has its vertices set to Bezier
or Bezier Corner is considered a Bezier Curve.

BioVision Files
The BioVision™ file format stores motion-capture information. A BVH file
contains the "actor's" skeletal and limb/joint rotation data, and uses the .bvh
file name extension.
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NOTE For the BVH file specification, see the BVH.rtf document on the program
disc.

BIP Files
BIP files contain skeletal size and limb rotation data for bipeds. This is the
native character studio motion file format.

Biped
Biped is a 3ds Max system provided with the character studio product. It
provides the armature used to pose a character, and facilities to animate it
using either footsteps or freeform animation.

Biped Dynamics
Biped dynamics calculate a biped's airborne trajectory, the bending of its knee
or knees on landing, and the biped position so it maintains balance when the
spine is rotated. When the position or animation of the biped change,
dynamics cause the biped to adapt.

There are six parameters that affect biped dynamics. Three are in the Body
section of the Key Info rollout on page 4367:

■ Balance Factor on page 7919

■ Dynamics Blend on page 7959

■ Ballistic Tension on page 7919

The other three are on the Dynamics & Adaptation rollout on page 4417:

■ GravAccel on page 8000

■ Biped Dynamics

■ Spline Dynamics on page 8135
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Biped Playback 
Biped Playback on the Biped rollout on page 4331 plays the animation for all
bipeds in a scene (unless you use the Display Preferences dialog to exclude
them). This playback mode usually gives real-time playback, which you might
not get if you use the 3ds Max viewport animation Play button.

In Biped Playback mode, the biped is displayed as bones only, with no other
scene objects visible.

Birth Event
A birth event is a special type of local event on page 8027 that always comes at
the start of a particle flow on page 7983, immediately after the global event on
page 7997. Its first action on page 7897 is a Birth operator on page 2844 or Birth
Script operator on page 2847. The birth event can contain any number of
additional actions, and can be succeeded by any number of additional events.
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Birth event (highlighted)
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Bitmap
A bitmap is a still image produced by a fixed matrix of colored pixels on page
8092, like a mosaic. You can use bitmaps as textures for materials, as backgrounds
to viewports, and as rendered environments.

You can use an animation or video file as a bitmap, in which case the material
or background changes over time.

Bitmaps can be reloaded automatically after they have been changed and
resaved by a graphic editing program. See the Reload Textures On Change
toggle in Preferences Settings > Files panel on page 7750.

3ds Max can use the following image file formats as bitmaps:

avi on page 7326

bmp on page 7328

cin on page 7328

cws on page 7329

dds on page 7330

gif on page 7334

Radiance Image File: (hdr on page 7334, pic)

ifl on page 7339

jpg on page 7347

mov on page 7348

mpg on page 7348

png on page 7360

psd on page 7361

rgb on page 7369

rla on page 7364

rpf on page 7366

tga on page 7370

tif on page 7372

yuv on page 7374
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NOTE 3ds Max can also render to some of these formats, but not to all of them.
See the topic for the individual image format for details.

Blend Object

NURBS blend surface

A dependent NURBS object that connects two curves or two surfaces. The
curvature of the blend is controlled by the objects it connects, and by two
tension parameters that control the "length" of effect of the tangent for each
of the "parent" objects.

Block Reference
In AutoCAD, a compound object that is inserted into a drawing and displays
the data stored in a block definition. A block reference is also sometimes
referred to as a Block Instance. Refer to the AutoCAD, Autodesk Architectural
Desktop, or Autodesk Mechanical Desktop help files for further information
regarding Blocks, Block Instances, and Block References.
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Block/Style Parent
A Block/Style Parent is closely related to a VIZBlock on page 8165 in that it is a
compound object similar to a nested AutoCAD block. Just like the VIZBlock,
it is used for organizing linked data from DWG files. When linking DWG data
to 3ds Max, you need to decide how the incoming entities are to be organized
in the scene. Objects in DWG files are commonly organized by layers, blocks,
and entities, while 3ds Max scenes are organized by parent/child hierarchies
of objects.

The main difference between a Block/Style Parent and a VIZBlock is that a
Block/Style Parent allows for a parent/child hierarchy of “components,” but
does not display any of its own geometry. A VIZBlock displays its own geometry
and lists a set of “components,” or sub-objects.

Blur / Blur Offset

Top: Blur = 1, Blur Offset = 0

Middle: Blur = 10, Blur Offset = 0

Bottom: Blur = 0.01, Blur Offset = 0.2
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The Blur and Blur Offset controls determine how a 2D map is blurred, or how
it is softened in the rendering. You can't see their effect in the viewport
renderer, only in the production renderer.

The Blur setting blurs the map based on its distance from the view. The farther
away the map is, the greater the blurring. You should always use some blurring
on your maps to avoid the type of scintillation, or aliasing that can occur
when pixel details are reduced off in the distance. This effect typically occurs
when you use detailed bitmaps viewed at a distance, and is particularly
apparent during animations. The Blur default is 1.0, which is a good setting
for most purposes.

Blur Offset blurs the map without regard to depth. That is, all the pixels in
the map are blurred equally, regardless of how close or how far they are from
the camera.

Whereas the Blur value is primarily used to avoid aliasing, Blur Offset is useful
when you want to soften, or defocus the details in a map. It's the equivalent
of blurring the bitmap in an image-processing program before applying it as
a material map.

NOTE For bump mapping on page 5478, lower Blur and higher Blur Offset values
give better results.

Body Space
A biped limb can be put into the coordinate space of the world or an object
in the scene as well as body space. Body space moves the biped limbs when
the biped moves; if you rotate the biped's hips, the feet, in body space, move
as well.
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Boolean Operation

The fence is operand A, and the cat is operand B.

Upper left and right: A minus B

Second to upper left: B minus A

Second to lower left: Union

Lower left: Intersection

A Boolean object combines two objects by performing a Boolean operation
on them. In the software, a Boolean object is made from two overlapping
objects. The original two objects are the operands (A and B) and the Boolean
object itself is the result of the operation.

For geometry, the Boolean operations are:

■ Union: The Boolean object contains the volume of both original objects.
The intersecting or overlapping portion of the geometry is removed.

■ Intersection: The Boolean object contains only the volume that was
common to both original objects (in other words, where they overlapped).
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■ Subtraction (or difference): The Boolean object contains the volume of
one original object with the intersection volume subtracted from it.

Bound Vertex
Binding spline vertices via the Refine and Bind functions in Editable Spline
(Vertex) on page 675 is useful for connecting splines when building a spline
network for use with the Surface Modifier on page 1766.

Bound vertices are black, allowing them to be easily distinguished from
standard vertices. You cannot move a bound vertex directly. However,
changing the segment length by scaling it or by moving a connected vertex
causes the bound vertex to shift its position in order to remain at the segment's
midpoint. You can change a bound vertex's type (right-click the vertex, and
then choose the type from the bottom of the right-click menu), and if you
convert it to a Bezier or Bezier corner, you can manipulate its handles.
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Bounding Box

Bounding box shows the extents of the model boat.

The bounding box is the smallest box that encloses the maximum dimensions
or extents on page 7969 of an object.

You can display selected objects in the scene as bounding boxes to speed up
screen redraw. Use the Object Properties dialog on page 305.

The Align command on page 1009 uses the maximum and minimum extents
of the object's bounding box to align objects.

Bulge
Physique allows you to “bulge” a mesh based on the orientation of a limb.
Bulging the mesh is used to simulate muscle contraction.
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Bulge Angle
In Physique, a bulge angle is a control that sets the limb angle where the bulge
will occur. Typically you first orient the limb, and then set the bulge angle.
After setting the bulge angle, you then deform the mesh to make it bulge.

BVH Files
BVH is the file name extension for the BioVision™ motion-capture file format.
A BVH file contains the "actor's" skeletal and limb/joint rotation data.

NOTE For the BVH file specification, see the BVH.rtf document on the program
disc.

By Layer

By Layer icon in the Layer Manager dialog

ByLayer is a property setting available to objects listed in the Layer Manager
on page 7441, as well as from the Object Properties dialog on page 305. When
By Layer is set, the object inherits settings for the selected property from its
associated layer.

Center of Mass (COM)
The root object of a biped. Transforming the center of mass moves the entire
biped. The center of mass can move outside of the biped body; for example,
moving the center of mass forward can help simulate lifting a heavy object.
The center of mass uses three animation tracks to animate the biped. Two of
these tracks, Body Vertical and Body Horizontal, contain biped dynamics on
page 7923 parameters.
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Chamfer

NURBS chamfer curves

A dependent NURBS object that is a line segment connecting two curves. It
is controlled by the curves it connects, and by two length parameters that
control the distance back from the point of apparent intersection of the
"parent" curves.

character studio Marker Files
The character studio marker (CSM) file format stores motion-capture data in
ASCII (text) format. It uses positional markers rather than limb rotation data.
When you import a raw marker file, only marker position data is stored in the
motion-capture buffer. character studio uses the marker data to extract limb
rotation data to position the biped.

NOTE For the CSM file specification, see the CSM.rtf document on the program
disc.
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CIBSE Files
The CIBSE file type is the file format for photometric data adopted by the
Chartered Institution of Building Services Engineers. It is used primarily in
Great Britain.

Clip Controller
In crowd animation on page 4761, the GlobalMotionClip and MasterMotionClip
controllers are used to create animation for multiple objects. Birds, butterflies,
schools of fish, and bugs can be animated using these tools. Clip controllers
can be created either as block controllers in Track View, or more directly in
the Crowd helper on page 4819 controls on the Global Clip Controllers rollout
on page 4916. Use clip controllers to animate non-biped creatures in crowds.

Clipping Planes
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Clipping planes let you exclude some of a scene's geometry to view or render
only certain portions of the scene. Each camera has a near and a far clipping
plane. Objects closer than the near clipping plane or farther than the far
clipping plane are invisible to the camera.

Clipping planes are useful for rendering selected portions of a scene that have
a lot of complex geometry. They can also help you create cutaway views.

Clipping plane settings are part of the camera's creation parameters. The
location of each clipping plane is measured along the camera's line of sight
(its local Z axis) in the current units for the scene.

Clipping planes are part of a camera’s general parameters on page 5210.

Viewports can also have clipping planes. You set a viewport’s clipping planes
via the viewport right-click label on page 7576.

Codec
Short for compressor/decompressor. An algorithm for compressing and
decompressing digital video data, and the software that implements that
algorithm.

Cognitive Controller
In crowd animation on page 4761, the Cognitive Controller editor on page 4857
lets you sequence different behaviors using state diagrams, where conditionals
written in MAXScript impose changes in behavior. For example, you can
specify that a character or object is to wander aimlessly until it comes within
a certain distance of another object, whereupon it heads straight for that
object. Or you can specify that one character is to avoid another only when
the second character is avoiding the first.
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Composite

The mailbox with its shadow is composited with the wall and sidewalk to make the
finished scene.

(noun) A still image or a motion picture created by overlaying one image or
motion picture with another.

(verb) To combine still images or motion pictures by laying one over the other.

Compositing often makes use of an image's alpha channel on page 7905.
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Compound Materials

House on right uses a compound material.

(House on left uses the default standard material).

Compound (or complex) materials let you create a material consisting of two
or more sub-materials.

The real power in using compound materials is that each sub-material can be
as complex as any standard material.

The Multi/Sub-Object compound material lets you assign different materials
to different sub-objects, at the sub-object level of your geometry.

You load or create compound materials using the Material/Map Browser.

For more information about the types of compound materials you can create,
refer to Compound Materials on page 5706.
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Constrained Point
A NURBS Point that is dependent on either another Point, Curve, or Surface,
and whose position is either on the parent object or relative to it. The relative
cases are XYZ-relative, along a normal, or along a tangent (or set of tangents
for a surface-dependent constrained point).

Contact Object
In Particle Flow on page 2795, in the context of the Shape Mark operator on
page 2911, a contact object is the object that will receive the marks created by
the operator.

Containers
Containers are Track View items with multiple branches that provide a
complete definition of something in your scene.

Container items that appear in Track View include:

■ Materials definitions with all parameters, maps, and sub-materials.

■ Maps containers with all map types and map parameters.

■ Single Map containers with a single map type and its associated parameters.

■ Object containers directly below a named object item defining the creation
parameters of an unmodified object.

■ Modified Object containers holding all of the modifiers applied to an object
as well as the creation parameters.

Continuity
A property of curves, including NURBS curves. A curve is continuous if it is
unbroken.
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Continuity Level

Levels of curve continuity:

Left: C0, because of the angle at the top

Middle: C1, at the top a semicircle joins a semicircle of smaller radius

Right: C2, the difference is subtle but the right side is not semicircular and blends with
the left

The level of continuity is a way to describe curvature. A curve with an angular
cusp is C0 continuous. The curve is continuous but its derivative is not. A
curve whose curvature changes has C1 continuity. The curve and its derivative
are both continuous but its second derivative is not. A curve with
uninterrupted, unchanging curvature has C2 continuity. NURBS curves must
have at least C0 continuity; a continuity level greater than C2 is unnecessary
for most 3D computer modeling.
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Control Lattice

Control lattice surrounding the NURBS model of the fountain basin

In NURBS modeling, the lattice described by the CVs that specify a CV Curve
or CV Surface. In viewports, this appears as a dotted yellow framework when
you edit the curve or surface at the CV sub-object level. You can also choose
to display the control lattice in viewports at all times.

Control Point
In Physique, a vertex used to control the cross sections of envelopes, bulges,
and tendons.

Glossary | 7941



Control Vertex (CV)

Control vertices in the lattice surrounding a NURBS surface

In NURBS modeling, a vertex that controls a CV Curve or CV Surface. The 3D
location of each CV affects the shape of the curve or surface. CVs aren't
constrained to lie on the curve or surface. Each CV has a rational weight that
can be used to adjust the influence of the CV on the curve's or surface's shape.

Controller
Software that controls animation. Controllers handle the following functions:

■ Storing animation key values

■ Storing procedural animation settings

■ Interpolating between animation key values

7942 | Glossary



Convex Hull Property
The property of NURBS curves and surfaces whereby the control lattice
described by CVs forms a convex hull surrounding the curve or surface.

Cool
It's useful to be able to edit a material in the Material Editor and have it
immediately updated in the scene. Sometimes you want to work on a material
without affecting the scene. You want to adjust a material until you're sure
that it's what you want, and then reassign it. In other words, you want to cool
a hot material on page 8006.

You cool a material by copying it in the Material Editor sample slots. You can
copy a material in two ways:

■ Use the Copy Material button.

■ Drag and drop to copy the material.

When you drag to copy a sample, you end up with two materials with the
same name, but one is cool while the other is hot. In the Material Editor, you
can have up to 24 materials with the same name, but every material in your
scene must have a unique name.

You can now adjust the cool material, and compare it with the hot material.
If you like the changes you've made, you can update the scene.

Coordinate Space
In character studio biped animation, the three most-used coordinate spaces
are world, object, and body space. These are often used to control the biped's
hands and feet.

Another coordinate system is used for the footstep gizmos themselves: a foot
on a footstep is in that footstep's coordinate space. If the footstep is moved,
the foot moves also. (A sliding footstep is a footstep that moves relative to the
coordinate system of the corresponding footstep gizmo.)
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CPY Files
CPY files contain postures, poses and tracks you have copied and saved on
the Copy/Paste rollout on page 4389. You can load a CPY created with one biped
to another biped. See Copying and Pasting Postures and Poses  on page 4281
and Copying and Pasting Tracks on page 4311.

Creation Parameters
An object’s creation parameters are settings, typically available on its
Parameters rollout, that you make when you first add the object to the scene.
You can later adjust these settings by accessing the object at the bottom of its
modifier stack. For example, a Box primitive’s creation parameters are its size
and number of segments in each of the three dimensions. You can usually
adjust an object’s size without scaling it by changing its creation parameters.

If you collapse on page 2016 an object, its creation parameters are lost, and can
no longer be adjusted.

Cross Section
In Physique, envelopes on page 7963, bulges on page 7932, and tendons on page
8144 all have cross sections. Envelope cross sections can be moved and scaled
to encompass more or less of the character's skeleton. In bulges, shaping the
cross sections controls the amount of bulging and the appearance of the bulge.
In tendons, cross sections provide connections between links and the mesh
skin.

Crowd
The Crowd helper object on page 4819, available from Create panel > Helpers,
serves as the command center for setting up and solving crowd simulations
on page 4761. The Crowd helper object also lets you add behaviors to the scene,
choose the current behavior from a list, and modify that behavior.
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Crowd System
In crowd animation on page 4761, a crowd system comprises the Crowd helper
on page 4819, one or more Delegate helpers on page 4811, a Vector Field space
warp on page 4917, and Motion Flow mode on page 4545. These are used in
combination to animate characters or other objects.

CSM Files
The CSM (character studio marker) file format stores motion-capture data. It
is an ASCII (text) file that uses positional markers rather than limb rotation
data. When you import a raw marker file, only marker position data is stored
in the motion-capture buffer. 3ds Max uses the marker data to extract limb
rotation data to position a biped.

NOTE For the CSM file specification, see the CSM.rtf document on the program
disc.

Curve View
Curve View is the area of the Animation Workbench that displays function
curves for the parts of the biped. Curve View is quite similar to the Key Window
in the Track View – Curve Editor. The same navigation and key manipulation
toolbars are used in both Curve View and the Key Window. Both Curve View
and the Key Window let you add or delete, move or scale keys selected on the
curves.

Curve View differs from the Key Window in that it also displays errors found
by the Analyzer panel, functionality which is not available in the standard
Track View. Curve View doesn't use soft-selection like the Key Window, instead
it has a specialized Show Layered Edit command for the equivalent of soft
selection on biped keys.
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CV

CVs (control vertices) in the lattice surrounding a NURBS surface

Short for control vertex.

In NURBS modeling, a vertex that controls a CV Curve or CV Surface. The 3D
location of each CV affects the shape of the curve or surface. CVs aren't
constrained to lie on the curve or surface. Each CV has a rational weight that
can be used to adjust the influence of the CV on the curve's or surface's shape.
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CV Curve

NURBS CV curve

A NURBS curve defined by CVs. The CVs don't necessarily lie on the curve.
Instead, they form a control lattice that affects the curvature of the curve.
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CV Surface

NURBS CV surface

A NURBS surface defined by CVs. The CVs don't necessarily lie on the surface.
Instead, they form a control lattice that affects the curvature of the surface.

Deformable Envelope
In Physique on page 4603, envelopes on page 7963 follow the Physique deformation
spline on page 7949 that runs through the joints in the skeleton's hierarchy. A
deformable (as opposed to rigid) envelope is one that moves the mesh vertices
it encloses as the skeleton moves.

A link can have both a deformable and a rigid envelope. When it has both,
the effect of the two is averaged, creating a less flexible skin.

In character animation, you typically use deformable envelopes; however,
some portions of the body, such as the head, might look best if they are rigid.
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NOTE Because of game-engine restrictions, if you are developing for certain
engines, you might want to use rigid envelopes exclusively.

TIP If your model consists of articulated rigid segments, such as a marionette, you
might not need to use Physique at all. Simply link each part to the corresponding
biped object.

Deformation
The effect caused by Physique on page 4603 on a mesh. Envelopes, bulges, link
parameters, and tendons all affect how a mesh deforms.

Deformation Spline
The deformation spline is created when you initialize Physique on page 4603.
It is a continuous curve through several points. The deformation spline is a
smooth curve that runs from joint to joint.
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The deformation spline displays as a yellow curve that runs through the mesh.

The Bend, Bias, and Tension spinners can change the shape of the deformation
spline.
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The deformation spline also takes into consideration twisting and scaling of
the skeleton’s links. At the Link sub-object level on page 4725, you take control
of the behavior of the deformation spline, and subsequently gain full control
of the skin’s behavior relative to the skeleton’s movement.

Degree
The degree of a curve is the highest exponent in the equation used to represent
it. A linear equation is degree 1, a quadratic equation degree 2. NURBS curves
typically are represented by cubic equations and have a degree of 3.

Delegates
In crowd animation on page 4761, the Delegate helper serves as an agent for the
motion created by a Crowd object on page 4819 and its behaviors. The Crowd
object controls a delegate or delegates, whose motion can then be imparted
to a biped or other object.

In viewports, the delegate object takes the shape of a pyramid. By default, the
point of the pyramid indicates the delegate's forward direction. Delegates
cannot be rendered.

Dependent
A dependent is an object whose behavior or appearance can be influenced by
other objects. Dependents include instances on page 8014, references on page
8106, and objects sharing a common modifier (the same objects that appear
green when Show Dependencies is on in the View menu). Also, an object
whose motion is constrained on page 3287 by another’s is a dependent of the
constraining object.

See also:

■ Select Dependents on page 7389 in the Scene Explorer dialog
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Dependent (NURBS)
Describes a NURBS sub-object whose definition depends on other NURBS
sub-objects. For example, a Blend Curve depends on the two curves that you
select when you create it.

Depot
The depot is the section of the Particle View dialog on page 2811 that holds the
Particle Flow actions on page 2838. In effect, it serves as a library of Particle Flow
functionality. Display of the depot can be toggled with the Particle View menu
command Display > Depot.

To add an action to the particle system, drag it from the depot to the event
display on page 2822. To view a description of an action in the description panel
on page 7953, click its entry in the depot.
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Description Panel
The description panel, found to the right of the depot on page 7952 in Particle
View on page 2811, displays a text description of any action whose name you
click in the depot. Display of the depot can be toggled with the Particle View
menu command Display > Description.

Diagonal
A diagonal is a line that connects polygon vertices in editable poly and Edit
Poly objects. Its function is primarily to resolve the polygon into triangles at
render time, especially if the polygon becomes non-planar via transformation
of its vertices. Such transformation and certain other operations can,
incidentally, cause automatic rearrangement of a polygon’s diagonals.
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Diagonals on the default Cylinder primitive

Diagonals are normally invisible, but in 3ds Max they appear as dashed lines
when you use the Turn or Edit Triangulation tool. Unlike edges, diagonals
cannot be transformed, or acted upon with tools like Chamfer. This is different
from the hidden edges in editable mesh/Edit Mesh objects, which are actual
edges and can be made visible, transformed, and manipulated with any editing
tool.
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Diffuse Color

Vase has a mapped diffuse color.

The diffuse color is the color that an object reflects when illuminated by "good
lighting," that is, by direct daylight or artificial light that makes the object
easy to see.

When we describe an object's color in conversation, we usually mean its diffuse
color.

The choice of an ambient color depends on the kind of lighting: for moderate
indoor lighting it can be a darker shade of the diffuse color, but for bright
indoor lighting and for daylight, it should be the complement of the primary
(key) light source. The specular color should be either the same color as the
key light source, or a high-value low-saturation version of the diffuse color.
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Dithering

Square on the right shows dithering.

When converting an image with a palette of a greater number of colors to an
image with a palette of fewer colors, dithering is a means of simulating colors
not in the more limited palette, by mixing different-colored pixels together.

Dithering is also a method of smoothing the edges between two color regions
by mixing their pixels so the edges appear to blend together.

If you are rendering for the limited colors of an 8-bit display (256 colors), you
have the option of turning on dithering. Dithering can help prevent a banding
effect in color gradients. Dithering does increase the size of 8-bit files and can
slow the playback speed of animations. You might want to try applying maps
to the flat areas in the scene to see if that eliminates banding before you turn
on dithering.

By default, 3ds Max renders 64-bit color output. Consequently, you also have
the option of setting dithering for truecolor (24 or 32-bit color) on page 8159.
The Dither True Color option ensures that you get the best quality on truecolor
displays.
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You turn dithering on and off in the Rendering panel on page 7768 of the
Preferences dialog. You can also set dithering for scene motion blur in Video
Post. Here, dithering provides a smoothing effect between the separate images
making up the "blur." Video Post dither is set as a percentage of total dither.

Dock and Float
These terms describe manipulations to user-interface elements, such as toolbars.

You dock a toolbar, for example, when you align it with the edge of another
interface element, typically a window or panel.

You float a toolbar when you detach it from a stationary position, and
reposition it elsewhere on the desktop.

Double Support Period
In footstep animation on page 7986, a period where both of the biped's feet are
on the ground.

Dummy Object
A dummy object is a non-rendering object that you use as an animation helper.
The primary use of the dummy helper object is to assist you in creating
complex motions and building complex hierarchies. Because dummies are
invisible in the rendered scene, they are an excellent choice for offset joints,
connectors between objects, and handles for manipulating complex hierarchies.

Breaking complex motions into simple components often makes it easier to
go back and edit your animations. For example, consider animating a bouncing
ball moving around your scene. You could animate the ball by properly
positioning it throughout the scene on many frames. The drawback is that it
would be very difficult for you to go back and adjust the height of the bounce
or the path the ball takes through the scene. You would have to edit the
motion of the ball on many frames to make even a simple change.

Using a dummy object easily solves this problem by breaking the motion into
two simple components. One component is the bounce of the ball. The other
is the path through the scene.
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DWG Files
The DWG file is the primary, native file format of drawing files created by
AutoCAD, Autodesk Architectural Desktop, and Autodesk Mechanical
Desktop®. It is a binary format used for importing and exporting on page 7206
AutoCAD drawing files.

You can also use the File Link Manager on page 6987 to create a live link between
a drawing file that can be open in AutoCAD and 3ds Max. Changes that are
made to the drawing can automatically be updated in 3ds Max without having
to reload scenes or re-import drawings.

DXF Files
DXF files are used to import and export objects to and from AutoCAD (and
other programs that support this file format).

Keep the following in mind when you are creating your DXF geometry, and
when you are deciding whether to convert by layer, color, or entity:

■ With AutoCAD Release 12, if you are using the AutoCAD Advanced
Modeling Extension (AME), use the SOLMESH command on your AME
models prior to saving the .dxf file.

■ After importing a DXF file, you might want to divide the resulting 3ds
Max file into smaller objects.

Entities that are frozen or turned off are ignored.

The successful unification of face normals depends on the welding of
coincident vertices. Sometimes, depending upon the precision of the model
as it was created in AutoCAD, the vertices may not be close enough to be
considered "coincident." They will not be welded, and the faces will not be
properly unified. In this case, increase the Weld Threshold value in the Import
DXF File dialog.

Converting by layer can result in objects consisting of many elements on page
7962. In certain cases, some of these elements may have all of their face normals
flipped the wrong way. You can detect this in the software by turning off
Backface Cull in the Display panel, or by rendering the objects. Use the Normal
modifier on page 1581 to correct this.

If you do not want to flip normals, you can either use 2-sided materials, or
turn on the Render Setup dialog > Force 2-Sided option on page 6128.
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If you are loading a large scene containing thousands of entities (such as 3D
faces) and have chosen to load an object by entity, the conversion can take a
long time. It also produces a huge number of objects to handle in the software.
To avoid this, organize your DXF file so that these kinds of entities are grouped
by layer, then make the conversion by layer rather than by entity.

Dynaflector
A space warp on page 8132 that lets particles affect objects in a dynamics
situation.

Three kinds of space warps are in the dynaflector category:

PDynaFlect Space Warp on page 2738

SDynaFlect Space Warp on page 2745

UDynaFlect Space Warp on page 2748

See also:

■ Omniflector on page 8067

Dynamics
Biped Dynamics on page 7923 calculate a biped's airborne trajectory, the bending
of its knee or knees on landing, and the biped position so it maintains balance
when the spine is rotated. When parameters change, dynamics cause the biped
to adapt.

Dynamics Blend
A parameter in the Body section of the Key Info rollout on page 4367, used with
freeform animation on page 7988. Blends between biped and spline dynamics.
Select the Body Vertical track (the vertical track of the biped's center of mass),
and use Dynamics Blend to control the amount of gravity in an airborne
period, such as in a running or jumping gait. Dynamics Blend has no effect
on a walking motion where footsteps overlap.
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Ease Curve
Ease curves vary the timing of a function curve. An unaltered function curve
charts the value of an animated parameter over time. An ease curve charts
changes to the timing of the function curve. Changing ease curve values shifts
the time of the original track left or right.

The horizontal scale of an ease curve represents normal time, just as it does
for all function curves. The vertical scale of an ease curve represents the time
scale of the function curve the ease curve is applied to. Changing the shape
of an ease curve changes the way time is interpreted by the affected function
curve.

The value of the ease curve at a particular frame is a frame value from the
original track. For example, if the ease curve is 0 at frame 0 and 10 at frame
10, the original track plays at its original speed. If the ease curve value at frame
10 increases to 20, the original track plays to frame 20 by frame 10: it has been
sped up by a factor of two.

An Ease Curve Example

Imagine you have animated a bird flying around the sky. After viewing the
animation you decide that you want to change the position of the bird so it
moves quickly at the beginning of the animation and then slows to a leisurely
pace toward the end.

You could accomplish this change by editing position keys, ranges, and
function curves but it would require more work than using an Ease curve.
Applying an Ease curve to the Position track provides a quick and easy solution.

Dragging the Ease curve causes time to compress near the beginning of the
animation and stretch out near the end. You can tell that the bird's motion
starts out fast and then slows down by looking at the effect the Ease curve has
on the Position function curves.

See also:

■ Multiplier Curve on page 8056
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Edge
An edge is a straight or curved line that connects two vertices in a mesh object
or spline. You can modify object shapes by transforming its edges; in effect,
by doing so you're moving two vertices simultaneously.

Editable Mesh
An editable mesh on page 2075 is a type of deformable object. An editable mesh
is a trimesh: that is, it uses triangular polygons. Editable meshes are useful for
creating simple, low-polygonal objects or control meshes for MeshSmooth
and HSDS modelling. You can convert a NURBS or patch surface to an editable
mesh. Editable meshes require little memory, and are a natural method of
modeling with polygonal objects.

An actively linked object cannot be collapsed to an editable mesh. Using the
File Link Manager on page 6987, you have to Bind the object first.

Editable Poly
An editable poly on page 2123 is a type of deformable object. An editable poly
is a polygonal mesh; that is, unlike an editable mesh, it uses more than
three-sided polygons. Editable polys are useful in that they avoid invisible
edges. For example, if you use a cut-and-slice operation with editable polys,
the program doesn't insert extra vertices along any invisible edge. You can
convert NURBS surfaces, editable meshes, splines, primitives, and patch surfaces
to editable polys.
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Element

The antler is one element of the moose head.

An element is one of two or more individual mesh objects (that is, groups of
contiguous faces) grouped together into one larger object. For example, if you
attach one box to another, you create one mesh object from the two boxes.
Each box is now an element of the object. Any function you perform on that
object affects all its elements. However, you can manipulate the elements
independently at the Element sub-object level.

Emitter
An emitter is an object that emits particles; particles are born, or first enter
the scene, at the emitter's location. By default, Particle Flow uses the source
icon on page 2829 as an emitter, but alternatively any other object in the scene
can emit particles using the Position Object operator on page 2853.
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End Effector
In history-dependent inverse kinematics (HD IK) on page 3422, the end effector
is the pivot point of the selected child object at the end of a kinematic chain.

The kinematic chain is a single branch of a hierarchy used for animation with
inverse kinematics (IK) on page 8016. The chain starts with the selected child
object and travels up through ancestors until it reaches the start of the chain.
When you move the end effector, the HD IK solver then uses IK calculations
to move and rotate all other objects in the kinematic chain to react to the
object you moved.

The end effector has two transforms: one that connects it to its parent, and
another that connects it to the End Effector Parent. By default, the End Effector
Parent is none (equivalent to World); you can assign this in the Motion panel.

NOTE You can move the end effector away from the child object, which causes
the IK chain to straighten out. When you move the end effector back toward the
child object, joints in the IK chain will bend again.

See also:

■ IK Goal on page 8008

Envelopes
In Physique on page 4603, the envelope is the primary tool for controlling skin
deformation. An envelope defines an area of influence about a single link in
the hierarchy. If the envelope is deformable on page 7948, mesh vertices within
that envelope follow the movement of the Physique deformation spline on
page 7949. An envelope has a pair of inner and outer bounds; the envelope's
influence is strongest at the inner bound, and falls off toward the outer bound.
By default, each envelope has four cross sections. You can reshape the cross
sections, or add new ones, to change the envelope's geometry.

In the Skin modifier on page 1672, the envelope plays a similar role with respect
to bones. Each bone has its own envelope with two or more cross-sections
that allow you to shape the envelope to fit the surrounding mesh.

Typically, the envelopes of adjacent links or bones overlap each other. Vertices
that fall in the overlap area are weighted to produce smooth blending at joint
intersections.
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Environment Map

Above: Image uses a picture in screen coordinates as a background.

Below: Image shows spherical mapping coordinates applied using a checker map.

Texture coordinates lock a map to geometry. Environment coordinates, on
the other hand, lock a map to the world. If you move the object, the map
remains in place. If you move the view (or camera), the map changes. This

7964 | Glossary



type of mapping system is used with reflection, refraction, and environment
maps.

There are four types of environment coordinates:

■ Spherical

■ Cylindrical

■ Shrink-Wrap

■ Screen

The first three are the same as those used by the UVW Map modifier on page
1931. If you imagine a sphere, infinite in size, surrounding your scene and
mapped with spherical mapping coordinates, you can visualize the effect you
get with spherical environment mapping. Shrink-wrap wraps the map around
a giant sphere, leaving only one singularity. Cylindrical is like a giant cylinder.

The Screen system maps the image directly to the view, with no distortion.
It's similar to planar, in that it's like a giant backdrop hung in the scene. Unlike
the other environment mapping methods, Screen is locked to the view. When
you move the camera, the map moves with it. Therefore, you can only use it
for still renderings, or animations in which the camera doesn't move.

To use a bitmap with any environmental mapping system other than Screen,
you need a high-resolution map because of the size of the virtual sphere, or
cylinder.

An environment map is not assigned in the Material Editor, because it's not
applied to the geometry of an object, but rather to the scene itself.
Environment maps appear in the background, as seen from the camera or
perspective view.

When you assign a map to the environment, it's the same as if you'd assigned
a mapped material to an object in your scene. To edit or adjust the assigned
map, you need to place it in one of the sample slots in the Material Editor.
You can do that in one of two ways:

■ Click the Get Material button in the Material Editor, and then get the map
from the scene.

■ Put the map from the Environment dialog to one of the sample slots in
the Material Editor. You can do this by dragging and dropping from the
Environment dialog map button to the sample slot.

Glossary | 7965



NOTE To control whether or not the renderer uses the environment map's alpha
channel in creating the alpha for the rendered image, choose Customize >
Preferences > Rendering, and then turn on Use Environment Alpha in the
Background Antialiasing group. If Use Environment Alpha is turned off (the default)
the background receives an alpha of 0 (completely transparent). If Use Environment
Alpha is turned on, the alpha of the resulting image is a combination of the scene
and background image's alpha. Also, when writing TGA files with Pre-Multiplied
Alpha set to off, turning on Use Environment Alpha prevents incorrect results.
Note that only background images with alpha channels or black backgrounds are
supported when compositing in other programs such as Photoshop.

Event
The event is the basic unit of organization in a Particle Flow particle diagram
on page 8081. There are two types of events: global on page 7997 and local on
page 8027. A birth event on page 7924 is a specialized type of local event.
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1. Global event

2. Birth event

3. Local event

Each event contains one or more actions on page 7897, which can affect particle
behavior or appearance. You can use tests on page 8147 to send particles to other
events if the particles meet certain qualifications. A single chain of linked
events as shown in Particle View on page 2811 is known as a flow on page 7983.
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Event Display
The event display, the main window in the Particle View on page 2811 dialog,
contains the particle diagram on page 8081. This is where you build and edit
the particle system.
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Event Level
In Particle Flow, you can select particles at the Event level or at the Particle
level on page 8082, using controls on the Modify panel > Selection rollout on
page 2833. An Event-level selection can be passed to the Particle level for
processing by the particle system by means of the Selection rollout > Get From
Event Level command.

Extents

Bounding box shows the extents of the model boat.

An object's extents are its maximum dimensions in X, Y, and Z. These are the
dimensions of the rectangular bounding box on page 7932 that surrounds the
object.

Glossary | 7969



Face/Polygon
When you render a scene containing geometry, 3ds Max uses the faces and
polygons in a mesh object on page 8043 to draw the object surfaces. Essentially,
faces and polygons are planar objects that fill in the gaps between edges in
the object structure. A face typically has three sides; a polygon can have three
or more sides. You can treat a polygon as a single object while modeling, but
at render time, 3ds Max breaks down all polygons into triangular faces.

Faceted

Vase on the right uses a faceted material.

Faceted shading provides a constant shading across each facet, or co-planar
surface of the object. The result has the appearance of so-called "flat" shading,
except that it provides specular highlights.

Turn on Faceted to provide a faceted look to your geometry without having
to explicitly change the smoothing groups in the object with the Edit Mesh
modifier.
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Both Standard on page 5395 and Raytrace on page 5490 materials provide a Faceted
toggle.

FFD
FFD stands for free-form deformation. It is used in computer animation for effects
like dancing cars and gas tanks. You can use it as well for modeling rounded
shapes such as chairs and sculpture.

An FFD modifier on page 1454 surrounds the selected geometry with a lattice
box or cylinder. By adjusting the control points of the lattice, you deform the
enclosed geometry.

NOTE You can use Physique on page 4603 to control an FFD space warp. Physique
actually deforms the space warp's control points, which in turn deform the model.

FGM File
An FGM file (.fgm) is a final gather map file. It is used by the mental ray
renderer on page 6230 to save the results of a final gathering pass. Generating
and saving an FGM file can speed up subsequent renderings.
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Field of View

Above: Narrow field of view

Below: Wide field of view

Field of View defines the width of your view as an angle with its apex at your
viewpoint and the ends at the sides of the view. The effect of changing FOV
is similar to changing the lens on a camera. As the FOV gets larger you see
more of your scene and the perspective becomes distorted, similar to using a
wide-angle lens. As the FOV gets smaller you see less of your scene and the
perspective flattens, similar to using a telephoto lens.

A Perspective view uses an imaginary camera with only one setting, FOV. The
FOV angle for the active Perspective view is displayed in the Rendering
Methods panel of the Viewport Configuration dialog. You can type a value
in the FOV field of the dialog to precisely set FOV for the active Perspective
view.

Use Field of View (FOV) to change the amount of the scene visible and the
amount of perspective flare applied to a Perspective or Camera view. The Field
of View button appears in the viewport navigation control panel when a
Perspective or Camera view is active.
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Fields

Two fields combine to make a single frame.

Your animations might ultimately be viewed on television monitors. Standard
video signals display animation by breaking it down within time segments
(frames). The image for each frame is split into horizontal lines (scan lines).
A special method for conveying frame information on a video signal has been
developed. This method is called field interlacing. Television monitors display
a video signal by separately scanning two portions of each frame called fields.
One field contains the odd scan lines of a frame, the other field contains the
even scan lines. Television monitors scan and display the fields of each frame
separately. The fields are alternately cycled through every other horizontal
line on the screen so that they "layer" together to form a single interlaced
image.

Render to Fields

On the Render Setup dialog, in the Common Parameters rollout on page 6121
> Options group, the Render To Fields check box sets whether the renderer
renders full frames at the specified frame rate, or renders fields at twice that
rate. When Render To Fields is on, the renderer renders an extra sub-frame
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image between every two frames, and composites each frame and the following
sub-frame into a single image with two fields. The result is a 60
fields-per-second animation suitable for play on an NTSC on page 8059 television
monitor.

Field Order

When you render to fields, you also specify a field order to identify which
field comes first. The Field Order configuration setting is found in Preferences,
on the Rendering page. A frame's scan lines are numbered and each field
contains either the odd or even scan lines. The video source (for example,
broadcast transmitter, video tape recorder, or digital video recorder) determines
which group of scan lines is in each field and which group is delivered to the
display first. The fields are referred to as Field 1 (F1) and Field 2 (F2); either
could contain the odd numbered (1st, 3rd, 5th, and so on) scan lines or the
even numbered (2nd, 4th, 6th, and so on) scan lines in the frame.

Using the default setting of Odd as your Field Order preference, the software
renders the first field image (F1) to the odd scan lines. If the field order
preference is set to Even, then the first field image is rendered to the even
scan lines. For an image to display properly, the field order and the video
device field order must match.

Some video systems require odd lines to be rendered first, and others require
the even lines to be recorded first. The Field Order parameter is set to Odd by
default. If you observe incorrect strobing in your video output, change the
parameter to Even.

Figure Mode
When you work with a biped on page 4147, you use Figure mode on page 4420 to
fit the biped to the mesh or mesh objects on page 8043 that represent your
character. You should have Figure mode turned on when you attach the mesh
to the biped with Physique on page 4603. Figure mode is also used to scale a
biped that has a mesh attached to it, to make biped "fit" adjustments after
Physique is applied, and to correct posture for motion files that need a global
posture change.

When Figure mode is turned on, the biped jumps from its animated position
to its Figure mode pose. Animation is preserved when you exit Figure mode.

The parameters on the Structure rollout on page 4424 are active only in Figure
mode, and at creation time.
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Fillet

NURBS fillet curves

A dependent NURBS object that is an arc connecting two curves. It is controlled
by the objects it connects, and by a radius parameter.
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Filter Color / Filter Opacity

Sphere on the right has a light green opacity filter color.

Filter opacity tints the colors behind the material using a specified transmission
color.

Filter opacity is the default system, because it provides a more realistic
transparency effect. When the Filter option is set in the Extended Parameters
rollout, the color used by the Filter Color swatch tints the transparency of the
material.

In life, a transparent material, such as colored glass, affects the colors behind
it not by the diffuse or ambient colors (which are reflected colors), but by the
transmission color.

The transmission color is that property of a substance that filters certain colors,
and allows others to pass. For example, a sheet of red cellophane is a filter
that blocks all light not in the red wavelength of the spectrum. By using filter
opacity, you can specify a transmission color and achieve strong, saturated
colors, no matter how transparent the material.
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Filtering (Antialiasing)
Filtering is a technique of antialiasing the bitmaps in mapped materials by
averaging pixels. The Pyramidal and Summed Area options provide two
methods of pixel averaging. Only one can be active at a time.

Both methods require approximately the same rendering time. Summed-area
filtering generally yields superior results but requires much more memory.
Pyramidal filtering requires the program to allocate memory equal to
approximately 133% of the size of the bitmap. By comparison, summed-area
filtering requires the program to allocate approximately 400% of the size of
the bitmap.

Use summed-area filtering only for smaller bitmaps, and avoid using any more
such bitmaps in a scene than necessary.

Pyramidal filtering is quite adequate for most purposes. However, because it
applies filtering as a function of distance, irregular antialiasing might occur
on detailed texture maps that are applied to a plane receding into the distance.
The effect of pyramidal filtering on extreme perspectives such as this is even
more noticeable in animations, where portions of the texture map appear to
"swim." If this occurs, turn on summed-area filtering for the material.

NOTE To control whether or not a background image is affected by the renderer's
antialiasing filter, choose Customize > Preferences > Rendering on page 7768 and
then turn on Filter Background in the Background Antialiasing group.

Filtering (Character Animation)
Filtering is the action of using selected data, rather than all data.

In the Motion Mixer on page 3699, you use the trackgroup on page 8151 filter to
select the biped parts that will be affected by motion clips and transitions on
tracks within the trackgroup. See Filtering Mixer Tracks on page 3715.

Filtering is also a motion-capture technique on page 4574. Motion-capture and
marker data typically have keys at every frame. Filtering motion-capture data
reduces the number of keys, making the job of altering or personalizing the
motion data simpler. Other filtering options include footstep extraction,
applying the skeletal structure stored in the motion-capture file to the biped,
looping the data, importing a portion of the motion capture file, and selecting
tracks to load. See Filtering Motion-Capture and Marker Data on page 4577.
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Final Gathering (mental ray Renderer)
Final gathering is an optional, additional step to calculating global illumination
on page 6261. Using a photon map to calculate global illumination can cause
rendering artifacts such as dark corners and low-frequency variations in the
lighting. You can reduce or eliminate these artifacts by turning on final
gathering, which increases the number of rays used to calculate global
illumination.

Scene rendered with global illumination but no final gather
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Same scene with final gather used to smooth the global illumination
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Same scene with final gather but no global illumination, for comparison

Final gathering can greatly increase rendering time. It is most useful for scenes
with overall diffuse lighting, less useful for scenes with bright spots of indirect
illumination such as focused caustics.

You turn on final gathering on the Render Setup dialog > Indirect Illumination
panel > Final Gather rollout on page 6295.
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First Vertex

First vertex of a spline

When you create a spline object, the software numbers the vertices from 1 to
the total number of vertices in the spline, according to the order of creation.
When the spline is displayed in viewports, the first vertex has a box around
it.

The first vertex is commonly used as an alignment marker when you place
two or more shapes on different path levels when lofting. If you place different
shapes on different path levels and you don't align their first vertices, the
resulting mesh object is twisted.

To avoid twisting, you can align the first vertices by rotating the splines as
necessary. Alternatively, you can change the position of a spline's first vertex
by using the Make First button in the Edit Spline modifier (at the Vertex
sub-object level).
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Flat Mirror

Flat mirror map reflects the ice-cream shop's interior.

If you want to create a flat, mirrored surface in a scene, such as a highly
polished floor, you must use a flat mirror reflection map.

Flat mirror reflection maps must be assigned to your geometry in a specific
way, and work only on flat surfaces.

When you use flat-mirror reflection maps, keep the following in mind:

The flat-mirror material must be assigned to connected, coplanar faces on a
flat surface of the object. If your flat-mirror reflection doesn't work, it's probably
because non-coplanar faces have been assigned the flat-mirror material. This
can happen during the selection process, if one or more non-coplanar faces
are included in the selection set. It can also happen if you've already assigned
the same material elsewhere on the object (coplanar faces are two or more
adjacent faces that are on the same two-dimensional plane, such as the surface
of a floor).

If you want to reflect in multiple planes of the same object, detach each plane
into a separate object before you assign the material.
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Flow
A particle system on page 8083 can contain any number of separate particle
flows. Each flow consists of an isolated chain or sequence of events on page
7966, as depicted in Particle View on page 2811. A flow typically contains a global
event on page 7997 and a birth event on page 7924, and any number of additional
local events on page 8027.

A particle system containing four separate flows
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Fluorescence

Glass on the right has a light green fluorescence.

Fluorescence is light emitted from an object when it absorbs radiation (for
example, ultraviolet light) from another source.

Raytrace materials have the ability to simulate fluorescence.
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Flyout

Example: Align flyout (main toolbar)

A flyout is an icon-based menu available from any button that has a small
black triangle in the lower-right corner. To access the flyout, click the button
and hold or drag a short distance. Then, to activate a flyout menu item, drag
to the item and release. As you drag, you can see each item's name on the
prompt line of the status bar on page 7524.

Follow Object
You can bind an object in your hierarchy to any other object (often an object
not in the same hierarchy). This other object is called the follow object.

The bound object tries to match the position and orientation of its pivot point
to the position and orientation of the follow object's pivot point.

For example, you might want to animate a figure that always points to another
object. Bind the hand of the figure to the other object. Turn IK on and as you
move the object the hand and arm of the figure move to point at it.
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Foot States
The biped feet can be in one of four states: plant, lift, move, and touch:

■ Plant The biped foot state in full contact with the footstep.

■ Lift The biped foot state just before leaving a footstep.

■ Move The biped foot state between footsteps; an airborne period.

■ Touch The biped foot state at which a biped foot first contacts a footstep.

Footstep Animation
Biped's patented footstep-driven keyframe animation feature allows animators
to use footsteps to create broad, global brush strokes for character movement.
Once footsteps are in place, keyframes are generated automatically to produce
an initial sketch of the 3D character's motion. Throughout edits and revisions,
the original nuances of the character are preserved; Biped remembers
everything about how a character moves, and it makes all of the appropriate
adjustments if the footsteps are changed.

Footsteps Method
Footsteps provide a way to animate a biped on page 4147. In viewports, footsteps
represent support periods in space for the biped's feet. Moving or rotating
footsteps in space is done in the viewports. The footstep position and
orientation in the viewport controls where the biped will step.

In Track View — Dope Sheet, each footstep appears as a block that represents
a support period in time for each of the biped's feet. Moving footsteps in time
is done in Track View — Dope Sheet.

TIP  To see the footsteps, you must turn on Edit Keys in the Dope Sheet.

There are three ways to create footsteps for the biped. The first way is to place
footsteps individually, one at a time. The second way is to invoke Biped's
multiple footstep creation tools to create a walk, run, or jump animation. The
third way is to extract footsteps from raw motion-capture data.
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A big advantage of the footstep method is the natural adaptation of the biped
that occurs when the footsteps are edited in time and space. Also, you can
reposition all of the footsteps to move the entire animation.

Forward Kinematics
The default method of manipulating a hierarchy uses a technique called
“forward kinematics”. The basic principles employed by this technique are:

■ Hierarchical linking from parent to child

■ Placement of pivot points to define the connecting joint between linked
objects

■ Inheritance of position, rotation, and scale transforms from parent to child

In forward kinematics, when a parent object moves, its children must follow.
If the child wants to go off on its own, the parent remains behind. For example,
in a hierarchical linkage of a human figure, when the torso (the parent) bends
over, the head (the child) moves along with it, but you can turn the head
without affecting the torso.

Forward Kinematics (Bipeds)
Using an arm to move a hand is an example of forward kinematics. Using the
hand to move the arm is an example of inverse kinematics on page 8016. When
you use freeform animation on page 7988 to animate a biped on page 4147, you
can use both kinds of kinematics.

By planting a hand or foot, you use another object (object space) or the world
(world space) to control IK motion. In this method, the IK Blend parameter
in the Key Info rollout on page 4367 determines how forward kinematics and
inverse kinematics are blended to interpolate intermediate positions.

Frame Rate
The frame rate of an animation is generally expressed in frames per second
(fps). This is the number of frames displayed for every second of real time.

Different recording devices output different frame rates, but the standard rates
are as follows:

Glossary | 7987



Film 24 frames per second

You can change the frame rate for your output at any time, outputting the
correct number of frames to maintain the correct playback speed for your
animation.

For example, if you create a 90-frame animation for video, using an NTSC
frame rate of 30 frames per second, the result will be three seconds of
animation.

If you later discover you need to output to PAL video (at 25 frames per second),
you can switch to the PAL frame rate. The 90 frames are automatically
converted to 75, producing the same total animation time with a different
number of frames. You can later switch back to NTSC frame rate to restore
the original 90 frames of animation.

You can switch back and forth between frame rates at any time without losing
animation data.

NTSC video 30 frames per second

PAL video 25 frames per second

Freeform Animation
character studio gives you the option to animate biped on page 4147 poses both
with and without the aid of footsteps. Freeform animation does not use
footsteps. In freeform animation, you set all the keys yourself.

Freeform Method
In freeform mode (without footsteps), you can pose every joint of your biped
on page 4147 exactly as you like using traditional keyframe methods. You can
even blend dynamically between forward kinematics and inverse kinematics
on page 8016 to introduce higher-level control in just the cases you need it to
simulate your character's particular motion.
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Freeze/Unfreeze

On the right, the trash can and streetlight are frozen.

You can freeze any selection of objects in your scene. By default, frozen objects,
whether wireframe or rendered, turn a dark gray. They remain on screen, but
can't be selected, and therefore can't be directly transformed or modified.
Freezing lets you protect objects from accidental editing and speeds up redraws.

Frozen objects are similar to hidden objects. Linked, instanced, and referenced
objects behave when frozen just as they would if unfrozen. Frozen lights and
cameras and any associated viewports continue to work as they normally do.

You can choose to have frozen objects retain their usual color or texture in
viewports. Use the Show Frozen In Gray toggle in the Object Properties dialog
on page 305.
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Function Curve
Function curves are editable splines that represent animation values in a
line-graph format. They provide a valuable way of both visualizing and editing
your animation tracks.

Function curves appear in the Track View, and provide the best method of
viewing and editing animation tracks. With the function curve display, you
can actually see the characteristics of the animation as they change over time.
The steepness of the curve indicates the velocity of an object in the scene. If
the curve steepens, the object is accelerating. If the curve flattens out, the
object is slowing.

You can display key dots in function curves, as well as in the key editing
displays. In function curves, the key dots appear as small, black squares. The
two ways to turn on their display are to click the green icon beside the track
label, or to click the function curve itself.

There are two basic ways to edit function curves. You can either change the
position of the key dots, thereby altering the curve, or you can edit the tangents
and the values of the keys themselves.

Fusing
In NURBS curves and surfaces, fusing connects a point to a point or a CV to
a CV. (You can't fuse a CV to a point, or vice versa.) This is one way to connect
two curves or surfaces. It is also a way to change the shape of curves and
surfaces.

Fused points behave as a single point or CV until you unfuse them. Fusing
points does not combine the two point objects or CV sub-objects. They are
connected but remain distinct sub-objects that you can unfuse later.

Fused CVs behave much like a single point, but the property of multiplicity
for coincident CVs also applies. The fused CVs have proportionally more
influence on the curve, which can become more sharply curved in the fused
CVs' vicinity, or even angular if more than two CVs are fused together.

FX File
An FX file defines a DirectX 9 (DX9) shader. It is a text file created using the
Higher-Level Shading Language (HLSL) standard. The DirectX 9 Shader material
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on page 5758 can apply DX9 shaders to objects, and display them with DX9
shading in viewports.

By default, DX9 shaders are saved in \maps\fx\ in the 3ds Max program
directory.

IMPORTANT For a DX9 shader's parameter to be visible in the DirectX 9 Shader
material's interface, the FX file must contain code to label the parameter, define
its type, and (optionally) limit its range. (A few other UI settings are also provided.)
You can find examples of files that contain this code in the above directory.

NOTE The following Web page provides a specification for the DirectX 9 Shader
material 3ds Max:
http://sparks.discreet.com/knowledgebase/techdocs/searchable/techdoc_DXMaterialFormat/DxMaterial_Effect_format.htm.

G-Buffer
G-Buffer (graphics buffer) is a type of rendering channel. Two file formats
output by 3ds Max, RLA on page 7364 and RPF on page 7366, can incorporate
masks that are based on graphics buffer (G-Buffer) channels instead of the
more widely used RGB and alpha channels. In addition, some kinds of Filter
and Layer events as well as certain rendering effects on page 6583 can post-process
objects or materials designated by the G-Buffer.
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Main image: G-buffer used to apply a glow to lighting in a scene

Upper left: The same scene with no glow applied

Middle left: Objects selected using the G-buffer

Lower left: Glow applied to the G-buffer objects

You can set two kinds of these channels in the scene to identify and group
objects or materials for a particular post-processing effect.

■ You set an object's value (see Object Properties Dialog on page 305) to
identify that object to receive a particular rendering or post-processing
effect or file mask.

■ You set a material's Material Effects Channel on page 5348 value to identify
that material to receive a particular post-processing effect.

You create object-specific or material-specific post-processing by following
this general procedure:

1 Assign a particular Object Channel ID or Material Effects Channel ID to
the objects or the materials you want to be post-processed or affected by
rendering effects.

7992 | Glossary



2 In the Image Filter or Image Layer event or in each rendering effect's
Options tab, choose the channel ID that associates the event with the ID
value you assigned in the scene.

3 When you render the scene or execute the Video Post queue, 3ds Max
singles out objects or materials that have the designated ID, and performs
its post-processing only on those objects or materials.

WARNING The mental ray renderer on page 6230 does not recognize Z-depth with
G-buffers. G-buffer data is saved on a single layer. Also, the mental ray renderer
does not support the following effects:

■ Glow lens effect on page 6599 (rendering effect)

■ Ring lens effect on page 6606 (rendering effect)

■ Lens effects Focus filter on page 6871 (Video Post)

Gait Pattern
In footstep animation on page 7986, the pattern created by a gait: walk, run, or
jump. When you create new footsteps, the timing for the footsteps is
determined by the gait you have chosen and the parameters for that gait. Gait
parameters are on the Motion panel in the Footstep Creation rollout on page
4434.

Gait Type
In footstep animation on page 7986, character studio can create three types of
gaits; walk, run, or jump.

■ In a walk, at least one foot is always in contact with the ground. The periods
when one or both feet are in contact with the ground are known as support
periods.

■ In running, there is a period between each support period in which the
body is airborne.

■ Jumping is a special case of running. Both feet are in contact with the
ground at the same time, or airborne at the same time.
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Gamma Correction
Gamma correction compensates for the differences in color display on different
output devices so that images look the same when viewed on different
monitors.

A gamma value of 1 corresponds to an "ideal" monitor; that is, one that has
a perfectly linear progression from white through gray to black.

Gamma = 1.0: no correction

I stands for Intensity.

However, the ideal display device doesn't exist. Computer monitors are
"nonlinear" devices. The higher the gamma value is set, the greater the degree
of nonlinearity. The standard gamma value for NTSC video is 2.2. For computer
monitors, gamma values in the range of 1.5 to 2.0 are common.
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Left: gamma = 1.8

Right: gamma = 2.2, the standard for video

The horizontal axis represents input (the original value) and the vertical axis represents
output (the gamma-corrected value).

Computer monitors and videos don’t display color in a linear way (as in the
first illustration). Also, the brightness of a monitor tends to make an image
seem brighter than its intensity values really specify. Gamma correction fixes
this problem, and can ensure consistency between different applications or
different monitors. When you set gamma, find a value that makes middle
gray on your own monitor match a true middle (50 percent) gray.

For more information, see Gamma and LUT Preferences on page 7758.

Geometric Primitives
Simple primitive objects such as, spheres, boxes, cylinders, and so on.
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Gizmo/Center

Examples of gizmos:

Left: Gizmo for a Bend modifier

Right: Gizmo for UVW mapping

A gizmo is geometry that appears in viewports, but not in the scene. You
manipulate a gizmo to modify the scene geometry or other effects. There are
gizmos for transforms, modifiers, atmospheric apparatus, and some directly
modifiable geometry such as spotlight cones.

For modifiers, a gizmo acts like a kind of container that transfers the
modification to the object to which it's attached. You can move, scale, and
rotate the gizmo as you would any object, altering the effect of the modifier
on the object.

With bipeds on page 4130, the footsteps in footstep animation on page 7986 are
gizmos that let you edit the position of the biped's feet over time. Physique
on page 4603 uses gizmos to visually identify bulge angles.

Some modifiers with gizmos also have a Center sub-object, which can be
manipulated independently of the gizmo to specify the point about which
the deformation, etc., takes place. For example, moving the Bend modifier
center parallel to the plane of the bend effect changes the size of the bend
circle and the location of the modified object within the bend circle.
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Global Event
The first event on page 7966 in a particle flow on page 7983 is always a global
event, whose contents affect all particles in the flow; the rest are local events
on page 8027. Although a global event has the same name as the Particle Flow
source icon, selecting the source icon in a viewport doesn't highlight the global
event, nor does highlighting a global event select the corresponding source
icon.
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Global event (highlighted)

By default, the global event contains a single Render operator on page 2951 that
specifies rendering properties for all particles in the flow. You can add other
operators here to have them act globally, such as Material, Display, and Speed.
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NOTE A global event is the only event that can be wired to another event without
using a test on page 8147. It's almost always wired directly to a birth event on page
7924.

IMPORTANT When you use an operator globally, be sure not to use the same
operator locally (that is, in any other events in the system) to avoid potential
conflicts.

Global Motion Clip Controller
In crowd animation on page 4761, a controller that contains the animation
necessary to animate a non-bipedal crowd of objects. It consists of a list of
motion clips and the logic needed to instance and blend these motion clips
for a crowd animation. The Global Motion Clip Controller is accessed via the
Crowd helper object on page 4819.

Glossiness and Specular Level Settings

Extremes of the Glossiness and Specular Level settings (Phong shader):

Top sphere: Glossiness=100; Specular Level=100

Left sphere: Glossiness=50; Specular Level=50

Right sphere: Glossiness=0; Specular Level=0

A material's glossiness (or dullness) depends on the size and intensity of its
specular highlight. In the Material Editor, the Glossiness spinner affects the
size of the specular area, and the Specular Level spinner affects the intensity
of the glossiness.
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When the Specular Level is too high, and Glossiness is too low, you can get
harsh backlights on your surfaces. The Soften option mitigates this.

GravAccel
In footstep animation on page 7986, the GravAccel (for gravitational acceleration)
parameter lets you scale the height of airborne periods. The greater this value,
the greater the height. If the biped appears to be going too high, reduce this
value; if the biped goes too low, increase it. Each biped has its own
Gravitational Acceleration value. The default is based on the height of the
biped.

For example, if the active unit on page 7809 is feet and the biped is 5 feet 10
inches tall, then Gravitational Acceleration equals 32, for 32 ft. per second
per second. For other biped heights, 3ds Max scales this value to fit the scene.
The Gravitational Acceleration value also changes to agree with other unit
systems, such as metric.

GravAccel is located on the Dynamics & Adaptation rollout on page 4417.

Gravity
In footstep animation on page 7986, character studio calculates the effect of
gravity for those periods when a biped on page 4147 is airborne (a biped becomes
airborne when it moves with a running or jumping gait). You can use the
GravAccel on page 8000 setting to scale the effect of gravity.
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Grid Object

One grid establishes the pitch of the boat, another the pitch of the ship.

A grid object is a type of helper object you can create whenever you need a
local reference grid or construction plane somewhere other than the home
grid.

You can have any number of grid objects in your scene, but only one can be
active at a time. When active, a grid object replaces the home grid in all
viewports.

You can freely move and rotate grid objects, placing them at any angle in
space, or attach them to objects and surfaces. You can also change viewports
to display a plan or top view of any active grid object.

Grid objects can be named and saved like other objects, or used once and
deleted.
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Head Object
A head object is a component of a Target Camera, Sunlight or Daylight system,
or a Tape helper. These objects comprise two components: the target that the
camera, sun, or tape points at, and the head that represents the camera, sun,
or tape. The head object always points at the center of the target.

Helper Object
3ds Max helper objects are used to help you set up an animation, but do not
render. Crowd animation on page 4761 uses two kinds of specialized helper
objects: crowd on page 4819 and delegate on page 4811.

Hide/Unhide
You can hide any objects in your scene and you have the option to hide any
selection of objects or to hide anything except your current selection of objects.
Hidden objects differ from frozen on page 7989 objects in that they disappear
from the viewport instead of turning dark gray. If you are working on a scene
that includes many objects or you have many objects in a very tight area,
hiding some of them gives you more access to the unhidden objects and speeds
up redraws.

You can hide an object that includes a target (such as target cameras, tape
helpers, or suns) by choosing either the head on page 8002 or the target object
and then selecting hide.

Hide and Unhide are accessible from the Display panel or from the Display
quadrant of the Quad Menus.

Hierarchical Linkage
3ds Max uses a family-tree analogy to describe the relationship between objects
linked together in a hierarchy.

Ancestors The parent and all of the parent's parents of a child object.

Branch A path through the hierarchy from a parent to a single descendent.
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Child An object controlled by its parent. A child object can also be a parent
to other children. An object that doesn't have any parent is by default a child
of the world. (The "world" is an imaginary object that acts as the root of all
other objects in the scene.)

Descendents The children and all of the children's children of a parent object.

Hierarchy The collection of all parents and children linked together in a
single structure.

Leaf A child object that has no children of its own. The lowest object in a
branch.

Link The invisible connection between a parent and its child. The link is a
conduit for transmitting position, rotation, and scale information from parent
to child.

Parent An object that controls one or more children. A parent object is often
controlled by another superior parent object.

Pivot Defines the local center and coordinate system for each object. You can
think of links as connecting the pivot of a child object to the pivot of its
parent.

Root The single parent object that is superior to all other objects in the
hierarchy. All other objects are descendents of the root object.

Subtree All of the descendents of a selected parent.
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Home Grid

Using the home grid to position houses

Grids are two-dimensional arrays of lines similar to graph paper, except that
you can adjust the spacing and other features of the grid to the needs of your
work.

Grids have these primary uses:

■ As an aid in visualizing space, scale, and distance

■ As a construction plane where you create and align objects in your scene

■ As a reference system for using snap

The home grid is the basic reference system, defined by three fixed planes on
the world coordinate axes. The home grid is visible by default when you start
the software, but can be turned off with an option in the right-click viewport
menu. You can use any view of the home grid as a construction plane or you
can create a grid object on page 8001 and use that as a construction plane instead.
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Horizon

Horizon in the distance of a scene

The horizon of a scene is the edge of vision at the height of the camera, parallel
with the world coordinate plane. You can view the horizon in camera
viewports.

A camera is level when it and its target are the same height from the world
coordinate plane. In other words, the camera's local Z axis is parallel to the
world plane. When the camera is level, the horizon line is centered in the
viewport. As the camera tilts up, the horizon line lowers; as it tilts down, the
horizon line raises.

The horizon line can help you match the perspective of your scene to the
perspective of a still image. In general, matching perspective involves the
following steps:

■ Display the horizon line. Use it to help you adjust the camera and target
so they are level.

■ Display the image in the camera viewport. Use Views menu > Background
Image.
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■ Display the image in the camera viewport. Use Views menu > Viewport
Background.

■ Orbit the camera until the perspective of the scene roughly matches that
of the still image.

■ Adjust the camera's perspective to fine-tune the perspective match.

■ Move the camera or target to position the scene against the background.

If you raise or lower the camera, raise or lower the target by an equal amount,
in order to keep them level and maintain the horizon.

Hot

A hot material is one that is instanced in both the scene and the Material
Editor. When you get a material from an object, that material is hot. Any
changes you make to the hot material are reflected in the scene wherever that
material is applied.

To edit a material without changing the scene, you can get the hot material
from an object, then make a copy of it. The term for the copied material is
cool on page 7943.

White triangular tabs in each corner of the Material Editor sample slots on
page 5304 show that the materials in those slots are hot.

In the Material Editor, the only time you need to select an object is when
you're assigning a material to an object. When you're adjusting a material,
object selection doesn't matter.
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Hotspot/Falloff

Hotspot and falloff cones, highlighted in red.

You've seen how a flashlight or a theater follow spot casts a circle of light.
Depending on the quality of the flashlight, or the adjustment of the follow
spot, the edge of the cast pool of light is either blurred or sharp.

In the case of a blurred pool of light, the bright circle in the center is the
hotspot, which has an even intensity. The outer extremity of the light, where
it meets the darkness, is the falloff. The difference in circumference between
the hotspot and the falloff determines the relative sharpness of the pool of
light. For example, if the hotspot and falloff are nearly the same size, the pool
of light has a sharp edge.

The hotspot angle of a spotlight must always be smaller than the falloff angle.
Put another way, the hotspot must always be inside the falloff.

You can hold down the Shift key to have the hotspot and falloff values affect
each other. If you increase the hotspot to be larger than the falloff, the falloff
is increased as well. Likewise, if you reduce the falloff to be smaller than the
hotspot, the hotspot is also reduced.

Glossary | 8007



IGES (Initial Graphics Exchange Specification)
The Initial Graphics Exchange Specification (IGES) is an ANSI standard that
defines a neutral form for the exchange of information among dissimilar
computer-aided design (CAD), computer-aided manufacturing (CAM) systems,
and computer visualization systems.

3ds Max implements the IGES standard for translating files to the software
from IGES file formats used by the mechanical engineering and entertainment
industries. Using the IGES import feature, you can read in native NURBS on
page 8060 data between 3ds Max and other programs such as Autodesk
Mechanical Desktop® (release 3.0 or later), Maya®, Pro/ENGINEER®,
SOFTIMAGE®, CATIA®, and others. For complete details on the IGES standard,
see The Initial Graphics Exchange Specification (IGES) Version 5.3.

IK Blend
In biped freeform animation on page 7988, the IK Blend parameter determines
how forward kinematics on page 7987 and inverse kinematics on page 8016 are
blended to interpolate an intermediate position. Using an arm to move a hand
is an example of forward kinematics. Using the hand to move the arm is an
example of inverse kinematics.

This parameter is located in the IK section of the Key Info rollout on page 4367.

IK Goal
In history-independent inverse kinematics (HI IK) on page 3392 and the IK Limb
Solver on page 3444, the IK goal is the object associated with the end joint of a
kinematic chain. By default, its name is IK Chain01.

The kinematic chain is a single branch of a hierarchy used for animation with
inverse kinematics (IK) on page 8016. The chain starts with the end joint and
travels up through ancestors until it reaches the start joint. When you move
the IK goal, the IK solver then uses IK calculations to move and rotate all other
objects in the kinematic chain to react to the object you moved.

NOTE You can move the IK goal away from the end joint, which causes the IK
chain to straighten out. When you move the goal back toward the end joint, joints
in the IK chain will bend again.
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See also:

■ End Effector on page 7963

IK Solution
Inverse kinematics (IK) uses a goal-directed method where the animator
positions a child object and the program calculates the position and orientation
of the parent objects. The final position of the hierarchy after all of the
calculations have been solved is referred to as the IK solution.

Applied IK requires that one or more parts of your IK structure be pinned to
animated follow objects. Once pinned, you select any object in your kinematic
chain and click the Apply IK button. The software then calculates the IK
solution for each frame of the animation and places transform keys for every
object in the IK chain.

Illuminance
Illuminance is the luminous flux on page 8029 incident on a surface of unit
area. It measures how much energy has fallen on a surface.

This quantity is useful for describing the level of illumination incident on a
surface without making the measurement dependent on the size of the surface
itself. The lux (lx) is the International System (SI) unit of illuminance. The
American System (AS) unit for illuminance is the footcandle (fc), equivalent
to 1 lumen per square foot. Illuminance is a function of the distance from the
light source. To specify the illuminance of a light, you must enter a value in
lx, and the distance at which that illuminance is measured.
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Image Motion Blur

Image motion blur has been applied to the falling coin on the right.

Motion blur can enhance the realism of a rendered animation by simulating
the way a real-world camera works. A camera has a shutter speed, and if
significant movement occurs during the time the shutter is open, the image
on film is blurred.

3ds Max provides a couple of ways to generate motion blur. Image motion
blur is one. Scene motion blur on page 8117, a Video Post Scene Event on page
6808 effect, is another. For most purposes, image motion blur gives better results
than scene motion blur. Scene motion blur is a more exaggerated effect. You
can use both image and scene motion blur in the same rendering.

You can also apply image motion blur as a render effect on page 6681.

(Another option, object motion blur on page 8063, is not meant to simulate a
camera, but to improve the rendered appearance of fast-moving objects.)
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Applying image motion blur is a two-step process:

1 Turn on image motion blur for the object you want to blur, using the
Object Properties dialog on page 305.

You cannot apply both image motion blur and object motion blur to the
same object in the same rendering.

2 Before you render, turn on image motion blur in the Default Scanline
Renderer rollout on page 6141 of the Render Setup dialog.

Tips and Limitations

Image motion blur smudges the object by creating a smearing effect, instead
of superimposing multiple images the way object motion blur does. It considers
camera movement. Image motion blur is applied after scanline rendering is
complete.

■ Because image motion blur is applied after rendering, it can't account for
object overlap. When blurred objects overlap, blurring doesn't work
correctly and there are gaps in the rendering. To fix this problem, render
each blurred object separately, to a different layer, and then composite the
two layers using the Alpha Compositor in Video Post or another
compositing tool.
The overlap problem also applies to objects behind an object rendered
with raytrace refraction.

■ Image motion blur doesn't work with objects that change topology. This
includes NURBS objects that are animated so their tessellation (surface
approximation on page 2554) changes. Regular tessellation doesn't change
in this way. This also includes Displacement mapping and Optimization.

■ Image motion blur can yield strange results with objects that have a
MeshSmooth modifier on page 1532 applied to them. If you see this
happening, turn of the MeshSmooth modifier's Keep Faces Convex toggle
(in the Settings rollout). This will fix the problem.

■ Image motion blur is not applied to reflections of objects. It is applied only
to actual geometry.
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In Place Mode 
When you play an animation of a biped character on page 4147 that travels,
you can use In Place mode to keep the biped visible in the viewports. Use this
for biped key editing, or adjusting envelopes with Physique on page 4603. In
Place mode prevents XY movement of the biped's center of mass during
playback; motion along the Z-axis is preserved.

This control is a three-button flyout: you can also restrict X movement without
restricting Y movement, or vice versa.

The state of In Place Mode is saved with the MAX file.

The In Place flyout is located on the expanded Biped rollout on page 4331.

Independent
Describes a NURBS object or sub-object that is not dependent on any other
object in a NURBS model. For example, a NURBS curve created using the Create
command panel does not depend on other objects.

Influence
An influence is the object that is required for the behavior or appearance of
another object to be correct. For example, take an “eye” object that should
follow the motion of a tennis ball in a match. One way to animate this is to
apply a LookAt Constraint on page 3312 to the eye, with the tennis ball as the
target. In this case the tennis ball is an influence of the eye, while the eye is
a dependent on page 7951 of the tennis ball.

See also:

■ Select Influences on page 7389 and Display Influences on page 7390 in the
Scene Explorer dialog

■ Select Influences on page 6959 in the XRef Merge dialog
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Initial Pose
When you apply Physique on page 4603 to a skeleton, the initial pose is the
original position of the mesh relative to the skeleton. Some of the Physique
sub-object levels on page 4716 have an Initial Skeleton Pose control that
temporarily puts the mesh into its initial pose.

Initialize
In Physique on page 4603, when you attach a mesh on page 8043 to a skeleton
such as a biped, the modifier is initialized. This process creates the links of
the deformation spline on page 7949, the envelopes on page 7963 around the links
to control the mesh, and so on.

Inputs: Event
In Particle Flow, you create a particle diagram on page 8081 by connecting events
on page 7966 using wires on page 8170. Each wire links an output on page 8075 with
an event input, which is the connector sticking up from the top of an event.
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Event inputs

Instance
An instance is an interchangeable clone of the original. You can instance
objects, modifiers, controllers, materials, and maps. Changing an attribute of
an instanced item also changes the same attribute of all instances.
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Object instances are not only alike in geometry, but also share modifiers,
materials and maps, and animation controllers. When you change one instance
by applying a modifier, for example, all the other instances change with it.

Each instance has its own set of transforms, object properties and space warp
bindings; these are not shared among instances.

Within the program, instances derive from the same master object. What
you're doing is applying a single modifier to a single master object. In the
viewport, what you see as multiple objects are multiple instances of the same
definition.

If you wanted to create a school of swimming fish, you might begin by making
many instanced copies of a single fish. You could then animate the swimming
motion by applying a ripple modifier to any fish in the school. The whole
school would swim with exactly the same motions.

Instance (Motion Mixer)
The term instance has two meanings in 3ds Max. One is the standard definition
on page 8014; the other is specific to clips in the Motion Mixer.

In general, an instance is a completely interchangeable clone of the original
object. Modifying an instanced object is the same as modifying the original.

In the Motion Mixer on page 8052, when the same clip is used more than once
on tracks, the clip versions are either instances or adaptations on page 7900 of
each other.

The same clip used more than once for one biped, or for different bipeds of
the same size, is an instance. The same clip used for different-sized bipeds is
an adaptation.

For example, suppose you scene contains two bipeds that are exactly the same
size, and you use the same clip in both bipeds' mixes. The clips within one
biped's mix are instances of one another, and clips within the mixes of the
two same-sized bipeds are also instances of one another. Instances have the
same number appended to the ends of their clip names in the Mixer.

Suppose you then add a third biped of a different size, and use the same clip
in that biped's mix. The new version of the clip is an adaptation of the clip
used on the first two bipeds. An incremental number is added to the end of
the clip name in the Mixer.

These terms are used because the Mixer adapts each loaded clip to the biped's
size. The first time a clip is loaded, the Mixer adapts the clip as needed, but
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no distinction is made between instances and adaptations at that point because
the clip appears only once .

When the clip is cloned or loaded again, the Mixer adapts the new clip to the
biped as needed, then compares the change to previously loaded versions. If
the change is the same, the new clip and its previous versions are instances
of one another. If not, the new clip and previous versions are adaptations of
one another.

Interactive Renderer
Another term for the Viewport Interactive Renderer on page 8164.

Interpolation
Interpolation is the calculation of intermediate values. For example, when
you set two keyframes for a moving object, the object's position on
intermediate frames is determined by interpolation.

Inverse Kinematics
Inverse kinematics (IK) is a positioning and animation method that is built
on top of the concepts of hierarchical linking. To understand how IK works
you must first understand the principles of hierarchical linking and forward
kinematics.

Inverse kinematics starts with linking and pivot placement as its foundation
and then adds the following principles:

■ Joints are constrained with specific positional and rotational properties.

■ Position and orientation of parent objects is determined by the position
and orientation of child objects.

Because of these added constraints, IK requires greater thought about how
you link your objects and place pivots. Where many different solutions for
linking objects might be suitable for forward kinematics, there are usually just
a few good solutions for any given IK approach. The best solution depends
on consideration of both the nature of the hierarchy, and how that hierarchy
will be animated.
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Inverse kinematics is often easier to use than forward kinematics and you can
quickly create complex motions. However, you sacrifice some of your control
to the automation of the IK functions.

Inverse Kinematics (Biped)
When you work with a biped on page 4147, you can use inverse kinematics (IK)
by moving the hands or feet in freeform animation on page 7988. For example,
you can position an arm by moving the hand.

A biped has three inverse kinematics parameters that you can vary during the
limb's motion by setting them at each key of the arm and leg tracks. As the
limb moves through each key:

■ IK Blend Sets the motion interpolation to be a blend of forward and
inverse kinematics. This will allow you to blend swinging motions with
directed hand or foot motions. The default is 0.0, or full forward kinematics.

■ Body or Object Determines the reference coordinate space on page 7943
of the IK path. This allows you to move the IK path with your character's
body, or temporarily attach a hand or foot to follow another object or be
attached to world space. The default is Body.

■ Join to Previous IK Key Determines if the key should be part of the
previous key (with the same reference position as the previous key).

These controls are in the IK section of the Key Info rollout on page 4367.
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Iso Line

Iso lines on a NURBS surface

Iso is short for isoparametric.

In NURBS modeling, a line of constant parameter value, similar to a contour
line. You can use iso lines to display a NURBS surface. You can also create
dependent NURBS curves based on a surface's U-dimension or V-dimension
iso lines.
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Isometric View

Isometric view of a scene

A special type of axonometric view on page 7918, where the sides of the object
are equally inclined to the screen, producing equal foreshortening along the
edges. You can create an isometric view by rotating a User view.

Keyframe Mode
Keyframe mode is active while the Auto Key button on page 7549 is turned on.
While you are in Keyframe mode, transforming an object or sub-object, or
changing the value of an animatable parameter, creates an animation key.

WARNING When you use freeform animation on page 7988 to animate a biped,
always use the biped-specific Set Key button and other key controls on the Key
Info rollout on page 4367, not the standard 3ds Max animation controls.
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See also:

■ Layout Mode on page 8022

■ Keyframes/Keys on page 8020

Keyframes/Keys

The red boxes indicate keyframes, the dotted line shows the interpolated trajectory.

Keyframes record the beginning and end of each transformation of an object
or element in the scene. The values at these keyframes are called keys.

For example, if you have an object representing an elevator that has not been
animated, no keyframes (or keys) exist for it. If you turn on the Animate
button, move to frame 20, and move the elevator along the Z axis to the
second floor, Position keys are created at frames 0 and 20. The key at frame 0
represents the position of the elevator before it was moved, while the key at
frame 20 represents the position of the elevator after it was moved along the
Z axis. When you play the animation, the elevator moves from the ground
floor to the second floor over 20 frames.
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Kinematic Chain
Inverse kinematics calculates the position and orientation of objects in a
kinematic chain.

The kinematic chain is defined as a single branch of the hierarchy that starts
with a selected child object and continues up through its ancestors until it
reaches the base of the chain. The base of the chain is either the root of the
entire hierarchy or an object that you specify as a terminator for the chain.

3ds Max automatically determines the kinematic chain when you select and
transform an object with the IK button turned on.

Knot
A value in an array or "knot vector" associated with a NURBS curve. The knots
specify the region of influence of the CVs on the curve. You can't see or directly
alter knots.

Launch Script
A launch script is a MAXScript script that you run from the command line
with the -U switch, instead of from the Utilities command panel.

You use a launch script to run batch operations in the software. For example,
you might have a batch rendering in which the script opens a sequence of
files, sets up shots in each, and renders them, all without using the user
interface.

Layer Track
A Motion Mixer track for a series of motions that do not require transitions
between them. Compare with a Transition track on page 8158, which allows
you to stack clips on top of one another and to create automatic transitions
between them. When a biped is added to the Motion Mixer, it is automatically
assigned a Layer track. See Adding Tracks to the Mixer on page 3704.

Glossary | 8021



Layers
Layers are like transparent overlays, and allow you to organize and group
different types of scene information. The objects you create have common
properties including color, visibility, renderability, and display. An object can
assume these properties from the layer on which you create it.

You can adjust layer properties from the Layers toolbar on page 7504 and the
Layer Manager.

See also:

■ Using Layers to Organize a Scene on page 7438

■ Layer Manager  on page 7441

■ Layer Properties Dialog on page 7451

Layers (Biped)
The Layers on page 4403 feature lets you add layers of animation above the
original biped animation. This is a powerful way to make global changes to
your character animation. For example, by adding a layer and rotating the
spine forward at any frame, a run cycle becomes a crouched run. The original
biped motion is kept intact and can be viewed by switching back to the original
layer. You can view layers individually or as a composite of the animation in
all layers. Layers behave like a freeform animation; the biped can adopt any
position.

Layers allow you to easily adjust raw motion capture data, which contains
keys at every frame. You add a layer and keyframe the biped.

Layout Mode
Layout mode is active while the Auto Key button on page 7549 and Set Key
button on page 7552 are both turned off. While you are in Layout mode, you
can transform objects and sub-objects, and change the values of animatable
parameters, without generating animation keys.
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See also:

■ Keyframe Mode on page 8019

■ Keyframes/Keys on page 8020

Lift
In footstep animation on page 7986, the state of a foot at the frame when it is
about to lift away from a footstep.

Light Map
A light map or lighting map is a bitmap on page 7926 that stores the lighting
levels (intensity and color) falling on an object in the scene. Typically, you
create a light map by rendering to a texture (texture baking) on page 6371. Light
maps are primarily for use in game engines, but you can also use them to
speed up renderings.

Banana object in a lighted room
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Light map of the banana

If you use the DirectX Manager on page 5393, you can display light maps
interactively in viewports, using either the LightMap shader on page 5760 or
the Metal Bump shader on page 5761.

See also:

■ DirectX Manager Rollout on page 5393

Linked Geometry
Linked geometry is a by-product of importing or linking a drawing file to 3ds
Max. It is a child object, or subcomponent, associated with VIZBlocks or
Block/Style Parents.

When you select a linked geometry object, it offers no parameters on the
Modify panel. You must first add an Edit Mesh modifier to the object or
collapse the linked geometry object to an editable mesh in order to access
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sub-object levels. If you add a modifier to linked geometry, the modifier is
applied to all instances of that object.

The only direct control you have over linked geometry objects is the Reset
Position option that is used to negate and basic move, rotate or scale
transforms.

Links
Links are the segments of the Physique deformation spline on page 7949. Links
follow the hierarchy of the skeleton, such as a biped, that has been attached
to the mesh on page 8043. Link parameters in Physique allow you to bend, twist,
change sliding behavior, and radially scale the mesh.

Listener Window
In MAXScript, the Listener Window is a command-line window that lets you
type in and execute MAXScript commands interactively. In other words, you
run the script as you go along, rather than running a pre-saved text file.

You open the listener window using the MAXScript Listener command on
the MAXScript menu or from the Utilities > MAXScript > MAXScript rollout
> Open Listener command.
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Local Coordinate System

A book in object space rests on a table in world space. The book has its own local
coordinate system.

The local coordinate system is the coordinate system that relates specifically
to the selected object.

Each object has its own local center and coordinate system as defined by the
location and orientation of the object's pivot point. The local center and
coordinate system of an object combine to define its object space.

The direction of the object's X, Y, and Z axes depend on the current transforms
of the object. Contrast with the world coordinate system.

You can see the difference between the two coordinate systems when you
unintentionally rotate an object, such as a wheel on a car model, around the
world axis instead of the object's local axis. The wheel immediately flies off
in a large arc because the center of the rotation is at the origin of the world
coordinates.
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To rotate the wheel correctly, first change the coordinate system to Local,
using the pop-up list on the toolbar. The wheel then rotates around its own
hub, which is the origin of its local coordinates.

Local Event
Particle Flow uses two types of events on page 7966: global on page 7997 and local.
All events in a flow on page 7983 except the first are called local events, because
the actions on page 7897 they contain take effect only while particles are in that
event. The birth event on page 7924 is a special type of local event that always
comes immediately after a global event.

Lofting

A circle is lofted along a path to construct a tubular shape.

Lofting is an important method for 3D object creation. You create shape
objects to serve as a path and any number of cross-sectional shapes. The path
becomes the framework that holds the cross-sections forming your loft object.
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Once you create a loft object you can change and animate its parameters and
sub-objects:

■ Add and replace cross-section shapes or replace the path.

■ Change or animate the parameters of the path and shapes.

■ Change or animate the surface parameters of the loft object.

The lofting process first requires that you create shape objects to serve as the
path and cross-sections of your loft object.

The term lofting comes from early shipbuilding. A large framework called a
loft was built to hold the hull of a ship while it was assembled. The process
of hoisting the ribs (cross-sections) of the hull into the loft became known as
lofting.

A traditional method for building three-dimensional models of a modern
vehicle design is to draw cross-sections at a number of key points. These
cross-sections are cut out to form two-dimensional templates that are then
placed on a rail. The model builders fill in the space between the templates
to generate the surface of the model.

You create loft objects using a similar process. You first create two or more
spline objects. One of these splines will be the rail, which is referred to as the
path. The rest of the splines are the cross-sections of your object, which are
called shapes. As you arrange your shapes along the path, the software
generates a surface between the shapes.

Log File (mental ray Renderer)
The log file (.log) is an ASCII text file that contains messages generated by the
mental ray renderer. You specify a name and location for the log file, and the
"verbosity" level of the messages it contains, in the mental ray preferences on
page 7787.

Look At Object
In the context of the Shape Facing operator on page 2901, a Look At object is
the camera or object toward which particles face.
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LTLI Files
The LTLI file type is the file format for photometric data created by the Danish
Illuminating Laboratory. It is used primarily in Scandinavian countries.

Luminance
Luminance is the value of light reflected off a surface. It is a measure of how
bright or dark we perceive the surface.

Luminous Flux
Luminous flux is the quantity of light energy per unit time arriving, leaving,
or going through a surface. The lumen (lm) is the unit of luminous flux in
both the International System (SI) of units and in the American System (AS)
of units. If you think of light as particles (photons) moving through space,
then the luminous flux of a light beam arriving at a surface is proportional to
the number of particles hitting the surface during a time interval of 1 second.

Luminous Intensity
Luminous intensity is the light energy per unit time emitted by a point source
in a particular direction. Luminous intensity is used to describe the directional
distribution of a light source, that is, to specify how the luminous intensity
of a light source varies as a function of the outgoing direction. The Candela
(cd) is the unit of luminous intensity.

LZF Files
LZF (Lens Effects Flare) files allow you to store all of the settings for a Flare
effect in one file. The settings are also saved with the MAX file; however,
saving them to a separate file allows you to use the same Lens Effects settings
in different scenes, and also allows you to share settings with other 3ds Max
users.
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LZG Files
LZG (Lens Effects Glow) files allow you to store all of the settings for a Glow
effect in one file. The settings are also saved with the MAX file; however,
saving them to a separate file allows you to use the same Lens Effects settings
in different scenes, and also allows you to share settings with other 3ds Max
users.

LZH Files
LZH (Lens Effects Highlight) files allow you to store all of the settings for a
Highlight effect in one file. The settings are also saved with the MAX file;
however, saving them to a separate file allows you to use the same Lens Effects
settings in different scenes, and also allows you to share settings with other
3ds Max users.

LZO Files
LZO (Lens Effects Focus) files allow you to store all of the settings for a Focus
effect in one file. The settings are also saved with the MAX file; however,
saving them to a separate file allows you to use the same Lens Effects settings
in different scenes, and also allows you to share settings with other 3ds Max
users.

LZV Files
LZV files allow you to store the settings for several Lens Effects in one file.
You can save all of your settings for Glow, Ring, Ray, Auto-Secondary, Manual
Secondary, Star, and Streak effects in one file. The settings are also saved with
the MAX file; however, saving them to a separate file allows you to use the
same Lens Effects settings in different scenes, and also allows you to share
settings with other 3ds Max users.

8030 | Glossary



Map Bias

On the right, increased map bias makes the dog appear to float.

Map bias moves the shadow toward or away from the shadow-casting object
(or objects).

By default, this value is 1.0 world coordinate unit. Increasing the bias moves
the shadow away from the object, and decreasing the bias moves the shadow
closer to the object. The Map Bias value can be any positive floating-point
number.

For example, if a shadow-casting object intersects another object but its shadow
doesn't meet properly at the intersection, the bias is too high. This effect varies
with the angle of the spotlight to the object. Extremely shallow spotlight
angles usually require higher bias values.

Another purpose of bias is to avoid problems with objects that cast shadows
onto themselves. If you see streaks or moiré patterns on the surface of the
object, the bias value is too low. If you increase the bias so much that the
shadow becomes disconnected from the object, reduce the bias and increase
the shadow map Size value instead.
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Map Channel

Left: Scene uses different map channels to place different copies of the same maps in
different locations.

Right: The three maps used to create the streets and the traffic markers painted on
them

When you turn on Generate Mapping Coordinates for an object, the
coordinates use map channel 1. You can assign new map channels with new
mapping coordinates by applying a UVW Map modifier on page 1931 to the
object. Map channel values can range from 1 to 99.

A map channel associates a map with an object's mapping coordinates.
Texture-baked maps on page 6371 also use map channels.

For NURBS on page 2237 surface sub-objects, you can assign a map channel
without applying UVW Map. The surface sub-object has a different set of
mapping coordinates for each map channel you use.

A map's map channel value identifies which of an object's mapping coordinates
to use. Different map channels allow maps for the same object to use different
coordinates. For example, you might use one channel for diffuse mapping on
page 5460 and a different one for bump mapping on page 5478. Map channels
also let different maps use different coordinates within a compound material
on page 5706, a compositor map on page 5918, or a multi/sub-object on page 5720
material.

Different map channels can have different U and V tiling values, different U
and V offsets, and so on. In the UVW Map modifier, you can also set different
map channels to have different mapping types (planar, cylindrical, spherical,
and so on).

If you apply a map that uses a certain map channel to an object that has no
mapping coordinates for that channel, the map doesn't appear on the object.
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When you render, a Missing Map Coordinates on page 5780 dialog appears to
warn you of the problem. The dialog lists the map channel and the object
name.

See also:

■ Coordinates Rollout (2D) on page 5782

■ Coordinates Rollout (3D) on page 5861

Mapped Material
A mapped material is a material on page 8041 that contains one or more maps
on page 5767. Typically, it contains a bitmap on page 7926 as a Diffuse map, but
having any map or maps applied qualifies a material as mapped.

In order for a mapped material containing a 2D map on page 7894 to appear
properly in the viewports and in the rendered image, any object to which it’s
applied generally needs mapping coordinates. By default, most parametric
objects in 3ds Max already have mapping coordinates applied; you can also
use the UVW Map modifier on page 1931 (link) or Unwrap UVW modifier on
page 1841 (link) to provide mapping coordinates.

NOTE Objects with materials that contain only 3D maps on page 7894 do not need
mapping coordinates.
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Mapping Coordinates

Decoration on the vase is a map positioned by rotating the UVW Map Modifier gizmo.
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Mapping coordinates specify the placement, orientation, and scale of a map
on the geometry. Coordinates are often specified in terms of U, V, and W,
where U is the horizontal dimension, V is the vertical dimension, and W is
the optional third dimension, representing depth.

If you apply a mapped material to an object that has no mapping coordinates,
the Renderer assigns default mapping coordinates. The built-in mapping
coordinates are designed for each object type. The box mapping coordinates
place a duplicate map on each of its six sides. For the cylinder, the image is
wrapped once around its sides, and duplicates of the image are distorted at
the end caps. A sphere has the image wrapped once around the sphere, and
then gathered at the top and bottom. Shrink-wrap mapping is also spherical,
but truncates the corners of the map and joins them all at a single pole,
creating only one singularity.

3ds Max provides a number of ways to apply mapping coordinates:

■ Use the Generate Mapping Coords option in the creation parameters rollout
of any standard primitive. This option, which is on by default for most
objects, provides mapping coordinates specifically designed for each
primitive. They require additional memory, so turn the option off if you
don't need them.

■ Apply a UVW Map modifier on page 1931. You choose from several types of
mapping coordinate systems and customize the placement of the mapping
coordinates on the object by positioning a mapping icon. In addition, you
can animate the transformations of the mapping coordinates.

■ Use special mapping coordinate controls for special objects. For example,
Loft objects provide built-in mapping options that let you apply mapping
coordinates along their length and around their perimeter.

■ Apply a Surface Mapper modifier. This world-space modifier takes a map
assigned to a NURBS on page 2237 surface and projects it onto the modified
object or objects. Surface Mapper is especially useful for seamlessly applying
a single map to a group of surface sub-objects within the same NURBS
model. You can also use it for other kinds of geometry.

There are three cases where you don't need mapping coordinates:

■ Reflection/refraction maps and environment maps
These use an environmental mapping system, in which the placement of
the map is based on the rendered view, and fixed to the world coordinates
in the scene.

■ 3D procedural maps (such as Noise or Marble)
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These are procedurally generated, based on the local axis of the object.

■ Face-mapped materials
The maps are placed based on the facets in the geometry.

Maps

Front left sphere: Marble bitmap

Front right sphere: Clouds bitmap

Back left sphere: Noise procedural map

Back right sphere: Marble procedural map

The images you assign to materials are called maps. The software provides
several different map types. They include standard bitmaps (such as .bmp, .jpg,
or .tga files), procedural maps, such as Checker or Marble, and image-processing
systems such as compositors and masking systems.

You can assign maps to most of the components that make up a material.
Materials that contain one or more images are called mapped materials. By
assigning maps to different attributes of the materials, you can affect the color,
the opacity, the smoothness of the surface, and much more.

Maps offer the level of realism you look for in materials. The different types
of maps you can use range from the common bitmap, to the flexible procedural
map.

For many map types, the renderer needs instructions telling it where the map
should appear on the geometry. These instructions are called mapping
coordinates on page 8034.
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Marker Data
Data from a motion-capture device on page 4574. Rather than limb rotational
data, marker data uses marker positions to specify limb position.

Marker Files
A file from a motion-capture device. character studio can read two marker file
formats:

■ CSM (character studio marker) on page 7934
This is the native marker file format of character studio.

■ BVH (BioVision) on page 7922

Markers
In a motion-capture session, markers are reflective objects placed on the “actor”
or “talent.” The markers enable motion-capture hardware to record the position
of various parts of the talent's body while performing motions.

Master Motion Clip Controller
In crowd animation on page 4761, a controller (similar to the Block controller)
that consists of a list of motion clips. When instanced, these motion clips can
blend from one animation to another. The Master Motion Clip controller is
accessed via the Crowd helper on page 4819.

Match Frame
For the purposes of combining inverse kinematic (IK) on page 8016 and forward
kinematic (FK) on page 7987 animation, this is a collection of keyframes that
allow a seamless blend between IK and FK control, or vice versa. On the IK
goal on page 8008, this includes IK keys for:

■ Position
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■ Enabled state

■ Swivel angle

On the IK bones, a match frame includes FK keys for:

■ Rotation

■ Preferred angles

■ Scale (less frequently)

Material ID

Figure mapped using a multi/sub-object material: material IDs identify the component
sub-materials.

A surface's material ID is the value that determines which sub-material the
surface will use when you apply a Multi/Sub-Object material on page 5720 to
the object to which the surface belongs.
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Geometric primitives have default material identification number assignments,
just as they have default smoothing groups. The default material ID assignment
depends on the type of geometry. Most curved objects such as spheres have
a single material ID. Boxes have six IDs, one for each side. Cylinders have
three: ID number 1 and 2 for the two caps, and ID number 3 for the sides.
Hedra have three: one for each of their P, Q, and R axes.

When you apply a Multi/Sub-Object material, the materials will match the
Multi/Sub-Object material ID numbers to the material ID numbers on the
faces of the object. Faces keep a record of the ID number, and not of the
material name. If the material is anything but Multi/Sub-Object, the material
is assigned to the object's entire surface.

Assigning some defining material ID number to each object before they become
compound object operands can be a useful technique for being able to select
the separate pieces after they're combined.

You can use material IDs for continuous surfaces that require separate paints
or finishes. For example, a car constructed from different types of materials,
such as a colored metal body, chrome parts, glass windows, and so on.

You can use the Material modifier on page 1517 to assign material ID numbers.
Also you can reassign material IDs using the Editable Mesh > Surface Properties
rollout, or Edit Mesh modifier > Edit Surface rollout.
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Material/Map Hierarchy

Material/map hierarchy shown in the Material/Map Navigator

The Material Editor could be called the Material and Map Editor, because you
can use it to design both materials and maps, and any combination of the
two. In addition, you can create material or map hierarchies.

A material hierarchy is a material that consists of other materials (or maps).
Similarly, a map hierarchy is a map consisting of other maps. Materials that
consist of other materials are called compound materials on page 7938. Maps
consisting of maps are compound maps.
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Materials

Spheres with variations of the standard material type (no maps used):

Green sphere: High Glossiness

Red sphere: Constant shading

Blue sphere: 60% opacity

Yellow sphere: Wireframe mode, slight self-illumination

A material is data that you assign to the surface or faces of an object so that
it appears a certain way when rendered. Materials affect the color of objects,
their glossiness, their opacity, and so on.

A standard material consists of ambient, diffuse, and specular components.
You can assign maps to the various components of a standard material.

The standard material is the default material in the six sample slots of the
Material Editor. However, you can change the type of material you're working
on by clicking the button labeled Type below the sample slots. This displays
the Material/Map Browser, and lets you select from a list of alternative material
types.

You can also change the type of material you're working on by clicking the
Get Material button below the sample slots. This displays the Material/Map
Browser, and lets you select from a list of alternative material types.
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Matte Object

Matte object reveals part of the background, making the hamburger geometry appear
to be inside the oven.

A matte object is invisible but blocks any geometry behind it. However, it
does not block the background.

For example, you might make a complex scene for the background of your
animation, render it once, then assign the resulting bitmap as a background
using only a few animated objects during the rendering of the animation. If
you then needed one of your objects to appear from behind some portion of
the background, such as a building, you would create a matte object that
matches the building. You then place the animated object behind it. The
bitmap image of the building appears, but the animated object is blocked until
it moves from behind the matte object.

Matte objects, though invisible, can cast shadows.

Matte objects can also receive shadows. When the Matte/Shadow material's
Affect Alpha check box is set, shadows cast on the matte object are applied to
the alpha channel. This lets you render maps with alpha shadows that you
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can composite later. To properly generate shadows on a matte object, turn off
the Opaque Alpha check box and then set the Affect Alpha check box.

MAXScript
MAXScript is the general-purpose scripting language for 3ds Max and related
products. While it works the same for all products, some functions are specific
to each. You can use MAXScript to automate many tasks, including modeling,
animation, material construction, and rendering. You can also use MAXScript
to add custom command-panel rollouts to the user interface.

The interface to MAXScript is on both the MAXScript menu on page 7496 and
the Utilities panel on page 7671.

Mesh
A mesh is a type of geometric model of a three-dimensional object in which
the basic shape is made up of points, or vertices on page 8164, connected by
edges on page 7961. The renderable surface of the mesh object is made up of
faces or polygons on page 7970 that connect the vertices and edges. Examples
of mesh objects in 3ds Max are primitives such as Sphere and Teapot, as well
as Editable Mesh and Editable Polygon objects.

In 3ds Max you can edit a mesh by transforming, adding, and deleting the
various elements, or sub-objects: vertices, edges, faces, and polygons. You can
also apply various changes with modifiers on page 8048.

Metaballs
A type of object that joins itself to other objects with a connecting surface.
When one metaball object moves within a certain distance of another, a
connecting surface is formed between the two. Metaballs are ideal for
simulating liquids and thick, viscous substances such as mud, soft foods, or
molten metal.

You can create metaballs with the BlobMesh compound object on page 745.
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MFE Files
A MFE file contains a motion flow graph on page 4549 and any scripts created
for the graph. See Saving, Loading, and Appending Motion Flow Graphs on
page 4521.

MI Files
The MI file (.mi, stands for “mental images”) contains a mental ray scene
description that a mental ray renderer can use to render your 3ds Max scene.
When you render with the mental ray renderer, you can export to a text
(ASCII) MI file. (There is a binary MI format as well. The mental ray renderer
in 3ds Max does not generate this format.) The exporter always generates mi3
(mental ray version 3) format. It does not support mental ray version 1 (mi1).

You specify a name and location for the MI file on the Render Setup dialog >
Processing panel > Translator Options rollout on page 6316.

See the mental ray manual, Programming mental ray, for a complete description
of the mental ray scene description language.

Mirroring
When working with a biped on page 4147, the Mirror control in the Keyframing
Tools rollout on page 4380 allows you to mirror the entire biped animation.

Mix
Data in the Motion Mixer on page 3699 for a single biped. The term mix refers
to the arrangement of elements in Motion Mixer (clips on page 8051, transitions
on page 8157, balance information on page 7919) as well as the result of the
arrangement. A mix is sometimes called a raw mix to distinguish it from a
mixdown on page 8045.

You can save a mix to a MIX file on page 8045.
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MIX Files
A MIX file contains data from the Motion Mixer, including information on
trackgroups on page 8151, tracks on page 8150, clips on page 8051, transitions on
page 8157 and balance information on page 7919. Compare with a mixdown on
page 8045, which contains the same data, but in a collapsed format; the data is
no longer separated into tracks and clips.

 You can save a MIX file in the Motion Mixer by choosing Mix menu >
Save Mix File, or by clicking Save File on the Mixer rollout.

Mixdown
A mixdown is a collapsed version of data in the Motion Mixer. In general, a
mixdown contains the same data as the raw mix on page 8044, with one
difference. During the process of computing a mixdown, any transitions
involving planted feet are corrected to prevent the feet from sliding.

After a mixdown is computed, it is placed on its own track in the Mixer. You
can turn the mixdown on and off by clicking it. When the mixdown is turned
on, the biped performs the motions in the mixdown; when it is turned off,
the biped does the motions in the raw mix. See Exporting Animation to the
Biped on page 3741.

MNM Files
An MNM file (Marker Name file) is a character studio file format that matches
custom names in a motion-capture marker file on page 8037 with the preset list
of known, supported marker names that are recognized by bipeds. See BVH
Files on page 7933 and CSM Files on page 7945 for descriptions of how thesse two
motion-capture file formats work with MNM files.

Modal/Modeless
Modal is a command state or dialog that affects all operations. You must
change the mode or dismiss the dialog before doing any operations that don't
pertain to that mode.
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Modeless means a nonexclusive command state or dialog. You can do other
operations and commands without changing the mode or dismissing the
dialog.

For example, the Track View and Material Editor dialogs are modeless, while
the Open File dialog is modal.

Modifier Stack

Example: Modifier stack display of cylinder with two modifiers applied to it
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Example: Stack display of mesh showing its sub-object hierarchy, and Edge sub-object
level chosen

The modifier stack on page 7635 is the key to managing all aspects of object
modification. You use the stack to:

■ View and manipulate the sequence of modifiers

■ Find a particular modifier

■ Adjust a modifier's parameters

■ Select a modifier's gizmo or center

■ Activate or deactivate a modifier

■ Delete or disable a modifier

The effect of modifiers is directly related to their sequence, or order, in the
stack.

Where you put a modifier in the stack is critical, because the program applies
modifiers in their stack order, beginning at the bottom, and carries the
cumulative change upward.

By clicking any entry in the stack, you go back to the point where you made
that modification. You can then rework your decisions or discard the

Glossary | 8047



modification entirely by deleting it. You can also insert a new modifier in the
stack at that point.

Modifiers

Example: effects of the twist modifier on an object

Modifiers on page 1085, as the name implies, modify an object's geometrical
structure, deforming it in some way. When you apply a taper modifier on
page 1811 to the end of a cylinder, for example, the vertices near the end move
closer together. Modifiers make changes in the geometry that stay in effect
until you adjust or delete the modifier.
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Morphing

Morphing makes the clock appear to melt.

Morphing is a term derived from metamorphosis, which means to change
physical shape or form.

The purpose of the morph object in 3ds Max is to create an animated object
that changes shape by morphing between two or more objects. Although it
appears that a single object is changing form, in reality the morphing process
translates the position of the vertices from their arrangement in one object
to the arrangement in another, relative to their local coordinate system.

Consequently, all objects chosen to make up a morph object must have the
same number of vertices. Typically, you achieve this by cloning an object,
and then altering the geometry of the clones without changing their vertex
count.

Motion Blending
When working with motion flow on page 4508, you use transitions to blend
clips together. By default, a transition is calculated with a method known as
“minimum motion loss.” If optimized transitions are used, then a sophisticated
algorithm that minimizes foot sliding is used. This alternative method is
computationally expensive.
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Motion Blur

Motion blur enhances the movement of the sword.

Motion blur can enhance the realism of a rendered animation by simulating
the way a real-world camera works. A camera has a shutter speed, and if
significant movement occurs during the time the shutter is open, the image
on film is blurred.

3ds Max provides a variety of ways to apply motion blur:

■ Image Motion Blur on page 8010 applies motion blur to entire frames of an
animation.

■ Motion Blur Rendering Effect on page 6681 lets you apply image motion blur
as a rendering effect on page 6583.

■ Multi-Pass Rendering Effect on page 5227 applies motion blur to frames by
offsetting the camera in multiple rendering passes. You can preview
multi-pass rendering effects in camera viewports.

■ Particle Motion Blur on page 3010 uses a material map to blur moving
particles in a particle system.

8050 | Glossary



■ Scene Motion Blur on page 8117 lets you apply motion blur as a Video Post
on page 6773 effect.

■ Object Motion Blur on page 8063 applies motion blur to specified moving
objects in a scene. Object motion blur is best for making fast-moving
objects appear to move more smoothly.

Motion Capture
The process of digitizing the movements of a live “actor” or “talent.” This
requires a motion-capture device.

Motion Clip
A motion clip is a sequence of motion on a biped or other objects. A motion
clip can be a BIP file, or a portion of a 3ds Max animation used in a crowd
sequence.

BIP files used in Motion Flow on page 8052 and the Motion Mixer on page 8052
are called motion clips. You can use these tools to combine several motion clips
and make a longer or different animation. A BIP motion clip can be created
by saving animation on page 4300 you have made on the biped, or by importing
motion-capture data on page 4576.

When you create a crowd animation on page 4761 that uses motion synthesis
on page 8053 on non-biped objects, a motion clip is a portion of a 3ds Max
animation used by the synthesis. You specify that a range of frames in the
animation is to be used when the delegate meets certain criteria, such as
turning upward to exceed a certain pitch.

One animation sequence can contain all the motion clips necessary to animate
the crowd. For example, a bird animation might have three motion clips: flap,
glide, and land. You could specify that when the delegate is pitched upward,
the range of frames that animate the flap motion are used in the simulation.
Motion clips are used by the Global Motion Clip Controller on page 7999 and
the Master Motion Clip Controller on page 8037.
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Motion Files
character studio can load these types of motion files:

■ BIP files on page 7923

■ BVH files on page 7933

■ CSM files on page 7945

Motion Flow
In Motion Flow mode on page 4508, you combine BIP files on page 7923 to create
longer character animation. You also use motion flow along with crowd
animation on page 4761 to automatically generate crowd behavior.

One motion can transition into another. To generate a transition, character
studio uses either velocity-interpolated transitions (“minimum motion loss”),
or an algorithm to minimize sliding feet.

Motion Flow Editor
In Motion Flow mode on page 4508, the Motion Flow Editor allows you to
manually create a transition between two clips. You set the start frame and
transition duration for both clips, and the orientation of the destination clip.

Motion Flow Scripts
When using motion flow on page 4508, a script is a sequence of motion files
that are played to create a character’s motion. Scripts are created either
manually or automatically.

Motion Mixer
The Motion Mixer is a window where you can mix motion clips (BIP files) on
a biped. The clips are placed on various tracks on page 8150 within the mixer.
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In the Motion Mixer, you can use trackgroups on page 8151 to affect different
body parts with different clips. Each trackgroup can contain transition tracks
on page 8158 and layer tracks on page 8021, which hold the motion clips.

Each biped in the Motion Mixer is assigned a balance track on page 7919, which
automatically compensates for differences in balance between upper and lower
body motion.

 To make the motion in the Mixer affect the biped in the scene, you
must turn on Mixer Mode in the Biped rollout on page 4331.

See Using the Motion Mixer on page 3699.

Motion Synthesis
In crowd animation on page 4761, motion synthesis is the process of animating
bipeds by combining motions (clips) automatically. Clips are added to the
Motion Flow Graph, and transitions are created between appropriate clips. In
the Crowd system, delegates are animated. During synthesis (solving the
motion), the delegates' speed and direction are analyzed by character studio.
Based on the analysis, clips are selected to animate the bipeds.
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MSP (MAXScript Package) Files
A MAXScript Package (MSP) combines the set of files that make up a scripted
tool into a single file. An MSP file can contain bitmaps, script sources, icons,
and so on.

For more information about MSP files, see the MAXScript Reference: Help
menu > MAXScript Reference

Multiplicity
In NURBS modeling, multiplicity is the property of coincident or nearly
coincident CVs that reduces the continuity level of the curve or surface. Two
coincident CVs locally increase curvature. Three coincident CVs (or more)
create an angular cusp. Fusing CVs shows the effect of multiplicity.

Effects of multiplicity:

On the left, three coincident CVs create a sharp angle.

On the right, only two coincident CVs in the same location create a gentler curve.
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Multiplier

Left: Default light multiplier of 1.0

Right: Multiplier of 5.0 causes burned colors

The Multiplier value in every light lets you increase the intensity, or brightness
of the light beyond its standard range.

Since increased Multiplier values tend to wash out, or "burn" portions of the
image, you're better off adding lights, or reducing the intensity of other lights
when you need to adjust the brightness of areas in your scene. Remember that
you can adjust the intensity of a light using its V(alue) spinner. In most cases,
it's better to adjust the V spinner than to alter the default Multiplier value.

Left: Spotlight with negative multiplier subtracts light from the scene.

Right: Multiplier of 0 and a negative density on a shadow whose color is white creates
the effect of a negative shadow.

An unusual characteristic of the Multiplier is that you can use negative values
to create negative light. You can use negative lights to further control the
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lighting in your scene. For example, you might want a darker area in the
corner of a room.

A negative Multiplier value reverses the color of the light, so a red light would
become cyan (the complementary color). In addition, the map image in a
projector light becomes a negative image.

Multiplier Curve
Multiplier curves are special function curves that you use to apply animated
value displacements to other function curves.

When you edit keys and function curves, you apply localized changes to your
animation at specific times. By applying a multiplier curve to the original
track, you affect the entire range of the original animation.

A multiplier curve shifts the value of the original track up or down. At a given
frame, the value of a multiplier curve is a scale factor applied to the value of
the original function curve.

■ The default value of a Multiplier curve is a horizontal line with a value of
1.0.

■ Values greater than 1.0 increase the value of the function curve.

■ Values below 1.0 decrease the value of the function curve.

■ Values less than 0.0 negatively scale the value of the function curve.

See also:

■ Ease Curve on page 7960

N Links
In Physique on page 4603, by default, any number of overlapping envelopes can
influence vertices. This is specified by the N Links option on the Vertex-Link
Assignment rollout on page 4703 of the Physique Initialization dialog, or at the
Vertex sub-object level on page 4753.

Typically, N Links is the preferred choice. For special purposes, such as
developing for a game engine that has limited support of overlap, you can
limit the number of links (with their envelopes) that can affect a vertex.
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Network Manager
The Network Manager service (Network Manager) is a service that must be
installed on at least one computer in each group of computers that will
participate in network rendering.

The Network Manager communicates with a specified group of Network
Rendering Servers to assign jobs and monitor rendering progress. The Network
Manager also handles the scheduling of jobs and the configuration of servers
through the Queue Monitor client.

It's often best to place the Network Manager on a computer that isn't in use
as a workstation and isn’t shut down regularly. The Manager Service can impact
CPU and network performance when network rendering is taking place, and
the Network Manager must be present at all times for network rendering to
work.

The ideal place to install the Network Manager is on a file server. If you have
a PC already set up as a texture-map file server, this would be an ideal place
for it.

You specify which PC is to be the Network Manager in the Network Job
Assignment dialog, a subdialog of the Render Setup and Video Post Execute
Sequence dialogs.

Network Rendering
Network Rendering is the rendering of animations using more than one
computer connected by a network.

Large and complex animations take many hours to render, even on the fastest
PCs. Network rendering allows you to use the power of other computers to
speed up the process. Any network-connected PCs that have the software
installed can participate. You can even render using computers connected
only by the Internet.

Setting up network rendering involves installing three kinds of programs:

■ The Network Manager, which should be installed on a central file-server
PC.

■ The Network Rendering Server, which must be installed on all participating
PCs.
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■ The Queue Monitor client provides a user-interface to monitor and control
network rendering. It can be installed on any of the participating PCs.

Network Rendering Server
The Network Rendering Server must be running on any computer dedicated
to rendering a job remotely.

The Server communicates with the Network Manager and starts the program
on that computer to render network processes. The Server has no user interface
itself, but you can set various options for it from the Queue Monitor client.
For example, you can specify the times of day that the Server is available to
do network rendering.

You specify which PCs are to be servers in the Job Assignment dialog on page
6481, a subdialog of Render Setup.

Newton
In the metric system, the newton is the unit of force required to accelerate a
mass of one kilogram one meter per second. In 3ds Max, you can use the
newton in dynamic simulations with objects such as the spring on page 890
and damper on page 881.

Node
Every object in a 3ds Max scene is represented in memory (that is, in the data
structure of the scene) as a node, which acts as a container for an object’s
geometry, its transform controllers, assigned materials and modifiers, etc.
Nodes also provide the building blocks for hierarchies, in which parent/child
relationships are created by linking objects node to node. Two tools that
display nodes are Track View and Schematic View.

”Node” is distinct from the term “object,” because the “object” refers more
narrowly to geometry: the mesh, or NURBS surface, spline, or patch, and so
on. The same instance of an object’s geometry can be shared by multiple
nodes. Each node in the scene is unique and can be identified as such by the
commands and tools 3ds Max or plug-ins implement.
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Normal

The normal of each face can point in a different direction.

A normal is a vector that defines which way a face or vertex is pointing. The
direction of the normal indicates the front, or outer surface of the face or
vertex.

You can manually flip or unify face normals to fix surface errors caused by
modeling operations or by importing meshes from other programs.

See also:

■ Normal modifier on page 1581

NTSC
NTSC (National Television Standards Committee) is the name of the video
standard used in North America, most of Central and South America, and
Japan. The frame rate is 30 frames per second (fps) or 60 fields on page 7973 per
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second, with each field accounting for half the interleaved scan lines on a
television screen.

NURBS

Fountain basin modeled as a NURBS surface

NURBS (Non-Uniform Rational B-Splines) are a technique for interactively
modeling 3D curves and surfaces.

NURBS Curve
A curve object created by NURBS modeling on page 8060. NURBS Curves can
be either Point Curves or CV Curves. You can use them as you do spline curves
in Shape objects.
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NURBS Model

Fountain modeled using NURBS surfaces

A NURBS object on page 8060 consisting of one or more sub-objects. The 3ds
Max documentation uses "NURBS model" to emphasize the final result of
NURBS modeling using a variety of sub-objects and techniques.

NURBS Surface
A surface object created by NURBS modeling on page 8060. NURBS Surfaces can
be either Point surfaces or CV Surfaces.
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Object

An assortment of geometric primitive objects

"Object" means an object in the scene, such as primitive geometry like boxes
and spheres, more complex geometry such as Booleans, and so on. Geometric
objects are renderable. A scene can also contain non-renderable objects such
as lights, cameras, helpers, and space warps.

You add objects to a scene by selecting the Create menu or from the Create
panel.

Object Instance
In 3ds Max, an instance is a completely interchangeable clone of the original
object. Modifying an instanced object is the same as modifying the original.

Instances are not only alike in geometry, but also share modifiers and materials.
When you change one instance by applying a modifier, for example, all the
other instances change with it.
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Each instance has its own set of transforms, object properties, and space warp
bindings. These are not shared among instances.

Within 3ds Max, instances derive from the same master object. What you're
doing is applying a single modifier to a single master object. In the viewport,
what you see as multiple objects are multiple instances of the same definition.

For example, if you wanted to create a school of swimming fish, you might
begin by making many instanced copies of a single fish. You could then
animate the swimming motion by applying a Ripple modifier to any fish in
the school. The whole school would swim with exactly the same motions.

Object Motion Blur
Object motion blur applies a blur effect to make fast-moving objects appear
to move more smoothly in animations. It is a form of "temporal antialiasing."

Left: Object motion blur. Right: Object motion blur with dithering.

TIP For simulating the blur created by a moving camera image motion blur on
page 8010 or scene motion blur on page 8117 works better than object motion blur.
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Applying object motion blur is a two-step process:

1 Turn on object motion blur for the object you want to blur, using the
Object Properties dialog on page 305.

You cannot apply both image motion blur and object motion blur to the
same object in the same rendering.

2 Before you render, turn on object motion blur in the Default Scanline
Renderer rollout on page 6141 of the Render Setup dialog.

Object motion blur works by rendering multiple copies of the object in between
frames and then rendering them together. It is not affected by camera
movement.

Object Space

A book in object space rests on a table in world space.

Object space is the coordinate system unique to each object in your scene. It
tracks the location of everything applied to an object. The location of object
vertices, the placement of modifiers, mapping coordinates, and materials are
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all defined in object space. By convention, especially in discussions of texture
mapping, object-space coordinates are expressed as UVW coordinates, as
opposed to the XYZ coordinates of world space on page 8175.

Each object has its own local center and coordinate system as defined by the
location and orientation of the object’s pivot point. The local center and
coordinate system of an object combine to define its object space.

When you choose Use Pivot Point Centers from the toolbar or Use Pivot Points
from the Modifier List, you are telling the program to use the Object Space
origin of one or more selected objects as the center of a transform or modifier
effect.

When you choose Local from the Reference Coordinate System list on page
967 (on the main toolbar), you tell the program to use a selected object’s object
space for the orientation of the active coordinate axes.

Most modifiers on page 8048 operate in object space. See Object-Space Modifiers
on page 1202.

Object Space (Biped)
When you use freeform animation on page 7988 to animate a biped, you can
place a biped limb into the space of another object, or into world space. For
example, if the biped's hands are in the space of a ball, then wherever the ball
moves the hands move with it. If the biped's feet are in world space, then
when you move the center of mass, the feet stay planted in the same location.

Obstacle-Avoidance Behavior
In crowd animation on page 4761, an important part of crowd behavior is
avoidance of obstacles. Think of an obstacle as anything that impedes a crowd
member's progress. Examples of obstacles include walls, telephone poles, and
fences, as well as other crowd members. Encountering such objects can cause
avoidance behavior, which consists of any combination of slowing down,
turning, and stopping.
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Object-Space Modifiers
Object space is the coordinate system unique to each object in your scene. An
object-space modifier, as opposed to a world-space modifier on page 8176, directly
affects an object using the object's local coordinates.

Object-space modifiers appear directly above the object in the modifier stack
on page 8046, and their effect can depend on the order they appear in the stack.

Omnidirectional Light

Above: Top view of an omni light

Below: Perspective view of the same light
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Above: Top view of an omni light

Below: Perspective view of the same light

Omnidirectional (omni) lights are standard light objects on page 5049 that
provide a point source of illumination that shoots out in all directions. They're
easy to set up, but you can't restrict the focus of their beam. You can, however
restrict which objects are illuminated by an omni light.

When no lights exist in your scene, two invisible omni lights are turned on
by default to provide overall illumination in the scene. However, as soon as
you create your own light in the scene, the two default lights are turned off.

You can apply attenuation to omni lights.

Omniflector
A space warp on page 8132 that deflects particles. Omniflectors are also capable
of refracting particles and generating spawned particles.

Three kinds of space warps are in the omniflector category:

POmniFlect Space Warp on page 2732

SOmniFlect Space Warp on page 2743

UOmniFlect Space Warp on page 2746

See also:

■ Dynaflector on page 7959
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Opacity Falloff
Real transparent surfaces vary their opacity, depending on the angle of the
material to your point of view. For example, a bottle appears more transparent
at its center than at its edge because you're looking through more glass at its
edge.

In the Extended Parameters rollout, you can specify the falloff of the
transparency, based on the angle of the face normals to the view. If a face is
perpendicular to the viewer, the angle of its normal is 0 degrees. If the face is
edge-on to the viewer, its normal angle is 90 degrees.

Falloff is either inward or outward:

In Transparency increases as the normal angle approaches 0 degrees and
decreases as the angle approaches 90 degrees. This gives the appearance of a
hollow object such as a glass ball or bottle.

Inward opacity falloff

Top: None

Bottom: 100%

Out Transparency increases as the normal angle approaches 90 degrees and
decreases as the angle approaches 0 degrees. This gives the appearance of a
solid object such as a cloudy glass marble.
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Outward opacity falloff

Top: None

Bottom: 100%

The falloff amount never makes the object less opaque than the value of the
Opacity spinner. For example, if Opacity were set to 50, and Falloff set to In,
the inner portions would remain at 50 percent opacity, and the Amt. spinner
would change the outer edges, until they became opaque at 100.

Operand
An operand is one of a set of objects upon which an operation such as Boolean
on page 757 is to be done. The Boolean operation takes two operands: the first
operand is called operand A, and the second operand is called operand B.

Operator
In Particle Flow on page 2795, the operator is the basic element of the particle
system; you combine operators into events on page 7966 to specify the particles'
characteristics over a given period of time. Operators let you describe particle
speed and direction, shape, surface properties, and more.

A list of all operators in Particle Flow is available in the Operators topic on
page 2841.
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See also:

■ Test on page 8147

Operator Icon
In Particle Flow on page 2795, adding a Find Target test on page 2970 or a Speed
By Icon operator on page 2876 to a particle system creates a special viewport
icon used by the action. This icon is known as an operator icon. In the 3ds
Max scene, an operator icon functions as a Helper object, and, in fact, you
can also add these two actions from the Create panel by choosing Helpers >
Particle Flow.

Find Target icon (top); Speed By Icon icon (bottom)
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Find Target icon (top); Speed By Icon icon (bottom)

Optical Markers
Reflective markers used by certain motion-capture equipment. In a
motion-capture session, markers are reflective objects placed on the “actor”
or “talent.” The markers enable motion-capture hardware to record the position
of various parts of the talent's body while performing motions.

Orientation Behavior
In crowd animation on page 4761, the Orientation behavior lets you control
whether and how delegates rotate, independent of their direction of motion.
Normally, a delegate always faces in the direction it's moving. You can use
the Orientation behavior to specify limits to the delegate's rotational activity
without affecting its path, which is generated by other behaviors. Use these
settings, for example, to keep delegates facing in one direction while moving
in another.

NOTE These settings do not affect the path a delegate takes, which is produced
by other behaviors such as Seek and Avoid. Orientation influences only the direction
the delegate faces as it traverses the path.
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Origin

Origin is the 0,0,0 point where the X, Y, and Z axes intersect.

A coordinate system assigns an arbitrary point in space as the origin, and sets
each axis at that point to zero.

In the world coordinate system on page 8174, numbers increase from the origin
to the right along the X axis, upward along the Y axis, and away from you on
the Z axis. Numbers decrease (–1, –2, –3, and so on) to the left along the X
axis, downward along the Y axis, and toward you along the Z axis. The distance
between each whole number is called a unit of measurement (a 3ds Max unit).

You can combine the measurements of all three axes to mark specific locations
in 3D space. The combined measurements are called coordinates. Thus, at the
origin, the coordinates are X=0, Y=0, Z=0, which can be expressed more simply
as the vector (0,0,0).

From the origin, the coordinates at a location 100 units to the right, 150 units
up, and 60 units away are X=100, Y=150, Z=60, or (100,150,60).
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Orthographic View

Orthographic views of a model
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Whether produced on computer or paper, most 3D design relies on 2D
representations for accurate description of objects and their positioning. Maps,
plans, cross-sections, and elevations are all examples of 2D representations.
Each of these views represents an orthographic view. In familiar terms, you
might think of these views as "flat" or "straight-on," or as "looking at right
angles."

Orthographic views are two-dimensional, each defined by two world coordinate
axes. Combinations of these axes produce three pairs of orthographic views:
top and bottom; front and back; left and right.

Orthographic views are a special case of axonometric views on page 7918. You
can set viewports to the various orthographic views using the viewport
right-click menu on page 7576 or keyboard shortcuts on page 7857.

Out-of-Range Types

When you specify values and keys for a controller, you are defining animation
over a range of time. You choose Out-of-Range Types to determine how the
animation continues outside a specified range. Out-of-Range choices include
holding a constant value, and various ways of repeating the animated range.

The easiest way to work with Out-of-Range Types is in the Track View Function
Curve mode.
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You use the Parameter Out-of-Range dialog to project the pattern of the key
dots in the selected track. These patterns are applied to the animation outside
the range of all keys in the track. This is why they're called out-of-range types.

By default, tracks use a constant out-of-range type. This means that the track
values before and after the range of keys remain constant. For example, in a
100-frame animation with keys up to frame 20, the X, Y, and Z values after
frame 20 remain the same for the rest of the animation. The objects in this
example do not move from frame 20 to frame 100.

Applying the Cycle out-of-range type will make the key pattern in frames 0–20
repeat cyclically for the remaining 80 frames.

Outputs: Source / Test
In Particle Flow, you create a particle diagram on page 8081 by connecting events
on page 7966 using wires on page 8170. Each wire links an output with an event
input on page 8013. There are two different types of outputs: ;

■ The connector sticking down from the bottom of a global event on page
7997 is a source output.

■ The connector sticking out from the side of a test on page 8147 is a test
output.
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Source output (above); test output (below)
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Overshoot

Above: No overshoot

Below: Overshoot turned on

The Overshoot option causes a spotlight to flood beyond its falloff area, and
cast light in all directions. With Overshoot turned on, the spotlight casts light
in all directions but casts shadows only within its falloff cone.
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The Overshoot control effectively turns the spotlight into a hybrid between
an Omni light and a spotlight. With Overshoot set, the spotlight casts light
in all directions as an Omni light does but still casts shadows or projections
as other spotlights do. The shadows and projections are limited to the falloff
region: outside the cone of the spotlight, Overshoot casts light but does not
cast shadows or projections.

Overshoot is useful when you want to light a large area but need to cast
shadows in only a small part of that area. Set the falloff to include the area
where shadows must appear, and then turn on Overshoot to light the rest of
the scene. This technique can reduce the size of shadow maps and thereby
improve rendering speed.

PAL
PAL (Phase Alternate Line) is the video standard used in most European
countries. The frame rate is 25 frames per second (fps) or 50 fields on page 7973
per second, with each field accounting for half the interleaved scan lines on
a television screen.

Parameter Space
NURBS objects have, in addition to their existence in 3D space, a parameter
space that includes the array of knot values. NURBS curves have a single U
dimension in parameter space. NURBS surfaces have two dimensions, U and
V, in parameter space.

Parameters Panel
The parameters panel, found to the right of the event display on page 7968 in
Particle View on page 2811, displays the parameters of any action whose name
you click in the depot. The panel uses the same format and editing methods
as the command panel in 3ds Max. Display of the parameters panel can be
toggled with the Particle View menu command Display > Parameters.
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Parameter/Parametric

A tube is one example of a parametric object. Varying its parameters creates varying
geometry.

A parameter is a setting or value that you can change. Many objects in 3ds
Max have parameters that you can change to alter the size or shape of the
object. This type of object can be described as parametric.

Unlike physical building blocks, which have a fixed shape and size, the
geometric primitives (box, sphere, torus, and so on) are parametric; you can
change their dimensions, segment settings, and other features after you create
them. Parametric objects respond to changes in their parameters by
dynamically updating their properties.

Changing a parameter can dramatically alter the structure and appearance of
an object. For example, you can turn a cylinder into a prism by reducing the
number of sides and turning the Smooth option off. Alternately, you can turn
a cone into a four-sided pyramid using the same technique.

Objects that you merge from other scenes or from Autodesk VIZ allow you to
access parametric values. Objects in drawings that you link from Autodesk
Architectural Desktop should be edited in Architectural Desktop, then relinked
to 3ds Max with the File Link Manager on page 6987.

You can animate almost all creation parameters for geometric primitives, and
interactively change their settings during animation playback.
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Parent Particle
A parent particle is an existing particle from which the particle system generates
spawn particles on page 8132. You can use the Spawn test on page 2991 to create
spawn particles arbitrarily, or the Collision Spawn test on page 2964 to create
spawn particles as the result of physical interaction between a parent particle
and a deflector.

Particle Diagram
The particle diagram is the graphical depiction of the particle system on page
8083 in Particle View on page 2811. It uses events on page 7966 and wires on page
8170 to represent the system's elements and logic. You edit the system by clicking
actions on page 7897 and events in the diagram and changing their values, by
adding new actions and events, and by creating wires between events.
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Particle Level
In Particle Flow, you can select particles at the Event level on page 7969 or at
the Particle level, using controls on the Modify panel > Selection rollout on
page 2833. At the Particle level, you select particles using standard 3ds Max
methods, such as clicking or dragging a region. A Particle-level selection can
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be acted upon by the Delete operator on page 2848 and the Split Selected test
on page 3000.

Particle System
Particle systems are objects that generate non-editable sub-objects, called
particles, for the purpose of simulating snow, rain, dust, and so on.

The particle system object generates the particles over time. You use particle
systems primarily in animations.

3ds Max provides several built-in particle systems, including Spray and Snow.
Your configuration might have other plug-in particle systems installed.

The Deflector, Gravity, and Wind space warps are for use with particle systems.
(Gravity and Wind also work with Dynamics.)

3ds Max also offers an event-driven particle system called Particle Flow on
page 2795.

Particle System (Particle Flow)
A particle system in Particle Flow consists of all flows on page 7983 defined in
Particle View, as well as parameters defined for all Particle Flow sources on
page 2829. In effect, it's the totality of settings in Particle Flow.

PASS File
A PASS (.pass) file saves the result of a single mental ray rendering on page
6230 pass. You can create a final rendering by merging multiple passes. The PASS
file format includes Z-buffer information to aid in merging passes.

Controls for creating and merging PASS files are on the Render Setup dialog
> Processing Panel > Translator Options rollout on page 6316.
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Patch

Example of a patch model

A patch is a type of deformable object. A patch object is useful for creating
gently curved surfaces, and provides very detailed control for manipulating
complex geometry.

When you apply an Edit Patch modifier on page 1360 to an object or convert it
to an editable patch on page 2019 object, the software converts the object's
geometry into a collection of separate Bezier patches. Each patch is made up
of three or four vertices connected by edges, defining a surface. Patches also
have interior vertices that you can control, or let the software control for you.

You control a patch surface's shape by manipulating the vertices and edges.
The surface is the renderable geometry of the object.

Patch-Based Objects
Objects made from patches. Physique on page 4603 can work with meshes,
patches, NURBS, splines, and FFD space warps.

Path
A path is the line (or other shape) along which shapes are lofted to create 3D
Loft objects on page 786.
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The Path constraint on page 3297 also lets you assign a line or other shape as a
motion path. A motion path is a form of trajectory on page 8154.

Get Path (Lofting)

A circle is lofted along a path to construct a tubular shape. Get Path chooses the path
spline

You use Get Path as a loft creation method when you want the path to move
to the location of the selected shape. For example, you use this method if you
have created a shape at the exact location where you want the base of your
loft object to be. You use Get Path to create a loft at that location.

Get Path causes the path shape to move and rotate to align itself with the first
shape on the path:

■ The first vertex on the path is located at the first shape's pivot point.

■ The tangent to the first vertex on the path is aligned with the positive Z
axis of the first shape.

■ The local Z axis of the path is aligned with the local Y axis of the first
shape.
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■ The local coordinate system of the resulting loft object equals the local
coordinate system of the path after it has been aligned with the first shape.

Sometimes, aligning the tangent of the path with the positive Z axis of the
first shape does not produce the result you want. You can flip the orientation
of the path by pressing Ctrl while getting the path. Pressing Ctrl aligns the
path so that the tangent to the first vertex of the path is aligned with the
negative Z axis of the shape.

Path Follow Behavior
In crowd animation on page 4761, the Path Follow behavior lets you direct
delegates to traverse a specified path during a crowd simulation. Delegates
can move forward or backward along paths, and when they reach the end,
they can loop back to the start or reverse direction, or even continue in the
same general direction.

If the delegate's start position isn't on the path at the start of the simulation,
it moves to the path before following the path. During the solution, character
studio intermittently displays an optional target icon to show the delegate's
immediate goal; this changes as the simulation proceeds.

Period
When you animate a biped, a freeform period is a period between footsteps
where you can animate the biped any way you want. Biped dynamics on page
7923 are suspended during this period. See Freeform Animation Between
Footsteps on page 4227.
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Perspective View

Perspective view of the ice-cream shop

Perspective views most closely resemble human vision. Objects appear to
recede into the distance, creating a sense of depth and space. For most 3D
computer graphics, this is the view used in the final output that the client
sees onscreen or on the page.

There are three ways to create a perspective view in a viewport: perspective
view, camera view, and light view.

A perspective viewport, labeled Perspective, is one of the default viewports.
You can change any active viewport to this eye-like point of view by pressing
the keyboard shortcut P.

A camera view requires that you first create a camera object in your scene.
The camera viewport tracks the view through the perspective of that camera.
As you move the camera (or target) in another viewport, you see the scene
swing accordingly. If you alter the camera's field of view on the Modify
command panel, you see the changes as they are applied.
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The light view works much like a targeted camera view. You first create the
spotlight or directional light and then set the viewport to that light. What
you see in the viewport is the view from the light looking into the scene. This
is very useful for adjusting the correct distances of hotspot and falloff for the
light.

Phases of Leg Motion
A leg's motion has four phases, beginning with the foot on the ground. Then
the foot lifts, moves through the air, and returns to the ground again. Biped
divides this motion into four phases, as follows:

■ Touch Occurs at the leg keyframe where the leg's foot first touches the
ground and always corresponds with the start frame of a footstep in Track
View — Dope Sheet.

■ Plant Occurs after touching, and before lifting. It is always in between
the start and end frames of a footstep in Track View — Dope Sheet.

■ Lift Occurs at the keyframe where the leg's foot lifts off the ground, and
always corresponds to the end frame of each footstep in Track View —
Dope Sheet.

■ Move Occurs while the foot is in the air and is always in the intervals in
between steps in Track View — Dope Sheet. In walking, while one foot
moves, the body is supported by the other leg. In running or jumping,
while a foot moves there is a period where the body is not supported, and
moves in midair.

Photometry
When you use photometric lights on page 5005, 3ds Max provides physically
based simulation of the propagation of light through an environment. The
results are not only highly realistic renderings, but also accurate measurements
of the distribution of light within the scene. The measurement of light is
known as photometry. This topic introduces the quantities used for defining
and measuring light.

There are several theories that describe the nature of light. For this discussion,
we define light as radiant energy capable of producing a visual sensation in a
human observer. When we design a lighting system, we’re interested in
evaluating its effect on the human visual response system. Thus photometry
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was developed to measure light, taking into account the psychophysical aspects
of the human eye/brain system. Four photometric quantities are used in the
lighting simulation system:

■ Luminous flux

■ Illuminance

■ Luminance

■ Luminous intensity

Luminous flux is the quantity of light energy per unit time arriving, leaving,
or going through a surface. The unit of luminous flux is the lumen (lm), which
is used in both the International System (SI) of Units and in the American
System (AS) of Units. If we think of light as particles (photons) moving through
space, then the luminous flux of a light beam arriving at a surface is
proportional to the number of particles hitting the surface during a time
interval of 1 second.

Illuminance is the luminous flux incident on a surface of unit area. This
quantity is useful for describing the level of illumination incident on a surface
without making the measurement dependent on the size of the surface itself.
The SI unit of illuminance is the lux (lx), which is equal to 1 lumen per square
meter. The corresponding AS unit is the footcandle (fc), equivalent to 1 lumen
per square foot.

Part of the light incident on a surface is reflected back into the environment.
The light reflected off a surface in a particular direction is called luminance,
the quantity that is converted to display colors to generate a realistic rendering
of the scene. Luminance is measured in candelas per square meter or candelas
per square inch. The candela was originally defined as the luminous intensity
emitted by a single wax candle.

Finally, luminous intensity is the light energy per unit time emitted by a point
source in a particular direction. The unit of measure of luminous intensity is
the candela. Luminous intensity is used to describe the directional distribution
of a light source, that is, to specify how the luminous intensity of a light source
varies as a function of the outgoing direction.

Because 3ds Max works with these physically based photometric values, it can
accurately simulate real-world lighting and materials.
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Photon Map
A photon map™ is a technique to generate the indirect illumination effects
of caustics on page 6255 and global illumination on page 6261 when you render
with the mental ray renderer on page 6230. When it calculates indirect
illumination, the mental ray renderer traces photons emitted from a light.
The photon is traced through the scene, being reflected or transmitted by
objects, until it strikes a diffuse surface. When it strikes a surface, the photon
is stored in the photon map.

Generating photon maps is time-consuming. To improve performance, you
must explicitly specify:

■ Which lights emit photons for indirect illumination.

■ Which objects can generate caustics or global illumination.

■ Which objects can receive caustics or global illumination.

The settings for generating and receiving caustics are on the Object Properties
dialog > mental ray Panel on page 322.

The photon map stores photons only for objects that can receive caustics,
global illumination, or both.

To further reduce the time required to generate a photon map, photons are
limited by the Trace Depth controls. These limit the number of times a photon
can be reflected, refracted, or both.

In animations, another way to save time is to reuse the photon-map file. If
lighting doesn't change over the course of an animation, use the Photon Map
controls on page 6312.

The mental ray renderer saves photon maps as PMAP files on page 8093. Photon
map controls are on the Render Setup Dialog > Indirect Illumination panel >
Caustics And Global Illumination rollout on page 6306.

PHY Files
You can save Physique on page 4603 data to a Physique (PHY) file. This saves
data common to all objects that share a given Physique modifier.

Later, you can reload the PHY file, either to restore the data that belongs to a
particular skin or portion of skin, or to transfer the Physique of one skin (or
portion of it) to a different one.
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Physique
Physique on page 4603 is a modifier that, when applied to a mesh, allows the
movements of an underlying skeleton to seamlessly move the mesh like bones
and muscle under a human skin. Physique will work on any point-based
object, including geometric primitives, editable meshes, patch-based objects,
NURBS, and FFD space warps. It will attach to any skeleton structure, including
a biped on page 4147, bones, splines, or any hierarchy.

NOTE For NURBS and FFDs, physique deforms the control points (control vertices),
which, in turn deform the model.

Pivot Point

Pivot point sets hand to the center of the clock face.

The transform center, or pivot point, is the spot about which a rotation takes
place, or to and from which a scale occurs.
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All objects have a pivot point. You can think of the pivot point as representing
an object's local center and local coordinate system.

The pivot point of an object is used for a number of purposes:

■ As the center for rotation and scaling when the Pivot Point transform
center is selected.

■ As the default location of a modifier center.

■ As the transform origin for linked children.

■ As the joint location for IK.

You can display and adjust the position and orientation of an object's pivot
point at any time using the Pivot functions in the Hierarchy command panel.
Adjusting an object's pivot has no effect on any children linked to that object.

Pixel
A pixel (short for Picture Element) is a single point in a graphic image. Graphics
monitors display pictures by dividing the screen into thousands (or millions)
of pixels, arranged in rows and columns.

Plant
In footstep animation on page 7986, the state of the biped foot when it is flat
on a footstep.

Plug-Ins
A plug-in is a feature or functionality supplied by an independent program
or component. Plug-ins can be supplied by third-party vendors or independent
software developers.

For example, several Video Post filter and layering plug-ins ship with 3ds Max.

The open architecture provides an API (application programming interface)
designed to make it easy for other companies to write plug-ins that extend
the core functionality of 3ds Max.
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PMAP File
A PMAP (.pmap) file is a mental ray photon-map on page 8090 file. This is a
binary file that the mental ray renderer on page 6230 uses to generate the effects
of caustics on page 6255 and global illumination on page 6261. You specify a name
and location for the PMAP file on the Render Setup dialog > Indirect
Illumination panel > Caustics And Global Illumination rollout on page 6306.

Point
A point in three-space, created when you use NURBS modeling to create a
Point Curve or Point Surface, or when you create an individual point
sub-object. Points that are part of a Point Curve or Point Surface are constrained
to lie on the curve or surface.

Points behave somewhat like vertices for spline objects on page 611, but their
behavior is not identical and they are a distinct object type. Helper object
points on page 2628 are also a distinct object type. You can't use spline vertices
or helper points as NURBS points (though you can convert a spline to a NURBS
curve).
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Point Curve

NURBS point curve

A curve defined by points. The points are constrained to lie on the curve. (Or
you can think of the curve as being dependent on its point locations.) More
than one NURBS solution is possible for a Point Curve; occasionally this can
cause unexpected results.
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Point Surface

NURBS point surface

A surface defined by points. The points are constrained to lie on the surface.
(Or you can think of the surface as being dependent on its point locations.)
More than one NURBS solution is possible for a Point Surface; occasionally
this can cause unexpected results.

Poses
When you work with a biped on page 4147, the pose is the stance of the entire
biped. You can copy and paste poses. See Copy/Paste Rollout on page 4389.

Positional Markers
In a motion-capture session, positional markers are reflective objects placed
on the “actor” or “talent.” The markers enable motion-capture hardware to
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record the position of various parts of the talent's body while performing
motions.

Posture
When you work with a biped on page 4147, the posture refers to the position
of selected biped parts, as opposed to the overall pose on page 8095. You can
copy and paste postures. See Copy/Paste Rollout on page 4389.

Precedence
You control an IK solution on page 8009 by setting joint precedence to determine
which joints contribute the most to the IK solution and which joints contribute
the least.

Joints with high precedence values are calculated first, and, therefore,
contribute more motion to the IK solution. Joints with low precedence values
are calculated last, and, therefore, contribute the least motion to the IK
solution.

Joints with equal precedence values are calculated by their order in the
hierarchy. Joints deeper in the hierarchy (closer to the end effector) are
calculated first and joints closer to the root are calculated last.

Premultiplied Alpha
There are two methods of storing alpha in a bitmap: premultiplied and
nonpremultiplied.

To composite an image that is in nonpremultiplied format, the alpha must
be multiplied by each of the R, G, and B channels before adding it to the color
of the background image. This provides the correct transparency effect, but
it must be done each time you composite. With premultiplied alpha, you store
the R, G, and B components with the alpha already multiplied in, so
compositing is more efficient.

This is not the only reason that 3ds Max stores images in the premultiplied
format. When you render an image, you typically want the edges of the objects
to be antialiased. This effect is achieved by determining the fractional coverage
of pixels on the edge of the object, and then adjusting the alpha of the pixel
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to reflect this. For example, a pixel that is 30% covered by the object will have
an alpha of 0.30.

To antialias the edges, the alpha must be premultiplied to darken these edge
pixels. (This is equivalent to compositing the image over a black image). So
it is natural, in a sense, for rendered images to have premultiplied alpha. If
you do not premultiply the alpha of a rendered image, then just looking at
the RGB you will see jaggies on the edges of objects. You would need to
composite it against black using the alpha channel whenever you wanted to
display it.

NOTE To control whether or not the renderer uses the environment map's alpha
channel in creating the alpha for the rendered image, choose Customize >
Preferences > Rendering, and then turn on Use Environment Alpha in the
Background Antialiasing group.

If Use Environment Alpha is turned off (the default), the background receives
an alpha value of 0 (completely transparent). If Use Environment Alpha is
turned on, the alpha of the resulting image is a combination of the scene and
background image's alpha channel. Also, when you render to TGA files on
page 7370 with Pre-Multiplied Alpha set to off, turning on Use Environment
Alpha prevents incorrect results.

TIP If you plan to composite objects in another program such as Combustion or
Photoshop, render the objects against a black background. Otherwise, a fringe of
environment or background color can appear around the objects.

Procedural Maps
Unlike a bitmap, which is an image produced by a fixed matrix of colored
pixels like a mosaic, a procedural map is generated by a mathematical
algorithm. Consequently, the types of controls you might find for a procedural
map will vary depending on the capabilities of the procedure.
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Three procedural maps (bricks, Perlin marble, and splat), with variations
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A procedural map can be generated in two dimensions, or in three. For
example, Wood has a grain that goes through the assigned geometry. If you
cut away part of an object with wood assigned as its texture, the grain in the
cutaway portion matches the grain on the object's exterior: it is all generated
by the same procedure.

Projector Light

Shadows created by projecting image of palm trees

By adding a map to a light, you turn it into a projector. You can assign a single
image, or you can assign an animation to create the effect of either a slide
projector or a movie projector.

You can also use projector maps to project black and white bitmaps to simulate
shadows seen through leaves or window frames, in the same way that gobos
are used in theater lighting.

You're not limited to circular projectors. Since you're usually projecting a
rectangular image, you can use a rectangular light to project it. You can use
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the Bitmap Fit option to adjust the aspect ratio of the light beam to match
that of the projected image.

When you use projection lights, it's often helpful to adjust their roll angle.
You can do this with the navigation controls or with the roll angle manipulator
on page 5082.

ProMaterials Library for mental ray
The ProMaterials™ library contains mental ray  ProMaterials on page 5647 based
on manufacturing-supplied data and professional images. This includes
building and design materials such as professional wall paint with glossy or
matte finishes, solid glass, and concrete. The library actually contains multiple
library (MAT) files. When you use the Material/Map Browser to browse libraries,
you see names such as autodesk.max.promaterials.ceramic.mat,
autodesk.max.promaterials.concrete.mat, and so on.

Prop Bone
The CSM marker file format on page 7945 supports a prop bone in either or both
hands. There are six additional markers for the top, bottom, and middle of
the two props. If these tracks are detected, character studio creates a 3ds Max
dummy object.

The length of the prop is the average distance between the top and bottom
prop marker during animation. The prop will be oriented in the plane of the
three prop markers, and its origin will be at the bottom prop marker.

Quadtree
A quadtree is a data structure used to calculate ray-traced shadows on page
8103.

The quadtree represents the scene from the point of view of the light. The
root node of the quadtree lists all objects that are visible in that view. If too
many objects are visible, the node generates four other nodes, each representing
a quarter of the view, each with a list of objects in that portion. This process
continues adaptively, until each node has only a small number of objects, or
the quadtree's depth limit (which can be set for each light) is reached.
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Each shadow-casting light ray needs to test intersection with the objects in
only one of the leaf nodes of the quadtree. This helps speed up the ray-tracing
process. In general, increasing the maximum quadtree depth can speed up
ray-tracing at a cost of memory.

The maximum size of a quadtree is the square of two to the power of the
maximum quadtree depth. At a depth of 7, the largest quadtree has 128 x 128
leaf nodes; at a depth of 10, the largest quadtree has a size of 1028 x 1028 leaf
nodes, and so on. (On the other hand, because each successive node contains
fewer objects, the size of a node's record decreases the deeper it is in the tree.)

NOTE An omni light can generate up to ten quadtrees, so omni lights that cast
ray-traced shadows use more memory at render time than spotlights do.

Queue Monitor
The Queue Monitor is a standalone network-administration tool that provides
a user interface to monitor and control network rendering.

The Queue Monitor can connect to any computer to which you have network
access with the appropriate security permissions, and a Network Manager
running on it. You can install the Queue Monitor separately. It will function
correctly on any Intel-based computer running Windows NT with appropriate
TCP/IP networking services, including over the Internet. In other words, you
can monitor and control network rendering services from any computer
connected to the Internet, in addition to using the Internet as a wide-area
backbone for a network rendering farm.

Radiosity
A technique to calculate indirect light to illuminate a scene. Radiosity calculates
the interreflections of diffuse light among all the surfaces in your scene. The
result is the radiosity solution on page 8101. See Modeling Global Illumination
with Radiosity on page 6168.

Radiosity Solution
The calculation of the radiosity on page 8101 effect in a scene. You compute the
radiosity solution as a separate step from rendering. Once the solution is
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computed, it can be used for multiple renderings. See Modeling Global
Illumination with Radiosity on page 6168.

Ray-Trace Acceleration (mental ray Renderer)
The mental ray renderer on page 6230 provides two different methods of
accelerating the process of ray tracing. The methods are:

■ BSP (Binary Space Partitioning). This method performs best for most
purposes.

■ BSP2. This method can perform better with large scenes and situations
with limited memory.

You set the raytrace acceleration method on the Render Setup Dialog >
Renderer panel > Rendering Algorithms rollout on page 6277.

Ray-Trace Bias

On the right, increased map bias makes the dog appear to float.

A single parameter, Ray-Trace Bias, affects the generation of ray-traced shadows
on page 8103. You set this parameter in the Shadow Parameters rollout.

The Ray-Traced bias control in the Shadow Parameters rollout moves the
shadow toward or away from the shadow-casting object (or objects). By default,
this value is 1 unit.

Increasing the bias moves the shadow away from the object, and decreasing
the bias moves the shadow closer to the object. The Ray-Trace Bias value can
be any positive floating-point number.
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For example, if a shadow-casting object intersects another object but its shadow
doesn't meet properly at the intersection, the bias is too high. This effect varies
with the angle of the spotlight to the object. Extremely shallow spotlight
angles usually require higher bias values.

Another purpose of bias is to avoid problems with objects that cast shadows
onto themselves. If you see streaks or moiré patterns on the surface of the
object, the bias value is too low.

Ray-Traced Shadows

Example of ray-traced shadows

Ray-traced shadows are generated by tracing the path of rays sampled from a
light source. Ray-traced shadows are more accurate than shadow-mapped
shadows on page 8125. They always produce a hard edge.

Ray-traced shadows are more realistic for transparent and translucent objects.
Also, only ray-tracing can generate shadows for wireframe objects.

Because ray-traced shadows are calculated without a map, you don't have to
adjust resolution as you do for shadow-mapped shadows. The parameters for
ray-traced shadows adjust the shadow's position (known as ray-trace bias on
page 8102) and the depth of the quadtree on page 8100 used to calculate ray tracing.

Advanced ray-traced shadows are the same as ray-traced shadows, however
they provide antialiasing on page 7904 control, letting you fine-tune how
ray-traced shadows are generated.
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RAYHOSTS File
The RAYHOSTS file is a text (ASCII) file that lists the name of host systems
capable of mental ray rendering on page 6230 in a distributed network. You turn
on distributed rendering on the Render Setup dialog > Processing panel >
Distributed Bucket Rendering rollout on page 6326.

Each line in the RAYHOSTS file contains the name of a host system. The host
name can be followed by a semicolon and a port number of the service to
connect to. The host name with or without the port number can also be
followed by white space and a list of mental ray command-line parameters.

See the manual, Rendering with mental ray, for descriptions of the mental ray
command-line options.

When you click Add on the Distributed Bucket Rendering rollout and use the
Add/Edit DBR Hosts dialog on page 6334 to add a host or satellite processor, this
updates the RAYHOSTS file. So does clicking Remove to remove a processor.

The RAYHOSTS file is named max.rayhosts. By default, it is located in the
\mentalray directory inside the program folder. You can change the default
location by creating an environment variable named MAX<X>_MI_ROOT,
where <X> is the 3ds Max version number, and setting the variable's value to
the path of the max.rayhosts file you want to use.

Real Time
By default, viewport animations play in real time, skipping frames where
necessary.

You can turn this off by clicking Time Configuration in the time controls,
and then turning off Real Time in the Playback group box of the Time
Configuration dialog on page 7565.

When Real Time is turned off, all frames are displayed during playback. The
playback may appear slow, but you'll know that you're seeing every frame.

You can also speed viewport animation by minimizing your viewports to
quarter size.
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Recognize Scene-Loading Technology
Recognize™ is an FBX-based scene-loading feature used for importing geometry,
lights, materials and cameras from Revit 2009. This feature includes the
numerous settings on the FBX Importer (and Exporter) dialog. Refer to the
FBX Plug-in Help for complete details.

Red, Green, Blue / Hue, Saturation,Value
There are two sets of color sliders in the Color Selector on page 391: the
red/green/blue (RGB) set and the hue/saturation/value (HSV) set. You can use
either set or both to mix a particular color. As you adjust the color sliders,
their RGB and HSV numeric values appear in the spinners.

There are separate RGB and HSV spinners as light parameters on page 4970.

RGB Sliders

Each of the RGB sliders is a band of red, green, or blue (the primary light
colors) shaded from black to the full intensity of the color. When you move
any slider, it mixes with the values of the other two, and the result appears
in the swatch beneath the sliders.

For example, if you move the Red slider all the way to the right (value 255)
and leave the other two at the left (0), the active swatch turns red. If you then
move the Green slider all the way to the right, the swatch turns yellow. If you
move all three sliders to 0, the result is black; if all three are at 255, the result
is white; and all three at any point of equal value produce shades of gray.
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HSV Sliders

If you prefer the hue/saturation/value color system, you can use the HSV
sliders to mix color. First move the Hue slider to the color band you want (if
the Value and Saturation sliders are set to low values, you don't see an
immediate result in the swatch). Move the Value slider to set the brightness,
or intensity of the color. Move the Saturation slider to determine the purity
of the color. The higher the saturation, the less gray the color.

Reference
References are like "one-way" instances. Referenced objects are based on the
original object, as are instances, and can have their own unique modifiers.
Any modification made to the original object is passed on to its references,
but any modification made to a reference is not passed back to the original.

The one-way effect is useful, since you can maintain an original that will affect
all its references, while the references themselves can take on individual
characteristics.

If you are modeling heads, for example, you might want to keep a family
resemblance in your characters. You could model basic features on the original,
then model specifics on each reference.

In the modifier stack, a solid line separates the reference from its parent object,
so you can see that the effect of modifiers on the reference will not affect the
parent object or other references to it.
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Reference Object
In Particle Flow on page 2795, a reference object is a geometry object or collection
of objects used as particles by the Shape Instance operator on page 2904. It can
be a single object, a group, a hierarchy, or even a compound object consisting
of several elements.

Refine
In NURBS modeling, refining means to increase the number of CVs on a curve
or surface. Refining does not change the curvature of the curve or surface.

Reinitialize 
In Physique on page 4603, when you need to reset vertex, envelope, and other
skin parameters, click Reinitialize to display the Physique Initialization dialog
on page 4683. Using controls in this dialog, you select which category to update,
and apply the new global settings you specify.

For example, if you've added a new bone to the hierarchy and want it included
and influenced by the Physique modifier, you'd use reinitialization. Or maybe
you've repositioned the biped structure relative to the mesh, or scaled both;
you'd need to reinitialize Physique settings to recognize those changes.

Repel Behavior
In crowd animation on page 4761, the Repel behavior lets you specify any object
or objects (sources) that will force delegates to move away from them. This is
basically the opposite of the Seek behavior. If you want delegates to back away
from an object, as opposed to turning to face the direction they're moving,
use Repel in conjunction with the Orientation behavior.

Reservoir
The Reservoir is a storage area for clips (BIP files on page 7923) used by the
Motion Mixer on page 8052. The Reservoir contains a single entry for each clip
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adaptation on page 7900 used in the Mixer. You can use the Reservoir to load
previously used clips, save adaptations to new BIP files, or view a clip's
adaptation data. See Using the Reservoir on page 3745.

The purpose of the Reservoir is to save memory. Instead of storing the
animation and adaptation data for each clip inside the clip, it is stored in the
Reservoir. When a clip is used more than once in the Mixer, the clip
occurrences can share the data from the Reservoir, saving memory.

Resolution
The horizontal and vertical number of pixels in a 2D image. For example, a
640x480 resolution describes an image that is 640 pixels across by 480 pixels
down. Resolution can also refer to an image’s bit depth, such as 24-bit or
32-bit.

You set the resolution of the image you are going to render on the Render
Setup dialog on page 6067.

Reveal Rendering
Reveal™ is used to perform iterative rendering by isolating regions, selections
or calculations to improve rendering speed while working on specific elements
to complete a final image. Access the Reveal feature set in the Render Setup
Dialog  on page 6067, directly in the Rendered Frame Window and the Viewport.

Review
Review is a previewing feature that can be used to view multiple maps
simultaneously in the Viewport. You can preview photometric lights (including
IES files) to see how real luminaries will affect the environment and real-time
shadowing of objects that use Arch&Design materials. Access the Review
feature from the right-click menu in the viewports.
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Rotoscoping

Boat is an object composited over video of breaking wave.

Rotoscoping is the process of bringing video frames into a scene to use as the
background for matching objects.

The way to use rotoscoping is to specify a digital disk recorder or movie file
and read the frames into the viewport using the Animation Synchronization
controls in the Viewport Background dialog. Once you've specified your source
device or file in the Viewport Background dialog, one frame of the video
displays for each scene frame by default. Remember to tun on Animate
Background as well as Show Background to have your video frames appear in
sequence in the viewport.

To produce the composited, rendered image, use Video Post or a compositing
application to composite the background image and the rendered scene
together.

Rubber-Band Mode
When you work with a biped on page 4147, Rubber-Band mode provides a way
to proportion the arm and leg links simultaneously, by moving the link with
the Move transform, instead of using scale. Rubber-Band mode scales both
the link and its child in a single step.

This is particularly useful when fitting a biped to a skin prior to applying the
Physique modifier on page 4603. For example, rubber-banding the upper arm
rescales the upper and lower arm objects and moves the elbow link without
affecting the position of the shoulder or the wrist. If you've spent a lot of time
getting the fingers in the right place, you can reposition the elbow by
rubber-banding, without affecting the hands.
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RVT Link
When working on Revit projects, you can import/link DWG, DXF, DGN, RVT
and image files. These files can contain 2D and 3D geometry to help in the
construction of your projects. Raster images can be imported as background
images into your Autodesk Revit project or as visual aids needed during the
creation of a model.

When you've exported the project to a DWG file, RVT links are comparable
to xrefs in an AutoCAD drawing.

For more information about the Import/Link features of Revit, refer to the
Autodesk Revit Help file.

Safe Frame

Safe frame borders show which portions of a viewport will be visible when rendered
to video.

The Safe Frame provides a guide to help avoid rendering portions of your
image that might be blocked in the final output.

For example, to ensure that no unintentional black areas are visible on a
television screen, broadcasters intentionally "overscan" the video image. The
result is that portions of an image around the edges are not visible on a typical
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set. In addition, portions of images on 35mm slides can be partially covered
by the slide mounts.

You can adjust the size of the safe frame as a percentage of the outer display
rectangle with the Safe-Frame controls on the Viewport Configuration dialog.
Depending upon its size, the safe frame can be used as the equivalent of a
"title safe frame" (the area inside which it is safe to display titles), or an "action
safe frame" (the area inside which action may occur without significant loss
of information).

To view the frames, choose Show Safe Frame from the viewport right-click
menu (displayed when you right-click the viewport label). Three rectangles,
one yellow, one green, and one pale blue, appear in the camera viewport. The
outer, yellow video rectangle shows the area and aspect ratio of your current
display. The middle, green rectangle represents the action safe zone. The inner,
pale blue rectangle shows the title safe zone.

To turn off the display, choose Show Safe Frame again.

Sample Range

Low sample range can cause jagged-edged shadows.
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Higher sample range causes soft-edged shadows.

Sample Range affects the softness of the edge of shadow-mapped shadows on
page 8125. The sample range determines how much area within the shadow is
averaged.

Small values reduce the area that is averaged, effectively bringing the edge of
the shadow inward, producing sharper-edged shadows. Sharper edges can
cause aliasing.

Large values extend the area that is averaged, effectively bringing the edge of
the shadow outward, producing softer-edged shadows. Soft-edged shadows
have more antialiasing. The effect is somewhat like the falloff of a soft-edged
spotlight.

The default Sample Range value is 4. The Sample Range value can be any
floating-point number from 0 to 20. Values of 2 to 5 are recommended. Values
below 3 can produce coarse-edged shadows. You can reduce this effect by
increasing the map size.

Values greater than 5 can produce streaking and moiré patterns. You can
reduce this effect by increasing the map size or the Bias value.

Rendering time increases exponentially as the Sample Range value increases.

Sampling (mental ray Renderer)
Sampling is an antialiasing technique. It provides a "best guess" color for each
rendered pixel. The mental ray renderer on page 6230 first samples the scene
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color at locations within the pixel or along the pixel's edge, then uses a filter
to combine the samples into a single pixel color.

(In 3ds Max, this technique is called "supersampling." Because the mental ray
renderer performs sampling on a scene basis, in the Material Editor, you don't
need to turn on supersampling for materials rendered using mental ray.)

Scene rendered with low sampling is jagged and inaccurate.

Sampling range: 1/64 to 1/4
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Same scene rendered with higher sampling shows smooth edges.

Sampling range: 1 to 16

The mental ray renderer provides five filter methods: Box, Gauss, Triangle,
Mitchell, or Lanczos. Box, the default, is also the quickest. Mitchell is often
the most accurate. The Box filter combines samples evenly, without weighting
them. Each of the other filters uses a particular curve to weight samples before
combining them.

Curves used to weight samples (these are approximate)

You choose the sampling filter and set other sampling options on the Render
Setup dialog > Renderer panel > Sampling Quality rollout on page 6272.
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NOTE Area lights (Area Omni Light on page 5070 and Area Spot Light on page 5073)
have their own sampling controls. These affect only shadows cast by the area light.
They are independent of the sampling used to render the scene as a whole.

Rendering the Sampling Rate

To help you choose a sampling filter, you can render a scene with diagnostics
enabled and Sampling Rate chosen on the Render Setup dialog > Processing
panel > Diagnostics rollout on page 6324. The Sampling Rate diagnostic tool
gives a schematic rendering that shows how the sampling method behaves
with your scene.

Rendering with diagnostic display of the sampling rate turned on

Sampling range: 1 to 16

The intensity of each pixel indicates the number of samples collected within
it and on its lower and left edges. The brighter the pixel, the greater the number
of samples. Overall, the View Sample rendering is normalized so the brightest
pixels have the maximum number of samples. Also, red boundaries indicate
the boundaries of sampling tasks.
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Lock Samples and Animation

By default, the mental ray renderer introduces a pseudo-random (quasi Monte
Carlo) variation in the sampling pattern from frame to frame. This reduces
rendering artifacts in animations.

You can turn off the sampling variation by turning on Lock Samples on the
mental ray: Sampling Quality rollout on page 6272.

Jittering

"Jitters" samples by introducing a variation into sample locations. Turning on
Jitter can help reduce aliasing. Default=off.

The Jitter control is also on the Sampling Quality rollout on page 6272.

Scale Stride
In footstep animation on page 7986, the Scale parameter lets you change the
length or width of a footstep selection (or both at once). This setting is on the
Footstep Operations rollout on page 4438.

The selected footsteps are scaled around the first footstep in the selection.

Scanline Renderer
The scanline renderer on page 6141 is the default renderer. By default, you use
the scanline renderer when you render a scene from the Render Setup dialog
on page 6067 or from Video Post. The Material Editor also uses the scanline
renderer to display materials and maps.

The image produced by the scanline renderer displays in the rendered frame
window on page 6073, a separate window with its own controls.

As the name implies, the scanline renderer renders the scene as a series of
horizontal lines. 3ds Max additionally provides the interactive viewport
renderer to provide a quick and simple rendered view of your scene as you
work on it. You might also have other plug-in or third-party renderers that
you've installed to work with 3ds Max.
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Scene Extents
Just as an object's extents on page 7969 are its maximum dimensions in X, Y,
and Z, the extents of a scene are its maximum dimensions in these three axes,
and define a box that encloses the entire scene.

Scene Motion Blur
Motion blur can enhance the realism of a rendered animation by simulating
the way a real-world camera works. A camera has a shutter speed, and if
significant movement occurs during the time the shutter is open, the image
on film is blurred.
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Above: Scene motion blur creates an effect of movement. (The background is blurred
because of slow camera panning.)

Below: The same scene with no blurring

3ds Max provides several ways to generate motion blur. Scene motion blur is
one. Image motion blur is another. For most purposes, image motion blur on
page 8010or multi-pass motion blur on page 5234 give better results than scene
motion blur. Use scene motion blur whenever you want to strongly emphasize
rapid motion. You can use both image and scene motion blur in the same
rendering.

(Another option, object motion blur on page 8063, is not meant to simulate a
camera, but to improve the rendered appearance of fast-moving objects.)
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You apply scene motion blur in Video Post on page 6773. It is one of the options
for a Scene Event on page 6808. In the Add or Edit Scene Event dialog, turn on
Scene Motion Blur in the Scene Options group, and then adjust the parameters.

Scene motion blur creates trails behind all moving objects by rendering the
entire scene at multiple time increments within each frame, and then creating
the frame by compositing the multiple images together.

Schematic View
Schematic View on page 7411 is a window that lets you see everything in your
scene as a node on a graph. The nodes on page 8058 are repositionable to create
custom configurations.

Use Schematic View to see and select all nodes that share a relationship, such
as a material or instanced modifier. You can perform basic operations on the
nodes such as rename, cut and paste modifiers or materials, or create
hierarchical linkages. You can use Schematic View to see and edit other
relationships such as wired parameters and constraints.

Script
A sequence of instructions used to automate a task. Scripts are typically text
files containing coded instructions for a particular application.

In 3ds Max, the MAXScript utility supports a scripting language.

MAXScript scripts have the file name extension .ms. By default, they are saved
in the scripts folder.

Script Editor Window
A text editing window provided with the MAXScript scripting system. A script
editor window can edit any kind of ASCII text file, but is particularly suited
to building and modifying MAXScript script files.

You open a script editor using the Open Script or New Script commands from
the MAXScript menu.
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Scripted Behavior
A behavior defined by MAXScript. When you use the cognitive controller on
page 4857 with crowd animation on page 4761, you can add conditional
expressions written in MAXScript that impose changes in behavior.

Scripted Utility Panel
A scripted utility panel is a custom command-panel rollout created using the
MAXScript scripting language. They let you create a graphical user interface
to a MAXScript script.

Scripted utility panels are available through the Utilities drop-down menu in
the MAXScript rollout of the Utilities panel.

Scripts (Motion Flow)
In motion flow mode on page 4508, a script is a list of clips (BIP files) that are
executed sequentially to animate a character. You can create scripts either
manually or automatically using crowd animation on page 4761.

Scripting
A scripting language is a programming language embedded in a host
application, and used to automate tasks within the application. 3ds Max
provides MAXScript as its scripting language.

MAXScript controls are located on the Utilities panel.

Seed Value
In NURBS sub-objects, a location in parameter space that is used to resolve
ambiguities in some kinds of sub-object creation. The seed value is a location
on a parent object, and the location nearest to the seed value that satisfies the
creation condition is the one that the software chooses. For a curve, the seed
value is a U location in the curve's parameter space. For a surface, the seed
location is a pair of UV coordinates in the surface's parameter space.
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Seek Behavior
In crowd animation on page 4761, the Seek behavior lets you specify any object
or objects as a stationary or moving target for delegates. Delegates move toward
the target during the crowd simulation while turning as necessary.

Segment

The arrow and highlight indicate a single segment in a spline.

The portion of a NURBS point curve between two of its control points, or the
portion of a spline between two vertices. (NURBS CV curves don't have
segments, as their control vertices don't lie on the curve.)
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Self-Illumination

The lamp on the right uses self-illumination to brighten the bulb and the glass panes.

Self-Illumination creates the illusion of incandescence by replacing any
shadows on the surface with the diffuse color. At 100 percent, the shadows
are completely replaced by the diffuse color, creating the illusion of
self-illumination.

Unless you use environmental effects, only lights illuminate your scene; they
don't appear in the rendering. You can use self-illuminated materials on objects
that represent lights to provide things like car headlights, and so on.

A self-illumination map lets you use a map to affect the intensity in different
areas of the self-illuminated surface. Like many other map types, only the
intensity of the map values affects self-illumination. White provides the most,
while black blocks the illumination completely.

It's often a good idea to design a self-illumination map to match your diffuse
map. For example, the diffuse map might have small, yellow rectangles to
represent windows, while the self-illumination map consists of matching
white rectangles against black to illuminate the yellow windows.
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TIP To have an object behave as an actual light source (for example, a spline that
models a neon light), use the scanline renderer on page 6141, photometric lights
on page 5005 with a radiosity solution on page 6168, and assign an Advanced Lighting
Override material on page 5734 to make the object luminous.

Shaders (mental ray Renderer)
In mental ray, a shader is a function that calculates light effects. There can be
shaders for lights, cameras (lens shaders), materials, shadows, and so on.

In 3ds Max, the mental ray translator provides the functionality of light and
camera shaders. Material shaders correspond to 3ds Max materials.

A number of shaders are provided with 3ds Max. See mental ray Shaders on
page 5974, mental ray Connection Rollout on page 5385, and mental ray Materials
on page 5543.

The mental ray manual, Programming mental ray, describes how to write custom
shaders.

Shaders (Standard Materials)
For a standard material on page 5395, the shader is the algorithm that controls
how the material responds to light. Shaders especially control how highlights
appear. They also provide a material's color components, and control its
opacity, self-illumination, and other settings. Shaders are often named for
their inventors; they can also be named for the effect they provide. See Shading
Type on page 5265.

Glossary | 8123



Samples of different shading for a standard material

1. Anisotropic

2. Blinn

3. Metal

4. Multi-layer

5. Oren-Nayar-Blinn

6. Phong

7. Strauss

8. Translucent

For each material, one of the available shaders is always active. You choose
the shader on the material's Shader Basic Parameters rollout on page 5397.
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The raytrace material on page 5490 uses a subset of the standard material shaders:
Anisotropic, Blinn, Metal, Oren-Nayar-Blinn, and Phong. You choose the
raytrace material's shader on the material's Raytrace Basic Parameters rollout
on page 5493.

The other types of materials in 3ds Max don't give you a choice of shader.

Materials (and lights and cameras) used with the mental ray renderer on page
6230 can use mental ray shaders, which are not the same as the standard material
shaders. See Shaders (mental ray Renderer) on page 8123.

Shadow Maps (Light Objects)

Example of shadow-mapped shadows

A shadow map is a bitmap that the renderer generates during a pre-rendering
pass of the scene. Shadow maps don't show the color cast by transparent or
translucent objects. On the other hand, shadow maps can have soft-edged
shadows, which ray-traced shadows cannot.

A shadow-map is projected from the direction of the spotlight. This method
provides a softer edge and can require less calculation time than ray-traced
shadows, but it's less accurate.

You can adjust the shadow map settings to achieve a sharper shadow. This
involves changing the resolution and the pixel sampling of the shadow's
bitmap. Because shadow-map shadows are only bitmaps, you need to keep in
mind their resolution in relation to your distance from the shadow, and the
detail required by the shadow. If the resolution is too low, and the camera
too close, the shadow might look more like sooty smudges.
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If shadows appear too coarse when you render them, increase the map size.
The size can range from 0 to 10,000. However, be aware that greater size
requires more memory and can take longer to generate. A 4096-line shadow
map occupies 64 MB of memory (4096 x 4096 x 4).

If you have enough RAM to hold the entire scene including shadow maps,
shadows don't affect performance, but if the renderer has to use a virtual
memory swap file, rendering time can slow considerably.

The default shadow map size is 256.

The bitmap used by shadow maps must fill the area covered by the falloff of
the spotlight. The wider the falloff, the coarser the shadow appears. Keep the
falloff as tight as possible given the requirements of your scene.

Shadow Map (mental ray Renderer)
A shadow map is a bitmap that the mental ray renderer generates during a
pre-rendering pass of the scene. Shadow maps can require less calculation
time than ray-traced shadows, but the shadows they generate can be less
accurate.

The mental ray renderer saves shadow maps as ZT files on page 8177. Shadow
map controls are on the Render Setup dialog > Renderer panel > Shadows &
Displacement rollout on page 6292.
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Shapes and Splines

Spline

A shape is an object made up of one or more splines. A spline is a collection
of vertices and connecting segments that form a line or curve. By adjusting
values in the vertices, you can make portions of the line curved or straight.

Shapes don't usually appear in the rendered scene. They're used for the
following purposes:

■ As the foundation for extruded objects, by applying an Extrude modifier
to the shape.

■ As the foundation for a spun object, by applying a Lathe modifier to a
shape.

■ As the components that make up a Loft object, by combining a shape as
a path, and one or more shapes as cross-sections along the path.

■ As an animation path for an object by assigning a path constraint to the
object, and then picking a shape as the path.
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■ As one method of linkage for inverse kinematic chains.

You can make shapes renderable to create tubular forms in the rendering.
Renderable shapes don't appear any different in viewports.

Shapes can also be NURBS curves on page 2237. You can use NURBS curves in
exactly the way you use spline-based shapes. You can also use a NURBS curve
as the basis for a NURBS model that includes multiple curve and surface
sub-objects.

Get Shape (Lofting)

A circle is lofted along a path to construct a tubular shape. Get Shape chooses the
contour spline.

You use Get Shape as a loft creation method when you want the shape to
move to the location of the selected path. For example, you use this method
if you have created a path at the exact location where you want your loft
object to be. You use Get Shape to create a loft at that location.

Get Shape causes the shape to move and rotate to align itself with the current
level of the path. The exact orientation of the shape is controlled by two other
loft settings named Contour and Banking.
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The following describes the orientation of the first shape at level 0:

■ The pivot point of the shape is located on the path at the current path
level.

■ The positive Z axis of the shape is aligned with the tangent to the path at
the current path level.

■ The local Y axis of the shape is aligned with the local Z axis of the path.

Sometimes, aligning the positive Z axis of the shape with tangent of the path
does not produce the result you want. You can flip the orientation of the
shape by pressing Ctrl while getting the shape. Pressing Ctrl aligns the shape
so that the negative Z axis of the shape is aligned with the tangent to the path.

SHP Files
SHP is the 3D Studio R4 (DOS) shape-file format. You can import these files
into 3ds Max.

The .shp file contains polygons created in the 2D Shaper in 3D Studio.

When importing an SHP file that contains multiple shapes, the software gives
you the option to either merge them all into one object or make multiple
incoming objects.

The shape importer looks at the vectors on incoming splines, and if they're
collinear within a couple of percentage points, it changes the angle to a
smoothed Bezier (otherwise, it's a Bezier corner).

Skylight
In the real world, daylight does not just come from direct sunlight; it also
comes from skylight that is scattered through the atmosphere. 3ds Max offers
great realism and accuracy by calculating not only sunlight, but calculating
this scattered light as well.

In 3ds Max, the sky is modeled as a dome of infinite radius placed around the
scene. Daylight computes the illumination of a point in the scene with
reference to all directions around the point where the sky is visible. The sky
brightness is not constant over the sky dome, but rather it changes depending
upon the position of the sun.
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See also:

■ Sunlight on page 8140

■ Sunlight and Daylight Systems on page 5139

Sliding Footstep
In footstep animation on page 7986, changing biped foot key parameters enables
the biped feet to move or slide during a footstep period. This feature is also
available for motion-capture file import to allow the biped feet to slide or
pivot. In the viewports, a sliding footstep is displayed as a footstep with a line
through the middle.

Smoothing Groups

Left: The bottle has no smoothing.

Middle: Smoothing is assigned only to the highlighted group of faces.

8130 | Glossary



Right: The bottle is smoothed using three different smoothing groups: on the body,
the neck, and the top edge.

Smoothing groups define whether a surface is rendered with sharp edges or
smooth surfaces.

Smoothing groups are numbers assigned to the faces or patches of an object.
Each face or patch can carry any number of smoothing groups up to the
maximum of 32. If two faces or patches share an edge and share the same
smoothing group, they will render as a smooth surface. If they don't share the
same smoothing group, the edge between them will render as a corner.

You can manually change or animate the threshold values for smoothing
group assignments using such tools as Editable Poly (Polygon/Element)  on
page 2177 and the Edit Mesh modifier on page 1353.

SMPTE
SMPTE (Society of Motion Picture and Television Engineers) is the standard
time display format for most professional animation work.

From left to right, the SMPTE format displays minutes, seconds, and frames,
delineated by colons. For example:2:16:14

represents 2 minutes, 16 seconds, and 14 frames.

As you move through time in a SMPTE display, when the seconds field
increments, the frames field recycles to 0 and starts over. For example, given
an NTSC frame rate of 30 frames per second, as you move through time, the
frames field counts from 0 to 29, at which point the seconds field increments
by 1, and the frames field begins again at 0.

As with the Frames display format, the SMPTE format lets the time slider move
at single-frame increments.

Space Warp Behavior
In crowd animation on page 4761, the Space Warp behavior lets you assign a
space warp, such as Wind or Gravity, to one or more delegates. The Space
Warp behavior can use any space warp in the Forces category. These space
warps treat delegates on page 7951 as if they were particles.
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You can also use the Space Warp behavior to bind delegates to the Vector
Field space warp on page 4917 provided with character studio. This space warp
causes delegates to avoid an object while following its contours.

Space Warps
Space warps on page 2685 are objects that provide a variety of "force field" effects
on other objects in the scene.

Space warps themselves are not renderable. You use them to affect the
appearance of other objects, sometimes a large number of objects at the same
time. Some space warps deform object geometry by generating ripples, waves,
or explosions. Other space warps are meant specifically for use with particle
systems, and simulate natural effects such as wind blowing snow or rain about,
or a rock in the path of a waterfall.

Space warps behave somewhat like modifiers, except that a space warp
influences world space, rather than object space as geometric modifiers do.

When you create a space warp object, viewports show a representation of it.
You can transform the space warp as you do other 3ds Max objects. The
position, rotation, and scale of the space warp affect its operation.

To have an object or selection set be affected by a space warp, you bind the
object to the space warp. A space warp has no effect on objects unless the
objects are bound to it. When an object is bound to a space warp, the warp
binding appears at the top of the object's modifier stack. A space warp is always
applied after any transforms or modifiers.

When you bind a space warp to multiple objects, the space warp's set of
parameters affects all the objects equally. However, each object's distance from
the space warp or spatial orientation to the warp can change the warp's effect.
Because of this spatial effect, simply moving an object through warped space
can change the warp's effect.

You can also use multiple space warps on a single object or objects. Multiple
space warps appear in an object's stack in the order you apply them.

Spawn Particles
In Particle Flow on page 2795, spawn particles are new particles that are generated
from existing particles (parent particles on page 8081) in a process called spawning.
You can use the Spawn test on page 2991 to create spawn particles arbitrarily,
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or the Collision Spawn test on page 2964 to create spawn particles as the result
of physical interaction between a parent particle and a deflector.

Specular Color

Changing specular color tints highlights on the shiny surface of the spacecraft.

Specular color is the color of highlights on a shiny surface. The highlights are
reflections of the lights that illuminate the surface. For a naturalistic effect,
set the specular color to the same color as the key light source, or make it a
high-value, low-saturation version of the diffuse color.

In 3ds Max, you can set the specular color to match the diffuse color. This
gives a matte effect, making the material appear less shiny.

Matching specular color to the diffuse color makes the surface less shiny.
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Speed Vary Behavior
In crowd animation on page 4761, the Speed Vary behavior is useful for objects
whose velocity changes as they move, such as strolling tourists who might
occasionally slow down to do some sightseeing.

Splice
The term splice means to cut a sequence, insert a segment and join the cut
ends to the segment. It can also mean a simple joining of ends to a segment.

In character studio, you can splice a footstep sequence. You do this by copying
a footstep sequence, then moving it to the middle or end of another footstep
sequence and placing it there. The ends of the segments are joined
automatically to make a smooth footstep sequence.

You can use splicing to extend your footstep animation or build a cyclic
sequence.
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Spline

Top: Spline

Middle: A segment of the spline

Bottom: Vertices of the spline

A type of curve that is interpolated between two endpoints and two or more
tangent vectors. The term dates from 1756, and derives from a thin wood or
metal strip used for drafting curves in architecture and ship design.

Spline Dynamics
Spline Dynamics is a biped dynamics on page 7923 option located on the
Dynamics & Adaptation rollout on page 4417. Choosing Spline Dynamics creates
keys for the biped's center of mass without calculating gravity or balance
(Dynamics Blend=0.0 and Balance Factor=0.0).
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Startup Script
When 3ds Max first starts, MAXScript searches for any startup script files,
which it then automatically loads and runs. This feature is useful if you have
function libraries you always use and want preloaded, or if you want to
establish custom UI settings, define scripted plug-ins, or load scripted utility
rollouts.

MAXScript first searches for .mcr (macroScript definition files) in the
ui\macroscripts directory. These macroScript definitions are not compiled at
this time; rather they are just scanned to identify the macroScripts that have
been defined.

MAXScript next searches for .ms, .mse, and .mzp files in the plug-in path
directories (defined on the Configure System Paths dialog on page 7732 and
Configure User Paths dialog on page 7729) and their subdirectories, and compiles
these files. The base scene and user interface have not been created at this
point, so no viewport or scene commands should be executed in these files.
These files should primarily define scripted plug-ins and utility functions.

Any utility functions used by the macroScripts defined when reading the
ui\macroscripts directory should be defined in a .ms or .mse file in one of these
directories. You can prevent a nested directory from being scanned by placing
its name in parentheses, for example "(old-versions)", allowing you to enable
and disable scripts in handy directory-based groupings.

At this point, 3ds Max creates the base scene and user interface. Any macro
scripts used by buttons in the user interface are compiled at this time.

The automatic loading of the following startup script files can be deactivated
by turning off the Auto Start MAXScript option in the MAXScript page of the
Preferences dialog, as described in MAXScript Preferences on page 7782.

MAXScript first searches for a file named startup.ms in the following directories,
in this order:

1 The Scripts directory (defined on the Configure User Paths dialog > File
I/O panel)

2 The Startup Scripts directory (defined on the Configure System Paths
dialog)

3 The 3ds Max executable main directory

4 The Windows NT 32-bit system directory (system32)

5 The Windows 16-bit system directory (system)
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6 The Windows directory

7 The directories that are listed in the PATH environment variable

MAXScript stops searching when it finds the first occurrence of startup.ms.

MAXScript then recursively scans the Startup Scripts directory (defined on the
Configure System Paths dialog) and any nested directories for .ms, .mse, and
.mzp script files and loads them. In this pass, any script files with the name
startup.ms are ignored. You can prevent a nested directory from being scanned
by placing its name in parentheses, for example "(old-versions)", allowing you
to enable and disable scripts in handy directory-based groupings.

If you specify a script to run in the command line (-U MAXScript script_name),
the script is executed at this point. (See the MAXScript Reference topic
“Running Scripts from the Command Line”).

SteeringWheels Navigation
SteeringWheels™ on page 114 are tracking menus that are divided into different
sections known as wedges. Each wedge on a wheel represents a single
navigation tool. You can pan, zoom, or manipulate the current view of a
model in different ways.

SteeringWheels, also known as wheels, combine many of the common
navigation tools into a single interface. Wheels are specific to the context that
a model is being viewed in. The SteeringWheels feature is on by default.
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Sub-Object

Left: A selection of face sub-objects

Middle: A selection of edge sub-objects

Right: A selection of vertex sub-objects

A sub-object s a subset of an object's geometry. Many objects have various
types of sub-objects that you can work with independently. For example, an
editable mesh object's on page 2075 sub-objects are vertices, edges, faces,
polygons, and elements. To access sub-objects, go to the Modifier panel. In
the modifier stack display, click the plus-sign button to display an object's
hierarchy, and then choose the sub-objects level from the hierarchy. At the
sub-objects level you can select sub-objects, transform the selections, apply
modifiers, and so on.

Many topics in the online reference deal with sub-objects. To see a list of
sub-object-related topics, search on the term “sub-object” (include the quote
marks in the keyword).
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Sub-Object Level

Edge sub-objects level chosen while editing a mesh.

Some types of objects let you change to a sub-object level to edit their
component parts. For example, editable meshes on page 2075 have Vertex, Edge,
Face, Polygon, and Element sub-object levels. NURBS models on page 2237 can
have Surface, Curve, Point, Surface CV, Curve CV, and Import sub-object
levels.

You change the active sub-object level using the Modifier Stack display on
page 7635 on the Modify panel.

Glossary | 8139



Subtractive Opacity

Sphere on the right uses subtractive opacity.

Subtractive opacity darkens colors behind the material by subtracting the
material's colors from the background colors.

If you simply want to reduce the apparent opacity of a material, while
maintaining the color values of its diffuse (or mapped) properties, use
subtractive opacity.

See also:

■ Additive Opacity on page 7901

Sunlight
The Sun is modeled as a parallel light source, which makes the incident
direction of sunlight constant over all surfaces in the scene. You can specify
the direction and intensity of the sun directly. Alternatively, the direction
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and intensity of the sun can be calculated based on geographical location,
time, and sky condition settings.

See also:

■ Skylight on page 8129

■ Sunlight and Daylight Systems on page 5139

Super Black
Super Black limits the darkness of rendered geometry. This option is used for
video compositing. When compositing, you need pure black for the
background, but overlying objects need to be less than pure black so that you
can still see exactly where they are. Also, some video systems have problems
with black that has RGB values of 0,0,0, and consider it an "illegal" color.

Unless you're sure you need it, leave the Render Setup dialog > Super Black
check box off.

The scanline and mental ray renderers use the value of the Super Black >
Threshold preference setting on page 7769 to determine the maximum darkness
of the rendered scene. For example, if you're rendering a heavily shadowed
object against a black background, although the background will be rendered
as pure black, the deepest shadows on the object will be no darker than the
intensity level specified by the Threshold setting (default is 15).

NOTE Setting the Threshold value too high can artificially raise low-blended values.
This can ruin antialiasing effects in the renderer.

Supersampling
Supersampling is one of several antialiasing techniques that the software
performs. Textures, shadows, highlights, and raytraced reflections and
refractions all have their own preliminary antialiasing strategies. Supersampling
is an optional additional step that provides a "best guess" color for each
rendered pixel. The supersampler's output is then passed on to the renderer,
which performs a final antialiasing pass.

See also:

■ SuperSampling Rollout on page 5381
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Support Period
In footstep animation on page 7986, the period where one or both of the biped
feet are on the ground.

Surface Arrive Behavior
In crowd animation on page 4761, the Surface Arrive behavior is similar to the
Seek behavior: it lets you specify one or morer objects as a stationary or moving
target for delegates. The principal difference is that you can use the Approach
settings to specify an intermediate target. After reaching this location, the
delegates will then make their final approach to the ultimate target surface.
An example would be birds flying over a row of telephone poles, and then
each one dropping to land on top of a different pole.

Surface Follow Behavior
In crowd animation on page 4761, the Surface Follow behavior moves delegates
with respect to object surfaces. Target objects can be animated. For example,
you can apply an animated Noise modifier to a patch grid to simulate a choppy
water surface, and objects guided by Surface Follow will stay on top.

Synthesis, Synthesize
Synthesizing is the process of computing (solving) motions for crowd
simulations on page 4761. The resulting simulation is a synthesis.

Talent Figure Mode 
When you work with motion capture on page 4574, after you load a raw marker
file on page 8037, you can turn on Talent Figure mode to scale the biped relative
to the markers. Calibration for the entire marker file takes place when you
exit Talent Figure mode.
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Tangents
The tangent of a function curve affects the interpolated values between the
keys of an animation. Most animation controllers use fixed tangents to define
the function curve at a key location.

By default, 3ds Max assigns smooth tangents to the keys in a Position function
curve. This is the reason that an animated object moves in smooth curves
through the key frames. 3ds Max assigns smooth tangents because they usually
provide the most natural motion.

Of course, you also need a way to add some corners and abrupt turns when
you need them. The Linear controller on page 3193 uses a discontinuous tangent
that points at the preceding and following keys, producing an abrupt change
in motion at that key.

The two large flyout buttons at the bottom of the Key Info dialog provide five
different types of predefined tangent types on page 3129, plus a sixth type that
lets you create your own custom tangents.

If you look at a single key dot and the line running through it, the line on
the left side of the key dot is the incoming tangent, and the line on the right
is the outgoing tangent. Using the tangent flyout buttons, you can assign a
different tangent type to the incoming and the outgoing lines for each key
dot.

The button on the left assigns the incoming tangent at the left side of the
selected key dot, and the button on the right assigns the outgoing tangent on
the right side of the selected key dot.

TCB (Biped)
TCB is short for Tension, Continuity, and Bias. These parameters quantify the
traditional animation technique of ease in and ease out (also known as “slow
in and slow out”). In freeform animation on page 7988 of a biped, you can use
them to change the timing of a limb's movement from key to key.

The TCB controls are in the TCB section of the Key Info rollout on page 4367.
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TCB (Tension, Continuity, Bias)
The TCB Position controller provides Tension, Continuity, and Bias controls
of the splines of a function curve.

TCB Controllers on page 3258 also produce curve-based animation much like
the Bezier controllers on page 3138. However, TCB controllers do not use tangent
types or adjustable tangent handles. They use numeric values to adjust the
Tension, Continuity, and Bias of the animation.

Bias Controls where the animation curve occurs with respect to the key.

High Bias pushes the curve beyond the key. This produces a linear curve
coming into the key and an exaggerated curve leaving the key.

Low Bias pulls the curve before the key. This produces an exaggerated curve
coming into the key and a linear curve leaving the key.

The default value of 25 distributes the curve evenly to both sides of the key.

Continuity Controls the tangential property of the curve at the key. The
default setting is the only value that produces a smooth animation curve
through the key. All other values produce a discontinuity in the animation
curve causing an abrupt change in the animation.

High Continuity values create curved overshoot on both sides of the key. Low
Continuity values create a linear animation curve.

Low continuity creates a linear curve similar to high tension except without
the Ease To and Ease From side effect.

The default value of 25 creates a smooth continuous curve at the key.

Tension Controls the amount of curvature in the animation curve.

High Tension produces a linear curve. It also has a slight Ease To and Ease
From effect.

Low Tension produces a very wide, rounded curve. It also has a slight negative
Ease To and Ease From effect.

The default value of 25 produces an even amount of curvature through the
key.

Tendons
When you use Physique on page 4603, after you adjust envelope parameters for
good mesh deformation, you can use tendons on page 4747 to control the
amount of skin stretching across multiple links. While envelopes provide
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smooth skin deformations, tendons provide additional stretching in much
the same way that actual human tendons might create pulling in the wrist
(several joints away) when the fingers are moved.

Tension, Continuity, Bias (Biped)
Tension, Continuity, and Bias (TCB) are parameters that quantify the
traditional animation technique of ease in and ease out (also known as “slow
in and slow out”). In freeform animation on page 7988 of a biped, you can use
them to change the timing of a limb's movement from key to key.

The TCB controls are in the TCB section of the Key Info rollout on page 4367.

Glossary | 8145



Terrain

Using contours to build a terrain

Creates terrain objects on page 774 from contour line data. You select editable
splines representing elevation contours and 3ds Max creates a mesh surface
over the contours. You can also create a "terraced" representation of the terrain
object so that each level of contour data is a step, resembling traditional study
models of land forms.

When you import an AutoCAD drawing file to use as contour data, 3ds Max
names each object based on the AutoCAD object's layer, color, or object type.
3ds Max appends a number after each name. For example, an AutoCAD object
on the layer BASE becomes BASE.01.
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After importing the contour data, selecting the objects and clicking the Terrain
button, 3ds Max moves all the selected objects out of the scene and into the
terrain object. Other splines in the selection are treated in the same way as
by the Move copy method. You can only use these splines as operands of the
terrain object. This is appropriate if you create splines in order to create a
terrain object and have no further use for them.

Test
The basic function of a test in Particle Flow is to determine whether particles
satisfy one or more conditions, and if so, make them available for sending to
another event. When a particle passes a test, it is said to “test True.” To send
eligible particles to another event, you must wire on page 8170 the test to that
event. Particles that don't pass the test (“test False”) remain in the event and
are repeatedly subjected to its operators and tests. Or, if the test isn't wired to
another event, all particles remain in the event.

A list of all tests in Particle Flow is available in the Tests topic on page 2956.

See also:

■ Operator on page 8069

Texel
A texel (short for Texture Element) is the base unit of a textured graphic, which
defines the surface of a three-dimensional object. The base unit of the surface
of a 3D object would be a texel, while a 2D object would consist of pixels on
page 8092.

Ticks
Ticks are the way 3ds Max views increments of time. There are 4800 ticks in
a second, so you can actually access time down to 1/4800th of a second.

Given a standard, NTSC video frame rate, there are 30 frames in a second, and
therefore 160 ticks in each frame.

When you use the FRAME:TICKS display format, time is shown in frames and
ticks, delineated by a colon. This format lets you adjust the time slider in

Glossary | 8147



sub-frame increments of 1/160th of a frame. As you move through time, the
ticks field counts from 0 to 159, at which point the frames field increments
by one, and the ticks field returns to 0.

You can step forward or backward at single increments by clicking the
single-frame buttons among the playback buttons.

When you use the MM:SS:TICKS Display format, you see minutes (MM),
seconds (SS), and ticks, each separated by colons.

As you move through time in this display format, the ticks field counts from
0 to 4799, at which point the seconds field increments and the ticks field
returns to 0.

You can step forward or backward at single increments by clicking the
single-frame buttons on either side of the playback button.

Tile/Mirror

Left: A bitmap

Middle: Tiling the bitmap

Right: Tiling and mirroring the bitmap

Tiling and mirroring are useful for creating patterns based on a simple image.
Use them when you need wallpaper and other repetitive designs.
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The Tile option in the Material Editor is on by default, repeating the image
along the U and V directions. You can use the Tiling values to scale the map
image. Setting negative Tiling values increases the size of the image.

You can also set tiling values in the UVW Map modifier. These settings are in
addition to the tiling values you set for the map in the Material Editor. If the
map's base tiling parameter has a value of 2.0 and the UVW Map modifier has
a tiling value of 3.0 for the same axis, the net result is 2.0 x 3.0 = 6.0. To avoid
confusion about where the tiling is coming from, you may want to set the
map's tiling in its base parameters or with the UVW Map modifier, but not in
both locations.

The Mirror option is a variation on the Tile option. Tile repeats the image
side-by-side, while Mirror flips the image repeatedly.

Topology
When objects and shapes are created, each vertex and/or face is assigned a
number. These numbers are used internally to determine which vertices or
faces are selected at any given time. This numerical arrangement is called
topology.

When you select vertices or faces and apply a modifier to the selection, the
modifier stack keeps track of which faces/vertices the modifier affects. If you
later return to the selection level of the stack and change the selection, you
change the topology to which the modifier is applied.

The term topology refers to the structure of faces and vertices as well as their
numbers.

For example, by carefully setting various parameters, you could make a box
and a cylinder with the same number of vertices. You might then think you
could use the box as a morph target for the cylinder. However, because the
two objects are created with such different methods, the vertex numbers on
these objects would be ordered very differently. Morphing causes each
numbered vertex to go to its corresponding place on the morph target. In a
case such as this, with two objects with such different topology, morphing
from one to the other would cause the object to crumple or turn inside out
as it morphs.
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Topology-Dependent Modifier
Topology-dependent modifiers perform operations on explicit, topological
sub-object selections. The Edit Mesh and Mesh Select modifiers are examples
of modifiers that perform operations or selections on explicit vertex or face
numbers. When these modifiers are present in the stack, you can adversely
affect their results if you visit previous stack operations and change the
topology (the number and order of faces and vertices) being passed to them.
When you do this, a topology-dependence warning alerts you to the situation.

Touch
In footstep animation on page 7986, the state of the biped foot on the first frame
of a footstep.

Track
A track is a linear representation of animation occurring over time. You can
think of a track as a long, straight railroad track, with the animation start time
at one end, and the finish time at the other. Keys are placed on the track at
intervals that correspond to the time along the track.

The term track is used in several areas of character studio, including the
following:

■ Each animatable object and parameter in 3ds Max and character studio
has its own animation track, which you can view and edit in Track View
on page 4236.

■ Tools are available especially for working with biped tracks. The center of
mass is unique in that it has separate tracks for horizontal and vertical
animation, which you can select on the Motion panel > Track Selection
rollout on page 4348. You can copy and paste tracks on page 4311 on biped
objects to other bipeds with the Copy/Paste rollout on page 4389.

■ In the Keyframing Tools rollout on page 4380, you can clear all animation
or just selected tracks.

■ In the Motion Mixer on page 3699, the linear areas that hold motion clips
are called tracks. Several tracks can be stacked on top of one another to use
animation from all tracks at the same time.
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Track View
Track View provides a visual representation of animation keys, allowing you
to view, edit, copy and adjust one or several keys at a time. This is where you
control the timing of your animation, through the manipulation of keys,
curves and ranges. You can also assign animation controllers to interpolate
or control all the keys and parameters for the objects in your scene.

Track View has two windows, a Controller window and a Key window. The
Controller window shows the hierarchy of linked objects, as well as the
modifier stack and transform tracks. The Key window displays keys, curves
and ranges. Keys are color coded to show what is animated.

Track View uses two different modes. Curve Editor mode on page 3518 displays
key interpolation as curves, and allows you to edit the curves. Dope Sheet
mode on page 3519 displays the animation as a spreadsheet of keys and ranges.
Dope Sheet has two modes, Edit Key and Edit Ranges.

Trackgroup
In the Motion Mixer, motions are placed on tracks, and the tracks are organized
into trackgroups. In other words, each trackgroup is a holder for one or more
tracks. Each trackgroup can be filtered so the tracks within it affect only certain
parts of the biped, such as its arms or legs. Every biped in the Motion Mixer
can have multiple trackgroups, each with its own selection of biped parts. See
Adding Tracks to the Mixer on page 3704 and Filtering Mixer Tracks on page
3715.

Track View Hierarchy Icons
The Track View hierarchy, as displayed in the Controller window, follows the
traditional example of organizational headings in an outline. The highest
levels of the hierarchy represent the main groupings in 3ds Max of Sound,
Environment, Materials, Render Effects, and Objects. Lower levels of the
hierarchy progress through the details of your scene, such as individual
materials, material maps, and map parameters.

Each type of item in the Track View Hierarchy List is represented by an icon.
You can use these icons to quickly identify what each item represents.
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 Controller Indicate animation controllers. Controllers are the animation
workhorses of Track View. They contain the animated values for all parameters
and are the only item in the Hierarchy list that can have a track containing
keys. Every controller has its own individual icon. Some examples:

■  Position controller

■  Rotation controller

■  Scale controller

Certain types of controllers can contain other controllers. Examples of these
are Transform Controllers and List Controllers.

 Map Indicates map definitions. All branches below a map definition are
part of that map. This includes values used by parametric maps and other map
definition that are part of a map tree.

 Material Indicates material definitions. All branches below a material
definition are part of that material. Because a material can be composed of
multiple materials it is possible to have nested material definitions in Track
View. Icons also appear in an object's modifier branch when a material is
assigned to an object.

 Modifier Indicate modified objects and Space Warp bindings. Branches
below a modifier contain the modifier's sub-objects and parameters.

 Object Indicates objects in the scene. Branches below the square icon
contain linked descendents of the object. Branches below the circle icon beside
a yellow cube contain transforms and modifications applied to the object.

 Sound Indicate sound parameters. 3ds Max provides only one sound
source in Track View.
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Tracks
Every item in the Track View hierarchy has a track that displays what happens
to the item over time.

Animation track displayed in track bar below time slider

There are two types of tracks:

■ Range tracks indicate the range of time over which the animation occurs.
In 3ds Max, range display is turned off by default. To display the range,
select the keys in the track bar, then right-click and choose Configure>
Show Selection Range.

■ Range tracks indicate when items below the track are animated. A range
bar in the track displays the range of time over which the animation occurs.

■ Animation tracks contain the actual animated values for an item. Only
controller items have an animation track.

The values in an animation track are usually displayed as keys. Some controllers
don't use keys and instead display their values as a range bar or some other
graphic symbol. For example, the Wave Form item displays a sound file as a
two-channel sound wave.

Animation tracks are also the only track type that can be displayed as a
function curve.
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Trajectory

Scooter following a trajectory

Whenever an object moves through world space, you can view its trajectory.
A trajectory is the visible path the object makes because of its movement. You
can think of a trajectory as a three-dimensional function curve for the Position
track of an object.

Object trajectories appear with the following properties:

■ The trajectory curve is drawn in blue.

■ Frame increments are displayed as yellow dots on the curve.

■ Position keys are displayed as white boxes surrounding the appropriate
frame dot on the curve.

■ Selected keys are displayed in gray.

In 3ds Max trajectories are created from animated objects. You must animate
the object first in order to create the trajectory.
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The Path constraint on page 3297 lets you picks a spline in the scene to use as
a motion path for an object. The spline becomes the object's explicit trajectory.

Trajectory (Biped)
The path an object follows as it moves through space. In 3ds Max, you can
think of a trajectory as a three-dimensional function curve for the Position
track of an object.

When you animate a biped on page 4147, you can turn on the display of its
trajectory. See Trajectory Display on page 4319.

Transform Gizmo
A gizmo on page 7996 that is displayed in viewports and provides a visual aid
when you transform objects.

Move gizmo
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Rotate gizmo

Scale gizmo
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Transforms

Moving, rotating, and scaling a figure

When you create any object, 3ds Max records its position, rotation, and scale
information in an internal table called a transformation matrix. Subsequent
position, rotation, and scale adjustments are called transforms.

An object's actual position within the world coordinate system is always
calculated in relation to its internal, or local coordinate system, which is based
on the object's transformation matrix. The origin of the local coordinate
system is the center of the object's bounding box on page 7932.

An object can carry any number of modifiers, but only one set of transforms.
Although you can change transform values from frame to frame, each object
always has only one position, one rotation, and one scale transform.

You can animate your transforms by turning on the Auto Key button and
then performing the transform at any frame other than frame 0. This creates
a key for that transform at the current frame.

Transition
In the Motion Mixer and in Motion Flow, a transition is a gradual change
between two motion clips. You can set the frames at which the transition
starts and ends in each clip.

To find out how to use transitions in the Motion Mixer, see Working with
Transitions on page 3724. For information on transitions in Motion Flow, see
Customizing Transitions on page 4525.
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Transition Track
A Motion Mixer track that allows you to stack clips on top of one another,
and to create automatic transitions between them. Transitions on these tracks
are similar to those in a Motion Flow network. Compare with a Layer track
on page 8021, which allows cuts only between clips. See Adding Tracks to the
Mixer on page 3704.

Translucency

Glass on the right has a light green translucency.

A translucent material transmits light, but unlike a transparent material, it
also scatters the light so those objects behind the material cannot be seen
clearly.

Raytrace materials on page 5490 can simulate translucency. A Raytrace material's
Translucency color component ignores surface normal directions, giving the
effect of light scattering.
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You can also obtain translucency effects using the Standard material's on page
5395 Translucent shader on page 5434.

Truecolor
Describes hardware and software that can support up to 16 million color
values. Also known as 24-bit color, or 32-bit color when saved with alpha
channel data on page 7905.

Twist Links 

Twist Links Mode active (left) and Twist Links Mode inactive (right)

When you turn on Twist Links Mode (on the Bend Links rollout on page 4363),
a rotation in local X applied to a single chain link is incremented equally
throughout the rest of the chain. The remaining two axes (Y and Z) are not
affected by this rotation.
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Universal Naming Convention (UNC)
The 3ds Max network rendering system uses the Universal Naming Convention
(UNC) to identify directories and files. UNC names begin with a double
backslash and do not include a drive letter. This is the convention:

\\machine_name\directory\subdirectory\filename

To simplify network rendering, use UNC names whenever possible within a
3ds Max scene, even if the directory is on the local machine.

TIP When entering UNC names, leave off the \\ before the file name until you've
entered the entire path and file name. This eliminates search delays when entering
UNC path names into file selection dialogs.

Some networks require drive letters instead of UNC names. Directories on
such networks can be mounted as drive letters and shared over the network.
See Mounting a Directory on page 6478.
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UVW Coordinates

Local UV coordinates shown on a surface

Most material maps are a 2D plane assigned to a 3D surface. Consequently,
the coordinate system used to describe the placement and transformation of
maps is different from the X, Y, and Z axis coordinates used in 3D space.
Specifically, mapping coordinates use the letters U, V, and W; the three letters
preceding X, Y, and Z in the alphabet.

The U, V, and W coordinates parallel the relative directions of X, Y, and Z
coordinates. If you look at a 2D map image, U is the equivalent of X, and
represents the horizontal direction of the map. V is the equivalent of Y, and
represents the vertical direction of the map. W is the equivalent of Z and
represents a direction perpendicular to the UV plane of the map.

You might question why you need a depth coordinate like W for a 2D plane.
One reason is because it's sometimes useful to be able to flip the orientation
of a map, relative to its geometry. To do this, you need the third coordinate.
The W coordinate also has a meaning for 3-dimensional procedural materials.
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Vector Field
In crowd animation on page 4761, a vector field is a special type of space warp
that crowd members can use to move around irregular objects such as a curved,
concave surface. The vector field gizmo, a box-shaped lattice, is placed and
sized so that it surrounds the object to be avoided. The vectors are generated
from the lattice intersections. These vectors are, by default, perpendicular to
the surface of the object to which the field is applied; if necessary, you can
smooth them out with a blending function. The crowd members move around
the object by traveling perpendicular to the vectors.

Vector Field Space Warp
In crowd animation on page 4761, you can use the Vector Field space warp on
page 4917 as a space warp behavior. A vector field allows crowd members to
move automatically around obstacle objects of any shape, following the object
contours. It also lets crowd members move within the confines of an enclosed
space, such as a room, while avoiding the walls. You can also use Vector Field
space warps to control particle motion.

The Vector Field space warp works by generating a number of vectors that
surround an object and are perpendicular to its surface. Crowd animation
then uses these vectors to guide delegates around the object by moving them
perpendicular to the vectors.
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Vectors and Vector Handles

Kinds of vector handles:

1. Corner

2. Smooth

3. Bezier

4. Bezier corner

Vectors are secondary control points connected to vertices on a spline or patch
object. They are also referred to as handles or vector handles.

Vector handles are visible as small green squares when you select a vertex.
However, if the Vectors filter is checked (for a patch object), handles can be
selected and transformed without selecting a vertex first. A transform cursor
appears when you move onto a vector.

Each vertex in a shape can be one of four types:

Bezier Provide handles, but forces the segments into a tangent through the
vertex.

Bezier Corner Provides handles, and allows the segments on either side of
the vertex to be any angle.

Corner Allows the segments on either side of the vertex to be at any angle.

Smooth Forces the segments into a smooth curve tangent to the vertex.
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Velocity Interpolation
One method of interpolation used in motion flow editing on page 4508. By
default, in a transition between two motion clips, velocity is interpolated to
blend smoothly between clips. If transitions are optimized, then a sophisticated
algorithm is used that minimizes sliding feet.

Vertex
A vertex (plural form: vertices) is a single point whose sole property is its
position in 3D space, which is typically defined by values for the X axis, Y
axis, and Y axis. Vertices form the basic structure of geometric objects in 3ds
Max, including mesh objects, splines, NURBS, and patches.

ViewCube Navigation System
The ViewCube™ on page 107 is a 3D navigation tool that appears when the
3D graphics system is enabled and allows you to switch between standard and
isometric views. The ViewCube is on by default.

Viewport (Interactive) Renderer
The interactive renderer, used for the viewports, is designed for speed so you
can easily manipulate your objects in a shaded environment. It's not the same
as the production renderer, which is used for your final images. Therefore, a
number of effects that are available to the production renderer will not show
up in the viewports.

When you design your materials, for example, you have four levels of visual
feedback. The lowest level is the shaded viewport. The next level is an
ActiveShade viewport (or floater). The next level is the sample slot, which uses
the production renderer to display the sample sphere. The highest level is the
rendered scene, which uses the production renderer to display the scene.

A single material can contain any number of maps.

Because viewing mapped materials slows the viewport display, it's up to you
to decide which map (if any) you want to display. To display a specific map,
you go to that map's level in the Material Editor, and then turn on its display.
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(If you later go to a different map in the same material, and turn its display
on, the other map is automatically turned off.)

VIZBlock
A VIZBlock is a compound object similar to a nested AutoCAD block. It is used
for organizing linked data from DWG files. When AutoCAD data is linked to
3ds Max, you need to decide how the AutoCAD entities are to be organized
in the scene. AutoCAD drawings are commonly organized by layers, blocks,
and entities, and 3ds Max scenes are organized by hierarchies of objects.

VPX Files
VPX (Video Post sequence) files contain all the information relating to the
queue and all associated settings and references. They have the file extension
.vpx and are stored by default in the 3ds Max \vpost folder.

All of the Video Post configuration data, queue events, and queue event
external data is saved with the MAX file also, however saving it to a separate
file allows you to use the same Video Post settings in different scenes, and
also allows you to share sequences with other 3ds Max users.

VUE File
A VUE (.vue) file is an editable ASCII file. You create a VUE file using the VUE
file renderer instead of the default scanline renderer.

A VUE file contains a sequence of frames to render. Each frame is described
by a sequence of commands, beginning with a "frame" command, which
specifies the frame number, and ending with a viewport command, which
specifies the view to render (such as "top" or "camera"). Between these two
commands, there can be any number of "transform", "light", and "spotlight"
commands.

NOTE VUE files created with 3DS DOS could also contain "morph" commands.
This is not supported in 3ds Max because the 3ds Max exporter doesn't export
morph targets.

The VUE file commands are as follows:
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frame <n>

transform <object name> <transform matrix>

light <light name> <x> <y> <z> <r> <g> <b>

spotlight <light name> <x> <y> <z> <tox> <toy> <toz> <r> <g> <b> <hot angle>
<falloff angle> <shadow flag>

top <x> <y> <z> <width>

bottom <x> <y> <z> <width>

left <x> <y> <z> <width>

right <x> <y> <z> <width>

front <x> <y> <z> <width>

back <x> <y> <z> <width>

user <x> <y> <z> <horiz> <vert> <roll> <width>

camera <x> <y> <z> <tox> <toy> <toz> <roll> <focal>

Frame Command

Begins each frame description. Has a single parameter: the frame number.

Transform Command

Transforms the specified object.

The first parameter is the name of the object. This is the name as it appears
when you use 3ds Max, but enclosed in double quotes.

The second parameter is a transform matrix. This consists of 12 real numbers:

T1 T2 T3 T4 T5 T6 T7 T8 T9 T10 T11 T12

The VUE file treats these as if they were arranged in a 4 x 4 matrix (M):

T1 T2 T3 0

T4 T5 T6 0

T7 T8 T9 0

T10 T11 T12 1

The first nine values, T1–T9, describe rotation and scaling. The last three,
T10–T12, describe a move, in world coordinates.
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The VUE file renderer transforms the points of the object by
post-multiplication:| X' Y' Z' 1| = | X Y Z 1 | * M

Omni Light Command

Controls the location and color of an Omni light.

The first parameter is the name of the light. This is the name as it appears
when you use 3ds Max, but enclosed in double quotes.

The next three parameters, <x>, <y>, <z>, are the light's location.

The next three parameters, <r>, <g>, <b>, are the light's color. The color values
are normalized to range between 0.0 and 1.0.

The last parameter, <shadow flag>, parameter is 1 if the light casts shadows,
0 otherwise.

Spotlight Command

Controls the location, color, and other characteristics of a target spotlight.

The first parameter is the name of the light. This is the name as it appears
when you use 3ds Max, but enclosed in double quotes.

The next three parameters, <x>, <y>, <z>, are the light's location.

The next three parameters, <tox>, <toy>, <toz>, are the location of the light's
target.

The next three parameters, <r>, <g>, <b>, are the light's color. The color values
are normalized to range between 0.0 and 1.0.

The <hot angle> parameter is the angle of the light's hot spot, in degrees.

The <falloff angle> parameter is the falloff angle, in degrees

The <shadow flag> parameter is 1 if the light casts shadows, 0 otherwise.

Orthogonal Viewport Commands

These commands render a particular view—top, bottom, left, right, front, or
back.

The <x>, <y>, <z> parameters are the coordinates of the center of the view.

The <width> parameter is the width of the rendered image, in world units.
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User Viewport Command

Renders the user view.

The <x>, <y>, <z> parameters are the coordinates of the center of the view.

The <horiz> parameter is the horizontal angle, in degrees.

The <vert> parameter is the vertical angle, in degrees.

The <roll> parameter is a placeholder for the roll angle—but this is an "empty,"
unused parameter that must always be zero. To use roll in a VUE file, use a
camera view instead of a user view.

The <width> parameter is the width of the rendered image, in world units.

Camera View Command

Renders a camera view.

The <x>, <y>, <z> parameters are the camera's location.

The <tox>, <toy>, <toz> parameters are the location of the camera's target.

The <roll> parameter is the camera roll angle, in degrees.

The <focal> parameter is the camera's focal length, in millimeters.

Walking Gait
One of the predefined biped gaits available in footstep animation on page 7986
(the others are running and jumping). In a walking gait, at least one foot is
always in contact with the ground.

Walkthrough Assistant
Walkthrough Assistant lets you easily create a predefined walkthrough
animation of your scene by placing a camera on a path and setting the height,
turning the camera, and viewing a preview. This feature is available on the
Animation Menu.

In a scene, create a path for the camera to follow using a spline or NURBS
curve. Then choose Walkthrough Assistant from the Animation menu. With
Walkthrough Assistant you can automatically create a camera and animate it
along the path. Change a Perspective viewport into the Camera viewport to
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view the result. You can adjust the eye height and head tilt. You can animate
turning the camera by turning on the Auto Key button. For more information
see Walkthrough Assistant on page 5239.

Wall Repel Behavior
In crowd animation on page 4761, the Wall Repel behavior uses a grid object to
repel delegates. When influenced by the Wall Repel force, delegates turn until
they're heading away from the grid. This behavior is useful for keeping objects
inside an enclosed, straight-sided enclosure, such as a room in a building.

Wall Seek Behavior
In crowd animation on page 4761, the Wall Seek behavior uses a grid object to
attract delegates. When influenced by the Wall Seek force, delegates turn until
they're heading toward the grid. This behavior is useful for moving objects
toward a rectangular area, such as a doorway.

You can set the grid to attract from either side or both sides, and optionally
specify a maximum distance for attraction. You can also set the behavior to
act as though the grid extends infinitely along its plane.

Wander Behavior
In crowd animation on page 4761, the Wander behavior imparts a random
motion to delegates, letting you simulate meandering activity in which
delegates move and turn in a haphazard manner. The behavior works by
randomly picking a new direction, and then turning and moving in that
direction. You can specify how often to pick a new direction, how far to turn,
and how fast or slow to turn while moving.

Weight Curve
In the Motion Mixer on page 8052, weight curves define the amount of influence
a clip on page 8051 or track on page 8150 has on the mixed animation.

On a layer track on page 8021, each clip has its own weight curve. On a transition
track on page 8158, one curve defines the influence for the entire track. On a
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balance track on page 7919, the weight curve determines the degree of automatic
balance compensation applied to the biped motion.

Wire
Particle Flow uses wires to show connections between events in Particle View
on page 2811. There are two types of wires: one that connects a global event on
page 7997 to a birth event on page 7924, represented by a dashed blue line; and
one that connects a test on page 8147 to a local event on page 8027, represented
by a solid blue line.
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Wire from global event to birth event (above); wire from test to local event (below)

To wire a test to an event, drag from its test output, the blue dot that by default
sticks out to the left of the test, to the event's event input, which sticks out
from the top, or vice-versa. Similarly, you can wire a global event to a birth
event by dragging between the source output on the bottom of the global event
and the event input.
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 The mouse cursor resembles the first image when you can
begin this operation: the bottom portion is the top of a small square. The
cursor resembles the second image when you can complete the operation: the
square at the bottom has become an arrow.

To delete a wire, right-click it and choose Delete Wire, or click it (it highlights
in yellow) and then press the Delete key. Or, with a wire between a test and
an event, drag from either connector to a blank area of the event display on
page 7968.

Wireframe Mode

Wireframe mode display of a director's chair and megaphone

Wireframe is a viewport display setting that lets you view objects in a given
viewport as a wire mesh. This is the default setting for non-Perspective
viewports. You change this setting from the viewport right-click menu on
page 7576.

In addition, you can set the Standard and Raytrace materials to render as wires.
Use the Extended Parameters rollout to set the size of the wire, and specify its
measurement in either pixels or units.

When you use pixels, the thickness of the wire is based on the screen pixels.
Therefore, it's absolute, and remains the same, regardless of its distance from
the camera. If you use units, the thickness is based on world units, and varies
depending on the distance from the camera. It's easier to compare the effect
of pixels and units if you first adjust the camera view to give a greater sense
of distance. You can most easily do this with the Perspective viewport
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navigation tool, which dollies the camera in one direction while changing
the field of view in the other.

Workbench
The Animation Workbench is a customized version of the Track View function
curve editor designed to be used with bipeds. It contains a Curve View that
displays keys on function curves which you can edit similar to the way you
work in Track View. It also contains a set of four panels for selecting bipeds,
analyzing their motion tracks for error conditions, and fixing those tracks
individually or in groups.

The Workbench can be used to assign SubAnim controllers to multiple biped
body parts at once through the display of the Controllers window.

Workbench filters can be used to smooth, blur or boost position and rotation
curves, and can also be used to apply controllers or remove keys.

The Workbench uses many of the same toolbars found in Track View for key
manipulation and track navigation. It uses manual navigation as the default
behavior. When multiple biped body parts are selected it does not display all
curves as a default, so you can perform error analysis and correction on many
tracks without displaying all the curves simultaneously.

Workflow
A series of steps to perform a task.
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World Coordinate System

A book in object space rests on a table in world space. The table uses the world
coordinate system.

The coordinate system for world space or the model space as a whole.

World space is the universal coordinate system for all objects in the scene.
When you look at the home grid in the viewports, you see the World Space
coordinate system. World space is constant and immovable.

In the world coordinate system seen from the front, the X axis runs in a
positive direction to the right, the Z axis runs in a positive direction upward,
and the Y axis runs in a positive direction away from you.

8174 | Glossary



World Space

A book in object space rests on a table in world space.

World space is the universal coordinate system used to track objects in the
scene. When you look at the home grid in the viewports, you see the
world-space coordinate system. World space is constant and immovable. By
convention, world-space coordinates are always expressed as XYZ coordinates,
as opposed to the UVW coordinates of object space on page 8064.

All objects in your scene are located in world space by their position, rotation,
and scale (their transforms).

Some modifiers on page 8048 operate in world space. See World-Space Modifiers
(WSMs) on page 1113.

Space warps also operate in world space. A space warp defines an area in world
space that is affected by the space warp’s parameters. Any object that is bound
to the space warp is affected as it moves through the space warp’s area of world
space.
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World Space (Biped)
When you use freeform animation on page 7988 to animate a biped, you can
place a biped limb into the space of another object, or into world space. For
example, if the biped's feet are in world space, then when you move the center
of mass, the feet stay planted in the same location.

World-Space Modifiers (WSM)
World space is the universal coordinate system that applies to the entire scene.
A world-space modifier, as opposed to an object-space modifier on page 8066,
affects an object but uses world coordinates.

A world-space modifier always appears at the top of the modifier stack on page
1090. Its effect is independent of its order in the stack.

See also:

■ World-Space Modifiers (WSMs) on page 1113

xref (AutoCAD External Reference)
An AutoCAD external reference. An xref is a variation on a block. A block is
a collection of geometry that is identified by a unique name, is stored in the
AutoCAD symbol table, and essentially behaves as if it is a single object. Xrefs
share block characteristics, and they are similarly defined in the symbol table.
However, unlike blocks, the geometry associated with an xref definition is not
stored in the current AutoCAD drawing; it is stored in another AutoCAD
drawing file. Like a block, there can be many instances of an xref in a AutoCAD
drawing, but only one definition.

Typically, xrefs are used to display the geometry of a common base drawing
in the current AutoCAD drawing without expanding its size. This allows
changes to the reference drawing to be reflected in any host AutoCAD drawings
that refer to it.

See also:

■ XRef (3ds Max Externally Referenced File) on page 8177
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XRef (3ds Max Externally Referenced File)
An XRef in 3ds Max is an externally referenced file or object. XRefs allow
multiple animators and modelers to work on one scene at the same time
without interfering with each other's work.

There are two ways to XRef another scene:

■ XRef Scene on page 6959
The File > XRef Scene command XRefs an entire scene. For example, a
classic use of this command is to bring in a scene that appears as a “set”
for an animation you create.

■ XRef Objects on page 6936
The File > XRef Objects command XRefs individual objects or materials.
For example, you might be working on the model of a building, and fill it
with furniture created by other artists.

You can also XRef the manipulators and modifiers associated with the
objects you XRef.

ZT File
A ZT (.zt) file is a mental ray shadow map file on page 8126. This is a binary file
that the mental ray renderer uses to accelerate the generation of shadows. You
specify a name and location for the .zt file on the Render Setup dialog >
Renderer panel > Shadows & Displacement rollout on page 6292.
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